Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to:
docfeedback@servicenow.com

Company Headquarters
2225 Lawson Lane
Santa Clara, CA 95054
United States
(408) 501-8550

©2019 ServiceNow. All rights reserved. Terms of Use Privacy Statement
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company and product names may be trademarks of the respective companies with which they are associated.
# Table of Contents

## Now Platform Administration

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core configuration</td>
<td>7</td>
</tr>
<tr>
<td>Activate a plugin</td>
<td>7</td>
</tr>
<tr>
<td>Available system properties</td>
<td>83</td>
</tr>
<tr>
<td>Handle HTTP 500 errors</td>
<td>160</td>
</tr>
<tr>
<td>Query join and complexity size limits</td>
<td>162</td>
</tr>
<tr>
<td>Tables and classes</td>
<td>163</td>
</tr>
<tr>
<td>Using accessibility features</td>
<td>169</td>
</tr>
<tr>
<td>Web proxy</td>
<td>172</td>
</tr>
<tr>
<td>Table administration</td>
<td>175</td>
</tr>
<tr>
<td>Table extension and classes</td>
<td>175</td>
</tr>
<tr>
<td>Create a table</td>
<td>178</td>
</tr>
<tr>
<td>Tables module</td>
<td>184</td>
</tr>
<tr>
<td>Delete a table</td>
<td>186</td>
</tr>
<tr>
<td>Delete all records from a table</td>
<td>187</td>
</tr>
<tr>
<td>Restore deleted records</td>
<td>189</td>
</tr>
<tr>
<td>Create a table index</td>
<td>191</td>
</tr>
<tr>
<td>Task table</td>
<td>191</td>
</tr>
<tr>
<td>Data dictionary tables</td>
<td>251</td>
</tr>
<tr>
<td>Schema map for tables</td>
<td>283</td>
</tr>
<tr>
<td>Create a many-to-many relationship</td>
<td>286</td>
</tr>
<tr>
<td>List administration</td>
<td>287</td>
</tr>
<tr>
<td>List v3 administration</td>
<td>287</td>
</tr>
<tr>
<td>List configuration</td>
<td>296</td>
</tr>
<tr>
<td>Controlling the sort sequence used to display lists</td>
<td>304</td>
</tr>
<tr>
<td>List editor administration</td>
<td>305</td>
</tr>
<tr>
<td>Personal list administration</td>
<td>313</td>
</tr>
<tr>
<td>Administer detail rows</td>
<td>314</td>
</tr>
<tr>
<td>Restrict filters and breadcrumbs with fixed queries</td>
<td>314</td>
</tr>
<tr>
<td>Enable a hierarchical list</td>
<td>319</td>
</tr>
<tr>
<td>Context ranking</td>
<td>322</td>
</tr>
<tr>
<td>Customize List v2 context menus</td>
<td>329</td>
</tr>
<tr>
<td>Form configuration</td>
<td>334</td>
</tr>
<tr>
<td>Using the form designer</td>
<td>335</td>
</tr>
<tr>
<td>Configure the form layout</td>
<td>342</td>
</tr>
<tr>
<td>Form administration</td>
<td>354</td>
</tr>
<tr>
<td>Administering form personalization</td>
<td>355</td>
</tr>
<tr>
<td>Administering form annotations</td>
<td>357</td>
</tr>
<tr>
<td>Administering attachments</td>
<td>358</td>
</tr>
<tr>
<td>Formatters</td>
<td>362</td>
</tr>
<tr>
<td>Form templates</td>
<td>379</td>
</tr>
<tr>
<td>UI actions</td>
<td>389</td>
</tr>
<tr>
<td>UI policies</td>
<td>399</td>
</tr>
<tr>
<td>Advanced form configuration</td>
<td>403</td>
</tr>
<tr>
<td>Field administration</td>
<td>410</td>
</tr>
<tr>
<td>Field types</td>
<td>410</td>
</tr>
<tr>
<td>Add and customize a field in a table</td>
<td>510</td>
</tr>
<tr>
<td>Field normalization and transformation</td>
<td>527</td>
</tr>
<tr>
<td>Data policy</td>
<td>573</td>
</tr>
<tr>
<td>Data lookup and record matching support</td>
<td>581</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency administration</td>
<td>587</td>
</tr>
<tr>
<td>Locale settings</td>
<td>587</td>
</tr>
<tr>
<td>Session and reference currency</td>
<td>588</td>
</tr>
<tr>
<td>Single-currency mode</td>
<td>589</td>
</tr>
<tr>
<td>Price fields</td>
<td>590</td>
</tr>
<tr>
<td>Currency values in lists</td>
<td>590</td>
</tr>
<tr>
<td>Currency values in forms</td>
<td>592</td>
</tr>
<tr>
<td>Currency values in reports</td>
<td>592</td>
</tr>
<tr>
<td>Currency conversions</td>
<td>593</td>
</tr>
<tr>
<td>Currency values in import and export</td>
<td>594</td>
</tr>
<tr>
<td>Currency values in scripts</td>
<td>594</td>
</tr>
<tr>
<td>Configure currency fields in audit records</td>
<td>597</td>
</tr>
<tr>
<td>Change currency decimal places</td>
<td>597</td>
</tr>
<tr>
<td>Configure currency optimizer</td>
<td>598</td>
</tr>
<tr>
<td>Currency system properties</td>
<td>598</td>
</tr>
<tr>
<td>Localization settings</td>
<td>599</td>
</tr>
<tr>
<td>Define locales</td>
<td>599</td>
</tr>
<tr>
<td>Internationalization support</td>
<td>600</td>
</tr>
<tr>
<td>Localize price fields</td>
<td>613</td>
</tr>
<tr>
<td>Use translated text</td>
<td>613</td>
</tr>
<tr>
<td>System localization</td>
<td>615</td>
</tr>
<tr>
<td>Time configuration</td>
<td>623</td>
</tr>
<tr>
<td>Date and time fields</td>
<td>623</td>
</tr>
<tr>
<td>Calendars and schedules</td>
<td>629</td>
</tr>
<tr>
<td>Client transaction timings</td>
<td>649</td>
</tr>
<tr>
<td>Define a relative duration</td>
<td>652</td>
</tr>
<tr>
<td>Time display</td>
<td>654</td>
</tr>
<tr>
<td>Time-related functionality</td>
<td>657</td>
</tr>
<tr>
<td>Range calculator scripts</td>
<td>658</td>
</tr>
<tr>
<td>Set an inactivity monitor</td>
<td>661</td>
</tr>
<tr>
<td>System scheduler</td>
<td>661</td>
</tr>
<tr>
<td>Event scheduling</td>
<td>669</td>
</tr>
<tr>
<td>Timeline pages</td>
<td>670</td>
</tr>
<tr>
<td>Timing functionality</td>
<td>684</td>
</tr>
<tr>
<td>Time zones</td>
<td>685</td>
</tr>
<tr>
<td>Search administration</td>
<td>689</td>
</tr>
<tr>
<td>Features of search administration</td>
<td>689</td>
</tr>
<tr>
<td>Zing text indexing and search engine</td>
<td>690</td>
</tr>
<tr>
<td>Contextual search displays matching knowledge results</td>
<td>738</td>
</tr>
<tr>
<td>Events</td>
<td>774</td>
</tr>
<tr>
<td>Event registry</td>
<td>775</td>
</tr>
<tr>
<td>Event states</td>
<td>775</td>
</tr>
<tr>
<td>Event logs</td>
<td>776</td>
</tr>
<tr>
<td>The incident events business rule</td>
<td>776</td>
</tr>
<tr>
<td>Sample scripts from the change events business rule</td>
<td>778</td>
</tr>
<tr>
<td>Script actions</td>
<td>779</td>
</tr>
<tr>
<td>Global events</td>
<td>782</td>
</tr>
<tr>
<td>Create an event</td>
<td>783</td>
</tr>
<tr>
<td>Register an event</td>
<td>784</td>
</tr>
<tr>
<td>Reprocess an event</td>
<td>785</td>
</tr>
<tr>
<td>Pass event parameters from a workflow to a notification</td>
<td>785</td>
</tr>
<tr>
<td>Data management</td>
<td>786</td>
</tr>
<tr>
<td>The unique record identifier (sys_id)</td>
<td>788</td>
</tr>
<tr>
<td>Data archiving</td>
<td>789</td>
</tr>
<tr>
<td>Export and import XML files</td>
<td>804</td>
</tr>
<tr>
<td>Export sets</td>
<td>819</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration with third-party applications and data sources</td>
<td>952</td>
</tr>
<tr>
<td>Integration options</td>
<td>953</td>
</tr>
<tr>
<td>User administration</td>
<td>986</td>
</tr>
<tr>
<td>Add a new company</td>
<td>986</td>
</tr>
<tr>
<td>Manage user administration system properties</td>
<td>987</td>
</tr>
<tr>
<td>Add a department</td>
<td>988</td>
</tr>
<tr>
<td>Create a user</td>
<td>988</td>
</tr>
<tr>
<td>User self-registration</td>
<td>993</td>
</tr>
<tr>
<td>Impersonate a user</td>
<td>994</td>
</tr>
<tr>
<td>Manage user sessions</td>
<td>997</td>
</tr>
<tr>
<td>Groups</td>
<td>999</td>
</tr>
<tr>
<td>Skills Management</td>
<td>1002</td>
</tr>
<tr>
<td>Roles</td>
<td>1004</td>
</tr>
<tr>
<td>Non-interactive sessions</td>
<td>1022</td>
</tr>
<tr>
<td>Instance Usage</td>
<td>1024</td>
</tr>
<tr>
<td>Authentication</td>
<td>1027</td>
</tr>
<tr>
<td>Normalization Data Services</td>
<td>1215</td>
</tr>
<tr>
<td>Platform performance</td>
<td>1219</td>
</tr>
<tr>
<td>Transaction log response times</td>
<td>1220</td>
</tr>
<tr>
<td>Network response times</td>
<td>1222</td>
</tr>
<tr>
<td>Browser settings and performance</td>
<td>1224</td>
</tr>
<tr>
<td>Diagnostics page</td>
<td>1225</td>
</tr>
<tr>
<td>System Diagnostics Stats Tools</td>
<td>1229</td>
</tr>
<tr>
<td>Use a slow query log</td>
<td>1323</td>
</tr>
<tr>
<td>Index suggestions for slow queries</td>
<td>1333</td>
</tr>
<tr>
<td>Transaction cancellation</td>
<td>1249</td>
</tr>
<tr>
<td>Import set performance</td>
<td>1251</td>
</tr>
<tr>
<td>Thread performance monitoring</td>
<td>1252</td>
</tr>
<tr>
<td>Performance metrics</td>
<td>1253</td>
</tr>
<tr>
<td>Table rotation</td>
<td>1273</td>
</tr>
<tr>
<td>Table flattening</td>
<td>1280</td>
</tr>
<tr>
<td>Add a module to test connection speed</td>
<td>1282</td>
</tr>
<tr>
<td>This ServiceNow instance</td>
<td>1283</td>
</tr>
<tr>
<td>Transaction quotas</td>
<td>1285</td>
</tr>
<tr>
<td>Application quotas</td>
<td>1292</td>
</tr>
<tr>
<td>Use table extension</td>
<td>1295</td>
</tr>
<tr>
<td>System security</td>
<td>1296</td>
</tr>
<tr>
<td>Instance security dashboard and settings</td>
<td>1298</td>
</tr>
<tr>
<td>Access control list rules</td>
<td>1310</td>
</tr>
<tr>
<td>Elevated privilege roles</td>
<td>1338</td>
</tr>
<tr>
<td>Login and authentication security</td>
<td>1344</td>
</tr>
<tr>
<td>Certificates</td>
<td>1364</td>
</tr>
<tr>
<td>Web service security</td>
<td>1368</td>
</tr>
<tr>
<td>HTML sanitizer</td>
<td>1376</td>
</tr>
<tr>
<td>Auditing and history sets</td>
<td>1380</td>
</tr>
<tr>
<td>Domain separation</td>
<td>1395</td>
</tr>
<tr>
<td>Virtual Private Network (VPN)</td>
<td>1460</td>
</tr>
<tr>
<td>Encryption support</td>
<td>1463</td>
</tr>
<tr>
<td>System logs</td>
<td>1472</td>
</tr>
<tr>
<td>Upgrades and conversions</td>
<td>1482</td>
</tr>
<tr>
<td>Upgrade History module: Track every upgrade</td>
<td>1482</td>
</tr>
<tr>
<td>Upgrade Monitor module: Upgrade an individual instance</td>
<td>1494</td>
</tr>
<tr>
<td>Express conversion to ServiceNow Enterprise</td>
<td>1510</td>
</tr>
</tbody>
</table>
Now Platform Administration

The primary administrator role (admin) has access to all system features, functions, and data, regardless of security constraints. Additional administrator roles manage specific applications.

ServiceNow administrators can configure the system in many different ways to address the business needs of an organization. They can install and set up any number of the process applications that are provided with ServiceNow and also create custom applications. Applications can be made available to selected users by way of roles and other access controls. The system may also be configured to send and receive notifications as a way to create and track service requests.

Core configuration

Core configuration encompasses changes made to the platform as well as supporting applications. These changes can affect global settings as well as settings for particular applications.

These settings include:

- **Forms and lists**: change the behavior and appearance of forms and lists.
- **Navigation and UI and search**: configure how users browse and search in the platform.
- **Time and performance**: keep your organization running and on time.
- **Localization and mobile device support**: take the platform anywhere.
- **Plugins and out-of-box appendix**: expand the platform to fit your needs.

Activate a plugin

You can activate most plugins. Some features require a separate subscription from the rest of the Now Platform. Some plugins require a purchased subscription before activation. Some plugins must be activated by ServiceNow personnel.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see [Purchase a plugin](#).

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see [Request a plugin](#).

For plugins that you can activate yourself, continue with the following steps.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

### List of Jakarta plugins

Plugins available in the Jakarta release.

A ServiceNow administrator can activate these plugins. For details, see [Activate a plugin](#).

If a plugin does not appear on this list, it may require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see [Request a plugin](#).

<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Live feed</td>
<td>com.glide.ui.$live</td>
<td>$Live feedola</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Activity formatter</td>
<td>com.glide.ui_activity_formatter</td>
<td>Quickly and easily filter the list of activities, or history, on a task form.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Agent Schedule</td>
<td>com.snc.agent_schedule</td>
<td>Agent Schedule</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Aggregate Web Service</td>
<td>com.glide.web_aggregate</td>
<td>Provides SOAP Access to GlideAggregate functionality.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Aggregate Development</td>
<td>com.snc.sdlc.scrum_pp</td>
<td>This plugin has been replaced by Agile Development 2.0 for all new users. Existing users can continue to upgrade and use this plugin. Agile Development 2.0 provides enhanced functionality on top of Agile Development plugin. Please refer to documentation for details.</td>
<td>Inactive</td>
<td>true</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile Development 2.0</td>
<td>com.snc.sdlc.agile.2.0</td>
<td>The Agile Development 2.0 plugin provides enhanced functionality on top of Agile Development. If you already have a customized version of Agile Development, delete the customizations before activating “Agile Development 2.0” to ensure that all features work properly. Please refer the documentation for detailed steps to delete the customizations.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.project_portfolio</td>
</tr>
<tr>
<td>Angular AMB Services</td>
<td>com.glide.ui.ng.amb</td>
<td>Angular Services for AMB</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.ng, com.glide.amb, com.glide.record_watcher</td>
</tr>
<tr>
<td>Anonymous Connect Support</td>
<td>com.glide.connect.support</td>
<td>Plugin allows access and properties for Anonymous Connect Support.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.connect.support</td>
</tr>
<tr>
<td>API Analytics</td>
<td>com.glide.api_analytics</td>
<td>API Analytics Statistics for Web Services</td>
<td>Active</td>
<td>false</td>
<td>com.glide.db.query_stats, com.snc.pa, com.glideapp.canvas</td>
</tr>
<tr>
<td>Application Authorization</td>
<td>com.glide.sys.app_authorization</td>
<td>Inactive, Replaced by the Platform as a Service plugin.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>Application Creator</td>
<td>com.snc.apps_creator</td>
<td>Retired, Replaced by the Platform as a Service plugin.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>Application Creator Templates</td>
<td>com.snc.apps_creator_template</td>
<td>Application creator templates.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>Application Design Restrictions</td>
<td>com.glide.scope.design</td>
<td>System for restricting and capturing tables augmented by an application</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>Application File</td>
<td>com.snc.apps_file</td>
<td>Associates configuration records with an application and tracks record metadata.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.sp_workbench_widgets, com.snc.financial_planning, com.snc.fiscal_calendar, com.snc.treemap</td>
</tr>
<tr>
<td>Application Metadata</td>
<td>com.snc.metadata</td>
<td>Active</td>
<td>Active</td>
<td>false</td>
<td>com.glide.sp_workbench_widgets, com.snc.financial_planning, com.snc.fiscal_calendar, com.snc.treemap</td>
</tr>
<tr>
<td>Application Portfolio Management</td>
<td>com.snc.apm</td>
<td>Application portfolio management features</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.sp_workbench_widgets, com.snc.financial_planning, com.snc.fiscal_calendar, com.snc.treemap</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>Applications</td>
<td>Improves file-level access for application development.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.apps, com.snc.apps_picker</td>
<td></td>
</tr>
<tr>
<td>Applications</td>
<td>Allows users to select the desired application during application development.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply Once APIs (New in Jakarta)</td>
<td>Improves the behavior of any 'apply_once' update in a plugin during plugin activation/upgrade.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approvals with e-Signature</td>
<td>Requires approver to enter credentials when an approver attempts to approve a request via the list context menu or Approve UI Action on the Approval form.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Architecture Compliance</td>
<td>Manages scheduled or on-demand audits of CMDB records, to determine if configuration items (CI) match expected attributes.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.certification_core</td>
<td></td>
</tr>
<tr>
<td>Assessment</td>
<td>Provides capabilities to use custom questionnaires and scripted queries to evaluate, score, and compare any records in ServiceNow.</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.workflow, com.glideapp.survey, com.snc.bestpractice.task_survey, com.glide.survey_designer</td>
<td></td>
</tr>
<tr>
<td>Assessment Components</td>
<td>Provides the core components required for legacy surveys.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.bestpractice.task_survey, com.glideapp.survey</td>
<td></td>
</tr>
<tr>
<td>Assessment Designer Common</td>
<td>Provides the core components required for assessment designer.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.ng.dc</td>
<td></td>
</tr>
<tr>
<td>Asset Management</td>
<td>Manages all your assets, consumables, and software licenses.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.expense_line, com.snc.model, com.snc.organization_management, com.snc.fixed_asset, com.snc.depreciation, com.snc.automation, com.glideapp.home</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Plugin Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Workbench</td>
<td>Provides a workbench that customer service managers can use to evaluate agents based on configurable criteria, such as skills and availability, and then assign tasks to the desired agents.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.matching_rule</td>
</tr>
<tr>
<td>Automated Test Framework</td>
<td>Testing framework and tools for creating automated tests</td>
<td>Active</td>
<td>true</td>
<td>com.glide.rollback, com.glide.ui.angular, com.glide.element_mapping, com.glide.vars</td>
</tr>
<tr>
<td>Automatic Assignment</td>
<td>Allows application that uses tables that are children of Task (task) to use auto-assignment to automatically find eligible assignees for any task.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Basic Export Set Functionality</td>
<td></td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Benchmark Client (New in Jakarta)</td>
<td>Benchmark Insights for Customers</td>
<td>Inactive</td>
<td>false</td>
<td>com.sn_bm_common</td>
</tr>
<tr>
<td>Benchmark Common (New in Jakarta)</td>
<td>Common code for Benchmark Insights</td>
<td>Inactive</td>
<td>false</td>
<td>com.sn_bm_common</td>
</tr>
<tr>
<td>Best Practice - Bulk CI Changes</td>
<td>Enables functionality to propose affected CI changes in the change_request record that will automatically be deployed to all related task_ci records.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Best Practice - Change Risk Calculator</td>
<td>Simple change impact calculations for change management</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Best Practice - Incident Resolution Workflow</td>
<td>Best practices for incident resolution dictate that, rather than closing the incident, the incident should have a state of Resolved. This state gives the service desk a mechanism to verify that the caller is satisfied with the resolution, and that the customer agrees with closing the incident.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Best Practice - ITIL KPI Reports</td>
<td>Provides a series of reports that track the Key Performance Indicators (KPI) of incident management and problem management.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.metrics</td>
</tr>
<tr>
<td>Best Practice - Task Survey Management</td>
<td>Provides task survey functionality, which includes triggering survey requests based on task conditions and linking survey responses to the task that generated the survey. Allows for detailed survey reporting that uses data from the related task record. The demo data relies on incident and user demo data, but is not installed with this plugin.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.app.survey, com.glide.db_view, com.glide.notification</td>
</tr>
<tr>
<td>Business Rule V2</td>
<td>Business rules to support script-free conditions and behaviors.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Case Assignment Workbench Demo</td>
<td>Intelligent agent recommendation through dynamic matching rules/criteria</td>
<td>Active</td>
<td>false</td>
<td>com.glide.app.workflow, com.glideapp.workflow</td>
</tr>
<tr>
<td>Catalog Designer Common</td>
<td>Catalog Designer Common</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.ng.dc, com.glideapp.workflow</td>
</tr>
<tr>
<td>Central Dispatch</td>
<td>Assists visually allocating tasks to agents for a logged in dispatcher.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.app.workflow, com.glide.db_view, com.glide.notification</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependence</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| com.snc.certification_core | Certification Core provides structures such as filters and templates. Certification Core is activated automatically when any of these applications are activated:  
| | • Desired State Certification (active by default)  
| | • Architecture Compliance  
| | • Data Certification  
| | • IT Governance Risk and Compliance | Active | false | com.glide.list_v2, com.snc.version |
| com.snc.best_practice.change.jakarta | Change Management Best Practice - Jakarta provides alignment with proven change management ITIL practices.  
<p>| | Note: This plugin is activated by default for new customers. Customers who upgrade from a previous release must request the plugin by contacting Customer Support. | Active | true | com.snc.change_management.cab, com.snc.change_management.cab.form_layout, com.glide.service-portal, com.snc.app_common.service_portal, com.glide.editor.tinymce, com.glide.list_v2, com.snc.version |
| com.snc.change_management.collision | Change Management - Collision Detector provides the ability to detect whether planned changes conflict with other changes, or have other scheduling issues. | Active | true | com.snc.change_management.collision, com.glide.service-portal, com.snc.app_common.service_portal, com.glide.editor.tinymce, com.glide.list_v2, com.snc.version |</p>
<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core</td>
<td>com.snc.change_management</td>
<td>Provides change management plugin which both Change Management State Model and Standard Change Catalog plugins depend on. This plugin will update the <code>Type</code> field on Change Request to have the values 'normal', 'standard' and 'emergency'. The <code>Type</code> value on existing Change Requests will be updated: Routine -&gt; standard (Standard) Comprehensive -&gt; normal (Normal) Emergency -&gt; emergency (Emergency) When creating a Change Request an interceptor will prompt you for the Type of Change you want to create.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.change_request, com.snc.change_collision</td>
</tr>
<tr>
<td>Change Management - Mass Update CI</td>
<td>com.snc.change_management.mass_update_ci</td>
<td>Provides the ability to propose changes of Configuration Items (CI) en masse.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.change_management, com.snc.change_request, com.snc.change_collision</td>
</tr>
<tr>
<td>Change Management - Risk Assessment</td>
<td>com.snc.change_management.risk_assessment</td>
<td>Provides risk assessment that is used to determine a risk based on data driven questions. Works in unison with the condition-based change risk calculator.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.assessment, com.snc.bestpractice.task_survey, com.glideapp.survey, com.glideapp.servicecatalog, com.snc.bestpractice.change_risk</td>
</tr>
<tr>
<td>Change Management - Standard Change Catalog</td>
<td>com.snc.change_management.standard_change_catalog</td>
<td>Provides the ability to propose, review, approve, and create templates for Standard Changes.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.change_management, com.glideapp.servicecatalog</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>plugin1.com.glideapp.change_management.overview.homepage</td>
<td>Change Management Overview Homepage</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report</td>
<td></td>
</tr>
<tr>
<td>plugin2.com.glideapp.change_management.workflows</td>
<td>Adds three new template workflow versions which are designed for use with the Change Management process.</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.workflow</td>
<td></td>
</tr>
<tr>
<td>plugin3.com.glideapp.change.request</td>
<td>Change Request</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.report.itsm</td>
<td></td>
</tr>
<tr>
<td>plugin4.com.glideapp.live.chat</td>
<td>Chat provides instant messaging, chat conversations, work queue and group chat support.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.custom_web_service, com.glideapp.live_common, com.glide.db_audio</td>
<td></td>
</tr>
<tr>
<td>plugin5.com.glideapp.live_checklist</td>
<td>Provides a simple way to track the progress of tasks without creating additional records, using checklists that can be added to any form.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.ng, com.glide.rest.service</td>
<td></td>
</tr>
<tr>
<td>plugin6.com.glideapp.client_transaction</td>
<td>Client Transaction plugin provides support to track client rendering times at the server, lining the values up with the server transaction times.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>CMDB Test Equipment</td>
<td>CORE-FUNCTIONS included in the Extended CMDB plugin, used for test equipment configuration items.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.cmdb</td>
<td></td>
</tr>
<tr>
<td>CMS User Interface - Service Management Core</td>
<td>CORE-SYSTEMS Management System items (blocks, pages, and menus) used to reference core IT self-service applications are packaged in this plugin. It is also the core foundation for all Service Management applications.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.cms, com.glide.cms.extensions, com.glide.db_images</td>
<td></td>
</tr>
<tr>
<td>Coaching Loops</td>
<td>ADDITIONAL functionality that facilitates the coaching of employees on their work using coaching opportunities that can be conditionally configured.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.planned_task, com.glideapp.custom_charts</td>
<td></td>
</tr>
<tr>
<td>Code Search</td>
<td>A configurable Code Search API</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collaboration</td>
<td>Replaced by the Connect plugin.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.connect</td>
<td></td>
</tr>
<tr>
<td>Common ITSM Service Portal Application Components (New in Jakarta)</td>
<td>COMMUNE-APPLICATION Components for Service Portal</td>
<td>Active</td>
<td>false</td>
<td>com.glide.service-portal</td>
<td></td>
</tr>
<tr>
<td>Coaches (New in Jakarta)</td>
<td>ENABLES you to connect, engage, and collaborate with your employees, customers, partners, and prospects.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.service-portal, com.sn_communities_global, com.snc.csm_unified_theme, com.glide.processor.ics</td>
<td></td>
</tr>
<tr>
<td>Company, extension</td>
<td>Adds currency columns to the Company (core_company) table.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.currency</td>
<td></td>
</tr>
<tr>
<td>Configuration Management (CMDB Enterprise Edition)</td>
<td></td>
<td>Active</td>
<td>false</td>
<td>com.snc.cmdb</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>com.snc.cmdb</td>
<td>Provides core functionality for the configuration management database, including enterprise hardware and configuration item relationships.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.custom_web_service, com.sn_cmdb_content, com.snc.db_rotation, com.glide.ui.list_v3_components</td>
<td></td>
</tr>
<tr>
<td>com.snc.cmdb</td>
<td>Provides scoped apps access to Identification Engine APIs.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.cmdb.enterprise</td>
<td></td>
</tr>
<tr>
<td>com.glide.connect</td>
<td>Provides a real-time messaging platform that connects you to your coworkers, bypassing email and static documents.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.live_feed, com.glideapp.live_common, com.glide.ui.list_v3_components, com.glide.ui.angularui, com.glide.ui.ng.amb, com.glide.notification.push, com.glide.db_audio</td>
<td></td>
</tr>
<tr>
<td>com.glide.connect</td>
<td>Build support messaging platform and enables support agents to provide real-time assistance to end users, using queues.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.connect</td>
<td></td>
</tr>
<tr>
<td>com.glide.connect</td>
<td>Provides a homepage and all the configuration records required to analyze Connect Support in reporting.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glideapp.report</td>
<td></td>
</tr>
<tr>
<td>com.glide.connect</td>
<td>Plugin to enable processor for Routing Connect Support request to appropriate Chat Queue</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.matching_rule, com.glide.connect.support_routing</td>
<td></td>
</tr>
<tr>
<td>com.glide.cms</td>
<td>Allows administrators to create custom, branded, web user interfaces on top of an existing ServiceNow instance.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.home, com.glide.text_search, com.glide.db_images</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>com.glide.cms.types</td>
<td>An extension to Content Management that adds iFrames and Flash frames.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.cms.type.flash, com.glide.cms.type.iframe</td>
<td></td>
</tr>
<tr>
<td>com.glide.sorting</td>
<td>Support for drag-and-drop lists and ranking dialog. Context ranking allows a user to sort a collection of records independently of the attributes of those records. Context Ranking is activated automatically with the SDLC - Scrum Process Pack plugin.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.list_v2</td>
<td></td>
</tr>
<tr>
<td>com.glide.context_help</td>
<td>Provides a context-sensitive help system, providing links to specific help pages (either on the official ServiceNow product documentation site or any other web site). These help pages can be linked to the list or form view of any table, or to the form view of a specific record in a table.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.contextual_search</td>
<td>Provides contextual search services.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.application.json_service</td>
<td></td>
</tr>
<tr>
<td>com.glide.role_management</td>
<td>Provides the flexibility and power to protect information by controlling read/write/create/delete authorization.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.db_view, com.glide.ui_page</td>
<td></td>
</tr>
<tr>
<td>com.glide.role_management.inh_count</td>
<td>Prevents duplicate entries in sys_user_has_role for inherited roles, based on the value of the inh_count column.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.role_management</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>com.glide.role_management.V2</td>
<td>Prevents duplicate entries in sys_user_has_role for inherited roles, based on the value of the inh_count column.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.role_management, com.glide.scripted_rest_services</td>
<td></td>
</tr>
<tr>
<td>com.snc.contract_management</td>
<td>Provides the ability to manage all types of contracts.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.asset_management</td>
<td></td>
</tr>
<tr>
<td>com.glide.rest.cors</td>
<td>CORS support for REST API</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.cost_management</td>
<td>Tracks operating costs for configuration items and task-related activities, allocates the costs to business consumers, and compares actual allocations to planned budgets.</td>
<td>Inactive</td>
<td>true</td>
<td>com.sncexpense_line</td>
<td></td>
</tr>
<tr>
<td>com.snc.problem_kb</td>
<td>Provides the ability to create knowledge articles from problems.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.scope.privilege</td>
<td>System for capturing and enforcing cross-scope privileges used byScoped Apps</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.ui.themes</td>
<td>Provides support for CSS customizations to the user interface.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.ui.themes.core, com.glide.ui.themes.doctype</td>
<td></td>
</tr>
<tr>
<td>com.glide.ui.themes - UI 14</td>
<td>Provides UI15 themes.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.themes.core</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>--------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>CTI Softphone com.snc.cti</td>
<td>Enables Twilio integration using Notify and OpenFrame to provide softphone functions and call center capabilities. These include make, receive phone calls, transfer, hold and mute. Applications like Customer Service and Incident Management provide demo workflows for CTI. Please re-activate respective applications where you require CTI demo workflows.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.matching_rule, com.snc.matching_rule, com.snc.notify.twilio</td>
<td></td>
</tr>
<tr>
<td>Currency support for the service catalog com.glideapp</td>
<td>Enables cataloging to support fully localized currencies for item prices and options.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.currency</td>
<td></td>
</tr>
<tr>
<td>Customer Service com.sn_customerservice</td>
<td>Enables you to provide service and support for your external customers using several communication channels, such as email, web, and telephone. A case is created to track the issue reported or service requested, and assigned to groups or agents. Customer service agents in your organization work on the cases and resolve issues.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.asset_management, com.snc.state_flows, com.glide.connect.support, com.glide.connect.support, com.snc.assignment_workbench, com.snc.cs_base, com.snc.skills_management, com.snc.assessment_core, com.snc.process_flow_formatter, com.snc.task_relations, com.snc.task_activity, com.snc.matching_rule, com.snc.resolutionshaper, com.snc.openframe, com.snc.shn, com.snc.contextual_search, com.snc.cs_social</td>
<td></td>
</tr>
<tr>
<td>Customer Service CTI Demo Data com.snc.customerservice_cti_demo</td>
<td>Customer Service CTI demo data</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.customerservice_cti, com.snc.cti</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>Customer Service Management for Orders</td>
<td>Customer Service Management for Orders</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.customerservice</td>
<td></td>
</tr>
<tr>
<td>Data Archiving</td>
<td>Moves data that is no longer necessary for immediate day-to-day access from primary tables into a set of archive tables. Typical candidates include historical ITIL documents such as incidents which were closed last year. The functionality supports archiving of non-ITIL documents as well.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.db.replicate</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------</td>
<td>----------------</td>
<td>-------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>com.snc.certification_v2</td>
<td>Enables field-level certification of data, either scheduled or on-demand.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.list_v2, com.snc.certification_core</td>
<td></td>
</tr>
<tr>
<td>com.glide.data_lookup</td>
<td>Administrators to define rules that automatically set one or more field values when certain conditions are met. This plugin completely replaces Priority Lookup. Any custom logic defined in the CalculatePriority business rule must be manually translated into the new priority data lookup definition.</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.servicecatalog.com.glide.data_lookup</td>
<td></td>
</tr>
<tr>
<td>com.glide.data_lookup</td>
<td>Allows administrators to perform data lookups for variables on service catalog item screens, on requested items, and on catalog tasks as a user fills out the values contained in variables.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.servicecatalog.com.glide.data_lookup</td>
<td></td>
</tr>
<tr>
<td>com.glide.data_policy2</td>
<td>Defines mandatory or read-only requirements for table fields.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.datastructures</td>
<td>Provides element types: DataStructure and DataObject for flyweight data that can be stored internally as JSON and utilized via the DataStructure API.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.db.offrow_migration</td>
<td>UI/Script elements to allow for compatible columns to be moved offrow.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.db.rotation</td>
<td>Allows large tables to be broken up into smaller, more manageable tables.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.db.rotation_default_tables</td>
<td>Adds database rotation functionality to default tables.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.db.rotation</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>com.glide.db_audio</td>
<td>Allows audio files to be uploaded and stored in the database, and referenced in HTML.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.db_images</td>
<td>Allows images to be uploaded and stored in the database, and referenced in HTML.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.db_video</td>
<td>Allows video files to be uploaded and stored in the database, and referenced in HTML.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.db_view</td>
<td>Allows you to define table joins for reporting purposes.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.ui.ng.datatables</td>
<td>DataTables 1.1.0 Components</td>
<td>Inactive</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.sn_dd_user_admin</td>
<td>Delegated Dev User Administration</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.delegated_development</td>
<td>Supports controlled development by users who do not have full administrative rights</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.demand_management</td>
<td>Aids with capturing the demand and provides tools to screen, assess, and prioritize it. Only upgrade is allowed for this plugin. Activation should be done through Project Portfolio Suite with Financials plugin.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.process_flow_formatter, com.snc.assessment_core, com.snc.timeline_visualization, com.snc.bubblechart_workbench</td>
<td></td>
</tr>
<tr>
<td>com.snc.depreciation</td>
<td>Core depreciation capabilities</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.ui.ng.dc</td>
<td>Provides common components required by designers such as the form designer and the quiz designer.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.tablet.theme, com.glide.ui.themes.doctype</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>com.snc.certification_desired_state</td>
<td>Evaluates records to see if they match a desired state, scheduled or on-demand.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.certification_core</td>
<td></td>
</tr>
<tr>
<td>com.snc.dhtmlx.gantt</td>
<td>DHTMLX Gantt library</td>
<td>Inactive</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.dhtmlx.scheduler</td>
<td>DHTMLX Scheduler library</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.monitor.diagnostics</td>
<td>Provides advanced diagnostic monitoring of each node in a ServiceNow instance.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.glide.dictionary_override</td>
<td>Dictionary values to be overridden for extended table elements. For example, this plugin allows the default value for the Assigned To field in the Incident table to be different than the default value specified for the Assigned To field in the Task table.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>com.snc.dynamic_scheduling</td>
<td>Dynamic scheduling for Service Management Applications with support for bulk task recommendations and interval based auto assignment</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.matching_rule, com.snc.service_management</td>
<td></td>
</tr>
<tr>
<td>com.glide.phone_number</td>
<td>Ensures that all necessary information for a phone number is included and properly formatted to successfully route an international call over a territory’s public telephone network.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.email_accounts, com.snc.platform.security</td>
<td></td>
</tr>
<tr>
<td>com.glide.email.oauth</td>
<td>Support for XOAUTH and XOAUTH2 email authentication</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.platform.security, com.snc.matching_rule</td>
<td></td>
</tr>
<tr>
<td>com.glide.email.accounts</td>
<td>Email accounts to define email accounts and settings in individual records.</td>
<td>Active</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>--------</td>
<td>----</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Email Automatic User Creation</td>
<td>com.glide.email.create_userid</td>
<td>Sets glide.email.create_userid so that when automatic user creation is enabled, the UserID of newly-created users matches the user's email address. Also widens sys_user.user_name column to 100 bytes to accommodate longer UserIDs based on email addresses.</td>
<td>Active</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>Email Filters</td>
<td>com.glide.email_filter</td>
<td>Filters emails into different mailboxes or junk, depending on headers and subject. Ignores any email that contains a VCAL invitation.</td>
<td>Inactive</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>Email Notification Preview Plugin</td>
<td>com.glide.email_notification_preview</td>
<td>Allows you to easily preview a ServiceNow email notification without sending the notification. This allows you to preview notifications at design time.</td>
<td>Active</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>Email Retention</td>
<td>com.glide.email_retention</td>
<td>Provides retention policy for email.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.mailbox, com.glide.auxdb</td>
</tr>
<tr>
<td>Email Service</td>
<td>com.glide.email.service</td>
<td>Defines javascript and REST API for sending email.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.mailbox</td>
</tr>
<tr>
<td>Email Unsubscribe</td>
<td>com.glide.email.unsubscribe</td>
<td>Adds the ability to include an unsubscribe link in notifications.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.email_ordered_processing, com.glide.notification.subscription</td>
</tr>
<tr>
<td>Email/SMS Separation</td>
<td>com.glide.email_sms_separation</td>
<td>Separation of the sending of SMS and email by adding a column to the email table. Prevents SMS messages from slowing down email message sending and vice versa. Activation of this plugin will cause email to stop sending during activation. On systems with large email tables this can take hours, and is not recommended.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.notification</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependence</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.embedded_help</td>
<td>Provides administrators with a new Embedded Help application to create customized embedded help and develop guided tours.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.hopscotch</td>
</tr>
<tr>
<td>com.glide.encryption</td>
<td>Allows text fields and attached files to be encrypted.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.encryption</td>
</tr>
<tr>
<td>com.glide.encryption</td>
<td>Demos how encrypted form fields can be assigned to one encryption context. Adds two encrypted fields to the Task table (Social Security Numbers and Credit Cards), a read-only encryption context field, an <strong>Add Secure Info</strong> button that unhides these fields, and a <strong>Change Encryption</strong> button to change the encryption context. After activating, configure the Incident form to add the three fields.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.encryption</td>
</tr>
<tr>
<td>com.glide.email_engine_notifs</td>
<td>Container for engine-based email notifications. Contains a set of default email notifications. Installed only on new z-boots.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.web_service_provider</td>
</tr>
<tr>
<td>com.glide.web_service_provider_v2</td>
<td></td>
<td>Active</td>
<td>false</td>
<td>com.glide.web_service_provider</td>
</tr>
<tr>
<td>com.glide.cms</td>
<td>ESS Portal (implemented within Content Management)</td>
<td>Active</td>
<td>true</td>
<td>com.glide.cms</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.glideapp.servicecatalog.execution_plan</td>
<td>Support for the service catalog</td>
<td>Active</td>
<td>true</td>
<td>com.glide.execution_plan</td>
</tr>
<tr>
<td>com.snc.expense_line</td>
<td>Core expense line table that enables cost tracking. Integrated with asset management, CMDB, cost management, and contract management.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.snc.extended_cmdb</td>
<td>Provides specialized configuration items, such as radio hardware, test equipment, and voice system hardware.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.cmdb</td>
</tr>
<tr>
<td>com.snc.facilities_service_automation.move</td>
<td>Facilities Move Management. This plugin enables single user move functionality as well as Enterprise Move and move planning functionality. Any floor plan aspects are not installed by default. Install the Facilities Visualization Workbench (com.snc.facilities_service_automation.fvw) plugin to use the floor plan.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management, com.snc.facilities_service_automation.fvw</td>
</tr>
</tbody>
</table>

**Important:**
When licensed for Field Service Management and HR Service Delivery and a building map does not display in the HR Service Portal, try: Activating this plugin before, activating the Human Resources Scoped App: Lifecycle Events (com.sn_hr_lifecycle_events) plugin.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facilities Service Management</td>
<td>com.snc.facilities_service_automation</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management.core</td>
</tr>
<tr>
<td>CMS Portal</td>
<td>com.snc.facilities_service_automation.cms</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.facilities_service_automation, com.snc.service_management.core.cms</td>
</tr>
<tr>
<td>Mobile</td>
<td>com.snc.facilities_service_automation_m</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.facilities_service_automation, com.snc.service_management_m</td>
</tr>
</tbody>
</table>

Facilities Service Management

- Description: Manages facilities service management mobile components.
- Integration files installed when Facilities Visualization Workbench (com.snc.facilities_service_automation.fvw) is required.
- Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.

Facilities Visualization Workbench

- Description: Manages facilities requests and enables users to report and track requests by their location. To view requests on a floor plan, the Facilities Visualization Workbench (com.snc.facilities_service_automation.fvw) plugin is required.
- Integration files installed when Facilities Visualization Workbench (com.snc.facilities_service_automation.fvw) is also installed.
- Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.facilities_service_automation.fvw</td>
<td>The Facilities Visualization Workbench provides map interaction built upon geoJSON file map sets. Integration files installed when Facilities Service Management (com.snc.facilities_service_automation) is also installed. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.vars, com.glide.system_update_set</td>
</tr>
<tr>
<td>com.snc.field_normalization</td>
<td>Provides support for cleaning up messy data through normalization and transformation.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.vars, com.glide.system_update_set</td>
</tr>
<tr>
<td>com.snc.wm_questionnaire</td>
<td>(New in Jakarta) Customer Questionnaires for Work Orders or Work Orders Tasks.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pdf_generator, com.snc.signaturepad</td>
</tr>
<tr>
<td>com.snc.wo_signature_pad</td>
<td>(New in Jakarta) Create PDFs for closed work orders that include the name and signature of the customer and a summary of the completed work.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.service_management, com.sn_shn, com.snc.assignment_work, com.snc.central_dispatch, com.snc.wo_signature_pad, com.snc.wm_questionnaire, com.snc.dynamic_scheduling</td>
</tr>
<tr>
<td>com.snc.work_management.cms_portal</td>
<td>Field Service Management CMS Portal Provides support for field Service Automation and other service management applications from a single CMS page.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.work_management, com.snc.service_management</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Field Service Management Demo Data</td>
<td>Demonstration Data for Field Service Management covering the medical and telecommunication domains. NOTE: Installing this plugin adds new Configuration Item tables and relationships to the database.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.work_management.demo, com.snc.wo_signature_pad</td>
</tr>
<tr>
<td>Field Service Management Geolocation Demo Data</td>
<td>Enables geolocation capabilities for the Field Service Management application.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.work_management.demo</td>
</tr>
<tr>
<td>Field Service Management Mobile</td>
<td>Enables Field Service Management UI for Field Service. This plugin automatically installs or upgrades the Field Service and Mobile UI plugins.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management.demo, com.snc.work_management.demo</td>
</tr>
<tr>
<td>Field Service with Project Management</td>
<td>Enables Field Service Management integration with the Project Management application. This plugin activates the Project Management plugin, which may require additional licenses.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.work_management.demo, com.snc.financial_planning_pmo</td>
</tr>
<tr>
<td>Field Service with Project Management Demo</td>
<td>Demonstration data for the Field Service Management integration with the Project Management application.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.wm_ppm, com.snc.work_management.demo, com.snc.customerservice.demo</td>
</tr>
<tr>
<td>Finance Service Management</td>
<td>Manages finance requests and enables users to report and track those requests. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management.demo, com.snc.financial_planning_pmo</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Finance Service Management CMS Portal</td>
<td>lets you launch Finance Service Automation and other service management applications from a single CMS page. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.finance_service_automation, com.snc.service_management.core.cms</td>
</tr>
<tr>
<td>Finance Service Management Mobile</td>
<td>Lets you launch mobile components.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.finance_service_automation, com.snc.service_management.core.cms</td>
</tr>
<tr>
<td>Finance Service Management</td>
<td>Enables financial analysts to assemble spending data, build cost models, and generate reports to show how funds are being used. Activation of this plugin on production instances may have licensing implications. Contact your ServiceNow account team for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.fiscal_calendar, com.snc.project_portfolio, com.snc.common_workbench, com.glide.ui.ng, com.glide.ui.expanding_iframe</td>
</tr>
<tr>
<td>Financial Management for CSM (New in Jakarta)</td>
<td>Service Management and Field Service Management provide integration with the Financial Management application. These plugins add cost allocations for the CSM and FMS applications as well as dashboards and reports. Financial administrators can use these cost allocations on the Financial Management workbench to allocate, track, and report on expenses.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.financial_management_for_csm, com.snc.financial_management, com.sn_customerservice</td>
</tr>
<tr>
<td>Fiscal Calendar</td>
<td>Provides support for creating and managing fiscal calendars.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.dynamic_operands.datetime</td>
</tr>
<tr>
<td>Fixed Asset</td>
<td>fixed asset tracking</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td>Form Designer</td>
<td>com.glide.ui.ng.fd</td>
<td>Form Designer</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Form Personalization</td>
<td>com.glide.ui.personalization</td>
<td>personalize the layout for any form view.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Fullcalendar Library</td>
<td>com.snc.fullcalendar</td>
<td>Fullcalendar library v2.5.0</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Geolocation</td>
<td>com.snc.geolocation</td>
<td>Uses Google Maps to track users, plan efficient routes between locations, and assist in finding accurate travel times. The system locates users from latitude and longitude information provided by their mobile devices.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Glide Metadata</td>
<td>com.glide.metadata</td>
<td>Core metadata support</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Glide Metadata Delete</td>
<td>com.glide.metadata_delete</td>
<td>Core metadata delete support</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Google Maps Plugin</td>
<td>com.glideapp.google_maps</td>
<td>Google Maps plugin allows the display of Google Maps within the product as map pages.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>GRC: Audit Management</td>
<td>com.sn_audit</td>
<td>The GRC: Audit Management application provides a centralized process for Internal Audit teams to automate the complete audit life cycle. Project driven audits allow auditors to quickly scope engagements, conduct fieldwork, collect control evidence, and track audit observations.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>GRC: Compliance UCF</td>
<td>com.sn_comp_ucf</td>
<td>The GRC: Compliance UCF plugin is an add-on that provides GRC: Policy and Compliance Management with the capability to download regulatory content and common controls from the Unified Compliance Framework (UCF).</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>GRC: Performance Analytics Premium Integration</strong></td>
<td>com.sn_grc_pa</td>
<td>GRC: Performance Analytics Premium Integration enables risk and compliance managers to continuously monitor key risk and control indicators using the advanced reporting capabilities provided by Performance Analytics Premium.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td><strong>GRC: Policy and Compliance Management</strong></td>
<td>com.sn_comp</td>
<td>The GRC: Policy and Compliance Management application provides a centralized process for creating and managing policies, standards, and internal control procedures that are cross-mapped to external regulations and best practices. The application provides structured workflows for the identification, assessment, and continuous monitoring of control activities.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td><strong>GRC: Risk Management</strong></td>
<td>com.sn_risk</td>
<td>The GRC: Risk Management application provides a centralized process to identify, assess, respond to, and continuously monitor Enterprise and IT risks that may negatively impact business operations. The application also provides structured workflows for the management of risk assessments, risk indicators, and risk issues.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td><strong>GRC: Workbench</strong></td>
<td>com.sn_grc_workbench</td>
<td>GRC: Workbench</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.guided_setup</td>
<td>Provides customers with visual guidance to configure ServiceNow applications.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.ui_components, com.glide.scripted_rest_services, com.glide.embedded_help, com.glide.scoped_analytics_framework</td>
</tr>
<tr>
<td>com.glide.sn_tourbuilder</td>
<td>Provides administrators with modules in the Embedded Help application to develop guided tours.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.embedded_help</td>
</tr>
<tr>
<td>com.glide.high_security</td>
<td>Maintains sys_history_set and sys_history_line tables to view a record's audit, email, and relationship data in a table format.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.role_management</td>
</tr>
<tr>
<td>com.glide.history_set</td>
<td>Provides a splash page for homepages. Upon logging in, instead of going to home.do, users go to a splash page that gives them the ability to cancel the home page transaction. This is useful when homepages take a long time to load.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.home</td>
</tr>
<tr>
<td>com.glide.ui.hopscotch</td>
<td>Hopscotch is a framework to make it easy for developers to add product tours to their pages. Hopscotch accepts a tour JSON object as input and provides an API for the developer to control rendering the tour display and managing the tour progress. To learn more about Hopscotch and the API, check out <a href="http://linkedin.github.io/hopscotch">http://linkedin.github.io/hopscotch</a>.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.htmlsanitizer</td>
<td>Automatically cleans up HTML markup in all HTML fields to remove unwanted code to protect against security concerns such as cross-site scripting attacks.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.sn_hr_migration</td>
<td>Data Migration moves data and roles from the global version of HR to the scoped version. Data migration includes: - Tables - Columns - Choice Lists - Roles</td>
<td>Inactive</td>
<td>false</td>
<td>com.sn.hr.core</td>
</tr>
<tr>
<td>com.sn_hr_lifecycle_events</td>
<td>Activates the Lifecycle Event module for HR. Combined with other licensed applications, provides a full-service, onboarding experience for new hires and employees managing the process.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.hr.core, com.sn_hr_service_portal</td>
</tr>
</tbody>
</table>

Note: Activating this plugin requires the global version of HRSM be installed.

Important: To use the Floor Plan Viewer in the HR Service Portal, activate the Facilities Move Management (com.snc.facilities_service_automation.move) plugin before activating this plugin.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.sn.hr.scoped_security</td>
<td>Human Resources Scoped App: Security</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.service-portal</td>
</tr>
<tr>
<td>com.sn.hr.service_portal</td>
<td>Human Resources Scoped App: Service Portal</td>
<td>Inactive</td>
<td>true</td>
<td>com.sn_hr_core, com.glide.connect.support</td>
</tr>
<tr>
<td>com.sn.hr_wday</td>
<td>Human Resources Scoped App: Workday Integration</td>
<td>Inactive</td>
<td>true</td>
<td>com.sn_hr_core</td>
</tr>
<tr>
<td>com.snc.i18n.brazilian_portuguese</td>
<td>Internationalization plugin for language internationalization. Provides Brazilian Portuguese.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.czech</td>
<td>Internationalization plugin for language internationalization. Provides Czech.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.dutch</td>
<td>Internationalization plugin for language internationalization. Provides Dutch.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.finnish</td>
<td>Internationalization plugin for language internationalization. Provides Finnish.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.french-canada</td>
<td>Internationalization plugin for language internationalization. Provides French - Canadian.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.french</td>
<td>Internationalization plugin for language internationalization. Provides French.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Plugin Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>118N: German Translations</td>
<td>An Internationalization plugin for language internationalization. Provides German.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Hebrew Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Hebrew.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Hungarian Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Hungarian.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Internationalization</td>
<td>An Internationalization plugin for language internationalization. Provides the elements necessary for translating an instance without any translation preloaded.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: International Translation helper</td>
<td>An Internationalization plugin for language internationalization. Provides Hungarian.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Italian Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Italian.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Knowledge Management Internationalization Plugin v2</td>
<td>An Internationalization plugin for language internationalization. Provides the elements necessary for translating an instance without any translation preloaded.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Korean Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Korean.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Polish Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Polish.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>118N: Portuguese Translations</td>
<td>An Internationalization plugin for language internationalization. Provides Portuguese.</td>
<td>Inactive</td>
<td>False</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.snc.i18n.russian</td>
<td>An Internationalization plugin for language internationalization. Provides Russian.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.simplified_chinese</td>
<td>An Internationalization plugin for language internationalization. Provides Simplified Chinese.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.spanish</td>
<td>An Internationalization plugin for language internationalization. Provides Spanish.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.thai</td>
<td>An Internationalization plugin for language internationalization. Provides Thai.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.traditional_chinese</td>
<td>An Internationalization plugin for language internationalization. Provides Traditional Chinese.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.i18n.turkish</td>
<td>An Internationalization plugin for language internationalization. Provides Turkish.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.i18n</td>
</tr>
<tr>
<td>com.snc.incident</td>
<td>Incident Base Plugin</td>
<td>Active</td>
<td>true</td>
<td>com.snc.service, com.snc.incident_notification, com.glideapp.report.itsm</td>
</tr>
<tr>
<td>com.snc.iam</td>
<td>Allows crisis managers to manage communications for major issues, to bring together all involved users and help resolve these issues quickly.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.contact_management, com.glideapp.live_feed, com.glide.phone_number</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>com.snc.best_practice.incident.jakarta</td>
<td>Provides alignment with proven incident management ITIL practices.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.incident</td>
</tr>
<tr>
<td>com.snc.incident_assignment_workbench_demo</td>
<td>Intelligent agent recommendation through dynamic matching rules/criteria</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.assignment_workbench</td>
</tr>
<tr>
<td>com.snc.incident_notification</td>
<td>Incident Management Notification Plugin</td>
<td>Active</td>
<td>false</td>
<td>com.snc.incident_notification</td>
</tr>
<tr>
<td>com.glideapp.report.incident_overview.homepage</td>
<td>Incident Overview Homepage</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report</td>
</tr>
<tr>
<td>com.snc.incident_resolution_fields</td>
<td>Provides Resolved and Resolved by fields to the Incident table, similar to Closed and Closed by, populated with a business rule when an incident is resolved or closed.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.incident_resolution_fields</td>
</tr>
<tr>
<td>com.glide.index_suggestion</td>
<td>Suggest database indexes for slow queries.</td>
<td>Active</td>
<td>false</td>
<td>Stats Tools, Column Statistics</td>
</tr>
<tr>
<td>com.glide.web_service_insert_multiple</td>
<td>Enables multiple inserts for the Direct SOAP API.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.web_service_insert_multiple</td>
</tr>
<tr>
<td>com.snc.integration.common</td>
<td>Provides common scripts for integrations.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.system_import, com.glide.web_service_provider, com.glide.system_property_categories</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Integration - Multiple Provider Single Sign-On Enhanced UI</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependences</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Integration - Multiple Provider Single Sign-On Installer</td>
<td>The multiple provider single sign-on plugin enables organizations to authenticate against multiple IDPs (Identity providers) using SAML. It also supports authentication using multiple digest configurations.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.integration.sso.multi.installer</td>
</tr>
<tr>
<td>Integration - OpenID SSO (Deprecated)</td>
<td>Legacy version of single sign-on used with an external OpenID Provider (OP). OpenID Connect is provided in London but is limited to Web Services. The Single Sign-On portion is not supported at this time.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.integration.sso.openid</td>
</tr>
<tr>
<td>Integration - Tivoli Enterprise Console (TEC) 2.0</td>
<td>Provides version 2.0 integration with Tivoli Enterprise Console (TEC).</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.integration.tivoli_tec, com.glide.web_service_application, com.glideapp.agent</td>
</tr>
<tr>
<td>IP Range Based Authentication</td>
<td>Controls access to an instance based on IP address.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>IT Data Mart</td>
<td>Stores the information that the IT Finance application uses to allocate expenses to specific accounts and segments in the general ledger.</td>
<td>Inactive</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>--------</td>
<td>----</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
</tr>
<tr>
<td>Item Designer support for the service catalog</td>
<td>com.glideapp.servicecatalog.item_designer</td>
<td>Service Catalog item designer</td>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>ITOM Guided Setup</td>
<td>com.snc.guided_setup</td>
<td>ITOM Guided Setup Metadata</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>ITSM and PA Demo Data</td>
<td>com.snc.itsm_pa.demo</td>
<td>Demo data for Incident, Problem, Change, Task SLAs, Business Services, Service Offering, Service Commitments, and Performance Analytics</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>ITSM Guided Setup</td>
<td>com.snc.guided_setup</td>
<td>The key to metadata. ServiceNow usage only. Contains metadata for 'ITSM Guided Setup'.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>JSDebugger</td>
<td>com.glide.js-debugger</td>
<td>ServiceNow server-side scripts debugger</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>JSON Service request/response model</td>
<td>com.snc.application.json_service</td>
<td>Core js components and helpers for a JSON request/response model. Includes JSON and XML transports for NG and GlideAjax support. An extension of the processor framework.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Keylines Business Service Maps</td>
<td>com.snc.keylines</td>
<td>An interactive and graphical interface to visualize Configuration Items (CIs) and their relationships. Provides filtering capabilities to manage data being displayed, allowing for configuration by the user to view in context to their role. Additional capabilities provide for the displaying of related tasks such as Incidents, Problems, Changes and Certification Tasks.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Keylines Core</td>
<td>com.snc.keylines</td>
<td>Contains the Keylines Javascript library for drawing diagrams.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Knowledge Advanced (New in Jakarta)</td>
<td>Adds advanced features to knowledge management. Please use Knowledge Advanced Installer plugin to activate.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.knowledge3</td>
</tr>
<tr>
<td>Knowledge Advanced Installer (New in Jakarta)</td>
<td>Add installer to install the Knowledge Advanced plugin. When you activate/upgrade this plugin, it will do validations on knowledge articles and knowledge bases to make sure that the Knowledge Advanced plugin can be successfully installed. If validation fails, look at the errors in the Plugin Activation Logs and follow instructions given to fix them. Once all the issues are fixed, please re-run this plugin to install Knowledge Advanced.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Knowledge Document</td>
<td>Adds knowledge-based functionalities to the Managed Documents plugin. You can create a knowledge article from a document, or update a knowledge document to a newer revision.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.document_management</td>
</tr>
<tr>
<td>Knowledge Management - Service portal (New in Jakarta)</td>
<td>Add knowledge management features on the service portal.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.serviceportal.esm, com.snc.knowledge3</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>Knowledge Management Wiki Support</td>
<td>Active</td>
<td>false</td>
<td>com.glide.wiki, com.glideapp.knowledge2.wiki</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>Knowledge Overview Homepage</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>Knowledge Product Entitlements</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc_product_entitlements</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>LDAP Support Enhanced UI</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.ldap, com.glide.ui.ng.guided_flow, com.glide.ldap</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>Legacy Notify</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.notification, com.glide.phone_number</td>
</tr>
<tr>
<td>glideapp.knowledge2.wiki</td>
<td>Legal Service Management</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc_service_management</td>
</tr>
</tbody>
</table>

Legacy Notify enables bi-directional notifications over SMS, Voice, and Conference Bridges. Tightly integrated with the workflow engine and business rules, it delivers a highly configurable and trusted way to deliver messages across a range of channels. Requires a separate contract with Twilio for SMS and Voice capabilities.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Service Management CMS Portal</td>
<td>Service Automation and other service management applications from a single CMS page. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.legal_service_automation, com.snc.service_management</td>
</tr>
<tr>
<td>Legal Service Management Mobile</td>
<td>Service Automation Service Management mobile components.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.legal_service_automation, com.snc.service_management</td>
</tr>
<tr>
<td>List v2</td>
<td>Updates to the display of lists that include a cleanup UI, hierarchical lists, and related lists embedded in forms.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.tiny_url, com.glide.ui_list_edit_with_form, com.glide.db_context_menu</td>
</tr>
<tr>
<td>List v3</td>
<td>Provides several enhancements to UI16 lists, including real-time updates, split mode, a redesigned filter interface, and enhanced list grouping capabilities.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.ui.list_v3_components</td>
</tr>
<tr>
<td>Live Feed</td>
<td>Provides an updated application to post and share content in a ServiceNow instance.</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.live_feed, com.glideapp.ui_components</td>
</tr>
<tr>
<td>Live Feed Document - follow tasks (Incident, Change, etc.)</td>
<td>Enables you to manage your task conversations and comments from My Feed or a document group.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.live_feed</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Magellan Navigator</td>
<td>Provides a redesigned application navigator for UI16. Combines standard navigation capabilities, customizable favorites, and recently accessed items in a single responsive control.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.magellan_navigator, com.glide.ui.doctype, com.glide.ui.ng</td>
</tr>
<tr>
<td>Maintenance Schedules</td>
<td>Links configuration items to maintenance schedules. The maintenance schedules are checked against the planned dates for changes, and those that appear outside the maintenance schedule are so marked.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.schedules, com.snc.cmdb</td>
</tr>
<tr>
<td>Managed Documents</td>
<td>Lightweight, ITIL-based solution for managing electronic documents within your ServiceNow instance. To enable the ability to publish to the knowledge base, activate the Knowledge Document plugin.</td>
<td>Inactive</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Marketing Service Management</td>
<td>Manages marketing requests and enables users to report and track those requests. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management</td>
</tr>
<tr>
<td>Marketing Service Management CMS Portal</td>
<td>Marketing Service Automation and other service management applications from a single CMS page. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.marketing_service_management, com.snc.service_management</td>
</tr>
<tr>
<td>Marketing Service Management Mobile</td>
<td>Marketing Service Management mobile components.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.marketing_service_management, com.snc.service_management</td>
</tr>
<tr>
<td>Merge Tool</td>
<td>User interface for performing merges between two payloads</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.snc_code_editor</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependency</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td>com.glide.source_control</td>
<td>Source control integration applies and commits changes in an external repository.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.system_update_set</td>
</tr>
<tr>
<td>com.snc.metadata_tree</td>
<td>Hierarchical representation of metadata</td>
<td>Active</td>
<td>false</td>
<td>com.snc.apps_file</td>
</tr>
<tr>
<td>com.glide.metrics</td>
<td>Provides an easy, declarative way to define metrics and allows the definitions to be tracked and stored by the system.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.schedules</td>
</tr>
<tr>
<td>com.glideapp.agent</td>
<td>Management, Instrumentation, and Discovery (MID) Server is a Java application that runs as a Windows service or UNIX daemon. The MID Server facilitates communication and movement of data between the ServiceNow platform and external applications, data sources, and services.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.custom_web_service</td>
</tr>
<tr>
<td>com.snc.itil_mobile</td>
<td>Applications and modules for ITIL and Service Management</td>
<td>Active</td>
<td>false</td>
<td>com.glide.labels, com.glide.mobile</td>
</tr>
<tr>
<td>com.snc.model_management</td>
<td>Enables you to manage and maintain model categories, models, suites, and bundled models.</td>
<td>Active</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>com.snc.asset_management</td>
<td>Provides users with self-service access to their own assets, contracts, and requests.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.asset_management</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Next-Gen BSM</td>
<td>Next Generation BSM (NG-BSM) built on D3 and Angular. Provides an enhanced, modern interactive graphical interface to visualize Configuration Items (CIs) and their relationships. Provides filtering capabilities to manage data being displayed and displays related information for CIs such as Events, Incidents, Problems, and Changes.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.keylines_bsm_map, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>NG Common for the Guided Flow experience</td>
<td>Provides libraries and services common to plugins using Angular.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.ui.tablet.theme, com.glide.ui.ng, com.glide.ui.themes.doc</td>
</tr>
<tr>
<td>NG shared components</td>
<td>Provides libraries and services common to plugins using Angular.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.angularui, com.glide.ui.ng.amb</td>
</tr>
<tr>
<td>Normalization Data Services Client</td>
<td>Helps maintain consistency by ensuring that records for a given company refer to that company by the same name.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.cmdb</td>
</tr>
<tr>
<td>Normalization Data Services Configuration</td>
<td>Provides libraries and services common to plugins using Angular.</td>
<td>Active</td>
<td>false</td>
<td>com.snc.guided_setup</td>
</tr>
<tr>
<td>Notification System Push Addon</td>
<td>Adds support for push notifications to the notification system.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.notification, com.glide.push</td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Notify</td>
<td>com.snc.notify</td>
<td>Notify provides powerful platform features for workflow-driven voice calls, conference calls, and SMS messages making it possible to create flexible Interactive Voice Response (IVR) systems to do virtually anything. Requires the Twilio Driver and a separate contract with Twilio for SMS and Voice capabilities.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Notify - Twilio Driver</td>
<td>com.snc.notify</td>
<td>Twilio support for Twilio. Requires a separate contract with Twilio for SMS/Voice capabilities.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>OAuth 2.0</td>
<td>com.snc.platform</td>
<td>The implementation of OAuth 2.0 to support token granting and authentication.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>OAuth 2.0 legacy (Do not activate. Use OAuth 2.0)</td>
<td>com.snc.platform</td>
<td>Legacy implementation of OAuth 2.0. Install com.snc.platform.security.oauth instead.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>ODBC Commons</td>
<td>com.glide.odbc</td>
<td>ODBC Commons</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>On-Call Scheduling</td>
<td>com.snc.on_call</td>
<td>Provides the ability to create on-call schedules and escalation trees. When an incident is created, dynamically route the escalation to an on-call resource. On Call allows you to configure and build different on-call schedules per process and assignment group. When utilizing the Notify plugin, resources can use SMS and Voice escalations to interact with the escalation to acknowledge incidents, and so on.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Openframe</td>
<td>com.sn_openframe</td>
<td>An interface to integrate external communication systems with ServiceNow. This plugin brings a UI frame that is accessible and available anywhere within ServiceNow screens.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Order. Email Processing</td>
<td>dom.glide.email_ordered_processing</td>
<td>Allows inbound email actions to be ordered, and programmatically stop processing.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Organization Management</td>
<td>com.snc.organization_management</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Outbound Email Notifications</td>
<td>dom.glide.email_outbound</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Outbound HTTP Log</td>
<td>dom.glide.outbound_http_log</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Overview Pages</td>
<td>dom.glide.ui.overview_help</td>
<td>Framework for Overview pages</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Package Call Removal Tool</td>
<td>org.glide.script.packages_call_removal</td>
<td>Packages calls to ServiceNow Java classes, proposes changes to replace them with alternate scriptable names, and facilitates the script changes. Packages calls to ServiceNow Java classes will eventually be disallowed in a future ServiceNow release, and this utility helps prepare an instance for that.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Password Reset</td>
<td>dom.glideapp.password_reset</td>
<td>Provides the capability to create self-service and service desk password reset processes for a ServiceNow instance.</td>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>Password Reset Windows App (New in Jakarta)</td>
<td>dom.glideapp.password_reset_windows</td>
<td></td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.pdf_generator</td>
<td>Provides a tool to generate PDF documents. The Human Resources application uses this with various documents.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.signaturepad</td>
</tr>
<tr>
<td>com.snc.pa</td>
<td>Enables users to define and track key performance indicators (KPIs) and visualize these in scorecards. Users can compare multiple time series, do advanced trend analysis, and compare their performance with preset targets.</td>
<td>Active</td>
<td>false</td>
<td>com.glideui.angular, com.glideapp.report, com.glideapp.home, public, com.snc.core.automation, com.glide.usageanalytics</td>
</tr>
<tr>
<td>com.snc.pa.configgenerator</td>
<td>Configuration generator for creating a set of Performance Analytics indicators, breakdowns, dashboards, and widgets based on the task-derived table.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>com.snc.pa.change</td>
<td>Performance Analytics content pack for Change Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.report.itsm</td>
</tr>
<tr>
<td>com.snc.pa.cmp</td>
<td>Performance Analytics content pack Cloud Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.runbook_automation</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Configuration Management (CMDB)</td>
<td>Performance Analytics content pack Configuration Management (CMDB) out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.cmdb, com.snc.pa.change</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Customer Service</td>
<td>Performance Analytics content for Customer Service. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.sn_customerservice</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Discovery</td>
<td>Performance Analytics content pack for Discovery out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.cmdb, com.snc.discovery</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Provides Performance Analytics content for Field Service Management. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.pa, com.snc.work_management</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Performance Analytics content pack Financial Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.financial_management, com.snc.pa</td>
</tr>
<tr>
<td>Performance Analytics (New in Jakarta)</td>
<td>Provides Performance Analytics reports for Scoped HR. Activation of this plugin on production requires a PA Premium license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.sn_hr_core</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Performance Analytics content pack for Incident SLA Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Performance Analytics content pack for Knowledge Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.knowledge3, com.glideapp.report.knowledge</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.snc.pa.problem_management</td>
<td>Performance Analytics content pack Problem Management out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.report.itsm</td>
</tr>
<tr>
<td>com.snc.pa.project_portfolio_suite</td>
<td>Performance Analytics content pack for Project Portfolio Suite core out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.project_portfolio_suite</td>
</tr>
<tr>
<td>com.snc.pa.request</td>
<td>Performance Analytics content pack for Request Management out-of-the-box KPIs for Requested Items. Installed with Performance Analytics - Premium. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>com.snc.pa.request2</td>
<td>Performance Analytics content pack for Request Management out-of-the-box KPIs for Requests. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>com.snc.pa.chat</td>
<td>Performance Analytics content pack Service Desk Chat out-of-the-box KPIs. Activation of this plugin on production instances may require a separate Performance Analytics license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.connect, com.glide.connect.support, com.glide.connect.managers_dashboard, com.snc.pa</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.snc.pa.performance_analytics.context_sensitive_analytics.change</td>
<td>inactive to open PA context sensitive PA dashboards in change request form based on UI actions.</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.change</td>
<td></td>
</tr>
<tr>
<td>com.snc.pa.performance_analytics.context_sensitive_analytics.chat</td>
<td>Provides context_sensitive_analytics dashboard to analyze Connect Support metrics for support queues in Performance Analytics. Adds a related link to the Chat Queue Entry (chat_queue_entry) form to quickly display Performance Analytics metrics for the associated queue.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.chat</td>
</tr>
<tr>
<td>com.snc.pa.performance_analytics.context_sensitive_analytics.cs</td>
<td>Performance Analytics adding ability to open PA context sensitive PA dashboards in customer service form based on UI actions.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.customer_service, com.sn_customerservice, com.snc.pa.customer_service</td>
</tr>
<tr>
<td>com.snc.pa.performance_analytics.context_sensitive_analytics.incident</td>
<td>Performance Analytics adding ability to open PA context sensitive PA dashboards in incident form based on UI actions.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.problem</td>
</tr>
<tr>
<td>com.snc.pa.performance_analytics.context_sensitive_analytics.problem</td>
<td>Performance Analytics adding ability to open PA context sensitive PA dashboards in problem form based on UI actions.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.snc.pa.problem</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Performance Analytics - Domain Support</td>
<td>Performance Analytics allows to automate recurring information needs with scorecards and dashboards and by taking configurable snapshots of any data at regular intervals.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.canvas</td>
</tr>
<tr>
<td>Performance Analytics - Example - LinkedIn</td>
<td>Automatically imports LinkedIn data historically and daily.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.canvas</td>
</tr>
<tr>
<td>Performance Analytics - Example - Stocks Quotes</td>
<td>Automatically imports stock quotes data historically and daily.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>Performance Analytics - Example - Twitter</td>
<td>Automatically import Twitter data historically and daily.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa</td>
</tr>
<tr>
<td>Performance Analytics - Spotlight</td>
<td>PA Spotlight</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.canvas</td>
</tr>
<tr>
<td>Performance Analytics - Spotlight - Incident Spotlight content pack</td>
<td>Incident Spotlight Analytics - Spotlight - Incident Spotlight content pack</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pa, com.glideapp.canvas</td>
</tr>
<tr>
<td>Platform as a Service</td>
<td>Allows the development of custom applications to meet business needs.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.workflow</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Problem Management</td>
<td>Helps to identify the cause of an error in the IT infrastructure that is reported as occurrences of related incidents.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.service, com.glideapp.report.itsm</td>
</tr>
<tr>
<td>Problem Management Best Practice - Jakarta</td>
<td>Provides a problem management ITIL practices. Note: This plugin is activated by default for new customers. Customers who upgrade from a previous release must request the plugin by contacting Customer Support.</td>
<td>Active</td>
<td>true</td>
<td>com.snc.problem</td>
</tr>
<tr>
<td>Problem Overview Homepage</td>
<td>Problem Overview Homepage</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report</td>
</tr>
<tr>
<td>Problem Tasks</td>
<td>Problem Task table with a reference to the Problem table.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Process Flow Formatter</td>
<td>Quickly summarizes multiple pieces of information about a process and displays the stages graphically at the top of a form.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Procurement</td>
<td>Allows users to create purchase orders and obtain items for fulfilling service catalog requests.</td>
<td>Inactive</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Product Catalog</td>
<td>Provides information about individual models. Models are specific versions or various configurations of an asset. Models published to the product catalog are automatically published to the service catalog.</td>
<td>Active</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td>Project Management</td>
<td>com.snc.project_management_v3</td>
<td>The Project Management application aids in planning, organizing and managing projects and resources in order to setup, execute, and complete a project faster and easier. Only upgrade is allowed for this plugin. Activation should be done through Project Portfolio Suite with Financials plugin.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Project Management TeamSpace 1</td>
<td>com.snc.ppm_teamspace_1</td>
<td>Installs a Project TeamSpace so that each team or each department like Marketing, Finance, IT-Team1, IT-Team2 can implement PPM suitable to their needs without overstepping each other.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Project Management TeamSpace 2</td>
<td>com.snc.ppm_teamspace_2</td>
<td>Installs a Project TeamSpace so that each team or each department like Marketing, Finance, IT-Team1, IT-Team2 can implement PPM suitable to their needs without overstepping each other.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Project Management TeamSpace 3</td>
<td>com.snc.ppm_teamspace_3</td>
<td>Installs a Project TeamSpace so that each team or each department like Marketing, Finance, IT-Team1, IT-Team2 can implement PPM suitable to their needs without overstepping each other.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Project Management TeamSpace 4</td>
<td>com.snc.ppm_teamspace_4</td>
<td>Installs a Project TeamSpace so that each team or each department like Marketing, Finance, IT-Team1, IT-Team2 can implement PPM suitable to their needs without overstepping each other.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.ppm_teamspace_5</td>
<td>Installs a Project TeamSpace so that each team or each department like Marketing, Finance, IT-Team1, IT-Team2 can implement PPM suitable to their needs without overstepping each other.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.financial_planning_pmo, com.snc.project_management_v3, com.snc.resource_management, com.snc.sdlc.scrum.pp, com.snc.sdlc.scrum.ppm_int, com.snc.test_mgmt, com.snc.test_mgmt.ppm_int, com.snc.program_management</td>
</tr>
<tr>
<td>com.snc.project_portfolio_suite</td>
<td>The Project Portfolio Suite (PPS) plugin activates an integrated set of applications for project portfolio management and IT software development. Only upgrade is allowed for this plugin. Activation should be done through Project Portfolio Suite with Financials plugin.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.financial_planning_pmo, com.snc.project_management_v3, com.snc.resource_management, com.snc.sdlc.scrum.pp, com.snc.sdlc.scrum.ppm_int, com.snc.test_mgmt, com.snc.test_mgmt.ppm_int, com.snc.program_management</td>
</tr>
<tr>
<td>com.glide.protocol_profile</td>
<td>Defines properties associated to protocols such as default port and keystore.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.push</td>
</tr>
<tr>
<td>com.glide.push_feedback</td>
<td>Collects feedback from the Apple push notification service or another feedback service. Provides a REST API for other instances to collect from this service.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.push</td>
</tr>
<tr>
<td>com.glide.push_notification</td>
<td>Defines push notification message enqueuing and sending Responsible for processing push notifications to their next destination.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.push</td>
</tr>
<tr>
<td>com.glide.push_retention</td>
<td>Provides retention policy for push notifications.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.push, com.glide.auxdb</td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>--------</td>
<td>----</td>
<td>-------------</td>
<td>-------</td>
<td>---------------</td>
</tr>
<tr>
<td>Qualys Vulnerability Integration</td>
<td>com.snc.vulnerability.qualys</td>
<td>Provides the ability to integrate the ServiceNow Vulnerability Response application with the Qualys vulnerability scanner. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Quiz Designer</td>
<td>com.glide.quiz_designer</td>
<td>Provides the ability to send scored questionnaires quickly and easily to one or more users. A quiz may have categories of questions that are assigned only to some users.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Random Watermark Support (New in Jakarta)</td>
<td>com.glide.email.random_watermark</td>
<td>Generate unpredictable watermarks, and enable matching on these watermarks in inbound emails.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Read-Only User Role</td>
<td>com.snc.read_only.role</td>
<td>Enables Read-Only user role functionality.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Relationship Layout</td>
<td>com.glide.ui.relationship_layout</td>
<td>Enables scoped relationships to be associated to out-of-scope related list views.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Release Management</td>
<td>com.snc.release_management_v2</td>
<td>The Release Management v2 plugin is a rewrite of the original release management module. All products, releases, features, and release tasks are planned_task extensions, and much of the project management functionality (Gantt charts, timelines, time cards) is shared with release.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Report - PDF Page Header Footer Templates</td>
<td>Allows page header and footer configuration for PDF reports.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report, com.glideapp.report2</td>
</tr>
<tr>
<td>Report Charting v2</td>
<td>Complies with ServiceNow HighCharts charts.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report, com.glideapp.report2</td>
</tr>
<tr>
<td>Report Engine - use summary table for reports</td>
<td>Allows data from all reports, standard and custom, to be stored in the sys_report_summary table and separates the data from the rendering process for all reports. Report data is periodically purged from the sys_report_summary table (approximately every two hours).</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report2</td>
</tr>
<tr>
<td>Report Security - enforce access control checks</td>
<td>Enforces ACL checks when reports are created, deleted or updated.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.report, com.glideapp.report2</td>
</tr>
<tr>
<td>Report Statistics Reports</td>
<td>Provides reports and dashboards on reporting statistics.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glideapp.report</td>
</tr>
<tr>
<td>Required Form Fields</td>
<td>Enables administrators to specify required fields that cannot be removed from a form.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glideapp.report</td>
</tr>
<tr>
<td>Resource Management</td>
<td>Enables requesters and resource managers to plan, organize, and manage resources for both planned and unexpected work. Activating Resource Management automatically activates the Project Management plugin if it is not already active. Only upgrade is allowed for this plugin. Activation should be done through Project Portfolio Suite with Financials plugin.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.schedule_loader, com.snc.process_flow_format, com.snc.cost_management, com.snc.pps_portal_common</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.snc.matching_rule</td>
<td>Provides a Resource Matching Engine.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.skills_management, com.snc.agent_schedule</td>
</tr>
<tr>
<td>com.glideapp.canvas</td>
<td>Enables responsive canvas. For dashboards, the responsive canvas dynamically responds to dashboard resizing and enables dragging to place and resize widgets. Easily find and preview widgets that you want to add directly from the canvas.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.home, com.glide.text_search, com.glide.db_images, com.glide.ui.angular, com.glide.ui.ng</td>
</tr>
<tr>
<td>com.glide.rest</td>
<td>Provides a REST API framework to support RESTful services.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>com.snc.undelete</td>
<td>Restores deleted records from audited tables and references to those records. Also restores any records that were deleted as a result of a cascade delete rule.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.snc.role_delegation</td>
<td>Allows an administrator to designate role delegates, who can delegate any role they have to members of their group.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.workflow</td>
</tr>
<tr>
<td>com.snc.sfa2</td>
<td>Provides tools to manage sales and marketing operations throughout the sales life cycle from lead generation through contract completion.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.process_flow_formatter</td>
</tr>
<tr>
<td>com.snc.samp.microsoft</td>
<td>Add-on to the SAM Premium Core plugin that provides the capability to manage software that is licensed under the Microsoft licensing model.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.samp</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.samp.oracle</td>
<td>Add-on to the SAM Premium Core plugin that provides the capability to manage software that is licensed under the Oracle licensing model.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.samp</td>
</tr>
<tr>
<td>com.snc.samp</td>
<td>Scoped app for sam premium software metering SCCM integration</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.samp, com.snc.integration.sccm2012v2</td>
</tr>
<tr>
<td>com.glide.erd</td>
<td>Displays the details of tables and their relationships in a visual manner, allowing administrators to view and easily access different parts of the database schema.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.diagrammer</td>
</tr>
<tr>
<td>com.glide.scoped_analytics_framework</td>
<td>Analytics Framework for Scoped Applications</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.scripted_rest_services</td>
<td>Provides templates for some script fields.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.scripted_rest_services.errors</td>
<td>Provides temporary support for continued direct invocation of whitelisted Java Packages, Constructors, and Methods.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.scripted_rest_services.internal</td>
<td>Provides framework for building Scripted REST APIs.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.scripted_rest_services, com.glide.scripted_rest_services.errors, com.glide.scripted_rest_services.internal</td>
</tr>
<tr>
<td>com.glide.scripted_rest_services.errors</td>
<td>An internal plugin component to Scripted REST APIs</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.scripted_rest_services.internal</td>
<td>An internal plugin component to Scripted REST APIs</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>SCSS Bootstrap Theme</td>
<td>Provides SCSS styles for Bootstrap using SCSS</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.scss</td>
</tr>
<tr>
<td>SCSS Content Provider</td>
<td>SCSS Content Provider</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>SDLC - SCRUM</td>
<td>Adds a release process specific to a Scrum development process. Sits on top of the SDLC application, adding additional agile notions like epics, stories, and sprints.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.sdlic</td>
</tr>
<tr>
<td>Security Incident Analytics</td>
<td>Provides a unified solution of Security Incident Response with Performance Analytics for trend-based reporting. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.security_incident</td>
</tr>
<tr>
<td>Security Incident Response</td>
<td>Provides visibility into the state of an organization’s security by using many of the same workflow and reporting capabilities ServiceNow is known for. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_management, com.snc.task_outage, com.snc.treemap, com.snc.security_support, com.snc.threat, com.snc.whtp, com.snc.threat</td>
</tr>
<tr>
<td>Security Jump Start (ACL Rules)</td>
<td>Adds ACL rules to provide a jump-start on securing many system tables, making it easier for an organization to get into production more quickly.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.secops.pwned</td>
<td>Provides the ability to submit Whois lookups on domain names and URLs to obtain context on URL observables, and to make better determination on threats. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.threat, com.snc.security.incident</td>
</tr>
<tr>
<td>com.snc.secops.crowdstrike</td>
<td>Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.secops.orchestration, com.snc.security.incident</td>
</tr>
<tr>
<td>com.snc.secops.elasticsearch</td>
<td>Searches your Elasticsearch logs and adds relevant sighting information to your security incidents. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.security.incident</td>
</tr>
<tr>
<td>com.snc.secops.paloalto.autofocus</td>
<td>Provides the ability to integrate the ServiceNow Security Incident Response application with the Palo Alto Networks AutoFocus. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.secops.orchestration, com.snc.security.incident</td>
</tr>
<tr>
<td>com.snc.secops.paloalto</td>
<td>Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.secops.orchestration, com.snc.security.incident</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.secops.security_operations.palo_alto.networks.wildfire</td>
<td>Provides the ability to integrate the ServiceNow Security Incident Response application with the Palo Alto Networks WildFire application. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.security_operations, com.snc.secops.orchestration</td>
</tr>
<tr>
<td>com.snc.secops.security_operations.qradar.integration</td>
<td>Provides the ability to integrate the ServiceNow Security Incident Response application with QRadar SIEM data. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.security_operations, com.snc.secops.orchestration</td>
</tr>
<tr>
<td>com.snc.secops.security_operations.splunk.integration (New in Jakarta)</td>
<td>Searches your Splunk logs and adds relevant sighting information to your security incidents. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.security_operations</td>
</tr>
<tr>
<td>com.snc.secops.security_operations.tanium.integration</td>
<td>Provides the ability to integrate the ServiceNow Security Incident Response application with Tanium data. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.security_operations, com.snc.secops.orchestration</td>
</tr>
<tr>
<td>com.snc.security_support.common</td>
<td>Provides common functionality for use across the various security applications, such as Security Incident Response. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.security_support.common</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.secops.orchestration</td>
<td>Provides an integration of Security Operations with Orchestration to allow the facilitation of workflow activities within Security Incident Response, Threat Intelligence, or Vulnerability Response. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.runbook_automation.runtime, com.snc.security_support.common</td>
</tr>
<tr>
<td>com.snc.password_reset</td>
<td>Allows locally authenticated users to request a temporary password if they forget their current password.</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.password_reset</td>
</tr>
<tr>
<td>com.glide.debugger</td>
<td>Allows application developers and administrators to efficiently debug scripts that drive the applications they develop and support.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.angular, com.glide.ui.zepto, com.glide.ui.font_icons</td>
</tr>
<tr>
<td>com.glideapp.servicecatalog.cms</td>
<td>Service Catalog CMS Extension</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.servicecatalog.platform, com.glide.cms</td>
</tr>
<tr>
<td>com.glideapp.servicecatalog</td>
<td>Service Catalog Core Applications</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.servicecatalog.platform, com.glideapp.servicecatalog.execution_plan, com.glideapp.servicecatalog.currency</td>
</tr>
<tr>
<td>com.snc.sc_catalog_manager</td>
<td>Service Catalog Manager</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glideapp.servicecatalog.rest.api</td>
<td>Service Catalog REST API</td>
<td>Active</td>
<td>false</td>
<td>com.glideapp.servicecatalog.scoped.api</td>
</tr>
<tr>
<td>com.glideapp.servicecatalog.scoped.api</td>
<td>Service Catalog Scoped API</td>
<td>Active</td>
<td>true</td>
<td>com.glideapp.servicecatalog.scoped.api</td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>--------</td>
<td>----</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| Service Creator | com.glide.service_creator | Enables a department to offer custom services through the service catalog, such as the HR department offering tuition reimbursement for further education. | Active | true | com.glide.ui.ng.cc, com.glideapp.servicecatalog |}
| Service Desk Call | com.snc.service_desk_call | Part of the Service Desk application that enables service desk staff to collect information in a call that does not relate to a specific process. The call is transferred to an incident, problem, change request, or service catalog request. Replaces the Best Practice - New Call Wizard plugin and the New Ticket Module. | Inactive | false | |
| Service Level Management | com.snc.sla | Provides the core SLA functionality. SLA Definitions provide conditions to start, pause, stop, cancel and reset Task SLAs against any Task type. In addition, you can specify a schedule on the definition to define the working hours and also a workflow to run against each Task SLA which is typically used to generate notifications. | Active | true | com.glideapp.workflow, com.glide.schedules, com.glide.relative_duration |}
<p>| Service Level Management Best Practice -- Jakarta | com.snc.best_practice.sla.jakarta | Provides alignment with proven service level management ITIL practices. | Active | true | com.snc.sla |</p>
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Management Geolocation</td>
<td>Provides Service Management geolocation capabilities.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.geolocation</td>
</tr>
<tr>
<td>Service Management Geolocation Mobile</td>
<td>Adapts the new mobile UI for Service Management Geolocation.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.ul.m, com.snc.service_management_geolocation</td>
</tr>
<tr>
<td>Service Modeling</td>
<td>Service Modeling used in Service Mapping and Delivery</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.vars, com.snc.cmdb.enterprise</td>
</tr>
<tr>
<td>Service Portal - Service Status</td>
<td>Service Status gives information on current, planned, and historical outages for Business Services so they do not have to call your Service Desk. Loading demo data randomly generates 90 days of outages for 19 demo data Business Services.</td>
<td>Active</td>
<td>true</td>
<td>com.glide.service portal</td>
</tr>
<tr>
<td>Service Portal Configuration Pages</td>
<td>Service Portal Configuration Pages</td>
<td>Active</td>
<td>false</td>
<td>com.glide.service portal</td>
</tr>
<tr>
<td>Service Portal Designer</td>
<td>Drag-and-drop wysiwyg portal designer</td>
<td>Active</td>
<td>false</td>
<td>com.glide.service portal</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Plugin Name</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
</tr>
<tr>
<td>com.glide.service-portal.sqanda</td>
<td>Service Portal Social QA</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>com.glide.service-portal.survey</td>
<td>Service Portal Surveys and Assessments</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>com.glide.service-portal.user-criteria</td>
<td>Service Portal User Criteria Support (New in Jakarta)</td>
<td>Enables Service Portal User Criteria support. Installing this plugin will create new user criteria records for each of your widgets and pages that already have role-based permissions on them.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>com.snc.service-portfolio</td>
<td>Service Portfolio Management</td>
<td>Allows an organization to document the business services it provides using a standardized, structured format. Performance against availability commitments is calculated and can be displayed in a homepage.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>com.snc.service-portfolio.sla</td>
<td>Service Portfolio Management - SLA Commitments</td>
<td>Allows commitments to be defined by an SLA, so that staff can track how efficiently the service desk meets commitments for a service offering.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>com.snc.usage_admin.snc</td>
<td>ServiceNow Subscription Management</td>
<td></td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>com.glide.sessiondebug</td>
<td>SessionDebug</td>
<td>Provides SessionDebug statements and filtering.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td>Signature Pad</td>
<td>com.snc.signaturepad</td>
<td>Provides a tool to allow a digital signature in a .pdf document. The Human Resources application uses this with various documents. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Skills Management</td>
<td>com.snc.skills_management</td>
<td>Enables an administrator to assign configured competencies, called skills, to groups or individual users. These skills can then be used to determine which users and groups can be assigned particular tasks.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>SLA Contract Addon</td>
<td>com.snc.sla.contract2</td>
<td>Extends the existing SLA functionality by utilizing a contract as the master document that houses all appropriate data to drive task SLA processing.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>SLA Timeline</td>
<td>com.snc.sla.timeline</td>
<td>Provides the ability to view an SLA in a timeline.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>SM Planned Maintenance</td>
<td>com.snc.planned_maintenance</td>
<td>Allows setup and configuration for repeating and triggered requests. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>SNC Code Editor</td>
<td>com.glide.snc_code_editor</td>
<td>code_editor</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Social Q&amp;A</td>
<td>com.sn_kb_social_qa</td>
<td>Allows users to ask and respond to questions and to vote on questions and answers. Social Q&amp;A extends the Knowledge application and uses existing Knowledge functionality such as user criteria and multiple knowledge bases.</td>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependence</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td>com.snc.software_asset_management</td>
<td>Provides the capability to do software asset management, includes reconciliation of entitlements to license including those for named users, workstation, and enterprise software agreements. Activation of this plugin on production instances may have licensing implications. Contact your ServiceNow account team for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.sam.core</td>
</tr>
<tr>
<td>com.snc.sam.ibmpvu.pp</td>
<td>Add-on to the Software Asset Management plugin that provides the capability to manage software that is licensed under the IBM Processor Value Units licensing model.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.software_asset_management</td>
</tr>
<tr>
<td>com.snc.sam.oracle.pp</td>
<td>Add-on to the Software Asset Management plugin that provides the capability to manage software that is licensed under Oracle licensing model.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.software_asset_management</td>
</tr>
<tr>
<td>com.snc.sam</td>
<td>Provides Software Asset Management improvements.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.snc.samp.core</td>
<td>Scoped app for Software Asset Management Premium</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.samp.core</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>com.snc.sdlc</td>
<td>Extends the Release Management v2 plugin by adding some new structures to accommodate the software development life cycle. This plugin is designed to accommodate most non-agile development methodologies, including the common waterfall method of development.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.release_management_v2</td>
</tr>
<tr>
<td>com.snc.sn_shn</td>
<td>Special Handling Notes</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.customerservice.demo</td>
</tr>
<tr>
<td>com.snc.shn_demo</td>
<td>Provides single sign-on access to ServiceNow instances through Okta.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.integration.sso.okta</td>
</tr>
<tr>
<td>com.snc.sso.okta</td>
<td>Provides single sign-on access to ServiceNow instances through Okta.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.integration.sso.okta</td>
</tr>
<tr>
<td>com.snc.state_flows</td>
<td>Enables advanced users to customize the state flow of any task table that uses states.</td>
<td>Inactive</td>
<td>false</td>
<td>com.glide.monitor.round_robin_database</td>
</tr>
<tr>
<td>com.glide.dev_studio</td>
<td>Allows developers to add and update application files.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.code_search, com.sn_appcreator</td>
</tr>
<tr>
<td>com.glide.notification_administration</td>
<td>Subscriptions Administration Base</td>
<td>Active</td>
<td>false</td>
<td>com.glide.subscription_framework</td>
</tr>
<tr>
<td>com.glide.notification_based_notifications</td>
<td>Enables users to subscribe to notifications on a task or CI without being on the watchlist or being one of the assigned users.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui_policy, com.glide.email_notification</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependence</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notification.subscription</td>
<td>Improved subscription model - improved and simplified.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.notification</td>
</tr>
<tr>
<td>glide.subscription_framework</td>
<td>Management and Enforcement Framework</td>
<td>Active</td>
<td>false</td>
<td>com.glide.usageanalytics</td>
</tr>
<tr>
<td>snc.activity_subscriptions</td>
<td>This plugin provides a generic set of artifacts to handle subscriptions for any defined subscribable object. Any entity can be defined as a subscribable object and a set of subscribers can subscribe to the objects. When an event occurs related to the subscribable object, activities can be tracked and subscribers can be notified.</td>
<td>Inactive</td>
<td>true</td>
<td>com.glide.notification</td>
</tr>
<tr>
<td>glide.survey_designer</td>
<td>Survey designer</td>
<td>Active</td>
<td>false</td>
<td>com.glide.assessment_designer, com.glide.assessment_designer.common</td>
</tr>
<tr>
<td>glide.syntax_editor</td>
<td>Syntax editor</td>
<td>Active</td>
<td>false</td>
<td>com.glide.snc_code_editor</td>
</tr>
<tr>
<td>glide.system_import_set_picker</td>
<td>Allows users to choose an update set for tracking customizations.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.system_import_set, com.glide.system_update_set_picker</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin ID</th>
<th>Description</th>
<th>State</th>
<th>Has Demo Data?</th>
<th>Dependence</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.system_update_set_preview</td>
<td>All update set preview the changes that are performed by an update set and predict whether there will be any collisions in attempting to apply the update set.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.system_update_set_preview, com.glide.system_update_set_picker, com.glide.system_update_set_preview</td>
</tr>
<tr>
<td>com.glide.web_service_application</td>
<td>Provides a series of web service import sets.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.web_service_provider, com.glide.web_service_import_sets, com.snc.web_service_import_set_tables</td>
</tr>
<tr>
<td>com.sn_publications</td>
<td>Provides a way to publish and send out newsletter like articles to targeted internal/external customers.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.cs_base</td>
</tr>
<tr>
<td>com.snc.publications.demo_data</td>
<td>Provides demo application demo data.</td>
<td>Inactive</td>
<td>true</td>
<td>com.sn_publications</td>
</tr>
<tr>
<td>com.snc.task_activities</td>
<td>Enables support for activities on task tables.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.snc.task_outage_relationship</td>
<td>Enables users to create an outage from an Incident and a Problem form. Incidents and problems have a many-to-many relationship with outages.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-----------</td>
<td>----</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
</tr>
<tr>
<td>Team Development</td>
<td>com.snc.apps</td>
<td>Supports parallel development on multiple, non-production ServiceNow instances by providing branching operations, the ability to compare a development instance to other development instances, and a central dashboard for all team development activities.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Test Management</td>
<td>com.snc.test.management</td>
<td>Provides a tool for manual software testing.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Text Index Attachments</td>
<td>com.glide.text_index_attachments</td>
<td>Text Index Attachments - natural language search using Lucene syntax</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Test Search</td>
<td>com.glide.text_search</td>
<td>Text Searching across multiple tables</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Threat Feeds (New in Jakarta)</td>
<td>com.snc.threat.feeds</td>
<td>Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Threat Intelligence</td>
<td>com.snc.threat</td>
<td>Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Threat Intelligence Sharing Client (New in Jakarta)</td>
<td>com.snc.intel_sharing.client</td>
<td>Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
</tr>
<tr>
<td>Time Card Management</td>
<td>com.snc.time_card_management</td>
<td>Works with the Task table to record time worked on projects, incidents, problems, and change requests. Task assignees can record time worked in the Time worked field on a task record or enter hours directly onto a time card.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>com.snc.wm_time_recording</td>
<td>Extends the functionality of the Time Card Management and Cost Management applications to Field Service Management. Field service agents record time worked on tasks and other activities. These time worked entries automatically create time cards and weekly time sheets. Managers can review and approve time sheets as well as view and create labor rate cards.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.work_management, com.snc.time_card, com.snc.cost_management</td>
</tr>
<tr>
<td>com.snc.timeline_visualization</td>
<td>Enables graphical representation of activities over time to provide a high-level view of strategic and operational activities in your organization such as incidents, problems, changes, and projects. A base system visualization provided by this plugin is the CIO Roadmap. This roadmap shows projects grouped by portfolios. Organization leaders can use the CIO roadmap to monitor and evaluate the status of current and upcoming projects.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.project_management_v3</td>
</tr>
<tr>
<td>com.glide.tiny_url</td>
<td>Enables support for generating shortened URLs to eliminate problems with very long URLs in Internet Explorer. New properties will be added to the System properties page.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.editor.tinymce</td>
<td>Enables users to edit HTML fields with the TinyMCE editor instead of the legacy (htmlArea) editor.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>com.glide.transaction_scope</td>
<td>Handles design scope management.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Transaction Quotas</td>
<td>Allows definition of quota policies for different types of transactions. A transaction quota cancels any transaction in violation of the policy and notifies the user of the cancellation.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Tree map</td>
<td>Enables support for treemap view on any applications.</td>
<td>Inactive</td>
<td>false</td>
<td>com.snc.pd</td>
</tr>
<tr>
<td>UI Common</td>
<td>Glide UI Common</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>UI Components</td>
<td>Provides common angular components for apps.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.ng, com.glide.ui.angularui, com.glide.ui.heisenberg</td>
</tr>
<tr>
<td>UI 11 - Navpage layout with multiple panes</td>
<td>Layout in multiple resizable panes, bookmarks and flyouts</td>
<td>Active</td>
<td>false</td>
<td>com.glide.db_images</td>
</tr>
<tr>
<td>UI16</td>
<td>Enables UI16, a user interface that provides an updated look and usability improvements. Notable features include real-time form updates, user presence, a redesigned application navigator with tabs for favorites and history, and enhanced activity streams.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.ui.doctype, com.glide.ui.concourse, com.glide.ui.form_presenter, com.glide.ui.snippets</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>----------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Upgrade Blame Tool</td>
<td>Tracks the affected table records touched (insert/update/delete) by the load files during system upgrade, zboot, or plugin activation/upgrade. This plugin adds application modules to allow ServiceNow employees to access the upgrade blame log and to turn on/off the feature. It also adds security access control rules to prevent user from modifying the upgrade blame logs table.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>User Guide</td>
<td>Provides the ability to create end-user help documentation that is specific to the policies and procedures of your organization. A default help page is provided in the base system that displays UI16 help documents for system navigation and other basic operations.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>User Registration Request</td>
<td>Provides the ability for unregistered users to request access to a ServiceNow instance.</td>
<td>Inactive</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Vendor Performance</td>
<td>Provides the capabilities to measure, manage, and track vendor data and compare performance characteristics in unique graphical views.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.assessment_core</td>
</tr>
<tr>
<td>Vendor Ticketing</td>
<td>Provides expanded functionality to obtain vendor performance data by tracking vendor incidents and SLAs.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.service_portfolio, com.snc.service_portfolio.sla, com.snc.task_outage, com.snc.vendor_performance</td>
</tr>
<tr>
<td>Version Management</td>
<td>Provides the ability to track, compare, and revert to multiple versions of table records.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Version Support</td>
<td>Supports tracking versions of files that are stored in update sets, including the ability to compare and revert to previous versions.</td>
<td>Active</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
<td>Dependencies</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>VirusTotal Integration</td>
<td>Enables the VirusTotal scanner in Threat Intelligence. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.threat</td>
</tr>
<tr>
<td>Vulnerability Analytics</td>
<td>Provides an integration of Vulnerability Response with Performance Analytics for trend-based reporting. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.pa, com.snc.treemap, com.snc.vulnerability</td>
</tr>
<tr>
<td>Vulnerability Response</td>
<td>Allows security users to compare security data pulled from internal and external sources and, if CIs or software are found to be vulnerable, changes, problems, and security incidents can be created. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
<td>Inactive</td>
<td>true</td>
<td>com.snc.sam.core, com.snc.secoos.orchestration, com.snc.security_support</td>
</tr>
<tr>
<td>Web Service Consumer</td>
<td>Provides a SOAP Message module for developing, prototyping, and saving outbound SOAP messages that can be reused in business rules and scripts.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.vars, com.glideapp.ecc</td>
</tr>
<tr>
<td>Web Service Import Set Tables</td>
<td>Complements affected web services and scripted web services in providing a web service interface to import set tables.</td>
<td>Active</td>
<td>false</td>
<td>com.glide.web_service_import_sets, com.glide.web_service_application</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>Plugin Name</td>
<td>Description</td>
<td>State</td>
<td>Has Demo Data?</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------------</td>
<td>-------</td>
<td>----------------</td>
</tr>
<tr>
<td>Web Service Import Sets</td>
<td>com.glide.web_service_provider</td>
<td>Enables the use of web services and scripted web services in providing a web service interface to import sets.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Web Service Provider - Common</td>
<td>com.glide.web_service_provider</td>
<td>Provides the ability to create a scripted web service to accept any WSDL format.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Web Service Provider - Custom WSDL</td>
<td>com.glide.custom_web_service</td>
<td>Enables the ability to create web services that are not addressed by the system. Allows a user to define input and output parameters and use JavaScript to do everything in between.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>Web Service Provider - Scripted</td>
<td>com.glide.scripts_web_service</td>
<td>Enables the use of web services and SOAP message resources.</td>
<td>Active</td>
<td>false</td>
</tr>
<tr>
<td>WebKit HTML to PDF</td>
<td>com.snc.webkit_htp</td>
<td>Enables the instance to use the service WebKit HTML to PDF.</td>
<td>Inactive</td>
<td>false</td>
</tr>
<tr>
<td>Workflow Authoring Tools</td>
<td>com.glideapp.workflow_authoring</td>
<td>Allows you to define and modify workflows by arranging and connecting activities with transitions.</td>
<td>Active</td>
<td>true</td>
</tr>
<tr>
<td>Workflow Runtime Engine</td>
<td>com.glideapp.workflow_runtime_engine</td>
<td>Enables the creation of workflows that drive automated processes. This may entail generating tasks based on conditions, running scripts, generating approvals, or other actions. Satisfies the same need as the Execution Plans plugin but with greater control and an easier interface.</td>
<td>Active</td>
<td>false</td>
</tr>
</tbody>
</table>

**ServiceNow plugins**

Plugins are software components that provide specific features and functionalities within a ServiceNow instance.
How plugins are activated

Plugins may be added to the base platform in one of the following ways.

- Activated by default in the base ServiceNow system
- Activated by an admin user (not by default)
- Requested from ServiceNow before activating. This may be the case when a plugin is new, is appropriate for only certain deployments, and/or can only be activated by ServiceNow personnel.
- Plugins that are associated with a for-fee subscription to an application or suite can be activated only after your organization has purchased the subscription. See View the applications and plugins that are included with a subscription.

**Note:** After a plugin is active, you cannot disable or deactivate it. You can hide the functionality, if needed.

Relationships between plugins

Some plugins depend on other plugins being activated.

In some cases, a plugin cannot work at all unless one or more other plugins are installed. When you ask to activate a plugin in this category, the system notifies you of the dependencies before it completes the activation. If you ask to continue, the system automatically activates all the plugins required.

In some cases, the plugin works, but certain features that do not apply to your system are not installed. When you ask to activate a plugin in this category, the system notifies you of the dependencies before it completes the activation. If you ask to continue, the system activates the requested plugin but does not include the features that depend on other plugins.

Request a plugin

Some plugins must be activated by ServiceNow personnel. These plugins do not appear in the System Definition > Plugins list.

Role required: none

Request the plugin through the HI Service Portal.

1. In the HI Service Portal, click **Service Requests > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least 2 business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.
Reason/Comments

Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.

3. Click Submit.

Purchase a plugin

Some features require a separate subscription from the rest of the ServiceNow platform.

Role required: admin

To purchase a subscription, contact your ServiceNow account manager. In most cases, the account manager will arrange to have the plugin activated on your organization’s production and non-production instances, generally within a few days. In some cases, you can activate the plugin within the instance.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the feature on a non-production instance before purchase, follow the steps to activate a plugin. If the plugin is not listed in the System Definition > Plugins module, make a request through HI.

Available system properties

This page describes properties available to an instance.

Some properties are available on a system properties form, but some lesser-used properties are only available from the System Property (sys_properties) table. In some cases, the property does not exist in a base instance, but can be added if you need to change the value.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.attachment.max_size</td>
<td>Sets the maximum file attachment size in megabytes. Leave the field empty to allow attachments up to a maximum of 1GB.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1GB</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Security</td>
</tr>
<tr>
<td>com.glide.csv.loader.ignore_non_parseable_lines</td>
<td>Enables (true) or disables (false) ignoring one or more lines (rows) in an import set that contain bad data, such as a row that is missing a column of data.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.glide.csv.loader.max_errors_allowed</td>
<td>Sets the maximum number of lines (rows) that an import can ignore before failing. If the import succeeds, the import lists the number of rows ignored due to errors.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.glide.email.max_read</td>
<td>Specifies the maximum number of emails a POP3 reader should process concurrently.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.glide.loader.verify_target_field_size</td>
<td>Controls whether import set fields can automatically increase in size during an import (true) or not (false). By default, data that exceeds the import field size is truncated. Set this property to true to allow any import set field to increase the column size to match the length of the data.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.glide.soap.include_non_db_fields</td>
<td>Controls if non-database fields, such as the sys_tags field, are included in WSDLs and SOAP responses.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.glide.ssl.read.timeout</td>
<td>Sets the time-out value in seconds for SSL connections during read operations. Typically, this setting is used as part of LDAPS. If you enter timeout values for both this system property and the LDAP Read timeout field, the lowest timeout value takes precedence.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Value: pa,html,script,include scripts,glide,custprefix_sn</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.glideapp.canvas</td>
<td>Enables (true) or disables (false) responsive canvas for dashboards. When enabled, all new dashboards use responsive canvas. Nonresponsive dashboards are not converted to responsive dashboards.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.apps.publish.maxrows</td>
<td>Defines the maximum number of data records to include when publishing an application.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1,000</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.assessment.decision_matrix_filter_max_entries</td>
<td>Defines the maximum number of items to show for a decision matrix field filter.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1,000</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.assessment.signature_authentication</td>
<td>Requires authentication for a user signature.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.hr.core.impersonateCheck</td>
<td>Allows a user to have identical permissions/access as the person they are impersonating.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td></td>
<td>True - access and restrictions apply when impersonating another user.</td>
</tr>
<tr>
<td></td>
<td>False - user has identical permissions/access as the person they are impersonating.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.snc.iam.log_level</td>
<td>Logging level for the business rule MapUpstreamImpactedCI. Debug is the most detailed option with full trace of how the Impacted CI List is calculated. Error is the minimal logging option with only severe errors being logged.</td>
</tr>
</tbody>
</table>
|                                                    | - Type: string  
- Default value: info  
- Possible values: debug.info.error  
- Location: System Property (sys_properties) table |
| com.snc.on_call_rotation.reminders.showtz          | Specifies whether to show a user’s time zone                                                                                                                                                                                                                                                                                               |
|                                                    | - Type: true | false  
- Default value: false  
- Location: add to the System Property (sys_properties) table |
| com.snc.pa.dc.max_breakdown_elements_limit        | Maximum number of breakdown elements for a breakdown to be included in data collection.                                                                                                                                                                                                                                                     |
|                                                    | - Type: integer  
- Default value: 10000  
- Location: System Property (sys_properties) table |
| com.snc.pa.dc.max_error_count                     | Maximum errors that may occur before data collection is stopped.                                                                                                                                                                                                                                                                          |
|                                                    | - Type: integer  
- Default value: 500  
- Location: System Property (sys_properties) table |
| com.snc.pa.dc.max_records                         | Maximum number of records that are stored during a data collection.                                                                                                                                                                                                                                                                       |
|                                                    | - Type: integer  
- Default value: 5000  
- Location: System Property (sys_properties) table |
| com.snc.pa.dc.max_row_count_indicator_source      | Maximum number of rows that are allowed to be fetched from an Indicator Source.                                                                                                                                                                                                                                                            |
|                                                    | - Type: integer  
- Default value: 50000  
- Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.dc.script_timeout</td>
<td>Maximum time in seconds a script is allowed to run during a data collection cycle.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.project.default_schedule</td>
<td>Stores the sys_ID if the default schedule attached to projects.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.project.loglevel</td>
<td>Automatically resubmits timed-out Ajax requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: 0 (debugging disabled)</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.project.wbs_gantt</td>
<td>Automatically resubmits timed-out Ajax requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Project &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>com.snc.task.associate_ci</td>
<td>List of all the task types where user wants to associate CI's using a List system.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default change_request</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; All &gt;</td>
</tr>
<tr>
<td>com.snc.time_card.default_rate</td>
<td>(Cost Management plugin) Sets a default hourly rate to use if no labor rate cards apply to the user.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 50</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.time_worked.update_task_timer</td>
<td>Enables (true) or disabling (false) updating of the task timer value based on changes to the task time worked records. This is accomplished through the Update task time business rule.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>css.assessment.caption.background.color</td>
<td>Sets the background color of the caption on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default value: #eee</td>
</tr>
<tr>
<td></td>
<td>- Location:</td>
</tr>
<tr>
<td></td>
<td>- Assessments &gt; Admin &gt; Assessment Properties</td>
</tr>
<tr>
<td></td>
<td>- Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>css.assessment.caption.font.color</td>
<td>Sets the font color of the caption text on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default value: #ffffff</td>
</tr>
<tr>
<td></td>
<td>- Location:</td>
</tr>
<tr>
<td></td>
<td>- Assessments &gt; Admin &gt; Assessment Properties</td>
</tr>
<tr>
<td></td>
<td>- Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>css.assessment.question.header.background.color</td>
<td>Sets the background color of question headers on assessment and survey questionnaires.</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default value: #767676</td>
</tr>
<tr>
<td></td>
<td>- Location:</td>
</tr>
<tr>
<td></td>
<td>- Assessments &gt; Admin &gt; Assessment Properties</td>
</tr>
<tr>
<td></td>
<td>- Survey Management &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>css.$nav-highlight-main</td>
<td>Sets the color for the navigation expanded items highlight background</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default Value: #3D4853</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$nav-hr-color</td>
<td>Sets the color for the navigation separator</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default Value: #303A46</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-header-bg</td>
<td>Sets the color for the header background</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default Value: #303A46</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>css.$navpage-header-color</td>
<td>Sets the color for the banner text</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #FFFFFF</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-nav-bg-sub</td>
<td>Sets the color for the background for navigator and sidebars</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #455464</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-nav-border</td>
<td>Sets the color for the border for UI16</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #DDD</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-nav-color-sub</td>
<td>Sets the color for module text in UI16</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #BEC1C6</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-nav-selected-bg</td>
<td>Sets the color for navigator selected tab background</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #4B545F</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.$navpage-nav-selected-color</td>
<td>Sets the color for the currently selected navigation tab icon color for UI16</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default Value: #FFFFFF</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>css.tablet.gradient.start</td>
<td>Start color of the gradient for the tablet UI header.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: #666</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Tablet UI Properties</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>css.tablet.gradient.end</td>
<td>End color of the gradient for the tablet UI header.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: #111</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Tablet UI Properties</strong></td>
</tr>
<tr>
<td>css.tablet.headerfooter.text.color</td>
<td>Color of the text and icons in the tablet UI header and footer.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: lightgrey</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Tablet UI Properties</strong></td>
</tr>
<tr>
<td>glide.allow.new.cert_follow_on_task</td>
<td>Allow Desired State audit to create a new follow-on task for the same failure, at each audit run.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.apps.hub.current</td>
<td>URL of the team development parent instance.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.attachment.extensions</td>
<td>Comma-separated list of file extensions that can be attached. No value means there are no restrictions.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Security</strong></td>
</tr>
<tr>
<td>glide.attachment.role</td>
<td>Comma-separated list of roles that can create attachments.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: public</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Security</strong></td>
</tr>
<tr>
<td>glide.authenticate.multisso.login_locate.user_field</td>
<td>Identifies a common login identifier.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: user_name</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.authenticate.sso.saml2.require_signed_authnrequest | Enables the Identity Provider's Single sign on service to receive a signed AuthnRequest  
• Type: true | false  
• Default value: false  
• Location: System Property (sys_properties) table |
| glide.banner.image.url              | URL used when clicking the banner image.  
• Type: string  
• Default value: home.do  
• Location: System Property (sys_properties) table |
| glide.banner.image.url_target       | Target frame used when clicking the banner image. Use gsft_main for the main frame, _top to replace the current browser window, _blank for a new window or tab.  
• Type: string  
• Default value: gsft_main  
• Location: System Property (sys_properties) table |
| glide.businessrule.async_condition_check | Specifies if the instance checks the condition statement of async business rules (the When field is set to async) prior to running the business rule. If this property is set to true, the instance evaluates the async business rule conditions a second time before running the rule. If this property is set to false or missing, the instance does not evaluate the conditions a second time.  
• Type: true | false  
• Default value: false  
• Location: add to the System Property (sys_properties) table |
| glide.businessrule.callstack        | Determines whether business rule executions are logged in the daily log when they start and finish (true) or are not logged (false). Logging is useful for troubleshooting a problem where you need to know which business rules are running and in which order.  
• Type: true | false  
• Default value: false  
• Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.canvas.grid.widget_performance_threshold</td>
<td>Defines the maximum number of seconds for a widget to render on a dashboard. Widgets that exceed this time are not rendered and a warning message displays. Users can click to restart rendering. Stopping widgets that render slowly enables faster widgets to load, and increases the speed of dashboard loading.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This system property applies to responsive dashboards only.</td>
</tr>
</tbody>
</table>
|                                                                     | - Type: integer  
- Default value: none  
- Location: add to the System Property (sys_properties) table                                                                                                                                               |
| glide.canvas.grid.widget_render_concurrent_max                      | Defines the maximum number of widgets that can render simultaneously on a dashboard. With smaller values, individual widgets load more quickly. With larger values, fewer Ajax requests to the server are needed. Set the value of this property to half of the number of widgets that are visible when your most-used dashboard loads. For example, if six widgets are visible on the dashboard set the value to 3. |
|                                                                     | **Note:** This system property applies to responsive dashboards only.                                                                                                                                                      |
|                                                                     | Two is the minimum value, and 1 is interpreted as 2. For values of zero or lower, all widgets load simultaneously.                                                                                                         |
|                                                                     | - Type: integer  
- Default value: none  
- Location: add to the System Property (sys_properties) table                                                                                                                                               |
| glide.chart.decimal.precision                                       | Controls the rounding precision of non-currency numeric values displayed on reports. This property has a maximum possible value of 4. A **Decimal Precision** value specified in a report's style options overrides this property. Currency values always have a precision of 2.              |
|                                                                     | - Type: integer  
- Default value: 2  
- Location: add to the System Property (sys_properties) table                                                                                                                                               |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.chat.invite_fields</td>
<td>(Chat plugin) Comma-separated list of fields (glide_list or references to sys_user or sys_group) used to generate the invitations when creating a chat room from a task. Users can select a check box for each of the specified fields to invite users referenced by the fields to the chat room.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: Social IT &gt; Chat Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.chat_room.create_roles</td>
<td>(Chat plugin) Comma-separated list of roles that are allowed to create chat rooms.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: Social IT &gt; Chat Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.chat.show_emoticons</td>
<td>(Chat plugin) Enables or disables rendering text emoticons as images.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Location: Social IT &gt; Chat Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.cmdb_model.display_name.shorten</td>
<td>When set to true, generates shorter display names for product models if the name of the product model contains the manufacturer name.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: false</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.cookies.http_only</td>
<td>Enables (true) or disables (false) the generation of HTTP only cookies. Set this property to <code>false</code> to use Approval with E-Signature.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.cost_mgmt.calc_actual_cost</td>
<td>(Cost Management plugin) Sums all task expense lines and adds the total to the <code>Work cost</code> field on the task record when an expense line is created for any task with a <code>Type</code> of <code>Planned task</code>.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.cost_mgm.debug</td>
<td>(Cost Management plugin) Enables debugging of cost management processing. All logging events are recorded in the Financial Management Log (fm_log) table. This feature should only be enabled during initial testing or when troubleshooting because it can generate a large number of log records.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.cost_mgm.process_task_cis</td>
<td>(Cost Management plugin) Creates expense lines to affected configuration items when creating a task expense line.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.cost_mgm.service_allocation.method</td>
<td>(Cost Management plugin) Defines whether business service to cost center allocation costs should be calculated based on total units or allocated units.</td>
</tr>
<tr>
<td></td>
<td>- Type: choice list</td>
</tr>
<tr>
<td></td>
<td>- Default value: all_units</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.csv.export.line_break</td>
<td>Enables the user to control how exported CSV data appears in Notepad. Valid values are LF for a line feed between records and CRLF for a carriage return followed by a line feed.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: LF</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.custom.ip.authenticate.allow</td>
<td>Comma-separated list or range of IP addresses that are allowed access to view the stats.do, threads.do, and replication.do pages.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: none</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.db.clone.allow_clone_target</td>
<td>Enables (true) or disables (false) use of a non-production instance as the target for a system clone.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false for production instances, true for non-production instances</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.db.impex.XMLLoader.max.file.size.mb</td>
<td>Controls the maximum file size allowed when importing an XML file, in megabytes. Attempting to import an XML file larger than this limit results in an error.</td>
</tr>
<tr>
<td></td>
<td>Warning: Use caution when modifying this property. Uploading a very large XML file may impact performance and can cause an instance outage.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 100</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Import Export</td>
</tr>
<tr>
<td>glide.db.large.threshold</td>
<td>Sets the number of rows above which a table is considered large and uses a different method of querying for results. When this property is absent, the instance uses the default query method.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: none</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.db.max.aggregate.size</td>
<td>Sets the maximum number of groups a grouped report or list renders. Larger values may affect system performance.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 100</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.db.max_view_records</td>
<td>Sets the maximum number of records returned when running a GlideRecord query in a script. Values larger than the default are not recommended as they may cause queries to consume excessive memory on the application server and can, in extreme cases, cause a system outage. This property does not control the maximum number of records that appear in a list, report, or exported file.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 10000</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.db.audit.ignore.delete</td>
<td>Specifies the tables where the sys_audit_delete file is not updated when records are deleted.</td>
</tr>
</tbody>
</table>
|                                           | * Type: string - a comma-separated list of tables  
* Location: System Property (sys_properties) table                                                                                                                                                       |
| glide.discovery.application_mapping       | Enables or disables the Application Dependency Mapping (ADM) feature.                                                                                                                                       |
|                                           | * Type: string  
* Default value: true  
* Location: add to the System Property (sys_properties) table                                                                                                                                          |
| glide.discovery.log_message_chars        | Specify the maximum length a log message can be before ServiceNow creates a preview for it in the list view. When a log message is longer than this value, ServiceNow creates a preview of the message with an ellipsis at the end of the message to indicate that there is content that is not shown. The preview size prevents any one list row from taking up the entire screen. |
|                                           | * Type: integer  
* Default value: 200 (Characters)  
* Location: Discovery Definition > Properties                                                                                                                                                       |
| glide.discovery.use_cmdb_identifiers     | Controls whether Discovery uses the CMDB Identification and Reconciliation Framework, introduced with the Geneva release, or the legacy identifiers from previous releases.                                             |
|                                           | * Type: true|false  
* Default value: true  
* Location: Discovery Definition > Properties                                                                                                                                                       |
| glide.domain.notify_change               | Displays a notification message telling the user that the domain picker automatically changed                                                                                                                |
|                                           | * Type: true|false  
* Default value: true  
* Location: add to the System Property (sys_properties) table                                                                                                                                          |
| glide.domain.notify_record_change        | Displays a notification message telling the user that the domain picker automatically changed because the record that the user is viewing changed the domain in which the user is in.                              |
|                                           | * Type: true|false  
* Default value: false  
* Location: add to the System Property (sys_properties) table                                                                                                                                         |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ecmdb.all_relationship_role</td>
<td>An example value is: itil,asset,configuration.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: none</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email.append.timezone</td>
<td>Specifies whether to append the time zone to all dates and times in outbound</td>
</tr>
<tr>
<td></td>
<td>emails.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.email.forward_subject_prefix</td>
<td>Specifies the list of prefixes (comma-separated) in the subject line that</td>
</tr>
<tr>
<td></td>
<td>identify a forwarded email.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: fw:,fwd:</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email.journal.lines</td>
<td>Specifies the number of entries from a journal field (such as Additional</td>
</tr>
<tr>
<td></td>
<td>comments and Work notes) included in email notifications. A value of</td>
</tr>
<tr>
<td></td>
<td>-1 includes all journal entries.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 3</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.email.mail_to</td>
<td>Specifies the email address to send notifications that use the ${mailto:}</td>
</tr>
<tr>
<td></td>
<td>variable.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: SMTP email address that is active by default</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email.name_split</td>
<td>Delimiter between first and last name in an email address to identify users</td>
</tr>
<tr>
<td></td>
<td>from incoming emails. For example, a delimiter of '. ' (period) in the</td>
</tr>
<tr>
<td></td>
<td>email address <a href="mailto:john.smith@company.com">john.smith@company.com</a> tells the system to look for a</td>
</tr>
<tr>
<td></td>
<td>user record for John Smith.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: period(.)</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.email.notification.save_when_no_recipients | Controls whether a notification-generated sys_mail record is saved even if there are no recipients. Used in conjunction with other notification recipient logging properties, this property enables troubleshooting problems with notifications.  
  - Type: true | false  
  - Default value: true  
  - Location: add to the System Property (sys_properties) table |
| glide.email.override.url                  | Sets the URL to use in emailed links in place of the instance URL. The URL should end with nav_to.do. An example value is: https://servicenow.customerdomain.com/production/nav_to.do.  
  - Type: string  
  - Default value: Instance URL  
  - Location: add to the System Property (sys_properties) table |
| glide.email.read.active                   | Specifies whether to enable or disable the inbound mail server.  
  - Type: true | false  
  - Default value: true  
  - Location: System Properties > Email |
| glide.email.reply_subject_prefix          | Specifies the list of prefixes (comma-separated) in the subject line that identify an email reply.  
  - Type: string  
  - Default value: re:aw:,r:  
  - Location: add to the System Property (sys_properties) table |
| glide.email.smtp.active                   | Specifies whether to enable or disable the outgoing mail server.  
  - Type: true | false  
  - Default value: true  
  - Location: System Properties > Email |
| glide.email.smtp.max_recipients           | Specifies the maximum number of recipients the instance can list in the To: line for a single email notification. Notifications that would exceed this limit instead create duplicate email notifications addressed to a subset of the recipient list. Each email notification has the same maximum number of recipients.  
  - Type: integer  
  - Default value: 100  
  - Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.email.smtp.max_send</td>
<td>Specifies how many emails to send through each new SMTP connection. The instance establishes a new SMTP connection if there are more emails to send than the specified value.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 100</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email.test.user</td>
<td>Specifies the comma-separated list of email addresses to which the instance sends all email messages. Typically used in non-production instances for testing purposes.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: none</td>
</tr>
<tr>
<td></td>
<td>- Location: [System Properties &gt; Email]</td>
</tr>
<tr>
<td>glide.email.text_plain.strip_xhtml</td>
<td>Indicates whether both outbound and inbound emails that are shown in comments convert the XML to plain text (true) or preserve the XML (false).</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email.watermark.visible</td>
<td>Indicates whether the watermark in email notifications is visible (true) or is wrapped in a hidden div tag (false).</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.email_client.show_sms_option</td>
<td>Specify whether a check box appears in the email client for sending the message to the user's SMS device. If no SMS device exists, the email client sends the message to the primary email device.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.excel.max_cells</td>
<td>Sets the maximum number of cells in an Excel export.</td>
</tr>
</tbody>
</table>
|                                     |  - Type: integer  
  - Default value: 500000  
  - Location: add to the System Property (sys_properties) table                                                                                                                                         |
| glide.excel.use_user_date_format    | Determines whether Excel exports use the date/time format specified in a user’s profile (true). If false, exports the instance date/time format defined by the glide.sys.date_format property.                                   |
|                                     |  - Type: true | false  
  - Default value: false  
  - Location: add to the System Property (sys_properties) table                                                                                                                                         |
| glide.export.csv.charset            | Specify the character set used to export CSV files. See Supported Character Encodings for a list of supported character encoding options.                                                                 |
|                                     |  - Type: string  
  - Default value: windows-1252  
  - Location: add to the System Property (sys_properties) table                                                                                                                                         |
| glide.export.csv.raw.value          | When true, raw database values are exported instead of the display values when you export to CSV. When false, display values are exported instead.                                                                 |
|                                     |  - Type: true | false  
  - Default value: false  
  - Location: System Properties > Import Export                                                                                                                                                    |
| glide.export.escape_formulas        | When true, string values that start with the characters +, -, =, or @ are prepended with a single apostrophe when you export to CSV, XLS, or XLSX files.                                                                 |
|                                     |  - Type: true | false  
  - Default value: true for new instances starting with Istanbul  
  - Location: System Property (sys_properties) table for new instances starting with Istanbul. For upgraded instances, add to the System Property table.                           |
| glide.export.excel.wrap_cells       | When true, values in cells in exported Excel files are wrapped automatically. When false, the width of exported Excel columns is resized to fit 256 characters and values are not wrapped.                          |
|                                     |  - Type: true | false  
  - Default value: true  
  - Location: Add the property                                                                                               |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.export.force_ui_list_behavior</td>
<td>When true, journal fields such as worknotes and comments are not included when you export records. When false, these fields are included.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.glidesoap.proxy_host</td>
<td>Specify the proxy server hostname or IP address for SOAP clients.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: value of glide.http.proxy_host</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.glidesoap.proxy_port</td>
<td>Specify the port number for the proxy server for SOAP clients.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: value of glide.http.proxy_port</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.help.default.page</td>
<td>Sets the overall help URL for the system if you are using context-sensitive help. This URL is used when there is not any context-sensitive help available for the form, list, or record.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: <a href="http://wiki.servicenow.com/">http://wiki.servicenow.com/</a></td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.history.max_entries</td>
<td>Sets the number of characters to display as a preview of journal input fields.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 250</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.home.page</td>
<td>Determines which page to load when a user selects a homepage from the banner.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: home_splash.do? sysparm_direct=true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| glide.home.refresh_disabled | Determines whether homepage refresh is disabled (true) or enabled (false).  
  - Type: true | false  
  - Default value: false  
  - Location: add to the System Property (sys_properties) table |
| glide.home.refresh_intervals | Comma-separated list of refresh intervals available on homepages.  
  - Type: string  
  - Default value: 300,900,1800,3600  
  - Location: add to the System Property (sys_properties) table |
| glide.html.escape_script     | Determines whether JavaScript tags are enabled (true) or disabled (false) in HTML fields.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property (sys_properties) table |
| glide.html.sanitize_all_fields | Determines whether all HTML fields are sanitized to remove unwanted code.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property (sys_properties) table |
| glide.http.connection_timeout | Specify the maximum number of milliseconds an outbound HTTP request (such as Web Services) will wait to establish a connection.  
  - Type: integer  
  - Default value: 10000 (10 seconds)  
  - Location: System Property (sys_properties) table |
| glide.http.proxy_bypass_list | Specify the semicolon-separated list of addresses that bypass the proxy server. Use an asterisk as a wildcard character to specify all or part of an address.  
  - Type: string  
  - Default value: none  
  - Location: System Property (sys_properties) table |
| glide.http.proxy_host       | Specify the proxy server hostname or IP address  
  - Type: string  
  - Default value: none  
  - Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.http.proxy_ntdomain</td>
<td>Specify the domain used to authenticate the proxy server with NTLM authentication.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_nthost</td>
<td>Specify the hostname used to authenticate the proxy server with NTLM authentication.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_ntpassword</td>
<td>Specify the password used to authenticate the proxy server with NTLM authentication.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_ntusername</td>
<td>Specify the username used to authenticate the proxy server with NTLM authentication.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_port</td>
<td>Specify the port number for the proxy server</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_password</td>
<td>Specify the password used to authenticate the proxy server.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.http.proxy_username</td>
<td>Specify the username used to authenticate the proxy server.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| glide.http.timeout | (Web Service Consumer Plugin) Specifies the maximum number of milliseconds to wait before an outbound transaction times out.  
- Type: integer  
- Default value: 175000 (175 seconds)  
- Location: add to the System Property (sys_properties) table |
| glide.i18n.force_index | Specifies that all translated fields are indexed regardless of the value of the table attribute text_index_translations.  
- Type: true | false  
- Default value: true |
| glide.image_provider.security_enabled | Controls the security settings for images. If true, images are visible only to authenticated and authorized users. If false, images are visible to anyone with a URL to the attachment.  
- Type: true | false  
- Default value:  
  - New/zbooted instances: property is present and set to true  
  - Upgraded instances: false if property is not present, unchanged if property is present  
- Location: Add the property to the System Property (sys_properties) table |
| glide.imap.secure | Specifies whether to enable SSL encryption for connections to the IMAP server.  
- Type: true | false  
- Default value: false  
- Location: add to the System Property (sys_properties) table |
| glide.imap.secure_port | Specifies the communications port for IMAP secure connections.  
- Type: string  
- Default value: 995  
- Location: add to the System Property (sys_properties) table |
| glide.imap.tls | Specifies whether to start the IMAP server in Transport Layer Security (TLS) mode.  
- Type: true | false  
- Default value: false  
- Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.import.debug</td>
<td>Enables debug logging for all import processes.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import.error_message.generic</td>
<td>When true, failed imports display a generic error instead of a verbose SQL message. Enabling this property is highly recommended.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true for new instances starting with Istanbul, false for upgraded instances</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import.sftp.debug</td>
<td>Enables additional debug logging for SFTP imports. Enabling this property causes the instance to log all outgoing and incoming messages during the SSH session.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import.scp.debug</td>
<td>Enables additional debug logging for SCP imports. Enabling this property causes the instance to log all outgoing and incoming messages during the SSH session.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import_set.preserve.leading.spaces</td>
<td>Specifies whether the import process preserves leading spaces in Excel data cells. When false, the import process removes leading spaces from Excel data cells. When true, the import process preserves leading spaces.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.import_set_row.dynamically_add_fields               | Specifies whether an import set can add new columns to the staging table (true) or not (false). Instances that contain large numbers of import sets can sometimes become unresponsive when an import adds a column because the instance must alter every row in the staging table. In some cases, the database alter table action causes an outage. Setting this property to false prevents an import set from adding columns to the staging table and produces a log message. As a workaround, administrators can manually add a column to the staging table by creating a new dictionary entry and then reimporting the import set.  
  - Type: true | false  
  - Default value: false  
  - Location: add to the System Property (sys_properties) table |  |
| glide.ir.query_method                                     | Sets the query method for global text search. Only the Simple query method is supported.  
  - Type: choice list  
  - Default value: simple  
  - Location: System Properties > Global Text Search |  |
| glide.integration.session_timeout                          | Length of time, in minutes, that an inactive integration session is maintained before the session times out.  
  - Type: integer  
  - Default value: 1  
  - Location: add to the System Property (sys_properties) table |  |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.invalid_query.returns_no_rows | Controls how invalid GlideRecord queries are handled. When this property is true, invalid queries always return no rows. When this property is false (default), if a query is incorrect, such as by including an invalid field name, the invalid part of the query condition is ignored and results are based on the valid part of the query. To override this logic at the session level, execute `gs.getSession().setStrictQuery(false)` To restore strict query, execute `gs.getSession().setStrictQuery(true)`. To use this property, change the line `gr.addQuery('table', arguments.length == 1 ? record.getRecordClassName() : tableName);` in the Workflow script include to `gr.addQuery('table', (tableName) ? tableName : record.getRecordClassName() );`. Type: true | false  
Default value: false  
Location: add to the System Property (sys_properties) table |
| glide.itil.assign.number.on.insert | Controls whether a task number is generated and assigned on load (Create New) or on submit of the task. This feature helps prevent unused task numbers. Type: true  
Default value: false  
Location: System Property (sys_properties) table |
| glide.jdbcprobeloader.retry | Sets the number of times a JDBC probe attempts to connect to a JDBC data source. Type: integer  
Default value: 60  
Location: add to the System Property (sys_properties) table |
| glide.jdbcprobeloader.retryMillis | Sets the number of milliseconds a JDBC probe waits between retry attempts to a JDBC data source. Type: integer  
Default value: 5000  
Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.knowman.search.apply_role_based_security | When set to true, honors read access of knowledge bases or articles specified for roles. When set to false, enables specified user criteria to override read access specified for roles.  
  - Type: true | false  
  - Default value: true  
  - Location: Add the property to the System Property (sys_properties) table.                                                                                                                                                                                                                                                          |
| glide.knowman.search_character_limit          | Minimum number of characters required for knowledge search. Search terms with fewer than this number of characters return no results.  
  - Type: integer  
  - Default value: 3  
  - Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                                                                         |
| glide.knowman.search.default_language        | (Knowledge Management Internationalization Plugin v2) Default language for knowledge articles. If empty, defaults to the logged in user language.  
  - Type: string  
  - Default value: empty  
  - Location: System Property (sys_properties) table                                                                                                                                                                                                                                                                               |
| glide.knowman.show_language_option           | (Knowledge Management Internationalization Plugin v2) Determines whether the Language box appears (true) or is hidden (false) on articles with multiple translations.  
  - Type: true | false  
  - Default value: false  
  - Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                                                                         |
| glide.knowman.show_language_option.roles     | (Knowledge Management Internationalization Plugin v2) Comma-separated list of roles that can see the Language box on articles with multiple translations.  
  - Type: string  
  - Default value: none  
  - Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                                                                         |
| glide.knowman.show_links                     | Determines whether the Link line appears (true) or is hidden (false) in a knowledge article.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property (sys_properties) table                                                                                                                                                                                                                                                                               |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ldap.allow_empty_group | Determines whether all members can be removed from an Active Directory security group.                                                                                                           | Type: true | false  
  Default value: true  
  Location: add to the System Property (sys_properties) table.                                                                                                                                                                                                                                                                                        |
| glide.ldap.binary_attributes | Comma-separated list of LDAP attributes that should be converted from binary format to encoded64 strings. If you set this property, only the values listed are converted. The most common attributes are objectGUID and objectSID. These converted values are unique and can be used as the coalesce field on the LDAP import mapping. If this property is blank, ServiceNow tries to map these binary attributes without the conversion and they are not guaranteed to be unique since they are not properly converted to string values. | Type: string  
  Default value: objectsid,objectguid  
  Location: System Property (sys_properties) table |
| glide.ldap.paging           | Enables (true) or disables (false) LDAP paging query support. LDAP paging is a more efficient LDAP querying method for environments with more than 1000 users.                                                                                                           | Type: true | false  
  Default value: true  
  Location: System Property (sys_properties) table.                                                                                                                                                                                                                                                                                        |
| glide.legacy.excel.export   | Enables (true) or disables (false) exporting to XLS format when exporting to an Excel file. By default, only XLSX export is enabled. This property does not affect the Excel web service. When true, this property also allows users to select XLS or XLSX as the Easy Import template format.                                                                                                           | Type: true | false  
  Default value: false  
  Location: add to the System Property (sys_properties) table.                                                                                                                                                                                                                                                                                        |
| glide.list.filter_max_length| Sets a maximum character limit for the condition builder query.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 | Type: integer  
  Default value: 0  
  Location: add to the System Property (sys_properties) table.                                                                                           |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.live_feed.company_feed_exclude_groups</td>
<td>Controls whether messages posted to a public group appear (true) or are omitted (false) on the Company Feed.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.live_services</td>
<td>(Chat plugin) Enables (true) or disables (false) Live Services, such as chat support.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.login.no_blank_password</td>
<td>Prevents (true) or allows (false) logins from users with blank passwords. Often, importing lists of users creates a large number of users with blank passwords. By default, this property is set to true on production instances.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.login.home</td>
<td>Sets the default homepage users see after login. If blank, the last page visited is used. The format is &lt;page&gt;.do</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: home.do</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.max_journal_list_size</td>
<td>Sets the maximum size, in megabytes, of journal input fields.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 10</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging</td>
<td>Master switch to enable/disable logging all reasons a recipient was included. If false, no include logging is performed.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| glide.notification.recipient.exclude_logging | Master switch to enable/disable logging all reasons a recipient was excluded. If false, no exclude logging is performed.  
- Type: true | false  
- Default value: true  
- Location: add to the System Property (sys_properties) table |
| glide.notification.recipient.exclude_logging.device_inactive | Logs recipients who are excluded because their chosen notification device record is marked as inactive.  
- Type: true | false  
- Default value: true  

The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.exclude_logging.device_schedule | Logs recipients excluded because the chosen notification device record’s schedule field excludes it.  
- Type: true | false  
- Default value: true  

The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.exclude_logging.event_creator | Logs recipients who are excluded because they initiated the notification event, such as updating an incident record, and the Send to Event Creator check box is cleared on the notification record.  
- Type: true | false  
- Default value: true  

The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.exclude_logging.invalid_email | Logs recipients who are excluded because the email address for that user is invalid, for example the @ is missing, or empty.  
- Type: true | false  
- Default value: true  

The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.notification.recipient.exclude_logging.user_calendar_integration_disabled | Logs recipients who are excluded because the Calendar Integration field is set to None on the user record.  
- Type: true | false  
- Default value: true  
The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.exclude_logging.user_inactive | Logs recipients who are excluded because the Active check box is cleared on the user record.  
- Type: true | false  
- Default value: true  
The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.exclude_logging.user_notification_disabled | Logs recipients who are excluded because the Notification field is set to Disabled on the user record.  
- Type: true | false  
- Default value: true  
The glide.notification.recipient.exclude_logging property in the System Properties > Email module must be enabled to modify this property. |
| glide.notification.recipient.include_logging | Enables or disables logging all reasons a recipient was included. This property is a master switch. If it is set to true, the subsequent properties dealing with the inclusion of logging are enabled. If it is set to false, none of the subsequent properties relating to the inclusion of logging are enabled. |
| glide.notification.recipient.include_logging.delegate | Logs recipients who are included because they are delegates of another user.  
- Type: true | false  
- Default value: true  
The glide.notification.recipient.include_logging property in the System Properties > Email module must be enabled to modify this property. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.notification.recipient.include_logging.event_parm1</td>
<td>Logs recipients who are included because they are in the parm1 or parm2 fields of the event record.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.recipient_fields</td>
<td>Logs recipients who are included via a notification target record, such as an incident record, specified in the Users/Groups in Field field for the notification record. The recipient_fields are fields in the target record that contain a recipient to add. For example, if the record that triggered the notification is an incident, and the assigned_to field for the incident is listed in recipient_fields, that user is included as a recipient.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.recipient_groups.group_email</td>
<td>Logs recipients who are included in a group email for any group provided in the notification record’s recipient_groups or the event parm1 or parm2 field.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.recipient_groups.manager</td>
<td>Logs recipients who are included because they manage any group provided in the notification record’s recipient_groups or the event parm1 or parm2 field.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.recipient_groups.membership</td>
<td>Logs recipients who are included via membership in any group provided in the notification record recipient_groups or the event parm1 or parm2 field.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.recipient_users</td>
<td>Logs recipients who are included via notification record's Users field (recipient_users).</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.notification.recipient.include_logging.subscription</td>
<td>Logs recipients because they are subscribed via User Notification Preferences.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>The glide.notification.recipient.include_logging property in the System Properties &gt; Email module must be enabled to modify this property.</td>
</tr>
<tr>
<td>glide.pdf_export_from_form_list.show_report_attrs</td>
<td>Enables or disable displaying the PDF page header for all PDFs generated from a list.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.pdf.max_rows</td>
<td>Sets the maximum number of rows in an exported PDF file.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.pdf.font.size</td>
<td>Sets the font size for exported PDF files.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 8</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.pg.any_rejection_rejects</td>
<td>Controls the default process guide rejection handling. If this property is set to true, the first rejection rejects the entity. If false, all users must reject the approval.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.phone_number_e164.allow_national_entry</td>
<td>Determines whether users can enter phone numbers in the local format or whether they must enter phone numbers in international format. When true, users can enter phone numbers in the local format listed in the territory selector. When false, users must enter phone numbers in the international format listed in the territory selector.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_national</td>
<td>Determines how a Phone Number (E164) field displays phone numbers. When set to true or form, a Phone Number (E164) field displays phone numbers in a local format on forms but as an international format on lists. When set to all, a Phone Number (E164) field always displays phone numbers in a local format. When set to user, a Phone Number (E164) field only displays phone numbers in a local format when the phone number matches the locale setting of the current user.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_territory_selector</td>
<td>Determines whether to display the territory selector. Hiding the territory selector restricts users to entering only local or national phone numbers.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_territory_text</td>
<td>Determines when a Phone Number (E164) field displays a territory label. When set to all, a Phone Number (E164) always displays the territory label. When set to national, a Phone Number (E164) displays the territory label only if the phone number is in local format. When set to read-only, a Phone Number (E164) displays the territory label in read-only mode regardless of whether the number is in local or global format. When set to read-only-national, a Phone Number (E164) displays the territory label in read-only mode only if the number is in local format. When set to list, a Phone Number (E164) displays the territory label in a list. When set to list-national, a Phone Number (E164) displays territory label in a list if the number is in national format. When set to none, a Phone Number (E164) does not display the territory label.</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_users_idd</td>
<td>Determines whether to display the international direct dialing prefix between the territory selector and the input box on forms.</td>
</tr>
<tr>
<td>glide.phone_number_e164.strict</td>
<td>Determines whether all phone number fields must match the display format of the field's select territory. When true, the phone number input box displays a red line underneath phone numbers that do not match the territory format listed in the territory selector. Users cannot save an invalid phone number. When false, the phone number input box displays a green line underneath phone numbers that do not match the territory format listed in the territory selector. Users can save an invalid phone number, and the territory selector offers the option to select an Other / Unknown territory format.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.pop3.ignore_headers</td>
<td>Specifies the comma-separated list of email headers that cause the instance to ignore an email message. Use the format name:value to specify email header types and values. You can use a wildcard (<em>) for the subtype. For example, &quot;Content-Type:multipart/</em>; report-type=delivery-status;&quot; ignores emails containing a type of multipart and a parameter of report-type=delivery-status. For syntax specifications, see <a href="http://www.w3.org/Protocols/rfc1341/4_Content-Type.html">http://www.w3.org/Protocols/rfc1341/4_Content-Type.html</a>.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: Auto-Submitted:auto-replied,X-FC-MachineGenerated:true,Content-Type:multipart/report; report-type=delivery-status;</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.pop3.ignore_senders</td>
<td>Specifies the comma-separated list of senders that cause the instance to ignore an email message. Enter only the name before the at (@) sign.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: mailer-daemon, postmaster</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.pop3.ignore_subjects</td>
<td>Specifies the comma-separated list of strings that cause the instance to ignore an email message if they are present at the start of a subject line. These values are case-insensitive.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: out of office autoreply, undeliverable:, delivery failure:, returned mail:, autoreply</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.pop3.parse_end</td>
<td>(Legacy) Text indicating the end of the email body section where the instance should parse name:value pairs to change field values when processing inbound email actions. This property is no longer required to set field values from the email body.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.pop3.parse_start</td>
<td>(Legacy) Text indicating the beginning of the email body section where the instance should parse name:value pairs to change field values when processing inbound email actions. This property is no longer required to set field values from the email body.</td>
</tr>
<tr>
<td></td>
<td>* Type: string                                                                                                                                  * Default value: none</td>
</tr>
<tr>
<td></td>
<td>* Location: <a href="#">System Properties &gt; Email</a></td>
</tr>
<tr>
<td>glide.pop3.process_locked_out</td>
<td>Enables (true) or disables (false) the ability for locked out users to trigger inbound actions.</td>
</tr>
<tr>
<td></td>
<td>* Type: true</td>
</tr>
<tr>
<td></td>
<td>* Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.pop3.reply_separators</td>
<td>Specifies the comma-separated list of separators that cause the instance to disregard everything below the text string in the message body. This list is case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>* Type: string                                                                                                                                  * Default value: \n\n-----Original Message-----, \n\n _____ \n\nFrom:</td>
</tr>
<tr>
<td></td>
<td>* Location: <a href="#">System Properties &gt; Email</a></td>
</tr>
<tr>
<td>glide.pop3readerjob.create_caller</td>
<td>Controls the behavior when an instance receives an email from an email address not associated with a user record. If this property is set to true, ServiceNow creates a new user record for the email address and places that new user in the Caller field of any created tickets. If the property is set to false, ServiceNow associates the new ticket to the Guest user record.</td>
</tr>
<tr>
<td></td>
<td>* Type: true</td>
</tr>
<tr>
<td></td>
<td>* Location: <a href="#">System Properties &gt; Email</a></td>
</tr>
<tr>
<td>glide.processor.json.row_limit</td>
<td>Specify the maximum number of rows a JSON query returns</td>
</tr>
<tr>
<td></td>
<td>* Type: integer                                                                                                                                  * Default value: 250</td>
</tr>
<tr>
<td></td>
<td>* Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.product.description</td>
<td>The value of this property is displayed as text in the banner next to the company logo</td>
</tr>
<tr>
<td></td>
<td>* Type: string                                                                                                                                  * Default value: Service Management</td>
</tr>
<tr>
<td></td>
<td>* Location: <a href="#">System Properties &gt; Basic Configuration UI</a></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.product.help_url</td>
<td>Controls whether the help icon, help.gif, appears in (true) or is omitted from (false) the welcome banner.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.product.help_show</td>
<td></td>
</tr>
<tr>
<td>glide.product.image.light</td>
<td>The Banner image displayed for UI16 Interface</td>
</tr>
<tr>
<td></td>
<td>• Type: uploaded image</td>
</tr>
<tr>
<td></td>
<td>• Default value: None</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Basic Configuration UI16</td>
</tr>
<tr>
<td>glide.product.icon</td>
<td>Stores the favicon image displayed in bookmarks, tabs, and the browser address bar.</td>
</tr>
<tr>
<td></td>
<td>• Type: image</td>
</tr>
<tr>
<td></td>
<td>• Default value: favicon.ico?v=4</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; System</td>
</tr>
<tr>
<td>glide.product.name</td>
<td>Specifies text to use in place of ‘ServiceNow’ in the browser's top title bar (and in browser tabs). This text is duplicated in the banner to</td>
</tr>
<tr>
<td></td>
<td>the right of the logo unless you add display: none; to the end of the value field within the glide.product.name.style property.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: ServiceNow</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.product.name.style</td>
<td>Specifies the CSS properties used to display the glide.product.name text in the banner to the right of the logo. To not display it, add display:</td>
</tr>
<tr>
<td></td>
<td>none; to the end of the value field in this property.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: padding-bottom: 0px; padding-top: 0px;</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.quota.manager.debug           | Controls whether to display (true) or hide (false) additional information related to the Quota Manager, such as running transactions, canceled transactions, and what quotas are matched to transactions.  
  - Type: true | false  
  - Default value: true  
  - Location: add to the System Property (sys_properties) table |
| glide.quota.manager.heartbeat       | Sets the number of seconds between the start of each Quota Manager heartbeat. This value determines how often the Quota Manager checks for transactions exceeding a quota and how often it writes status in the log file.  
  - Type: integer  
  - Default value: 1  
  - Location: add to the System Property (sys_properties) table |
| glide.quota.manager.minimum_transaction_time | Sets the minimum number of seconds a transaction must run before the Quota Manager matches it to a transaction quota. ServiceNow recommends setting this value to at least 1 second because smaller values decrease performance and because transactions shorter than 1 second are probably not worth canceling. For optimal performance, set this value to the value of your most restrictive quota. For example, if your most restrictive quota cancels transactions longer than 1 minute, set the minimum transaction time to 60 seconds.  
  - Type: integer  
  - Default value: 1  
  - Location: add to the System Property (sys_properties) table |
| glide.remote_glide_record.max_count | Control the maximum number of records that the GlideRecord query method returns when using the SOAP web service. The instance primarily uses this property to control the records returned when using a Perl API GlideRecord query.  
  - Type: integer  
  - Default value: 250  
  - Location: add to the System Property (sys_properties) table |

**Caution:** If you set this property to a large value, such as 10000, socket timeout errors might occur with MID Servers. Keep the value of this property less than 1000.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.report.calendar.max_more_events_per_day | Defines that maximum number of calendar events that can appear in the + <number> popup for:  
- A calendar day when calendar is in month or year view  
- The top ‘full day’ section of a calendar day when a calendar is in day or week view  
When this number is exceeded, a + many link appears, which opens a list of events instead of a popup. For more information about the maximum number of events that can be displayed in a calendar day, see system property glide.report.calendar.max_events_displayed_per_cell.  
- Type: integer  
- Default value: 30  
- Location: add to the System Property (sys_properties) table |
| glide.report.calendar.max_events_displayed_per_cell | Defines the maximum number of events that can appear in calendar report for:  
- A calendar day when calendar is in month or year view  
- The top ‘full day’ section of a calendar day when a calendar is in day or week view  
Events that exceed this value are visible via a link in the calendar cell. See glide.report.calendar.max_more_events_per_day for more information.  
- Type: integer  
- Default value: 3  
- Location: add to the System Property (sys_properties) table |
| glide.report.new_calendar | Enables (true) or disables (false) new calendar reports. Internet Explorer 7 and 8 do not support new calendars. If you open a calendar report in one of these browsers the old version of calendar reports is always used.  
- Type: true | false  
- Default value: true  
- Location: add to the system Property (sys_properties) table |
| glide.report_home.group_report.show_usr_grp | Enables (true) or disables (false) the Reporting preferences link in the user's profile.  
- Type: true | false  
- Default value: false  
- Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.rest.apis.disabled</td>
<td>Controls which REST APIs are available on the instance, along with glide.rest.apis.enabled. The value for this property is a comma-separated list of API names, such as Table API or Aggregate API. If neither this property nor glide.rest.apis.enabled is set, all REST APIs are available. If a particular API is specified in both properties, that API is disabled. If you disable specific APIs without explicitly enabling any APIs, all REST APIs except the disabled APIs are available.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: all REST APIs are enabled by default</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.rest.apis.enabled</td>
<td>Controls which REST APIs are available on the instance, along with glide.rest.apis.enabled. The value for this property is a comma-separated list of API names, such as Table API or Aggregate API. If neither this property nor glide.rest.apis.disabled is set, all REST APIs are available. If a particular API is specified in both properties, that API is disabled. If you enable specific APIs, only those APIs are available.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: all REST APIs are enabled by default</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.rest.debug</td>
<td>Logs all stages of REST processing, including processing times.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: false</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.rollback.version</td>
<td>Controls whether rollback behavior is used (true) or not (false).</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.rss.max_rows</td>
<td>Controls the maximum number of records returned by the RSS Feed Generator.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>· Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.reset_cascade</td>
<td>If true, forces variable cascading when navigating between pages in an order guide.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.schedules.repeat_nth</td>
<td>Controls how a schedule entry with Repeats set to Monthly and Monthly Type set to Day of the Week is defined. Choices are Week or Day. The Week option is defined as choosing a day of the month in the nth week selects the nth day of the month. The Day option is defined as choosing the nth day of the month.</td>
</tr>
<tr>
<td></td>
<td>- Type: choice list</td>
</tr>
<tr>
<td></td>
<td>- Default value: day</td>
</tr>
<tr>
<td></td>
<td>- Location: sys_properties table</td>
</tr>
<tr>
<td>glide.schedules.fifth</td>
<td>Controls how a schedule entry that selects the fifth occurrence of a day in month behaves in a month containing only four occurrences of the day. Choices are Last, Next, and Strict. The Last option selects the last (fourth) day of the month. The Next option selects the first day of the next month. The Strict option skips the day completely. This property is only valid when the glide.schedules.repeat_nth property is set to Day.</td>
</tr>
<tr>
<td></td>
<td>- Type: choice list</td>
</tr>
<tr>
<td></td>
<td>- Default value: last</td>
</tr>
<tr>
<td></td>
<td>- Location: sys_properties table</td>
</tr>
<tr>
<td>glide.script.ccsi.ispublic</td>
<td>Provides privacy control over client-callable script includes that are accessed by public pages. When this property is set to false, all client-callable script includes are private.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.script.log_level</td>
<td>Controls the behavior of gs.log. Set this property to none to disable Glide script logging, or print to save log data to the filesystem instead of the database. Use the default value all to save all Glide script logs to the database.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: all</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.script_processor.admin</td>
<td>Specifies the user role necessary to access the Scripts - Background module. To require administrators to elevate privileges to access this module, set the value to security_admin.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: admin</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.secondary.query.sysid</td>
<td>Controls whether a secondary sort using sys_id as a sort key is automatically applied when sorting requested database records on a list. This property is useful when sorting records that have multiple records found for a single value of the primary sort key. Use this property to ensure that the Next/Previous buttons on forms display the proper record. If set to false, there is no secondary sort, therefore records with the same primary sort value are returned as they are found in the database, and may be inconsistent.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.security.auto.resubmit.ajax</td>
<td>Automatically resubmits timed-out Ajax requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| `glide.security.checkacl.before.setvalue` | Controls how the high security setting `glide.security.strict.updates` processes ACLs. When true, the instance checks ACL rules for all columns before applying any updates to a row. When false, the instance applies ACL rules as each column is processed in alphabetical order. This behavior may result in one update preventing another update from occurring. For example, suppose you create a custom ACL rule to prevent updates after a record is closed. If you attempt to close an incident and also add information to a custom resolution code field in the same update, the close action is applied first because it is controlled by the `(incident.state)` column and the custom field by the `(incident.u_resolution_code)` column. After the instance applies the close action, the custom ACL rule prevents further write updates to the row.  
- Type: true | false  
- Default value: true  
- Location: add to the System Property (sys_properties) table |
| `glide.security.csrf.handle.ajax.timeout` | Handles errors for timed out Ajax requests.  
- Type: true | false  
- Default value: true  
- Location: add to the System Property (sys_properties) table |
| `glide.security.csrf.strict.validation.mode` | Enforces strict validation on CSRF tokens so that users cannot resubmit a request if the CSRF token does not match.  
- Type: true | false  
- Default value: false  
- Location: System Property (sys_properties) table |
| `glide.security.diag_txns_acl` | Controls who can view the stats.do, threads.do, and replication.do pages. When set to true, only administrators or users from a known IP address are allowed to view the pages. When set to false, all users have access to the pages.  
- Type: true | false  
- Default value: false  
- Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.security.disable_ui_pages_sysparm_client_script</td>
<td>Client scripts that are passed in URL parameter in UI pages are not evaluated by the system. If you use URL parameters to load client scripts, you can add and disable this system property. Only use this property while you change the implementation to no longer depend on clients being passed in by URL parameters. Do not keep the system property disabled.</td>
</tr>
<tr>
<td></td>
<td>Type: true</td>
</tr>
<tr>
<td>glide.security.mime_type.aliasset</td>
<td>Creates customized mime type alias sets. For example, ‘image/png=image/x-png’.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td>glide.security.granular.create</td>
<td>Requires users to have write access on all individual fields on a table before they can create a record in that table.</td>
</tr>
<tr>
<td></td>
<td>Type: true</td>
</tr>
<tr>
<td>glide.security.file.mime_type.validation</td>
<td>Enables (true) or disables (false) mime type validation for file attachments.</td>
</tr>
<tr>
<td></td>
<td>Type: true</td>
</tr>
<tr>
<td>glide.security.strict_elevate_privilege</td>
<td>Forces all elevated roles to be treated equally for users with the administrator role. When enabled, administrators need to explicitly, manually elevate themselves to any roles that are marked as elevated. When disabled, administrators only need to manually elevate to the security_admin role. Other roles are automatically granted to administrators.</td>
</tr>
<tr>
<td></td>
<td>Type: true</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.set_x_frame_options</td>
<td>Enables (true) or disables (false) the X-Frame-Options response header to SAMEORIGIN for all UI pages. The X-Frame-Options HTTP response header can be used to indicate whether or not a browser should be allowed to render a page in a &lt;frame&gt; or &lt;iframe&gt;. Set this property to true to avoid clickjacking attacks, by ensuring that CMS content cannot be embedded into other sites.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.short_poll_delay</td>
<td>(Chat plugin) Sets the short polling delay, in milliseconds, for XMPP requests. Polling is the method by which the browser gets information from the server to send instant messages in chat.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1000 (1 second)</td>
</tr>
<tr>
<td></td>
<td>• Location: Social IT &gt; Chat Administration &gt; Properties</td>
</tr>
<tr>
<td>glide.shortened_journal_length</td>
<td>Sets the number of characters to display as a preview of journal input fields.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 512000</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.smtp.dateformat</td>
<td>Specify the date format to use for outgoing email notifications</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: date format listed in email sender's user record (sys_user.date_format).</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.smtp.default_retry</td>
<td>Enables (true) or disables (false) resending email when an unknown SMTP error code is encountered. The instance only recognizes the SMTP error codes defined in the glide.smtp.defer_retry_ids property.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.smtp.defer_retry_ids</td>
<td>Specifies the comma-separated list of SMTP error codes that force the instance to resend email.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 421,450,451,452</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.smtp.fail_message_ids                    | Specifies the comma-separated list of SMTP error codes that prevent the instance from resending email.  
  - Type: string  
  - Default value: 500,501,502,503,504,550,551,552,553,554  
  - Location: System Properties > Email          |
| glide.smtp.timeformat                          | Specify the time format to use for outgoing email notifications  
  - Type: string  
  - Default value: time format listed in email sender's user record (sys_user.time_format).  
  - Location: add to the System Property (sys_properties) table |
| glide.soap.allow_null_numeric_output           | When true, SOAP XML responses return an empty element for numeric fields with no value. When false, numeric fields with no value return a value of 0 in the SOAP response.  
  **Note:** The property glide.wsdl.show_nillable must be true to allow null values in SOAP responses.  
  - Type: true | false  
  - Default value: true  
  - Location: add to the System Property (sys_properties) table |
| glide.soap.default_security_policy             | Specifies the name of SOAP security policy the instance uses when enforcing Web Services-Security (WSS) for inbound requests.  
  - Type: string  
  - Default value: default security policy  
  - Location: add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.soap.import_set_insert_serialized.<table name> | Controls the processing of web service inserts. When this property is set to true, the instance processes multiple simultaneous inserts one at a time (serially across nodes) to ensure an accurate transform. Serialized processing slows down the speed at which the instance processes inserts. When this property is set to false, multiple simultaneous inserts into an import set table result in simultaneous transforms that may produce duplicate target records due to the coalesce value being created at the same time. **Tip:** Only set this value to false to optimize for performance when the related transform map does not have a coalesce value that may be present simultaneously.  
  
  - Type: true | false  
  - Default value: true  
  - Location: add to the System Property (sys_properties) table |
| glide.soap.request_processing_timeout | Sets the maximum number of seconds a SOAP request has to finish processing before the connection times out. This property computes a default value from the value of the property glide.http.timeout divided by 1000. There might be network infrastructure (such as proxy servers) in place that implements a shorter timeout. In this case, a socket timeout may occur unless this property is set to a shorter value. In general, you should set this property to a value several seconds less than the shortest socket inactivity timeout in effect anywhere in the network path between the client application and the ServiceNow instance.  
  
  - Type: integer  
  - Default value: 175 (value of glide.http.timeout divided by 1000)  
  - Location: add to the System Property (sys_properties) table |
| glide.spell.dictionary.en | Sets the spell checker dictionary used in the system for English users. There are dictionaries available for Brazilian Portuguese, Dutch, English US, English UK, French, German, Italian, Portuguese, Russian, Spanish, and Thai.  
  
  - Type: choice list  
  - Default value: en.dic (English US)  
  - Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.spell.dictionary.max_matches</td>
<td>Sets the maximum number of spelling errors the spell-check should detect. By default it finds only 10 spelling errors. The instance ignores any additional errors after reaching the maximum value.</td>
</tr>
</tbody>
</table>
|                                                           |   • Type: integer  
|                                                           |   • Default value: 10  
|                                                           |   • Location: add to the System Property (sys_properties) table                                                                                                                                              |
| glide.sys.activity_using_audit_direct                      | (Not Supported) Controls whether the record's history is generated using the Audit table (true) or not (false). (Required) Set the value to false to generate history with History Sets.                                             |
|                                                           |   • Type: true | false  
|                                                           |   • Default value: false  
|                                                           |   • Location: System Property (sys_properties) table                                                                                                                                                         |
| glide.sys.audit_inserts                                   | Controls whether the Audit table audits inserts (true) or not (false).                                                                                                                                   |
|                                                           |   • Type: true | false  
|                                                           |   • Default value: false  
|                                                           |   • Location: System Property (sys_properties) table                                                                                                                                                         |
| glide.sys.date_format                                     | System date format for all users unless overridden in the user's record                                                                                                                                     |
|                                                           |   • Type: date format  
|                                                           |   • Default value: yyyy-MM-dd  
|                                                           |   • Location: System Properties > Basic Configuration UI16                                                                                                                                                   |
| glide.sys.default.tz                                      | System timezone for all users unless overridden in the user's record.                                                                                                                                   |
|                                                           |   • Type: timezone  
|                                                           |   • Default Value: none  
|                                                           |   • Location: System Properties > Basic Configuration UI16                                                                                                                                                   |
| glide.sys.time_format                                     | System time format for all users unless overridden in the user's record.                                                                                                                                  |
|                                                           |   • Type: time format  
|                                                           |   • Default Value: HH:mm:ss  
<p>|                                                           |   • Location: System Properties &gt; Basic Configuration UI16                                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sys_reference_row_check</td>
<td>Controls whether the script conditions of Access Control Rules apply to a table's reference fields.</td>
</tr>
</tbody>
</table>
|                                           | • Type: true | false  
|                                           | • Default value: false  
|                                           | • Location: add to the System Property (sys_properties) table  |
| glide.template.max_context                | Specifies the maximum number of templates displayed in a form’s context menu. If more than this number are available, users can click Apply Template on the context menu to open the reference list of templates. |
|                                           | • Type: integer  
|                                           | • Default value: 15  
|                                           | • Location: System Property (sys_properties) table  |
| glide.translate.learn                     | Enables (true) or disables (false) adding the current language suffix to UI elements such as labels and messages. Enabling the language suffix assists with translating new customizations.                               |
|                                           | • Type: true | false  
|                                           | • Default value: false  
|                                           | • Location: add to the System Property (sys_properties) table  |
| glide.ts.index.attachment.debug           | When the value is set to true, enables log messages for exceptions that occur when indexing attachments (default is false). You can leave this property enabled during normal operations to capture stack trace information about any exceptions. |
|                                           | • Type: true | false  
|                                           | • Default value: false  
|                                           | • Location: add to the System Property (sys_properties) table  |
| glide.ts.index.attachment.list_terms.debug| When the value is set to true, the system logs all indexed terms when an attachment is indexed (default is false). (Recommended) For optimal performance, set this property to false during normal operations. Only enable this property when you are actively debugging an issue. |
|                                           | • Type: true | false  
|                                           | • Default value: false  
<p>|                                           | • Location: add to the System Property (sys_properties) table  |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ui.activity.displayname             | Determines whether the activity formatter shows name values (true) or user_name values (false).  
• Type: true | false  
• Default value: false  
• Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                     |
| glide.ui.activity.email_roles             | Specifies the list of roles (comma-separated) that can view email in the Activity Formatter.  
• Type: string  
• Default value: itil  
• Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                     |
| glide.ui.activity.email.use_display      | Specifies whether to display email addresses or the user IDs (display value of the User table) in email headers. If true, the instance searches for a user record with a matching email address. If it cannot find a matching user record, it displays the email address.  
• Type: true | false  
• Default value: false  
• Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                     |
| glide.ui.activity_stream.form_button     | Removes the activity stream button from forms.  
• Type: true | false  
• Default value: true  
• Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                     |
| glide.ui.activity_stream.list_button     | Removes the activity stream button from lists.  
• Type: true | false  
• Default value: true  
• Location: add to the System Property (sys_properties) table                                                                                                                                                                                                                     |
| glide.ui.activity_stream.page_size       | Size of pages for UI16 form activity stream. A value of 0 means no paging.  
• Type: integer  
• Default value: 0  
• Location: This property still appears in the System Properties (sys_properties) table but is no longer available.                                                                                                                                                     |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ui.activity_stream.scale_animated_gifs             | Creates a thumbnail of animated .gif files. The maximum dimensions are 525px width and 350px height. The animation is not preserved in the thumbnail, but previewing the image displays the animation at its original size.  
  - Type: true  | false
  - Default value: false
  - Location: System Property (sys_properties) table |
| glide.ui.activity_stream.scale_images                    | Creates a thumbnail of large images to display in the activity stream. The maximum dimensions are 525px width and 350px height. If user clicks the image or attachment, the preview is at full size.  
  - Type: true  | false
  - Default value: true
  - Location: System Property (sys_properties) table |
| glide.ui.activity_stream.style.comments                  | Changes the color of the left bar in activity stream comments in UI16.  
  - Type: color entry, either a name, such as blue or a code, such as #0000FF.  
  - Default value: transparent  
  - Location: System Property (sys_properties) table |
| glide.ui.activity_stream.style.work_notes                | Changes the color of the left bar in activity stream work notes in UI16.  
  - Type: color entry, either a name, such as blue or a code, such as #0000FF.  
  - Default value: gold  
  - Location: System Property (sys_properties) table |
| glide.ui.activity.style.comments                         | Changes the background color of the activity stream comments in UI15.  
  - Type: string
  - Default value: background-color: WhiteSmoke  
  - Location: System Property (sys_properties) table |
| glide.ui.activity.style.work_notes                       | Changes the background color of the activity stream work notes in UI15.  
  - Type: string
  - Default value: background-color: LightGoldenRodYellow  
  - Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.allow_deep_html_validation</td>
<td>Allows administrators to prevent users from saving invalid HTML in a journal field.</td>
</tr>
</tbody>
</table>
|                                                           |   - Type: true | false  
|                                                           |   - Default value: false  
|                                                           |   - Location: add to the System Property (sys_properties) table                                                                                |
| glide.ui.attachment.force_download_all_mime_types        | Forces download of all attachment files.                                                                                                                                                                   |
|                                                           |   - Type: true | false  
|                                                           |   - Default value: false  
|                                                           |   - Location: add to the System Property (sys_properties) table                                                                                |
| glide.ui.audit_deleted_tables                            | Comma-separated list of system tables for which the audit history tracks deletions.                                                                                                                      |
|                                                           |   - Type: string  
|                                                           |   - Default value: sys_user, sys_user_group, sys_user_role, sys_user_has_role, sys_user_grmember, sys_group_has_role, sys_security_acl_role  
|                                                           |   - Location: System Property (sys_properties) table                                                                                           |
| glide.ui.auto.recovery                                   | Allows users to recover unsaved changes while working in the developer studio.                                                                                                                              |
|                                                           |   - Type: true | false  
|                                                           |   - Default value: true  
|                                                           |   - Location: Auto Recovery > Properties                                                                                                       |
| glide.ui.auto.recovery.exclude.field.types               | Comma-separated list of field types you want to exclude from automatic recovery.                                                                                                                              |
|                                                           |   - Type: string  
|                                                           |   - Default value: none  
|                                                           |   - Location: Auto Recovery > Properties                                                                                                       |
| glide.ui.auto.recovery.unsupported.field.types           | Comma-separated list of field types excluded from automatic recovery.                                                                                                                                        |
|                                                           |   - Type: string  
|                                                           |   - Default value: password, password2, glide_encrypted, video, user_image, image  
| glide.ui.auto.recovery.unsupported.tables                | Comma-separated list of tables you want to exclude from automatic recovery.                                                                                                                                  |
|                                                           |   - Type: string  
|                                                           |   - Default value: v_ws_editor  
<p>|                                                           |   - Location: Auto Recovery &gt; Properties                                                                                                       |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.auto_req.extend.session</td>
<td>When set to true, this property enables the user to extend their user session by selecting a homepage refresh time. When set to false, it enforces session timeout. The session timeout value is ignored when the user specifies an automatic refresh value. For example, if the user selects 5 minutes for automatic homepage refresh, the session is renewed every five minutes. By adding this property and setting the value to false, administrators can force the user session to time out even if the user's page refreshes every x number of minutes. The user's session times out after the value specified in the session timeout, plus the selected refresh value. This property takes effect when the Remember me check box is not selected for the user. Tablet and mobile devices do not support this feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.buttons_bottom</td>
<td>Controls whether UI actions appear at both the bottom and top of the form (true) or only at the top (false). This property works in UI11 only.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.cert_task_activity.fields</td>
<td>Defines which journal field is the task activity field.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: work_notes</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.chart.bar_horiz_max_col_slant_labels</td>
<td>Sets the maximum number of columns in a horizontal bar chart before slanting (angling) the labels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.chart.height</td>
<td>Specifies the height of a chart in pixels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 300</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.chart.pie.labels</td>
<td>Enables (true) or disables (false) labels on pie chart slices.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.chart.pie.labels.max_items</td>
<td>Sets the maximum number of pie chart slice values that can be returned in</td>
</tr>
<tr>
<td></td>
<td>order to display their labels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 8</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.clickthrough.popup</td>
<td>For reference fields, enables (true) or disables (false) displaying the</td>
</tr>
<tr>
<td></td>
<td>pop-up diamond icon for reference fields and opening a new window when the</td>
</tr>
<tr>
<td></td>
<td>icon is clicked.</td>
</tr>
<tr>
<td></td>
<td>For document ID fields, enables (true) or disables (false) displaying the</td>
</tr>
<tr>
<td></td>
<td>information icon and opening a pop-up window with the document's form.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Note: Related lists do not appear on</td>
<td>For more information, see Document ID field.</td>
</tr>
<tr>
<td>forms opened in the pop-up window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.clickthrough.replace</td>
<td>Enables (true) or disables (false) both the pop-up and clickthrough icons</td>
</tr>
<tr>
<td></td>
<td>for reference fields.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.date_format.first_day_of_week</td>
<td>Specifies which day of the week that weeks start on for calendar reports.</td>
</tr>
<tr>
<td></td>
<td>Values: 1=Sunday, 2=Monday</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.date_picker.first_day_of_week</td>
<td>Specifies the first (leftmost) day of the week for the date and date/time picker (1=Sunday, 2=Monday...).</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 1</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.default.applications</td>
<td>Comma-separated list of application names that open by default in the navigation pane when nothing is opened via user preferences. If the property is specified and is blank, no applications are opened in the navigation pane when no applications are opened via user preferences. If the property is not specified, the first application that is authorized for that user opens if no applications are opened via user preferences.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: first authorized application for the user</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.dirty_form_support</td>
<td>Enables (true) or disables (false) display of a confirmation message when a form has unsaved changes and the user leaves the form through any means except a submit (such as using the green back arrow, any form button, or other). This property is not supported in Safari.</td>
</tr>
<tr>
<td></td>
<td>- Note: This property is true by default.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.doctype</td>
<td>Enables or disables the UI15 interface.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.email_client.autocomplete.count</td>
<td>Sets the maximum number of auto-complete matches the Email Client displays.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 10</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.email_client.autocomplete.group</td>
<td>Specifies whether groups are included in auto-complete results for the Email Client.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.ui.email_client.email_address.disambiguator</td>
<td>Sets the columns from the User (sys_user) table that the auto-complete list displays.</td>
</tr>
<tr>
<td></td>
<td>Separate each column name with a semicolon character (;). See the system dictionary for a list of available column names. For example, add the sys_user.email and sys_user.company columns to show a user's email address and company in the auto-complete list.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: first_name;last_name</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.email_client.from</td>
<td>Specifies whether to display the From: line in the Email Client. Users can change the email address in the From: line by entering a new value.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.email_client.reply_to</td>
<td>Specifies whether to display the Reply to: line in the Email Client.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.filter.first_day_of_week</td>
<td>Identifies the first day of the calendar week for the company. By default, the start of the week is Monday, meaning that the calendar week begins with Monday and ends with Sunday. To change this behavior, add the property glide.ui.filter.first_day_of_week to the instance as an integer property. Set the value to the integer corresponding with the day of the week that the calendar begins on, where 1 is Sunday, 2 is Monday, and so on. The function impacts all charts and calculations where the day of the week is used as a parameter.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 2</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.first.field.reference</td>
<td>Enables (true) or disables (false) having the first column in a list always link to the underlying record, even if it is a reference field. For example, if the first column on an Incident list is <strong>Assigned to</strong>, that value links to the Incident if this property is set to true.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>glide.ui.form_annotations</td>
<td>Enables (true) or disables (false) form annotations, which allow you to add Custom, Section Separator, and Line Separator to a form.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>glide.ui.form_multiple_splits</td>
<td>Enables (true) or disables (false) multiple splits and end splits in the form layout configuration <a href="#">slushbucket</a>.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>glide.ui.gauge.view</td>
<td>Defines which view they want to be the default for homepage gauges.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: portal</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>glide.ui.glide_list.start.locked</td>
<td>Controls whether a glide_list (like the watch list) starts out locked (true) or unlocked (false) on a form.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>glide.ui.goto_use_contains</td>
<td>Controls whether the <strong>Go to</strong> navigation performs a &quot;contains&quot; query (true) or a &quot;greater than&quot; query (false) by default.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (<a href="#">sys_properties</a>) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.homepage.parallel</td>
<td>Enables (true) or disables (false) use of parallel rendering.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.homepage.parallelism</td>
<td>Sets the maximum number of threads that should cooperate on rendering any given homepage.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.homepage.preview</td>
<td>Enables (true) or disables (false) displaying the preview icon for lists on the homepage.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.html.editor</td>
<td>Determines which HTML field editor to use, TinyMCE or htmlArea (legacy).</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: tinymce</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.html.editor.extended_valid_elements</td>
<td>Defines which elements remain in the Tiny MCE text when the editor saves. This functionality can be very useful to add or override specific elements that should be kept.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: blank</td>
</tr>
<tr>
<td></td>
<td>• Location: System property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.html.editor.toolbar.line1</td>
<td>Configures the editing toolbar (first line) for HTML fields when the TinyMCE editor is enabled. The spellchecker tool is not supported in UI16 or UI15.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.html.editor.toolbar.line2</td>
<td>Configures the editing toolbar (second line) for HTML fields when the TinyMCE editor is enabled. The spellchecker tool is not supported in UI16 or UI15.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.html.image.allow_url</td>
<td>Enables (true) or disables (false) uploading an image via URL from HTML Fields.</td>
</tr>
<tr>
<td></td>
<td>Type: true</td>
</tr>
<tr>
<td></td>
<td>Default value: false</td>
</tr>
<tr>
<td></td>
<td>Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.html.toolbar</td>
<td>Configures the editing toolbar for HTML fields.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: list of buttons</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.incident_activity.fields</td>
<td>Defines what fields are visible in the activity formatter. If the activities are personalized, this property updates automatically.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: list of fields</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; UI Properties</td>
</tr>
<tr>
<td>glide.ui.incident_activity.max_addresses</td>
<td>Specifies the maximum number of addresses to list in an email audit record. If the number of addresses exceeds this limit, the instance truncates the list after the maximum value and displays an ellipsis character (...).</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: 5</td>
</tr>
<tr>
<td></td>
<td>Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.incident_alert_activity.fields</td>
<td>Incident alert activity formatter fields. This is the list of fields tracked from the incident alert form in the activity formatter.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: opened_by, work_notes, comments, severity, estd_distruption_time, actual_disruption_time</td>
</tr>
<tr>
<td></td>
<td>Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.js_error_notify</td>
<td>Displays client script errors to users with the client_script_admin role. Also displays a generic error message to other users who encounter a client script error.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; All Properties</td>
</tr>
<tr>
<td>glide.ui.label.enable</td>
<td>Enables (true) or disables (false) using labels, such as Most Active, Most Recent, or user created.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.m.clear_pasteboard_when_backgrounded</td>
<td>Clears the copy/paste clipboard when the ServiceNow application enters the background.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td></td>
<td>• in Categories add the mobile_post_auth category</td>
</tr>
<tr>
<td>glide.ui.max_calendar_duration</td>
<td>Maximum number of days that a single calendar report entry can display.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 90</td>
</tr>
<tr>
<td></td>
<td>• Range of possible values: 90 to 400</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.max_calendar_records</td>
<td>Maximum number of records saved in a calendar report.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value if the property is not configured: 10,000</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.m_agents</td>
<td>Comma-separated list of browser agents considered as mobile browsers for the Smartphone Interface. These browsers are directed to the mobile pages instead of the full browser pages.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: iphone,android_phone,iEMobile,Windows Phone,iPod,Windows CE,BlackBerry,BB10</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| glide.ui.max_ref Dropdown                 | Maximum number of records for a reference field that is displayed as a choice list. If the number of available records is greater than this value, the field appears as a reference field, not as a choice list.  
  * Type: integer  
  * Default value: 25  
  * Location: System Property (sys_properties) table                                                                                                                                                      |
| glide.ui_mobile_agents                    | Comma-separated list of browser agents considered as mobile browsers for the Legacy Smartphone Interface. These browsers are directed to the mobile pages instead of the full browser pages.  
  * Type: string  
  * Default value: iPod, Windows CE, BlackBerry, Android, Opera Mini, IEMobile, Windows Phone, iphone  
  * Location: System Property (sys_properties) table                                                                                                                                                      |
| glide.ui.nav.strip.select.maxchars       | Numerical character limit for list menu choices within the nav stripe. The nav stripe displays at the top of the page when using UI11.  
  * Type: integer  
  * Default value: none  
  * Location: add the property                                                                                                                                                                           |
| glide.ui.reference.readonly.clickthrough | Enables (true) or disables (false) reference pop-ups on read-only reference fields. Reference pop-ups and click-throughs are hidden by default if a client script, UI policy, or ACL makes the field read-only. Being able to see or click through to the target record is unrelated to the reference field being writable.  
  * Type: true | false  
  * Default value: false  
  * Location: System Properties > UI Properties  
  If set to false, the administrator can override the system setting for a specific field by adding the `readonly_clickthrough=true` attribute to the dictionary entry.                                                                                       |
| glide.ui.remember_view                    | Enables (true) or disables (false) use of user preferences for the last view.  
  * Type: true | false  
  * Default value: true  
  * Location: System Property (sys_properties) table                                                                                                                                                      |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ui.remember.me.default | Controls whether the **Remember me** check box is selected (true) or cleared (false) by default.  
- **Type:** true | false  
- **Default value:** true  
- **Location:** System Property (sys_properties) table |
| glide.ui.report.extend_calendar_choices | Controls which field styles are applied during calendar highlighting. If this property is set to false, field styles in only the Task table are used. If this property is set to true, the calendar first uses field styles from the table the report is based on. If no applicable styles exist in that table, the calendar uses field styles from the Task table.  
- **Type:** true | false  
- **Default value:** true  
- **Location:** System Property (sys_properties) table |
| glide.ui.section508 | Enables (true) or disables (false) rendering of alternate text in place of images.  
- **Type:** true | false  
- **Default value:** false  
- **Location:** System Properties > UI Properties |
| glide.ui.show_live_feed_activity | Enables (true) or disables (false) live feed for a record in the activity formatter.  
- **Type:** true | false  
- **Default value:** false  
- **Location:** System Properties > UI Properties |
| glide.ui.show_template_bar.<TABLENAME> | Controls whether the template bar can be displayed on the specified table. For example:  
`glide.ui.show_template_bar.incident = false`  
- **Type:** true | false  
- **Default value:** true  
- **add to the System Property (sys_properties) table** |
| glide.ui.session_timeout | Sets the session timeout, in minutes.  
- **Type:** integer  
- **Default value:** 30  
- **Location:** add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ui.stream_icon.<TABLENAME> | Toggles the displaying of the activity stream button on the specified table. For example: glide.ui.stream_icon.hr_case = true  
  - Type: true | false  
  - Default value: false |
| glide.ui.table.labels | Controls whether the system uses verbose labels for table names (true) or literal table names (false).  
  - Type: true | false  
  - Default value: true  
  - Location: System Property (sys_properties) table |
| glide.ui.tablet_enabled | Enables (true) or disables (false) the tablet UI.  
  - Type: true | false  
  - Default value: true  
  - Location: System Properties > Tablet UI Properties |
| glide.ui.tablet_agents | Uses the tablet UI if one of these strings (comma-separated) appears in the browser user_agent header  
  - Type: string  
  - Default value: ipad,android_tablet  
  - Location: System Properties > Tablet UI Properties |
| glide.ui.tablet.title | Displays a brief page title for tablet UI.  
  - Type: string  
  - Default value: ServiceNow  
  - Location: System Properties > Tablet UI Properties |
| glide.ui.tablet.title.ios_webapp | Displays the specified text as the default home screen icon label used in iOS version6 and later.  
  - Type: string  
  - Default value: ServiceNow  
  - Location: System Properties > Tablet UI Properties |
| glide.ui.task.insert | Enables (true) or disables (false) the use of Insert and Insert and Stay options on tables derived from Task (such as Incident, Change, and Problem).  
  - Type: true | false  
  - Default value: false  
  - Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.uitextarea.character_counter       | When true, displays a count of available characters for journal and multi-line text fields.  
  - Type: true | false  
  - Default value: false  
  - Location: System Property (sys_properties) table |
| glide.uitextarea_initial_rows            | Sets the number of rows initially displayed for multiline form elements. When the element is selected for editing, it is expanded. Set this value to 0 or blank to ignore this property. This functionality is used to conserve space on a form when multilne elements take up too much space on forms.  
  - Type: integer  
  - Default value: 0  
  - Location: System Property (sys_properties) table |
| glide.ui.update_on_iterate               | Controls whether updates are saved (true) or discarded (false) when a user clicks the blue arrows on a form.  
  - Type: true | false  
  - Default value: false  
  - Location: System Property (sys_properties) table |
| glide.ui.ui_policy_debug                 | Enables (true) or disables (false) logging of UI policy processing in the Javascript debug window  
  - Type: true | false  
  - Default value: false  
  - Location: add to the System Property (sys_properties) table |
| glide.ui.welcome.profile_link            | Enables (true) or disables (false) allowing users to click their name in the welcome message and see their user profile.  
  - Type: true | false  
  - Default value: In new instances true. In existing instances false.  
  - Location: System Property (sys_properties) table |
| glide.ui11.show_switch_link              | Displays (true) or hides (false) a banner link for switching between the UI11 and legacy interfaces.  
  - Type: true | false  
  - Default value: true  
  - Location: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.update.suppress_update_version</td>
<td>Comma-separated list of tables for which updates are not tracked in the Versions (sys_update_version) table. You cannot compare and revert versions for tables in this list.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: sys_user,sys_import_set_row</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.user.default_password</td>
<td>Default password for new users created from incoming email. Users must reset the password at first login.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: password</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.userauthgate.extauth.check</td>
<td>Enables the UserAuthenticationGate checks for external authentication mechanisms as well as internal ones.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.user.trusted_domain</td>
<td>Comma-separated list of trusted domains for which the instance automatically creates a guest user based on incoming emails. Use an asterisk (*) to trust all domains. If an email is not from a trusted domain, the instance processes the inbound email as a “guest user” however, it does not create a guest user in the instance.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: *</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Email</td>
</tr>
<tr>
<td>glide.workflow.model.cache.max</td>
<td>Maximum number of models held in the workflow cache. You must restart the instance after changing this property to apply the change.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 300</td>
</tr>
<tr>
<td></td>
<td>• Location: Workflow &gt; Properties</td>
</tr>
<tr>
<td>glide.wsdl.definition.use_unique_namespace</td>
<td>Enables (true) or disables (false) use of a unique WSDL namespace value when publishing a ServiceNow table through web services. When this property is set to true, the WSDL target namespace is <a href="http://www.service-now.com/">www.service-now.com/</a>&lt;table name&gt;.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.wsdl.maximum_hierarchy</td>
<td>Maximum number of hierarchical levels returned in a WSDL when hierarchical SOAP web service is enabled. This property has a maximum value of 3.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 3</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.xmlhttp.excessive</td>
<td>Sets the number of items visible in the Available half of a many-to-many or one-to-many collection box (slushbucket).</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 100</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.xmlprocessor.use_unload_format</td>
<td>Enables (true) or disables (false) unloading the XML using the display_value format. To unload using this format, add the parameter useUnloadFormat=true to the request URL.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.wsdl.show_nillable</td>
<td>Enables (true) or disables (false) allowing a WSDL element to be valid if it has no element content despite a (content type) which would otherwise require content.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>google.maps.auto_close</td>
<td>If true, automatically closes the current info window before opening a new one. Clear the check box to allow multiple pop-up windows to remain open at once.</td>
</tr>
<tr>
<td></td>
<td>- Type: True/false</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.client</td>
<td>Client ID for Google Maps API for Business. This is the client ID authorizing production use of Google Maps API for Business. By default, this ID is provided by ServiceNow. ServiceNow may require you to purchase a separate Client ID based on your usage.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: gme-servicenow</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>google.maps.key</td>
<td>Map key from Google, tied to the URL of the server. This is the private key authorizing development use of Google Maps.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: empty</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.latitude</td>
<td>Starting latitude of the map. This value determines the starting latitude displayed in Google Maps.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: 36.008522</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.longitude</td>
<td>Starting longitude of the map. This value determines the starting longitude displayed in Google Maps.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: -95.221764</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.max_items</td>
<td>Maximum number of items to display on the map. This setting determines how many icons can be displayed on a map.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 500</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.table</td>
<td>Table used by the map. This setting names the table containing the name, longitude, and latitude fields.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: cmn_location</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.zoom</td>
<td>Starting zoom level of the map (1 is the lowest).</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: 4</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>help.base.default</td>
<td>(Context-Sensitive Help plugin) Sets the base URL for help contexts in which ServiceNow wiki is false and an absolute URL is not specified.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>help.base.servicenow</td>
<td>(Context-Sensitive Help plugin) Sets the base URL for help contexts in which ServiceNow wiki is true.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>mid.server.rba_debug_powershell</td>
<td>Enables probe-level debugging for PowerShell probes. With this property enabled, PowerShell probes write detailed activity information to the MID Server log.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Orchestration &gt; MID Server Properties</td>
</tr>
<tr>
<td>password_reset.activity_monitor.incident_threshold</td>
<td>Determines the maximum number of lockouts before an alert is issued.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10 (lockouts)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.activity_monitor.incident_window</td>
<td>Determines the amount of time that is used for recording and counting the number of user lockouts.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 60 (minutes)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.captcha.ignore</td>
<td>Enables and disables CAPTCHA functionality.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.qa.num_enroll</td>
<td>Specifies the number of questions a user has to select and answer to be enrolled in the password reset program.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5 (questions)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This security question property can be overridden by adding a value for the num_enroll parameter in a security question verification.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>password_reset.qa.num_reset</td>
<td>Specifies the number of questions a user has to answer to verify their identity during the password reset process.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 3 (questions)</td>
</tr>
<tr>
<td></td>
<td>- Possible values: integers that are less than the number specified for the <code>num_enroll</code> property.</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>Password Reset &gt; Properties</strong></td>
</tr>
</tbody>
</table>

**Note:** This security question property can be overridden by adding a value for the `num_reset` parameter in a security question verification.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.request.max_attempt</td>
<td>Determines the number of password reset attempts a user has before they are locked out for a period determined by the value in <code>max_attempt_window</code>.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 3 (attempts)</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>Password Reset &gt; Properties</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.request.max_attempt_window</td>
<td>Determines how long a user is locked out or prevented from changing their password after trying the maximum number of times.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 1440 (minutes)</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>Password Reset &gt; Properties</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.request.retry_window</td>
<td>Determines length of time before the count for password reset attempts refreshes.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 1440 (minutes)</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>Password Reset &gt; Properties</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password_reset.request.success_window</td>
<td>Determines how long a user is locked out after they have successfully reset their password.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 10 (minutes)</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>Password Reset &gt; Properties</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>password_reset.sms.default_complexity</td>
<td>Specifies the number of characters required for a user to reset their password.</td>
</tr>
<tr>
<td></td>
<td>Note: This SMS code property can be overridden by adding a value for the complexity parameter in an SMS code verification.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 4 (digits)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.sms.expiry</td>
<td>Determines the amount of time, in minutes, until the SMS code sent to the user expires.</td>
</tr>
<tr>
<td></td>
<td>Note: This SMS code property can be overridden by adding a value for the expiry parameter in an SMS code verification.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5 (minutes)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.sms.max_per_day</td>
<td>Determines the maximum number of SMS codes that are sent to a user within one 24-hour period. When a user clicks the Send Verification Code button, the 24-hour period begins.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10 (per day)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>Note: This SMS code property can be overridden by adding a value for the max_per_day parameter in an SMS code verification.</td>
</tr>
<tr>
<td>password_reset.sms.pause_window</td>
<td>Determines the amount of time that needs to pass before another SMS code can be sent to a user.</td>
</tr>
<tr>
<td></td>
<td>Note: This SMS code property can be overridden by adding a value for the pause_window parameter in an SMS code verification.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2 (minutes)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>password_reset.wf.refresh_rate</td>
<td>Determines how often to check status of the workflow. Represented in the password reset process progress bar.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 90000 (milliseconds)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>password_reset.wf.timeout</td>
<td>Determines the maximum wait time, in milliseconds, for the workflow to execute. The workflow is triggered during the password reset request when the user clicks Submit.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 500 (milliseconds)</td>
</tr>
<tr>
<td></td>
<td>• Location: Password Reset &gt; Properties</td>
</tr>
<tr>
<td>sam.install_deletion_deadline</td>
<td>Defines the number of days after which a software install is deleted if not discovered with the configuration item. Use a value that is greater than the number of days between consecutive discovery runs.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 7</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>tablet.header.text</td>
<td>Text that appears on the right-hand side of the tablet UI header.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: ServiceNow</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Tablet UI Properties</td>
</tr>
<tr>
<td>tablet.footer.text</td>
<td>Text that appears on the footer of the tablet UI.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: Copyright ServiceNow 2012</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Tablet UI Properties</td>
</tr>
<tr>
<td>glide.bsm.map.style.text_color</td>
<td>Color of the text that appears under an unselected CI node.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: Black</td>
</tr>
<tr>
<td></td>
<td>• Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.map.style.selection_text_color</td>
<td>Color of the text that appears under a selected CI node.</td>
</tr>
<tr>
<td></td>
<td>• Type: color</td>
</tr>
<tr>
<td></td>
<td>• Default value: White</td>
</tr>
<tr>
<td></td>
<td>• Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.bsm.map.style.font_size</td>
<td>Font size of the text that appears with a CI node. The default size is magnified for nodes with more connections and reduced for downstream nodes.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 14</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.map.style.selection_background_color</td>
<td>Background color of a selected CI node. This color is also used with a node's Highlight Hierarchy option.</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default value: RoyalBlue</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.max_levels</td>
<td>Maximum level depth from the root CI that can be initially displayed in Business Service Maps. Level depth is the graph distance between the root CI and a node. This value must be an integer.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer, valid values 1 to 10</td>
</tr>
<tr>
<td></td>
<td>- Default value: 5</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.map.style.font_family</td>
<td>Font family name used in the map text. If you designate a font that is not on your users' system, the browser substitutes another font and the text may not render as you expect.</td>
</tr>
<tr>
<td></td>
<td>- Type: font name</td>
</tr>
<tr>
<td></td>
<td>- Default value: Arial</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.new_node_color</td>
<td>Color for nodes that became viewable from the last expand operation.</td>
</tr>
<tr>
<td></td>
<td>- Type: color</td>
</tr>
<tr>
<td></td>
<td>- Default value: PaleGreen</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.too_many_children</td>
<td>Maximum number of child nodes to display. Nodes are collapsed for the map to meet this limit.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer, valid values 1 or greater</td>
</tr>
<tr>
<td></td>
<td>- Default value: 10</td>
</tr>
<tr>
<td></td>
<td>- Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.bsm.color.affect_neighbors</td>
<td>Color of an affected neighbor node. When a node has a service issue, all the nodes that are dependent on that node are considered affected nodes. In the map, the affected nodes are parents or grandparents of the node with the service issue.</td>
</tr>
<tr>
<td></td>
<td>· Type: color</td>
</tr>
<tr>
<td></td>
<td>· Default value: Beige</td>
</tr>
<tr>
<td></td>
<td>· Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.max_nodes</td>
<td>Maximum number of downstream nodes to retrieve from the database for a CI. If more nodes exist in the database, they are not displayed in the map.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 1000</td>
</tr>
<tr>
<td></td>
<td>· Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.task_threshold</td>
<td>Change the CI’s glyph color from orange to red when the number of tasks reaches this threshold.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 3</td>
</tr>
<tr>
<td></td>
<td>· Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.bsm.refresh_interval</td>
<td>Seconds between each automatic reloading of troubles and tasks.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 30</td>
</tr>
<tr>
<td></td>
<td>· Range of possible values: 1 to 3600</td>
</tr>
<tr>
<td></td>
<td>· Location: BSM Map &gt; Map Properties</td>
</tr>
<tr>
<td>glide.entry.loggedin.page_ess</td>
<td>Specified the page that an ESS user, who by definition has no roles, is redirected to when the user logs in.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: none</td>
</tr>
<tr>
<td></td>
<td>· Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.required.attribute.enabled</td>
<td>Flag for enforcing required attributes (can’t be null) during identification and reconciliation.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Location: System Properties (sys_properties) table</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.class.upgrade.enabled</td>
<td>Flag for allowing class update during identification and reconciliation.</td>
</tr>
</tbody>
</table>
|                                  | - Type: true | false  
|                                  | - Default value: true  
|                                  | - Location: System Properties (sys_properties) table.                                                                                                                                                      |
| glide.class.downgrade.enabled    | Flag for allowing class downgrade during identification and reconciliation.                                                                                                                                   |
|                                  | - Type: true | false  
|                                  | - Default value: true  
|                                  | - Location: System Properties (sys_properties) table.                                                                                                                                                      |
| glide.class.switch.enabled       | Flag for allowing class switching during identification and reconciliation.                                                                                                                                   |
|                                  | - Type: true | false  
|                                  | - Default value: true  
|                                  | - Location: System Properties (sys_properties) table.                                                                                                                                                      |
| glide.reconciliation.override.null| Flag for allowing or disallowing the update of an empty field by a lower priority data source.                                                                                                               |
|                                  | - Type: true | false  
|                                  | - Default value: true  
|                                  | - Location: System Properties (sys_properties) table.                                                                                                                                                      |
| glide.identification_engine.skip_duplicates | Controls how identification processes a small set of duplicate CIs.                                                                                                                                            |
|                                  | - When true: If the number of duplicate CIs is less than the threshold specified by glide.identification_engine.skip_duplicates.threshold - then one of the duplicate CIs is picked as a match and gets updated. The rest of the duplicate CIs are tagged as duplicates.  
|                                  | - When false: Matching a CI fails, and an error is logged.                                                                                                                                                    |
|                                  | - Type: true | false  
|                                  | - Default value: true  
<p>|                                  | - Location: add to the System Properties (sys_properties) table.                                                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.identification_engine.skip_duplicates.threshold | Maximum number of CIs that can be in a set of duplicate CIs to allow identification to process the duplicate CIs according to the setting of glide.identification_engine.skip_duplicates. If the number of duplicate CIs exceeds the threshold, then identification processes the duplicate CIs as if glide.identification_engine.skip_duplicates is set to false, regardless of what it is set to.  
- Type: integer  
- Default value: 5  
- Location: add to the System Properties (sys_properties) table. |
| Enable alert aggregation | Enables aggregation of correlated alerts for services and alert groups.  
- Type: true | false  
- Default value: true  
- Location: Service Analytics > Properties |
| Enable root cause analysis for business services | Enables RCA for alerts associated with business services, to identify root cause CIs.  
- Type: true | false  
- Default value: false  
- Location: Service Analytics > Properties |
| Include CIs associated with business services, in alert aggregation |  
- Type: true | false  
- Default value: true  
- Location: Service Analytics > Properties |
| sa_analytics.rca.output_purge_days | Number of days that RCA output is kept before it is purged.  
- Type: integer  
- Default value: 3  
- Range of possible values: 3-5  
- Location: System Property (sys_properties) table |
| Purge staging tables (in days) | Number of days that RCA input is kept before it is purged.  
- Type: integer  
- Default value: 90  
- Range of possible values: 30-180  
- Location: Service Analytics > Properties |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time interval (in seconds) criteria for grouping alerts</td>
<td>Interval that alerts must be created in, to be included in a group. &lt;br&gt;<strong>sa_analytics.rca.learner_group_interval_secs</strong>&lt;br&gt;· Type: integer &lt;br&gt;· Default value: 300 &lt;br&gt;· Range of possible values: 60-900 &lt;br&gt;· Location: <strong>Service Analytics &gt; Properties</strong></td>
</tr>
<tr>
<td>Length of time period (in seconds) from which to include alerts for analysis</td>
<td>Period of past time from which to include alerts in alert aggregation analysis. &lt;br&gt;<strong>sa_analytics.rca.learner_query_interval_secs</strong>&lt;br&gt;· Type: integer &lt;br&gt;· Default value: 86400 &lt;br&gt;· Range of possible values: 43200-86400 &lt;br&gt;· Location: <strong>Service Analytics &gt; Properties</strong></td>
</tr>
<tr>
<td>Confidence score % threshold, above which RCA correlated alert groups will be displayed in the Event Management dashboard and alerts console</td>
<td>Confidence score that must be met by RCA correlated alert groups before the groups are displayed on the Event Management dashboard and alerts console. &lt;br&gt;<strong>sa_analytics.rca.query_probability_threshold</strong>&lt;br&gt;· Type: integer &lt;br&gt;· Default value: 0 &lt;br&gt;· Range of possible values: 0-100 &lt;br&gt;· Location: <strong>Service Analytics &gt; Properties</strong></td>
</tr>
<tr>
<td>Alert severity threshold, above which alerts will be included in analysis</td>
<td>Only alerts with severity that is above the threshold are included in alert aggregations and root cause CI analysis. &lt;br&gt;<strong>sa_analytics.alert.severity_threshold</strong>&lt;br&gt;· Type: choice list &lt;br&gt;· Default value: Info &lt;br&gt;· Other possible values: Warning, Minor, Major, Critical &lt;br&gt;· Location: <strong>Service Analytics &gt; Properties</strong></td>
</tr>
</tbody>
</table>

**Add a system property**

Add or create a property to control system behavior.

Role required: admin

Some properties in the system are not visible in an instance by default and must be added to the System Property (sys_properties) table. You can add a system property if a feature requires the addition of the property.

**Important:** System properties store configuration information that rarely or never changes. Each time you change or add a system property, the system flushes the cache to keep all nodes in the cluster in synch. This cache flush has a very high performance cost for one to ten minutes, which can potentially cause an outage if done excessively. To prevent such outages, do not use a system property to store configuration information that changes...
more than once or twice a month. Instead, use a custom table to store regularly changing configuration information.

1. In the Navigation filter, enter `sys_properties.list`. The entire list of properties in the System Properties (sys_properties) table appears.
2. Verify the property does not already exist by searching for the property name.
3. Click New.
4. Complete the System Property form using the database name of the property.

Make sure to specify the correct data Type and add the new value that you want the property to use.

Properties that you add already contain default values. You add properties to change this value.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property you are creating.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief, descriptive phrase describing the function of the property.</td>
</tr>
<tr>
<td>Choices</td>
<td>Comma-separated values for a choice list. If you need a different choice list label and value, use an equal sign (=) to separate the label from the value. For example, Blue=0000FF, Red=FF0000, Green=00FF00 displays Blue, Red, and Green in the list, and saves the corresponding hex value in the property value field.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the appropriate data type from the list (for example, integer, string, or true</td>
</tr>
<tr>
<td>Value</td>
<td>Set the desired value for property. All property values are stored as strings. When retrieving properties via the <code>gs.getProperty()</code> method, treat the results as strings. For example, a true</td>
</tr>
<tr>
<td>Ignore cache</td>
<td>Set this option to true to refresh the cache before processing the property. The cache stores commonly used items in memory such as forms and UI elements. Typically, you only ignore the cache if the system property depends upon a dynamic change on the form, and you want to ensure that the property uses the current value rather than a cached value.</td>
</tr>
<tr>
<td>Private</td>
<td>Set this property to true to exclude this property from being imported via update sets. Keeping system properties private prevents settings in one instance from overwriting values in another instance. For example, you may not want a system property in a development instance to use the same value as a production instance.</td>
</tr>
<tr>
<td>Read roles</td>
<td>Define the roles that have read access to this property.</td>
</tr>
</tbody>
</table>
5. Click **Submit.**

Depending on the property name, an administrator might be able to change its value only through a new module. It may also appear in one of the Properties pages in System Properties. For example, any property whose name begins with `glide.ui` automatically appears in the System Properties > UI Properties page.

---

**Note:** If the Ignore cache check box is selected, the system flushes the server cache when the parameter is changed.

---

### Create a system properties module

You can add a module in the application navigator to access the list of system properties. This module makes it easy to add properties to the System Properties table.

Role required: admin

1. Navigate to **System Definition > Application Menus.**
2. Search for the application you want to add the properties table to, for example **System Properties.**
   
   Select an application that is restricted to the admin role so that non-admin users cannot access it.
3. From the Modules related list, click **New.**
4. Complete the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Module name. For example, All Properties.</td>
</tr>
<tr>
<td><strong>Application Menu</strong></td>
<td>Specifies the name of the application menu the module appears under. This field should automatically be populated with the name of the application you accessed the Modules related list from.</td>
</tr>
<tr>
<td><strong>Link type</strong></td>
<td>Specifies the type of link this module opens. For a list of system properties, select List of Records.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Specifies the table used by the module. Select System Properties (sys_properties).</td>
</tr>
</tbody>
</table>

5. Click **Submit.**
6. Verify that the module was created. For example, navigate to **System Properties > All Properties.**

If you want to include additional parameters for the list of system properties module, see Create a module.

---

### Handle HTTP 500 errors

The HTTP 500 error is a generic error message that Internet Explorer passes to you when your web site errors for one reason or another, but it provides no useful information by itself.
We can change this setting, to allow you to see and read what the real error is. Good error information is essential to the debugging of any application, and the HTTP 500 error may in fact provide more information to the ServiceNow support team.

To enable Internet Explorer to show you the root cause of any error in your code, you need to make a change in the Internet Options window. You can access the Internet Options window by selecting the **Internet Options** item from the **Tools** menu at the top of Internet Explorer.

1. Select the **Advanced** tab.

2. Accessing the Advanced options displays a window that contains many settings that can be changed within Internet Explorer. These settings are broken down into categories. The category we are interested in is the **Browsing** Category.
3. Scrolling down the window will bring you to the Show friendly HTTP error messages check box. By default this box is checked in order to hide the real error from users. Once you have located this check box, remove the check and click the OK button.

You can now report any problem pages that you have had difficulty with and see the real error message that is being generated. Once you can see what the real error message is, then providing debugging information to the ServiceNow support team becomes so much easier.

Query join and complexity size limits

The platform uses a relational database to store data. Retrieving data can involve multiple joins to create a single result set. While these joins are usually simple, in certain cases the system may issue very large joins to bring together large numbers (>20) of tables.
Database engines normally handle multiple joins quite well. The relational model assumes joins are cheap and efficient, and this is usually true. Rarely, however, exceedingly large joins may cause a database performance issue.

To mitigate this potential complexity, use the following property to limit join complexity and size. Navigate to System Properties > System and find the property with this description:

Max number of database joins per query. Smaller values cause the system to issue a larger number of less complex queries. Larger values reduce the number of queries at the cost of additional complexity per query. In the absence of known database issues stemming from large join counts, this property should remain unchanged.

**Query complexity limits**

This property specifies the maximum number of joins the system prefers to do. In certain edge cases, more complex queries might need to be issued, but generally no more than this number of joins will be issued. e.g., a value of 10 will result in no more than 10 tables being joined together in any given query.

The system must compensate for the fewer joins by issuing more queries to retrieve necessary data, so tuning this number down will result in more queries being sent to the database. In most cases, tuning this parameter is counterproductive.

**Note:** In the absence of known database issues stemming from large join counts, this parameter should remain unchanged.

### Tables and classes

Administrators can use the schema map, Tables module, or the system dictionary to determine which system tables extend other tables.

#### Tables that are extensions of other tables

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Label</th>
<th>Extension of</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>ast_lease</td>
<td>Lease</td>
<td>ast_contract</td>
<td>Contract</td>
</tr>
<tr>
<td>ast_license_adobe</td>
<td>Adobe Software</td>
<td>ast_license_base</td>
<td>Base License Table</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ast_license_generic</td>
<td>Generic Software</td>
<td>ast_license_base</td>
<td>Base License Table</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ast_license_msft</td>
<td>Microsoft Software</td>
<td>ast_license_base</td>
<td>Base License Table</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ast_license_symantec</td>
<td>Symantec Software</td>
<td>ast_license_base</td>
<td>Base License Table</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ast_service</td>
<td>Service Contract</td>
<td>ast_contract</td>
<td>Contract</td>
</tr>
<tr>
<td>ast_warranty</td>
<td>Warranty</td>
<td>ast_contract</td>
<td>Contract</td>
</tr>
<tr>
<td>bsm_action</td>
<td>BSM Map Actions</td>
<td>diagrammer_action</td>
<td>Diagrammer Actions</td>
</tr>
<tr>
<td>Table Name</td>
<td>Label</td>
<td>Extension of</td>
<td>Label</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------</td>
<td>-------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>catalog_script_client</td>
<td>Catalog Client Scripts</td>
<td>sys_script_client</td>
<td>Client Script</td>
</tr>
<tr>
<td>catalog_ui_policy</td>
<td>Catalog UI Policy</td>
<td>sys_ui_policy</td>
<td>UI Policy</td>
</tr>
<tr>
<td>catalog_ui_policy_action</td>
<td>Catalog UI Policy Action</td>
<td>sys_ui_policy_action</td>
<td>UI Policy Action</td>
</tr>
<tr>
<td>change_phase</td>
<td>Change Phase</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>change_request</td>
<td>Change Request</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>change_request_imac</td>
<td>IMAC</td>
<td>change_request</td>
<td>Change Request</td>
</tr>
<tr>
<td>change_task</td>
<td>Change Task</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>cmdb_ci_acc</td>
<td>Accessory</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_aix_server</td>
<td>AIX Server</td>
<td>cmdb_ci_unix_server</td>
<td>Unix Server</td>
</tr>
<tr>
<td>cmdb_ci_apache_web_server</td>
<td>Apache Web Server</td>
<td>cmdb_ci_web_server</td>
<td>Web Server</td>
</tr>
<tr>
<td>cmdb_ci_appl</td>
<td>Application</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_application_so</td>
<td>Application Software</td>
<td>cmdb_ci_spkg</td>
<td>Software</td>
</tr>
<tr>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
<td>cmdb_ci_apppl</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_app_server_domino</td>
<td>Domino</td>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
</tr>
<tr>
<td>cmdb_ci_app_server_ja</td>
<td>Java Server</td>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
</tr>
<tr>
<td>cmdb_ci_app_server_omns</td>
<td>Jboss</td>
<td>cmdb_ci_app_server</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_app_server_radio</td>
<td>Weblogic</td>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
</tr>
<tr>
<td>cmdb_ci_app_server_weblogic</td>
<td>IBM Websphere</td>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
</tr>
<tr>
<td>cmdb_ci_app_server_websphere</td>
<td>IBM Websphere</td>
<td>cmdb_ci_app_server</td>
<td>Application Server</td>
</tr>
<tr>
<td>cmdb_ci_business_process</td>
<td>Business Process</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_circuit</td>
<td>Circuit</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_cluster</td>
<td>Cluster</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_cluster_node</td>
<td>Cluster Node</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_cluster_resource</td>
<td>Cluster Resource</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_cluster_vip</td>
<td>Cluster Virtual IP</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_comm</td>
<td>Communication Device</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_computer</td>
<td>Computer</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_computer_room</td>
<td>Computer Room</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_crac</td>
<td>Computer Room AC</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_database</td>
<td>Database</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_datacenter</td>
<td>Data Center</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_catalog</td>
<td>DB2 Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
</tr>
<tr>
<td>cmdb_ci_db_db2_instance</td>
<td>DB2 Instance</td>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
</tr>
<tr>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
<td>cmdb_ci_apppl</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_catalog</td>
<td>MSFT SQL Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
</tr>
<tr>
<td>Table Name</td>
<td>Label</td>
<td>Extension of</td>
<td>Label</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------</td>
<td>-----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>cmdb_ci_db_mssql_instance</td>
<td>MSFT SQL Instance</td>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_catalog</td>
<td>MySQL Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
</tr>
<tr>
<td>cmdb_ci_db_mysql_instance</td>
<td>MySQL Instance</td>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_catalog</td>
<td>Oracle Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
</tr>
<tr>
<td>cmdb_ci_db_ora_instance</td>
<td>Oracle Instance</td>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_catalog</td>
<td>Sybase Catalog</td>
<td>cmdb_ci_db_catalog</td>
<td>Database Catalog</td>
</tr>
<tr>
<td>cmdb_ci_db_syb_instance</td>
<td>Sybase Instance</td>
<td>cmdb_ci_db_instance</td>
<td>Database Instance</td>
</tr>
<tr>
<td>cmdb_ci_desktop_software</td>
<td>Desktop Software</td>
<td>cmdb_ci_spkg</td>
<td>Software</td>
</tr>
<tr>
<td>cmdb_ci_directory_server</td>
<td>Directory Server</td>
<td>cmdb_ci_inra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_disk</td>
<td>Disk</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_email_server</td>
<td>Email Server</td>
<td>cmdb_ci_inra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_esx_server</td>
<td>ESXi Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_file_system</td>
<td>File System</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_file_system_nfs</td>
<td>NFS File System</td>
<td>cmdb_ci_file_system</td>
<td>File System</td>
</tr>
<tr>
<td>cmdb_ci_file_system_smb</td>
<td>SMB File System</td>
<td>cmdb_ci_file_system</td>
<td>File System</td>
</tr>
<tr>
<td>cmdb_ci_ftp_server</td>
<td>FTP Server</td>
<td>cmdb_ci_inra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_group</td>
<td>Group</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_hpux_server</td>
<td>HPUX Server</td>
<td>cmdb_ci_unix_server</td>
<td>Unix Server</td>
</tr>
<tr>
<td>cmdb_ci_infra_service</td>
<td>Infrastructure Service</td>
<td>cmdb_ci_appl</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_infra_service_ldap</td>
<td>LDAP Service</td>
<td>cmdb_ci_inra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_inf_software</td>
<td>Infrastructure Software</td>
<td>cmdb_ci_spkg</td>
<td>Software</td>
</tr>
<tr>
<td>cmdb_ci_ip_device</td>
<td>IP Device</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ip_network</td>
<td>IP Network</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ip_phone</td>
<td>IP Phone</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ip_router</td>
<td>IP Router</td>
<td>cmdb_ci_netgear</td>
<td>Network Gear</td>
</tr>
<tr>
<td>cmdb_ci_ip_server</td>
<td>IP Server</td>
<td>cmdb_ci_inra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_ip_service</td>
<td>IP Service</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ip_switch</td>
<td>IP Switch</td>
<td>cmdb_ci_netgear</td>
<td>Network Gear</td>
</tr>
<tr>
<td>cmdb_ci_ipplanet_web_server</td>
<td>Internet Web Server</td>
<td>cmdb_ci_web_server</td>
<td>Web Server</td>
</tr>
<tr>
<td>cmdb_ci_linux_server</td>
<td>Linux Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_mainframe</td>
<td>IBM Mainframe</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_mainframe_lpar</td>
<td>IBM Mainframe LPAR</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_microsoft_iis_web_server</td>
<td>IIS Web Server</td>
<td>cmdb_ci_web_server</td>
<td>Web Server</td>
</tr>
<tr>
<td>cmdb_ci_msd</td>
<td>Storage Device</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_netgear</td>
<td>Network Gear</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_netware_server</td>
<td>Netware Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_network_adapter</td>
<td>Network Adapter</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>Table Name</td>
<td>Label</td>
<td>Extension of</td>
<td>Label</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------</td>
<td>--------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_net_traffic</td>
<td>Network Traffic</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_nginx_web_server</td>
<td>NGINX Web Server</td>
<td>cmdb_ci_web_server</td>
<td>Web Server</td>
</tr>
<tr>
<td>cmdb_ci_osx_server</td>
<td>OS/X Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_patches</td>
<td>Patch</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_pdu</td>
<td>PDU</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_pdu_outlet</td>
<td>Outlet</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_peripheral</td>
<td>Computer Peripheral</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_printer</td>
<td>Printer</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_print_queue</td>
<td>Print Queue</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_rack</td>
<td>Rack</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_server</td>
<td>Server</td>
<td>cmdb_ci_computer</td>
<td>Computer</td>
</tr>
<tr>
<td>cmdb_ci_service</td>
<td>Business Service</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_snc_component</td>
<td>SNC Component</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_solaris_server</td>
<td>Solaris Server</td>
<td>cmdb_ci_unix_server</td>
<td>Unix Server</td>
</tr>
<tr>
<td>cmdb_ci_spkg</td>
<td>Software</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_tomcat_connector</td>
<td>Tomcat Connector</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_unix_daemon</td>
<td>Unix Daemon</td>
<td>cmdb_ci_ip_service</td>
<td>IP Service</td>
</tr>
<tr>
<td>cmdb_ci_unix_server</td>
<td>Unix Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_ups</td>
<td>UPS</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ups_alarm</td>
<td>UPS Alarm</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ups_bypass</td>
<td>UPS Bypass</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ups_input</td>
<td>UPS Input</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_ups_output</td>
<td>UPS Output</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_vm</td>
<td>Virtual Machine</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_vm_parallels</td>
<td>Parallels</td>
<td>cmdb_ci_vm</td>
<td>Virtual Machine</td>
</tr>
<tr>
<td>cmdb_ci_vm_vmware</td>
<td>VMware</td>
<td>cmdb_ci_vm</td>
<td>Virtual Machine</td>
</tr>
<tr>
<td>cmdb_ci_vm_zones</td>
<td>Zones</td>
<td>cmdb_ci_vm</td>
<td>Virtual Machine</td>
</tr>
<tr>
<td>cmdb_ci_vpn</td>
<td>Virtual Private Network</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_websphere_cell</td>
<td>Websphere Cell</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_ci_web_application</td>
<td>Web Application</td>
<td>cmdb_ci_appl</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_webserver</td>
<td>Web Server</td>
<td>cmdb_ci_infra_service</td>
<td>Infrastructure Service</td>
</tr>
<tr>
<td>cmdb_ci_website</td>
<td>Web Site</td>
<td>cmdb_ci_appl</td>
<td>Application</td>
</tr>
<tr>
<td>cmdb_ci_winservice</td>
<td>Windows Service</td>
<td>cmdb_ci_ip_service</td>
<td>IP Service</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster</td>
<td>Windows Cluster</td>
<td>cmdb_ci_cluster</td>
<td>Cluster</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_node</td>
<td>Windows Cluster Node</td>
<td>cmdb_ci_cluster_node</td>
<td>Cluster Node</td>
</tr>
<tr>
<td>Table Name</td>
<td>Label</td>
<td>Extension of</td>
<td>Label</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------</td>
<td>------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>cmdb_ci_win_cluster_resource</td>
<td>Windows Cluster Resource</td>
<td>cmdb_ci_cluster_resource</td>
<td>Cluster Resource</td>
</tr>
<tr>
<td>cmdb_ci_win_server</td>
<td>Windows Server</td>
<td>cmdb_ci_server</td>
<td>Server</td>
</tr>
<tr>
<td>cmdb_ci_zone</td>
<td>Zone</td>
<td>cmdb_ci</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>cmdb_metric_cpu</td>
<td>CI CPU Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_db_connection</td>
<td>DB Connection Metric</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_errors</td>
<td>Errors Logged</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_events_processed</td>
<td>Events Processed</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_event_log</td>
<td>Events Logged</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_java</td>
<td>CI Java Metric</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_linux_memory</td>
<td>Linux Memory Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_load</td>
<td>CI Load Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_logs</td>
<td>CI Log Count</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_mysql_stat</td>
<td>CI MySQL Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_oracle</td>
<td>CI Oracle Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_partition</td>
<td>Partition Read/Write Statistics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_semaphore</td>
<td>CI Semaphore Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_service_now</td>
<td>CI Service-Now Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_sql</td>
<td>SQL Response Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>cmdb_metric_transaction</td>
<td>CI Transaction Metrics</td>
<td>cmdb_metric</td>
<td>CI Metric</td>
</tr>
<tr>
<td>discovery_probes_multi</td>
<td>Multiprobe</td>
<td>discovery_probes</td>
<td>Probe</td>
</tr>
<tr>
<td>discovery_probes_snmp</td>
<td>SNMP Probe</td>
<td>discovery_probes</td>
<td>Probe</td>
</tr>
<tr>
<td>discovery_probes_wmi</td>
<td>WMI Probe</td>
<td>discovery_probes</td>
<td>Probe</td>
</tr>
<tr>
<td>ecc_agent_counter_metric</td>
<td>ECC Agent Counter Metric</td>
<td>ecc_agent_metric</td>
<td>ECC Agent Metric</td>
</tr>
<tr>
<td>ecc_agent_memory_metric</td>
<td>ECC Agent Memory Metric</td>
<td>ecc_agent_metric</td>
<td>ECC Agent Metric</td>
</tr>
<tr>
<td>ecc_agent_rgr_metric</td>
<td>ECC Agent RGR Metric</td>
<td>ecc_agent_metric</td>
<td>ECC Agent Metric</td>
</tr>
<tr>
<td>ecc_agent_scalar_metric</td>
<td>ECC Agent Scalar Metric</td>
<td>ecc_agent_metric</td>
<td>ECC Agent Metric</td>
</tr>
<tr>
<td>expert_panel_catalog_checkout</td>
<td>Catalog Checkout Panel</td>
<td>expert_panel</td>
<td>Wizard Panel</td>
</tr>
<tr>
<td>expert_panel_catalog_order</td>
<td>Catalog Order</td>
<td>expert_panel</td>
<td>Wizard Panel</td>
</tr>
<tr>
<td>expert_panel_knowledge</td>
<td>KB Viewer</td>
<td>expert_panel</td>
<td>Wizard Panel</td>
</tr>
<tr>
<td>expert_panel_template</td>
<td>Record Generator</td>
<td>expert_panel</td>
<td>Wizard Panel</td>
</tr>
<tr>
<td>expert_script_client</td>
<td>Wizard Client Script</td>
<td>sys_script_client</td>
<td>Client Script</td>
</tr>
<tr>
<td>expert_variable</td>
<td>Wizard Variable</td>
<td>question</td>
<td>Question</td>
</tr>
<tr>
<td>Table Name</td>
<td>Label</td>
<td>Extension of</td>
<td>Label</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------</td>
<td>----------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>import_log</td>
<td>Import Log</td>
<td>syslog</td>
<td>Log Entry</td>
</tr>
<tr>
<td>imp_computer</td>
<td>Computer</td>
<td>sys_import_set_row</td>
<td>Import Set Row</td>
</tr>
<tr>
<td>imp_location</td>
<td>Location</td>
<td>sys_import_set_row</td>
<td>Import Set Row</td>
</tr>
<tr>
<td>imp_notification</td>
<td>Notification</td>
<td>sys_import_set_row</td>
<td>Import Set Row</td>
</tr>
<tr>
<td>imp_user</td>
<td>User</td>
<td>sys_import_set_row</td>
<td>Import Set Row</td>
</tr>
<tr>
<td>incident</td>
<td>Incident</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>item_option_new</td>
<td>Variable</td>
<td>question</td>
<td>Question</td>
</tr>
<tr>
<td>kb_submission</td>
<td>KB Submission</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>ola</td>
<td>OLA</td>
<td>sla</td>
<td>SLA</td>
</tr>
<tr>
<td>plan_mysql</td>
<td>Plan MySQL</td>
<td>plan_execution</td>
<td>Plan Execution</td>
</tr>
<tr>
<td>plan_oracle</td>
<td>Plan Oracle</td>
<td>plan_execution</td>
<td>Plan Execution</td>
</tr>
<tr>
<td>problem</td>
<td>Problem</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>process_step_approval</td>
<td>Approval Steps</td>
<td>process_step</td>
<td>Process Steps</td>
</tr>
<tr>
<td>release_phase</td>
<td>Release Phase</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>release_task</td>
<td>Release Task</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>scheduled_data_import</td>
<td>Scheduled Data Import</td>
<td>sysauto</td>
<td>Scheduled Job</td>
</tr>
<tr>
<td>scheduled_import_set</td>
<td>Scheduled Data Import</td>
<td>scheduled_data_import</td>
<td>Scheduled Data Import</td>
</tr>
<tr>
<td>sc_category_top_n</td>
<td>Dynamic Category</td>
<td>sc_category</td>
<td>Category</td>
</tr>
<tr>
<td>sc_cat_item_content</td>
<td>Content Item</td>
<td>sc_cat_item</td>
<td>Catalog Item</td>
</tr>
<tr>
<td>sc_cat_item_dt_approval</td>
<td>Execution Plan Approval Task</td>
<td>sc_cat_item_delivery_task</td>
<td>Execution Plan Task</td>
</tr>
<tr>
<td>sc_cat_item_guide</td>
<td>Order Guide</td>
<td>sc_cat_item</td>
<td>Catalog Item</td>
</tr>
<tr>
<td>sc_cat_item_producer</td>
<td>Record Producer</td>
<td>sc_cat_item</td>
<td>Catalog Item</td>
</tr>
<tr>
<td>sc_cat_item_wizard</td>
<td>Wizard Launcher</td>
<td>sc_cat_item</td>
<td>Catalog Item</td>
</tr>
<tr>
<td>sc_request</td>
<td>Request</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>sc_req_item</td>
<td>Requested Item</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>sc_task</td>
<td>Catalog Task</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>survey_question_new</td>
<td>Question</td>
<td>question</td>
<td>Question</td>
</tr>
<tr>
<td>sysapproval_group</td>
<td>Group Approval</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>sysauto_report</td>
<td>Scheduled Email of Report</td>
<td>sysauto</td>
<td>Scheduled Job</td>
</tr>
<tr>
<td>sysauto_script</td>
<td>Scheduled Script Extension</td>
<td>sysauto</td>
<td>Scheduled Job</td>
</tr>
<tr>
<td>sysauto_template</td>
<td>Scheduled Entity Generation</td>
<td>sysauto</td>
<td>Scheduled Job</td>
</tr>
<tr>
<td>sysevent_email_action</td>
<td>Email Notification</td>
<td>syrule</td>
<td>Rule</td>
</tr>
<tr>
<td>sysevent_in_email_action</td>
<td>Inbound Email Actions</td>
<td>syrule</td>
<td>Rule</td>
</tr>
<tr>
<td>sysevent_script_action</td>
<td>Script Action</td>
<td>syrule</td>
<td>Rule</td>
</tr>
</tbody>
</table>
Using accessibility features

Accessibility features include keyboard navigation, color and style settings, using a screen reader, and search methods.

Keyboard accessibility

The Now Platform is designed to be as accessible as possible without user modification or setting changes. Users can tab through the platform UI without enabling accessibility. However, without accessibility enabled, tabbing goes from input to input and skips other items on a form, such as reference icons.

Tab-through provides the following options:

- Use skip links to shift focus to different parts of the page without tabbing through every element.
- On edit pages such as forms, the keyboard focus starts at the first editable field on the page.
- If the glide.ui.accessibility.focus_first_field user preference is enabled, page focus starts at the first input field at the top of the page content section. In a table, this field is usually the search option. In a form, the field is the first input field in the form.
- Use tab-through and arrow keys to move items around in a slushbucket.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Label</th>
<th>Extension of</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>syslog_transaction</td>
<td>Transaction Log Entry</td>
<td>syslog</td>
<td>Rule</td>
</tr>
<tr>
<td>sysrule_approvals</td>
<td>Approval Rules</td>
<td>sysrule</td>
<td>Rule</td>
</tr>
<tr>
<td>sysrule_assignment</td>
<td>Assignment Rules</td>
<td>sysrule</td>
<td>Rule</td>
</tr>
<tr>
<td>sysrule_escalate</td>
<td>Service Level Agreement</td>
<td>sysrule</td>
<td>Rule</td>
</tr>
<tr>
<td>sysrule_escalate_am</td>
<td>Inactivity Monitor</td>
<td>sysrule_escalate</td>
<td>Service Level Agreement</td>
</tr>
<tr>
<td>sysrule_view</td>
<td>View Rule</td>
<td>sysrule</td>
<td>Rule</td>
</tr>
<tr>
<td>ticket</td>
<td>Ticket</td>
<td>task</td>
<td>Task</td>
</tr>
<tr>
<td>var_dictionary</td>
<td>Variables</td>
<td>sys_dictionary</td>
<td>Dictionary</td>
</tr>
<tr>
<td>v_field_editor</td>
<td>Edit Field</td>
<td>v_field_creator</td>
<td>Create Field</td>
</tr>
<tr>
<td>v_table_editor</td>
<td>Edit Table</td>
<td>v_table_creator</td>
<td>Create Table</td>
</tr>
<tr>
<td>v_ws_creator</td>
<td>Create Web Service</td>
<td>v_table_creator</td>
<td>Create Table</td>
</tr>
<tr>
<td>v_ws_editor</td>
<td>Edit Web Service</td>
<td>v_ws_creator</td>
<td>Create Web Service</td>
</tr>
<tr>
<td>v_ws_field_creator</td>
<td>Create Web Service Field</td>
<td>v_field_creator</td>
<td>Create Field</td>
</tr>
<tr>
<td>v_ws_field_editor</td>
<td>Edit Web Service Field</td>
<td>v_field_editor</td>
<td>Edit Field</td>
</tr>
<tr>
<td>wf_activity_variable</td>
<td>Activity Variables</td>
<td>var_dictionary</td>
<td>Variables</td>
</tr>
<tr>
<td>wf_log</td>
<td>Workflow Log Entry</td>
<td>syslog</td>
<td>Log Entry</td>
</tr>
<tr>
<td>wf_variable</td>
<td>Workflow SC Variable</td>
<td>item_option_new</td>
<td>Variable</td>
</tr>
<tr>
<td>wf_workflow_schedule</td>
<td>Workflow Schedule</td>
<td>sysauto_script</td>
<td>Scheduled Script Execution</td>
</tr>
</tbody>
</table>
• When focused on tabs, use right/left arrow keys to switch tabs
• Arrows keys work within menus to navigate between entries
• On tab-through for a list, the option to enable the **Edit table data inline** appears, so you can use the list editor, rather than opening the form.
  • When inline edit mode is enabled, screen focus shifts to the first cell in the table.
  • Press the Escape key while a cell is selected to exit inline edit mode. Focus still remains on the cell.
  • Use the arrow keys (in addition to tabbing) to move around the list in inline edit mode.
• If accessibility is enabled, a help icon appears with the HTML field. The help icon indicates how to access and escape the HTML field toolbar.

**Color and style accessibility**
There are several color and style changes that make the platform more accessible.

**Enable the Contrast UI theme**

In the system settings, on the themes tab, select the Contrast UI theme. The Contrast UI theme provides a higher contrast range of colors for the platform UI.

In Service Portal, you can apply the Stock - High Contrast theme to a portal for a higher contrast color range. Portal users also have the option to enable a contrast theme using the **Accessibility** option in the User Profile widget.

**Patterned charts and graphs**

View charts and graphs that rely heavily on color with patterns in addition to colors. Navigate to **System settings > General**, then select **Data visualization patterns enabled**.
Users by Location

- 27, Boulevard Vitton, Paris = 63 (10.84%)
- 3 Whitehall Court, London = 48 (8.28%)
- Paradise Road, Richmond, London = 39 (6.71%)
- 30 Katharine
- Bockenheimer Landstraße 223, Frankfurt = 28 (4.82%)

Data visualization patterns enabled
Screen reader accessibility

Screen elements in the platform have enhancements that make them accessible to screen readers.

Use NVDA, JAWS, or VoiceOver for non-visual access to the platform.

Skip links allow you to tab straight to the main content instead of tabbing through all the other elements on the page.

When a page reloads or search results display, screen readers inform the user.

Important images and field indicators, for example, status indicators for avatars in list v3, have alternative text for screen readers to read.

In order to reduce confusion when tabbing through modules, the edit application/edit module and add to favorites icons are now inaccessible to screen readers.

In Service Portal, users can add alternative text to containers in their own portal for screen readers to read.

Elements such as links or button are listed as such for screen reader awareness.

Accessibility search methods

There are several ways to search for information in the user interface.

- When a list opens, focus starts in the search field. Tab or shift+tab to navigate away from the search, or start typing while focus is in the search field.
- List views include a Go to search field in the list title bar. Using the * wildcard character in the search text allows you to perform a contains search rather than a starts with search. This type of query may take a little longer to run but can save keystrokes. You can also use several other wildcards with list searches.
- The navigation filter in the application navigator filters the applications and modules that appear in the navigator based on the entered text. Tab through or use skip links to navigate directly to the navigation filter. To open a module, click the module name, or press the Down Arrow to highlight the module name, and then press Enter.

See Available search options for more information about these search methods.

Web proxy

Several properties support Web proxy configuration.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.http.proxy_host</td>
<td>Specify the proxy server hostname or IP address.</td>
<td>proxy.company.com, 192.168.34.54</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Examples</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>glide.http.proxy_port</td>
<td>Specify the port number for the proxy server.</td>
<td>8080, 9100</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
<td></td>
</tr>
<tr>
<td>glide.http.proxy_username</td>
<td>Specify the username used to authenticate the proxy server.</td>
<td>proxyuser</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
<td></td>
</tr>
<tr>
<td>glide.http.proxy_password</td>
<td>Specify the password used to authenticate the proxy server.</td>
<td>password</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
<td></td>
</tr>
<tr>
<td>glide.email.override.url</td>
<td>Set the URL to use in emailed links in place of the instance URL. The URL should end with nav_to.do.</td>
<td><a href="https://servicenow.customerdomain.com/production/nav_to.do">https://servicenow.customerdomain.com/production/nav_to.do</a></td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default value: instance URL</td>
<td></td>
</tr>
</tbody>
</table>

**NTLM authentication**

NTLM is the most complex of the authentication protocols supported by a basic web server. NTLM is the most complex of the authentication protocols supported by a basic web server such as HttpClient. It is a proprietary protocol designed by Microsoft with no publicly available specification. Early versions of NTLM were less secure than Digest authentication due to faults in the design. However, these were fixed in a service pack for Windows NT 4 and the protocol is now considered more secure than Digest authentication.

NTLM authentication requires that an instance of NTCredentials be available for the domain name of the server or the default credentials. Since NTLM does not use the notion of realms, HttpClient uses the domain name of the server as the name of the realm. Also, the username provided to the NTCredentials should not be prefixed with the domain:

- Correct: adrian
- Incorrect: DOMAIN\adrian

There are some significant differences in the way NTLM works compared with basic and digest authentication. These differences are generally handled by HttpClient. However, having an understanding of these differences can help you avoid problems when using NTLM authentication.

- NTLM authentication works almost exactly the same as any other form of authentication in terms of the HttpClient API. The only difference is that you need to supply NTCredentials instead of UsernamePasswordCredentials (NTCredentials actually extends UsernamePasswordCredentials so you can use NTCredentials right throughout your application, if needed).
- The realm for NTLM authentication is the domain name of the computer being connected. This can be troublesome because servers often have multiple domain names. Only the domain
name that HttpClient connects to, as specified by the HostConfiguration, is used to look up the credentials. While initially testing NTLM authentication, it is best to pass the realm in as null, which is used as the default.

- NTLM authenticates a connection and not a request. So you need to authenticate every time a new connection is made and keeping the connection open during authentication is vital. For this reason, NTLM cannot be used to authenticate with both a proxy server and the web server, nor can NTLM be used with HTTP 1.0 connections or web servers that do not support HTTP keep-alives.

**Note:** Set these properties from the System Properties [sys_properties] table.

### NTLM authentication

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| glide.http.proxy_ntusername | Specify the username used to authenticate the proxy server with NTLM authentication.  
• Type: string  
• Default value: none | username |
| glide.http.proxy_ntpassword | Specify the password used to authenticate the proxy server with NTLM authentication.  
• Type: string  
• Default value: none | password |
| glide.http.proxy_nthost | Specify the hostname used to authenticate the proxy server with NTLM authentication.  
• Type: string  
• Default value: none | nhost |
| glide.http.proxy_ntdomain | Specify the domain used to authenticate the proxy server with NTLM authentication.  
• Type: string  
• Default value: none | DOMAIN |

### Proxy servers for SOAP clients

Administrators can specify separate proxy settings for SOAP clients, such as the MID Server or ODBC Driver.

To specify a proxy server for a MID Server, see [MID Server configuration](#).

To specify a proxy server for the ODBC driver, see [Configure ODBC to use proxy servers](#).

### Bypass the proxy server

Administrators can configure the instance to bypass the proxy server for specific URLs or URL patterns.
Typically, internal addresses do not need a proxy server for SOAP communications.

### Bypass the proxy server

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.http.proxy_bypass_list</td>
<td>Specify the semicolon-separated list of addresses that bypass the proxy server. Use an asterisk as a wildcard character to specify all or part of an address.</td>
<td>127.0.0.1;*.internal.com;localhost</td>
</tr>
</tbody>
</table>

**Examples**

- Type: string
- Default value: none
- Location: System Properties [sys_properties] table

### Table administration

A table is a collection of records in the database. Each record corresponds to a row in a table, and each field on a record corresponds to a column on that table.

Applications use tables and records to manage data and processes, such as Incident, Problem, and CMDB. Tables can extend other tables, creating parent tables and child tables.

The following video provides an introduction to tables in ServiceNow.

Administrators can use these tools for viewing and modifying the database structure:

- Tables module: Provides a list of all tables in the database.
- Tables & Columns module: Provides a list of all existing tables, with columns, column attributes, and indexes.
- Schema map: Provides a graphical representation of the relationships between tables.
- Data dictionary tables: Contains additional information that defines database elements.

### Table extension and classes

Enable one or more child tables to share fields and records with a parent table. Administrators and application developers can only extend tables during table creation.

Administrators and application developers typically extend tables to create a set of related records that share information. For example, in the base system, the Task and the Configuration Item tables have multiple extensions:

**Sample extended tables in the base system**

<table>
<thead>
<tr>
<th>Original table</th>
<th>Related tables extended from original table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task (task)</td>
<td>Incident (Incident)</td>
</tr>
<tr>
<td></td>
<td>Problem (problem)</td>
</tr>
<tr>
<td></td>
<td>Change Request (change_request)</td>
</tr>
</tbody>
</table>
A table that extends another table is called a child class, and the table it extends is the parent class. A table can be both a parent and child class both extending and providing extensions for other tables. A parent class that is not an extension of another table is called a base class.

**Note:** The concept of class refers specifically to Configuration Management Database (CMDB schema)-related tables that contain a Class column that indicates the type of child table for Configuration Item (CI). This concept does not apply to other tables in the Now Platform.

Administrators can use these tools to see the relationships between classes.

- Schema map
- System dictionary
- Tables module

Extending a table:

- Links the new table to the extending table.
- Creates system fields in the new table.
- Creates one or more database tables to store the parent and child classes. The number of tables the system creates depends upon the extension model selected during table creation.

### Extension models

The Now Platform offers these extension models.

- Table per class
- Table per hierarchy
- Table per partition

The extension model determines these attributes.

- The number of database tables created
- The derivation of fields from parent classes
- The replication of records from child classes

### Table per class

**Tables created**

Creates a separate database table for the parent class and each child class.

**Fields derived from parent class**

Child classes derive fields from parent classes. For example, the Service Contract (ast_service) table derives fields from the Contract (ast_contract) table.
Dictionary records created for parent class

A parent class has a Dictionary record for the collection and for each field that can be derived from it. For example, the Contract (ast_contract) table has 59 Dictionary records, which define the table and its fields.

Dictionary records created for child classes

Each child class only has Dictionary entries for fields unique to the class. For example, the Service Contract (ast_service) table only has four Dictionary records, which are not already defined in the Contract (ast_contract) table.

Records replicated

The parent class replicates each record stored in its child classes. Each child class only stores records unique to the class. Replicated records have the same Sys ID value in each table. The system replicates any change you make to a child record to the matching record in the parent table. For example, Contract (ast_contract) table replicates records from the Lease (ast_lease), Service Contract (ast_service), and Warranty (ast_warranty) tables. When you update a Service Contract record, the system also updates the same record in the Contract table.

Table per hierarchy

Tables created

Creates one database table for the parent class, which stores all records for the parent and child classes. Child classes do not have separate database tables.

Fields derived from parent class

Child classes derive fields from parent classes. For example, the Incident table derives fields from the Task table.

Dictionary records created for parent class

A parent class has a Dictionary record for the collection and for each field that can be derived from it. For example, the Task table is a parent class that has 66 Dictionary records, which define the table and its fields.

The Dictionary entry for the parent class contains a sys_class_name column whose value indicates which child class each record belongs to. For example, Incident records have a sys_class_name value of incident, and change records have a sys_class_name value of change.

Dictionary records created for child classes

Each child class only has Dictionary entries for fields unique to the class. For example, the Incident table only has 22 Dictionary records, which are not already defined in the Task table.

Records replicated

Record replication is not needed, because the parent class stores all records that belong to the hierarchy. For example, the Task table contains all records from its child classes such as the Change, Incident, and Problem tables.

Table per partition

Tables created
Creates one database table for the parent class, which stores all records for the parent and child classes. Child classes do not have separate database tables. As the database table reaches a storage limit, the system dynamically adds storage tables (partitions) to store additional records.

Fields derived from parent class

Child classes do not derive fields from parent classes. Instead each child class has its own list of fields. For example, the Base Configuration Item (cmdb), Configuration Item (cmdb_ci), and Hardware (cmdb_ci_hardware) tables all have their own field definitions.

Dictionary records created for parent class

A parent class has a Dictionary record for the collection and for each field relevant to it. For example, the Base Configuration Item (cmdb) table is a parent class that has 48 Dictionary records.

The system replicates changes made to parent class Dictionary entries to child class Dictionary entries. For example, when you change the name column in the parent class Base Configuration Item (cmdb) table, the system replicates it to child class Dictionary entries such as the Configuration Item (cmdb_ci) and Hardware (cmdb_ci_hardware) tables.

The Dictionary entry for the parent class contains columns for sys_class_name and sys_class_path whose values indicate which child class each record belongs to. For example, Hardware records have a sys_class_name value of cmdb_ci_hardware, and computer records have a sys_class_name value of cmdb_ci_computer.

When the database table reaches a storage limit, the system updates the Dictionary entry for the parent class to include columns for sys_storage_alias and storage_table_name. These storage column Dictionary entries allow administrators to manage the parent class and its storage tables as a single logical unit.

Dictionary records created for child classes

Each child class has a Dictionary record for the collection and for each field relevant to it. For example, the Hardware table has 73 Dictionary records with some records duplicating columns in the parent class.

Records replicated

Record replication is not needed, because the parent class stores all records that belong to the hierarchy. For example, the Base Configuration Item (cmdb) table contains all records from its child classes such as the Application (cmdb_ci_appl), Computer (cmdb_ci_computer), and Hardware (cmdb_ci_hardware) tables.

Create a table

Administrators and application developers can create custom tables to store application data.

Role required: admin

To minimize the existence of unneeded and extraneous tables in an instance, don't overdo table creation. Create only those tables you need to minimize administration tasks and shorten upgrade times.

1. Navigate to System Definition > Tables.
2. Click New and complete the form.
<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a unique label for the table (such as <strong>Laptops</strong> or <strong>Thin Clients</strong>). The label appears on list and form views for the table. Updating the <strong>Label</strong> field also updates the label record in the language file for the current language. See Field Labels in <em>Data dictionary tables</em>.</td>
</tr>
</tbody>
</table>
| Name         | Edit the table name, which is automatically populated based on the table label and a prefix as follows:  
  * For a table in a scoped application, the name is prefixed with a namespace identifier to indicate that it is part of an application.  
  * For a table in the global application, the name is prefixed with the string *u_*  
You cannot modify the prefix; however, you can modify the rest of the table name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (*_*).                                                                                          |
| Extends Table| Select the table to extend. Extending a base table incorporates all of the fields of the original table and creates system fields for the new table. You can extend tables that are marked as extensible if they are in the same scope or if they allow configuration from other scopes. This option is available only when creating a table. |
| Application  | *(Read only)* Displays the application associated with this table. If you are working on an application or are creating a table from an application record, the field defaults to that application. Otherwise, the field defaults to **Global**. Any records that are created from the table record, such as modules and security rules, are assigned to this application by default. |
| Create module| Select the check box and then complete the **Add module to menu** field to create a list module in the application menu. This option is available only when creating a table.                                                                                                                                                        |
| Add module to menu | Select an existing menu or select **Create new** and enter a new menu name. This option is available only when the **Create module** check box is selected.                                                                                                                                                     |

3. In the **Columns** section, use the **Table Columns** embedded list to add columns to the table.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column label</td>
<td>Define a unique label for the column. The label appears on list headers and form fields for the column. When you update the Column label field, the system also updates the label in the language file for the current language.</td>
</tr>
<tr>
<td>Type</td>
<td>(Mandatory) Define the field type for the column. See Introduction to Fields. To preserve existing data, only change fields between the same basic type (for example, Choice and String). A warning appears if a change to a custom field will result in data loss. For a base system field, you cannot make a change that will result in data loss.</td>
</tr>
<tr>
<td>Reference</td>
<td>Make the field into a reference field by entering the referenced table name. Note: Dynamic reference creation is enabled for this field. So, if you enter a table name that does not match an existing table, a new table is created when you save changes to the current table record. If the current table has a module in the application navigator, then a module for the newly created table is automatically created in the same application menu.</td>
</tr>
</tbody>
</table>
### Column

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max length</td>
<td>(String fields only) Limit the length of the field. A length of under 254 appears as a single-line text field. Anything 255 characters or over appears as a multi-line text box.</td>
</tr>
</tbody>
</table>

**Note:**
- You can only change this value if the **Type** of the field is **String**. Changes for any other type of field are ignored.
- Users on an Oracle instance cannot increase the maximum length of a string field to anything greater than 4000 through the application UI because this requires the CLOB datatype in Oracle. To increase beyond this size, log an incident with ServiceNow Technical Support to request the change.
- To prevent data from being lost, only decrease the length of a string field when you are developing a new application and not when a field contains data. A warning appears if a change to a custom field will result in data loss. For a base system field, you cannot make a change that will result in data loss.

### Default value

Specify the default value of the field for any new record. Ensure that this value uses the correct field type. For example, an integer field can use a default value of 2 but cannot use a default value of two. These values can be overridden with **dictionary overrides**.

### Display

Indicate whether this field is the **display value for reference fields** (appears on records that reference this table).

**Note:** This option does not control whether or not this field is displayed on lists or forms.

4. **In the Controls section, define additional table options.**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extensible</td>
<td>Select the check box to allow other tables to extend this table. Clear the check box to prevent the creation of additional child tables; existing child tables remain unchanged.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live feed</td>
<td>Select the check box to enable record feeds for the table. This option adds the Show Live Feed icon in the form header.</td>
</tr>
<tr>
<td>Auto-number</td>
<td>Select the check box, and then define the number format to add an auto-numbered field to the table. The check box is available only when a number format does not exist for the table. Otherwise, you can edit the existing number format.</td>
</tr>
<tr>
<td>Create access controls</td>
<td>Select the check box and then complete the User role field to create basic security rules for the table.</td>
</tr>
<tr>
<td>User role</td>
<td>Enter a new name or select an existing user role that is required to access this table. This option is available only when the Create access controls check box is selected.</td>
</tr>
</tbody>
</table>

5. In the Application Access section, define the scope protection for the table. For more information see Application access settings.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
</table>
| Accessible from    | Specify which application scopes can access the table:  
  All application scopes  
  Can be accessed from any application scope.  
  This application scope only  
  Can be accessed only from the current application scope. |
| Can read           | Select the check box to allow script objects from other application scopes to read records stored in this table. This option offers runtime protection. For example, a script in another application can query data on this table. You must first select read access to grant any other API record operation. |
| Can create         | Select the check box to allow script objects from other application scopes to create records in this table. This option offers runtime protection. For example, a script in another application can insert a new record in this table. This option is available only when the Can read check box is selected.  
  Clear the check box to prevent script objects from other application scopes from creating records in this table. |
<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can update</td>
<td>Select the check box to allow script objects from other application scopes to modify records stored in this table. This option offers runtime protection. For example, a script in another application can modify a field value on this table. This option is available only when the Can read check box is selected. Clear the check box to prevent script objects from other application scopes from modifying data stored in this table.</td>
</tr>
<tr>
<td>Can delete</td>
<td>Select the check box to allow script objects from other application scopes to delete records from this table. This option offers runtime protection. For example, a script in another application can remove a record from this table. This option is available only when the Can read check box is selected. Clear the check box to prevent script objects from other application scopes from deleting records from this table.</td>
</tr>
<tr>
<td>Allow access to this table via web services</td>
<td>Select the check box to allow users to make inbound Web services web service queries to this table. This option offers both design-time and runtime protection. The user performing the query must have the correct permissions to access this table, even when this check box is selected. Clear the check box to prevent users from making web service queries to this table.</td>
</tr>
<tr>
<td>Allow configuration</td>
<td>Select the check box to allow applications from other application scopes to create configuration records for this table that change its functionality. For example, an application designer can select this table from the Tables list on business rules, client scripts, or UI actions. This option offers design-time protection. Clear the check box to prevent application designers from selecting this table when creating configuration records.</td>
</tr>
</tbody>
</table>

6. Click Submit.

**Global default fields**

When you create a new custom table, several fields appear in the Table Columns embedded list. For all tables, required system fields are added automatically. You cannot delete or modify these fields.

For tables that extend another table, fields on the parent table also appear on the Table Columns embedded list for the current table. If you modify these fields, remember that all changes to fields on the parent table also affect all child tables, not just the current table.
These required system fields are added to all tables:

### Required system fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class (sys_class_name)</td>
<td>System Class Name</td>
<td>If the table is extensible, a string field that indicates which child table contains the record.</td>
</tr>
<tr>
<td>Created (sys_created_on)</td>
<td>Date/Time</td>
<td>A time-stamp field that indicates when a record was created.</td>
</tr>
<tr>
<td>Created by (sys_created_by)</td>
<td>String</td>
<td>A string field that indicates the user who created the record.</td>
</tr>
<tr>
<td>Sys_id (sys_id)</td>
<td>Sys ID</td>
<td>The unique record identifier for the record.</td>
</tr>
<tr>
<td>Updates (sys_mod_count)</td>
<td>Integer</td>
<td>A numeric field that counts the number of updates for this record since record creation.</td>
</tr>
<tr>
<td>Updated by (sys_updated_by)</td>
<td>String</td>
<td>A string field that indicates the user who most recently updated the record.</td>
</tr>
<tr>
<td>Updated (sys_updated_on)</td>
<td>Date/Time</td>
<td>A time-stamp field that indicates the date and time of the most recent update.</td>
</tr>
</tbody>
</table>

### Tables module

The Tables (sys_db_object) table contains a record for each table in the database.

To view the list of tables, navigate to System Definition > Tables. For example, you can filter the list to see extended table relationships.
Extended Table Relationships

To open the record for an existing table, click a table label. You can:

- View, add, or modify columns with a searchable and sortable embedded list, define the auto-number format, make the table extendable by other tables, and create modules for the table.
- Launch a schema map for a table by clicking the Show Schema Map related link.
- Open the dictionary entries for the table by right-clicking the form header and selecting Show Dictionary Record.
- Navigate directly to the default list or form view for the table by clicking the Show List or Show Form related link.
- Delete all records from a table by clicking the Delete All Records.
Administrators can delete custom tables that are no longer needed. For example, delete a table from an application that is under development because the business requirements change.

A table is custom if an administrator created it and it is not part of a system upgrade or plugin activation. Custom table names always begin with \texttt{u\_}, or \texttt{x\_} for scoped tables.

Base system tables cannot be deleted. Also, any missing base system tables are recreated when the instance is upgraded. If another table extends to it, you cannot delete a table.

**Warning:** You must delete the records in the table before you delete the table. If you do not delete the records first, errors can result on the parent table if it references the records. Deleting the records removes any references from the parent table.
Delete a custom table

You can delete a custom table if you no longer need it after you delete all the records in the table.

1. Navigate to System Definition > Tables.
2. Open the table to delete.
3. Click Delete All Records.
   Deleting all records before deleting the table ensures that the business logic is properly executed (for example, reference cascade rules or other delete business rules). If you do not delete all records from the table first, then you must manually fix any other records or tables that are impacted by the table deletion.
4. Click Delete.
5. In the confirmation dialog box, enter delete and click OK.

   The table and all items that reference the table are deleted, including:
   - Choice list items
   - Forms, form sections, lists, and related lists
   - Reports and Performance Analytics widgets
   - Reference fields that reference the table
   - Access controls

Delete all records from a table

You may decide to delete all the records on a table without deleting the table itself. For example, the administrator may want to delete all incidents on a test instance without deleting the incident table itself.

When you prepare to delete many records from a table, consider the following guidelines to minimize impact on performance.

- Limit the number of records to be deleted in a single delete action to prevent the table from being locked. Use the setLimit() method described at .
- Minimize triggering an excessive number of business rules as a result of this deletion. Use the setWorkflow(Boolean e) method described at .

**Note:** Deleting all records for a table also deletes records from tables that extend the table.

There are several methods for deleting table records. Depending on the number of records to be deleted, choose the method that would be most efficient in your environment. Use these methods with caution. Before performing this procedure, be sure that you do not need any of the records.

- From the Tables and Columns module, complete the following steps.
  a) Navigate to System Definition > Tables and Columns.
  b) Select the table for which to delete records.
Note: Some system tables do not allow this method of deleting records, for example, you cannot delete all user records (sys_user). The list of tables does not include system tables that you cannot delete records from.

c) Click **Delete all records**.
d) In the confirmation dialog box, enter delete and click OK.

- From a list view, complete the following steps.
  a) In List v2, navigate to the list view that displays the table records, click the context menu, and then navigate to Show.
  b) In List v3, click <Number> rows per page in the footer.
  c) Set the number of rows per page to display the max number.
  d) Select all the rows on the page.
  e) Click Actions on selected rows, and then click Delete.
  f) Continue deleting all rows on a page until all records are deleted.

The selected table is empty of records. The table still exists, and any references to the table on other tables (such as business rules or reference fields) are preserved.

**Restore deleted records**

In some cases, administrators can restore deleted records and references to those records.

For example, if a user inadvertently deletes a user record that was referenced in the Caller ID field on several incident records, you may be able to restore the user record as well as the incident field values. You may also be able to restore records that were deleted as a result of a cascade delete action.

There are several methods for restoring deleted records:

- Restore data records without references on tables that audit deletions.
- Restore data records and references on tables that audit deletions (requires the Restore Deleted Records plugin).
- Restore configuration records with the app creator.

**Activate Restore Deleted Records**

Administrators can activate the plugin. The Restore Deleted Records plugin allows administrators to restore audited database references and relationships for deleted records.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.

5. Click Activate.

**Restore a deleted record and reference**

The instance can track deletions on any table, and references on audited tables, with a few exceptions described here.

ServiceNow can track deletions on any table, and references on audited tables, except in these circumstances:

- Record deletions are not tracked on tables with the no_audit_delete=true dictionary attribute.
- File attachments are not restored when the record is restored.
- References to a restored record are restored only if the reference field is on an audited table.
- References to images using an Image type field are not restored.

1. Navigate to System Definition > Deleted Records.
2. Open a deleted record that you want to restore.

   **Note:** You can only restore one deleted record and its associated references at a time.

3. In the Audit Deleted Record form, select Restore Record and References under Related Links.

   **Note:** To restore the record without restoring the references, select Undelete Record

   An instructions page appears, explaining the process and its limitations.

4. Click Restore deleted record.

   A Progress page shows the progress of the restore process, and displays a counter of the references restored.

When the process completes, a Restore Summary itemizes the changes and provides links for viewing the restored record or returning to the deleted records list.

**Restore data records with deletion audits**

You can restore deleted data records on tables that audit deletions.

Limitations for restoring data records include:

- Record deletions are not tracked for tables with the no_audit_delete=true dictionary attribute.
- Attachments are not restored when the record is restored.
- Deletions from tables with a sys prefix are not audited by default. You can configure specific system tables to audit deletions.
- References are restored only if the reference field is on an audited table and the Restore Deleted Records plugin is activated.
- References that use an Image field type are not restored.
Configure a system table for a deletion audit

Deletions from tables with a sys prefix are not audited by default. To track deletions from these tables, add the table name to the glide.ui.audit_deleted_tables property. Enabling the Restore Deleted Records plugin adds several default values to this property.

Role required: admin

1. Navigate to System Properties > UI Properties.
2. Locate the List of system tables (beginning with "sys", comma separated) that will have the delete audited property.

3. Add or remove table names. Table names should be separated by commas, without any spaces.
4. Click Save.

Note: For more information about auditing, see Understanding the sys audit Table.

Create a table index

Constructing an effective index requires specialized knowledge in database architecture. We recommend that if you do not have this expertise, you consult someone who does.

Role required: admin

1. Navigate to System Definition > Tables.
2. In the list, find the table you want and click its label.
3. Navigate to the Database Indexes related list.
4. Click New.
5. Use the slush bucket to select the fields you want included in the index.
   The order in which you select the fields affects how the index works. If you do not have expertise in database design, we suggest you consult someone who does.
6. To create a unique index, check the Unique Index box.
7. Click Create Index.
   The Table Name field is there for your reference only. Overriding the default has no effect.

Task table

Task [task] is one of the core tables provided with the base system.

It provides a series of standard fields used on each of the tables that extend it, such as the Incident (incident) and Problem (problem) tables. In addition, any table which extends task can take advantage of task-specific functionality for driving tasks.

The Planned Task plugin provides the Planned Task (planned_task) table, which extends the Task (task) Table to provide more fields for tasks to measure duration and effort.
Create a task

Tasks are not created directly on the task table. Instead, tasks are created on task child tables.

1. Click the New button on the task record list will launch the Task Interceptor.
2. Follow the on-screen instructions to locate the desired table that extends Task.

Define assignment rules

The instance can automatically assign a task to a user or group based on pre-defined conditions by using data lookup rules and assignment rules.

Assignment lookup rules example

In this example, the Data Lookup Plugin assignment lookup rule automatically assigns any incident with the Category of Request and Subcategory of Password Reset to Fred Luddy.
Assignment data lookup

Assignment rules module

The Assignment rules module allows you to automatically set a value in the assigned_to and assignment_group fields when a set of conditions occurs.

An assignment rule must also meet these additional criteria to run:

- The task record has been created or updated. Assignment rules do not apply to unsaved changes on a form.
- The task record must be unassigned. The record cannot have an existing value for either the assigned_to or assignment_group fields. Assignment rules cannot overwrite existing assignments (including assignments set by a default value or a previously run assignment rule).
- The assignment rule is the first rule that matches the table and conditions. If more than one assignment rule matches the conditions, only the rule with the lowest order value runs.

Condition editor example

In this example, the assignment rule uses a condition statement to automatically assign any incident opened in the Network category to the System Administrator in the Network assignment group.

Data lookup rules

Data lookup rules offer a generic way to change any field value, not just assignment fields.
**Data lookup rules** offer the following improvements over the Assignment module:

- Ability to change any field value not just an assignment field
- More options to define when a rule runs:
  - On form change (Allows assignment rules to apply to unsaved changes on a form)
  - On record insert
  - On record update
- Option to replace existing values (including default values)

**Note:** You can define data lookup and Assignment rules at the same time. The system ignores any duplicate rules after an incident has been assigned unless you are using a data lookup definition option to replace existing values.

**Precedence between data lookup, assignment, and business rules**

When creating new assignment rules, keep in mind that business rules can take precedence over assignment rules in certain circumstances. Data lookup rules take precedence over assignment rules.

Data lookup rules, assignment rules and **business rules** run in the following order:

1. Data lookup rules take precedence over assignment rules.
2. All assignment rules run before business rules that run on a record insert with an order value less than 1000.
3. The first assignment rule with the lowest execution order and matching condition.
4. All assignment rules run before business rules that run on a record insert with an order value greater than or equal to 1000.
5. All assignment rules run after business rules that run on record insert.

**Workflow assignments**

An alternative to creating data lookup or assignment rules is to create one or more workflow tasks that assign a task record as part of a workflow.

Consider using a **workflow** for assignment if your process includes multiple steps or conditions such as requiring a particular group approve a request.

When using a workflow to manage task assignments, add a brief **timer** activity to the start of the workflow. Without this timer activity, the workflow runs before the parent record, the current record, is inserted into the database. After the timer activity completes, the workflow resumes using the parent record information from the database instead of the original current. Note that pausing a workflow in this way does not change a default workflow to a deferred workflow. For more information on how the workflow engine interacts with the database, see **workflow engine operation order**.

**Baseline assignment rules example**

A baseline instance contains certain assignment rules.
Baseline instance rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Conditions</th>
<th>Assigned to user, Assigned to group, or Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking</td>
<td>incident</td>
<td>Category is Network</td>
<td>User: System Administrator Group: Network</td>
</tr>
<tr>
<td>Database or Software</td>
<td>incident</td>
<td>Category is one of Request, Inquiry / Help, Software, Hardware</td>
<td>User: System Administrator Group: Software</td>
</tr>
<tr>
<td>SC Item fulfillment - Field Services</td>
<td>Ticket</td>
<td>Parent.Task type is Request Item</td>
<td>Group: Field Services</td>
</tr>
<tr>
<td>Release Planning</td>
<td>release_phase</td>
<td>Name is Plan</td>
<td>Script: current.release.product.service.assigned_to;</td>
</tr>
<tr>
<td>IT Hardware</td>
<td>sc_req_item</td>
<td>Approval is Approved and Item.Category is Request Computers and Hardware</td>
<td>User: System Administrator Group: Hardware</td>
</tr>
<tr>
<td>Service Desk</td>
<td>incident</td>
<td>Active is true</td>
<td>Group: Service Desk</td>
</tr>
</tbody>
</table>

Create an assignment rule

Create an assignment rule and apply it to a single table.
Role required: assignment_rule_admin or admin
Example assignment rule

**Note:** An administrator can configure the form to see all the fields.

1. Navigate to **System Policy > Rules > Assignment** and click **New**.
2. Complete the form.

**Assignment rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The descriptive name for the assignment rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies whether the assignment rule is active. Only active assignment rules take effect.</td>
</tr>
<tr>
<td>Applies to</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The table with the records that the assignment rule applies to.</td>
</tr>
</tbody>
</table>

**Note:** The list shows only tables and database views that are in the same scope as the assignment rule. If you select a custom table that extends the task table, and for the assignment rule to work properly, you must clear the instance cache by navigating to https://<instance_name>.service-now.com/cache.do.

| Conditions  | The conditions under which the assignment rule applies. In the example, the assignment rule applies when an incident is in the **Network** category |

| Assign to   |                                                                             |
|-------------|                                                                             |
| User        | The user the event is assigned to.                                           |
| Group       | The group the event is assigned to.                                          |
| Script      | A script to specify advanced assignment rule functionality. The current.variable_pool set of variables is available. |

**Note:** Make sure the input in the script is correct, and that the input type matches the field type in the Assignment Rule script. For example, if the assignment rule script sets the value of an Integer field, and the value in the script is set to String, the assignment rule may yield unexpected results.

<table>
<thead>
<tr>
<th>Other fields</th>
<th>Choices are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match conditions</td>
<td>- Any — If any of the conditions are met, assignment rule applies.</td>
</tr>
<tr>
<td></td>
<td>- All — If all the conditions are met, assignment rule applies.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Order</td>
<td>The order in which the assignment rule is processed. If assignment rules conflict, a rule with a lower-order value takes precedence over a rule with a higher value. If the order values are set to the same number, the assignment rule with the first matching condition takes precedence over the others. Only the first assignment rule with a matching condition runs against a record.</td>
</tr>
</tbody>
</table>

### Data lookup rules

You can define an assignment rule with Data Lookup and Record Matching Support.

1. Navigate to **System Policy > Rules > Assignment Lookup Rules**.
2. Click **New**.
3. Populate the assignment data lookup fields (see table).
4. Click **Submit**.

#### Assignment data lookup fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Select the category the data lookup matches against.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Select the subcategory the data lookup matches against.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Select the configuration item the data lookup matches against.</td>
</tr>
<tr>
<td>Location</td>
<td>Select the location the data lookup matches against.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Select the assignment group to assign the incident to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Select the user to assign the incident to.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Set to Yes to run the rule or No to deactivate the rule.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order in which the rule runs compared to other rules on the same table. The Data Lookup Plugin runs the rule with the lowest order and matching values.</td>
</tr>
</tbody>
</table>

**Note:** The assignment lookup rule assigns incidents matching the values in the matcher fields (Category, Subcategory, Configuration Item, and Location) to the values in the setter fields (Assignment Group and Assigned To). A valid assignment lookup rule requires at least one matcher field and one setter field.

### Important Task table fields

The Task table is a base class that provides fields for the core ITSM applications such as Incident, Problem, and Change Management. All applications that extend the Task table share these fields in common.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>active</td>
<td>boolean</td>
<td>Specifies whether work is still being done on a task or whether the task’s work is complete. By default, only application-specific business rules set the value of this field. For example, the <code>incident autoclose</code> business rule closes resolved incident that have not been updated for one day.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>comments</td>
<td>journal_input</td>
<td>Displays and allows entry of comments about the task record. Each comment is inserted into the Activity field. For more information, see <a href="#">Journal Fields</a>.</td>
</tr>
<tr>
<td>Approval History</td>
<td>approval_history</td>
<td>journal</td>
<td>Displays the history of approvals for the record. For more information, see <a href="#">Approvals</a>.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>assigned_to</td>
<td>reference</td>
<td>Specifies the user assigned to complete the task. By default, this field uses a reference qualifier to only display users with the itil role. Some applications override the parent reference qualifier to display relevant users. For example, the Service Order and Project Task tables filter users based on their skills.</td>
</tr>
<tr>
<td>Created</td>
<td>sys_created_on</td>
<td>glide_date_time</td>
<td>Displays the date and time when the task record was created.</td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td>string</td>
<td>Displays and allows entry of a multi-line description of the work to be done.</td>
</tr>
<tr>
<td>Escalation</td>
<td>escalation</td>
<td>integer</td>
<td>Indicates how long the task has been open. Escalations are dynamically populated using service level agreements, which specify how long a task remains in each escalation state. Escalation states go from Normal to Moderate to High, and finally to Overdue. Record lists color code each task by escalation state.</td>
</tr>
<tr>
<td>Number</td>
<td>number</td>
<td>string</td>
<td>Displays an identifying number for each task record. This field is the display value for the Task table. The system generates this number when the task is created. To manage number generation, see Number Maintenance.</td>
</tr>
<tr>
<td>Opened</td>
<td>opened_at</td>
<td>glide_date_time</td>
<td>Displays the date and time when the task record was opened by a human for the first time.</td>
</tr>
<tr>
<td>Label</td>
<td>Name</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Priority</td>
<td>priority</td>
<td>integer</td>
<td>Specifies how high a priority the task should be for the assignee. By default, this value is calculated by the <code>calculatePriority</code> business rule based on the <code>Impact</code> and <code>Urgency</code> values. Record lists color code each task by degree of priority.</td>
</tr>
<tr>
<td>Short Description</td>
<td>short_description</td>
<td>String</td>
<td>Displays and allows entry of a short description of the task, which is a human-readable title for the record.</td>
</tr>
</tbody>
</table>
| State         | state            | Integer      | Displays a choice list for status of the task:  
- Pending  
- Open  
- Work in Progress  
- Closed Complete  
- Closed Incomplete  
- Closed Skipped  
Applications typically use Dictionary overrides to display application-specific states. |
<p>| Sys ID        | sys_id           | GUID         | Displays the unique record identifier.                                                                                                                                                                     |
| Task Type     | sys_class_name   | sys_class_name | Specifies the type of task, which corresponds to the child class. The system populates this value when a record is created on a child table. For more information on extending tables, see Tables and Classes. |
| Time Worked   | time_worked      | timer        | Display a timer which measures how long a record is open in the form view.                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watch list</td>
<td>watch_list</td>
<td>glide_list</td>
<td>Specifies users who receive email notifications when the record is updated. By default, only the Incident, Change, and Service Catalog applications notify users listed in this field. For other Task-based applications, you must create custom email notifications sent to the users listed in this field.</td>
</tr>
<tr>
<td>Work notes</td>
<td>work_notes</td>
<td>journal_input</td>
<td>Displays and allows entry of comments viewable only by ITIL users. Each comment is inserted into the Activity field. For more information, see Journal Fields.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>work_notes_list</td>
<td>glide_list</td>
<td>Specifies users who receive email notifications when work notes are added to the record. By default, only the Change, Problem, and Service Catalog applications notify users listed in this field. For other Task-based applications, you must create custom email notifications sent to the users listed in this field.</td>
</tr>
</tbody>
</table>

**Journal fields**

Journal fields work together to create a log of changes and comments as tasks are worked on.

**Note:** Journal fields work on audited tables only.

Fields of the journal_input type are multi-line text boxes which, upon save, add the comments into the Activity field with a notation.

**Fields that accept input into the journal**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional comments</td>
<td>Can be updated by any user.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Can be updated by ITIL users.</td>
</tr>
</tbody>
</table>

These comments, as well as any changes to the record or email notifications sent out because of the record, are displayed in the activity formatter, which can be added to the form like a field.
Activity formatter for journal fields

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Modify the task interceptor

You can modify any task interceptor and provide different answers to users.

1. Navigate to System Definition > Interceptors (this module may need to be activated).
2. Select the Task Interceptor.
   The Answers related list specifies what choices are presented and where the user is redirected after a choice is selected.
3. Modify the Answers related list as desired.
4. After making changes, test the interceptor by clicking Try It.

**Note:** To disable the task interceptor, rename it to something other than task.do. This disables it without deleting it.

![Task Interceptor](image1.png)

![Answers related list](image2.png)
Planned task

The Planned Task plugin provides a Planned Task \[planned_task\] table that extends the Task \[task\] table.

The Planned Task plugin cannot be activated independently. It gets activated when activating the Project Management plugin (through Project Portfolio Suite with Financials plugin).

Planned tasks provide additional fields for tasks pertaining to time and effort as part of a planned, multi-stage process.

Note: If the Planned Task_v2 (com.snc.planned_taskv2) plugin is active when you upgrade to the Geneva or later releases, the system adds the Task column to the Planned Task (planned_task) table. The Task column is of type Composite Field, and stores the Short Description and Number of the task. During the upgrade, the system updates all records in the Planned Task table.

Create a planned task

Planned Tasks are created on planned task child tables.

Clicking the New button on the Planned Task record list will launch the Planned Task Interceptor, which prompts the user to select a child table to create the planned task on:

![Wizard](image)

Planned task

What type of Planned Task would you like to create?

- Project
- Project Task

To modify the planned task interceptor:

1. Navigate to System Definition > Interceptors (this module may need to be activated).
2. Select the Planned Task Interceptor.
3. The Related List Answers specifies what choices are presented, and where the user will be redirected to once they select the choice. Modify the list as desired.
Create a baseline

A Planned Task Baseline is a record of the planned task’s start and end times at a particular moment in time.

To create a baseline, navigate to the top planned task’s form and select the Create a Baseline related link:
Create baseline

To view the baseline, configure the related lists to add a related list of baselines:

<table>
<thead>
<tr>
<th>Group Resources</th>
<th>Project Tasks (3)</th>
<th>User Resources (17)</th>
<th>Baselines (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baselines</td>
<td>New</td>
<td>Go to: Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>2011-05-05</td>
<td>Description</td>
<td>Baseline 1</td>
</tr>
<tr>
<td>Actions on selected rows...</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Baselines tab

The baseline can be viewed on a Gantt Chart using the related link.

Measure time and effort

The Planned Task [planned_task] table provides standard fields for tracking duration and effort.

Duration measures time from start to end date. Effort measures hours of work exerted on the project.

- Planned duration: the projected length of time for the planned task.
- Actual duration: the actual length of time so far for the planned task.
- Remaining duration: the Planned duration minus the Actual duration, which represents the projected length of time left.

**Effort**
- Planned effort: the projected amount of time that will be spent on the planned task.
- Actual effort: the actual amount of time that has already been spent on the planned task.
- Remaining effort: the Planned effort minus the Actual effort, which represents the projected amount of work left.
- Percent complete: the Actual effort divided by the Planned effort, which estimates the percentage of planned work which has been completed.

**Important planned task table fields**
The Planned Task table has these fields.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual cost</td>
<td>work_cost</td>
<td>currency</td>
<td>The actual cost of the planned task, to be compared with the Estimated cost.</td>
</tr>
<tr>
<td>Actual duration</td>
<td>work_duration</td>
<td>glide_duration</td>
<td>The actual length of time (from start time to end time) of work on the planned task, to be compared with the Planned duration.</td>
</tr>
<tr>
<td>Actual effort</td>
<td>work_effort</td>
<td>glide_duration</td>
<td>The actual time spent working, to be compared to the Planned effort.</td>
</tr>
<tr>
<td>Critical Path</td>
<td>critical_path</td>
<td>boolean</td>
<td></td>
</tr>
<tr>
<td>Estimated cost</td>
<td>cost</td>
<td>currency</td>
<td>An estimation of the cost of the planned task, to be compared with the actual cost.</td>
</tr>
<tr>
<td>HTML Description</td>
<td>html_description</td>
<td>html</td>
<td>A description field that accepts HTML mark-up.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>percent_complete</td>
<td>decimal</td>
<td>A percentage of the completed effort. Generated using the Planned effort and Actual effort fields.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>duration</td>
<td>glide_duration</td>
<td>The estimated length of time (from start time to end time) of the planned task.</td>
</tr>
<tr>
<td>Planned effort</td>
<td>effort</td>
<td>glide_duration</td>
<td>The estimated amount of time spent working on the planned task.</td>
</tr>
<tr>
<td>Label</td>
<td>Name</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned end date</td>
<td>end_date</td>
<td>glide_date_time</td>
<td>The estimated date and time for the planned task to end.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>start_date</td>
<td>glide_date_time</td>
<td>The estimated date and time for the planned task to start.</td>
</tr>
<tr>
<td>Remaining duration</td>
<td>remaining_duration</td>
<td>glide_duration</td>
<td>The difference in planned and actual duration, representing the time left for the planned task.</td>
</tr>
<tr>
<td>Remaining effort</td>
<td>remaining_effort</td>
<td>glide_duration</td>
<td>The difference in planned and actual effort, representing the amount of work time left for the planned task.</td>
</tr>
<tr>
<td>Rollup</td>
<td>rollup</td>
<td>boolean</td>
<td>Read-only field managed by the system that identifies the task as having child tasks. A rollup task will have a number of its fields calculated from the children so those fields will be read-only.</td>
</tr>
<tr>
<td>Time constraint</td>
<td>time_constraint</td>
<td>string</td>
<td>A description of time constraints that apply to the planned task.</td>
</tr>
<tr>
<td>Top Task</td>
<td>top_task</td>
<td>reference (planned_task)</td>
<td>When different planned tasks are stacked in a hierarchy, this field populates with the highest-level parent task. For example, if Project A has a child Project B, and Project B has a child Project C, then Project C's Top Task is Project A. Project A's Top Task field will be blank.</td>
</tr>
</tbody>
</table>

**Planned task scripts**

A number of business rules and one script include power the dynamic calculation of crucial Planned Task fields.

**Planned Task Scripts**

<table>
<thead>
<tr>
<th>Business Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Actual Work Start Value</td>
<td>Sets the planned task's Actual Start Date when State is set to the default work state.</td>
</tr>
<tr>
<td>Business Rule</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Close Data on Inactive</td>
<td>Sets the planned task’s close data when task becomes inactive.</td>
</tr>
<tr>
<td>Recalculate</td>
<td>Recalculates the planned task schedule fields when one of the schedule fields changes.</td>
</tr>
<tr>
<td>Auto close milestones</td>
<td>Automatically closes milestones when they are passed.</td>
</tr>
</tbody>
</table>

**Planned task hierarchy**

The **Task Hierarchy** tool available for Planned Task displays the relationship between parent and child planned tasks.

Out-of-box, the **Task Hierarchy** tool is available in both Project and Release Management.

Different **Planned Task** tables have different UI actions to launch the task hierarchy:

- To view a Project’s hierarchy, navigate to the use the **Task hierarchy** context menu action.
- To view a Product’s hierarchy in Release v2, navigate to the product and click the **Product hierarchy** related link.
- To view a Release’s hierarchy in Release v2, navigate to the release and click the **Release hierarchy** related link.

**Rm2 Hierarchy**

The Task Hierarchy can be added to any planned task table by:

1. Navigating to **System UI > UI Actions**.
2. Selecting one of the existing Task Hierarchy UI Actions (e.g. Task hierarchy if Project Management is activated).
3. Change the table to the desired table and rename the UI Action if appropriate, and insert. The hierarchy should now be available as a UI Action on the new table's form.

Configure rollup for planned task fields

You can configure the planned task fields to roll up the field values in the parent entity. By default the following fields are configured to roll up for any planned task and planned task derivatives:

Cost, Budget, Effort, Actual date, Planned date, Duration, Percent Complete

1. Navigate to System Definition > Tables.
2. Open the Planned task rollup table.
3. In the Related links, click Show List.
4. Click New.
5. Fill out the Planned task rollup form (see table).
6. Click Submit.

Planned task rollup form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child</td>
<td>Select the table you want to include or exclude.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the column name you want to include or exclude.</td>
</tr>
<tr>
<td>Navigator</td>
<td>The reference column of the parent to which the value must be rolled up.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select the parent table.</td>
</tr>
<tr>
<td>Application</td>
<td>Auto-generated value.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Select the check box to allow roll up. Leave the field unchecked to exclude the field from rollup.</td>
</tr>
</tbody>
</table>

Reminder table

The Reminder (reminder) table provides a way to auto-generate reminders for a task. The Reminder (reminder) table is one of the child tables of the Task (task) table. Any table that extends the Task table, such as the Incident (incident) table, can use the Reminder (reminder) table.

Only the system administrator can create or modify a Reminder table. To access the Reminder table, type reminder.do in the filter navigator.

Reminder table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Refers to the parent task record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User</td>
<td>Specifies the user who has logged in to the system.</td>
</tr>
</tbody>
</table>
| Remind me    | Specifies the time before which the reminder must be sent. Available values are: 15 minutes, 30 minutes, 1 hour and 2 hours. You can add values to this field as required.  
  **Note:** Internally in the system, the value is always converted to minutes and then stored in the Remind me field. |
| Before       | Refers to the date from the date field of the parent task record. This date and the time that you mention in the Remind me field are considered to send a reminder. Available values are: Activity due, Due date, Follow up, and SLA due.  
  **Note:** The Activity due field and the SLA due field are legacy fields with an UNKNOWN value that you cannot use. You can only use the Due date and Follow up fields. |
| Using        | Specifies the method by which the reminder must be sent. Available options are: Send an Email and Outlook Calendar. |
| Subject      | Specifies the subject or the reason of the reminder. Maximum number of characters allowed on this field is 100. |
| Notes        | Provides a space where you can enter your comments regarding the reminder. Maximum number of characters allowed on this field is 8000. |

**Task table modifications**

Modifications made to the Task table are applied to all child tables.

Be sure that the changes being made are appropriate for all of the child tables. Adding fields is a low-impact change, because the field can be hidden on tables that do not need it. However, deleting fields may cause unwanted data loss if the field is being used across tables.

**Note:** When adding choice list entries to a choice list on the Task table, make sure the entry value is unique.

You can use **dictionary overrides** to change some parts of a field definition in a way that does not to not apply to all child tables.

**Tasks workflow**

An administrator can specify a specific workflow process to apply to tasks that meet certain conditions.

Once a task is created that meets the conditions, the workflow applies the process to the task, asking for approvals, notifying users, generating other tasks, running scripts, and so on.

**Time Card Management**

The Time card Management feature enables time card users such as task assignees to report and track their time for the assigned tasks.

Time card Management works with the Task table to record time worked on Projects, Incidents, Problems, and Change Requests.
With the Time card Management feature:

- The Time card users can record the time worked on a task using time cards and time sheets. Time card users can submit their time cards and time sheets for approval.
- The Time card approvers can approve the time cards in a submitted timesheet by approving the time sheet. Time card approvers can view and approve only those time cards and time sheets that are routed to them for approval. The routing for approval happens based on the Non-project time approver and Project time approver fields in the user time sheet policy.
- Time card approvers can use dashboards to view reports of time card and time sheet exceptions, and category wise time reported by the users.
- The project_manager and the resource_manager roles contain the timecard_approver role in the base system. However, the timecard_approver role can also be used independently without the project_manager or resource_manager roles.
- The time card admin can create and manage time sheet policies. The time card admin can also approve time by exception and process the time sheets.

**Note:** The Time card management plugin is required to use time cards. Some of the procedures on this page require the project management feature, which activates time cards automatically. See Project Management (com.snc.financial_planning_pmo).

### Activate Time Card Management

Administrators can activate the Time card management (com.snc.time_card) plugin. The dashboards for Time Cards must be activated separately using the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics Premium license to use these dashboards.

**Note:** Time cards feature also gets activated as part of (com.snc.financial_planning_pmo) plugin.

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the Load demo data check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.
5. Click Activate.

### Time sheet policies

Time sheet policies contain the policies to which a time sheet, or a time card must adhere.
By default, the Default time sheet policy is available with the system. It is possible to have multiple time sheet policies based on different requirements and workflows in an organization. For example, each department or team may want to specify its own set of time sheet policies, and assign users to them. Time card admin can specify the time sheet policy to which a user belongs.

Time sheet policies also provide an ability to specify appropriate approval workflow for project and non-project tasks.

A time sheet policy can be set as a Default Policy. The default policy is a global time sheet policy which applies to all the users who are not assigned to any other time sheet policy. Only one time sheet policy can be set as a default policy.

Navigate to Time Sheets > Administration > Time Sheet Policies to view the list of timesheet policies.

Create a time sheet policy
As a time card admin, you can create a time sheet policy to specify a different set of policies.

Role required: timecard_admin

1. Navigate to Time Sheets > Administration > Time Sheet Policies.
2. Click New.
3. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the policy.</td>
</tr>
<tr>
<td>Allow blank time cards</td>
<td>Allows submitting blank time cards for approval. By default, it is set to false.</td>
</tr>
</tbody>
</table>
| Auto create time card on task update | Auto-creates a user time card when they update a planned task. By default, it is set to false. When a planned task is updated, a time card is created only if:  
  - the user is a time card user, AND  
  - the user is assigned to the task through Assigned to or Additional assignee list field, AND  
  - the task is not in a pending state. |
| Auto fill time card with time worked entries | Auto-fills a user time cards with time from their Time worked entries. By default, it is set to false.  When the time worked is updated, a time card is created if a time card does not already exist for the task. The time card is created or updated only if:  
  - the user is a time card user, AND  
  - the user is assigned to the task through Assigned to or Additional assignee list field. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto create time cards every week</td>
<td><em>Auto-generates time cards</em> every week through a scheduled job for the users assigned to the time sheet policy. The time cards are generated for a user based on the user’s planned task assignments and hard allocated resource plans. By default, it is set to true.</td>
</tr>
<tr>
<td>Update actual hours and cost in resource plan</td>
<td>Updates the actual hours and cost in associated resource plan based on the hours entered in the approved time card. If set to true, the system looks for resource plans matching the user and the dates. If a resource plan is found, the resource plan is associated with the time card. The actual hours from the time card entry and the corresponding cost based on the user rate card are then updated in the actual cost field in the resource plan. By default, it is set to false.</td>
</tr>
<tr>
<td>Week starts on</td>
<td>Specifies the start day of the week for the timesheet. The default value is Sunday.</td>
</tr>
<tr>
<td>Maximum hours per day</td>
<td>Maximum number of hours a user can fill for any day in a timesheet. The default value is 24. If set to -1, it implies that there is no limit on maximum hours per day. However, the maximum hours entered per day cannot exceed 24 hours.</td>
</tr>
<tr>
<td>Maximum hours per week</td>
<td>Maximum hours a user can fill in a week in a timesheet. The default value is 40. If set to -1, it implies that there is no limit on maximum hours per week.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Non-project time approver</td>
<td>Determines which approvals are required for the non-project tasks.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Auto</strong>: Time cards are auto-approved when submitted.</td>
</tr>
<tr>
<td></td>
<td>- <strong>User Manager</strong>: Time cards are routed to the user manager for approval when submitted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>- A user manager is one who is selected in the <strong>Manager</strong> field on User form of the time card user.</td>
</tr>
<tr>
<td></td>
<td>- A user manager must have time card approver role to view and approve the time cards submitted by a time card user.</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong>: Time cards can be approved by users with timecard_admin role.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Project time approver| Determines which approvals are required for the project tasks.  
  - **Auto**: Time cards are auto-approved when submitted.  
  - **Project Manager**: Time cards for a project task are routed to the respective project manager for approval when submitted. The project manager is picked from the task against which the user is submitting time.  
  - **User Manager**: Time cards are routed to the user manager for approval when submitted.  
  - **Both**: Time cards are routed to both - user manager, and project manager for approval when submitted.  
  **Note**: A time card remains in Submitted state when only either approver approves the time card.  
  - **None**: Time cards can be approved by time card admin.  
  **Note**:  
  - The project manager and the user manager can view only those time cards that are routed to them for approval.  
  - The system automatically updates the approver of the time card if the user manager or the project manager changes while the time card is still not approved.  
  - If the name of the project manager or the user manager is not populated on the respective form, then the time card can be approved by the time card admin. |

| Default Policy       | Indicates if the time sheet policy is a default policy. There can be only one policy with Default Policy set to true.  
  The default policy is a global time sheet policy which applies to all the users who are not assigned to any other time sheet policy.  
  Any time sheet policy with default policy set to true cannot be deleted. The user must first make another policy as default policy to delete the current default policy. |
Time sheet policy form related links and lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Set as default</td>
<td>Sets the current policy as default policy.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>Lists the users who are assigned to the time sheet policy.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

- **Set** the time sheet policy as default policy, if required.
- **Assign** the time sheet policy to the users.

**Set time sheet policy as default policy**

Time card admin can set a time sheet policy as a default policy. The default policy is a global time sheet policy which applies to all the users who are not assigned to any other time sheet policy.

Role required: timetcard_admin

Only one time sheet policy can be set as a default policy.

1. Navigate to **Time Sheets > Administration > Time Sheet Policies**.
2. Open the time sheet policy record.
3. Click **Set as default** related link.

**Note:** The related link appears only for a time sheet policy which is not already set as the default policy.

The **Default Policy** check box on the **record form** is selected to indicate that the current time sheet policy is set as the default policy. Only one time sheet policy can have the **Default Policy** set to true. The **Default Policy** check box on the earlier default time sheet policy is cleared.

Any time sheet policy with **Default Policy** set to true cannot be deleted. The user must first make another policy as default policy to delete the current default policy.

**Assign a time sheet policy to a user**

Time card admin can specify the time sheet policy to which a user belongs.

Role required: timetcard_admin

Once a time sheet policy is created, it can be assigned to the required users. Users can be associated to only one time sheet policy.

1. Navigate to **Time Sheets > Administration > Time Sheet Policies**.
2. Open the time sheet policy record.
3. Click **Edit** in the **Users** related list.
4. Use the slushbucket to add the desired users to the policy.
5. Click **Save**.

The selected users appear on the **Users** list. The time sheet policy is assigned to the selected users.
Create a project time category

A time card admin or a project manager can create sub-categories to define specific activities in the projects. The time card users can use these project sub-categories to report time for a specific activity in a project.

Role required: timecard_admin, it_project_manager

1. Navigate to Time Sheets > Administration > Project Time Categories.
2. Click New.
3. Fill in the fields.

| Project time category form fields |
|----------------------------------|----------------------------------|
| Field                           | Description                      |
| Name                            | Unique name for the project time category. |
| Description                     | A description of the type of project activity. |

4. Click Submit.

Time Sheets

A time sheet groups all the time cards for a user for the given week.

With time sheets:

- Time card users can submit all the time for their work week in a single step by using a time sheet.
- Time card approvers can approve all the time cards in a time sheet for a user in a single step by approving the time sheet. They do not need to approve multiple time cards for a given user individually.

A time sheet can have any of the following states:

- Pending
- Submitted
- Approved
- Processed
- Rejected

Create a time sheet

As a time card user, you can create a time sheet to group all your time cards for the given week and submit them in a single step.

Role required: timecard_user

A user can create only one time sheet per week.

| Note: When a user creates a time card for a week, a time sheet is also automatically created for that week. |

1. Create the time sheet with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the time sheet menu</td>
<td>Navigate to Time Sheets &gt; My Time Sheets &gt; Current (This Week). The time sheet form for the current week opens.</td>
</tr>
<tr>
<td>Option</td>
<td>Steps</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>From the time sheet list</td>
<td>1. Navigate to Time Sheets &gt; My Time Sheets &gt; All &gt; New.</td>
</tr>
<tr>
<td></td>
<td>2. Click New.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

**Time Sheet form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Week starts on | Starting date of the week for which the time sheet is created.  
|             | **Note:** The start day of the week is controlled by the time sheet policy.  
|             | Week starts on.                                                             |
| Total Hours | Number of hours the user has worked in that week. This field is automatically populated from the hours recorded for associated time cards. |
| User        | Name of the user for which time sheet is created.                           |
| State       | Current state of the time sheet. All new time sheets begin as Pending.  
|             | Default states: Pending, Submitted, Approved, Processed, and Rejected.     |
| Comments    | Comments related to the time sheet.                                         |
| Notes       | Any additional information.                                                |

3. Click Submit.

Add time cards to the time sheet. You can use the following related links and related list to add time cards. You can also add time cards using the Worker Portal.

**Time sheet form related links and lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Related links</strong></td>
<td></td>
</tr>
<tr>
<td>Generate Time Cards</td>
<td>Link to generate time cards for the assigned project tasks.</td>
</tr>
<tr>
<td>Copy from previous time sheet</td>
<td>Link to open the Copy Time Sheet window for you to copy the time cards from previous time sheets.</td>
</tr>
<tr>
<td><strong>Related lists</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Time Cards             | List of the time cards that are part of the time sheet.  
|                        | To create a time card, click New.                                           |
Submit a time sheet
Once the time sheet is updated with time worked, you can submit the time sheet for the week to submit all the time cards for the week together.

Role required: timecard_user

When a user submits a time sheet, the time sheet policy assigned to the user is used for validation. If there is no time sheet policy assigned to the user, the default time sheet policy is used. Business rules prevent a user from submitting a time sheet in case any violation is found.

**Note:** You can also perform this task from the Worker Portal.

1. Navigate to the time sheet using one of the following options:
   - To submit a time sheet in the Pending state, navigate to Time Sheets > My Time Sheets > Pending.
   - To submit the time sheet for the current week, navigate to Time Sheets > My Time Sheets > Current Time Sheet.
   - To submit a time sheet in the Rejected state, Time Sheets > My Time Sheets > Rejected. You can make required changes as suggested in the rejection comments to resubmit a rejected time sheet.

2. To submit in the Time Sheets list, open the time sheet.
3. Add comments, if required.
4. Click Submit Time Sheet.

   - The time sheet moves to the Submitted state.
   - All the time cards associated with the time sheet are also submitted automatically and move to the Submitted state.

Approve or reject a time sheet
As a user manager, you can view and approve or reject a time sheet to approve or reject all the time cards for a user for the given week in a single step.

Role required: timecardApprover or timecardAdmin

1. Navigate to Time Sheets > Time Sheets > Pending Approval.
2. In the Time Sheets list, open the time sheet to approve or reject.
3. If required, add comments.
4. Click Approve or Reject.

   - The time sheet moves to the Approved or Rejected state.
   - All the time cards associated with the time sheet are also approved or rejected automatically.
   - If any time cards in the time sheet are pending approval by one of the approvers as defined by the time sheet policy, the time sheet remains in the Submitted state.

**Note:**
- You can also approve or reject the time cards within a time sheet selectively by selecting one or more time cards and approving or rejecting them.
- If a time sheet is rejected, all the associated time cards in the Submitted state are also rejected automatically. The time cards in the Approved and Processed state for the time sheet remain unaffected.
- If all the time cards in a time sheet are approved, the time sheet automatically moves to the Approved state.
Time cards

Time cards are used to record the time worked on a task by a task assignee. The time card management feature works with the Task table to record time worked on Projects, Incidents, Problems, and Change Requests.

Task assignees can record time worked in the Time worked field on a task record or enter hours directly into their time card. Some tables support automatic time card creation based on start and end date fields.

Time cards for the project tasks can be associated with relevant resource plans.

Time cards also have an optional approval mechanism for project managers to approve the time cards. Administrators and time card approvers can see all the time cards for the week. All users who are in a role that is responsible for working on tasks also can access their personal time cards.

A time card can have any of the following states:

- Pending
- Submitted
- Approved
- Rejected

Create a time card

Time cards can be created automatically or manually.

Role required: timecard_user

Allow time card reporting on field on the project form determines the level at which the time cards for the project tasks can be created.

- Automatic: Use the following options to automatically generate the time cards:
  - By updating task:
    - Auto create time card on task update
      Configure time cards to be created when a user updates a task record. The time sheet policy Auto create time card on task update controls this behavior and is set to false by default.
    - Auto fill time card with time worked entries
      Configure time cards to be created when a user records Time worked. A time card is created if a time card does not exist for the task. The time sheet policy Auto fill time card with time worked entries controls this behavior and is set to false by default.
  - By scheduled job: Configure time cards for the project tasks to be generated automatically for users through a scheduled job. Only the admin can configure a scheduled job.

Note: Time cards cannot be created automatically when you use the mobile interface. Use the desktop interface if you want to use the automatic time card feature.
- Manual: Create a time card for each task and enter the time manually.

1. Create the time card with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
   | From a time sheet related list  | 1. Open the time sheet that you want to create the time card for.  
   |                                 | 2. Click **New** in the **Time Cards** related list.                                                                                 |
   | From a time sheet related link  | 1. Open the time sheet where you want to create the time card.  
   |                                 | 2. Click any of the following related links. These options are also available on the **worker portal**:                               |
   |                                 |   - **Generate Time Cards**: This option generates the time cards for all project tasks assigned to the user for the time sheet week. With this option, time cards are generated only for the project tasks that are in progress or planned in that week.  
   |                                 |   - **Copy from previous time sheet**: This option copies all the time cards (for project and non-project tasks) from a selected time sheet. |
   | From worker portal              | 1. Navigate to **Time Sheets > Worker Portal**.                                                                                    |
   |                                 | 2. On the form, fill in the fields.                                                                                                  |

**Time card form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week starts on</td>
<td>Starting date of the week that the time sheet is created for. The field is automatically filled.</td>
</tr>
</tbody>
</table>

**Note:** The start day of the week is controlled by the **time sheet policy Week starts on**.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the time card. All new time cards begin in the Pending state. Default states: Pending, Submitted, Approved, Processed, and Rejected.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of task that the time card is created for.</td>
</tr>
<tr>
<td>Task</td>
<td>Task that the time card is associated to.</td>
</tr>
<tr>
<td>Project time category</td>
<td>Type of activity in the project that time is reported for. The field is available only when Category is set to Project/Project Task.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user that the time card is created for.</td>
</tr>
<tr>
<td>Remaining effort</td>
<td>Amount of work time left for the planned task. Remaining effort is the remaining effort in the planned task table and is calculated as: Remaining effort = Planned effort - Actual effort</td>
</tr>
</tbody>
</table>

**Note:** The field is not available on the time card form by default. Configure the form to add this field if required.

3. Click **Submit**.

- The time card is created for the selected time card period.
- If the time sheet for the week does not exist, a time sheet is created for the time card week.

After the time card is created, the hours for that task can be incremented automatically from the **Time worked** field in the task record. The time sheet policy **Auto fill time card with time worked entries** controls the way the time is updated in time cards. The policy is set to false by default. If automatic updates for time worked are not configured, the user must manually update the time card.

**Copy from a previous time sheet**

Another option for creating time cards is to copy them from an existing timesheet, which copies all the time cards (for project as well as non-project tasks) from a selected time sheet.

Role required: timecard_user

You can also perform this task from the **Worker Portal**.

1. Open the time sheet record that you want to create the time cards for.
2. Click the **Copy from previous time sheet** related link.
3. In the **Select Time Sheet** field, select a previous time sheet that you want to copy the time cards from.
4. Optionally, if you want to copy the time logged for the tasks in the previous time sheet, select the **Copy Time Logged** check box.
5. Click **OK**.

**Time cards for project tasks**
Time cards for all the project tasks that are in progress or planned in the current week are copied from the selected time sheet. If a time card for a project task exists, a duplicate time card is not created during copying.

**Time cards for non-task category**

Time cards for all non-task category such as meetings, and trainings are copied from the selected time sheet. If a time card for a non-task category exists, a duplicate time card is created during copying.

**Auto-generate time cards**

As an admin, you can configure a scheduled job to generate time cards automatically for project tasks assigned to time card users.

Role required: admin

In addition to the manual option **Generate Time Cards**, a scheduled job can be run to automatically generate the time cards for project tasks. A job can be scheduled to run every week, for example, on every Sunday to generate time sheets for all users for the next week. You can configure when to run the scheduled job based on the business process of the organization. By default, the scheduled job is turned off. For more information, see [Schedule a script execution](#).

**Note:** The scheduled job auto-generates time cards only for those users who have the **Auto create time cards every week** option set to true in their assigned time sheet policy.

1. Navigate to System Definition > Scheduled Jobs.
2. In the Scheduled Jobs list, select **Auto Generate Time Cards**.
3. Configure the following parameters in the script as per the business requirements:
   - run for (CURRENT_WEEK, NEXT_WEEK, LAST_WEEK)
   - Group Name (includeGroups, excludeGroups)

**Note:**

- If a time card exists for a project task for the time card week, a duplicate time card is not created.
- Time cards are generated only for those project tasks that are in progress or planned in that week.
- The **Allow time card reporting** on field on the **project form** determines the level that the time cards for the project tasks are created at.

The following example script is executed when a scheduled job is run to generate time cards for the **Current week** for the **Database** and **Hardware** groups:

```javascript
// Clone this schedule job to run separately for different groups at different times
// One of the following values
// TimeCardConstants.CURRENT_WEEK
// TimeCardConstants.NEXT_WEEK
// TimeCardConstants.LAST_WEEK
var runFor = TimeCardConstants.CURRENT_WEEK;

// Comma separated group sys ids or group names. TimeSheet/TimeCards will be auto generated for time card users in the given groups.
var includeGroups = [Database, Hardware];
var excludeGroups = [];
```
var generator = new TimeCardGenerator();
generator.generateFromConfig(runFor, includeGroups, excludeGroups);

Submit a time card
As a time card user, once a time card for the week is updated with the time worked, you can submit the time card individually.

A time card in the Pending or Rejected state can be submitted.

Role required: timecard_user

When a user submits a time card, the time sheet policy assigned to the user is used for validation. If there is no time sheet policy assigned to the user, the default time sheet policy is used. Business rules prevent a user from submitting a time card in case any violation is found.

1. Navigate to:
   - Time Sheets > My Time Cards > All
   - The Time cards related list in a time sheet.

   **Note:** You can select multiple time cards to submit.

2. In the Time Card list, open the time card to submit.
3. Click Submit Time Card.

   - The time card moves to the Submitted state.
   - The time card is submitted to an approver based on the values set in the Project time approver and Non-project time approver fields in the time sheet policy assigned to the user.

   **Note:** If the project or user manager is changed after submitting the time card, the time card is automatically redirected to the new project or user manager for approval.

Approve or reject a time card
As a time card approver, you can view and approve or reject a submitted time card.

Role required: timecard_approver or timecard_admin

You can view only those time cards that are submitted to you for approval. The time sheet policy assigned to the user governs the approval process.

1. Navigate to Time Sheets > Time Cards > Pending Approval.
2. Select the time card to approve or reject.
3. Click Approve or Reject.

   - The time card moves to the Approved or Rejected state.

   **Note:**
   - A user manager can also approve the time cards within a time sheet by selecting one or more time cards and approving them. When all the time cards in a time sheet are approved, the time sheet automatically moves to the Approved state.
   - If a time card is in Rejected state, then the associated time sheet also moves to the Rejected state irrespective of the state of other time cards in the time sheet.
   - If Project time approver is set to Both in the time sheet policy assigned to the user, the time card remains in Submitted state only when either approver approves the time
card. If one of the approver rejects, the time card state is set to the Rejected, and the Approved by field is cleared, requiring approval of both approvers on resubmission.

Record time worked

Time accrued on a project or spent working on any record in the Task table is retrieved by the time card from the **Time worked** field.

This field does not appear by default on the Project Task, Incident, Problem, and Change forms and must be added by personalizing the form. Time recorded in this field is used to populate an existing time card or to create a new time card if one does not already exist. This behavior is controlled by a time sheet policy.

**Note:**

When time worked is updated, a time card is created only if:

- the user is a time card user, AND
- the user is assigned to the task through **Assigned to** or **Additional assignee list** field.

The Time worked field has a counter that acts like a stopwatch for the duration of the time spent in the record. The counter can be stopped and started by a button in the field. By default, the Time worked counter is enabled and begins recording the elapsed time when the record is opened. Stop the counter with the stop button and restart it with the play button.

Time counter started:

![Time worked started](image)

Time counter stopped:

![Time worked stopped](image)

If you are creating time cards from time worked entries, you can add the related list to display the time worked records on the time card form. You will also notice an informational message on the time card to let you know that changes to time worked records will override values in the time card. This is displayed using a **formatter**, which can be added or removed by configuring the form.
Manage costs

When the cost management feature is enabled, time cards can be used to manage the cost of labor in the Cost Management application.

Enable the cost management feature. When a time card is marked Approved, the user's rate (listed in the Labor Rate Card) is used to generate a one-time Expense Line for the time worked. If no Labor Rate Cards apply to the user, the property `com.snc.time_card.default_rate` defines a default rate.

Roles

The `timecard_admin` role enables users to approve, modify, and delete the time cards of other users.

Project Manager Dashboard

The Project Manager Dashboard provides the project managers with quick reports of time card exceptions, and category wise time reported for their projects. The dashboard displays time card reports only for the projects managed by a project manager.

The dashboard can be activated using the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics Premium license to use this dashboard.

The reports in the dashboard are filtered based on Project, and Date selected.

The project manager dashboard consists of these components:

**Project time card exception count**

It displays the total count of entries in Project time card exceptions report.
Project time card exceptions report

The Project time card exceptions report lists the users who did not submit their time cards, and the time cards which are not yet approved for the selected project and time range. The exception report is generated for the users who are assigned to a task in progress, or hard allocated to the project/task in that time range. The report displays the following data:

- **User**: The time card user assigned to the selected project, or hard allocated to the resource plan associated with the project. If there are more than one time cards for a user in a given date range which are not submitted or require approval, then multiple entries are listed for the user.
- **Week starts on**: Starting date of the time card week in the selected time range.
- **State**: State of the time card. Time card entries with state as **Not Submitted** are also listed if a time card is not created for the week.

The report is generated from the project_timecard_exception table. It requires the schedule job **Project Time Card Exceptions** to be running to get the up-to date information.
Total approved hours for project(s)

It displays the total approved hours in all project categories displayed in **Time by Project Time Category** report.
Total approved hours for project(s)

1,253

Total approved hours for projects

Time by Project Time Category report

The bar chart report displays the time approved against each project category for the users allocated to the selected project.
Use the Project Manager Dashboard
The Project Manager Dashboard shows the time card reports for the selected projects.

Role required: it_project_manager, timecard_admin

1. Navigate to Time Sheets > Project Manager Dashboard.
2. Select a project and date range from the Project and Date choice lists.
3. Review the displayed reports and take necessary actions, if required.
User Manager Dashboard

The User Manager Dashboard provides the user managers with reports of time sheet exceptions, and category wise time reported by the users.

The dashboard can be activated using the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics Premium license to use this dashboard.

The dashboard displays time sheet reports only for those time card users who have the Manager field on User form set to the current user.

The reports in the dashboard are filtered based on Date range, and User selected.

The user manager dashboard consists of these components:

Time sheet exception count

It displays the total count of entries in Time sheet exceptions report.

Time sheet exception count

Time sheet exceptions report

The Time sheet exceptions report lists the users who did not submit/create their time sheets, and the time sheets which are not yet approved for the selected user, and time range. The report displays the following data:

- **User**: The time card user whose manager in User profile is the current user. If there are more than one time sheets for a user in a given date range which are not submitted or require approval, then multiple entries are listed for the user.
- **Week starts on**: Starting date of the time sheet week in the selected time range.
- **State**: State of the time card. Time sheet entries with state as Not Submitted are also listed if a time sheet is not created for the week.

The report is generated from the time_sheet_exception table. It requires the schedule job Time Sheet Exceptions to be running to get the up-to-date information.
Total approved hours

It displays the total approved hours in all categories displayed in Time by category report.
Total approved hours

485

Time by category report

The bar chart report displays the time approved against each category for the selected users whose manager in User profile is the current user.
Use the User Manager Dashboard
The User Manager Dashboard shows the time sheet reports for the users.

Role required: resource_manager, timecard_admin

The dashboard displays time sheet reports only for those time card users who have the Manager field on User form set to you.

1. Navigate to Time Sheets > User Manager Dashboard.
2. Select a date range and user from the Date and User choice lists.
3. Review the displayed reports and take necessary actions, if required.

Worker Portal
Worker Portal categorizes and displays all your assigned tasks in a single view for a given week. The portal enables you to record time spent on tasks on a day-to-day basis and submit the time sheet in a single action.
Worker Portal works with the Task table to record the time that you spend on various task types, such as projects, incidents, problems, and change requests. It provides a complete breakdown of the time you enter for the task, task categories, and days in a week. It enables you to:

- Generate time cards for assigned projects or project tasks.
- Copy time cards from a previous time sheet.
- Search and create a time card for a task that is not displayed in the assigned tasks list.
- Edit, delete, or add notes to a time card.

Worker Portal comprises the following sections:

**Header**

![Header Image]

The Worker Portal header:

- Displays a date range of the time sheet for the selected week and provides options to navigate to the previous or next week’s time sheet.
- Provides a link to navigate to the time sheet for the current week when a different time sheet is being viewed.
- Indicates the state of the time sheet being viewed.
- Indicates the total number of hours that you entered in the time sheet.
- Provides options that enable you to submit a time sheet, copy time cards from a previous time sheet, and generate time cards for assigned tasks.
Tasks

The **Tasks** tab displays your assigned tasks as cards. Each card provides information about a task, such as short description, state, last updated date and time, and priority. Tasks are derived from the following filter conditions:

- All your assigned incidents, problems, or change requests that are active.
- All your assigned incidents, problems, or change requests that are closed in the selected week.
- All tasks for which you are hard-allocated during the selected week.
- All your assigned projects or project tasks that are active during the selected week. Project or project tasks are derived from the following conditions:
  - A project or project task that has started and its actual start date is before the end of the selected week.
  - A project/project task has closed and its actual end date is after the week has begun.
  - When there are no actual dates for a project, planned dates of the project must occur within the selected week.
- All active stories assigned to you.
- All active scrum tasks assigned to you or closed in the selected week.
- All active test plans assigned to you.
- All active defect and enhancements assigned to you or closed in the selected week.

**Note:** If the Customer Service Management plugin (com.sn_customerservice) is activated, your assigned tasks that are active and closed in the selected week are also derived from the following tables:
- Case (sn_customerservice_case)
- Work Order (wm_order)
- Work Order Task (wm_task)

On the **Tasks** tab, you can perform the following operations:
- Type a keyword in the search field to view only cards with details that match the keyword.
- Sort cards in ascending or descending order based on priority, irrespective of the task type.
- View cards based on a category, such as projects, project tasks, incident, problem, change, defect, enhancement, test plans, and scrum tasks.
- **Create time cards** for assigned tasks.

**Note:** *Time sheet policies* apply when you create or edit a time card.
The Other tab displays cards used to log time against operational work, such as administration, meeting, and KTLO.

**Note:** The list of categories in the time card controls the list of cards displayed on the Other tab. If an administrator marks any of the categories as inactive in the time cards, those categories are not displayed on the Other tab.
Time Sheet

- The Time Sheet section displays the total number of tasks and hours that you have entered for each day in a week. When you click a day in the time sheet, that column for that day is highlighted in both the Time Sheet and Logged Time Cards sections. The first day displayed in the Time Sheet section is based on the value specified in the week starts on field in users Time Sheet Policy. For example, if the week starts on field is set to Friday, the Time Sheet section starts with Friday.
- Time Sheet breakdown displays a breakdown of user-entered hours in different work categories, such as admin, meeting, follow on tasks, or change requests.

Logged Time Cards

- The Logged Time Cards section displays time cards, in rows, for a given week. Each row provides details, such as task number, project time category, short description of the task, logged time, and state of the time card. Each row of the time card contains options that enable you to edit, delete,
or add notes to a time card. For more information, see *Create time cards and log time through Worker Portal.*

When there are no time cards, the Logged Time Cards section displays the **Generate Time Cards** and **Copy from previous time sheet** options that you can use to create time cards.

*Create time cards and log time through Worker Portal*

After you create time cards in Worker Portal, log time in the time cards.

Role required: timecard_user

1. Navigate to **Time Sheets > Worker Portal.**
2. Create time cards in the Logged Time Cards section using any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate time cards for assigned projects or project tasks</td>
<td>1. Click ▼ next to Submit.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Generate Time Cards.</strong> This option also appears in the center pane of the page when a user has no time cards for the selected week in the Logged Time Cards section.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>• If a time card exists for a project task during the selected week, a duplicate time card is not created.</td>
<td></td>
</tr>
<tr>
<td>• Time cards are generated only for those project tasks that are in progress or planned for the selected week.</td>
<td></td>
</tr>
<tr>
<td>• The <strong>Allow time card reporting on</strong> field on the project form determines the level at which the time cards are created for project tasks.</td>
<td></td>
</tr>
<tr>
<td>Copy time cards from a previous time sheet</td>
<td>1. Click ▼ next to Submit.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Copy from previous Time Sheet.</strong> This option also appears in the center pane of the page when a user has no time cards for the selected week in the Logged Time Cards section.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>• Time cards for all the project tasks that are in progress or planned in the current week are copied from the selected time sheet. If a time card for a project task exists, a duplicate time card is not created while copying.</td>
<td></td>
</tr>
<tr>
<td>• Time cards for all the non-task categories, such as meetings and trainings, are copied from the selected time sheet. If a time card for a non-task category exists, a duplicate time card is created while copying.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Steps</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Create a time card from the Tasks or Other tab | 1. On the **Tasks** or **Other** tab, point to any task (card) that you want to create a time card for.  
2. Click **Add to Time Sheet**.  
   **Note:** Add to Time Sheet creates a time card with the default rate type of the user, if it exists.                                                                                                     |
| Create multiple time cards from the Tasks tab | 1. On the **Tasks** tab, select multiple tasks (cards) that you want to create time cards for.  
2. Click **Add selected to Time Sheet**.                                                                                                                                                                       |
| Create a time card with logged time       | 1. On the **Tasks** or **Other** tab, point to any task (card) that you want to create a time card for.  
2. Click **Quick Add**.  
3. Select a project time category. This step is optional.  
   **Note:** This field is displayed only for a project or project tasks.  
4. Select a day and add hours and notes, if any.  
5. Select a rate type.  
   **Note:** This field is visible only when the allow multiple rate types check box is selected in the time sheet policy of the user.  
6. Click **Add Time**.  
   **Note:**  
   - When a time card exists for the same task and project category, **Quick add** adds hours to the existing time card.  
   - You can create multiple time cards for the same task using **Quick Add**. Each time card is differentiated by the value in the Rate type column.                                                                                              |
| Create a time card from the Logged Time Cards section | 1. Click **Add unassigned tasks to Time Sheet**.  
2. In the search bar, enter the task number or short description of the task you worked on during the selected week.                                                                                                                                |

Based on the **Allow time card reporting on** field settings in the **Preferences tab** of a project, the **Add to Time Sheet**, **Quick Add**, and **Add selected to Time Sheet** options are displayed in Worker Portal.

3. To log time in a time card:
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Through edit</td>
<td>1. Point to a row in the Logged Time Cards section and click the <strong>Edit</strong> icon.</td>
</tr>
<tr>
<td></td>
<td>2. Enter hours on the time card form.</td>
</tr>
<tr>
<td></td>
<td>3. To add notes, click the <strong>Notes</strong> icon.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

| Through inline editing     | 1. Select a row in the Logged Time Cards section and press **Enter**. You can also double-click a row.                                                                                     |
|                            | 2. Edit the values in the row and click ✅.                                                                                                                                                |

*Submit time sheet through Worker Portal*
Submit a time sheet for a given week.

Role required: timecard_user

When you submit a time sheet, time cards are verified against the assigned *time sheet policy*. If there is no time sheet policy assigned, time cards are verified against the default time sheet policy. Business rules prevent you from submitting a time sheet when any violation is found.

1. Navigate to **Time Sheets > Worker Portal**.
2. Click **Submit**.

The time sheet moves to the Submitted state.

*Tools for driving tasks*

There are several tools available to drive tasks to completion.

These tools can be run on any table which extends Task.

- **Approvals**
  Approvals can be generated to a list of Approvers, either manually or automatically, according to Approval Rules. Approvals can be incorporated into workflows or can stand alone. For more information, see *Process approvals*.
  Approvals can be used on tables that do not extend Task.

- **Assignments**
  Assignment rules can automatically assign tasks to users or groups, ensuring that tasks are handled by the most appropriate team members. For more information, see *Defining Assignment Rules*.

- **Service levels**
  Service level agreements can track the amount of time that a task has been open, to ensure that tasks are completed within an allotted time.

- **Inactivity monitors**
Inactivity monitors ensure that tasks do not fall by the wayside by notifying users when tasks have been untouched for a predefined period of time. For more information, see Setting Inactivity Monitors.

- **Workflow**

An administrator can specify a specific workflow process to apply to tasks that meet certain conditions. After a task is created that meets the conditions, the workflow applies an automated process to the task. The process is defined in the graphical workflow editor.

As the process takes place, it updates any field designated as a workflow field.
Workflows are not specific to the tasks, but there are task-specific Workflow Activities (such as Task Activities and Approval Activities). For more information, see Workflow Overview.

**Many to many task relations**

By default, tasks can be related to each other using a parent/child relationship, such as a Problem with a group of child Incidents or a Catalog Request with a group of child Catalog Tasks. However, it may prove useful to record exactly the nature of the relationship between the task records. When activated, the Many to Many Task Relations plugin allows administrators to define relationships between different tasks.

**Request many to many task relations**

The Many to Many Task Relations plugin is included with several plugins.

- Planned Task
- Field Service Management
- Project Management
- Governance, Risk, and Compliance

**Note:** Contact ServiceNow to activate the plugin by itself.

1. In the HI Service Portal, click **Service Requests > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least 2 business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.

| Reason/Comments | Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows. |

3. Click **Submit**.

**Plugin manifest**

When the plugin is activated, the Task Relationships application is available with certain modules.
Task relationships

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Relation Types</td>
<td>Contains the definitions for the possible types of relationships between knowledge articles and tasks.</td>
</tr>
<tr>
<td>Knowledge Relationships</td>
<td>Displays all of the defined relationships between existing tasks and knowledge articles.</td>
</tr>
<tr>
<td>Relationship Types</td>
<td>Contains the definitions for the possible types of relationships between tasks.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Contains all of the defined relationships between existing tasks.</td>
</tr>
</tbody>
</table>

The following Relation Types are available by default:

- Knowledge Relation Types
  - Solution is documented in::Documenting solution for

- Relationship Types
  - Caused by::Causes
  - Contains::Task of
  - Documenting Solution for::Solution is documented in
  - Investigated by::Investigates
  - Permanent correction for::Permanently corrected by
  - Related to::Related to
  - Requesting::Requested by
  - Solved by::Solves

Define a relationship type

Create type codes that define the relationship between parent and child tasks.

The Many to Many Task Relations plugin must first be activated. To learn more, see Request many to many task relations.

1. Navigate to Task Relationships > Relation Types and click New.

2. Populate the Parent Descriptor and Child Descriptor fields with a short description of the relationship between the two tasks, such as a parent descriptor of Caused By and a child descriptor of Causes.
3. Right-click the form header bar and select **Save**. The Name field automatically populates with the Parent and Child descriptors.

**Define a task relationship allowed from the task relationship type record**

It is possible to define Task Relationships Allowed from the Task Relationship Type record.

1. Scroll down to the related list and click **New**.
2. Populate the parent and child tables to define which tables are able to accept the relationship.
3. If desired, it is possible to define scripts to run in the Parent and Child script fields. These scripts are run when a parent or child record is run to automatically generate the other task (child or parent). These scripts use the current value of the new record, as opposed to the source record which triggered the script.
Modify the displayed field

The fields displayed in the Task Relations field and editing interface are defined by the Reference Lookup’s list view.

To modify the displayed fields:

1. Navigate to a form that has a reference to the table whose display values you would like to modify within Task Relations field.
2. Click the magnifying glass to display the Reference Lookup list view.
3. Right-click the list header and select **Configure > List Layout**.

   The selected List layout will be used as the display value for records within the Task Relations field.

Mark as Solution button

This button gets added to the KB popup view and is displayed when you search the knowledge base from a task record.

Clicking the button creates a record in the Task / KB Relationships [task_rel_kb] table to associate the KB article with a task. You can disable this button by marking the active field false on the ‘solution_button’ UI macro.

Define task relationships with UI actions

Once the task relationships are defined, it is possible to use UI Actions to define the task relationship as a new task is being created from an old task.
Below are a few examples.

**Warning:** These examples may not work on all instances. They are provided as illustrative examples.

## UI Actions examples

### Cause an incident

This UI Action allows the change management team to log an incident directly from the change request and records that the change caused the incident.

Create a UI Action on the Change Request (change_request) table and place the following into the script:

```
var inccaus =new GlideRecord("incident");
inccaus.short_description= current.short_description;
inccaus.comments= current.comments.getHTMLValue();
// inccaus.parent = current.sys_id;
inccaus.insert();
CauIncident();

gs.addInfoMessage("Incident "+ inccaus.number+" created");
action.setRedirectURL(current);
action.setReturnURL(inccaus);
```

```
function CauIncident(){
  var m2m =new GlideRecord('task_rel_task');
m2m.initialize();
m2m.child= current.sys_id;
m2m.parent= inccaus.sys_id;
m2m.type.setDisplayValue("Caused by::Causes");
m2m.insert();}
```

### Cause a problem

This UI Action allows the change management team to record a problem from a change request and record that the change caused the problem.

Create a UI Action on the Change Request (change_request) table and paste the following script:

```
var probcaus =new GlideRecord("problem");
probcaus.short_description= current.short_description;
probcaus.comments= current.comments.getHTMLValue();
// probcaus.parent = current.sys_id;
probcaus.insert();
CauProblem();

gs.addInfoMessage("Problem "+ probcaus.number+" created");
action.setRedirectURL(current);
action.setReturnURL(probcaus);
```

```
function CauProblem(){
  var m2m =new GlideRecord('task_rel_task');
m2m.initialize();
m2m.child= current.sys_id;
m2m.parent= probcaus.sys_id;
m2m.type.setDisplayValue("Caused by::Causes");
Fix a problem

This UI Action allows a change request to be generated from a problem, recording that the change fixes the problem.

Create a UI Action on the Problem (problem) table, and paste the following code:

```javascript
var fixchg = new GlideRecord("change_request");
fixchg.short_description = current.short_description;
fixchg.comments = current.comments.getHTMLValue();
// fixchg.parent = current.sys_id;
fixchg.insert();
FixChange();

gs.addInfoMessage("Change \+ fixchg.number\+" created");
action.setRedirectURL(current);
action.setReturnURL(fixchg);

function FixChange(){
  var m2m = new GlideRecord('task_rel_task');
m2m.initialize();
m2m.child = current.sys_id;
m2m.parent = fixchg.sys_id;
m2m.type.setDisplayValue("Fixes::Fixed by");
m2m.insert();
}
```

Data dictionary tables

These tables provide data dictionary, data modeling, and entity relationship information:

- Tables (sys_db_object): Contains a record for each table.
- Dictionary Entries (sys_dictionary): Contains additional details for each table and the definition for every column on each table. Each row represents either a column on a table or a table.
- Field Labels (sys_documentation): Contains the human-readable labels and language information.

Tables

The Tables (sys_db_object) table contains a record for each table in the database.

Access the Tables list by navigating to System Definition > Tables. Administrators can create a custom table, add or modify columns in a searchable and sortable embedded list, and define the auto-number format.

The following image shows a list of the tables that extend the Task table.
The Dictionary Entries \([\text{sys\_dictionary}]\) table, also called the **System Dictionary**, defines every table and field in the system. It contains information about data type, character limit, default value, dependency, and other attributes of a field.

Access the system dictionary in one of these ways:

- To see the system dictionary list view, navigate to **System Definition > Dictionary**.
- To view particular dictionary definition, right-click the list header, form header, or field label, and select **Configure Dictionary**.

The following image shows a filtered list of dictionary entries for the Incident table and the Task table, which it extends.
Field Labels

The Field Labels (sys_documentation) table, also called the Language File, contains information about the labels and hints for each table and column in the system.

Access the language file in one of these ways:

- To see the list view, navigate to System Definition > Language File.
- To see the field label for a particular field, right-click the field label on the form.

The following image shows the language file filtered to display only labels on the Incident table.
Field Labels

System dictionary

The system dictionary is a table, called Dictionary Entry [sys_dictionary], that contains details for each table and the definition for every column on each table in an instance.

Each row in the system dictionary represents either a table or a column in one of the tables. The system dictionary provides options for administrators to modify tables and fields, which in turn define lists and forms.

Use caution when changing system dictionary records because changes can have a high impact on functionality. In particular, changes to dictionary entries for system tables, which are tables that begin with sys_, can create system-wide issues such as the inability to use update sets.

Dictionary changes are difficult to reverse. Also, dictionary changes automatically apply to all extended tables unless a dictionary override is defined. Be sure that changes are well-tested before applying them to a production instance.

Creation options

When you create a field from the system dictionary, it is automatically added at the end of the first section of the default form view.
In most cases, use the following interfaces rather than creating entries directly on the system dictionary:

- To create new tables and fields, use the Tables module.
- To create new fields, configure the table form.

**Dictionary overrides**

Dictionary overrides provide the ability to define a field on an extended table differently from the field on the parent table.

For example, for a field on the Task (task) table, a dictionary override can change the default value on the Incident (incident) table without affecting the default value on Task (task) or on Change (change).

Administrators can override these aspects of a field:

- Reference qualifiers
- Dictionary attributes
- Default values
- Calculations
- Field dependencies
- Default column display values
- Mandatory and read-only status

**Define a dictionary override**

Use a dictionary override to allow a field in a child table to have a different value or behavior than the same field in a parent table. For example, a dictionary override changes the default value of the priority field from 4 in the parent table to 5 in the Incident table.

Dictionary overrides are only available for tables that support table extension. You can only add dictionary overrides on tables that are in the same scope as the parent table.

1. Navigate to **System Definition > Dictionary**.
2. Open the record for the field.
3. In the **Dictionary Overrides** related list, click **New**.
4. Fill in the fields on the form, as appropriate (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>The application scope to which the record belongs.</td>
</tr>
<tr>
<td>Base table</td>
<td>The parent table containing the field to override.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the extended table to which the dictionary override applies.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope as the dictionary override.</td>
</tr>
<tr>
<td>Override reference qualifier</td>
<td>Select the check box to display the <strong>Reference qualifier</strong> field, which overrides the <strong>reference qualifier</strong> for the field on the extended table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Override dependent</td>
<td>Select the check box to display the <strong>Dependent</strong> field, which overrides the field on which the current field depends.</td>
</tr>
<tr>
<td>Override attributes</td>
<td>Select the check box to display the <strong>Attributes</strong> field, which overrides the <strong>dictionary attributes</strong> for the field on the extended table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Any attributes defined on the base table are ignored. If there are attributes on the base table that should still apply to the extended table, make sure to include them in this field.</td>
</tr>
<tr>
<td>Override default value</td>
<td>Select the check box to display the <strong>Default Value</strong> field, which overrides the default value for the field on the extended table.</td>
</tr>
<tr>
<td>Override calculation</td>
<td>Select the check box to display the <strong>Calculation</strong> field, which overrides the calculation of the value for the field on the extended table.</td>
</tr>
<tr>
<td>Override mandatory</td>
<td>Select the check box to display the <strong>Mandatory</strong> field, which overrides whether the field on the extended table must contain a value to save a record.</td>
</tr>
<tr>
<td>Override read only</td>
<td>Select the check box to display the <strong>Read only</strong> field, which overrides whether a user can change the field value on the extended table.</td>
</tr>
<tr>
<td>Override display value</td>
<td>Select the check box to use this field as the display value on the extended table. For example, the Story (rm_story) table uses the short description as the display value in reference fields instead of the number, as defined in the Task (task) table.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Modify dictionary entries**

You can modify dictionary entries by configuring a field on a form or from the Dictionary module.

1. Do one of the following:
   - Navigate to a field on a form, right click the field, and select **Configure Dictionary** or **Show <field name>**. The system dictionary entry for the field opens.
   - Navigate to **System Definition > Dictionary**, and click an entry for a field or table. Entries for tables have **Type** set to **Collection**.

2. Update the dictionary entry fields.
3. Click **Update**.

**Dictionary entry form**

The Dictionary Entry form was redesigned to provide an Advanced view and additional fields. You might need to configure the form to see all fields.
## Dictionary Entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Defines the table in which the element is created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This list shows only the tables that meet the scope protections for adding fields.</td>
</tr>
<tr>
<td>Type</td>
<td>Defines the field type of the column or, if the Type is Collection, indicates that the dictionary entry represents the table. For more information, see Introduction to Fields.</td>
</tr>
<tr>
<td></td>
<td>You can change the type of a field. To preserve existing data, only change between logical types that map to the same physical type on the database. For example, Choice and String.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables or disables the field. When this check box is cleared, the field is not used by the system.</td>
</tr>
<tr>
<td>Read only</td>
<td>Determines whether users can change the field value. When this check box is selected, users cannot change the value. The data for the field is calculated and displayed by the system.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can override this option for extended tables.</td>
</tr>
<tr>
<td>Audit</td>
<td>Enables or disables auditing for a table. Turning on Auditing (History) for a Table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option only applies to tables.</td>
</tr>
<tr>
<td>Text index</td>
<td>Determines whether searches index the text in a table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option only applies to tables. To exclude fields from indexing, see Remove an Index for a Specific Field.</td>
</tr>
<tr>
<td>Column label</td>
<td>Defines a unique label for the column. The label appears on list headers and form fields for the column.</td>
</tr>
<tr>
<td></td>
<td>• Updating the Column label field also updates the label in the language file (for the current language).</td>
</tr>
<tr>
<td></td>
<td>• When you create a new column, the column name is populated automatically based on the label, which is prefixed with u_ to indicate that it is custom. For example, if you enter Activity Description as the column label, the column name defaults to u_activity_description.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Column name| Defines the field name of the column. When you create a new field, this name is populated automatically based on the label and a prefix as follows:  
- For a field on a table in a different scope, the name is prefixed with the scope to indicate that it is custom and not part of that application.  
- For a field on a table in the same scoped application, the name does not have a prefix, which indicates that it is part of the application.  
- For a field in a global application the name is prefixed with u_, to indicate that it is custom.  
You cannot modify the prefix; however, you can modify the rest of the name. The name can contain only lowercase, alphanumeric ASCII characters and underscores (_). You cannot change the name of an existing dictionary record. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max length</td>
<td>Provides a logical limit for the size of string fields to determine how the system displays them in the user interface and how to map them to physical database data types. String fields with a length under 255 characters appear as a single-line text fields. String fields with a length over 254 characters appear as a multi-line text box. The system maps the field length to the closest physical data type available on the database. In some cases this results in significantly more available length than originally specified. For example, entering a length of 50 maps to the closest physical data type of VARCHAR(100), which provides up to a 100 character limit or double the requested field length. Likewise, entering a length of 1000 maps to the closest physical data type of MEDIUMTEXT, which provides up to a 4000 character limit or four times the requested field length.</td>
</tr>
</tbody>
</table>

**Note:**
- You can only change this value for a **String** field. Changes for any other type of field are ignored.
- Users on an Oracle instance cannot increase the maximum length of a string field to anything greater than 4000 through the application UI as this requires the CLOB datatype in Oracle. To increase beyond this size, log an incident with technical support to request the change.
- To prevent data from being lost, only decrease the length of a string field when you are developing a new application and not when a field contains data. A warning appears if a change to a custom field will result in data loss. For a base system field, you cannot make a change that will result in data loss.

<table>
<thead>
<tr>
<th>Mandatory</th>
<th>Determines whether this field must contain a value to save a record. For more information, see <a href="#">Creating Mandatory Fields</a>.</th>
</tr>
</thead>
</table>

**Note:** You can override this option for extended tables.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Indicates that this field is the display value for reference fields. Set this to true for the one field whose value you want to use as the text displayed in links to this table on lists and forms. By default, the Number field is the display value for all task tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>- This option does not control whether a list or form displays this field as part of the layout. Instead, see List Configuration and Personalizing Forms.</td>
</tr>
<tr>
<td></td>
<td>- The display value becomes part of the form title when viewing an individual record from a table.</td>
</tr>
<tr>
<td></td>
<td>- You can set a different display value on an extended table than the display value on a parent table by using a dictionary override.</td>
</tr>
<tr>
<td>Attributes (Advanced view)</td>
<td>Alters the behavior of a field or functionality that depends on the field. For more information, see Dictionary Attributes. Attributes can be overridden for extended tables with dictionary overrides. You can also configure attributes for this dictionary entry through the Attributes related list.</td>
</tr>
<tr>
<td>Default Value</td>
<td></td>
</tr>
<tr>
<td>Use dynamic default (Advanced view)</td>
<td>Allows you to specify a default value that is generated dynamically based on a dynamic filter.</td>
</tr>
<tr>
<td>Dynamic filter value (Advanced view)</td>
<td>Specifies the dynamic filter that determines the default value if the Use dynamic default option is selected.</td>
</tr>
<tr>
<td>Default value</td>
<td>Specifies the default value of the field for any new record. Ensure that this value uses the correct field type. For example, an integer field uses a default value of 2 but cannot use a default value of two. These values can be overridden with dictionary overrides.</td>
</tr>
<tr>
<td>Reference Specification</td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>Makes the field into a reference field. If you enter a name that does not match an existing table, a new table is created when you save your changes to the dictionary record. If the current table has a module in the application navigator, a module for the new table is automatically created in the same application menu.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use reference qualifier (Advanced view)</td>
<td>Specifies the type of qualifier to use:</td>
</tr>
<tr>
<td></td>
<td>· Simple: A set of choice lists where you can specify a reference qualifier condition.</td>
</tr>
<tr>
<td></td>
<td>· Dynamic: A dynamic filter that you can use to build the qualifier.</td>
</tr>
<tr>
<td></td>
<td>· Advanced: A static encoded query string or JavaScript code that you can use to build the qualifier.</td>
</tr>
<tr>
<td>Reference qual condition</td>
<td>Specifies a condition when the reference qualifier runs if the Simple qualifier type is selected.</td>
</tr>
<tr>
<td>Dynamic ref qual (Advanced view)</td>
<td>Specifies the dynamic filter that determines the reference qualifier when the Dynamic qualifier type is selected.</td>
</tr>
<tr>
<td>Reference qual (Advanced view)</td>
<td>Filters the records available for a reference field if the Advanced qualifier type is selected. Reference qualifiers can be overridden with dictionary overrides.</td>
</tr>
<tr>
<td>Reference key (Advanced view)</td>
<td>Identifies a field other than sys_id to use as the unique identifier for reference fields.</td>
</tr>
<tr>
<td>Reference cascade rule (Advanced view)</td>
<td>Defines what happens to a record if the record it references is deleted. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>· Clear: clears the references (default).</td>
</tr>
<tr>
<td></td>
<td>· Delete: deletes all referencing records.</td>
</tr>
<tr>
<td></td>
<td>· Restrict: prevents record deletion if there is a referencing record.</td>
</tr>
<tr>
<td></td>
<td>· None: does not change referencing records.</td>
</tr>
<tr>
<td>Reference floats (Advanced view)</td>
<td>Enables the Edit button on related lists for one-to-many relationships.</td>
</tr>
<tr>
<td>Dynamic creation (Advanced view)</td>
<td>For reference fields, determines whether entering a value that does not match an existing record creates a new record on the referenced table. If selected, use the Dynamic creation script field to define how to create the new record.</td>
</tr>
<tr>
<td>Dynamic creation script (Advanced view)</td>
<td>When the Dynamic creation field is selected, allows you to enter a script for creating a record on the referenced table.</td>
</tr>
<tr>
<td>Dependent Field</td>
<td></td>
</tr>
<tr>
<td>Dependent on field (Advanced view)</td>
<td>Specifies a field on which the current field depends. For more information, see Configuring Dependent Fields.</td>
</tr>
</tbody>
</table>

Note: You can override this value for extended tables.

Choice List Specification
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Choice                       | Allows users to see a list of suggested values in one of the following ways:  
  - Drop-down menu without -- None --  
  - Drop-down menu with -- None --  
  - Suggestion  
  If a choice is used, either define a choice list or use the fields Choice table and Choice field to copy choices from another field elsewhere in the dictionary.                                                                                                                                                                                                                                                   |
| Choice table (Advanced view) | Populates the field choices with the same values as another choice field. If the Choice field is set to anything besides None, select a table to draw choice values from. The field Choice field must also be populated.  
  For example, if Choice table is set to the Incident (incident) table, this field has the same choice list as one of the choice fields on Incident. Choice field (see below) determines which field.                                                                                                                                                                                                                      |
| Choice field (Advanced view) | Populates the field choices with the same values as another choice field. If the Choice field is set to anything besides None, select a field from the table you selected for Choice table. For example, if the Choice table field is set to the Incident (incident) table, and Choice Field is set to Priority, this field has the same choices as the Priority field on Incident, even if those choices change.  
  **Note:** This field must be a choice field.                                                                                                                                                                                                                                                                                                      |
| Calculated Value             | Determines whether the value of the field is calculated from other values. If selected, use the Calculation field to define how the calculation is performed. When sorting or grouping by a calculated field, the sort order is based on the field value from the last time the field was updated, not the last time the field was displayed.  
  **Note:** In relation to business rules, calculated fields are populated first before any business rule, even a before business rule, is run. Calculated fields are then populated again if necessary after any before business rules run.                                                                                                                                                                         |
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Calculation (Advanced view)** | When the **Calculated** field is selected, allows you to enter a script for calculating the value of the field. These can be overridden for extended tables with *dictionary overrides*. You can use the current object in this script. Just as with access control rules, the script can:  
  - Evaluate to true or false.  
  - Return an answer variable set to true or false.  
  - Set a field value directly, such as:  
    
    ```
    current.display_name="name".
    ``` |
| **Additional fields** |  |
| **Class** | Identifies the table that the current table extends. Tables that do not extend other tables specify their own name in this field. For more information, see [Tables and Classes](#). |
| **Defaultsort** | Obsolete. |
| **Size class** | Determines whether the platform handles this table as a large table by reducing the amount of memory stored for each row during queries. There is a scheduled job which runs and sets the value of this field. |
| **Spell check** | Enables or disables spell check on the field. For more information, see [Adding Spell Check to a Field](#). |
| **Unique** | Requires the field value to be unique.  

**Warning:** Making a field unique when the corresponding table already has different values for that field causes data loss. Before you enforce uniqueness on a field, verify that no records in the table for the field have values, or that they all have the same value. |
| **UI action** |  |
| **Default view or Advanced view** | Changes the form view to the default or advanced view. The fields change based on the view. If you are using the default view, you must write a script to accomplish the same tasks that advanced view fields provided. |
| **Related Lists** |  |
| **Access Controls** | Provides access to the access controls that permit or limit access to the data in the table. |
| **Choices** | Provides access to the options in the choice list field you are editing. |
| **Dictionary overrides** | Provides access to the dictionary overrides for this field. |
| **Attributes** | Provides access to the dictionary attributes for this entry. |
Dictionary attributes

Dictionary attributes alter the behavior of the table or element that the dictionary record describes. Administrators can add or modify dictionary attributes.

Adding an Attribute

To add an attribute to a table or field, navigate to the System Dictionary record for the Dictionary entry, and add the attribute to the Attributes field. Attributes are comma-separated; if attributes already exist on a dictionary record, add a comma, with no spaces, before adding a new attribute.

For an attribute that accepts **true/false** values:

- To specify a value of **true**, you can either enter `attribute` or `attribute=true`.
- To specify a value of **false**, you can either ensure that the attribute does not appear or enter `attribute=false`. To maintain values during upgrades, do not remove an attribute that is on a table by default.

Maintaining Attribute Values for Upgrades

If you remove an attribute that is part of the base system, it is automatically restored during an upgrade. To prevent upgrades from changing the desired behavior of your system, leave the attribute on the table or field, but set its value as desired.

For example, if a field has the attribute `knowledge_search=true` by default, do not remove the attribute to set it to false; rather set it to `knowledge_search=false`.

Available attributes

### Available dictionary attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Target Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>allow_null</td>
<td>true/false</td>
<td>field_name field</td>
<td>If present or true, allows entering &quot;None&quot; as the field</td>
</tr>
<tr>
<td>allow_public</td>
<td>true/false</td>
<td>table_name field</td>
<td>If true, the table name field will display tables from all scopes instead of only the current scope.</td>
</tr>
<tr>
<td>allow_references</td>
<td>true/false</td>
<td>field_name field</td>
<td>If true, a tree is displayed to select from that includes reference fields so you can dot-walk.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>approval_user</td>
<td>name of field containing the user(s) for the approval type this field represents</td>
<td>integer field</td>
<td>The fields of the table are used to perform the lookup using a matcher. Approvals are specified as fields in the table that have an attribute of <code>approval_user=&lt;field_name&gt;</code>, where <code>&lt;field_name&gt;</code> indicates the field in the table that contains the users for this approval type. Fields with this attribute contain an integer value that indicates the sequence for the approvals. All approval fields with the same sequence number indicate that multiple approvals are required before continuing. Approvals are requested in the order of the sequence numbers. For example, all approvals with sequence number 100 must be approved before approvals with sequence number 200 are requested.</td>
</tr>
<tr>
<td>attachment_index</td>
<td>true/false</td>
<td>any table</td>
<td>If true, attachments on the table are indexed for search purposes. See <a href="https://service-now.com">Enable Attachment Indexing</a>.</td>
</tr>
<tr>
<td>barcode</td>
<td>true/false</td>
<td>string field</td>
<td>Allows a string field in the <a href="https://service-now.com">Using the ServiceNow Classic mobile app</a> to access a mobile device's camera to scan and process a bar code.</td>
</tr>
<tr>
<td>base_table</td>
<td>name of base table type</td>
<td>table_name field</td>
<td>A table_name field allows the user to choose any table derived from the table specified by this attribute. By default, the base table itself is also included in the choice list (but see <code>skip_root</code> to turn off this behavior).</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>calendar_elements</td>
<td>list of field names, separated by semicolons (';')</td>
<td>any calendar event table</td>
<td>Specifies a list of fields to be used when constructing the description of a calendar event. If not specified, the usual display name plus short description are used. The <code>calendar_elements</code> attribute does not support derived (dot-walked) fields.</td>
</tr>
<tr>
<td>collection_interval</td>
<td>interval specified as &quot;HH:MM:SS&quot; (like '01:02:30' for one hour, two minutes, and thirty seconds)</td>
<td>collection field</td>
<td>Specifies the interval of metrics collection.</td>
</tr>
<tr>
<td>close_states</td>
<td>inactive state integer values</td>
<td>task state field</td>
<td>Used by the TaskStateUtil API - identifies the list inactive state values delimited by semicolons (';')</td>
</tr>
<tr>
<td>critical</td>
<td>true/false</td>
<td>any field in the apm_application table</td>
<td>Defines fields that are critical information about an application. This allows tracking the entry of critical information.</td>
</tr>
<tr>
<td>current_location</td>
<td>true/false</td>
<td>string field</td>
<td>Allows a string field in the Using the ServiceNow Classic mobile app to access the GPS location of a mobile device.</td>
</tr>
<tr>
<td>disable_execute_now</td>
<td>true/false</td>
<td>any table derived from sys_auto</td>
<td>If present or true, disables the usual Execute Now button. This is used by applications using schedules (such as Discovery) to substitute their own more appropriate action.</td>
</tr>
<tr>
<td>default_rows</td>
<td>integer value</td>
<td>multtext fields</td>
<td>Sets the default number of rows in a multtext field.</td>
</tr>
<tr>
<td>default_close_state</td>
<td>state integer value</td>
<td>task state field</td>
<td>Used by the TaskStateUtil API - identifies the default close state value for a task table</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>default_work_state</td>
<td>state integer value</td>
<td>task state field</td>
<td>Used by the TaskStateUtil API - identifies the default working state value for a task table</td>
</tr>
<tr>
<td>detail_row</td>
<td>name of field to display in detail row</td>
<td>any table</td>
<td>Displays the value of the specified field as a detail row for each record in the list view. UI15 is required to use this attribute.</td>
</tr>
<tr>
<td>email_client</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, causes an icon (an envelope) to appear in the more options menu in the form header. If clicked, a popup email client appears.</td>
</tr>
<tr>
<td>exclude_auto_recovery</td>
<td>true/false</td>
<td>any table</td>
<td>Disables automatic recovery of draft records for this table and its extensions.</td>
</tr>
<tr>
<td>extensions_only</td>
<td>true/false</td>
<td>any table</td>
<td>Table should only have records in tables that extend it. For example, the Task table has this attribute because you would create incident, problem, change records and not task records.</td>
</tr>
<tr>
<td>field_list_selector</td>
<td>true/false</td>
<td>any glide_list</td>
<td>Allows the user to select a field from the dependent table (or current if dependent is not specified). This is used in some workflow activities.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>field_decorations</td>
<td>UI Macro name list, separated by semicolons (&quot;;&quot;)</td>
<td>most fields (except list and multiline text fields)</td>
<td>Similar to <strong>ref_contributions</strong>, causes the named UI macro to be invoked when the field is rendered on a form.</td>
</tr>
<tr>
<td>format</td>
<td>format name</td>
<td>any numeric field</td>
<td>Specifies a named format to use instead of the standard numeric formatting. Options are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>glide_duration</strong>: formats a time specified in milliseconds as <em>ddd hh:mm:ss</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>none</strong>: disables automatic number formatting (for example, changes 2,500 to 2500).</td>
</tr>
<tr>
<td>fv</td>
<td>table name; field name; sys_id</td>
<td>field_value field</td>
<td>This uses the three values to set the display of the field_value field.</td>
</tr>
<tr>
<td>glide.db.oracle.ps.query</td>
<td>true/false</td>
<td>any table</td>
<td>If present and false, prevents the use of Oracle prepared queries on the table.</td>
</tr>
<tr>
<td>global_visibility</td>
<td>true/false</td>
<td>any table with a sys_domain column</td>
<td>If present or true, makes this table visible globally even if there are domain restrictions (that is, the sys_domain field has a value).</td>
</tr>
<tr>
<td>hasLabels</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, marks this table as being the target of a label at some point. This attribute can be set manually, but it is set automatically whenever a label is generated. When true, the label engine runs on any change to the table, updating the labels as needed.</td>
</tr>
<tr>
<td>hasListeners</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, marks this table as available for listeners to get events (insert, update, delete) on.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>hasWorkflow</td>
<td>true/false</td>
<td>any table</td>
<td>Tells the workflow engine to listen for changes to the table, firing events to a workflow when a record associated with a particular workflow has changed.</td>
</tr>
<tr>
<td>html_sanitize</td>
<td>true/false</td>
<td>any HTML or translated HTML field</td>
<td>If present or true, HTML sanitization is enabled for the selected HTML or Translated HTML field. By default, HTML Sanitization is performed on all HTML and Translated HTML fields. Set this attribute to false to disable sanitization.</td>
</tr>
<tr>
<td>icons</td>
<td>name of JavaScript class</td>
<td>any workflow field</td>
<td>Specifies a JavaScript class that produces workflow icons.</td>
</tr>
<tr>
<td>image</td>
<td>relative path of image file</td>
<td>any table</td>
<td>Specifies an image file to be used when the table is used in a module or BSM map. This specification overrides the icons that would otherwise be used for the table.</td>
</tr>
<tr>
<td>include_container_types</td>
<td>true/false</td>
<td>any internal_type field</td>
<td>Causes the field to render with container (split) types as well other types.</td>
</tr>
<tr>
<td>iterativeDelete</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, forces all row deletes to be executed iteratively. Otherwise, some deletes may be performed using a more efficient bulk method.</td>
</tr>
<tr>
<td>knowledge_custom</td>
<td>name of JavaScript function</td>
<td>any field</td>
<td>Specifies a JavaScript function to implement a custom knowledge search (see knowledge_search).</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>knowledge_search</td>
<td>true/false</td>
<td>string fields</td>
<td>If present or true, causes a knowledge search icon (a small book) to appear next to the field. Clicking this icon launches a pop-up window for searching the knowledge base, unless a custom knowledge search function has been specified (see knowledge_custom).</td>
</tr>
<tr>
<td>largeTable</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, marks this table as “large” for the purpose of preventing table locking with specific MySQL database operations (adding/removing a column/index, compacting a table). Without this attribute (or the smallTable attribute), whether a table is large is determined by the glide.db.large.threshold property, or the default value of 5,000.</td>
</tr>
<tr>
<td>listen</td>
<td>true/false</td>
<td>any field</td>
<td>If present or true, causes a call to a JavaScript function named &lt;tableName&gt;_&lt;fieldName&gt;Listen or globalListen if that function does not exist. The function is called with arguments (tableName, fieldName, oldValue, newValue).</td>
</tr>
<tr>
<td>live_feed</td>
<td>true/false</td>
<td>any field</td>
<td>If present or true, creates a toggle option on the activity formatter header for incidents, tasks, and problems. The toggle provides the choice between the Live Feed for that record (also known as a document feed) or the activity formatter fields already in use. See Activity formatter for more details.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>long_label</td>
<td>true/false</td>
<td>any reference field</td>
<td>Long or short labels refer to the label displayed for reference fields on a form. For example, if the reference field contains the caller’s email address, the long label would be Caller Email, while the short label would just be Email. Usually the placement of the reference field on the form makes it clear what the field represents. The global property (glide.short.labels) is used to specify the type of labels displayed for all reference fields on any form. This global property can be overridden for any reference field by setting the short_label=true or long_label=true attribute for the reference field in the Dictionary.</td>
</tr>
<tr>
<td>maintain_order</td>
<td>true/false</td>
<td>any glide_list</td>
<td>If present or true, displays the up/down arrow order buttons to the right of the list of selected items.</td>
</tr>
<tr>
<td>mode_toggler</td>
<td>true/false</td>
<td>any composite_name field</td>
<td>If present or true, causes a name mode toggle icon (a small right-pointing triangle) to appear to the right of the label. Clicking this icon causes the field's rendering to change from a text field accepting &lt;tablename&gt;.&lt;fieldname&gt; to a pair of reference choice boxes (one for the table, the other for the field). The latter is the default.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------</td>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>model_class</td>
<td>binary Java class name</td>
<td>any field of type</td>
<td>Specifies a model variable within Java code. The model must have a class that implements the IVariablesModel interface.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>glide_var</td>
<td></td>
</tr>
<tr>
<td>model_field</td>
<td>see description</td>
<td>any field of type</td>
<td>Identifies a reference field in the record that has the model defined for it. For example, a workflow activity is associated with an activity definition. The activity definition has a related list of questions that make up the model for that activity definition. By using the activity_definition as the model_field for the activity, the model for the workflow activity is built by reading the questions that are defined for the referenced activity definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>glide_var</td>
<td></td>
</tr>
<tr>
<td>nibble_size</td>
<td>positive integer</td>
<td>any table affected</td>
<td>Specifies the maximum number of records the table cleaner can delete in a single operation. The default value for this attribute is 250.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by the table cleaner.</td>
<td></td>
</tr>
<tr>
<td>nibble_sleep</td>
<td>true/false</td>
<td>any table affected</td>
<td>If false, causes the table cleaner to perform cleanup operations without a pause between each operation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by the table cleaner.</td>
<td></td>
</tr>
<tr>
<td>no_attachment</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, prevents the attachment icon (a paperclip) from appearing on the form header.</td>
</tr>
<tr>
<td>no_attachments</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, attachments will not be checked for and deleted when a record from this table is deleted. Meant for high-activity tables that never have attachments.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>no_audit</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, this field will not be audited, even if the table is being audited.</td>
</tr>
<tr>
<td>no_audit_delete</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, a sys_audit_delete record will never be created when a record from this table is deleted. Meant for high-activity tables that never need sys_audit_delete information.</td>
</tr>
<tr>
<td>no_auto_map</td>
<td>true/false</td>
<td>any table</td>
<td>If true, this field will not be mapped during an import set. This is primarily used for LDAP imports.</td>
</tr>
<tr>
<td>no_email</td>
<td>true/false</td>
<td>any glide_list field referencing sys_user</td>
<td>If present or true, the email box is removed from the glide_list field like the Watch list field.</td>
</tr>
<tr>
<td>no_multiple</td>
<td>true/false</td>
<td>any glide_list field</td>
<td>Hides the select multiple icon.</td>
</tr>
<tr>
<td>no_optimize</td>
<td>true/false</td>
<td>any table affected by the table cleaner.</td>
<td>If present or true, prevents the MySQL table compaction operation from running on the specified table. The table compaction operation normally runs after the table cleaner deletes at least 50% of the data in the specified table.</td>
</tr>
<tr>
<td>no_separation</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, marks this table as not participating in domain separation.</td>
</tr>
<tr>
<td>no_text_index</td>
<td>true/false</td>
<td>any field on a text indexed table</td>
<td>If a table is text indexed, the no_text_index attribute on a field will prevent this field from being included in the text index.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>no_truncate</td>
<td>true/false</td>
<td>any string field</td>
<td>In a list view, shows the entire text value of the multi-text value in a list, without truncating it. Without this attribute the string is truncated based on the UI property <strong>Number of characters displayed in list cells</strong> which is 40 by default.</td>
</tr>
<tr>
<td>no_update</td>
<td>true/false</td>
<td>table</td>
<td>Is true for tables in which records are inserted or deleted but not updated. Prevents the system from creating sys_mod_count, sys_updated_by, sys_updated_on fields in the table when it is created. Does not stop the table from being updated. This attribute is used to save space on high volume system tables, such as syslog and sys_audit.</td>
</tr>
<tr>
<td>no_view</td>
<td>true/false</td>
<td>any glide_list field</td>
<td>Hides the view selected item icon.</td>
</tr>
<tr>
<td>onlineAlter</td>
<td>true/false</td>
<td>any table</td>
<td>Tables with the <strong>onlineAlter</strong> attribute perform MySQL database operations using online schema changes. Online schema changes provide a lock-free table upgrade when adding, modifying, or removing columns and when adding or dropping indexes. Without online schema changes, these changes to the database lock write access during execution. Online schema changes use additional system resources. Oracle databases do not lock tables by default and do not use online schema changes.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>order</td>
<td>numeric value</td>
<td>model variable fields</td>
<td>Used internally only (for model variables).</td>
</tr>
<tr>
<td>popup_processor</td>
<td>binary Java class name</td>
<td>any field or table</td>
<td>Specifies a custom popup processor for processing the field (or all fields in a table).</td>
</tr>
<tr>
<td>readable</td>
<td>true/false</td>
<td>any conditions field</td>
<td>When true, causes the conditions field to be rendered in any list view as a human-readable condition (instead of the encoded query stored in the database).</td>
</tr>
<tr>
<td>ref_ac_columns</td>
<td>list of field names separated by semicolons</td>
<td>any reference field with an auto completer (see ref_auto_completer)</td>
<td>Specifies the columns whose display values should appear in an auto completion list in addition to the name. See the cmdb_ci field (Configuration Item) on the Incident form for a working example.</td>
</tr>
<tr>
<td>ref_ac_columns_search</td>
<td>true/false</td>
<td>any reference field with an auto completer (see ref_auto_completer)</td>
<td>Causes auto-complete to work with all fields specified in the ref_ac_columns attribute. This overrides the default behavior, which searches only the display value column. See Configure auto-complete to match text from any reference field.</td>
</tr>
<tr>
<td>ref_ac_display_value</td>
<td>true/false</td>
<td>any reference field with an auto completer (see ref_auto_completer)</td>
<td>Causes the reference field to hide a the display value column so that auto-complete only matches text from the columns listed in the ref_ac_columns attribute. This feature requires the use of the AJAXTableCompleter class and the ref_ac_columns, ref_ac_columns_search, and ref_ac_display_value attributes. See Remove the display value column.</td>
</tr>
<tr>
<td>ref_ac_order_by</td>
<td>field name</td>
<td>any reference field with an auto completer (see ref_auto_completer)</td>
<td>Specifies the column that will be used to order the auto completion list.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Target Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| ref_auto_completer  | JavaScript class name      | any reference field (can be applied to a table to affect all reference fields on the table.) | Specifies the name of a JavaScript class (client side) that creates the drop-down auto completion choices. Valid class values include:  
  - **AJAXReferenceCompleter**: Displays matching auto-complete choices as a drop-down choice-list. The list only displays the reference table’s *display value* column. Reference fields automatically use this class if there is no other auto-completion class specified.  
  - **AJAXTableCompleter**: Displays matching auto-complete choices as rows in a table. The table displays the reference table’s *display value* column and any columns listed in the *ref_ac_columns* attribute.  
  - **AJAXReferenceChoice**: Displays matching auto-complete choices as a drop-down choice-list. The list only displays the reference table’s *display value* column. Furthermore, the list only displays up to 25 matching choices. If there are more than 25 auto-complete choices, the reference field instead displays the choices with the **AJAXTableCompleter** class. For more information, see [Auto-complete for reference fields](https:// servicenow.com). |
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Target Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ref_contributions</td>
<td>UI Macro name list, separated by semicolons (;)</td>
<td>any reference field</td>
<td>Causes the named UI macro to be invoked when the field is rendered on a form.</td>
</tr>
<tr>
<td>ref_decoration_disabled</td>
<td>true/false</td>
<td>any reference field</td>
<td>When set to true, disables display of the reference icon on a selected field.</td>
</tr>
<tr>
<td>ref_list_label</td>
<td>label text</td>
<td>any table</td>
<td>Specifies the title to use in a list banner.</td>
</tr>
<tr>
<td>ref_qual_elements</td>
<td>field name list, separated by semicolons (;)</td>
<td>any reference field with a reference_qual field</td>
<td>Specifies a list of fields to be sent back to the server in order to get an updated reference.</td>
</tr>
<tr>
<td>ref_sequence</td>
<td>list of fields in referenced table, separated by top hats (^)</td>
<td>any reference field</td>
<td>Specifies the fields in the referenced table that should be used to order the choice list. This works like an ORDER BY clause in SQL, with each element in ascending order.</td>
</tr>
<tr>
<td>reference_types</td>
<td>list of valid reference types that are clickable separated by semicolons (;)</td>
<td>field_name field</td>
<td>Limits the reference fields that are displayed in the tree to the specified types.</td>
</tr>
<tr>
<td>remoteDependent</td>
<td>name of database and table (like &quot;model.matcher&quot;)</td>
<td>any script field</td>
<td>Defines the remote (such as, in another database) table that the script depends on.</td>
</tr>
<tr>
<td>repeat_type_field</td>
<td>field name</td>
<td>a repeat count field for schedule rotation</td>
<td>Specifies the field that contains the repeat type (daily, weekly, monthly, or yearly).</td>
</tr>
<tr>
<td>restrictTo</td>
<td>field name (including indirect, dot-walked field references)</td>
<td>any conditions field</td>
<td>Specifies the field that contains the comma-separated list of fields that the conditions should be restricted to using.</td>
</tr>
<tr>
<td>ro_collapsible</td>
<td>true/false</td>
<td>any multi-line field</td>
<td>If present or true, causes an icon (either a &quot;+&quot; or a &quot;−&quot;) to appear next to the field's label, allowing the field itself to be expanded or collapsed.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>scale</td>
<td>integer</td>
<td>decimal field</td>
<td>Sets the number of decimal places to use on the Decimal field type. The default is 2. This is applied to the Max Length of the field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> Increase the Max Length to a value greater than 15 to increase this attribute.</td>
</tr>
<tr>
<td>script</td>
<td>a function that returns the contents of the field</td>
<td>any slushbucket field</td>
<td>Allows you to write a script to define what will be loaded into the slushbucket field.</td>
</tr>
<tr>
<td>short_label</td>
<td>true/false</td>
<td>any reference field</td>
<td>Long or short labels refer to the label displayed for reference fields on a form. For example, if the reference field contains the caller’s email address, the long label would be Caller Email, while the short label would just be Email. Usually the placement of the reference field on the form makes it clear what the field represents. The global property (glide.short.labels) is used to specify the type of labels displayed for all reference fields on any form. This global property can be overridden for any reference field by setting the short_label=true or long_label=true attribute for the reference field in the Dictionary.</td>
</tr>
<tr>
<td>show_all_tables</td>
<td>true/false</td>
<td>document ID fields</td>
<td>Allows users to select documents from system tables. For example, sys_script or sys_user. By default, users cannot select records from system tables.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>show_condition_count</td>
<td>true/false</td>
<td>condition fields</td>
<td>Enables or disables the condition count widget to preview how many records would be returned by a set of conditions. See Add the condition count to a condition field.</td>
</tr>
<tr>
<td>skip_root</td>
<td>true/false</td>
<td>table_name field</td>
<td>If present or true, removes the base table from the choice list (see base_table for more details).</td>
</tr>
<tr>
<td>sla_basis</td>
<td>list of table names separated by semicolons (&quot;;&quot; )</td>
<td>any field of date type (glide_date_time, glide_date, due_date, date, or datetime)</td>
<td>Defines the tables for which this field determines the start (open) time of an SLA.</td>
</tr>
<tr>
<td>sla_closure</td>
<td>list of table names separated by semicolons (&quot;;&quot; )</td>
<td>any field of date type (glide_date_time, glide_date, due_date, date, or datetime)</td>
<td>Defines the tables for which this field determines the start (open) time of an SLA.</td>
</tr>
<tr>
<td>slushbucket_ref_no_expand</td>
<td>true/false</td>
<td>any reference field</td>
<td>If present or true, prevents users from expanding the field from a form or list slushbucket.</td>
</tr>
<tr>
<td>smallTable</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, marks this table as &quot;small&quot; (that is, not large) for the purposes of our querying strategy. Without this attribute (or the largeTable attribute), whether a table is large is determined by the glide.db.large.threshold property, or the default value of 5,000.</td>
</tr>
<tr>
<td>start_locked</td>
<td>true/false</td>
<td>any glide_list field</td>
<td>Determines whether the field is locked or unlocked by default. Set the value to false to unlock the field by default.</td>
</tr>
<tr>
<td>staticDependent</td>
<td>name of table</td>
<td>any script field</td>
<td>Defines the table that the script depends on.</td>
</tr>
<tr>
<td>strip_html_in_pdf</td>
<td>true/false</td>
<td>any field</td>
<td>Attempts to remove HTML tags from a field when that field is exported to a PDF. Most likely useful on HTML fields.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>synch_attachments</td>
<td>true/false</td>
<td>any table</td>
<td>Similar to <code>update_synch</code> but writes the record's file attachments to update sets. See <a href="#">Enable Attachment Indexing</a>.</td>
</tr>
<tr>
<td>table</td>
<td>name of table</td>
<td>field_name field</td>
<td>Displays the fields of the table specified.</td>
</tr>
<tr>
<td>tableChoicesScript</td>
<td>name of script include</td>
<td>table_name field</td>
<td>The name of a script include whose <code>process()</code> method returns an array of table names from which to select.</td>
</tr>
<tr>
<td>target_form</td>
<td>name of form</td>
<td>any table</td>
<td>Specifies the alternative form to be used when this table is referenced through a popup on a reference field.</td>
</tr>
<tr>
<td>text_index_filter_junk</td>
<td>true/false</td>
<td>any table</td>
<td>Set the value to <code>false</code> to disable the junk filter for the table. By default, Zing does not index or search for 2-digit numbers and single character words (unless they are Chinese or Japanese characters). You must regenerate the index after disabling the junk filter. This attribute results in a larger table index. For optimal performance, do not apply it unless it is required.</td>
</tr>
<tr>
<td>text_search_only</td>
<td>true/false</td>
<td>table_name field</td>
<td>Limits the tables listed to those that are searchable by text.</td>
</tr>
<tr>
<td>text_index_translations</td>
<td>true/false</td>
<td>any table</td>
<td>If present or true, forces indexes to be recalculated when translated strings are added. Requires sys-admin role to modify. Automatically set for indexed fields that are translated, and to fields that have a translation and are being indexed. This attribute is overridden by the <code>glide.i18n.force_index</code> system property, which defaults to true.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Target Element</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>time_zone_field</td>
<td>name of field containing the time zone</td>
<td>any schedule date/time field</td>
<td>Specifies the field in the parent record that contains the reference time zone for this field.</td>
</tr>
</tbody>
</table>
| timeDimension      | true/false                   | any field of date type (glide_date_time, glide_date, due_date, date, or datetime) in a table subclassed from the task table | If present or true, enables production of time dimension data for use by OLAP (to produce reports based on quarters, weeks, or other time periods).  
Note: OLAP functionality has been deprecated. |
| tree_picker        | true/false                   | reference field with reference to a hierarchical table | Displays the hierarchy of reference values in a tree display (such as locations).                                                                                                                                 |
| ts_weight          | integer value                | any field                              | Controls the relative importance of a match in the field for text search. See Control Match Relevance By Field.                                                                                               |
| types              | list of valid element types separated by semicolons (";") | field_name field                       | Limits the fields display to the specified types.                                                                                                                                                           |
| update_synch       | true/false                   | any table                              | Indicates that changes in the table are tracked in update sets. Administrators cannot modify this attribute. To migrate data, use an instance-to-instance import.                                             |
| use_document_viewer| true/false                   | any table                              | If present or true, allows users to open supported attachments in a document viewer within the platform, rather than downloading the files directly to their own file system.                               |
| use_workflow       | true/false                   | any table that has delivery plans or uses workflow | If present or true, causes workflow to be used instead of delivery plans.                                                                                                                                     |
Modify the Glide durations format

In order to convert fields that are displayed in milliseconds (such as ‘Resolution Time’ on the Incident table) to a duration format (Months/Days/Hours/Seconds), populate the attribute field on the dictionary with: `format=glide_duration`.

Now the value will be displayed as a duration in lists and can be utilized in the Configure Calculations functions. This may be very useful to illustrate ITIL KPIs such as Mean Time To Repair.

Field Dictionary:

Results in list:
Schema map for tables

The schema map displays the details of tables and their relationships in a visual manner, allowing administrators to view and easily access different parts of the database schema.

The schema map can also be printed directly from a browser.

Schema relationship types supported, and the colors used for them, are:

<table>
<thead>
<tr>
<th>Relationship type</th>
<th>Color used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referenced by</td>
<td>Red</td>
</tr>
<tr>
<td>Referencing</td>
<td>Orange</td>
</tr>
<tr>
<td>Extended by</td>
<td>Green</td>
</tr>
<tr>
<td>Extending</td>
<td>Blue</td>
</tr>
</tbody>
</table>

By default, all these types of relationship are displayed, but you can view or hide each type.

Generate a schema map

Generate a schema map to view and easily access different parts of the database schema.

1. Navigate to **System Definition > Tables & Columns**.
2. In the **Table Names** pane, select a table.
3. Click **Schema map**.

The schema map for the selected table opens in a separate tab or window.

You can print this map from the browser, if required.
View the schema map

The schema map shows the selected table in yellow, typically centered, and all tables related to that table, typically shown at the sides.

From this map:

- The check boxes at the top allow you to control which relationships to display. Select or clear a relationship type to display or hide tables with that relationship to the selected table.
- Each related table has a colored bar indicating the relationship to the selected table.
- You can point to the connector lines to display the details of a relationship between the two tables.

Note: Since relationships are shown as single lines for simplicity, the diagrams rendered are not entity relationship diagrams.

Using the Table Selector:

To view a schema map as a list, point to the table selector in the right corner:
You can:

- Click a table in the list to scroll the schema map to that table.
- Click the eye icon beside a listed table to hide or show that table in the schema map.
- Click the pin icon in the selector to keep the list open.

Using Related Tables:

Right-click a table node header to display a context menu with these functions:

- **Focus on this table**: Make the selected table the new focus table and redraw the schema map based on the new selection.
  
  The new focus table is added as a breadcrumb at the top, allowing you to return to the previous table at any time.
- **Go to list**: Display the list of records for the table.
- **Go to dictionary**: Display the system dictionary, filtered for the selected table.

To hide a related table from view, click the eye icon in the node header (the node can be made visible again with the table selector).

For tables that are part of their own derivation hierarchy, click the expand button (+) in the node header to add their derivation hierarchy to the schema map.

**Viewing More Information**

Click the expand button (+) beside **Columns** to expand the table fields.
The reference fields show a red notation of the table they refer to.

If any tables extend from a table, their columns are displayed in reverse derivation order. For example:

Here, the Server [cmdb_ci_server] table extends from Computer [cmdb_ci_computer], Hardware [cmdb_ci_hardware], and Configuration Item [cmdb_ci], and displays the columns from those tables.

Similarly, the Computer table displays the columns from the Hardware and Configuration Item tables.

Create a many-to-many relationship

Many-to-many relationships allow a list to point to a list of entries, rather than to single field. For example, if a knowledge base article points to a list of related configuration items, it uses a related list. Not all lists can be used as related lists, however. For a list to be related to another list, a many-to-many relationship that refers to both tables must exist.
The Many to Many Definitions [sys_m2m] table allows administrators to create custom many-to-many relationships.

1. In the navigation filter, enter `sys_m2m.list`.
2. Click **New**.
3. In the **From table** field, specify a parent table.
4. In the **To table** field, specify a child table.
   The Many-to-Many form automatically populates the other fields with suggested values.
5. Optional: Edit other field values, if appropriate. Note that Many-to-Many table names cannot exceed 30 characters.

**Reference default many-to-many relationships**

Some many-to-many relationships are defined by default.

To reference many-to-many relationships that are available in the base system, administrators can enter `sys_collection.list` in the navigation filter.

*Note:* Only use this table to view many-to-many relationships in the base system. To create a new relationship, always use the *Many-to-Many Definitions table*.

**List administration**

Administrators control the data presented to end users in a list, the controls that appear, and the behavior of the controls.

*Note:* For information about using lists, see *Lists*.

**List v3 administration**

There are several aspects of list administration that are specific to List v3.

**Activate List v3**

You can activate the List v3 plugin (com.glide.ui.list_v3) if you have the admin role. This plugin activates related plugins if they are not already active.

Review the *compatibility conditions* for List v3. Incompatible lists display in List v2, even when List v3 is enabled. If the instance contains both v2 and v3 lists, the differences in behavior and appearance may impact user experience. Evaluate how much work is required to test list compatibility.

*Note:* List v3 may impact performance and should be tested thoroughly prior to activation on a production instance.

Role required: admin

If these related plugins are not already active, List v3 activates them.
Plugins for List v3

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v3 Components (com.glide.ui.list_v3_components)</td>
<td>Provides components required for List v3, including REST endpoints and Angular components.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

Consider [enabling List v3 for related lists](#). List v3 is disabled for related lists by default.

**Note:** Log out and log back in if you do not see any changes to lists after activating the List v3 plugin.

**Supported browsers for List v3**

List v3 is supported on recent versions of most major browsers.

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 9.1 and later
- The latest public release of Microsoft Edge
- Internet Explorer version 11
  - Edge mode is supported.
  - Compatibility mode is not supported.
  - Setting Security Mode to High (via the **Internet Options > Security** tab) is not supported.
Internet Explorer web browser notes

**Important:** Due to significant performance issues, ServiceNow recommends that customers utilize a modern browser for its products and migrate away from Internet Explorer 11. For more information, refer to [KB0683275](#).

- Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.
- In Jakarta and later, Internet Explorer versions prior to IE11 are no longer supported.
- Compatibility mode is not supported.
- Setting Security Mode to High (via **Internet Options** > **Security** tab) is not supported.

List v3 compatibility

Certain conditions prevent lists from displaying in List v3.

A list will load in List v2 under the following circumstances.

- List v3 is **disabled globally**. Disabling List v3 globally overrides all other conditions. By default, List v3 is enabled globally when the List v3 plugin is activated.
- The list is a related list and List v3 has not been **enabled for related lists**. By default, List v3 is disabled for related lists.
- The associated **list control** has any of the following fields set to **true**:
  - **Disable list v3** (by default, this field is set to **false** for most tables)
  - Hierarchical lists
  - List edit insert row

- All of the associated client-side list **UI actions** that are active have the **List v3 Compatible** field set to **false**. Client-side list UI actions have the **Client** and **List action** fields set to **true**.

**Note:** Embedded lists and list reports are not supported in List v3 and always display in List v2.

Debug List v3 compatibility

If a list displays in v2 when List v3 is enabled globally, you can debug compatibility and fix the issue quickly.

Role required: admin

The debug List v3 compatibility icon (🔍) appears in the title bar of v2 lists.

**Note:** Administrators can configure which roles can see the icon by modifying the `glide.ui.list_v3.debug_compatibility.roles` property. For more information, see [Properties for List v3](#).

1. Click the debug List v3 compatibility icon.
   A compatibility checklist opens. Each applicable condition and its compatibility status, pass (✓) or fail (✗), is listed. If there are client-side UI actions that are not compatible, each one is listed by name.
2. Point to the pass or fail icon to view an explanation of the condition criteria.
3. For failed conditions, click the link to navigate directly to the source of the problem.

**Properties for List v3**

Defines the properties that are available for List v3.

List v3 uses the following properties. These properties do not impact List v2 functionality.

---

**Note:** To open the System Property (sys_properties) table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.admin_import_xml_roles</td>
<td>Determines which user roles are required to access the <strong>Import XML</strong> option in the list title menu. When the value is blank, no role is required.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: admin</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.ui.list.allow_search_box</td>
<td>Allows the search box to display even if the filter controls are restricted.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>Property</td>
<td>Usage</td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| glide.ui.list_v3.append_module_title | Appends the name of the module from which a list was accessed to the list title when enabled. For example, if you open the Incident list by navigating to Incident > All, the list title is Incidents (All).  
- Type: true | false  
- Default value: true  
- Location: System Property (sys_properties) table |
| glide.ui.list_v3.chart_limit | Sets the maximum number of groups to display in list grouping charts.  
- Type: integer  
- Default value: 12  
- Location: Add to the System Property (sys_properties) table |
| glide.ui.list_v3.debug_compatibility.roles | Determines which user roles are required to access the debug List v3 compatibility icon, which appears in the title bar of v2 lists when List v3 is enabled globally. When the value is blank, no role is required.  
- Type: string  
- Default value: admin  
- Location: Add to the System Property (sys_properties) table |
| Enable List v3 glide.ui.list_v3.enable | Determines whether List v3 is enabled globally. Additional conditions may prevent incompatible lists from loading in List v3, even when this property is enabled.  
- Type: true | false  
- Default value: true  
- Location: System Properties > List v3  
- Learn more: Disable List v3 globally |
| glide.ui.list_v3.limit_chart_data | Determines whether list grouping charts display the Other category when the number of groups exceeds the value set in the glide.ui.list_v3.chart_limit property.  
- Type: true | false  
- Default value: true  
- Location: Add to the System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable List v3 for Related Lists on Forms</strong></td>
<td>Determines whether List v3 is enabled for related lists. The <code>glide.ui.list_v3.enable</code> property must be set to <code>true</code> to enable List v3 for related lists.</td>
</tr>
<tr>
<td>glide.ui.list_v3.related_list</td>
<td></td>
</tr>
<tr>
<td>Type: choice list</td>
<td></td>
</tr>
<tr>
<td>Default value: enable_async_v2</td>
<td></td>
</tr>
<tr>
<td>Available values:</td>
<td></td>
</tr>
<tr>
<td>- off: Disables List v3 for related lists. List v2 is used.</td>
<td></td>
</tr>
<tr>
<td>- enable_v3: Enables List v3 for related lists.</td>
<td></td>
</tr>
<tr>
<td>- enable_async_v2: Uses list v2 for related lists, but loads them asynchronously. When form tabs are enabled, only the lists on the visible tab are loaded.</td>
<td></td>
</tr>
<tr>
<td>Location: System Properties &gt; List v3</td>
<td></td>
</tr>
<tr>
<td>Learn more: Enable List v3 for related lists</td>
<td></td>
</tr>
<tr>
<td><strong>Enables real-time record updates on List v3 (Note: this may impact system performance)</strong></td>
<td>Determines whether live updates are enabled for v3 lists. When live updates are enabled, record updates appear in real time, without the need to refresh the list manually. In Jakarta and after, live lists are enabled by default.</td>
</tr>
<tr>
<td>glide.ui16.live_lists.enabled</td>
<td></td>
</tr>
<tr>
<td>Type: true</td>
<td>false</td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
</tr>
<tr>
<td>Location: System Properties &gt; List v3</td>
<td></td>
</tr>
<tr>
<td><strong>Allow related list query conditions to be added through the filter</strong></td>
<td>Determines whether the related list conditions builder is enabled for List v3 list views. The <code>glide.ui.list_v3.enable</code> property must be set to <code>true</code> to enable the related list conditions builder.</td>
</tr>
<tr>
<td>glide.ui.list.related_list_search_filter</td>
<td></td>
</tr>
<tr>
<td>Type: true</td>
<td>false</td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
</tr>
<tr>
<td>Location: System Properties &gt; List v3</td>
<td></td>
</tr>
<tr>
<td>Learn more: Add related list conditions</td>
<td></td>
</tr>
<tr>
<td><strong>Lowering the value of glide.ui.list.record_watcher_throttle property may impact system performance.</strong></td>
<td>Time (ms) to wait between reacting to record watch events</td>
</tr>
<tr>
<td>glide.ui.list.record_watcher_throttle</td>
<td></td>
</tr>
<tr>
<td>Type: integer</td>
<td></td>
</tr>
<tr>
<td>Default value: 30000</td>
<td></td>
</tr>
<tr>
<td>Location: System Properties &gt; List v3</td>
<td></td>
</tr>
<tr>
<td><strong>glide.ui.list_v3.enable_live_related_lists</strong></td>
<td>Determines whether live updates are enabled for v3 related lists. When live updates are enabled, record updates appear in real time, without the need to refresh the list manually.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Type: true</td>
<td>false</td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
</tr>
<tr>
<td>Location: System property (sys_properties) table</td>
<td></td>
</tr>
</tbody>
</table>
Configure available related tables for the related list query

You can configure which related list tables are available to users in the related list query. The related list query is only available in List v3.

Role required: admin

Related Lists Conditions choice list

Users only see the related tables that they are authorized to view. The administrator can add a system property for any table and specify which related tables to exclude for everyone from the choice list.

1. To configure the related tables to exclude, add a new system property with the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;table&gt;.related_list_query.blacklist</td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>comma-separated list of tables to exclude from the choice list.</td>
</tr>
<tr>
<td></td>
<td>Example: task_sla.task, task_ci.task</td>
</tr>
</tbody>
</table>

2. Click Submit.
Add this system property for every table for which you want to exclude related table choices.

**Enable List v3 for related lists**

List v3 is disabled for related lists by default. You can enable List v3 for related lists by editing a property.

Note that incompatible related lists display in List v2, even when List v3 is enabled for related lists. If a form contains both v2 and v3 related lists, the differences in behavior and appearance may impact user experience. Evaluate how much work is required to ensure each form displays related lists of the same version.

Role required: admin

1. Navigate to **System Properties > List v3**.
2. Locate the property called **Enable List v3 for Related Lists on Forms** (*glide.ui.list_v3.related_list*) and select **Enable V3** from the list.
3. Click **Save**. Assuming that List v3 is enabled globally, all compatible related lists display in List v3.

**Disable List v3 globally**

You can disable List v3 globally by editing a property.

Role required: admin

When you disable List v3 globally, all lists load in List v2 for all users.

1. Navigate to **System Properties > List v3**.
2. Locate the property called **Enable List v3** (*glide.ui.list_v3.enable*) and clear the check box.
3. Click **Save**.

**Disable List v3 for a specific list**

You can configure a specific list view to display v2 lists, even when the List v3 feature is enabled.

Role required: personalize_control
For example, you may need to disable List v3 for a list until you can train everyone who uses the application about the new location of the controls.

1. Navigate to the list for which you want to disable List v3.
2. Click the list title menu icon (三).
3. Select Configure > List Control.
   The List Control form appears.
4. Select the Disable list v3 check box.
5. Click Update.

**List configuration**

Users with the appropriate roles can configure various aspects of lists. Configuration changes apply to all users.

With list configuration, you can add, remove, and reorder list columns. You can configure calculations to appear under columns. You can also hide controls and define access conditions by role for existing list controls. Configuring lists is called personalizing lists in versions prior to the Fuji release.

**Note:** Configuring a list in this way modifies the list for all users. To make changes to a list that are visible to you only, see Personal lists.

### Configure the list layout

You can configure a list to choose which columns appear in a list, create list views, and create new fields on the table.

Role required: personalize_list

1. Navigate to the list you want to configure.
2. Select the view to configure by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Open the list title menu and select View &gt; (view name).</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select Change View, and then click the name of the view.</td>
</tr>
</tbody>
</table>

3. Open the list configuration page by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select Configure &gt; List Layout.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Layout.</td>
</tr>
</tbody>
</table>

4. Use the slushbucket to select the columns and the order of appearance.

In lists using List v2, the first non-reference field automatically links to the form view of the record. For this reason, consider using the record number as the first column in the list layout.

In lists using List v3, the first field automatically links to the form view of the record regardless of whether or not it is a reference field. In this case, an icon appears to the right of the text. This icon links to the referenced record rather than the record displayed on the current list view.
5. Click **Save**.

**Note:** If you create a personal list and then configure the list view differently, the changes do not appear until you reset your personal list to column defaults.

### Add an extended field to a base table list

Administrators can configure a property that determines whether fields on extended tables can be added to a parent table list. For example, when this feature is enabled, you can view and filter on the **Caller** field, from the Incident table, on a Task table list.

**Role required:** admin

**Note:** Enabling this property does not show the extended table fields in the personalize list.

1. Navigate to **System Properties > UI Properties**.
2. Locate the property **Allow base table lists (task, cmdb_ci, etc.) to include extended table fields (incident_state, os_version, etc.), and allow filtering on extended table fields (glide.ui.list.allow_extended_fields)**.
3. Select the check box to enable extended fields on parent table lists. Clear the check box to disable the feature.
4. Click **Save**.

### Configure list calculations in List v2

In List v2, you can configure list calculations for columns, which calculate column totals, minimums, maximums, and averages.

**Role required:** personalize_list

You can configure list calculations for multiple columns in the same list. List calculations apply only to the view of the list in which they are configured. Calculations configured on personalized list views are only visible to the user that created them. Reset list columns on a view to their defaults before configuring a list calculation to ensure visibility to all users.

**Note:** List calculations are available in list reports.

1. In a list of records, right-click the header of a numeric column you want to evaluate with list calculations.
2. Select **Configure > List Calculations**.
   The list calculation window appears.
3. Select one or more of the following list calculation options:
   - Total value (not available for string, date, or date/time fields)
   - Minimum value
   - Maximum value
   - Average value (not available for string, date, or date/time fields)

4. Click OK.
   The calculations appear below the last record in the column. If the list is grouped, in addition to the overall calculations at the bottom of the list, group calculations appear below the last record in each group.

**Configure list calculations in List v3**

In List v3, you can configure list calculations for columns, which calculate column totals, minimums, maximums, and averages.

Role required: personalize_list

You can configure list calculations for multiple columns in the same list. List calculations apply only to the view of the list in which they are configured. Calculations configured on personalized list views are only visible to the user that created them. Reset list columns on a view to their defaults before configuring a list calculation to ensure visibility to all users.

*Note:* List calculations are available in list reports, but the configuration instructions are different because list reports display v2 lists. For more information, see [Configure list calculations in List v2](#).

1. In a list, click the list title menu icon and select **List Calculations**.
   The List Calculations window opens. It lists all columns that are visible in the current list.
List v3 List Calculations window

2. Select the check box for one or more of the following calculation options for any column. You can only select calculation options that are available for a given column.
   - Average (not available for string, date, or date/time fields)
   - Minimum
   - Maximum
   - Total (not available for string, date, or date/time fields)

A calculation preview appears by the check box.

3. To remove all list calculations, click **Clear Calculations**.
4. Close the List Calculations window.
   The calculations appear at the bottom of the list for each configured column.

Configure list controls

You can configure list controls, such as buttons and filters.
Role required: personalize_control

1. Open a list.
2. Open the list configuration page by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select Configure &gt; List Control.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Control.</td>
</tr>
</tbody>
</table>

The List Control form appears.

3. Complete the form.

**Note:** The list control fields that are available for embedded lists are more limited. Unless otherwise noted, the list control fields in the following table are available for both standard and embedded lists.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>View the name of the table for the list or related list. For example, Change Request (change_request). This value is set by the system automatically.</td>
</tr>
<tr>
<td>Related list</td>
<td>View the name of the table and field that define the related list. For example, sysapproval_approver.sysapproval. This value is set by the system automatically.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter the label to display for this list. Allows an admin to customize the label for a related list or list. If not supplied, the default plural label for the file is used. For example, the label for the Incident table would be Incidents.</td>
</tr>
<tr>
<td>Omit new button</td>
<td>Select the check box to prevent the New button from displaying on this list. Clear the check box to display the New button or to control the New button with roles (New roles field). This field is available for standard lists only.</td>
</tr>
<tr>
<td>Omit edit button</td>
<td>Select the check box to prevent the Edit button from displaying on this list. Clear this check box to display the Edit button or to control the Edit button with roles (New roles field). The Edit button does not apply to all lists. This field is available for standard lists only.</td>
</tr>
<tr>
<td>Omit if empty</td>
<td>Select the check box to omit the Related List from the form entirely (no header) if there are no entries for the Related List.</td>
</tr>
<tr>
<td>Omit columns if empty</td>
<td>Select the check box for a top-level list to omit the column headers AND filters/breadcrumbs for an empty column.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Omit filters</td>
<td>Select the check box to hide filters or breadcrumbs for this list. Clear this check box if you always want filters or breadcrumbs or to control filters/breadcrumbs with roles (Filter roles field). This field is available for standard lists only.</td>
</tr>
<tr>
<td>Omit links</td>
<td>Select the check box to hide links for fields that reference other files in this list. Leave this button unchecked to generate links or to control the use of links with roles (Link roles field).</td>
</tr>
<tr>
<td>Omit drill-down link</td>
<td>Select the check box to disable the link to the record from the first column in list view. Users can still click the reference icon to access the record. This field is available for standard lists only.</td>
</tr>
<tr>
<td>List edit type</td>
<td>Controls the ability of a user to edit values directly in individual cells in a list. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Save immediately (cell edit mode):</strong> enables cell editing. The entire row is saved when the user enters a new value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Save data by rows:</strong> enables cell editing. The row is saved only when the user navigates away from the row or clicks the Save icon (✓). This mode allows the user to modify multiple values before saving a record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disable list editing:</strong> prevents users from editing cells in the list.</td>
</tr>
<tr>
<td>List edit tag</td>
<td>Enter an arbitrary string of letters or numbers to create a unique tag that is sent to a reference qualifier as the script variable listEditRefQualTag.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List edit insert row</td>
<td>Select the check box to enable or clear the check box to disable the ability for a user to create new records in list view. When it is enabled, an empty row appears at the bottom of the list.</td>
</tr>
<tr>
<td></td>
<td>This field is available for standard lists only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Enabling this setting renders the list incompatible with List v3. The list always renders in List v2, even if List v3 is enabled.</td>
</tr>
<tr>
<td>Hierarchical lists</td>
<td>Inserts a <a href="https://service-now-hierarchy.com">hierarchical list</a> into a record list. Hierarchical lists enable a user to view the contents of a record’s related lists without leaving the record list form.</td>
</tr>
<tr>
<td></td>
<td>This field is available for standard lists only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Enabling this setting renders the list incompatible with List v3. The list always renders in List v2, even if List v3 is enabled.</td>
</tr>
<tr>
<td>Edit default filter</td>
<td>Specify the filter to apply by default when this list is opened. The edit default filter control is specific to related lists. The option does not appear for standard lists.</td>
</tr>
<tr>
<td>New roles</td>
<td>Specify the user roles that can access the <strong>New</strong> button on this list. Leave the field blank to enable all users to access the <strong>New</strong> button. This option does not apply to embedded lists, which do not contain <strong>New</strong> buttons.</td>
</tr>
<tr>
<td>Edit roles</td>
<td>Specify the user roles required to have the <strong>Edit</strong> button appear in the list.</td>
</tr>
<tr>
<td>Filter roles</td>
<td>Specify the user roles required to have the filter appear in the list.</td>
</tr>
<tr>
<td>Link roles</td>
<td>Specify the user roles required to have links generated for fields that reference other files.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable list v3</td>
<td>Select the check box to disable List v3 for this list. For more information, see <a href="#">Disable List v3 for a specific list</a>. This field is available for standard lists only, when List v3 is activated.</td>
</tr>
<tr>
<td>Default view mode</td>
<td>Choose whether to load this list in List v3 Grid or Split mode by default. For more information, see <a href="#">List v3 split mode</a>. This field is available for standard lists only, when List v3 is activated.</td>
</tr>
</tbody>
</table>

**Example of configuring list controls**

The following example shows how to configure a list of related incidents in a problem record to suit specific business needs.

**Role required:** personalize_control

In this example, a related list label is configured to say Child Incidents, not just Incidents. The related list is also configured to remove the New button to prevent users from creating new incidents from the Problem form.

1. Navigate to a problem record.
2. Open the list context menu in the Incidents related list and select Configure > List Control.
3. On the List Control form, change the Label field to Child Incidents.
4. Select the Omit new button check box.
5. Click Submit to save your changes and return to the previous record, in this case, the problem record.

In the problem record, the label for the embedded incident list has changed and the New button is no longer available.

**Advanced list control with scripts**

You can write scripts to specify which list elements, such as links, filters, and buttons, are present. These scripts can react to the record that is being displayed. For related list controls, the parent record is identified by the global variable parent. For primary lists, there is no parent record.

Configure the List Control form and add the script field that you need:

- **Omit Columns Condition**: Omit column headings if there are no conditions.
- **Omit Edit Condition**: Omit the Edit button.
- **Omit Empty Condition**: Omit the list header if there are no conditions.
- **Omit Filter Condition**: Omit the list filter.
- **Omit Links Condition**: Omit related links.
- **Omit New Condition**: Omit the New button.

In these script fields, if the script evaluates to true, the item is omitted. The following script is an example that you can use on the Affected CIs related list to show only the Edit button if the parent task is active. This script is placed in the Omit Edit Condition script field.

```javascript
var answer;
if (parent.active == true) {
  // Omit Edit button
}
```
Configure a list UI action

You can create a UI action that opens the slushbucket interface to customize lists in the list view.

Role required: ui_action_admin

1. Navigate to System Definition > UI Actions.
2. Click New.
3. In the Table field, select the List (sys_ui_list) table.
4. Select the List context menu check box.
5. Ensure the Active check box is selected.
6. Paste the following script in the Script field:

```javascript
var url  = "slushbucket.do?sysparm_form=list&sysparm_list=" + current.
    name + "&sysparm_view=" + current. view. name ;
url  += "&sysparm_collection=" + current. parent + "&sysparm_collection_relationship=" + current. relationship ;
url  += "&sysparm_referring_url=sys_ui_view.do?sys_id=" + current. view.
toString () ;
action. setRedirectURL (url ) ;
```
7. Click Submit.

Controlling the sort sequence used to display lists

All lists have a default sort sequence based on the type of fields present in the list.

When a user displays a list for the first time, it is sorted by one of the following items.

- The ORDERBY arguments found the URL. (See the following section on source order control.)
- The `<table>.db.order` and `<table>.db.order.direction` user preferences.
- The isOrder dictionary attribute.
- The Order field if one is present in the table.
- The Number field if one is present in the table.
- The Name field if one is present in the table.
- The field specified as the display field for the table.

**Note:** The task table is an exception to the preceding sequence. Task and tables extended from task use the Number field when no URL arguments or user preferences are found.

Setting default order with user preferences

The `<table>.db.order` and `<table>.db.order.direction` user preferences determine the field and sort direction seen by the user. A default sort can be created by creating user preference records with no value in the User field and checking the System check box. This preference is applied to any users who do not have their own preference.
Setting the default sort order in the system dictionary

An administrator can set the sort order of records displayed for a table in the system dictionary when there is no other sort specified. This is done by adding an attribute called `isOrder` with a value of `true` to the dictionary entry of the desired field. This sort is the sort order presented to all users initially. Once a user sorts a list, that user preference is saved, and the list is always sorted for that user based on the previous sorting preference.

**Note:** `isOrder` can define which field is used for list sorting, but cannot control the sort direction.

Sort order control

For any list, if the user has clicked a column header to sort by that column, then that action is remembered. The next time that list is displayed, the same field is used to order the list.

This remembered sort field can be overridden by adding a `sysparm_order` specification to the definition of the module. For example, if each time `News` is displayed, you want the new items listed in order of importance, then the `News` module can be updated accordingly.

```sh
Arguments:
&sysparm_order=importance
```

Set module sort order to the Importance field value

The actual order (ascending or descending) can be specified by adding a `sysparm_order_direction` specification. Here are two examples of sorting a list by the `sys_created_on` field, one ascending and one descending:

```sh
&sysparm_order=sys_created_on &sysparm_order_direction=desc
&sysparm_order=sys_created_on &sysparm_order_direction=asc
```

Sort by multiple fields

To sort a list by multiple fields, remove everything from the filter field and place it in the arguments field. For example, if the filter specifies **(Active) (is) (true)** and you want to sort by category and subcategory, remove the condition and put the following in the module arguments:

```sh
active=true^ORDERBYcategory^ORDERBYsubcategory
```

This argument first orders by the category and then orders by the subcategory. If you want any field to be a descending sort then change `ORDERBY` to be `ORDERBYDESC`.

List editor administration

The list editor allows users to edit field values directly from a list without navigating to a form. Administrators can manage this feature by using the following options. Some of the options are not supported in List v3.

- Configure global properties
Configure list control settings for a table
Configure contextual security rules
Manage user preferences (List v2 only)

**Warning:** In List v2, the list editor does not enforce client scripts or UI policies. In List v3, the list editor enforces UI policies and mandatory dictionary attributes, but not client scripts. Allowing list editing with client scripts running on fields in a form can result in incorrect data being saved to the record. For systems in which client scripts or UI policies apply to forms, consider disabling list editing or creating appropriate business rules or access control to control the setting of values in the list editor. See *Use business rules and client scripts to control field values* for information on managing form and list editing.

**Configure list editor properties**

You can configure list editor properties that control whether lists can be edited, and, for List v2, which field types cannot be edited.

Role required: admin

1. Navigate to **System Properties > UI Properties**.
2. To disable list editing, set the **Enable list editing (glide.ui.list_edit)** property to **No** by clearing the check box.
   
   This property is enabled by default, and it globally enables list editing. When you disable it, the list editor is disabled globally.
3. To configure the field types that cannot be edited for v2 lists, complete the following steps.
   a) Locate the **List of element types (comma-separated) that cannot be edited in the list editor (glide.ui.list_edit_ignore_types)** property. It contains several element types that cannot be edited by default.

   **Note:** This property does not impact v3 lists. There is no equivalent property for List v3.

The following field types are not editable from the list editor by default:

- Conditions (conditions)
- Currency (currency)
- Document ID (document_id)
- Field List (field_list)
- HTML (html)
- Image (user_image)
- List (glide_list)
- Price (price)
- Template Value (template_value)
- Time (glide_time)
- User Roles (user_roles)
- Video (video)

b) Add any other field types you want to disable to the end of the list, separated by a comma.

4. Click **Save**.
Configure list control settings for the list editor

You can configure the list control settings that affect the list editor.

Role required: personalize_control

List control settings customize the behavior of list functions for a table.

1. Navigate to a list view for the desired table.
2. Open the list configuration page by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select Configure &gt; List Control.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Control.</td>
</tr>
</tbody>
</table>
3. On the List Control form, select the desired settings.

List control settings for the list editor

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List edit type</td>
<td>Controls the ability of a user to edit values directly in individual cells in a list. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Save immediately (cell edit mode)</strong>: enables cell editing. The entire row is saved when the user enters a new value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Save data by rows</strong>: enables cell editing. The row is saved only when the user navigates away from the row or clicks the <strong>Save</strong> icon (✔). This mode allows the user to modify multiple values before saving a record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disable list editing</strong>: prevents users from editing cells in the list.</td>
</tr>
<tr>
<td></td>
<td>This field is available for standard lists only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List edit insert row</td>
<td>Select the check box to enable or clear the check box to disable the ability for a user to create new records in list view. When it is enabled, an empty row appears at the bottom of the list.</td>
</tr>
<tr>
<td></td>
<td>This field is available for standard lists only.</td>
</tr>
</tbody>
</table>

4. Click Update.

**Configuring contextual security for the list editor**

The list editor enforces existing access control rules (ACLs) and additional security controls to restrict editing from a list.

The list_edit security operation specifically controls the ability to edit information in a list. Apply this operation in the same manner as the write operation to limit list editing for fields that require the user to navigate to the form. Reasons you may require a user to edit a field in a form include complex UI policy constraints or other policies you have in place.

The list_edit security operation specifically controls the ability to edit information in a list. Apply this operation in the same manner as the write operation to limit list editing for fields that require the user to navigate to the form. Reasons you may require a user to edit a field in a form include complex UI policy constraints or other policies you have in place.

- write and list_edit access to the field
- write and list_edit access to any dependent fields of the field
- write and list_edit access to any fields that are dependent on the field being edited

To configure access controls, navigate to **System Security > Access Controls**. The following examples use the list_edit security operation to restrict list editing in certain contexts.

**Example - Restrict a table**

This access control prevents everyone from editing all fields in the Incident table in a list.
Restrict the Incident Table

- **Type**: record
- **Operation**: list_edit
- **Name Incident**: [incident]
- **Admin overrides**: Clear the check box.
- **Script**: `answer = false;`

**Example - Restrict a field**

This access control prevents everyone except an administrator from editing the Short Description field of an incident record in a list.
Restrict the Incident Short Description

- **Type:** record
- **Operation:** list_edit
- **Name:** Incident [incident], Short Description
- **Admin overrides:** Select the check box.
- **Script:**
  ```java
  answer = false;
  ```

**Example - Restrict a field with a script**

This access control prevents everyone from editing an incident with a category of Software in a list. It is defined by a script.
Restrict Software Incidents

- **Type**: record
- **Operation**: list_edit
- **Name Incident**: [incident]
- **Admin overrides**: Clear the check box.
- **Script**:

  ```java
  if (current.category == 'software')
  answer = false;
  else
  answer = true;
  ```

**Example - Restrict a field with a condition**

This access control prevents everyone from editing a Critical Incident in a list. It is defined by a condition.
Restrict Critical Incidents

- **Type**: record
- **Operation**: list_edit
- **Name Incident**: [incident]
- **Admin overrides**: Clear the check box.
- **Condition**: Priority is not 1 - Critical

User preferences for v2 list editing

Users can set user preferences for v2 list editing by personalizing a list (available when the list mechanic is activated).

To view and manage list editor user preferences, navigate to User Administration > User Preferences.

**Note**: These user preferences do not apply to v3 lists. There are no equivalent user preferences for List v3.
User preferences for v2 list editing

<table>
<thead>
<tr>
<th>User preference name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>list_edit_enable</td>
<td>Set the value to <strong>true</strong> to enable or <strong>false</strong> to disable list editing. Default value is <strong>true</strong>.</td>
</tr>
<tr>
<td>list_edit_double</td>
<td>Set the value to <strong>true</strong> for double-click or <strong>false</strong> for single-click. Default value is <strong>true</strong>.</td>
</tr>
</tbody>
</table>

**Personal list administration**

Users can customize the layout for any list view by personalizing a list. Administrators can configure options related to list personalization.

In List v2, administrators can also disable or restrict access to list personalization. This functionality is not supported in List v3.

**Enable or disable personal lists in List v2**

You can enable or disable List v2 personal lists through the UI Macros module.

Role required: **ui_macro_admin**

**Note:** This functionality does not apply to List v3. Personal lists are not controlled by the list mechanic in List v3 and are always enabled.

1. Navigate to **System UI > UI Macros**.
2. Activate (or deactivate) the **list_mechanic2** UI macro.

**Control which roles can personalize lists in List v2**

You can control who can create personal lists in List v2.

Role required: **admin**

**Note:** This functionality does not apply to List v3. All users can personalize v3 lists.

1. Navigate to **System Properties > UI Properties**.
2. Locate the property labelled **List of roles (comma-separated) that can use Personal Lists. If blank, all can use (glide.ui.list_mechanic.**roles**).**
3. Enter the roles for which personal lists are available, separated by commas, or leave the field blank to allow access for all users (default).

**Manage personal lists**

Administrators can manage personal lists.

Role required: **admin**

1. Navigate to **System UI > Lists**.
2. Personal lists have a user value in the **User** field.
Administer detail rows

Detail rows provide additional information about records in a list.
Role required: admin
To display detail rows, an administrator must enable them globally and add them to lists.

**Note:** Detail rows are supported in UI15 and up. Detail rows are not supported in List v3.

1. To enable detail rows, **add a new system property** with the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.list.detail_row</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

2. To add detail rows to a list, complete the following steps.
   a) Add the **detail_row dictionary attribute** to the table.
      Specify the name of the field to display in the following format:
      `detail_row=short_description`
   b) Use the **all_tables** element descriptor with the **detail_row** attribute to display detail rows for all child tables that contain the designated field.
      For example, `all_tables.detail_row=short_description` is on the Task (task) table by default, so the short description detail row appears in lists for Incident (incident), Problem (problem), and other child tables unless you set `detail_row` to a different field for each one.

Restrict filters and breadcrumbs with fixed queries

The record list view allows users to navigate to different subsets of a table using breadcrumbs and filters. You can limit access to parts of the table by restricting active links in breadcrumbs or by suppressing breadcrumbs and filters for specific roles.
Role required: admin

A breadcrumb option enables an administrator to control the base view of a record list presented to users. By adding a fixed query to the argument for a module, an administrator can prevent users from expanding their view past a specified starting point. The argument for this fixed query is written as **&sysparm_fixed_query=active=true**. A use case for this query is to prevent users from using the breadcrumbs to switch a list of open incidents to a list of all incidents. When users select **Incident > Open**, they are limited to viewing and filtering a list of open (active=true) incidents.

**Note:** A new Create ACL allows all users to save filters by default. This will override any custom ACLs in place if administrators are restricting filter access. The new ACL gives all users access to the User field by default, and access to the Group field only if users have the filter_group role and are in the currently selected group.

1. Perform the appropriate action for your version of the UI:

   | UI16         | Point to the application menu that contains the module to edit and click the edit application (pencil) icon. |
To open the module directly, point to the module and click the edit module (pencil) icon.

### UI15 or UI11

| | Right-click the application in the navigation pane and select Edit Application. |

2. Select the module to edit.
   For example, select **Open**.
3. In the **Link Type** section of the Module form, select **List of Records** for the **Link type**.
4. Delete the **Active is true** filter, if present.
5. Add **&sysparm_fixed_query=active=true** to the **Arguments** field and update the record.
6. Navigate to **Incidents > Open** and examine the breadcrumbs.

The **Active=true** link is the widest view permitted in the list of Open incidents shown. The breadcrumb for **All** is not a link because of the fixed query.
Suppress filters and breadcrumbs with list controls

Use list controls to suppress filters and breadcrumbs on defined tables for users with specific roles.

Role required: personalize_control

1. Navigate to the list view of the table to restrict breadcrumbs.
2. Open list control by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column header and select Configure &gt; List Control.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Control.</td>
</tr>
</tbody>
</table>

You can also navigate to System UI > List Control.

3. On the List Control form, select the Omit Filters check box. Clear the check box to include filters.

The Filter Roles field allows an administrator to specify certain roles that can see the filters.

Use script includes to suppress filters and breadcrumbs

You can use a script to restrict filters and breadcrumbs to specific roles, either on a per-table or global basis. Using a script is an advanced option that offers additional flexibility compared to using list control.

Using a script include requires knowledge of JavaScript.

Role required: script_include_admin

1. Create a script include with the name <tablename>DisplayFilter.
The script section contains one function with the same name as the script include.

2. Use your function to set the global variable `answer` to either true (show the filters and breadcrumbs) or false (hide them.)
   The following example restricts filters and breadcrumbs on the Incident table to users with any role. Be sure that the name of the script matches the function name exactly, including case.

```javascript
var incidentDisplayFilter = Class.create();

incidentDisplayFilter.prototype = {
  type: 'incidentDisplayFilter',
  initialize: function() {
  },

  incidentDisplayFilter: function() {
    var answer;
    if (gs.hasRole()) {
      answer = true;
    } else {
      answer = false;
    }
    return answer;
  }
};
```

3. Optional: To exclude a specific role from having access to filters and breadcrumbs, make the following change.

```javascript
var incidentDisplayFilter = Class.create();

incidentDisplayFilter.prototype = {
  type: 'incidentDisplayFilter',
  initialize: function() {
  },

  incidentDisplayFilter: function() {
    var answer;
    if (gs.hasRole() && !gs.hasRole('newrole')) {
      answer = true;
    } else {
      answer = false;
    }
    return answer;
  }
};
```

Users with the role `newRole` do not have access to filters and breadcrumbs.

4. Optional: To let all users use filters and breadcrumbs on the Incident table, make the following change to your script.

```javascript
var incidentDisplayFilter = Class.create();

incidentDisplayFilter.prototype = {
  type: 'incidentDisplayFilter',
  initialize: function() {
  }
};
```
IncidentDisplayFilter: function() {
    var answer = true;
    return answer;
};

5. Optional: To modify filter and breadcrumb access for another table, create a script include using the name of that table instead of Incident.

Increase the allowed number of breadcrumb entries

You can add a property to allow for a larger number of breadcrumb entries in the filter.

Role required: admin

1. Enter sys_properties.list in the Navigation filter.
   The entire list of properties in the System Properties (sys_properties) table appears.

2. Verify the property does not already exist by searching for glide.ui.breadcrumb_max_entries.

3. Click New.

4. Complete the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.breadcrumb_max_entries</td>
</tr>
<tr>
<td>Type</td>
<td>integer</td>
</tr>
<tr>
<td>Value</td>
<td>The number of breadcrumb entries you want to appear in the filter, for example, 15. The default number is 10.</td>
</tr>
</tbody>
</table>

5. To verify this property, go to any table and use the filter modifier is one of to search for any number of items. The number of entries you entered in the Value field will display before ending in a (...).
Note: You cannot enable a hierarchical list view for an embedded list. Hierarchical lists are not supported in List v3, even if they are enabled.

1. Right-click any column header, and select **Configure > List Control** from the context menu.
2. Select the **Hierarchical lists** check box in the List Control dialog box and then click **Submit** or **Update**.
3. Click the arrow for a record number to display the related lists for the record.
Use list controls in hierarchical lists

By default, no related list tabs are visible in a hierarchical list and only a single related list is displayed at a time. The column headers are hidden by default.

Role required: none

Note: Hierarchical lists are not supported in List v3.

1. To select a different related list, click the link in the list title.
2. Select a list from the menu.

If the related list is empty, the hierarchical list indicates that there are no records to display.

The platform remembers this preference and displays the last selected related list for each table when you open another hierarchical list within that table.

3. To display column headers in the related list, click the show/hide headers icon in the upper right corner of the hierarchical list.
The platform remembers this preference and opens all hierarchical lists with column headers enabled until the headers are hidden.

**Context ranking**

Context ranking allows a user to sort a collection of records preferentially, that is, independently of the attributes of those records.

For example, a Customer Support manager can organize a list of incidents in the order in which a technician should work on the tasks. Creating such an arbitrary list with a list filter is not possible.

**Activate context ranking**

You can activate the Context Ranking plugin (com.glide.sorting) if you have the admin role. This plugin activates related plugins if they are not already active.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see [Purchase a plugin](#).

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see [Request a plugin](#).

For plugins that you can activate yourself, continue with the following steps.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
   
   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
   
4. Optional: If available, select the **Load demo data** check box.
   
   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   
   You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
   
5. Click **Activate**.

---

### Create a ranking definition

Enable context ranking for a related list by creating a ranking definition.

**Role required:** admin

1. Navigate to System Definition > Ranking Definitions.
2. Click **New**.
3. Enter a **Name** for the ranking definition.
4. In the **Record table** field, select the table for which ranking is enabled.
   
   This is the table of the records in the ranked related list. For example, to enable ranking for a related list of incidents in the Problem form, select the Incident (incident) table.
5. In the **Context column** field, select the reference column providing the context in which ranking is to be performed.

   The **context** in this case is the form in which the related list appears and not a table name. For example, a related list with a **Record table** of Incident (incident) can have a number of contexts, including the Problem form or a Configuration item form.
6. Complete the relationship-based fields if the ranking is to be performed on a related list that is defined by a relationship.
   
   - **Relationship table:** select the table forming the other side of the relationship. In the case of the ranking definition for Product stories in scrum, you might use the Product Model (cmdb_model) table.
   
   - **Relationship column:** select the column from the relationship table to compare with the context column. To avoid adding a related list of user stories to the Product Model (cmdb_model) table, you might use the Sys ID column, which defines a subclass of the Product Model table (cmdb_model.sys_id).
7. In the **Attributes** field, enter attributes to change and restrict the contents of the Rank dialog box, as appropriate.
   
   - **visible_columns:** a semi-colon separated list of columns to be displayed in the Rank dialog box. If not specified, the Rank dialog box uses the default view of the related list you selected in the **Record table** field.
- **extra_conditions**: an encoded query to restrict the records shown in the Rank dialog box. For example, the query `extra_conditions=^state!=7` displays all incidents whose state is not **Closed**. If not specified, the Rank dialog box shows all records for the relationship.

8. Click **Submit**.

The index is generated automatically. The system completes these read-only fields:

- Index column
- Rank ui action
- Context menu item

**Note:** After you submit a ranking definition, only the **Attributes** field can be edited. If additional changes are required, delete the record and create a new one with the revised settings.

The system does not generate indexes for ranking definitions inserted into the database by an update set. To use a ranking definition inserted by an update set, you must generate the indexes manually. To generate indexes, open the Ranking Definition form and click **Generate Indexes**.

![Ranking Definition form](image)
Rank a list

After you create a ranking definition for a table, related lists based on that table and context include options for ranking the list and displaying the list by rank.

Role required: none

You can set the preferential order of records.

1. Click the Rank button in the related list to reorder the records.

The Rank dialog box appears, allowing you to sort the records in any order.
2. Click and drag the move icon (👇) to change a record's position.

**Note:** Administrators can define which columns appear in the Rank dialog box in the Attributes field of the Ranking Definition form.

---

**Apply a new sort order to a list**

You can apply a new sort order to the records in a list.

Role required: none

1. Open the context menu from the list title and select **Sort by rank**.
2. To remove the ranking and return to the original order of the list, click the label in any column that contains data.

**Scrum ranking definitions**

Ranking definitions for user stories are part of the SDLC (scrum process) application. These ranking definitions enable scrum users with the proper roles to rank related lists of stories in the these tables:

- Product stories: Application Model (cmdb_application_product_model) table
- Release stories: Release (rm_release) table
- Sprint stories: Sprint (rm_sprint) table

Users can rank stories in the scrum planning board by priority. Story lists ranked in the planning board appear in the new order in product, release, and sprint forms. Stories ranked in one of these scrum forms changes the order in the planning board.

Story points for each story are listed in a ranked view, which is useful for prioritizing stories.
Ranking story points

Rank stories in a related list
The Context Ranking feature enables all scrum users to manually sort a related list of stories by priority.

A product owner or release planner uses this tool to establish the order in which he or she wants the stories worked. Stories ranked in a related list (in the Product, Release, and Sprint forms) appear in the same order in the planning board when the appropriate backlog is displayed. Conversely, stories ranked in the planning board appear in that order when viewed in the related list in the form. Users can switch the view in a Stories related list from ranked to any sort order without changing the ranking in the planning board.

1. In the Stories related list, click Rank.
   A dialog box appears, allowing you to arrange the stories in any order, such as by priority.

2. Click and drag each story into position using the move icon to the left of the story number.

3. When you are done, click the X in the upper right corner to close the list.
   The Stories related list is not sorted by your ranking initially.

4. To view the related list in its ranked order, open the context menu from the related list and select Sort by rank.
5. To return the sort order of the list to an unranked state, click once in the heading of any column that contains data.

The system uses this ranked list to display the appropriate backlog in the planning board. For example, if you rank stories in the Stories related list in the Release form, the release backlog in the planning board uses the same ranking to display the stories. Conversely, scrum masters, product owners, and release planners can create a new ranking order for the Stories related list by rearranging the list of stories in the planning board.

Customize List v2 context menus

You can customize the content and behavior of List v2 context menus.

Role required: admin

For example, you might add an option to the list column heading menu for a specific table. You might also want to change the roles required to access a global context menu option.

**Note:** This functionality is not supported in List v3. Context menu options created this way do not appear in v3 lists. Administrators can create UI actions instead.

1. Navigate to System UI > UI Context Menus.
2. Click New.
3. Complete the form.
Context menu form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Table     | Select the table to which this context menu option is attached. The base system menu items are attached to the Global (global) table, which applies the context menu option to all lists for all tables. If you specify a particular table, the option is available only on context menus in lists from that table.  
  **Note:** The list shows only tables and database views that are in the same scope as the context menu. |
| Menu      | Select the list context menu in which this option appears.  
  - *List title menus*  
  - *Column headings*  
  - *List row menu* |
| Type      | Select the type of menu option to create:  
  - *Action*: A menu option that performs an immediate action.  
  - *Menu*: Creates a parent menu that can display a submenu.  
  - *Separator*: Draws a line between groups of options on a menu. Menus do not display separator lines next to one another or at the bottom of a menu. If a condition that removes options for a role forces two separators together, one of the separators is removed from the view.  
  - *Label*: Create a unlinked label for a menu or section of a menu.  
  - *Dynamic actions*: Menu options dynamically created, such as the available views or user filters that can only be generated at the time the list is displayed. |
<p>| Name      | Enter the label for the action as it will appear in the menu. |
| Parent    | If this action is part of a submenu, type the name of the parent menu item. For example, in the base system, <em>Configure</em> is a parent. |
| Order     | Assign an order number to this item, menu, or separator to specify where in the menu it appears. |
| Active    | Enable or disable this context menu item. Only active items are shown in the context menu. |
| Run onShow script | Select this check box to display the <strong>onShow script</strong> field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Create the conditions under which this menu option appears. For example, define the role that has permission to see this item.</td>
</tr>
<tr>
<td>Action script</td>
<td>The action script runs when someone selects the context menu option. For more information, see <a href="#">Action script for List v2 context menus</a>.</td>
</tr>
<tr>
<td>Dynamic actions script</td>
<td>The dynamic actions script populates the context menu with dynamic options, such as filters or views. For more information, see <a href="#">Dynamic actions script for List v2 context menus</a>.</td>
</tr>
<tr>
<td>onShow script</td>
<td>The onShow script runs before the context menu is displayed, to determine which options appear in the context menu. For more information, see <a href="#">onShow script for List v2 context menus</a>.</td>
</tr>
</tbody>
</table>
### Context Menu

#### Database View

- **Table**: Global [global]
- **Menu**: Listheader
- **Type**: Dynamizations
- **Name**: DatabaseView

**Condition**: `gs.hasRole('admin') && gs.isDatabaseView(ListProperties.getTable()) && ListProperties.getLabelList()`

**Action script**

```
/*
 * Script executed on the client for this menu action
 * + g_list: the GlideList that the script is running against (only valid for List
 *   context menus)
 * + glRunAsName: the name of the field that the context menu is running against
 * + g_sysid: the sys_id of the row or form that the script is running against
 * + 'rowSysId' is also set to the sys_id of the row to support legacy actions,
 *   but g_sysid is preferred
 */
function showDatabaseView(query) {
    var url = new GlideURL('sys_db_view.do');
    url.addParam('sysparm_referencing_url', g_list.getReferringURL());
    url.addParam('sysparm_query', query);
    url.addParam('sysparm_domain_restore', 'false');
    window.location = url.getURL();
}
```

### Dynamizations script

```
/*
 * This server-side script is used to dynamically create actions for the context menu,
 * + Add items to the context menu by calling:
 *   AddAction(item_id, label, script_string, order);
 */
function buildContextActions() {
    var queryGen = new GlideCollectionQueryCalculator();
    var query = queryGen.buildQueryClause(g_tableName, 'name');
    g_contextMenu.addAction('dictionary', g_itemName, 'showDatabaseView' + query + '"");
}
```
4. Click Submit.

**Action script for List v2 context menus**

The *Action script* field, on the Context Menu form, defines a script. The script runs when someone selects the context menu option.

This script is client-side and runs in the user's browser. The following JavaScript variables are available to the Action script when it is executed.

**Action script variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_list</td>
<td>GlideList2 against which the script runs.</td>
</tr>
<tr>
<td>g_fieldName</td>
<td>Name of the field against which the context menu runs.</td>
</tr>
<tr>
<td>g_fieldLabel</td>
<td>Label of the field against which the context menu runs.</td>
</tr>
<tr>
<td>g_sysId</td>
<td>The sys_id of the row or form against which the script runs.</td>
</tr>
</tbody>
</table>

The base system uses the following code in an action script to refresh the platform view.

```javascript
  g_list.refresh(1);
```

Another example is the use of these variables in a list header menu to sort a list by the selected field in descending order (z to a).

```javascript
  g_list.sortDescending(g_fieldName);
```

**Dynamic actions script for List v2 context menus**

The *Dynamic actions script* field, on the Context Menu form, defines a script. The script populates a list context menu with dynamic options, such as filters or views.

The following JavaScript variables are available to the dynamic actions script when it is executed.

**Dynamic actions script variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_tableName</td>
<td>Name of the current table.</td>
</tr>
<tr>
<td>g_listId</td>
<td>ID of the list for which the context menu is built.</td>
</tr>
<tr>
<td>g_itemName</td>
<td>Name defined in the UI context menu record.</td>
</tr>
<tr>
<td>g_itemOrder</td>
<td>Order defined in the UI context menu record. Use this variable to pass the value of the <em>Order</em> field to the dynamic actions script.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following example displays a list title menu item that controls the number of records per page in the list view:

```javascript
    g_contextMenu.addAction('50', g_itemName, 'showRowsPerPage("50");',
    g_itemOrder);
```

**Note:** The action script for this item must define the `showRowsPerPage` function so that when selecting this menu item, that function is called with an argument of 50.

### onShow script for List v2 context menus

The **onShow script** field defines a script that runs before the context menu is displayed to determine which options appear in the context menu.

Use this script to change the menu items on the list header menu based on the current field column. The following JavaScript variables are available to the onShow script when it is executed:

#### onShow script variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_menu</td>
<td>Context menu to be displayed.</td>
</tr>
<tr>
<td>g_item</td>
<td>Current context menu item.</td>
</tr>
<tr>
<td>g_list</td>
<td>GlideList2 against which the script runs.</td>
</tr>
<tr>
<td>g_fieldName</td>
<td>Name of the field against which the context menu runs.</td>
</tr>
<tr>
<td>g_fieldLabel</td>
<td>Label of the field against which the context menu runs.</td>
</tr>
<tr>
<td>g_sysId</td>
<td>The sys_id of the row or form against which the script runs.</td>
</tr>
</tbody>
</table>

An example of an onShow script is one that determines when to enable or disable the **Ungroup** option in a list column heading menu based on whether the list is grouped or not.

```javascript
    if (g_list.getGroupBy()) {
        // list is grouped so enable the Ungroup menu item
        g_menu.setEnabled(g_item);
    } else {
        // list is not grouped, so disable the Ungroup menu item
        g_menu.setDisabled(g_item);
    }
```

### Form configuration

Form configuration involves changing the form layout and the related list layout. The form layout changes what appears on the form and the related list layout changes which related lists appear at the bottom of the form.

You change aspects of a form such as showing or hiding fields, embedding lists, and adding sections and annotations. This video highlights form layout and design.
Using the form designer

Administrators or users with the personalize_form role can use the form design feature to quickly create new or change existing form views.

Form design is an alternative to configuring forms that combines several configuration options into one tool. It is available by default for new instances and requires UI16 or UI15. Administrators who upgrade from a previous version must activate the Form Designer (com.glide.ui.ng.fd) plugin to use the feature.

Parts of the UI form design interface

The page header

The page header displays the current table and view being designed. Each form is tied to a unique table and view combination. For example, there can only be one form for the incident table default view. Select a different view to modify different form layouts for a table.
The field navigator

The field navigator allows you to manage fields on the form. It contains the following elements:

- **Filter**: Allows text search on the currently selected tab.
- **Fields**: Displays a list of existing fields you can add to the current form.
- **Field Types**: Displays a list of field types you can add to the current form. Adding a field type to the form layout creates fields in the selected table when the form layout is saved.
Field properties are accessed by clicking the gear icon that appears when you point to a field in the form layout.
Form layout

The form layout displays a separate cell for each field, section, annotation, UI element, and related list that is on the form. Each cell has an identifying label and a handle icon to aid in selecting and moving it. The location of the cell in the form layout represents its relative position on the form. Only fields visible on the form layout are displayed on a form.
Show or hide fields with the form designer

You can move fields to and from the form workspace to display the fields on the form.

Role required: personalize_form

Use the filter to quickly find fields in the field navigator.

1. Navigate to the form designer.
2. From the list of fields in the Field Navigator, select the field you want to display from the list of available fields.
3. Drag the field to the form layout.
4. Drag the field to the location you want it to be on the form.
5. To remove a field from the form layout, select the field and click the Remove this field (X) button beside the field label.
6. Click Save.

Add a form annotation with the form designer

Use annotations to provide instructions or additional information about fields on a form.

Role required: personalize_form

1. Navigate to the form designer.
2. Click the Field Types tab.
3. Select the Annotations field type.
4. Drag the annotation to the appropriate location on the form.
5. Point to the Annotations field and click the gear icon to open Properties dialog box.
6. In the Properties dialog box, enter a value for Annotation Text.
   You can use HTML tags to format the annotation text.
7. Click Save.

Add a new section with the form designer

Move sections to and from the form layout to display or remove the sections on the form.

Role required: personalize_form

Sections can have a one- or two-column layout.

By default, the first section on a form is always a read-only section displaying the label of the table. You cannot remove this section.

1. Navigate to the form designer.
2. Select an existing section.
3. Click the (+) button beside the section label to add a section.
4. Enter a label for the section.
5. Drag sections to reorder them.
   The label for the first section on the form designer is displayed as the form title.
6. To delete a section, click the (x) button beside the section label.
7. Click Save.
   The following GIF shows how you would use form designer to add and then delete a form section.
### Incident [Incident]

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Caller</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
</tr>
<tr>
<td>Subcategory</td>
<td></td>
</tr>
<tr>
<td>Business service</td>
<td></td>
</tr>
<tr>
<td>Configuration item</td>
<td></td>
</tr>
<tr>
<td>Contact type</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>On hold reason</td>
<td></td>
</tr>
<tr>
<td>Impact</td>
<td></td>
</tr>
<tr>
<td>Urgency</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Assignment group</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td></td>
</tr>
</tbody>
</table>

### 1 Column

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
</tbody>
</table>
Add a formatter with the form designer

Use formatters to add information from macros or previously scripted UI elements to a form. Formatters are used to add information from macros or previously scripted UI elements to a form.

1. Navigate to the form designer.
2. Click the **Fields** tab.
3. In the filter, enter the string **Format**.
4. Select the formatter you want to add to the form.
5. Drag the formatter to the location you want it to be on the form.
6. Click **Save**.

Add a new field with the form designer

You can add a field to a form and the associated table.

Role required: personalize_form

Adding a field creates a dictionary entry for the new column in the current table. You can create a custom table and then use the form designer to add fields to the form.

**Note:** Use the filter to quickly find field types in the field navigator.

1. Navigate to the form designer.
2. Click the **Field Types** tab.
3. Select the cell for the field type to create.
4. Drag the field type to the location you want it to be on the form.
5. Enter a label for the field.
6. Optional: Point to a field in the form design area and click the gear icon to access properties.
7. Click **Save**.

Configure the form layout

Administrators or users with the personalize_form role can configure the form and related list layout.

Show or hide fields on a form

Configure form layout to change what appears on the form. You can perform tasks like changing what fields are visible, embedding lists, and adding sections and annotations.

Role required: personalize_form

1. Navigate to a form.
2. Click the context menu icon (_show or hide fields icon_) and select **Configure > Form Layout**.
3. Using the slushbucket, select the fields and the order in which you want them to appear. Available items that appear in green followed by a plus (+) sign represent related tables. To access fields on these tables, use dot-walking.
In UI16, Form Layout is not responsible for the order of the Additional Comments and Work Notes fields. For more information on how to determine the order of these fields, see Customize activities.

4. Click Save.

**Warning:** It is not recommended to add the same field to more than one section of a form unless the field displays read-only data. Having two or more instances of an
editable field can cause data loss and prevent the proper functioning of UI and data policies.

Through form configuration, you can also add new fields to the form, which creates columns to the table that underlies the form. See Add and customize a field in a table for more information.

**Add a related list to a form**

You can configure related lists to appear on forms and in hierarchical lists.

Role required: personalize_form

Related lists display records in another table that have a relationship with the current record.

1. Open the form.
2. Click the form context menu icon and select Configure > Related Lists.
3. Using the slushbucket, select the related list to display on the form.
4. Click Save.

   Related lists appear at the bottom of the form.

**Add an annotation to a form**

You can add annotations to forms to display blocks of text or to add separators.

Role required: personalize_form

1. Navigate to a form.
2. Click the context menu icon (📝) and select Configure > Form Layout.
3. Under Form view and section, select a section.
4. In the Available list, double-click *Annotation* to move it to the Selected list.

   The Annotation Details section appears.

   © 2019 ServiceNow, Inc. All rights reserved.
   ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. Place it above the field to annotate.
6. In Annotation Details, select the type of annotation. The available types of annotations include Info Box Blue, Info Box Red, Line Separator (any text you add appears beneath the line), Section Details, Section Separator, and Text.
7. Select either **Plain Text** or **HTML** for the data type and enter the annotation in the text box. All valid HTML tags are supported.
   For example, select the **Text** annotation type, the **HTML** data type, and enter `<span style="color:red">Select the primary location:</span>`. The text appears red on the form.
8. Click **Save**.

**Toggle annotations**

Users can toggle annotations on a form in UI16 and UI15.

The `glide.ui.show_annotations` user preference controls the visibility of annotations for each user.

1. Navigate to a form.
2. Perform the appropriate action for your version of the UI.
Create a form section

Create sections on forms to help group related fields together.

Role required: form_admin

Users can expand or collapse form sections to show or hide the fields they need. If you have tabs enabled, each form section appears on a separate tab. The default Change Request form is an example of a form with multiple sections as shown in the following image.
Change Request form sections

1. Right-click the form header and select **Configure** > **Form Layout**.
2. In the **Form view and section** area below the slushbucket, click **New** in the **Section** list.
3. In the **Section caption** field, give the new section a title, then click **OK**.
4. Select a form section name and click the up or down arrow to change the section order.
5. Add fields to the new section using the slushbucket.
6. Click Save when you are finished.

The new section appears on the form with the fields you selected. If you do not add any fields to a section, the section stays empty.

If you want to delete the form section at a later time, do the following:

1. Navigate to System UI > Form Sections.
2. Filter for the table that contains the section you want to delete. For example, the Incident table. The name of the form section to be deleted is displayed in the Caption field.
3. Select the check box beside the form section to delete, and then select Delete from the Actions on selected rows menu.
4. Click OK to confirm the deletion.

Move form splits

Change the place where fields split on a form by moving the split section indicators in a slushbucket.

Role required: admin

1. Navigate to a form.
2. Click the context menu icon ( ) and select Configure > Form Layout.
3. Move any of the following split section indicators:
   - I - begin_split - I
   - I - split - I
   - I - end_split - I
4. Click Save.

Display tabbed forms

Tabbed forms offer a useful way to make forms and related lists take up less space by reducing the scrolling that must be done to navigate the form.
Tabbed forms

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Form sections and related lists are tabbed separately, each with their own tab line. A user always sees the first form section. All sections after that can be tabbed. Tabs are enabled by default for new instances.

Tabbed forms are enabled by default for new instances. A system user preference with the name `tabbed.forms` specifies whether the tabbed UI is used by default for all users. Users can change this preference as described in this procedure.

1. Click the gear icon in the banner frame.
2. Perform the appropriate action for your version of the UI:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td>Select the Forms tab and enable <strong>Tabbed forms</strong>.</td>
</tr>
<tr>
<td>UI15</td>
<td>Enable <strong>Tabbed forms</strong>.</td>
</tr>
<tr>
<td>UI11</td>
<td>Click the tabs toggle icon, which appears on any form with more than two sections and on any form with more than one related list.</td>
</tr>
</tbody>
</table>

In UI16 and UI15, an option is enabled when the switch appears green and is toggled to the right.

**Embed a list within a form**

You can embed lists within a form. When a list is embedded in a form, any changes made to the contents of the list are saved when the form is saved.

Role required: personalize_form

This allows the embedded list to be treated just like another element on the form. In addition, users can create records in the list view. After a row is added to the list, double-click any cell in the list to edit its value. You can add the same lists to a form as embedded lists or as related lists, depending on the path selected in the context menu.

You can also modify embedded list controls, such as the name of the related list and the roles required to create records in the embedded list.

1. Select a record from the list.
2. Right-click the form header and select **Configure > Form Layout**.
   The slushbucket shows the available fields and the lists that can be embedded in the form. Lists appear in red at the bottom of the Available list.
3. Select a list and move it to the Selected column.
4. Use the up and down arrow buttons to position the list in the form.
5. Click Save.

Lists adjust to fit the frames of the adjacent fields.
<table>
<thead>
<tr>
<th>Number</th>
<th>CHG00000109</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by</td>
<td>Fred Luddy</td>
</tr>
<tr>
<td>Category</td>
<td>SAP ORA01</td>
</tr>
<tr>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Risk</td>
<td>High</td>
</tr>
<tr>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Approval</td>
<td>Approved</td>
</tr>
<tr>
<td>Type</td>
<td>Comprehensive</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Bow Rugari</td>
</tr>
</tbody>
</table>

**Approvers**

<table>
<thead>
<tr>
<th>State</th>
<th>Approver</th>
<th>Comments</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Bow Rugari</td>
<td></td>
<td>08-28-2014 23:31:50</td>
</tr>
<tr>
<td>Approved</td>
<td>David Leo</td>
<td></td>
<td>08-28-2014 23:31:50</td>
</tr>
<tr>
<td>Approved</td>
<td>Erich Schroeder</td>
<td></td>
<td>08-28-2014 23:31:51</td>
</tr>
<tr>
<td>Approved</td>
<td>Fred Luddy</td>
<td></td>
<td>08-28-2014 23:31:51</td>
</tr>
</tbody>
</table>
Configure customer updates indicator

You can configure the indicator for customer updates, which are changes that update sets, scripts, service catalog items, and other configuration tables track.

Role required: admin

The customer updates indicator icon (.extent) may appear on the header of forms that have customer updates. Clicking the customer updates indicator opens the update set records for the item.

You can configure this indicator to appear for all or for specific administrators using the owned_by_indicator.form user preference.

1. Navigate to User Administration > User Preferences.
2. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the indicator for all administrators</td>
<td>Set the owned_by_indicator.form preference to true.</td>
</tr>
</tbody>
</table>
| Enable the indicator for an individual administrator | 1. Make sure the owned_by_indicator.form system user preference is set to false.  
2. Create a user preference with the following values:  
  - Name: owned_by_indicator.form
  - User: Select the administrator for which to enable the preference.  
  - Value: true |

Add a chart to a form

Add a chart to a form to show your users graphical data related to the form. For example, you could show an incident SLA-related chart on the Incident form so your users can see how well service level agreements are being met.

Role required: personalize_form

Note: The following report types are not supported on forms: List, Pivot, Multilevel Pivot, Calendar, and Single Score.
1. Navigate to **System UI > Forms**.
2. Select the form you want to configure.
3. Click the context menu icon ( ) and select **Configure > Form Layout**.
4. Using the slushbucket, select **Chart**.
5. Enter a **Label** in the chart details.
6. Click **Save** to return to the form.
7. Click **Configure chart**.
8. Select a chart in the **Report** field and configure other options as desired.
9. Click **Update**.

**Form administration**

Administrators can configure several settings that control form functionality.

**Form personalization**
Control how users configure forms. You can also change the role that is necessary to configure a form and disable the form configurations that specific users already made.

See [Administering form personalization](#) for instructions.

**Form annotations**

Choose the types of annotations that are available on forms and save localized versions of form annotations.

See [Administering form annotations](#) for instructions.

**Attachments**

Control several aspects of form attachments, such as attachment size, allowed file extensions, and the roles that are allowed to attach files.

See [Administering attachments](#) for instructions.

**Formatters**

Create and edit formatters, such as the activity formatter, which displays information on the form that is not a field in the record. You can also configure formatter settings such as the maximum number of formatter entries.

See [Formatters](#) for more information.

**Form templates**

Create templates that automatically populate form fields based on settings you configure.

See [Form templates](#) for more information.

**UI actions**

Add buttons, links, and context menu items on forms to the UI more interactive, customizable, and specific to user activities.

See [UI actions](#) for more information.

**UI policies**

Configure the policies that dynamically change information on a form.

See [Create a UI policy](#) for more information.

**Other advanced options**

Configure advanced form features, such as form focus, form splits, and derived fields.

See [Advanced form configuration](#) for instructions.

**Administering form personalization**

Administrators can configure several aspects of form personalization, which allows users to customize the layout for any form view.

Administrators can manage this function using the following options.

- Activate or deactivate form personalization globally.
- Control user access to form personalization based on roles.
- Manage the personalized forms of users.
Note: Personalizing a form in this way modifies the form for you only. To make changes to a form that are visible to all users, you must configure the form.

Activate form personalization

Form personalization is activated for new instances. To activate form personalization for upgraded instances, an administrator must activate the Form Personalization (com.glide.ui.personalize_form) plugin.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see Purchase a plugin.

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see Request a plugin.

For plugins that you can activate yourself, continue with the following steps.

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the Load demo data check box.

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.

5. Click Activate.

Change form personalization role requirements

By default, the itil role is required to personalize forms, but you can change this requirement with a system property.

Role required: admin

1. Enter sys_properties.list in the navigation filter.
2. Locate the glide.ui.personalize_form.role property in the System Properties list.
3. In the Value field, specify the roles that can access form personalization.

Manage personalized forms

When a user personalizes a form, the system stores the customizations as a user preference record. You can view and manage the user preferences.
Role required: admin

1. Navigate to User Administration > User Preferences.
2. Filter the list by (Name) (contains) (personalize).

   There is a user preference for each form view each user personalizes. The name format combines the word personalize with the name of the table and the name of the view. For example, if a user personalizes the default view of the Asset (alm_asset) form, the user preference is called personalize_alm_asset_default.
3. Delete a user preference to remove the customizations for the user.

**Disable form personalization**

If you do not want your users to customize forms, you can disable form personalization.

Role required: admin

Activating the Personalize Forms plugin sets the glide.ui.personalize_form property to true. You can disable form personalization.

1. Enter sys_properties.list in the navigation filter.
2. Locate the glide.ui.personalize_form property in the System Properties list.
3. Set the Value field to false.

**Administering form annotations**

Form annotations are additional pieces of information on a form, such as a line or paragraph of text. Use form annotations to provide on-screen instructions to your users.

Form annotations are enabled by default in the base system. To disable them, set the glide.ui.form_annotations system property to false.

**Support multiple languages for a form annotation**

You can store multiple translations of form annotation text.

Role required: admin

To support multiple languages, use message records to translate annotation text.

1. Navigate to System UI > Messages.
2. Create a message record for each language you support.
3. On the Message form, set the Key field to a unique identifier for the annotation text.
   - The annotation text is a good key. The key must be the same for each translation message for the annotation.
4. Select the appropriate Language.
5. In the Message field, enter the translated annotation text.
6. Edit the form annotation and reference the message key with a gs.getMessage call.
   - For example, if the message key is Message key text, enter ${gs.getMessage("Message key text")} in the form annotation.

**Administer form annotation types**

You can define the form annotation types to control their appearance.
Role required: admin

1. Navigate to System UI > Form Annotation Types.
2. Set the Active field to false for any types you do not want to use.
3. Click New to add a type.

Administering attachments

Administrators can configure system properties for how files are uploaded and attached to records. Uploading, viewing, and deleting file attachments triggers a single event that can be used for notifications or in scripts.

Attachment tables

When you store an attachment to any table, a record is created in the Attachment (sys_attachment) table that contains attachment metadata. The file data is stored in the Attachment Document (sys_attachment_doc) table, in 4k chunks. For example, if you attach a 12k file called My_attachment.pdf, then there is an Attachment entry with three related Attachment Document entries.

To learn how to upload attachments to records, see Add and manage attachments.

Activity stream thumbnail scaling

The glide.ui.activity_stream.scale_images property scales large images down and creates thumbnails for the activity stream view of the images.

This property is active by default. It applies to images retroactively, so any attachments included in an activity stream in the past also see the effects.

Maximum dimensions for thumbnails using this property are 525 pixels width by 350 pixels height. The system favors the pixel height first, so you can end up with images that are wider than 525 pixels.

Attaching image files over 5 MB can create an out of memory error and cause the instance to restart. An out of memory error and restart occur when the system generates the thumbnail when you attach a new image. The error and restart can also occur the first time you load existing images on a record.

The administrator can add the com.glide.attachment.max_get_size system property to control the maximum image scaling dimensions.

The following information is entered into the (sys_properties.list) table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>com.glide.attachment.max_get_size</td>
</tr>
<tr>
<td>Type</td>
<td>integer</td>
</tr>
<tr>
<td>Value</td>
<td>5242880</td>
</tr>
</tbody>
</table>

The value field represents the size in bytes. The base system value is 5242880 bytes (5 MB). You can change the value as necessary.

With this property set, images that are larger than 5 MB are not scaled and the system creates a link instead. Images smaller than 5 MB are scaled down.
Configure the max image size property for Activity Streams

When attaching an image in an Activity Stream, the system controls the maximum size of the image. Use the com.glide.attachment.max_get_size property to control the maximum image scaling dimensions.

Attachment events and logging

A script action or notification can process attachment events. Only one event is created when action is taken on a record with attachments, even when the record has multiple attachments. The following events are provided.

Only one event is created when action is taken on a record with attachments, even when the record has multiple attachments. The following events are provided.

Attachment events

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachment.read</td>
<td>An attachment has been read or downloaded.</td>
</tr>
<tr>
<td>attachment.uploaded</td>
<td>An attachment has been uploaded. If multiple attachments are uploaded to a record at one time, only one event is created.</td>
</tr>
<tr>
<td>attachment.deleted</td>
<td>An attachment has been deleted. This event is also triggered when the record containing the attachment is deleted. If a record is deleted that contains multiple attachments, a separate event is triggered for each attachment in the deleted record.</td>
</tr>
<tr>
<td>attachment.renamed</td>
<td>An attachment has been renamed.</td>
</tr>
</tbody>
</table>

Attachment logging

When an attachment is downloaded, the attachment.read event record is written, and you can do something with this event. For example, you can record when and by whom certain attachments are downloaded. For this functionality, current is a sys_attachment record, and the event record uses the following parameters:

- **parm1**: File name
- **parm2**: Table name

Debug attachment indexing

To change debugging options for attachment indexing, add these system properties.

- **glide.ts.index.attachment.debug**: When the value is set to true, enables log messages for exceptions that occur when indexing attachments (default is false).
  
  You can leave this property enabled during normal operations to capture stack trace information about any exceptions.

- **glide.ts.index.attachment.list_terms.debug**: When the value is set to true, logs all indexed terms when an attachment is indexed (default is false).
Configure attachment system properties

You can disable the drag-and-drop feature. (Users can still upload attachments by browsing to the file.) You can also limit the attachment file size, restrict who can upload attachments, and restrict what file extensions can be uploaded.

Role required: admin

1. To disable the drag-and-drop features, navigate to System Properties > UI Properties.
2. Clear the check box for the Allow attachment drag and drop in supported HTML5 browsers property.
3. Click Save.

Limit attachment file size

You can specify the maximum size allowable for attachments to avoid issues with the user's active session on the instance.

Role required: Admin.

Note: The maximum attachment size for email attachments is configured separately.

2. Enter a value in the Maximum file attachment size in megabytes property.
   - The system only allows attachment sizes up to 1 GB. By default, this field is blank. If you leave this field blank, the system uses the default maximum limit of 1 GB.
3. Click Save.

Require a role to attach files

You can restrict who can upload attachments.

Role required: Admin.

2. In the Attachment limits and behavior section, locate the List of roles (comma-separated) that can create attachments property (glide.attachment.role).
3. Enter one or more roles separated by commas.
   - Only roles listed in this property are able to upload attachments to a record. If no roles are entered, then all roles can upload attachments.
4. Click Save.

Restrict attachment file extensions

The glide.attachment.extensions property restricts the file extensions that users can upload as attachments.

Role required: Admin.

Use this property to improve security by preventing users from uploading harmful files, such as viruses, as attachments. Also, this capability can prevent the use of incompatible filetypes. For
example, Internet Explorer does not support icons in .png format. This property does not restrict files based on the actual file type, but only based on the extension.

1. Navigate to **System Properties > Security**.
2. In the **Attachment limits and behavior** section, locate the **List of file extensions (comma-separated) that can be attached to documents via the attachment dialog** property.
3. Enter the file extensions and click **Save**.
   
   If no extensions are specified, then all extensions are allowed. However, if any extensions are specified, all unlisted extensions are restricted. Listed extensions should not include the dot (.) prefix or spaces after commas. For example, enter xls,xlsx,doc,docx.

### Configure attachments on a table

You can prevent users from adding attachments to records on a specific table. You can also enable attachment indexing for a table so text searches can return matches from the record and its file attachments.

**Role required:** admin

By default, attachment indexing is enabled for the Knowledge Base. Enabling attachment indexing causes the platform to reindex the selected table, its parent table, and any children of the parent table. For large tables, such as the Task table, reindexing can take several hours and slows down the system until complete. Reindexing is best performed during non-peak times.

1. Open a record in the table.
2. Right-click the form header and select **Configure > Dictionary**.
3. Click the **Attributes** tab.
4. Click **New** and add the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Select Attachment index.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter true.</td>
</tr>
</tbody>
</table>

**Note:** The attachment indexing attribute only applies to the tables on which you explicitly add it. It does not cascade to child tables. For example, indexing attachments on the Task table does not index attachments on the Incident table. Not all file types are supported for attachment indexing. For a list of supported file types, see **Zing can include attachments in search results**.

5. Click **Submit**.
   
   The indexing process begins. When it is complete, attachments can be searched on that table.
6. Optional: To disable attachment indexing, remove the attribute and click **Update**.

### Hide the attachment (view) link

Users can open an attachment by clicking either the file name or the **(view)** link. The **(view)** link opens the file from within the browser, which executes JavaScript code as part of the attachment. You can hide the **(view)** link. Users can still view attachments by clicking the file name.
Role required: admin

1. Add the `glide.ui.disable_attachment_view` and `glide.ui.attachment_popup` properties. For instructions on adding properties to the platform, see Add a system property.

2. For the `glide.ui.disable_attachment_view` property, set the Type to `true/false` and set the Value to `true`.

3. For the `glide.ui.attachment_popup` property, set the Type to `true/false` and set the Value to `false`.

4. To return to the default behavior (enable the link), set the `glide.ui.attachment_popup` property Value to `true`.

**Configure attachment icons**

You can configure the icon that appears beside an attachment of a particular file type.

Role required: admin

1. Determine the path of the image file. If desired, upload a new image.

2. Navigate to **System UI > Attachment Icon Rules**.

3. Open an existing rule or click **New** to create a new rule.

4. Enter the rule details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select icon by</td>
<td>Select MIME Type or File Extension.</td>
</tr>
<tr>
<td>MIME type</td>
<td>If Select icon by is MIME Type, enter the MIME type and subtype to associate with the icon, separated by a slash (example: application/pdf).</td>
</tr>
<tr>
<td>File extension</td>
<td>If Select icon by is File Extension, enter the file extension to associate with the icon beginning with the period (example: .pdf).</td>
</tr>
<tr>
<td>Icon</td>
<td>Enter the path to the icon image file (example: images/icons/attach_pdf.gifx)</td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update**.

**Formatters**

A formatter is a form element used to display information that is not a field in the record. Add formatters to a form by configuring the form.

**Examples of formatters in the base platform**

<table>
<thead>
<tr>
<th>Formatter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity formatter</td>
<td>Displays the list of activities, or history, on a task form.</td>
</tr>
<tr>
<td>Process flow formatter</td>
<td>Displays the different stages in a linear process flow across the top of a record.</td>
</tr>
<tr>
<td>Formatter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent breadcrumbs formatter</td>
<td>Provides breadcrumbs to show the parent or parents of the current task.</td>
</tr>
<tr>
<td>Approval summarizer formatter</td>
<td>Displays dynamic summary information about the request being approved.</td>
</tr>
<tr>
<td>CI relations formatter</td>
<td>Displays on the CI form a toolbar for viewing the relationships between the current CI and related CIs.</td>
</tr>
</tbody>
</table>

**Note:** Formatter elements cannot be exported to PDF. When exporting PDF data from a form, any formatter elements added to the form are not displayed in the PDF output.

To create a custom formatter, create a UI macro to define content for the formatter, then create a formatter that refers to the UI macro. You can then add the formatter to a form.

**Create a UI macro for a formatter**

Create a UI macro to define the content that the formatter displays.

This functionality requires a knowledge of Jelly script.

Role required: ui_macro_admin

1. Navigate to **System UI > UI Macros**.
2. Click **New**.
3. Complete the form.
4. In the **XML script** field, enter Jelly script to define the content to be displayed by the formatter.

**Note:** The UI Macro for the formatter represents a row in the UI. It must begin and end with `<TR>` tags.
This Jelly script is reproduced below in plain text that you can copy into the Macro form as a basis for your macro script.

```
<?xml version = "1.0" encoding = "utf-8" ?>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" xmlns:g2="null">
<tr>
<td colspan="2">
Here  is some descriptive text for the Priority field.
</td>
</tr>
</j:jelly>
```

5. Click Submit.

Create a formatter and add it to a form

Create the formatter after creating the UI macro that defines the content.

Role required: admin
With the UI macro in place, create the formatter that references it, and add it to the form.

1. Navigate to **System UI > Formatters**.
2. Click **New**.
3. In the **Name** field, enter a descriptive name for the formatter.
4. In the **Formatter** field, enter the name of the UI macro with `.xml` appended to it.
5. In the **Table** field, select the table in which the formatter will be used.
6. In the **Type** field, select **Formatter**.
7. Click **Submit**.
8. To add the formatter to a form, **configure the form**. The formatter appears on the form according to your selections.

**Activity formatter**

The activity formatter provides an easy way to track items not saved with a field in the record, for example, journal fields like comments and work notes.

The activity formatter is enabled by default on the Task (task) table and other tables that extend the Task table, such as the Incident (incident) table. It is also enabled on the Approvals (sysapproval_approver) table.

You can filter the content that appears on the activity formatter and participate in the record feeds on the record. You can create an activity formatter for any form and configure properties that control what fields appear in the formatter.

In UI16, the activity formatter shows updates in real time so you can see the latest information without refreshing the form. User presence enables you to see when other users are entering comments.
Activity

David Loo
Looking into it

System Administrator

Assigned to

David Loo was Beth Anglin

Reassigning to David. Can you take a look?

System Administrator

UI16 activity formatter
Create an activity formatter

You can create an activity formatter for any audited table.

Role required: admin

1. Navigate to System UI > Formatters.
2. Click New.
3. Enter a name for the formatter, such as Activities (task).
4. Select a Table.
5. Enter activity.xml in the Formatter field.
6. Leave the Type as Formatter.
7. Click Submit.

Note: You can create more than one activity formatter for a table, however, the system does not allow you to add more than one activity formatter to a form.

Add the new activity formatter to forms as needed.

Add the activity formatter to a form

Add an activity formatter to any form to track journal fields on the form.

Role required: personalize_form

1. Verify that the table associated with the form is audited.
2. Configure the form layout to add Activities (filtered).
**Note:** In UI16, you cannot place another field in between a journal field and the activities formatter. The Activity Stream is built to keep journal fields stacked on top of the activity formatter.

**Note:** Field styles are not applied to comments and work notes fields used with the activity formatter. Styles for these fields can be set using the `glide.ui.activity_stream.style.comments` and `glide.ui.activity_stream.style.work_notes` system properties located on the `sys_properties` table.

---

**Enable the Live Feed-Activity toggle**

The Live Feed-Activity toggle allows users to switch between the activity feed and the document feed for a record.

Role required: admin

Use live feed to interact with other users on a record by posting messages and adding attachments to the feed. Use the activity formatter to see an overall summary of activity for the record.

---

**Live Feed/Activity toggle**

- The `glide.ui.show_live_feed_activity` property is enabled. Navigate to **Collaborate > Feed Administration > Properties** and enable the **Toggle the display of the live feed tab in the activity formatter** option.

1. Verify that the live feed and record feed plugins are active.
2. View the form to ensure that the activity formatter is visible. If not, configure the form to add it.
3. Set the `live_feed` dictionary attribute to true on the form.
   This action adds live feed to the activity formatter.
4. Complete the following steps to enable the system property.
   a) Navigate to **Collaborate > Feed Administration > Properties**.
b) Enable the **Toggle the display of the live feed tab in the activity formatter** option (glide.ui.show_live_feed_activity property).

**Customize activities**

You can customize which fields appear in the activity formatter. You can add or remove fields from the list of activities that users can select when they open the activity filter.

Role required: personalize_form and personalize_list

![Activity filter]

Customize the fields that appear in the activity filter

---

**Note:** In the UI15 interface, the number of updates to each field was shown in parentheses to the left of each field. This has been removed in UI16.

1. Perform the appropriate action for your version of the UI:

<table>
<thead>
<tr>
<th>UI16</th>
</tr>
</thead>
</table>
| 1. | Click the activity filter icon (⬇️).
| 2. | At the bottom of the list, click **Configure available fields**.
2. In the slushbucket, select the desired fields in the **Available** column and move them to the **Selected** column. The activities appear in alphabetical order, regardless of the order in the **Selected** column.

    **Note:** In UI16, **Configure available fields** is responsible for the order of the Additional Comments and Work Notes fields.

3. Click **Save** to add them to the activity formatter and the filter.

Administrators can also modify the system property **Incident activity formatter fields (glide.ui.incident_activity.fields)**. Access this property through **System Properties > UI Properties**. The system automatically synchronizes the values in the system property and the selections you made.

**Configure roles for viewing emails in the activity formatter**

The system property **glide.ui.activity.email_roles** enables you to control which roles can see emails in the activity formatter.

Role required: admin

In the activity formatter, users see activity only for fields they have permission to read. For example, self-service users might see the activity formatter on the self-service view of the Incident form, but they do not see work notes, unless security rules have been customized to allow this.

If the **Sent/Received Emails** field is included in the activities list, all users see all emails. No determination is made whether an end user, for example, should see an email containing work notes. Configure this property to restrict this capability to specified roles.

    **Note:** Email does not appear as an activity until it is sent. If email properties are not configured for outbound delivery, the message can be found by navigating to **System Mailboxes > Outbox**.

1. Navigate to **System Properties > UI Properties**.
2. Locate the property labeled **List of roles (comma separated) that can view emails in the Activity Formatter when "Sent/Received Emails" are included**.
3. Add roles to the property, separated by commas. These are the only roles that can see email in the activity formatter. All other roles are prevented from seeing email. If no roles are listed, all users can see email. The itil role is on the list by default.
4. Click **Save**.

**Configure the max activity size property**

Use the glide.max_activity_size property to increase the amount of content that can be visible in the Activity Formatter.

Role required: admin

The default size for an activity is 100 * 1024, which causes large amounts of content to be hidden in the Activity Formatter. You can change the default value by adding the glide.max_activity_size property.

1. Type **sys_properties.list** in the Application Navigator.
2. Click **New** and enter the following values.
### Configure email reply for the activity formatter in UI16

The `glide.ui16.emailStreamResponseActions` system property determines whether a user can reply to email using the email reply button in the activity stream in UI16.

1. In the navigation filter, type `sys_properties.list`.
2. Add the following system property. For more information on adding a system property, see Add a system property.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui16.emailStreamResponseActions</code></td>
</tr>
<tr>
<td>Description</td>
<td>Add the email reply button to the activity stream.</td>
</tr>
<tr>
<td>Type</td>
<td><code>true</code></td>
</tr>
<tr>
<td>Value</td>
<td>Set the value to <code>true</code>. The default value if this property is not configured is <code>false</code>.</td>
</tr>
</tbody>
</table>

3. Click Submit.

### Configure email reply for the activity formatter in UI15

The `email_reply` UI macro creates an email reply button in the activity stream in UI15. This UI macro can be deactivated to hide the button.

1. Navigate to System UI > UI Macros.
2. Open the `email_reply` UI macro record.
3. Check the check box in the Active field to enable the email reply button, or uncheck the field to disable it.
4. Click Submit

### Process flow formatter

The process flow formatter provides a graphical summary of the stages in a process. The formatter is typically shown at the top of forms that are part of a process.

Each record on the Flow Formatter (sys_process_flow) table represents a process stage and can have a different condition applied to it. When specified conditions are fulfilled, the formatter highlights the current stage and places a check mark next to all previous stages.

These examples show a workflow in the UI15 and UI16 interfaces.
UI16 process flow for a change request

When any formatter stages are defined for a table, they appear on the form associated with that table in the order specified, assuming the formatter has been added to the form.

**Activate the process flow formatter**

You can activate the Process Flow Formatter plugin.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the Load demo data check box.

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.

5. Click Activate.

**Create a process flow formatter**

You can create a process flow formatter stage.

Role required: admin

2. Click New.
3. Complete the form, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table for this process flow formatter.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name to identify the formatter.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter the name to be displayed in the form configuration slushbucket.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to ensure that the formatter stage is active. When the check box is cleared, the formatter stage does not appear in the flow display.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate where in the process flow the formatter will be displayed. Formatters are arranged with the lowest number on the left and the highest number on the right.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the condition builder to set the conditions under which the formatter is highlighted as current. Any field available in the condition builder, such as SLA or Impact, can be used to trigger a process flow stage.</td>
</tr>
<tr>
<td>Description</td>
<td>Describe the process flow formatter. This description does not appear on the actual formatter.</td>
</tr>
</tbody>
</table>

4. Repeat as necessary for each stage.

**Parent breadcrumbs formatter**

The parent breadcrumbs formatter on the Task table provides breadcrumbs that show the parent or parents of the current task. This formatter can be used also on any table that extends Task.

Role required: personalize_form

To add the parent breadcrumbs formatter to a form, configure the form and add **Parent Breadcrumbs** to the desired location. The breadcrumbs show only six levels of parents. If more levels exist, the breadcrumbs display an ellipsis ("...").

The **Parent** reference field also has to contain a value for the breadcrumbs to appear. You may need to configure the form to contain the **Parent** field as well.
Breadcrumbs

Customize the parent breadcrumbs formatter

You can customize the parent breadcrumbs formatter to control what breadcrumbs appear.

Role required: admin

1. Navigate to System UI > Formatters.
2. Select Parent Breadcrumbs.
3. Click View UI Macro for this Formatter to view or modify the underlying formatter.

By default, the breadcrumb uses the default display field, `gr.getDisplayValue()`, as the link in the breadcrumb. To customize this, add the following line, replacing the `fieldName` parameter with the desired field name (not the field label):

```javascript
pc.setLabelField("fieldName")
```

If a user points to a breadcrumb, the short description for that record appears as a hint by default. To display alternate hints for the breadcrumb, add the following line, replacing the `fieldName` parameter with the desired field name (not the field label):

```javascript
pc.setTitleField("fieldName")
```

Be sure to add these lines in the proper location, as shown in the following example:

```javascript
//parent crumb functions - script include
var pc = new ParentCrumbs(gr);
pc.setLabelField("short_description");

//override the default display field to be used for label
pc.setTitleField("number");

//override default short_description hover text
var crumbs = pc.getCrumbs();
```
Use the parent breadcrumbs formatter on non-Task tables

The parent breadcrumbs formatter can be used on non-Task tables as long as the table has a reference to itself through a field called parent.

Role required: admin

To make the formatter available for a different table, duplicate the formatter used by the Task table:

1. Navigate to System UI > Formatters.
2. Select Parent Breadcrumbs.
3. Set the Table field to the appropriate table.
4. Right-click the form header and choose Insert.
5. Add the new formatter to the appropriate form.

Approval summarizer formatter

The approval summarizer formatter creates the summary at the bottom of an approval form.

The approval summarizer displays different information depending on what is being approved, such as a change request or a service catalog request. Following are two examples.
### Summary of Item being approved

#### Change Request

<table>
<thead>
<tr>
<th>Number</th>
<th>CHG0000001</th>
<th>Requested by</th>
<th>David Loo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected CI</td>
<td>Sales Force Automation</td>
<td>Type</td>
<td>Normal</td>
</tr>
<tr>
<td>Planned start date</td>
<td>2016-07-27 18:00:00</td>
<td>Risk</td>
<td>High</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2016-07-27 18:00:00</td>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Short description</td>
<td>Rollback Oracle Version</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Performance of the Siebel SFA software has been severely degraded since the upgrade performed this weekend. We moved to an unsupported Oracle DB version. Need to rollback the Oracle instance to a supported version.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Summary of a catalog request

The **Deny** button allows the approver to deny one or more requested items in a multi-item request, before approving the overall request. If a requested item is denied, the workflow for that item never starts. The approver can then choose to **Accept** the item.

**Note:** When the overall request is approved, you must ensure this **Deny** button is hidden. If this button is used after request approval, the requested item workflow is canceled, leaving the stage in an inconsistent state. Similarly, the **Accept** button on requested items should only appear before the overall request is approved or rejected.

Override a formatter with macros

The system uses formatters to handle complex rendering of specific form elements.

Role required: ui_macro_admin

Examples of form elements rendered by formatters in the base platform are:

- Activity formatter: Displays the list of activities, or history, on a task form.
- Process flow formatter: Displays the different stages in a linear process flow across the top of a record.
- Task parent breadcrumbs formatter: Provides breadcrumbs to show the parent or parents of the current task.
- Approval summarizer formatter: Displays dynamic summary information about the element being approved.

A UI macro can override formatters provided in the base system.

1. Navigate to **System UI > UI Macros**.
2. Click **New**.
3. In the **Name** field, enter the same name as the formatter you want to override, but omit the `.xml` extension.

4. Complete the remaining fields on the form.

5. Click **Submit**.

This example shows the form that defines the existing approval summarizer formatter:

![](image)

Here is the form for the UI macro that overrides the approval summarizer formatter:

![](image)

**Limit the number of activity stream entries**

You can set a system property to limit the number of entries allowed in an activity stream.

Role required: admin

1. Enter `sys_properties.list` in the Navigation filter.
2. Search for the property `glide.history.max_entries`.
3. Edit the **Value** property to set the maximum number of entries that users can view in an activity stream.

**Note:** New entries do not count towards the max number until the form is refreshed.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.history.max_entries</td>
</tr>
<tr>
<td>Description</td>
<td>Maximum number of entries allowed to display in an activity stream. The default number is 250. New entries do not count towards the max number until the form is refreshed.</td>
</tr>
<tr>
<td>Type</td>
<td>integer</td>
</tr>
<tr>
<td>Default value</td>
<td>250</td>
</tr>
</tbody>
</table>

**Form templates**

Templates simplify the process of submitting new records by populating fields automatically.

To use a template, populate the most-used fields for a specific table, save it as a template, and then make the template accessible to your users. Users can manually apply a template when creating records, or an administrator can define scripts to apply templates automatically.

**Note:** When applying templates to a new record, only fields on the form are affected. If a template includes an update to a field that does not appear on the form, the template will not change that field's value.

You can create table-level access controls to restrict template creation. When applied, a user creating a new record from a template must satisfy the save_as_template access control for every field modified by the template.

**Automatically applied templates**

You can make a template that automatically applies to new, user-created records on a specific table. To create this kind of template, set the template name to match the name of the table to which the template applies.

For example, imagine you want to apply a template automatically when a user creates a record on the Windows Server (cmdb_ci_win_server) table. Set the Name field to cmdb_ci_win_server and the Table field to Windows Server (cmdb_ci_win_server) on the Template form.

Automatic templates are always global. They do not honor the User and Group fields on the Template form. Automatic templates do not apply to records created by the system, such as those records generated by business rules, UI actions, or workflows.

**Create a template using the Template form**

Create a template record for any table to automatically populate certain fields.

Role required: admin

1. Navigate to System Definition > Templates.
2. Click New.
3. Complete the form, as appropriate.
### Template form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Display name of this template.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Table this template applies to. Select <strong>Global</strong> to make the template available for use with all tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope as the template.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>User who can configure and apply the template. If a user is defined, no other users can see the template unless the <strong>Global</strong> check box is selected.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>A group whose members can configure and apply the template. If a group is defined, no other groups can see the template unless the <strong>Global</strong> check box is selected.</td>
</tr>
<tr>
<td><strong>Global</strong></td>
<td>Option for allowing any user who can access templates to view and apply this template.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>Description of the template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Adding content to this field does not add that content to the <strong>Short description</strong> field of forms that use this template.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The content that automatically populates records based on this template. Select a field from the specified table in the left column, then enter the data to automatically populate in the right column.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Even though you can select dot-walked fields in the template, they do not apply to fields that are on the form.</td>
</tr>
<tr>
<td><strong>Link element</strong></td>
<td>Links a template for a child table with the template for the parent table. In the template for the child table, set the value to the field that references the parent table. Once set, the child template is explicitly linked to the parent.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field does not appear by default. Configure the template form to add the field.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
See Application scope.

Create templates for related task records

Administrators can create a template for a Task table record that also creates one or more related records in the child Task table.

Role required: admin

Administrators must understand the parent-child relationships between Task tables. For example, the Change Task table is a child of the Change table and the Incident Task table is a child of the Incident table.

Note: Child templates can only be applied automatically if you first apply the parent template from a module.

1. From the parent Task table template, configure the form layout to add these fields.
   - Next Related Child Template
   - Next Related Template
   - Link element

2. Create a template for the parent Task table.
   For example, create this template for the Change table.

   Sample Change template

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Add server to network</td>
</tr>
<tr>
<td>Table</td>
<td>Change (change_request)</td>
</tr>
<tr>
<td>Short description</td>
<td>Set up a server on the network</td>
</tr>
<tr>
<td>Template</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Short description) (Set up server on the network)</td>
</tr>
<tr>
<td></td>
<td>(Category) (Hardware)</td>
</tr>
<tr>
<td></td>
<td>(Assignment group) (Hardware)</td>
</tr>
</tbody>
</table>

3. Create a template for the first related task.
   For example, create this template for the Change Task table.

   First sample Change Task template

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Order server</td>
</tr>
<tr>
<td>Table</td>
<td>Change Task (change_task)</td>
</tr>
<tr>
<td>Short description</td>
<td>Order server hardware</td>
</tr>
<tr>
<td>Template</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Short description) (Order server hardware)</td>
</tr>
<tr>
<td></td>
<td>(Assignment group) (Hardware)</td>
</tr>
<tr>
<td>Link element</td>
<td>Change request</td>
</tr>
</tbody>
</table>

4. Create a template for each additional related task.
   For example, create one additional template for the Change Task table.
Second sample Change Task template

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Install server on network</td>
</tr>
<tr>
<td>Table</td>
<td>Change Task (change_task)</td>
</tr>
<tr>
<td>Short description</td>
<td>Install server on network</td>
</tr>
<tr>
<td>Template</td>
<td>• (Short description)(Install server on network)</td>
</tr>
<tr>
<td></td>
<td>• (Assignment group)(Hardware)</td>
</tr>
<tr>
<td>Link element</td>
<td>Change request</td>
</tr>
</tbody>
</table>

5. From the parent Task table template, set **Next Related Child Template** to the first related child task.

For example, in the Add server to network template, select **Order server** in the **Next Related Child Template** field.
6. For each child related task, set **Next Related Template** to the next related task template. For example, in the Order server template, select **Install server on network** in the **Next Related Template** field.
Note: The last related task template does not have a value for Next Related Template. For example, the **Install server on network** template does not have a value in Next Related Template.

*Create a module* for the parent Task table template so that child templates can be applied to related task records. For example, create a module for **Add server to network**.
Create a template by saving a form in UI16 or UI15

Save a populated form as a template ui UI16 or UI15.

Toggle the template bar so it is visible on forms.

Role required: none

1. Navigate to a form.
2. Complete the form as it should appear when a user applies the template.
3. In the template bar, click the plus icon (+).
4. Enter a descriptive name to make it easy for a user to select the correct template.
5. Make any additional changes as needed.
6. Click **Save**.
Create records based on a template
You can create and schedule a scheduled job to create records based on a template.
Role required: admin
For example, you can regularly create a populated task record to perform a weekly backup.
1. Navigate to **System Definition > Templates**.
2. Select a template record.
3. Click **Schedule**. The **Scheduled Entity Generation** form appears.
4. In the **Run** choice list, select how frequently to create a record.
5. Complete the schedule information.
6. Click **Submit**.

Create a module for a template
You can create a module to open a form with pre-populated template data.
Role required: admin
Child templates are only applied if the parent template is applied from a module. Child templates are not applied by applying a template to a new form.
1. Perform the appropriate action for your version of the UI:

<table>
<thead>
<tr>
<th>UI16</th>
<th>Point to the application menu, such as <strong>Self-Service</strong>, and click the edit application (pencil) icon.</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI15 or UI1</td>
<td>Right-click an application menu and select <strong>Edit Application Menu</strong>.</td>
</tr>
</tbody>
</table>

2. In the **Modules** related list, click **New**.
3. Fill in the **Title** and **Order** fields as appropriate.
4. In the **Link Type** form section, in the table field, select the table you want to create the form in.
5. In the **Link Type** field, select **New Record**.
6. In the **Arguments** field, enter `<table>.do?sys_id=-1&sysparm_template=<templatename>`
   The `<table>` is the name of the table you selected for the table field, for example **incident**.
   The `<templatename>` is the name of the template you want to use to pre-populate the form, for example **Incident call type**.
7. Click **Submit**.
8. Refresh the application navigator to view the new module.

Toggle the template bar
The template bar appears at the bottom of forms in UI16 and UI15. It provides shortcuts to apply, edit, and create templates.
Role required: none
You can toggle the template bar, which hides or shows it for all forms. The template bar is shown by default.
Note: The template bar is not available in UI11.

1. Navigate to a form.
2. Do the appropriate action for your version of the UI.

   **UI16**
   1. Click the more options icon ( .. ) in the form header.
   2. Select **Toggle Template Bar**.

   **UI15**
   1. Right-click the form header.
   2. Select **Toggle Template Bar**.

The template bar is hidden or shown.

**Scripted templates**

You can apply an active template to a record using JavaScript.

**Apply a template to current**

To apply a template, use the `applyTemplate` method.

```javascript
current.applyTemplate("<templatename>");
```
Apply a template to a GlideRecord

To apply the template to a record other than current, change current to a GlideRecord variable. When using a GlideRecord variable, you may need to initialize it after declaring the variable.

```javascript
var recl = new GlideRecord("incident");
recl.initialize();
recl.applyTemplate("my_incident_template");
```

Apply a template from a UI action

The following script demonstrates a possible customization to the Create Change UI action on the Problem form. After you add this script to the UI action, a user can select the UI action to create a change record with information from both the problem record and the change template.

```javascript
var change = new GlideRecord("change_request");
change.initialize();
change.short_description = current.short_description;
change.description = current.u_details;
change.cmdb_ci = current.u_service;
change.priority = current.priority;
change.requested_by = current.caller_id;
change.assignment_group.setDisplayValue('Change & Release');
change.u_status = 'New';
change.parent = current.number;
change.applyTemplate("standard_rfc");
change.rfc = change.insert();
current.comments = 'Change ' + change.number + ' created.';
var mySysID = current.update();
gs.addInfoMessage("Change " + change.number + " created");
action.setRedirectURL(change);
action.setReturnURL(current);
```

Script a template with child templates

When using applyTemplate with a template that has one or more child templates, the system creates the parent record before applying the child templates. This behavior ensures that any references or dot-walked fields from the child record to the parent have a valid target.

For example, if a template for the Change Request table has a child template for the Change Task table, applying the Change Request template inserts a Change Request record into the database. It assigns this record as the Change request for the Change Task record, then applies the child template to the Change Task record.

UI actions

UI actions add buttons, links, and context menu items on forms and lists, making the UI more interactive, customizable, and specific to user activities. UI actions can contain scripts that define custom functionality.

Administrators and users with the ui_action_admin role can define UI actions.
UI action controls

You can create a UI action to provide any or all of these controls.

- A button on a form
- A context menu item on a form that appears when you open the form context menu or right-click the form header
- A related link in a form
- A button in the banner on top of a list
- A button at the bottom of a list
- A context menu item on a list that appears when you open the list context menu or right-click the list header
- A menu item for the action choice list at the bottom of a list
- A related link at the bottom of a list

Note: To hide or restrict the New or Edit UI action on a list or related list, use list control.
Create a UI action

You can create a new UI action or edit an existing one.

Role required: ui_action_admin or admin

You can add UI actions to tables and database views that are in the same scope as the UI action and tables that allow UI actions from another application scope to run on them.

1. Navigate to System Definition > UI Actions.
2. Click New or open an existing record.
3. Define the UI action by completing the fields.
   You may need to configure the form to see all the fields.

UI action fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Defines the text that appears on the button, link, or context menu item.</td>
</tr>
<tr>
<td>Table</td>
<td>Defines the table on which the UI action is available. By default, the UI action also appears on tables that extend the selected table (for example, Task actions appear on the Incident table). Select Global to make the action available on all tables.</td>
</tr>
<tr>
<td>Order</td>
<td>Defines the order in which the UI action appears. The order applies to buttons from left to right and to menu actions from top to bottom.</td>
</tr>
<tr>
<td>Action name</td>
<td>Defines a name to use when referencing the UI action in scripts.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the UI action when selected. To disable a UI action, clear the check box.</td>
</tr>
<tr>
<td>Show insert</td>
<td>Shows a button on new records that have not been inserted.</td>
</tr>
<tr>
<td>Show update</td>
<td>Shows a button on existing records.</td>
</tr>
<tr>
<td>Client</td>
<td>The UI action executes its script in the user's browser, not on the server. When enabled, the Onclick field appears above the Condition field.</td>
</tr>
<tr>
<td>List v2 Compatible</td>
<td>Indicates that the UI action is compatible with v2 lists. This field must be enabled to display the UI action in a v2 list, but only if the List v3 Compatible field is enabled as well. If the List v3 Compatible field is not enabled, the UI action displays in v2 lists regardless of the List v2 Compatible field state.</td>
</tr>
<tr>
<td>List v3 Compatible</td>
<td>Indicates that the UI action is compatible with v3 lists. This field must be enabled to display the UI action in a v3 list.</td>
</tr>
<tr>
<td>Form button</td>
<td>Puts a button on a form.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Form context menu</td>
<td>Puts an item in a form context menu (right-click the form header).</td>
</tr>
<tr>
<td>Form link</td>
<td>Puts a link in the Related Links section of a form.</td>
</tr>
<tr>
<td>List banner button</td>
<td>Puts a button in the banner of a list.</td>
</tr>
<tr>
<td>List bottom button</td>
<td>Puts a button at the bottom of a list.</td>
</tr>
<tr>
<td>List context menu</td>
<td>Puts an item in a list field context menu (right-click a cell in a list).</td>
</tr>
<tr>
<td>List choice</td>
<td>Puts an item in the action choice list at the bottom of a list.</td>
</tr>
<tr>
<td>List link</td>
<td>Puts a link in the Related Links section at the bottom of a list.</td>
</tr>
<tr>
<td>Overrides</td>
<td>Specifies a UI action that this UI action overrides.</td>
</tr>
<tr>
<td>Comments</td>
<td>Provides descriptive content regarding this UI action.</td>
</tr>
<tr>
<td>Hint</td>
<td>Defines the text that appears when a user points to the UI action control.</td>
</tr>
<tr>
<td>Onclick</td>
<td>The name of the JavaScript function to run when the UI action is executed.</td>
</tr>
<tr>
<td>Condition</td>
<td>Defines the conditions that restrict when a UI action appears. See <a href="#">Restricting UI actions based on conditions</a> for examples.</td>
</tr>
<tr>
<td>Script</td>
<td>Defines the script to run when the UI action is executed.</td>
</tr>
<tr>
<td>Related lists on the form view:</td>
<td></td>
</tr>
<tr>
<td>UI Action Visibility</td>
<td>Specifies other views of the form that the UI action applies to. Use this option to restrict the UI action to form views that you specify.</td>
</tr>
<tr>
<td>Versions</td>
<td>Shows all versions of the UI action. Use this list to compare versions or to revert to a previous version.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Note:** If the UI action is enabled to run on the client side, wrap it in a function. Otherwise, the contents of the **Script** field runs when the page loads.

As part of a UI action script, you can redirect a user to a URL. For example, you might add links to a form or open a new record after it is created from a UI action. To redirect a user to a URL from a UI action, use this syntax in the **Script** field to define the redirect link:

```
action.setRedirectURL ( 'http://www.mysite.com/mypage.htm' ) ;
```
To direct a user to a record, use this syntax, where `new_record` is the variable name for the:

```javascript
action.setRedirectURL (new_record );
```

**Note:** In UI11 only, you can control whether the UI action appears at the bottom of the form in addition to the top. Create the property `propertyglide.ui.buttons_bottom` and set it to `true`.

---

**Restricting UI actions based on conditions**

You can include scripts in the Condition field of the UI Action form. The condition must evaluate to `true` for the action to appear.

**Using the UI action condition builder**

If you leave the field empty, the condition defaults to `true`. For example, the following condition is configured for the **Close Incident** button:
For this action to appear on a form, these conditions must evaluate to true:

- **current.incident_state** must equal 6: The incident must already be in a Resolved state.
- **gs.hasRole("itil_admin")**: The current user must have the itil_admin role.

OR this condition must evaluate to true:

- **gs.getUserID() == current.caller_id**: The current user is the user who requested the change.

**Note:**

- The current object is not available for conditions on a list context menu (the **List context menu** check box is selected). Any use of **current** on these actions is ignored.
- You can reference the parent record for the UI action conditions on a related list button. For example, to disable the **New** and **Edit** buttons on the Affected CIs related
list for closed changes, copy the global m2m UI actions to the task_ci table and add a condition of `parent.active`.

Restricting UI actions based on form views

You can restrict UI actions to appear only on specified form views.

Use the UI Action Visibility related list on the UI Action form to restrict a UI action by view. A UI action is available for the specified view according to the following rules:

1. If there are no visibility rules, the action appears on all views.
2. Any exclude rule on a given view means that the action does not appear on that view.
3. If there is at least one include rule, then the action appears only on views that are specifically included.

Example: Show an action everywhere except the Cost Management view

Add an exclude rule for the Cost management view.

Example exclusion UI action view

Example: Show an action on the Routine and ITIL views, but nowhere else

Add include rules for the Routine and ITIL views.
Override a UI action for an extended table

You can override or remove a UI action for a table that is extended from another table.

When a UI action is defined for the Task table, it applies to all tasks, including incidents, changes, problems, and any other tables that extend the Task table. Similarly, a global UI action applies to every table. However, you can override a UI action for a specific table. This example demonstrates how to override or remove a UI action on the Task (task) table for only the Incident (incident) table.

1. Complete the following steps to override a UI action on the Task table for just the Incident table.
   a) Create a UI action on the Incident table with the same Action name.
      If the Action name is not defined, update both the new UI action and the UI action to be overridden with the same Action name.
   b) Enter a script that is specific to the Incident table.

2. Complete the following steps to remove a UI action on the Task table for the Incident table.
   a) Navigate to the UI action definition for the Task table.
   b) Add the condition `current.getRecordClassName() != 'incident'`.
UI policies

UI policies dynamically change the behavior of information on a form and control custom process flows for tasks.

For example, you can use UI policies to make the number field on a form read-only, make the short description field mandatory, and hide other fields. Basic UI policies do not require any scripting, however for more advanced actions, use the Run scripts option.

You can also use client scripts to perform all of these actions, but for faster load times use UI policies when possible.

Create a UI policy

Create a UI policy to define custom process flows for tasks.

Role required: ui_policy_admin

A UI policy condition evaluates all fields even if they are not visible on the form. This function removes the requirement that a field must be on a form for it to be evaluated.

Note:
- Policies carried over from versions prior to Fuji are evaluated differently. Fields that previously were not evaluated are evaluated.
- UI policies are not supported on search screens.
- UI Policies also apply to forms and lists displayed within Content Management System application.
- UI policies affect list views if List v3 is active and the field has a UI Policy Action.

1. Navigate to System UI > UI Policies.
2. Click New.
   The UI Policy (Advanced view) form opens
3. To change the view, in Related Links click Default view.
4. Complete the form, as appropriate.
   You may need to configure the form to see all the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table for the form to be modified.</td>
</tr>
<tr>
<td>Active</td>
<td>The active status of the UI policy. Only active UI policies are applied.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short summary of the UI policy.</td>
</tr>
<tr>
<td>Order (Advanced view)</td>
<td>The processing sequence, from the lowest to highest number. If two policies conflict, the UI policy with the higher number executes. For inherited UI policies, the extended (child) table’s UI policies are executed first. Then the base table UI policies are executed; both from lowest to highest specified value.</td>
</tr>
</tbody>
</table>

When to Apply
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>The conditions which, if fulfilled, cause the UI policy to be applied. Conditions are built with the condition builder. To set conditions using a script, use a client script instead. Conditions are only rechecked if a user manually changes a field on a form. If the change is made by a UI action, context menu action, or through the list editor, it is not evaluated.</td>
</tr>
<tr>
<td>Global (Advanced view)</td>
<td>Option for specifying whether the UI policy applies to all form views. If this check box is cleared, the UI policy is view-specific. By default, the Global UI policy applies to all form views. However, a UI policy can be specific to a view. For example, you can define a UI policy for only the itil view of a form. Use the View field to accomplish this.</td>
</tr>
<tr>
<td>View (Advanced view)</td>
<td>Option for indicating which form view the UI policy applies to. This field is visible only if Global is not selected. If Global is not selected and the View field is left blank, the script applies the default view. For more information on form views, see view management.</td>
</tr>
<tr>
<td>Reverse if false (Advanced view)</td>
<td>Option for specifying that the UI policy action should be reversed when the conditions of its UI policy evaluate to false. In other words, when the conditions are true, actions are taken and when they change back to false, the actions are reversed (undone).</td>
</tr>
<tr>
<td>On load (Advanced view)</td>
<td>Option for specifying that the UI policy behavior should be performed OnLoad as well as when the form changes. You can check or clear the On load check box in a UI policy to control whether it runs every time a form is loaded when the conditions are satisfied. In this example, an administrator does not want an incident to enter the Awaiting user info state unless the user provides an explanation to the customer. The administrator creates a UI policy with the following settings.</td>
</tr>
<tr>
<td></td>
<td>• In the When to Apply section, adds the condition (State) (is) (Awaiting user info) and clears the On load check box. This condition means that the UI policy applies only when the state is changed to Awaiting user info.</td>
</tr>
<tr>
<td></td>
<td>• In the UI Policy Actions related list, creates a record that makes the Additional comments field mandatory when the condition is met.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inherit (Advanced view)</td>
<td>Option for specifying whether extended tables inherit this UI policy.</td>
</tr>
<tr>
<td></td>
<td>When a child table has an inherited UI policy from its parent table, the UI policy on the child table always runs first. This event is true regardless of the Order of the UI policies.</td>
</tr>
<tr>
<td></td>
<td>Consider the following example:</td>
</tr>
<tr>
<td></td>
<td>• A child table has a UI policy with Order value 500 that shows the Urgency field when its conditions are met.</td>
</tr>
<tr>
<td></td>
<td>• Its parent table has a UI policy with the same conditions that hides the Urgency field. The parent table UI policy has Order value 100.</td>
</tr>
<tr>
<td></td>
<td>• Although the parent table Order field has a lower value, the child UI policy runs first and then the parent UI policy runs. When the conditions are met, the Urgency field is hidden.</td>
</tr>
</tbody>
</table>

**Script**

<table>
<thead>
<tr>
<th>Run scripts (Advanced view)</th>
<th>Option for specifying whether advanced behavior can be scripted for both true and false conditions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute if true (Advanced view)</td>
<td>A script that executes when the conditions of the UI policy are fulfilled. This field is available only if Run scripts is selected.</td>
</tr>
<tr>
<td>Execute if false (Advanced view)</td>
<td>A script that executes if the conditions of the UI policy are not fulfilled and the Reverse if false option is selected. This field is available only if Run scripts is selected.</td>
</tr>
</tbody>
</table>

**Other fields**

<table>
<thead>
<tr>
<th>Run scripts in UI type</th>
<th>The UI type for this UI policy: Desktop, Mobile / Service Portal, or Both.</th>
</tr>
</thead>
</table>

**Related List: UI Policy Actions**

<table>
<thead>
<tr>
<th>Table</th>
<th>(read-only) Field the UI policy action applies to.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Field name</th>
<th>Field on the selected table to which the UI policy performs an action if true.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If the specified field is not found on the form, the UI policy performs the action on the variable with the same name.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Mandatory | Choice list for specifying how the UI policy affects the mandatory state of the field. Choices are:
- Leave alone
- True
- False

Visible | Choice list for specifying how the UI policy affects the visible state of the field. Choices are:
- Leave alone
- True
- False

Read only | Choice list for specifying how the UI policy affects the read-only state of the field. Choices are:
- Leave alone
- True
- False

Related Links

Default view or Advanced view | Changes the form view to the default or advanced view. The fields change based on the view.

5. Click Submit.

Example: creating a UI policy

Create a UI policy to implement controls in the Incident form when the state changes to Resolved.

Role required: ui_policy_admin

This example demonstrates how to implement the following controls.

- Make a Close Notes field mandatory.
- Hide the Opened by field.
- Make the Priority, Severity, and Urgency fields read-only.
- Run a client script that displays an alert message.

1. Navigate to System UI > UI Policies.
2. Click New.
3. Supply the following information.

New UI policy

<table>
<thead>
<tr>
<th>Name</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Incident</td>
</tr>
<tr>
<td>Conditions</td>
<td>(Incident state) (is) (Resolved)</td>
</tr>
</tbody>
</table>
4. Right-click the form header and select Save from the context menu. The UI Policy Actions related list appears.

5. In the related list, click New.

6. Provide the following information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse if false</td>
<td>Select this check box. If the incident state is not Resolved, the UI policy is reversed.</td>
</tr>
<tr>
<td>On load</td>
<td>Select this check box to perform the actions when the form is loaded or when the condition changes.</td>
</tr>
</tbody>
</table>

6. Provide the following information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Close notes. This UI action makes the Close notes field mandatory.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
<tr>
<td>Visible</td>
<td>Leave alone</td>
</tr>
<tr>
<td>Read Only</td>
<td>Leave alone</td>
</tr>
</tbody>
</table>

7. Click Submit.

8. Repeat the process to create UI policy actions to hide the Opened by field, and to make the Priority, Severity, and Urgency fields read-only.

**Client scripts for UI policies**

Any scripts you create for UI policies run on the client side.

You can use different options in the UI Policy form to control when and how the UI policy is applied. These options include client scripts, OnLoad execution, and view-specific UI policies. Administrators can use the UI Policy form to create client scripts that run onChange when the UI policy conditions are met (Execute if true) or not met (Execute if false). To display these scripting fields in the UI Policy form, in the Script section, select the Run scripts check box.

For example, to display an alert to the user when the incident State field changes to Resolved, create the following script in the Execute if true field.

```javascript
function onCondition(){
  alert('You changed the "Incident state" to Resolved. Please enter your comments in the "Close notes" field.');
}
```

**Advanced form configuration**

Administrators can configure advanced form features, such as form focus, form splits, and derived fields.

- Allow insert options on task records to let users insert a new task record, such as an incident or change request, from the task record they are currently viewing.
- Disable first field form focus if you want to prevent the cursor from hopping to the first writable field on a form. You can also modify how form focus works with a client script.
- **Deactivate form submission with the Enter key** if you want users to be able to press the Enter key for reasons other than submitting the form.
- **Enable multiple form splits**, which organizes the fields into multiple columns, if you want to design forms with more than the default two column layout.
- **Define required fields** to prevent users from removing them when they configure the form.

### Allow insert options on task records

The **Insert** and **Insert and Stay** options are disabled by default for task records such as incidents and change requests. You can set a system property to show these options for task records.

**Role required:** admin

1. Navigate to **System Properties > UI Properties**.
2. Locate the property **Allow the use of the "Insert" and "Insert and Stay" options on task derived tables.** (`glide.ui.task.insert`)
3. Select the check box to enable or clear the check box to disable (default) the options for tasks.
4. Click **Save**.

### Disable first field form focus

By default, forms set focus on the first writable field on the form. An administrator can disable form focus with a system property to make the form more accessible to users who use screenreaders.

**Role required:** admin

1. Navigate to **System Properties > UI Properties**.
2. Set the property `glide.ui.focus_first_element` to `false`.

With first field focus disabled, the form focuses on the first element on the page instead. Focusing on the first element, instead of the first writable element, helps orient users who use screen readers so they can find all the elements on a form.

### Disable the template bar

Administrators can disable the template bar on a table by creating a system property.

**Role required:** admin

Creating a table-specific property and setting it to false prevents users from displaying the template bar on a record for the specified table.

1. Navigate to **sys_properties.list**.
2. **Add a property** with the following settings.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui.show_template_bar.&lt;TABLENAME&gt;</code></td>
</tr>
<tr>
<td>Type</td>
<td><code>true</code></td>
</tr>
<tr>
<td>Value</td>
<td><code>false</code></td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Modify form focus with a client script

By default, forms set focus on the first writable field on the form. An administrator can change that functionality to focus on other fields in the form for UI15 and earlier versions of the UI.

Modify the form focus with onLoad() client script on the form.

Note: The method g_form.getElementById has been deprecated in UI16.

```javascript
function onLoad () {
    setTimeout ( function () {
        var refocus = g_form.getElementById('table_name.field_name');
        refocus.focus();
    }, 0 );
}
```

Based on the nature of the field you are targeting, replace `table_name.field_name` with the appropriate value:

- For non-reference fields, enter the name of the field to focus on (for example, `short_description`).
- For reference fields, use the format `sys_display.table_name.field_name` (for example, `sys_display.incident.caller_id`).

Deactivate form submission with the Enter key

By default, when you press the Enter key in a simple one-line text field, a choice list, or a Boolean field, the form is submitted.

Role required: admin

You can use a system preference to deactivate this feature if you do not want the Enter key to submit the form.

1. From the left navigation pane, select User Administration > User Preferences.
2. Select the `enter_submits_form` preference.
3. Set the value to `false`.
4. Click Update.

The change does not take effect until user preferences are reloaded either at login or when a session is created.

Enable multiple form splits

Form splits enable you to organize fields on a form into columns. Administrators must add a property to enable form splits.

Role required: admin
Configuration of two form splits
Example of the form with two form splits

When you organize fields in this manner and the user is viewing the form on a small mobile device, the fields within the first split are listed before the fields in the second split. In this example, the Asset tag, State, Serial number, and Substate field are listed before any of the fields below them.

You can also create elements that span the form at the top of the form.

1. Enter `sys_properties.list` in the Navigation filter.
   The entire list of properties in the System Properties [sys_properties] table appears.
2. If the property does not exist, click New.
3. Enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui.form_multiple_splits</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enable multiple form splits</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click the form context menu icon and select Save.
   The Categories related list appears.
5. Click Edit and move UI to the Categories List.
6. Click Save.
   The System Property form reopens and the new property appears in the UI Properties page.
Define required fields

You can specify which form fields are required in forms. This action prevents users with the personalize_form role from removing the field by configuring the form layout.

Role required: admin

The Required Form Fields plugin must be active.

If present on a form, only an administrator can remove required fields. When you configure a form, required fields appear in a gray color and have a tooltip indicating they are required. Required fields are defined in the Required Form Fields (sys_ui_element_required) table.

The expected (although not the only) use case for this feature is as part of a delegated administration scheme. For example, you can grant branch offices the rights to modify forms by granting the personalize_form role, but not allow them to remove certain fields which are critical to overall business processing.

1. Navigate to sys_properties.list.
2. Locate the property named glide.ui.form.enforce_required_fields and make sure it is set to true.
3. Navigate to System UI > Required Form Fields.
4. Click New.
5. Select the table and field, and then select the Required check box.
   The following example sets the Short description field on the Incident form to be required.

   ![Required Form Field](image)

   If you decide later that you do not want to make the field required, clear the Required checkbox. This action is preferable to deleting the record.

6. Click Submit.

If the table specified has extension tables, then the Required Form Field record applies to forms of all extended tables. For example, if an administrator specifies that the Short description field is required for the Task table, then this configuration applies to the Incident form, Change Request form, Problem form, and so on.

An extended table can override the Required Form Field rule of its base table. For example, if the Short description field is required for the Task table, but not required for the Incident table, it is required for all Task tables except Incident.
Control the label type for derived fields

You can configure the type of label that appears for derived fields.

Role required: admin

An example would be displaying the email address for the caller when looking at an incident record. The email address is not stored in the Incident table, but is obtained by following the caller reference from the incident to the User table. You control the label type by setting a system property. For example, the field label for an incident email address can be either of the following strings.

- **Caller Email**, which represents the complete label to uniquely identify this field as the email from the caller user record. If you display the email address for the person the ticket is assigned to, its label would be **Assigned to Email**.

- **Email** which is the label for the target field. This label is not unique on the form if, for example, you are also displaying the email address of the person assigned to the incident. However, usually the placement of the field on the form makes it clear what the field represents.

1. Navigate to **System Properties > System**.
2. Locate the **Use short labels for all fields.** For example, if a form contains the caller’s email address, use the "Email" label rather than the full label of "Caller Email" (glide.short.labels) property.

   The default value is **true**, meaning that the short label is displayed in all forms.

3. If you want to display the complete label in forms, clear the check box.

4. Click **Save**.

---

**Field administration**

The individual pieces of data in a record are called fields. Users enter data in fields on the form or by using the list editor. Administrators can create new or modify existing fields.

Users can enter data in fields by using the list editor or by using a form. In form view, fields appear as fields in the form, and in list view they appear as columns of data in the table. Administrators can create new fields or change the type of existing fields.

**Field types**

These field types are available to administrators when creating new fields or changing the type of existing fields.

---

**Note:** If you edit a field on a child table that is present on the parent table, it is also changed in the parent table and all other child tables.

---

**Note:** If a table column identifier is created using Kanji characters, it is ignored in any update or insert operation from a form. Kanji characters are not currently supported.

---

**Field types**

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Field for uploading and embedding .mp3 or .ogg audio files.</td>
</tr>
<tr>
<td>Choice</td>
<td>List of configurable choices.</td>
</tr>
<tr>
<td>Collection</td>
<td>Dictionary entries with the Collection type represent the table rather than a field on the table. Changes such as attributes or the Read only check box applied to this entry are applied to the table rather than a specific field. This entry is automatically created when a table is created. There should not be more than one entry for a table of this type.</td>
</tr>
</tbody>
</table>
| Color          | String field that accepts CSS color declarations (including hex or RGB notation) and displays a preview. See:  
   - [HTML Colors (W3Schools)](https://www.w3schools.com) for more information on hex and RGB notation.  
   - [HTML Color Names (W3Schools)](https://www.w3schools.com) for valid color names. |
<p>| Condition String | Text field that accepts a plain JavaScript condition statement that is validated automatically for correctness before an update. |</p>
<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Field that adds the condition builder to a form. You must specify a dependent field that references the table name.</td>
</tr>
<tr>
<td>Currency</td>
<td>Decimal field with four digits after the decimal point. When displayed on a form, a currency field also includes an additional choice list for selecting the currency type. If there is no default value for the field, empty currency fields use the reference currency. Adding a value causes the field to use the session currency of the active user. See <a href="#">Change currency decimal places</a> for how to use two fraction digits.</td>
</tr>
<tr>
<td>Data Structure</td>
<td>Field that allows the selection of one of the following data structures and entry of values to organize particular information in the record.</td>
</tr>
<tr>
<td></td>
<td>· String</td>
</tr>
<tr>
<td></td>
<td>· Boolean</td>
</tr>
<tr>
<td></td>
<td>· Integer</td>
</tr>
<tr>
<td></td>
<td>· Decimal</td>
</tr>
<tr>
<td></td>
<td>· Object</td>
</tr>
<tr>
<td></td>
<td>· Array</td>
</tr>
<tr>
<td>Date</td>
<td>Day, which can be selected with a calendar widget.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Day and time of day, which can be selected with a calendar widget.</td>
</tr>
<tr>
<td>Decimal</td>
<td>Number with up to two digits after the decimal points (for example, 12.34).</td>
</tr>
<tr>
<td>Document ID</td>
<td>Reference to any record on any table.</td>
</tr>
<tr>
<td>Domain ID</td>
<td>System field that contains a reference to the domain.</td>
</tr>
<tr>
<td>Due Date</td>
<td>String input field that stores a date-time.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time. Stored in the database as an integer number of milliseconds, but appears in days, hours, minutes, and seconds.</td>
</tr>
<tr>
<td>Encrypted Text</td>
<td>Field that is encrypted for security. Depending on the user's encryption context, the field may be hidden, the value may be hidden, or the field and value may display.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Reference field for a field name in the table selected in a <strong>Table Name</strong> field type. Make this field dependent on the <strong>Table Name</strong> field.</td>
</tr>
<tr>
<td>Floating Point Number</td>
<td>Number with up to seven digits after the decimal point.</td>
</tr>
<tr>
<td>HTML</td>
<td>String field with a built-in HTML editor.</td>
</tr>
<tr>
<td>Icon</td>
<td>String field that provides the user access to an icon picker in a form. By default, the favorites icon set is used.</td>
</tr>
<tr>
<td>Image</td>
<td>Field for uploading and embedding images.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Integer</td>
<td>Number with zero decimal points.</td>
</tr>
<tr>
<td>IP address</td>
<td>Variable character field that stores IPv4 and IPv6 addresses. See IP address field type for more information.</td>
</tr>
<tr>
<td>Journal</td>
<td>Field that accepts text entries and displays previous entries with a user name and time stamp.</td>
</tr>
<tr>
<td>Journal Input</td>
<td>Field that accepts text entries but does not display previous entries.</td>
</tr>
<tr>
<td>Journal List</td>
<td>Field that displays the contents of journal fields. You must specify the journal fields as the dependent fields. If a journal list field depends on more than one journal field, the entries are displayed chronologically.</td>
</tr>
<tr>
<td>Name-Value Pairs</td>
<td>Field that maps text values. Each mapping is one-to-one, however a single Name-Value Pairs field can contain multiple mappings. Each mapping must use a unique name, and the name cannot be empty. For example, you can use a Name-Value Pairs field to hold header information for a web service request. In this example, the name of each mapping is the header such as Content-Type and the value is the header value, such as Application/json. For information on scripting Name-Value Pairs fields, see Name-value pairs field type.</td>
</tr>
<tr>
<td>List</td>
<td>Reference field that accepts multiple references rather than just one.</td>
</tr>
<tr>
<td>Long</td>
<td>Integer field that can contain a longer number than the integer field.</td>
</tr>
<tr>
<td>Password (1 Way Encrypted)</td>
<td>Text field that stores passwords with one-way encryption. One-way encryption stores the password as a secure hash value that cannot be decrypted.</td>
</tr>
<tr>
<td>Password (2 Way Encrypted)</td>
<td>Text field that stores passwords with two-way encryption. Two-way encryption stores the password as a secure encrypted value that can be decrypted programmatically within the instance. You can use Password 2 encryption with form variables. To encrypt text fields on forms, use Encryption Contexts. The length for password2 field values must be at least 255 characters.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Decimal field that renders a percent complete bar in lists. You can convert any existing decimal field to a percent complete field.</td>
</tr>
<tr>
<td>Phone Number (E164)</td>
<td>String field that provides E164-compliant formatting and validation for telephone numbers.</td>
</tr>
<tr>
<td>Price</td>
<td>A currency field that enables control over conversions and display. See Price fields for more information.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference</td>
<td>Query that displays records from another table.</td>
</tr>
<tr>
<td>Script</td>
<td>Text field that accepts JavaScript code input and provides controls, such as syntax checking and formatting. It also provides a list of fields and server APIs. You must specify a dependent field that references the table name for the list of fields.</td>
</tr>
<tr>
<td>Script (Plain)</td>
<td>Text field that accepts JavaScript code input and provides controls, such as syntax checking and formatting.</td>
</tr>
<tr>
<td>String</td>
<td>For 255 characters or less, the string field is a single-line text field. Anything 256 characters or over appears as a multi-line text box.</td>
</tr>
<tr>
<td>String (Full UTF-8)</td>
<td>A string field that can contain UTF-8 character encoding. This field has the same restriction as the String data type as to maximum length that a user can define within the application UI.</td>
</tr>
<tr>
<td>Suggestion</td>
<td>String field that provides suggested values but accepts free-form text. Available when you add a field by configuring a form or list. Otherwise, you must modify the dictionary entry of an existing string or journal field.</td>
</tr>
<tr>
<td>Table Name</td>
<td>String field that lets you select a table. If you use the Field Name field type, add this field type and make the Field Name field dependent on the Table Name field.</td>
</tr>
<tr>
<td>Time</td>
<td>Specific time. Stored in the database as a date/time field. Only the time part of this field is used.</td>
</tr>
<tr>
<td>Translated HTML</td>
<td>HTML field that displays different translations based on the user's language.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Translated Text</td>
<td>Text field that displays different translations based on the user's language.</td>
</tr>
<tr>
<td>True/False</td>
<td>Boolean field that appears as a check box.</td>
</tr>
<tr>
<td>URL</td>
<td>String field that is a clickable URL field when locked.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In the mobile UI, this field appears as a multi-line text field. The field saves as a single line, with the line breaks removed.</td>
</tr>
<tr>
<td>Video</td>
<td>Field for uploading and embedding video.</td>
</tr>
<tr>
<td>Wiki</td>
<td>String field with a built-in Wiki text editor that accepts a simplified version of standard Wiki text formatting.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Choice list field that displays a stage in a workflow.</td>
</tr>
</tbody>
</table>

**Note:** When you create a custom field, use one of these supported field types. Other field types, such as User Input, are for internal use only and are not supported for custom fields.

### Choice list field type

A choice list is a type of field that lets the user select from a pre-defined set of choices. Administrators can define the available choices and customize the behavior and appearance of choice lists.

![Choice list example](image)

**Incident state choice list**

**Note:** Choice lists do not support a one to many relationship. Only one choice from a choice list can be selected at a time.

### Choice list security

You can use the `personalize_choices` security role to enable non-administrators modify Choice elements options on all tables.
If more granular control is desired, you can also create a custom ACL (security rule) governing the personalize_choices operation either for a particular field or for all fields (\*) on a particular table. However, access to the personalize_choices operation on a particular field does not confer the ability to add new choices for that field.

To be able to create new choices for a particular field, an ACL that grants personalize_choices access for that field is required. For example, to give the hris_admin role the ability to personalize only the Category field for Human Resources KB articles, you need an ACL granting personalize_choices access to the hris_admin role on the Category field of the Knowledge (kb_knowledge) table.

There are predefined ACLs granting both types of access to the personalize_choices security role, for all fields on all tables. The personalize_choices security role also has read, write, and delete access to the sys_choices table. However, this additional access is not required when making just the Personalize Choices functionality available on a granular basis.

To be able to create new choices for a particular field, an ACL that grants personalize_choices access for that field is required. For example, to give the hris_admin role the ability to personalize only the Category field for Human Resources KB articles, you need an ACL granting personalize_choices access to the hris_admin role on the Category field of the Knowledge (kb_knowledge) table.

### Values to associate with choice labels for scripting

When you write a script that references a choice list, you need to know the value that is associated with each choice.

For example, to check whether the incident_state field is active, you could not use the condition `current.incident_state == "active"` because the value associated with the choice labeled Active is the integer 2. Instead, you would use the condition `current.incident_state == 2`.

The Type field on the choice list dictionary entry determines the data type of the values.

To determine the value associated with a choice, right-click the field label and select Show Choice List, and then locate the choice for which you need to know the value.

<table>
<thead>
<tr>
<th>Table</th>
<th>Element</th>
<th>Language</th>
<th>Value</th>
<th>Label</th>
<th>Inactive</th>
<th>Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>1</td>
<td>New</td>
<td>false</td>
<td>1</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>2</td>
<td>Active</td>
<td>false</td>
<td>2</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>3</td>
<td>Awaiting Problem</td>
<td>false</td>
<td>3</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>4</td>
<td>Awaiting User Info</td>
<td>false</td>
<td>4</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>5</td>
<td>Awaiting Evidence</td>
<td>false</td>
<td>5</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>6</td>
<td>Resolved</td>
<td>false</td>
<td>6</td>
</tr>
<tr>
<td>incident</td>
<td>state</td>
<td>en</td>
<td>7</td>
<td>Closed</td>
<td>false</td>
<td>7</td>
</tr>
</tbody>
</table>
The -- None -- option may not have a sys_choice record associated with it. A choice list field set to -- None -- evaluates to these values, depending on the script context as listed below.

- For client-side scripts, such as client scripts: "" (empty string)
- For server-side scripts, such as business rules: "0" (string of the number zero)

**Integer values for default choice lists**

Choice provide four default values.

Some common choice lists use integer values that do not match the string labels. For example, the Problem table uses these default values for the *State* field.

<table>
<thead>
<tr>
<th>State field default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

These integer values are also used in several default business rules. For example, a business rule on the Incident table sets the active flag to false when the *State* field changes to 7, which is the default value for the *Closed*. If you change the values of your Incident state options, this business rule may no longer behave as desired or expected.

On the Incident table, the *Active*, *State*, and *Incident state* fields are affected by the following default business rules.

<table>
<thead>
<tr>
<th>Default business rules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Business rule</strong></td>
</tr>
<tr>
<td>mark_closed (incident)</td>
</tr>
<tr>
<td>incident reopen (incident)</td>
</tr>
<tr>
<td>mark closed (task)</td>
</tr>
<tr>
<td>task closer (task)</td>
</tr>
<tr>
<td>task reopener (task)</td>
</tr>
</tbody>
</table>

**Note:** Notice that these business rules do not change incident_state based on a change to either the *Active* field or the *State* field. Changes to incident_state drive the other two fields, not the other way around.
Configure state field choice values

State fields are a subset of choice list fields. Keep the following information in mind when you configure choice values for the state field.

- Use a negative value to add a new active state field.
- Search for and study the business rules that use a state number filter on the **Script** and **Conditions** fields. You can use the Debug tool to trace the order of the business rule execution.
- New values representing inactive states should have a value above 8.

You can define any of the following attributes for a state field by configuring the dictionary. If the attributes are not defined, the system uses the default values. The TaskStateUtil API uses the following attributes. For more information on the TaskStateUtil API, see TaskStateUtil.

### Related Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>close_states</td>
<td>Semicolon delimited list of state values that are inactive, used to identify whether the task should be set to active or inactive. This is a required attribute to use the TaskStateUtil functionality.</td>
</tr>
<tr>
<td>default_close_state</td>
<td>Optional attribute to define the state value of the default close state if you want to define business rules that automatically close a task. Defaults to 3, typically Closed Complete if attribute is not defined.</td>
</tr>
<tr>
<td>default_work_state</td>
<td>Optional attribute to define the state value of the default working state if you want to define business rules that automatically set a task for working. Defaults to 2, typically Work in Progress if the attribute is not defined.</td>
</tr>
</tbody>
</table>

### State modification examples

Follow these examples for modifying the states of incidents and change requests.

Role required: admin

1. Navigate to **System Definition > Choice Lists**.
2. At the top of the list, construct a list filter like the following:
   - **Table**: incident  
   - **Element**: incident_state
3. Run the filter.
   
   Notice that the **Closed** state has a value of 7 and the **Resolved** state has a value of 6. Any state greater than or equal to 7 is assumed to be inactive. Therefore, you should use a positive integer greater than 7 if you want to add a new inactive-type of state. Use a negative value like -1 or -2 if you wish to add a new active-type of state field, such as **Awaiting Vendor**.
4. Navigate again to **System Definition > Choice Lists**.
5. At the top of the list, construct a list filter like the following:
   - **Table**: change_request  
   - **Element**: phase_state
6. Run the filter.
Notice that the **Complete** state has a value of **8**. Any state greater than or equal to **8** is assumed to be inactive. Therefore, you should use a positive integer greater than **8** if you want to add a new inactive-type of state, such as **Cancelled**. Use a negative value like **-1** or **-2** if you wish to add a new active-type of state field, such as **Pending**.

**Troubleshoot change states and business rules**

Business rules in the system make assumptions about state values. You can troubleshoot business rules to see the order in which they run and see how it affects changes you make to **State** field values.

Role required: admin

1. Navigate to **System Definition > Business Rules**.
2. Construct a filter like this one to view the scripts and conditions that pertain to the Resolved incident_state of 6 or the Closed incident_state value of 7:

   The **Script** field contains **7** OR the **Condition** field contains **7** OR the **Script** field contains **6** OR the **Condition** field contains **6** AND the **Table** field is incident AND the **Active** field is true.

See Debug Business Rule for information on how to trace the order of business rule execution. You can click **Debug All**, resolve an incident, and then check the trace at the bottom of form to watch the business rules execute. These two line examples show that the mark_closed business rule code is entered ==> and then exited <==

```plaintext
==> 'mark_closed' on incident
<= 'mark_closed' on incident
```

**View choice list definitions**

The Choice Set (sys_choice_set) table contains a record for every field that uses a choice list.

Role required: personalize_choices

```
Note: The personalize_choices role must be explicitly granted to the user; it cannot be an ACL.
```

The choice set record is associated with an application file, which allows update sets and team development to track and transfer all choices for a field in a single update record.

Choice list values allow a maximum length of 40 characters. The range of allowable numerical values is (-999, 999).

1. Right-click the choice list field label and select **Show Choice List**.
2. Review the items in the list.

```plaintext
Note: When you use an ACL to grant personalize_choices on a particular field, **Show Choice List** is not available. It is only available if you explicitly grant the role to the user. **Configure Choices** continues to appear regardless of whether it is an ACL or an explicitly granted user role.
```

2. Review the items in the list.

```plaintext
Warning: Do not add new choices to the list. To add new choices to a choice list field, use the **Configure Choices** option.
```

Define an option for a choice list

You can personalize the options that are available in a choice list.
Role required: personalize_choices

1. Navigate to a form where the field appears.
2. If the choice list is dependent on another field, enter the choice value that the options depend on.
   For example, on the incident table, the Subcategory is dependent on the Category. To customize which subcategory choices are available for the hardware category, select Hardware in the Category field.
3. Right-click the field label and select Configure Choices.
4. Use the slushbucket to rearrange the order, add, or remove items or to create new items.
5. Click Save.

   To dynamically add items to a choice list, use the addOption GlideForm method.

   **Note:** Some business rules may be affected by changes to choice list options (for example, default Incident states).

**Reuse a choice list**

After defining a set of choice list values, you can reuse the values for another field in a different table.

Role required: personalize_choices

1. Right-click an existing choice field (Field A) and select Configure Choices.
2. Add the desired choice list values in the Choices related list.
3. To reuse the choice list values for another field (Field B) in a different table, right-click the label for Field B and select Configure Dictionary.
4. In the Choice table field, select the table where Field A resides.
5. In the Choice field field, select Field A.

6. Click Update.
The choice list values defined on Field A are displayed on Field B. When you add or remove choice list values on Field A, those changes are also reflected on Field B. After you specify a choice table and a choice field, the field no longer uses the defined choice list.

Remove the None option from a choice list
You can remove the None option from a choice list if it is not necessary.

Role required: personalize_dictionary

1. Navigate to a form where the field appears.
2. Right-click the field label and select Configure Dictionary.
3. Change the Choice field value to Dropdown without -- None -- (must specify a default value).

4. Ensure that the Default field is populated to determine which choice is displayed by default.

Note: If the field is dependent on another field, the -- None -- option remains available.

Change the None display value for a choice list
You can change the default display label of the None option for a choice field.

Role required: personalize_choices

Note: The personalize_choices role must be explicitly granted to the user; it cannot be an ACL.

1. Navigate to a form on which the field appears.
2. Right-click the field label and select Show Choice List.
3. Click New.
4. Complete the form.

Choice form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table.</td>
</tr>
<tr>
<td>Element</td>
<td>Leave the name of the field that is automatically populated.</td>
</tr>
<tr>
<td>Language</td>
<td>Enter ISO language code for the label.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Leave empty. This field determines the order.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave cleared.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>Enter the label to appear in the choice list. You can use JavaScript, including calls to script includes, to define the label. For example, the JavaScript label in the following example changes the <strong>None</strong> value of the <strong>Time zone</strong> choice list in a user record to use the time zone value of the instance.</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Enter <strong>NULL_OVERRIDE</strong>. Note: You must enter <strong>NULL_OVERRIDE</strong> as the value, or the new label appears in addition to the <strong>None</strong> option.</td>
</tr>
<tr>
<td>Dependent value</td>
<td>Leave blank.</td>
</tr>
<tr>
<td>Hint</td>
<td>Leave blank.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

*Delete all choice list options*

You can delete all choices for a choice field from the Choice Set record.

**Role required: personalize**

You may want to use this method when you are developing a new application and the business requirements change. If you are updating a choice list that is already in use, consider...
deactivating the options you no longer use to avoid conflicts with existing data or scripts that may rely on the previous options.

1. In the navigation filter, enter `sys_choice_set.list` and press Enter.
2. Open the choice set record for the field.
   For example, to locate the choice set for the incident subcategory, filter by `(Table) (is) (incident) AND (Element) (is) (subcategory)`.
3. Check the box beside the choice set record to delete and select `Delete` from the Actions choice list below the list.
4. Click `Delete` in the confirmation window.
   All choices for the field are deleted.

Create a choice list for another field type
You can create a choice list for a field with another type, such as an integer, string, or reference field.

Role required: personalize_dictionary
You can use this configuration to standardize data entry and limit available options for a field while still maintaining the original field type.

1. Navigate to `System Definition > Dictionary`.
2. Open the dictionary entry for the field.

   Note: Reference fields with a large number of records in the reference table cannot be converted to look like choice fields. A reference field with too many records reverts to looking like a reference field.

3. Change the `Choice` value to `Dropdown with --- None ---` or `Dropdown without --- None ---` *(must specify a default value)*.
4. Right-click the form header and select `Save`.
5. Click `Create Choice List`.
   • The `Choices` related list appears on the dictionary entry form.
   • If records on the table contains data for the field, a choice list value for each unique field value is created. For example, if three records exist on the table and each record has a unique value in the field, then three choices are created.
   • If no data exists in the field, a choice list value of `-- New choice --` is created.

Display invalid choice list values
By default, inactive or invalid choice list values appear in blue text instead of black. You can disable the color indicator for invalid choices.

Role required: admin

In the following example, the `Network` category has been deactivated, so it appears in blue for records that still contain the inactive value.
1. Navigate to System Properties > UI Properties.
2. Clear the check box for the Display missing choice list entries property.

Adjust the choice list width

By default in UI11, all choice lists use a width of 160 pixels. You can adjust the width for all choice lists on the instance, or change the value for a particular list. This procedure is not applicable to newer versions of the UI.

Role required: admin or personalize_styles

1. To change the width for all choice list on the instance, complete the following steps (requires admin role).
   a) Navigate to System Properties > UI Properties.
   b) Change the value for the Default choice list width (pixels) property (glide.ui.choiceList.defaultWidth).
   c) Click Save.

2. To change the value for a particular list, for example, a list with much longer option names than other choice lists, complete the following steps.
   a) Navigate to a form where the field appears.
   b) Right-click the field label and select Configure Styles.
   c) Click New.
   d) In the Style field, enter width:auto.
      Leave the Value field empty so that the field style applies to all the choices for the field.
   e) Click Submit.
      When the field is displayed, the width adjusts to the size of the content.

Add search option to a choice field

Add a search field to choice fields that have a long list of options.

Role required: admin

1. Navigate to a form that contains choice fields. For example, incident.
2. From a choice field on the form, for example State, right-click the field and select Configure Dictionary.
3. Switch to the advanced view for the dictionary entry form using the context menu by navigating to View > Advanced.

4. In the Attributes field, type is_searchable_choice=true. If there are other entries in the attributes field, use a comma to separate the entries.

5. Update the Dictionary Entry form and reload the page containing the choice list.

The choice list contains a search field that users can use to filter the list of choices.

![Choice field search](image)

**Condition field types**

A condition field specifies when to run business logic such as a business rule or workflow.

There are two types of condition field.

### Condition field types

<table>
<thead>
<tr>
<th>Condition field type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition string</td>
<td>A text field that accepts a plain JavaScript condition statement. The system validates the condition syntax for correctness before an update.</td>
</tr>
<tr>
<td>Conditions</td>
<td>A field that adds a condition builder to a form. Condition builders require specifying a dependent field whose values the system uses to display choice list options. Typically, the dependent field is the Table field.</td>
</tr>
</tbody>
</table>

The system evaluates both types of condition field to determine if the conditions are true or false. When true, the system runs the business logic. When false, the system ignores the business logic.

To find dictionary attributes that affect condition fields, see [Dictionary attributes](#).

**Add the condition count to a condition field**

The condition count widget can be activated on condition fields to display a preview of the records that would meet the current set of conditions. For fields where the condition count is
activated, the number of records that match the conditions will automatically display. The count refreshes if the field the condition field depends on, such as Table, is changed. If the Table field is left blank, the widget is hidden.

Role required: personalize_dictionary

1. Right-click the field label and select **Configure Dictionary**.
2. Add `show_condition_count=true` to the **Attributes** field.
3. Submit.

In this example, a condition is run on the Incident table to look for incidents where **Category** is **Network**:

<table>
<thead>
<tr>
<th>Category</th>
<th>is</th>
<th>Network</th>
</tr>
</thead>
</table>

**Condition count**

The list shows that there are 112 records with **Network** as its category.

To refresh the preview, click the update count icon ( ).

To view details of the results, click the number of records to open the list view of the results:

<table>
<thead>
<tr>
<th>Number</th>
<th>Category</th>
<th>Priority</th>
<th>Incident state</th>
<th>Short description</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC000001</td>
<td>Network</td>
<td>2 - High</td>
<td>Closed</td>
<td>Can't read email</td>
<td>Charlie Whitherspoon</td>
</tr>
<tr>
<td>INC000005</td>
<td>Network</td>
<td>4 - Low</td>
<td>New</td>
<td>Routing to oregon mail server</td>
<td>John Bohnmann</td>
</tr>
<tr>
<td>INC012178</td>
<td>Network</td>
<td>4 - Low</td>
<td>Closed</td>
<td>VPN Access</td>
<td>Paul Roberge</td>
</tr>
<tr>
<td>INC019179</td>
<td>Network</td>
<td>1 - Critical</td>
<td>Closed</td>
<td>Page cannot be displayed</td>
<td>Natasha Ingram</td>
</tr>
<tr>
<td>INC019186</td>
<td>Network</td>
<td>3 - High</td>
<td>Closed</td>
<td>Need backup drive for Time Machine</td>
<td>Stacy Be supply</td>
</tr>
</tbody>
</table>

**Condition count results**

**Update a conditions field to use condition builder v2**

In UI16, you can update a conditions field to display the version 2 condition builder.

Role required: admin

You add a dictionary attribute to the Conditions field to enable condition builder version 2 (v2).
1. Open the form with the condition builder to configure.
2. Right-click the **Conditions** label and click **Configure Dictionary**.
3. In the **Attributes** field, enter `condition_builder=v2`.
   If attributes exist, add this string at the end separated by a comma.
4. Click **Update**.
   The form reloads with the v2 version of the condition builder.

### Database field type

Several field types are available in the system.

This table shows field types and corresponding MySQL database types. Typically, it isn't necessary to perform any actions at the database level. To learn about changing a field type, see System dictionary.
### Database field types

<table>
<thead>
<tr>
<th>Field types</th>
<th>Options</th>
<th>Dictionary XML type</th>
<th>MySQL DB type</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>small</td>
<td>string</td>
<td>VARCHAR(40)</td>
</tr>
<tr>
<td>String</td>
<td>medium</td>
<td>string</td>
<td>VARCHAR(100)</td>
</tr>
<tr>
<td>String</td>
<td>large</td>
<td>string</td>
<td>MEDIUMTEXT</td>
</tr>
<tr>
<td>String</td>
<td>extralarge</td>
<td>string</td>
<td>MEDIUMTEXT</td>
</tr>
<tr>
<td>Decimal</td>
<td></td>
<td>decimal</td>
<td>Decimal (15,2)</td>
</tr>
<tr>
<td>Integer</td>
<td></td>
<td>integer</td>
<td>Integer</td>
</tr>
<tr>
<td>True-False</td>
<td></td>
<td>boolean</td>
<td>TINYINT(1)</td>
</tr>
<tr>
<td>Date</td>
<td>glide_date</td>
<td></td>
<td>DATE</td>
</tr>
<tr>
<td>Date-Time</td>
<td>glide_date_time</td>
<td></td>
<td>DATETIME</td>
</tr>
<tr>
<td>Time</td>
<td>glide_time</td>
<td></td>
<td>DATETIME</td>
</tr>
<tr>
<td>Duration</td>
<td>glide_duration</td>
<td></td>
<td>DATETIME</td>
</tr>
<tr>
<td>Choice</td>
<td></td>
<td>string</td>
<td>VARCHAR(40)</td>
</tr>
<tr>
<td>Suggestion</td>
<td></td>
<td>string</td>
<td>VARCHAR(40)</td>
</tr>
<tr>
<td>Journal</td>
<td></td>
<td>journal</td>
<td>MEDIUMTEXT</td>
</tr>
<tr>
<td>Reference</td>
<td>&lt;reference table&gt;</td>
<td></td>
<td>VARCHAR(32)</td>
</tr>
<tr>
<td>List</td>
<td>glide_list</td>
<td></td>
<td>MEDIUMTEXT</td>
</tr>
<tr>
<td>Url</td>
<td></td>
<td>url</td>
<td>MEDIUMTEXT</td>
</tr>
<tr>
<td>Image</td>
<td></td>
<td>user_image</td>
<td>VARCHAR(40)</td>
</tr>
<tr>
<td>Due-Date</td>
<td></td>
<td>due_date</td>
<td>DATETIME</td>
</tr>
</tbody>
</table>

### Dictionary entry data types

You can only change a dictionary entry’s data type when the change does not result in data loss. Use the following guidelines to change a dictionary entry’s data type.

#### Valid data type changes

<table>
<thead>
<tr>
<th>Condition</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The field is empty in all table records.</td>
<td>None. You can convert an empty field from any data type to another without restriction.</td>
</tr>
<tr>
<td>The table contains existing data for the field.</td>
<td>You can only convert between logical data types that map to the same physical data type in the database. For example, you can convert a glide duration to a glide datetime since both logical data types map to the DATETIME physical data type in the database.</td>
</tr>
<tr>
<td>Condition</td>
<td>Restrictions</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>The field is a string field you are converting to another type of string field.</td>
<td>You can change between string-based data types as long as length changes do not cause any data loss from truncation. For example, you can change from a MEDIUM database type to a VARCHAR(100) database type if none of the existing data is greater than 100.</td>
</tr>
<tr>
<td>The field is a string field you are converting to a globally unique ID (GUID).</td>
<td>You can only convert a string field to a GUID if all of the exiting data in the field are already Sys ID values.</td>
</tr>
<tr>
<td>The field is a GUID field you are converting to a string field.</td>
<td>None. You can convert a GUID field to a string field without restriction.</td>
</tr>
</tbody>
</table>

**Document ID field**

You can create document ID fields to reference any record on any table.

Role required: personalize_dictionary

In comparison, a reference field references a record on a specific table. To reference records from any table, two fields need to work together—one to store the table reference and another to store the record reference.

You can select the document ID type when creating a new field.

1. Navigate to the form view for the table.
2. Right-click the header and select Configure > Form Layout.
3. Create a field to store the table name and click Add.
   - **Name**: any label (for example, Model table)
   - **Type**: String
4. Create a field to store the record reference and click Add.
   - **Name**: label for your document ID field (for example, Model ID)
   - **Type**: Document ID
5. Click Save.
6. Right-click the form header and select Configure > Dictionary.
7. Open the dictionary entry for the document ID field.
8. Under Related Links, click Advanced view.
9. In the **Dependent** field, enter the column name of the table reference field (for example, u_model_table).
10. Optional: In Attributes, add the **show_all_tables** dictionary attribute to display system tables.
11. Click Update. When users click the reference lookup for the document ID field, a dialog appears that allows them to select the table and then the record. The sys_id of the selected record is stored in the document ID field and the table name is stored in the table reference field.
12. Optional: **Configure the form** to remove the table reference field.
HTML field type

The HTML editor provides WYSIWYG (what you see is what you get) functionality and HTML source mode editing. Administrators can customize some of the functionality associated with HTML fields. The HTML editors available depend on your version of the UI.

**UI support for available HTML editors**

<table>
<thead>
<tr>
<th>HTML editor</th>
<th>UI support</th>
</tr>
</thead>
<tbody>
<tr>
<td>TinyMCE version 4</td>
<td>UI16, UI15</td>
</tr>
<tr>
<td>TinyMCE version 3</td>
<td>Legacy: UI11</td>
</tr>
<tr>
<td>htmlArea (legacy)</td>
<td>Legacy: UI11</td>
</tr>
</tbody>
</table>

Knowledge articles, service catalog item descriptions, release documentation, and HTML content blocks are common examples of HTML fields.

While HTML fields can be added to split forms, HTML fields are not intended for this use and can behave unexpectedly due to the limited available width in split pane forms.

Configure a field editor for the HTML field

You can configure HTML fields to use the TinyMCE editor or the legacy HtmlArea editor. This editor provides better stability and more editing functions than the legacy HtmlArea editor.

Role required: admin

There are two options for HTML editors.

- TinyMCE: A What You See Is What You Get (WYSIWYG) field that displays text as readers would see it on the screen. TinyMCE is the default editor.
- htmlArea: The legacy editor, which offers a more basic WYSIWYG interface as well as a mode that shows only HTML markup.

1. Navigate to System Properties > UI Properties.
2. Locate the property called **HTML field editor to use (glide.ui.html.editor)**.
3. Select TinyMCE or HtmlArea.
4. Click **Save**.

Configure the TinyMCE HTML toolbar

When HTML fields are configured to use the TinyMCE HTML editor, follow this procedure to configure which buttons are available on the toolbar.

Role required: admin
This procedure applies to both versions of the TinyMCE editor: version 3, available in UI11, and version 4, available in UI16 and UI15.

1. Navigate to System Properties > UI Properties.
2. Locate the appropriate properties based on your version of the UI.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| UI16 or UI15    | (TinyMCE v.4.0.26) Configures the editing toolbar (first line) for HTML fields (glide.ui.html.editor.v4.toolbar.line1)  
|                 | (TinyMCE v.4.0.26) Configures the editing toolbar (second line) for HTML fields (glide.ui.html.editor.v4.toolbar.line2)  |
| UI11            | Configures the editing toolbar (first line) for HTML fields (glide.ui.html.editor.toolbar.line1)  
|                 | Configures the editing toolbar (second line) for HTML fields (glide.ui.html.editor.toolbar.line2)  |

3. Enter or remove buttons for each toolbar as a comma-separated list without spaces.
   - Use a vertical bar ("|") to add a section separator.
   - Use the following button names when defining these properties.

<table>
<thead>
<tr>
<th>Button purpose</th>
<th>Accepted button names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting</td>
<td>newdocument, bold, italic, underline, strikethrough, justyleft, justifycenter, justifyright, justifyfull, formatselect, fontselect, fontsizeelect, bullist, numlist, outdent, indent, blockquote, forecolor, removeformat, backcolor, sub, sup</td>
</tr>
<tr>
<td>Table functions</td>
<td>tablecontrols</td>
</tr>
<tr>
<td>Editing</td>
<td>cut, copy, paste, pastetext, search, replace, undo, redo</td>
</tr>
<tr>
<td>Extended functions</td>
<td>link, unlink, cleanup, code, hr, visualaid, charmap, image, media, preview, spellchecker, fullscreen (not supported by Internet Explorer)</td>
</tr>
</tbody>
</table>

The spellchecker tool is not supported in UI16 or UI15.

4. Click Save.

Note: The Configures the editing toolbar for HTML fields (glide.ui.html.toolbar) property only applies to the legacy htmlArea editor. Changes to this property only apply when the legacy htmlArea editor is enabled; they do not affect the TinyMCE HTML toolbar.
Configure TinyMCE editor to allow deprecated tags

You can set a dictionary attribute on a TinyMCE editor field to allow the use of deprecated HTML tags, such as <b> and <i>. By default, the TinyMCE editor uses the <strong> and <em> tags for bold and italic formatting.

Role required: personalize_dictionary or admin

After you set the dictionary attribute, use code view to manually enter deprecated tags. The editor does not validate any tags you enter manually, for example, if you type an incorrect character.

1. Navigate to the form with an HTML field that uses the TinyMCE editor.
2. Right-click the HTML field label and select Configure dictionary.

3. In the Attributes field, enter tinymce_allow_all=true, separated by a comma if needed. If other attributes are already listed, use a comma as a separator.
Configure TinyMCE editor to allow JavaScript in URLs

You can set a dictionary attribute on a TinyMCE editor field to allow the use of JavaScript in a URL.

Role required: personalize_dictionary or admin

1. Navigate to the form with an HTML field that uses the TinyMCE editor.
2. Right-click the HTML field label and select Configure dictionary.

4. Click Update.
3. In the **Attributes** field, enter `tinymce_allow_script_urls=true`, separated by a comma if needed. If other attributes are already listed, use a comma as a separator.

4. Click **Update**.

**Configure the legacy HTML toolbar**

When HTML fields are configured to use the legacy htmlArea HTML editor, follow this procedure to configure which buttons are available on the toolbar.

The legacy HTML toolbar is not supported in UI16 or UI15.

1. Navigate to **System Properties > UI Properties**.
2. Locate the property called **Configures the editing toolbar for HTML fields** (`glide.ui.html.toolbar`).
3. Enter a comma-separated list, without spaces, to define the buttons that should appear on the toolbar. Use the following button names.

<table>
<thead>
<tr>
<th>Button purpose</th>
<th>Accepted button names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting</td>
<td>formatblock, fontname, fontsize, bold, italic, underline, justifyleft, justifycenter, justifyright, justifyfull, insertorderedlist, insertunorderedlist, outdent, indent, forecolor, hilitecolor</td>
</tr>
<tr>
<td>Editing</td>
<td>copy, paste, undo</td>
</tr>
<tr>
<td>Extended functions</td>
<td>createlink, inserthorizontailrule, insertimage, insertvideo, inserttable, htmlmode</td>
</tr>
</tbody>
</table>

4. Click **Save**.

---

**Note:**

The **Configures the editing toolbar (first line) for HTML fields** (`glide.ui.html.editor.toolbar.line1`) and **Configures the editing toolbar (second line) for HTML fields** (`glide.ui.html.editor.toolbar.line2`) properties only apply to the TinyMCE version 2 editor. The **Configures the editing toolbar (first line) for HTML fields** (`glide.ui.html.editor.v4.toolbar.line1`) and **Configures the editing toolbar (second line) for HTML fields** (`glide.ui.html.editor.v4.toolbar.line2`) properties only apply to the TinyMCE version 4 editor. Changes to these properties only apply when the TinyMCE editor is enabled; they do not affect the legacy htmlArea editor.

---

**Formatting in the TinyMCE editor**

The formatting table displays how to control the way text appears.

In the following table, the TinyMCE v3/htmlArea icon column displays icons that are available with the TinyMCE version 3 and htmlArea editors. The TinyMCE v4 icon column displays icons that are available with the TinyMCE version 4 editor. Names marked with an asterisk (*) are not available with the htmlArea editor.
## Formatting table

<table>
<thead>
<tr>
<th>TinyMCE v3/htmlArea icon</th>
<th>TinyMCE v4 icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>New Document*</td>
<td>Clears the contents of the HTML field.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>B</td>
<td>Bold</td>
<td>Applies bold formatting to the selected text or current word.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Keyboard shortcut: CTRL + B</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>i</td>
<td>Italic</td>
<td>Applies italics formatting to the selected text or current word.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Keyboard shortcut: CTRL + I</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>U</td>
<td>Underline</td>
<td>Applies underline formatting to the selected text or current word.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Keyboard shortcut: CTRL + U</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>strike-through</td>
<td>Strikethrough*</td>
<td>Applies strikethrough formatting to the selected text or current word.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Align Right</td>
<td>Applies right alignment to the current paragraph.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Code reference: text-align:right</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Align Center</td>
<td>Applies center alignment to the current paragraph.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Code reference: text-align:center</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Align Left</td>
<td>Applies left alignment to the current paragraph.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td></td>
<td>Code reference: text-align:left</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>TinyMCE v3/htmlArea Icon</th>
<th>TinyMCE v4 Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="justify_icon.png" alt="Justify Icon" /></td>
<td>Justify</td>
<td>Applies justified alignment, which stretches the lines to equal width, to the current paragraph. <strong>Code reference:</strong> <code>text-align:justify</code></td>
</tr>
<tr>
<td></td>
<td><img src="format_icon.png" alt="Format Icon" /></td>
<td>Format</td>
<td>Applies a paragraph style to the current paragraph, such as Paragraph, Heading 1, and Preformatted.</td>
</tr>
<tr>
<td><img src="arial_icon.png" alt="Font Family Icon" /></td>
<td><img src="arial_icon.png" alt="Font Family Icon" /></td>
<td>Font Family</td>
<td>Applies a font family to the selected text or current word.</td>
</tr>
<tr>
<td><img src="font_sizes_icon.png" alt="Font Sizes Icon" /></td>
<td><img src="font_sizes_icon.png" alt="Font Sizes Icon" /></td>
<td>Font Size</td>
<td>Applies a font size to the selected text or current word.</td>
</tr>
<tr>
<td><img src="bullet_icon.png" alt="Insert/Remove Bulleted List Icon" /></td>
<td><img src="bullet_icon.png" alt="Insert/Remove Bulleted List Icon" /></td>
<td>Insert/Remove Bulleted List</td>
<td>Applies or removes unordered list tags for the selected paragraphs. Click the arrow beside the button to select a different bullet type.</td>
</tr>
<tr>
<td><img src="number_icon.png" alt="Insert/Remove Numbered List Icon" /></td>
<td><img src="number_icon.png" alt="Insert/Remove Numbered List Icon" /></td>
<td>Insert/Remove Numbered List</td>
<td>Applies or removes ordered list tags for the selected paragraphs. Click the arrow beside the button to select a different number type.</td>
</tr>
<tr>
<td><img src="indent_decrease_icon.png" alt="Decrease Indent Icon" /></td>
<td><img src="indent_decrease_icon.png" alt="Decrease Indent Icon" /></td>
<td>Decrease Indent</td>
<td>Removes indentation from the current or selected paragraphs (removes 30px of left padding; padding cannot be less than 0). <strong>Code reference:</strong> <code>padding-left</code></td>
</tr>
<tr>
<td><img src="indent_increase_icon.png" alt="Increase Indent Icon" /></td>
<td><img src="indent_increase_icon.png" alt="Increase Indent Icon" /></td>
<td>Increase Indent</td>
<td>Applies indentation to the current or selected paragraphs (adds 30px of left padding). <strong>Code reference:</strong> <code>padding-left</code></td>
</tr>
<tr>
<td>TinyMCE v3/htmlArea icon</td>
<td>TinyMCE v4 icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>“</td>
<td></td>
<td>Block Quote*</td>
<td>Applies the <code>&lt;blockquote&gt;</code> tag, which defines a long quotation, to the current or selected paragraphs. Browsers usually indent these elements.</td>
</tr>
<tr>
<td>A_  _</td>
<td>A_  _</td>
<td>Select Text Color</td>
<td>Applies font color to the current word or selected text. Click the button to use the current color, or click the arrow next to the button to view more colors. Click More Colors... to view various color options and the hexadecimal codes.</td>
</tr>
<tr>
<td>ab^2</td>
<td></td>
<td>Select Background Color</td>
<td>Applies background color to the current word or selected text. Click the button to use the current color, or click the arrow next to the button to view more colors. Click More Colors... to view various color options and the hexadecimal codes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clear Formatting*</td>
<td>Removes the inline styles and formatting from the selected text.</td>
</tr>
<tr>
<td>x^2</td>
<td></td>
<td>Subscript*</td>
<td>Applies subscript text, which appears half a character below the baseline, to the current word or selected text.</td>
</tr>
<tr>
<td>x^3</td>
<td></td>
<td>Superscript*</td>
<td>Applies superscript text, which appears half a character above the baseline, to the current word or selected text.</td>
</tr>
</tbody>
</table>

**Extended HTML editor functions**

The extended functions available for working with HTML content.
<table>
<thead>
<tr>
<th>Icon</th>
<th>TinyMCE v4 Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Insert/Edit Link](icon) | ![Insert/Edit Link](icon) | Insert/Edit Link | Configures a link for the selected text. Define the link URL, title (additional information that appears in the tooltip), and the target (same window or new window or tab).
*Code reference:* `<a>` |
| ![Remove link](icon) | ![Remove link](icon) | Remove link* | Removes the current hyperlink. |
| ![Cleanup Messy Code](icon) | ![Cleanup Messy Code](icon) | Cleanup Messy Code* | Fixes standard HTML errors for the selected text, such as invalid tags. Clicking this button may change the layout of existing content. If you do not like the results, you can click **Undo** to revert this action. |
| ![HTML](icon) | ![HTML](icon) | Edit HTML Source | Opens HTML source code in a separate window. See **Editing in HTML Source Mode**. |
| ![Insert Horizontal Line](icon) | ![Insert Horizontal Line](icon) | Insert Horizontal Line | Inserts a horizontal line at the current location. |
| ![Toggle Invisible Elements](icon) | ![Toggle Invisible Elements](icon) | Toggle Invisible Elements* | Shows or hides invisible elements in the article, such as collapsed table borders. |
| ![Insert Special Character](icon) | ![Insert Special Character](icon) | Insert Special Character* | Inserts a special character (symbol) at the current cursor location. Click the button to view a list of available characters. Point to a character to view the name and HTML code. Click a character to insert it. |
| ![Insert/Edit Image](icon) | ![Insert/Edit Image](icon) | Insert/Edit Image | Inserts an image from the image library or an attachment. You can also add images to the image library with this feature. To learn more, see **Embedding Images in HTML Fields**. |
## Editing functions in the TinyMCE editor

Several editing functions are built into the TinyMCE editor.

You can add more edit functions to the TinyMCE v4 editor using the `glide.ui.html.editor.toolbar.line1` and `glide.ui.html.editor.toolbar.line2` properties located on the UI Properties page. For more information on configuring the edit functions, see Configure the TinyMCE HTML toolbar.

### Editing functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>TinyMCE v4 Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="..." alt="Cut" /></td>
<td><img src="..." alt="Cut" /></td>
<td>Cut*</td>
<td>Cuts the selected text. Not supported in all browsers; use keyboard shortcut. Keyboard shortcut: CTRL + X</td>
</tr>
<tr>
<td><img src="..." alt="Copy" /></td>
<td><img src="..." alt="Copy" /></td>
<td>Copy*</td>
<td>Copies the selected text. Not supported in all browsers; use keyboard shortcut. Keyboard shortcut: CTRL + C</td>
</tr>
</tbody>
</table>

*These options are not available with htmlArea.*
<table>
<thead>
<tr>
<th>Icon</th>
<th>TinyMCE v4 Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Paste" /></td>
<td></td>
<td>Paste*</td>
<td>Pastes the selected text. Not supported in all browsers; use keyboard shortcut. Keyboard shortcut: CTRL + V</td>
</tr>
<tr>
<td><img src="icon" alt="Paste as Plain Text" /></td>
<td></td>
<td>Paste as Plain Text*</td>
<td>Enables paste as plain text without source formatting.</td>
</tr>
<tr>
<td><img src="icon" alt="Paste from Word" /></td>
<td></td>
<td>Paste from Word*</td>
<td>Opens a new window that allows you to copy and paste content from Microsoft Word into the HTML field.</td>
</tr>
<tr>
<td><img src="icon" alt="Find" /></td>
<td></td>
<td>Find*</td>
<td>Allows you to locate text strings in the HTML field. Search above (up) or below (down) the cursor location.</td>
</tr>
<tr>
<td><img src="icon" alt="Find/Replace" /></td>
<td></td>
<td>Find/Replace*</td>
<td>Allows you to replace the next (Replace) or all (Replace All) occurrences of a text string in the HTML field.</td>
</tr>
<tr>
<td><img src="icon" alt="Undo" /></td>
<td></td>
<td>Undo*</td>
<td>Reverts the previous edit.</td>
</tr>
<tr>
<td><img src="icon" alt="Redo" /></td>
<td></td>
<td>Redo*</td>
<td>Reapplies the last reverted edit.</td>
</tr>
</tbody>
</table>

*These options are not available with htmlArea.

Table functions in the TinyMCE version 4 editor

The TinyMCE version 4 editor uses menus and menu selections to create and edit tables.
## TinyMCE version 4 editor

<table>
<thead>
<tr>
<th>UI element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Table icon" /></td>
<td>Click the table icon ( <img src="image" alt="Table icon" /> ) to access the TinyMCE version 4 table menu. Use the table menu to:</td>
</tr>
<tr>
<td></td>
<td>- Insert or delete a table</td>
</tr>
<tr>
<td></td>
<td>- Modify table properties</td>
</tr>
<tr>
<td></td>
<td>- Add, move, or delete rows and columns</td>
</tr>
<tr>
<td></td>
<td>- Modify row and column properties</td>
</tr>
<tr>
<td></td>
<td>- Split and merge cells</td>
</tr>
</tbody>
</table>

**Table menu**

To insert a table in the HTML field, click **Insert table** and highlight squares in the grid to represent the desired number of rows and columns. Click the last highlighted square to insert the table.

After you insert the table, you can modify the size by clicking and dragging the handles at the table edges.

**Table insert grid**
From the table menu, click **Table properties** to open the Table properties dialog box. From this box you can take any of the following actions.

- **General tab:**
  - Set table width and height
  - Set cell spacing and padding
  - Enable borders and captions
  - Set the table alignment

- **Advanced tab:**
  - Configure the table style
  - Select the border color
  - Select the background color

<table>
<thead>
<tr>
<th>UI element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table properties</strong></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Advanced</td>
</tr>
<tr>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>Cell spacing</td>
<td>Cell padding</td>
</tr>
<tr>
<td>Border</td>
<td>Caption</td>
</tr>
<tr>
<td>Alignment</td>
<td>None</td>
</tr>
</tbody>
</table>

Table properties
With the cursor in the desired table cell, open the table menu and click **Cell properties**. From this box you can set the following properties for table cells.

- **General tab**:
  - Width and height
  - Type and scope
  - Horizontal and vertical alignment

- **Advanced tab**
  - Configure the cell style
  - Select the border color
  - Select the background color

With the cursor in a table cell in the desired row, open the table menu and click **Row properties**. From this box you can set the following properties for rows.

- **Row type**
- **Alignment**
- **Height**

- **Advanced tab**
  - Configure the row style
  - Select the border color
  - Select the background color
You can also paste tables into HTML fields from table-based editors.

**Table functions in the TinyMCE version 3 and htmlArea editors**

The TinyMCE version 3 editor and the htmlArea editor use icons to create and edit tables. Names marked with an asterisk (*) are not available with the htmlArea editor.

### TinyMCE version 3 and htmlArea editors

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Insert/Edit Table](icon) | Insert/Edit Table | Inserts a table and defines properties for the current table, including columns, rows, width, layout, and spacing. To learn more, see the [table styles example](#).  
*Code reference:* `table` |
| ![Table Row Properties](icon) | Table Row Properties* | Defines properties for the current row, odd rows, even rows, or all rows in the table. To learn more, see the [table styles example](#).  
*Code reference:* `tr` |
| ![Table Cell Properties](icon) | Table Cell Properties* | Defines properties for the current cell, cells in the current row, cells in the current column, or all cells in the table. To learn more, see the [table styles example](#).  
*Code reference:* `td` |
<p>| <img src="icon" alt="Insert Row Before" /> | Insert Row Before* | Adds a row above the current row in a table. |
| <img src="icon" alt="Insert Row After" /> | Insert Row After* | Adds a row below the current row in a table. |
| <img src="icon" alt="Delete Row" /> | Delete Row* | Deletes the current row in a table. |
| <img src="icon" alt="Insert Column Before" /> | Insert Column Before* | Adds a column to the left of the current column in a table. |
| <img src="icon" alt="Insert Column After" /> | Insert Column After* | Adds a column to the right of the current column in a table. |
| <img src="icon" alt="Delete Column" /> | Delete Column* | Deletes the current column in a table. |
| <img src="icon" alt="Split Merged Table Cells" /> | Split Merged Table Cells* | Splits any merged cells in the selected table cells. |</p>
<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Icon](image) | Merge Table Cells* | Merges the selected cells in a table.  
  **Code reference:** colspan  
  **Code reference:** rowspan |

**Highlight text in the TinyMCE editor**  
On the bottom bar of the TinyMCE editor, the path of HTML tags for the text at the cursor position is displayed.

Click a tag in the path to highlight the text affected by the tag.

**Insert a line break in the HTML editor**  
When you use the **Enter** key, the editor creates a paragraph element (**<p>**) tag, which appears as a double space.

To enter a single-line space, use the **Shift + Enter** key combination, which inserts a line break (**<br>**) tag.

**Add a table to the HTML field**  
This example uses HTML field controls to format a table in a knowledge article.

---

To add the formatted table to a knowledge article:

1. Navigate to **Knowledge > Edit** and select the article to edit.
2. In the HTML field, position the cursor in the location for the table.
3. Click the table icon, click **Insert table**, and then select the number of rows and columns.

4. Complete the following steps to edit the table properties.
   a) Position your cursor in the table, click the table icon, and select **Table properties**.
   b) Enter the following values on the **General** tab.
      - Width: 75%
      - Cell spacing: 3
      - Cell padding: 3
      - Border: 1
      - Alignment: Left
   c) On the **Advanced** tab, click the text field next to **Border color** and enter **Gray**. The color picker box to the right turns gray to indicate the color that you entered. You can also click the box and select the color in the palette.
   d) Click **Ok**.

5. Complete the following steps to update the header table row.
   a) Select the cells in the first table row, click the table icon, and select **Row > Row properties**.
   b) Enter the following values on the **General** tab.
      - Row type: Header
      - Alignment: Center
   c) On the **Advanced tab**, enter **#87cefa** in the text box beside **Background color** to set it to a light blue.
   d) Click **Ok**.

6. To set cell properties, complete the following steps.
   a) Select all table cells in the first column except those cells in the header row, click the table icon, and select **Cell > Cell properties**.
   b) Enter the following values on the **General** tab.
c) Click **Ok**.
d) Repeat these steps for the table cells in the second column.

7. To set the background color of the middle row, complete the following steps.
   a) Position your cursor in the middle table row, click the table icon, and select **Row > Row properties**.
   b) On the **Advanced tab**, enter **Silver** in the text box beside **Background color** to set it to color **#c0c0c0**.
   c) Click **Ok**.

   Repeat this procedure for every other table row.

8. To set column width, complete the following steps.
   a) Click the first column of the table, click the table icon, and select **Cell > Cell properties**.
   b) On the **General tab**, enter **30%** in the **Width** text field.
   c) Click **Ok**.

9. Right-click the form header and click **Save**.
10. Enter data in the table cells and then save the article.

### Embed images in HTML fields

You can use the HTML field image picker to embed images into HTML fields, and to add images to the image library.

**Role required:** the role necessary to update the record that contains the HTML field. For example, any user with a role can create a knowledge article and embed an image in it.

| Note: Administrators and users with the image_admin role manage the image library at System UI > Images. See Storing images in the database. |

1. Open the form that contains the HTML field.
2. Click the position where the image is to appear, or to modify an existing image, click the image.
3. Click the insert/edit image icon (🖼️) on the HTML editor toolbar.
4. In the Insert/Modify image form, enter information in each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select the image type.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Image Library</strong>: Images stored in the db_image table. You can reuse images in the image library in multiple locations.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Attachment</strong>: Available in the current record only</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image</strong></td>
<td>Begin typing a file name and select an image from the list, or click the reference lookup icon and select an image. To upload a new image, click <strong>New</strong>, click <strong>Choose File</strong>, locate the image, and click <strong>Upload</strong>. If you chose the <strong>Attachment</strong> type, click <strong>Choose File</strong>, locate the image, and click <strong>Attach</strong>.</td>
</tr>
<tr>
<td><strong>Tooltip</strong></td>
<td>Enter alternate text that appears when a user points to the image.</td>
</tr>
<tr>
<td><strong>Alt</strong></td>
<td>Enter alternate text that can be used to improve accessibility. For example, it could be used with a screen reader. If this field is left blank, it defaults to the text entered in the <strong>Tooltip</strong> field.</td>
</tr>
</tbody>
</table>

**Note:** To resize an embedded image, click the image. The sizing frame appears. Drag a sizing point until the image is the desired size. Corner points adjust the size proportionally. Depending on your browser, you may need to highlight the image before the sizing frame appears.

5. **Optional:** To provide additional control over the appearance of an image, click **Advanced options**.

**Advanced options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout</strong></td>
<td>Select the image <strong>Alignment</strong> (default is <strong>Baseline</strong>) and enter the <strong>Border thickness</strong>.</td>
</tr>
<tr>
<td><strong>Spacing</strong></td>
<td>Enter the number of <strong>Horizontal</strong> and <strong>Vertical</strong> pixels around the image.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Enter the <strong>Width</strong> and <strong>Height</strong> of the image (in pixels).</td>
</tr>
</tbody>
</table>

6. Click **OK**.

7. **Optional:** Paste an image into the HTML editor. To edit the image, save the entry then select the image. Click the insert/edit image icon and complete the form using the same tables for adding an image.

Pasted images are saved in the system as attachments.

**Link to a website in HTML fields**

You can insert a link to a website in an HTML field.

Role required: the role necessary to update the record that contains the HTML field. For example, any user with a role can create a knowledge article and link to a website in the article text.

1. Move the cursor to the position where the link is to appear.
2. Click the insert/edit link icon (🔗) in the HTML toolbar.
3. Enter information in each field.
**Insert/Edit Link form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Enter the URL for the link. Copying and pasting is usually the easiest method.</td>
</tr>
<tr>
<td>Text</td>
<td>Enter the text you want to display for the link.</td>
</tr>
<tr>
<td>Target</td>
<td>Select the target window for the URL. For files, the <strong>None (use implicit)</strong> selection is generally the best choice. However, if you are linking to a complete web page, choose <strong>New window (_blank)</strong> so the browser opens the link in a new tab or window.</td>
</tr>
</tbody>
</table>

4. Click **OK** to insert the link into the field.

**Embed videos in HTML fields**

You can insert videos into HTML fields. You can also add videos to the video library using the HTML Insert/Modify Video form.

**Role required:** The role necessary to update the record that contains the HTML field. For example, any user with a role can create a knowledge article and embed a video in it.

The following file formats are supported in the base system.

- MPEG-4 video *.mp4*
- WebM Video *.webm*

The larger the file size, the longer it takes to download before the video will start. To reduce file size, you can reduce the bitrate, but doing so reduces the quality of the video. The following bitrates optimize download speed and video quality:

<table>
<thead>
<tr>
<th>Video resolution</th>
<th>Recommended bitrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard definition (480p)</td>
<td>1.5 to 2.5 mbps</td>
</tr>
<tr>
<td>High definition (720p)</td>
<td>3 to 5 mbps</td>
</tr>
<tr>
<td>High definition (1080p)</td>
<td>6 to 8 mbps</td>
</tr>
</tbody>
</table>

Internet Explorer and Safari have difficulty streaming videos uploaded to the database. Attach a file rather than embedding if you intend to use one of these browsers or an unsupported file type. For more information on attaching files, see [Add and manage attachments](#).

**Note:** Administrators and users with the image_admin role can manage the video library at **System UI > Videos**.

1. Open the form that contains the HTML field.
2. Click the position where the video is to appear, or to modify an existing video, click the video.
3. Click the insert/edit video icon on the HTML editor toolbar.
4. Enter information in each field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type  | Select the video type.  
· **Video Library**: List of videos stored in the `db_video` table. May be reused.  
· **URL**: from an external source  
· **Attachment**: available in the current record only  
For an attachment or video library file, select a video from the list or click **New**. For an external URL, enter the URL. |
| Size  | Enter the **Width** and **Height** of the video in pixels. |

5. Click **OK**.

By default, the HTML Sanitizer removes videos from HTML fields. To prevent the video from being removed:

- Add an attribute to the text field on the form that the video is added to:  
  ```javascript
horizontal Sanitize=false. ```  
Adding the attribute stops this HTML field from being sanitized in the future.

- Modify the white list in the script include `HTMLSanitizerConfig` to add the embed, object, and param attributes. The script include allows the attributes to be used in all HTML fields in the future. For example:

```javascript
HTML_WHITELIST :{  
  globalAttributes:{  
    attribute:[],  
    attributeValuePattern:{},  
  },  
  embed:{attribute:  
    ["src","type","allowfullscreen","allowscriptaccess","plugnspage"],  
  object:{attribute:{"classid","codebase"},  
  param:{attribute:{"name","value"}}}  
}
```

- Universally override elements that the TinyMCE strips out by adding a list of elements to the `glide.ui.html.editor.extended_valid_elements` property. For example, add `a[href|target|rel|media|hreflang|type|charset|name|rev|shape|coords|download|id|accesskey|class|dir|lang|style|tabindex|title]` to the `system` property.

**Define video file types for HTML fields**

You can define the types of video files that can be added to HTML fields.

**Role required**: image_admin

Users can add videos to HTML fields. By default, users can add one of the following types of videos to HTML fields: `.mp4`, `.webm`, and `.swf` video file types. You can inactivate video types that you do not want to allow users to add, or add new video types. `.swf` files are only minimally supported. `.mp4` files might be limited by browser type.
Note: By default, the HTML Sanitizer removes videos from HTML fields. To white list video file types see Embed videos in HTML fields

1. Navigate to System UI > Embed Object Types.
2. To deactivate a video type, set the Active field to false.
3. To add an additional video type, click New and complete the form.

Note: If you specify values for the Codebase or Pluginpage fields, which instruct the browser where to get the plugin, point to https pages to avoid warnings from Internet Explorer about unsecure content on the page.

Disable user access to the image library
By default, users can use and upload images to the image library from an HTML field. You can disable access to the image library from HTML fields.

Role required: admin

1. Navigate to System UI > UI Pages.
2. Select html_insert_image_dialog.
3. Locate the following lines of code in the HTML field and comment them out.

   `<j:if test="${jvar_use_dbimage}">
      <j:set var = "jvar_default_insert_image_type" value = "dbimage" />
      <g:ui_select_option text = "${gs.getMessage('Image Library')}" value = "dbimage" selected = "${jvar_default_insert_image_type}" />
   </j:if>`

4. Click Update.

To remove the Upload from URL option in the HTML editor, add a new property named glide.ui.html.image.allow_url and set the Value to false.

Paste content into the HTML editor
Paste content from a desktop application to the HTML editor. Content might not paste the same from every application.

Role required: admin

1. Navigate to an HTML field. For example, the Text field of a Knowledge article.
2. Paste in content from another application.
   Google Chrome and Mozilla Firefox do not support paste using the Paste icon. Use the command/control+V keyboard shortcut instead.
3. From the paste formatting options dialogue, choose to Keep or Remove the text formatting for the pasted content.

The HTML editor has some pasting limitations:
- Pasting images: Pasting images and text from OneNote works in Microsoft browsers. Pasting from OneNote into Chrome or Firefox works but styles and images are not included. You can still select images individually and paste them into the HTML field. Pasting images and text from Microsoft Word into any browser works as expected.
- Pasting tables: Pasting tables into Safari does not always work correctly. Pasting tables into Internet Explorer only works from Excel.

Image field type
Image fields enable you to add images to forms.
Role required: personalize\_form

For example, you can add portraits to the user records in your system. The image type must be .gif, .jpg/.jpeg, or .png.

Image resizing is defined by the CSS. Larger images are resized to 250 pixels. For most browsers, the larger of the height and width measurements is reduced to 250 pixels and the proportion of the image is maintained. For example, an image with a size of 1508 x 663 pixels is resized to 250 x 110 pixels. Some browsers resize both the height and width measurements to 250 pixels, resulting in a square image.

You can add a new image field.

1. Open the desired form.
2. Create a new field with the Type set to Image.
   For instructions, see Add and customize a field in a table.
3. Add the new field to the form and save your customization.
   The form displays the new blank image field.
4. Click Click to add in the image field, select an image to upload, and click OK.
   The selected image is attached to the form and displayed in the image field.

---

**IP address field type**

The IP Address (Validated IPV4, IPV6) (ip\_addr) field type stores valid IPv4 and IPv6 addresses.

**Support for IPv4 and IPv6**

Both dot-decimal and hex notation are supported for IPv4 and IPv6. For IPv6, you can use the double-colon notation to compress zeros. Familiarize yourself with IETF RFC5952 for examples and guidelines on text representation for IPv6 addresses.

The following are examples of valid IP addresses:

- A standard IPv4 address in dot-decimal notation:
  10.34.51.20
- A same IPv4 address in hex notation:
  0x0A223314 or 0A223314
Note: The optional prefix 0x is supported.

- A standard IPv6 address in dot-decimal notation:
  1507:f0d0:1002:0051:0000:0000:0000:0004
- The same IPv6 address above using the double-colon in place of zeros:
  1507:f0d0:1002:51::4

How IP addresses are stored in the database

The IP address `ip_addr` field is a Variable Character (VARCHAR) field with a length of 45 characters. The values are always stored in four-digit groupings in doc-decimal notation for both IPv4 or IPv6 addresses regardless of the notation you use when you input values in the field. For example:

- If you enter an IPv6 IP address in an using double-colons, the value in the database is actually expanded to its full IP address without compression: 1507:f0d0:1002:51::4 is saved in the database as 1507:f0d0:1002:0051:0000:0000:0000:0004
- If you enter an IPv4 address in hex notation, it is saved in the database as the standard dot-decimal notation: 0x0A223314 is saved as 10.34.51.20.

If you run a query on this field type in scripts, make sure to query on the full dot-decimal notation.

Journal field type

There are three types of journal field: `journal`, `journal_list`, and `journal_input`.

<table>
<thead>
<tr>
<th>Journal field types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>journal</code></td>
<td>Allow and store input, and display the combined inputs below the input box. Journal fields display in the activity stream in the form and in the list view.</td>
</tr>
<tr>
<td><code>journal_input</code></td>
<td>Allow and store input, but do not display the combined inputs. Journal input fields only display with the record they are associated with, so they do not display in the activity stream on the list view.</td>
</tr>
<tr>
<td><code>journal_list</code></td>
<td>Do not allow or store input; they merely display the contents of other Journal fields upon which the journal_list field is dependent. If a journal_list field is dependent on more than one Journal field, it will chronologically interweave those fields’ inputs. The journal_list field does not display content within the activity stream, but rather in a separate block.</td>
</tr>
</tbody>
</table>
The example image contains the three available journal field types. The first is a journal field, with its inputs displayed below the field. The second is a journal input field, which does not show its previous inputs. The third is Journal list field, which is configured to show the input from the journal input field above it.

Journal fields examples on a form

Restricting journal entries sent in a notification

Administrators can control the number of journal entries notifications include with the following system property.
<table>
<thead>
<tr>
<th>Property</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.email.journal.lines | Number of journal entries (Additional comments, Work notes, etc.) included in email notifications (-1 means all). | Specifies the number of entries from a journal field (such as Additional comments and Work notes) included in email notifications. A value of -1 includes all journal entries.  
- Type: integer  
- Default value: 3  
- Location: System Properties > Email |

**Code for getting the contents of a journal field into an array**

To put the contents of a journal field into an array so that you can iterate through each entry, you can use the code in this page.

```javascript
var notes = current.work_notes.getJournalEntry(-1);  // gets all journal entries as a string where each entry is delimited by '\n \n'
var na = notes.split("\n\n");

// stores each entry into an array of strings
for (var i = 0; i < na.length; i++)
gs.print(na[i]);
```

**Journal field script values**

The setValue() method is not supported for journal fields. Instead, assign values in script as in the following example.

```javascript
var gr = new GlideRecord('incident');

// query priority 1 incidents in the state of either 'new' or 'active'.
gr.addQuery('priority', 1);
var gc = gr.addQuery('state', 1);

gc.addOrCondition('state', 2);
gr.query();
while(gr.next())
{

// print a list of the incident numbers updated
gs.print(gr.number);

// add an entry to the 'work notes' journal field for each incident
gr.work_notes = "This is a high-priority incident. Please prioritize.";
gr.update();
}
```

**Render journal field entries as HTML**

Journal fields can render text enclosed within code tags as HTML.  
- Role required: any role that grants write access to a journal field
• System property: the High Security Setting glide.ui.security.allow_codetag is set to the default value of true

By default, a High Security Setting escapes any HTML code you type in a journal field by replacing it with its equivalent HTML entity value. Escaping causes the system to display HTML code as text rather than forwarding it to the browser as rendering instructions.

1. Enter [code][/code] tags around any code you want to render as HTML.

   **Note:** A single journal entry can contain multiple code tags as long as each code tag has a beginning and ending tag.

For example, enter these lines:

<table>
<thead>
<tr>
<th>Code entered</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>[code]&lt;b&gt;This text will be bold.&lt;/b&gt;[/code]</td>
<td>The system renders the sentence in bold.</td>
</tr>
<tr>
<td>&lt;b&gt;This text will not be bold.&lt;/b&gt;[/b]</td>
<td>The system escapes the bold tags and renders them as text.</td>
</tr>
<tr>
<td>[code]&lt;script&gt;gs.info(gs.getUserDisplayName());&lt;/script&gt;[/code]</td>
<td>The system escapes the content of the script tag.</td>
</tr>
</tbody>
</table>

   **Note:** By default, the HTML Sanitizer prevents the entry of <script> elements.

For more examples of HTML formatting options, see the blog post [Formatting within Journal fields using HTML & (code)](http://service-now.com) by a ServiceNow Technical Support Engineer in the ServiceNow Community.

2. Click Post.

   **Note:** You cannot edit previous journal entries.

The system renders the text within code tags as HTML.

**Restrict the CODE tag in journal fields**

You can prevent journal fields from rendering HTML code by disabling support for the [code] tag.

Role required: admin

1. Navigate to System Properties > UI Properties.
2. Clear the check box for Allow support for embedding HTML code by using the (code) tag (the glide.ui.security.allow_codetag property = false).
3. Click Save.

**Validate HTML in journal fields**

You can prevent users from saving invalid HTML in a journal field.
Role required: admin

1. Add the property `glide.ui.allow_deep_html_validation`. For instructions, see Add a system property.
2. Set the Value to true (it is false by default).
3. Click Save.

Users now see a warning in the activity formatter when they enter invalid HTML code in a journal field.

### Journal field display limits

Journal fields can greatly increase the size of task records because they allow users to enter very large string values.

Display limits prevent the instance from loading the entire journal field into memory. Administrators have the option to:

- Set the length at which journal fields stop displaying the entire field's contents and instead only display a portion (called a preview) of the field's contents. Users can still access the field's entire contents by clicking a Show All button.
- Set the size of the preview text the journal field displays.
- Set the maximum number of journal entries journal fields can display.

**Note:** In UI16, journal fields and the activity formatter must be in the same form section. You cannot place another field in between a journal field and the activities formatter. The Activity Stream is built to keep journal fields stacked on top of the activity formatter.

### Set the maximum display size for journal fields

You can set the maximum display size for journal fields by adding a system property.

Role required: admin

When a journal field exceeds the length set in this property, the instance shows a preview of the journal field instead of the field's entire contents. The preview includes a Show All button to display the rest of the field's contents. A separate property determines the number of characters the preview displays.

1. **Add a system property** with the following settings.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.max_journal_list_size</td>
</tr>
<tr>
<td>Description</td>
<td>Size in megabytes when a journal field should display a preview rather than the field's entire contents.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
</tbody>
</table>
2. Click **Submit**.

*Set the journal preview size*

When a journal field exceeds the size of the `glide.max_journal_list_size` property, the instance displays a preview rather than the field’s entire contents.

Role required: admin

To specify the amount of text to display as a preview, set the following system property. Users can click the **Show All** button to see the rest of the field’s contents.

- Add a system property with the following settings. For instructions, see [Add a system property](#).

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.shortened_journal_length</td>
</tr>
<tr>
<td>Description</td>
<td>Number of characters to display as a preview of journal fields.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
<tr>
<td>Value</td>
<td>512000</td>
</tr>
</tbody>
</table>

*Set the maximum number of journal entries*

To set the maximum number of entries the system shows in the activity formatter, edit the following system property. The activity formatter displays the entries starting with the most recent entry up to the maximum number.

Role required: admin

1. Enter `sys_properties.list` in the navigation filter.
2. Search for the property `glide.history.max_entries`.
3. Edit the **Value** of the property.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.history.max_entries</td>
</tr>
<tr>
<td>Description</td>
<td>Maximum number of entries the system shows in the activity formatter. The default is 250.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
<tr>
<td>Value</td>
<td>250</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Enable the text field character counter**

By default, multi-line text fields have a 4000 character limit. To help users see how many characters remain before they reach the limit, you can enable the `glide.ui.textarea.character_counter` property.

Role required: admin
This property adds a counter under text fields, such as the *Additional Comments* and *Work notes* fields. The counter is dynamically updated as users enter text.

1. Navigate to **System Properties > UI Properties**.
2. Select the check box next to **Character counter for textarea (journal and multi line text fields)**.
3. Click **Save**.

---

**Disable or enable spell checking on a journal field**

Spell checking is turned on by default on most input fields, except for single-line input fields. The spell checker highlights misspelled words.

*Role required: personalize_dictionary*

To enable the spell checking dictionary, install the appropriate language plugin. Localization plugins have the same name format, such as I18: German Translations.

The dictionaries available for spell checking include the following languages:

- Brazilian Portuguese
- Czech
- Dutch
- English US
- English UK
- Estonian
- Finnish
- French
- German
- Hebrew
- Hungarian
- Italian
- Polish
- Portuguese
- Russian
- Spanish
- Thai
Note: The words in the dictionary are part of the language plugin. You cannot add, remove, or modify the dictionary.

You can select a dictionary to use for a language that does not have a spell checker dictionary by navigating to **System Properties > System Localization**.

1. Navigate to **System Definition > Dictionary**.
2. Filter the list to view **journal** type fields and select a field to spell check.
   
   An example is the **comments** field in the Task table. This applies spell checking in the specified language to the multi-line **Comments** text box for incidents, problems, and changes.

3. Click the table name to open the Dictionary form.
4. Configure the form and add the **Spell check** check box.
5. Clear the check box to disable spell checking in every **Comments** field on the Task table.

**Name-value pairs field type**

You can access the values stored in a name-value pairs field in scripts using the name.

**Sample script**

The following example demonstrates how to add mappings to a name-value pairs field, and how to query existing values using the name.

```javascript
// Script example demonstrating setting and getting values
var gr = new GlideRecord('u_nv_table');
gr.initialize();

gr.nv_field.name1 = "value1"; //add a name-value Pair mapping with the name "name1" and value "value1"
gr.nv_field.name2 = "value2"; //add another name-value Pair mapping with the name "name2" and value "value2"

// Access by dot notation
gs.print("name1 = " + gr.nv_field.name1); // Expected output: name1 = value1

// Iterate over each property and print name and value
for(var name in gr.nv_field) {
  gs.print(name + " = " + gr.nv_field[name]);
}
```
Percent complete field type

Administrators can create percent complete fields, which accept decimal input and appear as progress bars when displayed in lists.

For example, use a percent complete field to set the completion percentage for a task or project in a form and then see that percentage displayed as a progress bar in a list.

Administrators can also configure views that compare actual progress with a target value to determine if goals are being met and then apply color to provide visual alerts where progress does not meet expectations.

Form view of a percent complete field

List view of a percent complete field

Target threshold colors attribute

If the target_field attribute is configured, a second attribute called target_threshold_colors enables an administrator to define additional parameters.

The parameters are:

- Different thresholds at which the colored bar should change color
- A specific color for each threshold

The format of this attribute's value is number1:color1;number2:color2 and so on. Use this attribute to apply warning colors to completion percentages that are lower than target percentages. These values are defined as the percentage of target accomplished. For example, a value of 0:red;50:yellow;90:green displays a red bar if the progress to target percentage is between 0-49. If the percent of target is between 50 and 89, the color is yellow. Percent of target 90 and above displays in green. Completion percentages that exceed target percentages also display in green. Order the color attributes from the smallest percentage to the largest.

If you do not specify a target_field, then a target of 100 is used, allowing you to use the color thresholds with a single field value.

The following table lists examples of percent of target calculation using the colors defined above.
### Target threshold colors attribute

<table>
<thead>
<tr>
<th>Target percent</th>
<th>Percent field value</th>
<th>Percent of target calculation</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>40</td>
<td>40%</td>
<td>tomato</td>
</tr>
<tr>
<td>65</td>
<td>59</td>
<td>90.7%</td>
<td>lightgreen</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>66.7%</td>
<td>khaki</td>
</tr>
</tbody>
</table>

### Percent complete color example

**Add a target field attribute**

Add an optional attribute (target_field) to a percent complete field to compare the actual completion percentage of a task or project with a target percentage in a different decimal field that specifies where the task should be at this point.

**Role required:** personalize_dictionary

If a target field is not specified, the target of 100 is assumed.

1. Right-click the % Complete field in a form.
2. Select **Configure Dictionary** from the pop-up menu.
3. In the Dictionary Entry form, add the following attribute:
   ```plaintext
   target_field=percent_complete_target
   ```
4. Update the dictionary record.

In the list, a gray bar appears behind the colored bar to indicate the target value. The gray target bar appears only if you defined a target field.
**Phone number field type**

The E.164 phone number standard ensures that all necessary information for a phone number is included and properly formatted to successfully route an international call over a territory’s public telephone network.

When a user enters a phone number, it is received and stored as a string of numbers. An E.164 phone number field automatically formats and validates the numbers so that they are E.164-compliant when displayed as local and international numbers. The E.164 phone number field type does not replace the phone field type.

An E.164 phone number field displays:

- (Optional) A choice list for the phone number territory.
- (Always) An input box for entering phone numbers.
- (By Default) A red underline when a phone number does not match the format for the selected phone territory and cannot be saved.
- (Optional) A green underline when a phone number does not match the format for the selected phone territory but can be saved with **Other / Unknown** as the territory.

---

**Territories assigned**

Territories are assigned to locations, and are not assigned directly to users.

A user’s territory, and so the user’s E.164-compliant phone functionality, is based on the user’s location. For example, if a user has a location of **SHS quadra 5, Bloco E., Brasilia** defined in the User (sys_user) table, the parent record for Brazil in the location table defines the phone territory. The phone territory may be assigned at any level of the **location** hierarchy, which is searched going up to the next parent until the territory is found or no parents remain.

---

**Dependent fields**

In the dictionary, you can specify a dependent field in the **User** or **Location** field, which displays the appropriate territory in the selector choice list when a user enters a phone number.

In the dictionary, you can specify a dependent field in the **User** or **Location** field, which displays the appropriate territory in the selector choice list when a user enters a phone number. For example, if you enter **caller_id** in the dependent field in the Incident table, the appropriate territory is added to the territory selector choice list when a user enters caller information.

---

**E.164 phone number field configuration**

Administrators can use the phone number system properties and dictionary attributes to do certain things.

The system properties apply the configuration option to all phone number fields that do not have a comparable dictionary attribute. The dictionary attributes apply the configuration only to the phone number field it is added to. Since dictionary attributes take precedence over system properties, administrators can set a global configuration with a property and then apply exceptions on a field-by-field basis.

*Requiring territory format validation*

By default, phone number fields require that a phone number match the display format of the selected territory.
By default, phone number fields require that a phone number match the display format of the selected territory. If a phone number does not match this format, the input box displays a red line underneath the phone number and users are prevented from saving it.

**Phone e164 strict**

Setting the `glide.phone_number_e164.strict` system property to `false` or adding the `pn_strict` dictionary attribute allows the phone number input box to display a green line underneath numbers that do not match the territory format listed for the selected territory. In this case, a user can save a phone number in an invalid format, but the field continues to display a warning until the phone number matches the format required by the territory. You can use the **Other / Unknown** territory to store otherwise invalid phone numbers.

**Warning:** Switching from optional territory format validation to required territory format validation may result in some phone numbers failing validation altogether. In such cases, the E.164 phone number field displays an error message.

**Requiring entry of international format**

By default, users can enter phone numbers in their territory’s local format and do not have to format the number for international dialing.

The phone number field automatically formats local phone numbers into E.164-compliant international phone numbers when the user finishes editing the field. As long as the phone number entered matches the territory’s format for a local number, users can save the phone number.

**Phone e164 entry local**

Changing the `glide.phone_number_e164.allow_national_entry` system property or adding the `pn_allow_national_entry` dictionary attribute requires users to enter a phone number in the territory’s international format, which starts with the plus (+) character. Users cannot save a locally formatted phone number, and the phone number input box displays a red line underneath phone numbers without the proper international formatting.

**Configure the display of the local format**

By default, an E.164 phone number field always displays phone numbers in an international format.
Change the E.164 phone number to use the local format in certain circumstances by adding the following system property:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.phone_number_e164.display_national | Type: string  
Default value: false  
Other possible values:  
  - true or form: displays phone numbers in a local format on forms, but displays an international format on lists.  
  - all: always displays phone numbers in a local format.  
  - user: only displays phone numbers in a local format when the phone number matches the local setting of the current user.  
  - false: does not display phone numbers in local format. |

Select one of the possible values to determine how the system handles the E.164 phone number. You can also add the following dictionary attribute to a specific field to override the system property:

<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| pn_display_national  | Overrides the glide.phone_number_e164.display_national property setting for how an E.164 phone number field displays phone numbers. Available values are identical to those described for the glide.phone_number_e164.display_national property.  
  - Type: string  
  - Default value: false  
  - Example: pn_display_national=all |

Configure the phone territory selector choice list
By default, an E.164 phone number field always displays the phone territory associated with the phone number.
Changing the system property or adding the dictionary attribute hides the territory selector choice list. If the territory selector choice list is hidden, users can only enter a local or national number.
Add the following system property to show or hide the territory selector choice list.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.phone_number_e164.display_territory_selector</td>
<td>Determines whether to display the territory selector choice list. Hiding the territory selector choice list restricts users to entering only local or national phone numbers.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

You can also add the following dictionary attribute to a specific field to override the system property:

<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pn_display_territory_selector</td>
<td>Overrides the glide.phone_number_e164.display_territory_selector property setting that determines whether to display the territory selector choice list. Available values are identical to those described above for the glide.phone_number_e164.display_territory_selector property.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Example: pn_display_territory_selector=false</td>
</tr>
</tbody>
</table>

Configure the display of territory labels
A property controls how territory labels are displayed.

You can display territory labels to the right of the number in an E.164 phone number field by setting the system property or adding the dictionary attribute. This is useful if the territory selector choice list is turned off and you want the user to see the territory for the entered phone number.

+44 (0)1733 753363 United Kingdom

E164 phone display territory labels

Enabling territory labels also displays the phone territory in lists.

Add the following system property to display the territory label to the right of the number in an E.164 phone number.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.phone_number_e164.display_territory_text</td>
<td>Determines when an E.164 phone number field displays a territory label.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: read-only</td>
</tr>
<tr>
<td></td>
<td>• Other possible values:</td>
</tr>
<tr>
<td></td>
<td>• all: always displays the territory label.</td>
</tr>
<tr>
<td></td>
<td>• national: displays the territory label only if the phone number is in local format.</td>
</tr>
</tbody>
</table>
You can also **add the following dictionary attribute** to a specific field to override the system property:

<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pn_display_territory_text</td>
<td>Overrides the glide.phone_number_e164.display_territory_text property that defines when a phone number field displays a territory label. Available values are identical to those described above for the glide.phone_number_e164.display_territory_text property.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: read-only</td>
</tr>
<tr>
<td></td>
<td>- Example: pn_display_territory_text=all</td>
</tr>
</tbody>
</table>

**Configure the international direct dialing prefixes**

A property is available to control the display of prefixes.

You can enable the display of the international direct dialing prefix, which appears between the territory selector choice list and the input box for an E.164 phone number field on forms, by setting the system property or adding the dictionary attribute.

![E164 phone display idd](image)

**Add the following system property** to display the international direct dialing prefix.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.phone_number_e164.display_users_idd</td>
<td>Determines whether to display the international direct dialing prefix between the territory selector choice list and the input box on forms.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
</tbody>
</table>

You can also **add the following dictionary attribute** to a specific field to override the system property:
<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pn_display_users_idd</td>
<td>Overrides the glide.phone_number_e164.display_users_idd property that determines whether to display the international direct dialing prefix between the territory selector choice list and the input box on forms. Available values are identical to those described above for the glide.phone_number_e164.display_users_idd property.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Example: pn_display_users_idd=false</td>
</tr>
</tbody>
</table>

**E.164 phone number field system properties**

Several properties are available to configure E.164 phone number fields.

**Note:** To open the System Properties (sys_properties) table, enter `sys_properties.list` in the navigation filter.

### e.164 phone number field system properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.phone_number_e164.strict</td>
<td>Determines whether all phone number fields must match the display format for the selected territory. When the value is true, the phone number input box displays a red line underneath phone numbers that do not match the format for the selected territory. Users cannot save the phone number. When the value is false, the phone number input box displays a green line underneath phone numbers that do not match the format for the selected territory. Users can save the phone number. The territory selector choice list offers the option to select an Other / Unknown territory format.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Properties (sys_properties) table.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.phone_number_e164.allow_national_entry</td>
<td>Determines whether users can enter phone numbers in the local format or whether they must enter phone numbers in international format. When <code>true</code>, users can enter phone numbers in the local format for the selected territory. When <code>false</code>, users must enter phone numbers in the international format for the selected territory.</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_national</td>
<td>Determines whether to display E.164 phone numbers in local format.</td>
</tr>
<tr>
<td>glide.phone_number_e164.display_territory_selector</td>
<td>Determines whether to display the territory selector choice list. Hiding the territory selector choice list restricts users to entering only local or national phone numbers.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| glide.phone_number_e164.display_territory_text | Determines when an E.164 phone number field displays a territory label.  
- **Type**: string  
- **Default value**: read-only  
- **Other possible values**:  
  - **all**: always displays the territory label.  
  - **national**: displays the territory label only if the phone number is in local format.  
  - **read-only**: displays the territory label in read-only mode, regardless of whether the number is in local or international format.  
  - **read-only-national**: displays the territory label in read-only mode only if the number is in local format.  
  - **list**: displays the territory label in a list.  
  - **list-national**: displays the territory label in a list if the number is in national format.  
  - **none**: does not display the territory label.  
- **Location**: Add to the System Properties (sys_properties) table. |
| glide.phone_number_e164.display_users_idd | Determines whether to display the international direct dialing prefix between the territory selector choice list and the input box on forms.  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Add to the System Properties (sys_properties) table. |

**E.164 phone number field dictionary attributes**  
You can override the global system property with certain dictionary attributes.

**e.164 phone number field dictionary attributes**

<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| pn_strict            | Overrides the glide.phone_number_e164.strict property setting that requires all phone number entries match the format for the selected territory. Available values are identical to those described for the glide.phone_number_e164.strict property.  
- **Type**: true | false  
- **Default value**: true  
- **Example**: pn_strict=false |
<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pn_allow_national_entry</td>
<td>Overrides the <code>glide.phone_number_e164.allow_national_entry</code> property setting that determines whether users can enter phone numbers in the local format or whether they must enter phone numbers in international format. Available values are identical to those described for the <code>glide.phone_number_e164.allow_national_entry</code> property.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Example: <code>pn_allow_national_entry=false</code></td>
</tr>
<tr>
<td>pn_display_national</td>
<td>Overrides the <code>glide.phone_number_e164.display_national</code> property setting for how an E.164 phone number field displays phone numbers. Available values are identical to those described for the <code>glide.phone_number_e164.display_national</code> property.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: false</td>
</tr>
<tr>
<td></td>
<td>· Example: <code>pn_display_national=all</code></td>
</tr>
<tr>
<td>pn_display_territory_selector</td>
<td>Overrides the <code>glide.phone_number_e164.display_territory_selector</code> property setting that determines whether to display the territory selector choice list. Available values are identical to those described for the <code>glide.phone_number_e164.display_territory_selector</code> property.</td>
</tr>
<tr>
<td></td>
<td>· Type: true</td>
</tr>
<tr>
<td></td>
<td>· Default value: true</td>
</tr>
<tr>
<td></td>
<td>· Example: <code>pn_display_territory_selector=false</code></td>
</tr>
<tr>
<td>pn_display_territory_text</td>
<td>Overrides the <code>glide.phone_number_e164.display_territory_text</code> property that defines when a phone number field displays a territory label. Available values are identical to those described for the <code>glide.phone_number_e164.display_territory_text</code> property.</td>
</tr>
<tr>
<td></td>
<td>· Type: string</td>
</tr>
<tr>
<td></td>
<td>· Default value: read-only</td>
</tr>
<tr>
<td></td>
<td>· Example: <code>pn_display_territory_text=all</code></td>
</tr>
</tbody>
</table>
### Dictionary attribute

<table>
<thead>
<tr>
<th>Dictionary attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| pn_display_users_idd | Overrides the glide.phone_number_e164.display_users_idd property that determines whether to display the international direct dialing prefix between the territory selector choice list and the input box on forms. Available values are identical to those described for the glide.phone_number_e164.display_users_idd property.  
  - Type: true | false  
  - Default value: false  
  - Example: pn_display_users_idd=false |

### Configure a territory phone display rule

The string of numbers that make up a phone number is automatically validated and formatted for a specific territory by applying a series of regular expressions.

Role required: admin

The number is first validated against the phone validations that have been defined for the territory, and in the order specified by the Order field. To be valid, the number must match the regular expression defined in the Condition field for at least one phone validation.

After a number has been validated, the Condition expression for each format defined for the territory is applied to the number in the order determined by the Order fields. The Pattern and Format regular expressions are applied to produce a phone number that is formatted correctly for the territory.

The Sys Phone Territory screen allows administrators to edit the display rules for a given territory. Administrators may want to modify the Active, Display, or Order fields. To edit the display rules for a territory:

2. Click a territory Name.
3. Edit the fields, as appropriate (see table).
4. Click Update.
## Territory phone display rules

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the territory.</td>
</tr>
<tr>
<td>Country calling code</td>
<td>The <em>country code</em> for dialing numbers from outside the territory.</td>
</tr>
<tr>
<td>International direct dial</td>
<td>The prefix for calling internationally from the territory, such as 00 or 001.</td>
</tr>
<tr>
<td>STD</td>
<td>The subscriber trunk dialing code, also known as the direct distance dialing code, which is a sequence of numbers before the telephone number that indicate whether the call is to be routed outside of the local calling area.</td>
</tr>
<tr>
<td>International prefix</td>
<td>The prefix required to dial an international call, such as a plus sign (+).</td>
</tr>
<tr>
<td>National prefix</td>
<td>The prefix required to dial a local call.</td>
</tr>
<tr>
<td>Active</td>
<td>An indicator for whether the territory phone definition is active. If deactivated, this territory unavailable to users.</td>
</tr>
<tr>
<td>Trunk dialing code optional</td>
<td>An indicator for whether the STD code is optional.</td>
</tr>
<tr>
<td>STD follows country</td>
<td>An indicator for whether the STD code should be displayed to the right of the country calling code.</td>
</tr>
<tr>
<td>Display</td>
<td>An indicator for whether to display the territory in the choice list. Clearing this check box removes the territory from the choice list. If an international number is entered for a territory that is not displayed in the territory selector choice list, that territory is temporarily added to the selector choice list for that field only. For example, if the United Kingdom Display field is not selected, the United Kingdom does not appear in the territory selector choice list. However, if the user enters an international number beginning with +44, the United Kingdom is added to the list and the number is formatted and validated accordingly.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which a territory appears in a choice list. Territories are sorted numerically by the number assigned here. If more than one territory is assigned the same number, they are subsorted alphabetically. All territories are assigned a default value of 100. To display a territory at the top of the list, assign a value that is less than 100. To display a territory at the end of the list, assign a value that is greater than 100. For example, if a territory is assigned an order of 500, it is displayed at the end of the list, and if more than one territory is assigned an order of 500, they are listed alphabetically at the end of the list.</td>
</tr>
</tbody>
</table>

**Phone validations**

Phone validations are already configured for all territories and are automatically applied to the phone number to ensure that the number is valid for the territory.

**E164 phone validations**

**Phone formats**

Phone formats are already configured for all territories and are automatically applied to the phone number to ensure that the number is valid for the territory.
E164 phone formats

Reference field type

A reference field stores a reference to a field on another table. For example, the Caller field on the Incident table is a reference to the User (sys_user) table.

When you define a reference field, the system creates a relationship between the two tables. Adding a reference field to a form makes the other fields in the referenced table available to the form.

**Note:** A reference field can refer only to records from one other table. To add a field that can refer to records on any table, use the Document ID element type.

Administrators can create new reference fields and configure several options for reference fields.

### Reference field options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display values</td>
<td>Each reference field stores a sys_id for each referenced record in the database, but the sys_id is not shown. The reference field shows the specified display value.</td>
</tr>
<tr>
<td>Decorations</td>
<td>A reference decoration is an icon that appears next to a reference field.</td>
</tr>
<tr>
<td>Reference styles</td>
<td>Reference styles are specialized field styles that control the appearance of reference fields.</td>
</tr>
<tr>
<td>Reference qualifiers</td>
<td>Reference qualifiers restrict the records that are available for reference fields.</td>
</tr>
<tr>
<td>Cascade delete rules</td>
<td>Cascade delete rules specify what should happen to records that reference a record that is deleted.</td>
</tr>
<tr>
<td>Auto-complete</td>
<td>By default, a reference field auto-completes as the user types in the field. Administrators can configure auto-complete settings.</td>
</tr>
<tr>
<td>Reference key</td>
<td>A reference key saves a field other than sys_id as the unique identifier for a reference field.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable dynamic creation</td>
<td>When dynamic creation is enabled, entering a nonexistent value in a reference field creates a new record on the referenced table instead of returning an error.</td>
</tr>
</tbody>
</table>

Add a reference field

Add reference fields to a table using the same method as for any other field.

Role required: personalize_form

The related table also appears in the Available Tables list for future form customizations.

1. Open the desired form.
2. Right-click the header and select Configure > Form Layout.
3. Use dot-walking to locate and select the field in the referenced table that you want to add. It appears as Table name.Field. For example, the caller’s email address appears as Caller.Email.
4. Click Save.

Enable dynamic creation for reference fields

When dynamic creation is enabled, entering a nonexistent value in a reference field creates a new record on the referenced table instead of returning an error.

Role required: personalize_dictionary

By default, a user must enter a value in a reference field that matches an existing record in the table that the reference field refers to. For example, the Caller field in an Incident must have a value that is an existing user. You can enable dynamic creation to create a new record on the referenced table when a user enter a nonexistent value in a reference field instead of returning an error.

1. Right-click the field label in the form and select Configure Dictionary.
2. Populate the following fields (you may need to configure the Dictionary form):
   - dynamic_creation: Select the check box.
   - dynamic_creation_script: Enter a script that dynamically creates the record.
3. Click Update.

Examples:

You could use the following dynamic_creation_script to create a record on the referenced table.

```javascript
current.name = value;
current.insert();
```

Note: The parent object can be used to access anything from the parent record.

You could create a script include named MyUserReferenceCreator with the following contents:

```javascript
var MyUserReferenceCreator = Class.create();
MyUserReferenceCreator.prototype = {
  initialize: function() {
  },
  create: function(current, value) {
```
When the script include is created, the following `dynamic_creation_script` generates a new location for an invalid reference field value:

```
new MyUserReferenceCreator().create(current, value);
```

**Configure cascade delete rules**

When a record is deleted, there are different options for how the deletion will affect records that reference the deleted record. You can configure what happens to records that reference a record when that record is deleted.

**Role required:** personalize_dictionary

For example, if you delete a user record that is referenced in the **Caller ID** field on several incident records, you can configure what happens to those incident records. By default, the references are cleared, so the incident records are maintained with an empty **Caller ID** field.

1. Navigate to a reference field on a form.
2. Right-click the field label and select **Configure Dictionary**.
3. Under **Related Links**, click **Advanced view**.
5. In the **Reference cascade rule** field, select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear or -- None --</td>
<td>Deleting a record clears references (default option).</td>
</tr>
<tr>
<td>Delete or Cascade</td>
<td>Deleting a record also deletes all referencing records. For example, when a user record is deleted, any incidents assigned to the user are also deleted.</td>
</tr>
<tr>
<td>Restrict</td>
<td>Deleting a record is restricted unless there are no references to the record. For example, prevent the user record from being deleted if any incident includes a reference to the user.</td>
</tr>
<tr>
<td>None</td>
<td>Deleting a record does not change records that reference the record.</td>
</tr>
</tbody>
</table>

**Caution:** Use this method with caution.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear or -- None --</td>
<td>Deleting a record clears references (default option).</td>
</tr>
</tbody>
</table>

6. **Click** **Update**.

**Define the reference key**

By default, reference fields store the `sys_id` of the record in the database.

**Role required:** personalize_dictionary
By defining a reference key, you can identify a field other than sys_id to use as the unique identifier for the reference field. The value of the reference key field, instead of the sys_id, is stored in the database for that reference field.

1. Navigate to **System Definition > Dictionary**.
2. Open the field record (for example, resolved_by on the Incident table).
3. In the Reference key field, enter a field name on the referenced table (for example, email on the sys_user table).

   **Note:** Always choose a field from the referenced table that is both required and unique.

4. Click **Update**.

---

**Display a reference field as a choice list**

You can display a reference field as a choice list instead of opening a lookup window.

Role required: personalize_dictionary

1. In the form, right-click the label for the reference field and select **Configure Dictionary**.
2. In the Choice List Specification section, select one of the following options in the Choice field.
   - Dropdown with --None--
   - Dropdown without --None--
3. Right-click the form header and click **Save**.
4. Under **Related Links**, click **Advanced view**.
5. In the Attributes field, add the following attribute, separated from other attributes by a comma.

   ```
   ref_auto_completer=AJAXReferenceChoice
   ```

6. Click **Update**.

   The form reopens, with the reference field as a choice list.
Note:

The `glide.ui.max_ref_dropdown` system property determines whether a reference field is displayed as a choice list or a reference icon. When the number of available choices exceeds the value of this property, a reference icon displays instead of a choice list. The default value of this property is 25. This property affects the entire instance, however you can override this property on an individual field by using the `max_ref_dropdown` dictionary attribute. Modifying dictionary attributes requires the `personalize_dictionary` role.

The `glide.xmlhttp.max_choices` system property determines how many choices display on a choice list. This property has a value of 15 by default, however, when the property is not present on the instance, the instance uses a hard coded value of 10.

Display values

Reference fields store a sys_id for each referenced record in the database, but the sys_id is not shown.

The reference field shows the display value. For example, an incident's `Assigned to` field stores the sys_id of a particular user, but actually displays the user's name. The following example shows how Charlie Witherspoon, which is the display value of a user record, is shown in the `Assigned to` field.
Display value xml

<table>
<thead>
<tr>
<th>Reference field</th>
<th>Value stored in database</th>
<th>Display value field of source table</th>
<th>Value displayed in UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>46b87022a9fe198101a78787e40d7547</td>
<td>sys_user.name</td>
<td>Charlie Whitherspoon</td>
</tr>
</tbody>
</table>

Reference fields show display values in:

- Lists
- Forms
- Reports
- Auto-complete suggestions
- Slushbuckets

Select a field as the table display value

Only one field can be defined as the display value for a table.

Role required: personalize_dictionary

When you set the **Display** value to **true**, a business rule sets the **Display** value to **false** for all other fields on the table. In previous versions, you must manually ensure that no other fields on the table have a value of **true** in the **Display** column.

**Note:** Extended tables inherit the display value of the parent table. Setting a separate display value for the extended table overrides the parent table's display value.

1. Navigate to **System Definition > Dictionary**.
2. Filter on (Table) (is) (<name of the referenced table>).
3. Locate the desired field and set **Display** to **true**.

For best results, choose a field that is required and unique in each record as the display value field.
Note: If you make a field the display field for a table, be sure to translate all values for the field in the Translated Text (sys_translated_text) table into all the languages provided. Display field options left untranslated are not presented by the autocomplete (type ahead) feature.

Reference fields look for the display value in the following order:

1. A field with display=true in the system dictionary on the lowest sub-table for extended tables.
2. A field with display=true in the system dictionary on the parent table.
3. A field named name or u_name.
4. The Created on field of the referenced record.

Decorations

Reference decorations are icons which appear next to the reference field.

The reference lookup is always visible and is used to select a record to reference. Other reference decorations appear when a record is selected.

Reference lookup

On forms, the reference lookup icon (🔍 in UI16/UI15) appears by editable reference fields. Clicking the reference lookup icon displays a list of records on the referenced table.

When List v3 is enabled, the list appears in a popover. Otherwise, the list appears in a pop-up window.
Reference lookup list popover
UI15 reference lookup list pop-up
Tree picker lookup
The reference lookup can be rendered in the tree picker format by modifying the dictionary and adding the attribute `tree_picker`.

You cannot customize the label names used in the tree picker. The label names are taken from the values in the table.

Reference field icon
On forms, the reference icon (in UI16/UI15, in UI11) appears by populated reference fields. Pointing to the icon opens a read-only preview of the referenced record.
Referenced record preview on a form

The preview closes when you move the cursor unless you hold the Shift key (or the Alt key on some UK keyboards) while moving the cursor.

Clicking the reference icon prompts you to save or discard your changes, then navigates to the referenced record.

**Note:** The reference icon behaves differently in lists. For more information, see [List fields](#).

If List v3 is enabled on your instance, click the icon to open a preview. The preview stays open until you click somewhere else on the screen. The preview contains a button to open the record.

Configure the reference icon view of fields
Use a table’s sys_popup form view to configure the fields in the pop-up form that appear when pointing to a reference icon. If the table has no sys_popup view, the pop-up uses the default view.

Role required: personalize_form

1. To configure a reference field popup form for a table using the default sys_popup view, navigate to the following URL format, substituting the instance name and table name:

   `<your instance name>.service-now.com/<table name>.do?sysparm_view=sys_popup`

   **Note:** This URL format only shows a table and default sys_popup view. It does not work for records that use a different view.

   An example of an instance for Acme, the sys_user table, and the sys_popup default view:

   `acme.service-now.com/sys_user.do?sysparm_view=sys_popup`

2. Optional: To configure a reference field popup form for a table using a non-default sys_popup view, navigate to the following URL format, substituting the instance name, table name, and name of view:

   `<your instance name>.service-now.com/<table name>.do?sysparm_view=sys_popup,<name_of_view>`

   An example of an instance for Acme, the sys_user table, and the sys_popup ESS view:

   `acme.service-now.com/sys_user.do?sysparm_view=sys_popup,ess`

3. Configure the form to add or remove fields as appropriate.

Configure the pop-up delay for a reference icon

When you point to the reference icon in a form or a v2 list, the reference pop-up appears after a configurable period of time.

Role required: admin

The default delay is 100 milliseconds (ms). You can configure a different value.

   **Note:** The following procedure does not apply to reference icons in List v3. In v3 lists, reference pop-ups appear only when you click the reference icon.

1. Navigate to **System Properties > UI Properties**.
2. Modify the property called **Record popup delay (milliseconds): (glide.ui.popup.delay)**.

   The property controls when the request for the pop-up is made; the actual display time depends on the browser.

   **Note:** Setting the value extremely low can lead to unwanted pop-ups being requested from the server. Additionally, a low setting can make it difficult to drill through the reference icon because the icon is not clickable until the pop-up appears. Conversely, an extremely high setting makes the pop-ups somewhat sluggish.

3. **Click Save**.

Configure pop-ups on read-only fields

Reference pop-ups and click-throughs are hidden by default when a client script, UI policy, variable, or ACL makes the field read-only. The ability to see or click through to the target record does not depend on whether the reference field is writable. You can change the read-only setting.
Role required: admin

1. Navigate to System Properties > UI Properties.
2. Change the value of the Enable click-through of a reference field when the reference field is read-only. (glide.ui.reference.readonly.clickthrough) property.
   If set to true, the pop-up appears for read-only fields and for variables.

If this system value is set to false, you can override the setting for a specific read-only reference field. Configure the dictionary entry and add the readonly_clickthrough=true attribute.

Dictionary entry showing the clickthrough attribute

Configure the related incidents icon
You can configure an icon to appear beside a reference field in a form, such as the Caller field, to display related incidents.
Role required: admin

The show related incidents icon ( in UI16 and UI15, in UI11) displays other incidents related to the referenced record.

1. In the form, right-click the label for the reference field and select Configure Dictionary.
2. Add the ref_contributions=user_show_incidents dictionary attribute in the Attributes field.
3. Click Update.
The form reopens and the related incidents icon appears beside the field on the right.

Configure the show workflow icon

You can configure an icon to appear beside a workflow field to display the related workflow in the Workflow Editor.

Role required: admin

The show workflow icon (⚠️ in UI16 and UI15, ⚠️ in UI11) opens the workflow in the Workflow Editor.

1. In the form, right-click the label for the workflow field and select Configure > Configure Dictionary.
2. Add the ref_contributions=show_workflow dictionary attribute in the Attributes field.
3. Click Update.

The form reopens and the show workflow icon appears beside the field on the right.

Reference styles

Reference styles are specialized field styles that control the appearance of reference fields.

For more information, see Define reference styles.

Reference qualifiers

Use reference qualifiers to create filters that restrict the data that is returned for a reference field.

A reference field stores a link (reference) to a field on another table, making the records/fields in the referenced table available to the form containing the reference field.

For example, the Assigned to field on the Incident table is a reference to the User (sys_user) table. By default, all values for the field that is being referenced appear in the reference lookup and can be directly accessed through the reference field (type ahead). Expanding on the prior example, if a reference qualifier is not defined, all users in the User table appear in the reference lookup. Including those users that are inactive. Sometimes, this might be the desired functionality. In other cases however, only a subset of the available values may be desired. In this case, create a reference qualifier to filter the available data so that only the desired values are returned and made available to the form. Such as only the active users or users that have a specific role.

Reference qualifiers are robust and can consist of simple AND/OR conditions, inline JavaScript, or complex script include.

You can modify the reference qualifier for a table, and any table based on that table (parent or extended), by defining a reference qualifier through the Dictionary Entry form. You can also modify the reference qualifier only on an extended table and its children (not the parent table), through a dictionary override. You can only define a single reference qualifier per field, per form/table. Reference qualifiers are not applicable to condition builders. For information on using filtering in condition builders, see Create a dynamic filter option.

Note: Creating reference qualifiers requires knowledge of the underlying ServiceNow data model (tables and fields) and knowledge of the ServiceNow API and scripting.

You can define a reference qualifier using one of the following methods.
Simple reference qualifier

Simple reference qualifiers use AND/OR statements (conditions) to create simple filters. Use simple reference qualifiers when filtering on conditions such as whether a company is active, a user has a specific role, and/or a caller is in a specific time zone. Simple reference qualifiers can have a maximum of 13 reference qualifier conditions. For additional information on how to use condition builders, see Condition builder.

Simple reference qualifier example

Dynamic reference qualifiers

Dynamic reference qualifiers enable you to use a dynamic filter option to run a query against a reference field to filter the returned data set. Dynamic filter options are stored filters that can contain encoded query strings, JavaScript, or script includes, and can be used in multiple dynamic reference qualifiers. Changes made to a dynamic filter option automatically apply to all reference qualifiers that use the same dynamic filter option. Use this type of reference qualifier when you want to use the same filter on multiple forms or to provide filter functionality to 'non-code savvy' implementers.

The base instance provides several OOB dynamic filter options. If a dynamic filter option that meets your needs does not exist, you can create a new dynamic filter option that is specific to your requirements. An example of an OOB dynamic filter option is the reference qualifier on the Model ID field on a configuration item form, such as the Computer form. The reference qualifier calls the CI Model Qualifier dynamic filter option, which in turn calls the ModelAndCategoryFilters script include. This script include filters the data set based on the class of the CI. The only options for the model ID are options that belong to the same class as the current CI. For example, only CIs that belong to the Computer class are available in the Model ID field on the Computer form.

To locate the available dynamic filter options, navigate to System Definition # Dynamic Filter Options. In the right-corner of the Dynamic Filter Options list, click the filter icon and create the filter condition Available for ref qual is true. All dynamic filter options that can be used in dynamic reference qualifiers appear.
Dynamic reference qualifier example

Advanced reference qualifier

Advanced reference qualifiers enable you to define an inline encrypted query string or JavaScript (actual code or the name of an existing script include or business rule) filter directly in the Reference qual field of the reference qualifier. Similar to the other reference qualifier types, when the form loads, the filter is executed, and only the records that match the filter appear in the reference field. Use this type of reference qualifier for implementations that only require a simple, unique filter, that cannot be handled by a simple reference qualifier, and is not used across multiple reference fields.

Note: As a good practice, make JavaScript calls to functions in a script include instead of a global business rule.

An example of an encoded query string is vendor=true, which returns all companies that are designated as vendors. Entering this string is the same as using the condition builder as shown in the example for the simple reference qualifier. For additional information on valid encoded query string syntax and examples, see Encoded query strings.
Advanced reference qualifier examples

An example of a JavaScript call is `javascript:new myScriptInclude().my_refqual()`. This code calls the function `my_refqual()` in the script include `myScriptInclude()`. The function must return a query string that can filter the options available on a reference field.

**Note:** You can also use encoded JavaScript filters such as
`javascript:'u_active=true^' + 'u_hr_service=\'+current.hr_service in reference qualifiers.`

In another example, if you are trying to filter based on the current company, you don’t have to use a lookup script but can simply add this line to your dynamic qualifier:

```
return "company=\" + current.company;
```

You can also simplify this and use an advanced reference qualifier instead of a dynamic one:

```
javascript:"company=\" + current.company
```
Related lists and reference qualifiers

When a field appears on multiple related lists on a single form view, it may be necessary to validate which related list is being referenced to properly build the reference qualifier for the field. In this situation, configure the list control for the related list and enter a unique tag in the List edit tag field. This tag value is available to filter scripts as a variable named listEditRefQualTag. The following script include code is an example of a function that uses this type of tag.

```javascript
// Advanced reference qualifier on the CI Relationship Child field that takes into account
// the related list that we are editing the child field on, if the field is being edited
// from a tagged related list.

cmdb_rel_ci_child_refQual:function(){
```
Using Javascript current syntax in reference qualifiers

current is a JavaScript object that contains the fields and field values of the active (current) record. For forms, this is the record that is displayed (loaded) in the form. Within advanced and dynamic reference qualifiers, you can use the JavaScript current object to define filters such as javascript:"company=" + current.company.

This JavaScript, within a reference qualifier, only returns the records from the referenced table that are equal to the company field value of the current record. So, if the value that appears in the Company field is Acme, the JavaScript returns all reference field records whose company value is equal to Acme (company="Acme"). If you then bring up a record whose company value is "ViewRite", the JavaScript resolves to company="ViewRite."

All fields within the currently loaded form (tables) are available for use with the current object. Use dot-walking to access values in a table, including the referenced table. For example, on the Incident form, the Assigned To field references the User table. To access the email address of the user, use the following syntax: javascript:"emailAddress=" + current.assigned_to.email.

Configure reference qualifiers
System administrators can configure reference qualifiers that enable filtering of the associated reference field.

This task walks you through creating a reference qualifier in the system dictionary. When creating a reference qualifier in the system dictionary, it not only applies to that table, but also to all the children of the table.

Note: You can also create reference qualifiers on extended tables through dictionary overrides. Dictionary overrides only impact the extended table and any of its children, not the parent table.

1. Navigate to the reference field on the form or table on which you want to define a reference qualifier.
2. Right-click the reference field label and select Configure Dictionary.
   The simple reference qualifier is available in both the default view and the advanced view. The dynamic and advanced reference qualifiers are available only in the advanced view.
4. In the Reference Specification section, verify that the table in the Reference field contains the table that you want associated with the reference field, or select another table if necessary.
5. From the Use reference qualifier choice list, select the reference qualifier to implement.
6. Configure the qualifier based on the type of reference qualifier.
   - Simple: Build the condition using the choice lists.
   - Dynamic: Either select an existing dynamic filter option or define a new dynamic filter option.
   - Advanced: In the Reference qual field, enter an encoded query string, JavaScript that returns a query string, or the name of a script include or business rule to run.
7. Complete the Reference Specification — Additional Customization section, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference key</td>
<td>Identifies a field other than sys_id to use as the unique identifier for the reference field.</td>
</tr>
</tbody>
</table>
| Reference cascade rule    | Defines what happens to a record if the record it references is deleted. Possible options include:  
  - None  
  - Cascade  
  - Clear  
  - Delete  
  - Delete no workflow  
  - Restrict |
| Reference floats          | Flag that determines whether to configure the edit option for one-to-many relationships. |
| Dynamic creation          | Flag that determines if the system should create a new record when a value for the reference field does not match an existing record. If you select this option, enter a script that specifies how to create the record in the Dynamic creation script field. |

8. Click **Update**.

Constrain the assigned to field by role

This example shows how to use JavaScript and a business rule to restrict the incident **Assigned to** field choices to only the users with the itil_admin role.

Role required: personalize_dictionary or admin

You can also change itil_admin to any other role on a reference field that refers to the User table.

1. Open an incident.
2. Right-click the **Assigned to** field and select **Configure Dictionary**.
3. In the **Reference qual** field, enter
   
   \[javascript:"sys_idIN"+getRoledUsers("itil_admin").join("","\).\]

4. Save the record.
5. To see the base system business rule that this JavaScript code calls, navigate to **System Definition > Business Rules**.
6. Open **getRoledUsers**.

   The business rule uses the following JavaScript code.

   ```javascript
   // Return an array of sys_ids of the users that have at least one role  
   // optional parameters allow the exclusion (NOT IN) of some roles or  
   // look for specific roles (IN)  
   //  
   // optional: queryCondition - 'IN' or 'NOT IN'  
   // optional: roleList - a comma separated list of role names  
   // function getRoledUsers(queryCondition, roleList) {  
   // var roleListIds;  
   // if (queryCondition && roleList) {  
   //   roleListIds = getRoleListIds(roleList);  
   // }  
   
   // var users = {};  
   ```
Constrain the assignment group field

This example shows how to use an advanced reference qualifier with JavaScript and a script include to restrict the incident Assignment group choices to only the groups that contain the user specified in the Assigned to field.

Role required: personalize_dictionary or admin

1. Open an incident.
2. Right-click the Assignment group label and select Configure Dictionary.
3. If the form appears in Default view, under Related Links, click Advanced view.
4. In the Use reference qualifier field, ensure that the Advanced option is selected.
5. In the Reference qual field, enter javascript:new BackfillAssignmentGroup().BackfillAssignmentGroup().
6. Save the record.
7. Navigate to System Definitions > Script Includes.
8. Click New.
9. Create a script include with the following JavaScript code. Ensure that the Client callable option is selected and that the Accessible form field is properly set for the environment.

```javascript
var BackfillAssignmentGroup = Class.create();
BackfillAssignmentGroup.prototype = {
    initialize: function() { },

    BackfillAssignmentGroup:function() {
        var gp = ' ';
        var a = current.assigned_to;

        //return everything if the assigned_to value is empty
        if(!a)
            return;
        //sys_user_grmember has the user to group relationship
```

```javascript
var gr = new GlideRecord('sys_user_has_role');
if (roleListIds) {
    gr.addQuery('role', queryCondition, roleListIds);
}
gr.query();
while (gr.next()) {
    users[gr.user.toString()] = true;
}

var ids = [];
for (var id in users)
    ids.push(id);

return ids;
}
```

```javascript
// get sys_id's for the named roles
function getRoleListIds(roleList) {
    var ids = [];
    var gr = new GlideRecord('sys_user_role');
    gr.addQuery('name','IN',roleList);
    gr.query();
    while (gr.next()) {
        ids.push(gr.sys_id.toString());
    }
    return ids;
}
```

```javascript
Constrain the assignment group field

This example shows how to use an advanced reference qualifier with JavaScript and a script include to restrict the incident Assignment group choices to only the groups that contain the user specified in the Assigned to field.

Role required: personalize_dictionary or admin

1. Open an incident.
2. Right-click the Assignment group label and select Configure Dictionary.
3. If the form appears in Default view, under Related Links, click Advanced view.
4. In the Use reference qualifier field, ensure that the Advanced option is selected.
5. In the Reference qual field, enter javascript:new BackfillAssignmentGroup().BackfillAssignmentGroup().
6. Save the record.
7. Navigate to System Definitions > Script Includes.
8. Click New.
9. Create a script include with the following JavaScript code. Ensure that the Client callable option is selected and that the Accessible form field is properly set for the environment.

```javascript
var BackfillAssignmentGroup = Class.create();
BackfillAssignmentGroup.prototype = {
    initialize: function() { },

    BackfillAssignmentGroup:function() {
        var gp = ' ';
        var a = current.assigned_to;

        //return everything if the assigned_to value is empty
        if(!a)
            return;
        //sys_user_grmember has the user to group relationship
```
var grp = new GlideRecord('sys_user_grmember');
grp.addQuery('user',a);
grp.query();
while(grp.next()) {
    if (gp.length > 0) {
        //build a comma separated string of groups if there is more than one
        gp += (',' + grp.group);
    }
    else {
        gp = grp.group;
    }
}
// return Groups where assigned to is in those groups we use IN for lists
return 'sys_idIN' + gp;
},
type: 'BackfillAssignmentGroup'
}

To test, create an incident and select a user in the Assigned to field. Click the Assignment group lookup icon. Only the groups that contain the user you selected appear. For example, you assign an incident to Bob Smith, who belongs to the Database group and the Networking group. The only options that appear in the assignment group are Database and Networking.

The INSTANCEOF operator in reference qualifiers
You can use the INSTANCEOF operator in a reference qualifier to shorten or simplify a complex class qualifier.

For example, use the INSTANCEOF operator for a reference field to the cmdb_ci table to specify that all subclasses of a class are included in the results. The following reference qualifier returns all servers, including Linux, UNIX, Windows, and so on, because each of those subclasses extend the cmdb_ci_server class.

sys_class_nameINSTANCEOFcmdb_ci_server

In another example, you can simplify the following reference qualifier in a similar way.

u_active=true^sys_class_name=cmdb_ci_acc
^ORsys_class_name=cmdb_ci_computer
^ORsys_class_name=cmdb_ci_server
^ORsys_class_name=cmdb_ci_win_server
^ORsys_class_name=cmdb_ci_unix_server
^ORsys_class_name=cmdb_ci_linux_server
^ORsys_class_name=cmdb_ci_appl
^ORsys_class_name=cmdb_ci_netgear

Using the INSTANCEOF operator, the reference qualifier is rewritten as follows because the server subclasses extend the cmdb_ci_computer class.

u_active=true^sys_class_name=cmdb_ci_acc
^ORsys_class_nameINSTANCEOFcmdb_ci_computer
^ORsys_class_name=cmdb_ci_appl
^ORsys_class_name=cmdb_ci_netgear

Auto-complete for reference fields
By default, a reference field auto-completes as the user types in the field.

Administrators can configure additional auto-complete options. A user must have table-level read permission on the referenced table for auto-complete to display any options.
Dictionary attributes for auto-completion of reference fields

There are dictionary attributes that are specific to reference fields and that determine auto-complete behavior.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ref_auto_completer</td>
<td>Specifies the name of the client-side JavaScript class that creates the drop-down auto completion choices. Valid class values include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>AJAXReferenceCompleter</strong>: Displays matching auto-complete choices as a drop-down choice list. The list only displays the reference table's display value column. Reference fields automatically use this class if there is no other auto-completion class specified.</td>
</tr>
<tr>
<td></td>
<td>- <strong>AJAXTableCompleter</strong>: Displays matching auto-complete choices as rows in a table. The table displays the reference table's display value column and any columns listed in the <code>ref_ac_columns</code> attribute.</td>
</tr>
<tr>
<td></td>
<td>- <strong>AJAXReferenceChoice</strong>: Displays matching auto-complete choices as a drop-down choice list. The list only displays the reference table's display value column. Furthermore, the list only displays up to 25 matching choices. If there are more than 25 auto-complete choices, the reference field instead displays the choices with the AJAXTableCompleter class.</td>
</tr>
<tr>
<td>ref_ac_columns</td>
<td>Specifies the list of reference table columns to display. Separate column names with a semi-colon. For example, <code>ref_ac_columns=user_name;email;sys_created_on</code> allows auto-complete to match text from the user_name, email, and sys_created_on columns.</td>
</tr>
<tr>
<td>ref_ac_columns_search</td>
<td>Enables auto-complete to match text in the columns listed in the <code>ref_ac_columns</code> attribute. Set this attribute to <code>true</code> to enable auto-complete to match text in all reference field columns. By default (or when this attribute is <code>false</code>) auto-complete only matches text in the display value column.</td>
</tr>
</tbody>
</table>
### Auto-complete UI features

The AJAX table completer class has a number of UI improvements.

- The table completer always displays the number of records the auto-complete query finds.
- The table completer highlights the entire selected row by changing the color of the background and text.
- The table completer lists a value for every column.
  - The first time a value appears in a column, the table completer displays it in black text.
  - The table completer displays subsequent duplicate values in grey text. Previously, the table completer displayed an empty cell in a column containing a duplicate value.

![Selected row highlight](image)

Set the `ref_autoCompleter=AJAXTableCompleter` dictionary attribute to use these improvements.

#### Define auto-complete attributes for all references to a table

A field inherits and uses the reference table’s auto-complete attributes unless the field has its own value for the same attributes. You can define the attributes for references to a table, and it affects every form that references that table.

**Role required:** personalize_dictionary

A field-level attribute overrides a table-level attribute of the same name. If a field uses different reference attributes from those that are defined for the reference table, then the field uses both sets of attributes.

Use these steps to define auto-complete attributes for all fields in a table that do not already have their own auto-complete attributes. This example describes how to define auto-complete attributes for all references to the User (sys_user) table.

#### Note:
A field’s auto-complete attribute value supersedes a table’s auto-complete attribute value. This means that any existing field-level value for an auto-complete attribute

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ref_ac_order_by</td>
<td>Specifies the reference table column that sorts the auto-completion choices. For example, <code>ref_ac_order_by=name</code> sorts the auto-completion choices alphabetically by name.</td>
</tr>
</tbody>
</table>

Administrators can also set a user preference to use a `contains` auto-complete search.
1. Navigate to a list of the target table, such as **User Administration > Users**.

2. Perform the appropriate action for your list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click the column header and click <strong>Configure &gt; Dictionary</strong>.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and click <strong>Configure</strong>, and then click <strong>Dictionary</strong>.</td>
</tr>
</tbody>
</table>

3. Select the row that does not list a column name. This row is typically the first row in the list. For example, select the first **sys_user** link.

4. Under **Related Links**, click **Advanced view**.

5. In the **Attributes** field, enter a comma-separated list of auto-complete attributes you want to apply to all fields in the table. For example, to display the user’s department with all references to the **sys_user** table, enter:

   ```plaintext
   ref_auto_completer=AJAXTableCompleter,ref_ac_columns=department,ref_ac_order_by=department
   ```

6. Click **Update**.

To test the new auto-complete attributes, open a form that references the User (sys_user) table, such as an open incident. Enter a single character in the **Assigned to** field. The auto-complete options now include both the user name and department.

---

**Remove the display value column**

You can remove the display value column from a reference field by setting the **ref_ac_display_value** attribute to false.

**Role required**: personalize_dictionary

This causes the reference field to remove the display value column and only display the columns listed in the **ref_ac_columns** attribute. This feature requires the use of the AJAXTableCompleter class and the **ref_ac_columns**, **ref_ac_columns_search**, and **ref_ac_display_value** attributes.

**Note**: Auto-complete cannot match text from additional columns when the reference field is a product of the **ui_reference** UI macro. This means any auto-complete action against a selector, such as the Impersonate User list, can only match text against the display value.

---

This example describes how to remove the display value column from references to the User (sys_user) table and replace it with references to the first_name and last_name columns.

1. Navigate to a list of the target table, such as **User Administration > Users**.

2. Perform the appropriate action for your list version.
3. Select the row that does not list a column name. This row is typically the first row in the list. For example, select the first `sys_user` link.


5. In the Attributes field, add the `ref_autoCompleter`, `ref_ac_columns`, `ref_ac_columns_search`, and `ref_ac_display_value` attributes. For example, to hide the display value column and only display the user's first and last names enter the following:

   ```
   ref_autoCompleter=AJAXTableCompleter,ref_ac_columns=first_name;last_name,ref_ac_columns_search=true,ref_ac_display_value=false
   ```

6. Click Update.

To test the new auto-complete attributes, open a form that references the User (sys_user) table, such as an open incident. Enter a single character in the Assigned to field. The auto-complete options now hide the display value column (user_name) and only display the first_name and last_name columns.

---

**Improve auto-complete queries**

By default, all reference fields use a **starts with** query to search for matching text in the reference table. This prevents auto-complete from executing inefficient **contains** queries every time a user searches a reference field. You can require all reference fields to use a **starts with** query.

Role required: admin

The following example illustrates a **contains** query. Note that the letter "d" appears anywhere in the user's first or last name.
This procedure describes how to change the `glide.ui.ref_ac.startswith` system property to always use a `starts with` query.

1. In the navigation filter, enter `sys_properties.list` and press the Enter key.
2. Select the `glide.ui.ref_ac.startswith` property.
   To search for the property, enter `*startswith` in the Go to search filter for the Name column.
3. In the Value field, replace `false` with `true`.
   
   **Note:** Setting the `glide.ui.ref_ac.startswith` system property to `true` overrides any existing `autocomplete.contains` settings in both user and system level preferences. This property changes the autocomplete query method for all users regardless of preferences.

4. Click Update.
5. Test the change by opening a record with a reference field and entering a character in it, as illustrated in the example below.

Configure auto-complete to match text from any reference field

By default, auto-complete only matches text in the display value column. You can configure a reference field to match text from any additional column the reference field displays.

Role required: personalize_dictionary

You can add the `ref_ac_columns_search` attribute to enable auto-complete to match text in any column listed in the `ref_ac_columns` attribute. Set the `ref_ac_columns_search` attribute to `true` to match text from all reference field columns. By default (or when this attribute is `false`) auto-complete only matches text in the display value column.

1. Right-click the label of a reference field.
2. Select Configure Dictionary from the choice list.

4. In the Attributes field, add the desired auto-completion attributes. For example, these attributes add the department field to the caller list and sort callers by their department:

   `ref_auto_completer=AJAXTableCompleter,ref_ac_columns=department,ref_ac_order_by=department,ref_ac_columns_search=true`

5. Click Update.

The following example describes how to set the Configuration Item field display the CI class names from auto-complete choices for the Configuration item (cmdb_ci) table.

   `ref_auto_completer=AJAXTableCompleter,ref_ac_columns=sys_class_name,ref_ac_order_by=sys_class_name,ref_contributions=task_show_ci_map;ci_show_incidents`

**Note:** The ref_contributions attribute controls the icons that appear next to the reference field.
Enable contains auto-complete searches

By default, the reference auto-complete uses a **starts with** search. A user preference can be created to implement a **contains** search.

Role required: admin

1. Disable the `glide.ui.ref_ac.startswith` system property.
   
   For more information, see [Improve auto-complete queries](#).

   **Note:** Setting the `glide.ui.ref_ac.startswith` system property to **true** overrides any existing 'autocomplete.contains' settings in both user and system level preferences. This property changes the auto-complete query method for all users regardless of preferences.

2. Navigate to **User Administration > User Preferences**.
3. Select the preference `"<referenced table>.autocomplete.contains"`.
4. Set the **value** field to **true**.
5. Click **Update**.

Log out and log back in to display the updated search.

*Wildcards in reference auto-completes*

Wildcard searches use the auto-complete functionality.

Use an asterisk in the reference field for wildcard searches.

One asterisk wildcard search

If two asterisks are entered, a list of available records display in the auto-complete suggestions.
Two asterisk wildcard search

Recent selections

Reference fields store a list of each user's recent selections to allow users to quickly select past values when filling in a reference field.

By default, the system stores up to 15 selections from a reference field for each user in the Recent Selection (sys_ui_recent_selection) table. Users can see the recent selections list by selecting an empty reference field.

**Note:** The system does not store recent selections for service catalog reference variables.

**Note:** Recent selections are not available in the service portal or mobile user interfaces.

The system uses auto-complete to filter the list of recent selections to match values the user enters.
The system adds a Recent Selection record whenever a user inserts or updates a reference field value. Administrators can control the number of recent selections the system displays with the `glide.xmlhttp.max_choices` system property. Setting the property to zero disables recent selections.

**Note:** This property also controls how many entries the system displays in choice lists.

### Suggestion field type

To help users find what they are looking for, you can add a suggestion field to any form.

**Role required:** `personalize_dictionary`

1. Open the form to which you are adding a suggestion field.
2. Add a new field or locate an existing field.
3. Right-click the field label and select **Configure Dictionary**.
4. In the **Choice** field, select **Suggestion**.
5. Click **Update**.

Suggestions are presented to the user.
Configure suggested text for string fields

You can configure the suggested text options for string fields.

Role required: personalize_choices

1. Right-click the field label and select Configure Choices.
2. Using the slushbucket, select options and the order in which you want them to appear.
   - To create a new option, enter the suggested text in the Enter new item field and click Add.
   - The Apply to Table field is available when the current table extends another table (for example, Incident extends Task). This field allows suggested text options to be configured for all tables that extend the parent or for only the current (child) table.
3. Click Save.
4. To edit existing options, right-click the field label and select Show Choice List.

Configure suggested text for journal fields

You can configure the suggested text options for journal fields, such as work notes or the activity stream. Suggested text options for journal fields are unavailable in UI16.
Role required: personalize_dictionary

1. Right-click the field label and select **Configure Responses**.
2. Click **New**.
3. Enter a label, or brief description, for the option.
4. Enter the complete text in **Response text**.
5. Click **Save**.

---

**Wiki field type**

Wikitext fields use the basic wiki markup language and support links to external URLs and to sources within the system.

Some fields in the base system support Wikitext and administrators can add Wikitext fields on any form in the system.

---

**Supported wiki tags**

Basic tags are supported for Wikitext fields in the system.
### Supported wiki tags

<table>
<thead>
<tr>
<th>Format</th>
<th>Wiki tag</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Headers</strong></td>
<td>= Header 1 =, == Header 2 ==, etc.</td>
</tr>
<tr>
<td>Numbered step</td>
<td>#Step 1</td>
</tr>
<tr>
<td>Bullets (multi-level)</td>
<td>*Bullet 1, **Bullet 2</td>
</tr>
<tr>
<td>Indentation</td>
<td>:Level 1, ::Level 2</td>
</tr>
<tr>
<td>Line break</td>
<td>&lt;br&gt;</td>
</tr>
<tr>
<td><strong>Tables</strong></td>
<td>Full table support, including cell spacing, padding, borders, background shading, and width measurements. For example:</td>
</tr>
<tr>
<td></td>
<td>`{</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>! Header 1</td>
</tr>
<tr>
<td></td>
<td>! Header 2</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>row 1, cell 1</td>
</tr>
<tr>
<td></td>
<td>row 1, cell 2</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>row 2, cell 1</td>
</tr>
<tr>
<td></td>
<td>row 2, cell 2</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td><strong>Code blocks</strong></td>
<td>&lt;pre&gt; Generic block &lt;/pre&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;javascript&gt; Javascript Syntax &lt;/javascript&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;xml&gt; XML Syntax &lt;/xml&gt;</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>&quot;&quot;text&quot;&quot;</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>&quot;text&quot;</td>
</tr>
<tr>
<td>Ignore Wiki and HTML formatting</td>
<td>&lt;nowiki&gt; wikitext &lt;/nowiki&gt;</td>
</tr>
<tr>
<td>Web link</td>
<td>(<a href="http://community.service-now.com/">http://community.service-now.com/</a> &lt;link text&gt;)</td>
</tr>
<tr>
<td>Placed images</td>
<td>([Image:&lt;image name&gt;]) For more information on uploading images or files to the database, see Storing images in the database.</td>
</tr>
<tr>
<td><strong>HTML</strong></td>
<td>Most common HTML tags are supported</td>
</tr>
<tr>
<td></td>
<td>&lt;b&gt;bold&lt;/b&gt;, &lt;strong&gt;strong&lt;/strong&gt;,</td>
</tr>
<tr>
<td></td>
<td>&lt;i&gt;italics&lt;/i&gt;, &lt;h1&gt;header1&lt;/h1&gt;, &lt;h2&gt;header2&lt;/h2&gt;, &lt;h3&gt;header3&lt;/h3&gt;, &lt;p&gt;paragraph&lt;/p&gt;, &lt;sub&gt;sub&lt;/sub&gt;, &lt;sup&gt;sup&lt;/sup&gt;,</td>
</tr>
<tr>
<td></td>
<td>&lt;center&gt;center&lt;/center&gt;</td>
</tr>
</tbody>
</table>

### Create a Wikitext field

You can create a Wikitext field on any form.
Role required: personalize_form
1. Create a new field with the **Type** set to **Wiki**.
2. Click **Wikitext** to begin editing.

The Wikitext field appears on the form.

**Extend the functionality of a Wikitext field**

Configure the Wikitext field to link to other sources within the system.

Role required: personalize_dictionary

1. Right-click in the header of the new Wikitext field.
2. Select **Configure Dictionary**
3. In the **Dependent** field of the dictionary form, enter the field you want to use for linking to other pages.

   For example, on the Incident table, you might choose the **number** field.
This configuration enables you to link to any incident by using that incident’s number. For example, to open INC0000002, you enter `[[INC0000002]]`.

The following dictionary attributes are available for wiki_text fields.

- `preview_first=true` - sets the preview mode to display on page load, otherwise editor will be displayed
- `preview_selector=true` - enables the toggle button to switch between the editor and preview
- `dual_mode=true` - enables displaying both the editor and the preview simultaneously during edit mode.

**Add and customize a field in a table**

Administrators can add new fields to a table to store and display data.

Role required: admin

**Warning:** Do not add more than 10 medium-length or longer String fields to a single table. Attempting to save a large number of characters in 11 or more String fields can result in the
following error: Syntax Error or Access Rule Violation detected by database (Row size too large (> 8126).

1. Navigate to any form.
2. Right-click the form header and select Configure > Form Layout.
3. In the Create new field section, fill in the following fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the field as you want it to appear on forms and lists.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a field type.</td>
</tr>
<tr>
<td>Field length</td>
<td>Select a field length. This field is visible only for certain field types.</td>
</tr>
</tbody>
</table>

4. Click Add.
5. Use the slushbucket to place the field in the desired location on the form.
6. Click Save.
   The field now appears on the form in the designated location.

Make a field mandatory

Fields can be marked as mandatory, meaning they must contain a value before the record can be saved. Mandatory fields are marked with a field status indicator before the label.

Role required: personalize_dictionary

A mandatory field that is pre-populated by the platform with default data, such as a value from a client script, does not display the indicator. If you delete this value from the field, however, the indicator appears. The color of the indicator depends on the field state. For more information, see Customize field status indicators.

Using a dictionary entry to make a field mandatory does not work when using WebServices. You can use a data policy instead. For more information on data policies, see Data policy.

1. Right-click the field’s label in the form and select Configure Dictionary.
2. In the Dictionary form, select the Mandatory check box.
3. Click Update.
   The next time the form is opened, a field status indicator appears next to the field label, indicating that a value is mandatory. If the mandatory field is pre-populated for any reason, the mandatory field indicator does not appear.

   Note: Mandatory fields are global. The field is marked as mandatory everywhere it appears in a form.

Mandatory Reference Fields

A form can be saved with an empty mandatory field, if that field is a reference field (derived from another table) and if the parent field is also blank. However, if the mandatory reference field shows a value from the parent field, then the form cannot be saved if this value is deleted. It is important to note that if the value in the referenced field is changed, the value for that field is changed everywhere it appears.
Change the field label or hint

You can change a field's label or the text that appears as a hint when you point your cursor to the field.

Role required: personalize_dictionary

1. Navigate to the form the field appears on.
2. Right-click the field label and select Configure Label.
3. Update the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table the label appears on.</td>
</tr>
<tr>
<td>Label</td>
<td>The label that the field displays. You can enter up to 80 characters for the label, but not all databases support this many characters. The recommended maximum is 30 or fewer characters. HTML in field labels is not supported.</td>
</tr>
<tr>
<td>Plural</td>
<td>The plural version of the field label.</td>
</tr>
<tr>
<td>Element</td>
<td>The dictionary name of the field.</td>
</tr>
<tr>
<td>Help</td>
<td>Helpful text stored in the record.</td>
</tr>
<tr>
<td>Hint</td>
<td>A short description of the field that displays when the user hovers over it.</td>
</tr>
<tr>
<td>URL</td>
<td>A URL link that displays on the label if this field is not blank.</td>
</tr>
<tr>
<td>URL target</td>
<td>A target attribute that determines where the URL will open. For information on the target attributes, see this <a href="#">W3Schools article</a>.</td>
</tr>
</tbody>
</table>

4. Click Update.

Delete a field from a table

You can delete custom fields that you created. Custom fields begin with _u_. It is recommended that you remove the field from forms and lists instead of deleting it.

Role required: admin

You cannot delete base system fields. In addition, any missing base system fields are recreated when the instance is upgraded.

1. Navigate to a form that contains a custom field to delete.
2. Right-click the field label and select Configure Dictionary.
3. Click Delete Column in the form header, and then click OK.
4. To delete multiple custom fields, complete the following steps.
   a) Navigate to System Definition > Dictionary.
   b) Locate the custom fields to delete.
      For example, search for column names that start with _u_.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
c) Check the boxes next to the fields to delete and select **Delete** from the action list below the list. A confirmation dialog opens and reminds you that this may result in deletion of related records. If there are dependencies for the selected fields, they are listed.

d) To proceed, click **Delete**.

**Customize field status indicators**

Administrators can customize the colors of field status indicators. A field status indicator is a colored bar that may appear to the left of form elements.

Role required: admin

Navigate to **System Properties > CSS**.

<table>
<thead>
<tr>
<th>Field status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory</td>
<td>Required field that is empty. The user must enter a value to save the form. Default color is red.</td>
</tr>
<tr>
<td>Populated mandatory</td>
<td>Required field for which a value has already been saved. Default color is light red. If the user enters a new value, the field status indicator changes to modified (default green).</td>
</tr>
<tr>
<td>Modified</td>
<td>Contains data that has not been saved. Default color is green.</td>
</tr>
<tr>
<td>Read-only</td>
<td>User cannot edit on the form. Default color is orange.</td>
</tr>
</tbody>
</table>

**UI11 field status indicators**

A field status indicator is a colored bar that may appear to the left of form elements.

Administrators can customize the colors of field status indicators in UI11. These indicators convey the following statuses.

<table>
<thead>
<tr>
<th>Field status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory</td>
<td>Required field that is empty. The user must enter a value to save the form. Default color is red.</td>
</tr>
</tbody>
</table>
### Field status

<table>
<thead>
<tr>
<th>Field status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populated mandatory</td>
<td>Required field for which a value has already been saved. Default color is light red. If the user enters a new value, the field status indicator changes to modified (default green).</td>
</tr>
<tr>
<td>Modified</td>
<td>Contains data that has not been saved. Default color is green.</td>
</tr>
<tr>
<td>Read-only</td>
<td>User cannot edit on the form. Default color is orange.</td>
</tr>
</tbody>
</table>

#### UI11 field status indicators

An administrator can customize the color of these field status indicators by navigating to **System Properties > CSS**:

- **Opened**: 2006-01-30 15:07:12
- **Opened by**: Joe Employee
- **Incident state**: Awaiting Problem
- **Category**: -- None --
- **Escalation**: Overdue
- **Assignment group**: Software
- **Assigned to**: Howard Johnson

#### Add users to a watch list

Watch lists allow multiple users to subscribe to notifications of a task. Expand the watch list and select users with the glide controls.

Role required: none

1. Expand the watch list by clicking the lock icon (🔒).
2. Select users with the glide list controls (see table).
Glide controls

<table>
<thead>
<tr>
<th>UI16/UI15 icon</th>
<th>UI11 icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="User Icon" /></td>
<td><img src="image2.png" alt="Watch List Icon" /></td>
<td>Add the current user</td>
</tr>
<tr>
<td><img src="image3.png" alt="Remove Icon" /></td>
<td><img src="image4.png" alt="Remove Icon" /></td>
<td>Remove the highlighted user</td>
</tr>
<tr>
<td><img src="image5.png" alt="Info Icon" /></td>
<td><img src="image6.png" alt="Info Icon" /></td>
<td>Open the highlighted user's record (active only when a user record exists)</td>
</tr>
<tr>
<td><img src="image7.png" alt="Slushbucket Icon" /></td>
<td><img src="image8.png" alt="Slushbucket Icon" /></td>
<td>Open a slushbucket to add or remove multiple users (not available until a record has initially been saved)</td>
</tr>
<tr>
<td><img src="image9.png" alt="Collapse Icon" /></td>
<td><img src="image10.png" alt="Collapse Icon" /></td>
<td>Collapse or expand the watch list</td>
</tr>
<tr>
<td><img src="image11.png" alt="Search Icon" /></td>
<td><img src="image12.png" alt="Search Icon" /></td>
<td>Open a reference list to select a single user</td>
</tr>
<tr>
<td><img src="image13.png" alt="Email Icon" /></td>
<td><img src="image14.png" alt="Email Icon" /></td>
<td>Enter an email address for users who are not in the User [sys_user] table or do not have an email address defined in their user record</td>
</tr>
</tbody>
</table>

Configure email notifications for watch lists

Watch lists (glide_list field type) allow multiple users to subscribe to notifications of a task. You can specify conditions in an email notification to send email notifications to the members when the conditions are met.

Role required: admin

To receive these notifications, users must define an email address in their user record or enter an email address into the watch list email field.

Important: Administrators configure email notifications for watch lists (see Configure email notifications for watch lists).

An advanced configuration using watch lists involves placing two watch lists on a form, one for the general comments on a task and another for work notes or non-public comments. By configuring separate email notifications, separate users on each watch list can be notified about different information.

If users on a watch list are getting more than one email for each update to an incident, it can be because other recipients are replying all to an email notification. Recipients may be receiving email through their email system (Outlook, Groupwise, and so on) and through the base system. To stop this duplication, remove the names of other users from the email or the watch list.

1. Open the notification to configure.
2. In the Who will receive section, select the icon beside Users/groups in fields.
3. Double-click Watch list in the Available column to move it to the Selected column.
4. Click Update.
**Hide email addresses in a watch list**
You can remove the email address text entry element from a watch list by modifying the dictionary.

Role required: admin

1. Open a task record that displays the Watch list field.
2. Right-click the label and select Configure Dictionary.
3. In the Attributes related list, click New.
4. Enter or select the no_email attribute and enter true in the Value field.
5. Click Submit.

The email entry field is hidden. Users can select users from the reference field to add to the watchlist.

**Configure order buttons on the watch list slushbucket**
When you add multiple users to a glide_list, such as a watch list, the slushbucket does not display the order buttons for the list of selected members. You can set a dictionary attribute to display the order buttons.

Role required: admin

The slushbucket opens when the user clicks the add/remove multiple users icon.

By default the order buttons on the right are not displayed. Follow the procedure to display the order buttons.
1. Open a task record that displays the Watch list field.
2. Right-click the label and select Configure Dictionary.
4. In the Attributes field, enter maintain_order=true separated by a comma if necessary.
5. Click Update.

**Define field styles**

Field styles allow you to declare individual CSS styles for a field in a list or form.

Role required: personalize_styles or admin

The CSS lets you change the following attributes of a field.

- Change the color.
- Change the font attributes (bold, italics, underline).
- Change the padding and alignment of text.

You can define field styles for tables and database views that are in the same scope as the field style and for other tables that have at least one field in the same scope as the field style. Field styles defined for a table do not apply to database views that include the table. Create separate field styles for database views.
**Note:** Field styles are not applied to comments and work notes fields used with the activity formatter. Styles for these fields can be set using the `glide.ui.activity_stream.style.comments` and `glide.ui.activity_stream.style.work_notes` system properties located on the `sys_properties` table.

1. Navigate to the list of styles for the field in one of the following ways.
   - Right-click the field label on the form and select **Configure Styles**.
   - Navigate to **System UI > Field Styles**, and locate the field to apply a style (admin only).

2. Click **New**, or click the style to modify.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the field.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> The list shows only tables and database views that meet the scope protections for field styles.</td>
</tr>
<tr>
<td>Field name</td>
<td>The field to which the style applies.</td>
</tr>
<tr>
<td>Value</td>
<td>The exact value or script-based-condition required to apply the style.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> The value only affects list field styles. To apply field styles on both lists and forms, leave this field blank.</td>
</tr>
<tr>
<td>Style</td>
<td>The CSS style to apply.</td>
</tr>
<tr>
<td></td>
<td>For example, to make the background of the Incident Category fields red in record lists, with a 24px font size and white text color, enter the following code.</td>
</tr>
<tr>
<td></td>
<td><code>background-color:red;</code></td>
</tr>
<tr>
<td></td>
<td><code>font-size:24px;</code></td>
</tr>
<tr>
<td></td>
<td><code>color:white;</code></td>
</tr>
</tbody>
</table>

4. Optional: To add alternative text for a style, **configure the form** to add the alternative text field. 
   For styles like the VIP style icon, you can add alternative text so that screen readers can differentiate between the style and the text.

5. Click **Submit** or **Update**.

**Define reference styles**

Reference styles are similar to field styles, but apply to any reference to a table. You can define styles that apply to any reference to a table.

Role required: admin

For instance, a reference style on the User (sys_user) table would apply to any reference field on any table that refers to User.

1. Enter `sys_ui_reference_style.list` in the application navigator filter and press Enter.
2. Click **New**.
3. Complete the form.

### Reference Style form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>If the check box is selected, the style is applied where appropriate.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to which all references will be styled.</td>
</tr>
<tr>
<td>Style</td>
<td>A CSS style to apply.</td>
</tr>
</tbody>
</table>

*Note:* The list shows only tables that meet the scope protections for table styles.

See [Application scope](#).

### Modify string field length

You can modify the maximum character limit for a string field.

Role required: personalize_dictionary

1. Right-click the field label in the form and select **Configure Dictionary**.
2. Change the **Max length** field to the desired length.

*Note:* You can change between string-based data types as long as length changes do not cause any data loss from truncation. For example, you can change from a MEDIUM database type to a VARCHAR(100) database type if none of the existing data is greater than 100.

3. Click **Update**.
   The system cancels any length change that results in data loss due to truncation.

### Specify a default field value

A default value populates a value in a field when a new record is created.

Role required: personalize_dictionary

The default value populates the field on the blank form for a new record, and also subsequently when the new record is submitted if the field is empty. Default values can be specified as either a constant or generated through script.

1. Right-click the field's label in the form and select **Configure Dictionary**.
2. Enter the default value in the **Default value** field.

   To set a constant value, type it into the **Default value** text box field. To assign a default value using a more complex formula, use JavaScript to output a default value.

*Note:* The default value should be the underlying value that would be present in the field, not the label. For example, in a choice list field, use the **value** of the choice as the default value, not the choice's name.
Default field value examples

Review the following examples about specifying default field values.

Constant default values

Here is an example that sets a default value for the Priority field.

![Diagram showing dictionary entry for Priority with default value set to 4](image)

Default value constant

Javascript default values

To view out-of-box examples of JavaScript default values, navigate to System Definition > Dictionary and enter this filter: (Default value) (starts with) (javascript).

Open some of the records and view the default value javascript entries.
Set a default value for assignment_group

The following example sets a default value in a (sys_user_group) reference field by getting the ID from the name of a group.

```javascript
javascript:GetIDValue('sys_user_group', 'Development');
```

Set a default value for assigned_to if user has the itil role

This example for the Task (task) table describes how to configure the default value for the (assigned_to) user equal to the current user id if the user has a role of itil.

- Column label: Assigned to
- Column name: (assigned_to)
- Reference Specification section
  - Reference: User (sys_user)
  - Reference qual condition: (Roles) (is) (itil)
- Default value script:

```javascript
javascript:if (gs.hasRole("itil")) current.assigned_to = gs.getUserID();
```

Set a default value for a duration field

To set a default value for a duration field, use the following in the Default value field of the duration field’s dictionary entry:

```javascript
javascript:current.duration_field.setDisplayValue('3 04:30:14');
```

Avoid hard-coding a particular date-time. If the system date-time format changes, the value becomes invalid. Instead, select the Use dynamic default check box and assign a dynamic filter option. For more information on dynamic filters, see Create a dynamic filter option.

Make a field dependent

A choice or reference field can be declared dependent on another field on the same table. Dependent fields limit their available values based on the value in the dependent field.

Role required: personalize_dictionary

If a required dependency does not function as expected, as might happen if there is a many-to-many relationship between the fields, consider using reference qualifiers to accomplish the goal.

1. Right-click the field label in the form and select Configure Dictionary.
2. In the Dependent field, enter the name of the field that this field will depend on.
3. Click Update when done.

In the example below, the "subcategory" field is made dependent on "category". The "category" value in a form will determine which options appear for the "subcategory" field.
### Dictionary Entry
<table>
<thead>
<tr>
<th>Table:</th>
<th>Incident [incident]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column name:</td>
<td>subcategory</td>
</tr>
<tr>
<td>Type:</td>
<td>string</td>
</tr>
<tr>
<td>Choice:</td>
<td>Dropdown with -- None</td>
</tr>
<tr>
<td>Default value:</td>
<td></td>
</tr>
<tr>
<td>Attributes:</td>
<td></td>
</tr>
<tr>
<td>Dependent:</td>
<td>category</td>
</tr>
<tr>
<td>Table reference:</td>
<td></td>
</tr>
</tbody>
</table>

### Note:
Fields cannot be made dependent on derived fields.

---

### Require unique values for a field
The system allows you to require that a field's values be unique. When this is done, the system will not let two records have the same value for that field.

Role required: personalize_dictionary

By default, fields are created without this constraint. A field can have unique values only if there are not already duplicate values in the database for that field. The system does not allow you to make a field unique while there are duplicate values in the table.

1. Verify that no records in the table for the field have values, or that they all have the same value.
2. Right-click the field label in the form and select **Configure Dictionary**.
3. **Configure the form** to add the **Unique** field if it does not already appear.
4. Select the **Unique** check box.
5. Update.

Record numbering

In the base system, several tables are numbered, including Incident, Problem, Change Request, and Knowledge. You can also use these numbers anywhere that script is present, for example to generate watermarks for emails. Records in tables can be numbered automatically.

Administrators can manage record numbering by navigating to System Definition > Number Maintenance. The current number format for a table, including the prefix (such as INC for incidents or CHG for changes), is stored in a record on the Number (sys_number) table.
You can renumber auto-incremented tables that extend the task table or manage numbering with a database field named **Number this field**. For information about renumbering custom tables, see [KB0538764: Renumbering auto-incrementated custom tables](https://knowledge.csoor.com/kb/KB0538764) in the ServiceNow knowledge base.

**Add auto-numbering records in a table**

You can define one number format per table in the system.

Role required: admin

1. Navigate to **System Definition > Number Maintenance**.
2. Click a table name to view the number record for that table, or click **New**.
3. Define the number format by completing the fields (see table).
4. Click **Submit** or **Update**.

If an auto-numbered field does not already exist, a new field is automatically created on the table with the following values:

- **Label**: Number
- **Name**: u_number
- **Default value**: `javascript:getNextObjNumberPadded();`

**Note:** This script renumbers records when the **Number of digits** is updated. To use a script that does not renumber records when the **Number of digits** is updated, open the dictionary entry for the **Number** field and enter the following script in the **Default value** field.

```
javascript:getNextObjNumberPadded();
```

Auto-numbering records in a table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select a table.</td>
</tr>
<tr>
<td>Prefix</td>
<td>Enter a prefix for every number in the table (for example, INC for Incident).</td>
</tr>
<tr>
<td>Number</td>
<td>Enter the base number for this table (default value is 1000). Record numbers are automatically incremented, and the next number is maintained in the Counter (sys_number_counter) table. If you set the base number to a value higher than the current counter, the next record number uses the new base number. Otherwise the next record number uses the current counter. The counter does not reset to a base number lower than itself. To see the current counter, click the <strong>Show Counter</strong> related link.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of digits</td>
<td>Enter the minimum number of digits to use after the prefix (default value is 7). • Leading zeros are added to auto-numbers, if necessary. For example, INC0001001 contains three leading zeros. The number of digits can exceed the minimum length. For example, if Number of digits is 2 and more than 99 records are created on the table, the numbers continue past 100 (such as INC101).</td>
</tr>
</tbody>
</table>

**Warning:** Changing this field may update all number values for existing records on a table. Take care when changing this field on a production instance.

**Note:**
To change the default values for new number formats, change the Default value field on the system dictionary record for the Number or Number of digits field. These fields are on the Number table.

---

**Prepare to left-pad number fields in custom tables**

Before you configure left padding of number fields on a custom table or a table that does not extend the task table, you must prepare business rules and script includes.

Role required: admin

1. Duplicate the base system business rule named **Pad Numbers**: Click **Insert and Stay**. If **Insert and Stay** is not available on your instance, create a new business rule and manually copy all field values from Pad Numbers.
2. Give the business rule a new name and change the script field to read as follows:

```javascript
padCurrentCategory();
function padCurrentCategory() {
  var target = new GlideRecord(current.category+"");
  if (!target.isValidField("u_number") || target.isValidField("number")) return;
  var nm = new UNumberManager();
  nm.padTableNumbers(current.category, current.maximum_digits);
} Save the changes.
```

3. Duplicate the base system script include named **NumberManager**.
4. Change the following two lines as indicated:

```javascript
105: currentNumber = records.u_number.toString();
117: records.u_number = prefix + currentNumber;
```

5. Name the new script include **UNumberManager** and save your changes.

You can now continue with the process of configuring left-padding and renumbering records.
Configure left padding of a system number in a table
You can configure the left padding of the system numbers on a table. For example, pad the Number field on an Incident, Problem, or Change Request.

If you are configuring numbers on a custom table or a table that does not extend the task table, then, before performing the following procedure, you must prepare business rules and script includes. For more information, see Prepare to left-pad number fields in custom tables.

Role required: admin

1. Navigate to the form, then right-click the Number field and select Configure Dictionary.
2. Enter the following script in the Default value field and click Update.

```javascript
javascript:getNextObjNumberPadded();
```
3. Navigate to System Definition > Number Maintenance.
4. Open the table record.
5. Enter a value in the Number of digits field.
6. Click Update.

Number padding is applied to both existing and new records.

![Sys number](image)

The result of the configuration in the image is an Incident number that is left padded.

![Incident](image)

Prevent numbering gaps
By default, numbers are generated every time a new record is created.

Role required: admin

When records are created but not saved, a gap in the numbering is created. You can prevent these numbering gaps by generating numbers only when records are saved.

1. Navigate to System Properties > System.
2. Set the property Assign a task number only upon insert (prevents unused numbers), glide.itil.assign.number.on.insert, to true.
3. Click **Save**.

**Enforcing unique numbering**

Although duplicate numbers are rare, numbering does not enforce uniqueness, by default. To enforce uniqueness, you can:

- Create a before business rule on insert only to check for duplicate values and replace duplicates with the next available number.
- Enable a unique index on the table.

**Note:** While unique indexes ensure data integrity they also prevent any insert involving a duplicate number. This may cause unexpected errors during data entry.

**Sample business rule**

This sample script can be used as part of a before business rule on insert only to check for duplicate numbers and replace them with the next available number. The following script references a script created in *Configure left padding of a system number in a table*.

```javascript
var curNum = current.number + ''; 
if(curNum) {
    var recordClass = current.getRecordClassName();
    var gr = new GlideRecord(recordClass);
    gr.addQuery('number', curNum);
    gr.query();
    if(gr.getRowCount() > 0) {
        var newNum = getNextObjNumberPadded();
        gs.addInfoMessage("The number " + current.number + " was already used by another " + recordClass + ". The " + recordClass + " number has been changed to " + newNum);
        current.number = newNum;
    }
}
```

**Field normalization and transformation**

Field Normalization includes normalization and transformation, which are two different ways to alter field values for increased data integrity and reduced duplication.

**Normalization**

Normalization searches for variations of the same field value and converts them into a single preferred value. By consolidating multiple variations of the same value into a single simple recognizable value, the system eliminates duplicate records and provides better search results. When a process or a user enters a value in a normalized field, the system determines whether to replace it with a normal value. Normalization also automatically adjusts queries to return normalized results and normalizes values in scripts.
While normalization is available for every field in the platform, it works best for descriptive values such as names or standard units of measurement. For example, you might create normalization rules to:

- Set the CPU type of a computer CI to a standard model name such as Xeon.
- Set the suffix used for the names of corporations to a standard format such as ServiceNow, Inc..

**Transformation**

Transformation converts raw field input values into standardized values that are more meaningful to an organization. Administrators control when transformation happens by defining rules and conditions for specific fields. For example, you might create transformation rules to:

- Remove suffixes from user names such as Jr. and II.
- Round computer CI RAM sizes to the nearest whole number such as rounding 4112 MB to 4000 MB.

Transform records make up the rules that define how a field transformation is executed. Order values determine the order in which each rule is evaluated. A check box on each transform enables an administrator to determine where processing stops when a rule evaluates to true.

**Enabling normalization and transformation by field type**

Field type records specify which data types are available for normalization and transformation. By default, the system supports normalization and transformation for these field types.

<table>
<thead>
<tr>
<th>Field type</th>
<th>Use to normalize</th>
<th>Use to transform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>Float</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>Integer</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>Numeric</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>String</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>URL</td>
<td>true</td>
<td>true</td>
</tr>
</tbody>
</table>

A field type entry applies to all fields whose dictionary entry data type matches the field type entry. Administrators can create additional field type records for other data types as needed.

**Warning:** Avoid creating field type records for fields that store a Sys ID value such as a reference field, field name field, or a table name field. Directly altering a Sys ID value is more likely to produce data corruption and broken references than to produce meaningful standard values. Instead, normalize or transform the display value associated with the Sys ID. For example, normalize the user name instead of the Sys ID of a specific user.

**Identifying normalized fields**

The system displays the normalization icon on fields with an associated normalization or transformation record. Users with the normalizer role can click the icon to access the associated...
normalization or transformation record. Users without the normalizer role instead see a help page. Administrators can configure who sees the normalization icon with a preference called Restrict to roles.

**Activate Field Normalization**

You can activate the Field Normalization plugin (com.snc.field_normalization) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

**Installed with field normalization**

Several components are installed with Field Normalization.

The following preferences (**Field Normalization > Administration > Preferences**) control features for normalization and transformation:

**Field Normalization preferences**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable field normalization</td>
<td>This preference enables or disables the Field Normalization functionality, including transformations.</td>
</tr>
<tr>
<td>Enable field normalization auditing</td>
<td>This preference enables or disables auditing of field normalization tables.</td>
</tr>
<tr>
<td>Logging</td>
<td>Select the maximum level of logging detail desired. For example, select Error to log only errors and information to log errors, warnings, and information.</td>
</tr>
<tr>
<td>Preference</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decoration URL</td>
<td>Enter the URL for the help/information link associated with the Field Normalization decoration. This link opens the page presented to users who do not have rights to see the normalization or transformation record. The default link opens a ServiceNow Wiki page with a general explanation of Field Normalization. The purpose of this page is to explain to normal users why a field value they entered was changed automatically.</td>
</tr>
<tr>
<td>Restrict decorations to roles</td>
<td>Use this preference to define the user roles that can view the reference icon (decoration) adjacent to a normalized field. This decoration displays transformation and normalization records to users with the normalizer role. For all other users, it opens the URL specified in the Decoration URL preference. If this preference does not specify any roles, then all roles can see the decoration.</td>
</tr>
</tbody>
</table>
Normalization preferences

Business rules

The following business rules were created for this plugin:

- Ensure Rules Application Job
- Ensure Transform Application Job
- Ensure Rules and Alias Jobs
- Ensure Transform Application Job
- Ensure Decoration Attribute
- Cleanup on field or table change
- Prevent duplicates in class hierarchy
- Handle potential duplicates
- Run job
- Ensure Pending Value Collection Job
- Ensure name changer job
- Flush forms when activating

### Field Normalization roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>normalizer</td>
<td>Person authorized to manage field normalization and transformation.</td>
</tr>
<tr>
<td>normalization_tester</td>
<td>Person authorized to create test records for normalizations and transformations. Only records opened by users with this role are available for testing normalization and transformation rules in Test mode.</td>
</tr>
</tbody>
</table>

### Field Normalization script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FieldNormalizationAjax</td>
<td>Provides AJAX services for the Field Normalization plugin.</td>
</tr>
<tr>
<td>FNEnsureJob</td>
<td>Ensures that a job record exists for a particular extant data job target.</td>
</tr>
<tr>
<td>FNExtantDataJobChoices</td>
<td>Generates a list of tables for use in document_id field of the fn_extant_data_normalization table.</td>
</tr>
<tr>
<td>FNExtantDataJobUtil</td>
<td>Determines whether an extant data job is allowed to run.</td>
</tr>
<tr>
<td>FNFields</td>
<td>Returns valid fields for normalization.</td>
</tr>
<tr>
<td>FNTransformChooserUtil</td>
<td>Provides support for the fn_transform_chooser UI page.</td>
</tr>
<tr>
<td>Position</td>
<td>Finds a position within a given string.</td>
</tr>
<tr>
<td>Round</td>
<td>Rounds numbers with various rounding modes and intervals.</td>
</tr>
</tbody>
</table>

### Field Normalization UI pages

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aliases</td>
<td>Creates the slushbucket with pending values for choosing aliases for a normal value.</td>
</tr>
<tr>
<td>fn_transform_chooser</td>
<td>Displays available transforms. Invoked by the New button on the fn_transform related list.</td>
</tr>
</tbody>
</table>

### Enable a field type for normalization or transformation

Create or modify a normalization field type record to enable a specific field data type for use with normalization or transformation.
To normalize or transform a value in a reference field, apply the processing to the field in the target table.

1. Navigate to **Field Normalization > Administration > Normalization Field Types**.
2. Click **New** in the record list.
3. Enter a **Name** for the field type that clearly describes the type in the dictionary. This value is for reference only and is not used in any processing. For example, you might enter **IP Address** for the field type of *ip_address*.
4. Enter the **Type** from the dictionary.
5. Select the appropriate check box to use this field type to normalize or transform fields. In the base system, only the **String** field type is used for normalization.
6. Right-click in the header bar and select **Save** from the choice list. The **Transform Categories** Related List appears.
7. If this field type is being used for transforms, click **Edit** to associate an existing Transform Category with this field type.

**Note:** If you create a custom field type that is used for normalizations only, a link to a transform category is not necessary.

The relationship of a field type to a category, and the category to a list of transformation definitions, is completely configurable.
Create a raw field

A raw field is a custom field created by an administrator to show the original (raw) input in a field on a form after it has been normalized or transformed.

An administrator might add a custom field to a form to show the original, or raw, value of a normalized field.

This is a read-only field that might be called something like **Raw CPU type** or **Original Name**. In the following example, the **CPU type** field was normalized to **Xeon** from an original, raw value of **Xeon L3350**.

1. In the form containing the field that is being normalized or transformed, right-click in the header bar.
2. Select **Personalize > Form Layout**.
3. Complete the Create new field form at the bottom of the page, and then click **Add**.
   - **Name**: Type the field label. In this case, use Raw + <field label>.
   - **Type**: Select a data type from the list for this field.
   - **Field length**: Select the character limit for this field. The default is 40.
4. Move the new field adjacent to the normalized field using the direction arrows in the slushbucket.
5. Click **Save**.
Normalization and transformation data jobs

The system uses data jobs to change field values during normalization and transformation. Administrators must manually start data jobs that apply field changes. By default, which blocks administrators from running manual data jobs that apply changes to existing data. Most data jobs have a rollback option to revert changes after the job completes. By default, the system provides these data jobs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Used for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending value collection</td>
<td>Normalization</td>
<td>The system runs this job to collect field values that will change during the next field normalization run. Since this data job does not change any field values, there is no rollback option.</td>
</tr>
<tr>
<td>Normal value change</td>
<td>Normalization</td>
<td>Run this job to re-run field normalization and update field values when you change a normal value. Rollback the data job to revert normalized fields to the previous normal value.</td>
</tr>
<tr>
<td>Alias application</td>
<td>Normalization</td>
<td>Run this job to normalize all field values that match an alias. Rollback the data job to revert normalized fields to their previous values.</td>
</tr>
<tr>
<td>Rule application</td>
<td>Normalization</td>
<td>Run this job to normalize all field values that match a rule. Rollback the data job to revert normalized fields to their previous values.</td>
</tr>
<tr>
<td>Coalesce to normal</td>
<td>Normalization</td>
<td>Run this job to normalize reference field values by replacing references to multiple duplicate records with one reference to a normalized record. Rollback the data job to restore the duplicate records as valid options. The rollback does not restore references to the previous records.</td>
</tr>
<tr>
<td>Transform application</td>
<td>Transformation</td>
<td>Run this job to transform all field values that match the transformation conditions. You cannot start this job while the Transformation record is in Test mode. Rollback the data job to revert transformed fields to their previous values.</td>
</tr>
</tbody>
</table>
Run a single data job

Running the data job/jobs is the fourth step in transforming a field. This topic explains how to run a single data job.

1. Start the Transform application data job to apply the transform to all the appropriate records in the database.
2. Open the Transformation record and switch the Mode to Active.
3. Select the Data Jobs Related List.
4. Run the data job using one of the following methods.
   - In the list of data jobs, select the check box of the jobs you want to run, and then select Start from the Actions menu. See #unique_465/unique_465_Connect_42_f_ModeSetToActive.
   - Click the link in the Created column to open the data job, and then click the Start Related Link. See #unique_465/unique_465_Connect_42_f_StartRelatedLink.
Run multiple data jobs

Running the data job/jobs is the fourth step in transforming a field. This topic explains how to run data jobs for multiple field transformations.

1. Start the Transform application data job to apply the transform to all the appropriate records in the database.
2. Navigate to Field Normalization > Data Jobs > All.
3. Select the check boxes for the jobs you want to start.

   **Note:** These jobs must have the **Mode** set to **Active**.

4. Select **Start** from the **Actions** menu.

   **Note:** The platform only runs data jobs from Active transformations. The Action menu indicates the number of Active data jobs that can run. For example, the menu might display Start (3 of 4).
Rollback a data job

Use rollback to revert changes made by a normalization or transformation data job.

Role required: admin or normalizer

You can only rollback completed data jobs.

1. Navigate to Field Normalization > Data Jobs > All.
2. Select the completed data job to rollback.
   The system displays the data normalization job record.
3. From Related Links, select Rollback.
   The values in the Pending Values Related List are removed and the data job State indicates that it was rolled back.

Normal values

A normal value replaces similar but ambiguous field values with one standard value.

Field value variations

Records values can come from multiple sources such as:

- Automated entries made by Discovery.
- Automated entries made by importing records from external systems or files.
- Manual entries made by users.

Each of these sources may describe the same field value in several different forms. For example, the CPU Type field on a computer CI form might display any of the following similar values:

- E3350 (Intel) 4.5.2234
- Intel Xeon 5.4.554
- Xeon L3350
- L3350

Without normalization, these variant field values results in:

- Duplicate CPU types
- Poor search results
- Complex queries and conditions to apply business logic

Creating a normal value record solves these issues by consolidating on one standard value such as Xeon.
Identifying variations with aliases and rules

Each Normal value record specifies how to identify variations of a normal value using a combination of aliases and rules.

Aliases

Aliases are known variations of an input value that normalization converts to the normal value. Use aliases when there is a short list of variant values.

For example, you could create a normal value Xeon that has these aliases.

- E3350 (Intel) 4.5.2234
- Intel Xeon 5.4.554
- Xeon L3350
- L3350

Whenever a normalization data job or normalized query sees a field value matching an alias, it automatically replaces the field value with the normal value. Normalization data jobs and queries process aliases before rules.

Note: Aliases are logically equivalent to rules using the (is) operator in a condition where (Field name)(is)(Alias value). For example, the sample aliases are equivalent to these rules:

(CPU Type)(is)(E3350 (Intel) 4.5.2234) OR (CPU Type)(is)(Intel Xeon 5.4.554) OR (CPU Type)(is)(Xeon L3350) OR (CPU Type)(is)(L3350)

Rules

Rules specify the conditions under which normalization replaces an input value with the normal value. Use rules when there are a large number of possible variant values, or when you must create complex conditions.

For example, the normal value Xeon could have this rule.

(CPU Type)(matches regex)\bxeon\b.*

Whenever a normalization data job or normalized query sees a field value matching a rule, it automatically replaces the field value with the normal value. Normalization data jobs and queries process rules after aliases.

Rules and aliases can be combined to normalize a field. Make sure to test your normalization methods before applying them to all the existing records in the database.

Normalized queries

An administrator can configure normalization to apply to queries issued against normalized fields in lists. Select the Normalize query check box on the Normalization form to enable this functionality. In a list containing normalized values, create a filter using the original (raw) value for the normalized field in the query condition.
Normalized query example

The filtered list returns records with the normal value substituted for the raw value. However, the breadcrumbs for the filter display the original query conditions.
Scripting and normalization

Scripts that update or insert records into the database (GlideRecord) are normalized automatically when field normalization is applied. For example, if a script to insert a CI record contains a CPU type of Xeon L3350, the script is normalized to insert the CI with a CPU type of Xeon instead. Scripts that query the database for normalized field values (using the conditions of equals or not equals) can be configured to return the normal value (such as Xeon) rather than the original (raw) value.

Create the normalization record

Regardless of the normalization method selected, all field normalization requires a list of existing variants and a normal value that is configured to replace these variants in forms and in queries.

Normalize a field by selecting aliases for a normal field value or by creating rules that use condition statements to match field variants with a normal value.

Note: Users must have the normalizer role to create and manage normalization records.

Special Cases

- Reference fields cannot be normalized. To normalize values appearing in reference fields, normalize the field in the target table. Examples of this would be normalized values for the Name fields in the Company (core_company) and Location (cmn_location) tables, which are referenced by other tables in the platform. The normalized names are available to all fields that reference these tables.
- Fields in a choice list can be normalized if they are of a type string.

1. Activate the Field Normalization plugin.
2. Navigate to Field Normalization > Configurations > Normalizations.
3. Click New.
4. Create a normalization record.

Normalization record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this normalization record. This value is for reference only and is not used in any processing.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the ServiceNow table for the field being normalized.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field to normalize.</td>
</tr>
<tr>
<td>Mode</td>
<td>The three available modes are Off, Test, and Active. All normalization records are created in the test mode by default. If you are planning to select aliases for your normal values, change the Mode to Active. If you intend to normalize the field using rules, be sure to leave this record in the Test mode. To disable this normalization, switch the mode to Off.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Normalize query</strong></td>
<td>Select this check box to apply the field value normalized by this record to all queries involving this field. Queries formed with the raw (original) field value return records displaying the normal value. Queries issued by a script using the conditions equals or not equals return normalized values. See <a href="#">Normalized Queries</a> for details.</td>
</tr>
<tr>
<td><strong>Coalesce each normal</strong></td>
<td>Select this check box to normalize reference field values. This option resets all references to records containing an alias field value to the record using the normal value. See <a href="#">Coalesce Normal Values</a> for details.</td>
</tr>
<tr>
<td><strong>Raw field</strong></td>
<td>Select the field to use to display the original (non-normalized) input values on a form in which a field value has been normalized. For the selection to appear in the drop-down list, add a custom field to the form for the table selected. For instructions on adding a field for raw data, see <a href="#">Creating a Raw Field</a>.</td>
</tr>
</tbody>
</table>

After the normalization record is submitted, the platform runs the Pending value collection job in the **Data Jobs** related list automatically to gather all the current values (Pending Values) for the field being normalized.

Click the **Pending Values** related list to view values for the normalized field that have been entered manually, imported into the platform, or created by Discovery.
Create a normal value

A normal value is a simplified, generic value for a field that replaces all the possible variants of that value that exist in the database.

Role required: admin or normalizer

Normal values should be clear and unambiguous.

After the platform runs the data job, the Pending Values related list on the Data normalization jobs form is populated with all the unique values for the field in the database. Examine the values in
the list and decide which normalizing method is best for the existing data. For example, define an alias for a small pool of values and a rule for a large pool of values. The following screenshot shows the pending values for CPU types in Linux servers in a network. The list contains several choices for Intel Xeon CPUs, which might be normalized as Xeon.

Normalization pending values 2

1. Navigate to Field Normalization > Normalizations.
2. Open the appropriate normalization record.
3. Click the Normal Values related list.
4. Click New.
5. In the Normal Value form, create normal values for the variants in the Pending Values related list.
   These are the values the platform uses to replace the variants configured as aliases.
Create aliases

Aliases are the variants of a field value in the instance that will be replaced by the normal value.

Role required: admin or normalizer

The list of potential aliases is the contents of the Pending Values related list. After creating a normal value, assign aliases to this value if the pool of pending values is small. A normalized field can have a combination of aliases and rules.

1. Navigate to Field Normalization > Configurations > Normalizations.
2. Open a normalization record.
3. Click the Normal Values related list.
4. Select one of the values.
5. In the normal value record, click the Aliases related link.

6. Select aliases for this normal value from the available (pending) values that appear in the slushbucket, and then click OK.
The aliases for this normal value now appear in the **Aliases** related list.
Apply the aliases by running the associated data jobs.

**Apply aliases**

After testing, aliases can be normalized in all new records or in existing records when they are updated.

Each time an alias is created for a normal value, a data job is created. The alias is not applied to values in the entire database until its data job is started manually. Run each job separately or run the jobs together to apply all aliases at once.

1. In a normalization record, ensure that the **Mode** is set to Active.
   
   Data jobs cannot run in the **Test** mode.
2. Click the **Normal value** related list.
3. Select a value from list.
4. In the Normal Value record, select the **Data Jobs** related list.

   A data job is listed for each alias configured for this normal value.

5. Run the extant data jobs to replace the aliases with the normal value in all existing records in the database.
   1. Select the check box next to a job, and then select **Start** from the Actions menu.
   2. To run all data jobs at once, select all the check boxes, and then select the **Start** action.
   3. Refresh the list to check the progress of the data jobs to ensure that they complete normally.
Create rules

The use of rules to normalize a field is intended for large lists of variant field values.

Always test your rules before applying them to all the existing records in the database. Prior to creating the rule, make sure to generate the list of Pending Values and create a normal value for the field. A normalized field can have a combination of aliases and rules.

The rules in this example are based on the following Pending Values:
Normalization rules 3

1. In a Normalization record, open the Normal Values related list.
2. Open a Normal Value record.
3. Open the Rules related list in the Normal Value form, and then click New.

The Field Normalization Rule form provides the following fields:
### Field normalization rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this rule. For example, this name might be Xeon CPU Type.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which this rule should be evaluated. The platform parses the rules in the order configured until it finds one that evaluates to true.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables or disables this rule. By default, new rules are active (true)</td>
</tr>
<tr>
<td>Make alias</td>
<td>If this check box is selected, and the rule evaluates to true, the rule makes an alias automatically from a pending value. If this check box is not selected, and the rule evaluates to true, the platform automatically changes the value for the named field in the record to the normal value, but does not create an alias.</td>
</tr>
<tr>
<td>Case sensitive</td>
<td>All pending values for the named field must match the case of the same value in a rule to be normalized.</td>
</tr>
<tr>
<td>Rule</td>
<td>Use the ServiceNow rule builder to construct the rules for normalizing fields. Rules automate the transformation of large numbers of pending field values into aliases.</td>
</tr>
</tbody>
</table>

4. Create a set of rules to incorporate all the possible variants of the pending values.

For this example, the rules might be:

- **Intel Xeon:** CPU type matches pattern *Intel*Xeon*. This rule normalizes all variants in which Intel precedes Xeon, including Intel Xeon, Intel(R) Xeon(TM) CPU 2.80GHz, and Intel(R) Xeon(TM) CPU 3.00GHz.
- **Xeon:** CPU type contains Xeon
- **L3350:** CPU type contains L3350
- **E3350:** CPU type contains E3350
For every rule that is created, the platform generates a **Rule applier** data job. In the testing mode, the **Start** controls are not available, and the job cannot be run until the mode is changed to **Active**.

5. Test all the rules before making the normalization record **Active**.

**Testing Rules**

---

**Note:** Users must have the normalization_tester role to create test records.

Field normalization records are created in the **Test** mode by default, enabling administrators to test normalization rules thoroughly before applying them to the existing records in the database. In the testing mode, the **Start** controls are not available for the **Rule applier** data job. The job can be run only when testing is complete and the **Mode** has been changed to **Active**. In the testing mode, only records that have been created or updated by a user with the normalization_tester role are normalized. The normalizer and normalization_tester roles can be combined for a single user or granted separately.

---

**Coalesce records on a normal value**

Coalescence enables an administrator to redirect references to multiple records containing variants of the same field value to point to a single record, based on a normal value.

An example of this is the Company table that might have multiple variants of a company name, such as Hewlett-Packard, Hewlett-Packard, Inc., Hewlett-Packard Incorporated, HP, and so on. Potentially, thousands of records might reference each of these duplicate company records. Using the variants of the Hewlett-Packard name as aliases, coalescence unifies all these
references into a single record that normalizes the **Name** field in the Company record to a normal value such as **HP**.

**Note:** Coalescing normal values changes the record values permanently. If a rollback is performed, records will be returned to the table, but the normalized values will not be rolled back to the original variants.

1. Navigate to **Field Normalization > Configuration > Normalizations**
2. Select a normalization record.
3. Enable **Coalesce each normal**.
   The system adds the **Coalesce to** field to the Normal Value form.
4. Create one or more normal value records for this normalization record.
   Create related aliases and rules as needed.
5. For each normal value record, set **Coalesce to** by selecting the record that contains the normal value.
   For example, suppose your Company table contains several variations of the name **ServiceNow**. When you create the Normal Value record, you select the Company record for **ServiceNow, Inc.**. During normalization, the system updates any references to variant records to instead refer to the normal record.
   The system updates any references to records that match aliases and rules to instead point to the normal record. The system also deletes the duplicate records from the table.
6. **Start** all the **Alias application** data jobs to replace the aliases with the normal value in existing records in the database.
   The system starts the **Coalesce to normal** data jobs for each alias.

**Transforms**

Transforms update field values by applying a transformation definition to the field contents such as replace text, change case, or round value.

**Transform definitions**

Transform definitions define the transformation actions available for a given field type. Administrators select a definition when they transform a field, and then provide the definition with the specific parameters that are applied to the transformation. For example, a definition can round up an integer or insert a value at a defined position in a string.

The system provides a number of definitions that are designed to meet the needs of most organizations, but administrators can create new definitions as needed. Transform definitions can be associated with existing Transform Categories or to new categories.

**Transform categories**

Transform categories are used to group the transform definitions together appropriately to present to users when creating new field transforms. You can create new categories for existing definitions or change the default associations of categories to definitions.

Transform categories are associated with normalization field types to present the correct definition option list for the field being transformed. The base system provides two transform categories: Text and Numeric.

**Text**
Definitions in the Text category transform string type field values. Included in the Text category are:

- Left
- Right
- Constant
- Trim
- Prefix
- Suffix
- Change Case
- Delete
- Insert
- Substring
- Replace

**Numeric**

Definitions in the Numeric category arithmetically manipulate integer type field values. Included in the Numeric category are:

- Limit
- Round
- Constant

**Transformation testing mode**

Transformation is a powerful tool that can cause data issues if used incautiously. Test all transformations before committing the changes to the CMDB.

All transformation records open in **Test** mode by default, which blocks administrators from running manual data jobs that apply changes to existing data. Only users with the normalization_tester role can transform data when a record is in the **Test** mode. This is limited to new records opened by the tester or records in which the transformed field is updated by the tester.

To apply transformations to the CMDB after testing, change the mode to **Active** in the transformation record and run the appropriate data job. For information on testing transforms, see [Test a transform](#).

**Transform a field**

Transform the contents of field using a set of rules and conditions.

Role required: admin or normalizer

1. Create a transformation record.
2. Create one or more related transform records.
3. Test the transform.
4. Runs data jobs.

If you want to also show what the original (raw) input value was prior to transformation, create a raw field to store this value. 

**Create a transformation record**

Creating a transformation record is the first step in transforming a field.

1. Activate the Field Normalization plugin.
2. Navigate to Field Normalization > Configurations > Transformations.
3. Click **New**.
4. Create a transformation record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this transformation record. This value is for reference only and is not used in any processing.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the ServiceNow table containing the field being transformed. It is important to understand the table hierarchy when setting up a field transform. For example, if you configure transformation for a field in the Computer (cmdb_ci_computer) table, that field will be transformed for all workstation machines, Windows servers, Linux servers, and UNIX servers.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field to transform. The list presented contains only those field types (integer and string) from the table selected that can be transformed. <strong>Note:</strong> The sys_user record that initiates the transform process must have its date format set to the default format of 'yyyy-MM-dd.' Any other date format causes an error during transformation. This problem is only specific to transforming <strong>TO</strong> TARGET fields of type Date/Time. This problem is not an issue if the target field type is of type String or if the field mapping for the date field is changed to the same date format as the transformation process.</td>
</tr>
<tr>
<td>Mode</td>
<td>The three available modes are <strong>Off</strong>, <strong>Test</strong>, and <strong>Active</strong>. All transformation records are created in the test mode by default. Do not change the mode until you have thoroughly tested the transformation. When testing is complete, change the mode to <strong>Active</strong>. To disable this transformation, switch the mode to <strong>Off</strong>.</td>
</tr>
<tr>
<td>Normalize query</td>
<td>Select this check box to apply the field value transformed by this record to all queries involving this field. Queries issued with the raw (original) field value will be edited to use the transformation value.</td>
</tr>
<tr>
<td>Raw field</td>
<td>Select the field to use to display the original input (non-normalized) values on a form in which a field value has been normalized. For the selection to appear in the drop-down list, add a custom field to the form for the table selected. For instructions on adding a field for raw data, see <a href="#">Create a raw field</a>.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Create one or more related transform records

Each related transform record performs a specific transformation type such as adding characters to the beginning of the value or replacing one string for another. You may need to create multiple related transform records to generate a preferred output field value.

1. In the Transformation record, select the Transforms Related List.
2. Click New.

A selection list of transform types appears, displaying only those transformations appropriate for the field type selected.

### Choose the type of transform you want to create:

<table>
<thead>
<tr>
<th>Text Transform that modify the text of the value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Case</td>
</tr>
<tr>
<td>Constant</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Insert</td>
</tr>
<tr>
<td>Left</td>
</tr>
<tr>
<td>Prefix</td>
</tr>
<tr>
<td>Replace</td>
</tr>
<tr>
<td>Right</td>
</tr>
<tr>
<td>Substring</td>
</tr>
<tr>
<td>Suffix</td>
</tr>
<tr>
<td>Trim</td>
</tr>
</tbody>
</table>

### Transform types

3. Select a transform type and provide the appropriate parameters.
4. Select an Order number for this transform.

**Note:** The conditions for the transforms are executed according to the order numbers assigned.

5. Select the Final check box to stop processing with this transform if the condition evaluates to true.
6. Select the Case sensitive check box to force case sensitivity in the condition statement.

The following transform example replaces the INC at the beginning of an incident number with the string ENG if the assignment group is ITSM Engineering.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Transformation record

7. Click Submit.

The new Transform appears in the Related List of the Transformation record.
When the Transform is created, a Transformation application data job is also created. This data job applies this transform to appropriate records in the entire database and should not be run until testing is complete.

8. Optional: Repeat steps 2 through 8 until the output value meets your desired criteria.

*Test a transform*
Verify the transform changes the field value as desired before applying them to existing records in the database.
Note: Users must have the normalization_tester role to create test records.

New transformation records open in the Test mode by default, enabling administrators to test transforms thoroughly before applying them to the existing records in the database. In the test mode, the Start controls are not available for the Transform application data job. There are two methods, listed below, for testing transforms before committing the transformations to existing data.

- Manually create or update test records.
  
  In the test mode, only records that have been created or updated by a user with the normalization_tester role are transformed. Grant the normalizer and normalization_tester roles to the same user or grant them to separate users.

- Use the Test transforms utility to enter a raw value and see the resulting transformed value.
  
  This feature enables a normalization tester to transform field values on the fly without opening or updating records. This utility tests all the transforms configured for this field.

  a) Open a Transformation record.
  
  b) Click the Test transforms Related Link.

A dialog box appears for testing field values.
c) Enter a value to transform in the **Raw data** field.

![Test Transform](image1.png)


d) Click **OK**.

The platform transforms the raw value in the **Transformed data** field.

![Test Transform](image2.png)

e) Enter new raw data to test other transforms.

f) Click **Cancel** to end the test.

g) When testing is complete, change the **Mode** to **Active** and run the data job.

**Default Transform Definitions**

The system offers default transform definitions for fields containing text, text numeric, and numeric values.

<table>
<thead>
<tr>
<th>Transform Type</th>
<th>Category</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change case</td>
<td>Text</td>
<td>Changes the case of the characters in the field value.</td>
<td><strong>Mode</strong>: Select one of the following modes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>Upper</strong>: Converts the value to all upper case characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>Lower</strong>: Converts the value to all lower case characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>Proper</strong>: Converts the value to title case, with the first character in each string in upper case, and the remaining characters of the string in lower case.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- <strong>Formal</strong>: Converts the value to a string in which only the first letter of the first word is in upper case.</td>
</tr>
<tr>
<td>Transform Type</td>
<td>Category</td>
<td>Description</td>
<td>Parameters</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Constant</td>
<td>Text Numeric</td>
<td>Converts the value in this field to a constant.</td>
<td><strong>Constant</strong>: The constant with which to replace the value in this field.</td>
</tr>
</tbody>
</table>
| Delete         | Text           | Delete a specified sequence of characters from a field value.               | **Starting position**: Specifies the first character in a sequence of characters to delete from a string. See the discussion of position modes at the beginning of this section for details.  
|                |                |                                                                            | **Ending position**: Specifies the final character in a sequence of characters to delete from a string. See the discussion of position modes at the beginning of this section for details. |
| Insert         | Text           | Insert a fixed character sequence into a field value.                      | **Position**: The character position at which to insert the new value. See the discussion of position modes at the beginning of this section for details.  
|                |                |                                                                            | **Insert**: The value to insert into this field.                            |
| Left           | Text           | Deletes or keeps a specified number of characters from the left side of this field value. | **Position**: Specifies the number of characters to keep or delete from the left side of the value. See the discussion of position modes at the beginning of this section for details.  
|                |                |                                                                            | **Mode**: Select the mode for this transform: Keep or Delete.               |
| Prefix         | Text           | Adds characters to the beginning of a field value.                         | **Prefix**: Defines the characters to add to the beginning of the transformed field value. |
| Replace        | Text           | Replaces occurrences of one string with another string. The special characters backslash (\) and dollar sign ($) in the replacement string can cause the transform to be different than if the replacement string were being treated as a literal replacement string. Use a regular expression to replace a string or parts of a string. | **Find**: Enter the string or regular expression to replace.  
<p>|                |                |                                                                            | <strong>Replace with</strong>: Enter the replacement string.                             |</p>
<table>
<thead>
<tr>
<th>Transform Type</th>
<th>Category</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
</table>
| Right          | Text     | Retains or deletes a specified number of characters from the right side of a field value. | • **Position:** The number of characters to delete or keep from the right side of this transformed field. See the discussion of position modes at the beginning of this section for details.  
• **Mode:** Select the mode for this transform: **Keep** or **Delete**. |           |
<table>
<thead>
<tr>
<th>Transform Type</th>
<th>Category</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
</table>
| Round         | Numeric     | Rounds integers to a configured rounding interval using specific criteria. The interval must be appropriate to the value being transformed, such as an interval of 12 for a value expressed in dozens or 0.01 for decimal values expressed in hundredths. | - **Interval**: Select the rounding interval that is appropriate to the units of the field value. For example, an interval of 256 is appropriate for expressing RAM values in megabytes, but does not work for Disk space expressed in gigabytes. The rounding interval for the examples below is 1.  
- **Mode**: Criteria for applying the rounding interval.  
  - **Half up**: Always round up a value that is exactly half way between two intervals. For example, 3.5 is always rounded up to 4, and -3.5 is always rounded up to -3.  
  - **Half down**: Always round down a value that is exactly half way between two intervals. For example, 3.5 is always rounded down to 3, and -3.5 is always rounded down to -4.  
  - **Half away from zero**: Always round an integer that is half way between the specified interval away from zero. For example, 3.5 is always rounded to 4, and -3.5 is always rounded to -4.  
  - **Half toward zero**: Always round an integer that is half way between the specified interval toward zero. For example, 3.5 is always rounded to 3, and -3.5 is always rounded to -3.  
  - **Half to even**: Always round an integer that is half way between the specified interval to the nearest interval whose least significant digit is even. For example, 3.5 is always rounded to 4, and 4.5 is always rounded to 4.  
  - **Half to odd**: Always round an integer that is half way between the specified interval to the nearest interval whose least significant digit is odd. For example, 3.5 is always rounded to 3, and 4.5 is always rounded to 5.  
  - **Up**: Always round an integer up by the specified rounding interval. For example, 3.4 is always rounded to 4 by a rounding interval of 1.0.  
  - **Down**: Always round an integer down by the specified rounding interval. For example, 4.6 is always rounded to 4 by a rounding interval of 1.0. |
<table>
<thead>
<tr>
<th>Transform Type</th>
<th>Category</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
</table>
| Substring     | Text     | Keep or delete characters from a specified sub-sequence of characters in the field value. | • **Starting position**: Specifies the first character in a sub-sequence of characters within the value. See the discussion of position modes at the beginning of this section for details.  
• **Ending position**: Specifies the final character in a sub-sequence of characters within the value. See the discussion of position modes at the beginning of this section for details.  
• **Mode**: Select whether to Delete the sub-sequence selected or Keep only those characters defined. |
| Suffix        | Text     | Appends characters to the end of a field value. | **Suffix**: Defines the suffix to add to the end of the field value. |
| Trim          | Text Numeric | Removes blank spaces from the field value. | No parameters |

### Create a transform definition

The following example describes the procedure for creating a new transform definition. In this example, we create a definition that transforms a number field to an odd or even integer. The transform category is **Numeric** and the normalization field type is **Integer**.

1. Navigate to **Field Normalization > Administration > Transform Definitions**.
2. Click **New** in the record list.
3. Enter a name for this definition. **Note**: In this example, we enter **Odd/Even**.
4. Enter a brief description of the action, such as, **Transforms an integer to an odd or even value**.
This information appears in the definition choice list when a user selects a new transform.

5. Right-click in the header bar and select **Save** in the context menu.

Two Related Lists appear in the form.

- **Transform Categories**: Click **Edit** and select **Numeric** as the category to which this definition belongs. Currently, field transformation supports two categories: **Numeric** and **Text**. The **Integer** normalization field type is already associated with this category.
- **Transform Variables**: Define any variables required by this transform definition to perform an action on a field value. Variables are not necessary if a script can perform the action alone.

### Create a transform variable for a transform definition

Transform variables enable an administrator to apply the same definition to different fields in different ways.

Transform variables contain values used by a script to perform a field transformation. Scripts and variables can be created in either order, but the script must use the transform variables. Transform variables are populated with values when a user configures a transform type.

1. In the Transform Definition record, click **New** in the **Transform Variables** Related List.
2. Complete the form.
Important considerations for completing a form:

- The Column name is an entry in the fn_transform_var table for this variable. This becomes the variable in the script, in the form of variables.<variable name>. For this example, we enter `odd_even`.
- The value in the Label field appears as the variable field label in the Transform form. In our example we enter `Odd/Even`.
- The field Type defines the field type of the variable value. Because the values for the variables used are "even" and "odd", this is a type of string.
- The Order of the variables controls the order in which they are displayed in lists and records.
- This variable has a choice list with two options: Even and Odd. We select Dropdown without - None as our format for the list in the Choice field and define a Default value of `even` when the list is displayed.
- Create a Hint that becomes a tooltip for the variable in the Transform record.

3. Right-click in the header bar and select Save from the context menu.

The Variables Choice List Related List appears.
4. Click **New** in the Variables Choice List and define the list options.
5. Create records for **Even** and **Odd**.

**Note:** The **Element** value is the same as the **Column** name in both selections for the choice list.
6. Save the choice list variables and return to the transform definition form to create the script.

Create a script for a transform definition

Create the script at any time during the configuration of a definition.

The script can perform a transform action without using a variable, but the action of the definition will be the same for all fields. Variables create more flexibility for the definition, enabling an administrator to use the same definition in different ways in different places. If a variable is defined, the script must reference the variable using the correct format.

There are three arguments in the script:

- Variables: Contains the variables using the format variables.<variable name>.
- Value: Contains the un-transformed value
- Parameters: Special objects that set debug messages.

All position parameters (such as Starting position and Ending position) have three modes that apply to all the transform types that use this variable.

<table>
<thead>
<tr>
<th>Position parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive positions</td>
</tr>
</tbody>
</table>

### Negative positions

If the position is expressed as a negative integer, the platform calculates the position beginning from the right side of the field value. For example, in the string ABCDE, a position of -3 places the starting point of the action before C.

### Regex

If the position value starts with `/regex/`, everything after that is a regular expression that is used to calculate the starting position. For example, in the string ABCDE, a position of `/regex/B.*D` places the starting point of the action after C (B and all the characters between B and D).

1. Open the **Odd/Even** record in the Transform Definitions module.
2. Enter the following script to pass values with the odd_even variable.

```javascript
function(variables, value, parameters) {
    var odd = ('odd' == variables.odd_even);
    var val = value - 0;
    var val_odd = ((val & 1) == 1);
    if (odd != val_odd)
        val++;
    return '' + val;
}
```

Notice that the script references the variable in the form variables.odd_even.
<table>
<thead>
<tr>
<th>Name</th>
<th>Odd/Even</th>
</tr>
</thead>
</table>

**Description:**
Transforms an integer to an odd or even value

**Script:**
```javascript
function(variables, value, parameters) {
  var odd = ('odd' === variables.odd_even);
  var val = value - 0;
  var val_odd = ((val & 1) === 1);
  if (odd != val_odd)
    val++;
  return '' + val;
}
```

**Transform Category:**
Model = Odd/Even

**Transform Variables:**
- **Odd/Even**: odd_even, Type: Integer, Max Length: 10, Order: 100

**Actions:**
Actions on selected rows...
3. Update the record to complete the configuration.
   The Odd/Even transform definition is now ready to use in a field transformation.

Create a transform category

Create a transform category to group the transform definitions together.

1. Navigate to **Field Normalization > Administration > Transform Categories**.
2. Click **New** in the **Transform Categories Related List**.
3. Enter the **Name** of this category and a description.
4. Select an **Order** for this category and save the record.
   The order determines the display order of categories in lists and forms. Two Related lists appear:
   - **Field Types**: Click **Edit** to select an existing field type for this category or click **New** to create a new field type. The normalization field types provided are:
     - Decimal
     - Float
     - Integer
     - Numeric
     - String
     - URL
   - **Transform Definitions**: Click **Edit** to select the transform definitions that are included in this category.

Regular expressions and patterns in field normalization rules

Field Transformation definitions support the use of regular expressions (referred to in the platform as **regex**) and pattern matching for determining the position of characters in a string.

After identifying the target characters, field transformation can replace or delete the identified characters or insert other characters at that position.

**Regex**

Regular expressions can be used in transform parameters and in condition statements to determine which characters in a field value are transformed.

- **Transform parameters**: Regular expressions used as parameters to locate characters in transformed field values must begin with `/regex/`. Everything after that is a regular expression that is used to calculate character position.

**Example**

The computer names in an organization's Windows network are expressed as domain\machine name, such as `development\devlab01`. The network administrator wants to simplify these names by removing the domain name and backslash. He creates a transformation record for the Computer (cmdb_ci_computer) table and selects the **Name** field to transform.
The network contains several domains, and each domain contains numerous computers. The only character common to each name is the backslash. To delete the domain name, the administrator decides to use a regular expression to replace the entire raw value in the field with the characters that appear after the backslash (the actual machine name). He creates a new Transform using **Replace** as the Transform Type and enters the following values:

- **Find:** `/regex/.*\(.*\)`
- **Replace with:** `$1`

---

**Transformation regex example**

The network contains several domains, and each domain contains numerous computers. The only character common to each name is the backslash. To delete the domain name, the administrator decides to use a regular expression to replace the entire raw value in the field with the characters that appear after the backslash (the actual machine name). He creates a new Transform using **Replace** as the Transform Type and enters the following values:

- **Find:** `/regex/.*\(.*\)`
- **Replace with:** `$1`
The regular expression `.*\\\(.*\)` represents the entire raw value in the **Name** field - in this example `development\devlab01`. The first part of the expression, `.*`, represents everything before the backslash (the **development** domain name). The backslash by itself is the escape character in regular expressions and requires special syntax to retain its function in the computer name. The administrator must escape it by using another backslash (`\\` means `\`). The part of the expression after the backslash, `\(`, represents the computer name (**devlab01**) and is grouped within parentheses for reference. The value in the **Replace with** field, `$1`, references this group and replaces the entire raw value of the field with the contents of the group, `devlab01`.

The administrator clicks **Test transforms** in the transformation record and enters `development\devlab01` in the **Raw data** field. He then clicks **OK** to apply the transform to the test value. The transform replaces `development\devlab01` with `devlab01`.

![Transformation Regex 3](image)

When the transforms for this field are tested successfully, the administrator changes the **Mode** in the transformation record to **Active** and runs the Transformation application data job to apply this transformation to existing records in the database.

**Pattern matching**

Pattern matching in Field Normalization uses special characters differently from regular expressions to create patterns that the platform recognizes when transforming field values.

Pattern matching can be used only in condition statements. When using pattern matching characters in a condition statement, make sure to select the **matches pattern** operator.

Use the following special characters to create patterns for searches.

- The asterisk in a search string (`*`) matches any number (including zero) of any character.
- The question mark (`?`) in a search string matches one of any character.
- Everything else in a search string matches itself.

**Examples**

- `the story` matches `the story` but not `that story`.
- `*story` matches `the story` and `that story`, but not `that story is the best`.
- `st?ry` matches `story` and `stxry`, but not `my story` or `stairy`.
- `*b?gus*` matches `bogus`, `my bogus story`, and `His bagus machine`, but not `my bgus story` or `my baigus story`.

**Data policy**

Data policies enable you to enforce data consistency by setting mandatory and read-only states for fields.
Data policies are similar to UI policies, but UI policies only apply to data entered on a form through the standard browser. Data policies can apply rules to all data entered into the system, including data brought in through import sets or web services and data entered through the mobile UI.

For example, suppose that you are configuring a web service that allows users from outside the platform to update problems on the ServiceNow instance. Since these problems are not updated through the instance UI, they are not subject to the UI policies on the problem form. To ensure that the Close notes field is completed before a problem is marked Closed/Resolved, you can create a data policy that applies to server-side imports. Data that does not comply with this data policy produces an error. You can also apply the policy on the browser by selecting the Use as UI Policy on client check box in the data policy record.

Since UI policies can also manage the visibility of fields on a form, you may want to augment UI policies with data policies rather than replace them.

By default, data policies are applied to all GlideRecord operations including those used in Scripted REST APIs, and the REST Table API. You can opt out of applying the data policy to:

- Target records of SOAP web services
- Import sets
- Client-side UI policies

The admin role is required to edit data policies.

**Note:** Defining a data policy enforces the policy when a record is submitted from the UI. This behavior cannot be changed.

### Installed with data policy

Data policy includes several components that are installed on the instance.

**Tables**

- Data Policy [sys_data_policy2]
- Data Policy Rule [sys_data_policy_rule]

**Roles**

The following role is available with data policy:

- data_policy_admin: Allows you to grant access for maintaining data policy to specific users. You may have to grant this role access to the System Policy application.

**Data Policy Module**

The System Policy > Data Policies module displays a list of all data policies and where they apply.
Create a data policy

You can create a new data policy to define data rules for a table.

Create data policies to enforce consistency. You can create data policies only for tables and database views that are in the same scope as the data policy and for other tables that have at least one field in the same scope as the data policy. For tables that are in a different scope from the data policy record, you can create data policy rules only for fields in the same scope as the data policy and you cannot make a field mandatory.

1. Navigate to Data Policies by completing one of the following actions.
   - From any form header, right-click the header bar and select Configure > Data Policies.
   - In List v2, open any column context menu and select Configure > Data Policies.
   - In List v3, open the list title menu and select Configure > Data Policies.

2. Click New.

3. Select any options for the data policy.

4. Create the condition that must exist for the platform to apply this policy.
   For example, your conditions might include (Problem state) (is) (Closed/Resolved)

5. Right-click the header and select Save.

6. Click New in the related list and create the record that identifies the field and the policy to apply.
It is possible to have multiple rules on a single field, but it is not recommended.

7. Click **Submit**.
8. Optional: Add more rules by repeating steps 6 and 7.

Data policy fields
These fields appear on the Data Policy form and related forms.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table to which this policy applies.</td>
</tr>
<tr>
<td>Note:</td>
<td>The list shows only tables and database views that are in the same scope as the data policy.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that contains this data policy.</td>
</tr>
<tr>
<td>Inherit</td>
<td>If selected, applies this data policy to tables that extend the specified table. For example, incident, problem, and change tables all extend the task table, therefore selecting Inherit on a data policy defined for task would apply the data policy to them as well.</td>
</tr>
<tr>
<td>Reverse if false</td>
<td>If selected, the data policy action is reversed when the conditions evaluate to false. For example, when the conditions are true, then actions are taken and when they change to false, the actions are reversed.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the data policy is used.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description that identifies the policy.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the policy.</td>
</tr>
<tr>
<td>Apply to import sets</td>
<td>If selected, the data policy applies to data brought into the system from import sets. This option also applies to web service import sets.</td>
</tr>
<tr>
<td>Apply to SOAP</td>
<td>If selected, the data policy applies to data brought into the system from a SOAP web service. Scripted SOAP web services are not affected. This field does not affect data policy interaction with REST web services.</td>
</tr>
<tr>
<td>Use as UI Policy on client</td>
<td>If selected, enforces the data policy on the UI using the UI policy engine.</td>
</tr>
</tbody>
</table>

Data policy rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table on which the data policy action applies.</td>
</tr>
<tr>
<td>Field name</td>
<td>The field from the specified table to which the data policy will apply.</td>
</tr>
</tbody>
</table>
### Convert a UI policy to a data policy

To make a UI policy the default setting, convert the UI policy to a data policy.

**Role required:** ui_policy_admin

You can also apply a UI policy to import sets or to data imported by SOAP web services when you convert it to a data policy. Converting a UI policy to a data policy deactivates the UI policy. To retain the policy in the UI, ensure that the **Use as UI Policy on client** check box is selected on the data policy record.

For a UI policy to be eligible for conversion to a data policy, the following conditions must be met on the UI Policy form.

- The **Run scripts** check box must be cleared.
- The **Global** check box must be selected.
- None of the UI policy actions can have **Visible** set to **True** or set to **False**. **Visible** must be set to **Leave Alone**.

1. Navigate to **System UI > UI Policies**.
2. Open an existing UI policy.
3. Under **Related Links**, click **Convert this to Data Policy**.
   - A new data policy record is created.
4. Edit the fields on the data policy record as necessary.

### Convert a data policy to a UI policy

Converting a data policy to a UI policy is useful if a data policy already exists, but only needs to apply to records created or updated in the browser.

**Role required:** admin

Converting deactivates the data policy - the new UI policy is applied only at the UI layer only and not to import sets or data imported from SOAP web services.
Note: An alternative to converting from a data policy to a UI policy is to select the **Use as UI Policy on client** checkbox on the data policy record. This field extends the data policy to the UI. The main difference between converting and using the **Use as UI Policy on client** checkbox is that converting provides the **Visible** field on the UI policy record. Use the **Visible** field to select how the UI policy affects the visible state of the field.

1. Navigate to **System Policy > Rules > Data Policies** and click an existing data policy.
2. Under **Related Links**, click **Convert this to UI Policy**. A new UI policy record appears.

3. Edit the fields on the UI policy record as necessary. For details about the fields, see *Create a UI Policy*.

**Data policy debugging**

Debug messages can help administrators identify and resolve data policy problems.
Debug messages can help you identify and resolve data policy problems. To view data policy debugging messages at the bottom of the screen, navigate to **System Diagnostics > Session Debug > Debug Data Policies**.

In the example, a data policy is in place to prevent the short description on an incident from being changed when the incident state is set to Open. A user edited the short description while the incident was open and tried to save the changes, but the data policy was enforced.

```
Debug Output: Others

- 16:13:37.693: DataPolicies Found: 2
- 16:13:37.693: Running Data Policy on incident "Users cannot edit the short description for a new incident"
- 16:13:37.694: Evaluating Condition
- 16:13:37.696: incident_state=1*EQ - true
- 16:13:37.697: Field Short description is Read Only
- 16:13:37.697: Evaluating Condition
```

### Data policy debug messages

### Data lookup and record matching support

The data lookup and record matching feature enables administrators to define rules that automatically set one or more field values when certain conditions are met.

Data lookup rules allow administrators to specify the conditions and fields where they want data lookups to occur. For example, on Incident forms, there are priority lookup rules for the sample data that automatically set the incident **Priority** based on the incident **Impact** and **Urgency** values.

**Note:** Activating the Data Lookup and Record Matching Support plugin replaces the `calculatePriority` business rule with a priority data lookup definition, but does not transfer any custom logic. If you manually activate the plugin, you must recreate any custom business logic that uses the priority lookup rules.

### Create custom data lookups

Creating custom data lookups involves adding a lookup value, creating the definition, and activating data lookup.

### Create a custom data lookup table

Create a custom table to store lookup data.

The custom table must extend the Data Lookup Matcher Rules `[dl_matcher]` table. For example, this custom lookup table stores information about VIP callers and incident assignments.
Custom data lookup table

<table>
<thead>
<tr>
<th>Field</th>
<th>Sample value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>VIP Caller Lookup</td>
</tr>
<tr>
<td>Table name</td>
<td>u_vip_caller_lookup</td>
</tr>
<tr>
<td>Extends base table</td>
<td>dl_matcher</td>
</tr>
<tr>
<td>Create new module</td>
<td>True</td>
</tr>
<tr>
<td>Add module to menu</td>
<td>System Policy</td>
</tr>
</tbody>
</table>

Add a data lookup value to the data lookup table

The columns of a data lookup table contain both matcher and setter field data.

Each data lookup is a query that searches for a row containing values that match the matcher fields. The data lookup then returns the value listed in the setter fields. For example, this Priority Data Lookup (dl_u_priority) table lists the combinations of impact and urgency (matcher fields) that produce a particular priority value (setter field).

Lookup table

<table>
<thead>
<tr>
<th>Matcher fields</th>
<th>Setter field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Urgency</td>
</tr>
<tr>
<td>1 - High</td>
<td>1 - High</td>
</tr>
<tr>
<td>1 - High</td>
<td>2 - Medium</td>
</tr>
<tr>
<td>1 - High</td>
<td>3 - Low</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>1 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>2 - Medium</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>3 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>1 - High</td>
</tr>
<tr>
<td>3 - Low</td>
<td>2 - Medium</td>
</tr>
<tr>
<td>3 - Low</td>
<td>3 - Low</td>
</tr>
</tbody>
</table>

1. In the navigation filter, enter the name of the new custom lookup table. For example, enter u_vip_caller_lookup.list.
2. **Configure the list** and create new fields, as appropriate. For this example, create the following new fields:

   **New fields**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Field length or Table to reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>Reference</td>
<td>User (sys_user)</td>
</tr>
<tr>
<td>Priority</td>
<td>Integer</td>
<td></td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Reference</td>
<td>Group (sys_user_group)</td>
</tr>
</tbody>
</table>

3. From the table list, click **New** and enter appropriate matcher and setter field values. For example:
New matcher and setter field values

<table>
<thead>
<tr>
<th>Matcher field</th>
<th>Setter fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>Priority</td>
<td>Assignment Group</td>
</tr>
<tr>
<td>Beth Anglin</td>
<td>2</td>
<td>VIP Issues</td>
</tr>
<tr>
<td>Fred Luddy</td>
<td>1</td>
<td>VIP Issues</td>
</tr>
</tbody>
</table>

**Note:** Each row in a data lookup table must be unique.

Create a data lookup definition record

Data lookup requires a definition record that specifies how to set one or more field values when specified conditions are met.

2. Click New.
3. Click Data Lookup Rule.
4. Complete the Data Lookup Rule form using the following table.

**Data lookup definitions fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the definition record.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Select the table containing the fields you want to automatically update with lookup values. Data Lookup Definitions are not inherited by extension tables. For example, a Data Lookup Definition on the Task table cannot match values on the Incident incident table.</td>
</tr>
<tr>
<td>Matcher Table</td>
<td>Select the table containing the lookup values. This table should always start with a u_ prefix.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to run this data lookup rule. Clear the check box to ignore this data lookup rule.</td>
</tr>
</tbody>
</table>
### Field Definitions Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on form change</td>
<td>Select this check box to automatically look up values whenever a user or onChange client script changes a field value on a source table form.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This does not include changes automatically made by other data lookup rules, such as the Priority Lookup Rules.</td>
</tr>
<tr>
<td>Run on insert</td>
<td>Select this check box to automatically look up values whenever a user creates a new record.</td>
</tr>
<tr>
<td>Run on update</td>
<td>Select this check box to automatically look up values whenever a user saves or updates a record.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Save.
6. From the **Matcher Field Definitions** related list, click New.
7. Complete the Matcher Field Definitions using the following table.

A data lookup only occurs on fields with matcher field definitions. The data lookup uses the values of the source table fields to look up one or more values from the matcher table. Note that data lookup does not work with **Journal** type fields.

#### Matcher Field Definitions Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Lookup</td>
<td>Displays the name of the parent data lookup definition record.</td>
</tr>
<tr>
<td>Source table field</td>
<td>Select the field from the source table that contains the data to match.</td>
</tr>
<tr>
<td>Matcher table field</td>
<td>Select the field from the matcher table that contains the data to match.</td>
</tr>
<tr>
<td>Exact lookup match</td>
<td>Select this check box to require the matcher table to contain a matching row for every possible combination of values (including blank values). Clearing this check box means that any blank values in the matcher table match any value. For example, suppose the Priority field is blank in the matcher table. When this check box is selected, there is a match only when the Priority value is blank in the source table row. When this check box is cleared, the blank matcher field value matches any value in the source table field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the lookup does not require an exact match, matcher table rows containing blank values are treated as wild cards, matching all values.</td>
</tr>
</tbody>
</table>

8. Click Submit.
9. From the **Setter Field Definitions** related list, click New.
10. Complete the Setter Field Definitions form using the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Lookup</td>
<td>Displays the name of the parent data lookup definitions record.</td>
</tr>
<tr>
<td>Source table field</td>
<td>Select the field from the source table that the data lookup updates.</td>
</tr>
<tr>
<td>Matcher table field</td>
<td>Select the field from the matcher table that provides the new value for the update.</td>
</tr>
<tr>
<td>Always replace</td>
<td>Select this check box to replace any existing value with a value from the data lookup. Clear this check box to ignore the update if the field has an existing value.</td>
</tr>
</tbody>
</table>

11. Click Submit.

12. Click Update.

For example, the following data lookup definition assigns incidents to the VIP Issues group based on the Caller field. In addition, the incidents are set to critical or high priority based on the caller.
Create a data lookup module

You can create a module for data lookup so it appears in the instance application navigator.

1. Navigate to **System Definition > Application Menus**, then select an application to add the module to.
2. In the Modules related list, click **New**.
3. Configure a module for the data lookup table you created using the following properties.
Module properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Required value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the data lookup table you created in Step 2. For example u_vip_caller_lookup.</td>
</tr>
<tr>
<td>Link type</td>
<td>List of Records</td>
</tr>
</tbody>
</table>

4. Click Submit.

Troubleshooting data lookup

If the custom data lookup definition rules are not behaving as expected, check for certain conditions.

- Verify that the data lookup definition is set to run on the appropriate events.
- Verify that the matcher field is not read-only. Since users cannot change read-only fields, user interactions cannot trigger an on form change event for read-only fields.
- Verify a client script is not changing a field value. Client scripts can trigger Run on form change events even on read-only fields.
- Verify that the data in the matcher table is correct.
- If the lookup requires an exact match, verify that there is a matcher table row for each possible combination (including blank values). The lookup fails if it cannot find a matching value.
- Verify that you have not created a recursive rule, such as:
  If Field A = 1, then Field B = 2. If Field B = 2, then Field A = 2

Currency administration

Currency fields provide features for handling display and calculations of currency values.

A currency field holds a value, a currency code, and a reference currency value.

- The currency code is a three-letter ISO code that identifies the currency in which the value is specified.
- The reference currency value is a number representing the currency value in the reference currency. The reference currency value is calculated by a rate conversion when the currency value is saved.

A price field is similar to a currency field, but with special features for conversion and display. To learn more, see Price fields.

Locale settings

There are two locale settings, system and user. The system locale determines the reference currency, and the user locale determines the session currency.

System locale

The system locale is set using the glide.system.locale property. The value is in the format Language.Country, where the language is an ISO 639 language code and the country is an ISO 3166 language code. Internally, this value is used as specified by Java. The system locale setting should be in the Java supported locales list. The system locale should be set once on a fresh zboot
because reference currency values in currency fields are assumed to be in the currency implied by the system locale. To set this property, see 
Currency system properties.

**Note:** Do not change the system locale after currency values have been entered into the instance. When you change the system locale, the reference currency values are not adjusted. There is no rate conversion. This persistence results in invalid aggregations and filtering.

---

**User locale**

The user locale, stored in the sys_locale table, is determined by the following, in order of consideration.

- User record in which both country and language are specified.
- System locale set using the glide.system.locale property.
- Browser locale.

Amounts in currency fields are composed of a currency code and amount. Amounts are always shown in the session currency and are formatted in the Java-specified format for the user locale.

**Session and reference currency**

The system uses two kinds of currency, session and reference.

The session currency is defined for the user by the user’s locale or single-currency mode. The reference currency is determined by the system locale. The reference currency is a standard used across the entire instance. Each time a value is entered in a currency or price field, the system stores three pieces of information:

- The value as entered, in the user’s locale.
- The currency code, in the user’s locale.
- The value converted to the reference currency using the current exchange rate.

**Note:** In multiple-currency mode, the currency code saved in currency field may not be the same as the session currency code. For example, the session currency could be the Euro and the number entered could be the Japanese Yen.

**Session currency**

When users view a currency value, they can see the value as entered or in the session-currency format. The format contains:

- The currency symbol
- The value converted to the session currency and shown in a localized number format.

The user’s locale determines the session currency format.

The number format can differ in features such as the decimal separator based on the locale; for example, the US formatting is 1,234,567.89 while German formatting is 1.234.567,89. The session currency is determined by the following, in order of consideration:

- Single-currency mode setup using glide.i18n.single_currency and glide.i18n.single_currency.code.
• The default currency for the user’s locale.

Reference currency

In order to perform calculations on heterogeneous currency values, the platform stores currency values converted to a system currency, referred to as the reference currency. Every currency field in the system contains a reference currency value. The reference currency is determined by the following, in order of consideration:

• The system locale set using the property glide.system.locale
• The Java default locale, typically en.US

The filtering and aggregation features use the reference currency value to perform calculations on default currency fields. This can yield inaccurate results because of conversion rate changes.

Issues with currency fields

Users are often confused by the results of filtering, sorting, and displaying currency fields because the system works with at least two currencies for each value: the session currency and the reference currency.

Note: Aggregations and filtering of currency fields use the reference currency, and the user sees the session currency. Because of changing conversion rates, the filtered reference currency values might not result in the same order as the session currency values would suggest. The same issue happens with aggregations.

The user might see the following issues:

• Lists filtered on currency fields might not be in the expected order because the reference currency values are used for filtering but session currency values are displayed.
• Aggregation of currency fields might not produce the expected results because reference currency values are aggregated and then converted to the session currency.
• Currency values might not be formatted as expected because currency values are formatted based on the user’s locale and not on the currency code.

The confusion is caused by the difference between session and reference currencies, changing conversion rates, and different session currencies used by different users.

Single-currency mode

Single-currency mode enables all users of the platform to view currency values in the same currency.

Before enabling single-currency mode, the system locale must be set. See Locale setting for valid locale formats.

To configure single-currency mode, set the following properties:

• glide.i18n.single_currency: true or false
• glide.i18n.single_currency.code: the three-letter ISO currency code
• glide.system.locale: the system locale

Using the single-currency mode has the following limitations:
• Single-currency mode changes the currency in the user views and does not change the number formatting. Even though users in different countries see currency values in one currency, the number formatting (as determined by the user’s locale) might not be what they expect.

• Because currency value input is constrained to the single currency, price fields cannot be used.

The effects of rate conversions can be avoided by setting the system locale and the reference currency to be the single currency.

Price fields

A price field is a currency field that enables control over conversions and display. The Service Catalog uses price fields.

The conversion and display selections can be chosen per price field and can be changed at any time. There are three variations:

• Calculated (Default): Behaves the same as the default currency field type. Whenever conversions are performed, the latest currency conversion rates are used. When the price field is displayed, it is shown in the user’s session currency.

• Fixed: When the price field is displayed, it is shown in the currency code used when the value was entered. Whenever conversions are performed, the latest currency conversion rates are used.

• Multiple: Enables you to enter multiple price values for an item using a different currency for each price. The field’s value is the value entered in the user’s session currency; otherwise, the first price entered is converted to the user’s session currency. Whenever conversions are performed, the latest currency rates are used. Note: The first value entered is used during display. The additional values are not used during calculations.

For examples of using price field, refer to the tables used in Service Catalog.

A price field’s currency code and numeric value can be changed in a form. An edit icon is shown next to the price field. Clicking the edit icon displays a form that can be used to edit all details of the price field:

• Currency: List of currencies enabled in the system in the combo box. In single currency mode, the currency is a label and cannot be changed.

• Amount: Numeric value formatted in the user’s locale

• Type: Combo box with calculated, fixed, multiple

• When the price type is changed to multiple, the system creates child records for all currencies enabled in the platform populated with values converted from the amount field using latest currency conversion rates.

• In single currency mode, the type cannot be changed.

• The price type can be modified any time.

Currency values in lists

In lists, currency values are displayed in the user’s session currency formatted for display in the user’s locale. Typically the currency symbol is followed by a formatted number.

Different field types appear as follows:

• Currency field type: Value in user’s session currency

• Price field type/Calculated: Value in user’s session currency

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
- Price field type/Fixed: Value in currency as entered by the user
- Price field type/Multiple: Value associated with the user’s session currency if this value exists; otherwise, the first value entered is converted to the user’s session currency

A Globe icon is displayed beside the currency value that enables the value to be changed to one of the following values:
- Value as entered by the user
- Value in session currency
- Value as entered and, in brackets, the value in reference currency.

The icon appears when the user’s session currency is different from the currency entered. Clicking the icon cycles through the listed displays.

In the preview for the record, currency values are shown as entered, formatted for display in user’s locale.

**Aggregation**

Aggregation operations can be used on currency columns. Aggregation operations include total, group by, average, minimum, and maximum. Aggregation is done in two steps:
- Aggregate the reference currency values for all records
- Convert this aggregate to the user’s session currency for display

**Note:** Because the conversion rate between the currency field’s value (what is displayed) and its reference currency value (used for the aggregation) might have changed, the result may not be what the user expects.

This limitation extends to different price types.
- For price type fixed, the calculated reference value can be old.
- For price type multiple, the reference value of the first price entered is used. The other values are not used.

The aggregate value is shown formatted in user’s locale with a currency symbol. Currency fields are stored with four decimal places, and aggregates have four decimal places. For upgrades, you must set the `glide.currency_price.use_all_fraction_digits` property. See Change currency decimal places for more information.

**Filtering**

You can set up filters on currency fields. The currency value is entered as a currency code and numeric value. Filtering is done in two steps:
- The filter currency value is converted to the reference currency.
- The filter’s calculated reference value is compared with the reference value in the records.

Matching records are shown in the list view.

**Note:** Because the conversion rate used when the filter is run might be different than the conversion rate used when calculating the reference values in the individual records, filtering results might not provide the expected result.

This limitation extends to different price types.
- For price type fixed, the calculated reference value can be old.
- For price type multiple, the reference value of the first price entered is used. The other values are not used.

**Currency values in forms**

In forms, currency values are shown in the currency in which they were entered.

A combo box gives the list of currencies available in the system. The format is determined by the user’s locale. When entering or changing the numeric value, format the value in the format specified by the user’s locale. In the form for a new record, the combo box with the list of currencies has the reference currency selected, and the numeric value set to zero.

If the record is read only, the currency value is shown as entered and formatted for display in the user’s locale. A price field shows the session currency value.

In single currency mode, the currency is a label and cannot be changed. The form for editing the details of fields previously mentioned cannot be accessed because the edit icon is not shown.

**Editing the currency instance table**

For users who can edit the currency instance table (fx_currency_instance), an edit icon appears next to the field. Users with the financial_mgmt_user role can edit the values associated with the currency field.

*Note:* Do not edit the fx_currency_instance table directly. The platform maintains these tables, and your changes could have unintended consequences.

**Currency values in reports**

Currency values in reports are in the user’s session currency formatted in the user’s locale with a currency symbol.

The user determines how the report is run.

- Shared report: The user who runs the report
- Scheduled report: Generally run as the user who scheduled the report

The two user-specific values in the report are:

- User session currency
- Converted value

*Note:* A user that has a different session currency than the person who runs a report might receive unexpected results.
Currency conversions

Currency values may be converted to other currencies when stored and accessed. Conversions may happen in these situations.

- The currency value is converted to reference currency when stored, whether on insert or update. This means that the reference currency value is saved as well as the currency value.
- The currency value is converted to the user’s session currency for display.
- The value entered for a filter from currency specified in the filter is converted to the reference currency.

Conversion rates are stored in the fx_rate table. Each record contains the conversion rate from a given currency to the Euro. The rates are updated daily from the ECB website by a scheduled job called ECB Exchange Rate Load.

A currency conversion from one currency to another involves two rates

- Rate to convert from the first currency to Euro
- Rate to convert from Euro to the second currency

Whenever a conversion is performed, the platform uses the latest conversion rates. Therefore, calculations can potentially yield unexpected results. For example:

- Different currency values can have different rates applied to them while storing the reference currency value. Aggregation therefore can combine values at different rates and convert back at another rate.
- A filter value is converted at current rates while the values it filters in the database can be converted at different rates. A filter for $100 at today’s rate can match a value of $99 obtained at yesterday’s rate.

Note: For display purposes, the currency value used is what the user entered converted to session currency. However, for aggregation and filtering, the reference currency value is used. Using the reference currency enables currency values converted at different rates to be compared together.

Schedule the rate update job

Schedule ECB Exchange Rate Load to perform a nightly download of currency-conversion tables from the European Central Bank (ECB). For information about turning off the regularly scheduled update and maintaining the Exchange Rate table manually, see Use your own currency-conversion rates.

You can adjust the frequency of this behavior or disable it entirely.

1. Navigate to System Scheduler > Scheduled Jobs.
2. Open the job named ECB Exchange Rate Load.
3. Modify the schedule, as needed.

After the job runs, rates are stored in and loaded from the Exchange Rate (fx_rate) table. Navigate to System Localization > Exchange Rates to see them.
Use your own currency-conversion rates

All currency conversions are based on the rates stored in the Exchange Rate table. You can turn off the regularly scheduled update from the European Central Bank, and maintain the table manually.

ECB Exchange Rate Load loads exchange rates from the ECB for the following currencies:
http://www.ecb.int/stats/eurofxref/eurofxref-daily.xml.

If ECB does not supply the daily rates for a specific currency, you can enter rates manually into the Exchange Rate table, use an import set, or use another service (for example, JSON or SOAP) that offers upload of more currency rates. You can then add a similar scheduled job to update these currencies.

1. Navigate to System Scheduler > Scheduled Jobs.
2. Open the job named ECB Exchange Rate Load.
3. In the Trigger type field, select -- None --.
4. Enter new exchange rates either manually or with an Import Set.

Currency values in import and export

In general, currency values crossing the boundaries of the platform are represented in the user’s session currency and formatted in the user’s locale.

Import

Currency values are imported as strings just like other fields. The default transform mapping to a currency field uses setDisplayValue(). The expected format for this function is:

- A number formatted in the user’s locale: this is taken as a value in the user’s session currency, for example, 1,234.56.
- The number prefixed by the three-letter currency code separated by a semicolon, for example, EUR;1.234,56.

This behavior can be customized in transform map scripts.

Export

Currency values are exported in the user’s session currency formatted in the user’s locale except when exporting as XML. When exporting currency in XML, the value is in the reference currency value with no formatting.

Currency values in scripts

You can use currency fields in scripts.

These methods are available on GlideElement objects.

To display currency values, use the display APIs (getDisplayValue()). To work with currency values in any way other than display, use the APIs that return/accept unformatted numbers.

Note: Do not use the getDisplayValue() methods and then process the string to remove formatting information before performing calculations on the value.
Methods such as `getValue()` and `getCurrencyValue()` return unformatted numbers as strings. The floating point value can be obtained by using the JavaScript function `parseFloat()`. The resulting value can be used to perform calculations. The currency associated with these values can be obtained by the APIs that return the currency code. You can also use the `getCurrencyCode()` methods to determine a field's currency.

```javascript
var rate = parseFloat(current.base_rate);
var currencyCode = current.base_rate.getCurrencyCode();
```

Use the `setValue()` method to set the value of a currency field. If the currency is the user’s session currency, use a plain number (either floating point number of a string containing it), otherwise prefix the value with the 3-letter ISO currency code.

```javascript
var totalCost = rate*current.hourly_rate;
current.total_cost.setValue(currencyCode + "\$" + totalCost);
```

When you use GlideAggregate on currency or price fields, you are working with the reference currency value. Be sure to convert the aggregate values to the user’s session currency for display. Because the conversion rate between the currency or price field’s value (what is displayed) and its reference currency value (used for the aggregation) might have changed, the result may not be what the user expects.

When a record containing a currency value is deleted, the platform deletes any associated currency records.

**Note:** Do not use `deleteMultiple()` on tables with currency fields. Always delete each record individually.

Currency values contain four decimal places.

- APIs that return values such as `getValue()` return up to four decimal places. Trailing zeros are always removed.
- APIs that return display values such as `getDisplayValue()` have at least two decimal places and up to four decimal places.
- GlideAggregate returns four decimal places.

You can have the system use two decimal places. See [Change currency decimal places](#) for how to change the number of decimal places used by the system. When set to two decimal places, numeric values returned by the API contain two decimal places. Although currency conversion rates may have more decimal places, currency fields store only two decimal places. APIs that accept numeric values round decimal places to two places.

- APIs that return values such as `getValue()` return up to two decimal places. The trailing zeros are removed for values read from the database, but if a value such as 00 is set later, 1.00 can be returned. The number of trailing zeros returned is not consistent.
- APIs that return display values such as `getDisplayValue()` contain up to two decimal places. This could sometimes return two places even for values such as 7.10, but could remove trailing zeros at other times. The number of trailing zeros returned is not consistent.
- GlideAggregate returns two decimal places.

In the following table, the example values use a currency value of 21345.67 in Japanese yen (1563.72 in Euros and 1152.48 in US dollars) with the user’s locale set to German (de.DE) and reference currency set to USD.
## Methods to access currency fields

<table>
<thead>
<tr>
<th>Method name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>getValue()</code></td>
<td>Returns the currency value in the user's session currency as an unformatted number.</td>
<td>1563.72</td>
</tr>
<tr>
<td><code>getReferenceValue()</code></td>
<td>Returns the currency value in the reference currency as an unformatted number.</td>
<td>1152.48</td>
</tr>
<tr>
<td><code>getSessionValue()</code></td>
<td>Returns the currency value in the user's session currency as an unformatted number.</td>
<td>1563.72</td>
</tr>
<tr>
<td><code>getCurrencyValue()</code></td>
<td>Returns the currency value as entered as an unformatted number.</td>
<td>21345.67</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This might not be the session or reference currency.</td>
<td></td>
</tr>
<tr>
<td><code>getDisplayValue()</code></td>
<td>Returns the currency value in the user's session currency formatted in the user's locale with a currency symbol.</td>
<td>€1.563,72</td>
</tr>
<tr>
<td><code>getSessionDisplayValue()</code></td>
<td>Returns the currency value in the user's session currency formatted in the user's locale with a currency symbol.</td>
<td>€1.563,72</td>
</tr>
<tr>
<td><code>getReferenceDisplayValue()</code></td>
<td>Returns the currency value in the reference currency formatted in the user's locale with a currency symbol.</td>
<td>$1,152.48</td>
</tr>
<tr>
<td><code>getCurrencyDisplayValue()</code></td>
<td>Returns the currency value as entered formatted in the user's locale with a currency symbol.</td>
<td>¥21,345.67</td>
</tr>
<tr>
<td><code>getCurrencyString()</code></td>
<td>Returns the currency value as entered as an unformatted number prefixed by the 3-letter ISO currency code separated by a semicolon.</td>
<td>JPY;21345.67</td>
</tr>
<tr>
<td><code>getCurrencyCode()</code></td>
<td>Returns the 3-letter ISO currency code for the currency value as entered.</td>
<td>JPY</td>
</tr>
<tr>
<td><code>getSessionCurrencyCode()</code></td>
<td>Returns the 3-letter ISO currency code for the user's session currency.</td>
<td>EUR</td>
</tr>
<tr>
<td><code>getReferenceCurrencyCode()</code></td>
<td>Returns the 3-letter ISO currency code for the reference currency.</td>
<td>USD</td>
</tr>
</tbody>
</table>
### Configure currency fields in audit records

You can control what currency value is stored in audit records.

**Role required:** admin

1. Navigate to `sys_properties.list`.
2. Find `glide.sys.audit_currency_value`, and set to the desired value.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>The value entered in the audit record is the numeric value in the session currency. The currency code is not included. This value is the pre-Istanbul behavior and the default.</td>
</tr>
<tr>
<td>true</td>
<td>The value as entered by the user in the format USD;1234.56.</td>
</tr>
</tbody>
</table>

### Change currency decimal places

You can specify the number of decimal places stored and used in currency fields and calculations.

**Role required:** admin

1. Navigate to `sys_properties.list`.
2. Find `glide.currency_price.use_all_fraction_digits`, and set to the desired value.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>Uses two decimal places. This value is the pre-Istanbul behavior and the default.</td>
</tr>
</tbody>
</table>
Configure currency optimizer

You can configure the system to use an optimizer for currency/price fields to speed up list view (reading currency/price values).

Role required: admin
1. Navigate to `sys_properties.list`.
2. To turn on the currency optimizer, find `glide.currency_price_optimizer.enabled`, and set to the desired value.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>Uses four decimal places.</td>
</tr>
<tr>
<td>false</td>
<td>The optimizer is not used.</td>
</tr>
<tr>
<td>true</td>
<td>The optimizer is used. This value is the default.</td>
</tr>
</tbody>
</table>

3. To set the minimum number of rows needed by the currency optimizer, find `glide.currency_price_optimizer.min_rows`, and set to the desired value.

   The default value is 4.

Currency system properties

You can control how currency fields are configured and used in your instance.

These properties are available for currency fields.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.sys.audit_currency_value</code></td>
<td>When <code>true</code>, currency fields in audit records are the value entered by the user, in the format USD; 1234.56. When <code>false</code>, the value is the numeric value in the session currency.</td>
</tr>
<tr>
<td>Type: Boolean</td>
<td>Default value: <code>false</code></td>
</tr>
<tr>
<td>Default value: <code>false</code></td>
<td>Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Learn more: Configure currency fields in audit records</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.currency_price.use_all_fraction_digits</td>
<td>When <strong>true</strong>, currency fields have four decimal places. When <strong>false</strong>, two decimal places are used.</td>
</tr>
<tr>
<td></td>
<td>• Type: Boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: <strong>false</strong></td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Change currency decimal places</a></td>
</tr>
<tr>
<td>glide.currency_price.optimizer.enabled</td>
<td>When <strong>true</strong>, the optimizer is used. When <strong>false</strong>, the optimizer is not used.</td>
</tr>
<tr>
<td></td>
<td>• Type: Boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: <strong>true</strong></td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Configure currency optimizer</a></td>
</tr>
<tr>
<td>glide.currency_price.optimizer.min_rows</td>
<td>The minimum number of rows in parent table needed for the optimizer. When fewer than this number of rows are present, the optimizer is not used.</td>
</tr>
<tr>
<td></td>
<td>• Type: Number</td>
</tr>
<tr>
<td></td>
<td>• Default value: <strong>4</strong></td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Configure currency optimizer</a></td>
</tr>
<tr>
<td>glide.system.locale</td>
<td>The value is of the format Language.Country where the language is an ISO 639 language code and the country is an ISO 3166 language code. Internally, this value is used as specified by Java. The system locale setting should be in the Java supported locales list.</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: empty</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; System Localization</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Locale settings</a></td>
</tr>
</tbody>
</table>

### Localization settings

Localization settings control translation, currency, and locale settings in the instance.

### Define locales

The base system allows you to specify your locale so information such as dates, times, and currencies display properly based on your location.

**Note:** Functionality described here requires the Currency Support for Service Catalog Plugin plugin. This plugin is automatically installed for new instances.
By default, the base system uses US standard formatting where the current default is the US dollar sign ($) displayed with two decimal places: $100.00. By customizing your locale, you can make things such as currency appear as you expect. For example, in France, you may want to see 100,00 € instead of $100.00.

How you display and utilize various locale information within your application form depends on how you want to use the information. For example, if you make a country field a reference field, then users can select from predetermined options. Also, script logic can then use the predetermined values of those options. If you want to avoid bad values or want to run scripts based on these values, use a reference field. If the country field is a simple string field, then users can enter whatever information they desire. Most companies restrict such free-form input to administrators or implementers who are setting up features and core company data. For example, do you want the country name to be “United States of America”, “USA”, “United States”, or “US.”

Set the instance locale

Set the instance locale using a locale code.

Role required: admin

1. Navigate to System Properties > System Localization.
2. Enter the locale code to use under Locale code to use for localization. Format is (language code).(country code) (e.g. en.GB for Britain fr.FR for France, de.DE for Germany, or ja.JP for Japan).

<table>
<thead>
<tr>
<th>Country</th>
<th>Locale code</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>en.US</td>
</tr>
<tr>
<td>Great Britain</td>
<td>en.GB</td>
</tr>
<tr>
<td>France</td>
<td>fr.FR</td>
</tr>
<tr>
<td>Germany</td>
<td>de.DE</td>
</tr>
<tr>
<td>Japan</td>
<td>ja.JP</td>
</tr>
</tbody>
</table>

3. Click Save.

Internationalization support

ServiceNow supports multiple languages, using UTF-8 for international characters.

When a user logs in, the system uses either the system default language or the language specified in the user record. This setting determines the language in which forms and messages are displayed throughout the session.

Language internationalization support

The ServiceNow system supports multiple languages, using UTF-8 for international characters.

When a user logs in, the language for the instance session is determined by the following logic:

1. If the language selection at login is enabled, that language is used.
2. If not, the language preference selected using the language picker in the header bar is used.
3. If not, the user’s language setting in the User (sys_user) table is used.
4. If none of the above are true, the system default language is used.

Some areas of the system are not translated, including journal fields, report titles, and any field that stores free-form text. These fields remain in the language used to create them.

When creating a custom field, you must add the labels in the Field Label table because they are not added automatically.

**FAQ**

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Will my custom fields be translated?</td>
<td>When you create a field, it does not create a translated label. Labels for custom fields are created with a language of English (en). You can, however, translate the fields manually.</td>
</tr>
<tr>
<td>I am not seeing journal fields translated.</td>
<td>User-defined string fields, such as short description, additional comments, and report titles are not translated. They appear in the language they were created in.</td>
</tr>
</tbody>
</table>

**Set default language for an instance**

You can set the default language for an instance. Do this after activating the plugin for the desired language.

Before selecting a new default language, activate the plugin for the desired language in System Definition > Plugins. The default global language for the system is set in System Properties > System Localization. This property defines the language that users see if a language is not specified in their user record.

**User specific language**

The user has several choices for identifying the language to be used for the instance, as described here.

- Language picker at login: If user-specific language is enabled, users see a choice list on the login page to select their language. To control display of the choice list on the login page, navigate to System Properties > UI Properties and use the property Show the language select box on the login page to allow the user to specify the language they would like to be logged in with.
- Language picker in the welcome banner (UI15): When an internationalization plugin is enabled, users can select their language in the language picker in the welcome banner.
- Language picker in the System Settings window (UI16): Users can select their language in the General tab of the System settings window. Access this window by clicking the gear icon on the right edge of the banner.

- Language setting on the user table: If you have users that require a different language in addition to the global language, you can specify a language for them in User Administration > Users. If the Language field isn’t already on the form, you can configure the form and add it.

The Language field in the User (sys_user) table overrides the default global language for that user’s sessions.

<table>
<thead>
<tr>
<th>User</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID:</td>
<td>french.itil</td>
</tr>
<tr>
<td>First name:</td>
<td>French</td>
</tr>
<tr>
<td>Last name:</td>
<td>ITIL</td>
</tr>
<tr>
<td>Language:</td>
<td>French</td>
</tr>
<tr>
<td>Title:</td>
<td>IT Technician</td>
</tr>
</tbody>
</table>

Note: Setting the language for the system guest user sets the language for both the login page and all users without a user role.

Translation tables

ServiceNow stores translation information in these tables.

- Languages [sys_language]
- Translated Name / Field [sys_translated]
- Message [sys_ui_message]
- Field label [sys_documentation]
- Choice [sys_choice]
- Translated Text [sys_translated_text]

Note: The Languages table is available only after I18N:Internationalization has been activated.

Languages table

The Languages [sys_language] table contains a list of the languages for which translated text is available.

To enable translation to a new language, add a record to the Languages table. The main fields for this table are:

- Name: language name.
- Text Direction: direction of text in this language.
- Active: indicator that shows whether the language has been activated (true) for this instance or not (false).
Configure a language as reading from right to left

Use the Text Direction field to configure a language that reads from right to left, such as Hebrew.

Role required: admin

Right-to-left language support is available only in the main user interface and on live feed. Other user interfaces and applications, such as the graphical Workflow Editor, reporting, CMS, chat, and the ServiceNow documentation sites, are not supported.

1. Navigate to System Localization > Languages.
2. Click New.
3. Enter the Name of the language, such as Hebrew.
4. Enter the two-character ISO 639.1 ID for the language. For example, Hebrew is he.
5. In the Text Direction field, select Right-to-Left.
6. Click Submit.

Translated Name / Field table

The Translated Name / Field [sys_translated] table stores translated values for text fields where the field type is translated_field (see the dictionary entry).

This option is available for text fields up to 255 characters in length. Some examples are names, titles, and short descriptions. The main fields for this table are:

- **Table**: name of the table this translation applies to.
- **Element**: name of the field this translation applies to.
- **Label (translate)**: translated text that users see on forms and lists.
- **Language**: two-character ISO language code for this translated text.
- **Value**: English value that causes this translated text to be displayed.
The Message [sys_ui_message] table contains the translations for informational messages, confirmation messages, error messages, and other types of system messages.

ServiceNow checks this table for translated text when a client script contains a `getMessage` call or a server script contains a `gs.getMessage` call. The main fields for this table are:

- **Application**: name of the application this message appears in.
- **Key**: internal unique identifier of this message.
- **Language**: language the message is translated into.
- **Message**: translated text that users see.

**Message list**

**Translated menu**

**Message table**

The Message (sys_ui_message) table contains the translations for informational messages, confirmation messages, error messages, and other types of system messages.

ServiceNow checks this table for translated text when a client script contains a `getMessage` call or a server script contains a `gs.getMessage` call. The main fields for this table are:

- **Application**: name of the application this message appears in.
- **Key**: internal unique identifier of this message.
- **Language**: language the message is translated into.
- **Message**: translated text that users see.

**Message list**
Field Label table
The Field Label [sys_documentation] table stores the text of table names along with the singular and plural labels for each field in the table.

For each table name and field label, the Field Label table contains a record for each installed language. ServiceNow uses the table and field names from this table to display lists and forms in the proper language. The main fields for this table are:

- **Table**: name of the table this translation applies to.
- **Element**: name of the field this translation applies to.
- **Language**: two-character ISO language code for the translated text.
- **Label**: translated text that users see.
- **Plural**: plural of the label.
- **Help**: reserved for future use.
- **Hint**: text that pops up when the cursor rests on the field.
- **URL**: URL for a web page that provides information about the field. When a URL is provided, the field label displays a help icon ( ).
- **URL Target (Supported on UI14 and lower)**: location where the URL appears, if a URL is given. If this field is empty, the URL opens in the current tab or window when a user clicks the help icon. If the field contains the code _blank, the URL opens in a new tab or window when a user clicks the help icon.
Field label

Translated field

 Choices table

The main fields for this table are:

- Table: name of the table this translation applies to.
- Element: name of the field this translation is used for.
- Language: two-character ISO language code for the translated choice.
- Value: English description of this choice.
- Label: translated text that users see for this choice.

Choice list

Translated choice list

**Translated text**

The Translated Text [sys_translated_text] table stores translations for fields with the field type translated_text or translated_html (see the dictionary entry).

This field type is typically used for long text fields, up to 6500 characters in length, such as survey name and introduction. The main fields for this table are:

- Document: internal identifier of the record this translation applies to.
- Field name: field this translated text appears in, for example, Close notes.
- Language: language the text is translated into.
- Table Name: table this translation applies to.
- Value: translated text that the user sees.
When setting up translations for the different areas of your instance, a property can be turned on that allows you to easily determine which table you need to add the translated label to.

Role required: admin

1. Navigate to System Properties > System Localization.
2. Select Display translation prefix on translatable strings.
3. After activating the property, refresh your browser.
4. Following the refresh, the following prefixes appear on fields, labels, and messages that have been translated internally.
Translate new customizations

When using one of the Internationalization plugins, most of the fields in the instance are automatically translated. However, customizations are not translated automatically, and need to be translated by hand. In this case, it is best to locate the individual untranslated strings, and insert those translations manually.

Below are three tools for locating untranslated strings:

- Displaying prefixes for translatable strings
- Exporting untranslated strings
- Using the translate and learn property

Locate translatable strings
These tables contain translatable strings, described more at length in Language Internationalization.

- Translated Name / Field (sys_translated)
- Message (sys_ui_message)
- Field Label (sys_documentation)
- Choice (sys_choice)

Display a translation prefix
Translation prefixes indicate where to find the string for translation.

Role required: admin

1. To enable prefixes on field labels for the current user session, navigate to System Localization > Enable I18N Debugging.
2. To disable prefixes for the current session, navigate to System Localization > Disable I18N Debugging.
For the prefix TRF, navigate to **System Localization > Translated Names / Fields**.
For the prefix MSG, navigate to **System Localization > Messages**.
For the prefix GMLD, navigate to **System Localization > Field Labels**.
For the prefix TRT, navigate to **System Localization > Translated Text**.
For the prefix CHC, navigate to **System Localization > Choices**.

Some few strings may not display translatable prefixes. This means that the string is not stored on any of these four tables. This behavior occurs with text embedded in images, such as the buttons in the Service Catalog, or text defined by properties, such as the text which follows the banner.

You must refresh your browser after accessing one of these modules to apply the change.

**Export an untranslated string**
One method for easily translating customizations is to export all of the translated names and fields, messages, field labels, and choices that only have English translations.

Role required: admin
To aid in this, there are four modules for the **System Localization** application menu that are active by default.
- Translated Name / Fields
- Messages
- Field Labels
- Choices

**Note:** The Customizations module is inactive by default. You must activate it to make it visible on the **System Localization** application menu.

1. Perform the appropriate action for your version of the UI:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UI16</strong></td>
<td>1. Navigate to <strong>System Definition &gt; Application Menus</strong>&lt;br&gt;2. Select <strong>System Localization</strong>.</td>
</tr>
<tr>
<td><strong>UI15 or UI11</strong></td>
<td>Right-click the <strong>System Localization</strong> application menu and select <strong>Edit Application Menu</strong>.</td>
</tr>
</tbody>
</table>

2. Use the list editor to set the **Active** field to **True** for the modules.
After the application navigator refreshes, the modules appear. Now it is possible to export the list of untranslated fields by viewing each of the lists and exporting it to any supported format. **Use the translate and learn property**

The *glide.translate.learn* system property, when set to true, creates records in the translate tables when an instance encounters text that should be translated, but no corresponding record exists. You can use this property to help locate untranslated strings.

**Note:** Using this method hampers the use of the exporting untranslated strings method.

For example: A user switches to the French language and opens a record. When loading the form, the instance looks at the Translated Field table to find the French translation for each field. If an appropriate translation record is not found, the instance automatically generates a stub record for that missing data, which can be manually translated.

The following HR application is missing translations for two modules:

The suffix (fr) indicates that there is a French translation missing. Because translation prefixes are enabled, the prefix *TRF:* indicates that the entry can be found in the Translated Name / Fields table. The following image shows untranslated modules, located using the filter (Label (translate)) (contains) (fr):

**Example untranslated modules**

**Service catalog buttons**

You can specify language-specific messages for buttons in these service catalog screens: Cart, Edit Cart, and Check Out (including workflows and approvals).
The text for the buttons is stored on the "Messages" table.

Activate a language

By default, the language supported by the platform is American English. You can activate other supported languages if you have the admin role.

The following plugins are currently available:

- I18N: Brazilian Portuguese Translations
- I18N: Czech Translations
- I18N: Dutch Translations
- I18N: Finnish Translations
- I18N: French Canada Translations
- I18N: French Translations
- I18N: German Translations
- I18N: Hebrew Translations
- I18N: Hungarian Translations
- I18N: Italian Translations
- I18N: Japanese Translations
- I18N: Korean Translations (deprecated)
- I18N: Polish Translations
- I18N: Portuguese Translations
- I18N: Russian Translations
- I18N: Simplified Chinese Translations
- I18N: Spanish Translations
- I18N: Thai Translations
- I18N: Traditional Chinese Translations
- I18N: Turkish Translations

In addition, the I18N: Internationalization plugin (com.glide.i18n) provides the elements necessary for translating an instance without any translation preloaded. This plugin is useful for translating an instance to a language other than those listed above. For more information on using the I18N: Internationalization plugin to translate an instance, see Translate an instance.

**Note:** Activating internationalization plugins for any of the available languages automatically activates the I18N: Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2).

Use the following steps to activate the desired language plugins.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

**Localyze price fields**

You can localize currencies for item prices and options.

**Note:** The system has the concept of a reference currency based on the global locale property. All currency values are automatically converted to the reference currency before aggregation or conversion. Do not change the global locale setting after you have data in the system. Changing the global locale setting after adding data to the system can cause aggregations to calculate and display incorrectly. See currency for more information.

See Price fields for information on the types of price fields supported.
See Currency values in scripts for information on using currency fields in scripts.

**Use translated text**

Each instance can be localized, translating the instance to the instance's local language.

Translated text fields allow the same field to display different content based on the user's language.

There are two different translated text fields:
These fields operate the same as text and HTML fields respectively, except that they can store multiple inputs in multiple languages.

The most frequent uses of translated text fields are in the Knowledge Base (e.g. article titles or content) or the Service Catalog (e.g. names, descriptions, or variables). The Knowledge Base also has an option for internationalization with the Knowledge Management Internationalization Plugin, which allows for language-specific articles rather than translating articles.

Note: The type is translated separately from Translated Text and Translated HTML fields.

Administer translated text fields

There is a slight performance penalty associated with changing a normal HTML or text field into a translated HTML or text field. It is best only to use translated fields if the translated capability is required.

English language text is stored in the master table, but the values of other are stored in the sys_translated_text table. Each translated field on every row has one or more entries in the sys_translated_text, one per language for which ServiceNow provides a translation.

Key Fields in the Translated Text [sys_translated_text] Table:
- tablename -- the table to which this translation belongs, e.g., problem
- fieldname -- the field to which this translation belongs, e.g., workaround
- documentkey -- the sys_id of the row to which this translation belongs, e.g., the sys_id of PRB00008
- language -- the two character ISO language code to which this translation belongs

Use translated text

Each instance can be localized, translating the instance to the instance's local language.

Translated text fields allow the same field to display different content based on the user's language.

There are two different translated text fields:
- Translated Text
- Translated HTML

These fields operate the same as text and HTML fields respectively, except that they can store multiple inputs in multiple languages.

The most frequent uses of translated text fields are in the Knowledge Base (e.g. article titles or content) or the Service Catalog (e.g. names, descriptions, or variables). The Knowledge Base also has an option for internationalization with the Knowledge Management Internationalization Plugin, which allows for language-specific articles rather than translating articles.

Note: The type is translated separately from Translated Text and Translated HTML fields.

Translate the content of a translated text field

After a translated text field or translated HTML field has been created and is in use, it displays English when viewed in a different language until the content is translated.
Be sure to confirm that the field is in fact a translated text field, and not a regular text or HTML field, for example, by right-clicking the field and choosing Personalize Dictionary.

The method below works best for one-off translations. To translate large numbers of translated text fields, use the Exporting Untranslated Strings method.

1. Use the language picker to switch to the language the field’s content is being translated to.
2. Navigate to the field on the form.
3. Replace the English text with the text of the target language.
4. Submit.

Now the text will display English when the user’s language is English and in the new language when the user’s language is set to that new language.

System localization

Localization allows administrators to accommodate users from a variety of different countries, using different languages and currencies, within the same instance.

The platform supports internationalization of language and localization of currencies and prices wherever they appear.

Set localization properties

System properties to localize the instance for users from multiple countries.

Role required: admin

Some localization properties only appear after the I18N: Internationalization plugin is activated.

1. Navigate to System Properties > System Localization.
2. Set these properties

<table>
<thead>
<tr>
<th>Customization properties for system localization</th>
<th>Enables language selection upon login.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show the language select box on the login page to allow the user to specify the language they would like to be logged in with. glide.ui.login.language.select</td>
<td>Enables language selection upon login.</td>
</tr>
<tr>
<td>Text Search stemming language. glide.ts.stemming_language</td>
<td>Selects the language to match derived words in text search.</td>
</tr>
<tr>
<td></td>
<td>Options: English, German, and French</td>
</tr>
<tr>
<td></td>
<td>Default value: English</td>
</tr>
<tr>
<td></td>
<td>Dependency: The I18N: Internationalization plugin must be active</td>
</tr>
<tr>
<td></td>
<td>Learn more: Zing matches derived words with stemming</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.ui.i18n_test</td>
<td>Displays translation prefix on translatable strings.</td>
</tr>
<tr>
<td>glide.i18n.single_currency</td>
<td>Use a single currency model. Display all currencies in the same currency code, regardless of a user's locale, country, or language code.</td>
</tr>
<tr>
<td>glide.sys.language</td>
<td>Default language for the system (two character values)</td>
</tr>
<tr>
<td>glide.i18n.single_currency.code</td>
<td>If using the single currency model, display all currencies using this currency code. Currency codes use the ISO 4217 three letter format.</td>
</tr>
<tr>
<td>glide.system.locale</td>
<td>Locale code to use for localization.</td>
</tr>
<tr>
<td>glide.translate.learn</td>
<td>Add the labels, messages, or choices to the appropriate table in English with an ending of the language code for newly added customizations that are missing translations.</td>
</tr>
</tbody>
</table>

**Note:** Do not change this value once a system has gone into production. If a user's locale must be changed, update the 'Country code' field on the user record.
Set up locations

If your organization supports more than one distinct location, you can configure these locations in the platform to help further identify users, assets, and incidents.

1. In the application navigator, navigate to **User Administration > Locations**.
2. Click **New**.
3. Complete the form with the necessary information then click **Submit**.
   The new location is available as a reference anywhere you can specify one.

Translate an instance

ServiceNow provides a series of Internationalization plugins, each of which translate most of the instance into a particular language.

Administrators can also translate an instance into languages other than those provided in the internationalization plugins.

Activate the I18N: Internationalization plugin

The first step in translating an instance is to install the elements required for translation, including tables to hold the translations, language pickers to allow users to switch between languages, and import set tables and transform maps to aid in importing translations. These elements are all provided in the plugin I18N: Internationalization.

Create a new choice record

This record allows users to select the language as a valid option in a User record and the language picker.

You must create a choice record for a new translation in the Choices [sys_choice] table.

1. Navigate to **System Localization > Choices**.
2. Click **New**.
3. Enter the following fields.
   - **Table**: Enter `sys_user`
   - **Element**: Enter `preferred_language`
   - **Language**: Enter the two-character **ISO 639.1** code for the language this choice record is a member of. For example, `tr`. The default is `en`
   - **Label**: Enter the name of the language selection as you want it to appear in the language picker. For example, Turkish.
• Value: Enter the two-character ISO 639.1 code for the new language selection. For example, tr. The instance uses this value to set the display language.
• Sequence: Enter a number to determine what order the option appears in the choice list if you do not want to list choices alphabetically. For example, 5.

4. Click Submit.

Create a new language record
You must create a language record for your new translation in the Languages (sys_language) table.

Role required: admin
1. Navigate to System Localization > Languages.
2. Click New.
3. Enter the following fields.
   • Name: Enter the name of the language. For example, Turkish.
   • ID: Enter the two-character ISO 639.1 code for the language. For example, tr.
   • Text Direction: Select the direction that the instance should display the language in. For example Left-to-Right.
4. Click Submit.

Import a translation from an Excel spreadsheet
The System Import Sets application contains four import tables and corresponding transform maps to assist with importing translations from an Excel spreadsheet.

1. Navigate to System Import Sets > Load Data.
2. Select Use Existing and the Table name that matches the type of data being imported, as follows.
   • For choices, select the [u_sys_choice] table.
   • For field labels, select the [u_sys_documentation] table.
   • For translated names and fields, select the [u_sys_translated] table.
   • For messages, select the [u_sys_ui_message] table.
   • For translated text, select the [u_sys_translated_text] table.
3. Select Upload an Excel file, and then click Browse to select the source Excel spreadsheet.
4. If appropriate, specify the Work sheet and Header row number.
5. Click Go.

The translations are now available in the appropriate Import Set Table.

6. Navigate to System Import Sets > Table Name and review the imported information to verify that the import was successful.
7. To transform the imported data into the corresponding table, navigate to System Import Sets > Run Transform.
8. Select the appropriate transform map, as follows.

   Note: Make sure you choose a transform map that has the Run Business Rule option selected. If the transform map does not have this option selected, any customized translations you have may be overwritten during the next upgrade.

   • For choices, select the Sys Choice Translation Map.
For field labels, select the **Sys Documentation Translation Map**.
For translated names and fields, select the **Sys Translated Translation Map**.
For messages, select the **Sys UI Message Translation Map**.
For translated text, select the **Sys Translated Text Translation Map**.

9. Click **Transform**.

**Translate a client script message**

Client scripts include a multi-line Messages field.

Use this field to enter message strings that the client script can use as a key to look up a localized message alternative from the Message \([sys_ui_message]\) table. Add each message key on a separate line. The instance looks for a localized message string anytime the client script makes a getMessage(msg) call where the msg string matches a key in the Messages field.

For example, if you add the string **Please populate the Reason field** to the Messages field, then the instance will look for a localized string from the Message \([sys_ui_message]\) table any time the client script calls:

```plaintext
getMessage("Please populate the Reason field")
```

Add a new record to the Message \([sys_ui_message]\) table for each localized string.

1. Navigate to **System Localization > Messages**.
2. Click **New**.
3. Enter the **Message** fields for the localized message.
4. Click **Submit**.

**Translate a field label**

Field labels are the names that appear on forms and lists to describe the type of information the field contains.

The following procedure works best for translating individual field labels, such as those added with a customization. To translate large numbers of field labels, use the procedure described in **Translate the Interface**.

1. Navigate to the field on the form.
2. Right-click the field label and select **Configure Label**.
3. In the Field Label form, replace the English text with the text of the target language in the Label, Plural, and Hint fields.
4. Enter the two-character Language code of the target language.
5. Right-click the header bar and select **Insert**.
   - Clicking **Insert** creates a new record in the Field Label table for this field label in the selected language.

**Translate a field value**

Field values are the text entries that are used for fields with the type translated_field, such as the Title or Hint field in the Module \([sys_app_module]\) table.

The following procedure works best for translating values for individual fields, such as those added with a customization. To translate large numbers of field values, use the procedure described in **Translate the Interface**.

1. Use the language picker in the header bar to switch to the desired language.
2. Navigate to the field on the form.
3. Enter the text of the target language for this value.

4. Click Submit.
   This creates a new record in the Translated Name / Field table for the selected language or updates the existing record.

Translate a related list name

Related lists appear at the bottom of forms. You can translate a related list name by configuring the list control.

Role required: personalize_control

1. Use the language picker to switch to the desired language.
2. Navigate to the related list on the form.
3. Open the list control for the related list by performing the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select Configure &gt; List Control.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Control.</td>
</tr>
</tbody>
</table>

4. On the List Control form, replace the existing Label with the text of the target language.

5. Click Submit or Update.

   The system creates a new entry in the Translated Name / Field (sys_translated) table or updates the existing entry for this language.

**Translate long text content**

Long text content occurs in fields with the type translated_text or translated_html.

Use the following procedure to translate the content for individual text fields. To translate large numbers of text or HTML fields, use the procedure described under Translate the Interface.

To translate the content of a text or HTML field on a form (field type translated_text or translated_html):

1. Use the language picker to switch to the desired language.
2. Navigate to the field on the form.
3. Replace the English text with the text of the target language.
4. Click Submit.

   This creates a new record in the Translated Text table for the active language. The field content displays English or the new language, depending on the user’s language selection.

**Translate the interface**

After creating the choice record, translate the interface, including the applications, modules, UI actions, forms, lists, alerts, and choice lists.

All of these interface items are stored as translatable strings in these translation tables:

- Translated Name / Field [sys_translated]
- Messages [sys_ui_message]
- Field Label [sys_documentation]
- Choice [sys_choice]
- Translated Text [sys_translated_text]

By default, these translation tables only contain English strings. To populate these tables with translated strings:

1. Export the contents of the translation tables into a format (such as Excel) that can be easily manipulated.
2. Within the exported document, translate the Label, Plural, Hint, and Message columns for each row. Be sure to also change the "Language" column to the two character ISO code of the new language.
3. Import the translated document back into the instance as an import set.
Self-localize the interface

If self-localizing the base system (for languages not supported by ServiceNow or deprecated), ServiceNow provides a file containing strings from the interface in the English language. This file can be translated into any language and imported to the instance.

All interface items are stored as translatable strings in these translation tables.

- Translated Name / Field [sys_translated]
- Messages [sys_ui_message]
- Field Label [sys_documentation]
- Choice [sys_choice]
- Translated Text [sys_translated_text]

By default, these translation tables only contain English strings. To populate these tables with translated strings:

1. Obtain the file containing English strings from the translation tables. This file is provided by ServiceNow.
2. Within the file, translate the Label, Plural, Hint, and Message columns for each row. Be sure to also change the “Language” column to the two character ISO code of the new language.
3. Import the translated document back into the instance as an import set.

Translate individual field labels and values

When translating just a few field labels or values, such as when you add customizations to a translated instance, use the procedure that applies to the type of text being translated.

Three types of ServiceNow fields store translated strings:

- Translated_field: Stores field labels, related list names, and certain field values. The value of the translated_field replaces the label, list name, or field value when the user selects the matching language. Translated_field values have a one-to-many relationship with their associated keys. As a result, multiple records can reference one translated_field value.
- Translated_text: Stores long text values in plain text. The value of the translated_text replaces the plain text when the user selects the matching language. Translated_text values have a one-to-one relationship with their associated keys. As a result, only one record can reference a translated_text value.
- Translated_html: Stores long text values in HTML. The value of the translated_html replaces the HTML when the user selects the matching language. Translated_html values have a one-to-one relationship with their associated keys. As a result, only one record can reference a translated_html value.

All three translated field types support list sorting. To determine the field type, right-click the field on the form, select Configure Dictionary, and check the Type field.

ServiceNow stores the translated values as separate records and displays the proper value according to the end user’s language. You can translate an entire instance by exporting the translation tables and then importing the translated strings as described under Translate the Interface.

Note: In addition to translated field types, currency fields display the same price in different currencies based on the user’s language.

Translate the knowledge base

The knowledge base has two separate methods for translation.
Translating the content of articles: used for articles that apply to users of all languages.
Creating language-specific articles: used when users with different languages need different articles.

Translating knowledge base articles

Knowledge base articles use translated_html fields for article content. This type of field displays the translation based on the user’s language, if multiple translations are stored. To learn about using translated_html fields, see Use Translated Text.

Creating language-specific articles

Activating the Knowledge Management Internationalization v2 plugin adds a Language field on the Knowledge form for setting the language of the article. Users can choose a language to search and search results return only articles in that language. Users can switch between different translations of the same article, as well.

Time configuration

Time configuration involves the scheduling of events and tracking of time across applications.

Date and time fields

Records can store date and time values in several different types of fields. These values are stored in the database as integer numbers of milliseconds, and are displayed in the appropriate date or time format.

Date and time field types

The following field types are provided for storing date and time information in records.

<table>
<thead>
<tr>
<th>Field type</th>
<th>Dictionary XML type</th>
<th>MySQL DB type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>glide_date</td>
<td>DATE</td>
</tr>
<tr>
<td>Date-Time</td>
<td>glide_date_time</td>
<td>DATETIME</td>
</tr>
<tr>
<td>Time</td>
<td>glide_time</td>
<td>DATETIME</td>
</tr>
<tr>
<td>Duration</td>
<td>glide_duration</td>
<td>DATETIME</td>
</tr>
<tr>
<td>Due-Date</td>
<td>due_date</td>
<td>DATETIME</td>
</tr>
</tbody>
</table>

For the full list of field types, see Introduction to Fields.

Global date and time field format

The default date and time formats are defined globally using system properties.
Date format

The date format is defined by the property glide.sys.date_format.

An administrator can modify the property by navigating to System Properties > System. Modifying the property changes the date or time format globally. When modifying the standard date format, also verify the format using a Validate Date and Time script. You can use the same pattern strings as the java.text.SimpleDateFormat class, with minor exceptions. Note that MM is months, where mm indicates minutes. The format string consists of the following abbreviations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Full form</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>yyyy (4 digits)</td>
<td>yy (2 digits), y (2 or 4 digits)</td>
</tr>
<tr>
<td>Month</td>
<td>MMM (name or abbr.)</td>
<td>MM (2 digits), M (1 or 2 digits)</td>
</tr>
<tr>
<td>Day of Month</td>
<td>dd (2 digits)</td>
<td>d (1 or 2 digits)</td>
</tr>
</tbody>
</table>

The default format is: yyyy-MM-dd.

**Note:** A user can override the global date or time format with a personal preference.

Time format

An administrator can modify the property by navigating to System Properties > System. Modifying the property changes the date or time format globally. When modifying the standard time format, also verify the format using a Validate Date and Time script. You can use the same pattern strings as the java.text.SimpleDateFormat class, with minor exceptions. The format string consists of the following abbreviations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Full form</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour (1-12)</td>
<td>hh (2 digits)</td>
<td>h (1 or 2 digits)</td>
</tr>
<tr>
<td>Hour (0-23)</td>
<td>HH (2 digits)</td>
<td>H (1 or 2 digits)</td>
</tr>
<tr>
<td>Minute</td>
<td>mm (2 digits)</td>
<td>m (1 or 2 digits)</td>
</tr>
<tr>
<td>Second</td>
<td>ss (2 digits)</td>
<td>s (1 or 2 digits)</td>
</tr>
</tbody>
</table>

Add the character a to the end of the time format string to indicate AM or PM. Note that this option shows AM or PM whether you are using 12-hour time (hh) or 24-hour time (HH).

The default format is: HH:mm:ss.

**Note:** A user can override the global date or time format with a personal preference.

Personalize the system date format

You can personalize the format in which date values appear in your instance.

Personalizing the date format does not change global settings or impact the way other users see date values.

1. Navigate to Self-Service > My Profile.
2. In the Date format field, select an option.
3. Click Update.
Personalize the system time format

You can personalize the format in which time values appear in your instance.

An administrator must add the Time format field to the Self-Service view of the User form. For more information, see Configure the form layout.

Personalizing the time format does not change global settings or impact the way other users see time values.

1. Navigate to Self-Service > My Profile.
2. In the Time format field, select an option.
3. Click Update.

Configure the date picker for the list editor

In UI16 and UI15, a system property enables you to choose between two date picker configurations for the list editor.

Role required: admin

1. Navigate to sys_properties.list.
2. Search for the property named glide.ui.list_edit.show_calendar_only.
3. Set the property Value to either of the following options.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>The date picker displays a calendar as well as a field for manual date entry. This is the default behavior in UI11, regardless of the property value.</td>
</tr>
</tbody>
</table>
Default date and time fields

Certain time fields are provided by default to store particular date and time fields.

Global timestamp fields

All records inherit certain time stamp fields from the Global (global) table.

- Created
- Updated

These fields are automatically populated with the correct date and time.

Planned Task time fields

The Planned Task plugin provides a table (Planned Task (planned task)) with standard fields for measuring a planned task’s time. For more information, see Planned Task.

Task fields for measuring work time

Use default task fields to measure progress and resolution for certain records.

The following base system fields are provided on certain tables to keep track of how long it takes to close tickets:

- Time worked: A timer which runs while the record is being viewed by a user, and pauses while the record is closed (or when it is paused manually). Used to keep track of the time spent by the help desk while working on the record.
- **Resolve time**: A calculated field which measures the time from the moment the record is opened, to the moment the record is closed. Used to keep track of how long it takes to resolve the record.

These fields provide different metrics for request response.

The following additional tools are available for tracking work time:
- **Service level agreements (SLAs)**: measure how long it takes a record fulfill certain conditions (such as an incident being marked **Resolved**).
- **Time cards**: use the **Time worked** field to break down how much time was spent by day of the week.

**Time worked**
The Task (task) table provides a time-tracking field called **Time worked**.

![Time worked field]

This field measures how long a record has been viewed in order to measure work time on a ticket. Any table that extends Task can use this field. To add the field, configure the form.

As the record is viewed, the timer counts upward. To pause the timer, click the stop icon (⏹).

To resume the timer, click the start icon (ʼʼ).

When the task is saved, the amount of new time in the timer is used to generate a record on the Time Worked (task_time_worked) table. This table can be viewed as a related list on the task form.

By default, the time displayed in the **Time worked** field displays a cumulative value stored in the task record. If you modify a Time Worked record, the changes will not be reflected in the task timer.

You can set the property `com.snc.time_worked.update_task_timer` to enable updating of the task timer value based on changes to the time worked records. This is accomplished through the **Update task timer** business rule.

**Resolve time**
The **Resolve time** field is available on the Incident (incident) and Request (sc_request) tables. This field allows for easy reporting on how long it takes for requests to be closed, and is stored as an integer number of seconds.

**Business rule calculation**

Specific business rules calculate the **Resolve time** field when the record is resolved or marked closed, and measure the difference between the **Opened** and **Closed** dates.

On the Incident table, the field is calculated on incident resolution, or closure, whichever happens first, based on the business rule `mark_resolved` or `mark_closed`. Both are based on Incident table get trigger.

When the incident is resolved, the calculation is based on the **mark_resolved** business rule. The following lines of code calculate the resolve time:

```java
if (dataChange || current.calendar_stc.nil())
```
current.calendar_stc = gs.dateDiff(opened, resolved, true);

When the incident is closed directly, the calculation is based on the mark_closed business rule. The following lines of code calculate the resolve time:

```java
if (dataChange || current.calendar_stc.nil())
    current.calendar_stc = gs.dateDiff(opened, closed, true);
```

Display resolve time as a duration

You can display the resolve time as a human-readable duration rather than an integer representing a number of seconds.

1. From the Incident or Request form, right-click the form header and click Configure > Table. The system displays the table form.
2. From the Columns embedded list, click Resolve time. The system displays the dictionary entry for the field.
3. From the Attributes related list, click New.
4. Enter these values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Format</td>
</tr>
<tr>
<td>Dictionary entry</td>
<td>Resolve time</td>
</tr>
<tr>
<td>Value</td>
<td>glide_duration</td>
</tr>
</tbody>
</table>

5. Click Submit.

Forms and lists display the resolve time as a number of days, hours, and minutes.

**Note:** This attribute does not change the field data format which remains an integer representing a number of seconds. Reports and data exports will still display the actual number of seconds rather than a duration.

Export date and time formats

Because some export formats are intended for human consumption and others are intended for database usage, different methods provide date and time field information in different formats.

**Excel**

Date, Date-Time, and Time fields are all exported as their display values, displayed using a custom format instead of the system date format. Duration fields, however, export as the value stored in the database, which is an integer value of seconds.

**Note:** If the date and time format is hh:mm:ss in the glide.sys.date_format setting in System Properties, and you export time values to Excel, they show in 24-hour military time format. To display the exported values in standard 12-hour am/pm time formats, select the 1:30PM time format in Format Cells > Time in Excel.
XML

All Date and Time fields export as the value stored in the database.

PDF

All Date and Time fields (including Duration) export as their display value.

CSV

All Date and Time fields export as the value stored in the database.

Calendars and schedules

Specific applications within the platform generate graphical calendar displays based on Schedule Pages.

These Schedule Pages can be displayed in a daily, weekly, or monthly view. Currently, the applications using Schedule Pages include:

- Project Management
- Maintenance Schedules
- Group On-Call Rotation
- Field Service Management

Schedule Pages are records that contain the scripts that determine the functionality of the graphical display. Because of the heavy degree of scripting involved in a schedule page, most instances should use the default schedule pages in the base platform. The schedule page uses a URL with a series of parameters attached to generate the graphical display.

Calendar content is controlled by a Schedule Page (cmn_schedule_page) record. To access Schedule Pages, navigate to System Scheduler > Schedules > Schedule Pages. The Schedule Pages form provides the following fields:

The Schedule Page record contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String</td>
<td>General name used to identify the current schedule page.</td>
</tr>
<tr>
<td>Field</td>
<td>Field Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule type</td>
<td>String</td>
<td>The schedule type is a string that is used to uniquely identify the schedule page via the <code>sysparm_page_schedule_type</code> URI parameter. For example, a schedule page could be accessed as follows: <code>/show_schedule_page.do?sysparm_page_schedule_type=gantt_chart&amp;sysparm_timeline_task_id=d530bf907f0000015ce594fd929cf6a4</code> Alternatively, the schedule page can also be accessed by setting the <code>sysparm_page_sys_id</code> URI parameter to that of the unique 32 character hexadecimal system identifier of the schedule page.</td>
</tr>
</tbody>
</table>
| View Type             | Choice     | Each view type displays different field combinations. There are two options available:  
- Calendars  
- Timelines |
| Description           | String     | General description that provides additional information about the current schedule page. This field is not necessary.                                                                                     |
| Init function name    | String     | **Note:** This functionality is only used by Calendar type schedule pages.                                                                                                                                  |
|                       |            | The init function name specifies the name of the JavaScript function to call inside the Client script function for calendar type schedule pages.                                                            |
| HTML                  | String     | **Note:** This functionality is only used by Calendar type schedule pages.                                                                                                                                  |
|                       |            | The HTML field is a scriptable section that is parsed by Jelly and injected into the display page prior to the rest of the calendar. It can be used to pass in variables from the server and define extra fields are necessary. |
| Client script         | String     | The client script is a scriptable section that allows for configuring options of the schedule page display. The API is different depending on the schedule page view type and is discussed below. |

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server AJAX processor</td>
<td>String</td>
<td>Note: This functionality is only used by Calendar type schedule pages. The Server AJAX processor is specific to calendar type schedule pages that is used to return a set of schedule items and spans to be displayed.</td>
</tr>
</tbody>
</table>

**Calendar views from the schedule pages**

A "URL from arguments" module, a field decoration (dictionary attribute "ref_contributions"), or a UI Action linking to 'show_schedule.do' is used to invoke the Schedule page.

For example, the On-call calendar module generates the calendar from the following URL:

```
$ocf.do?sysparm_start_date=2016-03-01&sysparm_current_view=monthly&sysparm_include_view=monthly,
```

This URL takes the user to the monthly calendar view dated March 1, 2016.

- The URL component `sysparm_current_view` determines the current calendar view. If `sysparm_current_view` is given an invalid or empty value, it will default to monthly view and rewrite the URL to that view. Valid values are monthly or weekly or daily.
- The URL component `sysparm_include_view` determines which calendar views are available. If `sysparm_include_view` is given invalid or empty values, it will display only the valid views. If all values are invalid, the default three views will be displayed and will rewrite the URL to those views. Valid values are monthly, weekly, and daily.

**Note:** The `sysparm_include_view` is only available for the new on-call calendar view.

- The URL component `sysparm_group_id` determines the specified group to filter on. If `sysparm_group_id` is specified, it will filter by the specified group. Valid value is a group sysId.
- The URL component `sysparm_start_date` determines the date based on which every view is displayed. If `sysparm_start_date` is specified, it will open the calendar displaying that particular date in which every view is selected. The format is YYYY-MM-DD. If an invalid format or date is specified, it uses the current date and rewrites the URL to that date.

**Note:** The `sysparm_group_id` URL component has been replaced with `sysparm_current_view` in OnCallRotation only.

**Timespan label events**

The SchedulePage may include JavaScript functions in the Client Script section to handle events triggered by user interaction with the displayed timespans and their labels. Note that these custom events are not created for timeline type schedules.

This is done by observing events via the CustomEvent object. For example:

```
CustomEvent.observe ( "timespan.clicked", timespanClicked )
```
In this example, your client script would include a function named `timespanClicked` to correspond to the one named in the code above.

```javascript
function timespanClicked (event , element , scheduleItem ) { alert ( "You clicked ID=" + itemID + " which is " + element ); }
```

The arguments passed to the functions are the event, the HTML element for the timespan, and the GwtScheduleItem of the timespan as given by your schedule page's server AJAX processor code.

Timespan events that can be observed are:

- `timespan.clicked`
- `timespan.contextmenu`
- `timespan dblclicked`
- `timespan.mouseover`
- `timespan.mouseout`

Timespan label events that can be observed are:

- `timelabel.clicked`
- `timelabel.contextmenu`
- `timelabel dblclicked`
- `timelabel.mouseover`
- `timelabel.mouseout`

View Properties:

Specify view properties to configure aspects of the view's appearance and behavior:

- `timespan_height`: Set to a number of pixels to customize the height of timespans on the view.
- `timespan_between`: Set to a number of pixels to customize the amount of space between timespans.
- `drag_scroll`: Set to false to prevent scrolling by dragging the timeline background left or right.

Example: Specify four timespans 4 pixels tall with 16 pixels between spans and do not allow drag scrolling.

```javascript
schedulePage.setViewProperty("timespan_height", 4);
schedulePage.setViewProperty("timespan_between", 16);
schedulePage.setViewProperty("drag_scroll", "false");
```

Examples

There are several examples of schedule pages used by these plugins:

- The Group On-Call Rotation plugin contains an example of an on-call calendar.
- The Project Management v2 plugin contains the **Project Resource Timeline** Schedule Page.

Fiscal calendars

With fiscal calendars you can define fiscal periods, such as one month long or four weeks long or Q1 2015 or July 2015.

To create a fiscal calendar, activate the Fiscal Calendar (com.snc.fiscal_calendar) plugin.

You can create one of these types:
<table>
<thead>
<tr>
<th>Calendar type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>A calendar with 12 periods, each of which is one month long.</td>
</tr>
<tr>
<td>13 Period</td>
<td>A calendar with 13 periods, each of which is four weeks long.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This calendar is the only type that does not use quarters.</td>
</tr>
<tr>
<td>445</td>
<td>A calendar that divides a year into subsequent 4-week, 4-week, 5-week periods. The first and second periods have four weeks, and the last has five weeks. The application creates these periods for the calendar duration.</td>
</tr>
<tr>
<td>454</td>
<td>A calendar that divides a year into subsequent 4-week, 5-week, 4-week periods. The first period has four weeks, the second has five weeks, and the third has four weeks. The application creates these periods for the calendar duration.</td>
</tr>
<tr>
<td>544</td>
<td>A calendar that divides a year into subsequent 5-week, 4-week, 4-week periods. The first period has five weeks, and the second and third have four weeks.</td>
</tr>
</tbody>
</table>

**Attention:** Once you start working with a set of financial data with a fiscal calendar type, you cannot change to another type of fiscal calendar. Be sure you can use your fiscal calendar with your financial data. If you import records into the Fiscal period (fiscal_period) table, you should validate that they are correct and do not contain any gaps.

**Activate the Fiscal Calendar plugin**

You can activate the Fiscal Calendar plugin (com.snc.fiscal_calendar) if you have the admin role.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

**Generate a fiscal calendar**

You can manually generate a fiscal calendar for a specified time period.

Role required: fiscal_calendar_admin

1. Navigate to **Fiscal Calendar > Generate**.
2. Configure the form (see table).
3. Click **Generate Calendar**.
4. Navigate to **System Definition > Fiscal Periods** and verify that the monthly, quarterly, and annual fiscal period records exist.

### Fiscal Calendar form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Calendar Types</td>
<td>Select the type of calendar by clicking it. The options in the choice lists update automatically.</td>
</tr>
<tr>
<td>Fiscal Unit</td>
<td>Select the base unit for the calendar.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start Month</td>
<td>Select the month that is the beginning of your fiscal year.</td>
</tr>
<tr>
<td>Start Year</td>
<td>Select the year.</td>
</tr>
<tr>
<td>Prefix for Year</td>
<td>Enter a prefix that the application uses in the name of the records that represent the fiscal year.</td>
</tr>
<tr>
<td>Prefix for Quarter/Period</td>
<td>Enter a prefix that the application uses in the name of the records that represent the fiscal quarter or period.</td>
</tr>
<tr>
<td>Start Day</td>
<td>Select the day that represents the beginning of each month.</td>
</tr>
<tr>
<td>End Year</td>
<td>Select the year the calendar ends.</td>
</tr>
<tr>
<td>Prefix for Month/Period</td>
<td>Enter a prefix that the application uses in the name of the records that represent the month or period.</td>
</tr>
</tbody>
</table>

**Attention:** Once you start working with a set of financial data with a fiscal calendar type, you cannot change to another type of fiscal calendar. Be sure you can use your fiscal calendar with your financial data.

**View, modify, and validate fiscal periods**

After you generate a fiscal calendar, you can view fiscal period records, modify the start and end date, deactivate a fiscal period if necessary, and validate.

Role required: fiscal_calendar_user

1. Navigate to System Definition > Fiscal Periods.
2. Open any of the fiscal periods (see table for field descriptions) to view, modify, or deactivate.

**Fiscal period form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the fiscal period.</td>
</tr>
<tr>
<td>Start date time</td>
<td>The date the fiscal period starts.</td>
</tr>
<tr>
<td>End date time</td>
<td>The date the fiscal period ends.</td>
</tr>
<tr>
<td>Fiscal Type</td>
<td>(Read-Only) The type of period, either Year or Quarter.</td>
</tr>
</tbody>
</table>

3. Validate the fiscal periods to ensure there are no gaps and that they match a valid style of calendar.
   a) To validate, return to the list view of fiscal periods and click Validate Periods.

**Schedules**

Schedules are rules that include or exclude time for various actions or tasks.
Use schedules to specify when service level agreements or inactivity monitors are active, or to specify when on-call rotations should take effect. For example, if a service level agreement is set to an 8-5 Weekdays schedule, the SLA only counts time during those hours.

**Default schedules**

Default schedules are available in a base system.
## Default Schedules

<table>
<thead>
<tr>
<th>Name</th>
<th>Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-5 weekdays</td>
<td>Repeats every week on weekdays Monday through Friday.</td>
</tr>
<tr>
<td>8-5 weekdays excluding holidays</td>
<td>Repeats every week on weekdays Monday through Friday. Includes the child schedule U.S. Holidays.</td>
</tr>
<tr>
<td>Application</td>
<td>Repeats every week on Sunday.</td>
</tr>
<tr>
<td>Application FLX</td>
<td>Repeats every week on Sunday.</td>
</tr>
<tr>
<td>Blackout Wednesdays (GMT)</td>
<td>Repeats every week on Wednesday.</td>
</tr>
<tr>
<td>Database Server FLX</td>
<td>Repeats every week on Saturday.</td>
</tr>
<tr>
<td>Default MS Project</td>
<td>Repeats every week on weekdays Monday through Friday from 8:00am to noon and 1:00-5:00pm.</td>
</tr>
<tr>
<td>Global Infrastructure</td>
<td>Repeats every week on Saturday.</td>
</tr>
<tr>
<td>MySQL Database Service</td>
<td>Repeats every week on Saturday.</td>
</tr>
<tr>
<td>Network</td>
<td>Repeats every week on Saturday.</td>
</tr>
<tr>
<td>Project Management Schedule</td>
<td>Repeats every week on weekdays Monday through Friday from 8:00am to noon and 1:00-5:00pm. Default schedule for the Project Management application.</td>
</tr>
<tr>
<td>Resource Management Schedule</td>
<td>Repeats every week on weekdays Monday through Friday from 8:00am to noon and 1:00-5:00pm. Default schedule for the Resource Management application.</td>
</tr>
<tr>
<td>Server</td>
<td>Repeats every week on Saturday.</td>
</tr>
<tr>
<td>Servers San Diego</td>
<td>Repeats every week on Wednesday.</td>
</tr>
<tr>
<td>Software Blackout</td>
<td>Repeats every week on Wednesday.</td>
</tr>
<tr>
<td>WebServer FLX</td>
<td>Repeats every week on Sunday.</td>
</tr>
<tr>
<td>Weekends</td>
<td>Repeats every week on Saturday for two days.</td>
</tr>
</tbody>
</table>

## Holidays

Each individual holiday can be defined as a schedule entry to create exceptions to existing schedules.

For instance, if an SLA requires an incident be resolved within three business days excluding Christmas, create a schedule entry for Christmas to ensure that SLAs do not count Christmas when calculating elapsed time, even if it falls within the work week.

Because schedules can be included in other schedules through a parent-child relationship, it is also possible to create a holiday schedule and include it in other schedules to keep holidays consistent.

The following example shows a holiday schedule.
### Schedule - U.S. Holidays

**Name:** U.S. Holidays

**Description:**
Sample set of holidays recognized in the United States

### Related Links
**Show Schedule**

<table>
<thead>
<tr>
<th>Schedule Entries (12)</th>
<th>Child Schedules</th>
<th>Referenced By (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Schedule Entries" /></td>
<td><img src="image" alt="Child Schedules" /></td>
<td><img src="image" alt="Referenced By" /></td>
</tr>
</tbody>
</table>

#### Schedule Entries

<table>
<thead>
<tr>
<th>Name</th>
<th>Repeats</th>
<th>Repeat every</th>
<th>Start date time</th>
<th>End date time</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Christmas Day</td>
<td>Every year on Dec 25</td>
<td>1</td>
<td>12-25-2012 00:00:00</td>
<td>12-25-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Christmas Eve</td>
<td>Every year on Dec 24</td>
<td>1</td>
<td>12-24-2012 00:00:00</td>
<td>12-24-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Columbus Day</td>
<td>Every year on 2nd Mon of Oct</td>
<td>1</td>
<td>10-09-2012 00:00:00</td>
<td>10-09-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Independence Day</td>
<td>Every year on July 4</td>
<td>1</td>
<td>07-04-2012 00:00:00</td>
<td>07-04-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Labor Day</td>
<td>Every year on 1st Mon of Sep</td>
<td>1</td>
<td>09-01-2012 00:00:00</td>
<td>09-01-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Martin Luther King Jr. Day</td>
<td>Every year on 3rd Mon of Jan</td>
<td>1</td>
<td>01-16-2012 00:00:00</td>
<td>01-16-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>Every year on last Mon of May</td>
<td>1</td>
<td>05-28-2012 00:00:00</td>
<td>05-28-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>New Year's Day</td>
<td>Every year on Jan 1</td>
<td>1</td>
<td>01-01-2012 00:00:00</td>
<td>01-01-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>New Year's Eve</td>
<td>Every year on Dec 31</td>
<td>1</td>
<td>12-31-2012 00:00:00</td>
<td>12-31-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Presidents' Day</td>
<td>Every year on 3rd Mon of Feb</td>
<td>1</td>
<td>02-20-2012 00:00:00</td>
<td>02-20-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Thanksgiving Day</td>
<td>Every year on 4th Thu of Nov</td>
<td>1</td>
<td>11-22-2012 00:00:00</td>
<td>11-22-2012 23:59:59</td>
<td>Excluded</td>
</tr>
<tr>
<td>Veterans Day</td>
<td>Every year on Nov 11</td>
<td>1</td>
<td>11-11-2012 00:00:00</td>
<td>11-11-2012 23:59:59</td>
<td>Excluded</td>
</tr>
</tbody>
</table>
The following example shows a schedule that includes the holiday schedule shown above.

Create a holiday schedule for multiple regions

You can create holiday schedules for multiple regions that follow the same work schedule but have different holidays.
The following method supports multiple regions that all follow the same work schedule (for example, an 8-5 weekdays schedule) but have different holiday schedules.

1. Create a holiday schedule for each region. For example, U.S. Holidays, British Holidays, and Australian Holidays.
2. Add the work schedule as a child schedule to each region's holiday schedule.

This method requires making \(<\text{number of schedules}> + 1\) total schedules. If you instead make the regional holiday schedule a child schedule of the work hours schedule, you will need to create a separate work hours schedule for each region. The total number of schedules in this case is \(<\text{number of schedules}> \times 2\) schedules.

### Parent and child schedules

Schedules can have one of two parent-child relationship with other schedules.

- **Parent field:** When a schedule record lists a value for the Parent field, schedule entries from the parent schedule apply to both the parent schedule and the child schedule. By default, there are no sample schedules that use the Parent field.

- **Child schedule:** When a schedule record has one or more child schedules in the Child Schedules related list, schedule entries from the child schedule apply to the containing schedule. By default, there are several sample schedules that use child schedules. For example, see the **8-5 weekdays excluding holidays** schedule that includes the **U.S. Holidays** schedule.

Parent and child schedules cannot contain conflicting schedule entry types. For example, a schedule containing maintenance schedule entries cannot also contain blackout schedule entries. Nor can a maintenance schedule have a child schedule containing blackout schedule entries.

Parent schedules are not valid if they are only exclusionary. They must have at least one entry that is not of type **Excluded**.

---

**Note:** The Show Schedule related link shows schedule entries from the current schedule and the child schedule record. For example, when showing the **8-5 weekdays excluding holidays** schedule, holidays are also shown as excluded because the holiday schedule is a child schedule.

---

### Schedule entry fields

The Schedule Entries related list contains the definitions of the time periods you want to include in or exclude from the schedule.

**Note:** A schedule entry can only be associated with one schedule.

The Schedule Entry form uses these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the schedule entry.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Enter a label that describes the purpose of the schedule. The system also uses the schedule type to determine how to process certain schedules.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Show As</td>
<td>Select an option to indicate how the schedule entry should be displayed in calendar applications and how it should interact with other schedule entries.</td>
</tr>
<tr>
<td>When</td>
<td>Enter the date and time to which the schedule entry applies. If the schedule entry applies to a full 24-hour day, select the <strong>All day</strong> check box.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Select a repetition interval for the schedule entry, if any. If you select a repetition interval, ServiceNow displays other fields to further specify the repeat interval.</td>
</tr>
<tr>
<td>Repeat every</td>
<td>Select how often the schedule repeats daily, weekly, monthly, or yearly. This field is only visible when the <strong>Repeats</strong> field has a value of <strong>Daily</strong>, <strong>Weekly</strong>, <strong>Monthly</strong>, or <strong>Yearly</strong>.</td>
</tr>
<tr>
<td>Repeat on</td>
<td>Select the days of the week a weekly schedule repeats on. This field is only visible when the <strong>Repeats</strong> field has a value of <strong>Weekly</strong>.</td>
</tr>
<tr>
<td>Monthly type</td>
<td>Select how a <strong>monthly schedule repeats</strong>. This field is only visible when the <strong>Repeats</strong> field has a value of <strong>Monthly</strong>. Monthly repeat options include:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Yearly type</td>
<td>Select how a yearly schedule repeats. This field is only visible when the Repeats field has a value of Yearly. Yearly repeat options include:</td>
</tr>
<tr>
<td></td>
<td>· Repeat on a specific day of the year</td>
</tr>
<tr>
<td></td>
<td>· Repeat on a floating day</td>
</tr>
<tr>
<td>Float week</td>
<td>Select which week of the month a floating yearly schedule repeats on. This field is only visible when the Yearly type field has a value of Floating.</td>
</tr>
<tr>
<td>Float day</td>
<td>Select which day of the week a floating yearly schedule repeats on. This field is only visible when the Yearly type field has a value of Floating.</td>
</tr>
<tr>
<td>Month</td>
<td>Select which month of the year a floating yearly schedule repeats on. This field is only visible when the Yearly type field has a value of Floating.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>Select a repetition end date. If you leave this field blank, the schedule repeats indefinitely.</td>
</tr>
<tr>
<td>Type</td>
<td>(Optional) Enter a schedule entry description.</td>
</tr>
</tbody>
</table>

**Schedule fields**

The Schedule form uses these fields.

**Schedule Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the schedule.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone for the schedule. If you select Floating, the time zone will be relative to whatever is accessing the item at any given time. For example, if a resource manager in Amsterdam sets a floating schedule for 8:00 A.M. to 5:00 P.M., a user in San Jose sees the schedule as 8:00 A.M. to 5:00 P.M. When a schedule is defined in a specific time zone, users in different time zones see the schedule with their own time zone applied.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select a parent schedule to constrain the new schedule.</td>
</tr>
</tbody>
</table>
### Define a schedule

Schedules are configured with two types of records.

- Schedule records specify a time zone and a type of schedule and use one or more schedule entries. Schedule records are saved in the Schedule (`cmn_schedule`) table.
- Schedule entry records specify the time periods that are included or excluded from a schedule. Schedule entries are saved in the Schedule Entry (`cmn_schedule_span`) table.

1. Navigate to **System Scheduler > Schedules > Schedules**.
2. Select a pre-existing schedule or click **New** to create a new one.
3. Complete the fields on the form (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the schedule.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone for the schedule. If you select <strong>Floating</strong>, the time zone will be relative to whatever is accessing the item at any given time.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select a parent schedule to constrain the new schedule.</td>
</tr>
</tbody>
</table>
| Type       | Enter a label that describes the purpose of the schedule. You can also use one of these system terms to determine how to process certain schedules:  
  - **excluded**: excludes time periods from SLA counts.  
  - **maintenance**: specifies time periods where change management activities are allowed. A schedule containing maintenance schedule entries cannot also contain blackout schedule entries.  
  - **blackout**: excludes time periods from change management schedules. A schedule containing blackout schedule entries cannot also contain maintenance schedule entries. |

Describe the schedule.
### Description
(Optional) Describe the schedule.

**Note:** The Schedule form displays a warning message if there are no active entries defined for the current schedule. If your schedule is a child schedule that only contains exclusions, ignore the message because exclusions are non-active entries.

4. Right-click the header bar and click **Save**.

**Note:** If you create a schedule of type `maintenance` and save the record, a UI policy hides the **Type** field from the form. To view or change the value for the **Type** field, view the list of schedules rather than the schedule form and add the **Type** column if necessary. You can double click the cell for the value in the **Type** column and modify from the list view.

5. Configure one or more schedule entries.
**Schedule**

- **Name**: 8-5 weekdays
- **Time zone**: -- Floating --
- **Parent**: 
- **Type**: 
- **Description**: 

**Related Links**

**Show Schedule**

<table>
<thead>
<tr>
<th>Schedule Entries (1)</th>
<th>Child Schedules</th>
<th>Referenced By</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schedule Entries</strong></td>
<td><strong>Go to</strong> Name</td>
<td></td>
</tr>
</tbody>
</table>

**Schedule = 8-5 weekdays**

<table>
<thead>
<tr>
<th>Name</th>
<th>Repeats</th>
<th>Repeat every</th>
<th>Start date time</th>
<th>End date time</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday-Friday 8-5</td>
<td>Weekly on Weekdays</td>
<td>1</td>
<td>07-07-2008 08:00:00</td>
<td>07-07-2008 17:00:00</td>
<td></td>
</tr>
</tbody>
</table>
Schedule for the fifth instance of a day of the week

When selecting a date near the end of a month for a repeating monthly schedule, it is possible to select a date that computes to the fifth instance of that week day.

ServiceNow offers three options for handling months that do not have a matching fifth instance of the selected day.

- Last: ServiceNow selects the last instance of the week day in the month.
- Next: ServiceNow selects the first instance of the week day in the next month.
- Strict: ServiceNow skips any month without a matching fifth instance and selects only months that have a matching fifth instance.

The system property `glide.schedules.fifth` controls how a schedule entry that selects the fifth occurrence of a week day behaves in months containing only four occurrences of that day. This property is only valid when the `glide.schedules.repeat_nth` property is set to `Day`.

The following example illustrates computing what day of the month a schedule repeats on when the schedule starts on the fifth instance of a week day in the month.

1. Navigate to `sys_properties.list`.
2. Open the `glide.schedules.fifth` property.
3. Verify that the `Value` is set to `last`.
4. Navigate to `System Scheduler > Schedules > Schedules`, define a new schedule, and click Submit.
5. Open the new schedule and in the Schedule Entries related list, create a new entry with the following parameters:
   - When: November 29, 2012 at 10:00 to November 29, 2012 at 11:00
   - Repeats: Monthly
   - Monthly type: Day of the Week
   - Starting: November 29 (note that November 29 is the fifth Thursday in the month)

6. Click Submit.
7. Open the same schedule entry.
   
   Note that the form says “Every month on the fifth Thu.”
The schedule for the first three months is computed as:

- November 29, 2012 (5th Thursday of the month)
- December 27, 2012 (Last Thursday of the month)
- January 31, 2013 (5th Thursday of the month)

8. If the **Value** on the `glide.schedules.fifth` property is set to `next` instead of `last` in step 3, the schedule for the first three months is computed as:

- November 29, 2012 (5th Thursday of the month)
- January 3, 2012 (1st Thursday of the next month since December 2012 does not have five Thursdays)
- January 31, 2013 (5th Thursday of the month)

9. If the **Value** on the `glide.schedules.fifth` property is set to `strict` instead of `last` in step 3, the schedule for the first three months is computed as:

- November 29, 2012 (5th Thursday of the month)
- No meeting (December 2012 skipped because it does not have five Thursdays)
- January 31, 2013 (5th Thursday of the month)

Repeat a monthly schedule

For monthly schedules (**Repeat** is set to **Monthly**) that start on a particular day of the month (**Monthly type** is set to **Day of the month**), you can specify the following options:

- How ServiceNow computes the starting day each month. See [Day of the Week](#).
- How ServiceNow handles monthly schedules that start on the fifth instance of a day. See [Fifth Instance of a Day of the Week](#).

**Day of the Week:**

ServiceNow offers two methods to compute what day of the week a monthly schedule repeats on:

- **Day:** This method computes the day of the week to repeat on by determining the order of the selected starting date within the month. For example, if the selected starting date is the first Monday in the month, the schedule repeats every first Monday of every month.
- **Week:** This legacy method computes the day of the month to repeat on by determining what week number the selected starting date appears in the month. For example, if the starting date is a Monday during the second week of the month, the schedule repeats the second Monday of every month.
The system property `glide.schedules.repeat_nth` determines what method your instance uses to compute what day a repeating monthly schedule occurs on. By default, instances use the more accurate Day method.

**Note:** Use the “Week” method to maintain backwards compatibility with customized schedule logic.

The following example illustrates computing what day of the week a monthly schedule repeats on.

1. Navigate to `sys_properties.list`.
2. Open the `glide.schedules.repeat_nth` property.
3. Verify that the **Value** is set to **day**.
4. Navigate to **System Scheduler > Schedules > Schedules**, define a new schedule, and click **Submit**.
5. Open the new schedule and in the **Schedule Entries** related list, create a new entry with the following parameters:
   - **When**: November 5, 2012 at 10:00 to November 5, 2012 at 11:00
   - **Repeats**: Monthly
   - **Monthly type**: Day of the Week
   - **Starting**: November 5 (note that November 5 is the first Monday in the month, but it is in the second week)

6. Click **Submit**.
7. Open the **Schedule Entry**.
   
   Note that the form says Every month on the first Mon.

   The first few dates this schedule will run are:
   - November 5, 2012 (1st Monday of the month)
   - December 3, 2012 (1st Monday of the month)
   - January 7, 2012 (1st Monday of the month)

8. If the **Value** on the `glide.schedules.repeat_nth` property is set to **week** instead of **day** in step 3, the first few dates this schedule will run are:
   - November 5, 2012 (Schedule starts on Monday in the 2nd week of the month)
   - December 10, 2012 (2nd Monday in the month)
   - January 14, 2012 (2nd Monday in the month)
Client transaction timings

The Client Transaction Timings plugin enhances the system logs by providing more information on the durations of transactions between the client and the server.

By providing information on how time was spent during the transaction, performance issues can be tracked down to the source by seeing where the time is being consumed.

This plugin requires the Response Time Indicator to be enabled, and collects information from the following browsers:

- Firefox
- Internet Explorer
- Chrome

Client Transactions Information

Installing the plugin adds the module Client Transactions to the System Logs application, which provides a list of every logged transaction between client and server within the last day. The following information is tracked:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>The moment the transaction was recorded.</td>
</tr>
<tr>
<td>Response Time</td>
<td>The number of ms spent by the server in fulfilling the transaction.</td>
</tr>
<tr>
<td>Business Rule Time</td>
<td>The number of ms spent by business rules triggered by the transaction.</td>
</tr>
<tr>
<td>SQL Time</td>
<td>The number of ms spent by the SQL database.</td>
</tr>
<tr>
<td>Client Response Time</td>
<td>(Load_completion_time) - (start_time). It is inclusive of server time.</td>
</tr>
<tr>
<td>Client Network Time</td>
<td>The number of ms spent by the network the client is connecting through.</td>
</tr>
<tr>
<td>Browser Time</td>
<td>The number of ms spent by the browser during the transaction.</td>
</tr>
<tr>
<td>Client Script Time</td>
<td>The number of ms spent executing client scripts</td>
</tr>
<tr>
<td>UI Policy Time</td>
<td>The number of ms spent executing ui policy</td>
</tr>
<tr>
<td>Type</td>
<td>Type of transaction (one of Form, List, Other)</td>
</tr>
<tr>
<td>Table</td>
<td>The table that was displayed e.g. incident, change_request</td>
</tr>
<tr>
<td>View</td>
<td>The view for this form/list</td>
</tr>
</tbody>
</table>

Client Detailed Information

A more detailed breakdown of the client timings for all Form rendering (but not list rendering) is also tracked. To see details, drill into a particular client transaction record and observe the related list at the base of the screen.
**Client Detailed Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The order during the load that this operation occurred</td>
</tr>
<tr>
<td>Type</td>
<td>The type of operation</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name of this particular operation</td>
</tr>
<tr>
<td>Duration</td>
<td>Number of ms this particular operation took to complete</td>
</tr>
</tbody>
</table>

**Components installed with Client Transaction Timings**

The Client Transaction Timings plugin installs several components.

**Database Table Structure**

The plugin adds the table syslog_client_transaction.

**Properties**

The property `glide.client.track_transaction_timings` enables and disables the plugin.

**Scripts**

The plugin relies on the new script include AJAXClientTiming. This is the script that gathers the information required and populates them on the syslog_client_transaction table.

**Dependencies**

This plugin does not require any other plugins, but will not gather information unless the Response Time Indicator is enabled.

**Activating the Plugin**

To activate the plugin, navigate to System Definition > Plugins and activate the plugin.

**Note:** New instances have the plugin activated by default.

**Disabling the Plugin**

Although plugins cannot be removed, the functionality can be disabled:

1. Enter `sys_properties.list` in the application navigator filter.
2. Locate the property named `glide.client.track_transaction_timings`.
3. Set the property value to `false`. 
The functionality can be enabled again by setting the property value to **true**.

**Timing values**

Timing values are broken down into several sections.

![Diagram showing timing values][1]

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>start_time</td>
<td>The date and time the user requests a page (the user clicks on a link). This value is set by hooking into the beforeunload event of the previous page. The beforeunload event is not properly supported by WebKit browsers, which is why the client timings are not supported on Safari or Chrome.</td>
</tr>
<tr>
<td>load_time</td>
<td>The date and time that the current page starts loading in the browser. This value is set by an inline javascript that runs as the first script in the HTML body.</td>
</tr>
<tr>
<td>server_time</td>
<td>The time in ms spent by the server processing the transaction. The server reports this value to the client.</td>
</tr>
<tr>
<td>load_completion_time</td>
<td>The date and time that the page is fully rendered in the browser. This operation is performed as the last script on the page and identifies the time the page completed loading.</td>
</tr>
</tbody>
</table>

The following timings are reported at the bottom right of many forms and lists:

---

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Timing Values

<table>
<thead>
<tr>
<th>Label</th>
<th>Element</th>
<th>Description</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Time</td>
<td>client_response_time</td>
<td>Calculates the overall time to deliver the page by subtracting the time the user requests the page from the time the page is fully rendered in the browser.</td>
<td>load_completion_time - start_time</td>
</tr>
<tr>
<td>Server Time</td>
<td>client_server_time</td>
<td>This is the time the server takes to process the transaction.</td>
<td>server_time</td>
</tr>
<tr>
<td>Network Time</td>
<td>client_network_time</td>
<td>Calculates the time the network takes to process the request by subtracting the time of the user's request from the time the page starts loading in the browser, and then subtracting the server processing time.</td>
<td>load_time - start_time - server_time</td>
</tr>
<tr>
<td>Browser Time</td>
<td>browser_time</td>
<td>Calculates the time the browser takes to deliver the page by subtracting the time the page is fully rendered from the time the page starts loading in the browser.</td>
<td>load_completion_time - load_time</td>
</tr>
</tbody>
</table>

### Define a relative duration

You can define a relative duration to work out duration time for SLAs.

- From the left navigation pane, select System Scheduler > Relative Durations.

Four baseline Relative Durations are available:

- 2 business days by 4pm
- 3 business days by 4pm
- Next business day by 4pm
- End of next business day

**Note:** Business day durations are defined by the business schedule used. If no schedule is defined, the durations are 24 X 7 by default.

We will start by looking at the End of next business day Relative Duration. From the Relative Durations list, select the **End of next business day** Relative Duration. The variable `days` is set to one, because we want the result of this calculation to land one day in the future. The rest of the script is as in the screenshot below. If
desired, you can customize the time at which you want the Relative Duration to end (currently set to 5pm).

There is one more important Relative Duration design aspect that is used by the other three out-of-box Relative Durations. To illustrate this design we will look at **2 business days by 4pm**.

As you can see in the image below, within the script there is an if-statement. This if-statement is checking to see if the calculated time is after 10am. If it is, then an additional day is added to the calculation. Hence the description of **2 business days by 4pm if before 10am**.

Note that “End of the business day” has nothing to do with the associated Schedule. The end time of 17:00 is hardcoded into this Relative Duration script. If you want the time to be different than the out of the box 5pm, you must change it in the script.

**Use a relative duration**

When you define an SLA, you can set the **Duration type** to be a relative duration.

When using relative durations, you can also use the **Relative duration works on** field to select to calculate either against the SLA record, or the task record that the SLA record is used for.

This example demonstrates how a relative duration of **End of next business day** works.

1. Create an SLA that has a relative duration of **End of next business day**.
2. Complete the rest of the fields of this SLA with the values as shown below, also setting a Schedule and a Timezone if you want.

![SLA Configuration](image1)

3. To show how this Relative Duration works, create a new incident.

Notice that the SLA is started for this incident. If you look at the Planned End Date field you will notice that the date is the next business day at 5pm (See image below).

![Incident Details](image2)

**Note:** Pause conditions are not compatible with Relative Durations.

### Time display

There are three interfaces that display record information over time: reports and performance analytics, timeline pages, schedule pages.
Reports

You can visualize data in two ways:

- **Reporting** enables users to generate charts from data within the platform in a variety of formats. Reporting is available as a standard part of the platform and offers snapshotting of current data.

- **Performance Analytics** enables you to track and aggregate data over time, such as to measure how many tickets are resolved each week per assignment group. Performance
Analytics is enabled for the Incident table by default. To track data for other tables and applications you must license *Get started with Performance Analytics Premium*.

**Timeline pages**

Timeline pages example

Timeline pages allow for easy definition of linear timelines from records with time information.
Schedule pages

Time-related functionality

There are a number of different functionalities that allow for tracking time and leveraging that information across applications.

Time Fields

Time can be stored in different ways in records. Understanding how time is stored underlies use of all of the time functions.

For more information, see: Use Date and Time Fields.

Time Zones

All times are stored in the platform in Universal Coordinated Time. They are displayed globally based on the system time zone, but are displayed to users in their local time zone according to
user settings. Time zone information is important to keep track of to avoid calculation errors or confusing outputs.

All dates and times gathered through web services display in GMT. Data inserted using a web service uses the active user's time zone or the system time zone if the active user does not have a time zone specified.

Schedules

Schedules are rules which include or exclude ranges of time for certain time-related functionality. For example, schedules can restrict SLAs to only count time during business hours.

Displaying Time

There are a number of useful user interfaces that help represent time visually. For more information, see Displaying Time.

Viewing Logs

Logs within the system provide historical information as to what occurred in the instance when.

Scheduling Events

These functionalities allow other functionality to be triggered at particular times, or in response to specific events. For more information, see Schedule Events.

Timing Functionality

These functions gather information with regards to duration. They answer the question "How long?", and can time events based off of that information. For more information, see Timing Functionality.

Range calculator scripts

You can specify a script include that calculates range restrictions and processes parent updates in a timeline page. Following are three examples of script includes that help specify range restrictions.

Range Calculator Scripts

ExampleUpdateParentsRangeCalculator

Updates parent records when a child record span is moved or resized in the timeline.

```javascript
var ExampleUpdateParentsRangeCalculator = Class.create();
ExampleUpdateParentsRangeCalculator.prototype = {
initialize: function() { },
updateParents: function(id, table, startDate, endDate){
```
if (table == "rm_sprint"){
    var releaseID;
    var sprint = new GlideRecord(table);
    sprint.addQuery('sys_id', id);
    sprint.query();
    if (sprint.next())
        releaseID = sprint.release + "";
    if (releaseID) {
        var gr = new GlideRecord("rm_release_scrum");
        gr.addQuery("sys_id", releaseID);
        gr.query();
        if (gr.next()) {
            if (startDate && startDate < this.getTimeMs(gr.start_date))
                gr.start_date = this.getTimeObject(startDate);
            if (endDate && endDate > this.getTimeMs(gr.end_date))
                gr.end_date = this.getTimeObject(endDate);
            gr.update();
        }
    }
}

getMinRangeDetails: function(id, table){ return [-1, -1, "", "];
},
getMaxRangeDetails: function(id, table){ return [-1, -1, ""];
},
gTimeMs: function(date){
    return new GlideScheduleDateTime(date).getMS();
},
getTimeObject: function(timeMS) {
    var gdt = new GlideDateTime();
    gdt.setNumericValue(timeMS);
    return gdt;
},
logMessage: function(message){ gs.log(message); },
type: 'ExampleUpdateParentsRangeCalculator'
}

In this example, the span is identified based on the id and table from function(id, table, startDate, endDate).

ExampleMinRangeCalculator

Defines the earliest start date and the latest end date for a specified span.

var ExampleMinRangeCalculator = Class.create();
ExampleMinRangeCalculator.prototype = {
    initialize: function() { },
    updateParents: function(id, table, startDate, endDate){ },
    getMinRangeDetails: function(id, table){
        var min = -1;
        var max = -1;
        var minID = "";
        var maxID = "";
        if (table == "rm_sprint"){
            var gr = new GlideRecord("rm_sprint");
            gr.addQuery("release", id);
            gr.query();
            while (gr.next()) {
                var start = this.getTimeMs(gr["start_date"]);
                var end = this.getTimeMs(gr["end_date"]);
                var id = gr["sys_id"];  
                if (min == -1 || start <= min){
                    if (start != min)
                        minID = "";
                    min = start;
                    minID += "," + id;
                }
                if (max == -1 || end >= max){
                    maxID = "";
                    max = end;
                    maxID += "," + id;
                }
            
```
ExampleMaxRangeCalculator

Defines the earliest start date and the latest end date for a specified span.

```javascript
var ExampleMaxRangeCalculator = Class.create();
ExampleMaxRangeCalculator.prototype = {
  initialize: function() { },
  updateParents: function(id, table, startDate, endDate){ },
  getMinRangeDetails: function(id, table){ return [-1, -1, "", ""] ; },
  getMaxRangeDetails: function(id, table){
    if (table == "rm_sprint"){
      var sprint = new GlideRecord(table);
      sprint.addQuery('sys_id', id);
      sprint.query();
      if (sprint.next())
        releaseID = sprint.release + "";
      if (releaseID) {
        var gr = new GlideRecord("rm_release_scrum");
        gr.addQuery("sys_id", releaseID);
        gr.query();
        if (gr.next())
          return [this.getTimeMs(gr.start_date),
                  this.getTimeMs(gr.end_date), gr.sys_id];
      }
    }
    return [-1, -1, ""];,
  }

  getTimeMs: function(date){ return new GlideScheduleDateTime(date).getMS(); },
  getTimeObject: function(timeMS) {
    var gdt = new GlideDateTime();
    gdt.setNumericValue(timeMS);
    return gdt; },
  logMessage: function(message){ gs.log(message); },
  type: 'ExampleUpdateParentsRangeCalculator'
}
```

Use the following two functions to obtain the correct start and end dates in the three example script includes provided for reference.

```javascript
getTimeMs: function(date){
  return new GlideScheduleDateTime(date).getMS();
}
```
getTimeObject: function(timeMS) {
    var gdt = new GlideDateTime();
    gdt.setNumericValue(timeMS);
    return gdt;
}

Set an inactivity monitor

An inactivity monitor triggers an event for a task record if the task has been inactive for a certain amount of time.

If the task remains inactive, the monitor repeats at regular intervals. User updates to the task record restart the monitor. If Reset Conditions are defined for the monitor but have not been met when you update the task record, the monitor is not restarted. Inactivity monitors only apply to records on tables that extend the Task table, or the Task table itself.

When an inactivity monitor triggers, it generates an event in the form <tablename>.inactivity (for example, incident.inactivity). The inactivity monitor does not automatically specify further actions, so either an email notification or script action must be defined to drive further action.

A record's activity is only based on user updates. System updates do not count as activity.

1. Navigate to System Policy > SLA > Inactivity Monitors and click New.
2. Give the inactivity monitor a name.
3. Specify the type of record to monitor in the Table field.
4. Specify how long the inactivity monitor should wait before sending each notification in the Wait field.
5. Specify any additional conditions in the Condition field. At least one condition must be specified for the inactivity monitor to work.
6. Specify an Order if multiple inactivity monitors might have their conditions met for a given record - the one with the lowest order will be used.
7. Click Save.

**Note:** If conditions are changed on an inactivity monitor, the monitor stops tracking previously tracked records. An inactivity monitor does not track records that were created before the inactivity monitor, even if the record meets all other conditions.

Escalation intervals and pause conditions

Escalation Intervals and Pause Conditions are not relevant to an inactivity monitor.

The related list and field are available because the inactivity monitor table extends the table used for SLAs, but these elements are not used in any way when an inactivity monitor attaches or is triggered.

System scheduler

The System Scheduler application contains two separate engines for scheduling: the Scheduled Jobs engine and the Schedules engine.
Scheduled Jobs:
Scheduled Jobs performs any work that must be done at a specific time or on a recurring basis. The Scheduled Jobs module links to the Schedule [sys_trigger] table. Manipulating records on the Schedule table is not recommended. Use this table to view existing base system scheduled jobs.

The Scheduled Jobs module in System Definition is an admin-friendly front end for scheduling work. Use this module to create new scheduled jobs.

For more information, see Create a Scheduled Job.

Schedules:
Schedules are rules which include or exclude time on a calendar. They are used by service levels, inactivity monitor, and group on-call rotation. For instance, a schedule can be defined to restrict service levels to only apply to weekdays during business hours, or to exclude holidays from an on-call rotation.

For more information, see Use Schedules.

Scheduled jobs
Scheduled Jobs are automated pieces of work that can be performed at either a particular time, or on a recurring schedule.

These kinds of tasks can be automated:
- Run and distribute a report
- Generate a record (incident, change, configuration item, etc.) from a template
- Run a business rule and do whatever the rule contains
- Scheduling at the end of the month
- Scheduling for weekdays
- Executing scheduled jobs from scripts
### Scheduled job states

A scheduled job can be in any one of the following states.

**Ready**
The job is ready to run at the next scheduled interval.

**Running**
The job is in the process of carrying out a task.

**Queued**
The job has been added to the scheduler queue and is waiting to run.

**Error**
An error occurred in running the job.

### Schedule a report

Scheduled reports are distributed via email.

Roles required: admin or schedule_admin

Scheduled reports created by an individual whose user account is deactivated might not display any data. To ensure that the desired data is displayed, an active user must recreate the scheduled report.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Click **New**.
3. Select **Automate the generation and distribution of a report**.
4. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name to identify this scheduled job.</td>
</tr>
<tr>
<td>Report</td>
<td>A reference to the report to be scheduled. Calendar, Pivot Table, Map and Single Score reports are not supported for automatic emailing.</td>
</tr>
<tr>
<td>Users</td>
<td>The users to send the report to at the scheduled date and time. The user must have Notification set to <strong>Enabled</strong> on their user record to receive reports. To force users to receive emails, use the <strong>Email Addresses</strong> field.</td>
</tr>
<tr>
<td>Groups</td>
<td>The groups to send the report to at the scheduled date and time.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Any other email addresses to send the report to, separated by commas. These emails will always receive the report, even if there's a matching user record for that address that says <strong>Do not notify</strong>.</td>
</tr>
<tr>
<td>Active</td>
<td>If true, this report will be sent at the scheduled date and time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Run           | The type of schedule to send the report on. Choices are:  
  - Daily  
  - Weekly  
  - Monthly  
  - Periodically  
  - Once                                                                                      |
| Day           | If Run is Weekly, the day of the week  
  If Run is Monthly, the day of the month.                                                      |
| Repeat Interval | If Run is Periodically, the duration between each scheduled report. The duration can be days, hours, or minutes.                        |
| Time          | If Run is Weekly or Monthly the time of day, on a 24 hour clock.                                                                        |
| Starting      | The date and time of the first scheduled report.                                                                                           |
| Priority      | The numerical priority of a scheduled job. Set essential jobs to a priority value below 100 and nonessential jobs to a priority above 100.  
  If 70% or more of all scheduled jobs are Overdue, any jobs marked with a value above 100 do not run.                                |
| Subject       | The subject line for the email.                                                                                                           |
| Introductory Message | The body of the email.                                                                                                                      |
| Run as        | The user creating and running the scheduled job. To have the scheduled job assigned to system behavior instead of the person creating the scheduled job, create a system or dummy user and add that user to this field. |
| Type          | The file-type of the attached report. Choices are:  
  - PDF-landscape  
  - PDF  
  - Excel  
  - CSV  
  - PNG                                                                                       |
| Include Detail | If checked, will include details on the records in the report.                                                                               |
| Zip Output    | If checked, the report will be compressed in a .zip file.                                                                                   |

As a workaround for scheduling calendar and pivot table reports for email distribution, consider using the publish option. Publish creates a URL for the report and displays the address above the report form. You can create an email notification with this URL and send the link to people who need to see the report, or you can send the url for the calendar report to a distribution list.
Schedule a script execution

Non-conditional and conditional scripts can be scheduled.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Click **New**.
3. Select **Automatically run a script of your choosing**.
4. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name to identify this scheduled script execution</td>
</tr>
<tr>
<td>Active</td>
<td>If true, the script will be executed at the scheduled date and time.</td>
</tr>
<tr>
<td>Run</td>
<td>The type of schedule to execute the script on. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Daily</td>
</tr>
<tr>
<td></td>
<td>• Weekly</td>
</tr>
<tr>
<td></td>
<td>• Monthly</td>
</tr>
<tr>
<td></td>
<td>• Periodically</td>
</tr>
<tr>
<td></td>
<td>• Once</td>
</tr>
<tr>
<td>Day</td>
<td>• If Run is <strong>Weekly</strong>, the day of the week</td>
</tr>
<tr>
<td></td>
<td>• If Run is <strong>Monthly</strong>, the day of the month</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>If Run is <strong>Periodically</strong>, the duration between each script execution.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This setting does not account for Daylight Savings Time changes.</td>
</tr>
<tr>
<td></td>
<td>For example, if you select a period of one day, this adds 24 hours to the</td>
</tr>
<tr>
<td></td>
<td>starting time of the job. If the start time was configured during a period</td>
</tr>
<tr>
<td></td>
<td>with Daylight Savings Time, the job executes with a one hour offset on days</td>
</tr>
<tr>
<td></td>
<td>when that time zone is not in Daylight Savings Time.</td>
</tr>
<tr>
<td>Time</td>
<td>If Run is <strong>Daily</strong>, <strong>Weekly</strong>, or <strong>Monthly</strong>, the time of day, based on a</td>
</tr>
<tr>
<td></td>
<td>24 hour clock.</td>
</tr>
<tr>
<td>Starting</td>
<td>The date and time of the first scheduled script execution.</td>
</tr>
<tr>
<td>Application</td>
<td>The application that contains the script.</td>
</tr>
<tr>
<td>Conditional</td>
<td>If checked, the entity will only be executed if certain conditions are met.</td>
</tr>
<tr>
<td>Condition</td>
<td>If <strong>Conditional</strong> is checked, a script determines under what conditions the</td>
</tr>
<tr>
<td></td>
<td>scheduled script is executed. The last expression of the script should</td>
</tr>
<tr>
<td></td>
<td>evaluate to a Boolean (true/false) value.</td>
</tr>
</tbody>
</table>
Example

The following is an example of a conditional script. This example runs the scheduled job only if there are active Incidents older than 30 days.

```java
// Only run this Scheduled Job if there are active Incidents over 30 days old
var ga = new GlideAggregate('incident');
ga.addAggregate('COUNT');
ga.addQuery('active', 'true');
ga.addQuery('sys_created_on', '<', gs.daysAgo(30));
ga.query();
ga.next();
ga.getAggregate('COUNT') !== '0'
```

Schedule the generation of an entity

You can schedule the generation of entities, which include changes, incidents, and CIs.

1. Navigate to System Definition > Scheduled Jobs.
2. Click New.
3. Select Automatically generate something (a change, an incident, a ci, etc) from a template.
4. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>If true, the entity will be generated at the scheduled date and time.</td>
</tr>
<tr>
<td>Run</td>
<td>The type of schedule to generate the entity on. Choices are:</td>
</tr>
<tr>
<td></td>
<td>- Daily</td>
</tr>
<tr>
<td></td>
<td>- Weekly</td>
</tr>
<tr>
<td></td>
<td>- Monthly</td>
</tr>
<tr>
<td></td>
<td>- Periodically</td>
</tr>
<tr>
<td></td>
<td>- Once</td>
</tr>
<tr>
<td>Day</td>
<td>If Run is Weekly, the day of the week</td>
</tr>
<tr>
<td></td>
<td>If Run is Monthly, the day of the month.</td>
</tr>
<tr>
<td>Repeat Interval</td>
<td>If Run is Periodically, the duration between each scheduled generation.</td>
</tr>
<tr>
<td>Time</td>
<td>If Run is Weekly or Monthly the time of day, on a 24 hour clock.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Starting</td>
<td>The date and time of the first scheduled generation.</td>
</tr>
<tr>
<td>Conditional</td>
<td>If checked, the entity will only be generated if certain conditions are met.</td>
</tr>
<tr>
<td>Condition</td>
<td>If Conditional is checked, a script determines under what conditions the scheduled script is executed. The last expression of the script should evaluate to a Boolean (true/false) value.</td>
</tr>
<tr>
<td>Generate this</td>
<td>A reference to a template for a record.</td>
</tr>
</tbody>
</table>

### Special cases in job schedules

Some special cases require care in job scheduling.

### End of the month schedules

Because months have different lengths, take care when scheduling jobs for the end of the month.

- Scheduling an event for the 29th or 30th is not recommended, because the scheduled job will not be executed in months (like February) which are shorter than those dates.
- If an event is scheduled for the 31st, it will be executed on the last day of the month, even if the month is shorter.

For example, something scheduled to run on the 31st of the month will run on February 28th or February 29th in a leap year.

### Weekday schedules

For scheduled scripts, use the following script to run only on weekdays:

```javascript
(function isWeekday() {
  var isWeekday;
  var gDate = new GlideDate(); //Uses your Timezone!
  var day = gDate.getByFormat('EEEE'); //Gets name of day
  switch(day) {
    case "Saturday":
    case "Sunday":
      isWeekday = false;
      break;
    default:
      isWeekday = true;
  }
  return isWeekday;
})();
```

### Scheduled jobs from scripts

To execute a scheduled job triggered by an event, use the following script:

```javascript
//Execute a scheduled script job
```
var rec = new GlideRecord('sysauto_script');
rec.get('name', 'YOUR_JOB_NAME_HERE');
SncTriggerSynchronizer.executeNow(rec);

This script can be run using one of several tables:
- scheduled_import_set (Scheduled Import Sets)
- sysauto_script (Scheduled Script Execution)
- sysauto_template (Scheduled Template Generation)
- sysauto_report (Scheduled Report)

**Note:** SncTriggerSynchronizer does not provide methods to execute scheduled jobs in the future.

### Running schedule jobs imported from another instance

To prevent unexpected data changes, the system does not automatically create Schedule Item (sys_trigger) records for Scheduled Jobs (sysauto) imported from an XML file such as an update set. To run a scheduled job imported from another instance, update the scheduled job record.

#### Create a scheduled job

Create a scheduled job on the Schedule Job (sysauto) table (System Definition > Scheduled Jobs).

Create all new scheduled jobs using this method. Some existing scheduled jobs are found on the Schedule Item (sys_trigger) table (System Scheduler > Scheduled Jobs). Do not create new scheduled jobs on the Schedule Item table.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Click **New**.
3. Select the appropriate type of scheduled job.

![Wizard](wizard.png)

**Automation Creator**

What would you like to automate?

- Automate the generation and distribution of a report
- Automatically generate something (a change, an incident, a CI, etc) from a template
- Automatically run a script of your choosing

The fields presented will depend on the type of scheduled job required.

#### View a schedule item

Schedule items are individual instances of a scheduled job. You can view them from the system scheduler.

- Navigate to **System Scheduler > Today’s Scheduled Jobs**.
  The table displays each schedule item that will be run.
Event scheduling

There are a variety of tools available for scheduling actions or tasks to happen in the future.

Maintenance schedules
Changes to the CMDB can be managed through the Maintenance Schedules Plugin, which allows changes to be proposed and viewed through a timeline.

On-call rotation
The Group On-Call Rotation Plugin allows a schedule to be defined to determine what users are primary contacts during particular hours of the day.

Scheduled reports
Once reports are defined, they can be scheduled to be emailed at a specific time, or at regular intervals, using the reporting interface.

Scheduled workflows
Workflows provide a robust system for automating advanced multi-step processes. Workflows can be triggered by conditions, like business rules, or they can be scheduled for a particular time/recurring schedule, like scheduled jobs.

Scheduled jobs
Scheduled jobs are scripts which can be set to be automatically performed at a specific date and time, or on a repeating basis.

Event registry
Events can be used to schedule actions or tasks to occur when conditions are fulfilled.

For example:
- **kb.view**: an event triggered when a user views a Knowledge Base article, used to trigger the script action Knowledge View to create a Knowledge Use record every time an article is viewed.
- **incident.commented**: an event triggered when a user comments on an article, used by two incident commented email notifications.

Inactivity Monitors:
An inactivity monitor triggers an event if a record has not been updated for a defined length of time.

Script Actions:
Script actions are scripts which are triggered when an event is recorded in the log. In that way, scripts can be set to be performed whenever a particular activity occurs in the platform, rather than at a particular time (like scheduled jobs) or in response to particular conditions (like Business rules).

Notifications:
Events are also used to trigger Email Notifications when an event is recorded in the log.

Register an event

You can register an event for a specific table and a business rule that fires the event.
1. To register an event, browse to System Policy > Events > Registry, and then click New.
2. Complete the Event Registration form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your new event.</td>
</tr>
<tr>
<td>Table</td>
<td>The database table for this event.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the purpose of the event.</td>
</tr>
<tr>
<td>Fired by</td>
<td>Name of the business rule that runs the event. This field is for reference</td>
</tr>
<tr>
<td>Queue</td>
<td>Name of the queue that the event is placed into when triggered.</td>
</tr>
</tbody>
</table>

Note: The list shows only tables and database views that are in the same scope as the event.

Timeline pages

Use timeline pages to track any activity bounded by two dates, such as the start and end date of a change request or the open and close date of an incident. For details on timeline navigation, filtering, and working with calendar perspectives, see Using Timelines.

Features

- Make selected timelines available to users by role.
- Select perspective from daily to yearly views.
- Create dynamic labels for timeline spans.
- Configure tooltips for each span.
- Permit span dragging and resizing by users.
- Lock timelines to prevent editing.

Timelines

Timelines display a linear calendar of tasks, such as incidents and change requests, defined by their start and end dates.

A span represents each task on the timeline, which is displayed as a horizontal bar and may have distinctive color coding. Each span has a label and can have tooltip text containing additional
information about the task. You can also change the perspective of the calendar for a more granular view of the data.

**Timeline pages**

Timeline pages are created by an administrator and are user interactive. They can be navigated and zoomed, and records can be updated from within the timeline by manipulating the spans.

**Viewing Timelines**

By default, only administrators have a module to access timeline records. ITIL users can only view timelines by selecting a context menu item from an incident record.
Administrator Role Users

Users with an administrator role can view timelines from the timeline page records.

1. Navigate to System UI > Timeline Pages.
2. Select a timeline record to view.
3. Click View Timeline.

Other Users

ITIL users can view timelines associated with any task record where the metrics are set to display as timeline records (by default, only Incident records display timeline metrics). ITIL users can select the Metrics Timeline context menu UI action to view the Assigned to duration and the State duration metric timelines.

1. Navigate to active task record, such as an incident.
2. Right-click the banner, and select Metrics Timeline.

To allow non-administrators to view other timelines, create a custom module.
Span details
If the left navigation pane is visible, the span label is visible in the left pane.

If the left pane is hidden, point the cursor over a span to view the tooltip.

Timeline Tooltip

Span focus and zoom
You can use keyboard shortcuts when using timelines.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macintosh</td>
<td>Command + Click</td>
</tr>
<tr>
<td>Windows</td>
<td>Control + Click</td>
</tr>
</tbody>
</table>

Spans edits
If the timeline has been configured for editing (horizontal moving, start and end date dragging), use the mouse to adjust the spans to suit your needs.

Dragging the span and changing the start or end dates updates the parent record.

Move the start or end dates to change the duration of the task.
High Priority Incidents

Timeline Drag Start

Move the entire span horizontally to adjust the start and end dates but not the duration.

Timeline Drag Span

Changes in perspective

Use the range selectors at the top of the timeline to change the perspective.

The increments go from one day to one year. To limit the timeline to an increment between the start date of the first span and the end date of the last span, click Max. Use the starting and ending calendar fields to select the timeline perspective. These fields control the same perspective as the slider at the bottom of the timeline. The green, vertical line indicates the current date and time, and sweeps across the timeline automatically.

Timeline Perspective Bar
The increments go from one day to one year. To limit the timeline to an increment between the start date of the first span and the end date of the last span, click Max. Use the starting and ending calendar fields to select the timeline perspective. These fields control the same perspective as the slider at the bottom of the timeline. The green, vertical line indicates the current date and time, and sweeps across the timeline automatically.

Timeline Perspective Bar

The pink slider at the bottom of the timeline offers another way to change the perspective. Move the slider from right to left to view all the spans on a long timeline. Adjust the end points of the slider to make arbitrary changes to the magnification. A narrow slider zooms in on the spans and provides a more detailed view of complex timelines. A wide slider pulls the view out and makes more of the timeline visible on the screen.

Timeline Perspective Slider

Create a timeline page

Create a timeline page to track any activity bounded by two dates.

1. Navigate to System UI > Timeline Pages.
2. Click New.
3. Fill in the form as described in the table and click Submit.

Creating A Timeline Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name that describes the function of this timeline. For example, High Priority Change Requests.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the name of the table associated with this timeline, such as Change Request [change_request].</td>
</tr>
<tr>
<td>Start date field</td>
<td>Select a time-related field from the specified table to use as the start date for the timeline. The timeline begins with the span for the record with the earliest start date from this field, after the filter and sort order are applied. For example, you can select Updated as the start date field and start the span for each active change request on the date it was updated to a high priority.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End date field</td>
<td>Select a time-related field from the specified table to use as the end date for the timeline. The timeline ends with the span for the record with the latest date from this field, after the filter and sort order are applied. For example, you can select Closed as the end date field and display all high priority change requests by the date on which they were closed.</td>
</tr>
<tr>
<td>Display Options</td>
<td></td>
</tr>
<tr>
<td>Show grid lines?</td>
<td>Select this check box to show horizontal background shading to highlight alternate spans.</td>
</tr>
<tr>
<td>Show left pane?</td>
<td>Select this check box to show label text in a pane on the left of the timeline. The text that appears in this pane is defined in Span text fields.</td>
</tr>
<tr>
<td>Show summary pane</td>
<td>Select this check box to show the pink, perspective slider at the bottom of the timeline. Move the slider from right to left to scroll across the chart. Adjust the end points of the slider to change the magnification. A narrow slider zooms in on the spans and provides a more detailed view. A wide slider pulls the view out and makes more of the timeline visible on the screen.</td>
</tr>
<tr>
<td>Auto refresh</td>
<td>Select an automatic refresh interval or disable automatic refresh. When auto refresh is disabled, the timeline adjusts only when the browser is manually refreshed or when a start or end date field is updated in a record.</td>
</tr>
<tr>
<td>CSS span color</td>
<td>Enter a custom span color using any CSS color format, such as RGB or hexadecimal. If this field is blank, the default span color, light blue, is used.</td>
</tr>
<tr>
<td>Show span text</td>
<td>Select this check box to display the content of the Span text fields as labels below each span.</td>
</tr>
<tr>
<td>Span text fields</td>
<td>Select fields from the specified table to have those values appear as span labels. For example, you might select Number and Short description. The span labels also appear in the left pane if the left pane is visible.</td>
</tr>
<tr>
<td>Show tooltips</td>
<td>Select this check box to display tooltips when the cursor rests on a span.</td>
</tr>
<tr>
<td>Tooltip text fields</td>
<td>Select from the specified table the fields whose values appear as tooltips. For example, you might select Category, Assigned to, and Due date.</td>
</tr>
</tbody>
</table>

Filtering and Sorting

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Create a condition to filter the results that appear in the timeline. For example, a condition that displays only active, high priority incidents. <strong>Add the condition count to a condition field</strong> to preview what records will be returned by this condition set.</td>
</tr>
<tr>
<td>Perform custom sort?</td>
<td>Select this check box to enable custom sorting. Configure the sort order by selecting fields in the Sort by and Sort by order fields.</td>
</tr>
<tr>
<td>Sort by</td>
<td>Select any field in the list for sorting the spans in the timeline. Common practice is to select either the Start date field or the End date field as the sorting field. If you select a different sorting field, also include that field in the list of Tooltip text fields to give users a way of discovering the sort criteria.</td>
</tr>
<tr>
<td>Sort by order</td>
<td>Select the sort order for the sorting fields selected.</td>
</tr>
<tr>
<td>Interactive Options</td>
<td></td>
</tr>
<tr>
<td>Allow horizontal moving?</td>
<td>Select this check box to permit users to drag timeline spans horizontally. Dragging changes the start and end dates and updates the record.</td>
</tr>
<tr>
<td>Allow start time dragging?</td>
<td>Select this check box to permit users to update the record by dragging the start time of a span.</td>
</tr>
<tr>
<td>Allow end time dragging?</td>
<td>Select this check box to permit users to update the record by dragging the end time of a span.</td>
</tr>
<tr>
<td>Range calculator</td>
<td>Specify a script include that calculates range restrictions and processes parent updates, if appropriate.</td>
</tr>
</tbody>
</table>

A completed Timeline Page record looks like this.
Customize the timeline page span style

The Timeline Page Span Style related list allows you to define conditional span styles.

1. Navigate to System UI > Timeline Pages.
2. Open the timeline page for which you want to define the span style.
3. Go to the Timeline Page Span Styles related list and click New.
4. Fill in the form as described in the table and click Submit.

The Timeline Page Span Style form provides the following fields.
Customizing the Timeline Page Span Styles

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Create a <a href="#">Condition Builder</a> to filter the results that appear in the timeline.</td>
</tr>
<tr>
<td>Label color</td>
<td>Select the color for the text under each span.</td>
</tr>
<tr>
<td>Label decoration</td>
<td>Select a character style for the text under each span: Bold, Italic, Underline, or Line-through.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to determine the sequence in which the style conditions are evaluated. Style conditions with a lower order are evaluated first.</td>
</tr>
<tr>
<td>Span color</td>
<td>Select the color of each span.</td>
</tr>
<tr>
<td>Timeline page</td>
<td>Select the timeline page to which the span style applies. By default, the span applies to the current timeline.</td>
</tr>
</tbody>
</table>

Display a metric as a timeline

Administrators can allow users to display any metric on a timeline by activating the Timeline Metrics UI action.

1. Navigate to [Metrics > Definitions](#).
2. Select the metric you want to display on a timeline. For example, Problem State Duration.
3. Select the [Timeline](#) checkbox.
4. Click [Update](#).

The UI action is available on the same table as the metric. By default, only Incident metrics are available.
Make a timeline visible to a selected user

Make selected timelines available to users by creating a custom module within an application and defining the roles that can access it.

To permit these users to update task records directly from the timeline, configure the timeline to allow span dragging.

**Note:** Timelines delivered by a custom module are not entirely dynamic. The left pane, the summary pane, the auto-refresh feature, and the grid lines are not dynamic and do not reflect changes made to the timeline record after the module link is created. However, the data represented by the spans, the labels, and tooltips display all updates in the custom module.

To create a timeline page module:

1. Right-click an application (such as Incident) in the navigation pane and select **Edit application**.
2. In the application Modules related list, click **New**.
3. **Configure** the Module form to add the Timeline page field.
4. Fill in the form as described in the table and click **Submit**.

The Module form provides the following fields.

**Making Timelines Visible to Selected Users**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the module as it will appear in the navigation pane. For example, you might use Planning Timeline.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to determine the sequence in which this condition will be evaluated if more than one matching condition exists. Conditions with a lower order are evaluated first.</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application for the new module.</td>
</tr>
<tr>
<td>Hint</td>
<td>Enter a brief description of the module that appears when the user places the cursor over the module name. For example, you might enter Weekly view of high priority changes.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to enable the module for the roles defined. Clear this check box to disable the module for all users.</td>
</tr>
<tr>
<td>Image</td>
<td>Select an appropriate icon to appear with the module name.</td>
</tr>
<tr>
<td>Link type</td>
<td>Select <strong>Timeline Page</strong>. When this link is selected, the Timeline Page field appears.</td>
</tr>
<tr>
<td>Timeline Page</td>
<td>Select the timeline page you want to appear in this module. For example, for the Change application select a change-related timeline, for the Incident application select an incident related timeline.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles that can access this module.</td>
</tr>
</tbody>
</table>

The completed module form looks like this.
Timeline sub item

Use the Timeline Sub Items related list to define child spans for the timeline, based on records in a table that references the parent timeline’s table.

This can be used to generate a hierarchical relationship starting from a timeline page to any number of levels. For example, if there is a timeline page for a release, a sub item might be sprints, and a sprint might have stories as a sub item.

To create a new sub item:

1. Navigate to **System UI > Timeline Pages**.
2. Open the timeline page for which you want to add a sub item.
3. Go to the Timeline Sub Items related list and click **New**.
4. Fill in the the form as described in the table and click **Submit**.

The Timeline Sub Item form provides the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent</strong></td>
<td><em>(Read-only)</em> Identifies the parent of the timeline sub item.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Enter a unique name that describes the function of this timeline.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Select the table called by this timeline. The selected table must have at</td>
</tr>
<tr>
<td></td>
<td>least one reference field to the table selected for the parent timeline</td>
</tr>
<tr>
<td></td>
<td>page. For example, if the parent timeline page uses the Scrum Release</td>
</tr>
<tr>
<td></td>
<td><em>(rm_release_scrum)</em> table, you might choose the Sprint <em>(rm_sprint)</em> table</td>
</tr>
<tr>
<td></td>
<td>for a timeline sub item.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start date field</td>
<td>Select a time-related field from the specified table to use as the start date for the timeline. For example, Planned start date.</td>
</tr>
<tr>
<td>End date field</td>
<td>Select a time-related field from the specified table to use as the end date for the timeline. For example, Planned end date.</td>
</tr>
<tr>
<td>Parent Reference Column</td>
<td>Select a reference field on which to base the timeline connection between the sub item records and the parent records. If multiple reference fields are available, choose the reference field that forms part of the hierarchy to be modeled by this timeline. If this list is blank, the sub item table contains no reference fields to the parent table. In this case, you must choose a different table for the sub item. ServiceNow uses the parent reference column to determine which records are displayed at each level of the timeline.</td>
</tr>
<tr>
<td>Display Options</td>
<td></td>
</tr>
<tr>
<td>CSS span color</td>
<td>Enter a custom span color using any CSS color format, such as RGB or hexadecimal. If this field is blank, the default span color, light blue, is used.</td>
</tr>
<tr>
<td>Span text fields</td>
<td>Select fields from the specified table to have those values appear as span labels. For example, you might select Number and Short description. The span labels also appear in the left pane if the timeline displays the left pane.</td>
</tr>
<tr>
<td>Tooltip text fields</td>
<td>Select fields from the specified table to have those values appear as tooltips. For example, you might select Category, Assigned to, and Due date.</td>
</tr>
<tr>
<td>Filtering and Sorting</td>
<td></td>
</tr>
<tr>
<td>Condition builder</td>
<td>Create a condition to filter the results that appear in the sub item. For example, you might create a condition that displays only active, high priority incidents.</td>
</tr>
<tr>
<td>Perform custom sort</td>
<td>Select this check box to enable custom sorting. Configure the sort order by selecting fields in the Sort by and Sort by order fields.</td>
</tr>
<tr>
<td>Sort by</td>
<td>Select any field in the list for sorting the spans in the timeline. Common practice is to select either the Start date field or the End date field as the sorting field. If you select a different sorting field, also include that field in the list of Tooltip text fields to give users a way of discovering the sort criteria.</td>
</tr>
<tr>
<td>Sort by order</td>
<td>Select the sort order for the sorting fields selected.</td>
</tr>
<tr>
<td>Interactive options</td>
<td></td>
</tr>
</tbody>
</table>
Field | Definition
--- | ---
Allow horizontal moving? | Select this check box to permit users to drag timeline spans horizontally. Dragging changes the start and end dates and updates the record.
Allow start time dragging? | Select this check box to permit users to update the record by dragging the start time of a span.
Allow end time dragging? | Select this check box to permit users to update the record by dragging the end time of a span.
Restriction | Specify the behavior when dragging a child span (available only if no Range calculator was specified for the parent timeline page).  
  • None: No restriction is in place.  
  • Restrict by parent: Child span can be moved only within the time frame defined by the parent span.  
  • Update parent: Parent span is updated when the child span is moved outside the time frame defined by the parent span.

**Timing functionality**

Timing functionality are tools that exist to answer the question "How Long?"

**Metric definitions**

Defined metrics can track how long an audited field holds a certain value.

For instance, a metric can track how long an incident is assigned to an individual, or how long an incident is in the state Active.

**Time configuration SLAs**

Service Level Agreements time how long a task meets a certain condition, and is primarily used to ensure that tasks are handled within a pre-determined time limit.

SLAs define the following conditions:

• Start Conditions  
• Pause Conditions  
• Stop Conditions

Once a task meets the Start Conditions, the SLA will time how long the task remains in that condition (unless it meets Pause Conditions). The timer will end if the Stop Conditions are met. If the time-limit is passed, the SLA will be marked breached.

Notifications can be driven off of the SLA to warn interested parties as the time limit approaches.

For more information on SLA configuration, see [Configure SLAs](#).
Time worked fields

The Task `[task]` table provides a time-tracking field called **Time worked**. This field measures how long a record has been viewed in order to measure work time on a ticket.

![Time worked: 03:13:18](image)

**Time Worked**

Any table that extends Task can use this field. To add the field, [configure the form](#).

As the record is viewed, the timer counts upward. To pause the timer, click the stop icon (⏹).

To resume the timer, click the start icon (▶).

When the task is saved, the amount of new time in the timer is used to generate a record on the Time Worked (task_time_worked) table. This table can be viewed as a related list on the task form.

By default, the time displayed in the **Time worked** field displays a cumulative value stored in the task record. If you modify a Time Worked record, the changes will not be reflected in the task timer.

You can set the property `com.snc.time_worked.update_task_timer` to enable updating of the task timer value based on changes to the time worked records. This is accomplished through the **Update task timer** business rule.

**Time zones**

All times are stored in Coordinated Universal Time (UTC). They are displayed globally based on the system time zone, but appear to users in their local time zone according to user preferences.

**Time zone representation**

Time zones that have the Country/City format are primary time zone IDs. Other time zone IDs are links to the primary time zone. For example, US/Pacific is a link to the America/Los_Angeles time zone. Both America/Los_Angeles and US/Pacific represent Pacific Standard Time with the same zone offset and Daylight Savings Time (DST) schedule.

Other than the representation, there is no impact on date and time functionality.

In the absence of a default time zone for the user or the system, JVM reads default time zone information from the machine. Depending on how the machine is configured, it might return the Country/City or link, for example, US/Pacific or America/Los_Angeles. Administrators should configure their system with a default time zone `glide.sys.default.tz` to avoid system dependencies. For more information, see [Time zone representation](#).

**Daylight Saving Time**

In general, if a time zone is specified based on location (for example, America/Los_Angeles), the system automatically adjusts for daylight saving time. If a time zone is specified based on the name of a time zone (for example, GMT), which is discouraged, it does not typically adjust.
for daylight saving time. There are however exceptions to these guidelines. For more detailed information on how daylight saving time is handled in Java, refer to these websites:

- https://www.iana.org/time-zones

User preferences

Once the System Time Zone is defined, users can also select their own time zone from their user form, accessed through Self-Service > My Profile. The System default appears as System ((name of the default time zone)). For example, if the System time zone is America/Los_Angeles, the user sees System (America/Los Angeles).

Time zones in email notifications

The date and time stamp of a notification uses the system time zone and not the time zone of any recipient. The property glide.email.append.timezone in System Properties > Email controls whether to append the time zone. If true, the system time zone of the instance is appended to any dates or date/times in outbound email messages (for example, 2010-07-02 04:01:14 PST).

Time zones in service level agreements

Service level agreements have different options for which time zone to use. To set a time zone for SLAs, navigate to Service Level Management > SLA Properties and locate the following property:

```
Use the following time zone for SLA:
```

- The caller's time zone
- The SLA definition's time zone
- The CI's location's time zone
- The task's location's time zone
- The caller's location's time zone

Some special considerations:

- If The caller's time zone is selected, unpredictable behavior can occur if the caller does not have a time zone defined.
- If The SLA definition's time zone is selected, the time zone must be manually defined on the SLAs form.

Time zone in scripting

When scripting on the server, there are several GlideSystem date and time functions used to obtain time values. For more information about specific methods and to learn the format in which each returns the requested time, see the .

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Enhancements

DST enhancement requires that reports and queries observe daylight saving time rules. Changes affect trend charts, line charts, and filters using the “trend on” operation.

Time zone changer

The time zone changer is active by default. Users can change their time zone for the current session in the system settings (the gear on the top right of the banner). Upon the next login, the time zone setting reverts to the system default, or user profile setting for time zone.

Change the time zone choice list

Wherever users have a choice of time zone, the choices are populated using the Time Zone choice list on the User [sys_user] table. Not all time zones appear by default.

To add or remove time zones from the list of time zones:

1. Navigate to User Administration > Users and open any user record, or click New.

   Notice that the default time zone is System (America/Los_Angeles).

2. Right-click Time zone, and then select Personalize Choices.

3. Highlight the desired time zone from the Available or Selected lists, and then Add or Remove the time zones as needed.
Change a time zone in a scheduled report

By default, scheduled reports use the time zone of the user who runs them (the user in the Run As field) to evaluate the query parameters. You are able to change this time zone.

For example, a report on 'incidents open today' resolves 'today' based on the user's time zone. To manually specify the time zone used to resolve the parameters of the report:

1. Configure the form to add the Run As tz field to the Scheduled Report form.
2. Select the appropriate time zone.

Change a time zone in a scheduled data import

By default, scheduled data imports are run using the time zone of the user who creates them. However, there is a way to manually specify the time zone for the import.

To change the time zone of the scheduled data import:

1. Configure the form to add the Run As tz field to the Scheduled Data Import form.
2. Select the appropriate time zone.
3. Click Update.

Set a system time zone

Set your system time zone with a system property.

All times are stored in Coordinated Universal Time (UTC), but are displayed globally based on system time zone (glide.sys.default.tz) or, if specified, according to user preference.

1. Navigate to System Properties > System.
2. Locate the property System timezone for all users unless overridden in the user's record (glide.sys.default.tz).
By default, the input field is blank. If no time zone is defined for this property, America/Los Angeles is the default.

3. Add a time zone in the format Country/City or using the name of a time zone (for example, GMT) and click **Save**. For available values, see **Time zone representation**.

The new system time zone automatically cascades to all users who do not already have a specified time zone. If a user selects a different time zone or if the administrator selects a different time zone for them, the user is assigned the selected time zone and does not use the system time zone anymore.

### Search administration

The system uses the Zing search engine to manage search functionality.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Zing text indexing and search engine</strong></td>
<td><strong>Zing indexes words</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Features of search administration</strong></td>
<td><strong>Global text search finds records from multiple tables</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Features of Zing text indexing and search engine</strong></td>
<td><strong>List search finds records from the current table</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Boolean operators allow conditional search results</strong></td>
<td><strong>Ask or answer questions in the Platform forum</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Quotation marks allow exact phrase searches</strong></td>
<td><strong>Search the HI Knowledge Base for known error articles</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Wildcard characters allow searching for patterns and variations</strong></td>
<td><strong>Contact ServiceNow Technical Support</strong></td>
</tr>
</tbody>
</table>

### Features of search administration

Enable and configure search administration features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zing text indexing and search engine</strong></td>
<td>Index and search record data by table.</td>
<td><a href="#">Enable text indexing for a table</a></td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="#">Zing can expand search results with synonyms</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="#">Zing can include attachments in search results</a></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Top tasks</td>
<td>Status</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>Contextual search</strong></td>
<td><strong>displays matching knowledge results</strong></td>
<td><em>Define search fields on a form</em></td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>Display knowledge search results on forms and record producers when users enter text in a field.</td>
<td><em>Define search context</em></td>
<td></td>
</tr>
</tbody>
</table>

### Zing text indexing and search engine

Index and search record data by table.

Zing text search is:
- an index split into multiple database shards for parallel querying
- created entirely with ServiceNow code
- implemented purely within the relational model
- yields fast results with search engine logic
- provides search results with an emphasis on relevancy scoring
  - frequency points
  - proximity points
  - field-level scoring (such as title, metadata, and short description)

- provides search suggestions
  - Type-ahead search suggestions
  - Did you mean: global search suggestions

Administrators and users with the ts_admin role can configure:
- match relevance
- field weights for each table
- global stop words
- stop words for each index
- synonym dictionaries for each table
- tables with attachment indexing

By default, the system uses the Zing text indexing and search engine to search record data.

### Features of Zing text indexing and search engine

Enable and configure Zing text indexing and search engine features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zing computes document scores using three components</strong></td>
<td>Compute document scores based on the frequency, sequence, and weight of search terms in the document.</td>
<td><em>Score search terms by inverse document frequency (IDF)</em></td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Set the relative weight of a field</em></td>
<td></td>
</tr>
</tbody>
</table>
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
<th>State</th>
</tr>
</thead>
</table>
| **Global text search finds records from multiple tables** | Search multiple record types from a single search field. | • Add a search group  
• Enable text indexing for a table | Active |
| **Global text search displays results dynamically** | Display global text search results for each table as Zing generates them. | • Add a search group  
• Revert to the legacy global search UI | Active |
| **List search finds records from the current table** | Search records from a table list view. | • Enable text indexing for a table  
• Regenerate a text index for a table | Active |
| **Zing can include attachments in search results** | Expand search results to include attachments from indexed tables. | • Enable attachment indexing on a table  
• Enable text indexing for a table | Active |
| **Zing removes stop words from queries** | Remove common words from search queries that do not produce meaningful results. | • Configure a global stop word  
• Configure a table-specific stop word | Active |
| **Zing matches derived words with stemming** | Convert any multiple-character search keyword to its stem form to find derived versions of the word. | • Set localization properties  
• Activate a language | Active |
| **Zing can expand search results with synonyms** | Expand search results to include additional search terms.  
Requires configuration before use | • Enable search synonyms  
• Create synonym dictionaries | Inactive |

## Available search options

Zing offers users several search interfaces and search operators to conduct text searches.

### Available search interfaces

<table>
<thead>
<tr>
<th>Search interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Global text search</strong></td>
<td>Find records in multiple tables from a single search field.</td>
</tr>
<tr>
<td><strong>Lists</strong></td>
<td>Find records in a list; search in a specific field (Go to), all fields (Search), or in a specific column.</td>
</tr>
<tr>
<td><strong>Knowledge Base</strong></td>
<td>Find knowledge articles.</td>
</tr>
</tbody>
</table>
### Search interface

<table>
<thead>
<tr>
<th>Search operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation filter</td>
<td>Filter the items in the application navigator.</td>
</tr>
<tr>
<td>Live feed</td>
<td>Filter, search, or sort messages in live feed.</td>
</tr>
<tr>
<td>UI pages</td>
<td>Create a custom UI page to search for records in a table.</td>
</tr>
</tbody>
</table>

### Available search operators

<table>
<thead>
<tr>
<th>Search operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean operators</td>
<td>Include or exclude search terms from global text searches.</td>
</tr>
<tr>
<td>Quotation marks</td>
<td>Filter search results to only include matches to an exact phrase consisting of one or more words.</td>
</tr>
<tr>
<td>Wildcard characters</td>
<td>Expand search results to match any non-space character. The system supports both single-character and multiple-character wildcards.</td>
</tr>
</tbody>
</table>

### Global text search finds records from multiple tables

Search multiple record types from a single search field.

To perform a global text search, perform one of the following actions based on the UI version you are using.

<table>
<thead>
<tr>
<th>UI version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td>Click the search icon in the banner on the upper right of the System settings for the user interface (UI), and then enter the search term.</td>
</tr>
<tr>
<td>UI15 or UI11</td>
<td>Enter the search term in the search box in the upper right of the UI15 banner frame and Edge buttons or Legacy: UI11 banner frame.</td>
</tr>
</tbody>
</table>

All UI versions also have a global text search keyboard shortcut. The `ui_global_text_search` UI Macro provides the global text search field.

By default, the system returns results for tasks, Live Feed, policy, people, places, knowledge, and catalog records.

**Global text search displays results dynamically**

Display global text search results for each table as Zing generates them.
Global text search results UI

Zing displays search results in a dedicated page consisting of these elements.

**Elements of the global search results UI**

<table>
<thead>
<tr>
<th>UI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Search terms</td>
<td>The current search terms and a text box to enter new search terms.</td>
</tr>
<tr>
<td>2. Total results</td>
<td>The total number of matching records.</td>
</tr>
<tr>
<td>3. Search group name</td>
<td>The name of the search group.</td>
</tr>
<tr>
<td>UI element</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 4. Preview of matching records   | The partial list of matching records up to the preview limit. By default, the system displays up to ten matching records per table. The system displays a separate list for each table in the search group sorted from highest to lowest document score.  
By default, the system uses the table text_search list view if available. Otherwise, it displays fields with the default list view.  
Administrators can set the preview results limit and the search results view from the [global text search properties](#).                                                                 |
| 5. Table name                    | The name of the search group table and the number of matching records in the table. Click the link to launch a filtered list view based on the query.                                                           |
| 6. Table filter                  | The current filter applied to search results from this table. Pointing to the information icon displays a pop-up containing the search filter applied. See [Add a search group](#) for information on applying a table filter to a search group. |
| 7. Progress bar                  | The current percentage of tables searched. The system hides this element after the search is complete.                                                                                                         |
| 8. Link to all table results     | The link to see all matching records from the search group table. Click the link to launch a filtered list view based on the query.                                                                                 |
| 9. Global search box             | The standard global search text box.                                                                                                                                                                         |
| 10. Results summary              | The list of search groups and tables with the number of search results per group and table. Click the table name to display the associated preview list results.                                      |

**Text search views format search results**

Configure how the system displays global text search results with a text search view.

Each search result listing consists of these elements.

---

Sample search result listing

1. **Update /etc/network/interfaces to include name servers 8.8.8.8 & 8.8.4.4**
2. **Number: CHG0000072 | Type: Normal | State: Authorize | Planned start date: 2017-06-19 19:30:00 | Planned end date: 2017-06-20 07:30:00**
   Requested by: System Administrator | Assigned to: Bow Ruggeri
3. **We need to add additional redundant name servers to Linux100, Linux101 and PS LinuxApp01**
### Search result elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Matching criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Title</td>
<td>The title is the first line of the search result block. The title links to the matching record of the search result.</td>
<td>Global search uses the first string field in the text search view that is not the number field. If there is no matching string field or the contents of the field is empty, the system displays the text ‘No title’ in the session language. For example, in the default incident table view the short description field meets the criteria to be the title.</td>
</tr>
<tr>
<td>2. Field list</td>
<td>The field list is the second line of the search results. The field lists contains a name-value pair for each field in the text search view separated by a pipe character. The system displays the field list in gray text.</td>
<td>All fields in the text search view that do not match the title or description criteria.</td>
</tr>
<tr>
<td>3. Description</td>
<td>The description is an optional third line of the search results. The system displays the description in black text.</td>
<td>Global search uses the first string field in the text search view that is not the title and is over 100 characters in length. If no field matches this criteria, the search results omit this line. For example, there is no matching description field in the text search view of the incident table.</td>
</tr>
</tbody>
</table>

By default, the system uses the text_search list view to format global text search results. If a text_search view doesn’t exist, the system instead formats search results using the default form view. Implementers can specify which view the system uses to format search results with the system property `glide.ui.text_search.view`.

### Search groups filter search results by table

The system displays search results by search group, which are collections of related tables that users can enable or disable to filter search results.

Within each search group, the system divides search results by table. A user must have read access to a table to see search results for it.

### Default search groups

<table>
<thead>
<tr>
<th>Search group</th>
<th>Example tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks</td>
<td>Incident, Change Request, Problem</td>
</tr>
<tr>
<td>Live Feed</td>
<td>Live Feed Message</td>
</tr>
<tr>
<td>Policy</td>
<td>Business Rule, UI Policy, Client Script</td>
</tr>
<tr>
<td>People &amp; Places</td>
<td>User, Group, Location, Company</td>
</tr>
<tr>
<td>Knowledge &amp; Catalog</td>
<td>Knowledge Base, Service Catalog</td>
</tr>
</tbody>
</table>
Displaying search results by group

The system displays knowledge and service catalog search results within their respective search results pages. The system displays other results in list format.

For exact match searches, the system only returns records from the Task (task) and Knowledge (kb_knowledge) tables.

**Note:** The system filters global search results to display only knowledge articles that are in the same language as the preferred language setting.

Example global search results

Options for administrators

Administrators can customize these search groups settings for all users:

- Specifying which tables are part of the group.
- Specifying whether the search group is available for use.
- Specifying whether searches include results from this search group by default.
- Creating new search groups.

Enabling a search groups allows users to see records from the search group’s tables. Disabling a search group hides records from the search group’s tables.

**Options for users**

Users can specify these individual search group preferences:

- Specify which group and table search results are collapsed and expanded by default.
- Specify which groups and tables the system includes in search results.

You can collapse or expand each search group and search table as you like, and those settings can be used for subsequent searches if you choose. For example, if you are rarely interested in Policy or Core Items search results, but still want to search them each time, you can collapse those groups.

If you do not want to search some groups or tables, you can deselect a search group or table on a per-user basis. Your preference is saved for subsequent searches. To deselect a search group, clear its check box on the search results page.

**Text Search Results**  
*No search groups selected - please check at least one*

Click a search group’s link, such as the blue **Tasks** link in the image above, to display a dialog box where you can deselect specific tables in each group.

**Add a search group**

You can add a search group to filter global search results.
Role required: text_search_admin

1. Navigate to **System Definition > Search Groups**.
2. Click **New**.
3. Complete the form.

**Text search groups**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name of the search group.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select one or more user roles if you want to restrict access to the search group to those roles.</td>
</tr>
<tr>
<td>User group</td>
<td>Select a user group if you want to restrict access to the search group to users in that user group.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter text to display as a tooltip for the search group.</td>
</tr>
<tr>
<td>Active</td>
<td>Ensure the check box is selected to make the search group available.</td>
</tr>
<tr>
<td>Searched</td>
<td>Clear the check box if you want to exclude results from this search group by default. A user can manually choose to show results from this search group on the search results page.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to determine the order in which this search group is listed relative to other search groups.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save**.
5. In the **Text Search Tables** related list, click **New**.
6. Complete the form.

**Text search table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the table to search.</td>
</tr>
<tr>
<td>Active</td>
<td>Ensure the check box is selected to search the table.</td>
</tr>
<tr>
<td>Searched</td>
<td>Clear the check box if you want to exclude results from this table by default. A user can manually choose to show results from this table on the search results page.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to determine the order in which this table is listed relative to other tables in the search group.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select one or more conditions to determine which records on the selected Table are searched.</td>
</tr>
</tbody>
</table>
Optional label

Enter the label to display for the table. For example, for a search group intended for your Sales team, display Contacts instead of Users for the User (sys_user) table.

7. Click Submit.
8. Add any other text search tables to include in the search group.

Set global text search properties
Administrators can control how global text search behaves with system properties.

Role required: admin
1. Navigate to System Properties > Global Text Search.
2. Set these properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional label</td>
<td>Enter the label to display for the table. For example, for a search group intended for your Sales team, display Contacts instead of Users for the User (sys_user) table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Global Text Search</td>
<td>glide.ui.text_search.enable</td>
</tr>
<tr>
<td>List of roles (comma-separated) that can use the Global Text Search capability.</td>
<td>glide.ui.can_search</td>
</tr>
<tr>
<td>List of tables (comma-separated) that will not appear as options when setting up Global Text Search tables.</td>
<td>glide.ui.no_text_search</td>
</tr>
<tr>
<td>Number of Global Text Search matches returned per table.</td>
<td>glide.ui.text_search.rowcount</td>
</tr>
<tr>
<td>Global Text Search background color for Knowledge Base results.</td>
<td>css.textsearch.kb.background.color</td>
</tr>
<tr>
<td>Global Text Search background color for Catalog results.</td>
<td>css.textsearch.catalog.background.color</td>
</tr>
<tr>
<td>Form view to use for Global Text Search exact match. Blank indicates the Default view.</td>
<td>glide.ui.text_search.match_view</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
List and form view to use for Global Text Search results. Blank means default view. **glide.ui.text_search.view** | Default value is the text_search view. If you do not have a text_search view, you can create it.

**Field** | **Description**
--- | ---
Query method for global text search. Run a query for each table, for each base class (parent table), against a single index regardless of table (requires text index regeneration), or let GlideRecord handle the query (simple). With the Zing text search engine, the preferred value is 'simple'. **glide.ir.query_method** | Default value is Simple query.

**Field** | **Description**
--- | ---
Maximum number of results that will be returned during a text index search. This limits the number of records that are extracted from the text index and appear. **glide.lucene.base_result_max** | Default value is 100. This property is not supported by the Simple query method and is ignored.

**Field** | **Description**
--- | ---
Maximum number of entries that will be retrieved from the text index. Only the table that is involved will be returned from the text index for all entries that are between the value specified for maximum results and this value. This is done so that you can indicate that more results exists for any given table that are going to appear. **glide.lucene.base_hits_max** | Default value is 500. This property is not supported by the Simple query method and is ignored.

**Field** | **Description**
--- | ---
Number of simultaneous processes (1 to 16) used when searching though multiple groups in a global search. **glide.ts.global_search.parallelism** | Default value is 4. Each search group uses one thread to render results. Set this value to yield optimal results for your search group configuration. For example, if you have five search groups and four threads, the first four groups run in parallel and the fifth group starts when one of the first four groups finishes. This setup may work well if one of the groups is much larger than another. Similarly, if you have five search groups, setting this value higher than five yields no benefits.

3. Click **Save**.

The business rule **Text Search Property Change Rationally** validates the new values and aborts the update if they are outside its acceptable ranges.

4. **Open the System Property table** and search for the property **glide.ts.max_wildcard_expansion**.

UI properties for global text search

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ts.max_wildcard_expansion</td>
</tr>
<tr>
<td>Description</td>
<td>Maximum number of matches for a wildcard term that are allowed as unambiguous.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
</tbody>
</table>
5. Edit the **Value**.
   If a wildcard search matches more words than this value, the system displays a message asking the user to refine the search.

6. Click **Update**.

7. To set the text search stemming language, install an internationalization (i18n) plugin.

8. Navigate to **System Properties > System Localization**.

9. Set this property.

### Text stemming property

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Search stemming language</td>
<td>Default value is <strong>English</strong>. The system supports stemming in English, German, and French.</td>
</tr>
<tr>
<td>glide.ts.stemming_language</td>
<td></td>
</tr>
</tbody>
</table>

#### Enable the simple query method

Configure the simple query method to allow GlideRecord to handle queries and is supported by Zing Text Search.

1. Navigate to **System Properties > Global Text Search**.
2. Locate **Query method for global text search** (the `glide.ir.query_method` property).
3. Select **Simple query**.
4. Click **Save**.

The following properties are not supported:
- Maximum number of results that are displayed per table (`glide.lucene.base_result_max`)
- Maximum number of results counted per base class (`glide.lucene.base_hits_max`)

#### Configure parallel processing of search groups

To improve performance, only activate search groups and tables that are necessary to meet business needs.

For example, if you do not need Change Task results, deactivate that table in the Tasks search group. If only one group of users needs Change Task results, set up a separate search group that includes Change Tasks. Other users search using a group that does not contain Change Tasks.

Global text search can render results in parallel to improve performance. To configure the number of parallel processes:

1. Navigate to **System Properties > Global Text Search**.
2. Locate the property called **Number of simultaneous processes (1 to 16) used when searching through multiple groups in a global search**.
3. Enter the number of processes to run in parallel.
   - Each search group uses one thread to render results. Set this value to yield optimal results for your search group configuration. For example, if you have five search groups and four threads, the first four groups run in parallel and the fifth group starts when one of the first four groups finishes. This setup may work well if one of the groups is much larger than another. Similarly, if you have five search groups, setting this value higher than five yields no benefits.
4. Click **Save**.
Disable the junk filter

By default, Zing does not index or search for 2-digit numbers and single character words (unless they are Chinese or Japanese characters). You can turn off this filter for a table.

For example, to have the ability to search for error 92 in the knowledge base, turn off junk filtering for kb_knowledge.

1. Navigate to System Definition > Dictionary.
2. Open the dictionary entry for the table.
3. In the Attributes field, enter text_index_filter_junk=false.
4. Right-click the header and select Save.
5. Click the Generate Text Index related link and click OK.

Note:
- To have the desired effect, you may also need to reconfigure the automatic stop words. For example, if a specific 2-digit number appears in all of your problem numbers (92-0001, 92-0002, and so on), the automatic stop word threshold is quickly exceeded and the word is no longer found in searches. To find that 2-digit number in the problem table, you must disable both junk filtering and automatic stop words.
- Disabling the junk filter results in a larger table index. For optimal performance, do not apply this attribute unless it is required.

Debug Zing

Debugging messages create a log of search processes as they occur. These messages may help administrators configure optimal performance settings.

- To view debugging messages, navigate to System Diagnostics > Session Debug > Debug Text Search. The search log messages appear at the bottom of the results page for the remainder of your session.

Debugging Messages

- To debug text indexing problems, you may want to view text_index events in the system log.
- In rare cases, you may need to reset the text search caches after regenerating a text index. If text search fails for known words, diagnose and fix this problem:

1. Enable text search debugging messages.
2. In any table with search problems, search for the problem text.
3. In the debug output, note the numbers used for the Stemmed terms.
4. Enter `ts_word.list` in the navigation filter.
5. Locate the stemmed terms and compare the numbers in the list to the debug output (Step 3). If the numbers are different, the UI node’s cache is stale.
7. Click the Reset Text Search Caches related link and click OK.

Revert to the legacy global search UI
Disable the dynamic global search UI to preserve customizations you made to the legacy global search UI.

Role required: admin
1. Enter `sys_properties.list` in the Navigation filter.
   The entire list of properties in the System Properties (sys_properties) table appears.
2. Click New.
3. Enter these field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.use_legacy_global_search</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click Submit.

The system displays the global search UI and uses the legacy display logic.

Legacy global search user preferences
The global text search results page allows users to set several user preferences for global text search.

The following search preferences are available from the Search tips and preferences link.

![Search tips and preferences](image)

Search preferences
## Search preferences

<table>
<thead>
<tr>
<th>User preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use remembered expand / collapse preferences</td>
<td>Specifies whether you want the collapse state of any search groups/tables remembered for your next search. If selected and you collapse the search results for the People &amp; Places search group for example, that group will be collapsed on your next search. If cleared, all groups and tables are expanded for every search.</td>
</tr>
<tr>
<td>ts.remember.expanded</td>
<td></td>
</tr>
<tr>
<td>Show list of tables with no search matches</td>
<td>Specifies whether or not you want to see a summary of tables that had no search matches. For example: No matches for Requests, Catalog Tasks, Tickets.</td>
</tr>
<tr>
<td>ts.show_negative_result_info</td>
<td></td>
</tr>
<tr>
<td>Show selectable search groups</td>
<td>Shows or hides the search group check box row.</td>
</tr>
<tr>
<td>ts.show_search_groups</td>
<td></td>
</tr>
<tr>
<td>Show groups with no search matches</td>
<td>Shows or hides a search group if it returns no matches. If selected, the search results display a placeholder row stating there were no matches for that group.</td>
</tr>
<tr>
<td>ts.show_empty_groups</td>
<td></td>
</tr>
<tr>
<td>Return task record if searching for exact number</td>
<td>Shows or hides the full search results page if the search term matches a task record number. When selected, an exact match to a record number causes the system to hide the full search results and instead display the record with an exact match message. Exact search matches ignore most additional search conditions normally applied to the record such as the currently selected search groups or the knowledge article published state. For example, an exact search match for a knowledge article returns the article in any state as long as the current user has read access to it.</td>
</tr>
<tr>
<td>ts.match</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The system filters exact search results to display only knowledge records that are in the same language as the preferred language setting.
Global text search suggestions

Global text search offers two types of search suggestions.

The knowledge base and global text searches provide suggestions as you type. Type-ahead suggestions appear under the search box. Suggestions are based on similar searches that begin with the same characters.

Type-ahead search suggestions

The knowledge base and global text searches also provide suggestions for alternate search terms. Suggestions appear if your original search does not return any results and an alternate spelling or similar recent search does. For example, if you misspell a search term (such as eail), the correct spelling (email) may appear as an alternate search suggestion. Suggestions appear beneath the search box on the results page.

Alternate search suggestions

Note: The type-ahead search suggestions feature is only available in the UI15 interface.

Update a type ahead suggestion

The knowledge base and global text searches provide suggestions as you type. These type-ahead suggestions are compiled on a nightly basis by a scheduled job.

Use the following procedure if you need to refresh this list sooner.

1. Navigate to System Scheduler > Scheduled Jobs.
2. Open TS Search Stats.
3. Run the scheduled job.

For more about how suggestions are generated and maintained, see the blog post Global Text Search Suggestions by a ServiceNow Technical Support Engineer in the Now Community.

Note: The type-ahead search suggestions feature is only available in the UI15 interface.

Configure a “Did You Mean?” suggestion

The Knowledge Base and global text searches can provide “Did you mean?” suggestions. Suggestions appear if a search does not return any results and an alternate spelling or similar recent search does. This feature is disabled by default.
1. Navigate to **System Properties > Text Search**.
2. Select any of the following check boxes:
   - **Suggest alternate search spellings for knowledge or global search** (the `glide.ts.dym.enable_spell_correct` property).
   - **Suggest related searches for knowledge or global search** (the `glide.ts.dym.enable_chain_suggest` property); uses search chains, which generate suggestions by tracking occurrences of similar searches, in order, over time.
3. Click **Save**.

**List search finds records from the current table**

Search records from a table list view.

Indexed tables display the for text option in the list title bar, which searches all records for matching field values.
### INCIDENT CONDITIONS

All of these conditions must be met

- **Keywords** are

  or

- New Criteria

### RELATED LIST CONDITIONS

<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>Caller</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0000051</td>
<td>2016-11-15 12:48:32</td>
<td>Manager can't access SAP Controlling application</td>
<td>Joe Emp</td>
</tr>
<tr>
<td>INC0000052</td>
<td>2016-11-15 12:48:40</td>
<td>SAP Financial Accounting application appears to be down</td>
<td>Bud Rich</td>
</tr>
<tr>
<td>INC0000055</td>
<td>2016-11-15 20:47:23</td>
<td>SAP Sales app is not accessible</td>
<td>Carol Con</td>
</tr>
<tr>
<td>INC0000053</td>
<td>2016-11-15 12:48:46</td>
<td>The SAP HR application is not accessible</td>
<td>Margaret</td>
</tr>
<tr>
<td></td>
<td>2015-11-02</td>
<td>SAP Materials</td>
<td></td>
</tr>
</tbody>
</table>
The list search field accepts *Boolean operators* (AND, OR, and NOT) in search queries. When a user adds a Boolean operator to a search query, the system only returns records that match all search conditions of the query.

The system also converts any search query into an equivalent keyword condition in the list breadcrumbs and filter. For example, searching for the text “Oracle OR SAP” produces the condition *(Keywords) (are) (Oracle OR SAP)*. The standard list controls can modify or remove these breadcrumbs and conditions.

**Boolean operators allow conditional search results**

Include or exclude search terms from global text searches.

All global text search interfaces support boolean operators.

- Global text search field
- Knowledge Base search
- List search for text

For Knowledge Base searches, if the AND search returns poor results, the search is automatically re-run with the OR operator. Administrators can configure the knowledge base search to always use OR by modifying the `glide.knowman.search.operator` property.

**Note:** Boolean operators are case-sensitive. For example, OR is an operator while or is a search term that may be a stop word.
### Boolean operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR or vertical bar symbol (</td>
<td>Finds a match if any of the terms exist in a document (a union using sets). For example, to find documents that contain either &quot;email password&quot; or just &quot;email&quot;, search for &quot;email password&quot; OR email OR &quot;email password&quot;</td>
</tr>
</tbody>
</table>
## Operator Description

### AND
Finds a match if all terms exist in a document (an intersection of sets). For example, to find documents that contain 'CPU load' and '10 minutes', search for "CPU load" AND "10 minutes"

By default, Zing applies an AND operator between all search terms regardless of whether the user entered them or not. For example, the system converts a search for the text 'email server down' to (Keywords (are) (email) AND (Keywords (are) (server) AND (Keywords (are) (down)).

### NOT, minus (-), or exclamation point (!)
Excludes documents that contain the term after the NOT operator (a difference of sets). For example, to find documents that contain 'CPU load' but not '10 minutes', search for "CPU load" NOT "10 minutes", "CPU load" -"10 minutes", or "CPU load" !"10 minutes"

The NOT operator cannot be used with just one term. For example, the following search returns no results: NOT "10 minutes"

NOT must be a stand-alone word. For example, atom NOT ion excludes the term ion. Whereas NOTION searches for the term notion.

Minus and exclamation point must immediately precede the excluded term. For example, email !Joe excludes the term Joe but email ! Joe includes the term Joe.

### Quotation marks allow exact phrase searches
Filter search results to only include matches to an exact phrase consisting of one or more words.

Zing only matches documents that contain the exact words in the exact order you specify. An exact phrase search ignores:

- stop words
- punctuation marks
- wildcard characters

**Note:** Wildcard characters are ignored as punctuation.

For example, searching for the phrase "email password" returns the same search results as these phrases:

- "email the password" because the stop word 'the' is ignored.
- "email password?" because the punctuation '?' is ignored.
- "email password*" because the wildcard '*' is ignored as punctuation.

### Wildcard characters allow searching for patterns and variations
Expand search results to match any non-space character. The system supports both single-character and multiple-character wildcards.

The following searches support wildcard characters.
Global text search

Knowledge Base

Note: To enable wildcard search in the Knowledge context, navigate to Contextual Search > Search Contexts > Knowledge Base Search and select the Enable wildcard searches check box.

Lists (text searches of all fields)
Reference fields

Note: Wildcard text searches are only effective with multiple character words. A wildcard within a sequence of pictogram characters returns too many options for an efficient search. Wildcards are best used with letter-based words.

To perform a single-character wildcard search, use the percent sign (%) character. This wildcard finds words that contain any one character in place of the percent-sign-character. For example, to find words such as text or test, search for: te%t

To perform a multiple-character wildcard search, use the asterisk (*) character. This wildcard finds words that contain zero or more characters in place of the asterisk-character. For example, to find words such as planned or placed, search for: pl*d

You can use wildcard characters anywhere in a search string. If a wildcard search returns too many hits, the system displays a message asking you to refine the search. Administrators can set a global text search property to change the limit for wildcard search results.

Zing generates search results in four phases

Generate search results by dividing documents among shards, searching shard documents, scoring shard documents, and merging scores into an index.

Zing generates search results in four phases:

1. Divide searchable documents among index shards.
2. Search and filter shard documents.
3. Score shard documents.
4. Merge shard document scores into an index.

Phase 1: Divide searchable documents among index shards

When a search is executed, the system equally divides all searchable documents among 10 index shards. Each shard has a unique list of documents.

To maximize search efficiency, the system creates 10 query threads to simultaneously search each index shard.
Divide documents among index shards

Phase 2: Search and filter shard documents

Each query thread searches through its list of shard documents to identify documents that match the search criteria. For example, if you search for "wifi network," the system returns all documents containing both "wifi" and "network" in no particular order.

**Note:** A multiple word search is equivalent to multiple single word searches connected by an AND operator. For example, \((\text{contains})(\text{wifi})(\text{AND})(\text{contains})(\text{network})\).

The query thread assigns each matching document a numeric value (a document ID) to uniquely identify it. All other documents are ignored.

Phase 3: Score shard documents

The query thread **scores** each matching shard document.
Query threads search, filter, and score shard documents
Phase 4: Merge and sort shard document scores

The system merges the document scores into a single index and sorts the documents from highest to lowest document score. The documents with the highest document score are most relevant to the search query.

<table>
<thead>
<tr>
<th>Doc</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>10</td>
</tr>
<tr>
<td>50</td>
<td>8</td>
</tr>
<tr>
<td>100</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Doc</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>81</td>
<td>11</td>
</tr>
<tr>
<td>91</td>
<td>6</td>
</tr>
<tr>
<td>101</td>
<td>5</td>
</tr>
<tr>
<td>11</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Doc</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>99</td>
<td>12</td>
</tr>
<tr>
<td>19</td>
<td>6</td>
</tr>
</tbody>
</table>

Merge and sort shard document scores
Zing filters search results with access controls

Filter search results to only display records the user can access.

For example, suppose you index the System Properties [sys_properties] table. When the ITIL User searches for a term in the system properties table, Zing returns no search results because the ITIL user does not meet the ACL rule requirements.

ITIL User Search

When a system administrator searches for the same property, Zing returns search results from the System Properties tables because the administrator meets the ACL rule requirements.
<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th><strong>Value</strong></th>
<th><strong>Type</strong></th>
<th><strong>Description</strong></th>
<th><strong>Updated</strong></th>
<th><strong>Updated by</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.smtp.default_retry</td>
<td>true</td>
<td>true/false</td>
<td>Resend email when unknown SMTP error code...</td>
<td>2012-12-27</td>
<td>admin</td>
</tr>
<tr>
<td>glide.email.user</td>
<td></td>
<td>string</td>
<td>User email (e.g., <a href="mailto:helpdesk@company.com">helpdesk@company.com</a>) to...</td>
<td>2013-01-04</td>
<td>guest</td>
</tr>
<tr>
<td>glide.smtp.auth</td>
<td>false</td>
<td>true/false</td>
<td>Authenticate with the SMTP server using...</td>
<td>2010-06-23</td>
<td>dJoe</td>
</tr>
<tr>
<td>glide.smtp.active</td>
<td>true</td>
<td>true/false</td>
<td>Enable email sending (SMTP)</td>
<td>2009-09-26</td>
<td>hello</td>
</tr>
<tr>
<td>glide.smtp.failure_message_ids</td>
<td>500,501,502,503,504,550,551,552,553,554</td>
<td>string</td>
<td>Do not resend email if these SMTP error codes...</td>
<td>2012-01-27</td>
<td>admin</td>
</tr>
<tr>
<td>glide.smtp.defروم retry</td>
<td>421,450,491,492</td>
<td>string</td>
<td>Resend email if these SMTP error codes...</td>
<td>2012-01-27</td>
<td>admin</td>
</tr>
<tr>
<td>glide.smtp.sender</td>
<td>relay</td>
<td></td>
<td>Outgoing (SMTP) mail server. Also used e...</td>
<td>2013-04-01</td>
<td>cory.sitting@enc</td>
</tr>
<tr>
<td>glide.smtp.default_suffix</td>
<td></td>
<td>string</td>
<td>Default gateway address for any outb...</td>
<td>2007-03-18</td>
<td>glide.maint</td>
</tr>
<tr>
<td>glide.pop3.user</td>
<td></td>
<td>string</td>
<td>Incoming (POP) mail account name, if different...</td>
<td>2013-01-04</td>
<td>guest</td>
</tr>
<tr>
<td>glide.pop3.server</td>
<td></td>
<td>string</td>
<td>Incoming (POP) mail server, if different...</td>
<td>2013-01-04</td>
<td>guest</td>
</tr>
</tbody>
</table>
Zing computes document scores using three components

The Zing search engine computes document scores based on the frequency, sequence, and weight of search terms in the document.

Document scores

The components of a document score are:

- **Frequency**: how often the search terms appear in the document.
- **Sequence**: how often the search terms appear in the same order as the search query.
- **Weight**: how heavily weighted the source field is in which the search terms appear.

Sample document score computation
Frequency points

Zing awards one point whenever a search term appears anywhere in the document. For example, when searching for "distributed database server", a document that contains "distributed" three times, "database" five times, and "server" 17 times would have 25 frequency points.

To increase search result scores of search terms that appear more frequently in a document, but less frequently in a document set, you can Score search terms by inverse document frequency (IDF). When TF-IDF is enabled, search term scores are calculated by multiplying the term frequency score by the inverse document frequency score. Because enabling TF-IDF increases the weight of less common search terms, search results for that table are more likely to be relevant. For example, when searching for "distributed database server", the term "distributed" might receive a higher score than "server" if it appears frequently in one document but less frequently in the document set as a whole.

Sequence points

Zing awards a document more points when it contains the search terms in the same order in which they were typed. The more search terms in sequence there are, the exponentially higher the score becomes.

Following the example above, each time the string "database server" appears in a document, it is awarded 100 (10^2) sequence points. Likewise, each time the string "distributed database server" appears in a document, it is awarded 1000 (10^3) sequence points.

Zing awards sequence points as 10^x, where x is the number of search terms that appear in sequence. If the sequence appears in a field that is weighted, Zing applies a multiplier to the sequence points based on the value of the ts_weight attribute for the field. The sequence points use the calculation (10^x * weight of the field).

Weight points

Zing awards a document more points if the field in which it appears is weighted. Zing applies a multiplier to frequency points based on the value of the ts_weight attribute for the field.

By default, each field has a weight of 1. A field with a weight of 50 (ts_weight=50) would add 50 points each time a search term appeared in the field. The maximum possible weight value is 255.

By default, the system elevates the scoring weight of knowledge record numbers, knowledge short descriptions, task record numbers, and task short descriptions.

- kb_knowledge.number = 50
- kb_knowledge.short_description = 10
- kb_knowledge.meta = 10
- task.number = 50
- task.short_description = 10

Score search terms by inverse document frequency (IDF)

Enable TF-IDF (term frequency–inverse document frequency) to increase the search result scores of search terms that appear more frequently in a document, but less frequently in the whole collection of searchable documents.

Role required: admin
To enable TF-IDF scoring, a text index must be present for the table. Make sure that text indexing is enabled for the table before changing the query mode. See [Enable text indexing for a table](#).

Administrators can enable TF-IDF scoring on a table to improve search results. In new and upgraded Jakarta instances, the Knowledge table (kb_knowledge) has TF-IDF scoring enabled by default.

**Note:** This task requires that you regenerate an index and therefore should be done with system performance in mind. Regenerating an index may take a while to complete depending on table size and other factors. You may notice performance degradation or incomplete search results while the system regenerates the index.

1. Navigate to the system dictionary and open the entry for the desired table.
2. In the Attributes related list, click New.
3. In the Attributes field, select Text search Enable IDF.
4. Click Submit.
   The Enable IDF Score check box in the table’s text index record can now be configured.
5. Navigate to System Definition > Text Indexes.
6. Open the text index created for the table.
7. Select Enable IDF Score.
   Regenerating document frequency is a one-time task. Regenerate document frequency when TF-IDF scoring is first enabled for a table.
9. Configure the desired notification and click OK.

**Set the relative weight of a field**

To improve search results, the search engine assigns to each potential match a numeric score that represents its relevancy to the query.

Role required: admin

Administrators can control the relative importance of a match for each field in a table with the ts_weight attribute. The default weight of a field is 1.

1. Open the system dictionary entry for the field.
2. In the Attributes field, enter ts_weight=<value>, where <value> is the relative weight of the field.

The following fields have elevated scoring weights by default:

- kb_knowledge.number = 50
- kb_knowledge.short_description = 10
- kb_knowledge.meta = 10
- task.number = 50
- task.short_description = 10

For example, if the Title field has a ts_weight=50 and the Description field has a ts_weight=10, then a match in the title is weighted 5 times more relevant than a match in the description and 50 times more relevant than a field without the ts_weight attribute.

3. Click Update.

**Note:** To view the complete scoring system, see [Document Scoring](#).
Zing indexes words

Index documents by dividing them into words. Depending on the languages your instance supports, a word may be a single character such as a Chinese or Japanese pictogram or a sequence of characters separated by spaces such as with Latin, Arabic, and Pinyin languages.

Zing uses spaces to define the basic unit of word separation. Zing uses the following rules to index words.

### Zing word indexing rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Punctuation</td>
<td>Zing indexes some punctuation marks as part of some words to improve search results for common search terms. Zing converts any non-indexed punctuation characters to spaces. See <a href="#">Zing indexes punctuation as part of some words</a>.</td>
</tr>
<tr>
<td>Pictograms</td>
<td>Zing supports the full range of Unicode pictogram characters. Each Chinese or Japanese pictogram is indexed as a separate word as if it were a single Latin-1 character surrounded by spaces.</td>
</tr>
<tr>
<td>Letter</td>
<td>Zing treats Latin-1, Arabic, and Pinyin characters as individual letters of space-separated-words. Sequences of letters define indexable words.</td>
</tr>
</tbody>
</table>

#### Zing indexes punctuation as part of some words

Zing indexes some punctuation marks as part of some words to improve search results for common search terms.

**Punctuation indexed as part of a word**

<table>
<thead>
<tr>
<th>Punctuation</th>
<th>Indexed to find</th>
<th>Search behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ampersands (&amp;)</td>
<td>Company names</td>
<td>Zing locates terms containing punctuation characters that are common in company names: ampersands (&amp;), plus signs (+), or hyphens (-). For example, a search for H&amp;R Block locates exact matches to the search term.</td>
</tr>
<tr>
<td>Apostrophes (')</td>
<td>Proper names</td>
<td>Zing ignores trailing possessives and retains most others to find company names. For example, a search for O'Reilly's locates matches to O'Reilly and O'Reilly's.</td>
</tr>
<tr>
<td>Hyphens (-)</td>
<td>Company names</td>
<td>Zing locates terms containing punctuation characters that are common in company names: ampersands (&amp;), plus signs (+), or hyphens (-). For example, a search for Coca-Cola locates exact matches to the search term.</td>
</tr>
<tr>
<td>Punctuation</td>
<td>Indexed to find</td>
<td>Search behavior</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Product numbers</td>
<td>Zing locates product numbers that follow a typical pattern. To meet this pattern, search terms must contain frequent numbers and only include underscores (_), hyphens (-), or periods for punctuation. For example, a search for PROD-10-987 locates exact matches to the search term.</td>
</tr>
<tr>
<td>Numbers (123)</td>
<td>Product numbers</td>
<td>Zing locates product numbers that follow a typical pattern. To meet this pattern, search terms must contain frequent numbers and only include underscores (_), hyphens (-), or periods for punctuation. For example, a search for PROD10987 locates exact matches to the search term.</td>
</tr>
<tr>
<td></td>
<td>Record numbers</td>
<td>Zing locates record numbers that follow a typical pattern. To meet this pattern, search terms must start with a recognized record number prefix. For example, a search for INT1234567 locates exact matches to the Incident record.</td>
</tr>
<tr>
<td>Periods (.)</td>
<td>Acronyms</td>
<td>Zing locates acronyms whether they are separated by periods or not. For example, a search for u.s.a. locates matches to usa or u.s.a. Note that wildcard searches may affect acronym handling. In another example, a search for u.s.* may yield better results than a search for u.s*.</td>
</tr>
<tr>
<td></td>
<td>Host names</td>
<td>Zing locates sequences of letters and numbers separated only by periods. For example, a search for en.myhost123.com locates exact matches to the search term.</td>
</tr>
<tr>
<td></td>
<td>IP addresses</td>
<td>Zing locates numbers that follow a typical IPv4 address pattern. For example, a search for 10.0.0.1 locates exact matches to the search term.</td>
</tr>
<tr>
<td></td>
<td>Product numbers</td>
<td>Zing locates product numbers that follow a typical pattern. To meet this pattern, search terms must contain frequent numbers and only include underscores (_), hyphens (-), or periods for punctuation. For example, a search for PROD.10.987 locates exact matches to the search term.</td>
</tr>
<tr>
<td>Plus signs (+)</td>
<td>Company names</td>
<td>Zing locates terms containing punctuation characters that are common in company names: ampersands (&amp;), plus signs (+), or hyphens (-). For example, a search for Google+ locates exact matches to the search term.</td>
</tr>
</tbody>
</table>
Punctuation | Indexed to find | Search behavior
---|---|---
Underscores (_ ) | Product numbers | Zing locates product numbers that follow a typical pattern. To meet this pattern, search terms must contain frequent numbers and only include underscores (_), hyphens (-), or periods for punctuation. For example, a search for \texttt{PROD\_10\_987} locates exact matches to the search term.

**Note:** The punctuation handling described here does not affect wildcard and boolean operators. These operators provide separate Zing functions.

Zing indexes some HTML elements

Zing indexes the contents of certain HTML elements to improve document search results. This indexing is addition to the normal indexing by word.

**Indexed HTML elements**

<table>
<thead>
<tr>
<th>HTML element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title attribute</td>
<td>Zing indexes the contents of the \texttt{title} attribute of any HTML element. This is separate from the \texttt{title} element, which Zing already indexes when identifying the words of the document.</td>
</tr>
<tr>
<td>Anchor link target</td>
<td>Zing indexes the target URL specified in the \texttt{href} attribute of any anchor element.</td>
</tr>
<tr>
<td>Alt text for an image</td>
<td>Zing indexes the alternative text of any image element.</td>
</tr>
</tbody>
</table>

Enable text indexing for a table

Administrators can enable text indexing on a table to allow users to search for string values from table records.

Role required: admin

By default, the system creates text indexes for the tables with a Text index record (\texttt{System Definition > Text Indexes}). For example:

- Knowledge-related tables
- Core-data-related tables
- Connect-related tables
- Task table
- User table

**Note:** Whenever you create an index table, the system also creates Access Control Roles (ACLs) for new tables.

Text indexing can be a resource-intensive task that may take a while to complete. You may notice performance degradation or incomplete search results during index generation. To estimate text indexing duration, you can view historical \texttt{statistics}.

1. Navigate to \texttt{System Definition > Dictionary}.
2. Click the table name to open the dictionary entry.
A table in the System Dictionary is a record that has a Table name but no Column name.

3. Select the **Text index** check box to enable text indexing for text fields on the table.

4. Click **Update**.
5. Click **Generate Text Index**.
   The system schedules the table for text indexing, typically within a minute.

The Search for text option appears on the list view for the table.

**Regenerate a text index for a table**

You can regenerate a table text index when you change table stop words or display values.

Role required: admin

By default, the system maintains text indexes on a daily schedule. Typically, you only need to manually regenerate a text index when you change these values.

- You change the list of table-specific stop words.
You change the display value of a record such as changing a user or group name.

Until you regenerate the index, text searches for old display values will still produce results and searches for the new display value will not show results.

Text indexing can be a resource-intensive task that may take a while to complete. You may notice performance degradation or incomplete search results during index generation. To estimate text indexing duration, you can view historical statistics.

1. Navigate to System Definition > Text Indexes.
2. Open the text index for the table.
   For example, select task.
   The system displays the Text Index record for the table.
3. Click the Regenerate Text Index related link and click OK.
<table>
<thead>
<tr>
<th>Table</th>
<th>Task [task]</th>
<th>Auto stop</th>
<th>Auto threshold</th>
<th>Queries last day</th>
<th>Queries last 7 days</th>
<th>Queries last 30 days</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Ready</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indexed rows</td>
<td>463</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unique terms</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total terms</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disable synonym</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partial Match Rule</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Generate Text Index**

The text index will be generated in the background so that you can continue other work while it is being created. If this table does not have a text index, one will be created after the dictionary text index flag is set to true. Upon completion, the system will send you a confirmation email unless you specify otherwise below.

**Upon completion**
- Email me: admin@example.com
- Do not notify me

**Text Index Specifics**

- Table name: task

**Related Links**

- Regenerate Text Index
- Index Stop Words
- Index Synonym Dictionaries

**Index Stop Words**

- Word
- Search

No words to display.
The system schedules the table for text indexing.

**Regenerate a corrupt index**

Typically, a corrupt index regenerates itself. If the system does not start the regeneration process, you must issue a script command to delete the existing index and regenerate it.

For example, to regenerate the task text index, the following script could be used as a background script:

```javascript
var indexer = new Packages.com.glide.lucene.TextIndexEvent();
indexer.createIndex("task", "my_email@service-now.com");
```

Change the email address to the address that receives the notification when the index is completed. The script creates an event that the index handler processes so the script completes almost instantly. When the scheduled job picks up the event, you can check the Component Status page and see that the index is being generated. An entry also appears in the log, as shown in the following example:

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>User</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/28/09 15:36:19</td>
<td>worker.1</td>
<td>TextIndexGenerator: Text index generation starting for: task</td>
</tr>
</tbody>
</table>

As each extended table completes, it is logged:

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>User</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/28/09 15:37:13</td>
<td>worker.1</td>
<td>TextIndex generation complete for: problem, rows indexed: 11</td>
</tr>
</tbody>
</table>

After all the extended tables are completed, the Component Status page entry is updated to "completed" and a final log entry is made. The log entry shows how long the process took.

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>User</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/28/09 15:37:20</td>
<td>worker.1</td>
<td>TextIndexGenerator: Text index generation complete for: task, in: 0:01:02.669</td>
</tr>
</tbody>
</table>

**Remove an index**

You can remove an index if you no longer want the search engine to return results for a table.

1. Navigate to **System Definition > Dictionary**.
2. Open the dictionary entry for the table.
3. Clear the **Text index** check box and click **Update**.
   The system no longer indexes or queries the table for text search results.

**Remove an index for a specific field**

You can remove an index if you no longer want the search engine to return results for a specific field.

1. Navigate to a form containing the field.
2. Right-click the field label and select **Configure Dictionary**.
3. Add `no_text_index=true` to the **Attributes** field. Separate multiple attributes with a comma (with no spaces).
4. Click **Update**.
   The system no longer indexes or queries the field for text search results.

**Change the query mode of an indexed table**

Set the query mode to specify whether searches on an indexed table must match all or only some of the search terms.
Role required: admin

To change the query mode of an indexed table, a text index must be present for the table. Make sure that text indexing is enabled for the table before changing the query mode. See Enable text indexing for a table.

Once a table is indexed, the data within the table can be searched through the global search bar. Change the query mode for the indexed table to allow global search to match all or only some of the searched terms. Enable a partial match rule to return results that partially match the searched terms.

1. Navigate to System Definition > Text Indexes.
2. Select the table you want to configure from the list of indexed tables.
3. Use the combo box to select a Default query mode.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The default query mode for a table is an AND query.</td>
</tr>
<tr>
<td>AND</td>
<td>Matches all search terms.</td>
</tr>
<tr>
<td>OR</td>
<td>Matches one or more search terms.</td>
</tr>
<tr>
<td>AND_OR</td>
<td>Matches all search terms. If no results are found, matches one or more search terms.</td>
</tr>
</tbody>
</table>

4. To enable partial matching of search terms, configure the partial match rule in the Partial Match Rule field.

Partial match rules return results that partially match the search terms. Use a partial match rule if queries often include many keywords (if, for example, users cut and paste phrases into the global search bar).

<table>
<thead>
<tr>
<th>Input type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>3</td>
<td>Indicates the minimum number of search terms to be matched.</td>
</tr>
<tr>
<td>Negative integer</td>
<td>-2</td>
<td>Indicates that the number of search terms, minus this number, should be matched.</td>
</tr>
<tr>
<td>Percentage</td>
<td>75%</td>
<td>Indicates the minimum percentage of search terms to be matched. The minimum number of search terms is the number computed from the percentage rounded down.</td>
</tr>
<tr>
<td>Negative percentage</td>
<td>-25%</td>
<td>Indicates that the number of search terms, minus this percentage, should be matched. The minimum number of search terms is the number computed from the percentage rounded down and subtracted from the total number of search terms.</td>
</tr>
<tr>
<td>Combination</td>
<td>3&lt;70%</td>
<td>A positive integer, followed by a less than symbol, followed by any of the previously mentioned input types. Indicates that if the number of search terms is equal to or less than the integer, all search terms are required. If the number of search terms is greater than the integer, the specification applies. In this example: if there are 1–3 search terms, all are required. If there are 4 or more search terms, only 70% are required.</td>
</tr>
</tbody>
</table>
### Input type, Example, Description

<table>
<thead>
<tr>
<th>Input type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple combinations</td>
<td>3&lt;25%, 9&lt;5</td>
<td>Multiple conditional specifications separated by commas.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In this example: if there are 1–3 search terms, all are required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If there are 4–9 search terms, all but 25% are required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If there are more than 9 search terms, all but 5 are required.</td>
</tr>
</tbody>
</table>

### Text indexing statistics and status

To view text indexing statistics and status, navigate to **System Definition > Text Indexes**.

- If text indexing is in progress, view the status of each index in the **State** field. Refresh the list to view updates. Tables are indexed one at a time.
- To see how long it takes to index a specific table, view the **Last indexing duration** field for the table entry. Although each process varies based on activity and data, historical data can provide a good estimate.
- View statistics (such as the number of indexed rows, terms, and queries in the past week) in the list or on the form for a specific table.

---

**Text Index Status**

---

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Text Index Statistics

Zing can include attachments in search results

Expand search results to include attachments from indexed tables.
Sample search including attachments

By default, only searches of Knowledge Base records include attachments.
Administrators can enable searching attachments for other tables, but doing so causes the platform to re-index the selected table, its parent table, and any children of the parent table.
Warning: For large tables, such as the Task table, re-indexing can take several hours and slows down the system until complete. Re-indexing is best performed during non-peak times.

Zing supports indexing and searching these attachment file types.

| .doc  | .reg   | .pptx |
| .htm  | .txt   | .potx |
| .html | .xls   | .pot  |
| .ini  | .docx  | .xlsx |
| .pdf  | .dotx  | .xltx |
| .ppt  | .dot   | .xlt  |
| .xls  | .xlsx  |       |
| .xlsx | .xltx  |       |
| .xltx | .xlt   |       |

Enable attachment indexing on a table

When you enable the attachment indexing for a table, text searches can return matches from the record and its file attachments.

Role required: admin

By default, attachment indexing is enabled for the Knowledge Base.

Enabling attachment indexing causes the platform to re-index the selected table, its parent table, and any children of the parent table.

Warning: For large tables, such as the Task table, re-indexing can take several hours and slows down the system until complete. Re-indexing is best performed during non-peak times.

1. Navigate to System Definition > Dictionary and select the record for the table.
2. Click the Attributes tab.
3. Click New and add the following values.

<table>
<thead>
<tr>
<th>Attribute values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Attribute</td>
</tr>
<tr>
<td>Value</td>
</tr>
</tbody>
</table>

Note: The attachment indexing attribute only applies to the tables on which you explicitly add it. It does not cascade to child tables. For example, indexing attachments on the Task table does not index attachments on the Incident table.

4. Click Submit.
5. Optional: To disable attachment indexing, remove the attribute.
6. Click Update.

   The indexing process begins. When it is complete, attachments can be searched on that table.

Zing removes stop words from queries

Remove common words from search queries that do not produce meaningful results.
Stop words are common words that are not indexed because they are not meaningful in search results. Articles, conjunctions, personal pronouns, and prepositions are examples of stop words that are not used in keyword searches. Administrators can configure stop words for all indexed tables and for specific tables.

By default, the system maintains two types of stop words.

**Types of stop words**

<table>
<thead>
<tr>
<th>Stop word type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System-wide text index stop words</td>
<td>The system always ignores system-wide text index stop words when generating text indexes. Any search for a system-wide stop word returns no search results.</td>
</tr>
<tr>
<td>Table-specific stop words</td>
<td>The system uses the table-specific Text Index record to determine whether to index the stop word or to just remove it from keyword search queries against the table.</td>
</tr>
</tbody>
</table>

By default, the system has stops words for common English words. Search administrators typically create stop words from search terms that produce too many search results such as articles, conjunctions, personal pronouns, and prepositions.

**Configure a global stop word**

Configure stop words that should not be indexed by the search.

1. Navigate to **System Definition > Text Index Stop Words**.
2. Add or remove stop words from the list.
3. If a message appears at the top of the list, contact Technical Support to regenerate all indexes.

You must regenerate indexes whenever words may be missing from an index. For example, if you delete, inactivate, or change an active global stop word, the word may be missing from the index. An after business rule checks these conditions and generates the notification message when index regeneration is necessary.

**Configure a table-specific stop word**

You can configure stop words for a specific table.

1. Navigate to **System Definition > Text Indexes**.
2. Open the text index entry for the table.
3. Add or remove stop words from the **Index Stop Words** related list.
For each word, select the desired **Stop mode** (Not a Stop Word (inactivates the stop word), Neither Index nor Query, or Index but do not Query).

4. If a message appears at the top of the form, click **Regenerate Text Index** and click **OK**. You must regenerate indexes whenever words may be missing from an index. For example, if you delete or change a stop word for which the mode was Neither Index nor Query, the word may be missing from the index. An after **business rule** checks these conditions and generates the notification message when index regeneration is necessary.

**Note:** Text search uses the global list plus the table-specific list of stop words when indexing the table.

---

Enable automatic stop words for a table

The system can identify and generate stop words when a search term exceeds an occurrence threshold.

- Role required: admin
- Enable text indexing for the table
By default, the TS Index Stats scheduled job identifies and creates stop words for tables with text indexes on a nightly basis. Automatically adding stop words improves your search results by removing search terms that return too many search results.

1. Navigate to **System Definition > Text Indexes**.
2. Open the text index entry for the table.
3. Select the **Auto stop** check box.
4. In **Auto threshold**, enter the maximum number of occurrences a search term can have in search results.
   - When a search term generates more search results than the threshold, the system automatically creates a stop word for the search term.
   - For example, to create stop words for the task table, see the blog post Configuring auto stop words and regenerating text indexes from a ServiceNow employee on the ServiceNow Community.
5. Click **Update**.

The job identifies and creates stop words for the table with a **Stop mode** value of **Index but do not Query** and inserts a **Comment** to indicate that the stop word was generated automatically.

**Zing matches derived words with stemming**

Convert any multiple-character search keyword to its stem form to find derived versions of the word.

Stemming removes a variety of common word inflections, such as plurals and past tense forms. Zing treats all words with a common stem as synonyms of the original search term. Stemming does not apply to searches involving single-character words such as Chinese and Japanese pictograms.

Zing uses the **Porter Stemming Algorithm**, which is most effective for English text, but supports stemming in these languages.

- English
- French
- German

The stemming language determines how the system generates indexes of record data. The system only supports one stemming language at a time regardless of how many languages the instance supports. When you change the stemming language, the system creates any new index entries based on the new language stemming rules, but does not regenerate any existing index records. You must manually regenerate indexes for tables you want to use the new stemming language.

**Zing can expand search results with synonyms**

Expand search results to include additional search terms.

By default, Zing includes a sample synonym dictionary consisting of a list of synonym sets (synsets). Zing supports two types of synonym sets.
## Synonym set types

<table>
<thead>
<tr>
<th>Synonym set type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synonym list</td>
<td>A synonym list is a list of words separated by commas. When a search uses any word from the list, Zing expands the search to include all words in the list.</td>
<td>Cyber, Internet, Cybercafe</td>
</tr>
<tr>
<td>Synonym map</td>
<td>A synonym map is two word lists separated by the equal and greater than characters =&gt;. When a search uses any word from the list on the left, Zing expands the search to include all words from the list on the right. When a search uses a word from the list on the right, Zing does not expand the search to include terms from the list on the left.</td>
<td>IOT, Internet of Things =&gt; Chip, Nest thermostat, RFID, IOT</td>
</tr>
</tbody>
</table>

Search administrators can create synonym sets for search terms that produce no or low-scoring search results. See the [Top Searches homepage](TopSearchesHomepage) for information about your user's search behavior.

### Search results, synonym expansion and weighting

In search results, documents containing the original search keywords having a higher score than documents containing the search synonyms. For example, documents with the keyword IOT have a higher score than documents with the synonym Internet of Things.

- One-way synonym expansion to/from multiple terms (blork, cork => malork, elastic) works as expected. Blork and cork both expand to malork and elastic.
- Multi-level one-way expansion (blork => cork => malork) does not work transitively. Neither blork nor cork expands to malork.
- Multi-level one-way expansion split between multiple synonym set records (blork => cork) (cork => malork) does not work transitively. Only cork expands to malork, blork only expands to cork but not malork.

By default, synonyms do not use the same weight as regular search terms. Synonyms are only weighted at 10% of the default search weight. Additionally, multiple instances of a synonym in a single doc/field do not increase the search weight. The weight of synonyms is controlled by the property `glide.ts.synonym.expanded.boost`. When this property value = 1, synonyms are weighted equally to normal search terms. 0.5 = 50% weight etc.

### Enable search synonyms

Enabling text index synonyms allows Zing to expand text searches with additional search keywords.

Role required: admin or ts_admin

By default, text searches do not use text index synonyms.

1. Navigate to System Properties > Text Search.
2. Scroll down to Enable Synonym, and click Yes.

Text searches use active synonym dictionaries to expand keyword searches.
Create synonym dictionaries

You can create synonym dictionaries to expand text searches with additional search keywords.

Role required: admin or ts_admin

By default, the system provides a sample synonym search dictionary called Example synonym dictionary.

1. Navigate to System Definition > Text Index Synonym Dictionaries.
2. Click New, and create a new record. See the table for field descriptions.

<table>
<thead>
<tr>
<th>Synonym dictionary form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>A name for the dictionary.</td>
</tr>
<tr>
<td>Active</td>
<td>When checked the dictionary is active. The default is checked.</td>
</tr>
<tr>
<td>Global</td>
<td>When checked the dictionary is to be used on all tables that have not been individually configured. The default is checked.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the dictionary.</td>
</tr>
</tbody>
</table>

3. Add a Synonym set.

<table>
<thead>
<tr>
<th>Synonym set form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Synset</td>
<td>A synonym definition, either a list or a map. Separate multiple synset words with commas. For example: medicalise, médicalisé</td>
</tr>
<tr>
<td>Active</td>
<td>When true the synonym set is used. Default is true.</td>
</tr>
<tr>
<td>Description</td>
<td>A description or notes about the synonym.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.
5. Click Publish Dictionary, under Related Links. The State changes from draft to Published.

Select synonym dictionaries for a table

Search administrators can specify one or more synonym dictionaries available to a particular table.

Role required: admin or ts_admin

1. Navigate to System Definition > Text Indexes.
2. Click the table for which you want to change search behavior. The system displays the Text index record for the table.
3. Click the Index Synonym Dictionaries tab.
4. Click New.
6. Click Submit.

Text searches on this table use the selected synonym dictionaries.

**Disable synonyms for a table**

By default, Zing uses all active synonym dictionaries when a user performs a text search. Search administrators can disable synonym dictionary usage on a per-table basis.

Role required: admin or ts_admin

1. Navigate to **System Definition > Text Indexes**.
2. Click the table for which you want to change search behavior. The system displays the Text index record for the table.
3. Click **Disable synonym**, so the check appears.
4. Click **Update**.

**Debug synonym searches**

You can view debug messages to determine if synonym searches are working as expected.

Role required: admin

1. Navigate to **System Diagnostics > Session Debug > Debug Text Search**.
2. Perform a search using a term in a synonym dictionary.
3. View the session debug output.

**Note:** You can only view the debug output on a table view (_list.do). You cannot view it on a UI page itself.

**Installed with Zing**

Several types of components are installed with Zing.

**Tables installed with Zing**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Index (ts_index_name)</td>
<td>Stores the tables the system indexes.</td>
</tr>
<tr>
<td>Index Stop Word (ts_index_stop)</td>
<td>Stores the stop words for a specific table.</td>
</tr>
<tr>
<td>Stop Word (ts_stop)</td>
<td>Stores the global stop words.</td>
</tr>
<tr>
<td>Text Search Groups (ts_group)</td>
<td>Stores search groups for global text search.</td>
</tr>
<tr>
<td>· ts_attachment</td>
<td>System tables that support Zing.</td>
</tr>
<tr>
<td>· ts_chain_summary</td>
<td>Extending or modifying these tables is not recommended.</td>
</tr>
<tr>
<td>· ts_chain</td>
<td></td>
</tr>
<tr>
<td>· ts_deleted_doc</td>
<td></td>
</tr>
<tr>
<td>· ts_document</td>
<td></td>
</tr>
<tr>
<td>· ts_index_stats</td>
<td></td>
</tr>
<tr>
<td>· ts_phrase</td>
<td></td>
</tr>
<tr>
<td>· ts_search_stats</td>
<td></td>
</tr>
<tr>
<td>· ts_search_summary</td>
<td></td>
</tr>
<tr>
<td>· ts_word_roots</td>
<td></td>
</tr>
<tr>
<td>· ts_word</td>
<td></td>
</tr>
</tbody>
</table>
### Business rules installed with Zing

<table>
<thead>
<tr>
<th>Business Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Search Property Change Rationally</td>
<td>Ensures that valid values are entered for Zing text search properties.</td>
</tr>
<tr>
<td>Text Index Stop Reminder</td>
<td>Warns the user of stop word changes that require the index to be rebuilt (table-specific). The warning is issued if record is deleted that had a stop mode “neither index nor query”, if record’s stop mode is updated to something else and was “neither index nor query”, and if record’s word is updated to something else and stop mode is “neither index nor query”.</td>
</tr>
<tr>
<td>Stop Word Reminder</td>
<td>Warns the user of stop word changes that require the index to be rebuilt (global). The warning is issued if record is deleted and it was active, if record is inactivated, and if record’s word is changed and was active.</td>
</tr>
</tbody>
</table>

### Scheduled jobs installed with Zing

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TS Search Stats</td>
<td>Compiles type-ahead suggestions each night. See <a href="#">Update A Type-Ahead Suggestion</a>.</td>
</tr>
<tr>
<td>TS Index Stats</td>
<td>Collects statistics and performs maintenance for text search and indexing. Runs nightly.</td>
</tr>
<tr>
<td>text index events process</td>
<td>Collects statistics and performs maintenance for text search and indexing. Runs every 30 seconds.</td>
</tr>
<tr>
<td>TS Search Summary</td>
<td>Compiles top search statistics each hour. See <a href="#">Update a top search statistic</a>.</td>
</tr>
<tr>
<td>TS Chain Summary</td>
<td>Compiles search chain statistics each hour.</td>
</tr>
</tbody>
</table>

### UI action installed with Zing

<table>
<thead>
<tr>
<th>UI action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regenerate Text Index</td>
<td>Displays the <a href="#">Regenerate Text Index</a> link on Text Index forms.</td>
</tr>
</tbody>
</table>

### Homepage installed with Zing

<table>
<thead>
<tr>
<th>Homepage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Searches homepage</td>
<td>Displays the most popular searches over the past hour, day, week, or month.</td>
</tr>
</tbody>
</table>

### Contextual search displays matching knowledge results

Display knowledge search results on forms and record producers when users enter text in a field.
Contextual search helps users deflect or quickly resolve their issues without involving the service desk operators. Contextual search can also include results from other sources such as a service catalog, allowing a user to directly order a catalog item from a search.

Contextual searches are enabled for incidents by default, providing incident deflection using knowledge and social Q&A questions. This default implementation includes contextual search results for forms, record producers, email notifications, and wizards.

To define a contextual search, first define a search context to set parameters, then define where the contextual search results are to appear: in forms, record producers, and wizards.

You must have the admin role to define contextual searches and to administer contextual search functions and properties.

Define contextual search

You can add and configure contextual search functions for fields in forms, record producers, and wizards.

For example, you can add a new contextual search capability to the Service Desk Call form, linking search to the short description in that form. This automatically provides relevant knowledge to service desk staff when they respond to calls, helping to resolve these calls more quickly.

By default, the system provides contextual search for incident record producers and the Incident form to help with incident deflection and resolution.

Contextual search process flow

Understand the steps you follow to define the contextual search process.

1. Define a search context to be available in multiple locations, setting overall values and conditions for the search results displayed.
   For example, define a search context for service desk calls that only displays search results from the Technical Solutions knowledge base.

2. Define where the contextual search results are to appear.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms</td>
<td>You can define knowledge to be associated whenever a problem record is created. For forms, you can also provide search results with email notifications sent when a record is created. For example, automatic notifications sent when an incident is created can include knowledge search results which may help the user who raised the incident resolve the issue independently.</td>
</tr>
<tr>
<td>Record producers</td>
<td>Define a Create New Incident record producer to trigger a search based on text entered in the Comments field. Display the search results at the bottom of the record producer.</td>
</tr>
<tr>
<td>Wizards</td>
<td>For example, if you have defined a wizard for creating incidents, you can add contextual search results to it.</td>
</tr>
</tbody>
</table>

- Forms:
- Record producers:
- Wizards:
**Define search context**

Create a search context to define a contextual search, with links to define which forms and record producers use that search.

For example, define a search context for service desk calls that only displays search results from your organization's Technical Solutions knowledge base.

1. Navigate to **Contextual Search > Search Contexts**.
2. Click **New**.
3. Fill in the fields, as appropriate.
Name of form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the context.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary of the context.</td>
</tr>
<tr>
<td>Searcher</td>
<td>The searcher for this context, which determines the information source to search.</td>
</tr>
<tr>
<td></td>
<td>- Catalog only: Provides search results from service catalog items.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge and catalog: Provides search results from knowledge articles and service catalog items.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge only: Provides search results from knowledge articles.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge, Discussions and pinned: Provides search results from knowledge articles, pinned knowledge articles and SocialQA/Community.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge, pinned knowledge and catalog: Provides search results from knowledge articles, pinned knowledge articles and service catalog items.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge and pinned knowledge: Searches knowledge articles and pinned knowledge articles.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge, Pinned, Catalog, SocialQA: Provides search results from Knowledge, Pinned Knowledge, Catalog items and Social Q&amp;A.</td>
</tr>
<tr>
<td></td>
<td>- Knowledge, Social Q&amp;A and pinned: Provides search results from knowledge articles, pinned knowledge articles and Social Q&amp;A.</td>
</tr>
<tr>
<td></td>
<td>- Pinned Knowledge only: Provides search results from pinned knowledge articles.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the search context.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.
5. Optional: Click **Set As Default** to make this the default context, used if a search query does not specify a context. For example, if a search query is invoked from a script without providing a context.
6. Use the related lists to further define the search context.
   - Record Producer Configurations: define which record producers use this context.
   - Table Configurations: define which forms use this context.
   - Wizard Configurations: define which wizards use this context.
   - Resource Configuration: define configurations to apply to the search context, such as restrictions on the results displayed.

**Define contextual search for a table**

Define contextual search to display search results in a table, such as the form for the Incident table.
Role required: admin

In Contextual Search > Table Configuration, you can configure the form that is associated with a table to display contextual search results. You specify where the search results appear, the information the results contain, and what the user can do with the results.

When knowledge articles are associated with a record, those search results can be included in email notifications. For example, email notifications sent when an incident is created can include knowledge search results. An article in the search results may help the user who raised the incident resolve the issue independently.

In the table configuration record, specify which fields on the form trigger a search. For example, contextual search in the Incident form can display search results based on text entered in the Short description field.

1. In the Search Context form, open the Table Configurations related list and click New. Alternatively, navigate to Contextual Search > Table Configuration and click New.

2. Complete the form.
### Table Configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table name associated with the form, for example, Incident (incident).</td>
</tr>
<tr>
<td>Search context</td>
<td>Name of the search context this table configuration applies to.</td>
</tr>
<tr>
<td>Results header text</td>
<td>Label for the search results area that appears in the form.</td>
</tr>
<tr>
<td>KB attachment</td>
<td>How a KB article in search results is embedded in the Comments field on the form.</td>
</tr>
<tr>
<td></td>
<td>- Embed article: The article text is copied into the Comments field in HTML format.</td>
</tr>
<tr>
<td></td>
<td>- Embed link to article: A link to the article is posted in the Comments field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this configuration.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum number of search results returned.</td>
</tr>
<tr>
<td>Results per page</td>
<td>Number of results to display per page.</td>
</tr>
<tr>
<td>Allow expand/collapse</td>
<td>Check box to allow the user to collapse the search results in the form.</td>
</tr>
<tr>
<td>Result action label</td>
<td>Label of the action button that appears when the user opens a search result record. By default, this label is set to This Helped.</td>
</tr>
<tr>
<td>Result action value</td>
<td>Internal value of the action button that appears when the user opens a search result record. By default, this value is set to This helped. This value is stored in the Relevant Document (cxs_relevant_doc) table.</td>
</tr>
<tr>
<td>Match condition</td>
<td>Conditions under which this search is enabled. For example, set (Active) (is) (true) to only enable the search on active knowledge articles.</td>
</tr>
<tr>
<td>Enable search as</td>
<td>Defines results to show for a different user. For more information, see Search as different users.</td>
</tr>
</tbody>
</table>

3. Open the form context menu and select Save. The Search Fields, Filter Configurations, and Email Configurations related lists appear. By default, a search field record is added to search on the Short description field.

4. Optional: To use a different search field, open the Short description record, select the field, and click Update.

5. Optional: Complete the following steps to add a filter configuration.
   Filter configurations are defined to map fields from two different tables to provide a more targeted search result set.
a) Click New in the Filter Configuration related list.
b) Select the Search resource: pinned, knowledge, or social.
c) Open the form context menu and select Save.
d) In the Filter Conditions related list that appears, click New.
   Based on the selected Search resource, the filter condition provides a query table to
   compare with the current form, for example, the Incident form. You select a field from
   each table, and the search results only include items where the values in the compared
   fields match.
e) Select the Field to compare and the Compare to fields for the Query table and Current
   form tables.
f) Select what value is compared, the value or the display value.
g) Select the Include if blank check box to include results if the Compare to field has no
   value.
h) Click Submit.
i) Click Update in the Filter Configuration form.

You can also select Scripted filter in the Filter Configuration form and add a script instead of
using a filter condition record.

6. Optional: Complete the following steps to define email configurations to include knowledge
   search results.
   a) Click New in the Email Configurations related list.
   b) Select the email notification to attach search results.
      You can select only from the notifications that are on the same table as the table
      configuration record.
   c) Select the field used to restrict the search results.
      For example, if you select Opened by, the search results include only the articles that the
      opened-by user can access based on user criteria.
   d) Update the Limit field as desired.
   e) Click Submit.

7. Click Update to save and close the Table Configuration record.

8. Add the search results area to the form for the associated table.
   a) Navigate to the relevant form for that table. For example, navigate to Incident > Open
      and open an Incident form.
   b) Configure the form and add Contextual Search Results in the location where you want to
      display the results. For example, you can display the search results immediately after the
      text field the search is based on or at the bottom of the form.

Define search fields on a form

Contextual searches are based on the content entered in selected search fields on forms. You
 can define multiple search fields for a form, with one field selected as the default.

Search results for the default field appear automatically in the Related Search Results section
when you open a record. Search results in other associated fields only appear when you type
content in those fields.
For example, in the base system the **Short description** is the default search field for the Incident form, so search results based on that field are displayed automatically.
**Incident - INC000005S**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INC000005S</td>
</tr>
<tr>
<td>Title</td>
<td>SAP Sales and Distribution</td>
</tr>
<tr>
<td>Category</td>
<td>ServiceNow</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Now Platform Administration</td>
</tr>
<tr>
<td>Configuration</td>
<td>SAP Sales and Distribution</td>
</tr>
<tr>
<td>Impact</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Urgency</td>
<td>1 - High</td>
</tr>
<tr>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Short description</td>
<td>SAP Sales app is not accessible</td>
</tr>
</tbody>
</table>

**Notes**

**Watch list**

**Work notes list**

**Activity**


Assigned to: Both Anglin

Configuration Item: SAP Sales and Distribution

SAP Sales app is not accessible
If the **Description** field is also defined as a search field on this form, search results only appear when you type content in that field.

1. Navigate to **Contextual Search > Table Configuration** and open the record.
2. Click **New** in the **Search Fields** related list.
3. Select the field to use and the order for that field.

**Note:** Only text fields can be selected.

4. Right-click the header and select **Save** to save the search field record.
5. Optional: If you have multiple search fields defined for that form, you can click **Set as Default** to select the new field as the default search field.

### Create an email notification for search results

Edit the email notification that is sent when the relevant record is created to include search results.

1. Navigate to **Open the Table Configuration form for the table.**
2. In the **Email Configurations** related list, click **New**.

#### Configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email notification</td>
<td>Email notification to use. For example, the default incident email notification provided is <strong>Incident opened for me</strong>.</td>
</tr>
<tr>
<td>User</td>
<td>Field identifying the user to receive the email. For example, <strong>Opened by</strong> if the email notification is sent to the user who created the record. This information is used to filter the search results included based on that user's access permissions, ensuring that the recipient can always access the information in the links provided.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum number of results the email notification includes.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
4. Configure the email notification to use the contextual search.
   a) Navigate to System Notification > Email > Notifications.
   b) Open the email notification which will include the contextual search results.
   c) Add the following script to the notification Message:
      ```
      ${mail_script:cxs_EmailSearchResults}
      ```

**Search as different user**

When you define contextual search for tables, you can choose to display search results as they would appear to a different user who performs the search.

For example, an HR administrator may want to display contextual search results, for a user who made an HR request, to find out why these results did not answer the user’s query.

---

**Note:** The results for the user performing the search are based on that specific user’s security access. Hence, the search result view for that user may have fewer entries than what that user can actually view.

---

1. Navigate to Contextual Search > Table Configuration.
2. Open a table configuration record.
3. In the Search as section of the form, fill in the fields as appropriate.
| Enable search as | | |
| Search as field | Assigned to | $ |
| Results message | Some results may not be displayed due to security constraints |
| Condition | Add Filter Condition | Add "OR" Clause |
| | -- choose field -- | -- oper -- | -- value -- |
| Script | | |
Search as configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable search as</td>
<td>Check box use search as functionality.</td>
</tr>
<tr>
<td>Search as field</td>
<td>The field on the table to identify the user to search as. You can only select User Reference fields. For example, select <strong>Opened by</strong> to search as the user who opened the relevant record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Specify the conditions based on which the search as results are displayed.</td>
</tr>
<tr>
<td>Script</td>
<td>A condition script, enabling administrators to implement more powerful conditions. For example, to restrict access to users that are members of a group, use <code>gs.getUser().isMemberOf(&quot;&lt;group name&quot;)</code>.</td>
</tr>
</tbody>
</table>

**Note:** Both **Condition** and **Script** must evaluate to true for the results to be displayed.

**Note:** An empty script evaluates to true.

When an eligible user opens the form for this table and enters search terms, two tabs are displayed: one with the search results the user sees (**My results**), and one with the search results the other defined user sees (**<User name>`s results**).

**Define contextual search for record producer**

You can define a record producer to trigger a search based on text entered in a variable field. Search results appear at the bottom of the record producer form.

For example, add contextual search to the **Description** variable in the Report an Issue record producer to provide potential answers to users who submit the form.

The base system **Create New Incident** record producer is configured to use contextual search. If you have customized this record producer, you can configure contextual search to link to a specific field on your record producer.

**Note:** Only one variable within a record producer can use contextual search.

1. Navigate to **Contextual Search > Record Producer Configuration**.
   You can also open a search context and click **New** in the **Record Producer Configurations** related list.
2. Complete the form.

**Configuration fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record producer</td>
<td>Name of the record producer to add the search to.</td>
</tr>
<tr>
<td>Search context</td>
<td>Name of the search context to use.</td>
</tr>
<tr>
<td>Search variable</td>
<td>Variable within the selected record producer which uses the contextual search.</td>
</tr>
<tr>
<td>Results header text</td>
<td>Label for the search results area that appears on the record producer.</td>
</tr>
<tr>
<td>Result action label</td>
<td>Label of the action button that appears when the user opens a search result record. By default this label is set to <strong>This Helped</strong>.</td>
</tr>
<tr>
<td>Result action value</td>
<td>Internal value of the action button that appears when the user opens a search result record. By default this value is set to helped. This value is stored within the Relevant Document [<em>cxs_relevant_doc</em>] table.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating this record producer configuration.</td>
</tr>
</tbody>
</table>
### Field and Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Maximum number of items to display in the results area. By default, this limit is set to 10. To return an unrestricted number, leave this field blank.</td>
</tr>
<tr>
<td>Results per page</td>
<td>Number of results that are shown per page in the results area.</td>
</tr>
<tr>
<td>Allow expand/collapse</td>
<td>Check box to allow the user to collapse the search results in the form.</td>
</tr>
</tbody>
</table>

3. Open the form context menu and click **Save**.

4. Optional: Complete the following steps to add a filter configuration.
   Filter configurations are defined to map record producer variables to the resource table to provide a more targeted search result set.
   a) Click **New** in the **Filter Configuration** related list.
   b) Select the **Resource configuration**: pinned, knowledge, or social.
   c) Open the form context menu and select **Save**.
   d) In the **Filter Conditions** related list that appears, click **New**.
      Based on the selected **Search resource**, the filter condition provides a query table to compare with the record producer, for example, **Report an Issue**. You select a field from the **Query table** and a variable from the **Record Producer**. The search results only include items where the values in the compared fields match.
   e) Select the **Field to compare** and the **Compare to** fields for the **Query table** and the **Record producer**.
   f) Select what value is compared, the value or the display value.
   g) Select the **Include if blank** check box to include results if the **Compare to** field has no value.
   h) Click **Submit**.
   i) Click **Update** in the Filter Configuration form.

You can also select **Scripted filter** in the Filter Configuration form and add a script instead of using a filter condition record.

5. Click **Update** to save and close the Record Producer Configuration record.

#### Define contextual search for wizard

You can define contextual search for a wizard.

For example, if you have defined a wizard for creating incidents, you can add contextual search results to it.

**Associate contextual search to a wizard**

You can associate contextual search to a text variable in a wizard to create a new wizard configuration record.

1. In the Search Context form, open the Wizard Configurations related list and click **New**. Alternatively, navigate to **Contextual Search > Wizard Configuration** and click **New**.
2. Fill in the fields, selecting an existing text variable to associate with contextual search.
3. Right-click the form header and select **Save**.
4. Click the **Add to Wizard** related link to associate the contextual search to the wizard.
**Add contextual search to wizard**

Update the wizard record to add the contextual search variable and implement contextual search.

1. Navigate to **System Wizards > Wizards**.
2. Open the wizard to be updated.
3. Define a new variable with **Type** set to **Macro** and **Macro** set to **cxs_wizard_search**.

4. Click **Submit**.
5. In the **Wizard Panels** related list, open the panel where you will add the macro variable.

   **Note:** Some types of panel may not allow variables.

6. On the **Variables** related list in the selected panel, click **Edit**.
7. Move the newly created macro from the **Collection** list to the **Variables List**.
8. Click Save.

By default, the Create Incident wizard includes contextual search linked to the **Please describe your symptoms** text variable.

**Apply configuration to search**

You can apply configurations to define conditions for each search context. For example, you can configure the **catalog** search resource to only display search results from a specific service catalog.

1. In the **Search Context** form, open the **Resource Configuration** related list to show the resource configurations available for that context. The resource configurations available are based on the searcher selected for this search context.

2. Click the arrow icon beside the searcher name to expand the entry, showing which configuration properties are available.
3. Click a property name to view the property details.

### Search Properties

<table>
<thead>
<tr>
<th>Catalog Search Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog name</td>
<td>Restrict the search results displayed to those within the named catalog.</td>
</tr>
<tr>
<td>Search operator</td>
<td>After how to combine AND and OR conditions when parsing the search string, to score the results displayed. Set this to:</td>
</tr>
<tr>
<td></td>
<td>- IR_AND_OR_QUERY (the default): Display results with exact matches of all terms if the number of results is greater than the value of the glide.ts.query.and_or_limit property (default 0) or the (overriding) value of the table custom attribute text_search_and_or_limit (when added). Otherwise display results with any matches of any terms.</td>
</tr>
<tr>
<td></td>
<td>- IR_AND_QUERY: Display results with exact matches of all terms only.</td>
</tr>
<tr>
<td></td>
<td>- IR_OR_QUERY: Display results with any matches of any terms.</td>
</tr>
</tbody>
</table>
4. Click **Update**.

**Contextual search roles**

Contextual search involves the following roles.

<table>
<thead>
<tr>
<th>Role title (Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator (admin)</td>
<td>Access and use contextual search functions.</td>
</tr>
</tbody>
</table>

**Deflect and resolve incidents with knowledge**

Incident deflection and resolution with knowledge provides contextual search results.

Contextual search is provided for the following areas:

- Incident record producers: deflecting incidents by helping end users resolve issues before they raise an incident.
- Incident forms: helping service desk staff resolve incidents quickly by providing relevant knowledge.
- Incident email notifications: helping end users resolve their incidents themselves without requiring manual intervention from service desk staff.

You can run feedback reports to track where these search results are marked as helpful.

You must have the admin role to configure contextual search.

**Provide knowledge in an incident form**

The Incident form displays contextual search results based on text entered in the **Short Description** field. These search results provide targeted knowledge to the incident analyst.

If the user who raised the incident has indicated that a returned result was useful, the incident analyst can review this information in more detail to help resolve the incident more quickly.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INC0000055</td>
</tr>
<tr>
<td>Caller</td>
<td>Carol Coughlin</td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>None</td>
</tr>
<tr>
<td>Subcategory</td>
<td>None</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>SAP Sales and Distribution</td>
</tr>
<tr>
<td>Impact</td>
<td>1 - High</td>
</tr>
<tr>
<td>Urgency</td>
<td>1 - High</td>
</tr>
<tr>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Opened</td>
<td>2014-10-16 21:47:23</td>
</tr>
<tr>
<td>Opened by</td>
<td>ITIL User</td>
</tr>
<tr>
<td>Contact type</td>
<td>Phone</td>
</tr>
<tr>
<td>State</td>
<td>Active</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Service Desk</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Beth Anglin</td>
</tr>
<tr>
<td>Short description</td>
<td>SAP Sales app is not accessible</td>
</tr>
</tbody>
</table>

**Related Search Results**

- **Can’t access SAP**: SAP troubleshooting techniques. Using transaction SE11, create a table (ZTABLE) with the same fields as the table in the external database, make sure that...
  - [Preview](#) [Attach](#)

- **SAP Outage - We are aware of the SAP out...**: SAP Outage - We are aware of the SAP outage. Service will be restored soon
  - [Preview](#) [Attach](#)

- **How to access office email from a home n...**: How to access office email from a home network
  - [Preview](#) [Attach](#)

- **Sales Force Automation is DOWN**: Sales Force Automation is DOWN
  - [Preview](#) [Attach](#)

- **Permissions for Calendar, Email and Task**: How to Set Permissions for Calendar, Email and Tasks You can configure your folders to provide varying levels of access to other users according to the types of...
  - [Preview](#) [Attach](#)
You can configure contextual search functionality to change which fields are searched on or to add contextual search to other forms.

**Provide knowledge in incident record producer**

Incident deflection provides self-service users with contextual knowledge when they create an incident using either the Create Incident record producer or the Something Broken ESS record producer.

Contextual search results appear based on text entered in the Please describe your issue below field of the Create Incident record producer, or in the Short description field of the Something Broken ESS record producer.

Users can indicate whether a search result is useful to them. If the knowledge provided resolved the incident, the user can cancel the record producer, which deflects the incident. The following scenario shows an example of this.

1. Navigate to the service catalog and select the Can we help you? category.
2. Select the Create New Incident catalog item to raise an incident.
   The Create Incident record producer is displayed.

3. Contextual search then searches the text entered in the Please describe your issue below field to display knowledge results.
4. The user can click an entry in the results list to view the article.
5. The user can then indicate that the article helped, navigate to another article, or close the article.

6. If the knowledge provided helps resolve the issue, the user can cancel the incident record producer. The incident has been deflected. If the information did not fully resolve the issue, the user can still submit the incident.

You can configure contextual search functionality to adapt it to your organization’s incident record producers, or to add contextual search to other record producers. For example, customized incident record producers do not have contextual search enabled by default, so you can add contextual search to a customized record producer.

Provide knowledge in incident email notification

Contextual search results are included in email notifications that are sent to users who create a new incident.

This provides links to knowledge articles that may help users resolve their issues faster. For example, if a user raises an incident when the service desk staff is not available, the email notification provides knowledge links that may help the user.

By default, contextual search results are based on the short description in the incident. Within the automated email response, contextual search adds links to relevant knowledge articles.
For example:

1. Navigate to A customer sends an email to IT support with the subject *My laptop keeps crashing*.
2. An incident is created based on this email.
3. The email subject is inserted into the Short description field of the new incident.
4. The automated email notification sent to the user includes search results based on *My laptop keeps crashing*. For example, one article could be *How to upgrade your Windows version to stop your laptop crashing*.
5. The customer may then be able to use the returned results to resolve the incident.

---

**Note:**

The knowledge links provided are filtered to ensure the articles are accessible to the user who submitted the email.

---

By default, notifications provide three article links. You can configure notification options, such as changing the number of links provided with notifications, can be configured by administrators.

You can also configure contextual search functionality to match your organization's email notifications or to use contextual search with notifications for other records.

**Attach an article**

If contextual search is available in a form that uses the knowledge search icon, that icon is removed to ensure there is only a single knowledge search mechanism for that form.

To retain the ability to attach a selected article to that form, an extra **Attach** button appears on the search results list, and an **Attach to incident** button appears on the displayed knowledge article.
Attach Button

Click the relevant button to attach that knowledge article to that incident, adding details of the knowledge article to the task.

Administer contextual search

You can configure contextual search functions. These procedures require the admin role.

Contextual Search properties

Navigate to Contextual Search > Properties to view and edit contextual search properties.

<table>
<thead>
<tr>
<th>Property label (Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value for maximum number of search results returned for table and record producer configurations</td>
<td>Set an upper limit on the number of search results displayed in record producers or forms using contextual search. By default, this is set to 10.</td>
</tr>
<tr>
<td>(com.snc.contextual_search.result.default.limit)</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property label (Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of milliseconds that a configured field will wait before triggering a search</td>
<td>Set the amount of time after a user finishes typing before running a search based on the typed text. By default, this is set to 500 (half a second).</td>
</tr>
<tr>
<td>(com.snc.search.service.wait_time)</td>
<td></td>
</tr>
<tr>
<td>Records returned above this threshold will log warnings</td>
<td>Trigger a warning message within the system log whenever more than this number of results is returned in a search. This logging helps if you are experiencing performance issues because of large searches. By default, this is set to 10,000.</td>
</tr>
<tr>
<td>(com.snc.contextual_search.result.threshold)</td>
<td></td>
</tr>
<tr>
<td>When a Form configuration is created a search field with a name matching this property will be automatically created</td>
<td>Link the context search to the search field identified in this property whenever you create a new context search for a form. This eliminates the need to select the field in the form manually. By default, this is set to short_description, meaning that whenever you create a new context search for a form with a short_description field, that field is automatically selected as the field the context search acts on.</td>
</tr>
<tr>
<td>(com.snc.contextual_search.widget.form.default_field)</td>
<td></td>
</tr>
<tr>
<td>Collapse the search results widget when opening an existing record in a form</td>
<td>When set to true, the search results widget will be collapsed when an existing record is opened. By default, this is set to true. Note: This applies only to existing records and not new records.</td>
</tr>
<tr>
<td>(com.snc.contextual_search.widget.form.open_collapsed_existing_records)</td>
<td></td>
</tr>
<tr>
<td>Show meta data on form contextual search results</td>
<td>When selected, the search results in the task form displays meta data related to each KB article.</td>
</tr>
<tr>
<td>(com.snc.contextual_search.widget.form.show_meta_data)</td>
<td></td>
</tr>
</tbody>
</table>

Run a feedback report

A **This Helped** button appears in displayed knowledge articles, allowing users to mark an article as helpful for resolving the associated issue. You can report on searches where a knowledge article was marked as helpful to measure the effectiveness of the contextual search results.

For example, service desk managers can produce a report on user issues that were resolved without an incident being raised to help measure the benefits of incident deflection using knowledge. This information can help to create targeted knowledge based on trends.

For example, analyzing commonly-raised incidents then creating knowledge articles based around those incident can help resolve or deflect similar incidents in future.

1. Navigate to **Reports > View / Run**.
2. Select the report to run.

Reports available by default are:

- **Number of deflected incidents over the last 3 months**: A line chart displaying the total number of deflected incidents per month for the last 3 months.
- **Successful deflection articles by search term**: A grouped list of search terms and the knowledge articles that were marked as helpful.
- **Top 15 most helpful articles**: A bar chart showing the top 15 articles that have been marked as helpful.

**Note:** You can also run a report by navigating to and searching for the word **Relevant**.
You can create additional feedback information reports by querying feedback tables.

**View a searcher**

Searchers specify where to locate information for a contextual search, such as knowledge and catalog items.

Searcher records are read-only, but you should be aware of the searchers available so you can select the correct one when defining contextual searches.

1. Navigate to **Contextual Search > Searchers**, then open a record.

   ![Searcher Configuration](image)

   - **Search Resources related list** to inspect the sources which define the information areas to search.

2. Use the Search Resources related list to inspect the sources which define the information areas to search.
For example, incident deflection uses the **knowledge and catalog** searcher which includes knowledge and catalog resources.

Search resources can also contain properties, refining the resource further. For example, the knowledge search resource contains a Sort order property to specify that the search results are returned sorted by relevance.

**Query feedback information**

The information captured when the user clicks the **This Helped** action button on the result window is stored in the following tables.

<table>
<thead>
<tr>
<th>Table (name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relevant Document (cxs_relevant_doc)</td>
<td>Contains incident record references where users have indicated that a search result record was useful by clicking the <strong>This helped</strong> button</td>
</tr>
<tr>
<td>Relevant Document Detail (cxs_rel_doc_detail)</td>
<td>Contains details of the search result record that users have indicated as useful or have attached to a form, as well as the search terms used to query the knowledge base.</td>
</tr>
</tbody>
</table>

This feedback information is important for analyzing the effectiveness of the searches provide. You can create custom reports on this information by querying these tables.

**Installed with contextual search**

Activating the Contextual Search plugin installs the following components:

**Business rules installed with contextual search**

Contextual search adds the following business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add variable to record producer</td>
<td>Record Producer Configuration (cxs_rp_config)</td>
<td>Contains script that adds contextual search to the selected variable on a record producer.</td>
</tr>
<tr>
<td>Add variable to wizard</td>
<td>Wizard Configuration (cxs_wizard_config)</td>
<td>Contains script that adds contextual search to the selected variable on a wizard.</td>
</tr>
<tr>
<td>Cascading delete for removed config</td>
<td>Table Configuration (cxs_table_config)</td>
<td>Deletes search fields when the related table configuration is deleted.</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Table Configuration (cxs_table_config)</td>
<td>Avoids duplicate table configurations.</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Email Configuration (cxs_table_email_config)</td>
<td>Avoids duplicate table email configurations.</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Wizard Configuration (cxs_wizard_config)</td>
<td>Avoids duplicate wizard configurations.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Record Producer Configuration</td>
<td>Avoids duplicate record producer configurations.</td>
</tr>
<tr>
<td>Check for invalid action values</td>
<td>Base UI Configuration</td>
<td>Checks for invalid action values against the related search configuration.</td>
</tr>
<tr>
<td>Create default search field</td>
<td>Table Configuration</td>
<td>Creates a default search field when an insert or update is performed on a table configuration.</td>
</tr>
<tr>
<td>Create m2m_kb_task record on attach</td>
<td>Relevant Document Detail</td>
<td>Creates a knowledge base task record.</td>
</tr>
<tr>
<td>Delete m2m_kb_task record on remove</td>
<td>Relevant Document Detail</td>
<td>Deletes a knowledge base task record.</td>
</tr>
<tr>
<td>Display default context config message</td>
<td>Client Configuration</td>
<td>Confirms the default search context configuration.</td>
</tr>
<tr>
<td>Display default field message</td>
<td>Search Field</td>
<td>Confirms the default table field.</td>
</tr>
<tr>
<td>If searcher changes check interleaved</td>
<td>Search Context</td>
<td>Check weather a search context needs to interleaved</td>
</tr>
<tr>
<td>Maintain context resource properties</td>
<td>Search Context</td>
<td>Is used to update context properties</td>
</tr>
<tr>
<td>Make default</td>
<td>Search Context</td>
<td>Sets the client configuration as the default.</td>
</tr>
<tr>
<td>Make default config</td>
<td>Search Field</td>
<td>Sets the table field as the default.</td>
</tr>
<tr>
<td>Populate ‘Order’ field</td>
<td>Search Field</td>
<td>Sets the order for new search field configurations. Order will be set to the highest order in the list.</td>
</tr>
<tr>
<td>Remove related search field records</td>
<td>Table Configuration</td>
<td>Removes related search fields when changes are made to a record producer</td>
</tr>
<tr>
<td>Remove related search field records</td>
<td>Record Producer Configuration</td>
<td>Removes related search fields when changes are made to a table.</td>
</tr>
<tr>
<td>Set ‘Name’ field</td>
<td>Record Producer Configuration</td>
<td>Sets the name of a record automatically for record producers.</td>
</tr>
<tr>
<td>Set ‘Name’ field</td>
<td>Table Configuration</td>
<td>Sets the name of a record automatically for forms.</td>
</tr>
<tr>
<td>Set ‘Name’ field</td>
<td>Email Configuration</td>
<td>Sets the name of a record automatically.</td>
</tr>
</tbody>
</table>
### Name | Table | Description
--- | --- | ---
Set ‘Name’ field | Search Field (cxs_table_field_config) | Sets the name of a record automatically.
Update related context config records | Search Resource (cxs_search_res_config) | Used to update related search context configuration records.
Validate active context | Base UI Configuration (cxs_ui_config_base) | Used to confirm that the search context is valid.
Validate limit | Email Configuration (cxs_table_email_config) | Ensures the limit is not negative or zero for email configurations.
Validate limit | Record Producer Configuration (cxs_rp_config) | Ensures the limit is not negative or zero for record producer configurations.
Validate limit | Table Configuration (cxs_table_config) | Ensures the limit is not negative or zero for form configurations.
Validate results per page | Table Configuration (cxs_table_config) | Ensures the limit is not negative, zero or greater than limit for forms.
Validate results per page | Record Producer Configuration (cxs_rp_config) | Ensures the limit is not negative, zero or greater than limit for record producers.

### Client scripts installed with contextual search

Contextual search adds the following client scripts.

**Client scripts installed with contextual search**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set default limit and results per page</td>
<td>Record Producer Configuration (cxs_rp_config)</td>
</tr>
<tr>
<td>Clear field when Record Producer changes</td>
<td>Record Producer Configuration (cxs_rp_config)</td>
</tr>
<tr>
<td>Set default limit and results per page</td>
<td>Table Configuration (cxs_table_config)</td>
</tr>
<tr>
<td>Warn about search fields being removed</td>
<td>Table Configuration (cxs_table_config)</td>
</tr>
<tr>
<td>Set default limit</td>
<td>Email Configuration (cxs_table_email_config)</td>
</tr>
<tr>
<td>Set default limit and results per page</td>
<td>Wizard Configuration (cxs_wizard_config)</td>
</tr>
</tbody>
</table>
## Email notifications installed with contextual search

Contextual search modifies the following email notifications.

### Email notifications installed with contextual search

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident opened for me</td>
<td>Incident</td>
<td>Shows the search result records that contextual search finds for that incident record.</td>
</tr>
<tr>
<td></td>
<td>(Incident)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** A note indicates neutral or positive information that emphasizes or supplements important points of the main text. A note supplies information that may apply only in special cases. Examples are memory limitations, equipment configurations, or details that apply to specific versions of a program.

## Script includes installed with contextual search

### Script includes installed with contextual search

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Extends</th>
</tr>
</thead>
<tbody>
<tr>
<td>cxs_App</td>
<td>Configures business rules, action scripts, and security script against tables using contextual search.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_ContextConfig</td>
<td>Configures Table Configuration (cxs_table_config) attributes.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_FormatResults</td>
<td>Determines and runs the macro to be used for displaying search results.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_Knowledge</td>
<td>Attaches knowledge articles to records such as incidents, change requests, and problems.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_RPAjax</td>
<td>Gets and retrieves record producer configurations.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_RPCConfig</td>
<td>Configures the Record Producer Configuration (cxs_rp_config) table and manipulates contextual search on record producers.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_RPVarTypes</td>
<td>Returns the types of variable that can be used when defining a contextual search for a record producer.</td>
<td>N/A</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Extends</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>cxs_SearchContextAJAX</td>
<td>Configures records in the Search Resource Context Configuration</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td></td>
<td>(cxs_res_context_config) table.</td>
<td></td>
</tr>
<tr>
<td>cxs_SearchResourceConfig</td>
<td>Contains method that will update Context Configuration for (cxs_search_res_config).</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_SearchResultsAJAX</td>
<td>Returns results from a search formatted using the specified macro.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_SearchServerAJAX</td>
<td>Checks that the search context is configured.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_TableActions</td>
<td>Gets email search request records.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_TableAjax</td>
<td>Gets table configuration from the Table Configuration (cxs_table_config) table.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_TableConfig</td>
<td>Creates and configures fields that have contextual search attached from the cxs_table_field_config table.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_TableEmailConfig</td>
<td>Configures and checks duplicates in the Email Configuration (cxs_table_email_config) table.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_TableEmailConfigAJAX</td>
<td>Configures the Email Configuration (cxs_table_email_config) table.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_TableFieldConfig</td>
<td>Configures records in the Search Field (cxs_table_field_config) table.</td>
<td>N/A</td>
</tr>
<tr>
<td>cxs_TableFieldTypes</td>
<td>Used to validate field types.</td>
<td>Search Field (cxs_table_field_config) table.</td>
</tr>
<tr>
<td>cxs_WizardAJAX</td>
<td>Gets and retrieves wizard configuration.</td>
<td>AbstractAjaxProcessor</td>
</tr>
<tr>
<td>cxs_WizardConfig</td>
<td>Creates and configures fields that have contextual search attached.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Tables installed with contextual search**

Contextual search adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Display Name (Table Name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Search Resource (v_cxs_search_resource)</td>
<td>A virtual table that contains a list of available search resources used in configuration of searches.</td>
</tr>
<tr>
<td>Display Name (Table Name)</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email Configuration</td>
<td>Contains a list of email notifications configured to have contextual search results attached.</td>
</tr>
<tr>
<td>(cxs_table_email_config)</td>
<td></td>
</tr>
<tr>
<td>Record Producer Configuration</td>
<td>Contains a list of record producers configured to have contextual search.</td>
</tr>
<tr>
<td>(cxs_rp_config)</td>
<td></td>
</tr>
<tr>
<td>Relevant Document</td>
<td>Contains incident record references where users have indicated that a search result record was useful by clicking the <strong>This helped</strong> button. Significant fields include:</td>
</tr>
<tr>
<td>(cxs_relevant_doc)</td>
<td>- <strong>Displayed on</strong>: Whether the contextual search results were shown on a table form or a record producer.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Session id</strong>: The id of the search session that the action button was triggered for.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Helped with</strong>: The record that the search result helped resolve.</td>
</tr>
<tr>
<td>Relevant Document Detail</td>
<td>Contains all the search result records which users have indicated were useful or have attached to a form, as well as the search terms used in the search query. Significant fields include:</td>
</tr>
<tr>
<td>(cxs_rel_doc_detail)</td>
<td>- <strong>Relevance</strong>: The internal value of the action button (<strong>This helped</strong> or <strong>Attach</strong>).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Help document</strong>: The search result that was marked as helped or attached.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Help document URL</strong>: The URL to the article that was marked as helped or attached.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Search request</strong>: The JSON object that was used by the search engine to perform the search.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Search term</strong>: The search term that was used to initiate the search.</td>
</tr>
<tr>
<td>Search Context</td>
<td>Contains available search contexts for contextual search.</td>
</tr>
<tr>
<td>(cxs_context_config)</td>
<td></td>
</tr>
<tr>
<td>Search Field</td>
<td>Contains all form fields which have contextual search configured to it.</td>
</tr>
<tr>
<td>(cxs_table_field_config)</td>
<td></td>
</tr>
<tr>
<td>Search Resource</td>
<td>Contains search resource configurations for the related searcher.</td>
</tr>
<tr>
<td>(cxs_search_res_config)</td>
<td></td>
</tr>
<tr>
<td>Search Resource Context Configuration</td>
<td>Contains conditions for this search context that will restrict the results returned to a user.</td>
</tr>
<tr>
<td>(cxs_res_context_config)</td>
<td></td>
</tr>
<tr>
<td>Search Resource Context Property</td>
<td>Contains the property values for search resource context configuration.</td>
</tr>
<tr>
<td>(cxs_res_context_config_prop)</td>
<td></td>
</tr>
<tr>
<td>Search Resource Property</td>
<td>Contains the property values for search resource searcher configuration.</td>
</tr>
<tr>
<td>(cxs_search_res_config_prop)</td>
<td></td>
</tr>
</tbody>
</table>
### Searcher Configuration
- **Display Name**: cxs_searcher_config
- **Description**: Contains the details of available search configurations.

### Table Configuration
- **Display Name**: cxs_table_config
- **Description**: Lists the tables configured for table configurations.

### Wizard Configuration
- **Display Name**: cxs_wizard_config
- **Description**: Lists the tables configured for wizard configurations.

### Base UI Configuration
- **Display Name**: cxs_ui_config_base
- **Description**: Contains the common elements for the record producer, table, and wizard configurations.

## UI macros installed with contextual search

Contextual search adds the following UI macros.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cxs_result</td>
<td>Represents a single search result when processed by cxs_results.</td>
</tr>
<tr>
<td>cxs_results</td>
<td>Processes the results returned by a contextual search.</td>
</tr>
<tr>
<td>cxs_results_header_email</td>
<td>Adds the header when sending contextual search results by email.</td>
</tr>
<tr>
<td>cxs_results_header_rp</td>
<td>Displays the header that is shown above the search results on record producers.</td>
</tr>
<tr>
<td>cxs_results_header_table</td>
<td>Displays the header that is shown above the search results on forms.</td>
</tr>
<tr>
<td>cxs_results_header_wizard</td>
<td>Displays the header that is shown above the search results wizards.</td>
</tr>
<tr>
<td>cxs_results_table</td>
<td>Processes the results returned by a contextual search.</td>
</tr>
<tr>
<td>cxs_results_vcr</td>
<td>Provides the pagination controls.</td>
</tr>
<tr>
<td>cxs_result_default</td>
<td>Represents a single search result where there is no specific macro for the source table.</td>
</tr>
<tr>
<td>cxs_result_email</td>
<td>Represents a single search result when the search results are being sent by email.</td>
</tr>
<tr>
<td>cxs_result_kb_knowledge</td>
<td>Represents a single search result returned from the kb_knowledge table.</td>
</tr>
<tr>
<td>cxs_result_sc_cat_item</td>
<td>Represents a single search result returned from the sc_cat_item table.</td>
</tr>
<tr>
<td>cxs_result_table</td>
<td>Represents a single search result for displaying on a form.</td>
</tr>
<tr>
<td>cxs_rp_search</td>
<td>Initiates a contextual search from a record producer.</td>
</tr>
<tr>
<td>cxs_table_search</td>
<td>Initiates a contextual search from a form.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>cxs_wizard_search</td>
<td>Initiates a contextual search from a record producer.</td>
</tr>
</tbody>
</table>

**UI policies installed with contextual search**

Contextual search adds the following UI policies.

**UI Policies installed with contextual search**

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Table field</td>
<td>Email Configuration</td>
<td>Changes email configuration visibility to false and read only.</td>
</tr>
<tr>
<td></td>
<td>(cxs_table_email_config)</td>
<td></td>
</tr>
<tr>
<td>Hide table config field</td>
<td>Search Field</td>
<td>Hides the table field on the form.</td>
</tr>
<tr>
<td></td>
<td>(cxs_table_field_config)</td>
<td></td>
</tr>
</tbody>
</table>

**Events**

Events are special records the system uses to log when certain conditions occur and to take some kind of action in response to the conditions.

The system uses business rules to monitor for system conditions and to generate event records in the Event (sysevent) table, which is also known as the event log or event queue.

Event-generating business rules typically use this script logic:

If (some condition is true for the current record), then (add a specific event to the queue).

For example, here are some of the conditions in the incident event business rule:

- If a user adds a comment to an incident record, add an incident.commented event.
- If a user adds an incident record, add an incident.inserted event.
- If a user updates an incident record, add an incident.updated event.

Event-generating business rules use the GlideSystem eventQueue method to insert event records, which typically contain this information:

**Event fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of event. Baseline event names include the record effected and the triggering action such as incident.commented.</td>
</tr>
<tr>
<td>Parm1</td>
<td>An event-specific parameter the system uses to pass record information to other parts of the system, such as a record Sys ID or a field value.</td>
</tr>
<tr>
<td>Parm2</td>
<td>Another event-specific parameter the system uses to pass record information to other parts of the system, such as a record Sys ID or a field value.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to which the event applies. This is the same table on which the business rule ran.</td>
</tr>
</tbody>
</table>
Scheduled jobs periodically read the event queue and forward them to the appropriate handler for processing. The handler uses information from event records to take some kind of action such as:

- Run a script action
- Schedule a job
- Send a notification
- Trigger a workflow activity
- Trigger an inactivity monitor

By default, the system provides events covering a broad view of application activity. If existing events do not meet your needs, you can create your own events to watch for specific changes to records.

### Event registry

The events registry lists the events the system recognizes. Use registered events to automate other activities, such as script actions or notifications.

After you create a new event and a business rule that uses the event, you must register it. Registration lets other parts of the system, such as Email Notifications and Script Actions, see the event in their list of available events and react to the event when it occurs.

### Event states

The event state describes where in the life cycle the event is.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>The system created the event and it is in the queue waiting to be processed.</td>
</tr>
<tr>
<td>Processed</td>
<td>The event successfully ran. An event does not necessarily trigger any further action when processed. Additional functionality must make use of the event.</td>
</tr>
<tr>
<td>Error</td>
<td>The event encountered an error during processing. This state is often caused by invalid event parameters. Reprocessing the event may resolve the error.</td>
</tr>
</tbody>
</table>
The event was rotated to a different shard of the Event \( (\text{sys} \text{event}) \) table. When an event is rotated, a duplicate record is created in an active shard to be processed. A scheduled job processes the event when it is next in the queue, but it is not possible to predict when this will happen as because several events may need to be processed before it. Therefore, you can reprocess the event. See [Reprocess an event](#).

### Event logs

The event log records all system events that occur within the system. This log provides the following information for all events that occur:

#### Event log

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time of the event for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the event as listed in the Event Registry.</td>
</tr>
<tr>
<td>URI</td>
<td>HTTP query that generated the event.</td>
</tr>
<tr>
<td>Parm1</td>
<td>Event-specific value that depends on the event and the recipient.</td>
</tr>
<tr>
<td>Parm2</td>
<td>Event-specific value that depends on the event and the recipient.</td>
</tr>
<tr>
<td>Table</td>
<td>Database table acted on for this event.</td>
</tr>
<tr>
<td>Processed</td>
<td>Date and time the event was processed This time reflects the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Processing time</td>
<td>Time taken to process this event, in milliseconds.</td>
</tr>
<tr>
<td>Queue</td>
<td>Processor queue name.</td>
</tr>
</tbody>
</table>

### The incident events business rule

The incident events business rule comes with the system and defines a number of events that can be triggered by different actions in the Incident table.
Incident events business rule

This business rule defines several events, three of which are triggered after a record in the Incident table is inserted or updated. The first script is:

```java
if (current.operation() != 'insert' && current.comments.changes()) {
    gs.eventQueue("incident.commented", current, gs.getUserID(), gs.getUserName());
}
```

The condition in this script requires that a change be made to the Comments field in an existing (not inserted) incident record. If this condition is true, then the platform adds the incident.commented event to the event queue.

The second condition requires that a record be inserted before the event is added to the queue.

```java
if (current.operation() == 'insert') {
    gs.eventQueue("incident.inserted", current, gs.getUserID(), gs.getUserName());
}
```

The condition in this script requires that a record be inserted before the event is added to the queue.
The third condition is true whenever the incident record is updated (including updates to the Comments field, as specified by the first script).

```java
if (current.operation() == 'update')
```

The then part of each script, the `gs.eventQueue` function, adds the event to the event queue. This statement uses the following syntax, set off with braces:

```java
gs.eventQueue("incident.updated", current, gs.getUserID(), gs.getUserName());
```

The `gs.eventQueue` function takes the following parameters:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the event triggered, set in quotation marks</td>
</tr>
<tr>
<td>Record</td>
<td>The record referenced when the condition in the script evaluates to true. Usually this is expressed as current, meaning the current record the business rule is working on. If the business rule is being triggered as part of a scheduled job, use a GlideRecord argument in its place.</td>
</tr>
<tr>
<td>Parm 1</td>
<td>An optional parameter you can use to pass system or record information with the event. For example, the GlideSystem API call <code>gs.getUserID()</code> passes the Sys ID of the user who acted on the current record as a string value. Other scripts can reference this string value as parm1 using the format <code>${event.parm1}</code>.</td>
</tr>
<tr>
<td>Parm 2</td>
<td>An optional parameter you can use to pass system or record information with the event. For example, the GlideSystem API call <code>gs.getUserName()</code> passes the user name of the user who acted on the current record. Other scripts can reference this string values as parm2 using the format <code>${event.parm2}</code>.</td>
</tr>
</tbody>
</table>

**Note:** The `gs.EventQueue` function works directly with the backend and therefore business rules that are called by `gs.EventQueue()` are not invoked.

**Sample scripts from the change events business rule**

Several scripts are found in the baseline change events business rule.

This business rule defines events that fire after a change request is inserted or updated.

```java
if (current.operation() == 'insert') {
    gs.eventQueue("change.inserted", current, gs.getUserID(), gs.getUserName());
}

if (current.operation() == 'update') {
    gs.eventQueue("change.updated", current, gs.getUserID(), gs.getUserName());
}

if (!current.assigned_to.nil() && current.assigned_to.changes()) {
```
gs.eventQueue("change.assigned", current, current.assigned_to.getDisplayValue(), previous.assigned_to.getDisplayValue());
}

if (current.priority.changes() && current.priority == 1) {
    gs.eventQueue("change.priority.1", current, current.priority, previous.priority);
}

if (current.risk.changes() && current.risk == 1) {
    gs.eventQueue("change.risk.1", current, current.risk, previous.risk);
}

if (current.start_date.changes() || current.end_date.changes() || current.assigned_to.changes()) {
    if (!current.start_date.nil() && !current.end_date.nil() && !current.assigned_to.nil()) {
        gs.eventQueue("change.calendar.notify", current, current.assigned_to, previous.assigned_to);
    }

    // Remove from previous assigned to, due to assigned_to changing
    if (!previous.assigned_to.nil()) {
        if (!current.assigned_to.nil() && current.assigned_to.changes() && (!previous.start_date.nil() && !previous.end_date.nil())) {
            gs.eventQueue("change.calendar.notify.remove", current, current.assigned_to, previous.assigned_to);
        }
    }

    // Remove old calendar from current assigned to, due to date changing
    else if (!current.assigned_to.nil()) {
        if ((current.start_date.changes() && !previous.start_date.nil()) ||
            (current.end_date.changes() && !previous.end_date.nil())) {
            gs.eventQueue("change.calendar.notify.remove", current, current.assigned_to, current.assigned_to);
        }
    }
}

### Script actions

You can use script actions to create server-side scripts that perform a variety of tasks, such as modifying a configuration item (CI), or managing failed login attempts. Script actions are triggered by events only.

### Configuration

To create a new script action, navigate to System Policy > Events > Script Actions and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a unique name for your script action.</td>
</tr>
<tr>
<td>Event Name</td>
<td>Select the event to use for this script. If you do not find an event for your script action that suits your purpose, you can create a new one.</td>
</tr>
<tr>
<td>Application</td>
<td>The application that contains this script.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the script will be executed.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box (true) to enable this script action.</td>
</tr>
<tr>
<td>Condition Script</td>
<td>Create a statement for a condition under which this script should execute.</td>
</tr>
<tr>
<td></td>
<td>The system only parses the <strong>Script</strong> field if the condition evaluates to true. If you decide to include the condition statement in the script, leave this field blank.</td>
</tr>
<tr>
<td>Script</td>
<td>Create a script that runs when the condition you define evaluates to true.</td>
</tr>
<tr>
<td></td>
<td>Two additional objects are available in this script:</td>
</tr>
<tr>
<td></td>
<td>- <strong>event</strong>: <code>a</code> - the sysevent that caused this to be invoked. If you wanted so get this first parameter on the event, you would use <code>event.parm1</code> or <code>event.parm2</code> for the second parameter. For the date/time of the event, use <code>event.sys_created_on</code>. To get the user ID that created the event (if there was a user associated), use <code>event.user_id</code>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>current</strong>: a GlideRecord - the event scheduled on behalf of (incident for example).</td>
</tr>
</tbody>
</table>

This is a sample of a script action that creates an email notification for Workflow activity:
```
function sendWorkflowNotification() {
    var activity = new GlideRecord('wf_activity');
    if (activity.get(parts[0]))
        return 0;

    // The EmailAction does not know how to handle ${workflow...} constructs so we need to handle
    // these for it
    var context = new GlideRecord('wf_context');
    if (parts.length == 2)
        context.set(parts[1]);

    GlideController.setGlobal('context', context);
    GlideController.setGlobal('workflow', workflow);
    GlideController.setGlobal('workflowActivity', workflowActivity);

    var subject = workflowActivity vars.subject;
    var message = workflowActivity vars.email;
    var emailAction = new GlideEmailAction();

    var email = new GlideRecord('sys/event/email_action');
```
Global events

Your instance has a global function called `global_events()` that triggers from a business rule when certain conditions occur.

This function triggers when your instance is:

- Inserting new records
- Updating existing records
- Adding comments to an existing record
- Assigning a record to a user
- Exceeding a record’s inactive timer

For example, if you add the script `global.events(current)` to a business rule on the `change_request` table, the instance automatically configures the following events:

- `change_request.inserted`
- `change_request.updated`
- `change_request.commented`
- `change_request.assigned`
- `change_request.inactive`

The business rule for global events on the `change_request` table looks like this:

![Business Rule](image)

Change request tasks global business rule
Create an event

If you do not find a suitable existing event, you can create your own.

Role required: admin

The gs.EventQueue function works directly with the backend and therefore business rules that are called by gs.EventQueue() are not invoked.

1. Navigate to System Policy > Events > Registry.
2. Click New and fill in the form.
3. Click the Business Rules related link.
4. If you are creating an event for a base system table, select the existing event business rule for the table.
   For example, select the sc request events business rule to create a custom Request event.
5. If you are updating an existing event business rule, add a new condition to the Script.
   The following sample script adds a request.commented event with the user’s Sys ID as parm1
   and the user’s user name for parm2.

   ```java
   if (current.operation() != 'insert' && current.comments.changes()) {
     gs.eventQueue('request.commented', current, gs.getUserID(),
                   gs.getUserName());
   }
   ```

6. If you are creating an event for a custom table, create a new business rule that runs after database operations.
   For example, this business rule defines several events for a custom application called Marketing Events.

Sample event business rule

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Attendee Events</td>
</tr>
<tr>
<td>Table</td>
<td>Attendee (x_snc_marketing_ev_attendee)</td>
</tr>
<tr>
<td>Application</td>
<td>Marketing Events</td>
</tr>
<tr>
<td>Advanced</td>
<td>Selected</td>
</tr>
<tr>
<td>When</td>
<td>after</td>
</tr>
<tr>
<td>Insert</td>
<td>Selected</td>
</tr>
<tr>
<td>Update</td>
<td>Selected</td>
</tr>
<tr>
<td>Delete</td>
<td>Selected</td>
</tr>
<tr>
<td>Script</td>
<td>Add custom script that:</td>
</tr>
<tr>
<td></td>
<td>· Checks for one or more conditions on the</td>
</tr>
<tr>
<td></td>
<td>current record.</td>
</tr>
<tr>
<td></td>
<td>· Calls the gs.eventQueue() method and</td>
</tr>
<tr>
<td></td>
<td>specifies an event name.</td>
</tr>
<tr>
<td></td>
<td>See code sample.</td>
</tr>
</tbody>
</table>
Note: If you add Filter Conditions, Role conditions, or a Condition value, verify it runs the business rule when expected.

```javascript
(function executeRule(current, previous /*null when async*/) {
    //This function will be automatically called when this rule is processed.
    //Add event when attendee inserted
    if(current.operation() == 'insert' &&
        current.marketing_event.changes()) {
        gs.eventQueue('x_snc_marketing_ev.attendee.added',
        current,
        current.marketing_event, current.email);
    }
    //Add event when marketing event changes
    if(current.operation() == 'update' &&
        current.marketing_event.changes()) {
        gs.eventQueue('x_snc_marketing_ev.attendee.deleted',
        previous,
        previous.marketing_event, previous.email);
        gs.eventQueue('x_snc_marketing_ev.attendee.added',
        current,
        current.marketing_event, current.email);
    }
    //Add event when attendee deleted
    if(current.operation() == 'delete') {
        gs.eventQueue('x_snc_marketing_ev.attendee.deleted',
        current,
        current.marketing_event, current.email);
    }
})(current, previous);
```

7. Register the event.

Create a script action or notification to process the event.

**Register an event**

You can register an event for a specific table and a business rule that fires the event.

1. To register an event, browse to System Policy > Events > Registry, and then click New.
2. Complete the Event Registration form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your new event.</td>
</tr>
<tr>
<td>Table</td>
<td>The database table for this event.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the purpose of the event.</td>
</tr>
</tbody>
</table>

**Note:** The list shows only tables and database views that are in the same scope as the event.
### Reprocess an event

You can fire the event again for testing or diagnostic purposes.

**Role required:** admin

1. Navigate to **System Logs** > **Events**.
2. Open an event.

### Pass event parameters from a workflow to a notification

You can pass two event parameters that send information about a record or related records from a workflow to a notification.

**Role required:** admin

1. Navigate to **System Policy** > **Events** > **Registry** and define a new event to call.
2. Create the activity step that calls the event from your workflow and assign the two possible parameters.
   
   These parameters can be references or fields on the record that triggered the workflow, such as `current.number` for the request item number. You can also dot-walk to records in other tables. The event then sends the parameters information to the notification that it triggers.
3. Retrieve the parameters in the notification with email scripts by using `event.parm1` and `event.parm2`.

   For example:

   ```javascript
   var string = event.parm1.toString();
   template.print(string);
   ```

   Another example using Sys IDs gives you access to anything in the record that triggered the workflow. Use a script like this to send information about a change or request to support personnel, for example.

   ```javascript
   var id = event.parm1.toString();
   var gr = new GlideRecord('sc_req_item');
   gr.get('sys_id', id);
   if (gr.next()){
     // Do something.
   }
   ```
Data management

Data in your instance is stored and managed according to a principled structure that administrators can view and configure. Data management functions include importing, exporting, and archiving database data and configuring fields and tables.

Database structure

All of the information in the instances is stored in tables, which consist of a series of records. The record in turn holds a series of fields that hold the individual bits of data and can be viewed either as a list or a form.

Tables can be related to each other in the following ways:

Extensions

A table can extend another table. The table doing the extending (child class) includes all of the fields of the other table (parent class) and adds its own fields. For instance, the Incident table has all of the Task table fields (because an incident is a special form of task) and has its own incident-specific tasks.

One-to-Many

Within a table, a field can hold a reference to a record on another table. There are three types of one-to-many relationship fields:

- Reference Field: allow a user to select a record on a table defined by the reference field. For instance, the Caller field on the Incident table allows the user to select any record on the User table.
- Glide List: allows a user to select multiple records on a table defined by the glide list. For instance, the Watch list field on the Incident table allows the user to select records on the User table.
- Document ID Field: allows a user to select a record on any table in the instance. These fields are much less common, but one example is the Document field on the Translated Text table.

Many-to-Many

Two tables can have a bi-directional relationship, so that the related records are visible from both tables in a related list.

Database Views

Two tables can be joined virtually with Database Views to enable reporting on data that might be stored over more than one table.

Data management tools

There are a number of tools that can help manage data within the instance.

Schema map

The Schema Map displays the relationships between tables visually, helping to navigate through the database structure.
The Schema Map provides an interface for viewing the relationships between tables. The inter-
table relationships it captures include many-to-many relationships, tables that extend other
tables, and tables that reference other tables through reference fields.

**Data dictionary tables**

Data dictionary tables holds information that defines the database and can be accessed for
information on the database schema.

These tables hold important information on the database and its structure:

- **Tables [sys_db_object]**: contains a record for each table.
- **Dictionary Entries [sys_dictionary]**: contains additional details for each table and
  the definition for every column on each table. Each row represents either a column on a
  table or a table.
- **Field Labels [sys_documentation]**: contains the human-readable labels and language
  information.

**Table cleaner**

Table cleaner automatically deletes records on certain tables to prevent data growing
exponentially. Records are automatically deleted from specific tables after a specific time
to deletion. Deleting these records automatically prevents the tables from growing to an
unmanageable size.

The time before a record is deleted begins on the date and time value in the tracked field.
The Table Cleaner scheduled job runs the table cleaner every hour. To view the list of tables
that are auto-cleaned, in the Navigator filter, type: `sys_auto_flush_list.do`. All records with
`[MatchField < (current_time - Age in seconds)]` are deleted.

- The **MatchField** field represents a Date/Time column in the table that you are trying to clean
  up.
- The **Age in seconds** field represents a value in seconds.

You can set up multiple table cleaner entries for a particular table. Performance depends on
the size of the table and the conditions used. For example, if you use a custom column in a very
large table that has no index on, performance is severely degraded. Performance also depends
on the number of rows to be deleted.

**Note:** TableCleaner does not call DBDelete.setWorkflow(). This means DBDelete
objects run with `workflow=false` (false is the default value for a Java boolean), hence
Delete business rules and workflows are not triggered.

**Cleaned tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Tracked field</th>
<th>Time to deletion</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_poll</td>
<td>sys_created_on</td>
<td>1 day</td>
</tr>
<tr>
<td>cmdb_metric</td>
<td>sys_created_on</td>
<td>2 days</td>
</tr>
<tr>
<td>ecc_agent_metric</td>
<td>sys_created_on</td>
<td>30 days</td>
</tr>
<tr>
<td>v_transaction</td>
<td>sys_created_on</td>
<td>1 day</td>
</tr>
<tr>
<td>wf_context</td>
<td>ended</td>
<td>180 days</td>
</tr>
<tr>
<td>sys_cache_flush</td>
<td>sys_created_on</td>
<td>1 hour</td>
</tr>
<tr>
<td>sys_replication_queue</td>
<td>sys_created_on</td>
<td>1 day</td>
</tr>
<tr>
<td>sysevent</td>
<td>sys_created_on</td>
<td>7 days</td>
</tr>
</tbody>
</table>
### Data management plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Archiving</strong></td>
<td>Provides the ability to archive records to minimize performance issues.</td>
</tr>
<tr>
<td><strong>Database Rotations</strong></td>
<td>Provides tools for managing large tables to minimize performance issues.</td>
</tr>
<tr>
<td><strong>Many to Many task relations</strong></td>
<td>Provides the ability to define many-to-many relationships between task tables.</td>
</tr>
</tbody>
</table>

### The unique record identifier (sys_id)

Each record in the instance is identified by a unique 32-character GUID (Globally Unique ID) called a Sys ID (sys_id).

The same sys_id value are never be generated twice, ensuring every record created in every table in every instance in the world has a unique identifying value. If two records have the same sys_id value, then one was copied to the other at the database level outside of the Now Platform. When created within the application, sys_id values are unique. The the Now Platform and database should manage all operations on sys_id values. Typical end users do not see a record’s sys_id, and database administrators rarely use sys_id values.

Note: A sys_id of -1 is the sys_id of a new record. Once the record is inserted, it will be given a new sys_id.

Note: The sys_id is not meant to show as a field on a form or as a column in a list. To learn more, see the [Users are unable to add the sys_id field to a form or list view](KB0690876) article in the HI Knowledge Base.
Get the sys_id from the header bar

Users can locate the sys_id of a record using the header bar.

1. Navigate to the record.
2. Right click the header bar and select Copy URL.

The sys_id is inside of the URL, after the parameter sys_id=. For example, the following is a URL for an Incident:

```
https://<instance name>.service-now.com/nav_to.do?uri=incident.do?
sys_id=9d385017c611228701d22104cc95c371
```

Therefore the sys_id is 9d385017c611228701d22104cc95c371.

Get the sys_id from a script

Users can locate the sys_id of a record using a script.

- The sys_id value of a record can be found in a business rule (or any other server-side JavaScript) by dot-walking from the GlideRecord.

```javascript
var id = current.sys_id;
```

- The sys_id of a record can be found in client-side JavaScript using g_form.getUniqueValue() as shown in the following example.

```javascript
function onLoad() {
    var incSysid = g_form.getUniqueValue();
    alert(incSysid);
}
```

Get the sys_id from the URL

Users can locate the sys_id of a record by viewing the URL.

Since the sys_id of a record is always part of the URL for a link to that record, it is possible to retrieve the sys_id by viewing the URL.

- View the sys_id in the information bar of the browser by hovering over a link to the record.

For example, an Incident with the following URL: https://<instance name>.service-now.com/nav_to.do?uri=incident.do?sys_id=23dc968f0a0a3c1900534f399927740e, would have this sys_id: 23dc968f0a0a3c1900534f399927740e.

Data archiving

The archive application moves data that is no longer necessary for immediate day-to-day access from primary tables into a set of archive tables.

The longer an instance runs, the more likely it is to accumulate data that is no longer relevant to current business needs. For example, task records from two years ago are typically less relevant than currently active tasks. Old data may eventually cause performance issues by consuming...
system resources and slowing down queries and reports. If you cannot delete this data because you need it for auditing or for historical purposes, set up an archive rule to archive the data and remove it from immediate access to free up system resources. You can then set up a destroy rule to delete the data after a specified period of time. Destroy rules are available starting with the Helsinki release.

Sample Benefits of Archiving Data

Data archiving supports domain separation. For example, incidents that belong to a domain keep their domain designation even after they are archived.

**Note:** If you want to archive email, activate the Email retention plugin and use the archive and destruction rules that come with the plugin. Do not use the archive feature to create your own archiving rules on the Email table.
Tables and modules created by an archive rule

The first time you activate an archive rule, it performs the following actions:

- Creates the archive table in the database. The archive table has the same name as the primary table with an "ar_" prefix. For example, if you archive the Incident [incident] table, then the archive table is [ar_incident].
- Converts multiple joined tables into a single flat-file archive table. The archive table no longer consists of a base and extended tables.
- Converts reference field values (values set by references to records in other tables) into string values. The archive record contains the display value of the reference field at the time of the archive.
- Adds a module to the Archive Tables list in the System Archiving application. The module name is a combination of the word "Archive" plus the display name for the archived table. For example, the archive module for the Attachment [sys_attachments] table is Archive Attachment. Click the module name to view records in the archive table.
- Creates a list of the archive table using the default list view.
- Creates a form for the archive table using the default form view. The form excludes any dot-walking fields such as Caller ID.Email.
Conversion of Multiple Joined Tables into a Flat Archive Table

Querying archived data

Archived tables are not optimized for ad hoc queries. They only contain index entries for the display value, creation date, and the primary key of sys_id.

For this reason ServiceNow does not recommend making ad hoc queries against an archived table, such as searching for all priority 1 archived incidents. Instead, only search against the indexed fields. For example, search for incident INC100001 or incidents created on a specific date.

Activate data archiving

The Data Archiving plugin installs the System Archiving application.
Role required: admin

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the Load demo data check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.

5. Click Activate.

Set archive rule processing behavior

In order to prevent the archive process from consuming too many system resources, the instance uses several system properties to control how many records the archive rule processes at one interval.

By default an archive rule follows these processing rules:

- Archives 100 records for each batch job
- Sleeps 1 second between batch jobs
- Runs 10 batch jobs in an archive run (every hour)

You can change these default settings by adding the following system properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.db.archive.batch_size</td>
<td>Controls how many records an archive rule processes per batch job.</td>
<td>Integer</td>
<td>100</td>
</tr>
<tr>
<td>glide.db.archive.sleep_time</td>
<td>Controls sleep time between each archive rule batch job run, in seconds.</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>glide.db.archive.max_iterations</td>
<td>Controls the maximum number of batch jobs to run within an hour.</td>
<td>Integer</td>
<td>10</td>
</tr>
</tbody>
</table>
Create an archive rule

The System Archiving application includes several sample archive rules that illustrate the archive features. Related records can be added to an archive rule, and you can view an estimate of the number of records the rule affects.

Role required: admin

The sample archive rules are inactive by default.

**Note:** If you want to archive email, activate the [Email retention](#) plugin and use the archive and destruction rules that come with the plugin. Do not use the archive feature to create your own archiving rules on the Email table.

1. Navigate to **System Archiving > Archive Rules**.
2. Click **New**.

![Archive Rule form](#)

3. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required. Enter a unique name that identifies the rule. Since this name is the display field for archive rules, references to archive rules display the name you enter here.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Required. Select the table containing records to archive. There can only be one archive rule per table (even if the rule is inactive). If there is an existing archive rule for a table, the table no longer appears as an option on the archive rule table list.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to enable the archive rule. Clear the check box to disable the rule. ServiceNow recommends leaving your archive rules inactive until you calculate an estimate of the number of records the rule affects and verify that rule behaves as expected.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the archive rule.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select an existing archive rule on which this rule depends on to run. This archive rule only runs when the parent rule also runs.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Select the fields and values that must be true in order for the archive rule to run. Typically, you would archive inactive records older than a certain date.</td>
</tr>
</tbody>
</table>

4. Click Submit.

After verifying that the archive rule is selecting records as expected, activate the archive rule.

If you do not want to wait for the scheduled job to run the archive rule, you can manually start the archive rule by clicking Run Archive Now.

Archive related records

Use the Archive Related Records related list to add related records to the archive rule.

1. Navigate to System Archiving > Archive Rules.
2. Select the appropriate archive rule.
3. From the Archive Related Records related list, click New.
4. Fill in the Archive Related Records form.

**Archive Related Records form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive map</td>
<td>Displays the archive rule to which the related records apply.</td>
</tr>
<tr>
<td>Action</td>
<td>Select the action you want the archive rule to take on related records.</td>
</tr>
<tr>
<td></td>
<td>Choices include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Archive</strong>: archive records that reference the archived record.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Clear</strong>: remove the reference to the archived record.</td>
</tr>
<tr>
<td></td>
<td>The record no longer references the archived record and does not appear as</td>
</tr>
<tr>
<td></td>
<td>a related record in future archives.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete</strong>: delete records that reference the archived record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Reference</td>
<td>Select the relationship of the records you want to apply an action to. The Reference field lists all relations that currently exist for the table being referenced. There are two types of possible relations.</td>
</tr>
</tbody>
</table>

- Another table has a reference field calling the archived table. For example, if you are archiving problem records, there is a Problem ID field in the Incident table that references the related problem records.

- The Archive action archives the related record in addition to the primary record. For example, if you select the Problem in Incident reference, the related record rule also archives any incident record that references an archived problem.

- The Clear action removes the reference to the primary record. For example, if you select the Problem in Incident reference, the related record rule updates any incident record with a reference to the archived problem record by clearing the reference. If the reference is a many-to-many relationship, the related record rule deletes the reference instead of clearing the reference.

- The Delete action deletes any record that references the primary record. For example, if you select the Problem in Incident reference, the related record rule deletes any incident record that references the archived problem record.

- Another table has a Document ID field which might point to the archived table. For example, if you are archiving problem records, there is a sys ID field in the Attachments table that may reference the problem record. The list indicates document ID relationships by displaying an asterisk (*) character at the end of the selection name.

- The Archive action updates the Document ID of the related record to point to the archived table. For example, if you select the Table sys ID Attachment(sys_attachment)* reference, the related record rule updates the attachment record to change the Document ID to refer to the archived table record.

- The Clear action updates the Document ID of the related record to point to the archived table.

- The Delete action deletes any record...
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference table</td>
<td>Displays the table where the rule looks for related records.</td>
</tr>
<tr>
<td>Reference element</td>
<td>Displays the reference field or Document ID the rule queries for.</td>
</tr>
<tr>
<td>Reference table rule</td>
<td>Select an existing archive rule that applies to the related records you are archiving. For example, if you already have an archive rule for the Incident table, you can select the existing Incident table rule when archiving records related to incidents records.</td>
</tr>
</tbody>
</table>

5. Click Submit.

### Verify the number of records affected

Each archive rule provides an estimate of the number of records the rule affects. This estimate only includes primary records and excludes any related records added to the archive rule. The estimate helps you determine if the archive rule affects the number of records you expect it to. If the estimate is too high or low, change the archive rule conditions and then click the Recalculate Estimate related link.

1. Navigate to **System Archiving > Archive Rules**.
2. Select the archive rule you want to estimate records for.
3. Click the **Recalculate Estimate** related link.

### Setting the language of archived strings

On internationalized instances, the archive process uses the language of the SYSTEM user to select the display value strings. If there is no SYSTEM user, the instance uses the default language setting to select the display value strings. You can either create a SYSTEM user with a specific language setting or set the system default language to **select the language of archived strings**.
Create a destroy rule

Create a destroy rule to delete archived records after a specified amount of time.

Role required: admin

1. Navigate to System Archiving > Archive Destroy Rules.
2. Click New.
3. Fill out the form fields (see table).
4. Click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a descriptive name.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the archive table that the system created when you archived records.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description.</td>
</tr>
<tr>
<td>Archive Duration</td>
<td>Specify the amount of time that records stay in the archive table before the system deletes them.</td>
</tr>
</tbody>
</table>

5. You can check the archive destroy log at any time
Manage archived data

You can view archived data, change an archive schedule, restore archived data, and archive a restored record.

Role required: admin

1. Navigate to System Archiving > Archive Tables.

2. Click the module name for the archived table you want to view. For example, Archive Attachment.
3. Click a record from the archived table to see the archived record.
Change an archive schedule

All active archive rules are executed by a system scheduled job set to run every 60 minutes. You can modify the job if you need to change the interval.

1. Navigate to System Scheduler > Scheduled Jobs.
2. Open the Archive record.
3. Modify the repeat value.

Restore archived data

When you restore a record, the instance inserts it back into the primary table and flags the record as having been restored in the log.

1. Navigate to System Archiving > Archive Log.
2. Select the archived record to restore.
3. **Click the **Restore Record **related link.**

**Warning:** Do not delete archive record log entries. Deleting an archive log entry prevents you from restoring the data for the archived records.
Archive a restored record

Archive rules will not archive restored records. In order to archive a restored record you must manually archive the record.

1. Navigate to the restored record.
2. Click the Archive Record link.

Export and import XML files

To occasionally migrate data from one instance to another, you can export the XML data from one instance and import it to another.

This method ensures that all fields and values are transferred exactly. Migrating data in an XML file saves time for unscheduled data imports since there is no need to build an import set or a transform map.

Exporting and importing data in XML files is commonly used for records created in a development instance that must be migrated with the update sets as part of a migration procedure. Examples of these records include lookup tables, unit test records, and other information required to support production. Typically, this information is only migrated once and the overhead of an import set is not justified.

Note: Image field data is not preserved when exporting to XML.
Exporting data
There are a variety of ways for administrators and users to export data.

**Form export**
Export an individual record from the user interface. Choose PDF or XML format directly from a form.

**List export**
Export multiple records from the user interface. Choose CSV, Excel, PDF, or XML format directly from a list.

**URL export**
Export multiple records from a table using the CSV, Excel, PDF, or XML processor. Specify the table form or list you want to export in the URL.

**Web services**
Export multiple records from a table when an external client makes a web services request. Create an external application or process to automate the retrieval of data from an instance via web services such as REST or SOAP.

**Export sets**
Create a file called an export set that contains all the data you want to export.

Export formats

<table>
<thead>
<tr>
<th>Export format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>Export table records as a comma-separated value text file. Use this option to export the currently displayed fields in the list or form as a text file. Configure the list or form to add or remove fields from the export. When exported to CSV, dot-walked fields appear using their full field name, such as u_assignment_group.parent.</td>
</tr>
</tbody>
</table>

**Note:** By default, ServiceNow exports all CSV files in Windows-1252 encoding. If you need to export translated data, set the `glide.export.csv.charset` system property to UTF-8.

| Excel         | Export table records as a Microsoft Excel spreadsheet. Use this option to export the currently displayed fields in the list or form as an Excel spreadsheet. Configure the list or form to add or remove fields from the export. |
### Export format

<table>
<thead>
<tr>
<th>Export format</th>
<th>Description</th>
</tr>
</thead>
</table>
| XML           | Export table records as an XML document. Use this option to export all data from a table or all data for a particular record. The XML file has an XML element for each column in the table.  
  **Note:** Image field data is not preserved when exporting to XML. |
| PDF           | Export table records as a Portable Document Format file. Use this option to export the currently displayed fields in the list or form as a PDF file. Configure the list or form to add or remove fields from the export.  
  **Note:** The PDF export processor prints data from left-to-right, which can produce rendering errors when displaying right-to-left language data. |
| JSON          | Export the table records as a JSON string. The JSON file has an element for each column in the table. |

### Column headers

The file type you export to, such as CSV or PDF determines how column headers are exported. In general, formats meant for human consumption such as PDF display the column label, whereas formats meant for machine use such as CSV use the database field_name.

#### Header format by file type

<table>
<thead>
<tr>
<th>File type</th>
<th>Column header format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel</td>
<td>Label</td>
</tr>
<tr>
<td>PDF</td>
<td>Label</td>
</tr>
<tr>
<td>CSV</td>
<td>field_name</td>
</tr>
<tr>
<td>XML</td>
<td>field_name</td>
</tr>
<tr>
<td>JSON</td>
<td>field_name</td>
</tr>
</tbody>
</table>

### Export limits

The platform provides a default upper limit for data exports.

The purpose of the upper limit is to avoid creating performance issues when a table is excessively large. If you need to export more records than the threshold permits, break up a large export into separate manageable chunks.

### Export limit properties

You can set the number of records to return during an export using the `sysparm_record_count` URL parameter.
However, the system analyzes the following settings to determine whether an export limit should be applied.

1. First, the platform checks the property that defines the format-specific export limit (see table below). Each format can have a different limit. Although this property can be set to any value, exceeding the default export limit can impact system performance. You may want to set the property at or below the default limit and have users **break up a large export** to export large amounts of data.

2. If the format-specific property is not set, the system checks the property for the general export limit (see table below). This property can also be set to any value, but exceeding the default export limit can impact system performance.

3. If neither the format-specific export limit nor the general export limit property is set, the system enforces the default export limit (see table below).

**Important:** To set these properties, navigate to **System Properties > Import Export.**

### Default export limit

<table>
<thead>
<tr>
<th>Format</th>
<th>Format-specific export limit</th>
<th>General export limit</th>
<th>Default export limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML</td>
<td>glide.xml.export.limit</td>
<td>glide.ui.export.limit</td>
<td>10,000</td>
</tr>
<tr>
<td>CSV</td>
<td>glide.csv.export.limit</td>
<td>glide.ui.export.limit</td>
<td>10,000</td>
</tr>
<tr>
<td>EXCEL (XLSX)</td>
<td>glide.xlsx.export.limit</td>
<td>glide.ui.export.limit</td>
<td>10,000</td>
</tr>
<tr>
<td>EXCEL (XLS)</td>
<td>glide.excel.export.limit</td>
<td>glide.ui.export.limit</td>
<td>10,000</td>
</tr>
<tr>
<td>EXCEL (XLSX)</td>
<td>glide.xlsx.max_cells</td>
<td>N/A</td>
<td>500,000</td>
</tr>
<tr>
<td>EXCEL (XLS)</td>
<td>glide.excel.max_cells</td>
<td>N/A</td>
<td>500,000</td>
</tr>
<tr>
<td>PDF</td>
<td>glide.pdf.max_rows</td>
<td>N/A</td>
<td>1,000</td>
</tr>
</tbody>
</table>

**Note:** The number of rows can be set from 0 to 5,000. If no value is specified, the default is 1,000. If a value greater than 5,000 is specified, the default value of 1,000 is used.
A warning threshold property called `glide.ui.export.warn.threshold` controls how the records are exported. If a user attempts to export a number of records from a List export that exceeds the warning threshold, a dialog box offers the choice of waiting for the export to complete or having the exported records emailed as an attachment. The warning threshold can be changed in the system property. The email attachment must not exceed the maximum allowed Email size limits.

<table>
<thead>
<tr>
<th>Example</th>
<th>Property</th>
<th>Table</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exporting to CSV</td>
<td>• glide.csv.export.limit = 20,000</td>
<td><img src="example_csv_table.png" alt="CSV Table" /></td>
<td>In the second export, the number of records returned from the database is limited because the number of records specified for export exceeds the value set in the glide.csv.export.limit property.</td>
</tr>
<tr>
<td></td>
<td>• glide.ui.export.limit = 10,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• com.glide.processors.XMLProcessor.max_record_count = 20,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default export limit for CSV = 10,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exporting to Excel (XLSX)</td>
<td>• glide.xlsx.export.limit = no entry</td>
<td><img src="example_excel_table.png" alt="Excel Table" /></td>
<td>In the second export, the number of records returned from the database is limited because the number of records specified for export exceeds the default export limit for Excel, 10,000 records.</td>
</tr>
<tr>
<td></td>
<td>• glide.ui.export.limit = no entry</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Default export limit for Excel (XLSX) = 10,000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Exporting to PDF

- glide.pdf.max_rows = 1,000
- Default export limit for PDF = 1,000
- Maximum export limit for PDF = 5,000

<table>
<thead>
<tr>
<th>Example</th>
<th>Property</th>
<th>Table</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exporting to PDF</td>
<td>• glide.pdf.max_rows = 1,000&lt;br&gt;• Default export limit for PDF = 1,000&lt;br&gt;• Maximum export limit for PDF = 5,000</td>
<td></td>
<td>In the first export, all records are returned because the number of records specified for export does not exceed the glide.pdf.max_rows property. In the second export, the number of records returned is limited because the number of records specified for export exceeds the value in the glide.pdf.max_rows property.</td>
</tr>
</tbody>
</table>

### Excel export threshold

Excel exports are intended for relatively small exports, fewer than 500,000 cells, while CSV can handle larger exports.

Whenever you export to Excel and the resultant spreadsheet has more than 500,000 cells (by default), the export process stops and you are given the Excel file at that point. In the bottom row, there will be the following message: Export stopped due to excessive size. Use CSV for a complete export:

| A | B | C       | D       | E
|---|---|---------|---------|---
| 1 | Table | Column name | Text index | Calculated | Re
| 16848 | cmdb_tcp_half | sys_mod_count | FALSE | FALSE
| 16849 | cmdb_tcp_half | sys_created_on | FALSE | FALSE
| 16850 | cmdb_tcp_half | sys_created_by | FALSE | FALSE
| 16851 | | **Export stopped due to excessive size. Use CSV for a complete export.** | 
| 16852 | | | |
| 16853 | | | |

### Form export

You can export a form data in a variety of formats.

Export formats include:
- PDF (Portrait)
- PDF (Landscape)
- **XML (This Record)**

Export an individual record from a form by right-clicking a form header bar and selecting the export type.

**Note:** When exporting PDF data from a form, only the fields that are visible from the current view are exported, with the exception of formatter elements. When exporting XML data, however, all the fields are exported, regardless of the view. You cannot export records to CSV or Excel from a form.

When exporting to XML, a dialog box may prompt you to save the file, or the browser may automatically save the XML file to the downloads folder specified in the browser preferences.

**List export**

You can export a list of records in a variety of formats.

The Export option is available in the column heading context menu in List v2. In List v3, it is available in the list title menu.
Export from a v2 list

**Note:** To export records in an embedded list, export the record containing the list.

Export formats include:

- Excel
- CSV
- XML
- PDF (Portrait)
- PDF (Landscape)
- PDF (Detailed Portrait): Exports the list and the associated form for each record.
- PDF (Detailed Landscape): Exports the list and the associated form for each record.

**Note:** You can control how line breaks appear in exported CSV data using the `glide.csv.export.line_break` system property.

**Note:** To remove unwanted HTML tags from list data, see the blog [Rendering HTML in Exported Lists](https://community.servicenow.com/app/home/articles/3114) by a ServiceNow employee in the Now Community.

When exporting to XML, a dialog box may prompt you to save the file, or the browser may automatically save the XML file to the downloads folder specified in the browser preferences.

**Determining which list fields are exported**

By default, exporting data from a list exports only the fields that are visible from the current view.

By default, exporting data from a list exports only the fields that are visible from the current view. If you want to export fields from another list view, you can switch views from the UI. Alternatively, you can add the `sysparm_view` parameter to the URL request. For example, to export fields visible from the Self Service (ess) view:

```
https://instance_name.service-now.com/incident.do?CSV&sysparm_view=ess
```
If you are exporting CSV or Excel data and do not specify a view, the export uses the default list view. You can export all fields by setting the `sysparm_default_export_fields` parameter to all. If you are exporting XML data, the export returns all fields unless you specify a particular view. The `sysparm_default_export_fields` parameter has no effect on XML exports.

**Use a URL query to filter a list result**

Use URL queries to programmatically generate filtered lists before exporting them.

URL queries are useful for scripts that generate a list of records and where no user will manually add the filter from the UI. You must be familiar with the table's column names and values to create a query.

1. Specify the instance URL. For example, https://demo.service-now.com/.
2. Specify the list URL for the table you want to export. For example, incident_list.do.
3. Specify the export format processor for the export. For example, ?XML.
4. Specify the query as the value of the `sysparm_query` parameter. For example, ?sysparm_query=priority=1.
5. Optional: Specify the result sort order with the `sysparm_orderby=` parameter. For example, CSV&sysparm_orderby=assigned_to.

**Note:** All queries use a column name, an operator, and a value. See [Condition Builder](#) for a list of available operators.

For example, to export a list of all priority 1 incidents as an XML file, use the following URL: https://<instance name>.service-now.com/incident_list.do?XML&sysparm_query=priority=1&sysparm_orderby=assigned_to

### Exporting currency fields to Excel

Exporting currency fields to Excel applies Account formatting and can be configured to convert all values to US dollars.

When exporting currency fields to Microsoft Excel, the cells containing currency data use Accounting formatting. This formatting allows you to perform numeric operations on those values as well as view the currency symbol, such as $ or €.

When exporting currency fields the type of currency, such as $ or €, is preserved by default. The conversion rates for non-USD currencies are stored on the Exchange Rates (fx_rate) table.

You can choose to export all currency values either in US dollars or in the user's session currency.

- To export all currency values in US dollars, set the property `glide.excel.fixed_currency_usd` to true.
- To export all currency values in the user's session currency, set the property `glide.excel.convert_to_user_currency` to true.

If both `glide.excel.fixed_currency_usd` and `glide.excel.convert_to_user_currency` are set to true, `glide.excel.fixed_currency_usd` overrides `glide.excel.convert_to_user_currency`.

### Currency export behavior and symbols

The behavior of the currency field in Excel depends on the **Symbol** of the currency.

- When the currency symbol is $, the Excel cell type is set as Currency.
- When the currency symbol is one character (such as ¥ or ₩) or more than 1 character (such as KR), the Excel cell type is set to Custom.
Export directly from a URL

You may want to export data from the URL if you need to dynamically export data from a script or web service.

You must be familiar with the ServiceNow table and column names to export data directly from the URL. See URL schema for more information about navigating to forms and lists.

Query parameters are available for you to use in the instance URL so you can display a specific list of records in a specific order:

<table>
<thead>
<tr>
<th>URL Parameter</th>
<th>URL Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_query</td>
<td>sysparm_query=(column name) (operator)(value)</td>
<td>Displays a list of records that match the query. For example: https://&lt;instance name&gt;.service-now.com/ incident_list.do? XML&amp;sysparm_query=priority=1</td>
</tr>
<tr>
<td>sysparm_orderby</td>
<td>sysparm_orderby=(column name)</td>
<td>Sorts a list of records by the column name provided. For example: https://&lt;instance name&gt;.service-now.com/ incident_list.do? XML&amp;sysparm_query=priority=1&amp;sysparm_orderby=assigned_to</td>
</tr>
</tbody>
</table>

You can sort by only one column using sysparm_orderby. To sort by multiple columns, use sysparm_query=ORDERBY(column name)^ORDERBY(column name). For example: sysparm_query=ORDERBYassigned_to^ORDERBYpriority.

To export data directly from the URL, create a URL containing the following parts:

1. Specify the instance URL. For example, https://<instance name>.service-now.com/.
2. Specify the table form or list to export. For example, incident_list.do.
3. Specify the export format processor to use for the export. For example, ?CSV.
4. Optional: Specify a query and sort order with URL parameters. For example, &sysparm_query=sys_id%3E%3Db4aedb520a0a0b1001af10e278657d27.

The final URL should look like one of these sample URLs:

<table>
<thead>
<tr>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>https://&lt;instance name&gt;.service-now.com/incident_list.do?CSV&amp;sysparm_query=sys_id%3E%3Db4aedb520a0a0b1001af10e278657d27</td>
<td>Export a particular incident to a comma-separated value text file.</td>
</tr>
<tr>
<td>https://&lt;instance name&gt;.service-now.com/incident_list.do?CSV&amp;sysparm_orderby=sys_id</td>
<td>Export all incidents to a comma-separated value text file and sort the list by sys_id.</td>
</tr>
</tbody>
</table>
Note: ServiceNow enforces basic authentication for direct URL access. The data extracted from the URL contains only the fields to which the currently authenticated user has read access.

Call URL export programmatically
You can dynamically export data from a script or web service by calling a URL export from any programming language.

The following procedure includes code samples that demonstrate calling a URL export in C# for a .Net framework call:

1. Add the following Imports:

   ```csharp
   using System.Net;
   ```
using System.IO;

2. Call the Download method:

```csharp
static void Main(string[] args)
{
    // Call to DownloadFile method supplying the URL and location to
    // save CSV file locally
    int read = DownloadFile("https://<instance>.service-now.com/incident_list.do?
        CSV&sysparm_query=priority=1&sysparm_orderby=assigned_to",
        "c:\\test\\incident.csv");
}
```

3. Create a Download method as follows:

```csharp
public static int DownloadFile(String url,
                               String localFilename)
{
    // Function will return the number of bytes processed
    // to the caller. Initialize to 0 here.
    int bytesProcessed = 0;
    // Assign values to these objects here so that they can
    // be referenced in the finally block
    Stream remoteStream = null;
    Stream localStream = null;
    WebResponse response = null;
    // Use a try/catch/finally block as both the WebRequest and
    Stream
    // classes throw exceptions upon error
    try
    {
        // Create a request for the specified remote file name
        WebRequest request = WebRequest.Create(url);
        // Create the credentials required for Basic Authentication
        System.Net.ICredentials cred = new
            System.Net.NetworkCredential("user_name", "password");
        // Add the credentials to the request
        request.Credentials = cred;
        if (request != null)
        {
            // Send the request to the server and retrieve the
            // WebResponse object
            response = request.GetResponse();
            if (response != null)
            {
                // Once the WebResponse object has been retrieved,
                // get the stream object associated with the
                response's data
                remoteStream = response.GetResponseStream();
                // Create the local file
                localStream = File.Create(localFilename);
                // Allocate a 1k buffer
                byte[] buffer = new byte[1024];
                int bytesRead;
                // Simple do/while loop to read from stream until
                // no bytes are returned
                do
                {
                    // Read data (up to 1k) from the stream
                    bytesRead = remoteStream.Read(buffer, 0,
                        buffer.Length);
                    bytesProcessed += bytesRead;
                } while (bytesRead > 0);
            }
        }
    }
    finally
    {
        // Close the file
        if (localStream != null)
            localStream.Close();
        // Close the remote stream
        if (remoteStream != null)
            remoteStream.Close();
        // Close the response, if there is one
        if (response != null)
            response.Close();
    }
    return bytesProcessed;
}
```
// Write the data to the local file
localStream.Write(buffer, 0, bytesRead);
// Increment total bytes processed
bytesProcessed += bytesRead;
} while (bytesRead > 0);
}
}
catch (Exception e)
{
    Console.WriteLine(e.Message);
}
finally
{
    // Close the response and streams objects here
    // to make sure they're closed even if an exception
    // is thrown at some point
    if (response != null) response.Close();
    if (remoteStream != null) remoteStream.Close();
    if (localStream != null) localStream.Close();
}
// Return total bytes processed to caller.
return bytesProcessed;

---

### Break up a large export

If the number of records to be exported exceeds the actual export limit, you may want to break the export into smaller increments that do not place a significant performance load on the platform.

1. **Filter the list** to display the records you want to export.
2. Write down the number of records returned.
3. If the record number is higher than the defined threshold, issue a `sysparm` query for the first 10,000 records using the following syntax:

   ```
   https://<instance name>.service-now.com/syslog_list.do?XML&sysparm_orderby=sys_id&sysparm_record_count=10000
   ```

   This exports the first 10,000 records in order, sorted by the `sys_id` number.
4. Find the next record in order, such as 10,001.
5. Right-click the row and copy the `sys_id` of the next record you want to export.
6. Access the next series of records with a greater than or equal to query run against the `sys_id` of record 10,001.

   ```
   https://<instance name>.service-now.com/syslog_list.do?XML&sysparm_query=sys_id%3E%3Db4aedb520a0a0b1001af10e278657d27&sysparm_orderby=sys_id&sysparm_record_count=10000
   ```

   **Note:** URL queries use typical **percent encoding**. In this example, the greater than sign (`>`) is encoded as `%3E` and the equal sign (`=`) is encoded as `%3D`.
7. Continue issuing this query, using the starting `sys_id` for the next set of records until you have exported all the necessary records.

---

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Enable export debug logging

When the property glide.export.debug is true, the instance logs export processing including database query time and the time taken to write data to the file.

When the property glide.export.debug is true, the instance logs export processing including database query time and the time taken to write data to the file. Debug logs are indicated by the text Export API. Prolonged use of this property can affect performance, so it is best to use it while debugging export processing, and then set the property back to false.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Level</th>
<th>Message Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/17/14</td>
<td>15:53:48</td>
<td>500</td>
<td>Maximum record count for this instance is: 10000; request is for: 0 Cap the Record count to Maximum Record Count</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:48</td>
<td>522</td>
<td>Export API - ExportProcessor :Processing EXCEL export request, ExportParameters: TableName=incident, Query=active=true, Limit=10000, SortBy=null</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:48</td>
<td>527</td>
<td>Export API - ExportProcessor : Export using background thread</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:48</td>
<td>528</td>
<td>Export API - ExportProcessor : Processing EXCEL export request, ExportParameters: TableName=incident, Query=active=true, Limit=10000, SortBy=null</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:48</td>
<td>529</td>
<td>Export API - ExportProcessor : Export using background thread</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:48</td>
<td>534</td>
<td>Export API - ExcelExporter : 29 rows retrieved from database duration_milliseconds=2</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:49</td>
<td>534</td>
<td>NONE New transaction</td>
</tr>
<tr>
<td>07/17/14</td>
<td>15:53:49</td>
<td>544</td>
<td>Export API - ExcelExporter : Rows written to file duration_milliseconds=1150</td>
</tr>
</tbody>
</table>

Import an XML file

After you have successfully exported data from the source instance, you can import the XML file directly to the target instance.

Role required: admin

Importing XML does not trigger business rules or update the instance cache.

1. Sign in to the target instance (the instance that should receive the data).
2. In the banner frame, click the Elevate privileges icon (🔒) beside the user name.
3. In the Activate an Elevated Privilege dialog box, select the security_admin check box and click OK.
4. Navigate to any list in the system. Any list can be used because the XML file contains the destination table name for the records.

5. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Open any column context menu and select Import XML.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select Import XML.</td>
</tr>
</tbody>
</table>

6. In the import screen, click **Choose File** and select the previously exported XML file.

7. Click **Upload**.

---

**Note:** If the data does not import, navigate to **System Definition > Tables & Columns** and verify that the table from which the data was exported also exists in the instance importing the data. If the table does not exist in that instance, you can move it using an update set.
Export sets

Export sets allow you to push data from an instance to an external file. You can export data to a remote system using a MID Server.

**Note:** You must use a MID Server from the Geneva release or later. Earlier MID Server releases do not support export sets. Export sets are not supported on MID Servers in a cluster.

Create an export set

Create an export set to export records from your instance to a file on a MID Server.

Role required: export_set_admin

**Note:** Export sets do not export attachments to records. To download an attachment, either use the REST Attachment API (HTTP request originates from a third-party HTTP client), or use the outbound REST Message module to send the attachment from the instance (HTTP request originates from the instance).

1. Navigate to **System Export Sets > Create Export Set**.
2. Enter a descriptive **Name** for the export set.
3. In the **What to export** section, define what data to export in one of these ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Yes and select an Export Definition record.</td>
<td>Use this configuration if you have already created an export definition record specifying what data to export.</td>
</tr>
<tr>
<td>Select No and select a table to export data from.</td>
<td>Use this configuration if you have not created an export definition record. A new export definition record is created automatically using the selected table that includes fields from the default list view for that table. You can modify the export definition record as needed after creating the export set.</td>
</tr>
</tbody>
</table>

4. In the **Where to export to** section, define where you want to export data to in one of these ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Yes and select an Export Target record.</td>
<td>Use this configuration if you have already created an export target record specifying where to export data to.</td>
</tr>
<tr>
<td>Select No and select a MID Server, and specify a path on the MID Server to save the exported data to.</td>
<td>Use this configuration if you have not created an export target record. A new export target record is created automatically for the selected MID Server and file path. You can modify the export target record as needed after creating the export set.</td>
</tr>
</tbody>
</table>

5. **Click Submit**.

After creating the export set, the Export Set form appears. You can configure advanced options from the form such as specifying a data format or scheduling recurring exports.
Export Set form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this export set.</td>
</tr>
<tr>
<td>File name</td>
<td>Enter a name for the target file.</td>
</tr>
<tr>
<td>Format</td>
<td>Select the format of the target file, such as CSV.</td>
</tr>
<tr>
<td>Append timestamp</td>
<td>Select this check box to append the current date and time to the name of the exported file.</td>
</tr>
<tr>
<td>Export definition</td>
<td>Select the export definition that specifies the data to export.</td>
</tr>
<tr>
<td>Export target</td>
<td>Select the export target that specifies the location you want to export to.</td>
</tr>
</tbody>
</table>

Create an export set from a list

You can quickly create an export set from a list.

Role required: export_set_admin

1. Navigate to a list of records.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click the list header and select Export &gt; Export Set.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and click Export, and then click Export Set.</td>
</tr>
</tbody>
</table>

The Export Set form appears. An export definition is created automatically based on the list.

3. Configure the export set as needed.
4. Click Submit.

Create an export definition

Create an export definition to define what data to export in an export set.

Role required: export_set_admin

An export definition specifies the data to be exported in an export set. This data includes a table, one or more fields, and optionally a filter to limit the included records.

1. Navigate to System Export Sets > Export Definition.
2. Click New.
3. Enter a descriptive Name for the export definition.
4. Select the Table to export data from.
5. Select one or more Fields from the selected table to export data from.
6. Optional: Specify a Filter to export only certain records from the selected table.

Specifying a filter condition on the Created (sys_created_on) or Updated (sys_updated_on) fields may prevent scheduled data exports from using delta exports functionality. Do not specify filter conditions on these fields if you intend to use scheduled delta exports.
Create an export target

Define where to export data to by creating an export target.

Role required: export_set_admin

You must use a MID server as the export destination.

Navigate to **System Export Sets > Export Targets** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the export target.</td>
</tr>
<tr>
<td>MID Server</td>
<td>Select the MID Server to export to. The MID Server must have a <strong>Validated</strong> value of Yes and a <strong>Status</strong> value of Up.</td>
</tr>
<tr>
<td>File Path</td>
<td>Specify a path relative to the MID Server directory to save the exported data to. The user account used to run the MID Server must have permission to write to this location.</td>
</tr>
</tbody>
</table>

Export set supported file types

Export sets support multiple file types for exporting and pushing data.

**File types**

You can export to these formats:

- CSV
- XML
- Excel
- JSON

Schedule an export

You can schedule an export to regularly push data from an export set to a remote destination. By setting up a recurring, scheduled export you are able to regularly push data to an external location, such as for reporting or for preserving a snapshot of the data.

Role required: export_set_scheduler or export_set_admin
You can configure scheduled export sets to export only new or changed records using delta exports.

1. Navigate to **System Export Sets > Scheduled Exports**.
2. Click **New**.
3. Fill in the following fields.

### Schedule Data Export fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for this scheduled export.</td>
</tr>
<tr>
<td>Export set</td>
<td>Select the export set to schedule.</td>
</tr>
<tr>
<td>Run as</td>
<td>Select the user to run the scheduled export as. Ensure the user has any roles needed to view the data to export.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the frequency for scheduled export.</td>
</tr>
<tr>
<td>Day</td>
<td>Select which day of the week or month to run this scheduled export on. This field appears when the <strong>Run</strong> field is set to <strong>Weekly</strong> or <strong>Monthly</strong>.</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Enter the number of days and hours to wait before repeating this scheduled export. This field appears when the <strong>Run</strong> field is set to <strong>Periodically</strong>.</td>
</tr>
<tr>
<td>Time</td>
<td>Enter the time of day to run the scheduled export.</td>
</tr>
<tr>
<td>Delta Exports</td>
<td></td>
</tr>
<tr>
<td>Enable delta exports</td>
<td>Select this check box to enable delta functionality for this scheduled export. When selected, only new or changed records are exported.</td>
</tr>
<tr>
<td>Delta on or after</td>
<td>Select <strong>Updated</strong> to export all records that changed since the last export, including new records. Select <strong>Created</strong> to export only new records created after the last export.</td>
</tr>
<tr>
<td>Last export scheduled run</td>
<td>Leave this field blank to export all records from the export definition. When using delta exports, this field is set automatically each time the scheduled export runs. Records updated or created after this date and time are included in the export delta, depending on the <strong>Delta on or after</strong> value.</td>
</tr>
</tbody>
</table>

**Note:** If the export definition already includes a filter condition on the **sys_updated_on** or **sys_created_on** fields, enabling delta exports will prevent you from saving the scheduled data export record. An error appears at the top of the form in this event.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional</td>
<td>Select this check box to run the schedule only when a condition is met.</td>
</tr>
<tr>
<td>Condition</td>
<td>Write the script to be used to evaluate whether the export should run. This field is visible if you select the Conditional check box.</td>
</tr>
<tr>
<td>Execute pre-export script</td>
<td>Select this check box to run a script before the export begins.</td>
</tr>
<tr>
<td>Pre script</td>
<td>Write the script you want to run before the data is exported. This field is visible if you selected the Execute pre-export script check box.</td>
</tr>
<tr>
<td>Execute post-export script</td>
<td>Select this check box to run a script after the export finishes.</td>
</tr>
<tr>
<td>Post script</td>
<td>Write the script you want to run after the export finishes. This field is visible if you selected the Execute post-export script check box.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

You can click the **Execute Now** button to run the export immediately and confirm the data is exported as expected.

**Scheduled export set scripting options**

When scheduling an export set, you can access certain JavaScript objects.

Use these objects in scheduled export set scripts, such as the **Pre-script** and **Post-script** fields.

**cancel**

Set this object to true to stop the export action. Any child export sets are also cancelled if the parent is cancelled. This object is available only in the **Pre-script** field.

**Example**: Use the **Pre-script** field to evaluate the conditions of the export and determine whether to cancel the export process. To cancel the export process, use the following call:

```javascript
cancel = true;
```

**export_set**

Get the GlideRecord object for the new export set. This variable allows you to query the following columns from the sys_export_set table:

- name
- sys_id
- state
- table_name

This object is available in both the **Pre-script** and **Post-script** fields.
Example: If you want to use information from the export set, you can specify one of the properties of the export_set variable.

```plaintext
var x = export_set.sys_id;
```

Export set history

An export set history record is automatically created whenever an export set runs, either scheduled or manually started by a user. Export set history records allow you to monitor and troubleshoot the progress of export sets.

Fields on the Export History form display the current status of the export set. The Export Log related list shows a detailed list of changes to the export set status.

### Export History form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export set</td>
<td>The export set that was run.</td>
</tr>
<tr>
<td>Started</td>
<td>The date and time the export started.</td>
</tr>
<tr>
<td>Completed</td>
<td>The date and time the export completed.</td>
</tr>
<tr>
<td>Export time</td>
<td>The amount of time it took to export the data, excluding the time it took to transfer the data to the target.</td>
</tr>
<tr>
<td>Run time</td>
<td>The amount of time it took to export the data, including the time it took to transfer the data to the target.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the export.</td>
</tr>
<tr>
<td>Delta export</td>
<td>The export used delta export functionality if this check box is selected.</td>
</tr>
<tr>
<td>ECC queue</td>
<td>The ECC Queue record associated with this export set run. This field is visible only to users with the admin role.</td>
</tr>
<tr>
<td>MID Server Attachment</td>
<td>A MID Server attachment record containing a copy of the exported file. The exported file is attached to this record in addition to being saved on the MID Server.</td>
</tr>
</tbody>
</table>

The **State** field may have the following values.

### States

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exporting</td>
<td>The export set is creating a file with the data to export.</td>
</tr>
<tr>
<td>MID Server Processing</td>
<td>The export set successfully created a file with the data to export. The file is being processed by the MID Server.</td>
</tr>
<tr>
<td>Completed</td>
<td>The export set successfully ran and sent the exported file to the target.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Completed wth errors</td>
<td>The export set ran, but encountered one or more errors.</td>
</tr>
<tr>
<td>Cancel requested</td>
<td>A user requested that the export set be cancelled.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The export set was cancelled.</td>
</tr>
</tbody>
</table>

**Cancel an export set**

You can cancel a running export set to stop the data from being sent to a MID server.

Role required: export_set_admin

You can cancel only exports that have not yet been sent to a MID server. You cannot cancel an export after it reaches the **MID Server Processing** state.

1. Navigate to **System Export Sets > Export Sets**.
2. Select an export set.
3. In the **Export Histories** related list, select a record with the **State** value of **Exporting**.
4. Click **Cancel Export Set**.

**Export Set properties**

These properties control the behavior of export sets.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.scheduled_export.stop_on_parent_error</td>
<td>When true, if a parent scheduled export set encounters an error, scheduled child export sets do not run. This property is false by default.</td>
</tr>
</tbody>
</table>

**Import sets**

Import sets allow administrators to import data from various data sources, and then map that data into ServiceNow tables.

**Explore**
- Import and Export release notes
- Upgrade to Jakarta
- Import Sets key concepts

**Set up**
- Create a data source
- Create a transform map

**Administer**
- Import Sets properties
- Troubleshoot import set performance

**Develop**
- Developer training
- Developer documentation
- Field map script variables
- Scheduled data import scripting options

**Integrate**
- Web service import sets
- Importing from another ServiceNow instance
- Apply CI Identification and Reconciliation to Import Sets

**Troubleshoot and get help**
Import Sets key concepts

Learn about Import Sets before importing data to your instance.

The Import Sets table acts as a staging area for records imported from a data source.

**Note:** Data should not be imported in extremely large chunks. Creating an extremely large import set can cause delays and system outages.

A transform map determines the relationships between fields displaying in an Import Set table and fields in an existing ServiceNow table, such as the Incidents or Users table.

Importing sets will skip records when the data in the instance matches the data being imported.

**Note:** Import Sets run as user System. Therefore, Import Sets cannot add data to encrypted fields.

Terminology

**Key terms**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Set table</td>
<td>A table that acts as a staging location for records imported from a data source prior to transforming those records. Fields on these tables are generated automatically based on imported data and should not be modified manually.</td>
</tr>
<tr>
<td>Data source</td>
<td>A record that defines where to get the data to import. A data source may point to a file, a JDBC-compatible database, or an LDAP organizational unit.</td>
</tr>
<tr>
<td>Transformation</td>
<td>The conversion of data from an import set table to another table according to the rules defined in a transform map.</td>
</tr>
<tr>
<td>Transform map</td>
<td>A set of field maps that define the relationships between fields in an import set and fields on a table, such as Incident.</td>
</tr>
<tr>
<td></td>
<td>During transformation, data is copied from the Import Set table to the destination table based on the transform map.</td>
</tr>
<tr>
<td></td>
<td>A single import set field may be mapped to multiple fields on other tables.</td>
</tr>
</tbody>
</table>
Foreign record insert

A foreign record insert occurs when an import makes a change to a table that is not the target table for that import. This happens when updating a reference field on a table. For example when updating a value for the caller on an incident the import is actually updating the sys_user table.

### Supported import formats

You can import data from several different file formats or external data sources.

#### File formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>CSV files must comply with the proposed CSV standard in <a href="https://tools.ietf.org/html/rfc4180">RFC4180</a>. In particular, this means that double quotes may not appear inside fields. The first row of data in an imported CSV file becomes the header row and defines the columns for that import set.</td>
</tr>
<tr>
<td>Excel</td>
<td>Excel files must have the XLS or XLSX extension.</td>
</tr>
<tr>
<td>XML</td>
<td>XML files must have a consistent XPath for each data row. If you are trying to load an update set XML file, see <a href="#">Load customizations from an XML file</a>.</td>
</tr>
</tbody>
</table>
| JSON   | - For JSON arrays, the path for each row must specify the array root element twice, such as /incidents/incidents.  
- JSON files should follow RFC-4627. For example, a single comma should separate a value from the following name. Names within an object should be unique.  
- Predicates such as @element, [index], or text(), as well as Axis such as children, siblings, or ancestors are not supported.  

For examples of various JSON formats, see [Importing JSON files](#). |

ServiceNow can import data from the following external data sources.

#### External data sources

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC</td>
<td>Some network configurations may require a MID Server.</td>
</tr>
<tr>
<td>LDAP</td>
<td>LDAP imports require a valid transform map.</td>
</tr>
</tbody>
</table>
Import set scheduled cleanup

The Import Set Deleter scheduled job cleans up old import set data every day at midnight. By default, the job will delete all import sets that are older than 7 days and the associated import set table records. If this scheduled job is not active on your instance, activate it to mitigate the growing import set tables that you may have, especially when using recurring imports.

**Note:** If scheduled cleanup is not currently active on your system, you must ensure that your import set tables are not too big (> 5 million records total across all tables) before enabling this cleanup. If the tables are too big, manually delete the records first before proceeding. Please contact ServiceNow Technical Support to coordinate the deletion of this data.

Data sources

Data sources are used to create an import set so that data can be processed, if necessary, prior to being mapped onto a production table.

**Data Source Types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Data is in a recognized file format, accessible locally or remotely through several file retrieval methods.</td>
</tr>
</tbody>
</table>
### Type data sources

You can import a file from a local source, a remote network server, or another instance by providing a path and authentication information.

For file type import sets, you can select from a list of file retrieval methods, including FTP, FTPS, SCP, and HTTPS.

**Note:** FTPS is not recommended because it is no longer supported by some firewall vendors. Consider using SFTP as an alternative.

### File retrieval methods

The following file retrieval methods are available to copy the file from where it resides to ServiceNow to be loaded into an import set.

After defining the files that are compatible for importing, define how the files can be imported.

**Note:** For the import to succeed, your FTP server and client must be set up for the same authentication mechanism that you select here. Refer to the following article for an explanation of FTP protocol support [http://en.wikipedia.org/wiki/FTPS](http://en.wikipedia.org/wiki/FTPS).

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>Attach a file to the record and import that file in an import set.</td>
</tr>
<tr>
<td>SFTP</td>
<td>Retrieve a file using SFTP. Fields are provided for the server name and login credentials.</td>
</tr>
<tr>
<td>FTP</td>
<td>Retrieve a file from an FTP server in your network. Fields are provided for the server name and login credentials. <strong>Note:</strong> FTP transfers are sent as clear text and cannot be encrypted. Use SCP or SFTP instead whenever possible.</td>
</tr>
<tr>
<td>FTPS (Auth SSL) (not recommended)</td>
<td>Not recommended because FTPS is no longer supported by some firewall vendors. Consider using SFTP as an alternative. An FTP Secure authentication command issued through the Secure Socket Layer (SSL) protocol. This method is also known as explicit FTP over SSL.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FTPS (Auth TLS) (not recommended)</td>
<td>Not recommended because FTPS is no longer supported by some firewall vendors. Consider using SFTP as an alternative. An FTP Secure authentication command issued through the Transport Layer Security (TLS) protocol. This method is also known as explicit FTP over TLS.</td>
</tr>
<tr>
<td>FTPS (Implicit SSL) (not recommended)</td>
<td>Not recommended because FTPS is no longer supported by some firewall vendors. Consider using SFTP as an alternative. In implicit security, the FTPS server defines a specific port for the client (990) to use for secure connections. Implicit security automatically begins with an SSL connection the moment an FTPS client connects to an FTP server.</td>
</tr>
<tr>
<td>FTPS (Implicit TLS) (not recommended)</td>
<td>Not recommended because FTPS is no longer supported by some firewall vendors. Consider using SFTP as an alternative. In implicit security, the FTPS server defines a specific port for the client (990) to use for secure connections. Implicit security automatically begins with a TLS connection the moment an FTP client connects to an FTP server.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Retrieve a file using <strong>HTTP</strong>. Fields are provided for the server name and login credentials. <strong>Important:</strong> For HTTP and HTTPS protocols, the file path is automatically URL encoded. Do not specify a URL-encoded file path when using either of these protocols.</td>
</tr>
<tr>
<td>HTTPS</td>
<td>Retrieve a file using <strong>HTTPS</strong>. Fields are provided for the server name and login credentials. Use this method to transfer data between ServiceNow instances.</td>
</tr>
<tr>
<td>SCP</td>
<td>The <strong>Secure Copy protocol (SCP)</strong> securely transfers files between a local and a remote host or between two remote hosts, using the Secure Shell (SSH) protocol.</td>
</tr>
</tbody>
</table>

**File data source examples**

These examples describe how to import various file types as data sources.

**Excel data source file**

You can import using both the XLSX format, and the legacy XLS format. XLS is the default format for spreadsheets created in Excel for versions 2003 and older. XLSX is the default format for Excel 2007 or later. Use XLSX instead of legacy XLS whenever possible for optimal performance.
**Note:** All .xls files must use the 1900 date system as opposed to the 1904 date system. The 1904 date system causes your dates to be imported with a year that is four years earlier than what appears in your spreadsheet. Refer to MS Support for additional information about date systems.

---

**XML data source file**

XML data source definitions have an extra field to specify the **XPath for each row**. This field is an **XPath** expression to select the elements whose children are converted to rows in the import set table. Each selected element causes a row to be created in the import set table. The children of the selected element are converted into columns in the row. For example, to import the asset information from the sample XML file below, the XPath expression should be specified as `/export/asset`. This expression matches the three `<asset>` elements in the file, so three rows are created. Although you could also specify `//asset`, this expression is much less efficient for large files. Use the absolute location path form for XPath expressions when using the XML loader. In other words, avoid expressions containing `//` unless strictly necessary.

Be careful not to specify an insufficiently restrictive XPath expression with a large XML file. For example, the expression `/export` would be wrong for the following sample file, since it matches the document (root) element. In general, you should never specify an XPath expression which matches the root element unless you want everything in the document to be made into a single row. Specifying an insufficiently restrictive XPath expression when attempting to load large XML files could result in lengthy processing times and incorrect output. For this reason, it is best to test and debug XML data source specifications with small XML files containing only a few rows worth of data. Once the specification has been tested, you can run it again with the full file.
Notice that the `<userInfo>` elements contained within `<asset>` contain child elements. This type of nesting creates a column called `userInfo` that contains XML for the `<userInfo>` element. If `Expand child nodes` is checked, individual columns are also created for `userInfo/lastName` and `userInfo/firstName`. If `Expand child nodes` is not checked, only the `userInfo` XML column is created.

When loading data from an XML file, ServiceNow samples the first 10 records to determine what fields are required to hold the data. If none of the first 10 records specify a value for a field, ServiceNow does not add that field to the table that holds the imported data. Ensure that at least one of the first 10 records specifies a value for any fields being imported.

If the XML file used for an XML data source does not contain a field in the first 10 nodes, the field is ignored. To import the field and ensure it is not ignored, you can add the `glide.db.impex.XMLLoader.max.scan_nodes` system property with a value greater than or equal to the position of the node where the field is first encountered. This property applies to all XML data sources. `glide.db.impex.XMLLoader.max.scan_nodes` defaults to 10, but you can enter a value from 1 to 2147483647 to specify how many nodes should be scanned to determine the values to be used for the import. You can specify -1 to scan all nodes in the XML files.

```
<?xml version= "1.0" encoding= "utf-8" ?>
<export>
<asset><assetTag>AT-01939</assetTag><type>Desktop</type><os>Windows 7 Professional</os><lastlogondate>12-07-2010 12:31:24</lastlogondate><userInfo><lastName>Loo</lastName><firstName>David</firstName></userInfo><isenabled>true</isenabled></asset><asset><assetTag>AT-53480</assetTag><type>Desktop</type><os>Windows 7 Professional</os><lastlogondate>09-07-2010 13:25:53</lastlogondate><userInfo><lastName>Merritt</lastName><firstName>Norris</firstName></userInfo><isenabled>true</isenabled></asset><asset><assetTag>AT-55782</assetTag><type>Desktop</type><os>Unknown</os><lastlogondate>01-01-1900 00:00:00</lastlogondate><userInfo><lastName>Currie</lastName><firstName>Mike</firstName></userInfo><isenabled>true</isenabled></asset></export>
```

### CSV data source file

CSV files are used as a cross-compatible file format for transferring files across platforms. A CSV file is a text file that defines a grid, where commas define columns and line breaks define rows. To define precise spacing for importing strings, you can optionally wrap text in quotes.

```
"user_name","name","email","sys_created_on","active"
"jared.laethem","Jared Laethem","jared.laethem@yourcompany.com","2008-02-24 22:21:32","true"
"jerrod.bennett","Jerrod Bennett","jerrod.bennett@yourcompany.com","2007-08-12 12:12:18","true"
"eric.schroeder","Eric Schroeder","eric.schroeder@yourcompany.com","2007-07-03 11:50:20","true"
"rob.woodbyrne","Rob Woodbyrne","rob.woodbyrne@yourcompany.com","2007-07-03 11:49:57","true"
"admin","System Administrator","admin@yourcompany.com","2007-07-03 11:48:47","true"
"christen.mitchell","Christen Mitchell","christen.mitchell@yourcompany.com","2007-05-16 15:26:42","true"
"rob.phillips","Rob Phillips","rob.phillips@yourcompany.com","2007-01-22 11:25:34","true"
"davin.czukowski","Davin Czukowski","davin.czukowski@yourcompany.com","2006-07-11 14:01:26","true"
```
When using CSV files, you can specify the encoding charset using the Properties field on the Data Source form. You may need to configure the Data Source form to see this field. For example, to use utf-8 encoding, enter `charset=utf-8`.

**Processing custom CSV files**

You can process CSV files that are delimited by a character other than commas. This is an advanced step to create a CSV import. Normally, you would upload the data and import it directly using System Import Sets, which will create this CSV data source for you automatically.

1. Create the data source record.
2. Attach the CSV file to the data source.
3. Customize the Data Source form and add the CSV Delimiter field.
4. Enter the character you want to use as the CSV file delimiter, such as the pipe symbol (`|`).
5. Test load the data source.

![Data Source form](image)

**Related Links**

- Test Load 20 Records
Importing JSON files

These examples demonstrate how to import various types of JSON data and the necessary path for each row. JSON files that you import should follow these guidelines.

- For JSON arrays, the path for each row must specify the array root element twice, such as /incidents/incidents.
- JSON files should follow RFC-4627. For example, a single comma should separate a value from the following name. Names within an object should be unique.
- Predicates such as @element, [index], or text(), as well as Axis such as children, siblings, or ancestors are not supported.

Simple array

- Path for each row: /incidents/incidents
- Result: 2 records

In this example, the path for each row includes the array root node /incidents twice, which is necessary when importing an array.

```json
{
  "source": "HI",
  "incidents": [
    {
      "number": "INC0000001",
      "short_description": "Can't read email"
    },
    {
      "number": "INC0000002",
      "short_description": "Error loading XML file"
    }
  ]
}
```

Array in 2nd level

- Path for each row: /problems/data/data
- Result: 4 records

In this example, the path for each row includes the array root node /data twice.

```json
{
  "problems": {
    "id": "0",
    "data": [
      {
        "number": "PRBTEST001",
        "short_description": "testsdl"
      },
      {
        "number": "PRBTEST002",
        "short_description": "testsd2"
      },
      {
        "number": "PRBTEST003",
        "short_description": "testsd3"
      }
    ]
  }
}
```
Nested array

- Path for each row: /problems/problems/data/data
- Result: 3 records

In this example, the path for each row includes the root nodes for both arrays twice, /problems and /data.

```json
{
  "problems": [
    {
      "id": 0,
      "data": [
        {
          "number": "PRBTEST001",
          "short_description": "testsd1"
        },
        {
          "number": "PRBTEST002",
          "short_description": "testsd2"
        },
        {
          "number": "PRBTEST003",
          "short_description": "testsd3"
        }
      ]
    }
  ]
}
```

Limited support for child (nested) arrays

There are some limitations related to importing child arrays within an array.

When an array has a simple collection of values like [1, 2, 3], there is no way to import that data in that format, regardless of where it lies in the JSON hierarchy. Here are some examples of what is and is not supported.

```json
{
  "response": {
    "docs": [
      {
        "id": "id_val",
        "childrenArray": [1, 2, 3],
        "anotherArray": [{"key1": "value1"}, {"key1": "value2"}]
      }
    ]
  }
}
```

- The /response/docs/docs path creates one record with only one column: id. Any arrays found in a record (like childrenArray or anotherArray) are not created as columns in the import table.
• The /response/docs/docs/anotherArray/anotherArray path creates two records, each with one column: key1.
• The /response/docs/docs/childrenArray/childrenArray path does not work and returns a Path should always refer JSON Objects error because the values in the array are not in a key-value structure.

There are two possible ways to adjust the format.

1. Change the array of "childrenArray":[1,2,3] to be "childrenArray ":[{"val":1}, {"val":2},{"val":3}], which creates three records.
   The downside is that you need two separate data sources, one for /response/docs/docs and another for /response/docs/docs/childrenArray/childrenArray.

2. Another option is to convert the array to a simple string: "childrenArray ":"1, 2, 3".
   This option drops the use of the array and works with the single data source. The downside is that any consumer of this data must split the string on commas.

Orphan array

**Important**: This format is not supported. A JSON array must always be inside an element. The JSON file must always start with { and end with }.

```
[
  {
    "number":"PRBTEST001",
    "short_description":"testsd1"
  },
  {
    "number":"PRBTEST002",
    "short_description":"testsd2"
  }
]
```

Multiple elements instead of an array

• Path for each row: /problems/problem
• Result: 3 records

**Important**: This format is not recommended. JSON files should follow RFC-4627, which states that names within an object should be unique. Use JSON arrays instead.

```
{
  "problems":{
    "title":"2 problems",
    "problem":{
      "number":"PRBTEST001",
      "short_description":"testsd1"
    },
    "problem":{
      "number":"PRBTEST002",
      "short_description":"testsd2"
    }
  }
}
```
FTP data source extended properties

Certain properties are available for customizing your FTP data source.

To enter these properties, you must configure the Data Source form and add the Properties field. When specifying more than one property, use a comma to separate each property.

Available FTP Properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Example custom value</th>
<th>Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection.timeout</td>
<td>Defines the number of milliseconds to wait before timing out the FTP connection attempt.</td>
<td>10000</td>
<td>connection.timeout=12000</td>
<td>FTP, FTPS</td>
</tr>
<tr>
<td>remove_file</td>
<td>Determines if the remote file is deleted after the import.</td>
<td>true</td>
<td>remove_file=false</td>
<td>FTP, FTPS, SFTP</td>
</tr>
<tr>
<td>rename_file</td>
<td>Determines if the remote file is renamed after the import. Renamed files use the format &lt;original file name&gt;.imported.</td>
<td>false</td>
<td>rename_file=true</td>
<td>FTP, FTPS, SFTP</td>
</tr>
</tbody>
</table>

JDBC type data source

A JDBC data source retrieves its data via a JDBC driver, usually type 4 network.

The JDBC connection is available either directly from the ServiceNow instance (a VPN setup required), or via a dedicated MID Server installed inside your firewall that can access the database port.

Note: JDBC calls from the MID Server are never encrypted. Limit the rights available to the MID Server user whenever making JDBC calls from a MID server.

JDBC data source supported database formats

JDBC data sources support several database formats and ports.
Supported database formats

<table>
<thead>
<tr>
<th>SQL Server Type</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td>3306</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>1433</td>
</tr>
<tr>
<td>Oracle</td>
<td>1521</td>
</tr>
</tbody>
</table>

**Note:** Oracle DATE fields are loaded as ServiceNow datetime fields.

**JDBC data source SQL statement requirements**

JDBC queries that run SQL statements must specify a column name.

For example, this query specifies the column name **ServerID**.

```sql
SELECT DISTINCT 'server_name:' + CONVERT ( VARCHAR , lg .ResourceID ) AS 'ServerID'
, LastHWScan
, Account0
, Category0
From v_GS_WORKSTATION_STATUSsInner  JOIN
v_GS_LocalGroupMembers0lg
ON s .ResourceID  = lg .ResourceID
Where Type0  = 'Local' AND Category0  = 'SystemAccount'
```

**SQL server integrated authentication for Windows**

A JDBC data source can use the ID of for the Windows MID Server service user to authenticate with SQL Server.

The **Use integrated authentication** check box on the Data Source form determines if the JDBC data source uses the MID Server service user credentials. For this field to appear on the Data Source form, the integration must meet these criteria:

- The MID Server must be running on a Windows computer with SQL Server.
- The MID Server service must use the same credentials that SQL Server requires.
- The data source **Type** is JDBC.
- The data source **Use MID Server** check box is selected.
- The data source **Format** is SQLServer.

**Important:** If integrated authentication is chosen, and you are integrating with Microsoft System Center Configuration Manager, the account running the MID Server service must have read rights on the SCCM database.
Data Source form

Name: SCCM 2012 v2 Processor
Import set table label: SCCM 2012v2 Processor
Import set table name: imp_sccm2012v2_processor
Type: JDBC
Use MID Server: Boomer1
Format: SQLServer
Instance name:
Database name: testSQL
Database port:
Adding JDBC drivers for unsupported database formats

Use the following procedure to extend the data source to use a driver for a database that is not provided in the base system. JDBC connections are supported for the following default databases:

**SQL server integrated authentication for Windows**

A JDBC data source can use the ID of for the Windows MID Server service user to authenticate with SQL Server.

The **Use integrated authentication** check box on the Data Source form determines if the JDBC data source uses the MID Server service user credentials. For this field to appear on the Data Source form, the integration must meet these criteria:

- The MID Server must be running on a Windows computer with SQL Server.
- The MID Server service must use the same credentials that SQL Server requires.
- The data source **Type** is JDBC.
- The data source **Use MID Server** check box is selected.
- The data source **Format** is SQLServer.

**Important:** If integrated authentication is chosen, and you are integrating with Microsoft System Center Configuration Manager, the account running the MID Server service must have read rights on the SCCM database.
Data Source form

ServiceNow  Jakarta  Now Platform Administration

Data Source form

ServiceNow  Jakarta  Now Platform Administration

Data Source form

ServiceNow  Jakarta  Now Platform Administration

Data Source form

ServiceNow  Jakarta  Now Platform Administration

Data Source form

ServiceNow  Jakarta  Now Platform Administration

Data Source form
Add a new JDBC format choice
Extend the available JDBC driver options by creating a new choice list entry to specify the JDBC driver Java package name.

Role required: import_admin

Add a new choice list entry for the new database to the Format field in the sys_data_source table.

1. Navigate to System Import Sets > Administration > Data Sources.
2. Click New.
3. In the Data Sources form, right-click the Format field label, and select Show Choice List from the pop-up menu.

4. Click New in the list of choices.
5. Provide the following values to create the new database choice. Look at the existing drivers for examples.
   - **Table**: `sys_data_source`
   - **Label**: Database name that appears as an option in the Format choice list, for example: Teradata.
   - **Value**: Package name and class of the driver. For example, the value for TeraData is `com.ncr.teradata.TeraDriver`. 
Note: The driver package and class must be provided by the driver vendor. This information is often available in the vendor’s documentation, such as for MariaDB or Teradata.

- Dependent value: JDBC

6. Click Submit.

The new data source now appears in the list of available JDBC formats.

Add Sybase or DB2 JDBC format choices
Extend the available JDBC driver options by activating the Sybase or DB2 choices.

Roles required: admin

Important: To use Sybase or DB2 JDBC drivers, you must manually install the driver JAR file on a MID server. Refer to KB0551236 for more information.

Activate the Sybase or DB2 JDBC drivers to connect with those database formats through a MID server. This procedure assumes you are using the following Sybase or DB2 drivers:
Drivers

<table>
<thead>
<tr>
<th>Format</th>
<th>Driver</th>
<th>Driver class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sybase</td>
<td>jconnect-jdbc</td>
<td>com.sybase.jdbc3.jdbc.SybDriver</td>
</tr>
<tr>
<td>DB2</td>
<td>db2jcc</td>
<td>com.ibm.db2.jcc.DB2Driver</td>
</tr>
</tbody>
</table>

If you are using a different implementation of the Sybase or DB2 driver, you must modify the choice Value to use the driver class from your driver implementation.

1. Navigate to System Import Sets > Administration > Data Sources.
2. Click New.
3. In the Type field, select JDBC.
4. Right-click the Format field label, and select Configure Choices from the pop-up menu.
5. Move the Sybase or DB2 Universal choices from the Available column to the Selected column.
6. Click Save.

The new data source now appears in the list of available JDBC formats.

Install a driver on a MID Server
You can install a new JDBC driver JAR file to a MID server to access database formats that are not supported by default.

Role required: agent_admin
1. Navigate to MID Server > JAR Files.
2. Click New.
3. Complete the following fields:
   - Name: A unique and descriptive name for identifying the file in the instance.
   - Version: A version number for the file, if one is available.
   - Source: Location of the JAR file for reference purposes. Source information is not used by the system.
   - Description: Short description of the JAR file and its purpose in the instance.
4. Click the paper clip icon in the banner and attach the JAR file to the record.
5. Click Submit.
6. Restart the MID Server service.

The platform makes the JAR file available to any MID Server configured to communicate with the instance.
Create a new JDBC data source for an unsupported database format
Add a new JDBC data source by defining a data source record.

Role required: import_admin

1. Navigate to System Import Sets > Administration > Data Sources and click New.
2. In the Data Source form, select JDBC from the list in the Type field.
3. Select the new data source from the choice list in the Format field.

4. Configure the form and add the Connection URL field.
5. Provide the connection URL to the JDBC data source, and then click Submit.

No other connection information is required.
LDAP type data source

An LDAP data source is automatically created when you configure your instance to integrate with LDAP.

Connection URL:
```
jdbc:teradata://gwhost:port/dbhost
```
Processing a large LDAP request without paging

When an LDAP server does not support paging, a large request is automatically broken into multiple smaller requests. This process is known as “nibbling” the LDAP request. The large request is broken into multiple smaller requests based on the value of the Query field in the LDAP OU definition. This field should specify a unique value such as email address or user ID.

For example, the following LDAP query might return more than 1000 records.

```
(&(objectclass=user)(sn=*))
```

In this example, the LDAP server Query field is preferredIdentity. The instance then splits the large request into multiple smaller requests, grouping records based on the preferredIdentity value.

```
(&(((preferredIdentity>=0)(preferredIdentity<=1)))
((&objectclass=user)(sn=*)))
```
Transform maps

A transform map is a set of field maps that determine the relationships between fields in an import set and fields in an existing ServiceNow table, such as Incident (incident) or User (sys_user).

```plaintext
&(((preferredIdentity>=1)(preferredIdentity<=2)))
((&(objectclass=user)(sn=*)))
&(((preferredIdentity>=2)(preferredIdentity<=3)))
((&(objectclass=user)(sn=*)))
...
&(((preferredIdentity>=9)(preferredIdentity<=a)))
((&(objectclass=user)(sn=*)))
&(((preferredIdentity>=a)(preferredIdentity<=b)))
((&(objectclass=user)(sn=*)))
&(((preferredIdentity>=b)(preferredIdentity<=c)))
((&(objectclass=user)(sn=*)))
```
After creating a transform map, you can reuse it to map data from another import set to the same table.

The Transform Maps module enables an administrator to define destinations for imported data on any tables. Transform mapping can be as simple as a drag and drop operation to specify linking between source fields on an import set table and destination fields on any table. Use transform mapping to map source and destination fields dynamically.

**Using multiple transform maps**

Multiple transform maps can be applied to a single data source. One import set row is created per transform map. This behavior can cause a large number of temporary records to be generated.

**Run multiple transforms off a single import set**

Users can select multiple transform maps during data import. The selected transform maps will be executed on the same import set in the order specified.

**Multi-map transform**

**Transform map scripts**

Transform Map scripts allow you to customize import operations using a robust programming interface to introduce advanced logic.
A transform map script executes as events occur while an import set is being transformed onto a ServiceNow table. Transform Map scripting is fully integrated into the ServiceNow scripting environment. There are two types of Transform Map scripts:

- Explicit Transform Map scripts, which explicitly define mapping relationships
- Transformation Event scripts, which modify the processing of events at different stages of a transformation

**Transform map scripts**

Transform Map scripts allow you to customize import operations using a robust programming interface to introduce advanced logic.

A transform map script executes as events occur while an import set is being transformed onto a ServiceNow table. Transform Map scripting is fully integrated into the ServiceNow scripting environment. There are two types of Transform Map scripts:

- Explicit Transform Map scripts, which explicitly define mapping relationships
- Transformation Event scripts, which modify the processing of events at different stages of a transformation

**Transformation script variables**

Multiple variables can be used to define explicit mapping relationships in a transform map script.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>Reference</td>
<td>JavaScript variable available during Import Set scripting that can be used to reference a field's value in the source row being processed.</td>
</tr>
<tr>
<td>target</td>
<td>Assignment</td>
<td>JavaScript variable available during Import Set scripting that can be used to assign a field's value to the current target row being processed.</td>
</tr>
</tbody>
</table>

```
var x = source.incident_state;

target.incident_state='active';
```
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| map           | Reference | Read-only information about the current transform map record. This variable supports querying the following columns from the `sys_transform_map` table.  
· name  
· sys_id  
· source_table  
· target_table  
· order |

```javascript
var x = map.order;
```

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| log           | Function | Log object for the current import run. For example,  
log.info( STRING ),  
log.warn( STRING ),  
log.error( STRING ). |

```javascript
log.info("An error has occurred");
log.warn("An error has occurred");
log.error("An error has occurred");
```

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>action</td>
<td>Function</td>
<td>Returns a value of either 'insert' or 'update' indicating whether the current target row is about to be created or updated.</td>
</tr>
</tbody>
</table>

```javascript
if(action =="insert")
    ignore =true;
```

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ignore</td>
<td>Flag</td>
<td>True = in onStart scripts, causes the entire transformation process to be skipped. Setting it to true in onBefore scripts causes the current row transformation to be skipped, and continues to process the remaining rows. Default is &quot;false&quot;.</td>
</tr>
</tbody>
</table>

```javascript
if(source.u_user_name.nil()){
    ignore = true;
}
```
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Flag</td>
<td>True = causes the current import row to stop processing at any stage in processing and registers an error in the Import Set Log. Default is “false”.</td>
</tr>
</tbody>
</table>

```java
if(source.name=="no_transform")
    error = true;
```

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error_message</td>
<td>String (output message)</td>
<td>When an error occurs, setting this value to a customized string value causes the SOAP response to contain an optional <code>error_message</code> field to be returned.</td>
</tr>
</tbody>
</table>

```java
error_message = "ignore this error"
```

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status_message</td>
<td>String (output message)</td>
<td>Setting this value to a customized string value will cause the SOAP response to contain an optional <code>status_message</code> field to be returned.</td>
</tr>
</tbody>
</table>

```java
status_message = "web service processed"
```

**Map with explicit transform map scripts**

Explicitly define mapping relationships in the Transform Map record itself.

An explicit Transform Map script explicitly defines mapping relationships in the Transform Map record itself. It runs after the source field values have been copied over to the target record, and before they are written to the database.

**CMDB software import facilitated by explicit mapping script**

An example demonstrating how explicit map scripting can be used to facilitate an import of software instances to the CMDB where it is necessary to have the count in the software packages table reflect the number of instances.

In the CMDB there exist tables for software packages and software instances. A software package refers to a one individual software title, such as Mozilla Firefox. A software instance refers to an individual instance of a software title such as Mozilla Firefox on Jared_T60_Laptop.

In more technical terms a software instance is a many-to-many relationship with a software package and a configuration item. This script imports software instances. In doing so it checks to see if a software package for the instance exists. If the software package doesn’t exist then it
is created and the sys_id for the newly created package is associated with the instance via the instance record's **Software** field.

```javascript
//First we will initialize some temporary variables, referencing values from the Import Set table source that will be used to reference software package records and create them if necessary.
var name = source.u_name;
var version = source.u_version;
var sid = "";

//Next we will perform a glide query on the software package table (Note: The target table //for the import is software instances)
var sgr = new GlideRecord("cmdb_ci_spkg");

//Here we are building our query to search for software packages where the name and //version of the package matches the name and version of the instance being imported
sgr.addQuery("name", name);
sgr.addQuery("version", version);
sgr.query();

//Now if a software package with the correct name and version are found then we record //the sys_id of the package record otherwise we create the package and then record the sys_id
if (sgr.next()) {
    sid = sgr.sys_id; // create it
    sgr.initialize();
    sgr.newRecord();
    sgr.name = name;
    sgr.version = version;
    sid = sgr.insert();
}

//Here we make an entry in System Import Set Log saying that we had to create a software package
log.info("Created new spkg: "+name+ " - "+ version);}

//Finally we set the reference field on our software instance record to the sys_id we have //recorded for the software package. In doing so we are also relating the software package with the instance and so the count, which keeps track of //the number of instances associated with a package, will automatically be incremented.
target.software = sid;
```

**Populating child tables by setting class names in an import to the CMDB**

An example demonstrating how to import servers into the configuration management database.

The destination table for the import is the cmdb_ci_servers table.

```javascript
var operating_system = source.u_operating_system.toString();

//This if statement uses JavaScript regular expressions to search the operating system
if (operating_system.match(/linux/i) !== null) {
    target.sys_class_name = "cmdb_ci_linux_server";
}
```
User import data sanitation

An example script demonstrating how to sanitize user data before import.

```javascript
if( operating_system.match(/win/i)!=null){
  target.sys_class_name="cmdb_ci_win_server";}

//Note: The field names referenced from an import set are
//prefixed with an "u_", also note that it is necessary to use the java
//method
//toString() to so that we can use JavaScript functions to
//manipulate the data.
var name= source.u_name.toString();

//Use native JavaScript function split to create an array for each word in
//the name "splitting" it
//anywhere that there is a space
var split_names =name.split(" ");

//Find the number of of names (i.e., first and last name only, or first
//middle and last name, etc.)
var num_names = split_names.length;

// If there is only one name then map it to the last name field in the user
//table
if(num_names ==1){
  target.last_name= split_names[0];}

//if there are two names then map the first one to first name and the last
//one to last name
if(num_names ==2){
  target.first_name= split_names[0];
  target.last_name= split_names[1];}

//if there are more than 3 names then all middle names get combined into one
//middle name this is done
//by shifting off the first name (array element 0 ) and mapping to first
//name and popping off the last
// name and returning it to the last name field
if(num_names >=3){
  target.first_name= split_names.shift();
  target.last_name= split_names.pop();
  target.middle_name= split_names.join(" ");}
```

Map with transformation event scripts

Transformation events occur during the process of transforming an import set table onto a table.

These events modify the transformation behavior from any type of mapping specification. Transformation Event scripts modify the processing of the events at various stages of the transformation.

For example, the processing of a mapping operation defined using the Mapping Assist Utility can be manipulated using the event scripts. There are a number of import set JavaScript objects that are accessible during these events. These objects represent tables or portions of tables. It is important to note that what these objects refer to varies depending on the context of the event in which they are referenced.

The following is a table of all of the transform events and their contextual variables:
# Transform events and their contextual variables

<table>
<thead>
<tr>
<th>Event name</th>
<th>Event Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>onStart</td>
<td>When: The onStart event script is processed at the start of an import run, before any data rows are read.</td>
</tr>
</tbody>
</table>

**Import Set JS objects available to be referenced and their context in the onStart event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onStart import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The first row of the source table, there is no data yet since the row has not been read.</td>
</tr>
<tr>
<td>import_set</td>
<td>GlideRecord</td>
<td>The import set that is currently being transformed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransform</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>ignore</td>
<td>Boolean</td>
<td>When set to true, the entire transformation will be stopped and no further processing will occur.</td>
</tr>
<tr>
<td>error</td>
<td>Boolean</td>
<td>When set to true, has the same effect as the ignore flag of stopping the entire transformation, with an error message.</td>
</tr>
</tbody>
</table>
### Event name

<table>
<thead>
<tr>
<th>Event name</th>
<th>Event Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>onComplete</td>
<td>When: The onComplete event script is processed at the end of an import run, after all data rows are read and transformed.</td>
</tr>
</tbody>
</table>

#### Import Set JS objects available to be referenced and their context in the onComplete event

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onComplete import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The last row of the source import set table.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The last row of target table.</td>
</tr>
<tr>
<td>import_set</td>
<td>GlideRecord</td>
<td>The import set that is currently being transformed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>error</td>
<td>Boolean</td>
<td>When set to true, will mark the current import set status to error after it completes.</td>
</tr>
</tbody>
</table>

#### Example:

```javascript
// Create a myimport_completed event that can be reacted by an email notification or script action
// (there is already an import.finished event that the system will create at the end of an import)
var e = new GlideEvent("myimport_completed", import_set.sys_id, map.sys_id, "");
```
### Event name: onBefore

When: The onBefore event script is processed at the start of a row transformation, before the source row is transformed into the target row.

**Import Set JS objects available to be referenced and their context in the onBefore event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onBefore import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The row of the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The row of the target table that is currently being processed.</td>
</tr>
<tr>
<td>import_set</td>
<td>GlideRecord</td>
<td>The import set that is currently being transformed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>action</td>
<td>String</td>
<td>Action returns a value of either “insert” or “update” indicating whether the current target row is about to be created or updated.</td>
</tr>
<tr>
<td>ignore</td>
<td>Boolean</td>
<td>When set to true, the current row transformation will be skipped and...</td>
</tr>
</tbody>
</table>
### Event name: onAfter

**When:** The onAfter event script is processed at the end of a row transformation, after the source row has been transformed into the target row and saved.

**Import Set JS objects available to be referenced and their context in the onAfter event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onAfter import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The row of the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The row of the target table that is currently being processed.</td>
</tr>
<tr>
<td>import_set</td>
<td>GlideRecord</td>
<td>The import set that is currently being transformed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Map—read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>action</td>
<td>String</td>
<td>Action returns a value of either “insert” or “update” indicating whether the current target row was created or updated.</td>
</tr>
<tr>
<td>status_message</td>
<td>String</td>
<td>Defines a custom message to be sent in the <code>&lt;status_message&gt;</code> XML response.</td>
</tr>
<tr>
<td>Event name</td>
<td>Event Parameters</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>onForeignInsert</td>
<td>When: The onForeignInsert event script is processed at the start of the creation of a related, referenced record, before the record is created.</td>
<td></td>
</tr>
</tbody>
</table>

**Import Set JS objects available to be referenced and their context in the onForeignInsert event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onForeignInsert import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The row of the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The row of the target table that is currently being processed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>action</td>
<td>String</td>
<td>Action returns a value of either 'insert' or 'update' indicating whether the current target row is about to be created or updated.</td>
</tr>
<tr>
<td>name</td>
<td>String</td>
<td>Evaluates to the field name of the target record for which a foreign record that is about to be created.</td>
</tr>
<tr>
<td>value</td>
<td>String</td>
<td>Evaluates to the display value from the source record for which a foreign record is about to be created.</td>
</tr>
<tr>
<td>Event name</td>
<td>Event Parameters</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td>onChoiceCreate</td>
<td>When: The onChoiceCreate event script is processed at the start of a choice value creation, before the new choice value is created.</td>
<td></td>
</tr>
</tbody>
</table>

**Import Set JS objects available to be referenced and their context in the onChoiceCreate event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onChoiceCreate import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The row of the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The row of the target table that is currently being processed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransform</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
<tr>
<td>action</td>
<td>String</td>
<td>Action returns a value of either “insert” or “update” indicating whether the current target row is about to be created or updated.</td>
</tr>
<tr>
<td>name</td>
<td>String</td>
<td>Evaluates to the field name of the target record for which a choice value is about to be created.</td>
</tr>
<tr>
<td>value</td>
<td>String</td>
<td>Evaluates to the display value from the</td>
</tr>
</tbody>
</table>
### Event name

<table>
<thead>
<tr>
<th>Event name</th>
<th>Event Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>onReject</td>
<td>When: The onReject event script is processed during the occurrence of a foreign record or choice creation, and the foreign record or choice is rejected, the entire transformation row is not saved.</td>
</tr>
</tbody>
</table>

**Import Set JS objects available to be referenced and their context in the onError event**

<table>
<thead>
<tr>
<th>Import Set JS object</th>
<th>Type</th>
<th>Context in the onError import set event</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The row of the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The row of the target table that is currently being processed.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>action</td>
<td>String</td>
<td>Action returns a value of either &quot;insert&quot; or &quot;update&quot; indicating whether the current target row is about to be created or updated.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. For example, log.info(...), log.warn(...), log.error(...).</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
//Create an event
var e = new GlideEvent("myimport_onReject", action, ",", ");
e.insert();
```
Updating records using coalesce

The coalesce option allows you to update existing target table records when transforming import data.

The coalesce option on a field map allows you to specify if the selected Target field should be used to coalesce on when import set records are transformed. If the field map Coalesce checkbox is selected, when the import set row is transformed the instance checks for an existing record in the target table that has the same value in the Target field as the import set row Source field.

If an existing record with a matching value in the target table is found, that record is updated. If no matching record is found, then a new record is created in the target table.

Note: Choose fields in the target table to coalesce on only if those fields will have unique values. If more than one record in the target table matches the specified coalesce options, only the first matching record in the target table is updated.

Coalesce options

There are several possible configurations you can use to coalesce data in import sets.

No coalesce

If no coalesce is defined, all imported rows are treated as new records. No existing records are updated.

Single-field coalesce

You can coalesce on a single field to update an existing record.

If a target table record exists with the same value in the coalesce field as the staging table record, the target table record is updated using the import set record values.

Multiple-field coalesce

You can coalesce on multiple fields to update an existing record.

If a target table record exists with the same values in all coalesce fields as the staging table record, the target table record is updated using the staging table record values. All coalesce field values between the target and staging tables must match to coalesce with multiple fields.

Conditional coalesce

You can use a script to determine if a staging table row should coalesce to a target record.

Most conditional coalesce scripts are defined in the Source script field of a field map for the sys_id field. To update a target record using the staging table record values, the script must return the sys_id of the target table record.
Example conditional coalesce scripts

Review examples of conditional coalesce scripts.

Updates only

To only update records where a match is found, and skip records where a match is not found, specify a coalesce field and add the following script as an `onBefore` script to the transform map.

```javascript
if (action == 'insert')
    ignore = true;
```

Conditional coalesce using dot-walking

You can use dot-walked fields in a conditional coalesce script, such as to match the email address of a user when importing incident data.

In this example, this script is defined in the `Source script` of a field map for the Incident target table `sys_id` field.

```javascript
var gr = new GlideRecord('incident');
gr.addQuery('caller_id.email', source.u_email); //check if the incident caller's email matches the import row email value
gr.query();
if(gr.next())
    {  
        answer = gr.sys_id; //if a match exists, return the sys_id of the matching Incident record
    }
else
    {  
        answer= -1;
    }
```

Conditional coalesce with an OR condition

You can use a conditional coalesce script to match source and target records based on multiple field values. Unlike multiple-field coalesce where all coalesce fields must match, you can specify a script to only require one of the fields to match.

In this example, this script is defined in the `Source script` of a field map for the User target table `sys_id` field.

```javascript
var gr = new GlideRecord('sys_user');
var qc = gr.addQuery('email', source.u_email); //first check if the user's email matches
qc.addOrCondition('user_name', source.u_name); //alternatively, check if the username matches
gr.query();
if(gr.next())
    {  
        answer = gr.sys_id; //if a match exists, return the sys_id of the matching User record
    }
```
Case-sensitive coalesce field values

You can control if an import set will coalesce on matching values with different cases. The field map Coalesce case sensitive field enables you to coalesce field values by case sensitivity.

By default, fields marked as Coalesce in the field map are used in a case insensitive lookup for existing records. If the Coalesce case sensitive check box is selected, the instance attempts to match coalesce field values by case. The target table record is updated only if the value in the target record and the import set staging record have the same value and case. Otherwise, a new record is created.

Coalesce on empty fields

You can control if an import set will coalesce on fields with no value. The field map Coalesce empty fields field allows you to coalesce on fields with no value.

By default, fields marked as Coalesce in the field map cause the import set to check for a target record with a field value that matches the value from the import set staging record. When Coalesce empty fields is selected for that field map, an empty value in the target record and import set staging record counts as a match for the purpose of coalescing.

For example, the User transform map coalesces on the email field. With the Coalesce empty fields option selected, a source record containing an empty email address coalesces to a target record containing an empty email address.

Standard import set tables

Several Import Set tables are available by default.

Notification

A standard object for describing an external interface for a notification in the system, eg. alarms and alerts from monitoring systems. The default transform map for this object will create or update an incident record. The incoming notifications are coalesced into incidents based on the UUID field.
### imp_notification

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>uuid</td>
<td>The universally unique identification number or string that uniquely identifies this notification. It is marked as the coalescing value in the default transform map for the corresponding Incident and is mapped to the correlation_id field of Incident.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>corrective_message</td>
<td>A free form string value that indicates the corrective or followup steps to be taken to address the issue identified in this notification. This field is not mapped by default.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>duration</td>
<td>A string value representing the time value duration affecting the issue reported in this notification. Out of box, the duration field is not mapped. The format of the time is up to the calling program and must be mapped accordingly in the default map to be used.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>expires_on</td>
<td>A string value representing the datetime value that the issue reported in this notification will expire. Out of box, the expires_on field is not mapped. The format of the time is up to the calling program and must be mapped accordingly in the default map to be used.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>message</td>
<td>A string value describing the nature of the issue related to this notification. It should be a concise description and is mapped to the short_description field of the Incident.</td>
<td>Character (80)</td>
</tr>
<tr>
<td>comments</td>
<td>A string value containing additional comments related to this notification. The value is mapped to the comments field of the Incident.</td>
<td>Character (4000)</td>
</tr>
<tr>
<td>category</td>
<td>A string value categorising the nature of this notification. The value is mapped to the category field of the Incident, and therefore should be one of its valid values. If an existing value does not exist, the default behavior is to create a new category.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Data type</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>assignment_group</td>
<td>A string value of the assignment group for this notification. The value is mapped to the assignment_group field of the Incident, and therefore should be one of its valid values. If an existing value does not exist, the default behavior is to create a new assignment group and set it for the resulting incident.</td>
<td>Character (40)</td>
</tr>
</tbody>
</table>
| severity     | A string representation of a numeric value that indicates the severity of the issue being reported in this notification. This field is mapped to the severity field on Incident. The out of box numeric values and their meanings are:  
· 1 - High  
· 2 - Medium  
· 3 - Low | Character (40) |
| state        | A string that indicates the state of the issue being reported in this notification. This field is mapped to the incident_state field on Incident. The out of box values are:  
· New  
· Active  
· Resolved  
· Closed | Character (40) |
<p>| source       | A string value to indicate the source of the issue or the configuration item (by unique identifier eg IP address, host name etc) related to the issue in this notification. It is mapped to the cmdb_ci field of Incident. | Character (40) |
| timestamp    | A string value representing the datetime value that marks the beginning of the issue reported in this notification. Out of box, the timestamp field is not mapped. The format of the time is up to the calling program and must be mapped accordingly in the default map to be used. | Character (40) |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>A string value categorizing the type of issue related to this notification. Out of box, this field is not mapped to any field on Incident. Integrations using this Notification message may use this field to identify its source and trigger additional scripts.</td>
<td>Character (40)</td>
</tr>
</tbody>
</table>

**Computer**

A standard object for describing an external interface for a computer in the system. The default transform map will create/update a Computer (cmdb_ci_computer) or Server (cmdb_ci_server, cmdb_ci_win_server, cmdb_aix_server etc ..) based on the operating_system field value. The incoming computers are coalesced based on the serial_number field. Additionally, the transform script of the map will map to various extensions of the Computer (cmdb_ci_computer) based on the operating_system value being entered.

- UNIX Server (cmdb_ci_unix_server)
  - AIX
  - HP/UX
  - Solaris
  - AIX
- Windows Server (cmdb_ci_win_server)
  - Windows 2000 Server
  - Windows 2003 Server
  - Windows NT 4.0
- Server (cmdb_ci_server)
  - Any operating system that contains the word "Linux"

**imp_computer**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>serial_number</td>
<td>The unique identifier for this computer. It is marked as the coalescing value in the default transform map for the corresponding Computer and is mapped to the serial_number field of Computer (cmdb_ci_computer).</td>
<td>Character (40)</td>
</tr>
<tr>
<td>cpu_count</td>
<td>The number of CPUs that this computer has. It is mapped to the cpu_count field of the Computer (cmdb_ci_computer) table.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Data type</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>cpu_speed</td>
<td>The clock speed of the CPU in MHz. This field is mapped to the cpu_speed field of Computer (cmdb_ci_computer)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>cpu_type</td>
<td>Free form text describing the type of CPU. Example values are &quot;GenuineIntel&quot;, &quot;IBM&quot;, or &quot;Pentium 4&quot;. This field is mapped to the cpu_type field of Computer (cmdb_ci_computer)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>disk_space</td>
<td>A numeric value describing the total disk space available to the computer in GB. This field is mapped to the disk_space field of Computer (cmdb_ci_computer)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>manufacturer</td>
<td>A string name for the manufacturer of the computer. This field is mapped to the manufacturer field of Computer (cmdb_ci_computer) which is a reference to Company (core_company)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>model_id</td>
<td>A string name for the model of the computer. This field is mapped to the model_id field of Computer (cmdb_ci_computer) which is a reference to Model Name (cmdb_model)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>name</td>
<td>A string value representing the name of the Computer, usually a host name or IP/MAC address. It is mapped to the name field of Computer (cmdb_ci_computer)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Data type</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>operating_system</td>
<td>A string value for the main operating system running on the computer. It is mapped to the os field of Computer (cmdb_ci_computer). Out of box values are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- AIX</td>
<td>Character (40)</td>
</tr>
<tr>
<td></td>
<td>- GNU/Linux</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- HP/UX</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Linux Fedora</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Linux Red Hat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Linux SuSE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Mac OS 10 (OS/X)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Mac OS 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Mac OS 9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Mac OS/X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- OS/400</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Solaris</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SunOS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000 Advanced Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000 Datacenter Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000 Professional</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000 Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Datacenter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Enterprise</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Web</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 95</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 98</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows ME</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows NT 4.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows XP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows XP Home</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows XP Professional</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2000 Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Enterprise</td>
<td></td>
</tr>
<tr>
<td>ram</td>
<td>A numeric value for the total number of memory installed on this computer in MB. This value is mapped to the ram field of Computer (cmdb_ci_computer)</td>
<td>Character (40)</td>
</tr>
</tbody>
</table>

**User**

A standard object for describing an external interface for a user in the system. The default transform map script sets the user_name field value to first_name.last_name if the web service’s
user_id field value is not supplied, otherwise, the user_id value is mapped directly to the user_name field in the User (sys_user) table.

### imp_user

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>email</td>
<td>A string value containing the user's email address. This value is mapped to the email field in User (sys_user) and is set as the coalesce value for the transform.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>department</td>
<td>The department the user is in. This field is mapped to the department field in User (sys_user) which is a reference to the Department (cmn_department) table.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>first_name</td>
<td>The first name of the user, mapped to the first_name field of the User (sys_user) table.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>last_name</td>
<td>The last name of the user, mapped to the last_name field of the User (sys_user) table.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>location</td>
<td>The location the user is in, mapped to the location field of the User (sys_user) table which is a reference field to Location (cmn_location)</td>
<td>Character (40)</td>
</tr>
<tr>
<td>phone</td>
<td>The phone number of the user, mapped to the phone (Business Phone) field of the User (sys_user) table.</td>
<td>Character (40)</td>
</tr>
</tbody>
</table>

### Location

A standard object for describing an external interface for a location in the system. The web service will create or modify records in the Location (cmn_location) table.

### imp_location

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>The name of the location, for example “Headquarters”, “Sales office” etc. This field is mapped to the name field of Location (cmn_location) and is part of the coalesce to search for an existing location.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Data type</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>street</td>
<td>The street address of the location, for example “1234 ServiceNow way” etc. This field is mapped to the street field of Location (cmn_location) and is part of the coalesce to search for an existing location.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>city</td>
<td>The city of the location, for example “San Diego”, “London” etc. This field is mapped to the city field of Location (cmn_location) and is part of the coalesce to search for an existing location.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>state</td>
<td>The state of the location, for example “California”, “Connecticut” etc. This field is mapped to the city field of Location (cmn_location) and is part of the coalesce to search for an existing location.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>zip</td>
<td>The zip code for the location, for example “92130”, “10001” etc. This field is mapped to the zip field of Location (cmn_location) and is part of the coalesce to search for an existing location.</td>
<td>Character (40)</td>
</tr>
<tr>
<td>country</td>
<td>The country for the location, for example “USA”, “United Kingdom” etc. This field is mapped to the country field of Location (cmn_location).</td>
<td>Character (40)</td>
</tr>
</tbody>
</table>

**Import sets maximum row size**

Rows imported using import sets must not exceed the maximum row size.

A single row in a database may not contain more than 8126 bytes of data. The size of each row is determined by the amount of content in all fields, as well as the character set for text fields. For example, a row with 10 text fields each containing 1000 characters using a French character set takes 15360 bytes.

Attempting to import more data to a single row than the maximum size causes the import to skip that row. Any rows that were skipped for this reason are listed in the import log.

**Data import using import sets**

To import data define a data source and transform map, and run or schedule an import.
Create a data source

Create a data source record to define what data an import set should import.

Role required: admin

1. Navigate to System Import Sets > Data Sources.
2. Click New.
3. Set the following fields.

Common data source fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for this data source.</td>
</tr>
<tr>
<td>Import set table label</td>
<td>Specify a label for the import set staging table to use.</td>
</tr>
</tbody>
</table>
4. Set additional fields based on the selected **Type**. Refer to the documentation for each data source type for additional field information.

5. Click **Submit**.

Define a transform map for the new data source and run an import.

**Data source fields**

Additional fields appear on the data source form depending on the value of the **Type** field.

**Field type data source fields**

These additional fields appear on the data source form when the **Type** field value is **File**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Select one of the following formats from the list: CSV, CSV (tab), Custom (Parse by Script), Excel, JSON, XML.</td>
</tr>
<tr>
<td>Zipped</td>
<td>Select this check box if the import file is compressed.</td>
</tr>
<tr>
<td>Xpath for each row</td>
<td>Specify an XPath expression that selects the nodes which become rows in the import table. The children of the selected nodes will become the columns in the rows.</td>
</tr>
<tr>
<td>Expand node children</td>
<td>Select this check box if child elements of the XML node or JSON object should be converted into additional columns. Clear this field if the parent column value should be an XML or JSON fragment. For JSON, note that selecting this option expands objects only, not arrays. For nested array support, see <strong>Importing JSON files</strong>.</td>
</tr>
<tr>
<td>File retrieval method</td>
<td>Choose the appropriate retrieval method for this file.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File path</td>
<td>Specify the path to the file to import. You can include a system property value in this field</td>
</tr>
<tr>
<td></td>
<td>using the format ${system.property.name}. When the connection is made, the variable is</td>
</tr>
<tr>
<td></td>
<td>replaced with the value of the specified property.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For files retrieved using HTTP or HTTPS, the property glide.ds.file.http.variable_replacement must be true to use system property expansion.</td>
</tr>
<tr>
<td></td>
<td>For example, you can specify the File path value /countries.csv?key=${datasource.apikey}.</td>
</tr>
<tr>
<td></td>
<td>When the connection is made, the value of the datasource.apikey system property is passed as the</td>
</tr>
<tr>
<td></td>
<td>value for the key parameter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For HTTP and HTTPS protocols, the file path is automatically URL encoded. Do not</td>
</tr>
<tr>
<td></td>
<td>specify a URL-encoded file path when using either of these protocols.</td>
</tr>
<tr>
<td>SCP authentication method</td>
<td>Select to authenticate with a Username and Password or with a Public key.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot authenticate to data sources with a public-private key pair. Use a</td>
</tr>
<tr>
<td></td>
<td>username and password authentication instead.</td>
</tr>
<tr>
<td>Server</td>
<td>Enter the name of the server from which the file will be imported.</td>
</tr>
<tr>
<td></td>
<td>You can include a system property value in this field using the format ${system.property.name}.</td>
</tr>
<tr>
<td></td>
<td>When the connection is made, the variable is replaced with the value of the specified property.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For files retrieved using HTTP or HTTPS, the property glide.ds.file.http.variable_replacement must be true to use system property expansion.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port to use to connect to the specified server. This field appears if you select</td>
</tr>
<tr>
<td></td>
<td>HTTP or HTTPS as the file retrieval method.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name for authentication on the file server.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for authentication on the file server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Private keyfile</td>
<td>Specify the keyfile when using legacy SCP public-private keyfiles.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot authenticate to data sources with a public-private key pair. Use a username and password authentication instead.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not use this legacy option. While it is available for use, it is not supported.</td>
</tr>
</tbody>
</table>

System KeyStore

Select this check box to validate the certificate from the FTPS server against all saved certificates. This certificate may be any type supported by the instance. If you do not select this check box, the instance uses the Java default certificate to validate the FTPS server. This field is available only for data sources with a File retrieval method value of FTPS. All FTPS file retrieval methods are supported, including Auth TLS, Auth SSL, Implicit SSL, and Implicit TLS.

**JDBC type data source fields**

These additional fields appear on the data source form when the Type field value is JDBC.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use MID Server</td>
<td>Select a MID Server to use to connect to this data source.</td>
</tr>
<tr>
<td>Format</td>
<td>Select one of the supported database formats. Instances can connect to Microsoft SQL Server 2012 but not Microsoft SQL Server 2000.</td>
</tr>
<tr>
<td>Instance name</td>
<td>Used to support dynamic port connectivity with SQL Server. To ensure connectivity, provide the instance name for a SQL Server that receives a new port number dynamically after each reboot. This field only appears when SQLServer is selected as a data source format.</td>
</tr>
<tr>
<td>Database name</td>
<td>Enter the name of the database instance.</td>
</tr>
<tr>
<td>Database port</td>
<td>Enter the port number for the database. Leave this field empty when using dynamic port connectivity with SQL Server.</td>
</tr>
<tr>
<td>Use integrated authentication</td>
<td>Select this check box to allow the JDBC connection to use the ID of the user configured for the Windows MID Server service for SQL Server authentication. For additional details, see SQL server integrated authentication for Windows.</td>
</tr>
<tr>
<td>User name</td>
<td>Enter the user name for authentication on the database server. The user name provided for the JDBC connection must be associated with an account on that database server; it cannot be a Windows Domain account.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for authentication on the database server.</td>
</tr>
<tr>
<td>Server</td>
<td>Enter the name of the server from which the data will be imported.</td>
</tr>
<tr>
<td>Query</td>
<td>Select the type of query to run: <strong>All rows from Table</strong> or <strong>Specific SQL</strong>. If you select to run a SQL statement, the SQL statement field appears.</td>
</tr>
<tr>
<td>Query timeout</td>
<td>Specify the number of seconds the JDBC driver will wait for a query (SELECT) to complete. Zero means no timeout. If timeout is exceeded, the integration considers the JDBC result inaccessible and places it in an error state.</td>
</tr>
<tr>
<td>Connection timeout</td>
<td>Specify the number of seconds before MID Server connection cache pool closes and removes it from the pool. Zero means no timeout.</td>
</tr>
<tr>
<td>Table name</td>
<td>Type the name of the table from which the data is being exported.</td>
</tr>
<tr>
<td>SQL statement</td>
<td>Type a SQL statement to extract the desired data from the database.</td>
</tr>
<tr>
<td>Use last run datetime</td>
<td>This selection controls the amount of data that is retrieved from a database during an import run. If this check box is unselected, then all rows in the table specified are imported, every time. You might want to use this setting if this is a one-time import, or if all the data in the target table is new. If this check box is selected, two additional fields appear, enabling you to select a datetime value to limit imported data to delta values only.</td>
</tr>
<tr>
<td>Last run datetime</td>
<td>The datetime value in this field is automatically populated from the database field you select below and represents the latest value from the previous run. This value acts as a dynamic filter to restrict the number of records retrieved to those records that have changed since the data source’s last runtime.</td>
</tr>
<tr>
<td>Last run database field</td>
<td>Select the field name from the source table that will be used as the filter in the next run. This value may need to be case sensitive depending on the target database type.</td>
</tr>
<tr>
<td>Additional Database Parameters</td>
<td>Optional parameters to add to the end of the URL generated for this data source. Enter a semicolon-separated list of parameters. You may need to configure the form to view this field.</td>
</tr>
</tbody>
</table>

**LDAP type data source fields**

These additional fields appear on the data source form when the **Type** field value is **LDAP**.
Create a transform map

Every import operation to a production table requires at least one transform map associated with an import set.

Role required: import_transformer, import_admin, or admin

The transform map specifies the data relationships between the import set and the target table. For every transformation, you must either create a new transform map or select an existing one.

1. Navigate to System Import Sets > Create Transform Map.
2. Fill in the fields, as appropriate (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP target</td>
<td>Select a target from the list of your LDAP OU definitions.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a user-friendly label for identifying the transform map.</td>
</tr>
<tr>
<td>Source table</td>
<td>Select the import table containing the raw import set data. An import table is any table that extends the Import Set Row [sys_import_set_row] table. You can select only tables within the currently selected application scope.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the transform map available for use.</td>
</tr>
<tr>
<td>Run Business Rules</td>
<td>Select this check box to run business rules, workflows, approval engines, auditing, and field normalization while the transformation inserts or updates data into the target table. Clearing this check box runs GlideRecord.setWorkflow() with a value of false.</td>
</tr>
<tr>
<td>Enforce Mandatory Fields</td>
<td>Choose whether to enforce mandatory fields on the target table.</td>
</tr>
<tr>
<td>Copy Empty Fields</td>
<td>Select this check box to clear fields with existing values when an incoming field contains an empty value. See Using NULL as a Field Value for information on how to import empty values.</td>
</tr>
<tr>
<td>Created</td>
<td>Shows the transform map creation date. This field is automatically populated.</td>
</tr>
<tr>
<td>Target table</td>
<td>Select the table where you want transformed data to be placed. You can select only tables within the currently selected application scope, the global scope, or tables that grant write access to other applications</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order in which to apply transform maps in the event that more than one map fits the conditions. ServiceNow runs transform maps from lowest to highest <strong>Order</strong>.</td>
</tr>
<tr>
<td>Run Script</td>
<td>Select this check box to display the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter the transform map script you want to use to transform field values in the source table to the target table. ServiceNow runs the transform map script in addition to any <strong>Field Maps</strong>.</td>
</tr>
<tr>
<td>Field Maps</td>
<td>Use this related list to add one or more field maps. ServiceNow runs the transform <strong>Field Maps</strong> in addition to any transform script.</td>
</tr>
<tr>
<td>Transform scripts</td>
<td>Use this related list to add one or more transform map scripts. A transform script allows you to apply extra business logic at a specified stage of the transformation.</td>
</tr>
</tbody>
</table>

The sample User import transform map looks like this.
**Table Transform Map**

- **Name:** User
- **Source table:** User [imp_user]
- **Created:** 2008-12-18 23:21:42
- **Target table:** User [sys_user]
- **Order:** 100
- **Run business rules:**
- **Run script:**

### Related Links
- Auto map matching fields
- Mapping Assist
- Transform

### Field Maps (7)

<table>
<thead>
<tr>
<th>Source field</th>
<th>Target field</th>
<th>Coalesce</th>
</tr>
</thead>
<tbody>
<tr>
<td>last_name</td>
<td>last_name</td>
<td>false</td>
</tr>
<tr>
<td>department</td>
<td>department</td>
<td>false</td>
</tr>
<tr>
<td>email</td>
<td>email</td>
<td>true</td>
</tr>
<tr>
<td>phone</td>
<td>phone</td>
<td>false</td>
</tr>
<tr>
<td>first_name</td>
<td>first_name</td>
<td>false</td>
</tr>
<tr>
<td>user_id</td>
<td>user_name</td>
<td>false</td>
</tr>
<tr>
<td>location</td>
<td>location</td>
<td>false</td>
</tr>
</tbody>
</table>

| Actions on selected rows... |
Important: The string NULL is a reserved word. It should not be used as a field value in import set transform maps or anywhere in the First name or Last name fields. The reserved word is NULL in all capital letters. A field with the value Null or null, for example, is acceptable. NULL should be used only to clear out a particular field.

Mapping options

You can map fields in a number of ways depending on the circumstances of the import and whether data must be transformed prior to loading onto a production table.

It is also important to note that any given import operation may require taking advantage of multiple mapping methods, and these methods can be readily used in conjunction with one another.

Automatic Mapping Utility

The simplest mapping method is where all of the field names of the import sets match the names of the fields on the production tables onto which the data will be transformed. In this case, simply click Auto map matching fields in the related list in the Table Transform Map form and confirm proper matching. If there are any discrepancies in terms of how fields were automatically matched, use the mapping assist utility to correct them. When all fields are matched properly, click the Transform related link to begin transforming data onto the destination table.

Mapping Assist Utility

The mapping assist utility provides a visually intuitive environment for specifying mapping between import set fields and production table fields. The mapping assist utility makes it possible to map a single source field (field on an import set table) to multiple destination fields (fields on a production table).
Changing the Date Format

If the date format of the source field does not match the format of the target field, you can set a date format mapping to transform dates from one format to another. For example, this mapping specifies that the date format of the CSV source file uses the **MM-dd-yyyy** format.
Field map date format

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dd-MM-yyyy</td>
<td>Day-month-year</td>
</tr>
<tr>
<td>dd-MM-yyyy hh:mm:ss</td>
<td>Day-month-year hours-minutes-seconds</td>
</tr>
<tr>
<td>dd-MM-yyyy hh:mm:ss z</td>
<td>Day-month-year hours-minutes-seconds timezone</td>
</tr>
<tr>
<td>MM-dd-yyyy</td>
<td>Month-day-year</td>
</tr>
<tr>
<td>MM-dd-yyyy hh:mm:ss</td>
<td>Month-day-year hours-minutes-seconds</td>
</tr>
<tr>
<td>MM-dd-yyyy hh:mm:ss z</td>
<td>Month-day-year hours-minutes-seconds timezone</td>
</tr>
<tr>
<td>yyyy-MM-dd</td>
<td>Year-day-month</td>
</tr>
<tr>
<td>yyyy-MM-dd hh:mm:ss</td>
<td></td>
</tr>
</tbody>
</table>

Field map date format options

Date format options include:

Mapping Options

<table>
<thead>
<tr>
<th>Date Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dd-MM-yyyy</td>
<td>Day-month-year</td>
</tr>
<tr>
<td>dd-MM-yyyy hh:mm:ss</td>
<td>Day-month-year hours-minutes-seconds</td>
</tr>
<tr>
<td>dd-MM-yyyy hh:mm:ss z</td>
<td>Day-month-year hours-minutes-seconds timezone</td>
</tr>
<tr>
<td>MM-dd-yyyy</td>
<td>Month-day-year</td>
</tr>
<tr>
<td>MM-dd-yyyy hh:mm:ss</td>
<td>Month-day-year hours-minutes-seconds</td>
</tr>
<tr>
<td>MM-dd-yyyy hh:mm:ss z</td>
<td>Month-day-year hours-minutes-seconds timezone</td>
</tr>
<tr>
<td>yyyy-dd-MM</td>
<td>Year-day-month</td>
</tr>
</tbody>
</table>
### You can specify a custom date format using **HH** to denote 24 hour time. Converting from a 24 hour to 12 hour date format may cause times from 12:00 to 12:59 to be formatted as 00:00.

### Mapping to a Duration Field

ServiceNow duration fields use a special data type that lists the number of milliseconds the duration value is. To map import data to a duration field use one of the following methods to transform source values into a duration:

- Calculate the duration from a start and end date
- Convert an existing duration value into a ServiceNow duration value

### Calculating a Duration Value from a Start and End Date

If the import source has a start and end date, you can calculate a duration with JavaScript.

1. Navigate to **System Import Sets > Transform Maps**.
2. Select the transform map you want to calculate a duration value. For example, the Notification transform map that imports into the Incident table.
3. Select the **Run script** check box.
4. Enter JavaScript to transform the start and end dates into a duration. See the sample script.
5. Click **Update**.

This sample script transforms the source.u_start and source.u_end fields to a duration value in the target.duration field. Change the field names to match your source and target fields as needed.

```javascript
target.duration = gs.dateDiff(source.u_start.getDisplayValue(), source.u_end.getDisplayValue(), false);
```

### Convert a Duration Value into a ServiceNow Duration Value

If the import source already contains a start date and a duration value, you can convert the existing duration into a ServiceNow duration. For example, you might have an Excel data source that lists a duration in seconds. ServiceNow expects durations to have millisecond values.

1. Navigate to **System Import Sets > Transform Maps**.
2. Select a transform map.
   For example, the Notification transform map that imports into the Incident table.
3. Select the **Run script** check box.
4. Enter JavaScript to convert existing duration values into a ServiceNow duration values. See the sample script.
5. Click **Update**.

---

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
This sample script converts a duration in seconds (from the `source.u_duration` field) to a duration in milliseconds (in the `target.duration` field). Change the field names to match your source and target fields, as needed.

```java
//Transform the value in source.u_duration from seconds to milliseconds
target.duration.setDateNumericValue(source.u_duration * 1000);
```

This sample script converts a duration already in milliseconds (from the `source.u_duration` field) to a ServiceNow duration (in the `target.duration` field). Change the field names to match your source and target fields, as needed.

```java
//Transform the value in source.u_duration to ServiceNow format
target.duration.setDateNumericValue(source.u_duration);
```

### Using a Script to Calculate a Source Value

You may want to use a source script instead of the **Source field** when:

- The source value is not in the format for the mapped target value.
- You want to look up a value before mapping to the target field.
- The source value must be computed from multiple fields.
- You need to create a compounded or calculated coalesce value in the target field.

For example, this example source script computes the value of the `user_name` field when it is blank in the source.

```java
if (source.user_id.nil()) {
    answer = source.first_name + "." + source.last_name;
} else answer = source.user_name;
```
A source script expects the calculated value to be set in the global variable `answer`.

### Mapping Binary or BLOB Fields

ServiceNow uses a special process to import binary and binary large object (BLOB) data from JDBC data sources. All binary data is automatically converted into a record in the Attachment (sys_attachment) table before the transformation occurs. The import set table only stores the attachment record's sys_id value in the import table field instead of the actual binary value. For example, suppose you use a JDBC data source to import data from a CA Service Desk system, which stores each record's key value as binary data. When you import the Service Desk key values into a ServiceNow table, the ServiceNow field only contains a sys_id reference to the corresponding binary data in the Attachment Record (sys_attachment) table rather than the actual binary data.

To have a transform map access the attachment, use the GlideRecord API in an `onAfter` script. The script needs to run in an `onAfter` event because the `target.sys_id` object is only available after the data is placed in the import set table. For example, to map the resulting attachment to the target transform record, you can use the following script:

```javascript
var agr = new GlideRecord("sys_attachment");
agr.addQuery("sys_id", source.u_blob_field);
// the source field needs to be mapped to the source that is the BLOB
agr.query();
if(agr.next()) {
    agr.table_name = "cmdb_ci"; // the target table of the transform map
    agr.table_sys_id = target.sys_id; // the target record
    agr.content_type = source.u_contenttype;
    // the content type string if available,
    // this becomes the mime encoding when clicking an attachment link
    agr.update(); // finally, move/re-attach the attachment to the target
}
```

If you are mapping directly to the `db_image` table, run the following `onAfter` script to display the image:

```javascript
var strTemp = source.u_file_name;
var fType = strTemp.substr(-3);
var iCont = ";
if(fType == 'jpg') {
iCont = 'jpeg';
} else {
iCont = fType;
}
var agr = new GlideRecord("sys_attachment");
agr.addQuery("sys_id", source.u_blob_field);
agr.query();
if(agr.next()) {
    agr.table_name = "ZZ_YYdb_image";
    agr.table_sys_id = target.sys_id;
    agr.content_type = 'image/' + iCont;
    agr.file_name = 'image';
    agr.update();
}
```

### Create a field map

Field maps establish a relationship between a field in an import set table and a field in the target table.
Role required: import_transformer, import_admin, or admin

The field map determines what values from the source table the transformation adds to the target table.

1. Navigate to System Import Sets > Transform Maps.
2. Open a transform map.
3. In the Field Maps related list, click New.
4. Fill in the fields, as appropriate (see table).
5. Click Save.
6. Repeat steps 3-4 for each field mapping.
7. Click Update.

Creating a Field Map

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source table</td>
<td>Displays the table where the raw import set data is loaded (the source for the transformation). This field is automatically populated from the transform map. You can select only tables within the currently selected application scope.</td>
</tr>
<tr>
<td>Source field</td>
<td>Select the field on the source table to be transformed. This may be blank if the Source table only contains raw data.</td>
</tr>
<tr>
<td>Map</td>
<td>Displays the transform map that uses this field mapping. This field is automatically populated.</td>
</tr>
<tr>
<td>Date format</td>
<td>This field is available if the target field is a date or date-time field. This field specifies the date format of the source field.</td>
</tr>
</tbody>
</table>
| Choice action  | This field is available if the target field is a choice list or reference field. This field specifies what to do if the import set contains a reference or choice value other than those available. Select one of these options:  
• create: Create a new choice or record in the reference table.  
• ignore: Ignore the new value from the source table.  
• reject: Skip the entire row (record) containing the new value and continue to the next row. |
| Use source script | Select this check box to use a script instead of the Source field. |
| Source script  | Enter a script to determine the source of this field mapping instead of the Source field. The script should return the answer variable. |
| Target table   | Select the table where you want transformed data to be placed. You can select only tables within the currently selected application scope, the global scope, or tables that grant write access to other applications |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target field</td>
<td>Select the field where the values from the source field is stored.</td>
</tr>
</tbody>
</table>
| Referenced value field name | When the target field is a reference field, the transform map needs a way to match incoming source values to existing records in the reference field's source table. Since most imports do not provide a 32-character sys_id value, you must specify a column from the reference field's source table that contains values that match the incoming source values.  
When there is a matching record, the transform map stores the sys_id of the matching record in the target field. If there is no matching record, the transform map creates a new record in the reference field's table and stores the sys_id of the new record in the target field.  
If you leave this field blank, the transform map looks for matching values from the display value column of the reference field table.  
For example, suppose you are importing incident records and the incoming data lists user IDs for the Assigned to field. If you leave Referenced value field name blank, the transform map searches for matching values in the User table's display value column: name. By setting the Referenced value field name to the user_name column you can match the user ID values to the appropriate user records. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coalesce</td>
<td>Configuring a target field to coalesce causes the import set to treat the field as a unique key. When selected, the import set application attempts to match source values to records with values from an existing record. If a match is found, the transform map updates the record instead of creating a new record. When false, the import set application always creates new records for each transformation. If multiple fields are set to coalesce, all coalesce values must match an existing record. If two fields are set for coalescing and a matching value is found for one of the coalescing fields but not on the other, a new record is inserted. You must create an index on the target table if none of the coalesce fields are indexed. Indexing can improve performance for read and write operations. If one or more coalesce fields already has an index, you do not need to create an additional index. After setting the <strong>Coalesce</strong> value for all fields on the target table, use the <strong>Index Coalesce Fields</strong> related link to create an index. Before creating the index, ensure that the <strong>Coalesce</strong> value is set correctly for all fields on the target table to avoid creating unnecessary indexes for the same target table. The index needs to be concatenated; meaning all fields specified to be coalesced, need to be in the same index. The correct setup is for one index to include all fields being coalesced.</td>
</tr>
<tr>
<td>Coalesce empty fields</td>
<td>Select this check box to match an empty source field value to an empty target field value. For example, the User transform map coalesces on the email field. With this option selected, a source record containing an empty email address coalesces to a target record containing an empty email address.</td>
</tr>
<tr>
<td>Coalesce case sensitive</td>
<td>Select this check box to have case sensitive coalesce values result in the creation of new records. By default, values marked as <strong>Coalesce</strong> are used in a case insensitive lookup for existing records. Case insensitive records only update existing records and do not cause the creation of new records.</td>
</tr>
</tbody>
</table>

A completed field map record with coalescence enabled might look like this:
Field map script variables

Several predefined variables are available in the **Source script** field.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>source</td>
<td>GlideRecord</td>
<td>The record from the source table that is currently being processed.</td>
</tr>
<tr>
<td>target</td>
<td>GlideRecord</td>
<td>The record from the target table that is currently being processed.</td>
</tr>
<tr>
<td>answer</td>
<td>String</td>
<td>The field value to set in the target record.</td>
</tr>
<tr>
<td>map</td>
<td>GlideTransformMap</td>
<td>Read-only information about the current transform map record.</td>
</tr>
<tr>
<td>log</td>
<td>Function</td>
<td>The log object for the current import run. Use this object to log messages such as <code>log.info(&quot;&lt;Message&gt;&quot;)</code> or <code>log.warn(&quot;&lt;Message&gt;&quot;)</code>. This object logs to the import log for standard import sets, or other log locations as required, such as for web service imports.</td>
</tr>
</tbody>
</table>
### Variable | Type | Description
--- | --- | ---
action | String | Contains either the value **insert** or **update**, depending on whether the current target row will be created or updated.  
**Note:** The action variable is available only when the Coalesce field is false.

**Run an import**

You can manually run an import to immediately import data.

1. From a Transform Map, click **Transform**.
   
   When the import is done, you’ll see a link to go straight to the target table containing your imported records. The amount of time that it takes to run an import varies depending on the number of record to be imported and may take as long as several hours for very large import operations (tens of thousands of records).

2. (optional) Click on the link **View the imported data** to see the loaded import set table.

3. (optional) Click on the link **Create transform map** to create a new transform map to transform the data in the import set table to its target table.

4. (optional) Click on the link **Run import** to execute an existing transform map for the loaded data.

Three things to note at this point:

- The spreadsheet was imported, and a new table was created to hold the data.
- Within that table, the imported records are designated with their own “Set” value.
- A new module was created in the System Import Sets application for the new table.

**Importing date/time values**

Considerations when importing data containing date/time values.

- The field containing the date/time value should be a Date/Time type field in the target table.
- The user performing the import should have their timezone (in the **Time zone** [time_zone] field in the User [sys_user] record for that user) set to match the timezone of the date/time values in the import file.

To set the user timezone, do the following.

1. Click the user drop-down in the banner and select **Profile**.

2. Change the **Time zone** field value to the timezone of the date/time values in the import file and click **Update**.

**Review the import set**

After an import set completes, you can review the completed import and clean up import set tables. Even if no errors were reported by the progress indicator, review how your data was imported into the new import set.

1. Click **View imported data**.
There are several fields that will be visible in the table that were not part of the original data source, these are system rows can be used to facilitate scripted import operations.

2. Review the data.
3. Return to the previous page.

Create a transform map to associate with this import set.

**Viewing the import log**

The import log is where you can find information about the internal processing that occurs during an import operation.

The log includes information generated by the system during the every step of the import operation from initialization of the import set table from a data source to transformation onto a target table. It is also possible to customize log outputs during the transformation by using log.info, log.warn, log.error statements.
Import Log

Import run history

The import history gives status information about individual import operations.

Note: Functionality described here requires the Admin role.

Run import utility

The Run Import utility is used to run an import operation using an existing Transform Map and Import Set table.
Schedule a data import

Scheduled imports make it is possible to specify that certain import operations should occur at some regular interval.

Role required: import_scheduler, import_admin, or admin

**Important:** Do not schedule multiple imports at the same time. Running multiple imports concurrently may negatively impact performance or cause an instance outage.

1. Navigate to **System Import Sets > Administration > Scheduled Imports**.
2. Complete the form.

**Scheduled Data Import form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for this scheduled data import.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data source</td>
<td>Select the data source record that defines the data to import. If you select a remote data source, it is refreshed via the remote connection prior to the import operation.</td>
</tr>
<tr>
<td>Run as</td>
<td>Enter the name of a user whose credentials the import job uses. If you do not specify a value, the import job runs as the guest user.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to activate the scheduled import.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the frequency at which you want to run the import.</td>
</tr>
<tr>
<td>Time</td>
<td>Enter the time you want the import to begin. Do not schedule multiple imports at the same time. Running multiple imports concurrently may negatively impact performance or cause an instance outage.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Select this check box if you want to write a script to define the conditions that must evaluate to true before the import runs.</td>
</tr>
<tr>
<td>Condition</td>
<td>Write the script to be used to evaluate whether an import should run. This field is visible if you selected the Conditional check box.</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Select the period that must elapse before the import is repeated. This field is visible if Run is set to Periodically.</td>
</tr>
<tr>
<td>Starting</td>
<td>Click the calendar icon and select the date on which the import should begin. This field is visible if Run is set to Periodically.</td>
</tr>
<tr>
<td>Execute pre-import script</td>
<td>Select this check box if you want to write a script to be run before the import is performed.</td>
</tr>
<tr>
<td>Pre script</td>
<td>Write the script you want to run before the data is imported. This field is visible if you selected the Execute pre-import script check box.</td>
</tr>
<tr>
<td>Execute post-import script</td>
<td>Select this check box if you want to write a script to be run after the import is performed.</td>
</tr>
<tr>
<td>Post script</td>
<td>Write the script you want to run after the import finishes. This field is visible if you selected the Execute post-import script check box.</td>
</tr>
</tbody>
</table>

3. To stop an import that is taking too much time, navigate to System Import Sets > Advanced > Progress.
4. Open the Progress Worker that must be canceled.
5. Under Related Links, click Cancel job.
### Scheduled data import scripting options

Multiple JavaScript objects are available in the Scheduled Data Import **Pre script** and **Post script** fields.

#### Data import scripting options

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>cancel</td>
<td>Set this object to true to stop the import action.</td>
<td>Use the <strong>Pre script</strong> field to evaluate the conditions of the import and determine whether to cancel the import process. To cancel the import process, use the following call: <code>cancel = true;</code></td>
</tr>
</tbody>
</table>
| import_set  | Get the GlideRecord object for the new import set. This variable allows you to query the following columns from the sys_import_set table: number, sys_id, state, table_name | If you want to use information from the import set, you can specify one of the properties of the import_set variable.

```javascript
var x = import_set.number;
```

| data_source | GlideRecord of the data source to be used for the scheduled import. | Typically, you define the data source with the Scheduled Data Import record. If you want to access this data source or modify the data source in certain conditions, you can use the following.

```javascript
data_source.import_set_table_name = 'new_set_from_scheduler';
data_source.update();
```

---

**Post CSV or Excel files directly to an import set**

An administrator can post CSV or Excel files directly to instance.

**Role required:** import_set_loader

The `sys_import.do` target lets you dynamically upload a CSV or Excel file into the import set table specified by the `sysparm_import_set_tablename` parameter. You must specify a name that matches an existing import set table name. If the import set table does not exist, pre-create it by performing a manual import. The `sysparm_transform_after_load=true` parameter causes the CSV transform to be executed immediately, if a transform map exists.

You can upload a file using POST to the following URL (replace placeholders with desired values):

```
https://<instance>.service-now.com/sys_import.do?
sysparm_import_set_tablename=<table_name>&sysparm_transform_after_load=<true>
```

**Important:** The body of the POST must contain the file as a multi-part attachment.
Posting a CSV file - Perl and Java examples
An example using Perl to post a CSV file with basic auth credentials and Java Apache HttpClient class to post a CSV file with basic auth credentials.

Perl example

```perl
#!/usr/bin/env perl

use strict;
use LWP::UserAgent;
use HTTP::Request::Common;
use Getopt::Long;
use File::Basename;

my ( $o_url, $o_fqn );
GetOptions(
    "url=s"        => \$o_url,
    "uploadfile=s" => \$o_fqn,
);

# mandatory arguments: url
&usage unless ( \$o_url && \$o_fqn );

my $url   = \$o_url;
my $fname = \$o_fqn;

# put timeouts, proxy etc into the useragent if needed
my $ua = LWP::UserAgent->new();

# setup basic authentication credentials
$ua->credentials(
    'demo.service-now.com:443',
    'Service-now',
    'admin' => 'admin'
);

my $req = POST $url, Content_Type => 'form-data',
    Content => [ submit => 1,
                 upfile => [ $fname ] ];
my $response = $ua->request($req);

if ($response->is_success()) {
    print "OK: ", $response->content;
} else {
    print $response->as_string;
}
exit;

sub usage {  
    © 2019 ServiceNow, Inc. All rights reserved.
    ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States
    and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
}  
```

Usage:
```
uploadafile.pl --url="https://instance.service-now.com/sys_import.do?
                    sysparm_import_set_tablename=dloo_test&sysparm_transform_after_load=true"
                    --uploadfile="/Users/davidloo/Desktop/test_files/test_users.csv"
```
printf "usage:%s --url=%s --uploadfile=%s\n",
    basename($0),'https://....','c:/data/test.csv';
exit
}

Java example

**Attention:** The Apache HttpClient may limit the amount of data you can import in a single transaction. This example is meant as a starting point and should not be used in production.

```java
HttpClient httpclient = new HttpClient();
PostMethod post = new PostMethod("https://instance-name.service-now.com/sys_import.do?
    sysparm_import_set_tablename=u_test_upload&sysparm_transform_after_load=true");
try {
    Credentials defaultcreds = new UsernamePasswordCredentials("admin", "admin");
    httpclient.getState().setCredentials(AuthScope.ANY, defaultcreds); // Prepare HTTP post
    httpclient.getParams().setAuthenticationPreemptive(true);
    File targetFile = new File("/Users/davidloo/Desktop/test_files/nodeinfo2736820198834983863.csv");
    Part[] parts = { new FilePart(targetFile.getName(), targetFile) };
    post.setRequestEntity(new MultipartRequestEntity(parts, post.getParams()));
    int result = httpclient.executeMethod(post);

    // Display status code
    System.out.println("Response status code: " + result);

    // Display response
    System.out.println("Response body: "+post.getResponseBodyAsString());
} catch(Exception e) {
    System.err.println(e.getMessage());
} finally {
    // Release current connection to the connection pool
    post.releaseConnection();
}

Import Sets properties

Multiple properties control Import Set behavior.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `glide.import_set.preserve.leading.spaces` | Specifies whether the import process preserves leading spaces in Excel data cells. When false, the import process removes leading spaces from Excel data cells. When true, the import process preserves leading spaces.  
  **Attention:** The import process always removes trailing spaces from Excel data cells.  
  - Type: true | false  
  - Default value: false  
  - Location: [Add the property](#) |
| `glide.import_set_row.dynamically_add_fields` | Specifies whether an import set can add new columns to the staging table (true) or not (false). Instances that contain large numbers of import sets can sometimes become unresponsive when an import adds a column because the instance must alter every row in the staging table. In some cases, the database alter table action causes an outage. Setting this property to false prevents an import set from adding columns to the staging table and produces a log message. As a workaround, administrators can manually add a column to the staging table by creating a new dictionary entry and then reimporting the import set.  
  - Type: true | false  
  - Default value: true  
  - Location: [Add the property](#) |
| `com.glide.loader.verify_target_field_size` | Enables dynamic resizing of import set fields. By default, up to 20 records of the source data are sampled to determine the import set field length. If the field is empty in all the sampled records, the default length of 40 is used. Any data loaded that exceeds the import set table field length is truncated.  
  - Type: true | false  
  - Default value: true  
  - Location: [Add the property](#) |
| `glide.ds.file.http.variable_replacement` | Enables system property expansion for File-type data sources that are retrieved using HTTP or HTTPS.  
  - Type: true | false  
  - Default value: true  
  - Location: [Add the property](#)  
  - More information: [Data source fields](#) |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.scheduled_import.stop_on_error</td>
<td>Set this object to true to stop the import process when the parent scheduled import generates an error. This behavior can be useful when one import set depends on the results of another import set.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>glide.impex.transformer.empty_value_nil</td>
<td>Controls how empty string values are handled during transformation from an import set staging table. Set this property to true to preserve empty strings. Set this property to false to convert empty strings to the string 'NULL'.</td>
</tr>
<tr>
<td></td>
<td>Note: An empty string is always stored as a null value in the database, regardless of this property value.</td>
</tr>
<tr>
<td></td>
<td>You can use this property when you run an onBefore script during transformation. Setting this property to true allows you to check for null values using hasValue() or nil() functions.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>com.glide.loader.max_scan_rows</td>
<td>Controls how many rows of source data are sampled to automatically generate staging table fields when you import data. This property applies to JDBC, XLS, CSV, and XML imports but not to JSON and XSLX imports.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 20</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
</tbody>
</table>

### Web Service Import Sets properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.ws_import_set.column_resize</td>
<td>When true, enables dynamic column resizing on import staging tables for web service import sets.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.glide.ws_import_set.column_resize.max_row_count</td>
<td>The maximum number of rows an import staging table can have for dynamic column resizing with web service import sets. Import staging tables with more than this number of rows will not use dynamic resizing with web service import sets, even if com.glide.ws_import_set.column_resize is true. This property has a maximum value of 500,000.</td>
</tr>
<tr>
<td></td>
<td>- Type: Integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 100,000</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
</tbody>
</table>

**CSV properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.csv.loader.ignore_non_parseable_lines</td>
<td>Allows an instance to ignore one or more lines (rows) that contain bad data in a CSV import, such as a row that is missing a column of data. By default, imports cannot ignore bad data in CSV files and fail on the first error.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
</tbody>
</table>

| com.glide.csv.loader.max_errors_allowed                   | Specify the maximum number of lines (rows) that an import can ignore before failing. If the import succeeds, the import lists the number of rows the import ignored due to errors. |
|                                                           | - Type: integer                                                                                                                                     |
|                                                           | - Default value: 100                                                                                                                                |
|                                                           | - Location: [Add the property](#)                                                                                                                      |

| glide.import.csv.charset                                  | The charset of the CSV file to import. Valid values are UTF-8 and WINDOWS-1252. You may need to use UTF-8 formatting when importing special characters.                                      |
|                                                           | - Type: String                                                                                                                                       |
|                                                           | - Default value: WINDOWS-1252                                                                                                                          |
|                                                           | - Location: [Add the property](#)                                                                                                                      |
### Excel import properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.excel.multiplier          | The maximum amount of instance memory to allocate to an Excel import. This property applies when importing .XLS files only. The value of this property is multiplied by the file size of the Excel file to determine the total memory allocation. The memory used cannot exceed the limit specified by the glide.excel.max_memory_percent property. For example, with the default value 8 and a 10MB Excel file, the instance will use up to 80MB of memory for the import.  
  - Type: integer  
  - Default value: 8  
  - Location: Add the property |
| glide.xlsx.multiplier           | The maximum amount of instance memory to allocate to an Excel import. This property applies when importing .XLSX files only. The value of this property is multiplied by the file size of the Excel file to determine the total memory allocation. The memory used cannot exceed the limit specified by the glide.excel.max_memory_percent property. For example, with the default value 10 and a 10MB Excel file, the instance will use up to 100MB of memory for the import.  
  - Note: Do not modify the value of this property. The default value was selected for optimal performance.  
  - Type: integer  
  - Default value: 10  
  - Location: Add the property |
| glide.excel.max_memory_percent  | The maximum amount of memory allowed for Excel imports, as a percentage of the total instance memory.  
  - Type: integer  
  - Default value: 20  
  - Location: Add the property |
| glide.excel.use_disk_backed_strings_table | Controls if the instance uses disk storage to maintain large file data during XLSX import. Set this property to false to store XLSX file data only in memory. Setting this property to false increases the memory used during XLSX import.  
  - Type: true | false  
  - Default value: true  
  - Location: Add the property |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.excel.in_memory_strings_table_size_mb</td>
<td>The maximum amount of memory, in megabytes, available to store XLSX file data before writing to disk storage when glide.excel.use_disk_backed_strings_table is true. Setting a lower value for this property will use less memory during XLSX import but may result in slower imports.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 5</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>glide.xlsx.import.debug</td>
<td>Enables debug logging for XLSX imports.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: false</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>glide.import.excel.enhanced_number_conversions</td>
<td>When true, numeric values greater than 10 million are preserved in import staging tables. When false, imported values greater than 10 million are converted to scientific notation that may not match the original imported value. This property should be set to true for importing most kinds of data.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
</tbody>
</table>

**JDBC Connection Properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.jdbcprobeloader.retry</td>
<td>The number of times a JDBC probe loader attempts to process data returning from a JDBC data source. Sleeps on the value defined in &quot;glide.jdbcprobeloader.retry_millis&quot; between retries.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 60</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
<tr>
<td>glide.jdbcprobeloader.retry_millis</td>
<td>How many milliseconds a JDBC probe loader waits in between retry attempts to process data from a JDBC data source.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 5000</td>
</tr>
<tr>
<td></td>
<td>- Location: <a href="#">Add the property</a></td>
</tr>
</tbody>
</table>
Logging and debug properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.import_set.importlog_level</td>
<td>Specifies how much information import sets add to the log. Possible values are INFO, WARNING, and ERROR. You can set this to INFO in dev environment and change it to WARNING or ERROR in production to reduce amount of logging noise traffic to the database.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property does not impact logging related to the cleanup of staging tables.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: INFO</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property</td>
</tr>
<tr>
<td>glide.import.debug</td>
<td>Enables debug logging for all import processes.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import.sftp.debug</td>
<td>Enables additional debug logging for SFTP imports. Enabling this property will cause the instance to log all outgoing and incoming messages during the SSH session.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Property (sys_properties) table</td>
</tr>
<tr>
<td>glide.import.scp.debug</td>
<td>Enables additional debug logging for SCP imports. Enabling this property will cause the instance to log all outgoing and incoming messages during the SSH session.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Add to the System Property (sys_properties) table</td>
</tr>
</tbody>
</table>

Web service import sets

Web Service Import Sets complement Direct Web Services and Scripted Web Services in providing a web service interface to Import Set tables.
This type of web service will transform the incoming data synchronously based on the associated transform maps by default. If the associated import set mode is set to Asynchronous, the behavior is to save the data for transformation at a later time. Web Service Import Sets tables publish all the default Web Service functions in the WSDL.

Web service import set WSDL are accessed by specifying the import set table name + ".do?WSDL" on the URL. For example:

http://<instance name>.service-now.com/imp_notification.do?WSDL (The System Web Service plugin must be enabled first)

**Creating an import set web service**

Create a web service import set table to define how to stage and transform imported data.

Navigate to **System Web Services > Create New**.
Create Mapped Web Service

The Name of the web service is the table name of the import set table whereas the Label field is the resulting table field.

If you want to create a transform map after creating the web service, check the Create transform map checkbox and choose the target table you want the data to transform into. After the Create button is clicked, the web service will be created and you will be immediately put into the Table Transform Map form. You may then continue to specify the transform map or script.

Web Service Fields

The fields available for this web service. All fields by default are published as the XSD type of xsd:string. The Name is the field that is exposed for the web service and therefore appears as the name of the field in the WSDL. The Label is the label of the field as it appears for the import sets table.

You can Add, mark for Delete or modify (double-click the field) an existing web service field in this list.

Note: After adding web service fields, click Create to create the web service import set table.

To add other fields after the Web Service is created, find the target table, and add the fields to that table.
Mapping web service import sets

During the creation of the web service import set, you may optionally create the transform map for it.

All transform maps are executed for the service when it is invoked and the import set mode is set as "Synchronous" (the default).

The following image is an example of the transform map associated with the Notification web service import set.
### Table Transform Map

<table>
<thead>
<tr>
<th>Name</th>
<th>SOAP notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source table</td>
<td>notification [soap_notification]</td>
</tr>
<tr>
<td>Created</td>
<td>2008-12-17 14:39:29</td>
</tr>
<tr>
<td>Target table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Order</td>
<td>100</td>
</tr>
</tbody>
</table>

#### Script

```
target.comments = "Timestamp: " + source.timestamp + 
    "\nExpires on: " + source.expires_on + 
    "\nDuration: " + source.duration;
```

### Related Links

- Mapping Assist
- Auto map matching fields

### Field Maps

<table>
<thead>
<tr>
<th>Source field</th>
<th>Target field</th>
<th>Coalesce</th>
</tr>
</thead>
<tbody>
<tr>
<td>duration</td>
<td>calendar_duration</td>
<td>false</td>
</tr>
<tr>
<td>severity</td>
<td>severity</td>
<td>false</td>
</tr>
<tr>
<td>uid</td>
<td>correlation_id</td>
<td>true</td>
</tr>
<tr>
<td>assignment_group</td>
<td>assignment_group</td>
<td>false</td>
</tr>
</tbody>
</table>

**Soap Transform Map**

© 2019 ServiceNow, Inc. All rights reserved.
Adding Web Service Response Values

In the transform map script associated with a web service import set, some variable values can change the response values of the web service. In addition to the normal variables that are available in a transform map script, the table documents the variables that are available and their effects.

### Adding Web Service Response Values

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>response</td>
<td>Output Object</td>
<td>Javascript object that holds dynamically created response elements used to customize the output response of a web service import set insert.</td>
</tr>
</tbody>
</table>

**Example**

```java
// create new elements called "transaction_id"
// and "hello" in the web service response
response.transaction_id="abc123";
response.hello="world";
status_message="message 1";
// this is the normal status_message variable
```

The code snippet example results in the following response being generated back to the web service consumer:

```
<soapenv:Envelope xmlns:imp="http://www.service-now.com/imp_notification"

xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
<soapenv:Header/>
<soapenv:Body>
<insertResponse xmlns="http://www.service-now.com/imp_notification">
<sys_id>969d157c0a0a0baf008ba5770ffa798c</sys_id>
<table>incident</table>
<display_name>number</display_name>
<display_value>INC0010091</display_value>
<status>inserted</status>
<status_message>message 1</status_message>
<transaction_id>abc123</transaction_id>
<hello>world</hello>
</insertResponse>
</soapenv:Body></soapenv:Envelope>
```

**Debugging web service import sets**

To debug a SOAP Request coming into the system, create the system property glide.processor.debug.SOAPProcessor.

Once you have created it, set it to true to have all SOAP requests be logged in the System Log. Set it to false when you are done to keep the size of your System Log to a managed length.

**Web service import set mode**

When a SOAP message inserts a record into an import set table, and there is no import set for that table in the *Loading* state, a new import set will be created with the *Mode* set to *Synchronous*. 
An import set with a Mode of Synchronous will transform the data as soon as it is inserted (provided that the transform map already exists). This import set will also have a default State of Loading. By default, all Synchronous import sets will automatically be modified to Processed at midnight. As a result, when a new insert happens to the same table, a new Synchronous import set will be created.

Synchronous import set

Changing this import set to a mode of Asynchronous and a state of Loading has the effect of not transforming the incoming data as it is inserted, but rather "loading" the import set and deferring the data transformation later, either manually, or with a scheduled script job.

<table>
<thead>
<tr>
<th>Mode</th>
<th>State</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous</td>
<td>Loading</td>
<td>Data transformation is not occurring automatically and immediately. Data added to import set row has a state of &quot;Pending&quot;. Transform can be scheduled or executed manually when state is changed to Loaded</td>
</tr>
<tr>
<td>Asynchronous</td>
<td>Loaded</td>
<td>Marks the completion of data loading. Data transformation can now occur in a scheduled fashion or manually.</td>
</tr>
<tr>
<td>Synchronous</td>
<td>Loading</td>
<td>Data transformation is occurring automatically and immediately whenever data is inserted into the associated import set row.</td>
</tr>
</tbody>
</table>
Controlling Insert Behavior

In imports sets that specify one or more coalesce fields, records with a matching coalesce value are transformed from source to target table serially (one at a time) to prevent duplicates.

In import sets that do not specify any coalesce field, records are transformed concurrently. You can control this behavior using the `glide.import_set_insert_serialized_when_no_coalesce` property.

The `glide.import_set_insert_serialized.<table name>` system property controls how the instance inserts records from web service calls into a specific import set table. When true, this property prevents identical simultaneous inserts from creating duplicate records by serializing the database insert operations. If a target table does not have any coalesce fields defined in a transform map, set this property to false to improve web service import set performance.

**Note:** Setting this property to false can result in the creation of duplicate records.

**Note:** The `glide.soap.import_set_insert_serialized.<table name>` system property provides equivalent functionality to `glide.import_set_insert_serialized.<table name>`, but if both properties are defined, `glide.import_set_insert_serialized.<table name>` supersedes `glide.soap.import_set_insert_serialized.<table name>`.

Standard SOAP Response

The SOAP response from a web service import set insert call returns the following standard values:

```
 xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/"
```

**Standard SOAP Response**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>The Sys_id of the resulting record that was created or modified</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>table</td>
<td>The table name of the table that was affected. In the case of an Asynchronous call, the table name would be the import set table eg. imp_notification for the Notifications web service import set table</td>
</tr>
<tr>
<td>display_name</td>
<td>The name of the field that is set as the display field for the record that was created or modified</td>
</tr>
<tr>
<td>display_value</td>
<td>The value of the field designated as the display field. For example, the display field for the Incident table is the Number field and an example value would be INC10001</td>
</tr>
<tr>
<td>status</td>
<td>A string value that indicates the action that occurred as a result of the web service invocation, relating to the record defined by the sys_id and table field values</td>
</tr>
<tr>
<td>status_message</td>
<td>This value translates to the value found in the Comment field of the import set row and usually contains information related to the status value eg. &quot;No field values changed&quot; when the status is &quot;ignored&quot;. Setting this value to a customized string value will cause the SOAP response to contain an optional status_message field to be returned.</td>
</tr>
<tr>
<td>error_message</td>
<td>The message related to a status of error. When an error occurs, setting this value to a customized string value will cause the SOAP response to contain an optional error_message field to be returned.</td>
</tr>
</tbody>
</table>

**Tailoring the SOAP Response**

It is possible to include information other than the information specified in the WSDL by overwriting the contents of status_message using the transform script.

**Inserting multiple records using insertMultiple**

You can insert multiple records in one SOAP request by using the insertMultiple operation.

By default, insertMultiple operations create new import sets in **Synchronous** mode. To process new import sets asynchronously, activate the business rule Insert multiple asynchronous mode.

The insertMultiple operation is available for the Direct Web Service API and Web Service Import Sets. To enable insertMultiple, activate the Insert Multiple Web Service plugin.
**Note:** Activating this plugin adds a new operation to the SOAP WSDL. After this plugin is activated, consume a new WSDL to update your web services client.

**Web service import sets security requirements**

Web Service Import Sets use the same security mechanisms as SOAP Web Services.

- Basic authentication requires a Web Service user provide a valid user name and password.
- Contextual security requires a Web Service user meet the access control rule of the queried table.

If your instance uses high security settings, the Web Service user may also need the soap role.

**Web service import sets related links**

When displaying a mapped web service table, you have the following related links.

- **Import Sets** — The import sets related to this web service import set.
- **Transform Maps** — A list of transform maps related to this web service.
- **Transform History** — The transformation history.
- **Edit Web Service** — Edit the web service.

The following image shows a record that was inserted into the web service import set Notification. The target record is the resulting creation or modification to the Incident table record as a result of the transform.

![Notification Table](image)

**Related Links**

- Import Sets
- Transform Maps
- Transform History
- Edit Web Service

---

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Web service import sets example

This example demonstrates the WSDL, SOAP envelope and response, Perl invocation, and result of a SOAP web service import.

Sample WSDL

```xml
<?xml version="1.0" encoding="UTF-8"?>
  <xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema" elementFormDefault="unqualified"
    targetNamespace="http://www.service-now.com/imp_notification">
    <xsd:element name="insert">
      <xsd:complexType>
        <xsd:sequence>
          <xsd:element maxOccurs="1" minOccurs="0" name="corrective_message" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="duration" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="expires_on" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="message" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="severity" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="source" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="timestamp" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="type" type="xsd:string"/>
          <xsd:element maxOccurs="1" minOccurs="0" name="uuid" type="xsd:string"/>
        </xsd:sequence>
      </xsd:complexType>
    </xsd:element>
    <xsd:element name="insertResponse">
      <xsd:complexType>
        <xsd:sequence>
          <xsd:element name="sys_id" type="xsd:string"/>
          <xsd:element name="table" type="xsd:string"/>
          <xsd:element name="display_name" type="xsd:string"/>
          <xsd:element name="display_value" type="xsd:string"/>
          <xsd:element name="status" type="xsd:string"/>
          <xsd:element name="status_message" type="xsd:string"/>
        </xsd:sequence>
      </xsd:complexType>
    </xsd:element>
  </xsd:schema>
  <wsdl:message name="insertSoapOut"> <wsdl:part name="tns:insertResponse"/>
  </wsdl:message>
  <wsdl:message name="insertSoapIn"> <wsdl:part name="tns:insert"/>
  </wsdl:message>
  <wsdl:portType name="ServiceNowSoap">
    <wsdl:operation name="insert">
      <wsdl:input message="sn:insertSoapIn"/>
      <wsdl:output message="sn:insertSoapOut"/>
    </wsdl:operation>
  </wsdl:portType>
  <wsdl:binding name="ServiceNowSoap" type="sn:ServiceNowSoap" soap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http"> <wsdl:operation name="insert">
    <wsdl:input soap:body use="literal"/>
    <wsdl:output soap:body use="literal"/>
  </wsdl:binding>
</wsdl:portType>
</wsdl:definitions>
```
Sample SOAP Envelope

```xml
<?xml version="1.0" encoding="UTF-8"?>
  <SOAP-ENV:Body>
    <insert xmlns="http://www.service-now.com">
      <message xsi:type="xsd:string">Host 198.10.10.210 is down</message>
      <uuid xsi:type="xsd:string">HGAF76251HGF1</uuid>
    </insert>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
```

Sample SOAP Response

```xml
<?xml version="1.0" encoding="UTF-8"?>
  <SOAP-ENV:Body>
    <insertResponse>
      <sys_id>b54aafbf0a8006f0058db95daa5b88d</sys_id>
      <table>incident</table>
      <display_name>number</display_name>
      <display_value>INC10008</display_value>
      <status>ignored</status>
    </insertResponse>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
```

Example Invocation using Perl

The following example script uses the Notification web service to create an Incident as the itil user. It uses the Perl language and the SOAP::Lite package.

```perl
#!/usr/bin/perl -w
use SOAP::Lite ( +trace => all, maptype => {} );
sub SOAP::Transport::HTTP::Client::get_basic_credentials
{
  return 'itil' => 'itil';
}
my $soap = SOAP::Lite->proxy('http://localhost:8080/glide/imp_notification.do?SOAP');
my $method = SOAP::Data->name('insert')->;attr({xmlns =>'http://www.service-now.com/'});
# insert into the web servicemy@params=( SOAP::Data->name(message =>'problem
detected for database DB12DG'));push(@params, SOAP::Data->name(source =>'DB12DG'));push(@params, SOAP::Data->name(uuid =>'HGAF76251HGF2'));
my $result = $soap->call($method=>@params);
print_fault($result); //print any SOAP faults
print_result($result); //print any results
sub print_result {my($result)=@_;if($result->body&&$result->body->{'insertResponse'}){
  my $keyHash = %{$result->body->{'insertResponse'}};
  foreach my $k (keys %keyHash) {
    print "name=$k value=$keyHash->{$k}\n";
  }
  
```
The following is the result printed by the Perl script on the console.

```
name=display_value value=INC10011
name=status value=inserted
name=table value=incident
name=display_name value=number
name=sys_id value=cd45649c0a0a0b2b00e6f27649d6bd2c
```

The following image shows the resultant row created for the import set table Notification (imp_notification).

```
WS Iset Perl

Easy import

Easy import is a simplified import process that enables you to import only the columns you want. Only admins can use easy import. You can import data to tables within the current scope and tables that grant write access to other applications.

Easy import template validation

Each import template must pass two sets of validation.

<table>
<thead>
<tr>
<th>Type of validation</th>
<th>Stored in</th>
<th>Results of failing validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client-side validation</td>
<td>Import template</td>
<td>The template highlights the invalid cell.</td>
</tr>
</tbody>
</table>
```
Download an import template

Select the list you want to import data to and create an import template from that list.

Role required: admin

1. Navigate to any list, such as **Self-Service > Incidents**.
2. Right-click the column heading.
3. Select **Import**.
4. Select if you want to **Insert** or **Update** records.

### Import template

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Use this template to add new records to a table.</td>
</tr>
<tr>
<td>Update</td>
<td>Use this template to change values within existing records in a table. This template contains one row for each record in the list. The current list filter determines what records the template contains.</td>
</tr>
</tbody>
</table>

5. Optional: Clear the **Include all fields in the template?** check box to include only columns that appear in the list in the template. Certain fields in the table are updated by system processes, and you cannot import values into them. An example is the **Created by** field, which is populated during import with the logged-in user who performs the import. Leave this check box selected to include all columns from the table in the template, even those columns that are hidden in the list.

6. Select the **Export template format** you want, either **XLS** or **XLSX**.
XLSX is the preferred format. XLS is available for legacy support. The Export template format field appears only if the property glide.legacy.excel.export is true.

7. Click Create Excel template.

Open the spreadsheet using your preferred application.

Note: Each template contains a Directions tab describing how to use the template.

Add a record in the template

Add rows to the template to create new records.

Role required: admin

Note: The template only imports records on the first page of the template. The import process ignores all other pages.

Easy import insert template

1. Add a row for each record you want to add to the table. Each column corresponds to a field in the target table. Use the UI field hints to learn about the purpose and content of the field.

   The template validates values as you enter them and highlights cells containing invalid data. While you do not have to provide a value for every column, certain fields may fail validation if you do not provide a value.

2. Review any highlighted cell and resolve the issue.

3. When you finish entering new rows, save the spreadsheet as an Excel Workbook.

   The insert templates uses special processing for certain fields:
   - Created by Field: The insert template always lists the system administrator user (admin role) in the Created by field regardless of whether the import includes a Created by column. Even if you provide a different user value in the template, the import process overwrites this value with the system administrator user.
• Blank Values: Leaving a cell blank in the insert template results in a blank value in the imported record, provided the field supports a blank value. Fields that do not support a blank value will produce a validation error if you provide a blank value.

Update a record in the template

Modify rows in the template to update existing records.

Role required: admin

Note: The template only imports records on the first page of the template. The import process ignores all other pages.

Easy import update template

1. Edit the row for each existing record to be updated. Replace existing values with new values. Use the UI field hints to learn about the purpose and content of the field.

   The template validates values as you enter them and highlights cells containing invalid data. While you do not have to provide a value for every column, certain fields may fail validation if you do not provide a value.

2. Review any highlighted cell and resolve the issue.

3. When you finish updating existing rows, save the spreadsheet as an Excel Workbook (.xls).

The insert templates use special processing for certain fields:

• Updated by Field: The update template always lists the system administrator user (admin role) in the Updated by field regardless of whether the import includes an Updated by column. Even if you provide a different user value in the template, the import process overwrites this value with the system administrator user.

• Blank Values: The update template uses these rules when handling blank values in spreadsheet cells.
### Blank values

<table>
<thead>
<tr>
<th>Original Value</th>
<th>New Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank value</td>
<td>Any non-blank value</td>
<td>Valid update: the update changes the blank value to the new value.</td>
</tr>
<tr>
<td>Any non-blank value</td>
<td>Blank value</td>
<td>Invalid update: the update preserves the existing non-blank value.</td>
</tr>
</tbody>
</table>

### Import a record from the template

After updating the import template with new data, import the template to your instance.

Role required: admin

1. Navigate to the same list you used to download the import template.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Action</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click the column heading and select <strong>Import</strong></td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select <strong>Import</strong></td>
</tr>
</tbody>
</table>
3. From Insert or update, select the import type.
4. From File, select the import template to import.
5. Click **Upload and Preview Import Data**.

   ServiceNow validates the template.

   If the template passes validation and the imported preview matches your expectations, click **Complete Import** to import records into the current table. If the template fails validation,
review the errors. Click **Ignore Errors and Complete Import** to continue the import by skipping any bad data cells.

**Easy import template validation**

Each import template must pass two sets of validation.

**Template validation**

<table>
<thead>
<tr>
<th>Type of validation</th>
<th>Stored in</th>
<th>Results of failing validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client-side validation</td>
<td>Import template</td>
<td>The template highlights the invalid cell.</td>
</tr>
<tr>
<td>Server-side validation</td>
<td>Instance</td>
<td>The import pauses and displays an error message.</td>
</tr>
</tbody>
</table>

**Template data validation**

Some cells in the template contain calculations or validation rules. These rules are intended to help you enter data that is appropriate for the field (column).

If you want to paste data from another spreadsheet, use the Paste Special command to paste only values or match the existing formatting.
Easy import paste special

Paste special values only
Template type validations
Server-side validation verifies that the import template contains the necessary format.

**Template type validation**

<table>
<thead>
<tr>
<th>Template type</th>
<th>Validation done</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert template</td>
<td>• Template contains a header row with valid field names.</td>
</tr>
<tr>
<td></td>
<td>• Template contains one or more data rows.</td>
</tr>
<tr>
<td></td>
<td>• Template does not contain a sys_id column.</td>
</tr>
<tr>
<td>Update template</td>
<td>• Template contains a header row with valid field names.</td>
</tr>
<tr>
<td></td>
<td>• Template contains one or more data rows.</td>
</tr>
<tr>
<td></td>
<td>• Template contains a sys_id column to match a row to an existing record.</td>
</tr>
</tbody>
</table>

Data type validations
Both client-side and server-side validation verify that template cells contain data that matches the ServiceNow field type.

**Data type validations**

<table>
<thead>
<tr>
<th>ServiceNow field type</th>
<th>Validation done</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice list</td>
<td>Cell contains a value that matches a choice option from the choice list.</td>
</tr>
<tr>
<td>Integer</td>
<td>Cell contains a number without any decimal points.</td>
</tr>
<tr>
<td>Reference</td>
<td>Cell contains a value that matches an existing related record. This validation applies only to</td>
</tr>
<tr>
<td></td>
<td>fields in which the list of possible choices is relatively small and mostly static. It does not</td>
</tr>
<tr>
<td></td>
<td>apply to fields such as “Assigned To” in which the list of possible choices is dynamic and large.</td>
</tr>
<tr>
<td></td>
<td>Validation takes place when the data is inserted into the database, but not in Excel.</td>
</tr>
</tbody>
</table>

**Note:** When you enter reference field values in the Excel spreadsheet, enter the display value and not the sys_id of the referenced record. Enter this value the same as you would on a form. For example, for a reference to a user record, enter the username.

| True | False | Cell contains a true or false value. |

Easy import properties
Several properties control the behavior of easy import.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.import_template.row_limit</td>
<td>Controls the maximum number of rows included in an easy import template. By default, if a table contains more than 10,000 records, only the first 10,000 are exported.</td>
</tr>
</tbody>
</table>
|                                   |  - Type: Integer  
|                                   |  - Default value: 10,000  
|                                   |  - Location: Add the property                                                                                                                                                                              |
| glide.easy_import.run_business_rules | When true, business rules, workflows, approval engines, auditing, and field normalization apply when easy import inserts or updates data. This functionality is equivalent to setting GlideRecord.setWorkflow() to true or false. |
|                                   |  - Type: true | false  
|                                   |  - Default value: true  
|                                   |  - Location: Add the property                                                                                                                                                                              |
| glide.import_template.field_types_to_ignore | A list of fields that will be ignored when a record is imported with easy import feature.                                                                                                                       |
|                                   |  - Type: String  
|                                   |  - Default value: table_name, order_index, collection, user_image, video, timer, translated_field, conditions, field_name, sys_class_name, journal, journal_input, due_date, user_input, image, workflow, template_value, domain_id, documentation_field, user_roles, glide_list |
|                                   |  - Location: Add the property                                                                                                                                                                              |

**Troubleshoot import set performance**

Review these performance issues to troubleshoot and improve the performance of your import set jobs.

**Running business rules during transform**

Running business rules during transform may cause the transform to take longer than expected, or cause the instance to slow down.

**Becomes an issue:** When importing a very large amount of data. For example, importing all data from an old system.

**Symptoms:** The transform takes much longer than expected. Also, the entire instance may be slow during that time.

**How to avoid this:** Do not run items like business rules, workflows, approval engines, and so on during a transform unless you want all insert and update business rules, notifications, and workflows to run. For example, when importing all data from an old system, you may not want notifications to run. To disable these items from running and to cease auditing and field normalization within the transform map for that import, deselect the **Run business rules** check box.
Note: Consider using an onComplete transform script to run business logic such as calculations at the end of an import rather than on each record as business rules do.

Slow transform scripts
Using multiple GlideRecord queries or large loops may slow down transform scripts.

Becomes an issue: When the transform scripts are using multiple GlideRecord queries or looping through large collections of objects for each row. This issue may appear when the transform script is not efficient. In most cases, script goals can be accomplished using built-in functionality within the Import Set application. For example, you can script case-sensitive coalesce instead of writing scripts that use GlideRecord queries. GlideRecord queries typically slow down the import.

Symptoms: The transform takes much longer than would be expected. Depending on the script, the entire instance may be slow during that time.

How to avoid this: Use base system functionality whenever possible instead of writing custom scripts and if you do write scripts, avoid writing complicated scripts that use GlideRecord queries.

Importing data that has not changed
Repeatedly importing data that has not changed leads to many skipped rows.

Becomes an issue: When a customer is importing data from a table that is very large and most of the records are not getting updated on a regular basis.

Symptoms: The import set takes longer than expected. Under System Import Sets > Progress, expect to see an import with a Total count that is very high with a Skipped count that is also very high - this is found under the Message column. Indicating that most of the records imported had not actually changed. These records did not need to be imported.

How to avoid this: If you are running a JDBC import, use the last run datetime option in your import set Data Source. For a type of File import, be sure that whatever is generating your files is only adding data that is new, or has been changed.

Coalescing on non-indexed fields
Coalescing on non-indexed fields with a large amount of data may cause transforms to slow down.
Becomes an issue: When matching on fields that are not indexed, this causes the transform stage of an import to run slowly. However, it only becomes an issue if there is a large enough amount of data. In extreme cases, this causes performance issues with the database due to added load.

Symptoms: Time spent in the transform stage of the import is large relative to the time taken to load the data. Expect to see high transform times.

How to avoid this: If possible, you should coalesce on a field that unique and already indexed. To determine if a field is already indexed, navigate to System Definition > Tables & Columns and find the table. In the list of columns for that table, an indexed column has a blue icon with an i next to it if indexed. For assistance indexing a field contact ServiceNow Technical Support.

Running imports simultaneously

Running imports simultaneously may cause excessive load on the database. Becomes an issue: When importing large amounts of data puts an additional load on the database. For example, importing 500,000 users and importing 200,000 configuration items at the same time. This can have a significant performance impact on all queries on the system due to the increased load on the database. This issue is especially severe when two imports are importing to the same table. In such a case, there is a possible contention issue for the table. Additionally, depending on which table is involved in processing, this can severely degrade performance of the import and the instance.

Symptoms: Multiple simultaneous imports running slowly combined with load on the database. You see large numbers of inserts and updates along; and if there is enough load or contention, high IO Wait times.

How to avoid this: Stagger your imports so they do not overlap.

Large import set tables

Failing to clean import set tables may lead to those tables becoming cluttered and slow. Becomes an issue: When the Import Set Deleter job is not running.

Symptoms: This is a size issue. If the import sets are not cleaned on a regular basis (a cleanup is recommended after seven days worth of data) the table fills causing imports to stop.

How to avoid this: Verify the Import Set Deleter job is running. If it is not currently running, contact ServiceNow Technical Support as they will truncate all import set tables before enabling this job.

Altering table schema during import

Changing the table schema, such as by importing a new column locks the import set table. Becomes an issue: Any time a new column is imported, the entire import set table is locked during that schema change and depending on the size of the table, can take between five and ten minutes. During that time, no data can be selected or inserted. If that table is not used often, this may not cause any problems. However, if that table is frequently used, for example the LDAP import table, issues may arise.

Symptoms: The symptoms of this problem may vary. In our example of the LDAP import table, any transactions requiring a query of the LDAP import table will have to wait until the schema change has completed. As the LDAP import table is used when logging into the instance, no users are able to log in while the schema change is happening.

How to avoid this: Truncate the import table before importing with a new column.

Importing very large data sets

Importing a very large data set takes longer than importing multiple smaller data sets.
Becomes an issue: When very large data sets are imported in a single job.

Symptoms: The import job takes a long time to complete.

How to avoid this: Break a very large data set into multiple, smaller jobs for faster results. Consider import sets under 100,000 records as a guideline. For example, importing 10 sets of 100,000 records completes faster than one import of 1 million records even though the total data imported is the same.

**Importing from another ServiceNow instance**

There are several methods for moving data from one instance to another.

All of these methods assume you need to periodically move a collection of records from a table on one instance to a table on another instance. If you want an action on an individual record to trigger a corresponding action on another instance, consider using a REST web service instead.

**Identifying Needed Related Records**

All import processes work by fetching data from one table at a time. This process can produce unexpected results if the incoming data references new records in other tables such as users, locations, or companies. To prevent importing broken references to other tables you must identify the connections between your tables and import the common data prior to importing the application data.

For example, prior to importing incident data, you might want to first import related configuration items, users, and locations. Furthermore you might want to import incidents before importing problems or changes that refer to these incident records.

**Available Import Processes**

The system offers the following processes to move data from one instance to another.

- Export and import XML records directly from lists
- Create XML import sets and transform data as needed
- Export and import CSV files from lists

**XML records from lists**

You can directly export records as XML from any list or form.

This export process preserves all record field values including system generated field values such as:

- Sys ID
- Creation date
- Update date

The XML import process directly inserts records into the target table. During the import the system:

- Ignores any business rules that normally apply to the table.
- Does not provide any opportunity to transform incoming data.
- Automatically matches a reference field’s display value to the local Sys ID for some tables.

This process is good for directly copying records from one system to another but does not remove the need to know the relationships between tables. If you need validate or transform data or reconcile the sys ID values of reference fields, use an XML import set instead.
Automatic matching of display values
During the import of XML records, the system attempts to match some reference field display values to a local sys_id value.

If the system finds an existing record with a matching display value on the local instance, the import uses the sys_id of the existing record rather than the sys_id of the imported record.

For example, suppose you export an incident record that is assigned to the user John Smith. In the exported XML file there is an entry such as:

```
<incident>
  ...
  <assigned_to display_value="John Smith">7712173d2ba80200c5244f74b4da159a</assigned_to>
  ...
</incident>
```

This user already exists on the target instance but has a different sys_id value such as:

```
<sys_user><name>John Smith</name>
  ...
  <sys_id>18cab8de2be80200c5244f74b4da15f7</sys_id>
  ...
</sys_user>
```

Since the display value matches an existing record, the system uses the local instance’s existing sys_id value for the reference field such as:

```
<incident>
  ...
  <assigned_to display_value="John Smith">18cab8de2be80200c5244f74b4da15f7</assigned_to>
  ...
</incident>
```

The system can match display values for the following tables.
- User (sys_user)
- Group (sys_user_group)
- Role (sys_user_role)
- Group Roles (sys_group_has_role)

Using XML import sets
Use an XML import set to import data from another instance.

This method allows you to:
- Apply business rules
- Transform incoming data
- Reconcile sys_id values if necessary

Note: Administrators cannot set the update_synch attribute in Dictionary records to move data as part of update sets. This attribute was being used incorrectly to migrate data in large tables and was causing significant performance problems.

Create an XML data source to another instance
Data sources are used to create an import set so that data can be processed, if necessary, prior to being mapped onto a production table.
Note: To import using XML with High Security Settings enabled, you must possess elevated privileges.

1. Navigate to System Import Sets > Administration > Data Sources.
2. Click New.
3. Complete the form using the following values:
   - Format: XML
   - Import set table label: `<import_set_table_label>`
   - Xpath root node: `<source_table_name>`
   - Expand node children: true.
   - File retrieval method: HTTPS
   - File path: `<source_table_name>.do?XML`
   - Server: `<instance name>.service-now.com`
   - User name: A user account on the remote instance. The username used cannot be an email address.
   - Password: The password for the same remote account.

4. Click Submit.
5. Click Test Load 20 Records to create the import set table and to ensure your data source is functional.

Note: The 20 loaded records cannot be transformed and are for testing purposes only.

Create a transform map
A transform map is a set of field maps that determine the relationships between fields in an import set and fields in an existing ServiceNow table, such as Incidents (incident) or Users (sys_user).

After creating a transform map, you can reuse it to map data from another import set to the same ServiceNow table.

1. Open the data source record that you just created.
2. In the Transforms related list, click New.
3. Populate all the usual fields and be sure to choose the proper Target table.
4. Submit the record.
5. Click Auto map matching fields.

Add a field map for sys_id
Add a field map to establish a relationship between the sys_id field in the source table (defined in the transform map) and the sys_id field in the target table.

1. Open the table transform map record you just created.
2. In the Field Map related list, click New.
3. Complete the form, using the following values
   - Source field: sys_id
   - Target field: Sys ID (You must do XML injection to make it work on older releases.)
   - Coalesce: Select the check box.
4. Click Submit.
Add onBefore scripts to the transform map
Create one onBefore transform map script to copy the sys_id of new records from the source to the target instance. Create a second onBefore transform map script to identify records on the target instance that have the same unique values but different sys_id values.

1. Open the table transform map record you just created.
2. In the Transform Scripts related list, click New.
3. In the When field, select onBefore.
4. Enter the following script:
   ```javascript
   if (action == "insert") {target.setNewGuidValue(source.u_sys_id); }
   ```
5. Click Submit.
6. In the Transform Scripts related list, click New.
7. In the When field, select onBefore.
8. Enter the following Script:
   ```javascript
   /**
   * This script queries for a uniquely identifying value of the referenced record and then
   * updates the target reference field with the sys_id of the matching target record.
   * This sample assumes:
   * 1) The target table contains an assigned_to field which is a reference field.
   * 2) The reference field references the User [sys_user] table.
   * 3) You can use the email field to uniquely identify users. Alternatively you
   *    could use the user_name field.
   */
   var ref = new GlideRecord("sys_user"); //Replace sys_user with any reference table
   ref.addQuery("email", source.email); //Replace email with any unique field
   ref.query();
   if(ref.next()){
       target.assigned_to = ref.sys_id; //Replace assigned_to with any reference field
   }
   ```
9. Click Submit.

Retrieving data from a CSV formatted file
In this method, you import data from another instance using an HTTPS data source to return a CSV formatted file containing the rows to be imported.
This approach uses the Import Sets application to retrieve the data from the source and import it to the destination.
HTTPS Data Sources

1. Create a new data source by navigating to **Import Sets > Data Sources** on the destination instance.
2. Provide the following field values:
   - **Import set table name**: Select a table.
   - **Type**: File
   - **Format**: CSV
   - **File retrieval method**: HTTPS

   **Note:**

   If the **Server**, **File path**, **Username**, and **Password** fields are not visible when you select HTTPS, change the file retrieval method temporarily to SCP and enter this
information. Remember to reset the File retrieval method to HTTPS after you enter these fields.

- **File path**: `incident.do?CSV

Note: To import specific change records, you can add qualifiers to the path. For example, the following path would return all active change records:

```
incident.do ?CSV &sysparm_query=active=true
```

- **User name** and **Password**: Enter the user name and password for a valid user on the destination instance.

3. Click the Test load 20 records related link to verify that the import is configured correctly.
4. After setting up the data source, configure a standard transform map.

**System clone**

The system clone application allows users with the clone_admin or admin role to clone data from one instance to another.

This functionality is primarily used to clone a production instance over an existing non-production instance before developing or testing changes. All clones are performed using the most recent nightly backup. This application applies to instances in Gen2 and later data centers.

**Clone process**

In response to a clone request, the ServiceNow platform performs the following tasks:

1. Generates a file to preserve operational data on the target server.
   This file contains the data preserved by **data preservers**.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
2. Copies the database schema from the source instance to the target instance.
3. Creates tables in the target instance database using the source instance table definitions.
4. Copies data from the most recent nightly backup of the source instance to the target instance database.
   Certain large tables are normally excluded. These include audit, log, and email tables.
5. Briefly disables UI traffic and requests to the target instance server.
6. Displays the message **Clone in progress...** to any user accessing the target instance.
7. Restores operational data preserved from the target instance.
8. Runs any post-clone cleanup scripts on the target instance.
9. Briefly suspends all email functions on the target instance.
10. Queues an event to regenerate text indexes.
11. Enables UI traffic and requests to the target instance server.

During a clone, the target instance may be intermittently unavailable. After clone completion, you have up to 24 hours to contact ServiceNow Technical Support and request a rollback of the target instance to its pre-clone state. You are notified when the rollback is complete.

**Clone to an instance on a different version**

The System Clone application can target an instance running a different instance version from the source.

A central web service controls clone processing and automatically modifies the target instance version to match the source instance version. This matching process starts up to 8 hours before the time specified in the **Date and time** field on the System Clone form. This web service also ensures that there is enough disk space on the target instance for the clone to proceed.

When cloning from a backup, the target instance does not need additional time to upgrade or downgrade. The ServiceNow platform performs any version changes during a brief window where the target instance is unavailable, after it copies data from the source instance backup.

**Clone from a backup**

The platform uses data from the most recent nightly backup of the source instance when cloning. Backups used for cloning are at most 36 hours old. System Clone begins the initial preparation process, including selecting the latest backup to use, four hours before it is scheduled to commence.

After cloning from a backup, the target instance is unavailable for several minutes before the clone is marked as complete in the source instance. If the source and target instances are on different versions of the ServiceNow platform, the target instance is modified to match the source instance version during this time.

When starting a clone from a backup, the date and time the backup was taken, as well as periodic progress messages, appear in the **Clone Log** related list.
System clone backup log

Clone over production instances

Production instances cannot be used as the target instance for a clone after the instance is live. Production clones are created during non-core business hours. Tables are backed up sequentially rather than simultaneously. Modifying data on the source instance during a clone can cause a data mismatch between records or duplicate record entries. This issue is minimized by running a clone after normal business hours.

When scheduling a clone for a production instance, the system automatically follows this process:

- Determines the instance region.
- Determines the non-core business hours for the region.
- Restricts the possible cloning time that can be specified on the Clone Request form to the non-core hours.

<table>
<thead>
<tr>
<th>Region</th>
<th>Non-core business hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas East Coast</td>
<td>23:00 to 04:00 Eastern time (UTC −5) and all day Saturdays and Sundays</td>
</tr>
<tr>
<td>Americas West Coast</td>
<td>20:00 to 01:00 Pacific time (UTC −8) and all day Saturdays and Sundays</td>
</tr>
<tr>
<td>Australia</td>
<td>23:00 to 04:00 Australian Eastern time (UTC +10) and all day Saturdays and Sundays</td>
</tr>
<tr>
<td>Europe Amsterdam</td>
<td>00:00 to 05:00 Central European time (UTC +1) and all day Saturdays and Sundays</td>
</tr>
<tr>
<td>Europe London</td>
<td>23:00 to 04:00 British time (UTC) and all day Saturdays and Sundays</td>
</tr>
<tr>
<td>Asia Hong Kong</td>
<td>23:00 to 04:00 Hong Kong time (UTC +8) and all day Saturdays and Sundays</td>
</tr>
</tbody>
</table>
Set up system clone

You can perform optional, pre-cloning tasks before you request a clone. For example, you can control the exclusion of certain tables from cloning and preserve data on the clone target instance.

Create a clone target

You create a target instance record before the instance can be selected as clone target.

Role required: clone_admin or admin

Note: If you are using IP Access Controls on your instance, the target instance must allow the IP range `10.0.0.0/10.255.255.255` to communicate on a local network to allow the clone. For more information, see [IP range based authentication](#).

1. Navigate to **System Clone > Clone Targets**.
2. Click **New**.
3. Enter the URL for the receiving instance (target).
4. Enter the basic authentication credentials for a user account with the admin role on the target instance.

   ![ServiceNow Instance](#)

<table>
<thead>
<tr>
<th>Instance URL</th>
<th>Username</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>https//instance.service-now.com</td>
<td>admin</td>
<td>.....</td>
</tr>
</tbody>
</table>

   Note: These credentials must exist in the User (sys_user) table as a user record or as part of an LDAP integration. Clone requests cannot use single sign-on to authenticate users from an identity provider.

5. Click **Submit**.
   The system checks connectivity and validates the user credentials against the target instance.

Exclude a table from cloning

Exclude a table to create an empty but usable table on the target instance.
The **System Clone > Exclude Tables** module lists the tables that are not copied during a system clone. By default, the system excludes tables for logging, auditing, notifications, workflow contexts, and license usage.

**Note:** Excluded workflow context data includes records stored in the wf_context table, and in related tables with names starting with a prefix of wf_. This also includes the workflow scheduler table. This prevents occurrence of workflow timer syncing issues that might take place due to the length of the cloning process if workflow contexts were included.

The system cannot exclude tables that extend the Task table and are also flattened into it as part of the **table per hierarchy extension model**. Since these extended tables are actually part of the same physical database table, the system clones the data when it clones the Task table. You can exclude tables that extend the Task table under two conditions. Either the system stores the tables in their own physical tables as part of the table per class extension model, or you exclude the Task table itself.

To preserve the existing data on the target instance, see **Create a data preserver**. Data on tables that reference the table, such as business rules, is not excluded.

1. Navigate to **System Clone > Exclude Tables**.
2. Click **New**.
3. Enter the table **Name**.
4. Click **Submit**.

### Data preservation on cloning target instances

Data can use data preservers to protect data on the target instance from being overwritten. If you have custom applications, you must also manually preserve unpublished application content.

#### Data preservers

Sometimes it is necessary to preserve some data on an instance targeted for cloning. For example, if the target is a MID Server, you must not overwrite the MID Server (ecc_agent) table. Preserved data is stored on the target instance before cloning begins and is restored on the target instance after cloning.

**Warning:** You must define data preservers on the source instance. Defining them on the target instance does not preserve the data.

Consider whether to preserve the data in the following tables.
- Bookmark (sys_ui_bookmark)
- Recent Selection (sys_ui_recent_selection)
- User Preference (sys_user_preference)

#### Data preservers for Multi-SSO

The system automatically creates the necessary data preservers for cloning when you activate Multiple Provider Single Sign-On integration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate</td>
<td>X.509 Certificates (sys_certificate)</td>
<td>None</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Conditions</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Core Instance Properties</td>
<td>System Property (sys_properties)</td>
<td>• (OR) (Name) (is one of) (glide.authenticate.external, glide.authenticateexternal.logout_redirect)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (OR) (Name) (starts with) (com.snc.integration.saml_esig)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (OR) (Name) (is one of) (glide.smtp.port, glide.smtp.auth, glide.smtp.encryption)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (OR) (Name) (starts with) (glide.authenticate.multisso)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (OR) (Name) (is) (glide.authenticate.sso.redirect.idp)</td>
</tr>
</tbody>
</table>

**Note:** The properties glide.smtp.port, glide.smtp.auth, and glide.smtp.encryption are deprecated.

<table>
<thead>
<tr>
<th>Digest Properties</th>
<th>Digest Properties (digest_properties)</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identity Providers</td>
<td>Identity Providers (sso_properties)</td>
<td>None</td>
</tr>
<tr>
<td>SAML2 Update1 Properties</td>
<td>SAML2 Update1 Properties (saml2_update1_properties)</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** Although you can modify these data preservers, a good practice is to avoid changing them. The Digest Properties (digest_properties), Identity Providers (sso_properties), and SAML2 Update1 Properties (saml2_update1_properties) tables are required for multiple source single sign-on to function properly. If multiple source single sign-on is disabled on the target instance, you can safely remove all three data preservers. Remove them at the same time, as the system terminates the clone with an error message when you attempt to clone with one or two of these tables being preserved.

### Data preservers for SAML

Preserving SAML SSO-related settings can prevent the target instance from using the wrong issuer and audience parameters when making authentication requests to your IdP. To preserve SAML settings, create data preservers for the following tables:

- **System Property (sys_properties):** to preserve SAML properties.
- **X.509 Certificates (sys_certificate):** to preserve SAML certificates.
- **User (sys_user):** to preserve SAML users.

You also need to preserve properties, certificates, and users that are involved in SAML.

### Create a data preserver

Data preservers maintain specified data on a target instance.

Role required: clone_admin or admin
Sometimes, preserving certain data on a target instance is desirable. For example, when using a MID Server, you can avoid overwriting the MID Server (ecc_agent) table. Preserved data is stored in a dynamically generated list on the target instance before the clone and restored on the target instance after the clone is complete. You define data preservers on the source instance.

Data preservers are primarily intended to preserve system settings and themes, such as instance-specific authentication settings. Do not use data preservers to transfer large sets of data, such as user groups. If you must preserve table data such as users, groups, and roles, consider exporting the records to a file and importing it after the clone is complete.

Consider whether to preserve the data in the following tables.

- Bookmark (sys_ui_bookmark)
- Recent Selection (sys_ui_recent_selection)
- User Preference (sys_user_preference)

If you set a data preserver on a table where the source instance has more records than the target instance, the data preserved on the target instance also includes the additional records from the source instance.

For example, assume that the data preserver is already in place.

- In the source instance, the sys_temp table contains 100 records.
- In the target instance, the sys_temp table contains 20 records.

After the clone, the sys_temp table in the target instance contains 100 records.

- The 20 records in the target sys_temp table are preserved successfully (per the data preserver specification).
- The source sys_temp table brings over the remaining 80 records to the target sys_temp table.

To resolve this issue and to preserve only the records in the target table, create an exclude table record for the target table, in addition to setting the data preserver on the source table.

1. On the source instance, navigate to System Clone > Preserve Data.
2. Click New.
3. Enter the table label as the Name, for example, User Preference for the (sys_user_preference) table.
4. Select the Table to be preserved.
5. Select the Theme check box if the data being preserved is a UI property.
6. Define the data to be preserved using the Condition Builder.

You can use conditions to define particular records you want to preserve during a clone. For example, to only preserve particular system properties, you can add conditions for each property name you want to preserve.
Warning: If the clone from backup fails for some reason, the clone process fails over to the legacy clone engine. The legacy clone engine cannot preserve data from extended tables, relationships, hierarchies between tables, and dot-walked queries. You may want to reschedule a system clone or manually transfer data in such cases.

7. Click Submit.

If you want to delete the data preserver later, make sure not to modify or delete the following data preserver records:

- Core Instance Properties
- Semaphores
- Email Accounts
Clone an instance with a SAML integration

Before cloning an instance that uses SAML 2.0, preserve the SAML SSO-related settings on the target instance. Failing to do so might make the target instance inaccessible.

Role required: admin

1. On the source instance, navigate to **System Clone > Preserve Data > Core Instance Properties**.

2. Make sure that the following SAML SSO-related properties are preserved using conditions, as shown:
   - glide.authenticate
   - glide.security
   - glide.entry
   - glide.script
   - glide.session
   - glide.saml2
   - com.glide.communications
   - com.snc.integration.saml_esig
<table>
<thead>
<tr>
<th>Name</th>
<th>Condition</th>
<th>Value</th>
<th>Operator</th>
<th>Table Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Instance Properties</td>
<td>is</td>
<td>glide.sys.schedulers</td>
<td>AND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td>glide.db</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is</td>
<td>glide.ui.max.transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td>glide.email</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is</td>
<td>glide.op3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is</td>
<td>instance_id</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td>glide.installation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is one of</td>
<td>glide.authenticate.external</td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>glide.authenticate.external.logout_redirect</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>glide.authenticate.failed_requirement_redirect</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td>glide.authenticate.sso.s</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td>com.snc.integration.san</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note: When you create the clone, include attachments so that certificates carry over to the target instance. Also, make sure the Theme check box is cleared so these properties are preserved regardless of whether you preserve the instance theme.

3. On the source instance, navigate to System Clone > Preserve Data to preserve SAML certificates on sys_certificate and SAML users on sys_user related to SAML/SSO/Multi SSO. If you need them, export them into XML, then manually import them on the target.

Warning: Do not try to clone the SAML/SSO/Multi SSO setup from one system to another. Most transfers of SAML/SSO or Multi SSO settings do NOT work because they must be configured on the identity provider. If you overwrite a working setup, the target instance will fail to authenticate so your target instance will become inaccessible. Also, do not change the sys_id of your Multi SSO provider record; doing that will force your users to flush their cookies. For more information about cloning precautions, see Checklist before cloning an instance.

4. Exclude the Multi SSO tables sso_properties, digest_properties and saml2_update1_properties.

5. Manually create the SAML/SSO/Multi SSO records on each instance independently and set up the records on your identity provider as well.

6. Make sure that you manually create a LOCAL admin account on sys_user (not in LDAP or SAML) record on the target instance and with a sys_id that does not exist on the source instance.

7. Click Update.

Preserve unpublished applications during a system clone

Application developers must manually save a copy of each application currently in development prior to cloning over their development instance.

- Role required: admin
- Write access to the application record
- A source control repository

The cloning process does not preserve version differences for applications in development. Instead, the system clone only copies the application version installed on the source instance onto the target instance. If the target instance had a development version of the same application, the application will be editable after the clone, but it will be at whatever version was installed on the source instance. If the application was missing from the source instance, the cloning process deletes the application from the target instance.

1. Use one of these actions to preserve the application on the clone target instance.
### Version differences between instances

<table>
<thead>
<tr>
<th>Application version state</th>
<th>Action to take</th>
</tr>
</thead>
<tbody>
<tr>
<td>The application version on the clone target instance is different than the source instance version.</td>
<td>Export each application from the clone target instance. Choices include:</td>
</tr>
<tr>
<td></td>
<td>· (Recommended) Link each application to a source control repository.</td>
</tr>
<tr>
<td></td>
<td>· Publish each application to an update set.</td>
</tr>
<tr>
<td>The application is only available on the clone target instance.</td>
<td>None. The system clone process will copy this application version onto the target instance during the clone.</td>
</tr>
<tr>
<td>The application version on the clone target instance is the same as the source instance.</td>
<td></td>
</tr>
</tbody>
</table>

2. Schedule a system clone of the source instance over the target instance. For example, clone your production instance over your development instance.

3. Log in to the clone target instance.

4. If you saved each application to a source control repository, use one of these actions to retrieve them from the source control repository.

#### Retrieve applications from a source control repository

<table>
<thead>
<tr>
<th>Application installation state</th>
<th>Action to take on clone target</th>
</tr>
</thead>
<tbody>
<tr>
<td>The application was previously installed on the source instance.</td>
<td>Apply remote changes from source control repository.</td>
</tr>
<tr>
<td>The application was never installed on the source instance.</td>
<td>Import the application from source control repository.</td>
</tr>
</tbody>
</table>

5. If you saved each application to an update set, use one of these actions to retrieve them from the update set.

#### Retrieve applications from an update set

<table>
<thead>
<tr>
<th>Application installation state</th>
<th>Action to take on clone target</th>
</tr>
</thead>
<tbody>
<tr>
<td>The application was previously installed on the source instance.</td>
<td>1. Delete the application version cloned from the source instance. 2. Load the update set containing the current application version.</td>
</tr>
<tr>
<td>The application was never installed on the source instance.</td>
<td>Load the update set containing the current application version.</td>
</tr>
</tbody>
</table>

The applications previously in development are available for further development on the clone target instance.
Preserve the Marketing Events application

Suppose your company previously created version 1.0 of a custom application called Marketing Events. You have already published version 1.0 of the Marketing Events application to the application repository and installed it on your production instance.

Over time, users have submitted enhancement requests for the application, and you decide to develop version 2.0 of the Marketing Events application on a non-production instance to address these requests. As development nears completion, you want to update your non-production instance to the latest copy of production for some comprehensive testing.

Since you previously used a source control integration to develop version 1.0 of the Marketing Events application, you have already linked the Marketing Events application to a source control repository. You commit version 2.0 of the Marketing Events application to the source control repository.

You schedule a clone of the production instance over the development instance. After completion, you log in to the development instance and see that it has version 1.0 of the Marketing Events application, because that was the version installed on the source instance.

Since the application was already installed on the source instance, you apply remote changes from the source control repository to receive the latest application version. The development instance now has version 2.0 of the Marketing Events application available for further development and testing.

Use system clone

Start the cloning process by requesting the clone, and then perform any post-clone cleanup that might be necessary.

Start a clone

For most instances, an administrator can start a clone.

Role required: admin

The glide property glide.db.clone.allow_clone_target must be set to True to allow an instance to be a clone target. Attempting to clone over an instance where this property is False displays the following error:

Clone target invalid

This property is False by default, and True on instances where the name ends in Dev, Test, Stage, UAT, or QA.

To modify the value of this property, add the property to the (sys_properties) table.

For instances that use an Oracle database, see KB0538884 - System Clone Support for Oracle Customers.

1. Navigate to System Clone > Request Clone.
2. Select a **Target instance** to receive the cloned data.

   **Note:** You cannot request cloning multiple targets from the same source. Instead, make a separate request for each target.

3. Complete the Options form section.

   **Clone options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clone from</td>
<td>Select the source database, if more than one database is available. If only one source is available, the <strong>Clone from</strong> menu does not appear. By default, the clone process ignores this field and uses data from the most recent nightly backup of the source instance. The clone process only uses this field value if the clone from backup fails for some reason.</td>
</tr>
<tr>
<td>Exclude audit and log data</td>
<td>Select this option to prevent the cloning of tables specified in System Clone &gt; Exclude Tables. This option is selected by default. Clearing the check box causes the platform to ignore the Exclude Tables module.</td>
</tr>
<tr>
<td>Exclude large attachment data</td>
<td>Prevents the cloning of large attachments such as video files, image files, and other typically large binary file types. Excludes all common binary file types, regardless of file size. When selected, the clone also excludes attachments from the Attachments (sys_attachment) and Attachment Documents (sys_attachment_doc) tables that meet all these criteria.</td>
</tr>
<tr>
<td>Preseture theme</td>
<td>Select this option to prevent the cloning of CSS elements, colors, and banner displays. This option enables or disables any data preservers where <strong>Preserve theme</strong> is True.</td>
</tr>
</tbody>
</table>

4. Schedule a **Date and time** to perform the clone. Multiple clones cannot be scheduled to run concurrently on the same target instance. A clone must be scheduled at minimum two hours in advance.

5. Enter an **Email** address to receive alerts after the clone finishes, is canceled, or has an error.
6. Click **Submit**.

7. In the authentication window that appears, enter the **Username** and **Password** for an administrator account on the target instance.

8. Click **Authenticate**.

9. Review the clone settings and click **OK**.
   An email is sent to the supplied address after the clone finishes, is canceled, or has an error.

**Warning:** If the clone from backup fails for some reason, the clone process fails over to the legacy clone engine. The legacy clone engine cannot preserve data from extended tables, relationships, hierarchies between tables, and dot-walked queries. You may want to reschedule a system clone or manually transfer data in such cases.

You can cancel a clone without negatively impacting system stability or usability. Canceling a clone restores the target instance to the pre-clone state, retaining all original data.
To cancel a scheduled or in-progress clone, navigate to System Clone > Clone History. Select the clone and click Cancel Clone.

### Post-clone cleanup scripts

The Cleanup Scripts module allows you to define scripts to automatically run on the target instance after a clone is finished.

Cleanup scripts run after data preservers and the clone is complete. You can add new post-cloning scripts on the source instance to perform any action that can normally be accomplished through script includes or business rules. To add a script, navigate to System Clone > Clone Definition > Cleanup Scripts and click New.

The following post-clone cleanup scripts perform various actions on the target instance.

<table>
<thead>
<tr>
<th>Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad MID Server credentials after clone</td>
<td>Runs a script include called BadMIDCredentialAfterClone on a cloned instance to detect bad MID Server user credentials. This script include creates scheduled jobs that log MID Servers in the Down state to the MID Server Issue (ecc_agent_issue) table after an instance clone.</td>
</tr>
<tr>
<td>Clear scheduled job node association</td>
<td>Resets any scheduled jobs that were active on the source instance to the Ready state. This script also clears the value of the System ID and Claimed by fields on all scheduled jobs.</td>
</tr>
<tr>
<td>Configure Email Accounts</td>
<td>Migrates email accounts that existed on the source instance to the target instance if they are not enabled there. This script also migrates the email properties to the target instance.</td>
</tr>
<tr>
<td>Disable emails</td>
<td>Disables email on the target instance. A default data preserver maintains other email settings from the target instance.</td>
</tr>
<tr>
<td>Install deactivated plugin</td>
<td>Enables the Domain Separation plugin for instances that use this feature.</td>
</tr>
<tr>
<td>Regenerate all text indexes</td>
<td>Rebuilds text indexes on the target instance after a clone. Text indexes are not cloned from the source to the target instance.</td>
</tr>
<tr>
<td>Schedule drop backup tables</td>
<td>Schedules the deletion of the data contained in the target instance database prior to the clone. This original data is preserved for 24 hours following a clone to allow you to roll back an instance to the pre-clone state. If the target instance is downgraded as part of the clone, backup data is not available.</td>
</tr>
</tbody>
</table>

### View clone history and active clones

You can view clone history information. All previously and currently scheduled clones from a particular instance display on this table. The clone history module additionally lists clones that have begun but have not yet finished.
Role required: clone_admin or admin

Navigate to **System Clone > Clone History**.

Clone history also displays the **State** for current and past clones. Clones in the **draft** state do not appear on the clone history table.

<table>
<thead>
<tr>
<th>Clone state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested</td>
<td>The clone was requested and is awaiting approval.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>The clone is ready to begin at the scheduled time and date.</td>
</tr>
<tr>
<td>Active</td>
<td>The clone is currently running.</td>
</tr>
<tr>
<td>Completed</td>
<td>The clone completed successfully.</td>
</tr>
<tr>
<td>Canceled</td>
<td>A user canceled the request.</td>
</tr>
<tr>
<td>Hold</td>
<td>The server rejected the clone request. This can happen either because the clone was not ready to proceed by the scheduled time or because additional clone requests were submitted before the first one completed.</td>
</tr>
<tr>
<td>Error</td>
<td>The clone encountered an error while running. Contact technical support for help resolving this issue.</td>
</tr>
</tbody>
</table>
Active system clone

After starting a clone, the **Clone Log** and **Database Table Clones** related lists appear on the form. These related lists show general log messages, and the details of individual tables respectively.

The duration of time a clone remains active varies depending on the amount of data being cloned, and whether the source and target instance are in the same physical location. If a clone takes longer than anticipated, ServiceNow Technical Support can identify additional details about the clone progress.

**Database rotation**

Database rotation involves managing table size growth and archiving old data.

With data constantly being added to the system, and activity being logged into system tables in the database, these tables grow in size and require management. As data sets increase in size, the amount of I/O traffic associated with actions such as cleaning, deleting, and archiving can negatively effect the performance of an instance. Additionally, working with all rows in a data set, rather than a smaller working set, can create unnecessary risk.

The Database Rotation plugin preserves instance performance and averts risk associated with querying growing data sets utilizing two techniques. Both techniques are based on the concept of managing large quantities of data by separating whole sets into individual tables based on user-specified time parameters. After this task is performed, each technique handles data in a different manner:

- **Table Rotation** works by rotating among a small set of tables, and deleting and reusing the old tables for new data.
- **Table Extension** works by periodically starting a new table and allowing old tables to be easily archived and removed from the system.
Table rotation plugins

- **Database Rotations Plugin** activates Table Rotation and Extension without any tables automatically included (com.snc.db.rotation)
- **Database Rotations Default Tables Plugin** applies Table Rotation and Extension to specific tables (com.snc.db.rotation_default_tables)

### Database Rotation

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Tables applied to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Rotation</td>
<td>syslog</td>
</tr>
<tr>
<td></td>
<td>sys_querystat</td>
</tr>
<tr>
<td></td>
<td>ecc_queue</td>
</tr>
<tr>
<td></td>
<td>ecc_event</td>
</tr>
<tr>
<td></td>
<td>cmdb_metric</td>
</tr>
<tr>
<td></td>
<td>sysevent</td>
</tr>
<tr>
<td>Table Extension</td>
<td>sys_audit</td>
</tr>
<tr>
<td></td>
<td>sys_email</td>
</tr>
</tbody>
</table>

### Reference values converted to strings

Archived data is stored as a flat file with no reference fields to other tables. The archive process converts any references to other tables to string values.

In the case of a reference field, the string uses the *display value* such as the caller's user name. For example, the **Caller** reference field in an incident would display the string ITIL User. If the reference was a document ID and the archive rule included the option to archive related document IDs, then the string is the document ID of the related record.

It is important to note that archive records do not receive any future changes to referenced values. For example, if you change the user name for "John Smith" to "John A Smith", all active incident records automatically show the caller as "John A Smith" because of the reference between the Incident and User tables. However, all archived incident records display the user name that existed at the time of the archive. Any incident for "John Smith" continues referencing this user. Likewise, if you delete a user from the system, current incidents no longer display the deleted user as a caller. However, there can be archived incidents that still display the string 'John Smith' as the user because the user existed at the time of the archive.

### Table rotation and extension

The System Definition Table Rotation module allows you to define a new table rotation, a new table extension or modify an existing one.
Table rotation groups

- **Name**: auto-generated from table name
- **Duration**: overall time parameter for function
- **Initialized**: sets function as active (true) or inactive (false)
- **Rotations**: number of tables to be created within Duration
- **Type**: indicates Extension (archiving) or Rotation (deletion) functionality

When you define a new rotation, a schedule is created and new data is subsequently written to one of the tables in the rotation group. You'll notice that the group includes the original table plus a number of additional tables. Be aware that deleting a rotation will delete the additional tables and all the data, therefore the rotation should not be deleted if the data is needed.

See these topics for more information on managing tables:

- [Table Rotation](#)
- [Table Extension](#)

**Activate database rotation**

For new instances, database rotation is active by default. If you are upgrading from a previous version, you can activate the Database Rotations plugin if it is not already active.

**Note**: Deployment of this plugin should be executed in partnership with a ServiceNow representative.

If it is not already active, you can activate the **Database Rotations** plugin if you have the admin role.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
If the plugin depends on other plugins, these plugins are listed along with their activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive.** The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

Do not activate the **Database Rotations Default Tables** plugin. Instead, specify the tables manually, after consulting a ServiceNow representative.

**Integration with third-party applications and data sources**

ServiceNow integrates with many third party applications and data sources.

The most common integrations are with CMDB, Incident Management, Problem Management, Change Management, User Administration, and Single Sign-on. A variety of techniques can be used, most notably Web Services, JDBC, LDAP, Excel, CSV, and Email, as well as any industry standard technologies that use SOAP, REST, or WSDL. Additionally, API and command-line integrations can be done using a MID Server. ServiceNow has performed the following integrations with enterprise systems and platforms.

This podcast offers additional information on integrations.

**Technologies**

The ServiceNow platform is based on service-oriented architecture (SOA), in which all data objects can use web services to access bi-directional data-level integration. The interface is also direct and dynamic because all modifications to existing objects and all new objects are automatically published as a Direct Web Service. A more indirect web service creation and usage can be achieved through Mapped Web Service where a transform map is used to gather incoming web service data into the final targeted tables. Finally, an advanced Scripted Web Service technique is available for defining process-based web services, where data is irrelevant, but serves more as a trigger for a process or a composite of actions that execute at the server.

Additionally the platform offers a rich interface for loading external data using import sets. Using this feature, you can load from various data sources such as HTTPS, FTPS, and SCP using file formats such as XML, CSV, and Microsoft Excel XLS files. Information can also be pulled from a data source using a direct JDBC connection, provided the network connectivity allows.

Information can be pulled from the platform to an external platform using an **ODBC Driver**.

Forms, lists, and reports on the platform can be accessed directly using a URL, which facilitates integration on the UI level between two or more web applications.

A handful of single sign-on technologies is identified and implemented out of the box to allow fast integration with your portal, however, the technique is customizable in a script to allow for flexibility in the different SSO environments our customers have.
Integration between ServiceNow Instances

There are times when you find you need to perform a specific integration between your instance and another ServiceNow instance. Instance-to-Instance integrations are a snap because all of the integration points exist between the two instances.

Integration options

Nearly all ServiceNow customers obtain additional value by integrating with third-party applications.

ServiceNow customers have the following options for integrating with third-party applications.

- Activate a ServiceNow provided integration.
- Install a certified integration from the ServiceNow Store.
- Install an integration from Share.
- Contact your sales representative for available custom-built integrations.
- Build your own custom integration using the platform’s integration interfaces.

Note: Certified integrations have passed a set of interoperability, security, and performance test criteria defined by ServiceNow.

ServiceNow provided integrations

ServiceNow provides many integrations as part of the platform.

These integrations are considered part of the platform and are provided at no additional charge.

Provided Integrations

<table>
<thead>
<tr>
<th>Integration</th>
<th>Type</th>
<th>Integration Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altiris (version 6.5)</td>
<td>MID Server</td>
<td>CMDB</td>
</tr>
<tr>
<td>Google Maps</td>
<td>Web services</td>
<td>Varies</td>
</tr>
<tr>
<td>Google Custom Search</td>
<td>Web services</td>
<td>Knowledge</td>
</tr>
<tr>
<td>Microsoft SMS / SCCM</td>
<td>MID Server</td>
<td>CMDB</td>
</tr>
<tr>
<td>Verizon eBonding</td>
<td>Web services</td>
<td>Incident</td>
</tr>
</tbody>
</table>

Set up Google Maps API

Map pages enable you to graphically display data on a Google Map, based on location data.

Role required: admin

Maps can be generated using basic JavaScript, but are flexible enough to display even the most complicated of queries. The maps you generate use standard Google Maps API mapping features, including various link types to records in your instance. This feature requires the Google Maps plugin.
1. If necessary, obtain a Google Maps for Work license key to cover development use of the Google Maps API. See the [Getting Started Guide](#) on the Google web site for details on obtaining a key, using the API, and relevant terms of service.

2. When you receive your key, enter it in the **System Properties > Google Maps** property form, and configure your maps using the property definitions from the table.

3. After you complete the configuration, create map pages or use the default pages included with the plugin.

Map pages define what data is displayed on the map and the appearance of the links. For a tutorial on how to display all markers that link to your records, see the [Display Map Markers on Google Maps](#) blog post on theNow Community.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>google.maps.auto_close</td>
<td>If true, automatically closes a map information window before opening a new one.</td>
</tr>
<tr>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.client</td>
<td>Client ID for Google Maps API for Work.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: gme-servicenow</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>google.maps.private.key</td>
<td>Private key for Google Maps API for Work. This key activates the geolocation feature, which locates users in the system precisely, using data from their mobile devices.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: empty</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.version</td>
<td>Version number of the current installation of Google Maps API.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: current version number</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.key</td>
<td>The Google Maps API key that is tied to the URL of the server. This key authorizes development use of Google Maps API.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: empty</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.latitude</td>
<td>Starting latitude of the map. This value determines the starting position displayed in Google Maps.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: 36.008522</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.longitude</td>
<td>Starting longitude of the map. This value determines the starting position displayed in Google Maps pages.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: -95.221764</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.max_items</td>
<td>Maximum number of items to display on the map.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 500</td>
</tr>
<tr>
<td></td>
<td>- Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
</tbody>
</table>
Activate Google custom search integration

The Google Custom Search Integration plugin is available by request.

Role required: none

Request the plugin through the HI Service Portal.

1. In the HI Service Portal, click Service Requests > Activate Plugin.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least 2 business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Microsoft SCCM integration

The Microsoft SCCM integration is a one direction import of SCCM data into the ServiceNow Configuration Management Database (CMDB).

Scheduled imports bring relevant SCCM data into the ServiceNow instance from a SQL Server database and map it to tables in the CMDB. You can configure either a full or incremental data import. The import is achieved using a JDBC connection via the MID Server. The integration keeps
the ServiceNow CMDB synchronized with the SCCM SQLServer database, so that only relevant data is imported from the SCCM database to the CMDB. The SCCM database is considered an authoritative source and is not written to.

**Supported versions**

Each of the currently supported SCCM plugins supports Asset Intelligence and Incremental Software Reconciliation:

- Microsoft SCCM 2007
- Microsoft SCCM 2012 v2

---

**Note:** If you upgrade your instance to a version of the Now Platform that does not provide support for your version of SCCM, you can continue to use that version. However, all new instances require the use of a supported SCCM version.

---

**Available modules**

- **Setup:**
  - Configure the data sources.
  - Specify database server settings and the MID Server.
  - Test configuration.

- **Scheduled Import:** Schedule the import or execute the import immediately.

- **Data Sources:** A list of the pre-configured data sources defining the external CMDB database.

- **Progress:** The progress log for scheduled imports.

- **Transform History:** A log of transformations performed by scheduled imports.

- **CI Identification:** Identifiers used by SCCM to match import set data with the CMDB.

- **Import Set Data:** Tables that store imported SCCM data.

- **Web Services:** List of web services used to add or remove fields in the transform maps.

**Asset intelligence**

Asset Intelligence is an SCCM feature that can filter, normalize and clean up software records. When enabled, it populates normalized software data in a separate table within the SCCM database. ServiceNow customers may elect to target this separate table instead of the raw software data table. When you import software records into the CMDB with this feature enabled, you get a cleaner set of software data. To use this feature, you must enable scheduled imports in the target ServiceNow instance, as well as in the source SCCM database.

**Activate a supported Microsoft SCCM plugin**

The SCCM plugins can be activated by an administrator and requires the Integration - JDBC and CI Identification plugins. These dependent plugins are activated automatically with SCCM activation.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
If the plugin depends on other plugins, these plugins are listed along with their activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive.** The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

**SCCM data import process and source tables**
The Microsoft SCCM versions supported in the ServiceNow® platform offer the same features and selected data.

**Data import process**

1. A schedule called **SCCM System <version> Import** determines when the SCCM tables are imported into the ServiceNow® instance. Imports can be executed immediately or scheduled to run at defined intervals.

2. A MID Server retrieves the SCCM data and imports it into staging tables on the instance.

3. Transforms run on the data in the staging tables and map the SCCM data to existing fields in the CMDB.
SCCM data imported

This table shows the SCCM source tables, the corresponding import set staging tables in the ServiceNow® instance, and the target tables in the CMDB.
### SCCM data sources

The ServiceNow® SCCM integration uses JDBC data sources to import software data from the SCCM database. Each data source contains the connection specifics for the SCCM database and names the MID Server the instance will use to import the data. The transforms that map the SCCM fields to the CMDB are defined in a related list in each data source record.

### Transform maps

Transform maps are accessed from the Transforms related list in each data source record. The source fields in SCCM and the target fields in the CMDB are listed in the Field Maps related list in each Table Transform Map record. The SCCM integration provides two transform maps for incremental software imports. Only one transform map can be enabled (Active) at a time.

<table>
<thead>
<tr>
<th>SCCM table</th>
<th>Staging table</th>
<th>CMDB table</th>
</tr>
</thead>
<tbody>
<tr>
<td>v_GS_Computer_System</td>
<td>SCCM &lt;version&gt; Computer Identity</td>
<td>Computer (cmdb_ci_computer)</td>
</tr>
<tr>
<td>v_GS_Workstation_Status</td>
<td>(imp_sccm&lt;version&gt;_computer_id)</td>
<td></td>
</tr>
<tr>
<td>v_GS_System</td>
<td></td>
<td></td>
</tr>
<tr>
<td>v_GS_PC_Bios</td>
<td></td>
<td></td>
</tr>
<tr>
<td>v_GS_Operating_System</td>
<td>SCCM &lt;version&gt; Operating System</td>
<td></td>
</tr>
<tr>
<td>v_GS_Computer_System_Product</td>
<td>(imp_sccm&lt;version&gt;_os)</td>
<td></td>
</tr>
<tr>
<td>v_GS_System_Enclosure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>v_GS_Baseboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>v_GS_Disk</td>
<td>SCCM &lt;version&gt; Disk (imp_sccm&lt;version&gt;_disk)</td>
<td>Disk (cmdb_ci_disk)</td>
</tr>
<tr>
<td>v_GS_Network_Adapter_Configuration</td>
<td>SCCM &lt;version&gt; Network (imp_sccm&lt;version&gt;_network)</td>
<td>Network Adapter (cmdb_ci_network_adapter)</td>
</tr>
<tr>
<td>v_GS_Operating_System</td>
<td>SCCM &lt;version&gt; Operating System (imp_sccm&lt;version&gt;_os)</td>
<td>Computer (cmdb_ci_computer)</td>
</tr>
<tr>
<td>v_GS_Processor</td>
<td>SCCM &lt;version&gt; Processor (imp_sccm&lt;version&gt;_processor)</td>
<td>Computer (cmdb_ci_computer)</td>
</tr>
<tr>
<td>v_GS_Add_Remove_Programs</td>
<td>SCCM &lt;version&gt; Software (imp_sccm&lt;version&gt;_software)</td>
<td>Software (cmdb_ci_spkg)</td>
</tr>
<tr>
<td>v_GS_Add_Remove_Programs_64</td>
<td></td>
<td>Software Installation (cmdb_sam_sw_install) (when Software Asset Management is enabled)</td>
</tr>
<tr>
<td>SCCM_Ext.Add_Remove_Programs</td>
<td>SCCM &lt;version&gt; Removed Software (imp_sccm&lt;version&gt;_removed_sw)</td>
<td>Software (cmdb_ci_spkg)</td>
</tr>
<tr>
<td>SCCM_Ext.Add_Remove_Programs_64</td>
<td></td>
<td>Software Installation (cmdb_sam_sw_install) (when Software Asset Management is enabled)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
- **Incremental Import**: Enabled by default. This map should be configured as **Active** when Software Asset Management is not enabled on the instance.
- **Incremental Import (SAM enabled)**: If the Software Asset Management plugin is activated, set this transform to **Active**.

**Note**: To force a one-time full import of all software data from the SCCM database, clear the value in the **Last run datetime** field. This operation can take a long time to execute, so the most efficient method is to use an incremental transform after the first full import.

### Transforming the assigned user

The SCCM <version> Computer Identity transform script attempts to set the **Assigned to** field in the CMDB record by looking up the name of the user in the SCCM source table and comparing the value with the matching field in the ServiceNow sys_user table. If a match is found, that user is assigned to the record. If no match is found, the **Assigned to** field is left blank. The matching field is controlled by the `glide.discovery.assigned_user_match_field` system property, which is set to **user_name** by default.

### Identifiers

The SCCM integration uses CI identification to update CIs created from data imported from SCCM with a resource ID. The Hardware Rule identifier returns the resource ID of a computer from SCCM and stores it in a table called Source `[sys_object_source]`. When resource IDs are first imported, either from SCCM or Discovery, the system populates the `sys_object_source` table with IDs for each CI it identifies. In subsequent imports, if an incoming ID matches that of an existing CI, the system updates the information for that CI in the CMDB. If the incoming resource ID does not match that of an existing CI, the system creates a new CI and populates it with the resource ID.

### Scripts

Data population scripts populate the related data in the CMDB for each target CI discovered by the Hardware Rule identifier.

### Software

The Microsoft SCCM integration reconciles the software package count in the records for a CI and removes a software instance from the Software Instance `[cmdb_software_instance]` table if the software package is uninstalled from the CI.

**Caution**: The table data imported from SCCM must contain complete data for the CI. The instance assumes that the import represents all relationships that exist and adjusts the CMDB accordingly. Partial data received from SCCM tables can cause the deletion of active relationships.

For a full software import, the transform populates the Software `[cmdb_ci_spkg]` and Software Instance `[cmdb_software_instance]` tables. If the Software Asset Management plugin is enabled, the transform populates the Software Installation `[cmdb_sam_sw_install]` table.

**Configure the SCCM integration and schedule an import**

Importing data from Microsoft SCCM requires a connection to the SCCM database via a JDBC data source and a schedule that tells the MID Server when to fetch the data.
Role required: admin

**Note:** You must have credentials to query the SQL Server that contains the SCCM database.

The system uses the details of the database connection you create in this procedure to configure the default SCCM data sources automatically.

**Note:** If you want to configure the JDBC data source to authenticate on your SQL Server database using the Windows MID Server service user, select the **Use integrated authentication** box on each of the existing data sources.

1. Navigate to **Integration - Microsoft SCCM <version> > Setup.**
2. Complete the required fields to configure connection to the SCCM SQL database. Make sure to include a valid MID Server that has access to the SQL database server.

SCCM data import setup

3. Under Related Links, click **Test data source connections** to test the connection to the SCCM database.
4. If the data source connects to the SCCM database, navigate to **Integration - Microsoft SCCM > Scheduled Import.**
The Scheduled Data Import form appears for your version of the SCCM integration. The Computer Identity data source runs first. The other data sources listed on the form run in sequence, based on their default order.
Scheduled Data Import
SCCM System 2012 v2 Import

Name: SCCM System 2012 v2 Import
Data source: SCCM 2012 v2 Computer Identity
Run as
Active: checked
Execute pre-import script: unchecked
Execute post-import script: unchecked
Update, Execute Now, Delete

Run the following imports when complete
New

Name

- SCCM 2012 v2 Operating System
- SCCM 2012 v2 Processor
- SCCM 2012 v2 Disk
- SCCM 2012 v2 Network
- SCCM 2012 v2 Software
- SCCM 2012 v2 Removed Software
5. Select a calendar interval (Day, Week, etc.) in the Run field and specify the time of day the import should run.
   Your selection displays additional fields required to complete the schedule.
6. Select the Conditional check box to display a condition builder.
7. Click Update to schedule the import or click Execute Now to perform the import immediately.

After the instance imports data using the SCCM <SCCM version> Computer Identity data source, the other data sources run in the order configured to retrieve the remainder of the SCCM data.

Upgrade the SCCM integration version
If you are using an earlier version of an System Center Configuration Manager (SCCM) plugin, you can switch over to a later version to take advantage of new features.

The ServiceNow SCCM integrations are self-contained and can exist independently. They each use their own import set tables, data sources and transform maps. However, all SCCM integrations will transform data into the same tables within the ServiceNow CMDB. To avoid the data being overwritten by another source:

- Use one SCCM integration and disable all other SCCM scheduled imports.
- Perform a full import to clear the cmdb_software_instance table, the cmdb_sam_sw_install table, and other tables of old SCCM data.

Note: It is possible to configure each plugin to integrate with SCCM 2007 or 2012 because the mechanism of the integration is actually the same, which is to leverage Java Database Connectivity (JDBC) imports. However, the data sources will need to be modified if a plugin is to be used for an SCCM version they’re not written for. Starting with Fuji, it is recommended to use the plugin version that corresponds to the SCCM version it is designed to integrate with.

To change the SCCM integration:

- Disable the current integration by deactivating the SCCM import schedule.
- Activate the new SCCM plugin.
- Reimport all the software records when you are switching to an integration that supports incremental imports of removed software.

To disable the SCCM import schedule:

1. Navigate to Integration - Microsoft SCCM <version> > Scheduled Import.
2. Clear the Active check box in the SCCM System <version> Import form.
Scheduled Import form

3. Click Save or Update.
4. To activate the new SCCM plugin, navigate to System Definition > Plugins.
5. Search on the name *SCCM to see all the available SCCM integrations plugins.
6. Activate the desired plugin.

Migrate the Verizon eBonding Integration to a Production System

This topic outlines the tasks required for moving the Verizon eBonding integration from a Dev/Test environment to a Production environment.

This process requires coordination with your assigned Verizon implementation manager.

General Tasks

The following work can be performed any time:

- Obtain a production SOAP password from Verizon. Your Verizon SOAP user ID is the same as that used against the Verizon test broker.
- Create an integration user for Verizon in the ServiceNow Production instance. Use the same user name and password that was created for the development instance, so that the communication between Verizon and ServiceNow is properly authenticated.
Migrating to a Production Environment

Perform these tasks in order.

- **Task 1**: Request the Verizon eBonding plugin for the production instance. When the plugin is installed, the only immediate user interface change is an additional **Category** field named **VZ eBonding**. All of the triggers for the integration are dependent on the category being set to **VZ eBonding**. Enabling the plugin on the production instance should not affect your users. If you wish to take additional precautions, disable the **VZ eBonding** category from the list when the plugin is activated for the instance.

- **Task 2**: Set up the Verizon certificate and keystore. Copy these directly over from the Dev instance or regenerate them so that you have separate versions for the Dev and Production instances.

- **Task 3**: Configure the integration properties to work with the Production Verizon eBonding system. This is userID, password, and other properties provided by your Verizon representative.

- **Task 4**: Change all the Verizon eBroker SOAP Message functions to use Verizon's production SOAP Endpoint. In most cases, the endpoint URL will be: https://pubwebsvc.vzbi.com:443/Trouble_Management_v3r0. Verify this URL with the Verizon implementation specialist.
  - In the **SOAP Message Functions** related list, click each function, clear the **Lock** check box, and enter the production endpoint.
  - Configure the **SOAP Message Functions** related list and add the **SOAP endpoint** column. In the **SOAP Message Functions** list view, unlock and update the endpoint for all records by **editing multiple records**.

- **Task 5**: Apply any customizations. If customizations to the integration on the Dev system were captured in an update set, apply that update set to the Production system.

- **Task 6**: Provide Verizon with the production SOAP Endpoint. The SOAP endpoint should look something like this: https://yourproductioninstance.service-now.com/ETMSPublish.do?WSDL.

- **Task 7**: Coordinate a Production turn up with your Verizon representative to do basic testing.

**Warning**: Do not create test tickets against the production system without working with the Verizon team. Any tickets created are treated as real tickets.

---

**Legacy: Altiris integration 2.0**

The Altiris integration is deprecated in the Istanbul release.

The Altiris integration a one direction import of the Altiris data into ServiceNow CMDB (Configuration management database). The integration keeps the ServiceNow CMDB up to date with Altiris SQLServer database.

**Data Import**

Relevant data is imported from the Altiris database to the CMDB. The Altiris database is not written to, it is considered an authoritative source. The import is achieved using a JDBC connection via the **MID Server**.

---

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Information pulled from Altiris includes:

- PC Hardware (Model, Manufacturer, memory, clock speed, number of CPUs, etc.)
- Operating System Information (Name, Service Pack)
- Printers
- Disk information (physical, network, and logical)
- Network (IP Address, Netmask)

**Configuration and Operational Modules**

Enabling this integration will create the **Integration - Altiris** application.
The following are the configuration and operational modules for this integration.

- **Setup**
  - Configure the data sources from one form
    - Provide the Database Server IP Address
    - Provide the Database Name
    - Provide the Database User ID and Password (this will need to be created on SQL DB side, see this article for help with this step: [http://technet.microsoft.com/en-us/library/aa337562.aspx](http://technet.microsoft.com/en-us/library/aa337562.aspx))
    - Find and select the MID Server
  - Specify Database server settings and MID server
  - Test configuration

- **Scheduled Import**
  - Schedule the execution of the import or import immediately

- **Data Sources**
  - A list of the pre-configured data sources defining the external CMDB database

- **Progress**
  - A historical list of progress on scheduled imports

- **Transform History**
  - A historical list of transformations performed during scheduled imports

---

**Warning:** If you have activated an existing integration of the previous version:

1. Activating the 2.0 plugin does not "add to" or "remove" anything from the existing integration.
2. If transitioning from the old integration to this new one, considerations need to be given to customizations already done eg. mapping enhancements or using different coalesce values, these will have to be re-implemented.
3. Both plugins could run at the same time, provided data is coalescing the same way - until there is no need for the older plugin at which time it can be turned off.

---

**Supported Versions**

The Altiris integration only supports Altiris version 6.5. The integration does not currently Altiris version 7.0.

*Legacy Import set data for Altiris*

This topic lists module names displayed by the Altiris import set data.

The Altiris import set data section shows a list of Import sets tables used in containing data retrieved from using JDBC to query the Altiris database. The module names (hence the import set tables they point to) match Altiris's table names and structure that it is loading from.
Module names

Note: Functionality described here requires the Integration - Altiris 2.0 plugin.

- Scheduled Cleanup
  - Configure a schedule to cleanup/delete import set data that have already been transformed

- vComputer
- Inv_AeX_OS_Operating_System
- Inv_AeX_HW_CPU
- Inv_AeX_HW_Memory
- Inv_AeX_HW_Serial_Number
- Inv_AeX_HW_Logical_Disk
- Inv_AeX_OS_Add_Remove_Programs
- Inv_AeX_AC_TCPIP

When viewing each of these table lists, at the end of the list you have links to other operational functions of the import set.

Related Links
- Import Sets
- Transform Maps
- Transform History
- Edit Web Service

Altiris integration application

- **Import Sets**
- **Transform Maps**
- **Transform History** - Log of completed import operations (where an import set was transformed into a table).
- **Edit Web Service**

Legacy: Web services import set tables for Altiris
This topic will list the modules that define the web service import set tables - the schema for the import set tables that are receiving the JDBC import.

From each web service, you can add/remove fields as well as access the transform maps to make modifications.
Note: Functionality described here requires the Integration - Altiris 2.0 plugin.

Related Links

Import Sets
Input Rows
Transform History

Changes made to this list will be saved when the Edit Web Service form above is saved

<table>
<thead>
<tr>
<th>Web Service Fields</th>
<th>Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name</td>
</tr>
<tr>
<td>CreatedDate</td>
<td>u_createddate</td>
</tr>
<tr>
<td>Domain</td>
<td>u_domain</td>
</tr>
<tr>
<td>guid</td>
<td>u_guid</td>
</tr>
</tbody>
</table>

Import set tables
Import set tables

Supported integration interfaces

ServiceNow provides a number of interfaces to be able to directly integrate with the platform. These interfaces are considered part of the platform and are provided at no additional charge.

Supported Integration Interfaces

<table>
<thead>
<tr>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
</tr>
<tr>
<td>JDBC</td>
</tr>
<tr>
<td>JSON</td>
</tr>
<tr>
<td>LDAP</td>
</tr>
<tr>
<td>SOAP</td>
</tr>
<tr>
<td>REST API</td>
</tr>
<tr>
<td>SSO - SAML 2.0</td>
</tr>
<tr>
<td>Digest token authentication</td>
</tr>
<tr>
<td>ODBC</td>
</tr>
<tr>
<td>Data Export</td>
</tr>
<tr>
<td>CTI</td>
</tr>
<tr>
<td>Syslog probe</td>
</tr>
</tbody>
</table>

Computer Telephony Integration

Computer Telephony Integration (CTI) is accomplished by the CTI client on the user machine sending a URL to the instance.

The URL must have the following components:
1. The base URL. For example: https://<instance name>.service-now.com/cti.do? would get to the instance and ask for CTI processing.

2. Parameters identify what parts of the incident form to display.
   - `sysparm_caller_name` = name where 'name' is the name for a user.
   - `sysparm_caller_phone` = phone where 'phone' is the user's phone number. Either a name or phone should be provided if you want to identify the user on the call. Other parameters may be supplied to identify the user as discussed later.
   - `sysparm_task_id` = taskID where 'taskID' identifies an existing issue that the caller is calling about.
   - `sysparm_view` = view where 'view' is the name of the view to be used to display the data.
   - `sysparm_xxxx` = value where 'xxxx' is the name of a field within the 'incident' record that should be populated with the specified 'value'. For example `sysparm_priority=1` would result in the priority field set to value of 1 when the new incident screen is shown.
   - `sysparm_cti_rule` = name where 'name' is the name of a function to be invoked for CTI processing rather than using the default script. The function must be defined in a sys_script entry marked client callable. If the function needs to insert, update, or delete any GlideRecord(s), it must call a separate non-client callable function to perform the update(s).

   **Note:** While the CTI Processing script has been changed to be client callable, the code implementing the task view has been commented out. You must implement a new non-client-callable function for the code that performs the `task.update()`.

   **Note:** To make a script client-callable you must check the client-callable checkbox on the form that displays when the sys_script entry is displayed. The client-callable checkbox might not show by default. To show the client-callable checkbox, you may need to modify the fields that show on the form using the gear icon and slashbucket mechanism.

Parameters on the URL are available to the business rule as global values. For example:

```javascript
var name = sysparm_caller_name;
```

The business rule you specify must return the URL for the pop-up screen, and set the 'answer' global variable.

An example URL to bring up a screen shot for user Don Goodliffe would look like the following.

https://<instance name>.service-now.com/cti.do?sysparm_caller_name=Don %20Goodliffe

Multiple sysparm parameters can be used, separated by ampersands (&).

**CTI Processing script**

When the `sysparm_cti_rule` parameter is not specified, the system uses the CTI Processing script to provide the following functionality.

The CTI Processing script does the following:

1. Tries to identify the user by the `sysparm_caller_name` value if it was supplied.
2. If no user has been found, the script tries to identify the user by the `sysparm_caller_phone` value if it was supplied.
3. If a user has been identified then one of the following is done
   a. If the user has open incidents, the popup screen shows information about the current caller and all the user's open incidents.
b. If the user does not have any open incidents, the popup screen shows a new incident with information provided in the URL shown.

4. If a user was not identified and a taskID is given and the taskID exists, then nothing happens. The code to handle this case is commented out. If you want the popup screen to show the details for the task, you must modify the CTI Processing script to put the functionality in a separate non-client-callable function.

Integrating ServiceNow with your Intranet

There are several ways you can add a ServiceNow login link to your intranet.

You can add a login link by:

- Enabling the PortletLogin Script include to be Client Callable.
- Creating a simple HTML link to your instance that takes your users directly to the ServiceNow login page.
- Adding an iframe link to the ServiceNow login portlet in one of your HTML pages to permit direct login.

**Note:** The ServiceNow login portlet is the only content supported within an iframe HTML element. To deliver ServiceNow content from a web page, see Service Portal instead.

Creating a Simple Link

Edit a web page on your intranet and add a direct link to your ServiceNow instance.

For example:

```html
<a href = "https://yourinstance.service-now.com">Help Desk</a>
```

Enabling the PortletLogin Script include to be Client Callable

The login portlet (https://yourinstance.service-now.com/portal/login.html) uses the PortletLogin Script Include.

Since this script is not client callable by default, you must enable the client callable option.

1. Navigate to System UI > Script Includes.
2. Open the script PortletLogin.
3. Check the Client Callable check box.
4. Click Update.

Add the Login Portlet

Adding the login portlet to an iframe HTML element creates an unbranded user and password prompt on any HTML page.

The user enters their user id and password and either presses the ENTER key or clicks the Login button. Once validated, the browser transfers to the logged-in ServiceNow session.

The portlet's size is 240 pixels wide and 125 pixels high. The portlet looks like:
To enable the login portlet:

1. Set the high security properties `glide.security.use_csrf_token` and `glide.set_x_frame_options` to `false`.
2. Add the following HTML code to your portal:

   ```html
   <iframe border = "0" frameborder = "0" width = "240" height = "125" src = "https://yourinstance.service-now.com/portal/login.htm" ></iframe>
   ```

   If you do not want to change your instance's High Security settings, create a simple link instead.

**JDBCProbe**

A JDBC probe runs on the MID Server to query an external database via (JDBC) and returns results to ServiceNow.

Probes interact with the MID Server via the ECC Queue, therefore the response of a JDBC probe returns as an XML payload in an "input" ECC Queue record. By default, each response payload will contain up to 200 returned rows, this value can be modified by setting the probe parameter `jdbcprobe_result_set_rows` to the desired number.

**Activating the Plugin**

Contact ServiceNow Technical Support to activate the Integration - JDBC (com.snc.integration.jdbc) plugin.

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   
   If the plugin depends on other plugins, these plugins and their activation status are listed.
3. (Optional) Select the Load demo data check box.
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

**Direct JDBC Probe**

A direct JDBC probe specifies all the parameters necessary in the outbound ECC Queue XML payload.

It is a standalone probe that is decoupled from a JDBC Data Source and does not insert into an import set. The required field in the ECC Queue record for a direct JDBC probe is Topic and it must
equal **JDBCProbe**. The **Source** field is reserved for the `sys_id` of the data source record in the case of a JDBC data source.

**Note:** If you have ServiceNow Discovery enabled on your platform, add the `skip_sensor` parameter to the probe to avoid the discovery sensors from processing the probe and resulting in a "No sensors defined" error.

**XML Structure**

A direct JDBC probe has the following XML payload structure:

```xml
<parameters>
  <parameter name = "skip_sensor" value = "true" />
  <parameter name = "sys_id" value = "sys_id_value" />
  ...
  <parameter name = "work" ><select ... >
    ...
  </select></parameter>
</parameters>
```

**JDBC Probes via Data Source**

JDBC probes are executed via a JDBC data source when an import is running against the data source.

A JDBC data source JDBC probe is described by the JDBCProbe Topic and the `sys_id` of the data source in the Source field of the ECC Queue output record.

The data source record would look like this.
JDBC Data Source

The following ECC Queue output probe will be created when you load from the data source.
JDBC Data Source Probe

Select * JDBC Probe short cut
Alternatively, you may specify a table_name parameter instead of a work element and the following query could be executed.

```
select * from <table_name>
```

For example, using the following XML payload

```xml
<?xml version= "1.0" encoding= "UTF-8" ?><parameters><parameter name = "jdbc_driver" value = "com.microsoft.sqlserver.jdbc.SQLServerDriver" />
<parameter name = "connection_string" value = "jdbc:sqlserver://xxx.service-now.com;databaseName=SMS_CRICKET;user=sms;password=sms" />
<parameter name = "table_name" value = "System_DATA" /></parameters>
```

Counting Rows

To count the number of rows in a table, you can indicate a select count(*) type query by including the count_rows parameter with a value of true.

For example

```xml
<?xml version= "1.0" encoding= "UTF-8" ?><parameters><parameter name = "jdbc_driver" value = "com.microsoft.sqlserver.jdbc.SQLServerDriver" />
<parameter name = "connection_string" value = "jdbc:sqlserver://xxx.service-now.com;databaseName=SMS;user=sms;password=sms" />
<parameter name = "count_rows" value = "true" /></parameters>
```

The resulting response XML payload

```xml
<parameters>
... 
<result query = "SELECT count(*) as row_count FROM System_DATA" ><row
id = "1" ><row_count class = "java.lang.Integer" length = "11" type = "4"
>2312</row_count></row></result>
```
Parameters
The following parameters are available in a direct JDBC probe.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jdbc_driver</td>
<td>Required. Java class name for the JDBC driver to use, the currently supported drivers are:</td>
</tr>
<tr>
<td></td>
<td>· Oracle: oracle.jdbc.OracleDriver</td>
</tr>
<tr>
<td></td>
<td>· Microsoft SQL Server: com.microsoft.sqlserver.jdbc.SQLServerDriver</td>
</tr>
<tr>
<td></td>
<td>· MySQL: com.mysql.jdbc.Driver</td>
</tr>
<tr>
<td>connection_string</td>
<td>Required. JDBC connection string/URL for defining the connection, usually contains information about the database server and name, the user ID and password for connecting to the database. The syntax is vendor specific, refer to the following links for reference:</td>
</tr>
<tr>
<td></td>
<td>· Oracle: [jdbc:oracle:thin:&lt;username&gt;/password&gt;@&lt;database&gt;]</td>
</tr>
<tr>
<td></td>
<td>· Microsoft SQL Server: [jdbc:sqlserver://localhost;user=MyUserName;password=*****;]</td>
</tr>
<tr>
<td></td>
<td>· MySQL: [jdbc:mysql://localhost/database?user=username %26password=passwd]</td>
</tr>
<tr>
<td>work</td>
<td>Required if not using the table_name parameter short cut. Parent element of an XML fragment describing the SQL command to execute.</td>
</tr>
</tbody>
</table>

Example

com.microsoft.sqlserver.jdbc.SQLServerDriver

dbc:sqlserver://xxx.service-now.com;
databaseName=SMS;
user=sms_user;
password=sms_password;

Example

...<parameter name= "work" ><select table = "System_DATA" where = "InstanceKey=692" ><MachineID /><SMSID0 /></select></parameter>
### Parameter | Description
--- | ---
query_timeout | Optional during SELECT. Number of seconds the JDBC driver will wait for a query (SELECT) to complete. Zero means no timeout. If timeout is exceeded, the integration considers the JDBC result inaccessible and places it in an error state.

table_name | Optional (except required during count_rows == true). Alternate way of executing a select * query; instead of using the work element. Equivalent to executing select * from <table_name>.

count_rows | Optional. Indicates whether a select count(*) query should return the number of rows (true/false). The result of the count will be returned as a row_count element in the result element.

query | Optional. Type of query. Possible choices are 'All Rows from Table' or 'Specific SQL'. If 'Specific SQL', the sql_statement will be required to specify the SQL statement.

sql_statement | Optional. Use a specific SQL query. The presence of this element executes a direct query specified in the value attribute.

skip_sensor | Optional. Determines if Discovery will attempt to process the ECC input from the JDBCProbe. Default = true

---

**Example**

```... select * from any_table where id = 123 ...
```

For example, to query a table using a direct JDBC probe, requires the following parameters:

- JDBC driver class name
- JDBC connection string
- Database server
- Database name
- User name
- User password

- The table name

Queue form

Using the Work Element
The work element encodes SQL statements to be executed by the probe.

The following are the valid work child elements.

- select
- update
- insert
- delete
SELECT

Retrieve rows from the specified table in the database specified by the JDBC connection string. The simplest select work just specifies the table name and will retrieve all fields in a row, for example:

```xml
...<parameter name="work"><select table="System_DATA" /></parameter>
...
```

To specify a search criteria, specify the where attribute on the select element, for example:

```xml
...<parameter name="work"><select table="System_DATA" where="InstanceKey=692"></select></parameter>
...
```

To specify the fields you want returned, embed the fields as child elements of the select element, for example:

```xml
...<parameter name="work"><select table="System_DATA" where="InstanceKey=692"><MachineID/><SMSID0/></select></parameter>
...
```

To use a direct SQL statement, specify it in the query parameter

```xml
...<parameter name="query" value="Specific SQL" /><parameter name="sql_statement" value="select * from any_table where value='test'" />
...
```

UPDATE

An update SQL can be executed by specifying the table, optional where clause and required child elements for the fields and their values to update.

```xml
...<parameter name="work"><update table="alerts.status" where="ServerName %='NCOMS' AND ServerSerial=3935"><Agent>ServiceNow - INC10020</Agent><URL>http://Macintosh-9.local:8080/glide/incident.do?sys_id=17a31f380a0a0bbae0048ca8750c891d0</URL><Severity quoted='false'>3</Severity><Acknowledged quoted='false'>0</Acknowledged></update></parameter>
...
```

INSERT

An insert SQL can be executed by specifying the table, and required child elements for the fields and their values to insert.

```xml
...<parameter name="work"><insert table="alerts.status" ><Agent>ServiceNow - INC10020</Agent><URL>http://Macintosh-9.local:8080/glide/incident.do?sys_id=17a31f380a0a0bbae0048ca8750c891d0</URL><Severity quoted='false'>3</Severity><Acknowledged quoted='false'>0</Acknowledged></insert></parameter>
...
DELETE

A delete SQL can be executed by specifying the table, and optional where clause.

```xml
<parameter name="work"><delete table="alerts.status" where="ServerName%='NCOMS' AND ServerSerial=3935"/></parameter>
```

Build a search provider for your instance

ServiceNow Search Providers allow you search this Wiki and our Forums from the IE and Firefox search bar. In Firefox 3.x you can also assign a keyword to each Search Provider and access them from the address bar. For example, assign w to the wiki search provider and you can search the wiki for Business Rules by typing: w business rules in the address bar.

```
<OpenSearchDescription xmlns="http://a9.com/-/spec/opensearch/1.1/">
  <ShortName>Demo Search</ShortName>
  <Description>Demo Search provider</Description>
  <InputEncoding>UTF-8</InputEncoding>
  <Url type="text/html" template="https://www.service-now.com/demo/nav_to.do?url=incident_list.do?sysparm_query=active%3Dtrue%3DTEXTQUERY321%3D{searchTerms}"/>
</OpenSearchDescription>
```

1. Create an opensearch description document. You can review the OpenSearch standards for details on additional attributes of this document such as including an icon.

2. Save the file to a web server with xml extension. The method used to install doesn't allow local file calls.
3. Create a simple HTML page to install the provider.

   ```html
   <a href="javascript:window.external.AddSearchProvider('http://yourServer/yourFile.xml');"
   title="MySearch" name="ServiceNow Custom Search">Add ServiceNow Custom Search Provider</a>
   
   You could try running the JavaScript command from the browser location box instead of using the HTML file. This works with FF not IE.
   
   **Syslog probe**

   The ServiceNow Syslog probe uses the MID Server to deliver log messages from a ServiceNow instance to another machine, such as a dedicated log server, using the syslog protocol over an IP network.

   **How the Syslog Probe Works**

   The syslog probe is launched by a ServiceNow **Script Include** (called Syslog) that can be invoked from a **business rule**, event, or Orchestration activity and is launched by a MID Server. A syslog server or any server that can receive messages using the syslog protocol must be installed on the recipient (target) machine. Typically, a dedicated log server in the network is configured to receive all internal syslog messages. Some products that accept syslog messages are:

   - ArcSight
   - Splunk
   - LogLogic
   - syslog-ng

   **Example**

   The Acme Corporation wants to send a log message from their ServiceNow instance to an ArcSight syslog server inside their corporate firewall each time a user login fails. The system administrator uses the login.failed event to trigger a business rule that invokes the Syslog Script Include each time a login fails. Acme's MID Server checks the ECC Queue for work and picks up the syslog probe, which contains the log entry. The MID Server then sends the log message to the ArcSight server, which gathers log messages from all the machine in the internal network.
The following code sample, included in an event or a business rule, directly calls the Syslog Script Include and sends a syslog message to a designated syslog server:

```javascript
var sl = new Syslog('FQDN of your syslog server', 'mid.server.Eclipse', 16);
sl.log('This is a sample log message', 6);
```

This code does the following:

- Sends the log message to facility 16
- Sets the priority to 6 (informational)
- Sends the message to your syslog server
- Launches the probe via the MID Server named "Eclipse"

**User administration**

Manage the individuals who can access your instance by defining them as users in the system. Create user groups, and assign users to them. Use roles to specify what different users and user groups can see and do.

A group is a set of users who share a common purpose. Members of groups perform tasks such as approving change requests, resolving incidents, receiving email notifications, or performing change request tasks. Assign every user to at least one group.

A good practice is to assign roles to groups rather than to users. Administrators can assign roles quickly to multiple users by adding the users to the group. If a user moves to another group, the role assigned to the new group is applied automatically.

**Add a new company**

You can add companies that represent vendors, manufacturers, or customers with whom you do business. These companies provide a way to categorize users, groups, and assets.

Role required: user_admin or admin

1. Navigate to **User Administration > Companies**.
2. Click **New**.
3. Complete the fields, as appropriate.

**Company fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the company.</td>
</tr>
<tr>
<td>Phone</td>
<td>Company phone number.</td>
</tr>
<tr>
<td>Fax phone</td>
<td>Company fax number.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Whether the company is a manufacturer.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Whether the company is a vendor.</td>
</tr>
<tr>
<td>Stock symbol</td>
<td>Three or four letter stock symbol for the company.</td>
</tr>
<tr>
<td>Stock price</td>
<td>Current price at which company stock is sold.</td>
</tr>
<tr>
<td>Street</td>
<td>Mailing street address of the company.</td>
</tr>
<tr>
<td>City</td>
<td>City in which the company is located.</td>
</tr>
<tr>
<td>State</td>
<td>State or province in which the company is located.</td>
</tr>
<tr>
<td>Zip/Postal code</td>
<td>Zip or postal code for the company.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any information about the company that would be helpful for others to know.</td>
</tr>
</tbody>
</table>

Fields that can be added by configuring the form:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latitude</td>
<td>The latitude of the company, if applicable. This field is populated by a business rule called <code>get_lat_long</code>. Deactivate this business rule to prevent the system from overwriting any values populated in the field manually. Latitude is expressed as a floating point data type. Latitude from upgraded versions of ServiceNow expressed in any format other than floating point appears in a column called <code>Old Latitude</code>. The system attempts to convert all latitude values from previous versions to the floating point notation, where possible.</td>
</tr>
<tr>
<td>Longitude</td>
<td>The longitude of the company, if applicable. This field is populated by a business rule called <code>get_lat_long</code>. Deactivate this business rule to prevent the system from overwriting any values populated in the field manually. Longitude is expressed as a floating point data type. Longitude from upgraded versions of ServiceNow expressed in any format other than floating point appears in a column called <code>Old Longitude</code>. The system attempts to convert all longitude values from previous versions to the floating point notation, where possible.</td>
</tr>
</tbody>
</table>

**Note:** The IT Finance application adds a Finance view to the Company form. The Finance view adds a chart that shows expenses that were allocated to the company.

**Manage user administration system properties**

The administrator can add or modify system properties to let users view their profile, automatically create a user record from a registration request, and modify the impersonate option.

**Allow a user to view a profile**

Users are able to view their profile by clicking their name in the Welcome banner. If your users cannot do this, enable a system property.

Role required: admin

1. Navigate to the System Properties (sys_properties) table.
2. Search for the `glide.ui.welcome.profile_link` property.
3. Set the value to `true`.

**Enable auto processing of a request**

You can enable auto processing of user self-registration requests by setting a property.

Role required: admin
When the **Enable auto processing of user registration requests** property is enabled, user accounts are automatically created upon registration.

1. Activate the User Registration Request (com.snc.user_registration) plugin. The User Registration Request plugin provides the ability for unregistered users to request access to a ServiceNow instance. For more information, see [Activate a plugin](#).
2. Navigate to **System Properties > System**.
3. Select the check box for the property **Enable auto processing of user registration requests**.
4. Click **Save**.
   If enabled, registration requests do not require approval. Instead, the business rule **Auto-Process User Registration** creates the user record from the information provided.

### Show or hide impersonation button

You can set a system property to show or hide the impersonation button. By default, the system shows the impersonation button.

**Role required:** admin

The system property only controls the visibility of the impersonation button, which is rendered by the **impersonate_button** UI macro. The impersonation button opens the **impersonate_dialog** UI page. Modifying either the impersonation UI macro or impersonation UI page are not recommended.

1. Navigate to **System Properties > UI Properties**.
2. Clear **Enable impersonation button in banner line** to hide the impersonation button, or select it to show the impersonation button.
3. Click **Save**.

Administrators can still access impersonation by navigating directly to the **impersonate_dialog** UI page.

### Add a department

Departments provide another way to categorize users, groups, and assets. You can add departments and assign them to users.

**Role required:** user_admin or admin

An administrator may need to configure the form to show all the fields listed in the steps.

1. Navigate to **User Administration > Departments** and create a new record.
2. Enter or modify the department name, ID, and description.
3. Optional: Select the company the department is associated with.
4. Optional: Add a department head, primary contact, or both from your list of users.
5. Optional: Add the parent department, if applicable.
6. Click **Submit**.

### Create a user

You can add a user to your instance to allow them to log in and use the features.

**Role required:** user_admin or admin

1. Navigate to **User Administration > Users**.
2. Click **New** and enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Create a unique identifier for this user's ServiceNow login user name. Typical examples of user IDs are cwitherspoon and charlie.witherspoon. You cannot create a new user whose User ID duplicates an existing user. If you do import duplicates from an update set, the more recently created name takes the duplicate User ID.</td>
</tr>
<tr>
<td>First name</td>
<td>Enter the user's full first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Enter the user's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter a title or job description, or select one from the list.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the user's department from the list.</td>
</tr>
<tr>
<td>Password</td>
<td>Assign a password to the user. This password can be permanent or temporary.</td>
</tr>
<tr>
<td>Password needs reset</td>
<td>Select this check box to require the user to change the password during the first login.</td>
</tr>
<tr>
<td>Locked out</td>
<td>Select this check box to lock the user out of the instance and terminate all their active sessions. The system prevents users with the admin role from locking themselves out.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make this user active. Only the administrator sees inactive user in:</td>
</tr>
<tr>
<td></td>
<td>• Lists of users</td>
</tr>
<tr>
<td></td>
<td>• The selection list on reference fields (magnifying glass icon)</td>
</tr>
<tr>
<td></td>
<td>• The auto-complete list that appears when you type into a reference field</td>
</tr>
<tr>
<td>Web service access only</td>
<td>Select this check box to designate this user as a non-interactive user. This field is available with <a href="#">Non-Interactive Sessions</a>.</td>
</tr>
<tr>
<td>Internal Integration User</td>
<td>Select this check box to designate this user as an <a href="#">Internal Integration user</a>.</td>
</tr>
<tr>
<td>Date format</td>
<td>Select the user's preferred format for dates.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Email                 | Enter the user's email address. To enter a non-standard email address that does not pass field validation, you must *deactivate* the validation script first.  
  1. Navigate to System Definition > Validation Scripts.  
  2. Select the email record.  
  3. Clear the Active check box and save the change.  
  4. Complete the user profile, including the email address, and update or submit the record.  
  5. Reactivate the email validation script. |
| Notification          | Select the type of notification to send to this user. The default is Email. If you select *None*, the user can still receive notifications if they subscribe to the notification or are specified as a recipient in the Email Notifications form.  
  To prevent notification completely, set a condition on the Email Notification form itself that does not deliver the notification if this field is set to None. |
| Calendar integration | Select Outlook to have this user receive meeting notifications via email directly to the calendar. Otherwise, select *None*. |
| Time zone             | Select the user's time zone.                                                |
| Business phone        | Enter this user's business phone number.                                    |
| Mobile phone          | Enter this user's mobile phone number.                                      |
| Photo                 | Attach a photo of the user, if appropriate.                                 |
| Geolocation tracked   | Select the check box to enable location tracking. The *Geolocation tracked* field, which is available when *Geolocation* is activated, provides the option to track a user's location. |
| Location              | Select the user's usual location. This field is visible when geolocation is active. |

3. Optional: Customize the form to add the Schedule field and assign a schedule to the user.  
4. Optional: Customize the form to add a Language field or a Country code field to associate a specific language or location with a user.  
5. Click Submit.  
   The new user record appears at the top of the list.

**Deactivate the validation script during user creation**

To enter a non-standard email address that does not pass field validation, you must deactivate the validation script first.
Role required: admin

1. Navigate to System Definition > Validation Scripts.
2. Select the email record.
3. Clear the Active check box and save the change.
4. Complete the user profile, including the email address, and update or submit the record.
5. Reactivate the email validation script.

User preferences

Individual users can configure many UI features, such as the number of rows per page in a list or whether the response time displays at the bottom of a v2 list or form.

These user customizations are stored as records in the User Preference (sys_user_preference) table, and are updated each time the user changes the setting.

The UI displays according to each user's preferences.

For example, by default the response time may appear at the bottom of v2 lists and forms. If a user hides the response time, a user preference record is created showing the response time indicator as hidden. During the user's future sessions, the response time indicator is hidden. If the same user later displays the response time, the user preference record is updated appropriately and future sessions open with the response time indicator visible.

Navigate to User Administration > User Preferences for a list of user preference records. Click a preference name to display that preference in form view.

Note: Having more than 10,000 user preferences causes system degradation and UI performance issues.
### User Preferences form

#### User preference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the feature or functionality.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional short description of the feature or functionality.</td>
</tr>
<tr>
<td>System</td>
<td>Shows whether this record indicates the system-wide default (TRUE), or not (FALSE).</td>
</tr>
<tr>
<td>Type</td>
<td>Shows the data type of entry accepted for the Value. For example, you can select string or integer.</td>
</tr>
<tr>
<td>User</td>
<td>Shows the name of the user for whom the setting is customized. If User is blank, the record is for a system-wide default.</td>
</tr>
</tbody>
</table>
Records for the system-wide value, which applies to users who have not customized the feature, have these values: **System=True** and **User=blank**. For each user who customizes the features, a separate record is created with these values: **System=False** and **User=<username>**. As a result, the same customizable UI feature may have multiple user preference records.

For some features, the system-wide record does not appear in the User Preferences module initially. The system-wide record may be added to the User Preferences list when a user record is created for the same feature.

When an administrator manually changes a user's preference value through this module, the user's next session uses the administrator's setting. However, the user can customize the features again through the UI, which updates their user preference record. If the administrator deletes the user preference record for a particular user, that user's next session uses the system-wide value for that feature. When the user later customizes the feature, the system creates a user preference record for the user.

### User preferences and update sets

User preference records for system-wide values, also called the default or global values, are stored in update sets. Any changes are implemented when you import the update set and affect all users who have not customized the feature. User preference records for specific users are not stored in update sets, so user customizations are retained when you import an update set.

### Troubleshooting user-specific UI differences

If a user encounters an unexplained behavior in the user interface, an administrator can check their user preferences. Navigate to **User Administration > User Preferences**. Search for the user name to find all that user's records. Delete the record that affects the behavior in question.

The system-wide preference is active during the user's next session. If the user customizes the behavior, a new user preference record is created and used for subsequent sessions.

### User self-registration

The User Registration Request plugin provides the ability for unregistered users to request access to a ServiceNow instance. An administrator can activate the plugin.

A user can request an account by navigating to the instance. If the plugin is installed, the following section is added to the welcome screen.

#### Request a user account

*If you do not yet have a user account you can request one using the self registration form.*
The user can complete and submit the self-registration form, and see a confirmation that it was submitted. The user receives an email when the account is registered.

Note: If the email address entered in the self-registration form is already in the system, the request is not submitted.

Approve an account

When a user submits a self-registration form, it can be reviewed and approved.

Role required: admin

1. Navigate to User Administration > Pending User Registrations and open the request.
2. Use the Create User and Reject related links on the registration request form to approve or deny the request.
   - If Create User is selected, a new user is created using the email address as the User ID.
   - If Reject is selected, the request is marked Rejected.

The user is sent an email notification with the login information if the request was accepted, or the rejection information.
3. Optional: To view past registration requests, remove the (State) (is) (Pending) breadcrumb from the list view.

Impersonate a user

Administrators can impersonate other authenticated users for testing purposes and view impersonation logs. The impersonation option is not visible in the mobile view of the platform.

When impersonating another user, the administrator has access to exactly what that user can access in the system, including the same menus and modules. The instance records anything the administrator does while impersonating another user as having been done by that user.
Impersonation limitations

- When you impersonate any user, all scope-protected roles and encryption context roles are removed from the user being impersonated. However, if the impersonating user (the admin, for example) has a scope-protected role, that role is not removed from the list of roles for the user being impersonated.
- When you impersonate a user with an application-specific admin role (for example, an application admin for Human Resources or Security Incident Response), you cannot access features granted by the application admin role, including security incidents, profile information, or other scope-protected features, unless you already have those roles. Access to modules and applications in the navigation bar is also restricted. Admins cannot change the password of any user with an application admin role.
- Impersonating a user is not supported for mobile phones. For most mobile phones, however, you can impersonate a user by switching to standard view, performing the impersonation, and switching back to mobile view. Some mobile devices may have problems rendering the Impersonation dialog.

Impersonation requirements

The user account to be impersonated must have a user ID. You can find this ID in the User (sys_user) record for the account. If this value is missing, the message The user you selected could not be impersonated appears.

You need several different logins to test the system:

- An admin account to do work.
- An itil (or similar) login to test as a technician.
- An ess login to test as an end user.

More logins may be required to adequately test the system.

**Note:** When you impersonate a user who is locked out or is inactive, the system forces a logout after you generate an event or click a link. All changes made while using impersonation affect the current session. Make sure you properly logout, then login after impersonation is completed.

Impersonate a user in UI16

You can select a user or enter a different user name to perform impersonation.

Role required: impersonator

1. In the banner frame, click your user name to open the user menu.
2. Select Impersonate User.
   - The Impersonate User dialog box appears.
3. Select a user from the Recent Impersonations list or enter a different user's name in the user selection field.
4. To return to your original login, follow these same steps then select your name from the list.

Impersonate a user in UI15 or UI11

You can click the impersonate icon and select a user name to perform impersonation.
Role required: impersonator

1. Click the impersonate icon (👤 in UI15, 🔄 in UI11) in the banner frame. The Impersonate User dialog box appears.
2. Select the user from the Recent Impersonations list, click the lookup icon and select the user’s name from the full list, or type the user’s name.
3. Click OK.

Impersonation logs

Impersonations are logged in the System Log. The administrator can enable or disable impersonation logging with the glide.sys.log_impersonation property.

<table>
<thead>
<tr>
<th>Source</th>
<th>Message</th>
<th>Created</th>
<th>Level</th>
<th>Message end:</th>
<th>Impersonate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Impersonation end: Claudio Loose (claudio.loose)</td>
<td>2017-02-13 15:43:26</td>
<td>Information</td>
<td></td>
<td>Impersonate</td>
</tr>
<tr>
<td></td>
<td>Impersonation end: ATF User (ATF.User)</td>
<td>2017-02-13 16:17:36</td>
<td>Information</td>
<td></td>
<td>Impersonate</td>
</tr>
<tr>
<td></td>
<td>Impersonation end: Julie Lewis (julie.lewis)</td>
<td>2017-02-13 11:05:05</td>
<td>Information</td>
<td></td>
<td>Impersonate</td>
</tr>
</tbody>
</table>

Impersonate log

Force logout

In some cases, impersonating a user might cause an issue that makes it difficult to switch back (for example, if in a test environment, the user is being presented with a broken page).

To return to the user, navigate to http://<instance name>.service-now.com/logout.do and log back in.
Manage user sessions

The Now Platform provides the ability to view and terminate individual user sessions, lock out users from the system, and make users inactive.

- Terminating a specific user session effectively logs that user out of the next transaction, which is usually the next browser click. Use the terminate sessions feature when you want to perform system maintenance.
- Locking a user out of the system means the user can no longer log in or generate any actions from any email messages that the user sends to the instance. Locking out users also terminates their user sessions.
- Making a user inactive means that the user does not show up in any fields that reference active users on the User table.

Modify session timeout

The base system uses the default Apache session timeout of 30 minutes.

Role required: admin

After 30 minutes of inactivity in the application, the platform logs the user out automatically, unless the Remember Me check box in the login screen is selected. Making the interval longer can lead to the unnecessary maintenance of inactive sessions in memory. Adjust this timeout setting to no more than a few hours, although up to 24 hours is workable.

Note: Regardless of how many windows a user has open in a browser, it is considered to be one session. However, if a user has two separate browsers open (such as Internet Explorer and Firefox), it is considered to be two separate sessions.

1. Clear the Remember Me check box in the login screen.
2. Add a new property using the following values:
   - Name: glide.ui.session_timeout
   - Description: Type a brief description. In this case, enter something like Override the default session timeout (30). This value is in minutes.
   - Type: Select the appropriate data type. In this case, select Integer.
   - Value: Change the default value from 30 minutes to a value of your choice.

Note: The session timeout can also be set through installation exit customizations.

- Ajax calls to the server keep the session alive (such as Labels and Refreshing homepages).
- Polling keeps the session alive when the chat desktop is open (requires the Chat plugin).
- Administrators can add the following properties to the System Properties table.
  - glide.security.csrf.handle.ajax.timeout: Handles errors for timed out Ajax requests when set to true.
  - glide.security.auto.resubmit.ajax: Automatically resubmits timed-out Ajax requests when set to true and the Remember Me check box is selected or automatically set. A popup appears to users asking them to continue.
  - glide.ui.auto_req.extend.session: When set to true, the system automatically extends a user’s session by the value the user selects for the homepage refresh time. If there is no homepage refresh time, the standard timeout value applies. Tablet and mobile devices do not support this property. When set to false, user sessions time out when the Remember me check box is clear. The timeout is based on whether there is a homepage refresh time. When there is no homepage refresh time, the standard timeout value applies. When there is a homepage...
refresh time, the user session times out after the timeout value plus one interval of the homepage refresh time. For example, if a user selects to refresh interval of five minutes, then user sessions expires after the timeout value plus five minutes.

**Note:** Users who select the **Remember me** check box are unaffected by session timeout properties.

- Administrators can also add the following properties to configure an alternate session timeout value for guest sessions. You can do this to conserve system resources:
  - `glide.session.unauthorized.timeout.enabled`: If set to **true**, enables an alternate session timeout for unauthenticated, guest sessions. Guest sessions are created for HTTP requests to the instance that do not contain authentication information. By default this property is set to true.
  - `glide.unauthorized.session_timeout`: The session timeout value in minutes that controls the lifespan of an unauthenticated (unauthenticated) guest session. Set the property to a value greater than **0** and less than the value in the `glide.ui.session_timeout` property.

**Lock out a user**

Lock out a user when you do not want the user to access the instance.

Role required: user_admin or admin

1. Navigate to **User Administration > Users** and select the user from the list.
2. Select the **Locked Out** check box, and update the record.

**Mark a user inactive**

You can mark a user inactive so the user does not show up in any fields that reference active users on the User table.

Making a user inactive does not lock out the user. The Lock Out Inactive Users business rule, which is active by default in all instances, sets the **Locked Out** flag to **true** on the User record when the Active flag is set to **false**. If you do not have this business rule active, inactive users are not automatically locked out and can still log in the instance.

1. Navigate to **User Administration > Users** and select the user from the list.
2. Clear the **Active** check box, and update the record.

**Terminate a specific user session**

You can terminate a user session, for example, if you are going to perform system maintenance and users are still logged in.

1. Navigate to **User Administration > Logged in users**.
   You can only see users who are logged into the same application node as you. If the Active field on a user record value is false, the user is logged in but not currently running a transaction. Most users appear as inactive at any given time.
2. Select the session you want to end.
3. Click **Lock Out Session**.
   The session is terminated, and the user is redirected to the login page at the next attempted transaction. The user is not locked out. Multiple user sessions may be associated with one user. Terminating a user session only affects the specific session.
Groups

A group is a set of users who share a common purpose. Groups may perform tasks such as approving change requests, resolving incidents, receiving email notifications, or performing work order tasks. Any business rules, assignment rules, system roles, or attributes that refer to the group apply to all group members automatically. Users with the user_admin role can create and edit groups.

Create a user group

Create groups and assign roles to them. Users assigned to the group inherit the roles.

Role required: user_admin or itil

Navigate to User Administration > Groups and create a new record (see table for field descriptions).

To see some of the fields, you may need to personalize the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Group manager or lead.</td>
</tr>
<tr>
<td>Type</td>
<td>Category for this group. For example, a group designated as type catalog is a service catalog group and can also be accessed under the Service Catalog &gt; Catalog Policy &gt; Fulfillment Groups module. You may need to personalize the form to add the Type field. Activating the Work Management plugin adds the Type field automatically. Note: ITIL is added for groups with an empty group type. Also, the default reference qualifier for tasks allows these groups to assign tasks and other task types to the group.</td>
</tr>
<tr>
<td>Group email</td>
<td>Group email distribution list or the email address of the point of contact, such as the group manager.</td>
</tr>
<tr>
<td>Parent</td>
<td>Other group of which this group is a member. If a group has a parent, the child group inherits the roles of the parent group. The members of the child group are not members of the parent group. For example, if an incident is assigned to the parent group and you click the Assigned to lookup icon, only the members in the parent group are available. The members of the child group are not available.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Active             | Check box that indicates whether the group is active or inactive. Inactive groups still appear in any reference field that already references the group, but are not visible by non-admin users in:  
  - lists of groups  
  - the reference lookup list for reference fields  
  - the auto-complete list of groups displayed when you type into a reference field |
| Exclude manager    | Check box that controls whether the group manager receives email notifications.                                                           |
| Include members    | Check box that controls whether the group members receive individual emails when someone sends an email to the Group Email address. The only exception to this functionality is for approval notifications, whereby all members of a group receive an approval notification, regardless of the Include members selection. See Receive notifications for more information. |
| Description        | Helpful information about the group.                                                                                                       |

### Add a user to a group

Add a user to a group so the user inherits all the roles assigned to the group.

Role required: user_admin or itil

1. Navigate to **User Administration > Groups**.
2. Click a group Name.
3. In the Group Members related list, click **Edit**.
4. Select one or more names in the Collection list.
5. Click **Add**.
6. Click **Save**.

### Remove a user from a group

Remove a user from a group when they change roles.

Role required: user_admin or itil

1. Navigate to **User Administration > Groups**.
2. Click a group **Name**.
3. In the **Group Members** related list, select the check box next to each group member name you wish to remove.
4. From the **Actions on selected rows** menu, select **Delete**.

**Note:** Before selecting **Delete**, first make sure you have properly selected the rows containing the specific users you wish to remove from the group.
Hide groups
You can hide groups by introducing a hidden field to the group form and then creating a business rule to filter out groups marked as hidden.

Only users in the hidden group will be able to see the hidden field when selecting a group in a reference field.

Add a hidden field to a group form
Add a custom check box field to the group form to allow the group to be hidden by the business rule.

Create a new true/false field labeled Hidden on the Group form.

The system creates new field called u_hidden on the (sys_user_group) table and enables use of the Hidden check box to designate a hidden group.

Add a business rule to filter out hidden groups
After creating a custom field on the group form to hide the group, add a business rule to filter out hidden groups. Only users within the hidden group and users marked admin or groups_admin can see the group.

Create a new before query business rule on the (sys_user_group) (Group) table with the following script:

```javascript
if (!gs.hasRole("admin") && !gs.hasRole("groups_admin") &&
gs.getSession().isInteractive()) {
    var qc = current.addQuery("u_hidden", ",!=" , "true"); // cannot see hidden groups...
    qc.addOrCondition("sys_id", "javascript:getMyGroups()"); // ...unless in the hidden group
}
```

Configure group types for assignment groups
Use the Type field to define categories of groups. Once defined, you can use these categories to filter assignment groups based on the group type using a reference qualifier.

For example, when selecting an assignment group from the Incident form, Type can be used to filter groups based on whether they are typically involved in the Incident management process. Groups such as Network or Help Desk are displayed as they are typically involved. Groups such as HR or New York are omitted.

The following items are provided in the base system.

- The types catalog, itil, and survey.
- The reference qualifier on (task.assignment_group) filters on (Type) (equals) (null).
- A reference qualifier named GetGroupFilter is available to filter for group types using dynamic filters.

Note: Dictionary overrides allow administrators to filter for a group type on an extended table with a simple reference qualifier override.

Add a new group type
You can add additional group types to filter assignment groups for tasks.
Role required: admin

You may need to configure the form to display the Type field.

1. Navigate to User Administration > Groups.
2. Select a group record.
3. Click the lock icon beside Type.
4. Click the lookup icon beside the selection field.
   The Group Types dialog opens.
5. Complete the following steps.
   a) Click New.
   b) Enter the group type name and description.
      For example, to define a type for a group as incident and problem, enter: incident,problem.
      Click Submit.

   The Group form reopens with the new type listed.
6. Optional: Add additional group types if needed.
7. Click Update.

Assign a group type

You can assign group types to filter assignment groups for tasks.
Role required: admin

1. Navigate to User Administration > Groups and select the desired group.
2. Click the lock icon beside Type.
3. Click the lookup icon beside the selection field and select one or more group types.

   Note: Because the default behavior of task.assignment_group is to filter out groups with group types defined, adding a type to a group filters it out of the Assignment Group field on tasks. To change the behavior, set up the reference qualifier.

4. Click Update.

Skills Management

The Skills Management feature enables an administrator to assign configured competencies, called skills, to groups or individual users. These skills can then be used to determine who can be assigned to particular tasks.

Skills can contain other skills. Any access granted to a parent skill is granted to any skill that it contains. Once a skill is assigned to a group, all members of the group automatically inherit that skill and any others contained within it. The skills mechanism is similar to the ServiceNow platform role management.

Create a skill

You can create skills to specify the competencies of your users.
Role required: skill_admin or admin

1. Navigate to Skills > Skills.
2. Click New.
3. Enter a unique, descriptive Name.
4. Enter a **Description** of the skill.
5. Right-click the form header and click **Save**.
The Contains Skills, Users, and Models related lists appear.
6. Optional: Use the Contains Skills related list to add subskills.
7. Optional: Use the Models related list to add any models that are associated with the skill.
The Users related list contains users (based on their User record or the groups they belong to) who have the skill and subskills named in this record. You can also add users to specify they have the skill.

**Assign a user skill**

You can assign skills individually to users. If you assign a skill that contains other skills to a user, the user automatically inherits the contained skills.

Role required: skill_admin or admin

1. Navigate to **Skills > Users**.
2. Select a user from the list.
3. In the User record, select the **Skills** related list.
4. Click **Edit** and select one or more existing skills from the slushbucket.
5. Click **Save**.

**Assign a group skill**

You can assign skills to groups, and the members of the group inherit all the assigned skills. If you assign a skill that contains other skills to a group, the group and all its members automatically inherit the contained skills.

Role required: skill_admin or admin

1. Navigate to **Skills > Groups**.
2. Select a group from the list.
3. In the Group record, select the **Skills** related list.
4. Click **Edit** and select one or more existing skills from the slushbucket.
5. Click **Save**.
The skill is added to the group and all the group members who are granted this skill are listed at the top of the form.

**Filter potential assignees based on skills**

In the base system, field service management tasks and project tasks use skills to filter assignments. If a skill is identified in the **Skill** field, only groups or users with the appropriate skill can be assigned to the task.

The Skills Management feature contains a script include that builds a qualifier based on the assignment group and required skills for the task. For example, the **Assigned To** field on the Project Task record uses the following reference qualifier (using a dictionary override):

```javascript
javascript:var util = new SkillsUtils(); util.assignedToRefQual(current);
```

This script has the following results.

- If an **Assignment group** is set, the list is filtered on members of that group.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If Skills are set (the Skills field may need to be added to the form), the list is filtered on users with all the selected skills.

If Assignment group and Skills are both set, the list is filtered on group members with the defined skills.

You can introduce the same behavior to other task tables by using the same reference qualifier.

Activate skills management

The Skills Management plugin is automatically activated by the Field Service Management and Project Management plugins. Administrators can also activate the Skills Management plugin manually.

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
   If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.
5. Click Activate.

Roles

Roles control access to features and capabilities in applications and modules. The admin role provides access to all features and capabilities.

After access has been granted to a role, all the groups or users assigned to the role are granted the access. Roles can contain other roles, and any access granted to a role is granted to any role that contains it.

For a complete list of the roles included with the ServiceNow platform, see Base system roles.

Create a role

Create a role to control access to features and capabilities in applications and modules. The new role does not have access to any application or module until you add other roles to it or add the new role to the appropriate applications and modules.

Role required: admin

Once access has been granted to a role, all of the groups or users assigned to the role are granted the access. Roles can contain other roles, and any access granted to a role is granted to any role that contains it.
For a complete list of the roles included with the base instance, see Base System Roles.

1. Navigate to User Administration > Roles and create a new record.
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the role.</td>
</tr>
<tr>
<td>Application</td>
<td>Select the application that contains this record.</td>
</tr>
<tr>
<td>Elevated privilege</td>
<td>A role that requires elevated privilege prevents the system from assigning it to a user at login. Instead, a user must manually elevate privileges to receive the elevated role. Select this option to mark this role as required to elevate to high security. See Elevated privilege roles for more information.</td>
</tr>
<tr>
<td>Description</td>
<td>Select the roles to delegate to the group member.</td>
</tr>
</tbody>
</table>

Grant a role access to applications and modules

Roles control access to features and capabilities in applications and modules. You add a role to an application or module to enable the role to grant access to the application or module for all users with the role.

Role required: admin

1. Navigate to System Definition > Applications or System Definition > Modules.
2. Click the appropriate application or module to open it in form view.
3. Click the lock to open the Roles field.
4. Use the slushbucket to add the desired roles to the application or module.
5. Click the lock to close the Roles field, and then save your changes.

Create a group role

Create a group role to control access to features and capabilities in applications for all members in a group.

Role required: admin

1. Navigate to User Administration > Group Roles.
2. Click New.
3. Fill in the fields on the form and then click Submit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Select a group.</td>
</tr>
<tr>
<td>Role</td>
<td>Select the role to apply to the group.</td>
</tr>
<tr>
<td>Inherits</td>
<td>Select this option to have all members of the group inherit the role. This option is selected by default.</td>
</tr>
</tbody>
</table>
Add a role to an existing role

When you add a new role to an existing role for a user, the user inherits the access that is granted by the new role.

Role required: admin

1. Navigate to User Administration > Roles and open the existing role.
2. Click Edit in the Contains Roles related list.
3. Use the slushbucket to add one or more roles to the existing role.
4. Click Save.

The users with the existing role inherit the access that is granted by the new role.

Assign a role to a group

You can assign a role to a group to grant access to applications and modules to group members.

Role required: user_admin or admin

When you assign roles to groups rather than to individual users, members of the group inherit the role. When a user switches groups, the new group role is assigned automatically.

1. Navigate to User Administration > Groups.
2. Click the group to assign a role.
3. In the Roles related list, click Edit.
4. Use the slushbucket to add the desired roles to the group.
5. Click Save.

Assign a role to a user

A user inherits roles from all groups to which the user belongs. You can also assign roles directly to a user. Whenever a user is assigned a new role, it only takes affect after logging in with a new session.

Role required: user_admin or admin

You cannot delete roles that are assigned to the group from the user record. You must remove the user from the group record.

1. Navigate to User Administration > Users and then open a user record.
2. In the Roles related list, click Edit.
3. In the Collection list, select the desired roles, and then click Add.
4. Click Save.

Role delegation

Administrators can authorize users to be role delegators to assign roles to users who are in a particular group. Role delegators can assign only the roles that are assigned to them.

Role delegation and record producers

These graphical workflows include the following:

- Grant role_delegator role to user in group
- Delegate roles to group member

These workflows can be customized as desired to add approval steps.

**Group manager change business rule**

The Group Manager Change business rule, which is disabled by default, automatically grants the role_delegator role to a user who is designated manager of a group in the Manager field on the Group form. The role is removed when the user is no longer the manager of the group.

Activate the business rule to take advantage of it.

**View delegated roles**

An administrator can view role designation in user records, the Role Delegators module, or the Role Audit module.

- **User records**
  
  Open a user record by navigating to User Administration > Users and selecting the user. You can see all the roles assigned to that user in the Roles related list.

- **Role Delegators module**
  
  To view existing role delegators and the groups in which they can delegate roles, navigate to User Administration > Role Delegators.

- **Role Audit module**
  
  The Audit Role list view displays all the role changes made in the instance by user and group. To access the Audit Role list, navigate to System Security > Reports > Role Audit.

**Define role delegators and delegate roles**

You can designate role delegators. A role delegator can assign roles to users who are in a particular user group.

Role required: admin to define role delegators, and role_delegator to delegate roles

The roles that delegators can assign to other users include the roles that the delegator inherits from a group and those roles that the administrator assigns to the delegator.

1. Navigate to User Administration > Designate Role Delegator.
2. Select the group that includes the user who you want to be the role delegator.
3. Select the user.
4. Click Submit.
   
   A change request for the role delegator request is created and automatically approved.

5. If you are a role delegator, complete the following steps to delegate a role.
   
   a) Navigate to User Administration > Delegate Roles in Group and fill out the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Select the group in which to delegate a role or roles to a member. Any group can be selected, including groups that the role_delegator does not belong to or groups that the role_delegator does not manage.</td>
</tr>
<tr>
<td>User</td>
<td>Select the group member to delegate a role or roles.</td>
</tr>
<tr>
<td>Roles to delegate</td>
<td>Select the roles to delegate to the group member. The roles available for delegating are only the roles that the role_delegator has.</td>
</tr>
</tbody>
</table>

b) **Click Submit.**

Upon submission, a change request is created for the delegation request. This change request is approved automatically, and the specified roles are granted to the named user in the group selected.

Delegated roles can be removed in the same form by reversing the process. Select the group and user, remove the unwanted roles from the Roles slushbucket, and then resubmit the request.

c) Optional: To remove a delegated role from a user, open the delegation record and remove the unwanted role or roles.

### Prevent a role from being delegated

You can prevent roles from being delegated to users.

Role required: admin

By default, the following roles cannot be delegated.

- admin
- public
- nobody
- role_delegator, a user with the role_delegator role cannot delegate this role to other group members

1. Navigate to User Administration > Roles.
2. Open the role.
3. Configure the form to add the Grantable or Can delegate fields.
4. Clear the check box for one or both of these fields.
5. Click Update.

### Base system roles

Administrators can assign one or more base system user roles to grant access to base system platform features and applications.

The following standard roles are included in the base ServiceNow system with a new instance.
**Note:** The system does not support changing the name of any base system role. Changing the name of a base system role will prevent users and groups from accessing base system resources that depend on these roles.

### Base system roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>The administrator role. This role has special access to all system features, functions, and data because administrators can override ACL rules and pass all role checks. Consider these implications when using admin overrides on ACLs. If you have sensitive information, such as HR records, that you need to protect, you must create a custom admin role for that area and train a person authorized to see those records to act as the administrator. Also note the <strong>Special Administrative Roles</strong>.</td>
</tr>
<tr>
<td>agent_admin</td>
<td>Can manage MID Server-related scripts.</td>
</tr>
<tr>
<td>approval_admin</td>
<td>Can approve or reject approvals.</td>
</tr>
<tr>
<td>approver_user</td>
<td>Can modify requests for approval routed to them. They also have all capabilities of Requesters.</td>
</tr>
<tr>
<td>assignment_rule_admin</td>
<td>Can manage Assignment Rules.</td>
</tr>
<tr>
<td>asset</td>
<td>Can manage hardware and software assets.</td>
</tr>
<tr>
<td>catalog</td>
<td>Has access to service catalog requests.</td>
</tr>
<tr>
<td>catalog_admin</td>
<td>Can manage the Service Catalog application, including catalog categories and items.</td>
</tr>
<tr>
<td>catalog_editor</td>
<td>Can create, modify, and publish items within categories they are assigned to.</td>
</tr>
<tr>
<td>catalog_item_designer</td>
<td>Can view the status of their category requests.</td>
</tr>
<tr>
<td>catalog_manager</td>
<td>Can view and assign catalog editors to their categories. Can also create, modify, and publish items within their categories.</td>
</tr>
<tr>
<td>category_manager</td>
<td>Can create, edit, and delete model categories.</td>
</tr>
<tr>
<td>contract_manager</td>
<td>Can create, edit, and delete contracts through the Contract Management application.</td>
</tr>
<tr>
<td>ecmdb_admin</td>
<td>Can administer the CMDB.</td>
</tr>
<tr>
<td>filter_admin</td>
<td>Can manage filters.</td>
</tr>
<tr>
<td>filter_global</td>
<td>Can create global filters.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>filter_group</td>
<td>Can create filters that belong to groups of which the user is a member.</td>
</tr>
<tr>
<td>gauge_maker</td>
<td>Can create gauges from reports. Starting with Helsinki, reports are no longer made into gauges.</td>
</tr>
<tr>
<td>image_admin</td>
<td>Can manage image files on the Images (db_image) table.</td>
</tr>
<tr>
<td>impersonator</td>
<td>Can impersonate users. Does not allow impersonation of admin users.</td>
</tr>
<tr>
<td>import_admin</td>
<td>Can manage all aspects of import sets and imports.</td>
</tr>
<tr>
<td>import_scheduler</td>
<td>Can schedule imports.</td>
</tr>
<tr>
<td>import_set_loader</td>
<td>Can load import sets.</td>
</tr>
<tr>
<td>import_transformer</td>
<td>Can manage import set transform maps and run transforms.</td>
</tr>
<tr>
<td>inventory_admin</td>
<td>Can create and delete stock information. Only users with the inventory_admin role can edit stock rules, stockrooms, and stockroom types.</td>
</tr>
<tr>
<td>inventory_user</td>
<td>Has access to stock information. Can create and manage transfer orders.</td>
</tr>
<tr>
<td>itil</td>
<td>Can perform standard actions for an ITIL helpdesk technician. Can open, update, close incidents, problems, changes, configuration management items. By default, only users with the itil role can have tasks assigned to them.</td>
</tr>
<tr>
<td>itil_admin</td>
<td>Possesses more privileges than the itil role and is intended for team leads. This role has the ability to delete incidents, problems, changes, and other related entities when both the itil and itil_admin roles are assigned.</td>
</tr>
<tr>
<td>knowledge</td>
<td>Can create, edit, and review knowledge base articles.</td>
</tr>
<tr>
<td>knowledge_admin</td>
<td>Can manage the knowledge base.</td>
</tr>
<tr>
<td>list_updater</td>
<td>Can use Update Entire List and Update Selected menu options on lists.</td>
</tr>
<tr>
<td>maint</td>
<td>Reserved for ServiceNow use.</td>
</tr>
<tr>
<td>mid_server</td>
<td>Role that any MID server user should be granted. This role gives the MID server access to the tables it ordinarily uses.</td>
</tr>
<tr>
<td>model_manager</td>
<td>Can create new CMDB models. Model manager can control the base models and any model extensions that are not software or consumables. Consumable models are controlled by the asset manager role (asset). Software models are control by the software asset manager role (sam).</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>nobody</td>
<td>The nobody role means that no user has access - not even admin or maint. Use the nobody role carefully. The nobody role takes precedence over the admin override option on ACLs, so even admins cannot have access. See <a href="#">Create an ACL rule</a>. Do not assign it to specific users. You can use this role in ACLs that control access to resources, such as UI pages, processors, script includes, and records. <strong>Warning:</strong> Applying the nobody role may be irreversible if applied to some important system functions.</td>
</tr>
<tr>
<td>personalize</td>
<td>Can configure forms, lists, rules, controls, scripts.</td>
</tr>
<tr>
<td>personalize_choices</td>
<td>Can configure choices and predefined responses for non-journal fields designated as choice or suggestion fields.</td>
</tr>
<tr>
<td>personalize_control</td>
<td>Can configure controls on lists, such as filters, links, and buttons.</td>
</tr>
<tr>
<td>personalize_dictionary</td>
<td>Can configure dictionary entries and labels.</td>
</tr>
<tr>
<td>personalize_form</td>
<td>Can configure forms.</td>
</tr>
<tr>
<td>personalize_list</td>
<td>Can configure lists and list calculations.</td>
</tr>
<tr>
<td>personalize_responses</td>
<td>Can configure predefined responses for journal fields designated as suggestion fields.</td>
</tr>
<tr>
<td>personalize_rules</td>
<td>Can configure business rules and scripts. This role contains the following specialized roles for granting selective, administrative access to rules and scripts: business_rule_admin, client_script_admin, ui_policy_admin, ui_action_admin</td>
</tr>
<tr>
<td>personalize_styles</td>
<td>Can configure field styles.</td>
</tr>
<tr>
<td>personalize_ui</td>
<td>Can configure forms and lists.</td>
</tr>
<tr>
<td>public</td>
<td>No login is required to access features or functions with the public role.</td>
</tr>
<tr>
<td>release_admin</td>
<td>Can edit Release history for a release.</td>
</tr>
<tr>
<td>report_admin</td>
<td>Can manage reports.</td>
</tr>
<tr>
<td>report_global</td>
<td>Can create global reports.</td>
</tr>
<tr>
<td>report_group</td>
<td>Can create reports and share reports with groups that the user is a member of. Users with this role can edit reports shared by other users in the group.</td>
</tr>
<tr>
<td>report_publisher</td>
<td>Can make reports available on a public page.</td>
</tr>
<tr>
<td>report_scheduler</td>
<td>Can schedule a report to be emailed.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>script_fix_admin</td>
<td>Can manage fix scripts.</td>
</tr>
<tr>
<td>soap</td>
<td>Can query, create, update, and delete records on all tables, as well as execute scripts.</td>
</tr>
<tr>
<td>soap_create</td>
<td>Can create records on all tables and columns.</td>
</tr>
<tr>
<td>soap_delete</td>
<td>Can delete records on all tables and columns.</td>
</tr>
<tr>
<td>soap_ecc</td>
<td>Can query, create, and update on the ECC Queue table only.</td>
</tr>
<tr>
<td>soap_query</td>
<td>Can query records on all tables and columns.</td>
</tr>
<tr>
<td>soap_query_update</td>
<td>Can query and update records on all tables and columns.</td>
</tr>
<tr>
<td>soap_script</td>
<td>Can execute business rule endpoint function via script.do.</td>
</tr>
<tr>
<td>soap_update</td>
<td>Can update records on all tables and columns.</td>
</tr>
<tr>
<td>survey_admin</td>
<td>Can manage survey masters, questions, and instances. Contains the assessment_admin role.</td>
</tr>
<tr>
<td>survey_reader</td>
<td>Can read survey instances and responses.</td>
</tr>
<tr>
<td>task_editor</td>
<td>Can edit protected task fields.</td>
</tr>
<tr>
<td>template_admin</td>
<td>Can create and modify templates.</td>
</tr>
<tr>
<td>template_editor</td>
<td>Can create templates for personal use, and modify or delete personal templates. Included in the itil role in the base system.</td>
</tr>
<tr>
<td>template_editor_global</td>
<td>Can create templates for global use.</td>
</tr>
<tr>
<td>template_editor_group</td>
<td>Can create templates for groups.</td>
</tr>
<tr>
<td>template_scheduler</td>
<td>Can schedule template-based record creation.</td>
</tr>
<tr>
<td>text_search_admin</td>
<td>Can customize Global Text Search groups and tables.</td>
</tr>
<tr>
<td>timecard_admin</td>
<td>Can approve, modify, and delete the time cards of other users.</td>
</tr>
<tr>
<td>ts_admin</td>
<td>Can administer <a href="#">Zing text indexing and search engine</a>.</td>
</tr>
<tr>
<td>unlimited_createnow</td>
<td>Role for CreateNow unlimited licensed users.</td>
</tr>
<tr>
<td>user</td>
<td>Available for customer use, has no function in the base system.</td>
</tr>
<tr>
<td>user_admin</td>
<td>Can administer users, groups, locations, and companies.</td>
</tr>
<tr>
<td>view_changer</td>
<td>Can switch active views.</td>
</tr>
<tr>
<td>workflow_admin</td>
<td>Can create, edit, publish or delete graphical workflows.</td>
</tr>
<tr>
<td>workflow_creator</td>
<td>Can create new graphical workflows.</td>
</tr>
<tr>
<td>workflow_publisher</td>
<td>Can publish graphical workflows.</td>
</tr>
</tbody>
</table>
Special administrative roles

Certain roles grant specific administrative rights without the full privileges of the admin role. For example, an administrator can grant a user the right to change UI policy but not client scripts.

These roles do not change the behavior of the admin role, which grants full administrative privileges.

**Note:** The system does not support changing the name of any special administrative role. Changing the name of a special administrative role will prevent users and groups from accessing base system resources that depend on these roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>assignment_rule_admin</td>
<td>Allows management of Assignment Rules.</td>
</tr>
<tr>
<td>ui_script_admin</td>
<td>Allows management of UI Scripts.</td>
</tr>
<tr>
<td>script_include_admin</td>
<td>Can manage Script Includes.</td>
</tr>
<tr>
<td>ui_page_admin</td>
<td>Can manage UI Pages.</td>
</tr>
<tr>
<td>ui_macro_admin</td>
<td>Can manage UI Macros.</td>
</tr>
<tr>
<td>form_admin</td>
<td>Can manage Forms, and Form Sections and Section Elements.</td>
</tr>
<tr>
<td>business_rule_admin</td>
<td>Can manage Business Rules.</td>
</tr>
<tr>
<td>client_script_admin</td>
<td>Can manage Client Scripts.</td>
</tr>
<tr>
<td>ui_policy_admin</td>
<td>Can manage UI Policies.</td>
</tr>
<tr>
<td>ui_action_admin</td>
<td>Can Manage UI Actions.</td>
</tr>
</tbody>
</table>

Read-only role

The read-only role (snc_read_only) restricts a user or a group of users to read-only access on the tables to which the user already has access.

This role is not intended to be the only role a user has. It is intended to be an extra role to restrict insert, update, and delete operations on the tables that the user can access as defined by the other roles.

After you assign this role to a user, they can no longer can create, update, or delete records on ANY tables.

**Note:** Assign this role only to users. Do not assign this role to other resources in the system, including applications, ACLs, and so on.

The snc_read_only role can be assigned to any user as a simple way to limit access to data without having to create ACLs for system and custom tables and fields. This practice is useful for performing internal or external audits without allowing a user to have insert or update access to data.

Users with the snc_read_only role have the following restrictions regardless of other roles and privileges they have.

- Cannot insert, update, or delete records from the UI or when using the GlideRecord API.
- Cannot activate or upgrade plugins.
- Cannot directly run SQL.
- Cannot upload XML files.
- Can only run background scripts when on an instance in the public sandbox environment.

**Note:** These role restrictions are in place even if impersonating another user with write access such as an admin.

### Activate the read-only role

If it is not already active, an administrator can activate the Read-Only User Role (com.snc.read_only.role) plugin.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see [Purchase a plugin](#).

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see [Request a plugin](#).

For plugins that you can activate yourself, continue with the following steps.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.
   
   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

**Read-only role properties**

These system properties control the snc_read_only role. The following default values are used for the properties.
### Read-only role properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.security.snc_read_only_role.tables.exempt_create</td>
<td>Specifies which tables are exempt from the read-only role enforcement and allow the creation of new records.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: sys_user_session, sysevent, syslog, syslog_transaction, sys_user_preference, sys_ui_list, sys_ui_list_element, sys_db_cache, user_multifactor_auth</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties (sys_properties) table</td>
</tr>
<tr>
<td>glide.security.snc_read_only_role.tables.exempt_write</td>
<td>Specifies which tables are exempt from the read-only role enforcement and allow the updating of existing records.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: sys_user_session, sysevent, syslog, syslog_transaction, sys_user_preference, sys_ui_list, sys_ui_list_element, sys_db_cache, user_multifactor_auth</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties (sys_properties) table</td>
</tr>
<tr>
<td>glide.security.snc_read_only_role.tables.exempt_delete</td>
<td>Specifies which tables are exempt from the read-only role enforcement and allow the deletion of existing records.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: sys_user_preference, sys_ui_list, sys_ui_list_element, sys_db_cache, user_multifactor_auth</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties (sys_properties) table</td>
</tr>
</tbody>
</table>

### Log on with the read-only role

Users logging in to a production instance should log in using the snc_read_only role to prevent unwanted modifications to the instance data.

1. Click **To log on with different role(s), click here**.
2. Enter **read_only, maint**.
3. Click **Refresh**.
4. Click **read_only, maint** to log in.

### Security jump start - ACL rules

The Security Jump Start (ACL Rules) Plugin is installed automatically on all new instances.

### Note:

- Plugin Required
Functionality described here requires the Security Jump Start (ACL Rules) plugin. The plugin is automatically installed for new instances.

These rules were written to provide a jump start on securing many system tables, to make it easier for an organization to more quickly get into production.

This plugin is not intended for existing instances, as it might modify security access to tables that are already in use in a production environment. If an admin is interested in the new ACL rules provided by this plugin, one or more of them may be created manually in an existing instance as specific needs dictate. This list of ACLs may be used as a guideline in that case. Should an admin strongly want this plugin installed on an existing instance, we highly recommend the plugin be tested extensively in a test instance first, to ensure that the rules do not conflict with the operational needs of the organization’s current implementation.

The following ACLs are included in this plugin. Click the icon in a header row to sort that column in ascending or descending order. The Operation key is as follows:

- **R**=read
- **W**=write
- **D**=delete
- **C**=create

<table>
<thead>
<tr>
<th>Name</th>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmdb_ci</td>
<td>WCD</td>
<td>asset or itil role required to write/create/delete Configuration Item records</td>
</tr>
<tr>
<td>cmn_department</td>
<td>WD</td>
<td>user_admin role required to write/delete Department records</td>
</tr>
<tr>
<td>cmn_location</td>
<td>WC</td>
<td>user_admin role required to write/create Location records</td>
</tr>
<tr>
<td>core_company</td>
<td>WD</td>
<td>user_admin role required to write/delete Company records</td>
</tr>
<tr>
<td>kb_knowledge</td>
<td>create</td>
<td>knowledge role required to created Knowledge records</td>
</tr>
<tr>
<td>ldap_ou_config</td>
<td>RWCD</td>
<td>user_admin role required to read/write/create/delete LDAP OU Definition records</td>
</tr>
<tr>
<td>ldap_server_config</td>
<td>RWCD</td>
<td>user_admin role required to read/write/create/delete LDAP Server records</td>
</tr>
<tr>
<td>process_guide</td>
<td>WCD</td>
<td>admin role required to write/create/delete Process Guide records</td>
</tr>
<tr>
<td>process_step</td>
<td>WCD</td>
<td>admin role required to write/create/delete Process Step records</td>
</tr>
<tr>
<td>sc_category</td>
<td>create</td>
<td>catalog_admin role required to create Service Catalog Category records</td>
</tr>
<tr>
<td>Name</td>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>sc_category</td>
<td>delete</td>
<td>catalog_admin role required to delete Service Catalog Category records</td>
</tr>
<tr>
<td>sc_category</td>
<td>write</td>
<td>catalog_admin role required to write to Service Catalog Category records</td>
</tr>
<tr>
<td>sc_cat_item</td>
<td>write</td>
<td>catalog_admin role required to write to Catalog Item records</td>
</tr>
<tr>
<td>sc_cat_item</td>
<td>delete</td>
<td>catalog_admin role required to delete Catalog Item records</td>
</tr>
<tr>
<td>sc_cat_item</td>
<td>create</td>
<td>catalog_admin role required to create Catalog Item records</td>
</tr>
<tr>
<td>sysevent_email_action</td>
<td>read</td>
<td>all users can read Email Notification records (for subscription purposes)</td>
</tr>
<tr>
<td>sysevent_register</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Event Registry records</td>
</tr>
<tr>
<td>sysevent_script_action</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Script Action records</td>
</tr>
<tr>
<td>syslog</td>
<td>RWCD</td>
<td>admin required to read/write/create/delete Log Entry records</td>
</tr>
<tr>
<td>sysrule</td>
<td>RWCD</td>
<td>admin required to read/write/create/delete Rule records (Email Notifications, Inbound Email Actions, Approval Rules, etc.)</td>
</tr>
<tr>
<td>sysrule</td>
<td>read</td>
<td>all users can read Email Notification records for (subscription based notifications)</td>
</tr>
<tr>
<td>sys_app_application</td>
<td>WCD</td>
<td>admin required to write/create/delete Application records</td>
</tr>
<tr>
<td>sys_app_category</td>
<td>WCD</td>
<td>admin role required to write/create/delete Application Category records</td>
</tr>
<tr>
<td>sys_app_module</td>
<td>WCD</td>
<td>admin required to write/create/delete Module records</td>
</tr>
<tr>
<td>sys_audit</td>
<td>RWCD</td>
<td>admin required to read/write/create/delete Audit records</td>
</tr>
<tr>
<td>sys_dictionary</td>
<td>RWC</td>
<td>personalize_dictionary role required to read/write/create Dictionary records</td>
</tr>
<tr>
<td>sys_dictionary.*</td>
<td>read</td>
<td>personalize_dictionary role can read Dictionary fields</td>
</tr>
<tr>
<td>sys_documentation</td>
<td>delete</td>
<td>personalize_dictionary role required to delete Field Label records</td>
</tr>
<tr>
<td>Name</td>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sys_documentation</td>
<td>create</td>
<td>personalize_dictionary role required to create Field Label records</td>
</tr>
<tr>
<td>sys_documentation</td>
<td>write</td>
<td>personalize_dictionary role required to write to Field Label records</td>
</tr>
<tr>
<td>sys_gauge</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Gauge records</td>
</tr>
<tr>
<td>sys_gauge_count</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Gauge Count records</td>
</tr>
<tr>
<td>sys_group_has_role</td>
<td>read</td>
<td>itil role required to see Group Role records</td>
</tr>
<tr>
<td>sys_home</td>
<td>WCD</td>
<td>itil_admin role required to write/create/delete Welcome Page Section records</td>
</tr>
<tr>
<td>sys_installation_exit</td>
<td>WCD</td>
<td>admin role required to write/create/delete Installation Exit records</td>
</tr>
<tr>
<td>sys_job</td>
<td>WCD</td>
<td>admin role required to write/create/delete Sys Job records</td>
</tr>
<tr>
<td>sys_nav_link</td>
<td>WCD</td>
<td>admin role required to write/create/delete Navigation Link records</td>
</tr>
<tr>
<td>sys_perspective</td>
<td>WCD</td>
<td>admin role required to write/create/delete Menu List records</td>
</tr>
<tr>
<td>sys_portal</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Portal records</td>
</tr>
<tr>
<td>sys_portal_page</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Homepage records</td>
</tr>
<tr>
<td>sys_portal_preferences</td>
<td>RWCD</td>
<td>admin role required to read/write/create/delete Portal Preferences records</td>
</tr>
<tr>
<td>sys_processor</td>
<td>WC</td>
<td>admin role required to write/create Processor records</td>
</tr>
<tr>
<td>sys_properties</td>
<td>WC</td>
<td>admin role required to write/create System Property records</td>
</tr>
<tr>
<td>sys_properties_category</td>
<td>WCD</td>
<td>admin role required to write/create/delete Property Category records</td>
</tr>
<tr>
<td>sys_report</td>
<td>delete</td>
<td>roles that can delete Report records (does not restrict deleting through Report UI)</td>
</tr>
<tr>
<td>sys_report</td>
<td>write</td>
<td>roles that can write to Report records (does not restrict editing through Report UI)</td>
</tr>
<tr>
<td>Name</td>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sys_report</td>
<td>read</td>
<td>users can read their own Report records, those of their groups, and GLOBAL ones (does not affect viewing through Report UI)</td>
</tr>
<tr>
<td>sys_report</td>
<td>read</td>
<td>roles that can read Report records (does not restrict viewing through Report UI)</td>
</tr>
<tr>
<td>sys_reportroles</td>
<td>read</td>
<td>admin role required to read Report Roles records</td>
</tr>
<tr>
<td>sys_script</td>
<td>WCD</td>
<td>admin role required to write/create/delete Business Rule records</td>
</tr>
<tr>
<td>sys_script_ajax</td>
<td>WCD</td>
<td>admin role required to write/create/delete AJAX Script records</td>
</tr>
<tr>
<td>sys_script_client</td>
<td>WCD</td>
<td>admin role required to write/create/delete Client Script records</td>
</tr>
<tr>
<td>sys_script_include</td>
<td>WCD</td>
<td>admin role required to write/create/delete Script Include records</td>
</tr>
<tr>
<td>sys_security_acl</td>
<td>write</td>
<td>admin role required to write to Access Control records</td>
</tr>
<tr>
<td>sys_security_acl_role</td>
<td>create</td>
<td>admin role required to create Access Roles records</td>
</tr>
<tr>
<td>sys_security_acl_role</td>
<td>delete</td>
<td>admin role required to delete Access Roles records</td>
</tr>
<tr>
<td>sys_security_operation</td>
<td>write</td>
<td>admin role required to write to Access Roles records</td>
</tr>
<tr>
<td>sys_security_operation</td>
<td>delete</td>
<td>admin role required to delete Security Operation records</td>
</tr>
<tr>
<td>sys_security_operation</td>
<td>create</td>
<td>admin role required to create Security Operation records</td>
</tr>
<tr>
<td>sys_security_operation</td>
<td>write</td>
<td>admin role required to write to Security Operation records</td>
</tr>
<tr>
<td>sys_security_type</td>
<td>write</td>
<td>admin role required to write to Security Type records</td>
</tr>
<tr>
<td>sys_security_type</td>
<td>create</td>
<td>admin role required to create Security Type records</td>
</tr>
<tr>
<td>sys_security_type</td>
<td>delete</td>
<td>admin role required to delete Security Type records</td>
</tr>
<tr>
<td>sys_status</td>
<td>create</td>
<td>admin role required to create System Status records</td>
</tr>
<tr>
<td>sys_status</td>
<td>delete</td>
<td>admin role required to delete System Status records</td>
</tr>
<tr>
<td>sys_status</td>
<td>write</td>
<td>admin role required to write to System Status records</td>
</tr>
<tr>
<td>Name</td>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>sys_template</td>
<td>write</td>
<td>template_editor role required to write to Template records</td>
</tr>
<tr>
<td>sys_template</td>
<td>create</td>
<td>template_editor role required to create Template records</td>
</tr>
<tr>
<td>sys_template</td>
<td>delete</td>
<td>template_editor role required to delete Template records</td>
</tr>
<tr>
<td>sys_template</td>
<td>read</td>
<td>template_editor role required to read Template Roles records</td>
</tr>
<tr>
<td>sys_ui_action</td>
<td>create</td>
<td>admin role required to create UI Action records</td>
</tr>
<tr>
<td>sys_ui_action</td>
<td>delete</td>
<td>admin role required to delete UI Action records</td>
</tr>
<tr>
<td>sys_ui_action</td>
<td>write</td>
<td>admin role required to write to UI Action records</td>
</tr>
<tr>
<td>sys_ui_action_view</td>
<td>write</td>
<td>admin role required to write to UI View Action records</td>
</tr>
<tr>
<td>sys_ui_action_view</td>
<td>create</td>
<td>admin role required to create UI View Action records</td>
</tr>
<tr>
<td>sys_ui_action_view</td>
<td>delete</td>
<td>admin role required to delete UI View Action records</td>
</tr>
<tr>
<td>sys_ui_policy</td>
<td>create</td>
<td>admin role required to create UI Policy records</td>
</tr>
<tr>
<td>sys_ui_policy</td>
<td>delete</td>
<td>admin role required to delete UI Policy records</td>
</tr>
<tr>
<td>sys_ui_policy</td>
<td>write</td>
<td>admin role required to write to UI Policy records</td>
</tr>
<tr>
<td>sys_ui_policy_action</td>
<td>create</td>
<td>admin role required to create UI Policy Action records</td>
</tr>
<tr>
<td>sys_ui_policy_action</td>
<td>delete</td>
<td>admin role required to delete UI Policy Action records</td>
</tr>
<tr>
<td>sys_ui_policy_action</td>
<td>write</td>
<td>admin role required to write to UI Policy Action records</td>
</tr>
<tr>
<td>sys_ui_script</td>
<td>write</td>
<td>admin role required to write to UI Script records</td>
</tr>
<tr>
<td>sys_ui_script</td>
<td>delete</td>
<td>admin role required to delete UI Script records</td>
</tr>
<tr>
<td>sys_ui_script</td>
<td>create</td>
<td>admin role required to create UI Script records</td>
</tr>
<tr>
<td>sys_user</td>
<td>write</td>
<td>Users with no role cannot update any user record but their own</td>
</tr>
<tr>
<td>sys_user_grmember</td>
<td>delete</td>
<td>user_admin role required to delete Group Member records</td>
</tr>
<tr>
<td>sys_user_grmember</td>
<td>write</td>
<td>user_admin role required to write to Group Member records</td>
</tr>
<tr>
<td>Name</td>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>sys_user_group</td>
<td>create</td>
<td>Only ITIL and above can create group records</td>
</tr>
<tr>
<td>sys_user_group</td>
<td>write</td>
<td>Only ITIL and above can write to group records</td>
</tr>
<tr>
<td>sys_user_has_role</td>
<td>read</td>
<td>ITIL role required to see User Role records</td>
</tr>
<tr>
<td>sys_user_role</td>
<td>create</td>
<td>Admin role required to create Role records</td>
</tr>
<tr>
<td>sys_user_role</td>
<td>delete</td>
<td>Admin role required to delete Role records</td>
</tr>
<tr>
<td>sys_user_role</td>
<td>write</td>
<td>Admin role required to write to Role records</td>
</tr>
<tr>
<td>sys_user_role_contains</td>
<td>read</td>
<td>ITIL role required to see Contained Role records</td>
</tr>
<tr>
<td>sys_user_role_contains</td>
<td>write</td>
<td>Admin role required to write to Contained Role records</td>
</tr>
<tr>
<td>sys_user_token</td>
<td>RWCD</td>
<td>Admin role required to read/write/create/delete User Token records</td>
</tr>
</tbody>
</table>

**Audit user roles**

Changes to user roles are automatically tracked in the Audit Roles (sys_audit_role) table.

**Role required:** admin

**Note:** If the Contextual Security: Role Management V2 plugin is installed, you must enable role auditing.

Navigate to the Audit Roles (sys_audit_role) table.
The Audit Roles table displays changes to user roles.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed by</td>
<td>The user who made the change.</td>
</tr>
<tr>
<td>Count after change</td>
<td>Direct role added as a result of the change (if any), plus the number of inherited roles added.</td>
</tr>
<tr>
<td>Granted by group</td>
<td>If the role was inherited, the group that the role was inherited from.</td>
</tr>
<tr>
<td>Operation</td>
<td>The type of change. Values include:</td>
</tr>
<tr>
<td></td>
<td>· Added</td>
</tr>
<tr>
<td></td>
<td>· Removed</td>
</tr>
<tr>
<td>Role</td>
<td>The affected role.</td>
</tr>
<tr>
<td>User</td>
<td>The affected user.</td>
</tr>
</tbody>
</table>
Non-interactive sessions

The Non-Interactive Sessions plugin creates a distinction between interactive and non-interactive users.

Interactive users

New users added to the instance automatically become interactive users. Interactive users can perform the following actions:

- Use their user name and password to log in to the UI or a service portal.
- Connect to an instance from a URL that calls a UI page, form, or list, for example, https://<instance name>.service-now.com/incident.do.
- Connect with single sign-on, for example, digest authentication or SAML.
- Use their credentials to authorize SOAP connections if allowed by strict security.
- Use their credentials for other API connections such as WSDL, JSON, XML, or XSD without restriction.

Non-interactive users

Non-interactive users can only use their credentials to authorize API connections such as JSON, SOAP, and WSDL. They cannot log in to the ServiceNow UI. The strict security high security setting determines if non-interactive users are subject to Contextual Security requirements.

Distinguishing between interactive and non-interactive users increases instance security by ensuring that users conform to the principle of least privilege.

Installed with Non-Interactive Sessions

Note: Non-Interactive Sessions is enabled for all new instances since the Calgary release. If you do not see it in the list of plugins, request it using the Activate Plugin service catalog item in HI.

- Adds a column Web Service Access Only (web_service_access_only) to the User (sys_user) table.
- Changes all existing users to be interactive users (web_service_access_only=false).
- Updates the User form to display the Web Service Access Only (web_service_access_only) field by default.

Create a non-interactive user for web services

Non-interactive users can only connect to a ServiceNow instance from an API protocol. Use this feature to set up user accounts for web service authentication purposes.

Role required: user_admin or admin

Non-interactive users cannot log in to an instance or a service portal, connect through single-sign-on, or be used as a MID Server user.

1. Navigate to User Administration > Users.
2. Search for the user to be updated.
   For example, SOAP user.
3. Select the Web Service Access Only check box.
4. Click Update.
Note:
ServiceNow always uses any user name and password credentials supplied with a request even if the High Security Settings do not require authorization for a given API protocol. For example, if a SOAP request supplies a user name and password, the instance verifies those credentials even if SOAP requests do not require authorization. To avoid verifying user credentials, the request must not include them.

Make a non-interactive user record interactive
Interactive users have the following access rights.
Role required: user_admin or admin
1. Navigate to User Administration > Users.
2. Search for the user you want to update. For example, System Administrator.
3. Clear the Web Service Access Only check box.
4. Click Update.

Update web service user accounts for strict security
If your instance requires strict security, add the soap role to any user accounts used for web services.
Role required: user_admin or admin
1. Navigate to User Administration > Users.
2. Select a web service user from the list.
3. From the Roles related list, click Edit.
4. Add soap to the Roles List.
5. Click Save.
6. Click Update.

Require authentication
You can specify whether non-interactive sessions require authentication from the High Security Settings module.
Role required: admin with elevated privileges
A non-interactive session bypasses the UI to connect to the instance at an API level. Typically, non-interactive sessions use set protocols such as JSON, SOAP, XSD, or WSDL. By default, all non-interactive sessions require authentication.
1. Log in with an administrator user with the security_admin role.
2. Elevate your privileges to use security_admin.
4. Select the matching "Requires authorization" option for the protocol you want to set. For example, Requires authorization for incoming SOAP requests.
5. Select the check box to require authentication for the non-interactive session method. Clear the check box to allow the non-interactive session method to connect without providing any credentials.
**Note:** Activating the Non-Interactive Sessions plugin on an existing system may prevent any existing users that authorize SOAP and WSDL-based integrations from logging in unless they already have the soap role.

## Instance Usage

The Instance Usage modules track usage for ServiceNow applications and for ServiceNow Store apps.

The usage analytics process collects data on all your instances and regularly updates the reports in the Application Usage Overview and ServiceNow Store Usage Overview modules. Application usage data is collected whenever an application is opened, and counts on tables are collected once a day. Data is collected on:

- The number of active users in the system
- The hardware CIs discovered (for instances that use Discovery)
- The number of cloud management service catalog items available to users in instances that use Cloud Management

All users with the admin role can view Application Usage Overview and ServiceNow Store Usage Overview reports.

### Application Usage Overview reports

The Application Usage Overview modules display reports on usage of ServiceNow applications and ServiceNow Store apps for your instance.

See the illustration for tips on using the charts. Navigate to Instance Usage > Application Usage Overview and Instance Usage > ServiceNow Store Usage Overview to view the following reports and charts:

<table>
<thead>
<tr>
<th>Chart or report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Usage of ServiceNow Applications</strong> and <strong>Usage of ServiceNow Store Applications</strong></td>
<td>Shows the number of accesses (views or operations performed) for each of the listed applications, grouped by month.</td>
</tr>
<tr>
<td><strong>Users of ServiceNow Applications</strong> and <strong>Users of ServiceNow Store Applications</strong></td>
<td>Shows the number of active users who have used the instance, grouped by month. An active user is any user who could have accessed the applications, not only users who actually did access the applications.</td>
</tr>
<tr>
<td>Chart or report</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional Metrics</td>
<td>Shows any of the following items, depending on your licensing agreement:</td>
</tr>
<tr>
<td></td>
<td>• Configuration automation nodes (This is Legacy functionality.)</td>
</tr>
<tr>
<td></td>
<td>• Custom Orchestration workflow activities</td>
</tr>
<tr>
<td></td>
<td>• Hardware CIs found by Discovery</td>
</tr>
<tr>
<td></td>
<td>• Public catalogs your organization is using</td>
</tr>
<tr>
<td></td>
<td>• Password credentials that the Password Reset application is managing</td>
</tr>
<tr>
<td></td>
<td>• Performance Analytics indicators</td>
</tr>
<tr>
<td>Other Metrics (ServiceNow applications only)</td>
<td>Shows the number of items that extend a table other than the Task base table or a custom table.</td>
</tr>
</tbody>
</table>
Click to add content like gauges, labels, or clocks to the chart.

Refresh, Configure, or Close the chart.

Save the chart as an image.

Point to a data point to view details.

Click a data point to view the underlying data.

Click to view data for applications during the specified month.

Working with charts on the Application Usage Overview report
Authentication

ServiceNow authentication validates the identity of a user who accesses an instance, and then authorizes the user to features that match the user’s role or job function.

Available authentication methods

You can use several different methods to authenticate users. User credentials are matched to different saved credentials for each method.

<table>
<thead>
<tr>
<th>Authentication methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local database</td>
<td>The username and password in their user record in the instance database.</td>
</tr>
<tr>
<td>External Single Sign-on (SSO)</td>
<td>The username and password configured in identity providers, which have a matching user account in the database.</td>
</tr>
<tr>
<td>LDAP</td>
<td>The username and password in their LDAP account, which has a matching user account in the database.</td>
</tr>
<tr>
<td>OAuth 2.0</td>
<td>The username and password of OAuth identity provider, which has a matching user account in the database.</td>
</tr>
<tr>
<td>Digest Token</td>
<td>An encrypted digest of the username and password in the user record.</td>
</tr>
<tr>
<td>Multifactor</td>
<td>The username and password in the database and a passcode sent to the user’s mobile device that has Google Authenticator installed.</td>
</tr>
</tbody>
</table>

**Note:** You can use SAML and Digest Authentication through the Multiple Provider SSO application.

External single sign-on (SSO)

External SSO allows organizations to use several SSO identity providers (IdPs) to manage authentication as well as retain local database (basic) authentication.

The integration supports any combination of local and external authentication methods on a single instance:

- LDAP
- SAML 2.0
- Digest Authentication
- Local database authentication

For example, a globally dispersed corporation might require one SSO provider for their employees, a different one for their vendors, and local database authentication for their administrators. Alternatively, a company might implement SAML 2.0 and a digest token authentication solutions on the same instance.
Multi-Provider SSO properties, tables, and scripts

The Integration - Multiple Provider Single Sign-On Installer plugin includes the following system properties, tables, and scripts.

Properties

Multi-Provider SSO adds the following system properties.

Multi-Provider SSO properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.authenticate.multisso.debug</td>
<td>Enables (true) or disables (false) debug logging for the multi-provider SSO integration.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>glide.authenticate.multisso.enabled</td>
<td>Enables (true) or disables (false) multi-provider SSO.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>

Tables

Multi-Provider SSO adds the following tables.

Multi-Provider SSO tables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSO Properties [sso_properties]</td>
<td>Stores data for each IdP, schema, common SSO data, and so on.</td>
</tr>
<tr>
<td>SAML 2 Update 1 Properties [saml2_update1_properties]</td>
<td>Stores data for SAML 2.0 Update 1 configurations such as SAML certificates.</td>
</tr>
<tr>
<td>Digest Properties [digest_properties]</td>
<td>Stores data for digest token authentication configurations.</td>
</tr>
<tr>
<td>SSO Federation [sso_federation]</td>
<td>Stores data for each SSO federation.</td>
</tr>
</tbody>
</table>

Scripts

Multi-Provider SSO adds the following scripts.

Multi-Provider SSO scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MultiSSO</td>
<td>Allows a customer to have an SSO type defined on a company basis.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MultiSSOLogin</td>
<td>Allows each domain to have their own login script.</td>
</tr>
<tr>
<td>MultiSSOLogout</td>
<td>Allows each domain to have their own logout script.</td>
</tr>
<tr>
<td>MultiSSO_Abstract_Core</td>
<td>Provides a base class for all multi-provider SSO classes.</td>
</tr>
<tr>
<td>MultiSSO_ClientHelper</td>
<td>Provides a client callable utility functions for multi-provider SSO.</td>
</tr>
<tr>
<td>MultiSSO_DigestedToken</td>
<td>Provides a base system logic for digested token authentication.</td>
</tr>
<tr>
<td>MultiSSO_SAML2_Update1</td>
<td>Provides logic to process SAML 2.0 Update 1 authentication for a multi-tenant single sign-on.</td>
</tr>
</tbody>
</table>

**Activate Multi-Provider SSO plugin**

This integration requires the Integration - Multiple Provider Single Sign-On Installer (com.snc.integration.sso.multi.installer) plugin.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that are not functional because other plugins are inactive, those plugins are listed. A warning states that some files are not installed. If you want the optional features to be installed, cancel this activation, activate the necessary plugins, and then return to activating the plugin.
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

**Set up Multi-Provider SSO**

You must perform several steps to set up Multi-Provider SSO, including configuring properties, creating identity providers (IdPs), and configuring users to use SSO.

**Multi-SSO (SAML) IdP authentication flow**

Describes the different entities that can authenticate a user through the SAML multi-SSO.

You can follow the authentication flow to understand when an entity authenticates a user using Multi-SSO.
Multi-SSO (SAML) IdP authentication flow

Access SNC Instance → Multi-SSO enabled? → No → Local DB

Yes → SAML SSO Cookie exist?

Yes → IdP used to create cookie

No → Auto-redirect IdP?

Yes → Auto-redirect IdP

No → Federated IdP

Federation:xxx

Is IdP sso:xxx or federation:xxx → IdP specified on SSO source?

Yes → Does user exist?

Yes → Auto-provisioning IdP

No → Default IdP

No → Active default IdP?

Yes → Auto-provisioning IdP

No → Redirect fails. Contact your administrator.
If Multi-SSO is not enabled, authentication directs to a local DB.

**SAML SSO Cookie IdP**

If a SAML SSO cookie exists, the IdP which is specified with this cookie authenticates the user.

**Auto-redirect IdP**

If the auto-redirect IdP is enabled, this IdP authenticates the user.

**Federated IdP**

If the user browser is redirected to the external authorization (login_locate_sso.do) login screen, and the user exists in the user table with the IdP set in the **SSO Source** field as federation: xxx, then the federated IdP authenticates the user.

**Associated IdP**

If the user browser is redirected to the external authorization (login_locate_sso.do) login screen, and the user exists in the user table with the IdP set in the **SSO Source** field as sso: xxx, then the associated IdP authenticates the user.

**Auto-provisioning IdP**

If the user browser is redirected to the external authorization (login_locate_sso.do) login screen, and the user does not exist in the user table, but auto-provisioning is enabled, then the auto-provisioning IdP authenticates the user.

**Default IdP**

If the user browser is redirected to the external authorization (login_locate_sso.do) login screen, and the user either:

- Does not exist in the user table, auto-provisioning is not enabled, and there is an active default IdP
- Exists in the user table, an IdP is not specified on the SSO source user or company record, and there is an active default IdP

then the default IdP authenticates the user.

**Configure Multi-Provider SSO properties**

Configure SSO properties and also add a property to the System Properties table to configure an IdP white list.

Role required: admin

1. Navigate to **Multi-Provider SSO > Properties**.
2. Select the **Enable Multi-Provider SSO** check box. This selection adds the link Use external login to the login page.
3. To **update the user table** with the users in the IdP, select the **Enable Auto Importing** option.
4. To enable the debug messages to appear at the bottom of the content frame, select the **Enable debug logging for the Multi-Provider SSO integration** check box.
   If enabled, the debug logging feature slows down performance and uses up disk space to generate logs.
5. In the property **The field on the user table that identifies a user accessing the User identification login page**, enter the field on the User table that contains the value the IdP uses to identify the user. The default value is **user_name**.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Multiple Provider SSO Properties

Please edit your changes and press Save.

Customization Properties for Multiple Provider SSO

Enable multiple provider SSO

☐ Yes | No

Enable Auto Importing of users from all identity providers into the user table

☐ Yes | No

Enable debug logging for the multiple provider SSO integration

☐ Yes | No

The field on the user table that identifies a user accessing the "User Identification" login page. By default, it uses the 'user_name' field.

user_name

Save

Multiple Provider SSO properties

6. Click Save.

7. Instruct your users to click the Use external login link when they log in to the instance.

Create a SAML 2.0 configuration using Multi-Provider SSO

You can create or update a SAML 2.0 SSO configuration from the Multi-Provider SSO feature.

Role required: admin

Note: New to the Jakarta release, you must validate your configuration by using the Test Connection functionality before you can activate your IdP configuration. You can still use the Update functionality to save your configuration data, but it is not an active configuration without a successful test connection.

1. Navigate to Multi-Provider SSO > Identity Providers.

2. Do one of the following options:
   - To update a configuration, click an SSO configuration record.
   - To create a new configuration, click New > SAML.

3. For a new configuration, enter the IdP information by one of the following methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a metadata descriptor URL</td>
<td>Click the URL check box and enter the URL of the IdP that you are using.</td>
</tr>
<tr>
<td>Using metadata descriptor XML file</td>
<td>Click the XML check box and paste in the XML data generated from the IdP you are using.</td>
</tr>
<tr>
<td>Entering metadata manually</td>
<td>Close the popup window and manually enter the data in the property fields.</td>
</tr>
</tbody>
</table>
All required fields must be filled-in on the **Identity Provider** form.

### Multi-provider single sign-on fields

<table>
<thead>
<tr>
<th>Property</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Yes</td>
<td>Enter the name for the SSO property record.</td>
</tr>
<tr>
<td>Active</td>
<td>Yes</td>
<td>Active should be set to true for the IdP to be used for authentication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The option to set this property only comes after a successful test connection.</td>
</tr>
<tr>
<td>Default</td>
<td>No</td>
<td>The Auto Redirect IdP, formerly known as the Primary IdP, automatically redirects users to access the base instance URL. This property sets this IdP configuration as the default.</td>
</tr>
<tr>
<td>Auto Redirect IdP</td>
<td>No</td>
<td>Sets this IdP configuration as the Auto Redirect IdP.</td>
</tr>
<tr>
<td>Identity Provider URL</td>
<td>Yes</td>
<td>Enter the URL to your IdP. Each IdP URL must be unique.</td>
</tr>
<tr>
<td>Identity Provider’s AuthnRequest</td>
<td>Yes</td>
<td>Enter the URL to the HTTP-Redirect binding obtained from the SingleSignOnService element. Add the value to the <code>glide.security.url.whitelist</code> property.</td>
</tr>
<tr>
<td>Identity Provider’s SingleLogoutRequest</td>
<td>No</td>
<td>Enter the URL obtained from the SingleLogoutService element.</td>
</tr>
<tr>
<td>ServiceNow Homepage</td>
<td>Yes</td>
<td>Enter the URL, including login page, of the instance for which the IdP authenticates. For example: <a href="https://yourinstance.service-now.com/navpage.do">https://yourinstance.service-now.com/navpage.do</a></td>
</tr>
</tbody>
</table>
### Property | Required | Description
--- | --- | ---
Entity ID/Issuer | Yes | Enter the base URL, excluding login page, of the instance for which the IdP authenticates. For example: `<nowiki>https://yourinstance.servicenow.com/</nowiki>`

### Audience URI | Yes | Enter the base URL, excluding login page, of the instance for which the IdP authenticates. For example: `<nowiki>https://yourinstance.servicenow.com/</nowiki>`

### NameID Policy | Yes | Enter the value of the NameIDFormat element the integration uses.

### External logout redirect | No | Enter the URL where the integration redirects users after they log out.

### Failed Requirement Redirect | No | Enter the URL for redirecting failed authentication requests. Typically, the URL endpoint is an error page or logout page.

---

4. Optional: Encryption And Signing tab

![Encryption And Signing](image)

**Encryption And Signing fields**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signing/Encryption Key Alias</td>
<td>Enter the alias of the key entry stored in <a href="#">SAML 2.0 SP Keystore</a>.</td>
</tr>
<tr>
<td>Signing Key Password</td>
<td>Enter the password of the key entry stored in <a href="#">SAML 2.0 SP Keystore</a>.</td>
</tr>
</tbody>
</table>
5. Optional: User Provisioning tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt Assertion</td>
<td>Select the check box to encrypt the assertion in the SAML response. The metadata generated for the IDP embeds the x509 certificate, which the IDP uses to encrypt the assertion in the SAML response that it generates.</td>
</tr>
<tr>
<td>Signing Signature Algorithm</td>
<td>Enter the URL that points to the SAML 2.0 Identity Provider AuthnRequest Consumer for eSignature Authentication.</td>
</tr>
<tr>
<td>Sign AuthnRequest</td>
<td>Select the check box to enable the IdP’s single-sign on service to receive a signed AuthnRequest.</td>
</tr>
<tr>
<td>Sign LogoutRequest</td>
<td>Select the check box to enable the IdP’s single-sign on service to receive a signed LogoutRequest.</td>
</tr>
</tbody>
</table>

6. Optional: Advanced tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Provisioning User</td>
<td>Enable automatic user provisioning, which creates a user in the instance User table when the user exists on the IdP but does not exist in the User table.</td>
</tr>
<tr>
<td>Update User Record Upon Each Login</td>
<td>Updates user information in the instance User table with the information in the IdP each time the user logs in using SAML.</td>
</tr>
</tbody>
</table>
### Advanced fields

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Field</td>
<td>Enter the field on the User table that contains the value the IdP requires to identify the user.</td>
</tr>
<tr>
<td>NameID Attribute</td>
<td>Leave this field blank unless you configure a new NameID policy. If you configure a new policy, the system requires this field in the User table. This field identifies the user logging in by matching the NameID token. Enter the name of that User table field here.</td>
</tr>
<tr>
<td>Create AuthnContextClass</td>
<td>Select the check box to specify a particular context class such as Password Protected Transport. If the check box is cleared, the IdP selects the most appropriate context class.</td>
</tr>
<tr>
<td>AuthnContextClassRef Method</td>
<td>Enter the URN of the login mechanism you want the IdP to use to authenticate users.</td>
</tr>
<tr>
<td>Force AuthnRequest</td>
<td>Select the check box to force AuthnRequests to occur.</td>
</tr>
<tr>
<td>Is Passive AuthnRequest</td>
<td>Select the check box if the AuthnRequest is passive.</td>
</tr>
<tr>
<td>Single Sign-On Script</td>
<td>Select the Single Sign-On script. The default is MultiSSO_SAML2_Update1.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Skew</td>
<td>Enter the number of seconds between the two attributes that make up the SAMLResponse nonce. The default is 60. A valid SAMLResponse must fall between the notBefore and notOnOrAfter date-time values. See Sample SAML 2 Response with the SubjectConfirmation and SubjectConfirmationData Elements and Sample SAML 2 Response with the AudienceRestrictions and Audience Elements for a sample SAMLResponse message.</td>
</tr>
<tr>
<td>Protocol Binding for the IDP’s SingleLogoutRequest</td>
<td>Enter one of the supported values listed in the Binding attribute from the SingleLogoutService element.</td>
</tr>
<tr>
<td>Metadata URL from which IDP properties are imported</td>
<td>The IdP properties import from this URL. If set, it enables the automatic import of SAML certificate from the IdP if the previous certificate has expired.</td>
</tr>
</tbody>
</table>

**Note:** If you upgrade from SAML 2 Update 1 to Multi-Provider SSO or if you manually set up your SSO connection, the IdP Metadata URL does not automatically populate.

---

**X.509 certificates for SAML**

Store and activate the necessary IdP certificates for your SAML configuration.

The X.509 certificates are the IdP certificates that a SAML configuration uses. After you install a certificate, you can add as many certificates as necessary. When there are multiple certificates, the system uses the first active certificate that is found. If a certificate is no longer valid, the system automatically polls the IdP for a current, valid certificate. It appends this certificate to your instance, and uses it for your active SAML configuration.

**Note:** Polling occurs if the IdP is accessible outside of your network.
Create and update identity providers
After you have configured the multi-provider SSO properties, you can update or create new SAML 2.0 Update 1 or digest token identity providers.

Role required: admin

1. Navigate to Multi-Provider SSO > Identity Providers.
2. To edit an identity provider record, click the record.
   - For digest token configurations, manually update the properties.
   - For SAML2 Update 1 configurations, automatically update the identity provider metadata with the Import Identity Provider Metadata related link or update the properties manually.
3. To create a new identity provider, click New.
   - For digest token configurations: Click Digest SSO and enter the digest properties for multi-provider single sign-on.
   - For SAML2 Update 1 configurations: Click SAML2 Update 1 and import the identity provider metadata from a URL, as XML, or manually enter the identity provider information.
4. To make the IdP the failover IdP that is used when the default IdP is not available, select the Default check box.

If you have SAML 2 Update 1 active and you upgrade to the Fuji release, the SAML 2 Update 1 IdP is selected as the default failover. No default failover IdP is selected for new instances or if you are upgrading from a release on which SAML 2 Update 1 is not active.

---

**Note:** The metadata import process automatically creates a certificate record for the identity provider. Navigate to the x509 Certificate module to see the certificate.

---

**Note:** Certificates for single-sign on should always be in PEM format to work with SAML certificates.

5. If E-Signature is active, configure the Identity Provider form and add the Assertion Consumer URL for eSignature authentication field.

In most cases, this URL is: https://YOURINSTANCE.service-now.com/consumer.do. However, if you employ a customized method of handling the SAML authentication for E-Signature, you can set up your own consumer URL. If you are only using SAML 2.0 Update 1 and not using Multi-Provider Single Sign-on, configure the assertion consumer URL with E-signature SAML properties.

**Configure users for Multi-Provider SSO**

Administrators can configure Multi-Provider SSO for individual users or for all users who belong to a company. You cannot configure Multi-Provider SSO for groups.

**Role required:** admin

1. Navigate to Multi-Provider SSO > Identity Providers.
2. Right-click an identity provider record and select **Copy sys_id**.
3. Copy the data to your clipboard.
4. Navigate to a user record or a company record.
5. Configure the form and add the **SSO Source** field.
6. **In the SSO Source field**, enter one of the following:
   - **SAML users**: enter `sso:` followed by the sys_id of the identity provider's record.
   - **SSO Federation users**: enter `federation:` followed by the sys_id of the federation record.

7. **Click Update.**

*Testing IdP connections*

Testing the connection to an IdP validates the settings before enabling external authentication.

Role required: admin

The Jakarta release supports the test connection within a pop-up window. If your IdP does not work correctly with this option, you can turn off this default setting.

1. Navigate to **Multi-Provider SSO > Identity Providers.**
2. Select a defined IdP or click **New** to define a new IdP.
3. Optional: Configure an identity provider if setting up a new IdP.
4. Click **Test Connection**, enter login credentials for the IdP to check login.
   You cannot activate the IdP until you have a successful test connection. If the test fails, you can update to save your configuration information, but you cannot activate this configuration.
5. Verify results using the **SSO Test Results/Summary** or the **Testing SSO Logs** section to see log messages.
   If there are any errors, refer to the **Multi-SSO (SAML 2.0) errors and fixes**
6. Click **Cancel** when testing is complete.
SSO Login Test Results

- SAML Login response received
- SAML Assertion retrieved
- Signature Validated
- Certificate Validated
- AudienceRestriction/Condition Validated
- Certificate Issuer Validated
- Subject Confirmation Validated

SSO Logout Test Results

- SAML Logout response received
- SAML Logout Response 'inResponseTo' validated
- SAML Logout Response 'status' validated

SSO Test Connection Summary

- Test connection is successful.

Click the "Activate" button to save and activate this configuration. Click the "Close" button to close this window and continue editing the SSO configuration.

02/21/17 17:10:01 (88Z) Issue Instant: 2017-02-22T01:10:01.000Z
02/21/17 17:10:01 (88Z) Session inResponseTo: SNCc1736edc961c8fe9e63334eb974622f9
02/21/17 17:10:01 (88Z) It is a logout response
02/21/17 17:10:01 (88Z) SAML LogoutResponse validated.
02/21/17 17:10:01 (88Z) request type : logoutResponse
02/21/17 17:10:01 (88Z) We will be redirecting user to the URL: /saml_test_conn_logout_completed.do?sysparm_noStack=true=sysparm_test_sso_id=7cb23f13eb21100227e5581be871355
02/21/17 17:10:01 (88Z) userToLogin: logout_success

Close  Activate
Common IdP connection errors
The following table describes some of the common IdP connection errors and their solutions.

**Troubleshooting IdP test connections**

<table>
<thead>
<tr>
<th>Error messages</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Field validation failed. Invalid User Field <code>&lt;field name&gt;</code> is not a field on sys_user table.</td>
<td>Verify the contents of the User table field you selected matches the SAML NameID token.</td>
</tr>
<tr>
<td>Assertion issuer is invalid.</td>
<td>Verify Identity Provider URL contains a valid URL to your IdP. Each IdP URL must be unique.</td>
</tr>
<tr>
<td>AudienceRestriction validation failed.</td>
<td>Verify the Audience URI contains a valid URL to your instance.</td>
</tr>
<tr>
<td>Cannot logout of IdP's session.</td>
<td>Verify the SingleLogoutRequest URL contains a valid URL to your IdP's logout service.</td>
</tr>
<tr>
<td>Signature did not validate against the credential's key.</td>
<td>Verify the IdP has a valid certificate installed.</td>
</tr>
</tbody>
</table>

**Multi-SSO (SAML 2.0) errors and fixes**
A list of common errors and associated fixes for a Multi-SSO (SAML 2.0) setup and configuration.

**Errors during Multi-SSO (SAML 2.0) setup**

<table>
<thead>
<tr>
<th>Error in instance logs</th>
<th>Test Connection Message</th>
<th>SAML property</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
</table>
| NotAfter: <Thu Jun 05 22:57:44 PDT 2014>. | Ensure that the IDP x509 certificate is present, valid, and active. | N/A | The current certificate or the SAML assertion has expired. | • Sync the SNC clock with the SAML IdP server clock.  
• Update the SAML 2.0 certificate record. |

- Unable to locate SAML 2.0 certificate.  
- Could not find a digital signature stored in the ServiceNow instance.  

| Ensure that the IDP x509 certificate is present, valid, and active. | The PEM-formatted string should be entered into the PEM Certificate field. | The SAML certificate does not exist. It might be inactive. | • Ensure that the correct PEM-formatted certificate is uploaded to the instance.  
• Verify that the certificate has the name SAML 2.0. No other names are allowed. |

*Note:* This naming convention is only applicable for the SAML2 update 1 plugin.
<table>
<thead>
<tr>
<th>Error in instance logs</th>
<th>Test Connection Message</th>
<th>SAML property</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificates do not match. Expect: <code>&lt;certStr&gt;</code>, actual: <code>&lt;inboundCert&gt;</code>.</td>
<td>Ensure that the IDP x509 certificate is present, valid, and active.</td>
<td>N/A</td>
<td>The available certificate in SNC does not match the certificate in assertion. Causes include: • The certificate is updated on the IdP but not in the ServiceNow instance. • The certificate is in the wrong format.</td>
<td>Confirm that the PEM-formatted string in the SAML 2.0 certificate record matches the X509 Certificate in the SAMLResponse for the user IdP.</td>
</tr>
<tr>
<td>Failure to check the validity of the certificate.</td>
<td>Ensure that the IDP x509 certificate is present, valid, and active</td>
<td>N/A</td>
<td>The current certificate might have expired.</td>
<td>Update the SAML 2.0 certificate record.</td>
</tr>
<tr>
<td>Failure to validate signature profile.</td>
<td>Ensure that the IDP x509 certificate is present, valid, and active</td>
<td>N/A</td>
<td>The assertion might be signed with a different certificate.</td>
<td>Check if the IdP has the same certificate as the SNC instance.</td>
</tr>
<tr>
<td>InResponseTo attribute in SubjectConfirmationData mismatch. Expect: <code>&lt;inResponseTo&gt;</code>, actual: <code>&lt;inResponseTo&gt;</code>.</td>
<td>Subject confirmation validation failed.</td>
<td>N/A</td>
<td>This error appears if either of the following situations occurs: • The IdP returns a SAMLResponse for a different SAMLRequest • A user bookmarks the URL with the SAMLRequest instead of just the instance URL • If a null value is expected, the response might be sent to a different node when the instance has multiple nodes.</td>
<td>The IdP admin should confirm that the expected SAMLResponse is being returned. This situation can be a load balancer or infrastructure issue.</td>
</tr>
<tr>
<td>SessionIndex value not found: <code>&lt;message&gt;...</code></td>
<td>SessionIndex not valid.</td>
<td>N/A</td>
<td>The <code>SessionIndex</code> is required in the SNC instance. The IdP returns it in the SAML response to authenticate successfully.</td>
<td>The IdP admin should confirm that the <code>SessionIndex</code> is defined in the SAMLResponse.</td>
</tr>
<tr>
<td>Error in instance logs</td>
<td>Test Connection Message</td>
<td>SAML property</td>
<td>Diagnosis</td>
<td>Fix</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>-----</td>
</tr>
<tr>
<td>No valid SubjectConfirmation found.</td>
<td>Subject confirmation validation failed.</td>
<td>N/A</td>
<td>Conditions could be missing due to an error on the IdP. The <strong>StatusCode</strong> in the response would contain Responder instead of the expected Success.</td>
<td>Review SAMLResponse to determine if Conditions are included in the SAMLResponse. The valid subject confirmation data could be expired or not for the right audience.</td>
</tr>
<tr>
<td>Assertion audience mismatch. Expect: &lt;propAudience&gt;, actual: &lt;audienceUri&gt;. or AudienceRestriction validation failed. No matching audience found.</td>
<td>Ensure that the 'Audience URI' field is set correctly</td>
<td>The audience URI that accepts the SAML2 token. (Normally, it is your instance URI. For example: <a href="https://demo.service-now.com">https://demo.service-now.com</a>.)</td>
<td>The SNC instance configured audience URI must match the value in the IdP.</td>
<td>Locate <a href="">saml2:Audience</a> in the SAMLResponse in the logs and verify that the value matches the one on the instance.</td>
</tr>
<tr>
<td>Assertion issuer is invalid. Expect: &lt;value on instance&gt;, actual: &lt;value returned by IdP&gt;</td>
<td>Assertion issuer is invalid.</td>
<td>The Identity Provider URL that issues the SAML2 security token with user info.</td>
<td>The IdP entity id (issuer) does not match the value defined in the SNC instance.</td>
<td>• Check if IdP or SP is not configured properly. • Confirm that the SAML property (the Identity Provider URL that issues the SAML2 security token with user info) is set correctly.</td>
</tr>
<tr>
<td>Subject is valid in the future. Now: &lt;now&gt;, NotBefore: &lt;notBefore&gt; or Subject is expired. Now: &lt;now&gt;, NotOnOrAfter: &lt;notOnOrAfter&gt;</td>
<td>Subject validation confirmation failed.</td>
<td>The number in seconds before notBefore constraint, or after notOnOrAfter constraint, to consider still valid.</td>
<td>The IdP clock is not synced with SP clock.</td>
<td>Update the SAML property glide.authenticate.sso.saml2.clockskew to a larger value. The default is 180 seconds. Some cases require a setting of 300 or higher. You may also need to check the time on your IdP server.</td>
</tr>
<tr>
<td>Error in instance logs</td>
<td>Test Connection Message</td>
<td>SAML property</td>
<td>Diagnosis</td>
<td>Fix</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>-----</td>
</tr>
<tr>
<td>Assertion is valid in the future, now: <code>&lt;now&gt;</code>, notBefore: <code>&lt;notBefore&gt;</code> or Assertion is expired, now: <code>&lt;now&gt;</code>, notOnOrAfter: <code>&lt;notOnOrAfter&gt;</code></td>
<td>Assertion is invalid.</td>
<td>The number in seconds before notBefore constraint, or after notOnOrAfter constraint, to consider still valid.</td>
<td>IdP clock is not synced with SP clock</td>
<td>Update the SAML property to a larger value. Default of 60 seconds. Some cases require a setting of 300 or higher. You may also need to check the time on your IdP server.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Common login and IdP errors</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Error or Symptom</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login requests generate an infinite loop between the system and the IdP when High Security is active.</td>
<td>• Typically the URL endpoint is an error page or logout page. • The logout_redirect.do might create this loop when you define glide.security.url.whitelist without adding the IdP host name to the property value.</td>
<td>Set (or create) the system property glide.authenticate.failed_redirect to redirect failed authentication requests to this URL.</td>
</tr>
<tr>
<td>The token used to authenticate the user or the request is signed with the signature algorithm <a href="http://www.w3.org/2001/04/xmldsig-more#rsa-sha256">http://www.w3.org/2001/04/xmldsig-more#rsa-sha256</a> which is not the expected signature algorithm <a href="http://www.w3.org/2000/09/xmldsig#rsa-sha1">http://www.w3.org/2000/09/xmldsig#rsa-sha1</a>.</td>
<td>Check the Alert Context tab for event details.</td>
<td>Navigate to the Advanced tab of the Relying Party Trust configuration dialog and verify that the algorithm is set to SHA-1 and not SHA-256.</td>
</tr>
</tbody>
</table>

Troubleshoot script issues with SAML
You might encounter script issues if SAML is already active at the time you activate Multiple Single Sign-On and if you already customized the installation exits.

Role required: admin

1. Back up the modified installation exit SAML2SingleSignon_update1 and script include SAML2_update1.
2. Revert both the installation exit and script include to the version that is available with the baseline system.
3. Activate or upgrade the Integration - Multiple Provider Single Sign-On Installer plugin. The system upgrades SAML and all necessary files to SAML 2 Update 1.
4. Open the Multiple SSO properties page and select the Enable Multi-Provider SSO check box to enable it.
5. Put the SAML2SingleSignon_update1 installation exit changes into the baseline script include MultiSSO_SAML2_Update1 and the SAML2_update1 script include changes into the baseline SAML2_update1 script include.
Log in using Multi-Provider SSO
The recommended and most efficient method for users to log in using Multi-Provider SSO is to use a specifically configured URL.

Role required: admin

After multi-provider SSO is configured, you can send a URL to your users with the correct IdP in the parameter string. For example:

`/login_with_sso.do?glide_sso_id=<sys_id of the sso configuration>`

After a user successfully logs in to the IdP page, a cookie containing the IdP sys_id is added to the browser. The next time the user attempts to log in, the system redirects the user to log in to the IdP server, which automatically logs in to the instance.

If a URL parameter is not set or the browser cache has been cleared, users can also do the following:

1. Click the Use external login link on the login page.
   The external login page appears. Users can click Use local login to return to the standard login page.
2. Enter the value for the specified field on the user table that you configured in Multi-Provider SSO properties.
   The user is redirected to the IdP server, where they log in.

After users successfully log in to an IdP, they are automatically redirected to that IdP whenever they attempt to access the instance. To have a user access a different IdP, send the user a URL with the new IdP information in the parameter. The new IdP overwrites the old IdP in the cookie if the user successfully logs in. If the user does not log in successfully, the old IdP information is retained in the cookie.

Allow users to choose the identity provider for login
SSO federation support allows users to choose which IdP to log into.

Role required: admin

SSO federations aggregate metadata from multiple IdPs and service providers, including your instance. Federations then publish the metadata as an XML file, which includes information like IdP names and IdP certificates. Administrators can then instruct the instance to read the XML file and automatically populate the SSO Properties table with all the necessary IdP information.

1. Navigate to Multi-Provider SSO > SSO Federation.
2. Click New.
3. Fill in the fields, as appropriate (see table).
4. Click Submit.
5. After you configure a federation, enable the Refresh SSO Metadata scheduled job, and then configure the users who you want to access the federation IdPs. Use the sys_id of the federation record you just created.
The instance populates the SSO properties table with the IdP information. When users who are configured to use the federation log in, they are redirected to the discovery service URL you configured. Then they select the IdP and provide the necessary credentials. Alternatively, you can send users a URL with the IdP in the parameter.

### Allowing users to choose the identity provider for login

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the federation.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the instance to pull the XML file from the federation.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of authentication this federation supports.</td>
</tr>
<tr>
<td>Discovery Service URL</td>
<td>Enter the URL of the discovery service for this federation. This is the site where users are directed to select an IdP and log in.</td>
</tr>
<tr>
<td>Meta Data URL</td>
<td>Enter the URL of the XML file that holds the federation metadata.</td>
</tr>
<tr>
<td>x509 Certificate</td>
<td>Select the federation certificate.</td>
</tr>
<tr>
<td>Domain</td>
<td>Select the domain that the data will belong to.</td>
</tr>
</tbody>
</table>

**Note:** The InCommon federated identity management IdP is preconfigured.

**Use ESS pages with Multi-Provider SSO**

You can redirect ESS users to an employee self-service page by adding a system property.

Role required: admin
You can add a global property to the system properties table. It applies to all IdPs. You cannot set multiple values for different IdPs.

1. Add the following system property: `glide.entry.loggedin.page_ess`.
2. Set the value of this property to the ESS page name: `myesspages`.
   - If the user has no role, they are redirected to that URL. If the user has a role, they are redirected to `instance.service-now.com/navpage.do`.

Use Multi-Provider SSO to set up an SSO approval for a SAML 2.0 authentication

An SSO approval with e-signature requires configuration on the SAML IdP and the ServiceNow instance.

The SAML IdP must support and honor the `forceAuthn` attribute in SAML assertion requests. E-signature does not function without this IdP setting. To set up an approval with e-signature using credentials from a SAML 2.0 authentication:

1. Activate or upgrade to SAML 2.0 with the [Integration - Multiple Provider Single Sign-On Installer plugin](#).
2. Activate the [Approval with E-Signature plugin](#).
3. Navigate to [Multi-Provider SSO > Identity Providers](#) and verify your 2.0 SAML IdP configuration. Advanced tab shows the `Force AuthnRequest` attribute checked.
   - Your SAML 2.0 IdP must support the `Force AuthnRequest` attribute, or e-signature is not supported.
4. On the eSignature Approval tab, enter the following e-signature SAML properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assertion Consumer URL for eSignature authentication</strong></td>
<td>This property defaults to the appropriate URL. To configure this property, click the lock icon to make this field editable. After edits, click the icon to lock the field.</td>
</tr>
<tr>
<td><strong>Assertion Consumer Index for eSignature authentication</strong></td>
<td>If your Service Provider has more than one URL set for the AssertionConsumerURL, you can set the index to use for eSignature, starting with index 1 or more.</td>
</tr>
<tr>
<td><strong>AuthnRequest URL for eSignature Authentication</strong></td>
<td>You can enter the URL that points to the SAML 2.0 IdP AuthnRequest URL for eSignature authentication. If the URL is the same as the Assertion Consumer URL, you can leave this setting blank.</td>
</tr>
<tr>
<td><strong>Authentication Pop-up Dialog Width</strong></td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the width of that dialog box. The default is 500.</td>
</tr>
<tr>
<td><strong>Authentication Pop-up Dialog Height</strong></td>
<td>When a user approves a request using eSignature, a dialog opens and a user can enter credentials. This setting controls the height of that dialog box. The default is 300.</td>
</tr>
</tbody>
</table>
5. Click the **Generate Metadata** button underneath the tabs to regenerate the service provider metadata. Copy this data and update it on the SAML IdP.

### Activate Approval with e-Signature plugin

The Approval with e-Signature plugin (com.glide.e_signature_approvals) allows users to approve requests by re-entering their login credentials.

**Role required:** admin

1. **Navigate to System Definition > Plugins.**
2. **Find and click the plugin name.**
3. **On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.**
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive.** The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. **Optional:** If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. **Click Activate.**

### Changes to SAML 2.0 and digest token configuration

Multiple provider single sign-on allows administrators to configure SAML 2.0 Update 1 and digest token as authentication methods.
Multiple provider single sign-on should be activated before you configure your SAML 2.0 Update 1 and digest token properties. After you request and activate multi-provider SSO, you must then set it up. After setting up multi-provider SSO, you can create or update the SAML 2.0 Update 1 and digest token configurations. You can use either or both authentication solutions with multi-provider SSO.

**Note:** The Integration - Multiple Provider Single Sign-On Installer plugin removes the SAML application from the navigator. The necessary SAML settings are migrated to the Multi-Provider SSO application into the SAML2 Migrated table. You can still modify items like the x509 certificate, IdP details, and so on through the Multi-Provider SSO application.

**LDAP integration**

An LDAP integration allows your instance to use your existing LDAP server as the master source of user data.

Administrators integrate with a Lightweight Directory Access Protocol (LDAP) directory to streamline the user login process and to automate administrative tasks such as creating users and assigning them roles. An LDAP integration allows the system to use your existing LDAP server as the master source of user data. Typically, an LDAP integration is also part of a single sign-on implementation.

The integration uses the LDAP service account credentials to retrieve the user distinguished name (DN) from the LDAP server. Given the DN value for the user, the integration then rebinds with LDAP with the user’s DN and password. The password that the user enters is contained entirely in the HTTPS session. The integration never stores LDAP passwords.

The integration uses a read-only connection that never writes to the LDAP directory. The integration only queries for information, and then updates its internal database accordingly.
Example LDAP Integration - User Import

**Note:** For detailed information about setting up the integration, see [LDAP integration setup](#).

**Note:** If your instance is using an LDAP integration and the Active Directory settings require users to reset their password upon login, your users will not be able to log in the instance. The instance cannot change any user’s active directory password.

### Aspects of LDAP integration

Administrators integrate with a Lightweight Directory Access Protocol (LDAP) directory to streamline the user login process and automate administrative tasks such as user creation and role assignment.

User data is refreshed from your master source into the instance. The instance integrates with your organization’s internal directory services through an LDAP query as a read-only connection, never updating your corporate LDAP.
Data population

An integration to your LDAP server(s) allows you to quickly and easily populate the instance with user records from your existing LDAP database. In case of data inconsistencies, configuration settings provide the ability to create, ignore, or skip records.

You can also specify the data that is imported by specifying attributes. We recommend importing only the data that you want to expose to the instance.

Note: You must specify all the attributes used in your transform map. If attributes are not specified, all available object attributes are imported from the LDAP server. This peripheral data accumulates in temporary import set tables, slowing import time.

For more information, see Specify LDAP attributes for configuration information and Create a transform map to help you create a transform map.

Authentication

When one of your users enters their domain credentials in the login page, the application passes those credentials to the defined LDAP server(s). The LDAP server responds with an authorized or unauthorized message which the application uses to determine if access should be granted.

By authenticating against your LDAP server, users use the same credentials for the application that they use for other internal resources on your domain. Also, you can leverage any existing password and security policies that are already in place (for example: account lockout after a number of failed logins and password expiration dates). Because the application is receiving a "yes" or "no" from the LDAP server, these policies are enforced.

Features of LDAP integration

LDAP integration features include scheduled refresh, a dedicated listener, and on-demand login.

Scheduled LDAP refresh

A scheduled scan of your LDAP server is usually run once a night. It queries all applicable user records' attributes and compares them with the account on our servers. If there is a difference, we modify our user record with the changed attribute. The load placed upon the LDAP server during the refresh depends on how many records are queried, and the number of attributes being compared. We recommend scheduling the refresh during off-peak hours. A large refresh operation can affect other scheduled operations, such as running reports, and should be planned to minimize any conflicts.

LDAP listener

LDAP listener is our version of a persistent query (or persistent search). We issue a standing query for changes made to your LDAP server, and constantly listen for a response. Assuming your server supports a persistent search, any changes made to any of your applicable LDAP accounts are returned to the LDAP listener and sent to your instance within approximately 10 seconds. This is an extremely useful tool, allowing us to have a nearly real-time copy of your users' account details, without having to wait for the next scheduled refresh.
On-demand LDAP login

After LDAP integration is complete, your instance has the ability to allow new users to login to the system, even if their accounts have not yet been created. When a new user attempts to login to your instance, we look to see if this user has an account. When the account is not found, the instance automatically queries the LDAP server for the username that was entered. If an account is found, we then try to authenticate with the user’s password. If the password checks out, the instance creates an account for the user, populates the account with all applicable LDAP information, and logs the user into your instance.

LDAP data population

An LDAP integration involves data population and authentication.

Note: Functionality described in this integration is not available by default. This integration involves post-deployment customization performed by an experienced administrator or by ServiceNow professional services consultants.

An integration to the LDAP servers allows you to quickly and easily populate the instance’s database with user records from the existing LDAP database. To prevent data inconsistencies, configuration settings provide the ability to create, ignore, or skip incoming LDAP records.

You can also limit the data the integration imports by specifying LDAP attributes, thereby importing only the data that you want to expose to an instance. Typically, the LDAP attributes you specify become part of the integration transform map. If you do not specify any LDAP attributes, the integration imports all available object attributes from the LDAP server. The instance stores imported LDAP data in temporary import set tables, so the more attributes you import, the longer the import time. For more information, see Specify LDAP attributes.

LDAP scheduled refresh

It is recommended that you run a scheduled scan of the LDAP server once a night.

The scan queries all applicable user records’ attributes and compares them to accounts on your instances. If the scan identifies a difference, the integration modifies the instance user record with the changed attribute.

The load placed on the LDAP server during the refresh depends on how many records are queried and the number of attributes being compared.

Schedule the refresh during off-peak hours at a time that minimizes conflicts. A large refresh operation can affect other scheduled operations, such as running reports.

LDAP authentication

Use LDAP authentication to access using LDAP credentials.

When a user enters network credentials in the login page:

1. The instance passes the credentials to an LDAP server to find the instance.
2. With RDNs, it validates the user’s DN string. It validates only if at least one of the LDAP OU configurations with table=sys_user has an RDN configured.
3. The LDAP server responds with an authorized or unauthorized message that the system uses to determine whether access should be granted.

By authenticating against your LDAP server, users access the platform with the same credentials that they use for other internal resources on your network domain. Also, you can reuse any existing password and security policies that are already in place. For example, the LDAP server may already have account lockout and password expiration policies.

When you enable LDAP, the system updates user records with these fields.
**LDAP user record updates**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Identifies whether or not LDAP is used to validate a user. If the source starts with ldap, then the user is validated via LDAP. If the source does not start with ldap, then the password on the user record is used to validate the user upon login.</td>
</tr>
<tr>
<td>LDAP Server</td>
<td>Identifies which LDAP server authenticates the user when there are multiple LDAP servers.</td>
</tr>
</tbody>
</table>

**Note:** The system does not support LDAP password authentication through a MID Server. An instance must be able to directly connect with an LDAP server to support password authentication.

**LDAP on-demand login**

Create new accounts by matching users to existing LDAP accounts.

After an LDAP integration is established, the instance can allow new users to log in to the system even if they do not yet have an account on the instance. When a new user attempts to log in to the instance, the integration checks to see if this user has an account in the instance. If the integration does not find an existing user account, it automatically queries the LDAP server for the username that was entered. If a matching LDAP account is found, the integration tries to authenticate with the password the user entered. If the password is valid, the instance creates an account for the user, populates the account with all applicable LDAP information, and logs the user in to the instance.

On-demand login uses the LDAP User Import transform map. For more information on transform map requirements, see [LDAP transform maps](#).

**LDAP integration requirements**

Review the requirements for LDAP integration, which include a PKI certificate an LDAP compliant directory services server.

LDAP integration requires:

- An LDAP v3 compliant directory services server
  - Allows inbound network access through the firewall (to the LDAP server)
  - *(Optional)* Accepts anonymous login
  - *(Optional)* Supports paging for large LDAP queries

- The external IP address or fully-qualified domain name of the LDAP server. You can also use a MID server.
- A read-only LDAP account of your choosing
- For multiple domains, network access for each domain controller
- For LDAPS, a PKI certificate
- For LDAP listener, a Microsoft Active Directory server that supports persistent queries (ADNotify)

**Supported LDAP servers**

The instance supports several LDAP servers.

Using JNDI to interface with the LDAP server, the instance has successfully integrated with the following servers:

- Microsoft Active Directory
- Novell
• Domino (Lotus Notes)
• Open LDAP

LDAP query limits
There are several methods of handling LDAP limitations.

By default, Active Directory 2000/2003 has an LDAP query limit (maxPageSize) of 1000 objects to prevent excessive loads and denial of service attacks. The system has two methods of dealing with this limit.

• The default method is to break up the query to return fewer than 1000 objects at a time. For example, query only for objects starting with the letter a, then query for b objects.
• The more efficient method for large environments is to enable paging, which is supported by default on all Microsoft Active Directory servers. Paging automatically splits the results into multiple result sets so the integration does not have to split up the query into multiple requests.

LDAP configuration options
There are several optional add-ons you can consider when you configure LDAP.

Secure LDAP connections
Secure connections provide additional protection for an LDAP integration.

The LDAP integration ensures security by connecting from a single machine that uses a fixed IP address through a specific port on the firewall. Furthermore, the connection requires a read-only LDAP account of your choosing for authentication. If you need additional protection for the LDAP integration, you can use one of these security features:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>To shield your LDAP server from external network traffic, install a MID Server on the local network and configure the system to communicate with the MID Server over a secure channel.</td>
</tr>
<tr>
<td>LDAPS</td>
<td>To establish an encrypted LDAPS connection, load the public side of your LDAP server’s SSL certificate. The integration uses the certificate to encrypt all communication between the LDAP server and the instance.</td>
</tr>
<tr>
<td>VPN</td>
<td>To secure the LDAP server with an encrypted point-to-point IPSEC VPN tunnel, speak to your account manager for details and pricing.</td>
</tr>
</tbody>
</table>

For more information about VPNs, Mid Servers, and LDAP integrations, see You Don’t Need A VPN Part I on the ServiceNow Community.

LDAP listener
A listener is a dedicated process that periodically searches for changes to users and groups on the LDAP server.

The listener can be deployed on a Microsoft Active Directory server that supports persistent queries (ADNotify), or on an LDAP server that supports persistent search request control (with OID 2.16.840.1.113730.3.4.3)

If the LDAP server supports a persistent search, the LDAP listener recognizes any user and group changes made to any of the applicable LDAP accounts and forwards them to your instance within approximately 10 seconds. This allows the instance to have a nearly real-time copy of your
users’ account details without having to wait for the next scheduled refresh. The LDAP listener can only synchronize objects that map to the User (sys_users) and Group (sys_user_group) tables.

**Note:** If a user is added via the listener, but the user does not meet the requirements as defined by the OU filter, then the instance ignores the record on the LDAP server. If it meets the criteria, the user is added to the instance.

LDAP listener properties
Several properties control the behavior of the LDAP listener.

**LDAP listener properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ldap.listener.use_background_transaction</td>
<td>When true, the LDAP listener is started as a background transaction. By running the LDAP listener as a background transaction, the quota rule LDAP Listener Start/Stop Transaction can cancel the transaction after the maximum duration is reached, 5 minutes by default. This behavior prevents an LDAP listener from waiting indefinitely.</td>
</tr>
<tr>
<td>glide.ldap.listener.mid.use_background_transaction</td>
<td>When true, the LDAP listener is started as a background transaction. By running the LDAP listener as a background transaction, the quota rule LDAP Listener Start/Stop MID Transaction can cancel the transaction after the maximum duration is reached, 5 minutes by default. This behavior prevents an LDAP listener from waiting indefinitely.</td>
</tr>
</tbody>
</table>

**Note:** This property applies only to LDAP connections that do not use a MID Server. Use `glide.ldap.listener.mid.use_background_transaction` to control the behavior of LDAP connections that go through a MID Server.

- Type: true | false
- Default value: false
- Location: Add to the System Property (sys_properties) table

Note: This property applies only to LDAP connections that use a MID Server. Use `glide.ldap.listener.use_background_transaction` to control the behavior of LDAP connections that do not go through a MID Server.

- Type: true | false
- Default value: false
- Location: Add to the System Property (sys_properties) table
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.ldap.listener.mid.one_listener | When true, only a single ECC queue message is created to start or stop the LDAP listener through a MID Server. When false, multiple ECC queue messages can be created, leading to the creation of multiple threads to start or stop the LDAP listener.  
  - Type: true | false  
  - Default value: true  
  - Location: Add to the System Property (sys_properties) table |

**LDAP monitor**

The LDAP monitor provides the current status of the LDAP servers and listener (starting with the Eureka release).

Monitoring the current health of your LDAP configuration can help with LDAP diagnostics and maintenance.
LDAP monitor

The available states are:

- Active
- Inactive
- Error
- Active (Shutting down...)
- Error (Shutting down...)

In addition to its current state, the monitor also shows:

- The last message detected by the listener, such as waiting for LDAP changes, error connecting, and so forth.
- The last LDAP user change, such as new user, updated user, and so forth.
- The last error that occurred.

Multiple LDAP domains
You can establish multiple network domains within the same forest or for completely non-trusted domains.
The recommended method for handling multiple domains is to create a separate LDAP server record for each domain. Each LDAP server record must point to a domain controller for that domain. This means the local network must allow connections to each of the domain controllers.

After expanding to more than one network domain, it is critical that you identify unique LDAP attributes for the application usernames and import coalesce values. A common unique coalesce attribute for Active Directory is `objectSid`. Unique usernames may vary based on the LDAP data design. Common attributes are `email` or `userPrincipalName`.

**Send a one-time password when the LDAP server is down**

An LDAP property is available to send a one-time password to a user if the user is unable to log in because the LDAP server is down. You can also configure another property to control how long the password is valid.

Role required: admin

To receive a one-time password, the user must have notifications enabled on their user profile. The notification is an email message only. SMS messages are not supported.

Both properties are enabled by default. The default value for property that controls password validity is 10 minutes.

1. Open the list of system properties by entering `sys_properties.list` in the filter of the application navigator.
2. Find the `glide.ldap.onetime.password.enabled` property.
3. Set the property to `true`.
4. To change the password validity time for a user, set the following property to an integer number of minutes: `glide.authenticate.onetime.password.validity`.

**LDAP integration FAQs**

Review these frequently-asked questions about LDAP integration in the instance.

**What are the prerequisites for an LDAP integration?**

- The directory services server must be LDAP v3 compliant
- Inbound network access through the firewall must be allowed (to the LDAP server)
- External IP or Name of the LDAP server
- User credentials with read-only access
- For LDAPS, a PKI certificate

**When is an LDAP integration usually done?**

LDAP integrations are usually done before the instance Go Live, but can be integrated at any time.

**Is this a synchronization or a copy?**

This question comes up regularly during our pre-integration discussions, and is centered around a concern of a third party (the instance in this case) making changes (writing) to your LDAP server. In an LDAP integration, your instance does not write to the internal LDAP directory. The instance queries for information, and updates its database accordingly.

No changes are made to the internal LDAP server by the instance. The service account is read only.
Is it secure?

Yes. The connection is made from a single machine using a fixed IP address through a specific port on your firewall. Authentication is done with a read-only LDAP account of your choosing. You can use standard LDAP, or load the public side of an SSL certificate installed on your directory, in which case we can use LDAPS. To add another layer of security, we also offer the option of a point-to-point IPSEC VPN tunnel. Speak to your account manager for details and pricing.

Another security aspect to consider is the data shared in an LDAP integration. To limit the data exposed to your instance, specify attributes in your transform map. For more information, see [Create a transform map](#).

How up to date is the information?

Most changes (including additions) to your LDAP server are available to the instance within seconds, depending on how many components of the full LDAP integration are in place.

Which attributes need to be pulled from the directory into the instance?

It is recommended that attributes are defined to import only required data. Defined attributes get mapped into the instance user database.

We cannot answer the question of which specific attributes are needed because this is determined by the scope of the project and business requirements.

What types of LDAP servers does the instance support?

The instance has successfully integrated with Microsoft Active Directory, Novell, Domino (Lotus Notes), and Open LDAP. We use JNDI to interface with the LDAP Server. As long as your LDAP server is LDAP v3 compliant, the integration is successful.

Since my users are already authenticated on my local network, how can I keep them from having to enter a password to access the application?

A single sign-on method is the solution. Along with the data population functionality provided with the LDAP import, you can use the External Authentication functionality supported by the application.

Can I integrate with multiple domains?

Yes, multiple domains can be within the same forest or completely non-trusted domains. The recommended method is to create a separate LDAP server record for each domain. Each LDAP server record must point to a domain controller for that given domain. This means that connections must be allowed to each of the domain controllers.

When you expand to more than one domain, it is critical that you identify unique LDAP attributes to be used as the application usernames and import coalesce values. A common unique coalesce attribute for Active Directory is objectSid. Unique usernames may vary based on your LDAP data design; common attributes are email or userPrincipalName.
How do you handle querying more than 1000 users?

By default, Active Directory 2000/2003 has an LDAP query limit (maxPageSize) of 1000 objects to prevent excessive loads and denial of service attacks. We have two methods of dealing with this limit.

The default method is to break up the query to return less than 1000 objects at a time. For example, query only for object starting with the letter ‘a’, then query for ‘b’ objects. The more efficient method for large environments is to enable paging. Paging is supported by default on all Microsoft Active Directory servers. It automatically splits the results into multiple result sets, so we don’t have to split up the query into multiple requests.

What type of LDAP query is done?

If an LDAP password is supplied then a “Simple Bind” is performed. If no LDAP password is supplied then “none” is used, in which case the LDAP server must allow anonymous login.

How is LDAP authentication accomplished when the username is provided?

We use provided service account credentials for LDAP to retrieve the user DN from the LDAP server. Given the DN value for the user, we then rebind with LDAP given the users DN and the provided password.

How is the user password stored?

The password that the user enters is contained entirely in their HTTPS session. We do not store that password anywhere.

Are LDAP records synchronized or just copied?

The instance does not synchronize department records. Users and group memberships are kept up-to-date by the LDAP Listener mechanism and a daily full LDAP Browse, but the instance does not delete any of these entries once they disappear from LDAP.

If an entry were to be deleted, the entire history would also get deleted, and any references to it would be cleared or deleted. Configuration Items (CIs), SLA Agreements, Software Licenses, Purchase Orders, and Service Catalog Entries all have a reference to Department, and if Department is deleted, then those references get cleared. There are many references to Users, and so deleting a user would lose all history of what that user did. Currently, the decision to delete or not to delete is made by our customers.

How is a user record defined to use LDAP authentication?

These fields on the user record pertain to LDAP:

- **Source**: The Source field identifies whether or not a user is validated using LDAP. If the source field starts with "ldap", then the user is validated via LDAP. If the Source field does not start with "ldap", then the password on the user record is used to validate the user upon login.
- **LDAP Server**: The instance supports multiple LDAP servers, so the LDAP Server field determines which server should be used to authenticate the user.
How can we keep LDAP records synchronized?

Schedule a periodic scan of the LDAP server to pick up changes.

I’m ready to configure my LDAP integration. Now what?

Let’s go! Start with **LDAP integration setup**.

**LDAP integration setup**

Administrators can enable LDAP integration to allow sign-on of users from their company LDAP directory.

After the integration, the MID Server connects to the instance and the MID Server also connects to the LDAP server. In both cases, the MID Server initiates the connection:

1. First, the MID Server connects to the LDAP server via LDAP on Port 389.
2. Then, the MID Server initiates an HTTPS encrypted connection to the instance on Port 443 to push the data to the instance.

**LDAP communication channels**

LDAP typically uses one of these types of communication channels.

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
<th>LDAP import support?</th>
<th>LDAP authentication support?</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server connection</td>
<td>Communicates over HTTP on port 80 by default. This communication channel does not require a certificate. The connection between the MID Server and the instance is over HTTPS (port 443). You can use the MID Server to import data over LDAP, but you cannot use the MID Server for LDAP authentication. Proceed to Define the LDAP Server.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Standard LDAP integration</td>
<td>Communicates over TCP on port 389 by default. This communication channel does not require a certificate. Proceed to Define the LDAP Server.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Connection</td>
<td>Description</td>
<td>LDAP import support?</td>
<td>LDAP authentication support?</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>SSL-encrypted LDAP integration (LDAPS)</td>
<td>Communicates over TCP on port 636 by default. This communication channel requires a certificate. Proceed to Upload the LDAP X.509 SSL certificate to obtain and upload the certificate.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VPN connection</td>
<td>Communicates over an IPSEC tunnel. Purchase or create an IPSEC tunnel on your local network. Proceed to Define the LDAP Server.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

A MID server initiates one connection to an LDAP server via port 389, then initiates an encrypted HTTPS connection to an instance via port 443 to push data to the instance. When using a MID server, the instance does not make the connection to the LDAP server. The MID server does.

The instance can also connect to the LDAP server directly, using LDAP or LDAPS, either over the internet or through a VPN tunnel.

For more information about VPNs, Mid Servers, and LDAP, see You Don’t Need A VPN Part II on the community.

Upload the LDAP X.509 SSL certificate
If your administrator is setting up an SSL-encrypted LDAP integration (LDAPS) to communicate over TCP on port 636, and has not already uploaded a certificate as part of your instance Go Live activities.

Role required: admin
1. Purchase or generate an SSL certificate on your LDAP server.
2. Upload the LDAP certificate to the instance.

Define an LDAP server
Create a new LDAP server record in the instance.

Role required: admin
1. Navigate to System LDAP > Create New Server.
2. Fill in the form fields.
3. Click **Submit**.

**Note:** You can also modify an existing LDAP server record by navigating to **System LDAP > LDAP Servers** and making the needed changes.

4. Make changes to the fields as necessary.

**LDAP server fields**
You can configure LDAP servers after you create a new server record.
### LDAP server form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the server.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box if the server is active.</td>
</tr>
<tr>
<td>LDAP Server URLs</td>
<td>Enter the URLs of the primary and backup LDAP servers. Servers are first ordered by operational status, with servers that are Up listed first, then ordered by the Order value that you specify. The first server listed is the primary LDAP server. The others are redundant servers.</td>
</tr>
<tr>
<td>Server URL</td>
<td>Enter the URL of the server. Configure the form to add this field if necessary. It is a calculated read-only field that shows the list of LDAP servers that you can also see in the LDAP Server URLs field, separated by a space, and ordered by operational status and the order values of the URLs.</td>
</tr>
<tr>
<td>Login distinguished name</td>
<td>Enter the distinguished name (DN) of the user authenticating the LDAP connection. To access an LDAP directory server, the username must be in the full distinguished name format: <a href="mailto:servicenow@service-now.com">servicenow@service-now.com</a></td>
</tr>
<tr>
<td>Login password</td>
<td>Enter the server's password.</td>
</tr>
<tr>
<td>Starting search directory</td>
<td>Enter the relative distinguished name (RDN) of the default search directory. All queries to this LDAP server will start from this RDN.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MID Server</td>
<td>Select the MID Server you want to use to connect to the LDAP server. Using a MID Server to establish an LDAP connection prevents you from having to expose the LDAP server to external network traffic. It also eliminates the need to establish a VPN tunnel between your LDAP server and ServiceNow data centers.</td>
</tr>
</tbody>
</table>
| **Note:**              | • The MID Server user must have the user_admin role in order to be able to read LDAP server configuration records.  
                          • The following are not available with the MID Server:  
                          - LDAP authentication  
                          - SSL connection |
| Connect timeout        | If a MID Server is configured, the connection times out after 10 seconds, regardless of this setting. This setting is hard-coded and cannot be altered.                                                             |
| Read timeout           | Specify the number of seconds the integration has to read LDAP data. The integration stops reading LDAP data after the connection exceeds the read timeout. If you enable an SSL connection, you can also set a read timeout value with the `com.glide.ssl.read.timeout` system property. If you enter timeout values for both this field and the system property, the lowest timeout value takes precedence. |
| SSL                    | Select this check box to require the LDAP server to make an SSL-encrypted connection. For more information, see Enable SSL. If you selected a MID Server, this field is not available. |
| Listener               | Select this check box to enable the integration to periodically poll Microsoft Active Directory servers or LDAP servers that support persistent search request control. Additionally, if you selected a MID Server, the listener functionality is available for that MID Server. See [LDAP listener](https://devcenter.servicenow.com/kb/article/159184) and [Enable an LDAP listener](https://devcenter.servicenow.com/kb/article/159184) for more information. |
| Listen interval (timeout value) | Specify the listener timeout value in the number of minutes that the integration listens for LDAP data with every connection. The integration stops listening for LDAP data after the connection exceeds the listen interval.                                           |
| Paging                 | Select this check box to have the LDAP server split up LDAP attribute data into multiple result sets rather than submit multiple queries.                                                                        |
The LDAP integration uses a redundant server if the primary LDAP server experiences a service interruption.

Role required: admin

Administrators can specify redundant servers from either the Create New Server module or from an individual LDAP Server record. The instance searches for an available LDAP server in the order in which they are listed.

1. Navigate to System LDAP > Create New Server.
2. Fill out the form as specified in Define the LDAP Server.
3. In the Server URL field, the valid URLs of all servers appear separated by a space. Servers are first ordered by operational status, with servers that are Up listed first, then ordered by the Order value that you specify. The first server listed is the primary LDAP server. The others are redundant servers.

   Note: There is a slight delay between the change in the actual operational status and the display.

4. Enter other LDAP server fields as needed.
5. Click Submit.
Specify a redundant LDAP server from an LDAP server record
The LDAP integration uses a redundant server if the primary LDAP server experiences a service interruption.
Role required: admin

1. Navigate to **System LDAP > LDAP Servers**.
2. Select the LDAP server for which you want to specify a redundant server.
3. From the LDAP Server URLs embedded list, click **Insert a new row**.
4. Fill in the fields for the row (see table).
5. Right-click the form header and click **Save**.
6. Repeat these steps for each additional server you want to specify.
### LDAP Server - Example LDAP Server

<table>
<thead>
<tr>
<th>LDAP Server URLs</th>
<th></th>
<th>1 of 2</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
</tr>
<tr>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
</tr>
<tr>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
<td><img src="https://example.com" alt="URL" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login distinguished name</td>
<td><a href="mailto:servicenow@servicenow.com">servicenow@servicenow.com</a></td>
</tr>
<tr>
<td>Login password</td>
<td></td>
</tr>
<tr>
<td>Starting search directory</td>
<td>DC=serviceNow,DC=com</td>
</tr>
<tr>
<td>NID server</td>
<td></td>
</tr>
<tr>
<td>Server URL</td>
<td><a href="https://10.10.1.389/ldap/10.10.1.389">https://10.10.1.389/ldap/10.10.1.389</a></td>
</tr>
</tbody>
</table>

**Related Links**
- Test Connection
- LDAP Listener Status
- Browse
- Login Listener
- Runtime List
- Advanced View
### LDAP Server URLs embedded list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The URL or IP address to the redundant LDAP server.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the instance searches for an available LDAP server from lowest value to highest. A business rule automatically populates this value if you leave the field blank.</td>
</tr>
<tr>
<td>Active</td>
<td>A true/false field indicating whether the LDAP server is available for use as a backup server. Only active servers can be used as backup servers.</td>
</tr>
<tr>
<td>Operational Status</td>
<td>A read-only true/false field indicating whether the LDAP server is currently available. Only servers that are currently operational can be used as backup servers.</td>
</tr>
</tbody>
</table>

#### Set up SSL-encrypted LDAP integration (LDAPS)

Set up an SSL connection for your LDAP server.

Role required: admin

If you use an LDAPS integration and the default SSL port is 636, no further configuration is necessary; SSL is automatically enabled. If the LDAPS integration uses another SSL port, define the alternate SSL connection properties.

1. Navigate to **System LDAP > LDAP Servers**
2. Select the LDAP server to configure.
3. Under **Related Links**, click **Advanced view**.
4. In the **Server URL** field, specify the LDAP IP address and alternate SSL communications port.
5. Select the **SSL** check box.
   - If this option does not appear on the form by default, configure the form and add it.
6. Click **Update**.

**Note:**

Be sure a network administrator configures the local firewall to allow the application server to access the LDAP server. If the LDAP server is located within an internal network, the firewall forwards (or NATs) the application server’s IP address through the firewall on the correct port.

#### Provide LDAP server login credentials

The LDAP login credentials determine what organizational units the integration can see.

Role required: admin

Servers that allow anonymous login generally limit the organizational unit (OU) data available to anonymous connections.

1. Navigate to **System LDAP > LDAP Servers**.
2. Select the LDAP server to configure.
3. In **Login distinguished name**, enter the user credentials for an account with read access to the directory levels from which you want to import users or groups. The system uses these credentials to connect to your LDAP server. 

To access an LDAP directory server, the username must be in the full distinguished name format:
- servicenow@service-now.com

4. In **Login password**, enter the password for the LDAP user.

   **Note:** Consider enabling LDAPS to encrypt this password during transmission.

5. Select the **Active** check box.

6. (Optional) In the **Starting search directory** field, explicitly specify the LDAP OU attributes you want the instance to import.

7. Click **Update**.

   **Note:** If you provide an LDAP password, the integration performs a Simple Bind operation. If you do not provide an LDAP password, the LDAP server must allow anonymous login or the integration cannot bind to the LDAP server.

Enable an LDAP listener

Enabling a listener is optional. If enabled, a listener notifies the system to process LDAP records soon after there is an update on the LDAP server.

Role required: admin

A **listener** is a dedicated process that periodically searches for changes on the LDAP server.

The listener can be deployed on a Microsoft Active Directory server that supports persistent queries (ADNotify), or on an LDAP server that supports persistent search request control (with OID 2.16.840.1.113730.3.4.3).

To enable a listener:

1. Navigate to **System LDAP > LDAP Servers**.
2. Select the LDAP server to configure.
3. Select the **Listener** check box.
4. Click **Update**.

   **Note:**

   The system only imports user records that match the LDAP OU filter. Incoming user records that do not meet the filter requirements are flagged as invalid and ignored by the import. Administrators can enable verbose LDAP logging to determine if incoming records are not matching the LDAP OU filter.

Specify LDAP attributes

Specify the attributes included in LDAP server queries using the LDAP server **Attributes** field. This can enhance performance as well as security.

Role required: admin

By default, the system loads all of the attributes for each object that it has permission to read from your LDAP server. Using the **Attributes** field, you can specify and thereby limit the attributes the LDAP query returns. Using this approach for large LDAP imports can greatly improve the speed of those imports.
Explicitly define attributes where possible. If there is information that you do not want exposed to the instance, exclude the attribute.

If you do not specify LDAP server attributes, user transactions may freeze for extended periods of time when new attributes are added to an LDAP server object because the system will be busy loading data from the new attributes.

---

**Note:** To use the manager lookup scripts described in Select or Create a Transform Map for LDAP Data, specify manager and dn (distinguished name) in the Attributes field. Neither attribute is required to be a part of a transform map.

---

**Set LDAP connection properties**

Configure your LDAP server connection properties.

Role required: admin

1. Navigate to **System LDAP > LDAP Servers**.
2. Select the LDAP server to configure.
3. Set the connection property fields (see table).
4. Click **Update**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the server.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box if the server is active.</td>
</tr>
<tr>
<td>LDAP Server URLs</td>
<td>Enter the URLs of the primary and backup LDAP servers. Servers are first ordered by operational status, with servers that are Up listed first, then ordered by the Order value that you specify. The first server listed is the primary LDAP server. The others are redundant servers.</td>
</tr>
<tr>
<td>Server URL</td>
<td>Enter the URL of the server. Configure the form to add this field if necessary. It is a calculated read-only field that shows the list of LDAP servers that you can also see in the <strong>LDAP Server URLs</strong> field, separated by a space, and ordered by operational status and the order values of the URLs.</td>
</tr>
</tbody>
</table>
| Login distinguished name | Enter the distinguished name (DN) of the user authenticating the LDAP connection. To access an LDAP directory server, the username must be in the full distinguished name format:  
  - servicenow@service-now.com |
| Login password         | Enter the server’s password.                                                                                                                                                                                   |
| Starting search directory | Enter the relative distinguished name (RDN) of the default search directory. All queries to this LDAP server will start from this RDN.                                                                     |
| MID Server             | Select the MID Server you want to use to connect to the LDAP server. Using a MID Server to establish an LDAP connection prevents you from having to expose the LDAP server to external network traffic. It also eliminates the need to establish a VPN tunnel between your LDAP server and ServiceNow data centers. |

**Note:**
- The MID Server user must have the user_admin role in order to be able to read LDAP server configuration records.
- The following are not available with the MID Server:
  - LDAP authentication
  - SSL connection
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect timeout</td>
<td>If a MID Server is configured, the connection times out after 10 seconds, regardless of this setting. This setting is hard-coded and cannot be altered.</td>
</tr>
<tr>
<td>Read timeout</td>
<td>Specify the number of seconds the integration has to read LDAP data. The integration stops reading LDAP data after the connection exceeds the read timeout. If you enable an SSL connection, you can also set a read timeout value with the <code>com.glide.ssl.read.timeout</code> system property. If you enter timeout values for both this field and the system property, the lowest timeout value takes precedence.</td>
</tr>
<tr>
<td>SSL</td>
<td>Select this check box to require the LDAP server to make an SSL-encrypted connection. For more information, see Enable SSL. If you selected a MID Server, this field is not available.</td>
</tr>
<tr>
<td>Listener</td>
<td>Select this check box to enable the integration to periodically poll Microsoft Active Directory servers or LDAP servers that support persistent search request control. Additionally, if you selected a MID Server, the listener functionality is available for that MID Server. See <a href="https://servicenow.com">LDAP listener</a> and <a href="https://servicenow.com">Enable an LDAP listener</a> for more information.</td>
</tr>
<tr>
<td>Listen interval (timeout value)</td>
<td>Specify the listener timeout value in the number of minutes that the integration listens for LDAP data with every connection. The integration stops listening for LDAP data after the connection exceeds the listen interval.</td>
</tr>
<tr>
<td>Paging</td>
<td>Select this check box to have the LDAP server split up LDAP attribute data into multiple result sets rather than submit multiple queries.</td>
</tr>
</tbody>
</table>

**Automatic LDAP server validations**

When an LDAP Server record is set to active, the system automatically tests every connection to validate it.

Validations include:
- The LDAP server is accessible at the provided URL and port
- The LDAP server URL is properly formatted
- The login credentials are valid

Starting with the Fuji release, the system displays colored dots next to each server URL:

**LDAP server connection icons**

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The server is active and operational.</td>
</tr>
<tr>
<td>Color</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Gray</td>
<td>The server is neither active nor operational.</td>
</tr>
<tr>
<td>Red</td>
<td>The server is active but not operational.</td>
</tr>
</tbody>
</table>
LDAP server connection status

Test an LDAP connection manually
You can manually test the connection to the LDAP server from the LDAP server form.
Role required: admin

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to test.
3. Under Related Links, click Test connection.
4. Under Related Links, click Browse to verify that the appropriate LDAP directory structure is visible to the system.
5. (Optional) If the connection was successful, click Browse to view the source LDAP directory structure that is visible to the instance.

**Note:**
The Filter and RDN fields on the left of the Browse window are ignored when you use the search field on the right.

---

Test communication between LDAP and MID Servers
The instance tests the connection automatically every time a user opens the LDAP Server form.

Role required: admin
The instance supports an LDAP connection timeout of 29 seconds or less. Error messages appear on the form if there are any issues connecting to the LDAP server.

Employees can also verify connectivity between the instance and the LDAP server. Contact Technical Support for assistance verifying LDAP connectivity.

**LDAP connection timeout**
The instance tests the connection automatically every time a user opens the LDAP Server form.

Error messages appear on the form if there are any issues connecting to the LDAP server.

**Note:** Employees can also verify connectivity between the instance and the LDAP server. Contact Technical Support for assistance verifying LDAP connectivity.

---

**Automatic LDAP operational status update**
The instance changes the operational status of LDAP servers depending on the result of the connection test.

- If your instance establishes a connection to a server that has a **Operational Status** value of **down**, the **Operational Status** value is automatically changed to **up**. This functionality is supported for both automatic and manual connection tests.
- If a connection cannot be established to a server that has a **Operational Status** value of **up**, the **Operational Status** value is automatically changed to **down**. This functionality is supported for automatic connection tests only, not manual tests.

---

**Define LDAP organizational units**
An organizational unit (OU) definition specifies the LDAP source directories available to the integration.

Role required: admin
OU definitions can contain locations, people, or user groups. Every LDAP server definition contains two sample OU definitions: one for importing groups into the system and the other for users.

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to configure.
3. In the LDAP OU Definitions related list, select either the **Groups** or **Users** sample OU definition.
4. Complete the LDAP OU Definition form (see table).
5. Click Update.
The system automatically tests the connection to the LDAP server.

6. Under **Related Links**, click **Browse** to view the LDAP directory records that the OU definition returns.

---

**OU Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify the name the integration uses when referencing this OU. The name you enter here becomes an LDAP target in the data source record.</td>
</tr>
<tr>
<td>RDN</td>
<td>Specify the relative distinguished name of the subdirectory you want to search. This RDN is combined with the start-searching directory from the LDAP server definition to identify the subdirectory containing information for this organizational unit. For example, the sample OU definition uses the RDN value of <code>CN=Users</code> to search the LDAP directory <code>CN=Users, DC=service-now, DC=com</code> and any directory below this point. This field must match a subdirectory in your LDAP system.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Query field | Specify the name of the attribute within the LDAP server to query for records. The query field must be unique in both single and multiple domain instances. For best results, use email addresses or other credentials that uniquely identify the user in a multiple domain instance. Active Directory uses the `sAMAccountName` attribute. Other LDAP servers tend to use the `cn` attribute.  

**Note:** The **Query field** must map to the **User ID** field in the User (sys_user) table. For example, if an Active Directory user logs in as `joe.example`, there must be a user record with a **User ID** value of `joe.example` and an LDAP record with an **sAMAccountName** value of `joe.example`. |
| Active    | Select this check box to activate the OU definition and to allow administrators to test importing data. However, the integration can only bring data into the system from active OU definitions. |
| Table     | Specify the table that receives the mapped data from your LDAP server. For users, select **User (sys_user)**, and for groups, select **Group (sys_group)**. |
| Filter    | Enter an LDAP filter string to select specific records to import from the OU. The more specific the LDAP filter query, the more efficient the query is.  

For example, the Users LDAP OU definition uses the following filter to select records that are classified as a person, have an `sn` attribute value, are not computers, and are not flagged as inactive:  

```
(&(objectClass=person)(sn=*)(!(objectClass=computer))(!
(userAccountControl:1.2.840.113556.1.4.803:=2)))
```

You can find a description of LDAP filter syntax by searching the internet for LDAP Filters RFC. |

---

**Example organizational unit definitions**

Suppose you have an LDAP server with the following directory structure:

- `dc=my-domain,dc=com`
- `ou=Groups`
  - `cn=Development`
  - `cn=HR`
Further suppose that you want to exclude the HR group and HR users from the application. Do the following:

1. Create an LDAP server record with a starting search directory of dc=my-domain,dc=com.
2. Create an OU definition record for ou=Groups with a filter to exclude cn=HR.
3. Create an OU definition record for ou=Users with a filter to exclude ou=HR.

If you do not specify additional attributes or filters with an OU definition, the LDAP query returns the entire sub-tree from the starting directory and RDN.

In these examples, an OU definition with the RDN value of ou=Groups and no filter would have returned all groups. Likewise, an OU definition with the RDN value of ou=Users and no filter would have returned all users and child organizational units.

Create a data source for LDAP

Each LDAP organizational unit (OU) definition has its own related list of data sources.

Role required: admin

**Note:** Both the LDAP Server and LDAP OU Definition must be active for the test load action to function properly. When the test load is activated for the first time, the system samples up to 20 records to determine the length of the import set fields. If the sampled records do not contain values for the User ID field, the system sets the field length for all subsequent imports to the default length of 40. The import truncates any imported data that exceeds the import set table field length. Additionally, the User ID field is truncated to a maximum of 40 characters. Be aware that the 20 loaded records cannot be transformed and are for testing purposes only. If the test records contain values for the User ID field, the field length is set based on the field length of the longest user ID in the test records.

To create a new data source:

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to configure.
3. In the LDAP OU Definitions related list, select an item, such as Groups or Users.
4. In the Data Sources related list, click New.
5. Complete the Data Source form (see table).
6. Click Submit.
7. Under Related Links, click Test Load 20 Records to test whether the data source can bring LDAP data into the import table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify the name the integration uses when referencing this data source.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Import set table name | Enter the name of the staging table where the system temporarily places the imported LDAP records and attributes. Review this table to view imported LDAP records. You can use the same import set table name for all LDAP data sources.
Type | Select LDAP to indicate the imported data is LDAP data. After you select the type LDAP, the form displays the LDAP target field.
LDAP target | Select the LDAP OU definition associated with this data source.

**LDAP transform maps**
The transform map moves data from the import set table to the target table (User or Group).
The LDAP integration uses standard import sets and transform maps. You can also create custom LDAP transform maps.

**Important:** Whether you select or create custom LDAP transform maps, there should be one active transform map for a set of source and target tables. Enabling multiple transform maps for the same source and target tables can produce duplicate entries in the target table unless you coalesce against the matching fields.

**Default LDAP transform maps**
By default, the system provides two transform maps for LDAP data.

<table>
<thead>
<tr>
<th>Transform Map</th>
<th>Source Table</th>
<th>Target Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP User Import</td>
<td>[ldap_import]</td>
<td>[sys_user]</td>
<td>Default transform map for creating user records from LDAP credentials as part of LDAP on-demand login. Contains mappings for an Active Directory LDAP server.</td>
</tr>
<tr>
<td>LDAP Group Import</td>
<td>[ldap_group_import]</td>
<td>[sys_user_group]</td>
<td>Default transform map for creating group records from LDAP OUs. Contains mappings for an Active Directory LDAP server.</td>
</tr>
</tbody>
</table>

**Note:** By default, the system does not have a transform map for LDAP department records.
Requirements for custom LDAP transform maps

If you choose to create a custom transform map, the transform map must meet the following mapping requirements.

### Requirements for custom LDAP transform maps

<table>
<thead>
<tr>
<th>Source Table</th>
<th>Source Field</th>
<th>Target Table</th>
<th>Target Field</th>
<th>Coalesce</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ldap_import</td>
<td>u_source</td>
<td>sys_user</td>
<td>source</td>
<td>false</td>
<td>The <code>u_source</code> field identifies the LDAP DN of the imported user or group. The system uses this field to determine that a user requires LDAP authentication, to find a user's manager, and to put users into groups.</td>
</tr>
</tbody>
</table>

- Select one of the following fields:
  - `u_samaccountname`
  - `u_dn`
  - `u_cn`

<table>
<thead>
<tr>
<th>Source Table</th>
<th>Source Field</th>
<th>Target Table</th>
<th>Target Field</th>
<th>Coalesce</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ldap_import</td>
<td>Select one of the following fields:</td>
<td>sys_user</td>
<td>user_name</td>
<td>true</td>
<td>If LDAP integrates to Active Directory, select <code>u_samaccountname</code> as the source field. If other LDAP directories are used, select <code>u_dn</code> or <code>u_cn</code> as the source field.</td>
</tr>
</tbody>
</table>

**LDAP data transformation**

If an LDAP attribute contains simple data, the transform map links an imported LDAP attribute to an appropriate field in the target table (User or Group).

For example, sample data in the sAMAccountName attribute maps to the **User ID** field in the User table.

If the imported LDAP data maps to a reference field, the instance searches for an existing matching record. If no matching record exists, the instance creates a new record for the reference field unless the field mapping specifies otherwise.

For example, suppose the LDAP attribute l maps to the **Location** reference field in the User table. Whenever the import brings in an attribute value that does not match an existing location record value, the transform map creates a new location record. The new location record has the same value as the imported attribute, and the imported user record now has a link to the new location record.

However, there are times when LDAP attribute returns a distinguished name (DN), which is essentially a reference to another record within the LDAP directory. For example, the manager attribute typically contains the distinguished name for the manager of the current LDAP directory.
entry. An imported DN typically uses a long text string such as: cn=Beth Anglin,ou=Users,dc=my-domain,dc=com.

Warning: Make sure your target fields are long enough to contain a DN. Many text fields use the default length of 40, which may not be long enough for some DN values. The ServiceNow system truncates any value that exceeds the field length.

Administrators do not typically want the system to create new users from the DN value because the new user has no association with an existing user. Instead, administrators want the import to locate the manager’s existing user record and associate it with the newly imported user. The LDAPUtils script include contains the setManager and processManagers functions that can parse a DN and search for an existing user. For best results, use these functions to create a custom transform map.

For example, the LDAP User Import transform map script calls the setManager function:

```javascript
// The manager coming in from LDAP is the DN value for the manager. // The line of code below will locate the manager that matches the DN value and set it into the target record. If you are not interested in getting the manager from LDAP then remove or comment out the line below
ldapUtils.setManager(source, target);
```

In some cases, the integration imports a user's record before importing the associated manager's user record. To handle such cases, you may want to call the processManagers function after the transform completes. For example, the LDAP User Import transform map uses an onComplete transform script to call the processManagers function:

```javascript
// It is possible that the manager for a user did not exist in the database when // the user was processed and therefore we could not locate and set the manager field. // The processManagers call below will find all those records for which a manager could // not be found and attempt to locate the manager again. This happens at the end of the // import and therefore all users should have been created and we should be able to // locate the manager at this point
ldapUtils.processManagers();
```

Remove or comment out the setManager and processManagers function calls if your LDAP integration does not use the manager attribute.

onStart and onAfter LDAP scripts
Any custom transform map should include onStart and onAfter scripts.

The onStart script should call the LDAPUtils script include and start logging. For example, the LDAP User Import transform map has an onStart script that uses this code:

```javascript
gs.include("LDAPUtils"); var ldapUtils = new LDAPUtils();
ldapUtils.setLog(log);
```

The onAfter script should call the addMembers function. For example:

```javascript
ldapUtils.addMembers(source, target);
```

Scheduled data imports for LDAP
A scheduled import allows administrators to import LDAP data on a regular schedule.

By default, the LDAP integration includes two sample scheduled imports:

- Example LDAP User Import
- Example LDAP Group Import

Neither example is active by default. Change these scheduled imports to meet your company's business needs.

**Auto provision LDAP users**
You automatically provision users who are in the LDAP server but not yet in your instance.

Role required: admin

- Create the following properties in the System Properties (sys_properties) table:

<table>
<thead>
<tr>
<th>LDAP property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ldap.authentication</td>
<td>Enables LDAP authentication by using LDAP to authenticate users. Set this property to true (the default value).</td>
</tr>
<tr>
<td>glide.ldap.user.autoprovision</td>
<td>Enables LDAP the system to automatically create users in the User (sys_user) table when the user exists in LDAP but is not yet in the instance. Set this property to true (the default value).</td>
</tr>
</tbody>
</table>

Both of these properties must be set to true for auto-provisioning to work.

**LDAP import maps**

LDAP import maps match fields in your LDAP database to fields in your instance.

**Note:** LDAP mapping has a performance effect, so the recommended approach is to schedule it during off-peak hours, or process a few records at a time to maintain system availability.

Define a transform map that only imports the needed or required attributes. Depending on the version of the instance you are using, the method for specifying LDAP mapping relationships varies.

The easiest way to know whether or not you are running a version which uses the System LDAP application for LDAP integration is to find the application from the application navigator. The Run Business Rules option is applied only for the target table. Only transform maps associated to the target table run the business rules associated with different tables. If you are updating a user group and have business rules running on a user group table, the group must have roles define.

**LDAP import mapping options**

<table>
<thead>
<tr>
<th>System LDAP application?</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Use a transform map to specify your mapping.</td>
</tr>
<tr>
<td>No</td>
<td>Use a LDAP legacy import map to specify your mapping, or the default LDAP transform that is included in baseline instances. Remember to adjust the Coalesce field to match against the correct fields.</td>
</tr>
</tbody>
</table>
**Differences between LDAP transform maps and legacy import maps**

When specifying LDAP mapping relationships using transform maps, there is a major difference in how reference fields are set for manager and department.

When using a transform map, it is necessary to use a transform script to create references. This is because the value associated with an LDAP attribute like “manager” is the distinguished name (DN) of the manager.

Without some extra logic in place, the result is the creation of a user record with a manager name that is the distinguished name of that user in LDAP. The integration includes a transform script to facilitate the creation of these references. The default transform map “LDAP User Import” includes transform scripts for these references.

**Existing mapping relationships**

When updating legacy import maps to transform maps, you can retain the LDAP mapping relationships that existed prior to the addition of the System LDAP application. The LDAP server has a Map field that is a reference to the legacy import map.

---

**Note:** By default this field is hidden, so you have to configure the form to display it.

---

If you want to transition to using a transform map, clear the reference to the legacy import map.

**LDAP import map settings**

Verify and use attributes to limit the fields the integration imports from the LDAP source. Additionally, it is important to map the user_name field to the LDAP attribute that contains the user’s login ID. For Active Directory this is usually the sAMAccountName attribute. If you would like to import and coalesce on a binary attribute (such as objectSID or objectGUID), you have to create a custom transform script.

---

**Note:** Any value mapped to the user_name field must be unique.

---

If you do not specify a transform map (such as LDAP User Import), the integration uses the following default mappings:

**LDAP import default mapping**

<table>
<thead>
<tr>
<th>User field or variable</th>
<th>LDAP attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>user_name</td>
<td>sAMAccountName</td>
</tr>
<tr>
<td>email</td>
<td>mail</td>
</tr>
<tr>
<td>phone</td>
<td>telephoneNumber</td>
</tr>
<tr>
<td>home_phone</td>
<td>homePhone</td>
</tr>
<tr>
<td>mobile_phone</td>
<td>mobile</td>
</tr>
<tr>
<td>first_name</td>
<td>givenName</td>
</tr>
<tr>
<td>last_name</td>
<td>sn</td>
</tr>
<tr>
<td>title</td>
<td>title</td>
</tr>
<tr>
<td>department</td>
<td>department</td>
</tr>
<tr>
<td>manager</td>
<td>manager</td>
</tr>
<tr>
<td>middle_name</td>
<td>initials</td>
</tr>
</tbody>
</table>
### LDAP import default mapping

If you do not specify a transform map (such as LDAP User Import), the integration uses the following default mappings.

<table>
<thead>
<tr>
<th>User field or variable</th>
<th>LDAP attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_memberof</td>
<td>groups</td>
</tr>
<tr>
<td>u_member</td>
<td>members</td>
</tr>
<tr>
<td>u_manager</td>
<td>manager</td>
</tr>
</tbody>
</table>

### LDAP scripting

These sample scripts automate common LDAP tasks.

Set disabled Active Directory users to inactive

Use the following script to automatically deactivate users when the associated AD user is disabled.

Role required: admin

You can identify disabled Active Directory users by checking the value of the `userAccountControl` attribute. This rule executes whenever the `userAccountControl` value changes and deactivates user accounts if the **User Account Control** signifies a disabled AD account.

Use the following script to automatically deactivate users when the associated AD user is disabled.

1. Configure the User form and create a new integer field called **User Account Control**.
2. Add mapping for `userAccountControl (external)` to the new field.
3. Create a new business rule with the following properties:
Disable AD Users business rule

<table>
<thead>
<tr>
<th>Business rule field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Disable AD Users</td>
</tr>
<tr>
<td>Table</td>
<td>User (sys_user)</td>
</tr>
<tr>
<td>When</td>
<td>Before</td>
</tr>
<tr>
<td>Condition</td>
<td>current.u_user_account_control.changes()</td>
</tr>
</tbody>
</table>

The Script field should contain the following:

```javascript
var disabledFlag = 2;

//perform a bitwise comparison on userAccountControl to see if the 2 bit flag is enabled
if (current.u_user_account_control && disabledFlag) {
    gs.log('Disabling user: ' + current.user_name + 'userAccountControl=' +
    current.u_user_account_control);
    current.active='false';
    current.locked_out='true';
}
```

Assign LDAP field values
You can use a script to assign a value to any field for which there is a field mapping.

For example, to assign a value to the sys_user.company field, create a field map for the company field and add a transform script of:

```javascript
company = "Don's Sporting Goods";
```

Exclude particular LDAP users
If you cannot completely filter the LDAP user list using LDAP filter properties, you can exclude users with a map script.

After you have run the logic to identify a user that should not be imported, set the user_name field to an empty string and this user will not be imported.

```javascript
user_name='';
```

One way to identify users to filter out is to look for a string in the distinguishedName attribute. For example, this script excludes accounts that are not in a Users OU. You might use this script if you have too many Users OU to include in the target OU LDAP Option.

```javascript
//vdn is a variable mapped to distinguishedName
gs.include("LDAPUtils");
var vdn = source.getElement(this.distinguishedName);
if (vdn.indexOf('OU=Users')<0) {
    user_name='';
    gs.log('LDAP Import Skipping User: ' + vdn);
}
```

A more complex method of filtering is to use regular expressions.

```javascript
//vcn is a variable mapped to cn
//vdn is a variable mapped to distinguishedName
//c is the regular expression string
gs.include("LDAPUtils");
var vdn = source.getElement(this.distinguishedName);
```
```javascript
var vcn = source.getElementById(this.cn);
var c = /^[a-z][a-z][a-z][0-9][0-9][0-9]$/;
var nvcn = vcn.toLowerCase();
// test to see if the cn is in the form of 3 letters followed by 3 numbers,
// only import these
if (c.test(nvcn)) {
    user_name = nvcn;
} else {
    gs.log("LDAP import rejected username: " + vcn + " for DN: " + vdn);
    user_name = "";
}
```

Verify LDAP mapping
After creating an LDAP transform map, refresh the LDAP data to verify the transform map works as expected.

Role required: admin

1. Navigate to System LDAP > Scheduled Loads.
2. Click your LDAP import job.
3. Click Execute Now.

Record creation options during an LDAP transform
Administrators can specify when to create new records based on changes from incoming LDAP records.

If the LDAP transform map updates a field in the import set table, the integration automatically creates a new record whenever there is a new record in the LDAP data. If the LDAP transform map updates a reference field storing data from another table, the administrator can choose to create, ignore, or reject new LDAP records.

For example, if the integration receives a new department record that does not match any existing department, you may want to update all of the other LDAP record fields without creating a new department record in the instance. The transform map allows you to set the record creation options for each reference field.

Set choice action in the LDAP transform map
The LDAP transform map determines how fields in the Import Set table map to fields in existing tables such as Incident or User.

Role required: admin

1. Navigate to System LDAP > Transform Maps.
2. Select one of the following actions from the Choice action field:
   - create – creates a new reference field record if a matching record does not exist.
   - ignore – ignores new records in the reference field and completes processing of all other fields in the transform map.
   - reject – stops the transform for the entire record.

Note: The field map only displays the Choice action field for reference fields.

LDAP integration via MID Server
Administrators can integrate using an LDAP data source over a Management, Instrumentation, and Discovery (MID) Server.

The MID Server facilitates communication and movement of data between the platform and external applications, data sources, and services. The MID Server is installed automatically for new instances.
You can use the MID Server to import data over LDAP, but you cannot use the MID Server for LDAP authentication. A MID Server does not support SSL connections.

Using a MID Server to establish an LDAP connection prevents you from having to expose the LDAP server to external network traffic. It also eliminates the need to establish a VPN tunnel between your LDAP server and data centers.

**Note:**
- The MID Server user must have the user_admin role in order to be able to read LDAP server configuration records.
- The following are not available with the MID Server:
  - LDAP authentication
  - SSL connection
  - Using the UI action **Refresh from LDAP** to refresh user and group records from LDAP

---

**Set up LDAP integration via MID Server**

Setting up an LDAP integration via MID Server involves several steps.

**Role required:** admin

1. **Define the LDAP server**
2. **Configure the LDAP server**
   - Provide LDAP server login credentials.
   - Enable a listener.
   - Specify attributes for improving performance or security.
3. **Set up communication between the LDAP and MID Servers**
4. **Define organizational units (OUs) on the LDAP server**
5. **Create a data source**
   - Create a transform map or select an existing transform map.
   - Transform LDAP data into data types that the instance supports.
   - Include **onStart** and **onAfter scripts** in a custom transform map.
6. **Create and execute a scheduled data import**
7. **Test an LDAP connection manually**

**Define an LDAP server**

Create a new LDAP server record in the instance.

**Role required:** admin

1. Navigate to **System LDAP > Create New Server**.
2. Fill in the form fields.
3. Click **Submit**.

   **Note:** You can also modify an existing LDAP server record by navigating to **System LDAP > LDAP Servers** and making the needed changes.

4. Make changes to the fields as necessary.

Configure an LDAP server

After an LDAP server record exists, you can configure login credentials, enable a listener, and add attributes to the LDAP server that can be used to improve server performance and security.

Role required: admin

1. **Provide LDAP server login credentials.**
2. **Enable a listener.**
3. **Specify attributes to improve performance and security.**

Provide LDAP server login credentials
The LDAP login credentials determine what organizational units the integration can see.

Role required: admin

Servers that allow anonymous login generally limit the organizational unit (OU) data available to anonymous connections.

1. Navigate to **System LDAP > LDAP Servers.**
2. Select the LDAP server to configure.
3. In **Login distinguished name**, enter the user credentials for an account with read access to the directory levels from which you want to import users or groups. The system uses these credentials to connect to your LDAP server.

To access an LDAP directory server, the username must be in the full distinguished name format:

- servicenow@service-now.com

4. In **Login password**, enter the password for the LDAP user.

   **Note:** Consider enabling LDAPS to encrypt this password during transmission.

5. Select the **Active** check box.
6. (Optional) In the **Starting search directory** field, explicitly specify the LDAP OU attributes you want the instance to import.
7. Click **Update**.

   **Note:** If you provide an LDAP password, the integration performs a Simple Bind operation. If you do not provide an LDAP password, the LDAP server must allow anonymous login or the integration cannot bind to the LDAP server.

Enable an LDAP listener
Enabling a listener is optional. If enabled, a listener notifies the system to process LDAP records soon after there is an update on the LDAP server.

Role required: admin

A **listener** is a dedicated process that periodically searches for changes on the LDAP server.

The listener can be deployed on a Microsoft Active Directory server that supports persistent queries (ADNotify), or on an LDAP server that supports persistent search request control (with OID 2.16.840.1.113730.3.4.3).

To enable a listener:

1. Navigate to **System LDAP > LDAP Servers.**
2. Select the LDAP server to configure.
3. Select the **Listener** check box.
4. Click **Update**.

   **Note:**
   The system only imports user records that match the LDAP OU filter. Incoming user records that do not meet the filter requirements are flagged as invalid and ignored by
the import. Administrators can enable verbose LDAP logging to determine if incoming records are not matching the LDAP OU filter.

Specify LDAP attributes
Specify the attributes included in LDAP server queries using the LDAP server Attributes field. This can enhance performance as well as security.

Role required: admin

By default, the system loads all of the attributes for each object that it has permission to read from your LDAP server. Using the Attributes field, you can specify and thereby limit the attributes the LDAP query returns. Using this approach for large LDAP imports can greatly improve the speed of those imports.

Explicitly define attributes where possible. If there is information that you do not want exposed to the instance, exclude the attribute.

If you do not specify LDAP server attributes, user transactions may freeze for extended periods of time when new attributes are added to an LDAP server object because the system will be busy loading data from the new attributes.

**Note:** To use the manager lookup scripts described in Select or Create a Transform Map for LDAP Data, specify manager and dn (distinguished name) in the Attributes field. Neither attribute is required to be a part of a transform map.
Set up communication between LDAP and MID servers
Configure your LDAP and MID servers to communicate with each other.

Role required: admin

A MID Server connection communicates over HTTP on port 80 by default. This communication channel does not require a certificate. The connection between the MID Server and the instance is over HTTPS (port 443).

An instance can connect to an LDAP server via the MID Server. When you do this, the instance communicates with the MID Server via HTTPS, and the MID Server communicates with the LDAP server via LDAP (port 389). The instance can also connect to the LDAP server directly, using LDAP or LDAPS, either over the internet or through a VPN tunnel.

**Note:** LDAP cannot communicate via the MID Server with password authentication.

To set connection properties for a specific LDAP server:

1. Navigate to **System LDAP > LDAP Servers**.
2. Select the LDAP server to configure.
3. Set the connection property fields (see table).
4. Click **Update**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the server.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box if the server is active.</td>
</tr>
<tr>
<td>LDAP Server URLs</td>
<td>Enter the URLs of the primary and backup LDAP servers. Servers are first ordered by operational status, with servers that are Up listed first, then ordered by the Order value that you specify. The first server listed is the primary LDAP server. The others are redundant servers.</td>
</tr>
<tr>
<td>Server URL</td>
<td>Enter the URL of the server. Configure the form to add this field if necessary. It is a calculated read-only field that shows the list of LDAP servers that you can also see in the <strong>LDAP Server URLs</strong> field, separated by a space, and ordered by operational status and the order values of the URLs.</td>
</tr>
</tbody>
</table>
| Login distinguished name | Enter the distinguished name (DN) of the user authenticating the LDAP connection. To access an LDAP directory server, the username must be in the full distinguished name format:  
  - servicenow@service-now.com |
| Login password         | Enter the server's password.                                                                                                                  |
| Starting search directory | Enter the relative distinguished name (RDN) of the default search directory. All queries to this LDAP server will start from this RDN.             |
| MID Server             | Select the MID Server you want to use to connect to the LDAP server. Using a MID Server to establish an LDAP connection prevents you from having to expose the LDAP server to external network traffic. It also eliminates the need to establish a VPN tunnel between your LDAP server and ServiceNow data centers. Note:  
  - The MID Server user must have the user_admin role in order to be able to read LDAP server configuration records.  
  - The following are not available with the MID Server:  
    - LDAP authentication  
    - SSL connection |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect timeout</td>
<td>If a MID Server is configured, the connection times out after 10 seconds, regardless of this setting. This setting is hard-coded and cannot be altered.</td>
</tr>
<tr>
<td>Read timeout</td>
<td>Specify the number of seconds the integration has to read LDAP data. The integration stops reading LDAP data after the connection exceeds the read timeout. If you enable an SSL connection, you can also set a read timeout value with the <code>com.glide.ssl.read.timeout</code> system property. If you enter timeout values for both this field and the system property, the lowest timeout value takes precedence.</td>
</tr>
<tr>
<td>SSL</td>
<td>Select this check box to require the LDAP server to make an SSL-encrypted connection. For more information, see Enable SSL. If you selected a MID Server, this field is not available.</td>
</tr>
<tr>
<td>Listener</td>
<td>Select this check box to enable the integration to periodically poll Microsoft Active Directory servers or LDAP servers that support persistent search request control. Additionally, if you selected a MID Server, the listener functionality is available for that MID Server. See <a href="#">LDAP listener</a> and <a href="#">Enable an LDAP listener</a> for more information.</td>
</tr>
<tr>
<td>Listen interval (timeout value)</td>
<td>Specify the listener timeout value in the number of minutes that the integration listens for LDAP data with every connection. The integration stops listening for LDAP data after the connection exceeds the listen interval.</td>
</tr>
<tr>
<td>Paging</td>
<td>Select this check box to have the LDAP server split up LDAP attribute data into multiple result sets rather than submit multiple queries.</td>
</tr>
</tbody>
</table>

**Test communication between LDAP and MID Servers**

The instance tests the connection automatically every time a user opens the LDAP Server form.

Role required: admin

The instance supports an LDAP connection timeout of 29 seconds or less. Error messages appear on the form if there are any issues connecting to the LDAP server.

Employees can also verify connectivity between the instance and the LDAP server. Contact Technical Support for assistance verifying LDAP connectivity.

**Configure LDAP connection monitoring**

Change or disable LDAP connection monitoring and notifications.

Role required: admin

The instance automatically sends an email to users configured in the LDAP Admins group when an LDAP server connection fails. This uses the email notification, which is launched by the LDAP Connection Test scheduled job. This email notification is enabled by default.
By default, the scheduled job tests the connection every 15 minutes. To change this interval or disable monitoring:

1. Navigate to System Definition > Scheduled Jobs.
2. Open LDAP Connection Test.
3. Do one of the following:
   - Change the interval in the Repeat Interval field.
   - Disable monitoring by clearing the Active check box.

Define LDAP organizational units
An organizational unit (OU) definition specifies the LDAP source directories available to the integration.

Role required: admin

OU definitions can contain locations, people, or user groups. Every LDAP server definition contains two sample OU definitions: one for importing groups into the system and the other for users.

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to configure.
3. In the LDAP OU Definitions related list, select either the Groups or Users sample OU definition.
4. Complete the LDAP OU Definition form (see table).
5. Click Update.
   The system automatically tests the connection to the LDAP server.
6. Under Related Links, click Browse to view the LDAP directory records that the OU definition returns.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify the name the integration uses when referencing this OU. The name you enter here becomes an LDAP target in the data source record.</td>
</tr>
<tr>
<td>RDN</td>
<td>Specify the relative distinguished name of the subdirectory you want to search. This RDN is combined with the start-searching directory from the LDAP server definition to identify the subdirectory containing information for this organizational unit. For example, the sample OU definition uses the RDN value of CN=Users to search the LDAP directory CN=Users,DC=service-now,DC=com and any directory below this point. This field must match a subdirectory in your LDAP system.</td>
</tr>
<tr>
<td>Query field</td>
<td>Specify the name of the attribute within the LDAP server to query for records. The query field must be unique in both single and multiple domain instances. For best results, use email addresses or other credentials that uniquely identify the user in a multiple domain instance. Active Directory uses the sAMAccountName attribute. Other LDAP servers tend to use the cn attribute.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to activate the OU definition and to allow administrators to test importing data. However, the integration can only bring data into the system from active OU definitions.</td>
</tr>
<tr>
<td>Table</td>
<td>Specify the table that receives the mapped data from your LDAP server. For users, select User (sys_user), and for groups, select Group (sys_group).</td>
</tr>
</tbody>
</table>

Note: The **Query field** must map to the **User ID** field in the User (sys_user) table. For example, if an Active Directory user logs in as joe.example, there must be a user record with a **User ID** value of joe.example and an LDAP record with an sAMAccountName value of joe.example.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Enter an LDAP filter string to select specific records to import from the OU. The more specific the LDAP filter query, the more efficient the query is. For example, the Users LDAP OU definition uses the following filter to select records that are classified as a person, have an <code>sn</code> attribute value, are not computers, and are not flagged as inactive: <code>(&amp;(objectClass=person)(sn=*)(!(objectClass=computer))(!(!userAccountControl:1.2.840.113556.1.4.803:=2)))</code>. You can find a description of LDAP filter syntax by searching the internet for LDAP Filters RFC.</td>
</tr>
</tbody>
</table>

**Example organizational unit definitions**

Suppose you have an LDAP server with the following directory structure:
- `dc=my-domain,dc=com`
  - `ou=Groups`
    - `cn=Development`
    - `cn=HR`
    - `cn=Sales`
  - `ou=Users`
    - `ou=Development`
    - `ou=HR`
    - `ou=Sales`

Further suppose that you want to exclude the HR group and HR users from the application. Do the following:

1. Create an LDAP server record with a starting search directory of `dc=my-domain,dc=com`.
2. Create an OU definition record for `ou=Groups` with a filter to exclude `cn=HR`.
3. Create an OU definition record for `ou=Users` with a filter to exclude `ou=HR`.

If you do not specify additional attributes or filters with an OU definition, the LDAP query returns the entire sub-tree from the starting directory and RDN.

In these examples, an OU definition with the RDN value of `ou=Groups` and no filter would have returned all groups. Likewise, an OU definition with the RDN value of `ou=Users` and no filter would have returned all users and child organizational units.

Create a data source for LDAP
- Each LDAP organizational unit (OU) definition has its own related list of data sources.

Role required: admin
Note: Both the LDAP Server and LDAP OU Definition must be active for the test load action to function properly. When the test load is activated for the first time, the system samples up to 20 records to determine the length of the import set fields. If the sampled records do not contain values for the User ID field, the system sets the field length for all subsequent imports to the default length of 40. The import truncates any imported data that exceeds the import set table field length. Additionally, the User ID field is truncated to a maximum of 40 characters. Be aware that the 20 loaded records cannot be transformed and are for testing purposes only. If the test records contain values for the User ID field, the field length is set based on the field length of the longest user ID in the test records.

To create a new data source:

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to configure.
3. In the LDAP OU Definitions related list, select an item, such as Groups or Users.
4. In the Data Sources related list, click New.
5. Complete the Data Source form (see table).
6. Click Submit.
7. Under Related Links, click Test Load 20 Records to test whether the data source can bring LDAP data into the import table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify the name the integration uses when referencing this data source.</td>
</tr>
<tr>
<td>Import set table name</td>
<td>Enter the name of the staging table where the system temporarily places the imported LDAP records and attributes. Review this table to view imported LDAP records. You can use the same import set table name for all LDAP data sources.</td>
</tr>
<tr>
<td>Type</td>
<td>Select LDAP to indicate the imported data is LDAP data. After you select the type LDAP, the form displays the LDAP target field.</td>
</tr>
<tr>
<td>LDAP target</td>
<td>Select the LDAP OU definition associated with this data source.</td>
</tr>
</tbody>
</table>

LDAP transform maps

The transform map moves data from the import set table to the target table (User or Group).

The LDAP integration uses standard import sets and transform maps. You can also create custom LDAP transform maps.

Important: Whether you select or create custom LDAP transform maps, there should be one active transform map for a set of source and target tables. Enabling multiple transform maps for the same source and target tables can produce duplicate entries in the target table unless you coalesce against the matching fields.

Default LDAP transform maps

By default, the system provides two transform maps for LDAP data.
Default LDAP transform maps

<table>
<thead>
<tr>
<th>Transform Map</th>
<th>Source Table</th>
<th>Target Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP User Import</td>
<td>[ldap_import]</td>
<td>[sys_user]</td>
<td>Default transform map for creating user records from LDAP credentials as part of LDAP on-demand login. Contains mappings for an Active Directory LDAP server.</td>
</tr>
<tr>
<td>LDAP Group Import</td>
<td>[ldap_group_import]</td>
<td>[sys_user_group]</td>
<td>Default transform map for creating group records from LDAP OUs. Contains mappings for an Active Directory LDAP server.</td>
</tr>
</tbody>
</table>

**Note:** By default, the system does not have a transform map for LDAP department records.

Requirements for custom LDAP transform maps

If you choose to create a custom transform map, the transform map must meet the following mapping requirements.

<table>
<thead>
<tr>
<th>Source Table</th>
<th>Source Field</th>
<th>Target Table</th>
<th>Target Field</th>
<th>Coalesce</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ldap_import</td>
<td>u_source</td>
<td>sys_user</td>
<td>source</td>
<td>false</td>
<td>The <strong>u_source</strong> field identifies the LDAP DN of the imported user or group. The system uses this field to determine that a user requires LDAP authentication, to find a user’s manager, and to put users into groups.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Source Field</td>
<td>Target Table</td>
<td>Target Field</td>
<td>Coalesce</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>--------------</td>
<td>--------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ldap_import  | Select one of the following fields:  
· u_samaccountname  
· u_dn  
· u_cn | sys_user | user_name | true | If LDAP integrates to Active Directory, select **u_samaccountname** as the source field. If other LDAP directories are used, select **u_dn** or **u_cn** as the source field.|

LDAP data transformation

If an LDAP attribute contains simple data, the transform map links an imported LDAP attribute to an appropriate field in the target table (User or Group).

For example, sample data in the sAMAccountName attribute maps to the **User ID** field in the User table.

If the imported LDAP data maps to a reference field, the instance searches for an existing matching record. If no matching record exists, the instance creates a new record for the reference field unless the field mapping specifies otherwise.

For example, suppose the LDAP attribute l maps to the **Location** reference field in the User table. Whenever the import brings in an attribute value that does not match an existing location record value, the transform map creates a new location record. The new location record has the same value as the imported attribute, and the imported user record now has a link to the new location record.

However, there are times when LDAP attribute returns a distinguished name (DN), which is essentially a reference to another record within the LDAP directory. For example, the manager attribute typically contains the distinguished name for the manager of the current LDAP directory entry. An imported DN typically uses a long text string such as: **cn=Beth Anglin,ou=Users,dc=my-domain,dc=com**.

**Warning:** Make sure your target fields are long enough to contain a DN. Many text fields use the default length of 40, which may not be long enough for some DN values. The ServiceNow system truncates any value that exceeds the field length.

Administrators do not typically want the system to create new users from the DN value because the new user has no association with an existing user. Instead, administrators want the import to locate the manager’s existing user record and associate it with the newly imported user. The LDAPUtils script include contains the **setManager** and **processManagers** functions that can parse a DN and search for an existing user. For best results, use these functions to create a custom transform map.

For example, the **LDAP User Import** transform map script calls the **setManager** function:

```plaintext
//
// The manager coming in from LDAP is the DN value for the manager.  
// The line of code below will locate the manager that matches the  
// DN value and set it into the target record.  If you are not  
// interested in getting the manager from LDAP then remove or  
// comment out the line below
```
In some cases, the integration imports a user's record before importing the associated manager's user record. To handle such cases, you may want to call the `processManagers` function after the transform completes. For example, the **LDAP User Import** transform map uses an `onComplete` transform script to call the `processManagers` function.

```javascript
ldapUtils.setManager(source, target);
```

// It is possible that the manager for a user did not exist in the database when the user was processed and therefore we could not locate and set the manager field. The `processManagers` call below will find all those records for which a manager could not be found and attempt to locate the manager again. This happens at the end of the import and therefore all users should have been created and we should be able to locate the manager at this point.

```javascript
ldapUtils.processManagers();
```

Scheduled data imports for LDAP

A scheduled import allows administrators to import LDAP data on a regular schedule.

By default, the LDAP integration includes two sample scheduled imports:

- Example LDAP User Import
- Example LDAP Group Import

Neither example is active by default. Change these scheduled imports to meet your company's business needs.

Import binary data through a MID Server

As an administrator, you can import binary large object (BLOB) data with an LDAP integration through the MID Server.

Role required: admin

Use the examples in the following steps to add choice tables, notes, tables, figures, step results, and postrequisites to the task.

1. Add the name of the LDAP column you want to import binary data from to the system property `glide.ldap.binary_attributes`.
2. Add a MID Server property with the Name `glide.ldap.binary_attributes` and the same value you set for the system property.

Create a concept topic to introduce the background needed to perform this process or task.

Troubleshooting LDAP integration via MID Server

You may encounter issues in the following areas while integrating LDAP via MID Server.

You can troubleshoot these issues by viewing the outputs found in the External Communication Channel (ECC) Queue (Discovery > Output and Artifacts > ECC Queue).

**Test Connection Issues**

When defining OUs within the server, there is a **Test connection** related list that is used to verify the LDAP connection. When you click this link, the ECC Queue should show a single output message with a topic name of `LDAPConnectionTesterProbe`. After the test has completed on the MID Server, the ECC Queue should show an input message with the same topic name. If the **Name** column for the input message shows **true**, the test was successful. Drill down into the record to view the payload and ensure it does not contain error messages.
Browse Issues

When defining OUs within the server, there is a Browse related list that is used to view the LDAP directory records that the OU definition returns. When you click this link, the ECC Queue should show a single output message with a topic name of LDAPBrowseProbe. After data has been returned from the MID Server, the ECC Queue should show an input message with the same topic name. If the Name column for the input message shows true, the test was successful. Drill down into the record to view the payload and ensure it does not contain error messages.

Load Import Issues

When uploading data (for example, using the Test Load 20 Records feature), the ECC Queue should show a single output message with a topic name of LDAPProbe. After data has been returned from the MID Server, the ECC Queue should show another input message called LDAPProbeCompleted. The Name column for this input message shows the total number of records returned.

An additional input messages, also named LDAPProbe, is displayed. The Name column for this input message displays the highest record number in the batch. If the total number of records returned is 258 and the batch size is 200 (the default), two LDAPProbe (200, 258) incoming messages will be received, and one LDAPProbeCompleted (258) incoming message will be received.

Drill down into the record to view the payload and ensure it does not contain error messages.

Import Load

Also keep an eye out for an output message called LDAPProbeError.

Error message

Click the link in the Name column to view the details of the error.
LDAP paging

LDAP paging does not work if the paging size on the LDAP server is less than 1000. Set the MID Server property `glide.ldap.max_results` to a value less than or equal to the LDAP server paging size.

LDAP fails to import binary data

To import binary data via LDAP, such as a user photo, you must include the binary attribute in the MID Server property `glide.ldap.binary_attributes`. For the user photo example, the attribute may be `jpegphoto`.

LDAP integration troubleshooting

If you are integrating your LDAP server and have questions, these items may help you troubleshoot the issue.

Preliminary checks

- If the LDAP is unavailable, users cannot log in to the instance. A good practice is to have local accounts for administrators so that if the LDAP is down, administrators can still access the instance.
- Check the service account to ensure that it is not expired or locked out.
- Check the format of the username. Instead of using just the username, try using the domain with the username, or username@domain.
- Verify that you have changed the `system_id` entry on the `ldap_server_config` record. If you modify the `system_id` unintentionally with an update set, `system_id` points to the wrong node for the target instance and does not work.

Error codes

The LDAP log file lists industry standard error codes for both LDAP and Active Directory (AD). The LDAP log file is contained in the wrapper file. The LDAP error codes are two-digit numbers, while the Active Directory error codes are three-digit numbers. For a list of the most-common error codes, see [LDAP Error Codes](#).

Multiple domain integration

You can integrate multiple domains within the same forest or in completely non-trusted domains. It is recommended that you create a separate `LDAP server record` for each domain. Each LDAP server record must point to a domain controller for that given domain. This means you will have to allow connections to each of the domain controllers. Multiple AD forests through LDAP with one LDAP account is not supported.

When you expand to more than one domain, it is critical that you identify unique LDAP attributes for the application usernames and import coalesce values. A common unique coalesce attribute for Active Directory is `objectSid`. Unique usernames will vary based on your LDAP data design. Common unique attributes are `email` or `userPrincipalName`.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Incoming records

See [Record creation options during an LDAP transform](#) to set how the integration processes incoming LDAP records that are missing matching values in reference fields.

Common authentication errors

- User Cannot Log In (Invalid DN)
- Invalid CN
- Invalid Connection

Automatic LDAP connection tests

You can manually test connections to LDAP servers or allow ServiceNow to automatically test the connections.

The system tests the connection automatically:

- Every time a user opens the LDAP Server form
- Through the LDAP Connection Test scheduled job, which runs every 15 minutes by default.

You can change how often this scheduled job runs. If this scheduled job is not able to establish a connection, a new one-time schedule job retries the connection test after either five minutes, or half the Repeat Interval value in the scheduled job, whichever occurs first.

Error messages appear on the form if there are any issues connecting to the LDAP server. Also supported are test connections for servers behind a MID server.

Troubleshooting LDAP integration via MID Server

You may encounter issues in the following areas while integrating LDAP via MID Server.

You can troubleshoot these issues by viewing the outputs found in the External Communication Channel (ECC) Queue ([Discovery > Output and Artifacts > ECC Queue](#)).

Test Connection Issues

When defining OUs within the server, there is a Test connection related list that is used to verify the LDAP connection. When you click this link, the ECC Queue should show a single output message with a topic name of LDAPConnectionTesterProbe. After the test has completed on the MID Server, the ECC Queue should show an input message with the same topic name. If the Name column for the input message shows true, the test was successful. Drill down into the record to view the payload and ensure it does not contain error messages.

Browse Issues

When defining OUs within the server, there is a Browse related list that is used to view the LDAP directory records that the OU definition returns. When you click this link, the ECC Queue should show a single output message with a topic name of LDAPBrowseProbe. After data has been returned from the MID Server, the ECC Queue should show an input message with the same topic.
name. If the Name column for the input message shows true, the test was successful. Drill down into the record to view the payload and ensure it does not contain error messages.

**Load Import Issues**

When uploading data (for example, using the Test Load 20 Records feature), the ECC Queue should show a single output message with a topic name of LDAPProbe.

After data has been returned from the MID Server, the ECC Queue should show another input message called LDAPProbeCompleted. The Name column for this input message shows the total number of records returned.

An additional input messages, also named LDAPProbe, is displayed. The Name column for this input message displays the highest record number in the batch. If the total number of records returned is 258 and the batch size is 200 (the default), two LDAPProbe (200, 258) incoming messages will be received, and one LDAPProbeCompleted (258) incoming message will be received.

Drill down into the record to view the payload and ensure it does not contain error messages.

**Import Load**

Also keep an eye out for an output message called LDAPProbeError.

**Error message**

Click the link in the Name column to view the details of the error.

**LDAP paging**

LDAP paging does not work if the paging size on the LDAP server is less than 1000. Set the MID Server property glide.ldap.max_results to a value less than or equal to the LDAP server paging size.

**LDAP fails to import binary data**

To import binary data via LDAP, such as a user photo, you must include the binary attribute in the MID Server property glide.ldap.binary_attributes. For the user photo example, the attribute may be jpegphoto.

**Test an LDAP connection manually**

You can manually test the connection to the LDAP server from the LDAP server form.

Role required: admin

1. Navigate to System LDAP > LDAP Servers.
2. Select the LDAP server to test.
3. Under Related Links, click Test connection.
4. Under Related Links, click Browse to verify that the appropriate LDAP directory structure is visible to the system.
5. (Optional) If the connection was successful, click Browse to view the source LDAP directory structure that is visible to the instance.

Note:

The Filter and RDN fields on the left of the Browse window are ignored when you use the search field on the right.

LDAP error codes

The LDAP Log file lists industry standard error codes for both LDAP and Active Directory (AD).

### Standard error codes

<table>
<thead>
<tr>
<th>Error / data code</th>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>LDAP_SUCCESS</td>
<td>Indicates the requested client operation completed successfully.</td>
</tr>
<tr>
<td>2</td>
<td>LDAP_PROTOCOL_ERROR</td>
<td>Indicates that the server has received an invalid or malformed request from the client.</td>
</tr>
<tr>
<td>3</td>
<td>LDAP_TIMELIMIT_EXCEEDED</td>
<td>Indicates that the operation's time limit specified by either the client or the server has been exceeded. On search operations, incomplete results are returned.</td>
</tr>
<tr>
<td>4</td>
<td>LDAP_SIZELIMIT_EXCEEDED</td>
<td>Indicates that in a search operation, the size limit specified by the client or the server has been exceeded. Incomplete results are returned.</td>
</tr>
<tr>
<td>5</td>
<td>LDAP_COMPARE_FALSE</td>
<td>Does not indicate an error condition. Indicates that the results of a compare operation are false.</td>
</tr>
<tr>
<td>6</td>
<td>LDAP_COMPARE_TRUE</td>
<td>Does not indicate an error condition. Indicates that the results of a compare operation are true.</td>
</tr>
<tr>
<td>7</td>
<td>LDAP_AUTH_METHOD_NOT_SUPPORTED</td>
<td>Indicates that during a bind operation the client requested an authentication method not supported by the LDAP server.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>LDAP_STRONG_AUTH_REQUIRED</td>
<td>Indicates one of the following: In bind requests, the LDAP server accepts only strong authentication. In a client request, the client requested an operation such as delete that requires strong authentication. In an unsolicited notice of disconnection, the LDAP server discovers the security protecting the communication between the client and server has unexpectedly failed or been compromised.</td>
</tr>
<tr>
<td>9</td>
<td>LDAP_REFERRAL</td>
<td>Does not indicate an error condition. In LDAPv3, indicates that the server does not hold the target entry of the request, but that the servers in the referral field may.</td>
</tr>
<tr>
<td>10</td>
<td>LDAP_ADMINLIMIT_EXCEEDED</td>
<td>Indicates that an LDAP server limit set by an administrative authority has been exceeded.</td>
</tr>
<tr>
<td>11</td>
<td>LDAP_UNAVAILABLE_CRITICAL_EXT</td>
<td>Indicates that the LDAP server was unable to satisfy a request because one or more critical extensions were not available. Either the server does not support the control or the control is not appropriate for the operation type.</td>
</tr>
<tr>
<td>12</td>
<td>LDAP_CONFIDENTIALITY_REQUIRED</td>
<td>Indicates that the session is not protected by a protocol such as Transport Layer Security (TLS), which provides session confidentiality.</td>
</tr>
<tr>
<td>13</td>
<td>LDAP_SASL_BIND_IN_PROGRESS</td>
<td>Does not indicate an error condition, but indicates that the server is ready for the next step in the process. The client must send the server the same SASL mechanism to continue the process.</td>
</tr>
<tr>
<td>14</td>
<td>LDAP_UNDEFINED_TYPE</td>
<td>Not used.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>18</td>
<td>LDAP_INAPPROPRIATE_MATCHING</td>
<td>Indicates that the matching rule specified in the search filter does not match a rule defined for the attribute's syntax.</td>
</tr>
<tr>
<td>19</td>
<td>LDAP_CONSTRAINT_VIOLATION</td>
<td>Indicates that the attribute value specified in a modify, add, or modify DN operation violates constraints placed on the attribute. The constraint can be one of size or content (string only, no binary).</td>
</tr>
<tr>
<td>20</td>
<td>LDAP_TYPE_OR_VALUE_EXISTS</td>
<td>Indicates that the attribute value specified in a modify or add operation already exists as a value for that attribute.</td>
</tr>
<tr>
<td>21</td>
<td>LDAP_INVALID_SYNTAX</td>
<td>Indicates that the attribute value specified in an add, compare, or modify operation is an unrecognized or invalid syntax for the attribute.</td>
</tr>
<tr>
<td>22-31</td>
<td></td>
<td>Not used.</td>
</tr>
<tr>
<td>32</td>
<td>LDAP_NO_SUCH_OBJECT</td>
<td>Indicates the target object cannot be found. This code is not returned on following operations: Search operations that find the search base but cannot find any entries that match the search filter. Bind operations.</td>
</tr>
<tr>
<td>33</td>
<td>LDAP_ALIAS_PROBLEM</td>
<td>Indicates that an error occurred when an alias was dereferenced.</td>
</tr>
<tr>
<td>34</td>
<td>LDAP_INVALID_DN_SYNTAX</td>
<td>Indicates that the syntax of the DN is incorrect. (If the DN syntax is correct, but the LDAP server's structure rules do not permit the operation, the server returns code 53: LDAP_UNWILLING_TO_PERFORM.)</td>
</tr>
<tr>
<td>35</td>
<td>LDAP_IS_LEAF</td>
<td>Indicates that the specified operation cannot be performed on a leaf entry. (This code is not currently in the LDAP specifications, but is reserved for this constant.)</td>
</tr>
<tr>
<td>36</td>
<td>LDAP_ALIAS_DEREF_PROBLEM</td>
<td>Indicates that during a search operation, either the client does not have access rights to read the aliased object's name or dereferencing is not allowed.</td>
</tr>
<tr>
<td>37-47</td>
<td></td>
<td>Not used.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>48</td>
<td>LDAP_INAPPROPRIATE_AUTH</td>
<td>Indicates that during a bind operation, the client is attempting to use an authentication method that the client cannot use correctly. For example, either of the following cause this error: The client returns simple credentials when strong credentials are required...OR...The client returns a DN and a password for a simple bind when the entry does not have a password defined.</td>
</tr>
<tr>
<td>49</td>
<td>LDAP_INVALID_CREDENTIALS</td>
<td>Indicates that during a bind operation one of the following occurred: The client passed either an incorrect DN or password, or the password is incorrect because it has expired, intruder detection has locked the account, or another similar reason. See the data code for more information.</td>
</tr>
<tr>
<td>49 / 52e</td>
<td>AD_INVALID CREDENTIALS</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext error, which is returned when the username is valid but the combination of password and user credential is invalid. This is the AD equivalent of LDAP error code 49.</td>
</tr>
<tr>
<td>49 / 525</td>
<td>USER NOT FOUND</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is returned when the username is invalid.</td>
</tr>
<tr>
<td>49 / 530</td>
<td>NOT_PERMITTED_TO_LOGON_AT_THIS_TIME</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is logon failure caused because the user is not permitted to log on at this time. Returns only when presented with a valid username and valid password credential.</td>
</tr>
<tr>
<td>49 / 531</td>
<td>RESTRICTED_TO_SPECIFIC_MACHINES</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is logon failure caused because the user is not permitted to log on from this computer. Returns only when presented with a valid username and valid password credential.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>49 / 532</td>
<td>PASSWORD_EXPIRED</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is a logon failure. The specified account password has expired. Returns only when presented with valid username and password credential.</td>
</tr>
<tr>
<td>49 / 533</td>
<td>ACCOUNT_DISABLED</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is a logon failure. The account is currently disabled. Returns only when presented with valid username and password credential.</td>
</tr>
<tr>
<td>49 / 568</td>
<td>ERROR_TOO_MANY_CONTEXT_IDS</td>
<td>Indicates that during a logon attempt, the user's security context accumulated too many security IDs. This is an issue with the specific LDAP user object/account which should be investigated by the LDAP administrator.</td>
</tr>
<tr>
<td>49 / 701</td>
<td>ACCOUNT_EXPIRED</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error that is a logon failure. The user's account has expired. Returns only when presented with valid username and password credential.</td>
</tr>
<tr>
<td>49 / 773</td>
<td>USER MUST RESET PASSWORD</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext data error. The user's password must be changed before logging on the first time. Returns only when presented with valid username and password credential.</td>
</tr>
<tr>
<td>50</td>
<td>LDAP_INSUFFICIENT_ACCESS</td>
<td>Indicates that the caller does not have sufficient rights to perform the requested operation.</td>
</tr>
<tr>
<td>51</td>
<td>LDAP_BUSY</td>
<td>Indicates that the LDAP server is too busy to process the client request at this time but if the client waits and resubmits the request, the server may be able to process it then.</td>
</tr>
<tr>
<td>52</td>
<td>LDAP_UNAVAILABLE</td>
<td>Indicates that the LDAP server cannot process the client's bind request, usually because it is shutting down.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>52e</td>
<td>AD_INVALID_CREDENTIALS</td>
<td>Indicates an Active Directory (AD) AcceptSecurityContext error, which is returned when the username is valid but the combination of password and user credential is invalid. This is the AD equivalent of LDAP error code 49: LDAP_INVALID_CREDENTIALS.</td>
</tr>
<tr>
<td>53</td>
<td>LDAP_UNWILLING_TO_PERFORM</td>
<td>Indicates that the LDAP server cannot process the request because of server-defined restrictions. This error is returned for the following reasons: The add entry request violates the server's structure rules...OR...The modify attribute request specifies attributes that users cannot modify...OR...Password restrictions prevent the action...OR...Connection restrictions prevent the action.</td>
</tr>
<tr>
<td>54</td>
<td>LDAP_LOOP_DETECT</td>
<td>Indicates that the client discovered an alias or referral loop, and is thus unable to complete this request.</td>
</tr>
<tr>
<td>55-63</td>
<td>Not used.</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>LDAP_NAMING_VIOLATION</td>
<td>Indicates that the add or modify DN operation violates the schema's structure rules. For example, The request places the entry subordinate to an alias. The request places the entry subordinate to a container that is forbidden by the containment rules. The RDN for the entry uses a forbidden attribute type.</td>
</tr>
<tr>
<td>65</td>
<td>LDAP_OBJECT_CLASS_VIOLATION</td>
<td>Indicates that the add, modify, or modify DN operation violates the object class rules for the entry. For example, the following types of request return this error: The add or modify operation tries to add an entry without a value for a required attribute. The add or modify operation tries to add an entry with a value for an attribute which the class definition does not contain. The modify operation tries to remove a required attribute without removing the auxiliary class that defines the attribute as required.</td>
</tr>
<tr>
<td>Error / data code</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>66</td>
<td>LDAP_NOT_ALLOWED_ON_NONLEAF</td>
<td>Indicates that the requested operation is permitted only on leaf entries. For example, the following types of requests return this error: The client requests a delete operation on a parent entry. The client request a modify DN operation on a parent entry.</td>
</tr>
<tr>
<td>67</td>
<td>LDAP_NOT_ALLOWED_ON_RDN</td>
<td>Indicates that the modify operation attempted to remove an attribute value that forms the entry's relative distinguished name.</td>
</tr>
<tr>
<td>68</td>
<td>LDAP_ALREADY_EXISTS</td>
<td>Indicates that the add operation attempted to add an entry that already exists, or that the modify operation attempted to rename an entry to the name of an entry that already exists.</td>
</tr>
<tr>
<td>69</td>
<td>LDAP_NO_OBJECT_CLASS_MODS</td>
<td>Indicates that the modify operation attempted to modify the structure rules of an object class.</td>
</tr>
<tr>
<td>70</td>
<td>LDAP_RESULTS_TOO_LARGE</td>
<td>Reserved for CLDAP.</td>
</tr>
<tr>
<td>71</td>
<td>LDAP_AFFECTS_MULTIPLE_DSAS</td>
<td>Indicates that the modify DN operation moves the entry from one LDAP server to another and requires more than one LDAP server.</td>
</tr>
<tr>
<td>72-79</td>
<td></td>
<td>Not used.</td>
</tr>
<tr>
<td>80</td>
<td>LDAP_OTHER</td>
<td>Indicates an unknown error condition. This is the default value for NDS error codes which do not map to other LDAP error codes.</td>
</tr>
</tbody>
</table>

**Customized error codes**

### Customized LDAP error codes

<table>
<thead>
<tr>
<th>Error / data code</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000</td>
<td>LDAP_ERROR_GENEREL</td>
</tr>
<tr>
<td>10001</td>
<td>LDAP_ERROR_MAL_FORMED_URL</td>
</tr>
<tr>
<td>10002</td>
<td>LDAP_ERROR_UNAUTHENTICATED_BIND</td>
</tr>
<tr>
<td>10300</td>
<td>LDAP_ERROR_COMMUNICATION_EXCEPTION</td>
</tr>
<tr>
<td>10301</td>
<td>LDAP_ERROR_SOCKET_TIMEOUT</td>
</tr>
<tr>
<td>10302</td>
<td>LDAP_ERROR_CONNECTION_REFUSED</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Error / data code</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>10303</td>
<td>LDAP_ERROR_CONNECTION_RESET</td>
</tr>
<tr>
<td>10304</td>
<td>LDAP_ERROR_NO_ROUTE</td>
</tr>
<tr>
<td>10305</td>
<td>LDAP_ERROR_UNKNOW_HOST</td>
</tr>
<tr>
<td>10400</td>
<td>LDAP_ERROR_SSL_EXCEPTION</td>
</tr>
<tr>
<td>10401</td>
<td>LDAP_ERROR_SSL_EMPTY_CERT_STORE</td>
</tr>
<tr>
<td>10402</td>
<td>LDAP_ERROR_SSL_CERT_NOT_FOUND</td>
</tr>
<tr>
<td>10403</td>
<td>LDAP_ERROR_SSL_CERT_EXPIRED</td>
</tr>
<tr>
<td>10500</td>
<td>LDAP_ERROR_INVALID_SEARCH_FILTER_EXCEPTION</td>
</tr>
</tbody>
</table>

LDAP record synchronization

Administrators can synchronize inactive, disabled, or deleted LDAP records with their LDAP records.

LDAP record synchronization is the process of detecting inactive records on the LDAP server and updating the corresponding LDAP records. Detecting inactive LDAP records involves defining consistent data indicators for each user object, importing LDAP data, and evaluating the data indicators.

A data indicator can be:
- a date field
- membership in a specific OU (identify by parsing the dn attribute), using the useraccountcontrol attribute
- a combination of these indicators

Imported data comes into the instance through import set tables where the data can be evaluated and processed.

The import process can use:
- **LDAP extraction**: a single import job to gather all user records into the import set temporary tables for evaluation
- **LDAP refresh filters**: multiple import jobs to divide different types of user records, segregating records for separate processing

LDAP refresh filters

Filters on the LDAP refresh process can be used to specify processing that ignores inserts of disabled users.

You can loosen the LDAP OU filter to bring all of the data in to your import set table (including inactive users) and then specify processing that ignores inserts of disabled users. The sample ‘Users’ OU definition that the instance provides in its out-of-box LDAP sample contains a filter.

This filter is important because it defines which user records are brought into the import set table to be evaluated. While achieving a smaller data load, a limitation of this filter is that it filters out inactive users, so the inactive user records are not imported into the import set temporary tables. Since there is not visibility of the inactive user records, there is no ability to evaluate the record indicators.
LDAP OU filter

To use filtering within the main LDAP refresh process, change the filter to bring in all of the user records. The result is that all the records will be loaded into the import set temporary table where they can be evaluated and transformed.

**Note:** There is a precaution here: because the filtering brings in all the records, you may end up with a vast amount of older inactive LDAP accounts that should not be inserted into the instance. A user record should never be created for a disabled user.

**Alternative method**

**LDAP extraction** uses a single import job to gather all user records into the import set temporary tables for evaluation.

**LDAP extraction**

An LDAP extraction process can be implemented to detect disabled users.

An extract from your LDAP source can filtered for disabled users using an active flag that can be set for every record in the import to ‘false’. Specify (`target.active=false`) and copy into the **Script** field directly on the Table Transform Map record.

**Benefits**

Benefits to this method include:

- Simple scripting
- Existing user records are not involved in processing
- Inactive users are not loaded into a temporary import table
- No performance impact

**Drawbacks**

Drawbacks to this method include:
An additional process is created
The extract set must be placed in a location where your data source can access it

**Alternative method**

**LDAP refresh filters** use multiple import jobs to divide different types of user records, segregating records for separate processing.

**Inactive LDAP user accounts**
Detect that an existing, current, user account is inactive or has been disabled or deleted from an Active Directory (AD) LDAP.

A common LDAP integration issue is how to detect disabled or deleted users in an Active Directory (AD) and then deactivate them in the instance. In an Active Directory LDAP, a filter is usually set to exclude inactive users when refreshing, so the instance is not aware of users that are disabled or deleted in AD. The issue is how to detect that an existing, current user is inactive or has been deleted from AD.

*Note:* The recommended approach is to de Activate user records and all other types of records, not delete them. Each record is linked to other records, and deleting a record destroys all the relationships to those other records. Deactivating records keeps those relationships in place.

Find inactive LDAP accounts using the userAccountControl field
Identify when an Active Directory (AD) user is deleted (or made inactive).

Role required: admin

One method is to track the active status of AD users and create a business rule to update corresponding accounts when an AD account is inactive.

1. Create a new string field on the User (sys_user) table to track the value of the AD userAccountControl field. For example: `u_ad_user_account`.
2. Create an LDAP transform script to set the field value.

   ```plaintext
   target.u_ad_user_account = source.userAccountControl
   ```

3. Update the LDAP filter to show disabled AD accounts.
   Here is an example of a filter.

   ```plaintext
   (&(objectClass=person)(sn=*)(!(objectClass=computer))(!(userAccountControl:1.2.840.113556.1.4.803:=2)))
   ```

   Here is an example of a replacement filter you can use.

   ```plaintext
   (&(objectClass=person)(sn=*)(!(objectClass=computer)))
   ```

4. Create an onChange business rule to set the active field to false whenever the `u_ad_user_account` field has the value 514.
   ‘514’ indicates an inactive account.

**LDAP script examples**
The following script examples assume you use an Active Directory (AD) for your LDAP server.
userAccountControl attribute values script
This example tests the source for the userAccountControl attribute values associated with a
disabled user (514 or 546).

```java
//Deactivate LDAP-disabled users during transform based on
'userAccountControl' attribute
if(source.u_useraccountcontrol == '514' || source.u_useraccountcontrol ==
'546'){
    target.active=false;
    target.locked_out=true;
}
```

Here is an example using a bitwise check:

```java
if(source.u_useraccountcontrol & 2)
    active = false;
```

userAccountControl attribute script
This example examines the userAccountControl attribute but does not test for specific values. It
also contains the option of reactivating LDAP user accounts.

```java
/*
* Deactivate LDAP-disabled users during transform based on
'userAccountControl' attribute
* Convert the userAccountControl attribute back to a hex value
*/
var ctrl = parseInt(source.u_useraccountcontrol, 10);
ctrl = ctrl.toString(16);

/*
* The only digit we care about is the final one
* A final hex digit value of '2' in 'ctrl' means disabled
*/
if(ctrl.substr(-1) == "2"){
    //Deactivate and lock the user account
    target.active = false;
    target.locked_out = true;

    //Ignore any insert of a disabled record
    if(action == 'insert'){
        ignore = true;
    }
}
/* Optional: Uncomment else block to reactivate and unlock the user account
else {
    target.active = true;
    target.locked_out = ctrl.substr(-2, 1) == "1";
}
*/
```
onBefore transform map script

Here is an example of a onBefore transform map script. The script identifies disabled records and records being inserted. If an insert of a disabled user is occurring, then the operation transform ignores the record.

```javascript
//Ignore any insert of a disabled record as defined by the 'userAccountControl' attribute var uc = source.u_useraccountcontrol; if((uc == '514' || uc == '546') && action == 'insert'){
  ignore = true;
}
```

DN member script

This script example introduces flexibility by not relying on the 546 and 514 userAccountControl values, but instead checking whether the user is a member of a particular Distinguished Name (DN). You can use this script either in the Script field of the 'Table Transform Map' record or in an onBefore transform map script.

```javascript
//Deactivate LDAP-disabled users during transform based on OU membership in 'dn'
if(source.u_dn.indexOf('OU=Disabled Accounts') > -1){
  target.active = false;
  target.locked_out = true;
}
```

Active Directory Application Mode (ADAM)

Active Directory Application Mode (ADAM) is an Lightweight Directory Access Protocol (LDAP)-compliant directory service.

**Note:** A basic level of understanding with Microsoft Windows Server and Active Directory is needed for understanding this topic. You must also have administrator permissions on the server you are configuring for ADAM.

These are sample procedures. Due to installation and environment variations, we cannot offer direct support. We recommend working with a Microsoft consultant.

ADAM has a simple install and runs as a service on Windows operating systems. It can be fully customized and distributed as an application component or used as a stand-alone LDAP directory. ADAM uses the same technologies found on Active Directory Domain Controllers (including replication and delegation features) and has its own administration and customization features. It can be run as a Windows service. ADAM can be installed on Windows XP, 2000, 2003, and 2008 operating systems. ADAM is included as part of Windows Server 2003 R2 and Windows Server 2008. A download is available at [http://www.microsoft.com/downloads](http://www.microsoft.com/downloads) for earlier operating systems.

Security

Some company security policies prohibit external vendors and partners from connecting directly to an Active Directory (AD) Domain Controller. If exposing certain AD objects or attributes to an external vendor or partner is prohibited, access to objects and attributes can be blocked using AD Security Access Control Entries (ACE or ACL). Depending on security requirements, this method can introduce complexity in the integration. Consolidating multiple domains and forests is recommended. If all LDAP imports and authentications need to be channeled through
a single source, ADAM can be used as a consolidated source. With the release of Windows 2008 this functionality has been renamed to Light-Weight-Directory Service, LDS. Installation and configuration is similar to Windows Server 2003 R2.

Recommended Knowledge

For this task, you must understand AD, object classes and attributes. To have a successful integration, you need to be knowledgeable of the current AD object structure, familiar with Active Directory delegations, and have a strategy on how to use ADAM and for what purposes. If you are not familiar with AD or ADAM, work with your AD administrator to configure a new ADAM environment.

Trusts

If `userProxy` objects is used, the computer hosting ADAM needs to be a member of the domain that has the AD accounts, or a member of a trusted domain.

Internal Connectivity

If `userProxy` objects is used, the ADAM computer must be able to connect to the related Domain Controllers to perform proxy authentication.

`Configuring an instance with ADAM`

The first install copies the ADAM files to your computer, registers requires components, and creates the application shortcuts.

Role required: admin

By default, all of the application files are installed to `%systemroot%\ADAM`.

- Windows Server 2003 R2 - ADAM can be installed using the Control Panel > Add and Remove Programs > Optional Component Manager.

Create the first instance service which functions as the first directory service hosted by ADAM. Do one of the following:

- Run `adaminstall.exe` from the ADAM folder.
- Use the Create an ADAM instance shortcut from the Start Menu > Programs > ADAM folder.
  a) Select the A unique instance install option.

  **Note:** You can use this option to install an instance replica on a second server to provide a fault tolerant system.

  b) Complete the fields.

<table>
<thead>
<tr>
<th>ADAM Instance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Name</td>
<td>used primarily to identify the Windows Service name and display name</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ports</td>
<td>sets the port numbers to be used for LDAP and LDAPS Listeners. The default LDAP port is 389, LDAPS is 636. If these ports are in use on the server, the setup wizard selects new ports. Work with your network administrator to determine the best ports to use.</td>
</tr>
<tr>
<td>Application Directory Partition</td>
<td>creates an application directory partition. Not needed at this step, we recommend creating the new partition now. A good practice is to use the same distinguished name as your forest or domain, but replace the highest level domain with adam instead of com or local. For example, if your forest partition is dc=myCompany,dc=com, you could create the ADAM partition as dc=myCompany,dc=adam.</td>
</tr>
<tr>
<td>File Locations</td>
<td>selects the location(s) for the ADAM partition data.</td>
</tr>
<tr>
<td>Service Account Selection</td>
<td>selects a service account that the instance runs as. For stand-alone services, you can use the default network service account. If you plan on using replicas, you need to use an account that has access to all ADAM instances.</td>
</tr>
<tr>
<td>ADAM Administrators</td>
<td>the delegation on the ADAM directory that leverages Windows integrated authentication. This is how the initial access is granted for administration. Once the initial account is granted rights, this user or group delegates rights to other Windows users or ADAM users. You can select the default to only grant admin access to the current user, or grant access to a different user or group based on your needs.</td>
</tr>
<tr>
<td>Import LDIF Files</td>
<td>the files to import. MS-UserProxy is the most important file to import, but it's worth adding all available files since there is little overhead to the schema and you won't have to worry about extending it later if your needs expand. Confirm the details and the wizard complete the configuration.</td>
</tr>
</tbody>
</table>

**Setting up the ADAM console**

Even though there are many similarities between ADAM and Active Directory, the administration can be very different since there is no Users and Computers management console.

Role required: admin
Most of the general administration is performed using the ADAM ADSI MMC console available from the ADAM start menu. The first time you run the ADAM ADSI console, you must connect to the partition you created.

1. Right-click the ADAM ADSI Edit item in the left frame.
2. Give the new connection a name and update the server name, port fields with the information used when you created the instance.
3. Select distinguished name or naming context and specify the distinguished name of the application partition you created earlier. You can connect to the Configuration and Schema partitions for advanced configuration options.
   You should now be able to see into the partition and the default containers for LostAndFound, NTDS Quotas, and Roles. The Roles container has not been configured yet.

Create containers and organizational units for ADAM
Objects stored in ADAM can be logically grouped into containers and organizational units (OU) just as they would in Active Directory.

Role required: admin

1. Right-click the root partition and select New > Object > organizationalUnit. You can also view the list of other objects that are available. This list varies based on the schema extensions installed when you imported the LDF files.

   Note: You can also view the list of other objects that are available. This list varies based on the schema extensions installed when you imported the LDF files.

2. When prompted for a value, enter the name of OU, for example Users.
3. The next screen displays a More Attributes button; use this to assign values to additional attributes. For OUs and containers, no additional values are needed.
   After creating OUs, the new OUs are listed as a child of the root object.

Delegation with ADAM
Once the OU structure is created, define the permission delegations to properly secure the objects to limited users.

As with Active Directory, there are two general ways to grant permissions:

- Add users to a group that already has the appropriate permissions assigned.
- Define new permissions on the ADAM objects.

For this task, we discuss object level permissions. Refer to the Group Administration section for information on group memberships.

Since we don’t have a Users and Computers console for ADAM, all object level permissions are defined using the Active Directory utility DSACLS.exe. This file is found in the ADAM program directory. When running ADAM utilities it is best to launch the ADAM Tools Command Prompt. This ensures the proper versions of the tools. DSACLS is used to view and set object access rights.

Example: "dsacls \localhost:50010\dc=myCompany,dc=adam" displays the permissions assigned to the root of partition dc=myCompany,dc=adam running on the localhost, port 50010. DSACLS is a complex tool used to create complex delegation. Run "DSACLS /?" for usage notes.

Populating ADAM Objects
ADAM Objects include User Objects, UserProxy Object, and Group Objects.
User Objects

Users can be created using the ADAM ADSI Edit console just as we did for OU creation. Users can also be administered using AD command line tools, which is beyond the scope of this document. The only mandatory attribute for new user objects is the `cn`, which is a short name or the user’s full name. There are also a wide range of optional attributes similar to Active Directory user attributes. You can access the full list of attributes by selecting properties from the user object.

UserProxy Objects

For ServiceNow LDAP integration we recommend you use UserProxy objects in ADAM which creates a proxy account that links to the related AD user account. This allows you to have ADAM authenticate logon credentials using AD usernames and passwords from the domain without ServiceNow directly connecting to the Domain Controller. UserProxy objects are very similar to AD and ADAM User objects except that do not store passwords and has an objectSID attribute that contains the SID from the linked AD User object. This is how the proxy works. UserProxy objects are created using the ADSIEDit console or command line tools, but this can be tedious. It is recommended that you use an automated process as defined below.

Group Objects

Groups are created using the ADSIEdit console and AD command-line tools. Group concepts are similar to AD and are used to integrate groups and members to ServiceNow. The biggest difference is ADAM groups can contain members from ADAM or from trusted AD Domains.

Automating ADAM Object Creation

If you are interested in synchronizing Active Directory accounts to ADAM, we recommend you use Microsoft ADAMSync tool. This is the most common use of ADAM for ServiceNow LDAP integration.

About Permission Delegation

ADAM contains some built-in groups with default permissions. These groups are found in the container `cn=roles,dc=myCompany,dc=adam`. These are similar to domain level groups and have rights to objects in the current partition. Similar to AD Forests you can also set a higher level of permissions using the default groups in `cn=roles,cn=configuration,dc=myCompany,dc=adam`. You must connect to the configuration partition in ADSIEDit. The Administrators group by default includes the account specified during the setup. This member is not always visible since it’s inherited through the configuration groups. Administrators have full control of all partition objects. The Readers group does not contain any members by default and has read access to all objects in the partition. The Users group is a dynamic group just as it is in Active Directory. Transitivity it includes all ADAM users created in the partition.

Testing and troubleshooting ADAM setup

The primary tool used for testing is LDP. This allows you to fully test user authentication.

Most of the object management can be completed using the ADAM ADSI Edit console which will provide access to the entire collection of objects and attributes. The highest level of control and troubleshooting ADAM services is using the Windows service created during the instance setup. The service name will vary and depends on the name of the instance created. This service must be running in order for the ADAM service to run. If you are experiencing connection problems, you should review the network configurations to ensure you have the appropriate network access to...
connect to the server and ADAM port. For each ADAM instance installed, a Windows Event Log is created. This is also a great tool for troubleshooting ADAM services.

The Windows Security Event Log is also helpful when troubleshooting userProxy authentications. All userProxy logon attempts are logged in the Security Log and reference the remote client device address, the distinguished name of the user trying to log on, and the result or status code.

**Backup and recovery with ADAM**

All ADAM data can be backed up using standard file system backup methods.

**Redundancy**

ADAM has built-in replication utilities based on the same technology as AD. A full read and write replica of an ADAM partition can exist on the same or different computer. You can use this replica in a variety of ways to provide a fault-tolerant LDAP integration with the instance. One option is to expose both partitions to the instance through the firewall and define both servers in the LDAP Properties server field.

**Use LDAPS with ADAM**

The default configuration for userProxy object authentication is to enforce LDAPS (secure LDAP) communications. LDAPS requires SSL certificates to secure the network traffic.

To remove this requirement make the following change using the `ADSIEdit` console connected to the configuration partition.

```
Object: CN=Directory Service, CN=Windows NT, CN=Services, CN=Configuration
Attribute: msDS-Other-Settings
Value: change RequiresSecureProxyBind from 1 (enforced) to 0 (disabled)
```

Restart the ADAM service to use the new setting.

To support secure binds and encrypt the user and password information being transmitted, a SSL certificate must be installed on the server and any LDAP client. Since there is limited and controlled uses to the ADAM service, it is feasible to use a self-signed certificate which would meet the needs without incurring certificate costs or building a Certificate Authority (CA) infrastructure. If you already have a CA, you can issue a certificate. Otherwise, create a self-signed certificate.

**Creating a Self-Signed Certificate**

To use the `selfssl` utility, Internet Information Services (IIS) must be installed. This service can be removed after you generate the certificate. You can get the `selfssl.exe` utility from the IIS Resource Kit. If IIS is already installed, create a new website so that the current sites will not be impacted during the certificate generation. Selfssl needs to temporarily attach the new self-issued certificate to a valid web site.

Selfssl is a command-line tool and has the following common parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/T</td>
<td>Adds the cert to ‘Trusted Certificates’ on the local machine</td>
</tr>
<tr>
<td>/N:cn</td>
<td>Set the common name of the certificate. This must match the fully qualified domain name of the server running the web service using the certificate</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>/K</td>
<td>Sets the strength of the key size in bits</td>
</tr>
<tr>
<td>/V</td>
<td>Number of days the cert is valid</td>
</tr>
<tr>
<td>/S</td>
<td>Web site ID to attach the certificate to</td>
</tr>
<tr>
<td>/P</td>
<td>IP port of the web service</td>
</tr>
</tbody>
</table>

The common name attribute should match the external name or address that the instance will use to connect to your ADAM computer. You will need to get the IIS Website site id unless you are using the default website which is 1 and does not need to be defined in the selfssl command. A sample command to generate a certificate for myCompany would be:

```
selfssl /N:CN=myCompany.externaldomain.com /K:1024 /V:3650 /S:12345 /P:50001 /T
```

This statement creates a certificate that is valid for 10 years. Set the value to any duration, but be aware the new certificate must be generated and submitted to the instance before the old one expires. We recommend making a note of the expiration date on the certificate.

Once the certificate is generated you can remove it from the website, or delete the entire web site if you created a temporary site.

Assigning the Certificate to ADAM
To support secure binds and encrypt the user and password information being transmitted, a SSL certificate must be installed on the server and any LDAP client.

Role required: admin

Since there is limited and controlled uses to the ADAM service, it is feasible to use a self-signed certificate which would meet the needs without incurring certificate costs or building a Certificate Authority (CA) infrastructure.

To assign the certificate to ADAM.

1. Open the Certificates MMC console. Create two console connections, one for Local Computer Certificates, and the other for Local Computer Services Certificates on the new ADAM service. The new certificate can be found under Certificates (Local Computer)\Personal\Certificates.
2. Copy the certificate to the container for the ADAM service, Certificates - Service (ADAM Service Name)\ADAM_ADAM Service Name\Trusted Root Certificates\Certificates. Also copy the certificate to Certificates - Service (ADAM Service Name)\ADAM_ADAM Service Name\Personal\Certificates.
3. Open the details tab on the certificate you copied. Note the Valid from date stamp. Now assign read access to the certificate key file. Go to C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys and identify the certificate with the matching time stamp. Assign Read & Execute rights to the service account running ADAM. By default this is Network Service.
4. Restart the ADAM service to activate the new certificate.

Exporting the Public Key Certificate
LDAPS clients, including the instance need the public key certificate in order to make a secure connection to ADAM.

Role required: admin
From the server certificate consoles you used above, export a public key to be used by the clients.

1. Select the certificate, right-click, select **all tasks/export**. Do not export the private key. Select the default DER encoded binary X.509 format and specify the export file name.

2. Install the public certificate on the LDAP clients that connect to the server using LDAPS. When prompted, add the certificate to the **Trusted Root Certificate Authorities store**.

**Test communication between LDAP and MID Servers**
The instance tests the connection automatically every time a user opens the LDAP Server form.

**Role required: admin**

The instance supports an LDAP connection timeout of 29 seconds or less. Error messages appear on the form if there are any issues connecting to the LDAP server.

Employees can also verify connectivity between the instance and the LDAP server. Contact Technical Support for assistance verifying LDAP connectivity.

**Active Directory Application Mode (ADAM) Access Account**
The system requires a user account to read the Active Directory Application Mode (ADAM) object information that is imported into the application instance.

Create the account by using one of the following methods:

- Create a local ADAM user account and assign it a password and assign permissions.
- Assign permission to a Windows domain account on the ADAM partition.
- Use a **userProxy** account.

When using ADAM as an LDAP source, you must specify the fully qualified distinguished name (FQDN) of the ADAM account in the instance’s LDAP server’s **Login distinguished name** field.

**Testing LDAPS Connections**
There are two console connections, one for Local Computer Certificates, and the other for Local Computer Services Certificates on the new ADAM service.

**Role required: admin**

1. Run **LDP.exe** from the ADAM install folder `c:\windows\adam`. Verify that the ADAM version is selected because this is not the standard Windows LDP client.

2. Open a new connection using the **Connection/Connect** menu. The server name must match the CN assigned to the certificate.

3. Enter the **LDAP port** and select the **SSL** checkbox.

   The results of a successful connection are some general server information and no errors.

4. Bind (log in) to the service. To replicate typical LDAP client connections select the Simple bind option. Enter a valid ADAM user or **userProxy** distinguished name in the user field and the associated password.

   If you see a return message stating ‘Authenticated as:…..’ then you have successfully connected using LDAPS.

**Use ADAMSync to populate ADAM**
Administrators use MS ADAMSinc to populate LDAP directories that use MS ADAM.

---

**Note:**

This document assumes you have at least a basic level of understanding with Microsoft Windows Server, Active Directory, and ADAM and that you already have a functional **ADAM** instance with a partition.

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
These are sample procedures. Due to the complexity and the fact that it is running in your environment, we cannot offer direct support. We recommend you work with Microsoft or a Microsoft consultant if you run into any trouble.

Once ADAM has been installed and the first partition has been created, you can populate it with objects.

The following options are available:

- Manual object creation using GUI or scripts. This option is inefficient and slow.
- Integrate with Active Directory using Microsoft Integration Information Server. This option ultimately provides the most flexibility and functionality but does require some advanced configurations. There is a free version of MIIS available that is compatible with Active Directory, ADAM, and Microsoft Global Address Lists from Exchange. Unless you already have experience with MIIS we advise that you don’t attempt to implement a new environment for LDAP integration only.
- Use ADAMSync, a synchronization tool that Microsoft provides with ADAM. This is the option that is explained here.

Define ADAM user accounts
Define the following user accounts in ADAM. One is used for the instance to connect with and the other for ADAMSync.

Role required: admin

These accounts can be local ADAM User objects, UserProxy objects, or a Windows account from a trusted domain.

User Account
This account requires read-only access to the directory structure you are importing to your instance. The best way to accomplish this is to add the account to the member attribute on the Readers group found in cn=roles,dc=myCompany,dc=adam.

New ADAM User accounts are disabled by default. You will need to enable the new accounts and set a password.

1. Enable users by changing the attribute msDS-UserAccountDisabled to FALSE.
2. Right-click the user object and reset the password.
3. Test the new accounts using LDP as defined in ADAM to make sure they can connect. Use the LDAP > View/Tree option, leaving the Base DN blank to make sure you can view the objects in the directory using the new accounts. The Configuration, Schema, and the domain partition should be visible in the left pane. Traverse the domain partition. If you are using a new local ADAM account, it will show ‘No Children’ which means you don’t have read access to the objects. Verify the Setup group memberships and re-test.

ADAMSync User Account
ADAMSync uses this account to manage objects in the ADAM partition. This account requires admin level rights since it will create, update, and delete ADAM objects.

ADAMSync AD Account
ADAMSync uses this account to read the AD objects that will be synchronized to ADAM.

Set up ADAMSync
ADAMSync is included with Windows Server 2003 R2. Download and install ADAMSync if you are using a different OS.
Extending the schema

The ADAM schema needs to be extended to support ADAMSync.

1. Run the following command from c:\windows\adam to import the ADAMSync schema extensions. You may have to change the server:port and add credentials if the current user doesn't have access. See the AdamSyncMetadata.ldf file for details.

   ```bash
   ldifde -i -f MS-AdamSyncMetadata.LDF -s localhost:50000 -j . -c "cn=Configuration,dc=X" #configurationNamingContext
   ```

2. Do the same with MS-AdamSchemaW2k3.ldf to support Windows 2003 attributes.

   ```bash
   ldifde -i -u -f MS-AdamSchemaW2K3.LDF -s localhost:50000 -j . -c "cn=Configuration,dc=X" #configurationNamingContext
   ```

Recommended schema changes

Here are some additional schema changes we recommend.

1. Open a new MMC console and add the ADAM Schema Snap-in.
2. Connect to the ADAM instance.
3. Expand the Classes folder and locate the userProxy class, open Properties.
4. Verify the following optional attributes on the Attributes tab, add any that do not already exist.
   - company
   - department
   - givenName
   - mail
   - physicalDeliveryOfficeName
   - sAMAccountName
   - sn
   - telephoneNumber
   - title
   - userAccountControl
   - userPrincipalName
5. Restart the ADAM Service to enable the new settings.

Install the ADAM configuration file

You can install the ADAM configuration file through the Windows command line.

Role required: admin

1. Install the configuration file.

   ```bash
   C:\WINDOWS\adam>adamsync /install localhost:50000 MS-AdamSyncConf-SNC.XML
   ```
2. Run the synchronization file. This will log to the console and may run for a long time.

```bash
C:\WINDOWS\adam>adamsync /sync localhost:50000 "ou=users,dc=service-now,dc=adam" /log -
```

3. Review the results by using the ADSIEdit console. You should see the new objects and attributes that were created by ADAMSync.

4. Run ldap to test the UserProxy authentication.

Automating the sync process

Setup the sync process as a Windows Scheduled Task. You must either provide the credentials in the config file, command line, or run the Scheduled Task with an account that has access.

Special notes

- You can create multiple configuration files and scheduled jobs to sync ADAM from multiple sources.

This example imports the sAMAccountName attribute which can be used as the application logon. If you are going to sync source you need to make sure you have a unique attribute value that can be used for the logon credentials. sAMAccountName is guaranteed to be unique within a domain, but not across multiple domains.

- If you are using Microsoft Exchange, we recommend excluding cn=SystemMailbox* objects as part of the object-filter configuration.

Example ADAM configuration files

All of the configurations for ADAMSync are stored in xml files.

**Default configuration file with comments**

There is a default configuration file called MS-AdamSyncConf.xml included with the ADAMSync install. Make a copy of this file so you have a base example to refer to in the future. This example is the default configuration file with comments added.

```xml
<?xml version="1.0"?>
<doc>
  <configuration>
    <!-- Sync File Description -->
    <description>MyCompany ADAMSync Configuration</description>
    <security-mode>object</security-mode>;
    <!-- source-ad-name = fqdn of the domain controller -->;
    <source-ad-name>;fully.qualified.domain.name.of.domain.controller</source-ad-name>;
    <!-- source-ad-partition = root AD domain partition -->;
    <source-ad-partition>;dc=myCompany,dc=com</source-ad-partition>;
    <!-- source-ad-account = use this to specify an account to connect to AD -->
    <source-ad-account>; </source-ad-account>;
    <!-- if not used, the current user will be used -->;
    <source-ad-account>;</source-ad-account>;
    <account-domain>;</account-domain>;
    <!-- target-dn = target ADAM OU -->;
    <target-dn>;ou=servicenow users,dc=myCompany,dc=adam</target-dn>;
    <query>;
    <!-- base-dn = should be the root AD partition if you want all users -->
    <base-dn>;dc=myCompany,dc=com</base-dn>;
    <!-- object-filter = standard ldap query format, this will grab all users -->;
    <object-filter>;(objectCategory=person)</object-filter>;
  </configuration>
</doc>
```
LDAP filters configuration file

You can provide any level of filtering in the object-filter value in the configuration file. Use standard LDAP query syntax with the following xml escape characters in place of the standard operators.

- **AND** = "&" replace with &amp;#38;
- **OR** = "|" (vertical line) replace with &amp;#124;
- **NOT** = "!" replace with &amp;#33;
Reference configuration file

Here's an actual configuration file that can be referenced as a sample.

```xml
<?xml version="1.0"?>;
<doc>;
<configuration>;
<description>;SNCTest ADAMSync Configuration</description>;
<security-mode>;object</security-mode>;
<source-ad-name>;domaincontroller.service-now.com</source-ad-name>;
<source-ad-partition>;dc=service-now,dc=com</source-ad-partition>;
<source-ad-account>;</source-ad-account>;
<account-domain>;</account-domain>;
<target-dn>;ou=servicenow users,dc=service-now,dc=adam</target-dn>;
<query>;
<base-dn>;dc=service-now,dc=com</base-dn>;
<object-filter>;(objectCategory=person)</object-filter>;
<attributes>;
<include>;objectSID</include>;
<include>;givenName</include>;
<include>;sn</include>;
<include>;description</include>;
<include>;title</include>;
<include>;company</include>;
<include>;department</include>;
<include>;mail</include>;
<include>;physicalDeliveryOfficeName</include>;
<include>;telephoneNumber</include>;
<include>;userAccountControl</include>;
</attributes>;
</query>;
<user-proxy>;
<source-object-class>;user</source-object-class>;
<target-object-class>;userProxy</target-object-class>;
</user-proxy>;
<schedule>;
<aging>;
<frequency>;0</frequency>;
<num-objects>;0</num-objects>;
</aging>;
<schtasks-cmd>;</schtasks-cmd>;
</schedule>;
</configuration>;
<synchronizer-state>;
<dirsync-cookie>;</dirsync-cookie>;
<status>;</status>;
<authoritative-adam-instance>;</authoritative-adam-instance>;
<configuration-file-guid>;</configuration-file-guid>;
<last-sync-attempt-time>;</last-sync-attempt-time>;
<last-sync-success-time>;</last-sync-success-time>;
<last-sync-error-time>;</last-sync-error-time>;
<last-sync-error-string>;</last-sync-error-string>;
<consecutive-sync-failures>;</consecutive-sync-failures>;
<user-credentials>;</user-credentials>;
<runs-since-last-object-update>;</runs-since-last-object-update>;
<runs-since-last-full-sync>;</runs-since-last-full-sync>;
</synchronizer-state>;
</doc>;

Configure Microsoft Active Directory for secure LDAPS communication

Use certificate pairs to enable Microsoft Active Directory (AD) LDAPS communications.
Note: These procedures were designed and tested using Windows 2003 R2 Standard Edition and work with all versions of Windows 2003.

Secure LDAP (LDAPS) communication is similar to SSL (HTTPS) communication in that both encrypt the data between servers and clients. To accomplish this, the server and clients share common information by using certificate pairs. The server holds the private key certificate and the clients hold the public key certificate. These certificates are required to enable Microsoft Active Directory (AD) LDAPS communications.

To configure LDAPS for Active Directory you must:

- Ensure that the Active Directory domain is set up and that the instance is able to connect to the Active Directory server through the firewall.
- Verify that there is a Certificate Authority (CA) that can issue a certificate for the domain controller (DC). If you don't already have a CA infrastructure there are two options.
  - Setup a stand-alone CA to issue the certificate
  - Request a third party certificate
- If you already have a CA in place, you can generate a certificate from an internal CA.

All certificates have a defined expiration date which can be viewed in the certificate properties. If the certificate expires, all LDAPS traffic fails, and your users can no longer log into the instance. To resolve this, a new certificate must be issued and installed on your instance.

The default expiration for Microsoft CA certificates is one year. External CA certificates are usually purchased in one year increments. Note when your certificate expires, or use the application's Expiration Notification function (located in System LDAP > Certificates). Ensure that you have a new certificate ready before the old one expires. This gives you time to install and test the new certificate before the old one expires.

Set up a stand-alone certificate authority for active directory
The first step to configure Microsoft Active Directory for SSL access is to set up a stand-alone Certificate Authority (CA).

Role required: admin

Do not worry about additional resource utilization because both of the required services (IIS & CA) can be disabled after issuing the certificate(s).

1. Install Internet Information Server (IIS).
2. Install Certificate Authority Services in stand-alone mode.
3. Verify the Certificate Services web application is installed and active.

Using the IIS Manager console, expand the local computer and select Web Sites. The state of Default Web Site should be Running. You should also see a CertSrv application listed under the Default Web Site. If the site is not running or the application is missing, you must resolve the issue before you proceed.

Generate a certificate from an internal certificate authority
When you configure Microsoft Active Directory for SSL access, you must generate an internal certificate and request the external certificate.

Role required: admin

These steps apply to Microsoft CA services. If you have a different internal CA platform, see your local CA administrator for assistance.

1. From the domain controller (DC) you want to create a certificate for, browse to http://localhost/certsrv or specify the CA server name if it is on a remote server.
2. From the Welcome page, click **Request a certificate** and select advanced certificate request.

3. On the Advanced Certificate Request page, select **Create** and submit a request to this CA.

4. Complete the Advanced Certificate Request as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The fully qualified domain name (FQDN) of the DC that is requesting the certificate.</td>
</tr>
<tr>
<td>E-Mail</td>
<td>The email address of the person responsible for the certificate.</td>
</tr>
<tr>
<td>Company</td>
<td>Your company name.</td>
</tr>
<tr>
<td>Key Options settings</td>
<td></td>
</tr>
<tr>
<td>Create new key set</td>
<td>Select it.</td>
</tr>
<tr>
<td>CSR</td>
<td>Microsoft RSA SChannel Cryptographic Provider.</td>
</tr>
<tr>
<td>Key Usage</td>
<td>Exchange.</td>
</tr>
<tr>
<td>Key Size</td>
<td>1024 is recommended. The instance supports up to 2048.</td>
</tr>
<tr>
<td>Automatic key container name</td>
<td>Select it.</td>
</tr>
<tr>
<td>Store certificate in the local computer certificate store</td>
<td>Select it.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
   You are directed to a page that provides your **Request ID**, make note of this ID.

6. To process the pending request, complete the following:
   a) Open the Certificate Authority management console.
   b) Expand the server node and select **Pending Requests**.
   c) Locate the Request ID for the request you just submitted, right-click, and select All Tasks/Issue to approve the request and issue the certificate.

7. To retrieve the issued certificate, complete the following:
   a) From the DC you made the request from, browse to `http://localhost/certsrv`, or specify the CA server name if it is on a remote server.
   b) Select **View the status of a pending certificate request**.
   c) Select the link to the new certificate.
   d) Select the link to **Install this certificate**.

You need to request a third party certificate. Certificates from external CAs can be purchased for as little as $30 per year. For detailed procedures on requesting a certificate from an external CA, see Microsoft article [321051](http://support.microsoft.com/kb/321051). After it is received, installed, and tested, follow the export procedure. **Test the LDAPS Connectivity Locally**

When you configure Microsoft Active Directory for SSL access, you must test the LDAPS connectivity after installing the internal and third party certificates.
Role required: admin

1. Ensure that Windows Support Tools are installed on the domain controller (DC).
   The Support Tools setup (suptools.msi) can be found in the \Support\Tools directory on your Windows Server CD.
2. Select Start > All Programs > Windows Support Tools > Command Prompt. On the command line, type ldp to start the tool.
3. From the ldp window, select Connection > Connect and supply the local FQDN and port number (636). Also select the SSL.
   If successful, a window displays and lists information related to the Active Directory SSL connection. If the connection is unsuccessful, try restarting your system and repeat this procedure.

Export the public key certificate to trust the LDAP certificate
When you configure Microsoft Active Directory for SSL access, you must export the public key certificate and import it into the application.

Role required: admin

If your Certificate Authority is not a trusted third party vendor, you must export the certificate for the issuing CA so we can trust it, and, by association, trust the LDAP server certificate. For MS Certificate Services users, you can view the certificate path by viewing the certificate in the console used to export; select the Certificate Path tab. You must export all certificates in the chain. You can find the CA certificate in the same folder as the LDAP certificate by looking for the name in the Certificate Path. Submit all certificates for importing to your instance.

1. From a current or new MMC console, add the Certificate (Local Computer) snap-in.
2. Open the Personal/Certificates folder.
3. Locate the new certificate. The Issued To column shows the FQDN of the domain controller.
4. Right-click the certificate and select All Tasks/Export.
5. Export to DER or Base-64 format. Name the file using the format: MyCompany.cer.
   This is the public key certificate the needs to be used on the instance to communicate securely with your domain controller.
6. Test LDAPS locally before you submit the certificate to the instance.

After completing this procedure, import the public key certificate into the application.

See Upload the LDAP X.509 SSL certificate to upload the certificate into the application.

LDAP global catalog usage

A DC can be granted the Global Catalog (GC) role. Global Catalog (GC) role is an LDAP-compliant directory consisting of a partial representation of every object from every domain within a forest.

Administrators configure Active Directory to host Lightweight Directory Access Protocol (LDAP) directory information using one of the following hosting methods.

- The common method of hosting LDAP directory information is to use the default LDAP or LDAPS (secure LDAP) on ports 389 or 636. These standard LDAP ports always exist on a Domain Controller (DC) and are rarely changed. Accessing this directory partition provides access to all of the objects within the domain that is hosted on the DC. There is no way to access objects from other domains using this method.
- A DC can also be granted the Global Catalog (GC) role. Global Catalog (GC) role is an LDAP-compliant directory consisting of a partial representation of every object from every domain within the forest. This LDAP directory can be accessed on port 3268, with LDAPS on port 3269. LDAPS and the default LDAP ports’ certificate requirements are the same.
Global Catalog LDAP dependencies

- The domain controller that your instance connects to must have the Global Catalog role enabled.
- Firewall rules must allow inbound traffic to the domain controller on port 3268 (LDAP) or 3269 (LDAPS).

Special notes

- Not all attributes are replicated to the GC partition. Common attributes such as first name, last name, email, phone number, description, and address are included. Additional attributes can be added to the GC but should be limited to minimize the impact to forest replication traffic.
- Standard LDAP integrations usually use sAMAccountName as the instance's UserID and as the coalesce key in the LDAP import map since this is guaranteed to be unique within a domain. This attribute is no longer unique when viewing an entire forest of domains. A new unique attribute needs to be identified and as the UserID and the coalesce key. These do not need to be the same attribute and may vary based on your forest design. Consult your Active Directory administrator. Typically, the userPrincipalName is a unique attribute across domains but this may not be a user-friendly name to login with, but it could be used for the unique identifier on imports. A common attribute that is used for the UserID is email address. These decisions impact the LDAP Properties and LDAP Mapping.
- The value used for the coalesce key on the LDAP import map must be unique and exist on every object being imported. If it is not unique or does not exist, incorrect records are updated with changes.
- If you already have an LDAP integration and wish to change it to a GC, change the import coalesce key. The new key values must be imported before you can change the coalesce key.
- If you make any changes to your LDAP integration that break your integration, your first step should be to revert those changes. After that, contact ServiceNow Technical Support with complete information about what you're attempting.

OpenLDAP minor schema modification

In OpenLDAP 2.3 systems that use the back-bdb (Berkley backend), administrators make a minor modification to their schema to facilitate the integration.

**Caution:** The customization described here was developed for use in specific instances, and is not supported by ServiceNow Technical Support. This method is provided as-is and should be tested thoroughly before implementation. Post all questions and comments regarding this customization to our community forum.

In OpenLDAP 2.3, back-bdb has limited support for inequality indexing (ordering). It is implemented only for generalizedTime and ChangeSequenceNumber syntax. It cannot be supported on syntax that support substrings. Search filters containing inequalities are processed using the presence index.

We recommend creating a custom attribute for this purpose, instead of changing what is already indexed or present in the schema (for example, servnowid).

**Modify the OpenLDAP schema**

These steps detail a schema modification to OpenLDAP 2.3 provided by one of our customers that helped them integrate with their instance.

Role required: admin
Caution: The customization described here was developed for use in specific instances, and is not supported by ServiceNow Technical Support. This method is provided as-is and should be tested thoroughly before implementation. Post all questions and comments regarding this customization to our community forum.

To modify the OpenLDAP schema for integration with the instance:

1. Create a custom attribute.

   ```
   attribute ( 1.3.6.1.4.1.3403000.2.1.8
       NAME 'servnowid'
       ORDERING caseIgnoreOrderingMatch
       EQUALITY caseIgnoreMatch
       SYNTAX '1.3.6.1.4.1.1466.115.121.1.15' )
   ```

2. Include the attribute in the selected objectclass OID.

   ```
   objectclass ( 1.3.6.1.4.1.3403000.2.2.1
       NAME 'BcfUserIdentifiers' SUP top AUXILIARY
       MAY ( uniqid $ unixid $ servnowid ) )
   ```

In OpenLDAP 2.3, you can dynamically change the server configurations, but you can only extend the schema. You cannot modify or delete the existing schema. Instead of creating another objectclass for this attribute in the dynamic configuration, use the static configuration file, slapd.conf.

3. In slapd.conf, include indexing for the new attribute in the bdb section of your main database backend.

   ```
   database bdb (configs here) ....
   
   index servnowid pres
   
   (other indexes here) ..... 
   ```

4. As root, run slapindex to index this attribute to make it available in search filters. Make sure that the OpenLDAP daemon is not running or is in read-only mode before starting slapindex.

LDAP monitor

The LDAP monitor provides the current status of the LDAP servers and listener (starting with the Eureka release).

Monitoring the current health of your LDAP configuration can help with LDAP diagnostics and maintenance.
LDAP monitor

The available states are:
- Active
- Inactive
- Error
- Active (Shutting down...)
- Error (Shutting down...)

In addition to its current state, the monitor also shows:
- The last message detected by the listener, such as waiting for LDAP changes, error connecting, and so forth.
- The last LDAP user change, such as new user, updated user, and so forth.
- The last error that occurred.

View LDAP monitor
You can view current information about LDAP servers and listeners using LDAP monitor.

Role required: admin
To view LDAP monitor:

Navigate to **LDAP > System LDAP > LDAP Monitor**.

![LDAP Monitor screenshot](image)

See the table for descriptions of the properties and fields in the screen.

### LDAP monitor

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>You can configure the refresh rate by clicking the <strong>Refresh</strong> field in the LDAP Server Monitor header bar, and selecting the number of seconds between each data refresh. You can also select <strong>None</strong> to suppress refreshing.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>The server connection indicator is located on the right side, above the LDAP Listener Status fields. When the server is connected, the box is green and shows <strong>Connected</strong>. When the server is not connected, the box is red and shows <strong>Not Connected</strong>. When the server connection is being tested, the box is yellow and shows <strong>Testing Connection</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LDAP Server Properties</td>
<td>As you monitor LDAP servers, you can make changes to the properties by clicking Edit in the LDAP Server Monitor screen.</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Server URL</td>
<td>The combination of the server name and server port where the LDAP Server is listening. Frequently, the port is set to one of the following: - 389: the default port for connecting to LDAP in clear text  - 636: the standard port for connecting to LDAP via an SSL connection Example value: ldap://10.10.10.3:389/ Your LDAP Server may have more than one URL address. This does NOT establish multiple directory structures from which you can import data, which is done by creating another LDAP Server entry, but does provide for redundancy when you have multiple LDAP Servers to avoid a single point of failure. The LDAP URL addresses are separated with a space character, and the system automatically tries each server address in turn until a valid connection can be made.</td>
</tr>
<tr>
<td>Starting search directory</td>
<td>The starting directory or RDN (Relative Distinguished Name) where the system begins searching for users or groups. Example value: DC=service-now, DC=com No data ABOVE this point is available for import. The instance has visibility into the specified directory and directories BELOW it in the LDAP hierarchy.</td>
</tr>
<tr>
<td>MID Server Status</td>
<td>The current connection status of the MID Server.</td>
</tr>
<tr>
<td>LDAP Listener Status</td>
<td>Current Status This indicates whether the listener is active.</td>
</tr>
<tr>
<td></td>
<td>Last Info Message This shows the last message the LDAP server received relating to user and group changes, and the time the message was received.</td>
</tr>
<tr>
<td></td>
<td>Last Change This shows the last change made to the LDAP server, and the time it was made.</td>
</tr>
<tr>
<td></td>
<td>Last Error This shows the last error that occurred on to the LDAP server, and the time it occurred.</td>
</tr>
</tbody>
</table>

**Record LDAP deletions**

By default, the instance does not delete any entries after they disappear from LDAP.
Deleting an entry, also referred to as a record, also deletes the entire history and references to the deleted entry.

For example, configuration items (CIs), SLA agreements, software licenses, purchase orders, and service catalog entries all have a reference to Department, and if a department is deleted, then the integration clears all references to the department. Also, deleting a user results in losing all history of what that user did.

Decide whether to retain or manually delete records according to your organization’s needs.

**SAML 2.0**

The Security Assertion Markup Language (SAML) is an XML-based standard for exchanging authentication and authorization data between security domains.

SAML exchanges security information between an identity provider (a producer of assertions) and a service provider (a consumer of assertions). SAML is a product of the OASIS Security Services Technical Committee. When implemented correctly, SAML is one of the most secure methods of single sign-on available.

The SAML 2.0 integration enables single sign-on (SSO) by exchanging XML tokens with an external Identity Provider (IdP). The IdP authenticates the user and passes a NameID token to the system. If the system finds a user with a matching NameID token (for example, the email address), the instance logs that user in.

If you are using the SAML 2.0 plugin for SSO authentication, you need to set the glide.ui.rotate_sessions property to false. Otherwise, it interferes with the session information sharing that takes place between the instance and the Identity Provider. Users with the security_admin elevated privilege can access this high security property by selecting **System Security > High Security Settings**.

**Note:** It is recommended that customers using an existing SAML 2.0 integration upgrade to the latest Multi-Provider SSO plugin.

**Activate and set up SAML 2.0**

SAML 2.0 activates through the Integration - Multiple Provider Single Sign-On Installer plugin.

**Note:**

Activate the Integration - Multiple Provider Single Sign-On Installer plugin to set up SAML 2.0 authentication. Refer to this plugin when directed to find and click the plugin name.

1. **Navigate to System Definition > Plugins.**
2. **Find and click the plugin name.**
3. **On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.**
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive.**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. **Optional: If available, select the Load demo data check box.**

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

**Data preservation and SAML**

Preserving SAML SSO-related settings can prevent the target instance from redirecting all authentication requests to the original IdP with the wrong issuer and audience parameters.

To preserve SAML settings you will need to create data preservers for the following tables:

- System Property (sys_properties): to preserve SAML properties. See [Clone an instance with a SAML integration](#) for instructions.
- X.509 Certificates (sys_certificate): to preserve SAML certificates.
- User (sys_user): to preserve SAML users.

You also need to preserve properties, certificates, and users that are involved in SAML.

**Identity Provider (IdP) system properties**

An IdP generally offers an XML document containing their authentication and logout metadata. For example, [SSOCircle](#) publishes their metadata online.

Browse the IdP metadata to find these entries:

- The **SingleSignOnService** element with a Binding attribute that contains a value of `HTTP-Redirect`. The Location attribute lists the URL the integration requires for the AuthnRequest service.
- The **SingleLogoutService** element with a Binding attribute that contains a value of `HTTP-Redirect`. The Location attribute lists the URL the integration requires for the SingleLogoutRequest service.

**Note:** The SAML 2.0 integration only supports binding to IdP services by HTTP-Redirect.

For example:

```xml

```
IdP properties

Set the IdP issuer URL

Provide the URL to the IdP's who will issue the security token.

Role required: admin

The integration verifies that each SAML response contains the same URL listed in this system property as the URL listed in the Issuer element. For example:

```xml
<samlp:Response xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
    Destination="https://demo12.service-now.com/navpage.do"
    ID="s28da6774c88ae1eab292bf25fe625db81919d8e1e"
    InResponseTo="SNC841720c227c81948cf68cadcad235c6"
    IssueInstant="2012-01-30T20:07:10Z" Version="2.0">
    ...
    <saml:Assertion xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
        ID="s2f347f973c063836cf70ea38302d94976f9c5b851"
        IssueInstant="2012-01-30T20:07:10Z" Version="2.0">
        <saml:Issuer搜狐首页.com</saml:Issuer>
        ...
    </saml:Assertion>
</samlp:Response>
```

1. Navigate to SAML 2 Single Sign-on > Properties.
2. In the property The Identity Provider URL which will issue the SAML2 security token with user info., enter the URL to your IdP. Each IdP URL must be unique.
By default, the integration contains the URL to SSOCircle http://idp.ssocircle.com.

Set the AuthnRequest service URL
Using the IdP's metadata, set the request service URLs for the integration's IdP.
Role required: admin

1. In the property The base URL to the Identity Provider's AuthnRequest service. The AuthnRequest will be posted to this URL as the SAMLRequest parameter, enter the URL to the HTTP-Redirect binding obtained from the SingleSignOnService element.
2. Select the check box next to Sign AuthnRequest to enable the Identity Provider's single-sign on service to receive a signed AuthnRequest.
3. In the property When SAML 2.0 single sign-on fails because the session is not authenticated, or this is the first login, redirect to this URL. This is the base URL where the initial SAML 2.0 AuthnRequest is sent using the SAMLRequest parameter, enter the URL to the HTTP-Redirect binding obtained from the SingleSignOnService element.

By default, the integration contains the URL to the SSOCircle service.

Set the SingleLogoutRequest service URL
Using the IdP's metadata, set the request service URLs for the integration's IdP.
Role required: admin

1. In the following property, enter the URL obtained from the SingleLogoutService element: The base URL to the Identity Provider's SingleLogoutRequest service. The LogoutRequest will be posted to this URL as the SAMLRequest parameter. The LogoutRequest is posted to this URL as the SAMLRequest parameter.

By default, the integration contains the URL to the SSOCircle service.

2. In the property URL to redirect users after logout, typically back to the portal that enabled the SSO (e.g. http://portal.companya.com/logout), enter the URL where you want to redirect users after they successfully logout. If your IdP uses form-based authentication, enter the URL to your IdP's login form. If your IdP uses a non-form-based authentication method such as Kerberos, you should set the URL to a static logout page. This way, users who log out do not get immediately get redirected to the IdP and login again.

By default, the integration contains the URL to the static UI page external_logout_complete.do.

(Optional) Enable signed logout requests
Some IdPs require the Service Provider to sign logout requests with a certificate.
Role required: admin

If your IdP requires signed logout requests, use the IdP's metadata to set the following system properties.

1. From the property Sign LogoutRequest. Set this property to true if the Identity Provider's SingleLogoutRequest service requires signed LogoutRequest, select Yes to specify that your IdP requires a signed logout request, or select No to use unsigned logout requests.
2. If you selected Yes to Sign LogoutRequest, then in The protocol binding for the Identity Provider's SingleLogoutRequest service. (Value can be either "urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect" or "urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST") property, enter the one of the supported values listed in Binding attribute from the SingleLogoutService element.

By default, the integration uses an HTTP-Redirect binding.

3. Click Update.
4. **Install a Service Provider (SP) key store.**

Example third-party SAML identity provider (IdP) configuration
View a video showing a third-party SAML IdP configuration.

An instance does not typically provide instructions for configuring third-party SAML IdP products, but customers might occasionally provide examples of how they have implemented their SAML IdP with their instance.

**Note:** The instance does not provide support for example configurations.

<table>
<thead>
<tr>
<th>Identity Provider</th>
<th>Example Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSOCircle</td>
<td>SSOCircle (Video Tutorial)</td>
</tr>
</tbody>
</table>

**Service Provider (SP) system properties**
These system properties define how the instance interacts with the IdP as a Service Provider.
### Service Provider (Service-Now) properties

**The URL to the Service-now instance homepage.**
https://yourinstance.service-now.com/navpage.do

**The entity identification, or the issuer**
https://yourinstance.service-now.com

**The audience uri that accepts SAML2 token. (Normally, it is your instance URL. For example: https://demo.service-now.com.)**
https://yourinstance.service-now.com

**The User table field to match with the Subject’s NameID element in the SAMLResponse**
email

**The NameID policy to use for returning the Subject’s NameID in the SAMLResponse. Your SAML identity provider will have to support this by declaring the policy in its metadata. The NameID value is used to match with the specified field in the User table to lookup the user.**
urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress

Create an AuthnContextClass request in the AuthnRequest statement. **This tells the IdP that ServiceNow requires that they present a specific login mechanism such as a form, Kerberos, etc. If the AuthnRequest doesn’t specify an AuthnContextClass, the IdP will choose the most appropriate method.**

- Yes ❌ No

**The AuthnContextClassRef method that we will be included in our SAML 2.0 AuthnRequest to the Identity Provider**
urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport

**The alias of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests.**
saml2sp

**The password of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests.**

Service Provider properties

Set the instance URL for SAML
Set the instance-specific URLs so the IdP can authenticate users.
Role required: admin

1. In the property The URL to the Service-now instance (usually this instance), enter the URL (including login page) of the instance for which the IdP authenticates. For example: https://yourinstance.service-now.com/navpage.do

2. In the property The entity identification, or the issuer, enter the base URL (excluding login page) of the instance for which the IdP authenticates. For example: https://yourinstance.service-now.com/

Set the audience URL for SAML

The Audience system property allows your instance to verify that it is the intended recipient of a SAML response.

Role required: admin

The integration verifies that each SAML response contains the same URL listed in this system property as the URL listed in the Audience element. For example:

```xml
<samlp:Response xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol" ID="s2cdc74f37f923e26felaeeec42b70a93d24230334f" InResponseTo="90AA6073F01567BFB0DF194F596314E2" Version="2.0" IssueInstant="2010-04-29T23:21:51Z" Destination="https://dloomac.service-now.com/navpage.do">
  ...
  ...
</samlp:Response>
```

1. Navigate to SAML 2 Single Sign-on > Properties.

2. In the property The audience uri that accepts SAML2 token. ( Normally, it is your instance URI. For example: https://<instance name>.service-now.com.), enter the URL of your instance. For example, https://demoi2.service-now.com. This URL must match the value of the Audience element in the SAML Response.

3. Click Update.

Set up a NameID policy for SAML

SAML 2.0 requires the IdP to exchange a NameID token with the service provider.

Role required: admin

For the SAML 2.0 integration the NameID token must map to a particular field in the User table. The integration uses the NameID token’s value to determine what user the IdP authenticates.

1. Browse the IdP metadata to find the NameIDFormat element that contains a value of emailAddress. The value of this element is the default format that the integration uses.

2. Review other NameIDFormat elements to determine if there are formats that match other fields in the User table.

Determine what User table field matches the NameID token

Identity providers specify what format the NameID token has.

Role required: admin

Setting up SAML 2.0 requires selecting a field from the User table that matches the format of the NameID token. Typically, IdPs offer the option to use an email address as the NameID token. Since the User table contains an email field, this field is a logical choice for use as a NameID token. To use another field from the User table as the NameID token, first verify that the IdP offers a NameID
Set the IdP NameID policy
Set the IdP NameID policy to use for returning the Subject’s NameID in the SAMLResponse. Your SAML identity provider will have to support this by declaring the policy in its metadata. The NameID value is used to match with the specified field in the User table to lookup the user. By default, the integration uses the email field.

1. In the property The NameID policy to use for returning the Subject’s NameID in the SAMLResponse, enter the value of the NameIDFormat element the integration uses. By default, the integration uses the SSOCircle NameIDFormat for email addresses.
2. Click Save.

(Optional) Enable providing an authentication context class for SAML
You can enable the instance to send an authentication context class request to the IdP containing your instance’s preferred authentication request format.

Role required: admin

If you enable creating an AuthnContextClass message, then you must also specify an authentication context class reference format.

Note: Some IdPs do not allow the Service Provider to set the authentication context class. Disabling this setting allows the IdP to choose the authentication context class.

1. From the property Create an AuthnContextClass request in the AuthnRequest statement, select Yes to specify a particular context class such as Password Protected Transport, or select No to have the IdP select the most appropriate context class.
2. If you selected Yes to Create an AuthnContextClass request in the AuthnRequest statement, then in The AuthnContextClassRef method that we will request in our SAML 2.0 AuthnRequest to the Identity Provider property, enter the URN of the context class you want to use for authentication (see table).

AuthnContextClass URN options

<table>
<thead>
<tr>
<th>Authentication type</th>
<th>Authentication context class URN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms-based authentication</td>
<td>urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport</td>
</tr>
<tr>
<td>Kerberos-based authentication</td>
<td>urn:federation:authentication:windows</td>
</tr>
</tbody>
</table>
By default, the integration uses a Password Protected Transport authentication method.

3. Click **Update**.

(Optional) Set keystore properties for signing logout requests for SAML

The Keystore properties allow the integration to sign logout requests using your signed server and signed CA certificates.

Role required: admin

1. In the property **The alias of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests**, enter the alias name you created for the SAML 2.0 Keystore. By default, the integration looks for the alias saml2sp.
2. In the property **The password of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests**, enter the password to your SAML 2.0 Keystore. By default, the password is the same as the default alias name.
3. Click **Update**.
4. Regenerate your **SP metadata**.

Install a service provider keystore for signing SAML requests

Use the following steps to remove the existing example key store and install your own Service Provider keystore containing your public and private key pair.

Role required: admin

1. **Create a Service Provider key store.**
2. Navigate to **SAML 2 Single Sign-on > Certificate.**
3. Click **SAML 2.0 SP Keystore.**
4. Click the **Manage Attachments** link.
5. Select the Delete checkbox next to saml2sp_keystore.
6. Click **Remove.**
7. Click **Choose Files** and select the Keystore containing your signed certificates.
8. Click **Attach.**
9. Close the Attachments popup.
10. In **Key store password**, enter the password to access the SAML 2 alias.
11. Click **Update.**

Create a service provider keystore for SAML

In order for your instance to sign logout requests, you must create a Java Key store containing the following items.

- Signed server certificate for the instance
- Signed CA certificate
- Public and private key pair

You may create your own signed certificate with a private certificate authority or purchase one from a public certificate authority.

The following steps illustrate how to generate a new Java Keytool keystore file, create a certificate signing request (CSR), and import certificates. Any root or intermediate certificates need to be imported before importing the primary certificate for your domain. Type these commands in a command line interface.
Note: These instructions are not specific to the platform and require technical knowledge of security certificates to complete. Technical Support cannot assist in creating the certificates.

1. Generate a Java keystore and key pair.
   
   ```
   keytool -genkey -alias mydomain -keyalg RSA -keystore my.keystore
   ```

2. Generate a CSR for an existing Java keystore.
   
   ```
   keytool -certreq -alias mydomain -keystore my.keystore -file mydomain.csr
   ```

3. Import a root or intermediate certificate authority CA certificate to an existing Java keystore.
   
   ```
   keytool -import -trustcacerts -alias root -file Thawte.crt -keystore my.keystore
   ```

4. Import a signed primary certificate to an existing Java keystore.
   
   ```
   keytool -import -trustcacerts -alias mydomain -file mydomain.crt -keystore my.keystore
   ```

(Optional) Advanced SAML properties
The following advanced settings allow you to further increase security and debug the integration.

### Advanced settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The number of seconds &quot;notBefore&quot; constraint, or after &quot;notOnOrAfter&quot;</td>
<td>Enter the number of seconds to add to the NotBefore and NotOnOrAfter constraints to account for time differences between the IdP clock and SP clock. These constraints prevent against replay attacks by denying requests that are not made within the specified time frame. If the IdP clock and SP clock are significantly different, network latency may result in the SAML request being unauthorized. This property adds a grace period during which SAML requests and responses are still considered valid.</td>
</tr>
<tr>
<td>constraint, to consider still valid</td>
<td></td>
</tr>
<tr>
<td>Turn on debug logging for SAML 2.0 Authentication</td>
<td>Select Yes to enable additional logging information for SAML 2.0 events.</td>
</tr>
</tbody>
</table>
Install the identity provider certificate
You can paste a PEM certificate into a X.509 Certificate form so the identity provider can verify communications with the service provider.

Role required: admin

The IdP's certificate is located within the IdP's metadata. The IdP developer determines where the certificate metadata resides when creating the local IdP.

Note: Certificates for single-sign on should always be in PEM format to work with SAML certificates.

1. Navigate to **SAML Single Sign-on > Certificate**.
2. Fill in the form fields (see table).
3. Click **Save**.
### X.509 Certificate

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>SAML 2.0</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>PEM</td>
</tr>
<tr>
<td><strong>Expiration notification</strong></td>
<td>System Administrator</td>
</tr>
<tr>
<td><strong>Notify on expiration</strong></td>
<td>Valid from 2011-05-17 12:57:21</td>
</tr>
<tr>
<td><strong>Warning in days to expire</strong></td>
<td>Expires 2016-08-17 12:57:21</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Expires in days</strong></td>
<td>1,837</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>idp.sso.idc.de</td>
</tr>
<tr>
<td><strong>Issuer</strong></td>
<td>CN=IDP, O=SSOCircle, C=DE</td>
</tr>
<tr>
<td><strong>Subject</strong></td>
<td>CN=IDP, O=SSOCircle, C=DE</td>
</tr>
<tr>
<td><strong>PEMCertificate</strong></td>
<td>123Covvy58C78P1komeS3d6k08h1h018Cv82bW8Q09i8y6x72cxsasvfrn=5646d9c4m622q5w6780QAX88epefJ4B8y6h78h</td>
</tr>
</tbody>
</table>

**Related Links**
- Validate Store/Certificates
**Note:** The integration does not currently sign the certificate in communications between the instance and the IdP.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The certificate name. Do not change the Name entry. The name of the X.509 certificate must be SAML 2.0 in order for the integration to use it. This requirement is only true if you are not using External single sign-on (SSO).</td>
</tr>
<tr>
<td>Expiration notification</td>
<td>Select this option to send a notification to the users selected in the Notify on expiration field. By default, this is enabled.</td>
</tr>
<tr>
<td>Notify on expiration</td>
<td>Select the users to revive the notification regarding certificate expiration. If no users are selected, the logged in user is added by default, along with the last two logged in users with the administrator role.</td>
</tr>
<tr>
<td>Warn in days to expire</td>
<td>The number of days before expiration that the instance send the notification. Enter a value of at least 20. Instances upgraded to Istanbul and later releases have this value set to 20 unless a greater value is specified.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate that this certificate is active.</td>
</tr>
<tr>
<td>Format</td>
<td>The format of the certificate. SAML only uses the PEM format.</td>
</tr>
<tr>
<td>Type</td>
<td>The certificate container. The instance recognizes certificates from trust stores, Java keystore, and PKCS#12 keystores.</td>
</tr>
<tr>
<td>Valid from</td>
<td>The instance automatically adds the certificate valid from date to this field. Attach the certificate to the X.509 certificate record to populate this field.</td>
</tr>
<tr>
<td>Expires</td>
<td>The instance automatically adds the certificate expiration date to this field. Attach the certificate to the X.509 certificate record to populate this field.</td>
</tr>
<tr>
<td>Expires in days</td>
<td>The calculated number of days to expiration.</td>
</tr>
<tr>
<td>Short description</td>
<td>A description for the certificate.</td>
</tr>
<tr>
<td>Issue</td>
<td>The instance automatically adds the certificate issuer to this field. Attach the certificate to the X.509 certificate record to populate this field.</td>
</tr>
<tr>
<td>Subject</td>
<td>The instance automatically adds the certificate subject to this field. Attach the certificate to the X.509 certificate record to populate this field.</td>
</tr>
<tr>
<td>PEM Certificate</td>
<td>Enter the value of the X509 certificate.</td>
</tr>
</tbody>
</table>
Click **Validate Stores/Certificates** to test the trust store and certificate.

Replacing a missing certificate for SAML

If the **Certificate** module displays a blank page, the SAML 2.0 certificate record has been deleted.

You can replace the missing certificate by manually creating a certificate record.

Role required: admin

1. Navigate to **System Definition** > **Certificates**.
2. Create a new record called **SAML 2.0**.

   **Important:** You MUST use this name. This requirement is only true if you are not using *External single sign-on (SSO)*.

3. Click **SAML 2 Single Sign-on** > **Certificate**.
4. In the PEM Certificate field, enter the value of the **ds:X509Certificate** element from your IdP’s metadata.
5. Click **Save**.

Add a Java keystore for SAML

You can add Java keystores to the SAML application if you want another repository for your SAML security certificates.

Role required: admin

By default, SAML 2 Single Sign-on provides a default keystore named **SAML 2.0 SP Keystore** which uses 1024 bits and is SHA1. This keystore is active by default. If you need to use a key with 2048 bit key and SHA256, you need to activate this certificate before you generate your metadata with the x509 certificate. You can add keystores as needed and specify which one to use by default with a property.

1. Navigate to **System Definition** > **Certificates**.
2. Fill in the fields on the form (see table).
3. Click **Submit**.
X.509 Certificate form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select Active to keep the key store available.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a description for the key store.</td>
</tr>
<tr>
<td>Type</td>
<td>Select Java Key Store.</td>
</tr>
<tr>
<td>Key store password</td>
<td>Enter the password for the key store.</td>
</tr>
</tbody>
</table>

4. To set the default key store, enter `sys_properties.list` in the application filter.
   The list of system properties opens.
5. Find and open the following property: `glide.authenticate.sso.saml2.keystore`.
   The Value field shows the Sys ID of the default key store: **SAML 2.0 SP Keystore**. Use this property when the system has multiple key stores for signed authentication or signed logout. Starting with Geneva patch 7, this property uses your configured key store if you upgrade from a version prior to the Geneva release. Prior to the Geneva patch 7, this property kept the default value upon upgrade, regardless of any changes you made.
6. Paste the Sys ID of the key store record that you created into the Value field.
7. Click Update.

Install a service provider keystore for signing SAML requests
Use the following steps to remove the existing example key store and install your own Service Provider key store containing your public and private key pair.
Role required: admin

1. **Create a Service Provider key store.**
2. Navigate to SAML 2 Single Sign-on > Certificate.
3. Click SAML 2.0 SP Keystore.
4. Click the Manage Attachments link.
5. Select the Delete checkbox next to saml2sp_keystore.
6. Click Remove.
7. Click Choose Files and select the Keystore containing your signed certificates.
8. Click Attach.
9. Close the Attachments popup.
10. In Key store password, enter the password to access the SAML 2 alias.
11. Click Update.

**Generate instance service provider (SP) metadata for SAML**
After setting all the integration properties, generate the instance SP metadata.

Role required: admin

The IdP needs the instance SP metadata to authenticate and forward requests.

1. Navigate to SAML 2 Single Sign-on > Metadata. The integration automatically generates the instance's SP metadata from the system property settings.
2. Copy the SP metadata in the text box. For example:

```xml
<EntityDescriptor xmlns="urn:oasis:names:tc:SAML:2.0:metadata"
  entityID="https://demoi2.service-now.com">
  <SPSSODescriptor
    AuthnRequestsSigned="false" WantAssertionsSigned="false"
    protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">
    <SingleLogoutService
      Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect"
      Location="https://demoi2.service-now.com/navpage.do" />
    <NameIDFormat>urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress</NameIDFormat>
  </SPSSODescriptor>
</EntityDescriptor>
```

3. Provide the instance SP metadata to the IdP. For example, SSOCircle allows a user to provide the SP metadata online.

**Test the SAML integration**
After completing all other setup tasks, test the integration.

Role required: admin

1. Log in to the instance as a user with the admin role.
3. In the property Enable external authentication, select Yes.

**Note:**

Enabling external authentication requires all users to use SAML 2.0 single sign-on. Thus, if anyone tries to access the application in an unauthenticated state, the instance automatically sends an authentication request to the (IdP) and redirects the user to the SAML IdP Authentication page.

4. Click Save.
5. Log out of the instance.
6. Browse to the instance URL. If the integration is functioning properly, the IdP should ask for the users credentials.

Multi-SSO (SAML 2.0) errors and fixes
A list of common errors and associated fixes for a Multi-SSO (SAML 2.0) setup and configuration.

Errors during Multi-SSO (SAML 2.0) setup

<table>
<thead>
<tr>
<th>Error in instance logs</th>
<th>Test Connection Message</th>
<th>SAML property</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
</table>
| NotAfter: <Thu Jun 05 22:57:44 PDT 2014>. | Ensure that the IDP x509 certificate is present, valid, and active. | N/A | The current certificate or the SAML assertion has expired. | · Sync the SNC clock with the SAML IdP server clock.  
· Update the SAML 2.0 certificate record. |
| · Unable to locate SAML 2.0 certificate.  
· Could not find a digital signature stored in the ServiceNow instance. | Ensure that the IDP x509 certificate is present, valid, and active | The PEM-formatted string should be entered into the PEM Certificate field. | The SAML certificate does not exist. It might be inactive. | · Ensure that the correct PEM-formatted certificate is uploaded to the instance.  
· Verify that the certificate has the name SAML 2.0. No other names are allowed. |
| Certificates do not match. Expect: <certStr>, actual: <inboundCert>. | Ensure that the IDP x509 certificate is present, valid, and active. | N/A | The available certificate in SNC does not match the certificate in assertion. Causes include:  
· The certificate is updated on the IdP but not in the ServiceNow instance.  
· The certificate is in the wrong format. | Confirm that the PEM-formatted string in the SAML 2.0 certificate record matches the X509 Certificate in the SAMLResponse for the user IdP. |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Error in instance logs</th>
<th>Test Connection Message</th>
<th>SAML property</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure to check the validity of the certificate.</td>
<td>Ensure that the IDP x509 certificate is present, valid, and active</td>
<td>N/A</td>
<td>The current certificate might have expired.</td>
<td>Update the SAML 2.0 certificate record.</td>
</tr>
<tr>
<td>Failure to validate signature profile.</td>
<td>Ensure that the IDP x509 certificate is present, valid, and active</td>
<td>N/A</td>
<td>The assertion might be signed with a different certificate.</td>
<td>Check if the IdP has the same certificate as the SNC instance.</td>
</tr>
</tbody>
</table>
| InResponseTo attribute in SubjectConfirmationData mismatch. Expect: <inResponseTo>, actual: <inResponseTo>. | Subject confirmation validation failed. | N/A | This error appears if either of the following situations occurs:  
- The IdP returns a SAMLResponse for a different SAMLRequest  
- A user bookmarks the URL with the SAMLRequest instead of just the instance URL  
- If a null value is expected, the response might be sent to a different node when the instance has multiple nodes. | The IdP admin should confirm that the expected SAMLResponse is being returned. This situation can be a load balancer or infrastructure issue. |
| SessionIndex value not found: <message>... | SessionIndex not valid. | N/A | The SessionIndex is required in the SNC instance. The IdP returns it in the SAML response to authenticate successfully. | The IdP admin should confirm that the SessionIndex is defined in the SAMLResponse. |
| No valid SubjectConfirmation found. | Subject confirmation validation failed. | N/A | Conditions could be missing due to an error on the IdP. The StatusCode in the response would contain Responder instead of the expected Success. | Review SAMLResponse to determine if Conditions are included in the SAMLResponse. The valid subject confirmation data could be expired or not for the right audience. |
### Error in instance logs

<table>
<thead>
<tr>
<th>Test Connection Message</th>
<th>SAML property</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assertion audience mismatch. Expect: <code>&lt;propAudience&gt;</code>, actual: <code>&lt;audienceUri&gt;</code></strong>&lt;br&gt;<strong>or</strong>&lt;br&gt;AudienceRestriction validation failed. No matching audience found.</td>
<td>Ensure that the 'Audience URI' field is set correctly</td>
<td>The audience URI that accepts the SAML2 token. (Normally, it is your instance URI. For example: <a href="https://demo.service-now.com">https://demo.service-now.com</a>)</td>
<td>Locate <code>&lt;saml2:Audience&gt;</code> in the SAMLResponse in the logs and verify that the value matches the one on the instance.</td>
</tr>
<tr>
<td><strong>Assertion issuer is invalid. Expect: <code>&lt;value on instance&gt;``, actual: </code>&lt;value returned by IdP&gt;`</strong>&lt;br&gt;Audition issuer is invalid.</td>
<td>The Identity Provider URL that issues the SAML2 security token with user info.</td>
<td>The IdP entity id (issuer) does not match the value defined in the SNC instance.</td>
<td>Check if IdP or SP is not configured properly.&lt;br&gt;Confirm that the SAML property (the Identity Provider URL that issues the SAML2 security token with user info) is set correctly.</td>
</tr>
<tr>
<td><strong>Subject is valid in the future. Now: <code>&lt;now&gt;</code></strong>, NotBefore: <code>&lt;notBefore&gt;</code>&lt;br&gt;<strong>or</strong>&lt;br&gt;Subject is expired. Now: <code>&lt;now&gt;</code>**, NotOnOrAfter: <code>&lt;notOnOrAfter&gt;</code> <strong>Subject validation confirmation failed.</strong>&lt;br&gt;The number in seconds before notBefore constraint, or after notOnOrAfter constraint, to consider still valid.</td>
<td>The IdP clock is not synced with SP clock.</td>
<td>Update the SAML property <code>glide.authenticate.sso.saml2.clockskew</code> to a larger value. Default of 180 seconds. Some cases require a setting of 300 or higher. You may also need to check the time on your IdP server.</td>
<td></td>
</tr>
<tr>
<td><strong>Assertion is valid in the future, now: <code>&lt;now&gt;</code></strong>, notBefore: <code>&lt;notBefore&gt;</code>&lt;br&gt;<strong>or</strong>&lt;br&gt;Assertion is expired, now: <code>&lt;now&gt;</code>**, notOnOrAfter: <code>&lt;notOnOrAfter&gt;</code> <strong>Assertion is invalid.</strong>&lt;br&gt;The number in seconds before notBefore constraint, or after notOnOrAfter constraint, to consider still valid.</td>
<td>IdP clock is not synced with SP clock.</td>
<td>Update the SAML property to a larger value. Default of 60 seconds. Some cases require a setting of 300 or higher. You may also need to check the time on your IdP server.</td>
<td></td>
</tr>
</tbody>
</table>
### Common login and IdP errors

<table>
<thead>
<tr>
<th>Error or Symptom</th>
<th>Diagnosis</th>
<th>Fix</th>
</tr>
</thead>
</table>
| Login requests generate an infinite loop between the system and the IdP when High Security is active. | - Typically the URL endpoint is an error page or logout page.  
- The logout_redirect.do might create this loop when you define glide.security.url.whitelist without adding the IdP host name to the property value. | Set (or create) the system property glide.authenticate.failed_redirect to redirect failed authentication requests to this URL. |
| The token used to authenticate the user or the request is signed with the signature algorithm http://www.w3.org/2001/04/xmldsig-more#rsa-sha256 which is not the expected signature algorithm http://www.w3.org/2000/09/xmldsig#rsa-sha1. | Check the Alert Context tab for event details. | Navigate to the Advanced tab of the Relying Party Trust configuration dialog and verify that the algorithm is set to SHA-1 and not SHA-256. |

**Force single sign-on login (SSO) only**

When single sign-on is enabled, you might not want users to see the login page or allow user to login locally.

In other words, if a user attempts to go to https://customerX.service-now.com, the internal company portal should be displayed instead of the default login page. Likewise, when a user logs out of the application, the browser should redirect them to a specific internal page. You can set redirection properties within the instance to ensure that users see the single sign-on page rather than the default login page.

### Redirection properties

When a user logs out, or if there is a failed attempt to sign on using SSO, you can define where the user is taken next, such as a main portal page or a knowledge base article with SSO login information. Use the following properties to specify the URLs. If one of these properties does not exist in your instance, you can create the property.

- **glide.authenticate.failed_requirement_redirect**
  URL to redirect users when they attempt to access a page that is private (for example, to view an incident) and do not provide SSO credentials. The property is typically set to a customer's login portal (for example, http://portal.companya.com/).

- **glide.authenticate.failed_redirect**
  URL to redirect users after a failed SSO attempt. You can redirect to a public knowledge article that describes the error and has helpful links (for example, http://portal.companya.com/error).

- **glide.authenticate.external.logout_redirect**
  URL to redirect users after logging out, typically back to the portal that enabled the single sign-on log in (for example, http://portal.companya.com/logout).

- **glide.authentication.external.disable_local_login**
When set to true, requires SSO credentials for the main login page. Defaults to false. This property needs to be used in conjunction with the glide.authenticate.failed_requirement_redirect property.

The following table shows the relationship between the Installation Exit return values, the properties, and the expected behavior.

### Forcing login using SSO only

<table>
<thead>
<tr>
<th>Return value</th>
<th>Property</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>failed_missing_requirement</td>
<td>glide.authenticate.failed_requirement_redirect</td>
<td>When this value is returned, it indicates that the required SSO credentials are not present in the session. Login fails and the session is redirected to the URL specified by the property. This is usually the URL for the SSO provider where login is challenged and credentials are collected.</td>
</tr>
<tr>
<td>failed_authentication</td>
<td>glide.authenticate.failed_redirect</td>
<td>When this value is returned, it indicates that the supplied SSO credentials failed authentication, the user does not exist, or the user is locked out. Login fails and the session is redirected to the URL specified by the property. This is usually the URL for the SSO provider where login is challenged and credentials are collected.</td>
</tr>
<tr>
<td>&lt;user_id&gt;</td>
<td>N/A</td>
<td>Login authorized for the user specified by &lt;user_id&gt;. This value matches with the field name defined in the SSO property glide.authenticate.header.value (&quot;the instance's field name to match against the incoming header&quot;)</td>
</tr>
</tbody>
</table>

### Restricting local login

As a security precaution, you should do more than rely on redirection properties to prohibit logging in locally. If a user should never log in locally and will always be authenticated by your internal single sign-on system, then a random password should be assigned to each user that is imported into the instance. The random password is most easily set at the time of the user import. If the user data is imported into your system through an import set, you can create an onBefore transform script using the following code.

```javascript
var r = new Packages.java.util.Random();
var str1 = Packages.java.lang.Long.toString(Packages.java.lang.Math.abs(r.nextLong()), 36);
var str2 = Packages.java.lang.Long.toString(Packages.java.lang.Math.abs(r.nextLong()), 36);
```

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
var newPass = str1 + str2;

target. user_password = newPass;

//password now set to a random string like this:
//qvm8lzdrn7cwwylpvw94eebk

SAML 2.0 concepts
Familiarize yourself with these SAML concepts.

Typical SAML process flow (diagram)
A typical SSO logic flow involves looking for an active session, checking user credentials, and creating the necessary token.
Login (AuthnRequest) process flow
SAML 2.0 specifies a Web Browser SSO Profile that involves exchanging information among an
identity provider (IdP), a service provider (SP), and a principal (user) on a web browser.

The identity provider can be any SSO service offering SAML authentication services (for example
SSOCircle). The service provider is always an instance. The message flow begins with a request for
a secured resource at the service provider.

Request the target resource at the SP
The principal requests a target resource at the service provider:
https://instance.service-now.com/

The instance checks the request to see if the SAMLRequest and RelayState URL parameters are
present. If they exist, the user has already validated with the IdP and can skip steps 2–6.

Issue AuthnRequest to Identity Provider
The instance constructs an AuthnRequest to be sent to the IdP using the SAMLRequest value. The
instance also constructs and sends a RelayState URL parameter value.

The RelayState token is an opaque reference to state information maintained at the service
provider. The value of the SAMLRequest parameter is the deflated and base64 encoded value of
the <samlp:AuthnRequest> element:

```
<samlp:AuthnRequest xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
   xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion" ID="identifier_1"
   Version="2.0" IssueInstant="2004-12-05T09:21:59Z"
   AssertionConsumerServiceIndex="0"><saml:Issuer>https://sp.example.com/
   SAML2</saml:Issuer><samlp:NameIDPolicy AllowCreate="true"
   Format="urn:oasis:names:tc:SAML:2.0:nameid-format:transient"/></
samlp:AuthnRequest>
```

The integration then URL-encodes the <samlp:AuthnRequest> element and sends it as the
SAMLRequest URL parameter.

The SSO service processes the <samlp:AuthnRequest> element by URL-decoding, base64-decoding and inflating the request, in that order. If it then performs a security check. If the
user does not have a valid security context, the IdP identifies the user by prompting for login
credentials. If the user is already logged in, the IdP simply responds with the SAMLResponse<tt>
and <tt>RelayState URL parameters (see step 3).

Respond with an SAMLResponse and RelayState
After collecting the required login credentials, the SSO service validates the request and responds
with a document containing an XHTML form:

```
<form method="post" action="https://instance.service-now.com/
navpage.do" ...><input type="hidden" name="SAMLResponse"
value="response ..." /><input type="hidden" name="RelayState"
value="token ..." />
...</form>
```
The value of the `RelayState` parameter comes from this step. The value of the `SAMLResponse` parameter is the base64 encoding of the following `samlp:Response` element:

```
<samlp:Response xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
    ID="s2cde74f3f923e26f6aee1c4ebf70a93d24230334f"
    InResponseTo="90AA6073F01567BF0DF194F596314E2" Version="2.0"
    <samlp:Status xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol">
        <samlp:StatusCode xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
    </samlp:Status>
    <saml:Assertion xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
        ID="s23e536bfc51b8487d4d3299dec162d9c2e338823b"
        <Signature xmlns="http://www.w3.org/2000/09/xmldsig#">
            ...
        </Signature>
        <saml:Subject>
            <saml:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress"
                           NameQualifier="http://idp.ssocircle.com" SPNameQualifier="https://dloomac.service-now.com/navpage.do">
                david.loo@service-now.com
            </saml:NameID>
            <saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
                <saml:SubjectConfirmationData InResponseTo="90AA6073F01567BF0DF194F596314E2"
            </saml:SubjectConfirmation>
        </saml:Subject>
        <saml:Conditions NotBefore="2010-04-29T23:11:51Z"
                           NotOnOrAfter="2010-04-29T23:31:51Z" saml:Condition>
        </saml:Conditions>
        <saml:AuthnStatement AuthnInstant="2010-04-29T23:21:51Z">
            <saml:AuthnContext/>
        </saml:AuthnStatement>
    </saml:Assertion>
</samlp:Response>
```

**Validate SAMLResponse**

The `SAMLResponse` value is base64 decoded and inflated to reveal the XML document in step 3. The login script extracts the XML value from the `//Subject/NameID` element and uses it to look up an existing user in the User table.

The login script also extracts the session ID from the `//AuthnStatement/@SessionIndex` element and stores it for the `LogoutRequest`.

**Logout (LogoutRequest) process flow**

During logout, the instance issues the SAML 2.0 LogoutRequest service call to the IdP.

This service logs the user out and then redirects back to the specified logout URL.
User Clicks the Logout Button

The user clicks the **Logout** button and the instance executes the logout script.
LogoutRequest issued

The logout script constructs a SAML 2.0 LogoutRequest and posts it to the preconfigured SingleLogoutRequest SAML 2.0 service at the IdP. The IdP deflates the request and then base64 encodes it. An example LogoutRequest looks like this:

```xml
<saml2p:LogoutRequest xmlns:saml2p="urn:oasis:names:tc:SAML:2.0:protocol"
  ID="21B78E9C6C8ECF16F01E4A0F15AB2D46"
  IssueInstant="2010-04-28T21:36:11.230Z" Version="2.0">
  <saml2:Issuer
    xmlns:saml2="urn:oasis:names:tc:SAML:2.0:assertion">
    https://dloomac.service-now.com
  </saml2:Issuer>
  <saml2:NameID
    xmlns:saml2="urn:oasis:names:tc:SAML:2.0:assertion"
    Format="urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress"
    NameQualifier="http://idp.ssocircle.com"
    SPNameQualifier="https://dloomac.service-now.com/navpage.do">
    david.loo@service-now.com
  </saml2:NameID>
  <saml2p:SessionIndex>s211b2f811485b2a1d2cc4db2b271933c286771104</saml2p:SessionIndex>
</saml2p:LogoutRequest>
```

User Logs Out

The user logs out of the IdP. The IdP redirects back to the instance, which in turns redirects back to the IdP since the user is not logged in.

**URL information for an SSO provider**

During a login challenge resulting from a URL link into the instance that requires an SSO session, the referring URL might need to be supplied to the SSO provider so that after authentication, the URL can be passed back to the instance and linked to the correct resource.
SSO Logic Flow w/ Target Redirect

Installation exit return values have been enhanced to pass a URL instead of, or in addition to the URL defined by the properties. Usually, you would return a username or a predefined string value.
to control authorize or challenge the SSO session. The following examples show the extended behavior of passing a URL.

```
return "failed_missing_requirement:%26amp;TARGET=https://instance.service-now.com/nav_to.do?uri=incident.do?sys_id=12345";
```

The example above passes the URL `https://instance.service-now.com/nav_to.do?uri=incident.do?sys_id=12345` to the SSO provider in the form of a URL parameter named TARGET.

**Note:** It is assumed that the SSO provider will use that information in the TARGET parameter to redirect back to the instance when the user credentials have been collected and authentication passed.

A colon : demarcates the two return values and an encoded & (%26amp;) concatenates the URL defined in the property `glide.authenticate.failed_missing_requirement` and the TARGET parameter.

### SAML 2.0 Single Sign-On — Update 1

The SAML 2.0 Single Sign-On - Update 1: security enhancements plugin improves integration security by requiring additional checks against the SAMLResponse URL parameter.

The integration explicitly checks the SAML response for the proper Identity Provider (IdP) and intended audience URLs.

#### Additional SAML response validations

With Update 1, the integration validates these elements in the SAMLResponse.

- An Issuer element that matches the value listed in the issuer system property
- The SubjectConfirmation and SubjectConfirmationData elements with a Recipient attribute
- The AudienceRestriction and Audience elements that match the value listed in the audience system property

#### Support for Signed SingleLogoutRequest

With Update 1, the SAML 2.0 integration has the option to sign SingleLogoutRequest elements. Some IdPs, such as Microsoft ADFS, require a signed SingleLogoutRequest.

#### Support for AuthnContextClass

With Update 1, the SAML 2.0 integration has the option to specify the method by which the IdP authenticates the user in the AuthnContextClass element. For example, the integration can now specify contexts such as form-based Password Protected Transport or Kerberos. See [Optional](#) Enable Providing an Authentication Context Class for instructions on setting an authentication context class.

### Properties

The SAML 2.0 Update 1 plugin includes the following system properties.

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1166
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Identity Provider URL which will issue the SAML2 security token with user info. glide.authenticate.sso.saml2.idp</td>
<td>Enter the value of the Issuer element that the integration uses to validate the IdP URL. Each IdP URL must be unique.</td>
</tr>
<tr>
<td>Sign LogoutRequest. Set this property to true if the Identity Provider's SingleLogoutRequest service requires signed LogoutRequest. glide.authenticate.sso.saml2.require_signed_logoutrequest</td>
<td>Select whether the IdP requires a signed logout request.</td>
</tr>
<tr>
<td>Select whether the IdP requires a signed logout request. glide.authenticate.external.logout_redirect</td>
<td>Enter the URL where the integration redirects users after they log out. Typically, you set this property to a UI page if you are using Kerberos authentication to prevent users from being redirected back to the IdP and logging in again after a logout request.</td>
</tr>
<tr>
<td>The audience URI that accepts SAML2 token. (Normally, it is your instance URL. For example: https://&lt;instance name&gt;.service-now.com.) glide.authenticate.sso.saml2.audience</td>
<td>Enter the value of the Audience element that integration uses to validate the SP URL in the SAMLResponse.</td>
</tr>
<tr>
<td>Create an AuthnContextClass request in the AuthnRequest statement. glide.authenticate.sso.saml2.createrequestedauthncontext</td>
<td>Select whether to create an AuthnContextClass element in the SAMLRequest that specifies the login mechanism the IdP should use to authenticate the user. Not all IdPs support a AuthnContextClass element in the SAMLRequest. If you select Yes, you must specify the URN of the context class with the glide.authenticate.sso.saml2.authncontextclassref property.</td>
</tr>
<tr>
<td>The AuthnContextClassRef method that we will request in our SAML 2.0 AutnRequest to the Identity Provider glide.authenticate.sso.saml2.authncontextclassref</td>
<td>Enter the URN of the login mechanism you want the IdP to use to authenticate users. For example, by default the system uses the forms-based Password Protected Transport authentication context urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport.</td>
</tr>
<tr>
<td>The alias of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests. glide.authenticate.sso.saml2.signing_key_alias</td>
<td>Enter the alias of the key that signs SAML 2 logout requests. You will have to create a Java Keystore for the alias.</td>
</tr>
<tr>
<td>The password of key entry stored in SAML 2.0 SP Keystore used to sign SAML 2 requests. glide.authenticate.sso.saml2.signing_key_password</td>
<td>Enter the password for the key that signs SAML 2 logout requests.</td>
</tr>
<tr>
<td>The number in seconds before &quot;notBefore&quot; constraint, or after &quot;notOnOrAfter&quot; constraint, to consider still valid. glide.authenticate.sso.saml2.clockskew</td>
<td>Enter the number of seconds between the two attributes that make up the SAMLResponse nonce. A valid SAMLResponse must fall between the notBefore and notOnOrAfter date-time values.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AuthnRequest URL for eSignature Authentication.</td>
<td>Enter the URL that points to the SAML 2.0 Identity Provider AuthnRequest Consumer for eSignature Authentication. In most cases, this will be the same as the AuthnRequest URL used in general authentication. Leave this setting blank if you intend to use the same AuthnRequest Consumer URL that is used for general SAML 2.0 authentication in your instance.</td>
</tr>
<tr>
<td>The SAML 2.0 Assertion Consumer URL for eSignature authentication.</td>
<td>In most cases, this URL will be: <a href="https://YOURINSTANCE.service-now.com/consumer.do">https://YOURINSTANCE.service-now.com/consumer.do</a>. However, if you employ a customized method of handling the SAML authentication for eSignature, you can set up your own consumer URL.</td>
</tr>
<tr>
<td>The SAML 2.0 Assertion Consumer Index for eSignature authentication.</td>
<td>If your Service Provider has more than one URL set for the AssertionConsumerURL, you can set the index to use for eSignature, starting with index 1 or more.</td>
</tr>
<tr>
<td>Authentication Pop-up Dialog Width.</td>
<td>When a user approves a request using eSignature, a dialog allows the user to enter their credentials. This setting controls the width of that dialog box.</td>
</tr>
<tr>
<td>Authentication Pop-up Dialog Height.</td>
<td>When a user approves a request using eSignature, a dialog allows the user to enter their credentials. This setting controls the height of that dialog box.</td>
</tr>
</tbody>
</table>

**SAML 2.0 update 1 requirements**

The SAML 2.0 update requires:

- Activating the SAML 2.0 Update 1 plugin
- Additional metadata from the SAML 2.0 Identity Provider (IdP)
  - SAML Request can include an AuthnContextClass element to specify the Service Provider's preferred login mechanism such as form-based authentication or Kerberos. If this element is not specified, the IdP chooses the login method.
  - SAML Response must include an Issuer element that matches the value listed in the issuer system property
  - SAML Response must include SubjectConfirmation and SubjectConfirmationData elements with a Recipient attribute
  - SAML Response must include AudienceRestriction and Audience elements that match the value listed in the audience system property

**SAML 2.0 integration requirements**

The SAML 2.0 integration requires several items, such as an IdP that provides a certificate and a single logout service.

- Activating the latest SAML 2.0 plugin
- Access to a SAML 2.0 Identity Provider (IdP)
- Must provide an authentication request service
- Must provide a single logout service
- Must have a valid certificate
- Must accept Service Provider (SP) metadata
- Must use the NameID element in the SAMLResponse

Upgrade from previous versions

The following table lists the actions to take if you are running a previous versions of SAML.

<table>
<thead>
<tr>
<th>Previous SAML version</th>
<th>Action required</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAML 1.1</td>
<td>Contact ServiceNow Technical Support to migrate your instance to SAML 2.0 Update 1.</td>
</tr>
<tr>
<td>SAML 2.0</td>
<td>Update to SAML 2.0 Update 1.</td>
</tr>
</tbody>
</table>

Integrating SAML 2.0 with other features

You can integrate your SAML 2.0 solution with other features like E-Signature, deep linking, and ADFS.

Add E-Signature support for SAML

Configure the following properties for E-Signature with SAML 2.0 update 1.

When E-signature is active with Multi-SSO, SAML properties are not used. The system adds E-signature properties to the SAML2 Update1 Properties (saml2_update1_properties) table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assertion Consumer Index for eSignature</td>
<td>An index number that identifies the endpoint.</td>
<td>1</td>
</tr>
<tr>
<td>Assertion Consumer URL for eSignature</td>
<td>The URL that identifies the consumer.</td>
<td><a href="https://yourinstance.service-now.com/consumer.do">https://yourinstance.service-now.com/consumer.do</a></td>
</tr>
<tr>
<td>AuthnRequest URL for eSignature Authentication</td>
<td>The URL for authentication</td>
<td>none</td>
</tr>
</tbody>
</table>

If you are using E-Signature with SAML 1.0 or SAML 2.0 (not including update 1), see the special configuration instructions: Using E-Signature with Single Sign-On (SSO).

Note: If you are a Life Science Customer using E-Signature, deactivate the User self-lockout prevention business rule. See KB0547061 for more information.

Add deep linking support for SAML

Deep linking allows instances to support direct email links to a particular record in the system.

With the SAML 2.0 integration enabled, deep-linking URLs must pass an authentication check before the IdP redirects the user to the originally requested URL. For example, consider an email that contains this URL: https://<instance name>.service-now.com/nav_to.do?uri=incident.do?sys_id=46c88ac1a9fe1981014de1c831fbcf6d

The instance sends an authentication request to the IdP and uses the RelayState URL parameter to preserve the originally requested resource (in this case, uri=incident.do?sys_id=46c88ac1a9fe1981014de1c831fbcf6d). After the IdP authenticates the user, the
instance reads the value of the RelayState URL parameter and redirects the user to the requested resource (if it exists in the instance).

To add support for deep linking verify that the identity provider supports the RelayState URL parameter.

**ADFS integration with SAML 2.0**

SAML 2.0 single sign-on (SSO) supports integration with Microsoft Active Directory Federation Services (ADFS) 3.0.

For information about installing and configuring ADFS, see [Active Directory Federation Services Overview](#).

---

**Note:** Multi-line attributes are not supported in the SAML Response in ServiceNow for ADFS.

---

**Set up ADFS for SAML**

This procedure uses ADFS 2.0 and shows samportal.example.com as the ADFS website. Replace this with your ADFS website address.

Role required: admin

1. Log into the ADFS 3.0 server and open the management console.
2. Right-click **Service** and choose **Edit Federation Service Properties**.
3. Confirm that the General settings match your DNS entries and certificate names.
4. Browse to the certificates and export the Token-Signing certificate.
   a) Right-click the certificate and select **View Certificate**.
   b) Select the **Details** tab.
   c) Click **Copy to File**. The Certificate Export Wizard opens.
   d) Select **Next**.
   e) Ensure the **No, do not export the private key** option is selected, and then click **Next**.
   f) Select **DER encoded binary X.509 (.cer)**, and then click **Next**.
   g) Select where you want to save the file and give it a name. Click **Next**.
   h) Select **Finish**. The instance requires that this certificate be in PEM format. You can convert this certificate using client tools or even online tools such as: SSL Shopper.

5. Use the DER/Binary certificate that you just created, and export it in Standard PEM format.
Set up the instance for ADFS

After you set up ADFS 2.0 or 3.0, set up the instance and SAML 2.0 settings to work with ADFS.

Role required: admin

1. If not already active, activate the Integration - Multiple Provider Single Sign-On Installer plugin.
2. Configure SAML 2.0, but when you install the IdP certificate, attach the PEM certificate you created when you Set up ADFS for SAML.
3. Click Save.
4. Verify that the Issue and Subject fields have values and that there are no errors. If an error occurs, open the saved PEM formatted certificate in Notepad and copy and paste the certificate into the PEM Certificate field.
5. Verify that the SAML2SingleSignon_update1 installation exit is active.
6. Continue the SAML 2.0 configuration.

---

**Note:** When a certificate is updated on the ADFS server, you also need to upload an updated certificate to the instance.

---

Configure an ADFS relying party

At this point you can take the instance metadata and import it into your ADFS server. However, manual configuration of the relying party appears to be easier to implement.

Role required: admin

1. Navigate to SAML 2 Single Sign-on > Properties and verify that the SAML property Sign AuthnRequest (glide.authenticate.sso.saml2.require_signed_authnrequest) is not active. Only keep this property active if your ADFS administrator can verify that you require signed requests.
2. Copy the metadata that you generated through the SAML 2 metadata link and save it to a file.
3. Log into the ADFS server and open the management console.
5. Select Add Relying Party Trust from the top right corner of the window.
   The wizard appears.
6. Click Start to begin.
7. Use the Import File option to import the metadata file.
8. Give it a display name such as ServiceNow and enter any notes you want.
9. Select ADFS 3.0 Profile.
10. Do not select a token encryption certificate. It will use the certificate that is defined on the service that has already been exported. Defining a certificate here will prevent proper communication with the instance.
11. Do not enable any settings on the Configure URL.
12. Enter the instance site to which you connected as the Relying Party trust identifier. In this case use https://company.service-now.com and click Add.
13. Permit all users to access this relying party.
14. Click Next and clear the Open the Claims when this finishes check box.
15. Close this page. The new relying party trust appears in the window.
16. Right-click on the relying party trust and select Properties.
17. Browse to the Advanced tab and set the Secure hash algorithm to SHA-1.

Configure ADFS relying party claim rules
Edit the Claim rules to enable proper communication with the instance.

Role required: admin

1. Log into the ADFS server and open the management console.
2. Right-click the relying party trust and select **Edit Claim Rules**.
3. Click the **Issuance Transform Rules** tab.
4. Select **Add Rules**.
5. Select **Send LDAP Attribute as Claims** as the claim rule template to use.
6. Give the claim a name such as **Get LDAP Attributes**.
7. Set the **Attribute store** to **Active Directory**, the **LDAP Attribute** to **E-Mail-Addresses**, and the **Outgoing Claim Type** to **E-mail Address**.
You can configure this rule to send the values of LDAP attributes as claims. Select an attribute store from which to extract LDAP attributes. Specify how the attributes will map to the outgoing claim types that will be issued from the rule.

**Claim rule name:**

**Get Attribute**

**Rule template:** Send LDAP Attributes as Claims

**Attribute store:**

*Active Directory*

**Mapping of LDAP attributes to outgoing claim types:**

<table>
<thead>
<tr>
<th>LDAP Attribute (Select or type to add more)</th>
<th>Outgoing Claim Type (Select or type to add more)</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶  E-Mail-Addresses</td>
<td>▶  E-Mail Address</td>
</tr>
</tbody>
</table>

```
c:[Type == "http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname", Issuer == "AD AUTHORITY"] => issue(store = "Active Directory",)
```
types = ("http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress"),
query = ";mail;{0}\", param = c.Value);

8. Select Finish.
9. Select Add Rules.
10. Select Transform an Incoming Claim as the claim rule template to use.
11. Give the Claim a name such as Email to Name ID.
12. Set the Incoming claim type to the Outgoing Claim Type in the previous rule. For example, E-Mail Address.
13. Set the Outgoing claim type to Name ID and the Outgoing name ID format to Email.

Note: These values must match the Name ID policy you define during SAML 2.0 configuration.

14. Select Pass through all claim values.
This claim rule should look similar to the following rule language.

c:[Type == "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress"]
Create a SAML logout endpoint
Create a SAML logout endpoint to allow single logout.
Role required: admin
See this article on ADFS signout for more information.

Note: An IdP initiated logout is not supported.

1. Go to ADFS manager > Trust Relationships > Relying Party Trusts > properties.
2. Under the Endpoints tab, click Add.
3. Configure the settings:
   - Endpoint Type: SAML Logout
   - Binding: POST
   - URL: https://myadfsserver.domain.net/adfs/ls/?wa=wsignout1.0

Test the ADFS configuration
Test your ADFS configuration to verify that it is properly functioning as an identity provider.
Role required: admin
1. Open an Internet Explorer browser.
   This page contains a drop down list of all configured Relying Party Trusts.
3. Select the relying party associated with your instance.
4. Click Continue to Sign In.
   If you have configured the SAML 2.0 external authentication properly, you should be automatically logged into the instance.

(Workaround) Enable service provider-initiated authentication
A workaround is available if authentication fails because you do not have SAML 2.0 Update 1. This can happen if users attempt to skip IdP authentication and navigate directly to the instance.
Role required: admin
This is an error with the instance not providing ADFS with the needed definition and semantics for the SPNameQualifier attribute in the SAMLResponse.
To enable service provider-initiated authentication, do one of the following
- Upgrade to SAML 2.0 Update 1 and clear the option to create an AuthnContextClass request. See Activate and set up SAML 2.0.
- Modify the SAML2 script include to comment out the definitions of the SPNameQualifier attribute when you have SAML 2.0 active (not SAML 2.0 Update 1).
Comment out these lines in the `createNameID` and `createNameIDPolicy` functions:

```java
//nid.setSPNameQualifier (serviceURL ) ;
//nameIdPolicy. setSPNameQualifier (serviceURLStr ) ;
```

If you do not want the login prompt from your ADFS server to appear when you access the instance, set the following SAML 2.0 Update 1 property to false: **Create an AuthnContextClass request in the AuthnRequest statement** *(glide.authenticate.sso.saml2.createrequestedauthncontext)*.

### (Workaround) Support Kerberos authentication

A workaround is available for the SAML 2.0 integration that changes the authentication context from forms-based authentication to Windows-based authentication.

**Role required: admin**

Currently, the SAML 2 integration uses a PasswordProtectedTransport or “forms-based authentication” authentication context. This authentication context requires the IdP to present users with a form for authentication credentials. With Kerberos, a SAML session is already active through an established Windows login, so the user does not need to authenticate with the IdP.

1. Navigate to **Multi-Provider SSO > Identity Providers**.
2. Open the **SAML2 Update1 IdP record**.
3. Set the **The AuthnContextClassRef method that we will be included in our SAML 2.0 AuthnRequest to the Identity Provider** to one of the following:

   **AuthnContextClassRef method values**
   
<table>
<thead>
<tr>
<th>Default Value</th>
<th>Alternative Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>:---:</td>
<td>:---:</td>
</tr>
</tbody>
</table>

4. **Click Update**.

### Email links with external authentication

You can use email links when using the digestive token external authentication, however, you must establish how to handle links in email notifications.

The default links contain a URL that directs you to a specific location in the instance, like an Incident or Change Request, without incorporating SSO credentials. Below are examples for directing the user to the location in the instance without logging in on the instance login page.

- **Unencrypted HTTP technique** to connect to the `/demo` instance (it does not navigate to specific record):

  ```java
  https://<instance name>.service-now.com/?
  SM_USER=user_name&DE_USER=1Qj1Vp7aRJtyPx5+2O/vgU24tbE=
  ```

- **Link (in an email notification)** to a specific record, so that the user first goes to the company’s own login portal:

  ```java
  https://login.company_portal_page.com/nav_to.do?uri=incident.do?
  sys_id=009f8eda0a0b2b01ab4eb094223466&26sysparm_stack=incident_list.do
  %3Fsysparm_query=active=true
  ```

You must set the **glide.email.override.url** property in your instance to contain the URL of the company portal page. If this property does not exist, you can create it.
• The company portal must then take that URL and construct the redirect URL to the instance preserving the segment necessary to access the specific record, and adding the SSO credentials to the end of the URL:

https://<instance name>.service-now.com/nav_to.do?uri=incident.do?sys_id=009f8eda0a0a0b2b01ab4eb094223466%26sysparm_stack=incident_list.do%3Fsysparm_query=active=true&SM_USER=user_name&DE_USER=1Qj1Vp7aRJtyPx5+2O/vgU24tbE=

Migrating an existing SAML 1.1 integration to SAML 2.0

To migrate from a SAML 1.1 integration to a SAML 2.0 integration, contact customer support.

Update existing SAML 2.0 integration

Perform these steps to update your existing SAML 2.0 integration.

Role required: admin

Request the SAML 2.0 Update 1 Plugin

Contact ServiceNow Technical Support to request the SAML 2.0 Single Sign-On - Update 1: security enhancements plugin. The plugin applies updated versions of the SAML2SingleSignon installation exit (login script), SAML2Logout installation exit (logout script), and SAML2 script include (script object). See Activate a plugin.

Merge Customizations from Existing Installation Exit Scripts into New Scripts

The update saves an inactive copy of the integration’s original installation exit scripts. You can use these copies to merge any customizations you made to the login and logout scripts to the new versions of these installation exits.

<table>
<thead>
<tr>
<th>Original Installation Exit Script Name</th>
<th>Original Script Status</th>
<th>New Installation Exit Script Name</th>
<th>New Script Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAML2SingleSignon</td>
<td>Inactive</td>
<td>SAML2SingleSignon_update1</td>
<td>Active</td>
</tr>
<tr>
<td>SAML2</td>
<td>Inactive</td>
<td>SAML2_update1</td>
<td>Active</td>
</tr>
<tr>
<td>SAML2Logout</td>
<td>Inactive</td>
<td>SAML2Logout_update1</td>
<td>Active</td>
</tr>
</tbody>
</table>

You can navigate to the SAML 2.0 login and logout installation exit scripts using these paths.

• SAML 2 Single Sign-on > Login script.
• SAML 2 Single Sign-on > Logout script.
• System Definition > Installation Exits.

You can navigate to the SAML 2.0 update 1 script include using these paths.

• SAML 2 Single Sign-on > Script object.
• System Definition > Script Includes.

Test the Update

Perform these steps to troubleshoot your integration update.

1. Add a new system property called glide.authenticate.sso.saml2.debug with a value of true.
2. Attempt SAML 2.0 login.
3. Review the system log. SAML2 validation errors begin with the text SAML2ValidationError.
4. Identify and fix typical login errors. See Multi-SSO (SAML 2.0) errors and fixes.

Sample SAML 2 responses after the update
The following sections illustrate the new required elements and attributes that the IdP should provide in the SAML Response.

Sample SAML 2 Response with Issuer Element
The following SAML 2 response uses the Issuer element.

```xml
<samlp:Response xmlns:samlp="urn:oasis:names:tc:SAML:2.0:protocol"
    Destination="https://demoi2.service-now.com/navpage.do"
    ID="s28da6774c88ae1eab292bf25fe625db81919d8e1e"
    InResponseTo="SNC841720c227c81948cf68cadcad235c6"
    IssueInstant="2012-01-30T20:07:10Z" Version="2.0"><saml:Issuer
idp.ssocircle.com</saml:Issuer>
    ...
    <saml:Assertion xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"
    ID="s2f347f973c063836cf70ea38302d94976f9c5b851"
idp.ssocircle.com</saml:Issuer>
    ...
</saml:Assertion></samlp:Response>
```

Sample SAML 2 Response with the SubjectConfirmation and SubjectConfirmationData Elements
The following SAML 2 response uses the SubjectConfirmation and SubjectConfirmationData elements with the NotOnOrAfter and Recipient attributes.

```xml
<saml:SubjectConfirmationMethod="urn:oasis:names:tc:SAML:2.0:cm:bearer"><saml:SubjectConfirmation
    InResponseTo="SNC841720c227c81948cf68cadcad235c6"
    NotOnOrAfter="2012-01-30T20:17:10Z" Recipient="https://demoi2.service-
    now.com/navpage.do"/></saml:SubjectConfirmation>
```

Sample SAML 2 Response with the AudienceRestrictions and Audience Elements
The following SAML 2 response uses the AudienceRestrictions and Audience elements with the NotBefore and NotOnAfter attributes.

```xml
<saml:ConditionsNotBefore="2012-01-30T19:57:10Z"
demoi2.service-now.com</saml:Audience></saml:Conditions>
```

SAML user provisioning
If users exist in your IdP but are not in your instance, SAML user provisioning can automatically create the users in your instance.

SAML user provisioning is supported for SAML 2.0 Update 1 when Multi-SSO is enabled.
How SAML user provisioning works

If SAML user provisioning is enabled, when the system encounters a user that is not in the instance, the instance automatically creates a record in a temporary table. The naming follows a standard convention, `u_imp_saml_user_<suffix>`, where `<suffix>` is an automatically generated text identifier. The system also creates transform map that specifies the data relationships between the import table and the User table. Each IdP identified in the system has its own transform map. The transform map is created once for each IdP. Administrators can update it as necessary.

When the user logs in, they access an IdP to log in.

- The system presents a list of all IdPs that are able to use SAML user provisioning. If there is only one IdP that can use SAML user provisioning, that one is used automatically.
- If none of the above conditions are true, the system uses the default IdP, if active.

Administer SAML user provisioning

To update the User table with the users in your IdP, you must first set up field mapping and then enable user provisioning through Multi-SSO IdP settings.

1. Navigate to Multi-Provider SSO > Properties.
2. Select `Enable Auto Importing of users from all identity providers into the user table` (glide.authenticate.multisso.user.autoprovision) to activate this feature.
3. Click Save.
5. Open the SAML2 Update1 record.
6. To create a record in the User table when the user does not already exist, select Auto-provision Users. If you upgraded to this release, you need to configure the form and add this field.
7. To enable user records to be updated when users log in to the IdP and the information on the IdP is out of date with the information on the User table, select Update User Record Upon Each Login. If you upgraded to this release, you need to configure the form and add this field.
8. Click User Provisioning Transform Map to see the map that the system automatically creates.
9. Make changes to the map as needed.

When the first unknown users tries to log in, the system creates the fields in the import set table from the metadata.xml file.

Note: You cannot map the fields from the IdP table until this first user logs in.

SAML 2.0 troubleshooting

Before contacting support, try the troubleshooting solutions available in the knowledge base on Hi.

Note: The instance does not support solutions provided by external sites.

See the following knowledge base article: KB0540617 "SAML Error Matrix".
## Other Common Issues

<table>
<thead>
<tr>
<th>Error or Symptom</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message: “is not a function.”</td>
<td>This error occurs because the plugin was not active and did not load the .jar file. Therefore, the code appears to be missing. Contact Technical Support to restart nodes that are missing the plugin.</td>
</tr>
<tr>
<td>Additional information:</td>
<td></td>
</tr>
<tr>
<td>This issue might occur in a multi-node environment. If the plugin does not get activated on all nodes, an error like the following appears: org.mozilla.javascript.EcmaError: (\text{(JavaPackage org.opensaml.saml2.core.impl.AuthnRequestBuilder)}) is not a function.</td>
<td></td>
</tr>
<tr>
<td>SAML does not authenticate users accessing CMS pages.</td>
<td>By default, CMS pages are public and therefore do not require authentication. If you want SAML to authenticate CMS pages, change the view_content.do public page from active=true to active=false.</td>
</tr>
<tr>
<td>Cannot redirect a user back to a CMS page after SAML authentication.</td>
<td>By default, the SSO integration uses a URL parameter called URI to control where the user is directed after authentication at the IdP. SSO ignores relative URLs. For example, SSO cannot redirect users to a /ess relative URL. Instead, the user has to navigate to a URL such as /nav_to.do?uri=/ess, which uses deep linking syntax. However, this puts the ESS portal inside the main navigation content IFrame. In other words, the site does not take up the full page, but rather loads as a page in your instance. For more information, see CMS Sites and Single Sign-On. If you change the CMS entry page to make it private by setting view_content.do to active=false, deep linking behavior then requires a customization to the Installation Exit login script. Create a script that looks for the URI portion of the URL and constructs a RelayState URL parameter containing the relative URL path to redirect users after authenticating at the IdP.</td>
</tr>
<tr>
<td>SAML does not redirect users to the appropriate page after authentication.</td>
<td>Determine if the relay state is passed out to the IdP and then passed back during authentication. You can do this with a browser capable of saving HTTP request headers and POST info, such as Chrome with its built-in developer tools, or Firefox with the add-on called HTTPfox. For Internet Explorer, use a third-party application such as Fiddler. The goal is to watch the requests pass from the client (browser) to the instance, and from the client to the IdP.</td>
</tr>
</tbody>
</table>

---

Monitor the event queue for login activities
Every single sign-on integration creates events for login activities.

You can use these events to monitor for login failures and determine if there are any security concerns to address.
## Monitoring the event queue for login failures

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
<th>Record</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>external.authentication.succeeded</code></td>
<td>authentication succeeded and the user accessed the instance URL.</td>
<td>Session ID</td>
<td>User ID of user who successfully logged in</td>
<td>The URL the user accessed (which may be a deep link)</td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td>Session ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td>User ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Event queue login events**

The SAML 2.0 integration creates events for login activities.

You can use these events to monitor for login failures and determine if there are any security concerns to address.

## Login activities events

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
<th>Record</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>saml2.logout.validation.failed</code></td>
<td>The logout response from the IdP failed validation against your logout request. The event validates the <code>&lt;inResponseTo&gt;</code> element against the session ID (ID attribute of the <code>&lt;saml2p:LogoutRequest&gt;</code> element). For example, see the workflow for logout request issued.</td>
<td>Session ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.succeeded</code></td>
<td>authentication succeeded and the user accessed the instance URL.</td>
<td>Session ID</td>
<td>User ID of user who successfully logged in</td>
<td>The URL the user accessed (which may be a deep link)</td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td>Session ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td>Session ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>external.authentication.failed</code></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event name</td>
<td>Description</td>
<td>User ID</td>
<td>Event name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>external.authentication.failed</td>
<td>The user does not exist in the User (sys_user) table.</td>
<td></td>
<td>external.authentication.failed</td>
<td>The user is locked out.</td>
</tr>
</tbody>
</table>

## OAuth 2.0

OAuth 2.0 allows users to access instance resources through external clients by obtaining a token rather than by entering login credentials with each resource request.

You must have the security_admin role to manage the OAuth integration. Configure OAuth 2.0 for the following scenarios:

- **OAuth external client scenario**: Your instance provides an endpoint for third-party clients to pull data from the instance.
- **OAuth provider scenario**: Your instance pulls data from a third-party provider.

Both the simple security and high security frameworks support OAuth 2.0. High Security is recommended. See [High Security Settings](#) for information about which versions have high security already active and how to activate high security.

## Key concepts of the OAuth 2.0 implementation

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Owner</td>
<td>An entity capable of granting access to a protected resource. A resource owner who is a person is called an <em>end user</em>. The resource owner is always a user account.</td>
</tr>
<tr>
<td>Client</td>
<td>An application that, with the authorization of the resource owner, makes requests for protected resources on behalf of the resource owner.</td>
</tr>
<tr>
<td>Resource Server</td>
<td>The server that hosts the protected resources, capable of accepting and responding to requests for protected resources.</td>
</tr>
<tr>
<td>Authorization Server</td>
<td>The server that issues access tokens to the client after successfully authenticating the resource owner and obtaining authorization.</td>
</tr>
<tr>
<td>Authorization Request</td>
<td>The permission that a client requires to access a protected resource. The authorization request is always an HTTP POST message that contains the ID of the client that is acting on behalf of the resource owner and credentials that authorize the request.</td>
</tr>
<tr>
<td>Authorization Grant</td>
<td>A credential that represents the authorization from the resource owner to access a resource. The authorization grant is either user login credentials or a refresh token.</td>
</tr>
</tbody>
</table>
## Access Token

A secure string that a client uses to access protected resources. An instance issues access tokens to clients that have a valid authorization grant. Each access token has a specific scope, lifespan, and other attributes.

By default, an instance issues access tokens with a 30-minute lifespan in the scenario where the instance is the OAuth provider. For third-party tokens, 30 days.

## Refresh Token

A credential that a client uses to obtain new access tokens without requiring additional user authorization. An instance issues a refresh token to a client when it is first authorized to have an access token.

By default, an instance issues refresh tokens with a 100-day lifespan in the scenario where the instance is the OAuth provider. For third-party tokens, 365 days.

## User agent

The user who delegates access rights to a client application, which is often a website. The access rights permit the client application or website to access data in the instance that the user has access rights to. The user agent is used in the authorization code grant flow scenario.

### OAuth grant types

A grant type is the way that the client obtains the access token. The following grant types are supported:

- **Authorization code**: The consumer first gets an authorization code and then uses it to get an access token. You can specify this grant type when you Specify an OAuth profile. The process that uses the authorization code is also referred to as auth code flow or authorization code flow.

- **Resource owner password credentials**: The consumer of the resource already has the user credentials to get the access token. This process is also referred to as password flow.

- **Client credentials**: The consumer of the resource uses the client ID and client secret that is already configured in the application registry.

### Storage of authentication credentials

The OAuth client secret is stored as a password2 type field, which is encrypted in Triple DES. User passwords, which are used to check incoming endpoint requests, are stored as a hash value in the User table in a password type field (SHA 256).

### Set up OAuth

To set up OAuth, register applications to OAuth, enable the OAuth system property, and generate token requests.
Role required: admin

1. Make sure the **OAuth plugin** is active and the **OAuth activation property** is set to true.

2. Create an OAuth application registry using one of the following methods:
   - **Create an endpoint for external clients** that want to access your instance. This creates an **OAuth client application** record and generates a client ID and client secret that the client needs to access the restricted resources on the instance.
   - **Use a third-party OAuth provider** that provides the authorization for access to your instance.

   When you are connecting to another OAuth provider, **Specify an OAuth profile** and **Specify an OAuth scope**

3. Configure your client applications to create an HTTP POST that requests an OAuth token. The application must also be able to parse the JSON response to use the returned access token and refresh token.

**Activate OAuth**

By default, the OAuth plugin is active on new and upgraded instances. If the plugin is not active on your instance, you can activate the plugin.

Role required: admin

1. Navigate to **System Definition > Plugins**.

2. Find and click the plugin name.

3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.

   If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

   Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

   You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

**Set the OAuth property**

To generate OAuth 2.0 tokens to registered applications, the **com.snc.platform.security.oauth.is.active** property must be active for the instance.

Role required: admin

1. Type **sys_properties.list** in the application navigator filter and then click **New**.

2. Fill out the form with the following settings:
   
   - **Name**: com.snc.platform.security.oauth.is.active
   - **Type**: true | false
   - **Default value**: true

3. Set the property to **true** to use OAuth 2.0.
Create an endpoint for clients to access the instance
Create an OAuth application endpoint for external client applications to access the ServiceNow instance.

Role required: admin

1. Navigate to System OAuth > Application Registry and then click New.
2. On the interceptor page, click Create an OAuth API endpoint for external clients and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name that identifies the application that you require OAuth access for.</td>
</tr>
<tr>
<td>Client ID</td>
<td>(Read-Only) The auto-generated unique ID of the application. The instance uses the client ID when requesting an access token.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>(Required) The shared secret string that both the instance and the client application or website use to authorize communications with one another. The instance uses the client secret when requesting an access token. Leave this field blank to have the instance auto-generate a client secret. To display existing client secrets, click the lock icon.</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>The callback URL that the authorization server redirects to. Enter the full URLs of the clients requesting access to the resource, appended by /oauth_redirect.do. For example, http://token_consumer:port/oauth_redirect.do. Enter as many URLs as needed for all possible token consumers. The instance matches the URL of the incoming request to one of the redirect URLs. If no match is made, the instance uses the first redirect URL.</td>
</tr>
<tr>
<td>Logo URL</td>
<td>The URL that contains an image to use as the application logo. The logo appears on the approval page when the user receives a request to grant a client application access to a restricted resource on the instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to make the application registry active.</td>
</tr>
<tr>
<td>Refresh Token Lifespan</td>
<td>The number of seconds that a refresh token is valid. The instance uses the lifespan value when requesting a refresh token. By default, refresh tokens expire in 100 days (8640000 seconds).</td>
</tr>
<tr>
<td>Access Token Lifespan</td>
<td>The number of seconds that an access token is valid. The instance uses the lifespan value when requesting an access token. By default, access tokens expire in 30 minutes (1800 seconds).</td>
</tr>
</tbody>
</table>
3. Click **Submit**. The record is saved in the Application Registries (oauth_entity) table.

The system creates a record in the Application Registries (oauth_entity) table with of type **OAuth Client**. When the instance actually issues tokens and authorization codes, they are stored in the table. See **Manage OAuth tokens** for more information.

**OAuth parameters for default profile support**

The default profile feature requires a set of parameters that you can use with the `setParameter()` API to specify the OAuth requestor, a context for the request, and the provider profile.

In the OAuth provider scenario, you must set three parameters that tell the OAuth provider which OAuth profile to use by default. When these three parameters are set, the access token is saved in the instance database. Use these parameters with `GlideOAuthClientRequest`.

**OAuth parameters for default profile support**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>oauth_requestor</td>
<td>The sys_id of the object, which can be a user record or an email account.</td>
</tr>
<tr>
<td>oauth_requestor_context</td>
<td>Descriptor that provides context for the OAuth requestor. As a good practice, use the name of the table where the <code>oauth_requestor</code> object is saved.</td>
</tr>
<tr>
<td>oauth_provider_profile</td>
<td>The sys_id of the default OAuth profile record (see <strong>Specify an OAuth profile</strong>).</td>
</tr>
</tbody>
</table>

You do not need to use parameters to set the grant type and scope because the values are configured in the OAuth profile record. If you do not use the parameters, you can use the `GlideOAuthClientRequest` API methods `setScope` and `setGrantType`. For additional information, refer to and .

**OAuth API request parameters**

Access token requests use the following request parameters.

**Access token request parameters**

<table>
<thead>
<tr>
<th>Request parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>grant_type</td>
<td>(Required) The type of credentials authorizing the request for an access token. This parameter must have one of the following values:</td>
</tr>
<tr>
<td></td>
<td>- <strong>password</strong>: A set of user credentials authorize the access token request. Specify the user credentials in the username and password parameters.</td>
</tr>
<tr>
<td></td>
<td>- <strong>refresh_token</strong>: An existing refresh token authorizes the access token request. Specify the refresh token in the refresh_token parameter.</td>
</tr>
</tbody>
</table>
### Request parameter | Description
--- | ---
client_id | (Required) Auto-generated unique ID of the client application requesting the access token.
client_secret | (Required) Shared secret string that the instance and the OAuth application use to authorize communications with one another.
username | User account name that authorizes the access token request. This parameter is required for access token requests with a grant_type of password.
password | Password for the user account that authorizes the access token request. This parameter is required for access token requests with a grant_type of password.
refresh_token | Existing refresh token that authorizes the access token request. This parameter is required for access token requests with a grant_type of refresh_token.

### Requests Using User Credentials

The instance requires clients to provide user login credentials when first authorizing the client or when authorizing the creation of a new refresh token. This type of request always returns two tokens:
- An access token
- A refresh token

The instance verifies that the user is active, not currently locked out, and has an interactive session. If any of these conditions are false, the instance does not produce an access token. Access requests made within the expiration time of the access token always return the current access token.

**Note:** This type of authorization grant relies on TLS encryption to protect the user credentials during transmission.

The following example illustrates requesting an access token with a set of user credentials. (Spaces have been added to improve readability.)

```bash
$ curl -d "grant_type=password&client_id=be3aeb583ace210011c15b24a43e25d8&client_secret=client_password&username=admin&password=admin" https://instancename.service-now.com/oauth_token.do
```

### Requests Using a Refresh Token

The instance can use an existing refresh token to create a new access token. This type of request returns only an access token. The instance confirms that the refresh token has not expired before generating a new access token. Access requests made within the refresh token expiration time always return the current refresh token. Transmitting refresh tokens is generally more secure than
transmitting user credentials. The following example illustrates requesting an access token with an existing refresh token. (Spaces have been added to improve readability.)

```
$ curl -d "grant_type=refresh_token&client_id=be3aeb583ace210011c15b24a43e25d8 &client_secret=client_password &refresh_token=w599voG89897rGVDmdp12WA681r9E5948c1CJTPi8g4Hgc4NWaz62k6k1K0FMxHW40H8yOO3Hoe"
https://instancename.service-now.com/oauth_token.do
```

OAuth API response parameters
The OAuth 2.0 API produces a JSON response containing the following parameters as name:value pairs.

**Access token response parameters**

<table>
<thead>
<tr>
<th>Response parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>scope</td>
<td>Amount of access granted by the access token. The scope is always <code>useraccount</code>, meaning that the access token has the same rights as the user account that authorized the token. For example, if Abel Tuter authorizes an application by providing his login credentials, then the resulting access token grants the token bearer the same access privileges as Abel Tuter.</td>
</tr>
<tr>
<td>token_type</td>
<td>Type of token issued by the request as defined in the OAuth RFC. The token type is always <code>Bearer</code>, meaning that anyone in possession of the access token can access a protected resource without providing a cryptographic key. See RFC6750 for more information about how OAuth 2.0 uses bearer tokens.</td>
</tr>
<tr>
<td>expires_in</td>
<td>Lifespan of the access token in seconds.</td>
</tr>
<tr>
<td>refresh_token</td>
<td>String value of the refresh token.</td>
</tr>
<tr>
<td>access_token</td>
<td>String value of the access token. Access requests made within the access token expiration time always return the current access token.</td>
</tr>
<tr>
<td>format</td>
<td>(Optional) Output format of the response. This value is always JSON.</td>
</tr>
</tbody>
</table>

The following example illustrates the JSON string returned by an access token request. (Spaces have been added to improve readability.)

```
{"scope":"useraccount","token_type":"Bearer","expires_in":1800,"refresh_token":"w599voG89897rGVDmdp12WA681r9E5948c1CJTPi8g4Hgc4NWaz62k6k1K0FMxHW40H8yOO3Hoe","access_token":"F0jh9korTyzd9ka2qZ0SjKZu5Sut014P46Lc52m2JYHiLcqzFAumpyxshU9mMQ"}
```

OAuth authorization code grant flow
Authorization code grant flow allows a user to access a resource by authenticating directly with an OAuth server that trusts the resource, in contrast with authenticating with username/password credentials.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
This implementation of OAuth authorization code flow allows access to a resource via REST. The authorization code framework gets the access token through the authorized URL that the user configures rather than requiring the user to enter a username/password. The username/password are never exposed to the client that is requesting access to the resource.

**A ServiceNow instance as the authorization server**

The OAuth server is typically a third-party authorization server. You can also specify a ServiceNow instance as the authorization server that issues the tokens for authorization code flow.

The user who owns the restricted resource must authorize access. The user can also revoke the issued access token at any time to terminate access.

**Authorization code grant flow process**

The Authorization code grant flow process consists of these three steps:

1. **Initial token request**
   
   In step one, the client application or website initiates a REST API call in the form of a GET request to the instance via the user agent. Typically, the REST call is initiated when the end user clicks a button or a link on the client application or website to request an access token. In the client application, the end user also has to specify the authorization URL, token URL, client ID, and client secret. For an explanation of these items, see the field descriptions in this topic: Use a third-party OAuth provider. If the client asks for a grant type, the end user must select Authorization Code.

   Example GET request from the client application to the instance:

   ```
   https://myinstance.servicenow.com/oauth_auth.do?
   response_type=code&redirect_uri={the_redirect_url}&client_id={the_client_identifier}
   ```

   **Note:** The *response_type* must be *code* to use the standard OAuth code grant flow.

   The end user must manually allow access to the restricted resource on the instance. In the ServiceNow implementation, the end user must be logged into the instance. The instance prompts the end user with a UI page that has Allow and Deny buttons. See Authorize access to an OAuth endpoint using auth code flow for instructions.
The item that the client application is actually requesting the token from is the OAuth provider application registry record that you created, also known as the authorization endpoint (see Use a third-party OAuth provider). The auth code is sent from the authorization endpoint to the client. It does not go to the client directly but to the Redirect URL that you specify on the authorization endpoint form. This URL is also known as a callback URL. You can obtain this URL from the client application or website.

Example response from the instance to the client application, providing an authorization code:

```
https/http://{callbackURL}?code={the actual auth code}
```

Now that the client application has the authorization code, the client uses the code to request the access token. The authorization code proves that the user has consented in step 1.

Example GET request from the client application to the ServiceNow instance that provides the auth code and requests the access token:

```
https://myinstance.servicenow.com/oauth_token.do?grant_type=code&code={the auth code}&redirect_uri={the_same_redirect_url}&client_id={the_same_client_identifier}
```

The endpoint on the instance returns an access token and a refresh token. The refresh token can be used to request additional access tokens.

You can manage the tokens, including revoking the token, in the instance. See Manage OAuth tokens.

The client application uses the access token to authenticate to the REST API. After authenticating the client application, the REST API returns the requested data in a JSON payload.
Example GET request for the JSON payload of data for the Incident (incident) table:

```plaintext
https://myinstance.service-now.com/api/now/table/incident?
access_token={the_token}
```

**Note:** The system also supports [OAuth implicit grants](#), also known as implicit grant code flow.

### Integration support

Authorization code flow supports the following integrations on the instance:

- Multi-SSO
- SAML 2.0 Update 1
- Multifactor authentication

The mobile interface is also supported.

**OAuth implicit grants**

ServiceNow instances support the implicit grant of an access token.

The implicit grant type, also known as *implicit grant code flow*, allows the access token to be given directly to the client application via the user agent, which is typically the web browser or mobile device. No refresh tokens are granted. The end user must still grant access to the protected resource on the instance, just as with standard [authorization code grant flow](#).

### OAuth implicit grant flow process

Just as with the standard authorization code flow process, the client application makes a request to use the restricted resource on the instance and the end user approves it. The request is in the form of a URL sent to the instance. The URL must include the following parameters:

- `client_id=(the necessary client ID)`. This is **mandatory** to identify which protected resource the client application wants access to.
- `response_type=token`. This is **mandatory** to request the access token directly (as opposed to asking for an authorization code). The value must be `token` for implicit grants. In the standard authorization code flow example, the response type is `code`.
- `redirect_uri=(a URL)`: The location where the token is sent.

The authorization server sends the access token, rather than an authorization code, to client application via the user agent.

Here is an example GET request to receive the JSON payload of data for the Incident (incident) table:

```plaintext
https://myinstance.servicenow.com/oauth_auth.do?
response_type=token&redirect_uri={the_redirect_url}&client_id={the_client_identifier}
```

If the user grants access, the token is included in the redirect (callback) URL:

```plaintext
https://http://{callbackURL}?access_token={the_token}
```

**Authorize access to an OAuth endpoint using auth code flow**

End users who own a protected resource on the ServiceNow instance must authorize access to the resource before the instance can provide the access token.
You must already be logged in to the instance that holds the protected resource. Alternatively, you can log in using the authentication method (such as multi-factor authentication or SAML) that your ServiceNow administrator already set up.

1. Click the link or button on the client application where you are requesting access to the protected resource on the instance. This kicks off the token request.
   If you are making a REST call from one instance to another, this link is Get OAuth Token on the REST Message form.
2. If you are not logged in, log in now. If you are not the same user as the user specified in the upper-right corner, click Not You? and log in.
3. Click account permissions to open the list of access tokens that you have already issued. The list view of tokens is the same as the Self-Service > My connected apps token list.
4. Click Allow to allow access and have the instance issue the authorization code (if using auth code flow) or the access token (if using implicit grant type). If you click Deny, the authorization is not allowed, but you are not logged out of the instance.

Test endpoint would like to connect to your ServiceNow account on instance {instance name}

By clicking Allow, you allow Test endpoint to connect to your ServiceNow account on instance {instance name}, and allow it to interact with records as you.
You can change this and other account permissions at any time.

A message that confirms access should appear. If you are requesting access from the REST Message form on an instance, the following message appears at the top of the form: OAuth Refresh token is available and will expire at {date}.

authcode flow: ServiceNow instance as authorization server (example)
You can use an instance as an authorization server to issue tokens to a client using authorization code flow.

This example uses two instances: one as the authorization server and the other as the client. One instance uses a REST call to request tokens from another instance.

You must activate OAuth 2.0 on both instances.

Setting up the authorization server
1. On one instance (running the Istanbul or later release), navigate to System OAuth > Application Registry and then click New.
2. Click Create an OAuth API endpoint for external clients.
3. Fill out the form fields for the OAuth application record as described in Create an endpoint for clients to access the instance.

Setting up the client server

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
On another instance, navigate to System OAuth > Application Registry and then click New. Click Connect to a third party OAuth Provider.

Fill out the form fields for the OAuth application record as described in Use a third-party OAuth provider.

Note the following field values:

- **Client ID**: Client ID of the application registry record that you created for the authorization server.
- **Default Grant type**: Select Authorization code.
- **Authorization URL**: URL of the instance that is the authorization server. Remember to append oauth_auth.do at the end of the URL.
- **Token URL**: URL of the instance that is the authorization server. Remember to append oauth_token.do at the end of the URL.
- **Redirect URL**: URL of this instance: the client server instance. Remember to append oauth_redirect.do at the end of the URL.

Create a profile for the record with the Authorization code grant type.

Creating an outbound REST message on the client server

Navigate to System Web Services > Outbound > REST Message and then click New.

Fill out the form fields for the OAuth application record as described in Create a REST message.

Note the following field values:

- **Endpoint**: URL of the instance that is the authorization server.
- **Authentication type**: OAuth 2.0.
- **OAuth profile**: OAuth profile that you created for the client server.

Getting the tokens

On the REST message record, click Get OAuth Token.

Authenticate with the instance that provides the token—the method depends on the single-sign on integration. You might use:

- Your username and password that you use to authenticate to the instance.
- The username and password for the IdP if Multi-SSO is enabled. Click Use External Login to access the IdP login screen.
- Your Multi-factor Authentication code, if MFA is enabled.

Click Allow or Deny to complete the authorization and issue the tokens.

The process that follows is outlined in OAuth authorization code grant flow.

Manage OAuth tokens

Open OAuth tokens to provide access to restricted resources.

Role required: any user or admin

Only the tokens that the instance issues are available, not the tokens that the instance can receive to access third-party resources.

Navigate to one of the following menu options:

- **Self-Service > My Connected Apps** to see the tokens that the instance created when you granted access to a resource on the instance.
- **System OAuth > Manage Tokens** to see all tokens. Only administrators can access this module.

Click the Name to open the token.
3. Click **Revoke Access** to prevent access to the restricted resource.
4. You can also view other information about the token, including the scope it allows access to and the expiration date.

**Revoke an OAuth token**
You might want to revoke an OAuth access or refresh token for security reasons.

Role required: admin

Revoking the token pertains to the situation where your instance acts as the OAuth resource server. You can revoke the token through a URL or by accessing the token in the instance.

- Access your instance using `oauth_revoke_token.do` and append the token in the instance.
  
  **For example:**
  
  ```
  https://[Your_ServiceNow_Instance]:[port]/oauth_revoke_token.do?token=[access or refresh token] without the brackets [ ].
  ```

This endpoint access does not require authentication. The token in this request is marked as expired.

**OAuth client APIs**

The OAuth client API provides methods to request and revoke OAuth tokens.

These OAuth classes are available:

- : Methods for requesting and revoking the refresh and access tokens.
- : Methods for handling client requests.
- : Methods for handling client responses.
- : Methods for retrieving the access token and information about the access token.

You can also customize the OAuthUtil script include to intercept the request parameters and also parse the responses from external OAuth providers.

OAuth classes are available in global and scoped scripts. In a scoped script, use the `sn_auth` namespace identifier.

**Scoped OAuth APIs**

OAuth supports application scoping by providing access to all OAuth methods in the available OAuth classes using the `sn_auth` namespace identifier.

For example, the following code accesses the requestToken:

```java
var oAuthClient = new sn_auth.GlideOAuthClient();
var tokenResponse = oAuthClient.requestTokenByRequest('TestClient', text);
```

In a global script omit the `sn_auth` namespace identifier.

**Digest token authentication**

The digest token authentication passes user credentials and a digest token within an unencrypted HTTP header.

The instance reads the HTTP header value and compares its computed hash value of the digest token. If the computed hash value matches the digest token value, then the instance searches for a matching value in the User table. If there is a matching value in the User table, the instance considers the user pre-authenticated and logs the user in.

Digest token authentication is more secure than simple unencrypted HTTP headers because any accidental or intentional change to the unencrypted HTTP header produces a different hash.
value. If the hash value fails to match, the instance denies the user access to the requested instance. This prevents users from attempting to login with another user's credentials.

Integration requirements

A Digest Token Authentication integration requires:

- A web server
- SiteMinder or another single sign-on application to pre-authenticate the user on the local network
- A web page or portal that passes user credentials to the target instance in one of these formats
  - HTTP Header
  - URL parameter
  - Cookie

- A web page or portal that creates and passes a digest token to the target instance using one of these encoding techniques
  - SHA1
  - MD5

Set up Digest Token Authentication

Setting up digest token authentication involves generating an unencrypted HTTP header and token, then enabling an installation exist and configuring properties.

Generate an unencrypted HTTP header

The first step in setting up digest token authentication is to generate an unencrypted HTTP header.

Role required: admin

The system only accepts one HTTP header as the source of pre-authentication.

1. Choose an HTTP header that matches data from the User (sys_user) table.
2. Configure your single sign-on software or authentication portal to generate the desired HTTP header.

For example, here are some sample SiteMinder HTTP headers.

<table>
<thead>
<tr>
<th>User credential</th>
<th>Sample HTTP header</th>
<th>Matching sys_user field</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>SM_USER</td>
<td>user_name</td>
</tr>
<tr>
<td>Email address</td>
<td>EMAIL</td>
<td>email</td>
</tr>
</tbody>
</table>

Generate a digest token

After generating an unencrypted HTTP header, generate a digest token for authentication.

Role required: admin
The system only accepts one HTTP header as the source of pre-authentication. Configure your single sign-on software or authentication portal to generate an HTTP header to contain the digest token.

For example, here is a sample SiteMinder HTTP header.

<table>
<thead>
<tr>
<th>Sample HTTP header</th>
<th>Sample digest HTTP header</th>
<th>Sample HTTP headers with digest</th>
</tr>
</thead>
<tbody>
<tr>
<td>SM_User</td>
<td>DE_USER</td>
<td>SM_USER=joe.employee;DE_USER=KfNrt4nl86b9gEfoiT0dU/YLM0=</td>
</tr>
</tbody>
</table>

Typically, the authentication portal or web page runs the code to generate a digest token from the unencrypted HTTP header and includes the digest token in the URL to the target instance. See SNC Guru for code samples of generating a digest token.

**Enable digest installation exit script**

After generating a digest token for authentication, enable a digest installation exist script.

Role required: admin

The system uses an installation exit to identify and decode incoming digest tokens. By default, the installation exit uses SHA1 to compute a hash value.

1. Navigate to **System Definition > Installation Exits**.
2. Click **DigestSingleSignOn**.
3. Set **Active** to true.
4. Click **Update**.
5. To use MD5 for computing the digest token hash value, change this line: `var MAC_ALG ="HmacSHA1";` to this: `var MAC_ALG ="HmacMD5";`

**Enter single sign-on system properties**

After enabling a digest installation exist script, configure properties for single sign-on.

Role required: admin

If you are configuring digest token for multi-provider SSO, skip this step and enter the digest properties for multi-provider single sign-on. Set these properties to enable single sign-on with an unencrypted HTTP header.

1. Navigate to **System Properties > Single Sign-on**.
2. For **Enable external authentication**, select **Yes**.
3. For **HTTP header name to look for an externally authorized user (e.g. for SiteMinder)**, enter the HTTP header you generated. For example, **SM_USER**.
4. For **HTTP header name to look for an externally authorized user (e.g. for Digest Encryption)**, enter the HTTP header you generated. For example, **DE_USER**.
5. For **Service-now.com field name to match against the incoming header**, enter the sys_user field that contains matching data. For example, **user_name**.
6. For **Secret passphrase for single sign-on (SSO) encryption/decryption**, enter the secret key (password) to use for encoding digest keys. For example, **SecretKey123**.
7. Click **Save**.
Enter the digest properties for multi-provider single sign-on
After enabling a digest installation exist script, configure properties for multi-prover single sign-on.

Role required: admin

If you are not using multi-provider single sign-on, configure standard single sign-on properties.

1. In the **Name** field, enter the name of the digest token.
2. In the **User** field, enter the sys_user field that contains the matching data for the incoming header.
3. In the **HTTP Digest header name** field, enter the HTTP header you generated. For example, `DE_USER`.
4. In the **HTTP header name field**, enter the HTTP header you generated in Step 1. For example, `SM_USER`.
5. In the **Secret Passphrase** field, enter the secret key to use for encoding digest keys. For example, `SecretKey123`.
6. In the **Failed SSO Redirect field**, enter the URL to redirect users after a failed authentication.
7. In the **External logout redirect** field, enter the URL to redirect users after a logout.
8. In the **Single Sign-on Script**, select `MultiSSO_DigestedToken`.
9. Click **Update**.

**Test the integration**
This single sign-on method allows pre-authentication from URL parameters, HTTP headers, or cookies.

Role required: admin
- Verify users can sign-on from all methods.
For example:

- **URL Format:**
  https://<instance name>.service-now.com?
  SM_USER=joe.employee&DE_USER=KfNr4nl7869gEfooiT0dU/YLM0=

- **HTTP Header Format:**
  SM_USER=joe.employee;DE_USER=KfNr4nl7869gEfooiT0dU/YLM0=

- **Cookie Format:**
  'SM_USER=joe.employee; DE_USER=KfNr4nl7869gEfooiT0dU/YLM0="; expires=Fri, 27 Jul 2012 02:47:11 UTC; path=/'

Create links for digest authentication

After you set up digest token authentication, construct URLs to take users to a particular page or resource.

Role required: admin

- Create a URL to your instance and append the appropriate user (SM_USER) and digest (DE_USER) request parameters.

Example URLs are as follows:

https://demo.service-now.com/nav_to.do?
uri=ess&SM_USER=itil&DE_USER=nqQ82LONeYQnXPmqddxnsvsArrQ=

https://demo.service-now.com/nav_to.do?url=incident.do?
sys_id=9d385017c611228701d22104cc95c371&SM_USER=itil&DE_USER=Uj/
HopjjPczCNpN2xcX17kQty4=

http://demo.service-now.com/nav_to.do?url=incident_list.do?
sysparm_userpref_module=4dedbac7d0bbf538017a7f13c4af257%26sysparm_query=caller_id=javascript:gs.getUserID()^active=true^EQ&SM_USER=itil&DE_USER=Uj/
HopjjPczCNpN2xcX17kQty4=

**Note:** If you are using request parameters inside a URL (nav_to.do? uri=), ampersands (&) are encoded as `%26`.

Sample digest token implementations

Here are several samples of creating a digest token.

Sample digest authentication implementations

<table>
<thead>
<tr>
<th>Digest built with</th>
<th>Secret key value</th>
<th>Hash method</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java</td>
<td>abc123</td>
<td>SHA1</td>
<td>Sample Java Digest Algorithm for Encryption</td>
</tr>
<tr>
<td>C</td>
<td>Value of sharedKey parameter</td>
<td>Value of strEncryptionMethod parameter (SHA1 or MD5)</td>
<td>Sample C</td>
</tr>
</tbody>
</table>

Sample Java digest algorithm for encryption

This Java algorithm illustrates creating a digest token from an HTTP header.

This sample assumes:
The web server supports Java
The hash computation method is SHA1
The secret key value is abc123
The unencrypted HTTP header name is user_name

Change the Java code to use another hash computation mechanism (such as MD5), change the secret key value, or HTTP header name.

```java
import javax.crypto.Mac;
import javax.crypto.spec.SecretKeySpec;
import sun.misc.BASE64Encoder;

public class DigestTest {
    private static final String MAC_ALG = "HmacSHA1"; // default to something JDK 1.4 has
    String fKey = "abc123";

    public byte[] getDigest(String acct) {
        try {
            byte[] bkey = fKey.getBytes();
            byte[] data = acct.getBytes();
            Mac mac = null;
            try { // init (new SecretKeySpec(bkey, MAC_ALG));
                mac = Mac.getInstance(MAC_ALG);
                mac.init(new SecretKeySpec(bkey, MAC_ALG));
            } catch (Exception e) {
                e.printStackTrace();
            }
            byte[] sig = mac.doFinal(data);
            String signature = new String(sig);
            System.out.println("value: ");
            System.out.println("digested value: ");
            return sig;
        } catch (IllegalStateException e) {
            e.printStackTrace();
            return null;
        }
    }

    public static void main(String[] args) {
        BASE64Encoder encoder = new BASE64Encoder();
        DigestTest test = new DigestTest();
        String userName = "user_name";
        System.out.println("base 64 digest username: ");
        System.out.println(encoder.encode(test.getDigest(userName))); //
    }
}
```

Sample C

This C class illustrates creating a digest token from three input parameters.

- `strEncryptionMethod` lists the hash computation method (SHA1 or MD5)
- `message` lists the value to be converted into a digest token
- `sharedKey` lists the secret key

This sample assumes:

- The web server supports C
- Other code calls this class and passes the expected parameters

Sample Code

```c
private string digestData(string strEncryptionMethod, string message, string sharedKey) {
    UnicodeEncoding myUnicodeEncoding = new UnicodeEncoding();
    byte[] messageBytes = System.Text.Encoding.ASCII.GetBytes(message);
    byte[] sharedKeyBytes = System.Text.Encoding.ASCII.GetBytes(sharedKey);
    string b64SHA1Message;

    if (this.DEBUG) {
        TextBoxMessage.Text = message;
        TextBoxSecret.Text = sharedKey;
    }
```
switch ( (strEncryptionMethod ) )
{
    case "SHA1" :
        HMACSHA1 hmacsha1 = new HMACSHA1 ( ) ;
        hmacsha1. Key = sharedKeyBytes ;
        hashedMessage = hmacsha1. ComputeHash (messageBytes ) ;
        b64SHA1Message = Convert. ToBase64String (hashedMessage ) ; if (this. DEBUG ) TextBoxDigest. Text = Convert. ToString (hashedMessage ) ; break ;
    case "MD5" :
        HMACMD5 hmacmd5 = new HMACMD5 (sharedKeyBytes ) ;
        hashedMessage = hmacmd5. ComputeHash (messageBytes ) ;
        b64SHA1Message = Convert. ToBase64String (hashedMessage ) ; if (this. DEBUG ) TextBoxDigest. Text = Convert. ToString (hashedMessage ) ; break ;
    default :
        b64SHA1Message = "Unknown Encryption Method" ; break ;
}

TextBoxBase64. Text = b64SHA1Message ; return b64SHA1Message ;

Multifactor authentication (MFA)

MFA, also known as two-step verification, is a security requirement that asserts a user enter more than one set of credentials to authenticate to an instance.

The basic level of authentication to an instance is local database authentication where a user enters a username and password combination. MFA gives administrators and users the ability to require a second level of authentication where a user must enter a passcode or token in addition to the password. A mobile application on a user mobile device generates the passcode.

- Users can require MFA for their own login credentials.
- Administrators can require MFA for any user login credentials or specific roles.

Supported authentication methods

- You can use MFA in combination with the following authentication methods:
  - Local Database Authentication (native ServiceNow authentication)
  - LDAP integration

Authentication methods that are not supported

- MFA is not supported in combination with the following authentication methods:
  - SSO SAML
SSO Digest

Administrator MFA authentication flow

**Note:** If a user performs a password change while MFA is enabled on the user profile, the user does not need to enter the authorization code.

1. The administrator goes to a user profile or role in the instances and initiates MFA.
2. The instance displays a QR code and a QC code number.
3. Using a compatible authenticator, scan the QR code with the authenticator, or manually enter the QC code number in the MFA registration screen.
4. A TOTP code generates and displays within the authenticator application along with your associated ServiceNow instance name and username.
5. For every subsequent login, enter the TOTP code generated from your authenticator application in the MFA challenge screen that displays after you enter your username and password.
6. If the challenge is correct, the user authenticates to the instance.

You can also skip the MFA challenge screen and directly logon to the instance:

1. You can also append your TOTP code to your password from the initial login screen. If your password is 'XXX' and your TOTP code is '123', you can enter 'XXX123' as your password to skip the MFA challenge screen.
2. If the username, password, and passcode combination are correct, the MFA challenge screen does not appear and the user directly logs into the instance.

MFA FAQs

<table>
<thead>
<tr>
<th>Questions</th>
<th>Answers</th>
</tr>
</thead>
<tbody>
<tr>
<td>What if I do not own a smart phone?</td>
<td>If you do not have access to a smart phone, you can use the Chrome browser Authy extension to set up and use MFA. Download and add the extension to your Chrome browser. Then, set up an account and master password with the Chrome extension before you set up MFA with the extension.</td>
</tr>
<tr>
<td>Questions</td>
<td>Answers</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| I use Firefox instead of Chrome. Is there an Authy plug-in for Firefox that I can use? | Currently, Firefox does not support the browser-based Authy plug-in. However, you can install the Authy plug-in through the Chrome browser. You can use the Authy app standalone (without using the Chrome browser) for generating the code to use in Firefox to log on to ServiceNow MFA-enabled applications.  
**Note:** After you install Authy, you must select the Multi-Device option from the Devices section.  
| What if I do not have a smart phone while logging in?                     | After the initial pairing, if you do not have your smart phone available, you can email yourself a code to log in.  
| Can I enter the code and my password in one login screen instead of two different screens? | Yes. After initial setup, you can enter your password followed by the 6-digit code in the first login screen to log in.  
| What if I must change devices and re-pair or reenter the code into a different mobile device? | Go to your user profile in the ServiceNow instance under My Profile and click multi-factor authentication to get access to the code to reenter and pair your device.  
| What should I do if my authenticator code obtained from Authy is not working on my computer? | Update the preference on your computer to set the time automatically to generate the correct code. If you manually set the time on your laptop, a time difference could cause the codes to fail. After you sync the time on your laptop, the app confirms that the time syncs and you can use your verification codes to sign in.  
**Note:** The sync only affects the internal time of your authenticator app and does not change the date and time settings on your device.  
| Can I turn it off?                                                        | No, when an administrator enables MFA, a user cannot disable it.  

For help or questions with MFA, contact your ServiceNow administrator.

**Activate multifactor authenticator**

Administrators can activate the Integration - Multifactor Authentication plugin, which is not active by default.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their activation status.
If the plugin has optional features that are not functional because other plugins are inactive, those plugins are listed. A warning states that some files are not installed. If you want the optional features to be installed, cancel this activation, activate the necessary plugins, and then return to activating the plugin.

4. Optional: If available, select the Load demo data check box.

Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.

5. Click Activate.

Configure multifactor authentication

You can enable multifactor authentication on the instance and specify how many times users can skip the additional passcode requirement.

Role required: admin

2. Configure these properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Multifactor Authentication (glide.authenticate.multifactor)</td>
<td>Select this check box to allow users and administrators to use this feature.</td>
<td>Enabled</td>
</tr>
<tr>
<td>Number of times a user can bypass multifactor authentication (</td>
<td>Enter a number that represents how many times a user can choose to skip</td>
<td>3</td>
</tr>
<tr>
<td>glide.authenticate.multifactor.setup.bypass.count)</td>
<td>the additional passcode requirement. This gives your users the ability to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>still log in the instance if they do not have their mobile device with</td>
<td></td>
</tr>
<tr>
<td></td>
<td>them. If you disable this feature and then re-enable it, the counter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts over again.</td>
<td></td>
</tr>
<tr>
<td>The time in minutes, the one time code sent to user's email address is</td>
<td>Enter a number in minutes that specifies how long the reset code is valid.</td>
<td>10</td>
</tr>
<tr>
<td>valid for (glide.multifactor.onetime.code.validity)</td>
<td>See Log on with multifactor authentication.</td>
<td></td>
</tr>
</tbody>
</table>
### Property | Description | Default
---|---|---
Additional time in seconds for which the code will be valid to accommodate for the clock skew. Max value is 60 seconds. (glide.authenticate.multifactor.clock_skew) | Enter a number in seconds with a maximum of 60. By default, the instance validates the code entered by the user against the single app-generated code generated at whatever the current time is. You can skew the time window with this property and allow one or more codes generated during a time window to be considered valid. The property's value is used in the following calculation: `current time - x/2` and `current time + x/2`, where `x` is the value of this property. If you use the value of 10, for example, the instance considers any codes generated by the app between the time range `[current time - 5 seconds]` and `[current time + 5 seconds]` to be valid. Use this property to prevent log in issues where the user is unable to enter the correct code in the default time allotted. | 10

3. Click Save.

### Tested third-party authenticators with MFA

Users must install and use an authenticator that supports Time-based One-time Password (TOTP) to generate a temporary MFA passcode.

### Tested third-party authenticators

Users should install the recommended authenticator to their mobile devices. MFA has been tested with the following authenticators:

- Google Authenticator
- Microsoft Authenticator
- LastPass Authenticator
- Authy
- FreeOTP
- Duo
- Okta Verify
Note: Other authenticators not listed might also be compatible.

Logging into your instance using MFA
You can log into your instance with your credentials and a generated passcode.

1. Go to your instance login screen and enter credentials. An MFA registration screen displays with a QR code and a QC code number.
2. Using a compatible authenticator, scan the QR code with the authenticator, or manually enter the QC code number in the authenticator application. A TOTP code generates and displays within the authenticator application associated to your ServiceNow instance.
3. For every subsequent login, enter the TOTP code generated from your authenticator application in the MFA challenge screen that displays after you enter your username and password.

Note: You can also append your TOTP code to your password from the initial login screen. If your password is ‘XXX’ and your TOTP code is ‘123’, you can enter ‘XXX123’ as your password to skip the MFA challenge screen.

If you properly enter your credentials and current passcode, you should authenticate to the instance.

Require multifactor authentication for a user
You can require multifactor authentication for any user record in the system that you have access to.

Role required: admin

1. Navigate to User Administration > Users.
2. Configure the list to show the Enable Multifactor Authentication column.
3. Change the values of the Enable Multifactor Authentication column for the selected users to true.

When the user logs in with their username and password, they are prompted to set up multifactor authentication.

Set up multifactor authentication upon initial login
If your administrator enabled multifactor authentication on your profile but you have not yet set up the application, you can set it up upon login.

Role required: none

1. Log into your instance using your username and password. The multifactor authentication setup screen intercepts your login.
2. If you want to skip the authentication setup at this time, click Bypass Setup. You can bypass multifactor authentication for a limited number of times that your administrator allows. Eventually you need to configure multifactor authentication.

3. If you do not yet have the Google Authenticator application in your mobile device, you can download it from one of the links provided under Download the app.

4. Take a photo of the QC code with the Google Authenticator application or enter the string in the application manually.

5. Enter the code and click Pair device and log in.

The application responds with a six digit code that refreshes every 30 seconds. If you entered the correct code, a message appears telling you that Multifactor Authentication is set up. If you entered an invalid code, look for the code on your mobile device again as it may have refreshed, and enter the code that you see.
Log on with multifactor authentication

After multifactor authentication is enabled for your User profile, you can log in with the addition of the passcode that the Google Authenticator app gives you.

You must have multifactor authentication enabled for your profile. You can enable it yourself on your user profile or your administrator can enabled it for you.

Role required: none

1. Go to the URL of your instance to open the log in screen.
2. Open the Google Authenticator application on your mobile device and make note of the number. The number refreshes every 30 seconds.
3. Enter your username and password, and append the passcode that you currently see on your mobile device to your password without any extra spaces. For example, if your password is 12345 and the current passcode is 424 058, enter 12345424058.

If you forget to enter the code and you only enter the password, you are prompted to enter the code in a new window.

4. Enter the code and click Login.
5. If you do not remember the passcode, click the Click to send one-time passcode link.

The temporary passcode is sent to your email address. You can append this passcode to your password as you would the original passcode. You can only use this temporary passcode once and it is only valid for 10 minutes.

Note: You must have an email address configured in your user profile on the instance to receive this email message.

Set up multifactor authentication on your own profile

You can set up multifactor authentication on your own User profile.

Role required: none
**Note:** If you are trying to reset multi-factor authentication, log in to the instance first by requesting the temporary code via email, and then follow the steps below.

1. Navigate to **Self-Service > My Profile**.
2. Click the **Multifactor Authentication** related link on your User record.

The multifactor authentication window appears.

**Complete the steps below to enable multifactor authentication**

1. Download the app
   - Apple iTunes
   - Google Play
   - Windows Store

2. Scan the QR Code:

3. Type in the App's response:
   - 6 digit response
   - Validate Response

Or type in: KW2YUCQ6SIBOEN

3. If you do not yet have the Google Authenticator application in your mobile device, you can download it from one of the links provided under **Download the app**.

4. Take a photo of the QC code with the Google Authenticator application or enter the string in the application manually.

5. Enter the code and click **Validate Response**.

   The application responds with a six digit code that refreshes every 30 seconds. If you entered the correct code, a message appears telling you that Multifactor Authentication is set up. If you entered an invalid code, look for the code on your mobile device again as it may have refreshed, and enter the code that you see.

**Note:** For the code to work properly, the system time on your computer must be in the same time zone as the time on your mobile device.
Disable multifactor authentication on your User profile

Users can disable multifactor authentication on their own user profile.

Role required: admin

1. Log in the instance using your multifactor authentication code appended to your password.
2. Navigate to **Self-Service > My Profile**.
3. Click the **Multifactor Authentication** related link on your User record.
4. Click **Disable Multifactor Authentication**.
5. Confirm the action.

You return to the user record. The setting is automatically saved. You do not need to save your User record again.

Disable multifactor authentication on the User table

You can disable multifactor authentication for the users that you have access to on the User table.

Role required: admin

1. Log in the instance.
2. Open the User \[sys_user\] table.
3. Configure the list to show the **Enable Multifactor Authentication** column.
4. Change the values of the Enable Multifactor Authentication column for the selected users to false.

These users will no longer need the passcode. However, each user can still enable multifactor authentication for their own user profile. To disable the ability for any user to enable multifactor authentication, **disable the system property**.

OKTA SSO integration

Administrators can enable the Okta SSO integration to provide single sign-on access to instances through Okta.

This integration allows users to access their instance without logging in with their user credentials. Users only need to sign on to their organization's Okta service to gain access to the instance.

How the Okta integration works

Organizations using Okta for single sign-on services typically have user information stored in another user management system, such as Active Directory. The user data is shared between Okta and these services or applications so that Okta always has the most up-to-date user credentials necessary to automatically log users into their applications. Organizations using Okta might also enter user data directly into the Okta user management service.

For Okta to automatically authenticate users to the instance, user data must be shared between Okta and the instance. The user management system in Okta manages this data sharing. In the user management system, administrators identify the users that are users by either manually configuring the user data or by importing users from the database. If changes need to be made at a later time, the user management system can import the updates from the database or, if the updates were made in Okta, the user management system can push the updates to the user table. This keeps the user data in synch.
When a user successfully authenticates with Okta and tries to access the instance, a token is sent to the instance authorizing the user so they do not have to sign in again.

**Activate OKTA SSO**

An administrator can activate the SSO Provided by Okta, Inc. plugin (com.snc.sso.okta), which also activates the SAML 2.0 Update 1 plugin.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

**Set up the OKTA SSO integration**

The OKTA site contains up-to-date instructions on how to set up the integration with your instance.

Role required: admin

1. Activate the SSO that is provided by Okta, Inc. plugin.
2. Navigate to the following external URL: [ServiceNow Deployment Guide page](#).
3. Download the documentation.

**Instruct users to log in with OKTA SSO**

Users should log in to Okta before logging in to the application.

Role required: admin

This gives them access to all the applications that are configured to work with Okta, including the application, without signing in to each one separately.

After you activate Okta SSO, users can log into the application by:

- Clicking the **Click here to log in with Okta, Inc.** link on the login page.
- Clicking the application link on your organization’s Okta site.

In both cases, users who are already logged in to Okta are immediately redirected to the instance as a logged-in user. If they are not logged in to Okta, they must log in with their Okta credentials before being automatically redirected to the instance.
Enable external authentication

You can enable external authentication on your instance.

1. Navigate to **System Definition > Installation Exits**.
2. Activate the **ExternalAuthentication** installation exit.

**Note:** If you are using the Digest authentication method, you must also enable the DigestSingleSignOn installation exit.

3. Navigate to **System Properties > Single Sign-on**.
4. Select **Enable external authentication** and click **Save**.

You can also navigate to the **sys_properties.list** and search for the glide.authenticate.external property and set it to True.

Administrators might need to bypass external authentication when testing an SSO integration. Use the following URL to bypass external authentication and log in with a local user: `http://<your-instance>.service-now.com/side_door.do`

- A logged-in user cannot access the page
- Attempting to access the page while logged in produces a ‘page not found’ error

Limit concurrent sessions

You can limit the number of concurrent interactive sessions for a user or role on an instance across all nodes.

Concurrent interactive sessions refer to the number of sessions a user can have active per ServiceNow instance. An active instance session occurs with every new login to a specific ServiceNow instance. By default, there are no limitations on the number of active instance sessions a user can have.

With the Jakarta release, you can limit the number of active concurrent sessions per user. When the user logs in after hitting the maximum number of sessions active, the oldest active session terminates and a new interactive session becomes active. If a user tries to access a closed session through a browser, the user is redirected to the login page.

**Note:** The **Limit concurrent sessions** plugin must be active to enable a maximum session limit. Limits are set through the glide.authenticate.max.concurrent.interactive.sessions property. A maximum limit value applies to any user or role that has the limit property active. For the Jakarta release, this feature does not support sessions created through the native mobile app or non-interactive mechanisms.

A typical use case if a maximum concurrent session of 1 is set:

1. The user accesses the initial ServiceNow instance through Chrome.
2. After the user successfully logs in, ServiceNow creates session 1 (S1) for the user.
3. The user decides to initiate another access to the ServiceNow instance through Firefox.
4. After the user successfully logs in, ServiceNow creates session 2 (S2) for the user.
5. Since the user has a maximum concurrent session limit of 1, the S1 session invalidates when S2 is created.
6. When the user goes back through Chrome to access the S1 ServiceNow instance, the user is redirected to the login page as S1 is invalid.
Concurrent session limits work with all the ServiceNow authentication mechanisms: SAML, LDAP, and local database authentication. It also works with Multi-factor authentication and all interactive ServiceNow authentication mechanisms. The source of the session is viewable through the `sys_user_session` table, under the column `Type`. The values can be:

- Web Browser
- Mobile Browser
- ServiceNow Mobile App
- Non-interactive (SOAP, WSDL, OAuth)

### Activate and configure limit concurrent sessions plugin

You can activate the Limit Concurrent Sessions plugin (com.glide.limit.concurrent.sessions) if you have the admin role.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Find and click the Limit Concurrent Sessions plugin.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
4. Click **Activate**.
5. To enable this feature and set a maximum limit of concurrent sessions, go to the Plugin Files tab, find the following properties, and change the setting values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.authenticate.limit.concurrent.interactive.sessions</td>
<td>You can enable the ability to limit concurrent sessions by setting the value to <strong>True</strong>. By default, this property is set to <strong>False</strong>, which means there is no limit on the number of interactive sessions a user can have active.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To disable this feature, set this property back to <strong>False</strong>.</td>
</tr>
<tr>
<td>glide.authenticate.max.concurrent.interactive.sessions</td>
<td>You can set the maximum number of concurrent active interactive sessions a user can have on the instance across all nodes.</td>
</tr>
</tbody>
</table>

6. Optional: You can also amend the following properties, if necessary:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.authenticate.session.types.to.limit.concurrency | This property limits session types. By default, only the web browser sessions have a limit. Session types include:  
- Web Browser (1)  
- Mobile Browser (2)  
- ServiceNow Mobile App (3)  
- Non-interactive (10)  
You can configure and set the value to ‘1’ for web browser, ‘2’ for mobile browser, or ‘1,2’ for both.  
**Note:** Only web and mobile browser sessions can have a limit. There are no limits for sessions that originate from the ServiceNow mobile app or non-interactive sessions. |
| glide.authenticate.limit.concurrent.sessions.across.all.nodes | This property restricts the limit of concurrent sessions per node instead of restricting them across all nodes of a ServiceNow instance. By default, the value is set to true, which limits user sessions across all nodes. If the property is set to false, only the sessions on that node and not the ones on the other nodes are subject to the limit. |

7. **Click Update** to have the settings take effect.

**Set a concurrent session limit by user or role.**

**Set a concurrent session limit by user or role**

You can set a concurrent session limit on a specific user or on a particular role.  
Role required: admin  
1. Navigate to User Administration > Users or User Administration > Roles.  
2. Select a user or role that you want to set a concurrent session limit, check the Limit Concurrent Sessions check box, and click Update.  
The user or role has a limit of how many concurrent sessions can be open at one time.

**Disable a concurrent session limit by user or role**

You can disable a concurrent session limit on a specific user or on a particular role.  
Role required: admin  
1. Navigate to User Administration > Users or User Administration > Roles.  
2. Select a user or role that you want to disable a concurrent session limit, uncheck the Limit Concurrent Sessions check box, and click Update.  
The user or role is not subject to a limit of how many concurrent sessions can be open at one time.

**Normalization Data Services**

The Normalization Data Services plugin helps maintain consistency for table fields that refer to a company name.
Tables related to configuration items and assets usually contain columns referring to a company name, such as a vendor or manufacturer. Often, these tables refer to the same company by several different names. This situation can happen for many reasons. For example, vendors sometimes use different company names depending on the device. This inconsistency creates problems, especially for reports that rely on these company names.

The Normalization Data Services plugin helps alleviate this problem.

When you enable and configure the Normalization Data Services plugin, the system downloads a list of standard company names that ServiceNow has compiled. It also downloads a list of common variants of that name. Any time the plugin finds a company-name field with one of those variants, it substitutes the standard name in its place.

Note: The Normalization Data Services plugin refers to a standard name as a normalized name and to a variant name as a discovered name.

While the Normalization Data Services plugin provides services similar to the field normalization feature, it has several key differences:

- The Normalization Data Services plugin does not require you to manually set up the mappings from one name to another. If you like, you can add your own mappings to the set. However, you automatically start with extensive lists of common company names (normalized names) and their variants (discovered names).
- For Helsinki, the Normalization Data Services plugin applies only to the manufacturer field for configuration items and assets.

The Normalization Data Services plugin stores data in two tables. The Normalized Company Names table contains the list of normalized company names. The Normalized Mappings table contains the mappings between each discovered name and its normalized name.

Caution: If you edit a field whose value is a normalized name, you change the normalized name for ALL discovered names that map to it. This change occurs regardless of the table in which you edit the field.

Note: Because the Normalization Data Services feature requires an internet connection to download mapping information, this feature is not supported for on-premise instances.

Guided setup for the Normalization Data Services plugin

Activate and configure the Normalization Data Services plugin by following the steps outlined in the Guided Setup.

Role required: admin

1. Start guided setup.
   a) Navigate to Normalization Data Services > Guided Setup.
   b) Click Get Started.
   c) Read the description of the plugin, then click Get Started again. A list of steps appears.

2. Activate the Normalization Data Services plugin. If you manually activated the plugin, you can skip to Step 2.d.
   a) On the Activate Plugin row, click Configure.
      The plugin record displays.
   b) Click the Activate link (near the bottom of the page).
A series of dialog boxes ask for confirmation and show the progress of the installation.

c) Answer the prompts and wait for the plugin to complete installing.

d) On the Activate Plugin row for the Guided Setup, click Mark as complete.

3. Download the normalization data.
   a) On the Download Normalized Data row, click Configure. Then click Start Download.
      The download can take up to an hour.
   b) When the download completes, on the Download Normalized Data row, click Mark as complete.

4. Update reference qualifiers.
   a) On the Update Reference Qualifiers row, click Configure. Then click Start Update.
   b) When the update is complete, on the Update Reference Qualifiers row, click Mark as complete.

5. Set properties to configure Normalization plugin.
   a) On the Normalization Properties row, click Configure.
      The Normalization Properties dialog box appears.
   b) Check the properties you want to enable, then click Save.
      For guidance on what each property controls, see Normalization Properties.
   c) On the Normalization Properties row, click Mark as complete.

6. Optional: Normalize existing data in the CMDB CI table.
   a) If you want to normalize your existing data in the CMDB CI table, click Configure on the
      Normalize Configuration Items (CMDB) row. Otherwise, click Skip.
      The Normalize Configuration Items (CMDB) dialog box appears.
   b) On the Normalize Configuration Items (CMDB) row, click Mark as complete.

7. Optional: Normalize existing data in the CMDB Model table.
   a) If you want to normalize your existing data in the CMDB Model table, click Configure on
      the Normalize Configuration Items (CMDB) Model row. Otherwise, click Skip.
      The Normalize Configuration Items (CMDB) Model dialog box appears.
   b) Click Start Update.
   c) On the Normalize Configuration Items (CMDB) Model row, click Mark as complete.

Normalized Company Names table
The Normalization Data Services plugin stores the normalized company names in the Normalized Company Names table.

**Normalized company names fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The normalized name for this company.</td>
</tr>
<tr>
<td>Table</td>
<td>The table in which this name is stored.</td>
</tr>
</tbody>
</table>
Fields |
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td><strong>Customer override</strong></td>
</tr>
<tr>
<td>Customer override</td>
</tr>
</tbody>
</table>

**Normalized company names related lists**

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized mappings</td>
<td>A list of all the discovered names that map to this normalized name.</td>
</tr>
</tbody>
</table>

**Normalized Mappings table**

The Normalized Mappings table lists all the discovered names and the normalized name to which each maps.

**Normalized mappings fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Discovered name</strong></td>
<td>A variant of a normalized name in the database.</td>
</tr>
<tr>
<td><strong>Normalized name</strong></td>
<td>The normalized name to which the discovered name maps.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The table in which this name is stored.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td>The field in which this name is stored.</td>
</tr>
</tbody>
</table>

**Related mappings**

A list of all the discovered names that map to the same normalized name as the selected record.

**Actions**

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promote discovered name</td>
<td>Replaces the normalized name with the discovered name for the selected record and for all the records in its related mappings list.</td>
</tr>
</tbody>
</table>

**Normalization Properties**

On the Normalization Properties form, you can see and change the configurable properties for the Normalization Data Services plugin.
Normalization Properties

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference qualifiers on all tables that reference Company will be updated to use the Normalized field.</td>
<td>If Yes, any reference field for Company – for any table across the platform – uses the Normalized name. This service only works if you have run the Update Reference Qualifiers task in the Guided Setup.</td>
</tr>
<tr>
<td>Enable business rule that automatically normalizes manufacturer names for configuration items.</td>
<td>If Yes, the system normalizes company names when you add or update configuration items by a mechanism other than Discovery (such as by manual import sets).</td>
</tr>
<tr>
<td>Enable Discovery to use the normalization service for manufacturer name.</td>
<td>To have Discovery use the normalized company name for the manufacturer name, click Yes.</td>
</tr>
<tr>
<td>This property is to enable or disable the Normalization API.</td>
<td>To enable the Normalization Data Service API, click Yes. To disable, click No. For details, see Normalization Data Services.</td>
</tr>
</tbody>
</table>

Changing normalized company names

You can change a normalized company name several different ways. In all cases, that change affects all normalized fields referring to that company.

You have several options for changing a normalized company name:

- Edit the Normalized Name field in the Normalized Mappings table. This method is preferred.
- Edit the Normalized Company name table.
- Edit the Company Name field on any table that refers to the Company (core_company) table.

Caution: If you edit a field whose value is a normalized name, you change the normalized name for ALL discovered names that map to it.

Change a normalized company name

You can change normalized company names by editing records in the Normalized Company Name table.

Role required: admin

You can edit records in the Normalized Company Names tables, but you cannot add records to it.

1. Navigate to User Administration > Normalization Data Services > Normalized Mappings.
2. Find the record with the name you want to replace and edit the Normalized name field. The system changes the Normalized Company name for every discovered name that maps to that normalized name.

Platform performance

Ensure system optimization through performance monitoring and diagnostics.

- Application server response: Time for the application server to process a request and render the resultant page.
- Network latency and throughput: Time for the network to pass your request to the server and the response back.
Browser rendering and parsing: Time for your browser to render the HTML and parse/execute Javascript.
Instance Cache: The amount of system resources available for processing.

Instance cache effects on performance

There is a performance degradation whenever you purge and rebuild the instance cache. During core business hours, avoid or minimize any of the following actions that cause a purge and rebuild of the instance cache.
- Adding or updating system properties
- Adding or updating dictionary entries
- Committing update sets
- Adding or updating translations

Transaction log response times

The instance automatically logs the vital statistics of every transaction it processes, and that information is available to you as an administrator.

To look at the log, navigate to System Logs > Transactions.

To see the average response time of all listed transactions, right-click the column Response time. Select Configure > List Calculations, and then select the Average value check box.

It is a good practice to limit the list to those transactions that took place during the time period of interest. The default filter returns transactions from today.

Transaction log

For each completed transaction, the following information is available (times are in milliseconds):
- Date/time, User ID, IP address, and URL of the transaction.
- Total response time, which does not include the browser time because the server does not have that information.
- Network time: network transmission time, both from and to the user.
- SQL time: time spent executing SQL commands.
- SQL count: number of SQL commands executed.
- Business rule time: time spent processing business rules.
- Business rule count: number of business rules executed.
- Output length: how many bytes the transaction returned, after any compression.

Response time on forms

A response time indicator (clock) appears at the bottom right of many forms and lists. This indicator provides the processing time for a completed transaction, including the total time and the time for each step. Click the icon to show and hide the response time details. Point to the icon to see a tooltip with the details. The following example shows the response time for retrieving a filtered list in a demo instance.

Response time

In this example, the transaction took the following amount of processing time:
- 1019 milliseconds total time
- 3 milliseconds moving data across the network
- 526 milliseconds on the server

Note: Server time is calculated using the following formula:

\[
server\ time = (client\ response\ time - browser\ time - client\ network\ time)
\]

- 490 milliseconds in the browser, rendering the HTML and parsing and executing JavaScript

Response does not appear for simple operations, such as paging, changing a list sort order, or for the first transaction in a session.

To view a detailed breakdown of the browser processing time on forms, click browser.

Browser response time details

Administrators can disable the response time by setting the `glide.ui.response_time` property to `false`. 

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
When you review response times, look for the following issues.

1. A period where all transactions took an unusually long time. For example, transactions that normally took 1 second took 15 seconds between 11:00 AM and 11:20 AM. This issue can indicate that an unusual load, such as a large report, ran on that app server during that time.

2. A specific transaction which repeatedly took an unusually long time. For example, the list of closed incidents sorted by short description took 30 seconds each time it was displayed. This issue can indicate that a particular transaction put an unusual database load on the system, such as sorting 500,000 records on an unindexed field.

Try the following actions to improve performance.

1. Look for one or more transactions that span the entire window. For example, you observe that the response was slow for six minutes and one transaction ran the entire time. You can try adding additional indexing to the database to make the transaction faster. Certain types of queries are always going to run more slowly than others, regardless of indexing.

2. Ensure that a cache flush is not being run during business hours. Cache flushes are intended to prevent older data from interfering with changes and updates, and are performed automatically when using update sets. Scheduled cache flushes, using cache.do, can affect overall performance, and degrade system response times. Do not run cache flushes during business hours, and do not trigger cache flushes automatically.

3. If you cannot find any specific issues when experiencing slow response time, contact support to see if there are global issues with the application server hardware.

Client transaction timings

The Client Transaction Timings plugin provides extra information about the amount of time spent on both the client and server side, and by the browser and network. This feature not only helps find long-running processes, but also provides information about where in the process the performance issue is caused.

Network response times

Troubleshooting a poor network response time can be difficult, but there are certain quick tests you can perform.

One clear indicator of a network issue is when you find that users in one location have good performance, and users in another location have poor performance. That tells you that the server and application are fine. Assuming that browser settings are identical, the only meaningful difference is the network.

Ping times

The coarsest measure of network response time is a ping. A ping measures the total time for a packet to make it from the source machine to the target and back again.

To perform a ping in Windows, bring up a command window (DOS prompt) and type:

```
ping -t <yourinstancename>.service-now.com
```
Look for a time under 100 ms if you are in the U.S., or 150 ms if you are in Europe or Asia. In practice, anything less than 250 ms is not of concern as it is not generally a major component in your perceived response time.

**Traceroute**

If you are seeing slow ping times, you can run a traceroute. Some networks refuse to forward ICMP, and your traceroute request may not work. If it does work, it is a great tool for identifying network bottlenecks. To run a traceroute on Windows, bring up a command window and run the following command.

```
tracert <yourinstancename>.service-now.com
```

Sample output:

```
C:\dev\mysql5\bin>tracert mycompany.service-now.com
Tracing route to mycompany.service-now.com [70.85.100.85] over a maximum of 30 hops:
1    1 ms    1 ms    1 ms  12.192.116.193
2    4 ms    4 ms    4 ms  12.116.227.37
3  32 ms  32 ms  32 ms  gbr1-p90.sd2ca.ip.att.net [12.123.145.178]
4  33 ms  33 ms  33 ms  tbr1-p013503.phmaz.ip.att.net [12.122.2.142]
5  34 ms  33 ms  33 ms  tbr2-cl1521.phmaz.ip.att.net [12.122.10.194]
6  32 ms  33 ms  33 ms  tbr2-cl1592.dlstx.ip.att.net [12.122.10.81]
7  31 ms  50 ms  31 ms  gar1-p370.dlrtx.ip.att.net [12.123.16.173]
8  31 ms  31 ms  31 ms  12.119.136.14
9  31 ms  31 ms  31 ms  te9-1.dsr02.dllstx3.theplanet.com [70.87.253.22]
10 37 ms  37 ms  37 ms  vl41.dsr01.dllstx4.theplanet.com [70.85.127.83]
11 31 ms  37 ms  31 ms  gi1-0-1.car16.dllstx4.theplanet.com [67.18.116.67]
```

© 2019 ServiceNow Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Each line in the traceroute represents a network step between the source machine and the destination machine. In the sample traceroute, there were a total of 12 steps required to get the network traffic from the laptop to <yourinstancename>.service-now.com.

- The left column is the step number.
- The next three columns are latency estimates, performed three times to give an average.
- The last column is the machine you are hopping to.

For example, from rows #1 and #2 above, you can tell:

<table>
<thead>
<tr>
<th>Step</th>
<th>Latency</th>
<th>Latency</th>
<th>Latency</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 ms</td>
<td>1 ms</td>
<td>1 ms</td>
<td>12.192.116.193</td>
</tr>
<tr>
<td>2</td>
<td>4 ms</td>
<td>4 ms</td>
<td>4 ms</td>
<td>12.116.227.37</td>
</tr>
</tbody>
</table>

At the end of row 1, it was at 12.192.116.193. It then took 4 ms (on average) to get to 12.116.227.37.

Generally, with a traceroute, you are looking for individual steps that take a long time, like 500 ms for a particular hop. You are also looking for steps that show an asterisk (*) instead of a step time, for example:

<table>
<thead>
<tr>
<th>Step</th>
<th>Latency</th>
<th>Latency</th>
<th>Latency</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100 ms</td>
<td>*</td>
<td>500 ms</td>
<td>12.192.116.193</td>
</tr>
</tbody>
</table>

The asterisk indicates that a particular packet failed to arrive, which can indicate network problems on that particular hop. You also see an asterisk if that particular router is set to not forward ICMP. This outcome is potentially a false alarm if all three latency times for a step are asterisks.

### Browser settings and performance

Depending on the browser you use, browser settings can affect the performance of your instance.

Web pages in your instance can be large, for example, over 500 kb for a long list of incidents with many columns. To speed performance, most browsers can accept compressed data from an application server so that the full 500 kb does not have to be sent over the wire. Instead, the browser indicates that it can accept compressed data if the server can send it. The app server then compresses the response, which transforms the 500 kb data to about 20 kb.

Compression is enabled by default on all ServiceNow application servers. The application server always sends compressed data if your browser accepts it. There are browser settings that control whether your browser accepts compressed responses.

In Microsoft Internet Explorer (IE), navigate to Tools > Internet Options. Ensure that the following two check boxes are selected in the Advanced tab.

- Use HTTP 1.1
- Use HTTP 1.1 through a proxy server
Frequently, a proxy or edge device in the environment disables gzip compression. Enabling gzip compression also speeds up the interactions.

**Cache items from https locations**

If you enforce an IE policy to never cache items from an https location, every interaction must refetch a large amount of JavaScript and images from the server, which affects performance. The IE option is *Do not save encrypted pages to disk*, and the default is off.

**Diagnostics page**

Administrators can use the system diagnostics page to look for root causes of platform performance issues.

This page provides an overview of useful diagnostic information about a running instance and cluster nodes.

Navigate to [System Diagnostics > Diagnostics Page](#).
### System Diagnostics

#### Cluster Nodes Status
- **Name**: apo120021.iad4.service-now.com:demoonightly/helsinki001
- **Status**: online
- **Logged in users**: 26
- **Last reported**: 0 seconds
- **Last reported (seconds ago)**: 0
- **JVM UP time**: 13 hours 1 minute
- **JVM CPU time**: 3 hours 8 minutes
- **Scheduler running**: true
- **Scheduler queue length**: 0

#### Memory (MB)
- **813.0 of 1980.0**

#### JVM Classes
- **27029.0 loaded, 1503.0 unloaded**
- **Transactions**: 82905
- **Errors**: 218
- **GC.ConcurrentMarkSweep.Count**: 329 (2 per 5 minutes)
- **GC.ConcurrentMarkSweep.TotalTime**: 522285 (4 minutes)
- **GC.ConcurrentMarkSweep.AvgTime**: 0.88640425
- **GC.ParNew.Count**: 7425 (47 per 5 minutes)
- **GC.ParNew.TotalTime**: 144453 (2 minutes)
- **GC.ParNew.AvgTime**: 0.019453676

#### System overview
- **Emails (recv) last 60 minutes**: 0
- **Emails (send) last 60 minutes**: 0
- **Events pending**: 1
- **Log entries last 60 minutes**: 409
- **POP3 Status**: 0
- **SMTP Status**: There is currently no active SMTP account configured, cannot send email

#### Database overview
- **URL**: jdbc:mysql://db109144.iad4.service-now.com:34411/sfl5833df17b50a5
- **Name**: demoonightly/helsinki_1
- **Driver**: Demo
- **Type**: 5.6.16-log
- **Version**: 1.1
Memory

To see how much memory each node is using, you can use the 'stats' page for each node in System Diagnostics. Each 'stats' page lists the available and in-use memory. Bear in mind that memory use will fluctuate, and it’s not uncommon for it to 'creep' up to beyond 95% usage before memory garbage collection reduces it back to normal levels.

Cluster Nodes

If you’re running a multiple-node cluster, it’s useful to know the status of each of the nodes. The nodes check in every 30 seconds and display their current status in the 'sys_cluster_state' table. You can see this information by clicking the 'Note States' module in the 'System Cluster' application.

Transactions

If you’re looking for 'what was this user doing at this time', the transaction log is your friend. The transaction log lists all transactions, the user who performed it, and the URL the user was going to. You can get to the transaction log by going to System Logs > Transaction Log.

Email

The email log can help you determine whether emails are sending, who they’re sending to, and the format of the message itself. The email log also shows all inbound email. You can get to the email log by going to System Logs > Email Log.

Configuring System Diagnostics Properties

Use properties to define when things appear red on the page. Navigate to System Properties > System Diagnostics.
System Diagnostics

Please edit your changes and press Save

Customization Properties for System Diagnostics

Auto refresh the system_diagnostics_page after this many seconds:

60

Condition used to flag Emails Received value:

Condition used to flag Emails Sent value:

Condition used to flag Pending Events value:

> 1000

Condition used to flag number of log entries in last 24 hours value:

Condition used to flag a node’s Last Reporting Time value:

> 180

Condition used to flag a node’s Scheduler Is Running value.

! = 'true'

Condition used to flag a node’s Schedule Queue Length value.

> 10

Condition used to flag a node’s Status value:

! = 'online'

Condition used to flag POP3 Status value:

Condition used to flag SMTP Status value:
System Diagnostics Stats Tools

To aid in performance evaluation, the Stats Tools records statistics for system activities that affect performance such as the execution of queries, scripts, and transactions.

**Note:** The Stats Tools plugin is activated by default. It requires the admin role to activate or upgrade, and it requires the com.glide.monitor.round_robin_database.

Stats Tools adds modules under System Diagnostics > Stats, including Slow Queries, Slow Scripts, and Slow Transactions. Each module accesses a table of activity patterns (sys_query_pattern), (sys_script_pattern), (sys_transaction_pattern). Each pattern table represents a collection of unique activities. Each collection is an aggregation of executions of that unique activity over all time. Each record provides basic timing analysis with example identifiable details of the activity.

Activity patterns are immediately recorded to a cache and are later persisted to their pattern table. If you flush server caches, then recorded activities that have not been persisted are cleared.

Following are examples of pattern records.

- Each time a query is executed that meets the recording and persistence threshold it is aggregated and stored as a query pattern record.
- Each time a particular business rule is executed it aggregates to a script pattern record.
- Each time a particular background job runs it aggregates into a unique transaction pattern record.
- Each click of the New button on the Incidents list counts as a list type transaction pattern with specific form action.

**Metrics**

Metrics include total and average times of interest per unique execution pattern over the total execution count. Metrics are aggregated with each new instance of the unique activity and persisted to the pattern record.

**Metadata**

Example data from specific executions are included on each pattern to identify execution details.

**Characterizations of each activity type**

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Any transaction type includes server-side and related client-side transactions. Metrics include <strong>Total server load time</strong>, which aggregates the total server-side time excluding semaphore and session wait times. It also aggregates relevant server transaction times that are found on the syslog_transaction table. Transaction types:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• An HTTP Request transaction is identified by a URL, transaction type, processor, form/list action, URL query (filters), and related table name.</td>
</tr>
</tbody>
</table>
Any other transaction is identified by its transaction URL/page/name, transaction type, and processor or thread name.

**Scripts**

Any script activity type includes scripts evaluated by GlideScopedEvaluator.

**Script Types:**
- A Jelly Script is identified by the `sys_jelly_file` table, jelly file path, line number, and script that was executed.
- Any other script is identified by the table and `sys_id`.

**Queries**

Any query activity includes prepared statements executed by GlideDBI.

**Query Types:**
- All queries are identified by MongoDB query or insert, update, or select statements, as well as other components of the statement like selected columns, where clause, unions, column sets, and limits.

---

**Slow mutex locks record detail**

Administrators can use slow mutex logs to gain insight into how mutex locks are affecting platform performance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mutex name</td>
<td>The name of the mutex lock for this record.</td>
</tr>
<tr>
<td>Is Fast Lock</td>
<td>If <code>false</code>, the lock was placed on a record in the ServiceNow platform. If <code>true</code>, the lock was placed on a record in the underlying database.</td>
</tr>
<tr>
<td>Average execution time</td>
<td>The average time for which the mutex lock was held.</td>
</tr>
<tr>
<td>2-hour moving average (ms)</td>
<td>The average of the moving average values of execution time, calculated over periods of two hours.</td>
</tr>
<tr>
<td>Day moving average (ms)</td>
<td>The average of the moving average values of execution time, calculated over periods of one day.</td>
</tr>
<tr>
<td>Month moving average (ms)</td>
<td>The average of the moving average values of execution time, calculated over periods of one month.</td>
</tr>
<tr>
<td>Execution count</td>
<td>The number of similar occurrences that are aggregated.</td>
</tr>
<tr>
<td>Last sighting</td>
<td>The time and date the last occurrence was noted.</td>
</tr>
<tr>
<td>First sighting</td>
<td>The time and date the first occurrence was noted.</td>
</tr>
<tr>
<td>Example stack trace</td>
<td>A stack trace for an individual mutex lock.</td>
</tr>
<tr>
<td>Total execution time</td>
<td>The sum of execution time for the aggregated occurrences.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### ServiceNow Jakarta Now Platform Administration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has</td>
<td>The hash value for this record.</td>
</tr>
<tr>
<td>Label</td>
<td>The mutex lock label.</td>
</tr>
<tr>
<td>Example URL</td>
<td>The URL for an individual mutex lock.</td>
</tr>
<tr>
<td>Event Execution Time / Event Count Trend graphs</td>
<td>The Mutex Execution Time Trend graphs show the total execution time of these mutex locks over the most recent period of two hours, one day, or one month. The Mutex Count Trend graphs show the mutex lock counts over the most recent period of two hours, one day, or one month.</td>
</tr>
</tbody>
</table>

### Slow events log record detail

Administrators can use slow events logs to gain insight into how events are affecting platform performance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event name</td>
<td>The name of the event for this record.</td>
</tr>
<tr>
<td>Queue</td>
<td>The event queue containing this event.</td>
</tr>
<tr>
<td>Execution count</td>
<td>The number of similar occurrences that are aggregated.</td>
</tr>
<tr>
<td>Average execution time (ms)</td>
<td>The average duration to execute one of these similar events.</td>
</tr>
<tr>
<td>Day moving average (ms)</td>
<td>An average of the moving average values of execution time, calculated over periods of one day.</td>
</tr>
<tr>
<td>Last sighting</td>
<td>The time and date the last occurrence was noted.</td>
</tr>
<tr>
<td>First sighting</td>
<td>The time and date the first occurrence was noted.</td>
</tr>
<tr>
<td>Hash</td>
<td>The hash value for this record.</td>
</tr>
<tr>
<td>Month moving average (ms)</td>
<td>An average of the moving average values of execution time, calculated over periods of one month.</td>
</tr>
<tr>
<td>Label</td>
<td>The event label.</td>
</tr>
<tr>
<td>Example URL</td>
<td>The URL for an individual event.</td>
</tr>
<tr>
<td>Example stack trace</td>
<td>An example stack trace for an individual event.</td>
</tr>
<tr>
<td>Total execution time</td>
<td>The sum of execution time for the aggregated occurrences.</td>
</tr>
<tr>
<td>Event Execution Time / Event Count Trend graphs</td>
<td>The Event Execution Time Trend graphs show the total execution time of these events over the most recent period of two hours, one day, or one month. The Event Count Trend graphs show the event counts over the most recent period of two hours, one day, or one month.</td>
</tr>
</tbody>
</table>
Use a slow query log

Administrators can use slow query logs to gain insight into how queries are affecting platform performance. The Slow Queries log aggregates data for similar queries. Use slow query data to evaluate the need for new indexes, changes to existing indexes, or changes to frequent queries.

Role required: admin

Queries are similar when they select from the same table and query the same field in the where clause, but search for different values in the field. For example, these queries are aggregated as similar queries.

SELECT * FROM sys_user WHERE name="ITIL User"
SELECT * FROM sys_user WHERE name="System Administrator"

Aggregating similar query data allows administrators to monitor the performance impact of slow queries and of queries that occur frequently. The log reports data for similar queries where the total execution time exceeds 5 seconds.

1. Navigate to System Diagnostics > Stats > Slow Queries

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT sys_execution_tracker0,'parent', ...</td>
<td>An SQL statement for an individual query, before being canonicalized to aggregate it with similar queries.</td>
</tr>
<tr>
<td>Hash</td>
<td>The hash value for this record.</td>
</tr>
</tbody>
</table>

2. Open a query record for more details.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Example stack trace           | A stack trace for an individual query. Lines referencing script code (includes both custom and base system code) appear in the following format:  
  table name.sys_id:line number
  For example, this stack trace indicates a function call from line 119 of a script include.  
  sys_script_include.105f70abc0a8010300d4d79ed1b93eb0:119
  For more information, see [stack traces](#).                                                                                                         |
| Example URL                   | The URL for an individual query, depending on how the query was called.  
  - User transactions: lists the transaction parameters. For example, if a user navigates to the incident list, the URL is `/incident_list.do sysparm_query=active=true`  
  - Scheduled jobs: lists the name of the scheduled job.  
  - Any other method: lists an empty field.                                                                                                             |
| First sighting                | The first occurrence of a similar query.                                                                                                                                                                     |
| Last sighting                 | The last occurrence of a similar query.                                                                                                                                                                     |
| Total execution time          | Total execution time.                                                                                                                                                                                       |
| Execution Count               | The number of similar query occurrences that are aggregated.                                                                                       |
| Average execution time (ms)   | The average duration to execute one of these similar queries.                                                                                       |

3. To see what the database is doing to retrieve the data, click **Explain Plan**.  
The query plan is reported in the **MySQL Explain Plan** related list. Use the query plan to evaluate the need for new indexes or changes to existing indexes. For more information, see [MySQL explain plan documentation](#).

This feature works on other supported databases, including MongoDB and Oracle.

4. To generate an index suggestion for a slow query, click **Index Suggestion**. For details, see [Generate an index suggestion for a slow query](#).

### Index suggestions for slow queries

The Index Suggestion Engine (ISE) can generate an index suggestion for a selected slow query. When you request an index suggestion for a slow query, the ISE analyzes the query and recommends an index that can improve the query execution time.

If you choose to use the index suggestion and create the index, the ISE continues to review the effectiveness of that index during a 14-day evaluation period. The ISE provides details on the index during the evaluation, including recommendations for managing the index.

Administrators use the ISE to:
• Generate an index suggestion for a slow query.
• Review index suggestions for slow queries in your instance.
• Export an index suggestion to a non-production instance for evaluation and testing.
• Schedule an index for creation.
• Monitor the effectiveness of an index during the index evaluation period.
• Test index performance (this test is an immediate performance assessment of the index).
• Drop an index that does not optimize query performance, as recommended by the ISE.

In new and upgraded instances, the Index Suggestion Engine plugin (com.glide.index_suggestion) is activated by default.

Note: The ISE supports MySQL databases only.

How index suggestions work

You start the index suggestion process by requesting an index suggestion for a selected slow query. The ISE runs a daily job that collects column statistics from tables in the slow query, gathering data such as cardinality (unique columns in a table) and null/not null count.

Next, the ISE aggregates and analyzes the information collected, applies a weighted column ranking algorithm to the slow query, and generates an index suggestion for the query.

After an index suggestion is generated, you review the suggestion and determine whether to create the index for the slow query. When you create the index, the ISE provides information on the index as it moves through its life cycle. You can track the index suggestion through three main processing stages:

Index suggestions to review

During this initial stage, you can review index suggestions that the ISE generated for your slow queries. You can choose to ignore a suggestion, export the index suggestion to a non-production instance for further testing, or schedule the index for creation. If the ISE successfully generates an index suggestion and you choose to schedule the index for creation, the index suggestion moves to the next processing stage. However, if the database cannot use the suggestion or the suggestion degrades query performance, the ISE recommends that you drop the index suggestion.

Index in progress

In this stage, the ISE creates the index and the 14-day evaluation period begins. The ISE does an hourly evaluation to determine whether the index improves or degrades the query execution time. The ISE updates the index state, including recommended actions that you can take. For example, if the index does not improve the performance of the slow query, the ISE advises that you drop the index. You can then schedule the index to be dropped from the database. During this stage, you can also choose to test index performance or accept an index, even if the ISE recommends dropping it.

Index done

In the last processing stage, the ISE describes the final state of the index and related processing activity. If the index improved the slow query time, the ISE changes the index state to Created and the database continues to use the index. If the index did not improve the query time and you chose to drop the index, the ISE drops the index from the database and changes the index state to Dropped.

Index suggestion life cycle
Processing states for index suggestions

The Index Suggestions (sys_index_suggestion) table provides state information on your indexes as they move through the three main processing stages:

- Index Suggestions > To review
- Index Suggestions > In Progress
- Index Suggestions > Done

Index Suggestions table
The Index Suggestion Engine uses the following states to describe the processing activity for an index.

### Index suggestion states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Suggestions to review</td>
<td></td>
</tr>
<tr>
<td>Suggested</td>
<td>ISE generated an index suggestion for the slow query.</td>
</tr>
<tr>
<td>Drop Suggested - Unused</td>
<td>ISE recommends that you drop the index, since the database is not using the index for the slow query.</td>
</tr>
<tr>
<td>Drop Suggested - Performance Degradation</td>
<td>ISE recommends that you drop the index because the index did not improve the query time or made the performance worse.</td>
</tr>
<tr>
<td>Index in progress</td>
<td></td>
</tr>
<tr>
<td>Creation Scheduled</td>
<td>You scheduled the index for creation.</td>
</tr>
<tr>
<td>Creation in Progress</td>
<td>ISE is creating the index.</td>
</tr>
<tr>
<td>Creation Failed</td>
<td>ISE could not create the index.</td>
</tr>
<tr>
<td>Evaluating Effectiveness</td>
<td>ISE created the index and is assessing index performance during the 14-day index evaluation period.</td>
</tr>
<tr>
<td>Drop Suggested - Unused</td>
<td>ISE recommends that you drop the index from the table for which the index was created, since the database is not using the index for the slow query.</td>
</tr>
</tbody>
</table>
## Generate an index suggestion for a slow query

Use the Index Suggestion Engine (ISE) to generate an index suggestion for a slow query.

**Role required:** admin

When the ISE generates an index suggestion for a slow query, it reviews query metrics and information from tables in the query. If the ISE does not have the information required to generate an index suggestion, the system displays messages informing you about the data needed. These messages typically provide links for obtaining more information, such as updated query metrics or gathering column statistics from tables in the query. Sometimes the ISE may be unable to suggest an index for the query and lets you know why the suggestion cannot be generated.

1. Navigate to **System Diagnostics > Stats > Slow Queries**.
2. In the Slow Queries table, click the query record for which the index suggestion is to be generated.
3. In the Slow Queries record, click **Suggest Index**.

   If the ISE needs more information, the system may display one or more messages with details for obtaining that information. After you respond to each message, click **Suggest Index**. Repeat this process until the ISE has the information required to generate the index suggestion.

For example, the ISE may need:

- **Recent metrics** - If the system displays a message indicating that query metrics are outdated, the message provides a link for obtaining the most recent metrics.
  - Click the link to get the updated query metrics.
  - Click **Suggest Index**.

- **Column statistics** - If the column statistics do not exist for the query, the system displays a message asking you to schedule the Collect Column Stats job. You can choose to run the
job at the default time when the system is less busy, or you can have the system collect the statistics immediately.

- If you schedule the Column Stats job to run later, the ISE generates the index suggestion after it collects the column statistics. After the column stats job runs, return to the Slow Queries record and click Suggest Index.
- If you choose to collect column stats immediately, the system displays the Collect Column Statistics progress indicator while it gathers column statistics. In the Slow Queries record, click Suggest Index.

When the ISE successfully generates an index suggestion, the Index Suggestion record for the query shows the index State as Suggested.

4. If you want to continue working with the index suggestion, select the next processing step:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Downloads the index suggestion as an .xml file so that you can export it to a non-production instance for testing and evaluation.</td>
</tr>
<tr>
<td>Ignore</td>
<td>Sets the index suggestion state to Ignore, which indicates that the index suggestion is not to be used. Index suggestions with an Ignore state are listed in the Index Suggestions &gt; Done view of the Index Suggestion table.</td>
</tr>
<tr>
<td>Schedule creation</td>
<td>Opens the Schedule Index Creation window for scheduling index creation.</td>
</tr>
</tbody>
</table>

Review index suggestions for slow queries

You can review index suggestions and indexes created by the Index Suggestion Engine (ISE). The ISE provides three main views of index suggestions as they move through their life cycle: index suggestions in review, index in progress, and index done.

Role required: admin
Access index suggestions from the Application Navigator or the Performance homepage.

1. Access the index suggestions for your instance:

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Application Navigator</td>
<td>Navigate to System Diagnostics &gt; Index Suggestions &gt; Index Suggestions &gt; To review.</td>
</tr>
<tr>
<td>From the Performance homepage</td>
<td>If the suggestion icon indicates that one or more index suggestions are available, ( ), click it to open the Suggested Indexes window, and click View all suggested indexes.</td>
</tr>
</tbody>
</table>

Note: In the Suggested Indexes window, click View next to a specific table to open its index suggestion record in the Suggestion Details - Add Index form. This form is the same as the Index Suggestion form described in Step 3.

2. In the Index Suggestions table, click the **Table Name** associated with the index suggestion you want to view.

3. Review the index suggestion for the selected table.
Index Suggestion fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slow query</td>
<td>The slow query for which the index suggestion was generated.</td>
</tr>
<tr>
<td>Example</td>
<td>An actual SQL statement for an individual query, before being canonicalized</td>
</tr>
<tr>
<td>Table name</td>
<td>Name of the table used in the query.</td>
</tr>
<tr>
<td>Column names</td>
<td>Names of the columns used in the query.</td>
</tr>
<tr>
<td>Index name</td>
<td>Name of the index, assigned by the ISE after the index is created.</td>
</tr>
<tr>
<td>State</td>
<td>Processing state of the index. For details, see the <code>Index suggestion states</code> table.</td>
</tr>
<tr>
<td>Imported</td>
<td>This box, if checked, indicates that the index suggestion was imported from a different instance for evaluation and testing.</td>
</tr>
</tbody>
</table>

4. Choose the next processing step for the index suggestion.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Downloads the index suggestion as an .xml file, which can be exported to a non-production instance for testing and evaluation.</td>
</tr>
</tbody>
</table>
### Export an index suggestion to a non-production instance

You can export an index suggestion from a production instance to a non-production instance for evaluation and testing, before implementing the index on your production instance.

**Role required:** admin

This task involves exporting an index suggestion as an .xml file from your production instance and importing it to a non-production instance. You can then create the index and evaluate its performance on the non-production instance.

1. In your production instance, navigate to the Index Suggestion to be exported:
   a) Access the Index Suggestions table to review the index suggestions for slow queries.

      | Location | Description |
      |----------|-------------|
      | From the Application Navigator | Navigate to System Diagnostics > Index Suggestions > Index Suggestions > To review. |
      | From the Performance homepage | If the suggestion icon indicates that one or more index suggestions are available ( ), click it to open the Suggested Indexes window, and click View all suggested indexes. |

      **Note:** In the Suggested Indexes window, you can click View next to a specific table name to open its index suggestion record.

   b) In the Index Suggestions table, click the **Table Name** to open the index suggestion.

2. In the Index Suggestions form, click Export.
   The ISE downloads the index suggestion as an XML file with the file name `sys_index_suggestion_<alphanumeric identifier>.xml`. The file name has a unique alphanumeric string to differentiate it from other index suggestions.

3. In your non-production instance, navigate to System Diagnostics > Index Suggestions > Index Suggestions > To review.

4. In the Index Suggestions table under Related Links, click Import Suggestions.

5. In the Import XML form, choose the index suggestion file that you exported and click Upload.
After the import, the imported index suggestion appears in the Index Suggestions table on your non-production instance.

6. To continue the index evaluation process on your non-production instance, you can schedule the index suggestion for creation and test index performance.

Schedule an index suggestion for creation

Use the Index Suggestion Engine (ISE) to schedule an index suggestion for creation.

Role required: admin

1. Navigate to the index suggestion for the slow query:

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Application Navigator</td>
<td>Navigate to System Diagnostics &gt; Index Suggestions &gt; Index Suggestions &gt; To review.</td>
</tr>
<tr>
<td>From the Performance homepage</td>
<td>If the suggestion icon has a number ( ), click the icon to open the Suggested Indexes window, and click View all suggested indexes.</td>
</tr>
</tbody>
</table>

2. In the Index Suggestion table, click the Table Name for which the index is to be created.
3. In the Index Suggestion form, click Schedule Creation.
4. In the Schedule Index Creation window, select the time that the index is to be created and click Create. You can schedule index creation later when your instance is less busy.
**Note:** If the index to be created involves large tables, such as the Incident or CMDB table, index creation may take up to one hour or longer.

- **Create now** - The Schedule Index Creation progress indicator window shows the progress of the index creation. When index creation is complete, click **Close**.
Create later - If you select this option, the state changes to Create Scheduled, and the index is created at the scheduled time. After the index is created, the index state changes to Evaluating Effectiveness.

When the ISE creates the index at the selected time, it assigns an index name based on the tables used in the slow query.

5. Verify that the index was created by reviewing the index State in the Index Suggestion record or in the Index Suggestion table (System Diagnostics > Index Suggestions > Index Suggestions > In Progress).

The Index Suggestion record shows the state, Evaluating Effectiveness. The ISE begins the 14-day index evaluation period.
6. During the evaluation period, you can monitor the index **State** in the Index Suggestion record or in the Index Suggestion table (System Diagnostics > Index Suggestions > Index Suggestions > In Progress).
**Test index performance**

After the Index Suggestion Engine (ISE) creates an index for a slow query, you can test the index to see if it improves the query time.

**Role required: admin**

This test is a quick assessment of the index and is not part of the 14-day index evaluation process. If you are evaluating an index suggestion on a non-production instance, you can run this test after creating the index to get immediate results on index performance.

**Note:** Index test results from your non-production instance may not necessarily predict similar performance results on your production instance.

1. Open the Index Suggestion record for the index to be tested:
   a) Navigate to **System Diagnostics** > **Index Suggestion** > **Index Suggestions** > **In progress**.
   b) In the Index Suggestions table, click the **Table name** for the index to be tested.

2. In the Index Suggestion record, click **Test Performance** to start the performance test.

3. When the Test Index Suggestion progress indicator shows that testing is complete, click **Go to Result**.

4. In the Query Performance Test Results form, compare the **Average with index** and **Average without index** fields to see if the index improved the query time.
   
   In the following example, the index improved the query time. The **Forced** check box is unchecked, indicating that the database is using the index. If the check box is checked, the database was forced to use the index during the test but is not using the index outside of the test.
### Query Performance Test Results

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Suggestion</td>
<td>Name of the index suggestion.</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time this performance test was run.</td>
</tr>
<tr>
<td>Average with Index (ms)</td>
<td>Query time using the index suggestion.</td>
</tr>
<tr>
<td>Average without Index (ms)</td>
<td>Query time before using the index suggestion.</td>
</tr>
<tr>
<td>Forced</td>
<td>Check box indicating whether the database is using the index. If this box is checked, the database was forced to use the index suggestion, but only for this test. If the box is unchecked, the database is using the index.</td>
</tr>
</tbody>
</table>

5. Click the back arrow to navigate back to the Index Suggestion record for the table. The result of this index performance test does not change the index state recorded in the Index Suggestion record.

### Schedule an index to be dropped

Administrators can drop an index for a slow query when the index is not used by the database or does not improve query performance.

**Role required:** admin

During the index evaluation period, the ISE may recommend that you drop the index when the database does not use the index or the ISE finds that the index does not improve the query time. You can drop the index immediately or schedule the drop for a later time.
Note: If you want to retain an index even though the ISE recommends dropping it, you can use the Accept option in the Index Suggestion record to continue using the index. Before using this option, contact ServiceNow Technical Support for guidance.

1. Navigate to System Diagnostics > Index Suggestions > Index Suggestions > In Progress.
2. In the Index Suggestions table, click the Table Name for the index to be dropped.
3. In the Index Suggestion record, click Schedule Drop.
4. In the Schedule Index Drop window, select the time that the index is to be dropped and click Drop. You can schedule the index drop at a later time, when your instance is less busy.

Note: If the index to be dropped involves large tables, such as the Incident or CMDB table, dropping the index may take up to one hour or longer.

### Schedule Index Drop

**Select Time**

- [ ] Drop now
- [x] Drop later

2017-05-06 17:17:57

- **Drop now** - The Schedule Index Drop progress indicator window shows the progress of the index drop. When the index drop completes, click Close. If the drop is successful, the Index Suggestion record shows the index state as Dropped.
Schedule Index Drop

- **Drop later** - When you schedule the drop, the index state changes to Drop Scheduled. When the system drops the index at the scheduled time, the index state changes to Dropped.

5. Verify that the index was dropped by reviewing the index state in the Index Suggestion record or in the Index Suggestion table (System Diagnostics > Index Suggestions > Index Suggestions > Done).

**Transaction cancellation**

A user can cancel a transaction that takes longer than expected to load. Causes of slow-loading transactions include the following scenarios.

- Sorting a large number of records by an unindexed string field.
- Grouping a large table on a field that has predominantly distinct values.
- Exporting all rows from a large table.
- Testing a poorly scripted business rule that has an infinite JavaScript loop.

**Note:** You cannot cancel an import with these controls.
**Transaction cancel timer**

During a long-running transaction, a timer and a red cancellation button appear in the banner frame.

![Welcome: James Capaldo - Running: 26.1s](image)

**Cancel request**

To cancel the transaction, click the cancellation button. The timer indicates that the transaction is being canceled. When it is finished, you see a message that the transaction was canceled.

If the transaction completes successfully, the timer indicates how long it took for the transaction to complete.

![Welcome: James Capaldo - Completed: 9.0s](image)

**Transaction completed**

**Canceled transaction logs**

Canceled transactions appear in the transaction log with **CANCELLED** appended to the URL. Transactions canceled by a user are logged differently from transactions canceled by Transaction quotas.

**Cancel transaction properties**

Administrators can configure the behavior of the transaction cancel capability using the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.request_manager.active</td>
<td>Let users cancel long running transactions (enabled by default).</td>
<td>Open the sys_properties table.</td>
</tr>
<tr>
<td>glide.ui.transaction.long_response</td>
<td>Delay in seconds before the cancel transaction button appears for a long-running transaction.</td>
<td>Navigate to System Properties &gt; UI Properties</td>
</tr>
</tbody>
</table>
View and kill active transaction

Administrators can view active transactions and kill long-running transactions.

*Note:* Functionality described here requires the **Admin** role.

This action is intended to stop background processes, such as scheduled jobs, and not user-initiated transactions.

1. If **high security** is enabled, elevate privileges to security_admin.
2. Navigate to the appropriate **Active Transactions** module.
   - To view and kill transactions on the current node for your instance, navigate to **User Administration > Active Transactions**.
   - To view and kill transactions on all nodes for your instance, navigate to **System Diagnostics > Active Transactions (All Nodes)**.
3. Select the transaction you want to stop.
4. Either right-click the record and select **Kill**, or select the check box next to the record and select **Kill** from the **Actions on selected rows** drop-down at the bottom of the list.

Canceled-transaction logging to a table

The system logs canceled-transactions to a table in addition to the transaction log.

Transactions canceled manually or by a quota rule are logged to the Transaction Cancellation Log (`syslog_cancellation`). The Transaction Cancellation Log is an extra debugging feature, and will not contain information on all cancellations.

*Note:* There are safeguards in place to prevent infinite loops and issues related to synchronicity, which mean it is not always possible to log a cancellation to a database table.

You can find the Transaction Cancellation Log by clicking **System Logs > System Log > Transaction Cancellations**.

You can turn off canceled-transaction logging to a table by changing a property.

### Canceled-transaction log property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.quota.manager.log.cancellation | Indicates whether canceled transactions are to be logged to the Transaction Cancellation Log table.  
Type: Boolean  
Default value: true  
Location: [Add to the System Properties](sys_properties) table |

Import set performance

The algorithm transforms import sets from their staging table into their final destination.

Importing data via an import set requires two phases:
1. The data is loaded from a data source into a staging table
2. The data is transformed from the staging table into a target table

The transform algorithm operates in "blocks" of 100 records at a time as opposed to the previous algorithm which transformed a single record at a time. The newer approach allows the application server to pre-fetch a variety of information relevant to each block of records, reducing the number of unique interactions with the database and improving throughput.

Who should expect to see a performance improvement?
Any customer using import sets should expect to see a performance improvement in large transformations.

What kinds of transformations benefit the most from these changes?
Transformations with a large number of reference or choice type columns see the largest improvement.

What kind of transformations benefit the least?
Transformations that with complex or unkeyed coalesce conditions see a proportionately smaller benefit.

Thread performance monitoring

The instance tracks the performance of individual threads, which administrators can view in the transaction log or System Overview graph in the Performance homepage.

Thread performance can be monitored in two places as described in the following sections.

Transaction log

The amount of time a thread waits for an available semaphore or session synchronization is included in the Response Time field in the transaction log. To view the transaction log, navigate to System Logs > Transactions.

Performance graph

Every second, the system looks at all active threads (both UI and background) and places them into one of the following categories.

- **CPU**: The thread is active, but is not executing any of the steps. This condition typically means non-business rule compute time, although in this case a few other internal wait states are categorized as CPU. Therefore a 1:1 correlation between threads in a CPU count and hardware CPU utilization is not expected.
- **Database**: Waiting for information from the database.
- **Business Rule**: The system is running a business rule (synchronous or asynchronous) and is not currently executing a query (which would be database).
- **Network**: Writing data out to the network or waiting for an outbound network buffer to flush.
- **Concurrency**: Cannot run because they are waiting on a semaphore or session synchronization.

Every minute, the system averages these transactions and records them in the database. These averages are displayed in the System Overview graph available in the ServiceNow Servlet metrics. For details, see ServiceNow servlet performance metrics.
The **System Overview** chart can be added to any homepage. For more information, see *Add existing reports to a homepage*.

**Performance metrics**

You can view a wide range of performance metrics for your instance and for the machine on which your instance is running. The ServiceNow Performance homepage provides central access to different graph sets for monitoring the performance of your instance.

The Performance homepage features time series graphs for analyzing system behavior and patterns over selected time periods. The homepage interface provides:

- Aggregate summaries of time series graph data
- Graph overlay capability to compare two different data sources within a single graph
- Diagnostic event overlay on each graph to highlight performance anomalies
- Zoom controls to expand each graph and view time series details

You can also filter the data in each graph by using different measurements, such as maximum and minimum values, means, and medians.

The graph sets provide performance data for the following functional areas: AMB, Database, Discovery, MySQL Global Status, ServiceNow Servlet, and Slow Pattern. Some of these graphs are intended for use by ServiceNow Technical Support to troubleshoot performance issues or help you tune your system for maximum efficiency.

To open the Performance homepage, navigate to **Self-Service > Homepage** and in the homepage list, select **ServiceNow Performance**.

**Note:** The administrator or any user who can modify a homepage can also add performance metric graphs to a custom homepage. For more information, see *Add existing reports to a homepage* and *Customize your homepage content*.

**Performance homepage features**

The Performance homepage provides the following graph and display controls.
## Performance homepage elements

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | **Graph controls:**  
|        |   - **Graph set** - Graph collections for viewing performance in specific functional areas: AMB, Database, Discovery, MySQL Global Status, and Slow Pattern.  
|        |   - **Monitorable items** - Name of the instance under evaluation.  
|        |   - **Timespan** - Period over which the data is captured: 1 hour, 2 hours, 1 day, 7 days, or 30 days  
|        |   - **Compare with graph list** - Graph overlay feature that lets you select a graph from a different data source and compare it to the current graph set.  
<p>| 2      | <strong>Suggestion</strong> icon - Opens the Index Suggestion window, which provides links to index suggestions that have been created for slow queries. For details, see <a href="#">Review index suggestions for slow queries</a>. |</p>
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3      | Display controls:  
• Information tooltip - Point to an area to see details about it.  
• Documentation icon - Opens the documentation page for the graph set.  
• Fullscreen icon - Opens an enlarged view of the graph, which includes a legend that identifies the graph data. |
| 4      | Diagnostic Events widget - Lists system events that occurred during the selected timespan. Provides controls for displaying diagnostic events on graphs. |

**Display and zoom controls**

**Fullscreen graph view**

Click the fullscreen icon to open an enlarged view of a graph. The fullscreen view includes a legend, with check boxes for controlling data displayed in the graph. To disable the display of a data item in a graph, clear its check box. On some graphs, you can also change the sort order of certain metrics in the legend.
Zoom in on a selected area of the graph

Click and drag across a portion of the graph area to zoom in on that area and view details over a smaller time interval. To return to the original view, click **Reset Zoom**.
Graph overlays

Use the graph overlay feature to look for trends or patterns between different data sets. For example, you could overlay the Database Response graph over the System Overview graph to determine possible correlations.

- In the **Compare with graph** list, select a performance graph to overlay the current graph set.
- To remove the graph overlay, select **None** in the **Compare with graph** list.
Diagnostic event overlays

Display controls for diagnostic events

Use the following features in the Diagnostic Events widget to control the diagnostic events overlaid on graphs:

- **Show on graphs** switch - Click to enable or disable the event overlay on the graph set. The event overlay is enabled when the switch is green. The following severity flags identify diagnostic events on the graphs:
- I - Information
- W - Warning
- E - Error

- Filter - Click the filter icon to limit events displayed on the graphs. Clear the check boxes for events you do not want displayed.
- Clear filter - Click to reset the filter to its default state (show all events).

**Diagnostic event information**

- If you enabled the diagnostic event display, point to an event in the graph to see its information.
For quick access to details on a particular event, click the event listed in the Diagnostic Events widget to open the Event Details form.

### Event Details fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type of event.</td>
</tr>
<tr>
<td>Reported on</td>
<td>Date and time of event.</td>
</tr>
<tr>
<td>Detail</td>
<td>Additional information on the event, such as type of plugin activated.</td>
</tr>
<tr>
<td>Severity</td>
<td>Type of diagnostic event:</td>
</tr>
<tr>
<td></td>
<td>· I - Information</td>
</tr>
<tr>
<td></td>
<td>· W - Warning</td>
</tr>
<tr>
<td></td>
<td>· E - Error</td>
</tr>
<tr>
<td>Status</td>
<td>Event state:</td>
</tr>
<tr>
<td></td>
<td>· Information</td>
</tr>
<tr>
<td></td>
<td>· Open</td>
</tr>
<tr>
<td></td>
<td>· Closed</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Infrastructure component, if applicable.</td>
</tr>
</tbody>
</table>

**ServiceNow servlet performance metrics**

Each instance has a servlet, and you can monitor its performance using the servlet graph set in the Performance homepage.
To view servlet graphs in the Performance homepage, select ServiceNow Servlet in the **Graph Set** list, an instance in the **Monitorable Items** list, and a time period in the **Timespan** list.

For details on using the graph and display controls in the Performance homepage, see *Performance metrics*. 
**System Overview:** Provides thread performance information. Every second, the system looks at all active threads (both UI and background) and places them into one of the following categories.

- **CPU:** The thread is active, but is not executing any of the steps. This condition typically means non-business rule compute time, although in this case a few other internal wait states are categorized as CPU. Therefore a 1:1 correlation between threads in a CPU count and hardware CPU utilization is not expected.
- **Database:** Waiting for information from the database.
- **Business Rule:** The system is running a business rule (synchronous or asynchronous) and is not currently executing a query (which would be database).
- **Network:** Writing data out to the network or waiting for an outbound network buffer to flush.
- **Concurrency:** Cannot run because they are waiting on a semaphore or session synchronization.

The system averages these transactions every minute and records them in the database. The graph shows the averages for each category.

- **Transactions:** Displays all UI transactions initiated by users. This graph can show large spikes in end-user traffic and identify when peak end-user activity occurs.
- **Response Time:** Displays the interval (in milliseconds) between the time that the instance receives a transaction and the time the instance responds. Displays the time that the server takes to complete a transaction on average, during the given time span. An increase in average response time might indicate that there is a systemic issue or an influx of generally slower transactions. To identify possible performance problems, you can correlate response time with other areas, such as memory, database, or CPU.
- **Sessions:** Shows active sessions, including those sessions initiated by the MID Server and external integrations. A large number of stale but active sessions can lead to memory and performance issues. Session counts larger than 10,000 can typically result in performance degradation. Consider reviewing integration session guidelines and limiting session timeouts.
- **Session Wait Queue:** Displays the number of transactions that are waiting on another transaction for the same user. Waiting sessions occur when a user submits a duplicate request before the prior request completes. Can indicate a slow page or a transaction that requires further investigation. To identify the transactions that are waiting, check the Transaction Log (syslog_transaction) and view the Session wait time to find the transactions that are waiting. Next, find the transaction (Transaction Number?) that the user is waiting on.
- **Semaphore Use:** Shows the number of semaphores in use by the selected instance. Semaphores control the number of user transactions that can be run in parallel. Long-running transactions on a semaphore can back up all semaphores, causing transactions to wait. The platform manages semaphores, and they require no customer administration. The semaphore graph is used only by ServiceNow Technical Support for troubleshooting.
- **Semaphore Wait Queue:** Shows the wait queue for a semaphore. Use this graph with the Semaphore Use graph. A high wait queue indicates long-running transactions on the semaphore. A high and persistent semaphore queue can indicate that the instance node is overloaded with work. Check the Transaction Log (syslog_transaction) to find the longest-running transactions during that time period and identify the problem. This graph is used only by ServiceNow Technical Support.
- **Scheduler:** Displays all scheduler activity for the selected instance, including Discovery probes. You can determine the backlog of scheduled jobs in the queue for a particular time period. You can then compare that against the rate at which the jobs are being processed during the same period.
- **Java Memory:** Records memory usage and indicates when the instance is running out of memory. The Java Memory graph is a useful problem indicator.
- **Java Garbage Collection Floor:** Shows the minimum memory floor and the memory currently consumed. Use this graph to identify high memory consumption. The higher the minimum memory floor, the less memory is available for processing on the server. When less memory is...
available, excessive garbage collection can occur, which can degrade performance. This graph can help identify low memory situations due to objects that are not picked up during garbage collection.

- **Garbage Collection Activity**: Shows the percent of time that the server performs garbage collection. When the Java Virtual Machine (JVM) collects garbage, all processing stops until garbage collection is completed. High garbage collection times over a few percent can lead to a degradation in server performance.

- **Metaspace**: Shows the native memory used for storing the class metadata in JDK 8. Metaspace replaces PermGen space in JDK 8.

- **Logs**: Shows the average number of logs created for the instance during the given timespan.

- **Errors**: This graph shows any severe errors that were printed to the localhost logs or syslog. Multiple severe errors indicate a problem that requires further investigation.

- **Events Processed**: Shows the average number of the events processed during the selected time period.

- **Events Logged**: Shows the average number of the events queued and added to the event log in the selected time period.

- **HTTP Transactions**: Displays all completed HTTP transactions, including UI, integration, and AMB traffic. This graph can show large spikes in HTTP traffic and can help identify when peak user activity occurs.

### Database performance metrics

Database graphs in the Performance homepage display metrics for various database operations, for example, insertions and deletions. They also display a current count of database connections for the selected ServiceNow instance.

All the traffic shown in the graphs is specific to your cluster node/instance. If you are looking at the database graph for your Discovery node, it does not include traffic for your UI node or vice versa. If you, like most customers, are running on a single node, the graphs show everything.

Users with the admin role can review performance metrics.

- To view database metrics in the Performance homepage, select Database in the Graph Set list, an instance in the Monitorable Items list, and a time period in the Timespan list.
- For details on using the graph and display controls in the Performance homepage, see [Performance metrics](#).
Graph Set
Database

Monitorable Items
demo

Time span
1 day
• **Database Throughput**: Displays the count (per minute) for each type of database operation (inserts, deletes, and so on) over time.

• **Database Response**: Displays the response time (in milliseconds) for each type of database operation.

• **DB Connection Use**: Shows how many connections this instance has open to the database. View the maximum, median, and minimum number of database connections in use by the selected node.

• **Replication Throughput**: Measures the difference in the data (delta) between the production instance and the replicated instance as user activity changes the database. Replication is the process whereby an entire instance is replicated on a second machine for failover protection. ServiceNow Technical Support uses this information to monitor the progress of replicating a customer instance.

**Discovery performance metrics**

Discovery metrics, available in the Performance homepage, measure the performance of the probes and sensors in your instance as they collect information about CIs in the network.

**Note**: Functionality described here requires the Discovery plugin.

Users with the admin role can review performance metrics.

- To view Discovery metrics in the Performance homepage, select Discovery in the **Graph Set** list, an instance in the **Monitorable Items** list, and a time period in the **Timespan** list.
- For details on using the graph and display controls in the Performance homepage, see **Performance metrics**.

The available measurements to apply are **Count**, **Maximum**, **Mean**, **Median**, and **Minimum**. All times in these graphs are measured in milliseconds.
Discovery graphs
• **Discovery Probe Run Time**: Elapsed time, in milliseconds, that probes take to run. Use this chart to check the performance of your MID Server. Slow run times can indicate a resource problem on the MID Server machine.

• **Discovery Sensor Queue Time**: Indicates how long a sensor task sits in the scheduler queue on the instance before it runs.

• **Discovery Sensor Run Time**: Measures how long a sensor task takes to run after it is started.

**MySQL Global Status performance metrics**

The MySQL Global Status graphs in the Performance homepage provide an aggregate view of all traffic going to your database server.

These graphs are distinct from the Database graph set, which monitor only queries originating at your particular application instance. All the traffic shown in the graphs here is specific to your cluster node/instance.

Users with the admin role can review performance metrics.

• To view metrics for MySQL server status global variables in the Performance homepage, select MySQL Global Status in the **Graph Set** list, an instance in the **Monitorable Items** list, and a time period in the **Timespan** list.

• For details on using the graph and display controls in the Performance homepage, see [Performance metrics](#).

---

**Note**: The MySQL Global Status graphs are intended for use by ServiceNow Technical Support to troubleshoot performance issues.
Slow pattern metrics

You can identify slow patterns (transactions, scripts, slow queries, events, mutexes, and cache) in your instance by using the slow pattern graph set in the Performance homepage.

Users with the admin role can review performance metrics.

- To view slow pattern graphs in the Performance homepage, select Slow Pattern in the Graph Set list, an instance in the Monitorable Items list, and a time period in the Timespan list.
- For details on using the graph and display controls in the Performance homepage, see Performance metrics.

Note: In the fullscreen view of each slow pattern graph, the legend provides links to the slow pattern records represented in the graph. For example, the legend in the Slow Query Time graph lists the slowest queries for the instance during the selected timespan. Clicking a slow query item in the legend opens the slow query record. You can review query details and determine what action to take on the slow query. For convenience, the slow pattern graph appears below the record so that you can review and compare the graph with details from the slow pattern record.
Asynchronous Message Bus metrics

The Asynchronous Message Bus (AMB) graphs in the Performance homepage are available to monitor the transaction count and response times for transactions using asynchronous communication.

Users with the admin role can review performance metrics.

- To view AMB graphs in the Performance homepage, select AMB in the Graph Set list, an instance in the Monitorable Items list, and a time period in the Timespan list.

  Note: The AMB graphs are intended for use by ServiceNow Technical Support.

- For details on using the graph and display controls in the Performance homepage, see Performance metrics.
Table rotation preserves instance performance and averts risk associated with querying growing data sets by using the External Communication Channel (ECC) Queue and the `sys_created_on` field to separate data sets into multiple tables based on date.

Functionality

The administrator specifies the time parameter (duration) of the process and the number of tables (rotations) within. After the rotation writes the last table in a rotation, the rotation overwrites the first table in the rotation. Please contact ServiceNow Technical Support before applying table rotation to a custom table.
Examples:

- The query `Records created between 2015/12/10 08:49 and 2015/12/09 07:34 where topic=SystemCommand` is translated to a SQL query on a single table, because the clause on `sys_created_on` targets a single shard.
- The query `Records updated between 2015/12/10 08:49 and 2015/12/09 07:34 where topic=SystemCommand`, or without a date range, needs to target all shards and therefore is translated as a union query on all shards.

Advantages

- Allows deletion of old data without affecting current data (for example, to drop or truncate a table).
- Ensures tables only grow to a reasonable size.
- Reduces working set of data when date is known for query.

Disadvantages

Queries that do not use the table rotation date (for example, by using the `sys_created_on` field), force an inefficient union query to query time ranges that span multiple tables and can be extremely slow if the number of sub-tables is large.

To improve performance, it is recommended that the query includes a window of created dates.

You can use table rotation for sequentially-written tables or for insert-only tables. You cannot use table rotation for `sys_import` tables or tables that extend the Task (task) table.

Disk partition statistics

Disk partitions let you view the input and output statistics for partitions on the server that hosts your ServiceNow instance.

The available measurements are the read and write requests per minute and the number of bytes read and written per minute.
Disk partition performance metrics

You can display the statistics for each partition or the cumulative totals for all partitions. To view cumulative I/O for the entire disk, select the first item in the CI choice list. Select one of the individual partitions from the list to view the statistics for that partition alone.
Four of the disk partitions that appear in the list are generated as business services and are used to populate the performance graphs with data. If they are deleted, the instance automatically regenerates them. They appear in the list of business services.

**Business services disk partitions**

**Linux statistics**

The Linux Stats graph displays performance data for the server on which your instance is running. These graphs are used as a tool to locate and resolve issues with your instance.

- **CPU Usage:** The measurement of this graph indicates the percentage of the available CPUs that are running on this machine. This aggregated data indicates what portion of the machine's resources are being used at any given time. The most useful metric on this chart is the IOWait time measurement, which can indicate performance issues.

- **Load:** The load on the Linux machine indicates the average sum of the number of processes waiting. It includes those processes executing over increments of 1 minute, 5 minutes, and 15 minutes.
**CPU usage metrics:**

The following selections are available for CPU metrics.

- **Idle:** No threads are running. This statistic indicates the percentage of the machine's CPUs that are idle.
- **IOWait**: Indicates how long the CPU spends in a waiting state for disk or network I/O.
- **Nice**: View threads with a modified (lower) scheduling priority that configures them to be run when time permits.
- **System**: Displays the percentage of a single CPU that is being used to run system threads.
- **User**: Displays threads initiated by the application (the instance and the database).

### Apply table rotation

You can apply table rotation by specifying the time parameter (duration) of the process and the number of tables (rotations) within.

**Role required**: admin

**Note**: Deployment of this plugin should be executed in partnership with a ServiceNow representative.

1. Navigate to **System Definition > Table Rotations**.
2. Click **New**, or select the table rotation group to modify.
3. Set the table rotation fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the table to which the action is to be applied.</td>
</tr>
<tr>
<td>Duration</td>
<td>Set the overall duration for the action.</td>
</tr>
<tr>
<td>Initialized</td>
<td>Sets table rotation as active (true) or inactive (false). (This must be checked (true) for the rotation or extension to be active.)</td>
</tr>
<tr>
<td>Type</td>
<td>Choose either Rotation or Extension.</td>
</tr>
<tr>
<td>Rotations</td>
<td>Sets the number of tables to be maintained through the duration.</td>
</tr>
<tr>
<td>Clean base rotation</td>
<td>Sets the date to clean (truncate) the base table.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Note**: Deleting a rotation deletes the additional tables and all the data. Do not delete the rotation if the data is needed.

When you define a new rotation, a schedule is created and new data is subsequently written to one of the tables in the rotation group. The group includes the original table plus a number of additional tables.
### Table Rotation Group - syslog

- **Name**: syslog
- **Duration**: Days 7, Hours 00
- **Type**: Rotation
- **Clean base rotation**: 2017-01-12 15:14:25

#### Related Links
**Synchronize Shards**

<table>
<thead>
<tr>
<th>Name</th>
<th>Offline</th>
<th>Table name</th>
<th>Valid from</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0007]</td>
<td>2017-01-04 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0006]</td>
<td>2016-12-28 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0000]</td>
<td>2016-11-16 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0005]</td>
<td>2016-12-21 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0003]</td>
<td>2016-12-07 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0001]</td>
<td>2016-11-23 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0004]</td>
<td>2016-12-14 03:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog]</td>
<td>1969-12-31 16:00</td>
</tr>
<tr>
<td>false</td>
<td></td>
<td>Log Entry [syslog0002]</td>
<td>2016-11-30 03:00</td>
</tr>
</tbody>
</table>
Table flattening

Table flattening stores a hierarchy of related tables as one table in a relational database.

Extension models

Tables such as Task and Base Configuration Item (cmdb) have a hierarchy of related tables where one or more child tables extend from a parent table. The system offers these extension models to store a table hierarchy on a relational database.

Available extension models

<table>
<thead>
<tr>
<th>Extension model</th>
<th>Flattens tables?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table per class</td>
<td>No</td>
</tr>
<tr>
<td>Table per hierarchy</td>
<td>Yes</td>
</tr>
<tr>
<td>Table per partition</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The extension model does not affect how the tables appear or function in the instance. All table functionality, including database views, remains unchanged by the extension model.

Table per class

The Table per class extension model stores each table of the hierarchy in its own physical table on the relational database. The physical table is named after the source table of the hierarchy and each stores a different class of records such as Change, Incident, Problem, or Task. The parent table of the hierarchy, such as Task, stores a copy of every record in its descendant tables such as Change, Incident, or Problem.

To find records in a table hierarchy, the system queries records from multiple tables and joins the results. For example, when searching for incidents that have a related problem, the system must join results from the Incident, Problem, and Task tables.

Table joins cause a performance bottleneck on relational databases. The more classes a query includes, the worse the query performance. Therefore any query for records from the top of the table hierarchy has the worst performance because it requires joining all descendant tables.

The system uses the Table per class extension model by default when creating tables. Most system tables also use the Table per class extension model as there is no performance benefit from flattening them.

Table per hierarchy

The Table per hierarchy extension model stores an entire table hierarchy in a single flat physical table on the relational database. The physical table is named after the parent table of the hierarchy, such as Task. The physical table contains all records of the table hierarchy and assigns a class name column value to each descendant table of the hierarchy. The system uses the name of the source table as the class name value. For example, Task records can have class names such as Change, Incident, or Problem.

To find records in a table hierarchy, the system queries the physical table and uses the class name column to constrain the results. Since such queries do not require joining results from multiple tables, the system provides better search performance.
Table per hierarchy extension model is used for the Task table hierarchy on MySQL databases. Other tables use the Table per class extension model because there is no performance benefit to flattening them. To use Table per hierarchy on an Oracle database, contact Technical Support.

Table per partition

The Table per partition extension model stores an entire table hierarchy in a single flat logical table on the relational database. Each logical table can have multiple physical storage tables called partitions supporting it. Each partition optimizes the database resources available to a physical table such as the column count, index count, and row size. The system adds a partition whenever the logical table needs additional relational database resources.

Each logical table is named after the parent table of the hierarchy, and each supporting physical partition consists of the logical name plus a partition name. For example, the Base Configuration Item (cmdb) table starts as a logical table with no partitions. Suppose your hardware configuration items consume enough database resources that the system creates a partition called cmdb$par1 to store them. Later, computer configuration items could consume enough database resources to warrant the system creating a second partition called cmdb$par2 to store these records.

Within each logical table, the system assigns a class name column value to each descendant table of the hierarchy. For example, within the Base Configuration Item logical table there are records with class names for Application, Computer, and IP Router. The system also assigns a two-digit class path value to each descendant table of the hierarchy. The class path is based on the table location in the hierarchy. For example, the parent class Hardware might have a class path such as /!!/!D and the child class Computer might have a class path such as /!!/!D/!!.

To find records in a table hierarchy, the system queries the logical table and its partitions and uses the class path column to constrain the results. Since these queries do not require joining results from multiple tables, the system provides better search performance. In addition, the class path reduces the total number of records to search, which further improves search performance.

The system uses the Table per partition extension model for the Base Configuration Item (cmdb) table hierarchy on MySQL databases. To use Table per partition on an Oracle database, contact Technical Support.

View a table hierarchy and the extension model

The extension model used by a table is not immediately apparent. While a hierarchy can use a single physical table, the platform displays tables as if each logical table has a unique physical table. For example, when specifying a table for a workflow, you can select Change (change_request) or Incident (incident) even though the parent table, Task (task), uses a single physical table.

Role required: admin

Administrators can view the status of flattened table hierarchies, but cannot flatten additional hierarchies. You can configure the form to add the Extension model field if necessary.

1. Navigate to System Definition > Tables.
2. Select a table record.
3. Review the Extension model field value, which indicates whether the table hierarchy uses multiple unique tables or a single flat table.
   - None: Indicates that the table uses the table per class model. Defines a unique physical table per logical table in a hierarchy. For example, there are separate physical tables for
Task (task), Incident (incident), Problem (problem), and Change (change_request) on the MySQL database.

- **Table per hierarchy**: Defines a single physical table per logical table hierarchy. For example, there is a single Task (task) table on the MySQL database that contains all the Task, Incident, Problem and Change records. This single physical table is represented as separate logical tables.

### Add a module to test connection speed

A connection test can indicate the connection speed between your computer and your instance. A connection speed test (/connection_test.do) is available as a UI page.

Role required: admin

**Connection Test**

Connection test is used to determine the type of connect between the end computer and your Service-now.com instance.

To start the connection test, press this button:

![Start Connection Test](image)

Average time: 594ms (per 170k)
Estimated connection: T1/Cable (average download was 282K/s)

**Connection Test page**

1. Perform the appropriate action for your version of the UI:

| UI16 | 1. Navigate to System Definition > Application Menus.  
2. Open the application menu to which you want to add the module, for example, System Diagnostics. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>UI15 or UI11</td>
<td>Right-click an application menu, such as System Diagnostics, and select Edit Application Menu or click the pencil icon.</td>
</tr>
</tbody>
</table>

2. Click **New** in the list of modules.

3. Complete the Module form using the following values:
   - **Title**: Unique name such Connection Test.
   - **Link type**: URL (from Arguments)
   - **Arguments**: connection_test.do
4. Click **Submit**.

**This ServiceNow instance**

Performance graph statistics are attached to the **This ServiceNow instance** business service. These statistics are the ones you can see on the Admin homepage when you add a Performance Graph Controls widget, and then add one or more performance graphs.

Do not delete this business service, or else the instance becomes unable to track its own performance.
This ServiceNow Instance
Transaction quotas

Transaction quotas allow you to define a quota policy for different types of transactions. A transaction quota cancels any transaction in violation of the policy and notifies the user of the cancellation.

The Transaction Quotas plugin is active by default on all new and upgraded instances.

Transaction canceled

The transaction quota also writes the cancellation message to the log file as a warning.

Transaction cancelled log

Typically, administrators set transaction quotas to prevent poorly performing queries and scripts from consuming system resources. This ensures that no transaction consumes enough resources to prevent other transactions from running. Administrators can also view cancellation log messages to identify transactions that might consume excessive resources.
How transaction quotas work

Transactions use the Quota Manager, which is a background thread that cancels transactions. The Quota Manager performs the following actions.

1. Obtains a list of active transactions, similar to the list under User Administration > Active Transactions.
2. Cycles through each transaction, and matches it to a quota rule if it does not have one assigned to it. If a transaction changes or there is a new quota rule, the Quota Manager reprocesses the transaction.
3. Cancels the transaction if it has been running longer than the specified quota maximum.
4. Logs the running transactions.
5. Sleeps until the next heartbeat, which is controlled by the glide.quota.manager.heartbeat system property.

Transaction cancellation examples

Transactions can be canceled for more than one reason. Look for the following indicators.

- **maximum execution time exceeded**: This message appears when the glide.quota.manager threads cancels the transaction.
- **canceled by other transaction**: This message appears when the transaction was canceled by the session thread that initially issued it, and not by the glide.quota.manager thread.
- **canceled by user request**: This message appears when the user clicked the red X button to cancel the running transaction.

If you are looking for transactions that were canceled by glide.quota.manager, Search for the combination. For example:

```
Cancelling transaction /home.do - Default-thread-11.0 (maximum execution time exceeded): Thread Default-thread-11.0 (Default-thread-11.0, F530DD111B11111111FC031767DA158E), after 30000ms
```

Add variable information to the cancellation message

You can use the following methods of the jvar_transaction variable to add information to the cancellation message.

**Adding Variable Information to the Cancellation Message**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getURL()</td>
<td>Returns the URL for the transaction.</td>
</tr>
<tr>
<td>getReason()</td>
<td>Returns the reason for page cancellation, localized to the user's language.</td>
</tr>
<tr>
<td>getQuotaId()</td>
<td>Returns the sys_id of the quota rule.</td>
</tr>
<tr>
<td>getQuotaName()</td>
<td>Returns the name of the quota rule.</td>
</tr>
<tr>
<td>getRunTime()</td>
<td>Returns the total run time for the page up to this point.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>getType()</td>
<td>Returns the type of transaction, such as form, list, report, other.</td>
</tr>
<tr>
<td>getUser()</td>
<td>Returns the sys_id of the user.</td>
</tr>
<tr>
<td>getHomepage()</td>
<td>Returns the sys_id of the homepage.</td>
</tr>
<tr>
<td>getHomepageWidget()</td>
<td>Returns the name of the homepage widget.</td>
</tr>
</tbody>
</table>

**Transaction quota properties**

The administrator can add the following system properties to manage transaction quotas.

**Configuring Transaction Quota Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.quota.manager.heartbeat</td>
<td>The number of seconds between the start of each Quota Manager heartbeat. This value determines how often the Quota Manager checks for transactions that exceed a quota and how often it writes status in the log file. Type: Integer Default value: 1 Location: Add to the [sys_properties] table</td>
</tr>
<tr>
<td>glide.quota.manager.minimum_transaction_time</td>
<td>The minimum number of seconds a transaction must run before the Quota Manager matches it to a transaction quota. ServiceNow recommends setting this value to at least 1 second to avoid performance issues. For optimal performance, set this value to the value of your most restrictive quota. For example, if your most restrictive quota cancels transactions longer than 1 minute, set the minimum transaction time to 60 seconds. Type: Integer Default value: 1 Location: Add to the [sys_properties] table</td>
</tr>
<tr>
<td>glide.quota.manager.debug</td>
<td>Controls whether to display (true) or hide (false) additional debugging information related to the Quota Manager. Debugging information includes running transactions, canceled transactions, and what quotas are matched to transactions. Type: True</td>
</tr>
</tbody>
</table>

**Enable transaction quota debugging**

You can enable the logging of transaction quota debugging information by enabling the system property.
Role required: admin

1. Add the `glide.quota.manager.debug` system property, and set the value to `true`.
2. Navigate to System Diagnostics > Session Debug > Debug Quotas.
   The Debug Quota script runs to enable debugging.

After setting the above system property to `true`, go to your system log to see messages from the Quota Manager.

**Default quota rules**

Various transaction quota rules are available in the base system.

- **Fix Script Processor**: Allows the fix script processor to run for four hours.
- **Presence**: Cancels presence requests quickly when the system is busy.
- **REST Import Set API request timeout**: Prevents inbound REST Import Set API transactions from running for longer than 60 seconds.
- **REST Table API request timeout**: Prevents inbound REST Table API transactions from running for longer than 60 seconds.
- **AMB Transactions**: Cancels AMB transactions lasting longer than the specified maximum duration. Applies to all AMB transaction types: message send and message receive.
- **Reference Completer**: Stops the reference completer transaction after five seconds.
- **REST Aggregate API request timeout**: Prevents inbound REST Aggregate API transactions from running for longer than 60 seconds.
- **Homepage Widgets**: Prevents all homepage widgets from running longer than 30 seconds.
- **REST Attachment API request timeout**: Prevents inbound REST Import Set API transactions from running for longer than 60 seconds.
- **UA Count Persistor Quota**: Prevents UA count persistor scheduled jobs from running for more than one hour.
- **UI Transactions**: Cancels UI transactions that are two seconds away from the 5-minute server disconnect. ServiceNow datacenter load balancers display an internal server error (HTTP Error 500) to users after five minutes. This quota rule returns a transaction canceled page instead of an error. This rule includes an exception to prevent the cancellation of background scripts.

**Normal transaction activities**

Before setting transaction quotas, navigate to User Administration > Active Transactions to review the normal transaction activities for your instance. You can view and terminate long-running transactions if necessary. Over time, you can determine the normal transaction load for your instance and set your quotas to match these norms.

**Configure a transaction quota rule**

Transaction quota rules allow you to define a quota policy for different types of transactions.

Role required: admin

Transaction quota rules allow you to specify the following conditions.

- The conditions under which the policy applies.
- The order in which transaction quotas apply.
- The maximum duration of a transaction before the quota manager cancels it.
**Warning:** Setting transaction quotas too low can severely impact your users and prevent normal instance operations. Test your transaction quotas rigorously before implementing them in production.

1. If necessary, activate the Transaction Quotas plugin.
2. Navigate to **System Definition > Quota Rules**.
3. Click **New**.
4. Complete the form.

### Transaction quota rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name to identify the rule.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box that determines if this rule is active (selected).</td>
</tr>
<tr>
<td>Maximum Duration</td>
<td>The number of seconds a transaction has to complete before the quota cancels the transaction.</td>
</tr>
<tr>
<td>Maximum Business Rules</td>
<td>The number of business rules executions allowed.</td>
</tr>
<tr>
<td>Maximum Database Time</td>
<td>The total number of seconds for all SQL requests.</td>
</tr>
<tr>
<td>Maximum SQL Statement Time</td>
<td>The number of seconds a SQL statement can run.</td>
</tr>
<tr>
<td>Maximum Outbound Requests</td>
<td>The number of outbound HTTPs requests allowed.</td>
</tr>
<tr>
<td>Order</td>
<td>A number that represents the priority of the quota transaction in relation to other quotas. The transaction quota with the lowest timeout, the lowest order value, and matching conditions determines the applied quota policy.</td>
</tr>
<tr>
<td>Maximum Events</td>
<td>The number of sysevent inserts allowed.</td>
</tr>
<tr>
<td>Maximum Jobs</td>
<td>The number of sys_trigger inserts allowed.</td>
</tr>
<tr>
<td>Maximum SQL Queries</td>
<td>The number of SQL queries allowed.</td>
</tr>
<tr>
<td>Maximum Outbound Request Duration</td>
<td>The number of seconds for an outbound HTTP request.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the transaction quota rule.</td>
</tr>
</tbody>
</table>

5. Set a condition to specify when the transaction quota should take effect. The transaction quota rule condition builder displays conditions that are only applicable to transactions as listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The URL of the page.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
**Thread Name** | The name of the execution thread that is running the transaction. Foreground threads have names like http-bio-8080-exec-1. Background threads can have various names, and are useful where the URL is not sufficiently descriptive.

**Foreground** | Whether the transaction was completed in the foreground or background:
- **True**: a foreground transaction.
- **False**: a background transaction.

**Type** | The type of transaction:
- **List**: Any list transaction, such as incident_list.do.
- **Form**: All forms, UI pages, CMS pages, and so on.
- **XMLHttp**: Transactions that run through GlideAjax, where the URL is xmlhttp.do.
- **SOAP**: SOAP transactions.
- **Export**: When a list is exported in a format such as XML or Excel.
- **Scheduler**: When a scheduled job is performed.
- **Text Search**: The text search transaction or any of its related operations.
- **Other**: Any type that does not meet the qualities of another type.

**Note**: Match the transaction quota **Type** to the transaction type listed in the Quota Manager log entry for the transaction.

**User** | The user performing the transaction.

**Homepage** | The homepage that is running. This condition is populated only if the URL is home.do.

**Homepage Widget** | The homepage widget that is rendered in the transaction. When a homepage is rendered initially, each homepage widget is rendered in parallel.

**Attributes** | Miscellaneous attributes that are related to the transaction.

6. Click **Submit**.

**View a canceled transaction**

The Quota Manager logs each canceled transaction as a warning message in the system log.

**Role required**: admin
Use the following procedure to search for transaction warnings in the system log.

1. Navigate to **System Logs > System Log > Warnings**.
2. Edit the filter to add the condition *(Message) (starts with) (Cancel)*.
3. Click **Run**.

**Example system log messages**

An example of system log messages for transactions.

- At every heartbeat interval, which is one second by default, the Quota Manager prints the running transactions:

```
2012-02-13 12:34:08 (096) glide.quota.manager SYSTEM URL= /incident_list.do?
sysparm_userpref_module=b55fbec4c0a80009008e83d7ff500de&active=true&sysparm_query=active=true^EQ, THREAD= http-bio-8080-exec-3, FG= true, TYPE= 1, STATE= 2, USER= null, TIME= 8,807, MEM= 0, ATTRIBUTES= {}
```

- Every time the Quota Manager matches a quota to a transaction, it prints a message similar to the following example:

```
2012-02-13 13:25:31 (900) glide.quota.manager SYSTEM QuotaFinder: Assigning quota "TEST PROBLEM FORM" with filter: type=form?urlLIKEsys_id=46fb9e31a9fe198101492060c2a4f8cb^EQ to transaction: URL= /problem.do?sys_id=46fb9e31a9fe198101492060c2a4f8cb, THREAD= http-bio-8080-exec-1, FG= true, TYPE= 1, STATE= 4, USER= null, TIME= 1,121, MEM= 0, ATTRIBUTES= {}
```

- Every time the Quota Manager cancels a transaction, it prints a message similar to the following example:

```
Thread http-bio-8080-exec-1
```

**Modify the transaction cancellation page**

The Quota Manager uses a UI page to control the contents of the transaction cancellation message.

Role required: admin
Knowledge of *Apache Jelly* is highly recommended when modifying the UI page. See *Extensions to Jelly syntax* for more information.

1. Navigate to **System UI > UI Pages**.
2. Open the UI page with the name **transaction_canceled_quota**.
3. In the **HTML** field, add or modify the new cancellation message.
   
The following table describes available variables.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getURL()</td>
<td>Returns the URL for the transaction.</td>
</tr>
<tr>
<td>getReason()</td>
<td>Returns the reason for page cancellation, localized to the user's language.</td>
</tr>
<tr>
<td>getQuotaid()</td>
<td>Returns the sys_id of the quota rule.</td>
</tr>
<tr>
<td>getQuotaName()</td>
<td>Returns the name of the quota rule.</td>
</tr>
<tr>
<td>getRunTime()</td>
<td>Returns the total run time for the page up to this point.</td>
</tr>
<tr>
<td>getType()</td>
<td>Returns the type of transaction, such as form, list, report, other.</td>
</tr>
<tr>
<td>getUser()</td>
<td>Returns the sys_id of the user.</td>
</tr>
<tr>
<td>getHomepage()</td>
<td>Returns the sys_id of the homepage.</td>
</tr>
<tr>
<td>getHomepageWidget()</td>
<td>Returns the name of the homepage widget.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Application quotas**

You can set a limit on the number of events or jobs that can run in an application's scope within a specified time.

Application quota rules set application quotas. Each scoped application can have one application quota rule. When an application exceeds the quota limit, all transactions running in the application scope are canceled. New transactions are canceled when they start until the next update period. These actions effectively block transactions from an application scope from running for the update period.

An application quota rule applies to transactions created by all instances of an application and all transactions created by methods of the application called by other applications.

- If two users are running the same application, the application quota rule does not distinguish between transactions for each instance of the application. If, together, they violate the quota, all transactions in the application's scope are canceled.

If you check the **Log Only** option, transactions are not canceled by a quota violation. Instead, entries are added to the local host log that indicate the transactions are running under violation.

Transaction and application quota rules are evaluated separately, by defining an application quota rule, you simply introduce another restriction. A transaction is canceled if it violates a transaction quota rule, or if collectively with other application transactions, it violates its application quota rule.

You cannot define an application quota rule for the global application.
Application-quota property

An administrator can add a system property to specify how often application quota rules are evaluated.

### Application quota property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.quota.manager.cluster.update.seconds</td>
<td>Indicates the application quota update period in seconds. If this value is less than the glide.quota.manager.heartbeat property, the glide.quota.manager.heartbeat value is used. Type: Number Default value: 300 (5 minutes) Location: Add to the System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

Configure an application-quota rule

You can configure an application-quota rule to limit the number of events or jobs that can run in an application's scope within a specified time.

Role required: admin

You must be in the application scope of the application for which you want to create a rule.

1. Navigate to System Definition > Application Quota Rules.
2. Click New.
   The Application Quota Rule form is shown.
3. Fill in the fields.

### Configuring application quota rules

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name to identify the rule.</td>
</tr>
<tr>
<td>Application</td>
<td>The scoped application's name. To change this field, use the application picker to change the application. This field cannot be Global.</td>
</tr>
<tr>
<td>Order</td>
<td>A number that represents the priority of the quota transaction in relation to other quotas.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box that determines if this rule is active (selected).</td>
</tr>
<tr>
<td>Log only</td>
<td>When checked, transactions are not canceled by a quota violation, but entries are added to the local host log that indicate transactions are violating the quota rule. An entry is added to the Transaction Cancellation Log where the log only field is set.</td>
</tr>
<tr>
<td>Maximum Events</td>
<td>The maximum number of events allowed during the update period.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Jobs</td>
<td>The maximum number of jobs allowed during the update period.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions that determine when the transaction quota applies. The condition builder displays conditions that are only applicable to transactions. For example, Foreground is true.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the transaction quota.</td>
</tr>
</tbody>
</table>

4. Set a condition to specify when the application quota rule should take effect. The application quota rule condition builder displays conditions that are only applicable to transactions as listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>Miscellaneous attributes that are related to the transaction.</td>
</tr>
<tr>
<td>Created</td>
<td>When the transaction was created.</td>
</tr>
<tr>
<td>Created by</td>
<td>Who created the transaction.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Whether the transaction was completed in the foreground or background:</td>
</tr>
<tr>
<td></td>
<td>• True: a foreground transaction.</td>
</tr>
<tr>
<td></td>
<td>• False: a background transaction.</td>
</tr>
<tr>
<td>Homepage</td>
<td>The homepage that is running. This value is populated only if the URL is home.do.</td>
</tr>
<tr>
<td>Homepage Widget</td>
<td>The homepage widget that is rendered in the transaction. When a homepage is rendered initially, each homepage widget is rendered in parallel.</td>
</tr>
<tr>
<td>Initial Scope Name</td>
<td>Scope where the method that created the transaction is defined. Setting this name to anything other than the selected application means that the rule is never used. The rule only looks at transactions of the selected application, and this value has the rule look for a different application, so the condition is never satisfied.</td>
</tr>
<tr>
<td>Scope Name</td>
<td>Scope of the application that called the method that created the transaction.</td>
</tr>
<tr>
<td>Sys ID</td>
<td>A sys_id of the transaction.</td>
</tr>
<tr>
<td>Thread Name</td>
<td>The name of the execution thread that is running the transaction. Foreground threads have names like http-bio-8080-exec-1. Background threads may have various names, and may be useful where the URL is not sufficiently descriptive.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Type</td>
<td>The type of transaction:</td>
</tr>
<tr>
<td></td>
<td>· <strong>List</strong>: Any list transaction, such as incident_list.do.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Form</strong>: All forms, UI pages, CMS pages, and so on.</td>
</tr>
<tr>
<td></td>
<td>· <strong>XMLHttp</strong>: Transactions that run through GlideAjax, where the URL is xmlhttp.do.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Report</strong>: The page sys_report_template.do.</td>
</tr>
<tr>
<td></td>
<td>· <strong>SOAP</strong>: SOAP transactions.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Export</strong>: When a list is exported in a format such as XML, Excel.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Scheduler</strong>: When a scheduled job is performed.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Text Search</strong>: The text search transaction or any of its related operations.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Other</strong>: Any type that does not meet the qualities of another type.</td>
</tr>
</tbody>
</table>

**Note:** Match the transaction quota **Type** to the transaction type listed in the Quota Manager **log entry for the transaction**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The URL of the page.</td>
</tr>
<tr>
<td>Updated</td>
<td>When the transaction was updated.</td>
</tr>
<tr>
<td>Updated by</td>
<td>Who updated the transaction.</td>
</tr>
<tr>
<td>Updates</td>
<td>What was updated.</td>
</tr>
<tr>
<td>User</td>
<td>The user performing the transaction.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Use table extension**

This example shows you how to set the Table Extension parameter to a table rotation group.

Role required: admin

**Note:** Deployment of this plugin should be executed in partnership with a ServiceNow representative.

Administrators typically specify the time parameter (duration) of the process, but may alternatively specify the number of tables (rotations). After the last table in a rotation is written, new tables are added and old tables are archived. Using table extension, tables are never overwritten.

An advantage of table extension is to partition data across tables. It also allows you to archive data while ensuring that tables stay reasonably-sized. The working set of data is reduced when a date is known for the query.

The disadvantage is that table extension requires a union query when you query for a time range that spans multiple tables. Union queries are less efficient than queries against a single table.
A good practice is to use table extension when you have sequentially-written tables or insert-only type tables (there are exceptions to this parameter). Table extension is also useful in tables where data is needed for long periods of time.

The following example describes how to set table extension for the (sys_audit) table.

1. Navigate to **System Definition > Table Rotations**.
2. Click **New**.
3. Enter the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the table to apply the action. In this example, the table is (sys_audit).</td>
</tr>
<tr>
<td>Duration</td>
<td>Enter the overall duration for the action. 30 days is the duration in this example.</td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Extension</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

---

**System security**

Security is built into all levels of the system. Implement the security features that are appropriate for your organization, from managing failed logins and encrypted password protection, to access control rules and audit logs.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Status</th>
<th>Top Tasks</th>
</tr>
</thead>
</table>
| **Instance security dashboard and settings** | Use the Instance Security dashboard to gain awareness of security level controls, educate with security resources, and take steps to configure and maintain application security standards. | Active | **General security settings**
<p>|                          |                                                                            |        | <strong>High Security Settings</strong>  |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Status</th>
<th>Top Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access control list rules</td>
<td>Rules for access control lists (ACLs) restrict access to data by requiring users to pass a set of requirements before they can interact with it.</td>
<td>Active</td>
<td>• Create an ACL rule&lt;br&gt;• Contextual Security Manager</td>
</tr>
<tr>
<td>Elevated privilege roles</td>
<td>Elevated privilege roles require a user to manually accept the responsibility of using the role before the user can access the features of the role.</td>
<td>Active</td>
<td>• Elevate to a privileged role&lt;br&gt;• Force administrators to manually elevate</td>
</tr>
<tr>
<td>Login and authentication security</td>
<td>Configure login security options to control access to your instance.</td>
<td>Active</td>
<td>• Define login scenarios&lt;br&gt;• Make UI pages public or private</td>
</tr>
<tr>
<td>Certificates</td>
<td>Your instance requires certificates to establish secure connections and validate signatures.</td>
<td>Active</td>
<td>• Upload a certificate to an instance</td>
</tr>
<tr>
<td>Web service security</td>
<td>Enforce security using basic authentication, mutual authentication, or WS-Security.</td>
<td>Active</td>
<td>• Setting up mutual authentication&lt;br&gt;WS-Security</td>
</tr>
<tr>
<td>HTML sanitizer</td>
<td>Remove unwanted code and protect against security concerns such as cross-site scripting attacks by sanitizing HTML markup in HTML fields and translated HTML fields.</td>
<td>Active</td>
<td>• Activate HTML sanitizer&lt;br&gt;• Configure HTML sanitizer</td>
</tr>
<tr>
<td>Auditing</td>
<td>Track record changes on auditing-enabled tables. By default, the system tracks changes to the incident, change, and problem tables, among others.</td>
<td>Active</td>
<td>• Enable auditing for a table&lt;br&gt;• History sets</td>
</tr>
<tr>
<td>Domain separation</td>
<td>The separation of data, administrative tasks, processes or reporting into logically defined domains is known as domain separation. A domain can be entities, customers, or sub-organizations. By default, members of one domain only see the data contained within their domain or the child domains that are lower in the domain hierarchy.</td>
<td>Requires a separate subscription&lt;br&gt;• Request domain separation&lt;br&gt;• Domain separation setup and basic administration</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Feature

<table>
<thead>
<tr>
<th>Description</th>
<th>Status</th>
<th>Top Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Virtual Private Network (VPN)</strong></td>
<td>Available by request</td>
<td>- Virtual Private Network (VPN)</td>
</tr>
<tr>
<td>Use a virtual private network (VPN) to integrate your instance with external</td>
<td>from ServiceNow</td>
<td>- Request a VPN service</td>
</tr>
<tr>
<td>data sources over the Internet.</td>
<td>personnel.</td>
<td></td>
</tr>
<tr>
<td><strong>Encryption support</strong></td>
<td>Requires configuration</td>
<td>- Set up encryption contexts</td>
</tr>
<tr>
<td>Use encryption contexts to allow or deny access to sensitive data based on</td>
<td>before use.</td>
<td>- Encrypt MID Server login credentials</td>
</tr>
<tr>
<td>user role.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ServiceNow® Edge Encryption</strong></td>
<td>Requires a separate</td>
<td>- Edge Encryption installation</td>
</tr>
<tr>
<td>ServiceNow® Edge Encryption encrypts sensitive data on your company premises</td>
<td>subscription.</td>
<td>- Edge Encryption configuration</td>
</tr>
<tr>
<td>before sending it over the Internet to your ServiceNow instance (encrypted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>in flight) where it remains encrypted at rest.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>System logs</strong></td>
<td></td>
<td>- Transaction logs</td>
</tr>
<tr>
<td>View warnings and errors for instance processes, records, and non-critical</td>
<td>Active</td>
<td>- Event logs</td>
</tr>
<tr>
<td>events, such as memory usage on the server machine.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Instance security dashboard and settings

Use the Instance Security dashboard to gain awareness of security level controls, educate with security resources, and take steps to configure and maintain application security standards.

**Caution:** To ensure that your dashboard receives up-to-date security information with every upgrade, do not customize the Instance Security Dashboard. Test all changes to security settings before implementing them in a production environment.

Visit [System Security > Instance Security Dashboard](#) to view the security compliance score for your instance, learn more about recommended settings, and configure system properties from the following categories:

**Input Validation**

Ensure the application is robust against all forms of input data, whether obtained from the user, infrastructure, external entity, or database system.

**Access Controls**

Restrict user accounts to control resources on the instance.

**Authorization**

Apply authorization controls to the application.

**Authentication**

Configure credential and password requirements.

**Attachments**

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Apply restrictions on all the attachments uploaded, downloaded, and managed on the instance.

**Session Management**

Ensure that cookies and other session-related information are securely managed.

**Security Best Practices**

Apply best practices to increase the effectiveness of base system security measures on the instance.

**Secure Communications**

Ensure that confidentiality and integrity are achieved through SSL certificates and associated metadata.

**Security Whitelisting**

Enforce security on unauthorized content.

**Email Security**

Apply inbound email configurations for additional security over the default configurations.

**Logging/Errors**

Apply logging and auditing strategies so that suspicious activity is identified and acted upon in a timely manner.

---

**Note:** Some settings require the security_admin role to configure. The Instance Security dashboard can only be modified in the Global scope.

---

You can return to the Instance Security dashboard at any time to adjust your settings and manage the overall security health of your instance. The dashboard automatically updates based on the properties set on your instance. The Instance Security dashboard generates a compliance score based on guidelines in the ServiceNow instance hardening customer security document.
Instance Security Dashboard

Welcome to Instance Security Dashboard. This dashboard provides awareness of your current security posture. The current compliance is 55% Compliant, which is a Moderate level.

What Does My Compliance Mean?

Compliance percentage is between 50% and 90%, which is recommended in the ServiceNow Instance Health Check. Additionally, review any of the critical Security Alerts listed.

Security Alerts

Your event-based information is summarized here and automatically refreshed. Today, there were 12 failed login attempts.

<table>
<thead>
<tr>
<th>Failed Login Attempts</th>
<th>Today</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yesterday</td>
<td>0</td>
</tr>
<tr>
<td>This Week</td>
<td>12</td>
</tr>
</tbody>
</table>

Security Resources
Note: The Failed login attempts Today dashboard item only displays local logins. Failed SAML logins do not display.

General security settings

Security settings provide several properties to control the level of security on your instance. There are two ways to set or change general security settings properties.

- Navigate to System Properties > Security.
  
  Options on the Security page are Yes or No.
- Navigate to the sys_properties.list and search for the property you want to set or change.

Options in the System Properties table (sys_properties.list) are true or false.

Warning: When implementing any of these security features, you must thoroughly test the features before deploying them in a production instance.

General security settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.security.allow_codetag</td>
<td>Allow support for embedding HTML code by using the (code) tag.</td>
</tr>
<tr>
<td>gl.&lt;br&gt;ide.ui.security.codetag.allow_script</td>
<td>Allow embedded HTML (using (code) tags) to contain Javascript tags.</td>
</tr>
<tr>
<td>glide.ui.escape_all_script</td>
<td>Forces all expressions within Jelly JavaScript &lt;script type=&quot;text/javascript&quot;&gt; tags to be escaped by default. Enforces escaping only if the type attribute in the &lt;script&gt; tag is empty, or if the value is text/javascript, text/ecmascript, application/javascript, application/ecmascript, or application/x-javascript.</td>
</tr>
<tr>
<td>com.glide.attachment.max_size</td>
<td>Maximum file attachment size in megabytes.</td>
</tr>
<tr>
<td>glide.attachment.role</td>
<td>List of roles (comma-separated) that can create attachments.</td>
</tr>
<tr>
<td>glide.attachment.extensions</td>
<td>List of file extensions (comma-separated) that can be attached to documents via the attachment dialog. Extensions should not include the dot (.), for example, xls, xlsx, doc, docx. Leave blank to allow all extensions.</td>
</tr>
<tr>
<td>glide.ui.attachment.force_download_all_mime_types</td>
<td>Forces download of all attachment files.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.security.file.mime_type.validation</td>
<td>This property must be set to activate MIME type checking for uploads (all versions). Enables (Yes) or disables (No) MIME type validation for file attachments. File extensions configured via glide.attachment.extensions are checked for MIME type during upload.</td>
</tr>
<tr>
<td>Customer uploads</td>
<td>These properties affect customer uploads only. They do not affect attachments.</td>
</tr>
<tr>
<td>glide.ui.strict_customer_uploaded_static_content</td>
<td>When set to Yes, turns on the ability to restrict the types of files that can be downloaded, when they have been uploaded using the Upload File functionality of the Now Platform. Used with glide.ui.strict_customer_uploaded_content_types</td>
</tr>
<tr>
<td>glide.ui.strict_customer_uploaded_content_types</td>
<td>When this parameter includes a list of comma-delimited file types, of the files that were uploaded using the Upload File functionality of the Now Platform, only these file types can be downloaded from the instance.</td>
</tr>
<tr>
<td>Security Manager and options</td>
<td></td>
</tr>
<tr>
<td>glide.security.manager</td>
<td>Security Manager.</td>
</tr>
<tr>
<td>glide.sm.default_mode</td>
<td>Security manager default behavior in the absence of any ACLs on a table.</td>
</tr>
<tr>
<td>glide.security.strict.updates</td>
<td>Double-check security on inbound transactions during form submission (rights are always checked on form generation).</td>
</tr>
<tr>
<td>glide.security.strict.actions</td>
<td>Check conditions on UI actions before execution. Normally conditions are checked only during form rendering.</td>
</tr>
<tr>
<td>glide.security.granular.create</td>
<td>Enforce create (as opposed to write) rules on new records.</td>
</tr>
<tr>
<td>glide.security.explain.write.locks</td>
<td>Display an explanation on locked form elements.</td>
</tr>
<tr>
<td>Cookies</td>
<td></td>
</tr>
<tr>
<td>glide.ui.forgetme</td>
<td>Remove Remember me check box from login page.</td>
</tr>
<tr>
<td>glide.ui.secure_cookies</td>
<td>Enable secure session cookies: Enable additional cookie security. If Yes, strict session cookie validation is enforced. With version 3 cookies enabled, additional security requirements are also enforced.</td>
</tr>
<tr>
<td>glide.secure_cookie.debug</td>
<td>Secure session cookie debugging: Check to enable extensive debug logging of secure session cookie operations.</td>
</tr>
<tr>
<td>Security restrictions for execution of scripts originating from the client</td>
<td></td>
</tr>
<tr>
<td>glide.script.use.sandbox</td>
<td>Run client-generated scripts (AJAXEvaluate and query conditions) inside a reduced-rights sandbox. If Yes, only those business rules and script includes with the Client callable check box set to Yes are available, and certain back-end API calls are disallowed.</td>
</tr>
<tr>
<td>glide.script.allow.ajaxevaluate</td>
<td>Enable the AJAXEvaluate processor.</td>
</tr>
</tbody>
</table>
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.script.secure.ajaxgliderecord | Apply standard security ACLs to AJAXGlideRecord calls.  
- Default value: Yes for new and upgraded instances. If Yes, cannot be changed to No. |

### Miscellaneous

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.communications.trustmanager_trust_all</td>
<td>By default, the instance trusts a certificate’s Certificate Authority (CA) to ensure that the instance accepts self-issued certificates. If you want to validate a certificate’s CA, set the system property to No.</td>
</tr>
<tr>
<td>glide.outbound.sslv3.disabled</td>
<td>When active, outbound connections from an instance are forced to use TLS instead of SSL.</td>
</tr>
</tbody>
</table>

Additional properties are available for [High Security Settings](https://service-now.com).

### High Security Settings

High Security Settings refer to several security options available in your instance. There are two ways to set or change High Security Settings properties:

- Navigate to **System Security > High Security Settings**.  
  Options on the High Security Properties page are **Yes** or **No**.
- Navigate to the **sys_properties.list** and search for the property you want to set or change.  
  Options in the System Properties table (sys_properties.list) are **true** or **false**.

This module is activated with the High Security Settings plugin, which is active by default on new instances. If High Security Settings are not active on your instance, you can request activation.

Properties for these types of high security settings are available:

- Default property values: To harden security on your platform by centralizing all critical security settings to one location for management and auditing.
- Default deny property: Provides a security manager property to control the default security behavior for table access.
- Security Administrator role: Provides a role to prevent modification of key security settings and resources. The Security Administrator role is not inherited by the admin role and must be explicitly assigned.
- Elevated privileges: Allows users with the security admin role to operate in the context of a normal user and elevate to higher security role when needed.
- Property access controls: Allows security administrators to set the roles required to read and write properties.
- Transaction and system logs: Are read only.

**Note:** High Security Settings also automatically activates the Contextual Security plugin, if it is not already active. In addition, Platform Security Settings - High delivers settings and features in the context of increasing the security of your instance.
Property access control

Two additional columns are created in the Properties (sys_properties) table when High Security Settings are active:

- **read_roles**: A comma-separated list of role names that are allowed to read all fields of this property.
- **write_roles**: A comma-separated list of role names that are allowed to write/modify all fields of this property.

Properties listed in the Properties table have read_roles of admin and write_roles of security_admin. Users with the admin role can view and read the property values, but must elevate to the security_admin role to modify them.

Notifications

Activation of high security settings also activates security warning messages. The following is an example of a message that appears after an approval.

![Security Warning](image)

Security Warning notification

High Security Settings properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.escape_text</td>
<td>Escape XML values at the parser level for the user interface. Prevents reflected and stored cross-site scripting attacks. This property is not applicable in Service Portal. Default: Yes</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.escape_all_script</td>
<td>Forces all expressions within Jelly JavaScript <code>&lt;script type=&quot;text/javascript&quot;&gt;</code> tags to be escaped by default. Enforces escaping only if the type attribute in the <code>&lt;script&gt;</code> tag is empty, or if the value is <code>text/javascript</code>, <code>text/ecmascript</code>, <code>application/javascript</code>, <code>application/ecmascript</code>, or <code>application/x-javascript</code>. Default: Yes in new Jakarta instances.</td>
</tr>
<tr>
<td>glide.ui.rotate_sessions</td>
<td>Rotate HTTP session identifiers to reduce security vulnerabilities. See: <a href="http://www.owasp.org/index.php/Session_Management#Rotate_Session_Identifiers">http://www.owasp.org/index.php/Session_Management#Rotate_Session_Identifiers</a>. Default: Yes. If you are using the SAML 2.0 plugin for Single Sign-on authentication, set this property to No. Otherwise, it interferes with the session information sharing that takes place between the instance and the Identity Provider.</td>
</tr>
<tr>
<td>glide.ui.secure_cookies</td>
<td>Enable secure session cookies: Enable additional cookie security. If Yes, strict session cookie validation is enforced. Default: Yes.</td>
</tr>
<tr>
<td>glide.security.password_reset.uri</td>
<td>For mobile Password Reset, URL that the user is taken to when user taps the Forgot password? button.</td>
</tr>
<tr>
<td>glide.security.strict.updates</td>
<td>Double-check security on inbound transactions during form submission (rights are always checked on form generation). Default: Yes.</td>
</tr>
<tr>
<td>glide.security.strict.actions</td>
<td>Check conditions on UI actions before execution. Normally conditions are only checked during form rendering. Default: Yes.</td>
</tr>
<tr>
<td>glide.security.use_csrf_token</td>
<td>Enable usage of a secure token to identify and validate incoming requests. This token is used to prevent cross-site request forgery attacks. Default: Yes.</td>
</tr>
<tr>
<td>glide.ui.escape_html_list_field</td>
<td>Escape HTML for HTML fields in a list view Default: Yes.</td>
</tr>
<tr>
<td>glide.ui.forgetme</td>
<td>Remove Remember me check box from login page. Default: Yes.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.smtp.auth</td>
<td>Authenticate with the SMTP server by the user name and password properties.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is deprecated.</td>
</tr>
<tr>
<td>glide.script.use.sandbox</td>
<td>Run client generated scripts (AJAXEvaluate and query conditions) inside a reduced-rights sandbox. If <strong>Yes</strong>, only those business rules and script includes with the <strong>Client callable</strong> check box set to <strong>Yes</strong> are available, and certain back-end API calls are disallowed. For more information, see <a href="#">The script sandbox property</a>.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.soap.strict_security</td>
<td>Enforce strict security on incoming SOAP requests. When <strong>Yes</strong>, requires incoming SOAP requests to go through the security manager for table and field access and checks SOAP users for the correct roles for using the web service.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.wsd1</td>
<td>Require authorization for incoming WSDL requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you choose not to require authorization for incoming WSDL requests, you must modify the Access Control (ACL) rules to allow guest users to access the WSDL content.</td>
</tr>
<tr>
<td>glide.basicauth.required.csv</td>
<td>Require basic authorization for incoming CSV requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.excel</td>
<td>Require basic authorization for incoming Excel requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.importprocessor</td>
<td>Require basic authorization for incoming import requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.pdf</td>
<td>Require basic authorization for incoming PDF requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.rss</td>
<td>Require basic authorization for incoming RSS requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>glide.basicauth.required.scriptedprocessor</td>
<td>Require basic authorization for incoming script requests.</td>
</tr>
<tr>
<td></td>
<td>Default: <strong>Yes</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.basicauth.required.soap</td>
<td>Require basic authorization for incoming SOAP requests.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.basicauth.required.url</td>
<td>Require basic authorization for incoming unload requests.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.basicauth.required.xml</td>
<td>Require basic authorization for incoming XML requests.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.basicauth.required.xsd</td>
<td>Require basic authorization for incoming XSD requests.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.cms.catalog_uri_relative</td>
<td>Enforce relative links from the URI parameter on /ess/catalog.do. If Yes, only relative URLs are permitted through the /ess/catalog.do page using the uri parameter. If No, all URLs are allowed, which may permit linking to external unauthorized content.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.set_x_frame_options</td>
<td>Enable this property to set the X-Frame-Options response header to SAMEORIGIN for all UI pages. The X-Frame-Options HTTP response header can be used to indicate whether a browser should be allowed to render a page in a &lt;frame&gt; or &lt;iframe&gt;. Sites can use this property to avoid clickjacking attacks by ensuring that their content is not embedded into other sites. <a href="https://developer.mozilla.org/en/the_x-frame-options_response_header">https://developer.mozilla.org/en/the_x-frame-options_response_header</a></td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.ui.attachment.download_mime_types</td>
<td>A list of comma-separated attachment mime types that do not render inline in the browser. Prevents cross-site scripting attacks. For example, text/html forces HTML files to be downloaded to the client as attachments rather than viewed inline in the browser.</td>
</tr>
<tr>
<td></td>
<td>Default: text/html,image/svg,image/svg+xml</td>
</tr>
<tr>
<td>glide.security.groupby_acl_check</td>
<td>When set to Yes, ACL checks for GroupBy operations are performed for the group names based on the actual data from the groups.</td>
</tr>
<tr>
<td></td>
<td>Default: Yes</td>
</tr>
<tr>
<td>glide.security.diag_txns_acl</td>
<td>If set to Yes, only admin user or user from allowed IP address can access stats.do, threads.do, and replication.do.</td>
</tr>
<tr>
<td></td>
<td>Default: No</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>glide.ui.security.allow_codetag</td>
<td>Allow support for embedding HTML code by using the (code) tag. Default: Yes</td>
</tr>
<tr>
<td>glide.ui.security.codetag.allow_script</td>
<td>Allow embedded HTML (using (code) tags) to contain JavaScript tags. Default: No</td>
</tr>
<tr>
<td>glide.script.allow.ajaxevaluate</td>
<td>Enable the AJAXEvaluate processor. The AJAXEvaluate API call allows the client to send and execute arbitrary scripts on the server. Default: No</td>
</tr>
<tr>
<td>glide.login.autocomplete</td>
<td>Allow browsers to use auto-complete on password fields on login forms. Default: No</td>
</tr>
</tbody>
</table>

The following properties are defined in the sys_properties table, but are not visible on the High Security Settings page.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.communications.httpclient.verify_hostname</td>
<td>Verify the hostname and certificate chain presented by remote SSL hosts. Protect against Man-In-The-Middle (MITM) attacks. Default: true</td>
</tr>
</tbody>
</table>

Note: This property overrides the com.glide.communications.trustmanager_trust_all property.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.security.csrf_previous.allow</td>
<td>Allow usage of an expired secure token to identify and validate incoming requests. This token is used to prevent cross-site request forgery attacks. Default: false</td>
</tr>
<tr>
<td>glide.security.csrf_previous.time_limit</td>
<td>Time in seconds for a secure token to expire. Allows control over the length of time that the previous CSRF token is valid. When the user session expires, the secure token expires with it unless the glide.security.csrf_previous.allow property is enabled and it is within the timeframe described by this property. This token is used to prevent cross-site request forgery attacks. Default: 86400 seconds or 1 day</td>
</tr>
<tr>
<td>glide.security.csrf.strict.validation.mode</td>
<td>Enforces strict validation on CSRF tokens so that users cannot resubmit a request if the CSRF token does not match. Default: false</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.basicauth.required.schema</td>
<td>Require basic authentication for inbound table schema requests. Default: true</td>
</tr>
</tbody>
</table>

**Request High Security Settings**

The High Security Settings plugin is active by default on all new instances.
Before activating High Security Settings on an existing instance:

1. Review the following information to understand the new behavior:
   - Access control list rules
   - High Security Settings
   - Default deny property

2. Enable the plugin on a non-production instance. A recent clone of production is preferable.

3. Test the revised functionality, especially the added ACLs and default-deny functionality.
   Continue testing until the system performs as expected. If users cannot access expected resources, ensure they have appropriate roles and ACL rules to grant them the access.

4. Create update sets of any needed changes so you can apply them to production.

If it is not active on your instance, you can request the plugin.

1. In the HI Service Portal, click Service Requests > Activate Plugin.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least 2 business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.</td>
</tr>
</tbody>
</table>

3. Click Submit.

The script sandbox property

Enable the script sandbox property (glide.script.use.sandbox) to run client generated scripts inside a sandbox that has restricted rights.

There are two cases within the system that allow the client to send scripts to the server for evaluation.

- Filters and/or queries: It is legal to send a filter to the server such as:
  ```javascript
  assigned_to=javascript:getMyGroups();
  ```
- System API: The API call AJAXEvaluate allows the client to run arbitrary scripts on the server and receive a response.
If you enable the script sandbox property (glide.script.use.sandbox), the script being evaluated via either of these two entry points runs within a reduced rights sandbox with the following characteristics:

- Only those business rules marked **client callable** are available within the sandbox.
- Only script includes marked **client callable** are available within the sandbox.
- Certain API calls (largely but not entirely limited to those dealing with direct DB access) are not allowed.
- Data cannot be inserted, updated, or deleted from within the sandbox. Any calls to `current.update()`, for example, are ignored.

These methods are not allowed in client scripts when script sandboxing is enabled.

### Restricted methods

<table>
<thead>
<tr>
<th>Class</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlideRecord</td>
<td>deleteMultiple(), deleteRecord(), insert(), update(), updateMultiple()</td>
</tr>
<tr>
<td>GlideSystem (gs)</td>
<td>addErrorMessage(), addInfoMessage(), addMessage(), eventQueue(), flushMessages(), getEscapedProperty(), getProperty(), setProperty(), setRedirect(), setReturn(), workflowFlush()</td>
</tr>
<tr>
<td>ScopedGlideRecord</td>
<td>deleteMultiple(), deleteRecord(), insert(), update(), updateMultiple()</td>
</tr>
<tr>
<td>ScopedGlideSystem (gs)</td>
<td>addErrorMessage(), addInfoMessage(), eventQueue(), executeNow(), getProperty(), getSessionToken(), setRedirect()</td>
</tr>
</tbody>
</table>

If you run the system without script sandboxing enabled, then none of these restrictions apply.

**Note:** This property is activated by default when you activate the High Security Settings plugin. Do not activate this property outside of the plugin.

<table>
<thead>
<tr>
<th>Property</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run client generated scripts (<strong>AJAXEvaluate</strong> and query conditions) inside a reduced rights &quot;sandbox.&quot;</td>
<td>Enabled (sandbox in use)</td>
</tr>
<tr>
<td>If enabled, only those business rules and script includes with the <strong>Client callable</strong> checkbox set to true are available and certain back-end API calls are disallowed.</td>
<td></td>
</tr>
</tbody>
</table>

**Access control list rules**

Rules for access control lists (ACLs) restrict access to data by requiring users to pass a set of requirements before they can interact with it.
Components of ACLs

All access control list rules specify:

- The object and operation being secured
- The permissions required to access the object

The object is the target to which access needs to be controlled. Each object consists of a type and name that uniquely identifies a particular table, field, or record.

For example, all these entries specify an object:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Object secured</th>
</tr>
</thead>
<tbody>
<tr>
<td>record</td>
<td>(incident).(-- None --)</td>
<td>The Incident table.</td>
</tr>
<tr>
<td>record</td>
<td>(incident).(active)</td>
<td>The Active field in the Incident table.</td>
</tr>
<tr>
<td>REST_Endpoint</td>
<td>user_role_inheritance</td>
<td>The record for the user_role_inheritance Scripted REST API.</td>
</tr>
</tbody>
</table>

Each operation describes a valid action the system can take on the specified object. Some objects, such as records, support multiple operations, while other objects, such as a REST_Endpoint, only support one operation.

For example, all these entries specify an operation:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Operation</th>
<th>Operation secured</th>
</tr>
</thead>
<tbody>
<tr>
<td>record</td>
<td>(incident).(-- None --)</td>
<td>create</td>
<td>Creating records in the Incident table.</td>
</tr>
<tr>
<td>record</td>
<td>(incident).(active)</td>
<td>write</td>
<td>Updating the Active field in the Incident table.</td>
</tr>
<tr>
<td>REST_Endpoint</td>
<td>user_role_inheritance</td>
<td>execute</td>
<td>Running the user_role_inheritance Scripted REST API.</td>
</tr>
</tbody>
</table>

The permissions specify when someone can access the named object and operation. Security administrators can specify permission requirements by adding:

- One or more user roles to the Requires role list.
- One or more conditions.
- A script that evaluates to true or false or sets the answer variable to true or false.

To gain access to an object and operation, a user must pass all permissions listed in an access control. For example, this access control restricts access to write operations on the incident table.
### Access Control

**Incident**

- **Type**: record
- **Operation**: write
- **Admin overrides**: ✓
- **Name**: Incident [incident]
- **Description**: -- None --

### Definition

Access Control Rules allow access to the specified resource if all three of these checks evaluate to true:

1. The user has one of the roles specified in the Role list, or the list is empty.
2. Conditions in the Condition field evaluate to true, or conditions are empty.
3. The script in the Script field (advanced) evaluates to true, or sets the variable "answer" to true, or is empty.

The three checks are evaluated independently in the order displayed above.

### More Info

<table>
<thead>
<tr>
<th>Requires role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
</tr>
</tbody>
</table>

- **Role**

**Condition**

- **30 records match condition**
- **Add Filter Condition**
- **Add "OR" Clause**

<table>
<thead>
<tr>
<th>Incident state</th>
<th>is not</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Update**  **Delete**
To update a record in the incident table, a user must have the listed role and the record must meet the condition.

<table>
<thead>
<tr>
<th>Permission type</th>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requires role</td>
<td>Requires role: itil</td>
<td>Only allow users with the itil role to update incidents.</td>
</tr>
<tr>
<td>Condition</td>
<td>(Incident state) (is not) (Closed)</td>
<td>Only allow updates to active incident records.</td>
</tr>
</tbody>
</table>

**ACL evaluation process**

An ACL rule only grants a user access to an object if the user meets all of the permissions required by the matching ACL rule.

- The condition must evaluate to true.
- The script must evaluate to true or return an answer variable with the value of true.
- The user must have one of the roles in the required roles list. If the list is empty, this condition evaluates to true.
- (Record ACL rules only) The matching table-level and field-level ACL rules must both evaluate to true.
ACL evaluate permissions
Whenever a session requests data, the system searches for access control rules that match the requested object and operation. If there is a matching access control rule, then the system evaluates if the user has the permissions required to access the object and operation. If an access control rule specifies more than one permission, then the user must meet all permissions to gain access to the object and operation. Failing any one permission check prevents the user from accessing the matching object and operation.

If a user does not meet the permissions of the first matching rule, the system evaluates the permissions of the next matching access control rule as specified by the access control processing order. If the user fails to meet the permissions of any matching access control rule, the system denies access to the requested object and operation.

**Note:** If there are no matching access control rules for the requested object and operation, then the system grants the user access to it. In practice, it is rare for the system to find no matching rules because the system has a set of default access control rules that protect all record operations.

The effects of being denied access to an object depend on the ACL rule that the user failed. For example, failing a read operation ACL rule prevents the user from seeing the object. Depending on the object secured, the ACL rule hides a field on a form, hides rows from a list, or prevents a user from accessing a UI page. The following table contains complete list of results of failing an ACL rule for a given operation and object type.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Results of failing an ACL rule on object</th>
</tr>
</thead>
<tbody>
<tr>
<td>execute</td>
<td>User cannot execute scripts on a record or UI page.</td>
</tr>
</tbody>
</table>
| create               | User cannot see the **New** UI action from forms. The user also cannot insert records into a table using API protocols such as web services.  
A **create** ACL with a condition requiring that a field contain a specific value always evaluates as false. Fields on new records are considered empty until the record is saved. |
| read                 | User cannot see the object in forms or lists. The user also cannot retrieve records using API protocols such as web services. |
| write                | User sees a read-only field in forms and lists, and the user cannot update records using API protocols such as web services. |
| delete               | User cannot see the **Delete** UI action from forms. The user also cannot remove records from a table using API protocols such as web services. |
| edit_task_relations  | User cannot define relationships between task tables.                                                    |
| edit_ci_relations    | User cannot define relationships between Configuration Item (cmdb_ci) tables.                            |
| save_as_template     | Used to control the fields that should be saved when a template is created.                             |
| add_to_list          | User cannot view or personalize specific columns in the list mechanic.                                   |
| list_edit            | User cannot update records (rows) from a list.                                                          |
| report_on            | User cannot create reports on the object.                                                               |
### Operation Results of failing an ACL rule on object

| personalize_choices | User cannot right-click a choice list field and select Configure Choices. |

### ACL matching requirements for objects

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Matching ACL Rules Required to Access Object</th>
<th>Existing Wildcard ACL Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client-callable script includes</td>
<td>Users must meet the permissions of two ACL rules:</td>
<td>By default, there are no wildcard (*) rules for these object types. If you create a wildcard ACL rule for one of these objects, then the ACL rule applies to all objects of this type.</td>
</tr>
<tr>
<td>Processors</td>
<td>1. All wildcard ACL rules for the object (if any ACL rule exists for the operation).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. The first ACL rule that matches the object's name (if any ACL rule exists for the operation).</td>
<td></td>
</tr>
<tr>
<td>UI pages</td>
<td>Users must meet the permissions of two ACL rules:</td>
<td>By default, there are wildcard table rules (<em>) for the create, read, write, and delete operations and wildcard field rules (</em>.*) for the personalize_choices, create, and save_as_template operations. When you create a new table, create new ACL rules for the table unless you want to use the provided wildcard ACL rules.</td>
</tr>
<tr>
<td>Record</td>
<td>1. The first ACL rule that matches the record's field (if any ACL rule exists for the operation).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. The first ACL rule that matches the record's table (if any ACL rule exists for the operation).</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Security manager default behavior (`glide.sm.default_mode`) property determines whether users can access objects that only match against wildcard table ACL rules. When this property is set to Deny access, only administrators can access objects that match the wildcard table ACL rules.

**Note:** The wildcard field ACL rule (*.*) for the create operation reuses the same permissions as the write operation. This means that the create permissions are the same as the write permissions unless you define an explicit create operation ACL rule.

### Multiple ACL rules at the same point in the processing order

If two or more rules match at the same point in the processing order, the user must pass any one of the ACL rules permissions to access the object. For example, if you create two field ACL rules for `incident.number`, then a user who passes one rule has access to the number field regardless of whether the user failed any other field ACL rule at the same point in the processing order.
Required role

Normal admin users can view and debug access control rules. However, to create or update existing access control rules, administrators must elevate privileges to the security_admin role. See [*Elevate to a privileged role*](#) for instructions.

ACL rules in scoped applications

You can create ACL rules for objects in the same scope as the ACL rule and for tables with at least one field that is in the same scope as the ACL rule.

For tables that are in a different scope than the ACL rule record, the types of rules are limited.

- You can create an ACL rule for any table, UI page, or other object that is in the same scope as the ACL rule.
- You can create an ACL for a field that is in the same scope as the ACL rule.
  - If the table is in the same scope, you can use a script to evaluate permissions.
  - If the table is in a different scope, you cannot use a script to evaluate permissions.
- You cannot create or modify ACL rules for objects that are in a different scope than the application you have selected in the application picker, including adding a role to an ACL in a different scope.
- You can create wildcard table rules (*) only in the global scope.
- You can create wildcard field rules (*) only for tables in the same scope as the ACL rule.

ACL rule types

You can create ACL rules on different components of the system.

Record ACL rules

Record ACL rules consist of table and field names.

- The table name is the table that you want to secure. If other tables extend from this table, then the table is considered a parent table. ACL rules for parent tables apply to any table that extends the parent table.
- The field name is the field that you want to secure. Some fields are part of multiple tables because of table extension. ACL rules for fields in a parent table apply to any table that extends the parent table.

ACL rules can secure the following record operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>create</td>
<td>Allows users to insert new records (rows) into a table.</td>
</tr>
<tr>
<td>read</td>
<td>Allows users to display records from a table.</td>
</tr>
<tr>
<td>write</td>
<td>Allows users to update records in a table.</td>
</tr>
<tr>
<td>delete</td>
<td>Allows users to remove records from a table or drop a table.</td>
</tr>
<tr>
<td>edit_task_relations</td>
<td>Allows users to extend the Task table.</td>
</tr>
<tr>
<td>Operation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>edit_ci_relations</td>
<td>Allows users to extend the Configuration Item (cmdb_ci) table.</td>
</tr>
<tr>
<td>save_as_template</td>
<td>Allows users to save a record as a template.</td>
</tr>
<tr>
<td>add_to_list</td>
<td>Allows users to view or personalize specific columns in the list mechanic.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Conditions and scripts are not supported.</td>
</tr>
<tr>
<td>list_edit</td>
<td>Allows users to update records (rows) from a list.</td>
</tr>
<tr>
<td>report_on</td>
<td>Allows users to create reports on tables. This operation is not valid for field ACL rules.</td>
</tr>
<tr>
<td>personalize_choices</td>
<td>Allows users to configure the table or field.</td>
</tr>
</tbody>
</table>

Record ACL rules are processed in the following order:

- Match the object against table ACL rules.
- Match the object against field ACL rules.

This processing order ensures that users gain access to more general objects before gaining access to more specific objects. A user must pass both table and field ACL rules to access a record object.

- If a user fails a table ACL rule, the user is denied access to all fields in the table, even if the user passes a field ACL rule.
- If a user passes a table ACL rule, but fails a field ACL rule, the user cannot access the field described by the field ACL rule.
Start

1. User requests access to a record object

2. Find ACL rules matching object

1. ACL name matches table?
2. ACL name matches parent table?
3. ACL name matches **?

Find first matching table ACL rule

No matches

1. ACL name matches table.field?
2. ACL name matches parent table.field?
3. ACL name matches *.field?
4. ACL name matches table.*?
5. ACL name matches parent table.*?
6. ACL name matches *.*?

Find first matching field ACL rule

No matches

Match found

Match found

Pass

Evaluate ACL permissions

Pass

Grant user access to the record object

End

Fail

Fail

Deny user access to the record object
Processor ACL rules

Processor ACL rules specify the processor you want to secure. For a list of available processors, navigate to System Definition > Processors.

Processor ACL rules honor the STAR (*) rule only if the explicit_roles plugin is installed.

By default, an ACL rule for the EmailClientProcessor is included to restrict the email client to users with the itil role.

Table ACL rules

The user must first pass the table ACL rule. Since the base system includes STAR (*) table ACL rules that match every table, the user must always pass at least one table ACL rule. The base system provides additional table ACL rules to control access to specific tables.

Table ACL rules are processed in the following order:
1. Match the table name. For example, incident.
2. Match the parent table name. For example, task.
3. Match any table name (*). For example, *.

If a user fails all table ACL rules, the user cannot access the fields in any table. If a user passes a table ACL rule, the system then evaluates the field ACL rules.

Field ACL rules

After a user passes a table ACL rule, field ACL rules are processed in the following order:
1. Match the table and field name. For example, incident.number.
2. Match the parent table and field name. For example, task.number.
3. Match any table (*) and field name. For example, *.number.
4. Match the table and any field (*). For example, incident.*.
5. Match the parent table and any field (*). For example, task.*.
6. Match any table (*) and any field (*). For example, *.*.

A user must pass the table ACL rule to be granted access to the table's fields. For example, the user must first pass the table ACL rule for the incident table to access the Number field in the incident table.

The first successful field ACL evaluation stops ACL rule processing at the field level. When a user passes a field ACL rule, the system stops searching for other matching field ACL rules. For example, if a user passes the field ACL rule for incident.number, the system stops searching for other ACL rules that secure the Number field in the incident table.

UI page ACL rules

UI page ACL rules specify the UI page to be secured. For a list of available UI pages, navigate to System UI > UI Pages. When defining an ACL rule for a UI page, use the fully scoped page name. For example, x_myapp_mypage.
UI page ACL rules honor the STAR (*) rule only if the `explicit_roles plugin` is installed.

ACL rules can secure the following UI page operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>read</td>
<td>Allows users to display the UI page.</td>
</tr>
</tbody>
</table>

**Client-callable script include ACL rules**

Script include ACL rules specify the client-callable script include to be secured. For a list of available script includes, navigate to **System Definition > Script Includes**. You can personalize the list to show the Client callable column.

Client-callable script include ACL rules honor the STAR (*) rule only if the `explicit_roles plugin` is installed.

The base system does not include any ACL rules for client-callable script includes.

**Create an ACL rule**

Create a custom ACL rule to secure access to new objects or to change the default security behavior.

Role required: security_admin

To create ACL rules, you must elevate privileges to the security_admin role. For tables that are in a different scope from the ACL rule record, the types of rules are limited.

1. **Elevate privileges** to the security_admin role.
2. Navigate to **System Security > Access Control (ACL)**.
3. Click **New**.
4. Complete the form.

**Access control fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select what kind of object this ACL rule secures. The type of object determines how the object is named and what operations are available. This field becomes read only after the ACL rule is created. If you want to change the type, you must delete the ACL and create a new one with the correct type.</td>
</tr>
<tr>
<td>Operation</td>
<td>Select the operation this ACL rule secures. Each object type has its own list of operations. An ACL rule can only secure one operation. To secure multiple operations, create a separate ACL rule for each.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Admin overrides</td>
<td>Select this check box to have users with the admin role automatically pass the permissions check for this ACL rule. Admin users pass regardless of what script or role restrictions apply. However, the nobody role takes precedence over the admin override option. If an ACL is assigned the nobody role, admin users cannot access the resource even when Admin overrides is selected. See Base system roles. Clear this check box if administrators must meet the permissions defined in this ACL rule to gain access to the secured object. Since administrators always pass role checks (see the description of the Requires role field), use the condition builder or Script field to create a permissions check that administrators must pass.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to enforce this ACL rule.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to display the Script field.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the object being secured, either the record name or the table and field names. The more specific the name, the more specific the ACL rule. You can use the wildcard character asterisk (<em>) in place of a record, table, or field name to select all objects that match a record type, all tables, or all fields. You cannot combine a wildcard character and a text search. For example, inc</em> is not a valid ACL rule name, but incident.* and *.number are valid ACL rule names. Note: Click the blue triangle to manually enter the record name or the table and field names of the object being secured. Use this option to secure an object that does not appear in the dropdown.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the object or permissions this ACL rule secures.</td>
</tr>
<tr>
<td>Requires role</td>
<td>Use this list to specify the roles a user must have to access the object. If you list multiple roles, a user with any one of the listed roles can access the object. The Requires role list appears as a related list. Note: Users with the admin role always pass this permissions check because the admin role automatically grants users all other roles.</td>
</tr>
</tbody>
</table>

Note: ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Use this <em>condition builder</em> to select the fields and values that must be true for users to access the object.</td>
</tr>
</tbody>
</table>
| Script  | Enter a custom script describing the permissions required to access the object. The script can use the values of the current and previous *global variables* as well as system properties. The script must generate a true or false response in one of two ways:  
  - return an answer variable set to a value of true or false  
  - evaluate to true or false  
  
In either case, users only gain access to the object when the script evaluates to true and the user meets any conditions the ACL rule has. Both the conditions and the script must evaluate to true for a user to access the object. |

**Note:** If the evaluated item is in a related list, *current* points to the item the related list is on, not to the current item the ACL is for. However, if the item you are evaluating the ACL for is not in a related list, *current* points to the actual item.

5. Right-click the form header and select **Save**.
Access Control Rules allow access to the specified resource if all three of these checks evaluate to true:
1. The user has one of the roles specified in the Role list, or the list is empty.
2. The condition in the Condition field evaluates to true, or conditions are empty.
3. The script in the Script field (advanced) evaluates to true, or sets the variable "answer" to true, or is empty.
The three checks are evaluated independently in the order displayed above.

Requirements:

- Role
- Script

Condition: 3 records match condition: 
- choose field: dropdown
- operator: dropdown
- value: input
Secure records in an embedded list

To apply security to the records in embedded lists, limit editing and deleting records in embedded lists to specific roles.

Elevate to the security_admin role.

Role required: security_admin

1. Navigate to System Security > Access Control (ACL).
2. Open the Write or Delete record for the appropriate table.
3. In the Requires Role section of the form, add the roles that have write or delete permission for that table.
4. Save the changes.

When records from the associated table appear in an embedded list, the edit and delete options are available only to users with the specified roles.

Contextual Security Manager

Contextual Security Manager protects your data by controlling read, write, create, and delete authorization.

Key advantages

The Contextual Security Manager is aware of the system table hierarchy, enabling you to create specific security rules for a field based on where in the hierarchy it is displayed. Benefits of the Contextual Security Manager include:

- Contextual security: Secure a record based on the contents of the record.
- Hierarchical security: Apply security rules to any level in the object hierarchy.

Securing fields and tables

With the legacy Simple Security Manager, you could secure fields and tables by adding roles to the appropriate dictionary entry. With the Contextual Security Manager, these dictionary roles are no longer tested. Instead, the system looks for ACL rules on fields and tables.

Warning: After you install the Contextual Security Manager, you must secure fields and tables via ACL rules. Even if you configure the dictionary form and add roles to a dictionary entry, no change in rights occurs.

Contextual security and roles

You can grant roles to users or groups. However, after installing the Contextual Security Manager, the roles field on the user record is no longer checked and no longer appears on your user and group forms. Instead, you must add roles to the Roles related list instead of to the user or group record.

Applications and modules contain lists of the roles required to view them. For example, to view the System Definition application, the admin role is required. Security rights for applications and modules are still defined using role arrays.
Both catalog items and catalog variables contain lists of the roles required to view them. Security rights for catalog items and catalog variables are still defined via these role arrays.

Under the Contextual Security Manager, a group still automatically inherits any role granted to the group when the inherits flag for the role is set to true.

**Activating the Contextual Security Manager**

The Contextual Security Manager is active in the base system. If there are many duplicate entries in the User Roles table, you may need to upgrade to Contextual Security: Role Management V2 to eliminate duplicate roles. Plugins include:

**Contextual Security: Role Management (com.glide.role_management)**

Provides contextual security functionality. This plugin is automatically installed.

**Contextual Security: Role Management V2 (com.glide.role_management.inh_count)**

Prevents duplicate entries caused by inherited roles in the User Roles (sys_user_has_role) table. This plugin is automatically installed on new instances and can be activated for upgrades. The Contextual Security: Role Management Enhancements plugin is a previous version of this plugin. The Role Management Enhancements plugin does not include the RoleManagementVerify() script. This script returns a list of changes that an upgrade will perform, enabling you to monitor changes made by the plugin.

---

**Note:** After activating Role Management V2, you must set the glide.role_management.v2.audit_roles system property to allow the Audit Roles table to create audit records related to user roles. For more information about the Audit Roles table, see [Audit user roles](#).

---

**Prevent duplicate entries with Contextual Security: Role Management V2**

Roles inherited from other roles are added as individual entries in the User Roles table (sys_user_has_role), potentially causing one role to have duplicate entries. Contextual Security: Role Management V2 eliminates these duplicate entries and prevents future duplicates.

**Eliminate duplicate entries through inheritance count**

Contextual Security: Role Management V2 uses the Inheritance Count (inh_count) column to track the number of times a role is inherited from another role or group. In the User Roles (sys_user_has_role) table, a user can inherit a specific role only one time, eliminating duplicate entries. The Inheritance Count (inh_count) column is read-only and calculates the number of times the user inherits a role.

**Activation changes**

Contextual Security: Role Management V2 is automatically installed on new instances and can be activated for upgrades. When activated, Contextual Security: Role Management V2 replaces both Contextual Security and Contextual Security: Role Management Enhancements.

When Contextual Security: Role Management V2 is activated, the following columns are deprecated, but remain in the User Roles table for backward compatibility:

- `granted_by` (used only by Role Delegation)
- `included_in_role`
Visualize role inheritance through the Role Inheritance Map

The Role Inheritance Map displays a visual representation of inherited roles. You can use this map to understand the roles represented in the Inheritance Count (inh_count) column. To view the Role Inheritance Map, configure the User Roles (sys_user_has_role) table to display the Role Inheritance Map column.

Role Inheritance Map

Upgrade to Contextual Security: Role Management V2

Contextual Security: Role Management V2 is automatically installed on new instances. You can upgrade from Contextual Security: Role Management to Contextual Security: Role Management V2 to eliminate duplicate roles in the User Roles table and prevent future duplicates.

Role required: admin

If not already active, Contextual Security: Role Management V2 activates these related plugins.

Plugins for Contextual Security: Role Management V2

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contextual Security: Role Management V2 (com.glide.role_management.inh_count)</td>
<td>Prevents duplicate entries in the User Roles (sys_user_has_role) table.</td>
</tr>
<tr>
<td>Contextual Security: Role Management V2 REST API (com.glide.role_management.inh_count.rest_api)</td>
<td>Enables API functionality for role management.</td>
</tr>
</tbody>
</table>
Before upgrading from Contextual Security: Role Management to Contextual Security: Role Management V2, test the results of an upgrade by running the script. The script returns a list of changes that an upgrade will perform. If the changes are acceptable, install the Contextual Security: Role Management V2 plugin. If the changes are not acceptable, do not install the Contextual Security: Role Management V2 plugin. Alternatively, you can perform the upgrade and then manually make any necessary changes.

1. Test the impact of an upgrade prior to upgrading by running the following script.
   a) Navigate to **System Definition > Scripts - Background**.
   b) Run the following script in global scope.

   ```java
   new RoleManagementVerify().verifyInheritedRoles();
   ```

   For large sys_user_has_role tables, the execution may take up to several hours to complete. Do not edit or add user roles during this time.

   **Example result based on test data:**

   ```
   *** Script: 2016-12-01 19:58:54 Starting checking of inherited roles for all users...
   *** Script: User: itam, inherited roles to be ADDED: financial_mgmt_user
   *** Script: User: bernard.laboy, inherited roles to be DELETED: api_analytics_read,pa_viewer,rest_api_explorer,a123
   *** Script: User: bernard.laboy, inherited roles to be ADDED: dependency_views
   *** Script: Number of inherited-role records in sys_user_has_role, current: 260, after re-calculation: 258
   *** Script: Number of users with discrepancies for inherited roles: 2
   *** Script: 2016-12-01 19:58:55 Finished checking of inherited roles for all users!
   ```

   c) Evaluate the script results to determine whether the proposed changes are acceptable.

2. Activate the Contextual Security: Role Management V2 plugin.
   a) Navigate to **System Definition > Plugins**.
   b) Find and click the plugin name.
   c) On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   d) Click **Activate**.

   After activating Role Management V2, the changes outlined in the script result are enacted. The Inheritance Count (inh_count) column in the User Roles table is read-only and automatically reflects the number of times the user inherits a role.

   **Enable role auditing with Contextual Security: Role Management V2**

   Set a system property to enable the Audit Roles table to create audit records related to user roles.

   Role required: admin

   When enabled, the Audit Roles (sys_audit_role) table maintains changes to user records. For more information about role audits, see [Audit user roles](#). If the Contextual Security: Role Management V2 (com.glide.role_management.inh_count) plugin is installed, you must set a system property to true to enable role auditing.

   1. Navigate to the System Properties (sys_properties) table.
   2. Add the `glide.role_management.v2.audit_roles` system property and set it to `true`. 
If the Contextual Security: Role Management V2 (com.glide.role_management.inh_count) plugin is installed, setting this property to true enables the Audit Roles (sys_audit_role) table to create records when user roles change.

Double-check form submission

When the system determines that a particular field (such as task.number) should not be written to by the current user, the system renders that field in a read-only mode, which is why the number field is not writable on most incidents.

If you set the system to double-check the values of any incoming fields for writability, then the system applies the same set of security rules to the inbound leg of a transaction. When you submit an incident, for example, the system double-checks to determine if the number field can be written to before posting any changes.

If you tell the system not to double-check inbound transactions, then the system allows you to write to a nominally read-only field if that is the transaction the client sends back. In many deployments this is actually a desirable behavior if, for example, you are using client scripts to set nominally read-only fields in response to user selections in other, writable fields.

<table>
<thead>
<tr>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double check security on inbound transactions during form submission (rights are always checked on form generation)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Properties &gt; Security</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled (no double checking)</td>
</tr>
</tbody>
</table>

Default deny property

The default deny property (glide.sm.default_mode) controls the security manager default behavior when the only matching ACL rules are the wildcard table ACL rules.

A set of wildcard table ACL rules for the most common record-based operations are available: read, write, create, and delete. A significant number of ACLs to provide role-based access to system tables are also available. For example, there are ACLs that grant sys_script access to the business_rule_admin role because that role is documented as being able to manage business rules.

Use the glide.sm.default_mode property to deny or allow these operations on all tables:

- **Deny Access**: The wildcard table ACL rules restrict the read, write, create, and delete operations on all tables unless the user has the admin role or meets the requirements of another table ACL rule. Other operations, such as report_on and personalize_choices, are unaffected by this setting.
- **Allow Access**: The wildcard table ACL rules allow the read, write, create, and delete operations on all tables unless there are specific table ACL rules in place to restrict such operations.

You cannot reset glide.sm.default_mode to **Allow Access** once it has been set to **Deny Access**.

**Note:** By default, the wildcard table ACL rules are the only ACL rules that check for the value of the glide.sm.default_mode property. If you want to control other operations with this setting, create your own ACL rules to check for this property value.

Advanced ACL configuration

In addition to creating new ACLs or modifying existing ones, you can configure other aspects of ACL functionality.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply ACL script conditions to reference fields</strong></td>
<td>Enable a property to allow script conditions to apply to reference fields if you want to control access to the data that a reference field displays on a form or in a list. There might be an impact to the performance of your instance if you enable this.</td>
</tr>
<tr>
<td><strong>Apply ACLs to AJAXGlideRecord (client-side Glide record)</strong></td>
<td>Apply ACLs to GlideAjax API calls so that the system queries only the data that the currently connected user has rights to access.</td>
</tr>
<tr>
<td><strong>Evaluate the admin override at the access level</strong></td>
<td>Force ACL evaluation for admin overrides at the access level. By default, users with the admin role automatically pass the permissions check for this ACL rule when the Admin Overrides option is selected on the ACL rules form.</td>
</tr>
</tbody>
</table>

### Apply ACL script conditions to reference fields

If you want to enable script conditions for reference fields, you can add a system property. The default behavior is intended to improve instance performance. If you want to enable script conditions for reference fields, add the following system property.

**System property**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sys_reference_row_check</td>
<td>Controls whether the script conditions of Access Control Rules apply to a table’s reference fields.</td>
</tr>
<tr>
<td>· Type: true</td>
<td>false</td>
</tr>
<tr>
<td>· Default value: false</td>
<td></td>
</tr>
<tr>
<td>· Location: Add to the System Properties (sys_properties) table</td>
<td></td>
</tr>
</tbody>
</table>

### Apply ACLs to AJAXGlideRecord (client-side Glide record)

From within client scripts, it is possible to query arbitrary data from the server via the AJAXGlideRecord (renamed GlideAjax) API, by using syntax similar to a server-side glide record. This is an extremely powerful and useful tool in many deployments. You can set a system property to perform ACL validation when server-side records (for example, tables) are accessed using GlideAjax APIs within a client script.

If you choose to apply access control lists (ACL) to GlideAjax API calls, then you can only query data to which the currently connected user has rights to access. For example, if the user is logged in as an ESS user who has no rights to read the cmn_location table, then any GlideAjax API call by the user will fail.

If you run the system without an ACL checking on GlideAjax calls, then the API can return information that the currently logged in user could not otherwise access via the UI.

**Note:** Set this property in System Properties > Security.
Evaluate the admin override at the access level

If you want to force ACL evaluation for admin overrides at the access level, you can add a system property.

Role required: security_admin

ACLS are evaluated cumulatively. If there are number of ACLs on any given field and the Admin Overrides option is false (not selected) on one of them, then the effective admin overrides for all the ACLs are considered to be false. This causes admins to be unable to pass even the ACL where the override should be in effect.

- Add the following property to the system properties table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.security.admin.override.accessterm</td>
<td>Evaluates the admin override condition at the access term level.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true for new instances, false for upgrades.</td>
</tr>
<tr>
<td></td>
<td>- Location: Add to the System Properties (sys_properties) table</td>
</tr>
</tbody>
</table>

ACL debugging tools

Field level debugging and access ACL rule output messages are available to help you troubleshoot and debug ACLs. The ACL configuration watcher lets you know what related ACLs exist when you modify one.

Field level debugging

When debugging is enabled, a small bug icon (🇬🇧 #) appears beside each field with an ACL rule. Clicking the icon lists the ACL rules that apply for the field and the evaluation results.

Field level security on an incident

After enabling ACL debugging, you can impersonate another user to see what ACL rules the user passes and fails. When you impersonate a user, you can only see what that user is allowed to see. For example, you cannot view a record that an ACL prevents the user from seeing. To make debugging easier, read-only access to certain ACL-related tables is enabled by default,
even when impersonating a user that does not have read access to the tables. To change this functionality, set the following property to false.

To enable ACL rule debugging, navigate to **System Security > Debug Security Rules**.

<table>
<thead>
<tr>
<th>System property</th>
<th>Description</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.security.access_acl_as_impersonator</td>
<td>Allows read access to the following tables while impersonating a user: sys_security_acl, sys_security_operation, sys_security_type, and sys_user_role. As a result, the impersonating user can read data that the impersonated user cannot read.</td>
<td>true</td>
</tr>
</tbody>
</table>

**Note:** When the property is set to false, the impersonated user might be prevented from reading ACL-related data. In this case, a second session logged in as admin or security_admin might be required to debug ACLs.

**ACL rule output messages**

ACL debugging displays ACL rule output messages at the bottom of each list and form. The output message displays the following:

<table>
<thead>
<tr>
<th>Message element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME</td>
<td>The total time used to process this ACL rule.</td>
</tr>
<tr>
<td>PATH</td>
<td>Information that uniquely identifies each ACL rule in the format: &lt;ACL rule type&gt;&lt;ACL rule name&gt;&lt;Operation&amp;gt.;</td>
</tr>
<tr>
<td>CONTEXT</td>
<td>The object being evaluated by the ACL rule.</td>
</tr>
<tr>
<td>RC</td>
<td>The return code of the ACL rule. A true value passes the ACL rule. A false value fails the ACL rule.</td>
</tr>
</tbody>
</table>
RULE

A brief summary of processors and scripts, followed by ACL results for each table-level and field-level ACL evaluation. Most ACL evaluations show an overall pass or fail result followed by a breakdown of the results for each type of ACL criteria:

- **iAccessHandler**: An internal system check using hidden source code on the platform. This is a system security check that you cannot modify. `iAccessHandler` can grant or deny access to a resource without evaluating ACLs. If `iAccessHandler` is ignored, then the ACLs are evaluated. You cannot modify the `iAccessHandler` checks in any way. For example, an `iAccessHandler` implementation is used for access checks on application resources and this cannot be changed. This is available starting with the Istanbul release.
- **Roles**: Verification that the user has the correct role.
- **Condition**: Verification that the user passed the condition specified on the ACL rule (if any).
- **Script**: Verification that the user passed the script specified on the ACL rule (if any).

The icons that appear show how the ACL was evaluated:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A green checkmark (✔) #</td>
<td>Indicates the table or field passed the criteria.</td>
</tr>
<tr>
<td>A red x icon (✗)</td>
<td>Indicates the table or field did not pass.</td>
</tr>
<tr>
<td>An empty gray circle icon (〇) #</td>
<td>Indicates the ACL evaluation did not need to be performed.</td>
</tr>
<tr>
<td>A blue checkmark, x, or empty circle</td>
<td>Indicates that the ACL was taken from a cached result of a previous ACL check. The icons mean the same as the above.</td>
</tr>
</tbody>
</table>

You can perform these actions on the ACL debug output:

- Select or clear these check boxes at the top of the debug output:
  - **Security rules**: Show or hide the results of the ACL checks.
  - **Others**: Show or hide other warnings or messages.
- Click the name of the ACL next to any of the output messages to open that ACL record.
**ACL troubleshooting reference**

Common ACL rule errors and their solutions.

<table>
<thead>
<tr>
<th>Error or symptom</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot access records from a custom table.</td>
<td>Create a table ACL rule for the custom table granting users access to the table. Without an explicit table ACL rule, users must pass the permissions in the table wildcard (*) ACL rule, which by default restricts access to administrators only. Enable debugging and determine what ACL rules are evaluated for the custom table.</td>
</tr>
<tr>
<td>You create a custom ACL rule that does not work properly.</td>
<td>The most likely problems are that another rule takes precedence over your custom rule in the processing order or that the user does not meet all the permission requirements for the object type. Enable debugging and verify that the ACL rule is being evaluated.</td>
</tr>
<tr>
<td>Your field ACL rule does not work properly.</td>
<td>There is likely a table ACL rule that the user has not met. Enable debugging and determine what ACL rules are evaluated for the field. Verify that there is not a conflicting table ACL rule or duplicate field ACL rule.</td>
</tr>
<tr>
<td>Your table ACL rule does not work properly.</td>
<td>There is either an ACL rule higher in the processing order or a duplicate table ACL rule interfering with the table ACL rule. Enable debugging and determine what ACL rules are evaluated for the table.</td>
</tr>
<tr>
<td>You can see a field in a list but not in form.</td>
<td>It is possible that the ACL rule conditions or script are being triggered in the list but not in the form. Enable debugging and determine when the ACL rules evaluate to true. Update the conditions or script to have the same behavior on the list and form.</td>
</tr>
</tbody>
</table>
### Error or symptom

You receive an error message when trying to execute a processor or client-callable script include.

### Solution

There is an ACL rule for the processor or client-callable script include that the user has not met. If the user should have access to the object, enable debugging and determine what ACL rules are evaluated for the processor or script include. Update the ACL rule or the user roles as needed to access the object.

---

**ACL configuration watcher**

The ACL configuration watcher lets you know what related ACLs exist on a table when you insert, update, or delete an ACL on the same table.

The ACL configuration watcher is an interceptor window that displays every time you make important changes on the Access Control (sys_security_acl) table. It displays a security rules summary window where you can view ACLs related to the one you are modifying. You cannot modify any ACLs from the security rules window. To make any modifications, close the watcher window and go to those ACLs.

The ACL configuration watcher is available with the Geneva release.

The ACL configuration watcher does not appear in the following situations:

- If you save or update an ACL record without actually making any changes.
- If you make minor updates (not an insert or delete), such as updating scripts, conditions, and the admin-overrides option.
- If the ACL record is not active.

**ACL Security Rules window**

The configuration watcher shows the **ACL execution plan**. The execution plan is displayed in the security rules pop-up window. You can view this kind of information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>red highlight</td>
<td>An ACL that is deleted or deactivated.</td>
</tr>
<tr>
<td>blue highlight</td>
<td>An ACL that is modified.</td>
</tr>
<tr>
<td>green highlight</td>
<td>An ACL that is added or becomes active.</td>
</tr>
<tr>
<td>Masked</td>
<td>An ACL that was effective until you made a change.</td>
</tr>
<tr>
<td>Unmasked</td>
<td>An ACL that was just made effective when you made a change.</td>
</tr>
</tbody>
</table>
Configuration watcher example

Show ACL execution plan
Administrators can view how ACLs relate to each other by viewing an execution plan for any ACL in the instance.

Role required: security_admin

1. Elevate to a privileged role.
2. Open an ACL that is a record-type ACL.
3. Click Show ACL Execution Plan.

The security rules window appears for the ACL.
ACL execution plan window

<table>
<thead>
<tr>
<th>UI Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the ACL.</td>
</tr>
<tr>
<td>Tab name</td>
<td>If the ACL is create, read, write, or delete.</td>
</tr>
<tr>
<td>Row level</td>
<td>Row-level ACLs that run on this table.</td>
</tr>
<tr>
<td>Field level</td>
<td>Field-level ACLs that run only on this field (or column in the table).</td>
</tr>
</tbody>
</table>

4. Click **Show all** to show all related ACLs, including those ACLs that are overridden and generic ACLs that apply to all records. Overridden ACLs have a line through the name and generic ACLs have the wildcard character asterisk (*) for the name.

5. Click **Show Effective** to show only the immediate ACLs related to the one you are viewing. This action hides the ACLs on tables from which the ACL table is extended and the generic wildcard (*) ACLs.

**Use the ACL configuration watcher**

Use the ACL configuration watcher after you elevate to security administrator.

Role required: security_admin

**Elevate to a privileged role**

1. Open an ACL that is a record-type ACL.
2. Perform an action on the ACL, such as modifying it, or selecting an option from the context menu like **Insert**.
3. If you modified any values on the Access Control form, right-click the header and select **Save** or click **Update** or **Delete**.

The Security Rules window appears. The system did not yet perform the database action on the ACL, so the changes are not yet saved.

These are examples of security rules on the Visual Task Board application’s Private Task (vtb_task) table. See **ACL configuration watcher** for a description of the items on this window.

Verify Security Rules for "vtb_task.short_description"  

<table>
<thead>
<tr>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row level</td>
</tr>
<tr>
<td>Field level</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Show All  

Cancel  Continue
4. Just as with the execution plan, you can click Show all to show all related ACLs, including those that are overridden and generic ACLs that apply to all records, or click Show Effective to show only the immediate ACLs related to the one you are viewing.

5. Hover your mouse over any of the ACLs to see a description.

Elevated privilege roles

Elevated privilege roles require you to manually accept the responsibility of using the role before you can access the features of the role.

By default, you do not have elevated privilege roles upon login. You must manually elevate to the privilege of the role. An elevated privilege role only lasts for the duration of the user session. Session timeout or logout removes the role.

You can designate any role as an elevated privilege role, and then assign that role to one or more users. Do this when you want to restrict users from having access to the rights that the role provides immediately after login. You can designate the privilege role on the Role form. See Create a role for instructions.
To use an elevated role, you must meet these conditions:

- The role must be assigned to you.
- You must manually elevate to a specific elevated role to get its privileges, even if you are already elevated to a second elevated role that contains the first elevated role.

For example, if elevated role A contains elevated role B, even if you elevate to role A, you must still elevate to role B to get its privileges.

### The admin role

To grant the admin role to a user, the granting user must also have the admin role. For example, a user with only the user_admin role cannot grant the admin role to other users.

- Non-admin users cannot add a user to a group that contains the admin role.
- To grant the security_admin role to a user, the granting user must also have the admin role and must elevate to the security_admin role before granting the security_admin role to other users. A user with only the admin role cannot grant the security_admin role to other users.
- A user without the security_admin role cannot add a user to a group that contains the security_admin role.

**Warning:** The use of elevated privilege on the admin role is not supported and may cause unexpected behavior. To require administrators to manually elevate, see Force administrators to manually elevate.

### The security_admin role

In the base system, the security_admin role is the only role that has elevated privileges. This role is automatically assigned to the user who is the default System Administrator (admin) user. It provides access to ACLs and High Security Settings.
Roles assigned to the System Administrator (admin) user

Note: To see this role, you must actually elevate to the security_admin role first. If you are logged in as the System Administrator (admin) user only, you cannot see the security_admin record in the list of roles.
The security_admin role record

security_admin role

The security_admin role is an elevated privilege role provided with High Security Settings that lets users create and change access controls and change High Security Settings.

In the base system, only the default System Administrator (admin) user has the security_admin role. Since it requires elevating privileges, the admin user does not have this role at login. After elevating privileges, the admin user has the security_admin role for the duration of the user session.
**Note:** The record for the System Administrator (admin) role is only visible to users who elevate privileges to the security_admin role.

To maintain high security, the security_admin role requires elevating privileges. Limit the users and groups to which you assign this role.

### Elevate to a privileged role

The base system admin can elevate to a privileged role to have access to the features of High Security Settings.

**Role required:** admin

**Note:** If you grant additional users the admin role, they cannot elevate to a privileged role. Only the out-of-box admin can elevate.

1. Do the appropriate action for your version of the UI:

   **UI16**
   
   1. In the banner frame, click your user name.
   2. Select **Elevate Roles**.

   ![Elevate Roles UI16](image)

   **UI15 or UI11**

   In the banner frame, click the lock icon (🔒) by your user name.

   A dialog box appears.
2. Select an elevated role and click **OK**. This role grants the user elevated privileges to all resources controlled by the role for the remainder of the session. When the user logs out, the elevated privileges are terminated and must be reestablished at the next login. When elevated privileges are activated, the icon has an unlocked appearance.

Note: Any edits being made when the page reloads are lost.

### Force administrators to manually elevate

A property is available to force all users with the administrator role to manually select the role that they want to elevate to.

Role required: security_admin

1. Log in as a user with the security_admin role.
2. Elevate roles to security_admin.
3. Navigate to **sys_properties.list**.
4. Set the `glide.security.strict_elevate_privilege` property to **true**.

When the user logs in, they are presented with a dialog window to select the role to which they can elevate.
Login and authentication security

Configure login security options to control access to your instance.

Security options

You can control several aspects of user login and authentication security:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Related topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log in and log out controls</td>
<td>Control several dimensions of the log in and log out process for users, such as specifying a landing page that the user sees upon login and control how users log out.</td>
<td>• Define login scenarios&lt;br&gt;• Enable the logout confirmation prompt&lt;br&gt;• Remove the Logout button&lt;br&gt;• Installation exits&lt;br&gt;• Specify lockout for failed login attempts</td>
</tr>
<tr>
<td>Authentication security</td>
<td>Control the password reset process and features like the Remember Me option. You can also use IP address-based controls for access to the instance and implement a nonce to be used with single sign-on digest authentication.</td>
<td>• Strengthen password validation rules&lt;br&gt;• Example: The default self-service Password Reset process&lt;br&gt;• Change settings for the Remember me check box and cookie&lt;br&gt;• IP range based authentication&lt;br&gt;• Using a nonce with single sign-on</td>
</tr>
</tbody>
</table>
Define login scenarios

You can direct all users to the same page after login.

Role required: admin

When users log on to an instance directly, such as going to http://{instance_name}.service-now.com/, the system does the following:

1. Accesses the value in the property `glide.entry.page.script`. The default value of the property is derived from a script include named CMSEntryPage.
2. Directs the user to the instance login page if the entry page requires a login.
3. Applies login rules, if any, to the user.

To force the system to direct all users to the same page after login:

1. Navigate to Content Management > Configuration > Configuration Page.
2. Select a value for the Login page field, or create a new page as desired. If this page is not the site default page, it always redirects here. If it is a site default page, it applies login rules. If this value is null, the system uses navpage.do as the entry page. Do not enter a login page here; otherwise, users need to log in twice.

Logging Into an Instance to Access a Record:

When users log into an instance to access a record by its globally unique identifier (sys_id), such as http://{instance}.service-now.com/incident.do?sys_id={sys_id}, then the system does the following:

1. Directs the user to a login page if not already logged in.
2. Directs the user to the appropriate record if they are allowed to access it. If the user does not have access rights to the record, a denial of access message appears.

Logging Into a CMS Site:

When users log on to a CMS site, such as http://<instance>.service-now.com/site-name/page.do, the system does the following:

- If there is a value in the Login page field on the CMS site form, it directs the user to that login page and applies login rules, if any, to the user.
- If there is no login page specified, it directs the user to the value in the Home page field on the CMS site form.

Logging Into a CMS Site to Access a Record:

When users log on to a CMS site to access a record, such as http://{instance}.service-now.com/ess/incident_detail.do?sysparm_document_key=incident,{sys_id}, the system follows the same procedure and finally takes the user to the record. If the user does not have access rights to the record, a denial of access message appears.

Logins and the employee self-service portal

The system keeps track of the first starting page that a user is trying to access even if the user wants to log in to the Employee Self-Service Portal.

Consider the following scenarios.

Example 1:

1. A user is not logged in, and then tries to access a record using a specific SYS ID in the URL.
2. The system redirects the user to the login page.
3. Rather than logging in, the user tries to access another site, such as the Employee Self-Service (/ess) Portal.
4. The system redirects the user to the login page again.
5. The user logs in and is redirected to the record that the user was first trying to access rather than the Employee Self-Service Portal.

Example 2:
1. A user is not logged in, and then tries to access a record using a specific SYS ID in the URL through the Employee Self-Service (/ess) Portal.
2. The system redirects the user to the login page.
3. Rather than logging in, the user tries to access another record through the Employee Self-Service Portal.
4. The system redirects the user to the login page again.
5. The user logs in and is redirected to the first record rather than the second.

Specify a login landing page

By default, users see their homepage upon login. You can specify a different login landing page by using a system property or the content management system.

Role required: admin

To specify a login landing page for all users, change the property value on the sys_properties table.

1. Type sys_properties.list in the navigation filter.
2. Locate the glide.login.home system property.
3. In the Value field, enter the name of the page that all users see upon login.

   Use <page name>.do; you may omit the http://'instance'.service-now.com/ portion of the URL. To determine the page name or the URL of a page in the system, you can point to a link. Some possible pages are welcome.do and incident.do.

   To specify a dashboard landing page, set the property to $pa_dashboard.do?dashboard=<SYS_ID>. Replace <SYS_ID> with the sys_id of the dashboard.

   **Note:** This property is system-wide, so setting it affects all users.

You can also specify a login landing page with the content management system.

Specify lockout for failed login attempts

The system provides inactive script actions that enable you to specify the number of failed login attempts before a user account is locked and to reset the count after a successful login.

Role required: admin

Navigate to System Policy > Script Actions to view or activate the scripts.
**SNC User Lockout Check with Auto Unlock**

- Uses the value of the `glide.user.max_unlock_attempts` property to set the limit for failed login attempts.
- Unlocks the user account after the time period that is specified for the `glide.user.unlock_timeout_in_mins` property. If no value is specified, then the system unlocks the user account after the default period of 15 minutes.

<table>
<thead>
<tr>
<th>SNC User Lockout Check</th>
<th>Tracks the number of failed login attempts and locks the user account after a specified number of failed login attempts (default: 5).</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNC User Clear</td>
<td>Updates the user record after a successful login: Resets the number of failed login attempts and updates the date of the last login.</td>
</tr>
</tbody>
</table>

Each time a user attempts to log in, the action is recorded in an event log. You can view a log of failed login attempts.

1. Navigate to **System Policy > Event Logs**.
2. Filter for **login.failed** in the **Name** field. You can view the attempted login name, date, and IP address logged for the attempt.

---

**Make UI pages public or private**

You can make pages public if you want your users to see the pages without logging in.

Role required: admin

Most pages are only viewable by logged in users. A limited number of pages are public so that users do not have to log in to view them, such as the welcome page, the front page, and the login and logout pages.

**Warning:** Several base system public pages are required for the functionality of many features. Do not disable base system public pages.

1. In the application navigator filter, type `sys_public.list`.
2. Click **New**.
3. In the `sys_public` table, create a record with the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>The name of the page. For example: $sp</td>
</tr>
<tr>
<td>Active</td>
<td>When selected, the page is publicly accessible. Deselect the Active option when you want the page to be private.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
   By setting active to true, the page is public, so anyone visiting `<instance_name>/sp` or `<instance_name>/sp.do` can access the page.

---

**Enable the logout confirmation prompt**

You can enable a logout confirmation prompt to prevent users from inadvertently logging themselves out.
Role required: admin

**Note:** The following procedure does not work in UI16.

1. Navigate to **System Properties > System**.
2. Locate the **Prompt user to confirm a logout request** property and select the check box.
3. When the user clicks the **Logout** button, a confirmation dialog box displays.

![Confirmation dialog box](image)

### Remove the Logout button

You can remove the **Logout** button to prevent inadvertent logouts.

Role required: admin

**Note:** The following procedure does not work in UI16.

1. Navigate to **User Administration > User Preferences**.
2. Delete the system preference **user.can.logout**.

### Installation exits

Installation exits are customizations that exit from Java to call a script before returning back to Java.

**Note:** Functionality described here requires the **Admin** role.

### Available installation exits

Navigate to **System Definition > Installation Exits**. Some installation exit names (Login, Logout, ValidatePassword, ExternalAuthentication) are reserved and cannot be changed. Other installation exits can override these with custom script that replaces the script in the default installation exit.

The following installation exits are available in the base system:

<table>
<thead>
<tr>
<th>Installation Exit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Takes a username and password pair and authenticates with the user object</td>
</tr>
<tr>
<td>Logout</td>
<td>Takes the user to the welcome page upon signing out; can be overridden by LogoutRedirect</td>
</tr>
</tbody>
</table>
### Installation Exit

<table>
<thead>
<tr>
<th>Installation Exit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogoutRedirect</td>
<td>Takes the user to a specified URL upon signing out</td>
</tr>
<tr>
<td>ExternalAuthentication</td>
<td>Authenticates using header, parameter, or cookie; can be overridden by DigestSingleSignOn and PGPSingleSignOn</td>
</tr>
<tr>
<td>DigestSingleSignOn</td>
<td>Authenticates using header, parameter, or cookie and decrypts Digest encryption</td>
</tr>
<tr>
<td>PGPSingleSignOn</td>
<td>Authenticates using header, parameter, or cookie and decrypts PGP encryption</td>
</tr>
<tr>
<td>ValidatePassword</td>
<td>Active by default, starting with the Helsinki release; allows customers to define their own password validation; can be overridden by ValidatePasswordStronger</td>
</tr>
<tr>
<td>ValidatePasswordStronger</td>
<td>Requires passwords be at least 8 characters long and contain a digit, an uppercase letter, and a lowercase letter</td>
</tr>
<tr>
<td>GetIntegrationSessionTimeout</td>
<td>Implements the default integration session timeout behavior.</td>
</tr>
</tbody>
</table>

### Login modifications

The following modification to the **Login** installation exit sets each user’s session timeout value as the user is logging in. In this particular example, if the user name is admin, the session is set to timeout in 30 seconds.

```javascript
gs.include("PrototypeServer");

var Login = Class.create();
Login.prototype = {
  initialize : function() {

  process : function() {
    // the request is passed in as a global
    var userName = request.getParameter("user_name");
    var userPassword = request.getParameter("user_password");

    var authed = GlideUser.authenticate(userName, userPassword);
    if (authed) {
      // ***********************************************************
      // customization - if the userName == admin, set the session
      // timeout to be 30 seconds. You can implement your own
      // session timeout algorithm here by checking to see if a user
      // belongs to a certain group or has a certain role.
      // Values of setMaxInactiveInterval exceeding 1440 minutes are
      // treated as one day (1440 minutes).

      if (userName == "admin") {
        request.getSession().setMaxInactiveInterval(30);
      }
      // ***********************************************************
      return GlideUser.getUser(userName);
  }
};
```
Session timeout can also be set according to IP address.

```javascript
var Login = Class.create();
Login.prototype = {
  initialize : function() {
  },

  process : function() {
    // the request is passed in as a global
    var userName = request.getParameter("user_name");
    var userPassword = request.getParameter("user_password");

    var authed = GlideUser.authenticate(userName, userPassword);
    if (authed) {

      // customization - if the user is logging in from a particular IP
      // range starting with XXX.XXX you can implement your own
      // session timeout algorithm here by checking the login IP
      //
      // Values of setMaxInactiveInterval exceeding 1440 minutes are
      // treated as one day (1440 minutes).

      var clientIP = gs.getSession().getClientIP().toString();
      // if client IP starts with specified range
      if (clientIP.indexOf('XXX.XXX') == 0) {
        // set to 10 hours
        request.getSession().setMaxInactiveInterval(60 * 60 * 10);
      }
    }

    return GlideUser.getUser(userName);
  },

  this.loginFailed();

  return "login.failed";
},

loginFailed : function() {
  var message = GlideSysMessage.format("login_invalid");
  var gSession = GlideSession.get();
  gSession.addErrorMessage(message);
}
```

```javascript
gs.include("PrototypeServer");
```
Strengthen password validation rules

You can customize password strength validation rules for the change password screen by overriding the installation exit associated with password validation.

1. Navigate to **System Definition > Installation Exits**.
2. Locate **ValidatePassword** (inactive by default) and **ValidatePasswordStronger** (active by default, starting with the Helsinki release).
3. The **ValidatePasswordStronger** script (below) is a sample script that overrides the **ValidatePassword** script by using regular expressions to require that passwords be a minimum of 8 characters long, contain a numeric digit, and contain mixed-case letters.

```javascript
var ValidatePasswordStronger = Class.create();
ValidatePasswordStronger.prototype = {
  process : function() {
    var user_password = request.getParameter("user_password");
    var min_len = 8;
    var rules = "Password must be at least " + min_len + " characters long and contain a digit, an uppercase letter, and a lowercase letter.";
    if (user_password.length() < min_len) {
      gs.addErrorMessage("TOO SHORT: " + rules);
      return false;
    }
    var digit_pattern = new RegExp("[0-9]", "g");
    if (!digit_pattern.test(user_password)) {
      gs.addErrorMessage("DIGIT MISSING: " + rules);
      return false;
    }
    var upper_pattern = new RegExp("[A-Z]", "g");
    if (!upper_pattern.test(user_password)) {
      gs.addErrorMessage("UPPERCASE MISSING: " + rules);
      return false;
    }
    var lower_pattern = new RegExp("[a-z]", "g");
    if (!lower_pattern.test(user_password)) {
      gs.addErrorMessage("LOWERCASE MISSING: " + rules);
      return false;
    }
    return true; // password is OK
  }
}
```

The script variable created by `Class.create()` must have the same name as the installation exit itself – “ValidatePasswordStronger” in this example. The script implements the `process()` function which returns true if the password is acceptable and false if the password must be revised. The `gs.addErrorMessage` function can be used to return error messages on the change password screen. You can try this Installation Exit in your instance by checking the active flag and updating the record. Be sure and clear the cache after doing this so the change is recognized.
Also, keep in mind that modifying these scripts will not change the default ServiceNow behavior: Blank passwords are still prohibited by default and the password and verify password fields must match.

To test, check the **Password needs reset** box on a user record then login with that user. Validation will occur at the point that the user attempts to set the password. Validation does not apply when an admin user updates the password in the user record directly (the admin can put anything in the password field).

**Note:** The change password screen only applies to customers who do not use single sign on and are not integrated with their local LDAP.

### Example: The default self-service Password Reset process

The default self-service Password Reset process enables a user to reset the password without assistance from service desk agents.

#### The default self-service password reset flow

1. If a user does not remember the password, the user can click the **Forgot Password?** link on the login screen.

   ![Login Screen](image)

2. The Password Reset application starts. On the **Identity** page, the user identifies himself or herself by entering a **Username**.

   ![Identity Page](image)

3. On the **Verify** page, the user proves that they are the person who is associated with the username. In this example, the user enters the email address that is associated with the user profile. The admin can configure a different verification method or can require additional verifications, for example, a personal question that only the user can answer.
4. The Reset page tells the user to check email for instructions.

5. The user opens the email and clicks the here link to reset the password. The link is valid for a period that you specify (use the password_reset.request.expiry property).

6. The Reset Password page guides the user to reset the password.
The default self-service Password Reset process (com.glideapp.password_reset) defines:

- The URL that specifies where users are redirected when they click **Forgot Password**. By default this value is `/$pwd_reset.do?sysparm_url=ss_default`, which is the same value used in the `glide.security.password_reset.uri` property. In previous releases, this value was set to `/reset_password.do`.
- The **Enable Password Reset URL** option, which specifies that the user should receive an email with a link to reset their password after they click **Forgot Password**.
- The **Personal Data - Enter Email Address** verification flow that specifies the three-step password reset flow.

See [Configure your Password Reset process](#) for instructions on accessing this form and configuring the fields.

**Note:**
- This feature works for locally authenticated users who enter the username and password specified in their user record. Users logging in to the instance via an SSO solution or an LDAP integration cannot reset passwords with self-service Password Reset.
- The end user must enable and configure notification preferences. See [Subscription-based notifications](#). Administrators can [modify the email that is sent to the end user](#).

---

### Change settings for the Remember me check box and cookie

When the **Remember me** check box is selected at login, a cookie is stored on the user's computer. This cookie automatically authenticates the user upon subsequent visits.

If the user logs out, the cookie is destroyed. The default value of the **Remember me** check box is controlled by one property, and whether or not the check box appears on the login page is controlled by a different property.

#### Change the default value of the Remember me check box

You can change the default value of the **Remember me** check box.

**Role required:** admin

1. Navigate to **System Properties > UI Properties**.
2. Locate the **Default value of "Remember me" checkbox on login page** property (`glide.ui.remember.me.default`).
3. To set the default value of the **Remember me** check box to **No**, clear the property check box.
4. To restore the default value of the **Remember me** check box to **Yes**, select the property check box.

#### Remove the Remember me check box

You can remove the **Remember me** check box so users do not have access to this feature.

**Role required:** security_admin

1. Elevate your role to security_admin.
3. Locate the Remove "Remember me" checkbox from login page property (glide.ui.forgetme).
4. Select the property check box.
   This setting removes the Remember me check box, invalidates existing cookies, and disables Remember me functionality entirely.
5. To restore the Remember me check box to the login page, clear the property check box.

**IP range based authentication**

One way to secure a web-based application is to restrict access based on the IP address.

You can block access to a specific address or range of addresses that you suspect belong to malicious individuals. The instance allows you to control access by IP address.

**Notes and Limitations:**

- The system won't let you lock yourself out, so if you try to add a rule such that your current address would be locked out, the system warns you and refuses your insert.
- If you're inside of a corporate intranet, be very careful about setting up your IP rules. The IP address you see on your own computer (like 10.10.10.25) generally bears no relationship to the IP address you'll actually appear as out on the internet. Your company likely proxies and/or NATs your address into a predictable set of outbound addresses which you'll likely need to ask your network team about.
- A user whose access is restricted based on an access rule gets a 403 error on their browser.
- Restricted users do not use transactions, semaphores, or count towards any server resource counts.
- This feature does not supersede or override your existing access control rules if, for example, you're running a VPN to our data center. It's an additional check that must be met in addition to any access controls we may have set up on your PIX.
- Allow rules always supersede deny rules. So if an address is both allowed (by one rule) and denied (by a second rule) it is, in fact, allowed.
- Asterisks and CIDR blocks are not currently supported.
- Regarding forwarded proxy addresses, the allow rules are applied to each address in the chain and then the deny rules are applied to each address in the chain if none of the allow rules matched.

**Define IP Address access control**

By default the list is empty, meaning that there are no particular restrictions on access to your instance.

Role required: admin

Navigate to System Security > IP Address Access Control to see a list of your IP access controls. You may need to activate this module.

You can add these types of rules:

- Allow: any IP address in this range is allowed to connect to this instance.
- Deny: any IP address in this range is not allowed to connect to this instance unless it is listed in an allow rule.

**Note:** These rules also affect transferring update sets. To ensure that IP Address Access Control does not cause update sets to fail, add the target instance as an exception on the source instance.
Example 1: Block a particular range
An example of how to block a particular range.

Let’s say we want to block a particular range of IPs, say 64.236.16.0 – 64.236.16.255. Click “new” to add a new rule. Then fill it in as follows. Range Start and Range End must be specific IP addresses as seen in the examples, without asterisks or CIDR blocks.

**Access Control**

<table>
<thead>
<tr>
<th>Type</th>
<th>Deny</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range start</td>
<td>64.236.16.0</td>
</tr>
<tr>
<td>Range end</td>
<td>64.236.16.255</td>
</tr>
</tbody>
</table>

Deny range

Example 2: Block everyone except a particular range
An example of how to block everyone except a particular range.

For example, you want to allow addresses between 64.236.16.0 and 64.236.16.255 to connect, but want to deny all other addresses. To do this, designate two rules, one to allow the designated range, and a second to deny addresses outside the range.

Click **New** and add a new rule. Then fill it in as follows.

**Access Control**

<table>
<thead>
<tr>
<th>Type</th>
<th>Allow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range start</td>
<td>64.236.16.0</td>
</tr>
<tr>
<td>Range end</td>
<td>64.236.16.255</td>
</tr>
</tbody>
</table>

Allow range

Add the deny rule.

**Access Control**

<table>
<thead>
<tr>
<th>Type</th>
<th>Deny</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range start</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Range end</td>
<td>255.255.255.255</td>
</tr>
</tbody>
</table>

Deny all
Find denied IP addresses

Denied IP addresses are by default not viewable from the system logs. However, you can still find them in the instance's node log files.

Role required: admin

Log entries for blocked IP address appear as follows:


2. Browse the logs by criteria, such as time period and message.
3. You can also download log files when you know which log you are looking for, by navigating to System Logs > Utilities > Node Log File Download.

Using a nonce with single sign-on

You can implement a nonce to be used with single sign-on digest authentication. The usage of a nonce prohibits a malicious user from performing a replay attack in order to log into your system.

To use a nonce with the unencrypted token or encrypted token methods of single sign-on, these steps apply with only a few minor changes.

Note: The nonce is used only for login requests, not for any other type of request. If the system receives a nonce value after login, the nonce is not consumed.

Nonce process flow

When a customer has implemented the digested token Single Sign-on and wishes to add the security of a nonce, they follow a certain process flow.

1. A user logs into the customer's portal.
2. The customer generates the required SSO parameters and appends a random nonce to the end. For example, if the customer were forwarding the authentication response via the query string, it may look something like this:

   SM_USER=itil&DE_USER=V1QuWMmxSfBgfRS099X0cAJo5Q=&NONCE=1407743018

The instance receives this request and retrieves the authentication variables. Before attempting to verify the integrity of the authentication response, the instance checks the nonce against an internal table (u_authentication_nonce) to verify that it does not yet exist. If the nonce does not exist within that table, the nonce is then added to the table and the authentication process is allowed to continue. However, if that nonce value already exists within the table, the authentication attempt is cancelled and an error code of failed_missing_requirement is returned, which typically takes the user back to the login page.

Implement a nonce

Implementing a nonce is fairly straightforward when these steps are followed:

- Create a system property called glide.authenticate.header.nonce_key and set its value to whatever variable name you're using for the nonce, such as NONCE or NCE.
- Create a new table called u_authentication_nonce. Add a field to the table called u_nonce.
- Go to **System Properties > Installation Exits** and create an item called *DigestSingleSignOnNonce* which overrides *ExternalAuthentication* (see image below).

![Installation Exit](image)

- Add the following code to the script portion of the newly created *DigestSingleSignOnNonce*.

```javascript
gs.include("PrototypeServer");

var DigestSingleSignOnNonce = Class.create();
DigestSingleSignOnNonce.prototype = {
    process : function() {

        var headerKey = GlideProperties.get("glide.authenticate.header.key", "SM_USER");
        var headerDigestKey = GlideProperties.get("glide.authenticate.header.encrypted_key", "DIGEST");
        var headerNonceKey = GlideProperties.get("glide.authenticate.header.nonce_key", "NCE");
        var fieldName = GlideProperties.get("glide.authenticate.header.value", "user_name");
        var fkey = GlideProperties.get("glide.authenticate.secret_key");

        // Look in the Headers
        var data = request.getHeader(headerKey);
        var encdata = request.getHeader(headerDigestKey);
        var nonce = request.getHeader(headerNonceKey);

        // If not, then check the URL Parameters
        if (data == null || encdata == null || nonce == null) {
            data = request.getParameter(headerKey);
            encdata = request.getParameter(headerDigestKey);
            nonce = request.getParameter(headerNonceKey);
        }

        // then maybe its a cookie
        if (data == null || encdata == null || nonce == null) {
            var cookies = request.getCookies();
            data = GlideCookieMan.getCookieValue(cookies, headerKey);
            encdata = GlideCookieMan.getCookieValue(cookies, headerDigestKey);
            nonce = GlideCookieMan.getCookieValue(cookies, headerNonceKey);
        }
    }
```
if (data != null && encdata != null && nonce != null) {
    try {

        // Replace all spaces with plus(+)s, converted in url
        encdata = encdata.replaceAll(' ', '+');

        // ----- Encrypt the username|nonce
        var key = this.getDigest(data + "|" + nonce, fkey);

        // Check for match of received encoded data
        // and your encoding of user name
        if (encdata == key) {
            var ugr = new GlideRecord("sys_user");
            ugr.initialize();
            if (!ugr.isValidField(fieldName)) {
                GlideLog.warn("External authorization is set to use field: "+
                    fieldName + " which doesn't exist");
                return "failed_missing_requirement";
            }
            ugr.addQuery(fieldName, data);
            ugr.query();
            if (!ugr.next()) {
                var userLoad = GlideUser.getUser(data);
                if (userLoad == null) {
                    return "failed_authentication";
                }
                ugr.initialize();
                ugr.addQuery(fieldName, data);
                ugr.query();
                if (!ugr.next()) {
                    return "failed_authentication";
                }
                if (this.processNonce(nonce)) {
                    var userName = ugr.getValue("user_name");
                    return userName;
                } else {
                    return "failed_authentication";
                }
            } catch (e) {
                gs.log(e);
                return "failed_authentication";
        }

        // Encoded data didn't match recieved Encoded data
    } else {
        return "failed_missing_requirement";
    } catch (e) {
        gs.log(e.toString());
    }
}

getDigest : function(data, fkey) {
    try {
        // default to something JDK 1.4 has
        var MAC_ALG = "HmacSHA1";
        return SncAuthentication.encode(data, fkey, MAC_ALG);
    } catch (e) {
        gs.log(e.toString());
    }
}
throw 'failed_missing_requirement';
}

processNonce : function( sentNonce ) {
  var ngr = new GlideRecord("u_authentication_nonce");

  ngr.addQuery("u_nonce", sentNonce);
  ngr.query();
  if (ngr.next()) {
    gs.log("This SSO entry has already been processed! (Nonce: " + sentNonce + ")");
    return false;
  }
  var ngrNew = new GlideRecord("u_authentication_nonce");
  ngrNew.initialize();
  ngrNew.u_nonce = sentNonce;
  ngrNew.insert();
  gs.log("Inserted new nonce: " + sentNonce);
  return true;
}

- Once you’ve saved your new installation exit, go to the DigestSingleSignOn installation exit and make sure that it is set Active=false.

Your instance should now be configured to implement a nonce.

**ServiceNow access control**

This SNC Access Control plugin (com.snc.snc_access_control) enables customers to control which ServiceNow employees may access their instance, and when.

When the plugin is first activated, ServiceNow employees cannot log into the customer’s instance. Any currently logged-in ServiceNow employees remain logged in. The customer creates records in the SNC Access Control table that grant access to specific SNC employees or all employees.

**Login security**

Security for authorized ServiceNow employee logins to customer instances employs encrypted tokens generated by a secure server. Only properly authenticated ServiceNow employees are granted access to a customer instances. Without the SNC Access Control plugin, the security server ensures that access rights are enforced on hi.service-now.com. When the plugin is enabled, the encrypted login tokens must match names in the plugin-provided access list, using the criteria defined in those records. This method of authentication enables our customers to determine precisely which ServiceNow employees may access their instances, and when these employees may do so.

The architecture chosen for this system has several features designed to enhance security for our customer’s instances:

- **Security server:** The security server is a locked-down, Linux host that can only be accessed by ServiceNow security personnel. This server is the only system that has access to the critical private encryption key necessary to produce the login tokens. By using this compartmentalization (a standard security practice), the private key is protected, even in the unlikely event that the HI instance is compromised by an attacker.

- **Synthetic users:** The facility on customer instances that enables authorized ServiceNow employees to log into their instance does not require an account to be provisioned on that
instance. There is no user record provisioned, and no permanent or persisted credentials. Instead, a synthetic user is created for each ServiceNow employee logon. This user exists only in memory and provides no ongoing privileges. ServiceNow can deauthorize any ServiceNow employee at any time, and if the SNC Access Control plugin is enabled, our customers can also deauthorize any ServiceNow employee at any time.

- **Tokens:** The security tokens are specific to a customer instance and a particular ServiceNow employee. In addition, the mechanism that generates the tokens only works with actual ServiceNow employee logins to HI, not impersonated users. Once a security token is generated, it may only be used by a specific ServiceNow employee to log into a particular customer instance.

- **Time limit:** Security tokens expire four hours after they are generated. This limits the utility of hijacked tokens, which can only be used during this short window.

- **Logging:** Logins by ServiceNow employees to customer instances are recorded as a login event, and every action taken by the logged-in ServiceNow employee is added to both the transaction log (in the database) and the instance log (on the file system, which is inaccessible to most ServiceNow employees). ServiceNow employee logins and actions are readily identifiable, since the user names all end in @snc (like frodo.baggins@snc). This provides our customers with easy-to-use, robust, and reliable security logging for non-employee access.

When a ServiceNow employee wants to log into a customer instance, the security processing flow is as follows:

1. A ServiceNow Support technician requests a login for the customer’s instance through hi.service-now.com.
2. HI checks that the technician has the proper role authorizing access to customer instances.
3. If the user has the proper role, HI sends the request for access to the Security Server.
4. The Security Server verifies that the request came from HI’s IP address, and evaluates the request (user, role, and IP address of the requester). If the request is valid, the Security Server approves it and constructs a token. This token contains the user name, roles on the customer instance, the instance ID, and the time (the start of the 4-hour token life span). Finally, the Security Server encrypts the token with the private encryption key.
5. The Security Server sends the encrypted token to HI.
6. HI sends the token to the Support technician’s browser.
7. The Support technician’s browser initiates a login into the customers instance, using the special user name ending with @snc.
8. The customer’s instance uses the public key to decrypt the token. To verify the token, the instance matches it to the user name supplied in the previous step, the instance ID, and the authorized time window. If the SNC Access Control plugin is enabled, the instance verifies that the user is:
   - Listed
   - Active
   - Configured to access the instance in the current time window
9. If the user is authenticated, the customer instance creates a *synthetic user* in memory with the given roles. This user does not persist after the time limit expires, the user logs off, or the instance is restarted.
Audit logging

The following logging tracks logins and activity by ServiceNow employees:

<table>
<thead>
<tr>
<th>Logging Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event logs</td>
<td>The event logs show all ServiceNow logins to a customer instance.</td>
</tr>
<tr>
<td>Transaction logs</td>
<td>The transaction logs show all activity on the instance, including any efforts to delete logs.</td>
</tr>
</tbody>
</table>

Request ServiceNow access control

Customers must request the SNC Access Control plugin (com.snc.snc_access_control) from HI.

Role required: admin

1. In the HI Service Portal, click **Service Requests > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
</tbody>
</table>
Specify the date and time you would like this plugin to be enabled

Date and time must be at least 2 business days from the current time.

**Note:** Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.

<table>
<thead>
<tr>
<th>Reason/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Configure ServiceNow access control**

Configure an access control record to specify one or more ServiceNow employees who have permission to log in your instance.

Role required: admin

1. Navigate to **System Security > SNC Access Control**.
2. Click **New**.
3. Fill in the form fields (see table).
4. Click **Submit**.

**SNC Access Control form fields**

<table>
<thead>
<tr>
<th>Form fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Names each ServiceNow employee who has permission to log in this instance. The names are expressed as firstname.lastname in lower case letters separated by a period (e.g., john.smith). Each name must have a corresponding user record in hi.servicenow.com. If more than one ServiceNow employee has permission to log in this instance, enter multiple names and separate them by commas. To allow all ServiceNow employees login rights to access the instance, enter an asterisk (<em>) in place of the name. For clarity, if you intend on restricting ServiceNow employee access to the instance, then the values in the Name field must not have an asterisk (</em>) anywhere in the field.</td>
</tr>
<tr>
<td>Reason</td>
<td>Human-readable field that describes why permission is being granted. This field is optional.</td>
</tr>
</tbody>
</table>
### Certificates

Your instance requires certificates to establish secure connections and validate signatures. Certificates are used for features such as:

- **LDAP**
- **Outbound web services mutual authentication**
- **Web services security**
- **Mid Server**

In order to use a certificate, you need to generate or purchase a certificate for the secured server or client and upload it to an instance.

#### LDAP certificates

An SSL certificate is required for the instance to establish an LDAP over SSL (LDAPS protocol) connection with an LDAP server. The instance accepts two types of LDAP certificates:

<table>
<thead>
<tr>
<th>Certificate</th>
<th>Type</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP server certificate</td>
<td>Any supported type</td>
<td>All LDAP configurations</td>
</tr>
<tr>
<td>LDAP client certificate</td>
<td>Java keystore type</td>
<td>Mutual authentication</td>
</tr>
</tbody>
</table>

If there are multiple server certificates, the instance tries each server certificate in turn until the LDAP server allows the connection. If you use multiple LDAP servers, be sure to include the SSL certificate for each LDAP server.

If your LDAP server requires **mutual authentication**, which requires the client to present a certificate in addition to the server, you must also provide your LDAP server’s client certificate in a Java keystore type certificate.

#### Certificate criteria

A valid certificate must meet these criteria:

- The certificate can have a key size up to 2048 bits.
- The certificate must have one of these file extensions:
<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DER</td>
<td>The Distinguished Encoding Rules format is a binary message transfer syntax. This format also supports the .CER and .CRT file extensions.</td>
</tr>
<tr>
<td>CER</td>
<td>Certificate file extensions for certificates using the Distinguished Encoding Rules format.</td>
</tr>
<tr>
<td>CRT</td>
<td>Certificate file extensions for certificates using the Distinguished Encoding Rules format.</td>
</tr>
<tr>
<td>PEM</td>
<td>The Privacy Enhanced Mail format is a base-64 encoded DER certificate enclosed between &quot;-----BEGIN CERTIFICATE-----&quot; and &quot;-----END CERTIFICATE-----&quot; text strings.</td>
</tr>
</tbody>
</table>

**Certificate trust**

By default, your instance trusts the Certificate Authority (CA) for a certificate. This ensures the instance accepts self-issued certificates. If you do not want to trust all certificates by default, set the following general security property to false: `com.glide.communications.trustmanager_trust_all`.

**Generate an LDAP client certificate**

Generate an LDAP client certificate for mutual authentication using OpenSSL. The final output is a PKCS#12 certificate stored within a Java keystore.

Role required: admin

See the [OpenSSL documentation](https://www.openssl.org/) for more information about generating certificates. These steps assume you have access to OpenSSL.

Enter these commands in a command line interface.

1. Generate a self-signed client certificate.
   For example, this command creates a client certificate test1-cert.crt based on the test1-key.key private key.
   
   ```
   openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout test1-key.key -out test1-cert.crt
   ```

2. Convert both the certificate file and private key to PKCS#12 (a file with a .pfx or .p12 extension).
   For example, this command converts the client certificate and private key to a PKCS#12 certificate called test1-certificate.pfx.
   
   ```
   openssl pkcs12 -export -out test1-certificate.pfx -inkey test1-key.key -in test1-cert.crt
   ```

3. Generate the Java Key Store and import the pkcs12 file into it.
   For example, this command imports the certificate to the test1.jks Java keystore.
   
   ```
   keytool -importkeystore -srckeystore test1-certificate.pfx -srcstoretype PKCS12 -destkeystore test1.jks
   ```

4. **Upload the certificate** in the keystore file (test1.jks) to the instance.

   **Upload a certificate to an instance**
Generate a server certificate

You can use keytool to generate a new Java keystore file, create a certificate signing request (CSR), and import the private key, public certificate pair, and signed certificates into the keystore.

Role required: admin

See the Java keytool documentation for more information on generating keys and CSRs.

Enter these commands in a command line interface:

1. Generate a Java keystore and key pair.
   For example, this command creates a keystore called my.keystore and generates a private key called mydomain within the keystore.
   
   ```
   keytool -genkey -alias mydomain -keyalg RSA -keystore my.keystore
   ```

2. Generate a CSR for an existing Java keystore.
   For example, this command generates a CSR called mydomain.csr or the mydomain key.

   ```
   keytool -certreq -alias mydomain -keystore my.keystore -file mydomain.csr
   ```

3. Import a root or intermediate certificate authority, or CA, certificate to the Java keystore.
   For example, this command imports the CA certificate for Thawte. This command assumes that Thawte was the CA that signed the CSR.

   ```
   keytool -import -trustcacerts -alias root -file Thawte.crt -keystore my.keystore
   ```

4. Import a signed primary certificate to the Java keystore.
   For example, this command imports the signed certificate mydomain.crt into the keystore.

   ```
   keytool -import -trustcacerts -alias mydomain -file mydomain.crt -keystore my.keystore
   ```

5. Upload the certificate in the keystore file (my.keystore) to the instance.

   **Upload a certificate to an instance**

**Upload a certificate to an instance**

You can add a certificate to the instance from the Certificates module.

Role required: admin

**Note:** When a certificate is updated on the ADFS server, you also need to upload an updated certificate to the instance.

1. Navigate to **System Definition > Certificates**.
2. Click **New**.
3. Fill in the following fields (see table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify a unique name for the certificate.</td>
</tr>
<tr>
<td>Expiration notification</td>
<td>(Optional) Select whether you want to send a notification when the certificate is about to expire.</td>
</tr>
<tr>
<td>Active</td>
<td>Select whether the instance should use this certificate for secure communications and signing requests.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>(Optional) Enter a text description of the certificate such as the requester or server name.</td>
</tr>
<tr>
<td>Format</td>
<td>Select the certificate format. The instance supports the PEM and DER formats.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the certificate container. The instance recognizes certificates from trust stores, Java key store, and PKCS#12 keystores.</td>
</tr>
<tr>
<td>PEM Certificate</td>
<td>Enter the base-64 encoded PEM-formatted text containing the DER certificate. The instance decodes the certificate to populate the Valid from, Expires, Expires in days, Issuer, and Subject fields.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

   During the upload, the module extracts and displays the certificate’s read-only properties in these fields:
   - Valid from date
   - Expiration date
   - Issuer
   - Subject of the certificate

5. Click **Validate Stores/Certificates** to check if the certificate is correct. If the instance encounters any errors with the certificate or keystore, it displays an error message.

### Upload a trusted server certificate

By uploading the service provider’s trusted server certificate, the instance ensures it is connecting to a valid and secure service.

Role required: admin

The instance validates outbound Web Service calls by using the certificate provided by the service provider.

1. Create a new Certificate record with the type “Trust Store Cert”.
2. Do one of the following actions:
   - Attach the service provider’s DER formatted certificate.
   - Copy and paste the service provider’s PEM format certificate into the **PEM Certificate** field.
Web service security

Enforce security using basic authentication, mutual authentication, or WS-Security.

Basic Authentication

To enforce basic authentication on each request for a WSDL document or posting of SOAP messages, you may set the property `glide.basicauth.required` to `true`. If you do so, each WSDL or SOAP request would have to contain the "Authorization" header as specified in the Basic Authentication protocol. Because the request is non-interactive, the Authorization header is always required during a request.
Supplying basic authentication information whether or not it is required has the added advantage that the data created or updated as a result of the Web Service invocation is done on behalf of the user supplied in the basic authentication credentials. As an example, when creating an Incident record, the journal fields have the user id of the basic authenticated user, instead of the default Guest user.

To make the authorization header ignore the capitalization rules, use the glide.security.script.include.name.case.insensitive.list property. You can modify this property in the System Properties (sys_properties) table and add the script includes that are necessary to process the authentication. By default, this property has these values:

- BasicAuth
- CustomAuth

Add other script includes as needed.

To supply basic authentication when using Perl and the SOAP::Lite libraries, you can implement the following function:

```perl
sub SOAP :: Transport :: HTTP :: Client :: get_basic_credentials { return 'user_name' => 'password'; }
```

- When using C# .NET VS 2005 or older, you can take advantage of the Credentials object, for example:

```csharp
System.Net . ICredentials cred = new System.Net . NetworkCredential ( "user_name", "password" );

service . ServiceNow proxy = new service . ServiceNow ();
service . get getService = newservice . get ();
service . getResponse getResponseService = new service . getResponse ();

try {
    proxy . Credentials = cred;
    getService . sys_id = "bf522c350a0a140701972dbf876f1610";
    getResponseService = proxy . get (getService );
} catch (Exception ex ) { }
```

- When using C# .NET VS 2008, you can take advantage of the ClientCredentials object, for example:

```csharp
Demo_Incident. ServiceNowSoapClient client = new Test08WebService . Demo_Incident . ServiceNowSoapClient ();
client . ClientCredentials . UserName . UserName = "admin";
client . ClientCredentials . UserName . Password = "admin";

Then in your app.config file look for the following and change "None" to "Basic":

```xml
<transport clientCredentialType= "None" proxyCredentialType= "None" realm= "" />
```

- When using VB .NET taking advantage of the Credentials object would look like the following:

```vb
Sub Main()
    Dim cred As New System.Net.NetworkCredential("user_name", "password")

    Dim proxy As New VB_Democm.incident.ServiceNow
    Dim getIncident As New VB_Democm.incident.get
    Dim getResponse As New VB_Democm.incident.getResponse
```
proxy.Credentials = cred
getIncident.sys_id = "[your sysID here]"
getResponse = proxy.get(getIncident)
End Sub

The resulting response when Basic Authentication is turned on and no credentials are supplied looks like this:

```html
<html>
<head>
<title>Apache Tomcat/5.0.28 - Error report</title>
</head>
<body>
<h1>HTTP Status 401 - </h1>
<p><b>type</b> Status report</p>
<p><b>message</b> <u></u></p>
<p><b>description</b> This request requires HTTP authentication ().</p>
</body>
</html>
```

**Setting up mutual authentication**

Mutual authentication establishes trust by exchanging secure sockets layer (SSL) certificates.

Before connecting to a server, the client requests an SSL certificate. The server responds by requesting that the client send its own certificate. Both respond by validating the certificates and sending acknowledgments before initiating an HTTPS connection.

Administrators do the preliminary work of setting up a keystore and generating certificates before certification requests are fulfilled.

**Warning:** This feature only enables mutual authentication on outbound https connections. The instance does not support mutual authentication on inbound requests.

**Creating the Key Store**

The instance currently supports uploading a Java keystore file to contain the private key, public certificate pair, and its signed certificates.

The following steps use commands that allow you to generate a new Java Keytool keystore file, create a certificate signing request (CSR), and import certificates. Any root or intermediate certificates need to be imported before importing the primary certificate for your domain. Type these commands in a command line interface.

1. Generate a Java keystore and key pair.

   ```bash
   keytool -genkey -alias mydomain -keyalg RSA -keystore my.keystore
   ```
2. Generate a CSR for an existing Java keystore.

   keytool -certreq -alias mydomain -keystore my.keystore -file mydomain.csr

3. Import a root or intermediate certificate authority CA certificate to an existing Java keystore.

   keytool -import -trustcacerts -alias root -file Thawte.crt -keystore my.keystore

4. Import a signed primary certificate to an existing Java keystore.

   keytool -import -trustcacerts -alias mydomain -file mydomain.crt -keystore my.keystore

**Setting up the Key Store**

Now that the key store has been created, it can be uploaded to the Certificates table. On the System Definition > Certificates page, click New and set the following fields:

- Enter a certificate Name.
- Store the key store as Active.
- Set Type = Java Key Store.
- Provide a Key store password. This is the password that was used to create the keystore.

Click Submit to create the Java Key Store entry.

**Keystore**

**Specifying a Trusted Server Certificate**

During an outbound SSL connection, which is an HTTPS Web Service call, it is possible to specify a certificate provided by the service provider that ensures the validity of the service provider during the SSL connection. For example, a browser attempting to connect to a secure service which identifies itself by a certificate.

By uploading the trusted server certificate, ServiceNow ensures that the service it is connecting to is valid and secure.

Create a new Certificate entry with the type of "Trust Store Cert" and attach a DER formatted certificate, or copy and paste its PEM format into the PEM Certificate field.
Processing Mutual Authentication Requests

**Certificate Exchange**

- When a client requests the server certificate for authentication, a certificate signing request (CSR) is generated.
- To respond to a CSR, the server generates two unique cryptographic keys: A public key, which is used to encrypt messages to the server and a private key, which is used to decrypt messages. Both keys are kept in the Key Store.
- Keys are used to decrypt the client secure messages so they can be read by the server. Any outgoing connection that is going to be HTTPS verifies the certification by checking the Key Store, offering its public certification, and uses the trust store certificates to verify mutual trust back.
- To complete the secure link between the client and the server, the server matches the certificate to the corresponding private key. Because only the server has access to the private key, the server can decrypt the data from the client.

Here is an example of a command that registers MYHTTPS with the `com.glide.certificates.DBKeyStoreSocketFactory` socket factory on port 443. The database key store factory is used during the SSL exchange process to offer a client certificate for mutual authentication.

```plaintext
glide.httpclient.protocol.myhttps.class = "com.glide.certificates.DBKeyStoreSocketFactory"
glide.httpclient.protocol.myhttps.port = "4433"
```

Having the above configuration affects any outbound `myhttps://host.domain.com/target` URL to use the custom socket factory and exchange certificates during SSL.

**Note:** Overriding the default HTTPS protocol socket factory affects every outbound HTTPS connection. This is usually undesirable.
The server responds by sending a certificate. Is this a certificate that the client accepts? If yes, a message is sent to the server accepting the certificate and a secure channel is initiated. If the certificate is not accepted, it may mean that the root authority is needed for certification.

**WS-Security**

Support for WS-Security 1.1 in the form of WSS X.509 Token Profile and WSS Username Token Profile is available for incoming SOAP requests.

The configuration to use WS-Security is separate from the requirement to enforce Basic Authentication, and is enforced when the SOAP envelope contains the WS-Security headers.

**WS Security Profiles**

The **WS Security Profile** module lists the WS-Security profiles that are currently in effect. The **Order** of the profiles indicates the order of authentication that is checked, all profiles are checked during the incoming SOAP request, when a profile fails authentication, it does not execute the next one in order. The **Bind session** check box indicates which profile to use to assume the session’s identity, there can only be one “bound” session.

**WS Security List**

**WSS X.509 Token Profile**

Use the X.509 authentication framework as defined by the Web Services Security: SOAP Message Security specification. An X.509 certificate specifies a binding between a public key and a set of attributes that includes (at least) a subject name, issuer name, serial number, and validity interval. An X.509 certificate is used to validate a public key that is used to sign the incoming SOAP message. Upload the certificate in the **Certificate** module and reference it in the **X509 Certificate** field. If this is a bound session, select the user to impersonate when the WS-Security authentication succeeds.

See the following document: [http://www.oasis-open.org/committees/download.php/16785/wss-v1.1-spec-os-x509TokenProfile.pdf](http://www.oasis-open.org/committees/download.php/16785/wss-v1.1-spec-os-x509TokenProfile.pdf)
WSS Username Token Profile

In addition to specifying the X.509 Token Profile, a UsernameToken can also be supplied in the SOAP request. A UsernameToken is used as a means of identifying the requester by "username", and optionally using a password (or shared secret, or password equivalent) to authenticate that identity to the instance. The UsernameToken profile cannot be used independent of the X.509 Token Profile currently.

1. Authenticate using the Username of the incoming SOAP request to lookup a User by the specified User field to match UserName value. The password value in the incoming Username Token is used to authenticate the request. When the Bind session option is selected, the user that authenticates successfully is used for the session.

2. Authenticate using a separate pair of user name / password that is unrelated to users in the User table. When the Bind session option is selected, the user that is specified in the Run as user field is used for the session.

Example WS-Security SOAP Envelope Headers

**Note:**

This sample has been formatted with line returns to fit the content into the frame.

```
```
HTML sanitizer

Remove unwanted code and protect against security concerns such as cross-site scripting attacks by sanitizing HTML markup in HTML fields and translated HTML fields.

The HTML sanitizer works by checking the built-in white list for markup that you always want to preserve. The sanitizer provides the HTMLSanitizerConfig script include that administrators can use to modify the built-in white list. Items can also be added to the black list, which overrides the white list, to remove HTML markup.

The following types of items can be added to white and black lists:

- Global attributes
- Any HTML elements

Note: By default, URL attributes like href and src support only these protocols:

- http
- https
- mailto
- data

For example:

```html
<a href="https://community.servicenow.com/community">Community</a>
```
Configure urlAttributes and the protocols

You can configure urlAttributes and their protocols in the HTMLSanitizer script include. For example:

```javascript
HTML_WHITELIST : {
  urlAttributes: { "protocols" : [ "file", "notes" ] },
  -
  -
}
```

Because `notes` is white listed in the example above, this URL is not sanitized:

```html
<a title="Lotus" href="Notes://ABC/X575C90019DE33/ABC594DCB76D86EB4925653E0011C4C1/Z290B7E2D33964749257EEA003456FD">Lotus</a></p>
```

The Default White List

```javascript
BUILTIN_HTML_WHITELIST : {
  globalAttributes:{ attribute:['id','class','lang','title','style'],
    attributeValuePattern:{}},
  label:{ attribute:['for']},
  font:{ attribute:['color','face','size']},
  a:{ attribute:['href','nohref','name','shape']},
  img:{ attribute:['src','name','alt','border','hspace','vspace','align','height','width'],
    table:{ attribute:['border','cellpadding','cellspacing','bgcolor','background','align','noresize','height','width','summary','frame','rules']},
    th:{ attribute:['background','biclor','abbr','axis','headers','scope','nowrap','height','width','align','off','char','colspan','rowspan']},
    td:{ attribute:['background','biclor','abbr','axis','headers','scope','nowrap','height','width','align','off','char','colspan','rowspan']},
    tr:{ attribute:['background','height','width','align','valign','char off','char']},
    thead:{attribute:['align','valign','char off','char']},
    tbody:{attribute:['align','valign','char off','char']},
    tfoot:{attribute:['align','valign','char off','char']},
    colgroup:{attribute:['align','valign','char off','char','span','width']},
```

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Activate HTML sanitizer

The HTML sanitizer provides a property to enable or disable the sanitizer for all HTML fields in the system.

Role required: admin

By default, the property is set to true for new instances.

1. In the navigation filter, enter `sys_properties.list`.
2. Set the properties `glide.html.sanitize_all_fields` and `glide.translated_html.sanitize_all_fields` to `true`. If the properties do not exist in the System Properties table, you can add them.

Configure HTML sanitizer

You must modify a script include to make configuration changes to the HTML sanitizer.

Role required: admin

1. Navigate to System Definition > Script Includes.
2. Open HTMLSanitizerConfig.
3. To add items to the black list, use the HTML_BLACKLIST class. To add items to the white list, use the HTML_WHITELIST class.

Use this format:

```
HTML_XXXXLIST :{
    globalAttributes :{
        attribute:[attribute-name1,...],
        attributeValuePattern:{ attribute-name2:attribute-value-regex-pattern,...}
    },<html-element-name>:{// Same as Above},----
```

- `globalAttributes` contains attribute or attributeValuePattern items that are applicable globally for all the HTML elements.
- `attribute` is a comma-separated list of attributes.
- `attributeValuePattern` is a dictionary of attribute to attribute-value-regex-pattern pairs. The attribute-value-regex-pattern is a regular expression which has to match the attribute value.

Consider the following example:

```
HTML_WHITELIST:{
    globalAttributes:{
        attribute:["id","name"],},
    img:{
        attribute:["style","align"],
        attributeValuePattern:{src:".*jpeg"}),
    iframe:{},}
```

It adds the following items to the white list:

- The global attributes id and name. This is a list of strings that can be applied globally to all the elements.
- The img element where the attributes are style and align.
Enable sanitization on individual fields

You can use field attributes to enable or disable the sanitizer on individual fields.

Role required: admin

You need to first set the sanitizer property to false, and then enable the sanitizer on a per-field basis for any form.

1. Navigate to the sys_properties table and set the `glide.html.sanitize_all_fields` to `false`. This disables the sanitizer for all HTML fields in the system.
2. Navigate to the form that contains the HTML field.
3. Right-click the HTML field label, and select **Configure Dictionary**. The Dictionary Entry form opens for the HTML field.
4. Enter one of the following in the Attributes field:
   - To disable sanitization enter `html_sanitize=false`
   - To enable sanitization enter `html_sanitize=true`
5. Click Update.
6. To enable the HTML sanitizer for translated HTML fields, set the `glide.translated_html.sanitize_all_fields` property is `true`.

Enable HTML Sanitizer logging

When the HTML sanitizer removes elements or attributes, they are added to the system log. You can review these sanitized elements by adding `/syslog_list.do?sysparm_query=source%3DHTMLSanitizer` to your instance URL.

1. To review these sanitized elements add `/syslog_list.do?sysparm_query=source%3DHTMLSanitizer` to your instance URL.
2. To enable or disable logging, add the `glide.html_sanitize.discarded_log.enable` property to the system properties and set the value to `true` (enabled) or `false` (disabled). This property is `true` by default.

Auditing and history sets

Track record changes on auditing-enabled tables. By default, the system tracks changes to the incident, change, and problem tables, among others.

Enabling auditing tracks the creation, update, and deletion of all records in the table. If you just want to audit individual fields in a table, you can hide fields you do not want to track using a dictionary attribute.

Auditing information is kept in these tables:

- The **Audit** table.
- The **History sets** table.
Caution: Auditing certain system tables that receive a large amount of traffic, such as Workflow Contexts (wf_context), can impact performance and is not recommended.

Auditing parent and child tables

Tables do not derive the audit flags from parent or child audited tables. For example, if you enable auditing for the cmdb_ci table, only CIs stored in that base table are audited. Likewise, if you enable auditing for the cmdb_ci_computer table, only the computer CI records are audited, including any fields on the cmdb_ci_computer table that are derived from the cmdb_ci table.

Auditing system tables

By default, the system does not audit the deletion of a record from system tables. To audit a system table, add it to the list of tables in the glide.ui.audit_deleted_tables property list.

Auditing deletions from a form or list

By default, the system audits deletions of individual records from a form. To prevent auditing, set the table's dictionary attribute no_audit_delete.

The system audits deletions from a list when audit is checked on the table dictionary and the table is not listed in the property glide.db.audit.ignore.delete.

Information audited

Auditing tracks the following record changes:
- Unique Record Identifier (sys_id) of the record that changed
- Field that changed
- New field value
- Old field value
- Number of times this record and field have been updated
- Date and time when the change occurred
- User who made the change
- Reason for the change (if any reason is associated with the change)
- Internal checkpoint ID for the record, if the record has multiple versions.

Information exempted from auditing

Some updates are not audited despite enabling auditing on a table. This is why you may see 132 updates in a record's history, but only seven audited ones.

Auditing excludes the following information:
- Updates made by an upgrade.
- Updates made through import sets.
- Records in parent or child tables.
- Fields with the no_audit dictionary attribute.
- System tables not listed in the glide.ui.audit_deleted_tables property list.
- Fields that begin with the sys_ prefix (system fields), except the sys_class_name and sys_domain_id columns.
• Any time an inactivity monitor touches a record. This prevents you seeing possibly hundreds of updates listed against an incident, with the noise drowning out the useful data.

Auditing a table

For instructions on how to audit a table, see [Enable auditing for a table](#).

By default, the system tracks all fields in an audited table. You can audit a subset of fields in a table in one of two ways:

- You can enable auditing for the entire table, then exclude those fields you do not want to include. This is appropriate when you want to audit most, but not all, fields and is referred to as **blacklisting**. For more information, see [Exclude a field from being audited (blacklisting)](#).
- You can enable auditing for the table but only for specified fields. This is appropriate when you want to audit only a small number of the table's fields and is referred to as **whitelisting**. For information on how to include a field using whitelisting, see [Include a table field in auditing (whitelisting)](#).

Differences Between Audit and History Sets

The Audit (sys_audit), History Sets (sys_history_set), and History (sys_history_line) tables store the same data, but they serve different purposes and manage data differently.

The Audit (sys_audit) table is where the system stores historical information for all records. These records are intended to be kept forever so that administrators can always track the history of audited records. As the number of auditing records grows over time it becomes more and more inefficient to directly query the Audit table for historical information. It is much more efficient to run queries only on the smaller subset records you actually want to view historical information for.

The History Set (sys_history_set) table identifies which particular records from an audited table have historical information. The History (sys_history_line) table stores the actual changes to field values that occurred. The system automatically generates History Set and History records as needed from the Audit table when a user either creates a record or requests its history. Rather than containing a complete history of all changes in the system, History Set and History records only contain a recent subset of historical information for records where users have created or requested such information.

The system limits History Set and History records by:

- Having the table cleaner delete History Set records that have not been updated in 30 days.
- Using table rotation to rotate between four History tables every seven days. This means the system drops History records that are older than 28 days.

Should someone need historical information again at a later date, the system can regenerate it from auditing source records.

After the system generates History Set records, the context menu choice **History** uses the History Set rather than Audit records. From the user's perspective, the same historical data is available in the same user interface, but the way the information is stored is different.

The Sys Audit table

The system tracks inserts and changes to audited records in the Sys Audit [sys_audit] table.

The system audits tables in which the **Audit** check box is selected on the Dictionary record. By default, the system does not audit records from system tables, such as update sets tables.
Note: To prevent performance issues and infinite loops, the system skips any business rule or workflow triggered by inserts to the Sys Audit table.

Sys Audit table columns

Records in the Sys Audit table display these columns:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table that the audit record is for (for example, &quot;incident&quot;)</td>
</tr>
<tr>
<td>Field Name</td>
<td>Column in the table that the audit record is for (for example, &quot;assigned_to&quot;)</td>
</tr>
<tr>
<td>Document Key</td>
<td>The Sys ID (Unique Record Identifier) of the record the audit record is for.</td>
</tr>
<tr>
<td>Old Value</td>
<td>Old value of the field change represented by this sys_audit record.</td>
</tr>
<tr>
<td></td>
<td>- Reference fields: Displays the unique sys_id value of the changed record.</td>
</tr>
<tr>
<td></td>
<td>- Date and time fields: Displays the value in Coordinated Universal Time (UTC) as stored in the database.</td>
</tr>
<tr>
<td>New Value</td>
<td>New value of the field change represented by this sys_audit record.</td>
</tr>
<tr>
<td></td>
<td>- Reference fields: Displays the unique sys_id value of the changed record.</td>
</tr>
<tr>
<td></td>
<td>- Date and time fields: Displays the value in Coordinated Universal Time (UTC) as stored in the database.</td>
</tr>
</tbody>
</table>

Enable auditing for a table

You can enable table auditing to track changes to all or some of the table's fields.

Role required: admin

1. Navigate to System Definition > Dictionary. The system displays the list of dictionary entries. The list includes a row for each table as well as a row for each column (field) in the table.
2. In the list of dictionary entries, find the row corresponding to the table you want to audit, for example cmdb_ci_computer. You can distinguish the row for the table itself – versus a row for a column in the table – by finding the row with the correct table name, an empty entry for Column name, and a type of collection.
3. Select the dictionary entry for the table. The system displays the dictionary entry form.
4. Check the Audit check box.
5. Click Update.

If you want to audit only a few fields in the table Enable whitelist auditing for a table. If you want to audit most – but exclude some – fields, Exclude a field from being audited (blacklisting).
Enable whitelist auditing for a table

Enable a table to audit only those fields you explicitly designate. This is useful when you want to audit only a small number of an audited table’s fields.

Role required: admin

The table must be enabled for auditing.

1. Navigate to System Definition > Dictionary.
   The system displays the list of dictionary entries. The list includes a row for each table as well as a row for each column (field) in the table.
2. If necessary, customize the list view to show the Attributes column.
3. In the list of dictionary entries, find the row corresponding to the table you want to audit, for example cmdb_ci_computer. You can distinguish the row for the table itself – versus a row for a column in the table – by finding the row with the correct table name, an empty entry for Column name, and a type of collection.
4. In the Attributes field for that row, enter audit_type=whitelist.

Designate which fields you want to audit in this table.

Exclude a field from being audited (blacklisting)

Prevent the system from tracking a subset of fields in an audited table by excluding those fields from the audit.

Role required: admin

To exclude a field in a table from being audited, you must have first enabled auditing for that table.

Blacklist a set of fields when you want to audit most of an audited table’s fields. If you need to audit only a few fields, follow the whitelisting procedure instead.

1. Navigate to System Definition > Dictionary.
2. If necessary, customize the list view to show the Attributes column.
3. Navigate to the row corresponding to the table and field (column) you want to exclude from auditing.
4. In the Attributes column for that row, enter no_audit.

Include a table field in auditing (whitelisting)

Track a subset of fields in an audited table by whitelisting those fields.

Role required: admin

To whitelist fields in a table, you must have first enabled auditing for that table and enabled whitelist auditing for that table.

Whitelist a set of fields when you want to audit only a small number of an audited table’s fields. If you need to audit most fields, and exclude only a few, follow the blacklisting procedure instead.

1. Navigate to System Definition > Dictionary.
2. If necessary, customize the list view to include showing the Attributes column.
3. Navigate to the table and field (column) you want to whitelist.
4. In the Attributes field, enter audit=true.
History sets

The system generates history set records when a user requests to view an audited record’s history. If the record is on an audited table, a history set is generated when the record is inserted. A user must view a record for the system to create or update a history set for that record.

**Note:** Do not use history sets to generate reports.

Viewing history sets

There are two ways of viewing the history set, accessible through the Context Menu action **History**.

**Calendar**

The history calendar shows you the days a record was changed and by whom. In this view, you can:

- Highlight changes to a particular field by selecting the field from the **Highlight changes to field** selection box. Hover over the text of one of a highlighted change to see the change in value.
- Hover over the icon within an entry to view a popup displaying all the value changes.
- Click the day number to get a view of the changes for that day.
- Click the week number to the left to get the week view. You can scroll to and from month-to-month to see changes.
### Incident History Detail

**Details for INC0000039**

- **Created**: 2012-04-05 17:42:29 by admin
- **Last updated**: 2012-05-15 12:56:25 by ITIL User
- **Update count**: 3 (1 audited)

#### 2012-04-05 17:42:29 Created by System Administrator (70 Days Ago)
- **2012-05-15 12:56:25 Updated by ITIL User (2 Minutes)**

#### Highlight changes to field: -- None --

<table>
<thead>
<tr>
<th>Week</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Sun</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>15</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
</tr>
<tr>
<td>17</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>30</td>
<td>May 1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

**Field** | **Value**
--- | ---
Active | true
Approval | Not Yet Requested
Assignment group | Network
Caller | Bud Richman
Category | Network
Configuration Item | MailServerUS
Additional comments | Routing from San Diego to the Oregon mail server appears to be getting packet loss!
Contact type | Phone
Escalation | Normal
Impact | 3 - Low
Incident state | New
Knowledge | false
Location | Salem OR
Made SLA | false
Notify | Do Not Notify
Number | INC0000039
Opened | 2012-04-05 17:41:01
Opened by | Bud Richman
Priority | 4 - Low
Severity | 3 - Low
Short description | Routing to Oregon mail server
SLA due | 2012-04-26 17:41:01
State | New
Task type | Incident
Domain | global
Urgency | 3 - Low
List

The history list displays each change as its own row in the change list.

To view a history list, the following requirements must be met.

- Auditing: Auditing for the table must be enabled to view a history list.
- ACLs: By default, the List history option is only available to users with the admin user role. To enable this option to non-admins, create a custom ACL rule granting read access to the Record History (sys_history_set) table.
- Roles: At least one of the roles that the user has must be included in the glide.history.role property, which includes the itil role by default.
View History List

Click a row item to view additional details about the change.
List view fields

List View Record Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>A Document ID for the record whose history is being recorded.</td>
</tr>
<tr>
<td>Table</td>
<td>The audited table for the record whose history is being recorded.</td>
</tr>
<tr>
<td>Load Time</td>
<td>The amount of time it took to generate the history set.</td>
</tr>
</tbody>
</table>

Audit History Record Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The label of the field which was changed.</td>
</tr>
<tr>
<td>Old</td>
<td>The value before the change.</td>
</tr>
<tr>
<td>New</td>
<td>The value after the change.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates if the entry is for a normal field, an email record, or a relationship change record.</td>
</tr>
<tr>
<td>Update Number</td>
<td>The number of times this field has been changed.</td>
</tr>
<tr>
<td></td>
<td>A value of -1 indicates when the record was created or deleted.</td>
</tr>
<tr>
<td>Update Time</td>
<td>The date and time of the change</td>
</tr>
<tr>
<td>User Name</td>
<td>The name of the user who created the change.</td>
</tr>
</tbody>
</table>

Tracking inserts, references, and relationships

History sets can also track changes to references, inserts, and relationships.

Tracking changes to reference fields

Since reference fields only store an ID value, the system can normally only audit changes when the ID value changes. By default, the system does not audit changes when a reference field display value changes.

Consider the following situation. A user changes her name from Jane Smith to Jane Miller. Since the user name is the display value for the User table, any previous reference to Jane Smith instead refers to Jane Miller. If the administrator just updates the name of the existing user record, audit and history records will only display the new name Jane Miller. By default, the system does not provide a way to distinguish between changes made under the original user name versus those made with the new user name.

If your auditing policy requires tracking user name changes, you can:

- Create a new user record for the new name and deactivate the previous user record. The system preserves audit records for the old user name and creates future audit records with the new user name.
Create custom fields and a business rule to save the previous name and the date of the name change. The system can use this information to construct the proper names in audit and history records.

Tracking inserts

By default, the system does not create Audit records for inserts because in a typical instance, inserts can account for over 80% of the size of the Audit table.

Not tracking inserts allows for better performance and a much smaller Audit table. Administrators can enable auditing of inserts by setting the `glide.sys.audit_inserts` property to true.

Tracking CI relationships

Changes to a CI relationship (CI Relations, CI/User Relations, or CI/Group Relations) appear in the history of the items on both sides of the changed relationship regardless of whether the change was manual or a result of Discovery.

For example, if the computer alpha has a used by CI Relation with the computer beta, then the history for alpha has a record of when the relationship with beta was established, and likewise, the history for beta has a record of when the relationship with alpha was established. This example illustrates the history displayed when some CI Relations are established, and then one of the relations is removed:
CI Relationship History

The created bullet indicates the date that the CI, user, or group was created. The last activity bullet refers to when the relationships were last changed. If you don’t want to show CI relationship history for any or all CI relationship types, you can turn it off by disabling auditing on the CI relationship tables (CI Relationship [cmdb_rel_ci], CI/User Relationship Type [cmdb_rel_user_type], or Group Relationship [cmdb_rel_group]).

Control access to history

You can give a role access to view audit history by setting a system property.

Role required: admin

1. Navigate to System Properties > System.
2. In the property List of roles (comma-separated) that can access the history of a record, enter the user roles you want to access history.
3. Click Save.

Any changes to a field are omitted if a user without read-access views the history of a record.
Change the number of history entries

By default, the history displays a maximum of 250 history entries, but you can change this value.

Role required: admin

1. Navigate to System Properties > System.
2. In the property Maximum number of field entries displayed in record history, default is 250, enter a new maximum number of entries.

History Timeline

You can view a timeline of changes for a CI and for its related records, relationships, baselines, and proposed changes for the CI. Timelines are available for CIs in the Configuration Item (cmdb_ci) table or a descendant of this table, if auditing is enabled for the tables.

Role required: The ACL for this view is based on the roles defined in the glide.history.role system property, which by default is set to itil. Also, the user must have read access to the History Set (sys_history_set) table, which by default is granted to admin.

You can open a timeline when you view the history of a CI. You can specify the time period, time range, and properties that are displayed in the timeline. You can view either what has changed in a particular change set, or view the entire CI to better troubleshoot any issues. You can also display a timeline of changes to the CI's related records, and export and compare snapshots of the CI at any point in time.

CI changes are represented by bubbles in different shapes and colors along the timeline. The shape of each bubble represents a different type of change and the color of each bubble specifies whether the change is valid or invalid. CI baselines are represented by black circles that you can hover over to display more details. Click the ? icon to display bubble shape and color definitions, and point to a bubble to display details about the change set.

A change to a relationship is considered valid only if it was applied through change management. If the change was applied via the Proposed Changes framework, it is valid. For additional validation steps, see Create or edit a planned change validation script.
History Timeline view

Timeline bubbles

**Note:** Proposed changes that do not have a planned start date are placed at future points of time.

**Timeline navigator**

Use the handles on both ends of the timeline navigator to extend or to shorten the time period that is shown.

You can scroll to a different period of time by clicking on the bottom part of the timeline navigator and then dragging the navigator to the left or right.
Zoom

By default, the timeline for the last month is shown. Next to the Zoom label above the timeline, you can select another time interval. You can select intervals from a minute to the entire period of data.

If there are many changes of the CI during the time period, the bubbles displayed might get too crowded. You can zoom in or out to spread the bubbles in either method:

- Change the time interval on the timeline. As you shorten the time interval, you zoom in, and as you lengthen the time interval, you zoom out.
- Select the section of the timeline that you want to zoom into.

Property filter

You can filter the bubbles that are displayed. By default, all bubbles are displayed, representing changes to all of the CI's properties. You can limit the view to display only the bubbles in which selected properties have changed and exclude bubbles in which only unselected properties changed.

The Detail and Summary views highlight properties within your filter scope that have changed. The changed properties are highlighted in light blue.

In the Summary view, you can choose to include all the properties of the CI, or only properties that have changed. If you choose to display all properties in the summary view, then changed properties are listed before unchanged properties.

Summary view

The Summary view displays snapshots of the CI's represented by each bubble. Each snapshot displays the changes to the CI's fields and relationships according to the change set. It displays old and new values before and after the change, and any relationships that were added or deleted.

Use the > and < buttons on both sides of the snapshot display to scroll through the next and previous change set records in a chronological order.

Detail view

The Detail view displays snapshots of the CI that correspond with the bubbles. Each snapshot includes the fields that are within the property filter scope, displaying the properties that have changed with a light blue background. Click on a bubble to display its corresponding snapshot of the CI. The data that is displayed is read-only.

Use the > and < buttons on both sides to scroll through the next and previous change set records in a chronological order.

View timeline of changes to related records

On the timeline of changes for a CI record, you can also view a timeline of changes for the CI's related records.

- Role required: admin
- Target table: the CI record must be in the Configuration Item (cmdb_ci) table or a descendant of this table.
• Auditing: must be enabled for the table containing the CI.

1. Open the timeline for the CI.
2. Click the Related Records icon and select related records from the List of Related Records to view. Click the Related Records icon again to display the related records timeline.

The timeline of changes to the CI’s related records is displayed right above the CI’s timeline. If you uncheck all related records, the related records timeline is hidden.

Hover over a change bubble on the related records timeline to display details about the change, such as date and number of changed properties. As you change the time interval in focus, or zoom in or out, it affects both the CI timeline and the related records timeline simultaneously.

Export a snapshot of a CI
You can export a snapshot of a CI from its timeline.

The CI must be in the Configuration Item (cmdb_ci) table or a descendant of this table. Auditing must be enabled for the table containing the CI.

Role required: admin
You can export a snapshot of the CI to an XML, PDF (Portal), or PDF (Landscape) format.

1. Open the timeline for the CI.
2. Select the bubble representing the time for which you want to export a snapshot of the CI.
3. Click the export icon ( ).
4. Select the file format to use for the export.
   You can download the file to your system for viewing.

Compare CI snapshots
You can compare the properties and relationships of a CI at two different points in its timeline.

The CI must be in the Configuration Item (cmdb_ci) table or a descendant of this table. Auditing must be enabled for the table containing the CI.

Role required: admin

1. Open the timeline for the CI.
2. Click Compare.
3. Select a Start date and an End date.
4. Click Compare.

Domain separation
Domain separation allows you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Explore
• Understanding domain separation
• Application support for domain separation

Set up
• Request domain separation
• Access the Domain Configuration console
• Create a domain

Administer
• Validate domain hierarchy
• View a list of tables using domain separation
• Delegated administration

Troubleshoot and get help
Understanding domain separation

The separation of data, administrative tasks, processes or reporting into logically defined domains is known as domain separation. A domain can be entities, customers, or sub-organizations. By default, members of one domain only see the data contained within their domain or the child domains that are lower in the domain hierarchy.

Domain separation is best for those customers who:

- Want to customize business process definitions and user interfaces for each domain
- Prefer to maintain some global processes and global reporting in a single instance
- May have minor or moderate process differences among customers or sub-organizations
- Need to enforce data segregation between domains

**Note:** If you require complete and total separation of all system properties and do not require global reporting or global processes, then consider establishing separate instances.

**Warning:** Before activating domain separation, consult your ServiceNow representative to verify that it is suitable for your environment. Domain separation adds a level of administration overhead. Although it can be disabled, it cannot be removed from an instance.

Domain separation hierarchy

Members of a domain only see the data contained within their domain or the child domains that are lower in the domain hierarchy. By default, all users and all records are members of the global domain unless an administrator assigns them to a particular domain. Once you assign a user or a record to a domain, the instance compares the user's domain to the record's domain to determine whether the user can view the record.

Users in the global domain can see all records, regardless of the record's domain settings. If a user is a member of another domain, then there is no single visibility setting that allows users to see across domains or allows users to see records at a higher level in the hierarchy.

**Note:** Guest users must be part of the global domain.

In general, data defined at a higher level in the domain hierarchy is not visible at lower levels in the hierarchy. With the exception of form sections and options in a choice list, which behave like policies; when defined at a higher level in the hierarchy, these records are visible in child domains.
Domain: Global
- Records in the global domain are visible to all users

Domain: Database
- Users in a parent domain can see and manage records in child domains

- ITL User
- Beth Anglin
- Fred Luddy

Domain: Database Atlanta
- Bow Ruggeri

Domain: Database San Diego
- Don Goodlife

Domain: NY DB
- David Loo

Users in a child domain cannot see or manage records in a parent domain.
In this domain hierarchy:

- Bow Ruggeri can see any records in the Database Atlanta or the global domain.
- Don Goodliffe can see any records in the Database San Diego or the global domain.
- David Loo can see any records in the NY DB or the global domain.
- Fred Luddy, ITIL User, Beth Anglin can see any records in the Database, Database Atlanta, Database San Diego, NY DB, or the global domain.

**Domain assignment**

Domain separation adds a domain field to the Task (task) and Configuration Item (cmdb_ci) tables and their extensions. You can also extend domain separation to any new tables by adding a `sys_domain` field to the table's dictionary definition. By default, the system only domain separates platform and baseline application tables where appropriate.

The system prevents the following tables from being domain separated:

- `Access Control [sys_security_acl]`
- `Script Include [sys_script_include]`
- `System Property [sys_properties]`
- `Security Black/Whitelist Entities [sys_security_restricted_list]`
- `Dictionary Entry [sys_dictionary]`
- `Dictionary Entry Override [sys_dictionary_override]`

---

**Warning:** ServiceNow does not recommend domain separating platform tables (any table with the sys_ prefix such as the Dictionary Entry [sys_dictionary] and Dictionary Entry Override [sys_dictionary_override] tables) because it can produce unexpected results.

---

**Assign a user to a domain by assigning the company**

Administrators can assign users to domain by assigning them to a company. After users are assigned, records automatically inherit the user's domain.

For example, assigning Bow Ruggeri to the ACME company automatically assigns him to the ACME domain. Assigning Don Goodliffe to the Initech company automatically assigns him to the Initech domain. Any records they create are automatically added to the appropriate domain.
By default, the system automatically assigns users to the same domain as their company. For example, all users of the ACME company automatically become members of the TOP/ACME domain.

**Note:** Users with the admin role have the ability to change their own user records and therefore can change domains. Managed Service Providers may want to either disable delegated administration or set up an approval process to verify that the user needs the admin role.

When you change a company’s domain, the instance automatically changes the domain of the following associated records to match the company’s new domain.

- Locations
- Departments
- Groups
- Users

**Note:** The instance does not automatically change the domain of any record where you have selected the Managed domain checkbox.

**Deactivated domains and inactive companies**

When you deactivate a domain, the instance also automatically completes the following actions.

- Deactivates all companies in the domain.
- Prevents all users assigned to the inactive company from logging in.

**Note:** When a user from an inactive company attempts to log in, the user sees an error message.

For example, if you deactivate the ACME domain from the sample data, the instance also deactivates the ACME company, and the three sample users are locked out.

![Login error message example](image)
Assign domains using business rules

Administrators can use a business rule to automatically set a domain value when creating a record. The business rule must set a value in the sys_domain field. Administrators must ensure there is a sys_domain column available for the record’s table.

Assign domains using modules

Administrators can use the sysparm_domain URL parameter to automatically assign new records to a particular domain from a module. Administrators must create a module with an Argument value of: sysparm_domain=sys_ID of domain.

Assign domains using form templates

Administrators can use a form template to automatically assign new records to a particular domain. Administrators must add the sys_domain field to the form and select a domain value. For example, setting the sys_domain field to TOP/ACME domain automatically assigns all records from this template to the TOP/ACME domain.

Assign domains using parent table inheritance

By default, related records inherit the domain of the parent record.
- A change task record inherits the domain of the parent change request record.
- A problem record inherits the domain of the parent incident record.

Automatically assign domains based on user domain

If no other domain conditions apply, a record automatically inherits the domain of the user who creates it.

Visibility domains and Contains domains

Visibility domains control what a specific user can see, while Contains domains control what an entire domain of users can see.

Visibility domains

Visibility domains is a related list on the user record that determines whether users from one domain can access records from another domain. Granting users a visibility domain grants all the rights they would normally have to the record based on ACL rule permissions.

A visibility domain:
- Is a user-to-domain relationship and is explicitly granted.
- Is not a child domain.
- Is not controlled by the selection in the domain picker. Once the user is granted access to a visibility domain, they always see data in that domain and its children.
Note: Using visibility domains excessively is not recommended. Although visibility is one method to allow users to access records, it is recommended that you use contains domains for more robust control.

Contains domains

Normally parent-child relationships define the domain hierarchy. A contains domain lets you relate domains on an as-needed basis, independent of parent-child relationships. However, contains domains only grant visibility to domain data. Processes remain unaffected by contains relationships.

A contains domain:
- Is a many-to-many, domain-to-domain relationship.
- May have child domains. When a domain is selected, you can see the data from that domain and its children.
- Is controlled by the selection in the domain picker.

Contains domain example

A user has access to domain A (the user's home domain) and is granted visibility to domains B and C. The user selects domain A in the domain picker. In this case, the user has access to domains A, B, and C. If the user changes the domain picker to domain B, B and C are visible. C is still visible because the user still has visibility to it. A is not visible, because it is not selected in the domain picker and it is not a visibility domain.

Visibility domain example

Using domain visibility, if Don Goodliffe is in the Database domain, and Bow Ruggeri is in the Network domain, and no incidents are in the global domain, then Don Goodliffe cannot access Bow Ruggeri's incidents because of data separation.

Sample set of domain-separated incident records
You can add the database domain as a visibility domain to Bow Ruggeri’s user record. Then Bow Ruggeri can access Don Goodliffe’s incidents, since he now has visibility to the database domain. If you remove the visibility domain, then Bow Ruggeri can no longer access incidents in the database domain.
Inherit visibility domains based on group membership

If you set the domain table to the Group (sys_user_group) table, users can inherit visibility domains based on their group membership.

For example, as a member of the Database group, Don Goodliffe also automatically gains the Database domain as a visibility domain. Group membership grants visibility to any matching domain name.
Domain scope

Domain scope defines what users can and cannot access.

Every user has two domain scopes when establishing a session in a domain separated instance.

- **Session scope** is set upon session establishment to the domain listed in the user's user record. Users can manually change their session domain scope from the domain picker.
- **Record scope** uses the domain of the record and is active when viewing the form of any record.

By default, the record scope takes precedence over the session scope so that users in higher level domains adhere to each record's data and process constraints. However, these users can choose to expand or collapse the domain scope to show or hide data from other domains.
For example, a user in the MSP domain also has visibility into child domains such as the ACME domain. When looking at an incident record from the ACME domain, the user can choose to expand the domain scope to show values from the MSP domain or collapse the domain scope to only show record values that match the record’s ACME domain.

**Note:** Users always have access to data from domains that have been explicitly granted to them by domain visibility.

Users with the `domain_expand_scope` user role can select the domain scope from the **Toggle Domain Scope** UI action on the form. When record scope is in effect, click the UI action to expand to session scope and display all data available based to the user’s domain and child domains. When session scope is in effect, click the UI action to collapse to record scope and display only data that matches the current record’s domain.

**Note:** A record does not display the UI action to toggle the domain scope if the record is in the global domain or if the user’s domain matches the record’s domain.

**Record value selection from other domains**

Users who can see multiple domains have the option to select record values from a domain that is different than the record’s domain.

For example, service desk agents working for a managed service provider might want to assign certain incidents to themselves to resolve issues on behalf of their customers. When they do this, the incident **Assigned to** field might contain a user from the MSP domain, even though the incident record itself is associated with a child domain such as ACME.

Selecting a record value from another domain does not change the record’s domain. The record retains its original domain. When a user views a record with values from multiple domains, the user’s domain visibility determines what they see.

**Record value selection**

<table>
<thead>
<tr>
<th>When these conditions are met</th>
<th>The user has access to these UI elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>The user has access to the domain of the current record referenced in a field.</td>
<td>The user can:</td>
</tr>
<tr>
<td></td>
<td>• See reference field display value. For example, sees the user name in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• See the related record from reference icon. For example, sees the user record for the user in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Select values from any visible domain. For example, can select users from either the MSP and ACME domains.</td>
</tr>
<tr>
<td>The user does not have access to the domain of the current record referenced in a field.</td>
<td>The user can:</td>
</tr>
<tr>
<td></td>
<td>• See the reference field display value. For example, sees the user name in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Only select values from the record’s domain. For example, can only select user’s from the ACME domain.</td>
</tr>
</tbody>
</table>
Domains and associated companies

Domain separation allows you to cascade changes you make to a company record to the domain and other records associated to the company.

By default, the system automatically assigns users to the same domain as their company. For example, all users of the ACME company automatically become members of the TOP/ACME domain.

**Note:** Users with the admin role have the ability to change their own user records and therefore can change domains. Managed Service Providers may want to either disable delegated administration or set up an approval process to verify that the user needs the admin role.

When you change a company's domain, the instance automatically changes the domain of the following associated records to match the company's new domain.

- Locations
- Departments
- Groups
- Users

**Note:** The instance does not automatically change the domain of any record where you have selected the **Managed domain** checkbox.

Domain deactivation and associated companies

When you deactivate a domain, the instance also automatically completes the following actions.

- Deactivates all companies in the domain.
- Prevents all users assigned to the inactive company from logging in.

**Note:** When a user from an inactive company attempts to log in, the user sees an error message.

For example, if you deactivate the ACME domain from the sample data, the instance also deactivates the ACME company, and the three sample users are locked out.
Domain scope properties and user preferences

Administrators have access to properties and user preferences that control domain scope.

Properties

New activations of domain separation automatically restrict domain scope to the record’s domain for all processes. When the user views a record in a form, the record’s related data (such as reference picker and related list data) and applied processes (such as business rules and client scripts) are restricted to the record’s domain scope. If there are records in multiple tabs, each tab has its own domain scope based on the record opened within that tab. The following properties restrict domain scope to either the record’s domain and the user’s current session domain.

Domain scope properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sys.domain.use_record_domain_for_processes</td>
<td>Restricts domain scope to the record’s domain for all processes. This property does not apply to business rules. Business rules are always processed from the domain record.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
</tbody>
</table>
### Property Details

<table>
<thead>
<tr>
<th>Property</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sys.domain.use_record_domain_for_data</td>
<td>Restricts domain scope to the record’s domain for all data.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: true in new domain activations from Fuji onwards (upgrades from instances older than Fuji do not have this property in the table)</td>
</tr>
<tr>
<td></td>
<td>- Location: System Property (sys_properties) table</td>
</tr>
</tbody>
</table>

When either the `glide.sys.domain.use_record_domain_for_processes` or the `glide.sys.domain.use_record_domain_for_data` property is set to `true`, the following properties are not used, regardless of their setting:

- `glide.sys.domain.use_record_domain`
- `glide.sys.domain.use_record_domain_for_client_scripts`
- `glide.sys.domain.domain_change_notify`
- `glide.sys.domain.no_change_roles`

### Domain scope for business rules executed on the domain table

In new activations of domain separation starting with the Jakarta release, the session domain determines the business rules executed on the domain table. In previous versions, business rules executed on the domain table were set based on the newly created domain’s hierarchy. This behavior is modified by the `glide.sys.domain.skip_domain_insert_businessrules` property. Setting this property to `true` significantly improves domain insert performance.

#### Domain scope properties for business rules executed on the domain table

<table>
<thead>
<tr>
<th>Property</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sys.domain.skip_domain_insert_businessrules</td>
<td>Specifies the domain scope for business rules executed on the domain table. In new activations of domain separation, the property default is true and business rules are determined by the session domain. In existing implementations, the property default is false and the business rules are determined by the newly created domain’s hierarchy.</td>
</tr>
<tr>
<td></td>
<td>- Type: true</td>
</tr>
<tr>
<td></td>
<td>- Default value: True in new domain activations starting with Jakarta. False in existing implementations.</td>
</tr>
</tbody>
</table>

### User preferences

In addition, user administrators can set the following user preference globally or on a per-user basis:
### Domain scope user preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated By</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.domain.session_scope</td>
<td>Domain</td>
<td>Admin Only</td>
<td>When true, sets the default scope to the user's session domain rather than the record's domain. When false, the default scope is the record's domain. Users with the domain_expand_scope user role can still change the domain scope as needed.</td>
</tr>
<tr>
<td>glide.domain.session_scope</td>
<td>Domain</td>
<td>Admin Only</td>
<td>When true, displays a visual cue that record values include an expanded domain scope. When false, the notification is hidden.</td>
</tr>
</tbody>
</table>

### Domain query methods

A domain query method allows the instance to efficiently query large numbers of domains.

**Note:** Domain paths are used for all customers on Helsinki and later. Domain numbering is no longer used. ServiceNow Technical Support can assist in the upgrade.

Part of Domain Support 2.0 is a new query engine designed to perform and scale to tens of thousands of domains. Prior methods, including domain numbering, have had limitations that domain paths resolve. While you have the flexibility to continue using your existing query method, we highly recommend that you switch to domain paths through the new Domain Configuration screen at your earliest convenience.

A domain path is a series of three-character codes separated by a slash (/) delimiter that uniquely identifies a domain. Each digit in the three-character code consists of one of the following 60 possible characters:

```
!#$&()*+,-.0123456789:;<?ABCDEFGHIJKLMNOPQRSTUVWXYZ\[\]^`|~
```

The three-character codes that make up a path are not unique across a domain tree. Rather, the entire path string itself is unique. For example:
An example domain tree

<table>
<thead>
<tr>
<th>Domain name</th>
<th>Parent domain</th>
<th>Domain path</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNC</td>
<td>None</td>
<td>!!!/</td>
</tr>
<tr>
<td>SNC/US</td>
<td>SNC</td>
<td>!!!/!!!/</td>
</tr>
<tr>
<td>SNC/EU</td>
<td>SNC</td>
<td>!!!/!!!#/</td>
</tr>
<tr>
<td>SND/RU</td>
<td>SNC</td>
<td>!!!/!!!$/</td>
</tr>
<tr>
<td>SNC/US/NY</td>
<td>SNC/US</td>
<td>!!!/!!!/!!!#/</td>
</tr>
<tr>
<td>SNC/US/CA</td>
<td>SNC/US</td>
<td>!!!/!!!/!!!$/</td>
</tr>
<tr>
<td>SNC/EU/DE</td>
<td>SNC/EU</td>
<td>!!!/!!!#/!!!/</td>
</tr>
<tr>
<td>SNC/EU/FR</td>
<td>SNC/EU</td>
<td>!!!/!!!#/!!!#/</td>
</tr>
</tbody>
</table>

**Note:** With three-character codes delimited by a single character in a path string of 255 total characters, each node of the domain tree supports up to 216,000 child domains, and the maximum depth of the tree is 63 levels.

**Installed with domain separation**

Several platform components are added or modified with domain separation.

**Roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain_admin</td>
<td>Can create, edit, and delete domains.</td>
</tr>
</tbody>
</table>
Additions to (sys_domain) fields

The sys_domain field is added to the following tables:

### Tables with the sys_domain field

<table>
<thead>
<tr>
<th>Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_attachment</td>
</tr>
<tr>
<td>sys_user_has_role</td>
</tr>
<tr>
<td>sys_group_has_role</td>
</tr>
<tr>
<td>sys_email</td>
</tr>
<tr>
<td>sys_user_group</td>
</tr>
<tr>
<td>core_company</td>
</tr>
<tr>
<td>cmn_location</td>
</tr>
<tr>
<td>cmn_department</td>
</tr>
<tr>
<td>sys_gauge</td>
</tr>
<tr>
<td>sys_report</td>
</tr>
<tr>
<td>kb_feedback</td>
</tr>
<tr>
<td>sysapproval_approver</td>
</tr>
<tr>
<td>sys_user_grmember</td>
</tr>
</tbody>
</table>

Field for the Task Table

MSP Extensions add a task_for field to the Task table to support the New Ticket module. This reference field refers to the User table.

The task_for column on the Task table

Options for the Group Type

MSP Extensions add several new default options to the type field of the Group table. Add to or update these types as needed to support your domains.
### Tables

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain - Activate/Deactivate</td>
<td>core_company</td>
<td>Activates the related domain if at least one of its companies is active. Deactivates the related domain if all related companies are inactive.</td>
</tr>
<tr>
<td>Domain - Cascade Company</td>
<td>core_company</td>
<td>Keeps a company’s domain in sync with its users, groups, departments, and locations.</td>
</tr>
<tr>
<td>Domain - Cascade Domain - Email</td>
<td>sys_email</td>
<td>Keeps an email’s domain in sync with its attachments.</td>
</tr>
<tr>
<td>Domain - Cascade Domain - Group</td>
<td>sys_user_group</td>
<td>Keeps a group’s domain in sync with its inherited roles (sys_group_has_role records).</td>
</tr>
<tr>
<td>Domain - Cascade Domain - Knowledge</td>
<td>kb_knowledge</td>
<td>keeps a knowledge article’s domain in sync with its related feedback.</td>
</tr>
<tr>
<td>Domain - Cascade Domain - Task</td>
<td>task</td>
<td>Keeps the domain in sync with related tasks for wf_context, wf_executing, wf_history, attachments, emails, task_sla and its workflow, sysapproval_approver and its workflow, and sysapproval_group and its workflow.</td>
</tr>
<tr>
<td>Domain - Cascade Domain - User</td>
<td>sys_user</td>
<td>Keeps a user’s domain in sync with its group membership (sys_user_groupmember) and role (sys_user_has_role) records.</td>
</tr>
<tr>
<td>Domain - Cascade Domain - Version</td>
<td>wf_workflow_version</td>
<td>Keeps domains in sync with related workflow versions for wf_activity and wf_transition.</td>
</tr>
<tr>
<td>Domain - Deactivate Companies</td>
<td>domain</td>
<td>Deactivates related companies if a domain is deactivated.</td>
</tr>
<tr>
<td>Domain - Default - Task</td>
<td>task</td>
<td>Sets the task domain based on the Task for user’s domain. If this domain would be global, sets domain to Default instead.</td>
</tr>
<tr>
<td>Domain - Default - User</td>
<td>sys_user</td>
<td>Sets a user’s domain to Default if the domain otherwise would have been global.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain - Disallow Global Domain Record</td>
<td>domain</td>
<td>Prevents creation of a domain with the name global.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_app_application</td>
<td>When an application is overridden for a domain, creates a copy of its modules for the new application.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_data_policy2</td>
<td>When a data policy is overridden for a domain, creates a copy of its data policy rules for the new data policy.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_gauge</td>
<td>When a gauge is overridden for a domain, creates a copy of its gauge counts for the new gauge.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_ui_action</td>
<td>When a UI action is overridden for a domain, creates a copy of its UI action views for the new UI action.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_ui_list_control_embedded</td>
<td>When an embedded list control is overridden for a domain, creates a copy of its client and server scripts for the new embedded list control.</td>
</tr>
<tr>
<td>Domain - Override Copy</td>
<td>sys_ui_policy</td>
<td>When a UI policy is overridden for a domain, creates a copy of its UI policy actions for the new UI policy.</td>
</tr>
<tr>
<td>Domain - Set Domain - Approvals</td>
<td>sysapproval_approver</td>
<td>Sets the domain based on that of the record being approved.</td>
</tr>
<tr>
<td>Domain - Set Domain - Attachment</td>
<td>sys_attachment</td>
<td>Sets the domain based on the parent record's domain.</td>
</tr>
<tr>
<td>Domain - Set Domain - CMDB_CI</td>
<td>cmdb_ci</td>
<td>Sets a CI's domain to that of its company.</td>
</tr>
<tr>
<td>Domain - Set Domain - Department</td>
<td>cmn_department</td>
<td>Sets a department's domain to that of its company.</td>
</tr>
<tr>
<td>Domain - Set Domain - Domain</td>
<td>domain</td>
<td>Sets a domain's domain to itself.</td>
</tr>
<tr>
<td>Domain - Set Domain - Email</td>
<td>sys_email</td>
<td>Sets the domain based on the parent record's domain. An email's parent record is the record specified in the instance field.</td>
</tr>
<tr>
<td>Domain - Set Domain - Feedback</td>
<td>kb_feedback</td>
<td>Sets a knowledge feedback's domain to that of its knowledge article.</td>
</tr>
<tr>
<td>Domain - Set Domain - Group</td>
<td>sys_user_group</td>
<td>Sets a group's domain to that of its company.</td>
</tr>
<tr>
<td>Domain - Set Domain - Group Approvals</td>
<td>sysapproval_group</td>
<td>Sets the domain based on that of the record being approved.</td>
</tr>
<tr>
<td>Domain - Set Domain - Group Role</td>
<td>sys_group_has_role</td>
<td>Sets a group role's domain to that of its group.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain - Set Domain - Location</td>
<td>cmn_location</td>
<td>Sets a location's domain to that of its company.</td>
</tr>
<tr>
<td>Domain - Set Domain - Task SLA</td>
<td>task_sla</td>
<td>Sets a task SLA's domain to that of its task.</td>
</tr>
<tr>
<td>Domain - Set Domain - User</td>
<td>sys_user</td>
<td>Sets a user's domain to that of its company.</td>
</tr>
<tr>
<td>Domain - Set Domain - User Role</td>
<td>sys_user_has_role</td>
<td>Sets a user role's domain to that of its user.</td>
</tr>
<tr>
<td>Domain - Set Domain - WF Activity Hist</td>
<td>wf_history</td>
<td>Sets the workflow activity history domain based on the parent workflow context's domain.</td>
</tr>
<tr>
<td>Domain - Set Domain - WF Context</td>
<td>wf_context</td>
<td>Sets the workflow context domain based on the referenced record's domain, if it has one.</td>
</tr>
<tr>
<td>Domain - Set Domain - WF Exec Activity</td>
<td>wf_executing</td>
<td>Sets the workflow executing activity domain based on the parent workflow context's domain.</td>
</tr>
<tr>
<td>Domain - Set task for - Change</td>
<td>change-request</td>
<td>When converting a ticket to a change request, sets the Requested by field to the ticket's Task for value.</td>
</tr>
<tr>
<td>Domain - Set task for - Incident</td>
<td>incident</td>
<td>When converting a ticket to an incident, sets the Caller field to the ticket's Task for value.</td>
</tr>
<tr>
<td>Domain - Validate Default</td>
<td>domain</td>
<td>Ensures only one domain has the Default check box selected.</td>
</tr>
<tr>
<td>Domain - Validate Primary</td>
<td>domain</td>
<td>Ensures only one domain has the Primary check box selected.</td>
</tr>
</tbody>
</table>

### Business Rules Installed with Domain Support Plugin

<table>
<thead>
<tr>
<th>Business rules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Domain Set</td>
<td>Sets the domain set to the current domain.</td>
</tr>
<tr>
<td>Domain support properties</td>
<td>Sets the system properties to match the domain query method (domain paths or domain numbering).</td>
</tr>
</tbody>
</table>

#### Client scripts

<table>
<thead>
<tr>
<th>Client script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain - Set Company and Location (sys_script)</td>
<td>Monitors the incident caller field for changes. If the company and location fields do not already have a value, the script adds this information from the caller record. If the company and location fields already have a value, the script retains the existing values.</td>
</tr>
</tbody>
</table>
### Application support for domain separation

Not all ServiceNow applications support domain separation in the base system. Some supported applications include limitations on the data and administrative settings that can be domain separated.

#### Domain Separation support levels

While some applications include architectural support for domain separation, they may not have support for domain separated administration and workflows. For this reason, ServiceNow applications are defined with the following support levels.

These definitions delineate the Domain Separation support level system, which operates from the perspective of actual use cases and personas.

**Data only**

The application supports the data security model of separating visibility of data from one domain to another.

**Level 1**

Level 1 support targets tenant domain **Requestor** use cases. This means that an application has been designed to support Requestor activities within tenant domains.

**Level 2**

Level 2 support targets tenant domain **Fulfiller** use cases. This means that an application that supports Level 2 Domain Separation can be used by the Fulfiller within the tenant domains. An application with Level 2 domain support includes Level 1 (Requester) and Level 2 (Fulfiller) support. The entire application can be used as a tenant domain-owned application.

**Level 3**

Level 3 support targets the tenant domain administrator use cases. Applications with Level 3 Domain Separation support have been designed with prescriptive Domain-Separated configuration capabilities which can be administered by a tenant domain administrator.

<table>
<thead>
<tr>
<th>Supported feature</th>
<th>Data only</th>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported tenant domain user role.</td>
<td>Data only</td>
<td>Requester</td>
<td>Fulfiller</td>
<td>Administrator</td>
</tr>
<tr>
<td>Data can be domain separated.</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Domain column is present for base system application tables.</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Supported feature</td>
<td>Data only</td>
<td>Level 1</td>
<td>Level 2</td>
<td>Level 3</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Domain-specific configuration is managed by instance owner.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tenant domains can manage their own application data.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application properties are domain aware when needed.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business logic and processes can be domain separated by instance owner.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business logic and processes can be administered by tenant domain.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Application support for domain separation**

<table>
<thead>
<tr>
<th>Product Suite</th>
<th>Application</th>
<th>Support level</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Management</td>
<td>Agile Development</td>
<td>Level 1</td>
<td>Product models are not domain separated. System properties cannot be domain separated.</td>
</tr>
<tr>
<td></td>
<td>Application Portfolio</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asset Management</td>
<td>Level 1</td>
<td>License calculations are supported in the global scope only.</td>
</tr>
<tr>
<td></td>
<td>Coaching Loops</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cost Management</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compliance</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data Certification</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Demand Management</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Financial Management</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Governance, Risk, and</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compliance</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Managed Documents</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project Portfolio Suite</td>
<td>Data only</td>
<td>Architectural support only. Certain properties cannot be domain separated.</td>
</tr>
<tr>
<td></td>
<td>Project Portfolio Suite with</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Financials</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product Suite</td>
<td>Application</td>
<td>Support level</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>IT Service Management</td>
<td>Release Management</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Structured Problem</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test Management</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vendor Performance</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Benchmarks</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Change Management</td>
<td>Level 1</td>
<td>Change Advisory Board (CAB) workbench does not support domain separation.</td>
</tr>
<tr>
<td></td>
<td>Contract Management</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expense Line</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual Agents</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Incident Alert</td>
<td>Data only</td>
<td>Can be separated through customization.</td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Incident Management</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On-Call Scheduling</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password Reset</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Problem Management</td>
<td>Level 2</td>
<td>Task-outage relationship includes architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Procurement</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Product Catalog</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Catalog</td>
<td>Level 2</td>
<td>Service Catalog administration is not domain separated. However, items can be domain separated through the user interface. Tasks created are domain separated.</td>
</tr>
<tr>
<td></td>
<td>Service Desk</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Level</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Smart Workspaces</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Software Asset</td>
<td>Level 1</td>
<td>Only the alm_asset table is domain separated.</td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Survey Management</td>
<td>Data only</td>
<td>Architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Service Portfolio</td>
<td>Data only</td>
<td>Architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IT Operations</td>
<td>Cloud Management</td>
<td>No Support</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td>Credentials</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discovery</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td>Product Suite</td>
<td>Application</td>
<td>Support level</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Event Management</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Release Automation</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Analytics</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Mapping</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td>Now Platform</td>
<td>Assessments</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contextual Search</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Automated Test Framework</td>
<td>Level 1</td>
<td>Because application tables are not domain separated, data is not visible in child domains.</td>
</tr>
<tr>
<td></td>
<td>Connect</td>
<td>Level 1</td>
<td>Connect Chat is supported within each domain only. Connect Support dashboard and queues do not support Domain Separation.</td>
</tr>
<tr>
<td></td>
<td>CMDB</td>
<td>Level 2</td>
<td>Certain classes, identifiers, and CI relationship types are not domain aware due to platform limitations.</td>
</tr>
<tr>
<td></td>
<td>CMDB Health</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Content Management System</td>
<td>Data only</td>
<td>Can be separated with customization.</td>
</tr>
<tr>
<td></td>
<td>Dashboards</td>
<td>Data only</td>
<td>Architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Delegated Development</td>
<td>Level 1</td>
<td>Application Administration must be enabled.</td>
</tr>
<tr>
<td></td>
<td>Dependency Views</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edge Encryption</td>
<td>Data only</td>
<td>Architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Homepages</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integrations with third-party applications and data sources</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Knowledge Management</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Live Feed</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mobile</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Notifications</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ODBC Driver</td>
<td>Data only</td>
<td>The ODBC user domain restricts access to data.</td>
</tr>
<tr>
<td></td>
<td>Orchestration</td>
<td>Data only</td>
<td>Additional support possible, but depends on use case.</td>
</tr>
<tr>
<td>Product Suite</td>
<td>Application</td>
<td>Support level</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------</td>
<td>---------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Platform Security</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ServiceNow® User Interface</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Script Debugger</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Self-service</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Portal</td>
<td>Data only</td>
<td>Architectural support only.</td>
</tr>
<tr>
<td></td>
<td>Time Card</td>
<td>Data only</td>
<td>Can be separated with customization.</td>
</tr>
<tr>
<td></td>
<td>Visual Task Boards</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Web services</td>
<td>Data only</td>
<td>Additional support possible, but depends on use case.</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
<td>Data only</td>
<td>Additional support possible, but depends on use case.</td>
</tr>
<tr>
<td></td>
<td>Performance Analytics and Reporting</td>
<td></td>
<td>Can be domain separated, except for separated properties.</td>
</tr>
<tr>
<td></td>
<td>Performance Analytics</td>
<td>Level 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reporting</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td>Security Operations</td>
<td>Security Incident Response</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Security Operations Integrations</td>
<td>Level 2</td>
<td>Supported for a single instance of integration.</td>
</tr>
<tr>
<td></td>
<td>Threat Intelligence</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trusted Security Circles</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vulnerability Response</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td>Service Management</td>
<td>Customer Service Management</td>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Facilities Service Management</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Field Service Management</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finance Service Automation</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HR Service Delivery</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal Service Management</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Marketing Service Management</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Planned Maintenance</td>
<td>Data only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Request Management</td>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service Management Core</td>
<td>No support</td>
<td></td>
</tr>
<tr>
<td>Product Suite</td>
<td>Application</td>
<td>Support level</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>ServiceNow Communities</td>
<td>Level 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Flow</td>
<td>Data only</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Domain separation setup and basic administration**

Setting up domain separation involves requesting activation of a plugin, setting options, and assigning users and records to domains.

Do the following to set up domain separation:

1. Request domain separation.
2. Access the Domain Configuration console.
3. Create a domain.
4. Add a user and a record to a domain.

You can also perform these basic administrative tasks on domains:

- Activate or deactivate a domain
- Use a custom table for the domain table
- Change domain visibility

See [Domain separation administration](#) for a list of tasks to perform after you set up domain separation and perform basic administration.

**Request domain separation**

All domain support features are activated with a plugin called Domain Support - Domain Extensions. Administrators can request activation of this plugin.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

Role required: none

If the Domain Support - Domain Extensions plugin is already active, content in the Domain Support - Domain Extensions plugin will not be installed to avoid potential conflict with an existing implementation.

Domain separation replaces Company Separation. However, if company separation is already active when you activate domain separation, both plugins are active at the same time. You can control the company separation activation status with the `glide.db.separation.field` property.

1. In the HI Service Portal, click **Service Requests > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
</tbody>
</table>
Specify the date and time you would like this plugin to be enabled | Date and time must be at least 2 business days from the current time.

Note: Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.

Reason/Comments | Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.

3. Click Submit.

Activating the Domain Extension plugin enables these features:

- Domain separation is based on the Domain [sys_domain] table.
- Delegated administration lets each domain have separate policy.
- All records are part of the global domain.
- The current user’s domain determines the domain to use when viewing or operating on a record in a different domain.

Access the Domain Configuration console

Use the Domain Configuration module to enable, configure, and view the status of domain separation support.

You can set domain separation configuration options, such as selecting the domain table and enabling delegated administration. You can also view domain alerts.

1. Navigate to **Domain Admin > Configuration**
   The Domains Configuration page displays
2. Configure the following Domain Separation options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Domain Table| Select the table containing domain names for domain separation. You can select any existing table. By default, the system uses the Domain (domain) table.  

**Warning:** No domain can have the name `global`. Verify that the name `global` is not used in any of the domain names in the table before saving the domain configuration.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Domain Validation          | Lists any current validation issues. Click the More link to see validation troubleshooting options. Options include:  
  - Validate domains hierarchy  
  - Show tables with the Domain field  
  - Reset all records to Global |
| Domain Progress Workers    | Lists any currently running conversion or validation processes.              |
| Domain Alerts              | Lists any information, warning, or error messages relating to domain separation. You can also find this information in the instance log. |
| Enable Domain Separation   | Select whether to enable or disable domain separation. By default, domain separation is enabled. You can manually disable domain separation with this setting. However, the sys_domain column will still be present on any table it was added to. This option maps to the system property glide.sys.domain.partitioning. |
| Enable Delegated Administration | Select whether to enable or disable delegated administration. Activating the plugin automatically enables delegated administration. You can manually disable delegated administration with this setting. This option maps to the system property glide.sys.domain.delegated_administration. This property controls process separation. |
| Enable verbose domain logging | Select whether to enable additional debugging information for domain separation. This option maps to the system property glide.sys.domain.verbose. |

**Note:** When both glide.sys.domain.delegated_administration and glide.sys.domain.partitioning are disabled, all domains are disabled. Users logging in have their session domain set to **Global**.

**Create a domain**

You can create a domain by creating a record in the (domain) table.

Role required: admin

When creating a new domain, keep the following in mind:
  - Only one domain can be the default domain.
  - Only one domain can be the primary domain.

1. Navigate to **Domain Admin > Domains**.
2. Click **New**.
3. Fill in the necessary fields (see table).
4. Click **Submit**.

**Domain form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the domain.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a domain type that describes the domain. By default the domain types are Vendor, Customer, and MSP. You can also add your own choices.</td>
</tr>
<tr>
<td>Primary</td>
<td>Select the check box if this domain is to be the top-level domain in the hierarchy. The top-level domain only has child domains and no parent domains.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select the name of the domain higher in the hierarchy that contains this domain. This field must have a value for the domain to appear in the domain map.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to make the domain available for use. You must select this option for this domain to appear in the domain map.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the domain.</td>
</tr>
</tbody>
</table>

Each domain record can also have several related records:
- Companies
- Contains Domains
- Contained By
To change the domain hierarchy, go to the Contains Domains related list and select the domain records that is the child (contained) domains of the contains relationship.

**Add a user and a record to a domain**

By default, all users and records are part of the global domain and are therefore accessible to all users.

Role required: admin

To use data separation and delegated administration, you must first assign users and their relevant records to one or more domains.

1. Personalize the list or form to add the Domain field.
2. Set the Domain field for the user or record.

   For example, assign Bow Ruggeri to the Network domain. Assign Don Goodliffe to the Database domain. Add the Network and Database domains to relevant records such as incidents, configuration items, requests.

![Image](image_url)

**Make a domain the default**

The default domain is the domain to which the system automatically assigns task and user records that are not already assigned to a domain.

Role required: admin

1. Navigate to Domain Admin > Domains.
2. Open the domain you want to be the default domain. For example, Default.
3. Configure the form layout to add the Default field.
4. Select the Default check box.
5. Click Update.
Tasks and users without a domain are placed in this domain when created/updated. This behavior can be overridden by:
1) Unchecking the Default field on this record, or
2) Checking the Default field on another Domain record.
If no domain is set as Default, Tasks and Users with no domain are placed in the global domain.
Note: If you do not set a default domain, then new tasks and user records are placed in the global domain.

Use domain selection menus
Domain selection in an instance is available through the domain selector or the domain reference picker.

Domain selector
Provides a drop-down list of available domains

Domain reference picker
enables a reference field that offers filtering and an auto-complete, type-ahead entry feature. Use this format for longer lists.

The placement of these pickers and the procedure to show or hide them differ depending on the user interface version.

Enable domain selection menus in UI16
Displaying the domain picker in UI16 enables the domain selector by default. After enabling the domain selector, you can add a system property to enable the domain reference picker.

Role required: admin
1. Click the gear icon in the header.
2. On the General tab, click the Show domain picker in header switch.
   The domain selector appears in the UI16 header.
3. Optional: Enable the domain reference picker.
   a) Enter sys_properties.list in the application navigator.
   b) If not already present, add the glide.ui.domain_reference_picker.enabled property and set the value to true.
   c) Refresh the browser.

   The domain reference picker appears in the UI16 header.

Enable domain selection menus in UI15
Enable the domain selector or the domain reference picker. Use the domain reference picker with auto-complete for long lists that require excessive scrolling.

Role required: admin
On UI15, you must enable a UI macro.
1. Navigate to System UI > UI Macros.
2. Select a macro depending on the type of menu you want to enable.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain_select</td>
<td>Enables the domain selector</td>
</tr>
<tr>
<td>domain_reference_picker</td>
<td>Enables the domain reference picker</td>
</tr>
</tbody>
</table>

3. Select the **Active** check box, and click **Update**.

   **Note:** If using the domain reference picker, the `domain_select` macro must be set to `false`. If using the domain selector, the `domain_reference_picker` macro must be set to `false`.

4. Refresh the browser.

5. Click the gear icon in the banner frame to show the **Domain** field (UI15). The **Domain** field appears by default on the banner in UI11.
The domain selector for UI15
Restrict access to the domain picker

Use a system property to restrict access to the domain picker in UI16.

Role required: admin

By default, users with the itil role, and roles that include the itil role (such as the administrator), can access the domain picker in UI16. You can grant other roles access by adding them to the property or restrict roles by removing them.

1. Open the System Properties (sys_properties) table.
2. Add this property: glide.ui.domain_picker.role
3. Configure the property value as a comma-separated list of roles that you want to access the domain picker.

Restrict access to domain selection by role in UI15

You can include a comma-separated list of roles in domain-related UI macros to restrict access to domain selection by user role.

Role required: admin

This procedure is valid for the pre-UI16 interface. Starting with UI16, you must use a system property to control access to the domain picker. See Restrict access to the domain picker.

1. Navigate to System UI > UI Macros.
2. Select any of the four domain-related UI macros: two named `domain_select` and two named `domain_reference_picker`. There are two of each type. Two support different UIs. The UI macros with the Media Type field empty are for UI11, and the other two are for UI15.

3. Locate one of the following lines of code:
   - `domain_select`:
     ```javascript
     var ds = new DomainSelectControl("gsft_domain","itil","Domain","Domain");
     ```
   - `domain_reference_picker`:
     ```javascript
     var dp = new DomainPicker("${jvar_id}","itil","DomainReference","Domain");
     ```

4. Replace the parameter `itil` with a comma-separated list of roles to control who sees the domain selection menu.

Domain separation administration

Administrators can view information about domain separation, identify potential issues, and change configuration settings.

Manually manage the domain for particular records

By default, the system automatically assigns a domain based on the user’s company record. In some cases, however, domain administrators want to manually manage which domain a particular record belongs to.

Role required: admin

The Managed domain field allows domain administrators to manually select a domain for the user, group, department, location, or CI record, rather than using the domain assigned automatically from the company record. The Managed domain field is available on these record types.

- User records
- Group records
- Department records
- Location records
- CI records

1. Navigate to the record you want to manually manage.
2. Select the Managed domain check box.
3. From the Domain field, select the domain for the record.
4. Click Update.
Clearing the Managed domain check box hides Domain field and the record uses the domain value from the record’s company.

Activate or deactivate a domain

When you activate or deactivate a domain, the activation status cascades to companies within the domain.

Role required: admin

When you activate a company record, domain separation automatically activates the company’s associated domain. For example, if you activate the ACME company, then you also activate the TOP/ACME domain.

1. Navigate to the domain record.
2. Clear or select the Active check box.
3. Click Update.

Warning: Do not delete domains. Deactivate domains that you no longer need instead of deleting them.

Add a domain field to a table

Administrators can domain separate custom tables by adding a sys_domain field to it.
Role required: admin

1. Navigate to the table's list view. For example, type `<table name>.list` in the navigation filter.
2. Right-click the list header and select **Configure > List Layout**.
3. In the **Create new field** section, enter `sys_domain` as the **Name** and **Domain ID** as the **Type**.
4. Click **Add**.
5. Click **Save**.

**Note:** Any other means of creating a field adds a `u_` prefix to the column name. For domain separation to work the column name must be `sys_domain` without any `u_` prefix.

---

**Use a custom table for the domain table**

You can use a custom table as the domain table if the custom table contains a reference field column called `parent` that refers back to the custom table.

Role required: admin

1. Create a custom table to store the domain information. For example:

<table>
<thead>
<tr>
<th>Table</th>
<th>Column name</th>
<th>Type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_organization</td>
<td>u_name</td>
<td>string</td>
<td></td>
</tr>
<tr>
<td>u_organization</td>
<td>u_description</td>
<td>string</td>
<td></td>
</tr>
<tr>
<td>u_organization</td>
<td>u_location</td>
<td>reference</td>
<td>cmn_location</td>
</tr>
</tbody>
</table>

2. Create a reference field within the custom table that refers back to the custom table. For example:

<table>
<thead>
<tr>
<th>Table</th>
<th>Column name</th>
<th>Type</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>u_organization</td>
<td>parent</td>
<td>reference</td>
<td>u_organization</td>
</tr>
</tbody>
</table>
3. Select the custom the table from the list of tables in the New Domain Table list.
4. Click **Reset Data** to make these changes:
   - The domain table changes to the table you selected.
   - All existing records with a domain value are reset to the global domain.
   - All existing domain overrides are deleted.
   - All existing domain contains definitions are deleted.
   - All existing domain visibility settings, both user and group, are deleted.

5. Click **Ignore Data** to make these changes:
   - The domain table changes to the table you selected.
   - All domain visibility settings, both user and group, are deleted.
   - All existing records with a domain value refer to invalid domains until you migrate the domain data.
   - All existing domain overrides refer to invalid domains until you migrate the domain data.
   - All existing domain contains definitions refer to invalid domains until you migrate the domain data.

**Note:** Visibility settings are deleted whenever the domain table reference changes.

When you select the ignore option, no existing domain-separated tables are moved to the global domain, and it is your responsibility to migrate the domain records. Until the migration is complete, the domain validator shows warnings about inconsistent domain
data. If necessary, you can manually reset all domain-separated tables to the global domain.

Create contains relationships between domains

Creating a contains relationship between domains changes the domain hierarchy.

Role required: admin

Domains in a contains relationship inherit the visibility settings of the containing domain. The containing domain allows users to see data in the contained domain as well as any of its children. Processes are unaffected by a contains relationship.

1. Navigate to the domain table.
2. Select the domain record that is the parent (container) domain of the new contains relationship.
3. Toggle the domain scope to switch between the session scope and record scope, if necessary.
4. From the Contains Domains related list, click Edit.
5. Select the domain records that is the child (contained) domains of the contains relationship. Only child domains appear by default when the domain picker is set to Global. Toggle the domain scope to see all domains in slushbucket.
6. Click Save, and then click Update.

Add domains to a visibility domains list

Adding a visibility domain allows a user or group to see and potentially edit records from another domain regardless of the user or group’s normal domain membership.

Role required: admin

Assigning visibility domains to all members of a group is preferred over granting them to individual users.

Note: Adding a visibility domain does not change a table or record’s access control rule requirements.

1. Navigate to the domain table.
2. Select the group you want to provide with visibility domains.
3. Add the Visibility domains related list to the form.
4. From the Visibility domains related list, click Edit.
5. Select the domain records you want the group or domain to see.
6. Click **Save**, and then click **Update**.

---

**Grant visibility domains to an individual user**

You can add visibility domains for specific users on the User form.

Role required: admin

1. Navigate to **User Administration > User**.
2. Select the user you want to provide with visibility domains.
3. Add the **Visibility domains** related list to the form.
4. From the Visibility Domains related list, click **Edit**.
5. Select the domains whose records you want the user to see.
6. Click **Save**, and then click **Update**.

---

### The Visibility domain embedded list contains the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Domain that is visible to the group or user.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Domain is inherited from domain visibility or a parent domain.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Granted By</td>
<td>Name of the group that granted domain visibility.</td>
</tr>
<tr>
<td>Parent visibility</td>
<td>Name of the parent domain and used for grouping records. If the parent record is deleted, then all records with the same parent are deleted as well.</td>
</tr>
</tbody>
</table>

### Select a primary domain

The primary domain indicates the top-level domain in the domain map.

Role required: admin

The primary domain cannot have a parent domain and must have at least one child domain. There can only be one primary domain at a time. If you select another domain as the primary domain, it overrides the previous primary domain.

1. Navigate to Domain Admin > Domains.
2. Select the domain you want to be the primary domain. For example, TOP.
3. Select the Primary check box.
4. Click Update.
Top level, process flows down from here. Overrides from global process are done here.
Create a domain-specific choice list

Administrators can configure choice lists to contain entries specific to a particular domain.

Role required: admin

1. Select the domain from domain picker where the choice should be added.
2. Right-click the field and select Configure Choices.
3. Update or add choices.
4. Push changes through the normal change process such as update sets.

**Note:** Administrators should ensure that choices are unique across domains to prevent administrative confusion in the global domain.

If an administrator adds a new choice from the global domain, then users from domains lower in the hierarchy see the new choice at the end of their current choice lists. If the new choice is not active at the global level, then it is available to the domain users via Configure Choices but does not show as an active choice.

Validate domain hierarchy

By default, the instance validates the domain hierarchy every time you change the domain table, change the query method, or reset the records to the global domain.

Role required: admin

Domain hierarchy validation might take an excessive amount of time if there are a large amount of records in a table.

The Domain Progress Workers list displays any currently running domain tasks. Use the following procedure to manually start the validation process.

**Note:** Domain paths are used for all customers on Helsinki and later. Domain numbering is no longer used. ServiceNow Technical Support can assist in the upgrade. When you create a domain or update the parent of a domain, the system runs a scheduled job to recalculate domain paths. The result of the scheduled job, use the following URL: https://<your-instance-name>/syslog_domain_list.do

1. Navigate to Domain Admin > Configuration.
2. From Domain Validation, click More > Validate domains hierarchy.
3. After the validation process completes, review the Domain Alerts section for any renumbering or path conversion errors.

The domain validation process automatically fixes some validation errors and provides information about errors that cannot be automatically fixed.
If domain hierarchy validation takes an excessive amount of time due to a large number of records in a table, you can exclude these tables from the validation process. To do so,

1. Add this property to the System Properties (sys_properties) table:
   
   glide.sys.domain.validation_skip_threshold.

2. Set the integer value to the maximum number of records that a table can have for it to be validated. Tables with a larger number of records than this value are not validated. The default value is 5000000.

You can also view the domain log by click a domain log record.
<table>
<thead>
<tr>
<th>Created</th>
<th>Level</th>
<th>Message</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>2016-02-25</td>
<td>Error</td>
<td>2 records detected in 'sys_table' that are not in any existing domain and DomainPath:</td>
<td>com.glide.domain.validator</td>
</tr>
<tr>
<td>25 13:19:38</td>
<td></td>
<td>DomainPath. Fix the domain value in these records &amp; run validator again.</td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Error</td>
<td>2 records detected in 'sys_table' that are not in any existing domain and DomainPath:</td>
<td>com.glide.domain.validator</td>
</tr>
<tr>
<td>25 12:20:15</td>
<td></td>
<td>DomainPath. Fix the domain value in these records &amp; run validator again.</td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Domain validation completed with no issues</td>
<td>com.glide.domain.validator</td>
</tr>
<tr>
<td>25 12:25:51</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Domain validation completed with no issues</td>
<td>com.glide.domain.validator</td>
</tr>
<tr>
<td>25 12:25:50</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: Cisco; remaining domains in the table: 5; remaining tables: 12.</td>
<td>com.glide.domain.cisco</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: Cisco; if of rows affected: 3</td>
<td>com.glide.domain.cisco</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: global; if of rows affected: 119.</td>
<td>com.glide.domain.global</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: global; if of rows affected: 560.</td>
<td>com.glide.domain.global</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: global; if of rows affected: 9</td>
<td>com.glide.domain.global</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: global; if of rows affected: 5</td>
<td>com.glide.domain.global</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user' for domain: global; if of rows affected: 22</td>
<td>com.glide.domain.global</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
<tr>
<td>2016-02-25</td>
<td>Information</td>
<td>Updated table 'sys_user_group' for domain: Cisco; remaining domains in the table: 5; remaining tables: 9.</td>
<td>com.glide.domain.cisco</td>
</tr>
<tr>
<td>25 12:23:56</td>
<td></td>
<td></td>
<td>sys_domain</td>
</tr>
</tbody>
</table>
View domain relationships

The domain map offers domain administrators a read-only representation of the active domains on the instance and how they relate to each other.

Role required: admin

All domain maps must have one domain set as the primary domain. In addition, each domain in the domain map must meet these criteria:

- The Parent field must be filled in (the primary domain is the only exception to this).
- The Active check box must be selected.

The domain map does not draw domain relationships for domains that fail to meet the mapping criteria.

1. Navigate to Domain Admin > Domain Map.
2. Click the plus (+) or minus (-) icons on the domain headers to show or hide sub domains.

View a list of tables using domain separation

You can view a list of all domain-separated tables from the Configuration module.

Role required: admin

1. Navigate to Domain Admin > Configuration.
2. From Domain Validation, click More > Show tables with Domain field.

Exempt roles from the current record domain

By default, all roles use the domain of the current record when Use the domain of the record being viewed instead of the user’s own property is true.

Role required: admin

You can provide a list of roles that ignore this property and always use the user’s domain rather than the record’s domain. You may want certain roles such as administrators to always work from their own domain rather than use the domain of the record they are viewing.

1. Navigate to Domain Admin > Configuration.
2. For List of roles (comma-separated) that will not trigger the automatic change of domain to the domain of the record that is being viewed, enter a comma-separated list of roles that ignore automatic domain change behaviors.
3. Click Save.

Reset all records to the global domain

You can manually reset all domain-separated records to the global domain at any time.

Role required: admin

⚠️ Warning: The only way to recover resetting records to the global domain is to restore from a data back-up.

1. Navigate to Domain Admin > Configuration.
2. From Domain Validation, click More > Reset all records to Global.

Manually re-enable domain separation

Use the following steps to manually re-enable domain separation if it was previously disabled.
Role required: admin

1. Navigate to Domain Admin > Configuration.
2. Select the domain table. For example, to navigate to the Group [sys_user_group] table, click User Administration > Groups.
3. Select the domain query method. For example, Switch to Domain Paths.
4. For Enable domain separation, select the Yes check box.
5. Click Save.

Change domain visibility

By default, when a user in the global domain views a table containing a sys_overrides column, the user sees records from only the global domain.

Role required: admin

1. Change the glide.sys.restrict_global_domain_processes property to true.
2. To view records from all domains, click Expand Domain Scope under Related Links.
3. To return to viewing records from the global domain only, click Collapse Domain Scope.

Delegated administration

Delegated administration allows administrators to set domain-specific policies.

The policies set lower in the domain hierarchy override policies set higher in the domain hierarchy. While in a domain, administrators can set domain-specific versions of these global policies and settings:

- Client scripts
- System policies
- Application and module names
- Application roles
- Module filters

⚠️ Warning: All users with the admin role have special access to all system features, functions, and data because administrators can override ACL rules and pass all role checks. Grant this privilege carefully.

When users have the admin role, then all policies in the instance are available to them regardless of the assigned domain. They can enter a specific domain, and then only policies in that domain or higher are visible and processed during a relevant transaction. When an administrator modifies a policy that is in a higher domain or the global domain, the system automatically creates a new record for that administrator’s current domain. It does not modify the original policy, application, or module record. This new record overrides the original.

To make changes to a policy in a lower-level domain, go into that domain and modify the policy. This approach creates the new policy record in your domain that overrides the original, higher-level policy record.

Do not make changes on the higher-level policy and then change the Domain field on that policy. This approach does not create a policy record in your lower-level domain, nor does it keep the policy record for the higher-level domain.

The sys_overrides field indicates that a policy, application, or module at a lower level in the hierarchy overrides a record at a higher level. The system automatically sets this field when an administrator attempts to modify a policy, application, or module that belongs to another domain higher in the hierarchy. Again, rather than actually changing the higher level record,
the attempted update is changed into an insert, and the `sys_overrides` field is set to indicate the higher level policy, application, or module that is being overridden. Later when the records for a relevant transaction are loaded, the overriding domain-specific policy, application, or module is used instead of the original.

**Domains for delegated administration**

By default, delegated administration always uses the record’s domain to determine what policies to apply.

The record’s domain takes precedence over the user’s domain. If there are no policies in the record’s domain, delegated administration checks for policies in the next highest level of the domain hierarchy. The search for domain policies continues up the domain hierarchy until reaching the global domain. If there are no domain policies lower in the domain hierarchy, delegated administration uses the policies for the global domain.

For example, Fred Luddy is a user in the Database domain who can see records in the Database: Atlanta, Database: San Diego, and NY DB child domains. When he opens a record in the Database: San Diego domain, delegated administration first checks for policies in the Database: San Diego domain. If there are no policies at this level of the domain hierarchy, delegated administration checks for policies from the Database domain. If there are no policies in the Database domain, delegated administration uses the global domain policies as there are no other domains higher in the domain hierarchy.

**Example delegated administration with domain specific applications**

The following example illustrates delegated administration with domain-specific applications and modules.

As the administrator of the Database domain, David Loo decides to customize the Configuration application. To start with, David reviews the modules available in the Configuration application module.
Starting view of the Configuration application

David decides to rename the Configuration application to CMDB and to allow the inventory_admin role to see the application.
### Sample domain-specific changes to the Configuration application

<table>
<thead>
<tr>
<th>Title</th>
<th>Active</th>
<th>Order</th>
<th>Roles</th>
<th>Name</th>
<th>Domain</th>
<th>Overrides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Management</td>
<td>true</td>
<td>900</td>
<td>admin</td>
<td>asset</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>BSM Map</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>bsm_map</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>true</td>
<td>400</td>
<td>itil</td>
<td>change_management</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>CMDB</td>
<td>true</td>
<td>600</td>
<td>inventory_admin</td>
<td>configuration_management</td>
<td>global</td>
<td>Database configuration_management</td>
</tr>
<tr>
<td>Content Management</td>
<td>true</td>
<td></td>
<td>content_admin</td>
<td>cms</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Contract Management</td>
<td>true</td>
<td>1,000</td>
<td>asset</td>
<td>contract_manager</td>
<td>asset_contacts</td>
<td>global</td>
</tr>
<tr>
<td>Domain Admin</td>
<td>true</td>
<td></td>
<td>domain_admin</td>
<td>domain_admin</td>
<td>domain_admin</td>
<td>global</td>
</tr>
<tr>
<td>ECC</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>ecc</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Homepage Admin</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>home</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Incident</td>
<td>true</td>
<td>200</td>
<td>itil</td>
<td>incident_management</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Instance Clone</td>
<td>true</td>
<td></td>
<td>clone_admin</td>
<td>instance_clone</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>true</td>
<td>800</td>
<td>knowledge</td>
<td>km</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Metrics</td>
<td>true</td>
<td></td>
<td>itil_admin</td>
<td>metric_admin</td>
<td>metrics</td>
<td>global</td>
</tr>
<tr>
<td>MID Server</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>MID</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Organization Management</td>
<td>true</td>
<td>675</td>
<td>asset</td>
<td>organization_management</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>true</td>
<td>300</td>
<td>itil</td>
<td>problem_management</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>true</td>
<td>1,100</td>
<td>itil</td>
<td>reports</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>SAML 2 Single Sign-on</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>saml_2_single_sign_on</td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>SAML Single Sign-on</td>
<td>true</td>
<td></td>
<td>admin</td>
<td>SAML Single Sign-on</td>
<td>global</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Next, David decides to change the Incident application by activating the **Open - in "New" State** module and adding a new filter item to show open incidents in the Database category.

**Sample domain-specific changes to the Open - "New" State module**

This creates a new module entry in the application rather than overwriting the existing module in the global domain.
## Application

<table>
<thead>
<tr>
<th>Title</th>
<th>Table</th>
<th>Active</th>
<th>Filter</th>
<th>Order</th>
<th>Link Type</th>
<th>Roles</th>
<th>Domain</th>
<th>Overrides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New</td>
<td>incident</td>
<td>true</td>
<td></td>
<td>100</td>
<td>URL (from Arguments)</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Assigned to me</td>
<td>incident</td>
<td>true</td>
<td>active=true*assigned_to=javascript:,...</td>
<td>150</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>incident</td>
<td>true</td>
<td>active=true*EQ</td>
<td>200</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Open - &quot;New&quot; state</td>
<td>incident</td>
<td>true</td>
<td>incident_state = &quot;new&quot;</td>
<td>200</td>
<td>List of Records</td>
<td></td>
<td>Database</td>
<td>incident</td>
</tr>
<tr>
<td>Open - Unassigned</td>
<td>incident</td>
<td>true</td>
<td>assigned_to=*state*=NUL<em>active=true</em>EQ</td>
<td>300</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>incident</td>
<td>true</td>
<td>state=*EQ</td>
<td>325</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>incident</td>
<td>true</td>
<td>active=false*EQ</td>
<td>350</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>All</td>
<td>incident</td>
<td>true</td>
<td></td>
<td>400</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>incident</td>
<td>true</td>
<td></td>
<td>500</td>
<td>URL (from Arguments)</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Critical Incidents Map</td>
<td>true</td>
<td>true</td>
<td></td>
<td>600</td>
<td>URL (from Arguments)</td>
<td></td>
<td>global</td>
<td></td>
</tr>
<tr>
<td>Trend Chart</td>
<td>sys_dashboard_template</td>
<td>false</td>
<td></td>
<td>700</td>
<td>List of Records</td>
<td></td>
<td>global</td>
<td></td>
</tr>
</tbody>
</table>
If another administrator from another domain, such as Fred Luddy, logs in and looks at the Configuration application, the settings from the global domain appear.

David Loo’s view of applications
Example delegated administration with domain specific policies

The following example illustrates delegated administration with domain-specific policies.

In this hierarchy, David Loo is in the Database domain and Don Goodliffe is in the Database/Database San Diego domain.

To begin, David Loo makes a change to the global assignment policy. Then Don Goodliffe also makes a change to the same policy. Initially, all assignment rules have a global domain as shown below:
Global domain rules

If David Loo updates the assignment rule for Database or Software, the following list appears:

Database domain-specific rules

The following policy changes occur:
When the policy is chosen and updated, the system detects that David Loo is not at the right level of the hierarchy to change this record. Therefore, the update is changed into an insert, and a new record is created.

The new policy has the same name (Database or Software).

Notice that this policy is in the Database domain and overrides the policy that previously applied (Database or Software). Notice that there are now two policy entries with the same name. Because this is not desirable, David opens the record and changes the name to something appropriate. After the update, the list appears as follows.

Renamed database or software to database specific policy

This time, the record being updated is at the same level in the domain hierarchy as the user, so the record is updated with a more appropriate name. Here is the resulting rule. Notice that database incidents are directly assigned to David.
Database specific policy assignment rule

If a new incident is created in the Database domain or lower in the hierarchy, the new rule is applied. It has overridden the global assignment rule. If a new incident is created in the global domain or any other domain not within the Database domain hierarchy, then the global rule applies.
In the following scenario, Don Goodliffe, in the Database/Database San Diego domain hierarchy, decides that database incidents created in his domain should be assigned to him rather than to David Loo. As an administrator, Don Goodliffe starts out with the following assignment policy:

![Assignment Rules Table]

Don Goodliffe's starting view of assignment rules

Notice that this level of the hierarchy starts out with the policy established at the parent level (the Database domain). After changing the **Database-Specific Policy**, the list looks like this:
Database San Diego rules override Database-specific policy rules

Again, the attempted update is changed automatically to an insert, and the override value is supplied to indicate that the higher-level policy is being overridden. Here is the resulting rule; it shows that database incidents created in the Database San Diego domain are assigned to Don Goodliffe.
San Diego specific policy

The result of the above customization is:

- A database incident from the Database San Diego domain is assigned to Don Goodliffee.
- A database incident from the Database hierarchy other than Database San Diego is assigned to David Loo.
• A database incident from any other domain, including global, is assigned to the system administrator.

The above customizations all show changes to higher-level policy. However, new policy can also be created at any level of the domain hierarchy.

During a transaction, the current user’s domain normally determines the policy to load. For example when a user in the Database domain updates an incident, the Database domain is used for business rules and policies even if the incident record was originally created in the Database San Diego domain. By default, the user’s domain supersedes the record’s domain.

There is a system setting that can change this behavior. If **Using the Current Record’s Domain Instead of the Current User’s Domain** is set to **true**, then the above behavior is reversed. The domain of the record is used to determine which policy to load, not the domain of the user. For example if a user in the Database domain updates an incident that is in the Database San Diego domain, then the business rules and policy that exist for Database San Diego are executed. The domain of the user still determines the records that are visible to the user, and the domain of the user sets the domain for records that user creates, but is not a factor in determining rules and policies.

**Manually re-enable delegated administration**

Delegated administration allows administrators in lower portions of the domain hierarchy to add domain-specific policies that override policies set higher in the domain hierarchy.

Role required: admin

By default, activating domain separation enables delegated administration. Use the following steps to manually re-enable delegated administration if it was previously disabled.

1. Navigate to **Domain Admin > Configuration**.
2. For **Enable delegated administration**, select the **Yes** check box.
3. Click **Save**.

**Troubleshoot domain separation errors**

If you encounter domain separation issues, review this list of solutions.
<table>
<thead>
<tr>
<th>Error or symptom</th>
<th>Solution</th>
</tr>
</thead>
</table>
| A domain sys_id points to a non-existent domain      | This error occurs when a data record, such as a user or task record, has a sys_domain column value whose sys_id does not exist in the current domain table. The domain sys_id could have been accidentally deleted or it could refer to a previous domain table if you changed the domain table.  
   To fix the error, open a list for the table containing the error, filter on the invalid sys_domain value. Then, either manually enter the correct sys_domain value or remove it.  
   **Note:** You can have invalid domain sys_ids in any table that references the domain table. For example, invalid domain IDs can occur in the User Visibility Domain [sys_user_visibility], Group Visibility Domain [sys_user_group_visibility], and Contained Domain [domain_contains] tables. |
| A domain path or domain number sys_id points to the wrong domain | This error occurs when a domain number or domain path query is out of sync with the actual domain name. This error can occur with domain numbers when adding domains requires renumbering or during the conversion from domain numbers to domain paths.  
   To fix the error, validate the domain tree and let the background conversion process run to completion. If the error persists, you can manually edit the value for the sys_domain_path or sys_domain_number columns to point to the proper domain. |
| The domain tree structure is corrupt                  | This error occurs if there is a series of domain contains relationships that create an infinite loop among domains.  
   To fix the error, open a list for the domain table and manually edit the domain contains values to not form a loop. |

**Enable verbose domain logging and debug messages**

Domain log and debug messages allow you to troubleshoot domain configuration errors.

Role required: admin

1. Navigate to Domain Admin > Configuration.
2. For **Enable verbose domain logging**, select the Yes check box.
3. Click Save.

**View a real-time domain message**

You can view real-time domain messages from the system logs.
Role required: admin

1. Enable verbose domain logging.
2. Navigate to System Diagnostics > Session Debug > Enable All. Because this is a real time review, there is no need to let the debug session run for a time before checking the log files.
4. Search for the text Query against table.

This query finds log messages in this format:

```
08:36:43.974: [Domain Spool] Query against table incident restricted by domain values [Database Atlanta[db53580b0a0a0a6501aa37c294a2ba6b], Database[287ee6fe9fe198100ada7950d0b1b73], Database San Diego[db53a9290a0a650091abebccf833c6], global, NY DB[5f74727dc0a8010e01efe33a251993f9]]
```

In this example, the user viewing the Incident table only saw records that matched the Database Atlanta, Database, Database San Diego, global, and NY DB domains.

---

**View a historical domain message**

You can view historical domain messages in the log file to troubleshoot domain separation issues.

Role required: admin

1. Enable verbose domain logging.
2. Navigate to System Diagnostics > Session Debug > Enable All.
3. Let the debug session run for a time period, such as a day, before checking the log files.
5. Open the record for the day you want to view. Log files use the naming format localhost_log.<yyyy-mm-dd>.txt.
6. Click the Download log related link.
7. Open the downloaded log file in a text editor and search for log messages with the following format:

   Query against table incident restricted by domain values [global, Software[8a4dde73c6112278017a6a4baf547aa7]]

In this example, a user only saw records from the Incident table that matched the global and Software domains.

---

**Virtual Private Network (VPN)**

Use a virtual private network (VPN) to integrate your instance with external data sources over the Internet.

When configuring an integration that uses an encrypted protocol, such as Lightweight Directory Access Protocol (LDAP) or HTTPS, it is good practice to use the Internet as a transport mechanism.

However, there may be security or network architecture requirements that dictate the use of a site-to-site Internet Protocol Security (IPSEC) Virtual Private Network (VPN) connection between the data centers and your business networks. The VPN supports the necessary encrypted communication between the instance and your network.

This video describes how to locate the IP addresses for each of your company's instances.
VPN connections

The ServiceNow VPN infrastructure uses pairs of Cisco adaptive security appliance (ASA) devices that serve as VPN termination points.

The VPN between the instance and your network utilizes your existing networking hardware to support communications. It is not necessary to install a piece of hardware. Because each customer has a unique configuration, the instance has a flexible VPN solution. The instance has built tunnels to Checkpoint, Juniper, Nortel, and other IPSEC VPN-capable devices.

The VPN connections between the instance and your network are created to support the encrypted flow of traffic into your network. Frequently, integrations that use the VPN do not have encryption as part of the underlying protocol. For example, LDAP over the VPN versus LDAPS over the Internet and HTTP over the VPN versus HTTPS over the Internet.

The network does not allow any inbound-to-ServiceNow integration or end-user-to-ServiceNow traffic to traverse a VPN connection. This restricted communication includes end-user access to the platform, administration of the platform, web services integrations, and other integrations that are configured to use a MID Server. All such inbound communication to the instance must be performed over the Internet using HTTPS. This configuration provides an encrypted communication channel. The encryption channel, along with IP access control, meets the security requirements for this traffic flow.

Addresses for VPN communication

To prevent conflict or overlap with internal ServiceNow networks or with another internal IP address schemes in your network, all tunneled traffic in the encryption domain must use non-RFC-1918 addresses on both sides of the tunnel.

ServiceNow provides a single IP address for the source of queries into your network. You must provide Network Address Translation (NAT), non-RFC-1918 addresses for each host that is integrating with your instance. These public addresses need to be owned by your organization. Third-party addresses cannot be used inside tunnels. Additionally, the encryption domain must not contain the IP address of the VPN peer.

Redundant tunnels

There are two ways to build redundancy for your tunnels:

- Using the same encryption domain behind both of your peers. This is the preferred method.
- Using a different encryption domain behind each peer.

With the first method, you need to provide the same NAT address behind each of your peers to create a connection path using that address to your server. The path to your server could be the same physical machine or a mirror which provides identical services. With this method, your instance would use the same IP address to connect to your servers regardless of whether
your primary or secondary tunnel is active. If you have more than one server, follow this same scheme for your additional servers. This method provides the most transparency to your users and is recommended.

The second method requires configuration in your instance to provide the redundancy. When the tunnel is used for LDAP, for example, you could provide redundant LDAP servers in your instance. Note that this method requires the connection to the first configured LDAP server to timeout before the instance attempts to connect to the secondary server. Because of this additional time delay, this solution should only be implemented if the first option is unattainable. Also note that not all services can be configured for redundantly in your instance. If you are using a VPN tunnel for something other than LDAP and redundancy is required, check that your configuration can support multiple addresses, or see the first option above.

Alternatives to using a VPN

These alternatives provide a simpler way to connect your instance to the resources in the ServiceNow data centers and provide better encryption. Additionally, you can avoid any issues that VPN downtime might cause, such as making your instance unavailable to users if there is an issue with the VPN tunnel.

Single sign-on and MID server

Consider using a combination of Single Sign-On (SSO) for authentication and the MID Server for user data synchronization, rather than using a VPN to connect your LDAP server to your instance. For integrations other than LDAP, consider using certificate-based encryption.

You can use:

- The Okta for single sign-on (see OKTA SSO integration) for more information.
- The LDAP listener on a MID server to synchronize your user table in near real time.

The advantage of this approach is that there are no firewall holes, routes, VPN tunnels, or other special network settings to configure and maintain. The SSO/MID-Server solution is the most flexible, secure, and cost-effective method to achieve the complete LDAP integration.

LDAP over SSL

Another alternative to using a VPN tunnel is to configure LDAP Over SSL (LDAPS) directly over the Internet. You can configure a read-only domain controller and lock the instance down in your DMZ using only the instance’s source addresses and the destination ports of your choice. Since the ports for LDAP are configurable in your instance, you can perform a port address translation (PAT) if desired. With LDAPS, you control the certificate that is uploaded over an encrypted channel to the instance, (see Upload a certificate to an instance). The packets cannot be encrypted or decrypted without the certificate.

The advantage of this approach is that it provides a stronger encryption and decryption mechanism. A VPN can only encrypt and decrypt the traffic between the two peers sitting on the Internet with a coordinated pre-shared key, similar to a password. LDAPS provides a longer encrypted path, end-to-end, at the application layer and with a certificate that is far more complicated than a pre-shared key that the IPSec tunnel uses.

VPN setup

From the time that a VPN request is submitted, it typically takes one week or less to complete the VPN build. To support the redundancy requirements of your instance and your organization, a
minimum of two and a maximum of four VPNs are provisioned (from the active site to your active site or the active site to your DR site, and so on).

It is good practice for the encryption domain to be as specific as possible. Ideally, the encryption domain would include only the specific hosts that are required for the integrations. A large encryption domain can create opportunities for routing discrepancies (VPN versus Internet).

To create the VPN, the instance does the following:

1. Provides the VPN peer and host addresses from each data center.
2. Builds the necessary VPN connectivity from two data centers into your network. To support redundancy and disaster recovery (DR) requirements, the VPNs can be provisioned from two data centers into two networks.

The instance does not support building multiple VPN tunnels into a customer network for the purpose of connecting to multiple geographic regions or subsidiaries. You should perform any inter-site routing, traffic distribution, or traffic shaping within your own internal network, rather than having multiple VPN tunnels.

**Request a VPN service**

For all VPN requests, including provisioning, modifications, or general questions, use the Service Catalog VPN Request form.

1. Open [Hi]
2. Navigate to **Self-Service** > **Service Requests** > **VPN Requests**.
3. Select the appropriate VPN request type.
4. Answer the questions. Questions vary depending on the request type selected.
5. Click **Submit**.

Once your request is submitted, ServiceNow will work with your network engineer(s) to test and validate that the VPN is successfully passing traffic. To ensure that your questions are answered in a timely manner, please address VPN-related questions during this process.

**Create an address for VPN communication**

To prevent conflict or overlap with internal ServiceNow networks or with another customer’s internal IP address schemes, the instance requires that all tunneled traffic in the encryption domain use non-RFC-1918 addresses on both sides of the tunnel.

The instance provides a single IP address for the source of queries into your network.

- Provide Network Address Translation (NAT), non-RFC-1918 addresses for each host that is integrating with the instance.

**Encryption support**

Use encryption contexts to allow or deny access to sensitive data based on user role.

Encryption and decryption occur on the server, not in the user interface.

Users with access to the encryption context can see data encrypted with that particular encryption context. The encryption process requires an administrator to grant an *encryption context* to users by granting the user an associated role.
After encryption:

- Encrypted text fields and attachments are no longer accessible by database tools and cannot be indexed.
- Encrypted text fields cannot be added to a filter.
- Encrypted text fields cannot be used to sort lists.

You can encrypt all String fields, including fields provided by default in the system and new fields that you create in the dictionary.

Access to encrypted data

A user’s encryption context determines access to encrypted data. Security_admin users can grant an encryption context to a user by granting the user an associated role.

To monitor the assignment of roles, the customer or ServiceNow professional services can set up security measures. For example, an email can be sent to an appointed encryption manager whenever a role associated with an encryption context is granted to a user.

<table>
<thead>
<tr>
<th>Access level</th>
<th>Data visibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>User with no encryption contexts</td>
<td>The form hides the encrypted field.</td>
</tr>
<tr>
<td>User with one encryption context</td>
<td>The user automatically uses their encryption context with encrypted text fields.</td>
</tr>
</tbody>
</table>

- **If there is no data in the field:** The form displays the encrypted field (assuming UI policy does not prevent it). Users with any encryption context can see empty encrypted fields. Entering data in the field causes the encrypted fields to use the currently selected encryption context to encrypt the data.
- **If there is data in the field:** If the user has access to the matching encryption context, the form displays the encrypted field.
### Access level | Data visibility
--- | ---
User with two or more encryption contexts | The user can select an encryption context from the selector in the welcome bar.

- **If there is no data in the field:** The form displays the encrypted field (assuming UI policy does not prevent it). Users with any encryption context can see empty encrypted fields. Entering data in the field causes the encrypted fields to use the currently selected encryption context to encrypt the data.

- **If there is data in the field:** If the user has access to the matching encryption context, the form displays the encrypted field. The encrypted field always uses the original encryption context to encrypt changes to the field. This prevents users with multiple encryption contexts from changing the encryption context of a field.

### Note:
A lock icon appears next to the field label to indicate an encrypted field. If a user has access to the encryption context, pointing to the icon displays the name of the context used to encrypt the field.

![Service Cost: $50/hr Encrypted: HR](image)

### Exporting data from encrypted text fields
When exporting encrypted text fields in a list or form to a file format, only fields encrypted by an encryption context available to the current user will display in the exported document.

By default, exporting encrypted data from a list view is disabled. To enable exports of encrypted data from a list view, add the `glide.encryption.export_encrypted_data.allowed` system property and set the value to `true`.

### Activate the Encryption Support plugin
You can activate the Encryption Support plugin (com.glide.encryption) if you have the admin role.

**Role required:** admin

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their activation status.
If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).

4. Optional: If available, select the **Load demo data** check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.

5. Click **Activate**.

### Set up encryption contexts

Administrators can create an encryption context that uses an encryption key.

Your instance can generate an encryption key, or you can generate your own key with a certificate authority. See your certificate authority documentation for information on creating an encryption key.

1. Navigate to **System Security > Encryption Contexts**.
2. Click **New**.
3. Enter the following:
   - Name: enter the text users see when selecting an encryption context.
   - Encryption key: do not change this field if you want the instance to randomly generate a key. Otherwise, enter the desired key (exactly 24-characters for Triple DES, or exactly 16-characters for AES 128-bit, or 32-characters for AES 256-bit).

   **Warning:** You cannot retrieve this key from the instance, so save it elsewhere before clicking **Submit** if you need it.

   - Type: select **AES 128-bit** for Advanced Encryption Standard, **Triple DES** for Triple Data Encryption Standard, or **AES 256-bit** if your system is configured for it.

4. Click **Submit**.

   The encryption key itself is encrypted with a key that is stored in the program, not in the database. This prevents other users from copying the key and using it to decrypt data.

5. Navigate to **System Security > Roles** and open the role to associate with the encryption context.
6. Configure the Roles form to add the Encryption context field.
7. Select the encryption context to associate with the role (there can be only one encryption context per role).
8. Click **Update**.

   Users must log out of the instance and log in again to use the encryption context.

### Add an encrypted text field to a form

Only a user with configuration rights, such as an administrator, can add an encrypted text field to a form. Encrypted text fields are installed with the Encryption Support plugin.
**Note:** When you convert an existing field to an encrypted field, make sure the field length matches the max length of the encrypted field type.

1. Configure a form.
2. Create a new field and set the Type to **Encrypted Text**.
3. Place the field where it should appear on the form.
4. Click **Save**.

**Add an encryption context selector**

The encryption context selector enables users who have multiple encryption contexts to select a context when entering data.

Only a user with the admin role can activate the encryption context selector.

1. Click **System UI > UI Macros**.
2. Open the encryption_select UI macro.
3. Select the **Active** check box.
4. Click **Update**.
5. Click the gear icon in the banner frame to open the System Settings window.
6. In the **General** tab, select the **Show encryption picker in header** switch.
7. Reload the page to see the choice list (if you have more than one encryption context).

The encryption context selector appears in the welcome banner only for users who have multiple roles with different encryption contexts.

**Note:** The selector appears only for users who have two or more encryption contexts to choose from. Users with either one or no encryption contexts do not see the selector.

**Use attachment encryption**

You can encrypt attachments that are already attached to records.

1. Log in as a user with at least one encryption context.
2. If more than one encryption context is available, select the encryption context for this session from the selector.
3. Navigate to a form which needs an attachment added, such as the Incident or Problem form, and click the attachment icon to open the Attachments dialog box.
4. Select the file to be attached.
   
   Only users with one or more encryption contexts see the Encrypt file check box below the file name.
5. Select the **Encrypt file** check box.
   
   Users with more than one encryption context are asked to confirm the encryption context. If you select a different encryption context, the encryption context selector updates to reflect the change.
6. Click **Attach** to upload the file attachment.

The file appears in the Current file attachments section of the form with a special icon indicating that it is encrypted. Pointing to the icon shows the name of the encryption context.
7. Click **Done**.

Attached files are listed across the top of the form. A special icon identifies encrypted files. Note that you can only see the encrypted files for which you have the encryption context.

**Encrypt a password in system properties**

The Encrypt SysProperty Password business rule automatically encrypts the value of any system property with the type password or password2.

The business rule encrypts passwords when you add a new value or update an existing one. After encrypting the password, the instance always stores and displays the encrypted password value. The instance only decrypts the password in memory and never saves a clear-text version.

After upgrading from an earlier version, encrypt existing properties that contain passwords by updating the value.

1. In the Type filter text, enter `sys_properties.list`.
2. Select the system property you want to encrypt.
3. Enter or update the Value to change the password.

4. Click **Update**.
The business rule encrypts the password.

Encryption scripting examples

There are several example scripts for you to use with encryption.

Encrypt unencrypted attachments

The following sample script encrypts unencrypted attachments, such as in the incident table.

```javascript
// Note: Impersonation does not change the encryption contexts available to a user. Even while impersonating, you have only the encryption contexts available to you originally.

bulkEncryption();

function bulkEncryption() {
  gs.log("*********** BULK ENCRYPTION RUN BY " + gs.getUserName());
  encryptAttachments("incident", "testContext");
  gs.log("*********** BULK ENCRYPTION COMPLETED");
}

// Note that whomever runs this script must have access to use the specified encryption context or nothing will happen when
// "changeEncryptionContext" is called except that a warning will appear
// in the log: WARNING *** WARNING *** Attempt to get
// cipher for encryption context 'contextName' without authorization
function encryptAttachments(table, encryptionContextName) {
  var contextGR = new GlideRecord("sys_encryption_context");
  contextGR.addQuery("name", encryptionContextName);
  contextGR.query();
  if (!contextGR.next()) {
    gs.log("*********** No such encryption context " + encryptionContextName);
    return 0;
  }
  var encryptionId = contextGR.getUniqueValue();
```
To write a script changing the encryption context from one context to another, access to both contexts is required.

### Set the encryption context ID

The function `setContextID` is provided to set the encryption context ID of an encrypted field in script.

The argument to the function is the `sys_id` of the encryption context you wish to use. The following example creates records with an encrypted field, `u_subspecies`, encrypted by the "Species Security" encryption context.

**Note:** The user who runs this script must have access to the encryption context.
return contextGR.getUniqueValue();
}

function createEncryptedRecord(commonName, genus, species, subspecies, encryptionID) {
    var newRecord = new GlideRecord("u_species_encrypted");
    newRecord.u_common_name = commonName;
    newRecord.u_genus = genus;
    newRecord.u_species = species;

    // We have one encrypted field, u_subspecies.
    newRecord.u_subspecies.setDisplayValue(subspecies);
    newRecord.u_subspecies.setContextID(encryptionID); // use our encryption context for the field
    newRecord.insert();
}

Remove encryption contexts

These functions remove an encryption context, or all encryption contexts, from those available to the user session.

This can be used by customers in a script to further limit the encryption contexts that are available to a user under certain conditions. For example, a synchronous Script Action triggered by the session.established event could remove all encryption contexts if a user was not connecting from an IP in a certain range.

if (some condition) {
    var contexts = gs.getSession().getEncryptionContext();
    contexts.removeAllContexts();
}

Individual encryption contexts can be removed as well using the sys_id of the encryption context.

if (some condition) {
    var contexts = gs.getSession().getEncryptionContext();
    contexts.removeContext("077d9b3307211000e2bb5720e1021e61");
}

Return a decrypted field value

You can return the field value for an encrypted field by using the getDisplayValue method.

Demonstration plugin

The instance provides a demonstration plugin called Encryption Support - Single Context Task Encryption Demo (com.snc.task_encryption.demo).

The demonstration plugin is meant to illustrate how to use business rules, UI actions, and UI policy to support encrypted fields. The plugin enforces a limit of one security context per record. The first person to add encrypted information to a record sets the context.

You should test the demonstration plugin on a non-production instance since it modifies the Task table and adds business rules and a UI policy. After activating the plugin:

1. Create one or more encryption contexts.
2. Configure the Incident form to add the Social security number, Credit card, and Encryption context fields.

The plugin UI actions are:

- Add Secure Info: appears on records without encrypted data and allows the user to display the social security numbers and credit card fields.
- Add Secure Info: appears on records without encrypted data and prompts the user to select an encryption context (if the user has more than one).
- Change Encryption: appears on records with encrypted data and prompts the user to select an encryption context (if the user has more than one).

The plugin business rules are:

- Form Single Encryption Context: ensures that each form only has one security context.
- Update on New Encrypted Attachment: ensures that each attachment has the same security context as the parent incident.

The plugin UI policies show the encrypted fields when appropriate.

System logs

The System Logs module provides a variety of logs that you can use to troubleshoot and debug transactions and events that take place within the instance.

Access the following logs from the System Logs module:

<table>
<thead>
<tr>
<th>Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>All browser activity for an instance.</td>
</tr>
<tr>
<td>Email and Push</td>
<td>All email notifications and Push messages sent from all instances within the system.</td>
</tr>
<tr>
<td>Events</td>
<td>All system events that occur within the system.</td>
</tr>
<tr>
<td>Import</td>
<td>Data import activity within the platform.</td>
</tr>
<tr>
<td>Table Changes</td>
<td>Changes made to all tables in the system.</td>
</tr>
<tr>
<td>Outbound HTTP Requests</td>
<td>All outbound web services requests such as REST and SOAP requests.</td>
</tr>
<tr>
<td>Signature Images</td>
<td>Electronic signatures for the HR signature pad.</td>
</tr>
<tr>
<td>System</td>
<td>Warnings and errors for instance processes, records, and non-critical events, such as memory usage on the server machine.</td>
</tr>
</tbody>
</table>

Use the Log File Browser to search and download logs. You can also search archived logs in the log history.

Other logs

Your instance offers other logs in addition to those in the System Log module. For example, the System Diagnostics menu provides upgrade history and slow query logs, which you can use to gain insight into how queries are affecting platform performance. The Customer updates table records every change that is made in the system.
System Diagnostics module

The System Diagnostics application provides logs that relate to the platform.

- **Upgrade History**: tracks every upgrade to an instance.
- **Slow Queries**: provides insight into how queries affect platform performance. See *Slow Query Logs*.

The System log

View warnings and errors for instance processes, records, and non-critical events, such as memory usage on the server machine.

The following information is tracked in the system log:

- Workflows
- Configuration
- Chats sessions
- Transactions for each view of each page in the system, including load times for network, server, and browser
- Inbound and outbound email
- Events triggered in the system
- Imports and integrations
- System warnings, errors, and script logs
- Upgrade information for any plugin activations, update sets, or system upgrades

This list view displays the log entries for the current day only. To view other log files, use the log file browser.

This log provides the following information for all occurrences:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time of the logging activity for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Level</td>
<td>Type of message displayed. The levels are Debug, Error, Warning, and Information. A warning is an error that has been handled and recovered. An error is something that must be fixed.</td>
</tr>
<tr>
<td>Message</td>
<td>System-generated message regarding the nature of the occurrence.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the process or area affected by the occurrence. For example, the source of the occurrence might be EMAIL or Memory.</td>
</tr>
</tbody>
</table>

Workflow logging

- Each activity executed, including:
  - Date and time started
  - Date and time ended
• State, for example, Finished, Cancelled, Timed Out, Error
• Result
• Fault description, if there was an error

• Transition history, including:
  • Time of transition
  • Activity transitioned from
  • Activity transitioned to
  • Which transition was triggered

• Workflow log, including any log statements added to the workflow

Configuration information

• Action taken, including insert, update, and delete
• Category of change
• Comments recorded with the change
• Name of the change
• XML difference of the change
• Update set the change is associated to
• Date and time of the change
• User who made the change
• Table where the change was made
• Name of the object being changed
• Type of object being changed
• View the change was made in, for changes to forms or lists

Transaction logs

The transaction log records all browser activity for an instance.
This log provides the following information for all activities.

Transaction log

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time of the browser action for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Created by</td>
<td>The user who created this activity.</td>
</tr>
<tr>
<td>Response time</td>
<td>Round trip response time for the browser request, in milliseconds.</td>
</tr>
<tr>
<td>Network time</td>
<td>Latency time of the network response after the browser request is made, in milliseconds.</td>
</tr>
<tr>
<td>Output length</td>
<td>Size of the output string sent by the instance to the browser, in bytes.</td>
</tr>
<tr>
<td>SQL count</td>
<td>Number of SQL server commands executed for this activity.</td>
</tr>
<tr>
<td>Business rule count</td>
<td>Number of business rules executed for this activity.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business rule time</td>
<td>Elapsed time for the execution of the business rules for this activity.</td>
</tr>
<tr>
<td>URL</td>
<td>The application or module connected to by the client browser.</td>
</tr>
<tr>
<td>System ID</td>
<td>System generated identifier of the client instance making the request. This ID is used for cluster environments in which several instances (nodes) communicate with the database.</td>
</tr>
<tr>
<td>IP address</td>
<td>IP address of the client making the request.</td>
</tr>
<tr>
<td>GZipped</td>
<td>Indication of whether a compressed Web page was requested by the browser.</td>
</tr>
<tr>
<td>Protocol</td>
<td>The HTTP protocol used by the browser for this instance.</td>
</tr>
</tbody>
</table>

### Client transaction timings

The Client Transaction Timings plugin enhances the system logs by providing more information on the durations of transactions between the client and the server.

By providing information on how time was spent during the transaction, performance issues can be tracked down to the source by seeing where the time is being consumed.

This plugin requires the Response Time Indicator to be enabled, and collects information from the following browsers:
- Firefox
- Internet Explorer
- Chrome

### Client Transactions Information

Installing the plugin adds the module Client Transactions to the System Logs application, which provides a list of every logged transaction between client and server within the last day. The following information is tracked:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>The moment the transaction was recorded.</td>
</tr>
<tr>
<td>Response Time</td>
<td>The number of ms spent by the server in fulfilling the transaction.</td>
</tr>
<tr>
<td>Business Rule Time</td>
<td>The number of ms spent by business rules triggered by the transaction.</td>
</tr>
<tr>
<td>SQL Time</td>
<td>The number of ms spent by the SQL database.</td>
</tr>
<tr>
<td>Client Response Time</td>
<td>(Load_completion_time) - (start_time). It is inclusive of server time.</td>
</tr>
<tr>
<td>Client Network Time</td>
<td>The number of ms spent by the network the client is connecting through.</td>
</tr>
<tr>
<td>Browser Time</td>
<td>The number of ms spent by the browser during the transaction.</td>
</tr>
<tr>
<td>Client Script Time</td>
<td>The number of ms spent executing client scripts</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>UI Policy Time</td>
<td>The number of ms spent executing ui policy</td>
</tr>
<tr>
<td>Type</td>
<td>Type of transaction (one of Form, List, Other)</td>
</tr>
<tr>
<td>Table</td>
<td>The table that was displayed e.g. incident, change_request</td>
</tr>
<tr>
<td>View</td>
<td>The view for this form/list</td>
</tr>
</tbody>
</table>

Client Detailed Information

A more detailed breakdown of the client timings for all Form rendering (but not list rendering) is also tracked. To see details, drill into a particular client transaction record and observe the related list at the base of the screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The order during the load that this operation occurred</td>
</tr>
<tr>
<td>Type</td>
<td>The type of operation</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name of this particular operation</td>
</tr>
<tr>
<td>Duration</td>
<td>Number of ms this particular operation took to complete</td>
</tr>
</tbody>
</table>

Event logs

The event log records all system events that occur within the system.

This log provides the following information for all events that occur:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time of the event for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the event as listed in the Event Registry.</td>
</tr>
<tr>
<td>URI</td>
<td>HTTP query that generated the event.</td>
</tr>
<tr>
<td>Parm1</td>
<td>Event-specific value that depends on the event and the recipient.</td>
</tr>
<tr>
<td>Parm2</td>
<td>Event-specific value that depends on the event and the recipient.</td>
</tr>
<tr>
<td>Table</td>
<td>Database table acted on for this event.</td>
</tr>
<tr>
<td>Processed</td>
<td>Date and time the event was processed This time reflects the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Processing time</td>
<td>Time taken to process this event, in milliseconds.</td>
</tr>
<tr>
<td>Queue</td>
<td>Processor queue name.</td>
</tr>
</tbody>
</table>
# Email logs

The email log records all email notifications sent from the instance.

This is a verbose and unfiltered view of email. For a more detailed view, see the System Mailbox application.

This log provides the following information for all notifications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>The system mailbox to use for filtering the email notifications displayed.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the notification (Error, Ignored, Processed, or Ready).</td>
</tr>
<tr>
<td>Receive type</td>
<td>The type of inbound email notification (None, Forward, New, or Reply).</td>
</tr>
<tr>
<td>Type</td>
<td>The status of the email notification. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• received: The server received this email.</td>
</tr>
<tr>
<td></td>
<td>• received - ignored: The server received this email, but it was ignored by</td>
</tr>
<tr>
<td></td>
<td>the instance for inbound email action purposes. Typically, these emails</td>
</tr>
<tr>
<td></td>
<td>are either spam or auto-replies. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - failed: The server has attempted to send the email and failed. See</td>
</tr>
<tr>
<td></td>
<td>the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ignored: The server skipped sending this email. Typically, this is</td>
</tr>
<tr>
<td></td>
<td>for an email which was generated but lacked a recipient email address or</td>
</tr>
<tr>
<td></td>
<td>is a duplicate email. See the Error String field for details.</td>
</tr>
<tr>
<td></td>
<td>• send - ready: The email is ready to be sent, but has not been sent out by</td>
</tr>
<tr>
<td></td>
<td>the mail server. Typically, an email remains in this state for only a</td>
</tr>
<tr>
<td></td>
<td>short time.</td>
</tr>
<tr>
<td></td>
<td>• sent: The email was sent by the instance without any errors or issues.</td>
</tr>
<tr>
<td>Target</td>
<td>A Document ID reference to the record if the email is generated by an insert,</td>
</tr>
<tr>
<td></td>
<td>update, or delete of a particular record.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user, from the user record, of the instance from which the</td>
</tr>
<tr>
<td></td>
<td>email notification was sent.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is a string field.</td>
</tr>
<tr>
<td>Notification Type</td>
<td>The type of notification. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• SMS</td>
</tr>
<tr>
<td></td>
<td>• SMTP</td>
</tr>
<tr>
<td>UID</td>
<td>The unique ID for the server.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time of the email activity for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Deleted</td>
<td>An indication of whether the email was deleted from an instance mailbox.</td>
</tr>
<tr>
<td>Weight</td>
<td>The weight of the email, which determines the sending priority relative to other notifications on the same table.</td>
</tr>
<tr>
<td>Importance</td>
<td>An indication that the email was sent with a changed level of importance, such as Urgent.</td>
</tr>
<tr>
<td>Originating Event and Notification</td>
<td>An embedded list that stores the event and notification that initiated the email notification.</td>
</tr>
<tr>
<td>Subject</td>
<td>A configured description of the action that generated the email notification. You create the subject text for notifications in System Notification &gt; Email &gt; Notifications.</td>
</tr>
<tr>
<td>Error String</td>
<td>The error string captured from the email server to determine why the email was not sent. This is logged only if the email is send-failed.</td>
</tr>
<tr>
<td>Recipients</td>
<td>The email address of the recipient of each notification.</td>
</tr>
<tr>
<td>Body</td>
<td>The body of the email, displayed in raw HTML markup. Use the related link Preview HTML Body to see the body text as rendered HTML.</td>
</tr>
<tr>
<td>Content type</td>
<td>The email content type.</td>
</tr>
<tr>
<td>Headers</td>
<td>Any headers embedded in the email.</td>
</tr>
</tbody>
</table>

Invalid email addresses that the instance strips out of outbound email messages are logged, starting with the Geneva release.

**Outbound email notification recipients**

For outbound notifications, the email system log provides reasons that recipients were included or excluded.

Each log entry corresponds to a reason for inclusion or exclusion. For example, all users who were excluded because they are inactive appear in a single log entry.

A series of system properties can be used to fine-tune the information to be logged. Two master switch properties, glide.notification.recipient.include_logging and glide.notification.recipient.exclude_logging, control all recipient inclusion and exclusion logging. Several other properties allow you to tailor the information reported in the logs to meet your needs. All of the properties are enabled by default.
Outbound system logs

Import logs
The import log displays information in a verbose format about any data import activity within the platform.
For a more detailed view of the import sets that produced a particular log, see Import Sets > Transform History.
This log provides the following information for all imports:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time of the import for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Level</td>
<td>Type of message displayed. For import files, the level is Information.</td>
</tr>
<tr>
<td>Message</td>
<td>System-generated message regarding the status of the import.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the external source of the import, such as an integration.</td>
</tr>
</tbody>
</table>

Push logs
Consult the push log to track the status of push notifications that are queued to send from your system.
To view the push log, navigate to System Logs > Push Notifications. Users are required to have the push_admin or admin role to view the push log.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim</td>
<td>Identification number that is generated by the scheduled job that sends the push notification. This number is applied to the Claim field to ensure consistency across multiple push scheduled jobs.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>Content of the push notification.</td>
</tr>
<tr>
<td>Queue count</td>
<td>Number of times that the system tried to send the push notification. The status of the push notification relates to its queue count.</td>
</tr>
<tr>
<td></td>
<td>- If the queue count is 0 for longer than expected, then there are no scheduled jobs that are trying to send the push notification.</td>
</tr>
<tr>
<td></td>
<td>- If the queue count is greater than 0 and the Type is success, then you can infer that this is how many times the system tried to send the push notification before finally sending.</td>
</tr>
<tr>
<td></td>
<td>- If the queue count reaches 10, the system stops trying to send the push notification. The Type changes to failure.</td>
</tr>
<tr>
<td>Request ID</td>
<td>Unique identification number for the push notification. Similar to the message ID for an email, the request ID is used as a correlation token for the push notification.</td>
</tr>
<tr>
<td>Type</td>
<td>Status to indicate whether the push notification has been sent. The Type column can have these values:</td>
</tr>
<tr>
<td></td>
<td>- failure: The message could not be sent.</td>
</tr>
<tr>
<td></td>
<td>- pending: The message is queued for processing.</td>
</tr>
<tr>
<td></td>
<td>- success: The message was successfully sent, although not necessarily received by the mobile device.</td>
</tr>
</tbody>
</table>

### Customer updates table

Every change that is made in the system is recorded on the Customer Updates [sys_update_xml] table chronologically.

To navigate to this table, enter sys_update_xml.list into the navigation filter. For information about update sets, see System update sets.

The following information is stored about each update:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name that identifies the updated record.</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time the customer update record was created.</td>
</tr>
<tr>
<td>Created By</td>
<td>The user who performed the change.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the update.</td>
</tr>
<tr>
<td>Updated</td>
<td>The date and time the customer update record was updated.</td>
</tr>
<tr>
<td>Updated By</td>
<td>The user who performed the update.</td>
</tr>
<tr>
<td>Updates</td>
<td>The number of times the record has been updated.</td>
</tr>
<tr>
<td>Target Name</td>
<td>The name of the element that was altered.</td>
</tr>
<tr>
<td>View</td>
<td>The view of the form that was altered if it was a form layout change.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payload</td>
<td>The XML contents of the record after the change.</td>
</tr>
<tr>
<td>Remote Update Set</td>
<td>A reference to that update set if the change was performed by a remote update set.</td>
</tr>
<tr>
<td>Local Update Set</td>
<td>The update set the change is associated with.</td>
</tr>
</tbody>
</table>

### Log history

The system uses table rotation and table extension to archive older logs. By default, the system uses the following schedule to archive common logs:

**Common log archive schedule**

<table>
<thead>
<tr>
<th>Table</th>
<th>Archive schedule</th>
<th>Rotations</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event (ecc_event)</td>
<td>Every day</td>
<td>7</td>
<td>Rotation</td>
</tr>
<tr>
<td>Queue (ecc_queue)</td>
<td>Every day</td>
<td>7</td>
<td>Rotation</td>
</tr>
<tr>
<td>Event (sysevent)</td>
<td>Every day</td>
<td>7</td>
<td>Rotation</td>
</tr>
<tr>
<td>Log (syslog)</td>
<td>Every week</td>
<td>8</td>
<td>Rotation</td>
</tr>
<tr>
<td>Transaction Log</td>
<td>Every week</td>
<td>8</td>
<td>Rotation</td>
</tr>
<tr>
<td>Email (sys_email)</td>
<td>Every 30 days</td>
<td>8</td>
<td>Extension</td>
</tr>
</tbody>
</table>

### Use the log file browser

The instance provides the utilities log file browser and log file download.

Use **System Logs > Log File Browser** to view any system log entry. You can search for log files by using the following filters:

**Log file browser**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>Start date and time of the range you want to search, for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Session ID</td>
<td>System-generated hexadecimal string that identifies the session that generated the log entry.</td>
</tr>
<tr>
<td>End time</td>
<td>End date and time of the range you want to search, for the locale of the machine running the instance.</td>
</tr>
<tr>
<td>Message</td>
<td>System-generated description of the occurrence.</td>
</tr>
<tr>
<td>Level</td>
<td>Type of message displayed. The levels are Debug, Error, Warning, and Information. A warning is an error that has been handled and recovered. An error is something that must be fixed.</td>
</tr>
<tr>
<td>Thread name</td>
<td>System-generated identifier of the thread that created the log file.</td>
</tr>
</tbody>
</table>
The instance creates compressed archives of system logs every two days and purges log archives after 21 days. You can download log file archives and view them with System Logs > Log File Download. Select a log archive from the list, and then click Download log under Related Links to open or save the archive.

**Note:** Log files are only available for the node you are currently logged into. To see the currently logged into node, navigate to System Diagnostics > Stats.

### Upgrades and conversions

The ServiceNow platform includes tools to help you during and after an upgrade, and also allows you to convert a ServiceNow Express instance to a ServiceNow Service Management enterprise platform.

**See also**

*Upgrade to Jakarta*

The upgrade process moves your instance to a new ServiceNow release version. Understand the difference between upgrading and patching, release definitions, rollback and backup options, and how to test your non-production and production instance upgrades.

**Upgrade History module: Track every upgrade**

The Upgrade History module tracks every upgrade made to an instance. Administrators can use the module to resolve upgrade conflicts and optionally to revert customizations to base system versions to take advantage of new features.

An upgrade history record is created for each upgrade that is run. To view an upgrade history record, navigate to System Diagnostics > Upgrade History and click the upgrade.

**Note:** The Payload and Payload Hash fields have been removed from the Upgrade History record.

**Upgrade History record**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Name of the previous .war file (version).</td>
</tr>
<tr>
<td>To</td>
<td>Name of the applied .war file (version).</td>
</tr>
<tr>
<td>Upgrade started</td>
<td>Time stamp when the upgrade process began.</td>
</tr>
<tr>
<td>Upgrade finished</td>
<td>Time stamp when the upgrade process was completed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Changes skipped       | Total number of records that were different from the previous upgrade but were skipped, mostly like due to customization. Changes skipped is the sum of the records that have disposition of skipped manual merge (where the value of changed is true), added to the number of records that have disposition of skipped error, added to the number of records that were skipped and different.  
Note: To prevent your customizations from being overwritten during system upgrades, the upgrade process skips (does not apply the update to) objects that have been customized. One of your responsibilities as the administrator is to resolve each update that was skipped due to a customization. To resolve a skipped update, you review the reason for each skipped record and then either merge the customization or revert the customization to the base system. |
| Changes applied       | Total number of the changes that were applied in this upgrade. Changes applied is sum of updated and different records, added to the number of deleted records (where the value of changed is true) added to the number of inserted records (where the value of changed is true).                                                                                                                                                                                                                     |
| Changes processed     | Total number of items processed during this upgrade. Changes processed is the sum of Changes skipped, plus Changes applied.                                                                                                                                                                                                                                                                                                                                                                                                               |

**Upgrade History Details form section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated and different</td>
<td>Number of Upgrade Detail records for which the value of the disposition is updated, and the value of changed is equal to true. This does not appear on the form by default.</td>
</tr>
<tr>
<td>Updated and not different</td>
<td>Number of Upgrade Detail records for which the value of the disposition is updated, and the value of changed is equal to false. This does not appear on the form by default.</td>
</tr>
<tr>
<td>Skipped and different</td>
<td>Number of Upgrade Detail records for which the value of the disposition is skipped, and the value of changed is equal to true. This does not appear on the form by default.</td>
</tr>
</tbody>
</table>
Review Skipped Records form section

The Skipped Changes to Review related list displays each record that was skipped during the upgrade process. Use the list to review the reason for each skipped record in the list and then either merge your customization or revert your customization to the base system.

Skipped Changes to Review related list

To prevent your customizations from being overwritten during system upgrades, the upgrade process skips (does not apply the update to) objects that have been customized. To assist you in tracking and resolving skipped update records that need review, Skipped Changes to Review lists all updates skipped during the upgrade process.

By default, the list is filtered by disposition skipped error or (disposition skipped manual merge and changed is true) or (disposition skipped and changed is true) or (disposition skipped(second pass) and changed is true), and the resolution status is either empty or not reviewed.

Navigate to System Diagnostics > Upgrade History to view the Skipped Changes to Review related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Name of skipped Upgrade Detail record.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Disposition | Action performed on this file during the selected upgrade:  
- Inserted: The system inserted a new record.  
- Updated: The system updated this record.  
- Deleted: The system deleted this record.  
- Skipped: The system did not change this record in order to preserve customizations.  
- Reverted: This record was reverted to the base version.  
- Table not found: The system could not find the table that contains this record.  
- Unchanged: The system did not change this record because the baseline component has not changed since the last release.  
- Skipped Manual Merge: The system did not change this record because updating it requires manual intervention.  
- Skipped Apply Once: The system skipped this record because it had already applied an update from an xml file in the apply once folder.  
- Not Latest: The system applied a change, but this change was overwritten later during the same upgrade. |
| Priority | Relative importance of the conflict that caused the skip based on the following criteria:  
- 1 (highest priority): xml content  
- 2: script or script_plain  
- 3: html content  
- 4: sys_ui_form_section, sys_ui_related_list, or sys_choice_set  
- 5 (lowest priority): other |
| Resolution |  
- Reviewed  
- Retained  
- Reverted |
| Comment | During the process of resolving a skipped update, you have the option to add a Comment to any record. For example, the comment might explain the action that you took to future reviewers. |
| Target name | Name of the record corresponding to the current file. |
| Plugin | Plugin that contains the record. |
| Type | Current file type (such as Business Rule or UI Policy). |
| Table | Table that contains the record. |
Resolve a skipped update and set a resolution status

To prevent your customizations from being overwritten during system upgrades, the upgrade process skips (does not apply the update to) objects that have been customized. One of your responsibilities as the administrator is to resolve each skipped update after an upgrade.

Role required: admin

You resolve an update by either retaining the customization or (when the software upgrade contains a feature that you would like to implement) by merging or overwriting the customization with the base system update.

Note: Objects that are customized and that did not change in the base system since the last upgrade require no action on your part.

When an object is customized, the system adds a corresponding record to the Customer Updates (sys_update_xml) table and then maintains current version information for all customized objects. The upgrade process skips changes to objects that have a current version in the Customer Updates table. When you follow the procedure, you perform one of the following actions:

- Retain (keep) a customization with no changes
- Retain a customization by merging changes from the updated object
- Revert a customized object to the updated version (that is, overwrite the customization)
- Review the skip and perform no action on the object

1. Navigate to System Diagnostics > Upgrade History.
2. Select the desired software version.
3. In the Skipped Changes to Review related list, select the update record to resolve.

Note: By default, the list displays records with disposition of Skipped and resolution status of Not Reviewed.

4. Review the list of changes. For text fields, you can click in the field to open the Diff/Merge tool. Review the differences. Click a text box to view and edit the detailed differences.
5. Perform one of the following actions. You have the option to add a Comment to any record, for example, to explain the action to future reviewers.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain the customized record as is and do not update it.</td>
<td>After reviewing the changes, set Resolution Status to Reviewed and Retained. The record moves from the Skipped Changes to Review to Skipped Changes Reviewed related list.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retain the customization by merging changes from the updated object.</td>
<td>1. Click <strong>Resolve Conflicts</strong> to navigate to the <strong>Resolve Conflicts form</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Review the differences.</td>
</tr>
<tr>
<td></td>
<td>3. To merge a field:</td>
</tr>
<tr>
<td></td>
<td>• Click the right-arrow button for the field.</td>
</tr>
<tr>
<td></td>
<td>• Click a text box to view and edit the detailed differences.</td>
</tr>
<tr>
<td></td>
<td>• When you have merged all appropriate fields, click <strong>Merge</strong>.</td>
</tr>
<tr>
<td></td>
<td>After merging the customization changes:</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Disposition</strong> changes from <strong>Skipped</strong> to <strong>Merged</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Resolution Status</strong> changes to <strong>Reviewed and Merged</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.</td>
</tr>
<tr>
<td>Discard the customization and update the record to match the base system for this upgrade.</td>
<td>After reviewing the changes, click <strong>Revert to Base System</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Disposition</strong> changes from <strong>Skipped</strong> to <strong>Reverted</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Resolution Status</strong> changes to <strong>Reviewed and Reverted</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The system creates a Customer Update record.</td>
</tr>
<tr>
<td></td>
<td>• The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.</td>
</tr>
<tr>
<td>Note:</td>
<td>At any time after you revert a customization, you can click <strong>Reapply Changes</strong> to reapply the customization (undo the revert).</td>
</tr>
<tr>
<td>Review the skip and perform no action on the object.</td>
<td>After reviewing the changes, set <strong>Resolution Status to Reviewed</strong>. The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.</td>
</tr>
<tr>
<td>Leave on the skipped list for a later decision, and note that you have not reviewed the record.</td>
<td>From the <strong>Resolution</strong> list, choose **Not Reviewed to defer the decision on how to handle this conflict. The record stays on the Skipped Changes to Review related list.</td>
</tr>
<tr>
<td>6. Click <strong>Update</strong>. Repeat the process to resolve each update record in the list.</td>
<td>Only skipped updates with a <strong>Resolution Status</strong> of Not Reviewed appear in the <strong>Skipped Changes to Review</strong> related list. Any action you take that changes the <strong>Resolution Status</strong> to a value other than Not Reviewed removes the skipped update from list and moves it to the Skipped Changes Reviewed related list.</td>
</tr>
</tbody>
</table>
Skipped Changes Reviewed related list

Skipped Changes Reviewed lists update records that previously appeared on the **Skipped Changes to Review** related list and have been reviewed. When you select a skipped record to review and set a **Resolution Status** to a value other than Not Reviewed, the update record moves to the Skipped Changes Reviewed related list.

Navigate to **System Diagnostics > Upgrade History** to view the Skipped Changes Reviewed related list.

### Skipped Changes Reviewed related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Name of reviewed Upgrade Details record.</td>
</tr>
<tr>
<td>Disposition</td>
<td>Action performed on this file during the selected upgrade:</td>
</tr>
<tr>
<td></td>
<td>• Inserted: The system inserted a new record.</td>
</tr>
<tr>
<td></td>
<td>• Updated: The system updated this record.</td>
</tr>
<tr>
<td></td>
<td>• Deleted: The system deleted this record.</td>
</tr>
<tr>
<td></td>
<td>• Skipped: The system did not change this record in order to preserve</td>
</tr>
<tr>
<td></td>
<td>customizations.</td>
</tr>
<tr>
<td></td>
<td>• Reverted: This record was reverted to the base version.</td>
</tr>
<tr>
<td></td>
<td>• Table not found: The system could not find the table that contains this</td>
</tr>
<tr>
<td></td>
<td>record.</td>
</tr>
<tr>
<td></td>
<td>• Unchanged: The system did not change this record because the baseline</td>
</tr>
<tr>
<td></td>
<td>component has not changed since the last release.</td>
</tr>
<tr>
<td></td>
<td>• Skipped Manual Merge: The system did not change this record because</td>
</tr>
<tr>
<td></td>
<td>updating it requires manual intervention.</td>
</tr>
<tr>
<td></td>
<td>• Skipped Apply Once: The system skipped this record because it had</td>
</tr>
<tr>
<td></td>
<td>already applied an update from an xml file in the apply once folder.</td>
</tr>
<tr>
<td></td>
<td>• Not Latest: The system applied a change, but this change was</td>
</tr>
<tr>
<td></td>
<td>overwritten later during the same upgrade.</td>
</tr>
<tr>
<td>Priority</td>
<td>Relative importance of the conflict that caused the skip based on the</td>
</tr>
<tr>
<td></td>
<td>following criteria:</td>
</tr>
<tr>
<td></td>
<td>• 1 (highest priority): xml content</td>
</tr>
<tr>
<td></td>
<td>• 2: script or script_plain</td>
</tr>
<tr>
<td></td>
<td>• 3: html content</td>
</tr>
<tr>
<td></td>
<td>• 4: sys_ui_form_section, sys_ui_related_list, or sys_choice_set</td>
</tr>
<tr>
<td></td>
<td>• 5 (lowest priority): other</td>
</tr>
<tr>
<td>Resolution</td>
<td>Reviewed</td>
</tr>
<tr>
<td></td>
<td>Retained</td>
</tr>
<tr>
<td></td>
<td>Reverted</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comment</td>
<td>During the process of resolving a skipped update, you have the option to add a Comment to any record. For example, the comment might explain the action that you took to future reviewers.</td>
</tr>
<tr>
<td>Target name</td>
<td>Name of the record corresponding to the current file.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Plugin that contains the record.</td>
</tr>
<tr>
<td>Type</td>
<td>Current file type (such as Business Rule or UI Policy).</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the record.</td>
</tr>
<tr>
<td>File name</td>
<td></td>
</tr>
<tr>
<td>File differences</td>
<td>Comparison of the file in the upgrade with the customized version.</td>
</tr>
<tr>
<td>Changed by vendor</td>
<td>Indicates whether the file has been changed by the vendor since the last upgrade.</td>
</tr>
</tbody>
</table>

**Customizations Unchanged related list**

Customizations Unchanged lists all records that were skipped (due to a customization), but the changes that were going to be applied in this upgrade have not changed from the last upgrade.

Navigate to **System Diagnostics > Upgrade History** to view the Customizations Unchanged related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Name of unchanged sys_upgrade_history_log record. Select it if you want to access Upgrade Details and add comment text, or set a resolution status for it.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Input Value</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disposition</td>
<td>Action performed on this file during the selected upgrade:</td>
</tr>
<tr>
<td></td>
<td>· Inserted: The system inserted a new record.</td>
</tr>
<tr>
<td></td>
<td>· Updated: The system updated this record.</td>
</tr>
<tr>
<td></td>
<td>· Deleted: The system deleted this record.</td>
</tr>
<tr>
<td></td>
<td>· Skipped: The system did not change this record in order to preserve customizations.</td>
</tr>
<tr>
<td></td>
<td>· Reverted: This record was reverted to the base version.</td>
</tr>
<tr>
<td></td>
<td>· Table not found: The system could not find the table that contains this record.</td>
</tr>
<tr>
<td></td>
<td>· Unchanged: The system could not find the table that contains this record because the baseline component has not changed since the last release.</td>
</tr>
<tr>
<td></td>
<td>· Skipped Manual Merge: The system did not change this record because updating it requires manual intervention.</td>
</tr>
<tr>
<td></td>
<td>· Skipped Apply Once: The system skipped this record because it had already applied an update from an xml file in the apply once folder.</td>
</tr>
<tr>
<td></td>
<td>· Not Latest: The system applied a change, but this change was overwritten later during the same upgrade.</td>
</tr>
<tr>
<td>Priority</td>
<td>Relative importance of the conflict that caused the skip based on the following criteria:</td>
</tr>
<tr>
<td></td>
<td>· 1 (highest priority): xml content</td>
</tr>
<tr>
<td></td>
<td>· 2: script or script Plain</td>
</tr>
<tr>
<td></td>
<td>· 3: html content</td>
</tr>
<tr>
<td></td>
<td>· 4: sys_ui_form_section, sys_ui_related_list, or sys_choice_set</td>
</tr>
<tr>
<td></td>
<td>· 5 (lowest priority): other</td>
</tr>
<tr>
<td>Resolution</td>
<td>・Reviewed</td>
</tr>
<tr>
<td></td>
<td>・Retained</td>
</tr>
<tr>
<td></td>
<td>・Reverted</td>
</tr>
<tr>
<td>Comment</td>
<td>During the process of resolving a skipped update, you have the option to add a <strong>Comment</strong> to any record. For example, the comment might explain the action that you took to future reviewers.</td>
</tr>
<tr>
<td>Changed by vendor</td>
<td>Indicates whether the file has been changed by the vendor since the last upgrade.</td>
</tr>
<tr>
<td>Target name</td>
<td>Name of the record corresponding to the current file.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Plugin that contains the record.</td>
</tr>
<tr>
<td>Type</td>
<td>Current file type (such as Business Rule or UI Policy).</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the record.</td>
</tr>
</tbody>
</table>
Revert a customization

To prevent customizations from being overwritten by system upgrades, the upgrade process automatically skips changes to objects that have been customized. You may want to overwrite your customizations when a software upgrade contains a feature that you would like to implement.

Role required: admin

To identify customized objects, the system adds a corresponding record in the Customer Updates (sys_update_xml) table. The table maintains the current version information for all objects that have been customized. The upgrade process skips changes to objects that have entries in the table. The upgrade process does not skip objects if only excluded fields have changed.

1. Navigate to System Diagnostics > Upgrade History.
2. Select the desired software version.
3. Filter the Upgrade Details related list by Disposition is Skipped.
4. Add another filter condition for Changed is True to return only the objects that have changed since the last upgrade.
5. Select the update record to implement.

The File differences field displays a side-by-side comparison of the customization and the default version. Deletions are highlighted in red, additions in green, and modifications in yellow.

6. Click Revert to base system to overwrite your customized object with the system default version.

- The Disposition changes from Skipped to Reverted.
- After you revert a customization, you have the option to click Reapply Changes to reapply your customizations (undo the revert).

Changes Applied related list

Changes Applied lists all changes that were applied in this upgrade.

This list is ordered by priority and displays Upgrade Detail records for this upgrade that have a disposition of updated, updated(second pass), inserted, inserted(second pass), deleted, deleted(second pass), and for which the changed flag is true for all of the dispositions.

Navigate to System Diagnostics > Upgrade History to view the Changes Applied related list.
### Changes Applied related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disposition</td>
<td>Action performed on this file during the selected upgrade:</td>
</tr>
<tr>
<td></td>
<td>· Inserted: The system inserted a new record.</td>
</tr>
<tr>
<td></td>
<td>· Updated: The system updated this record.</td>
</tr>
<tr>
<td></td>
<td>· Deleted: The system deleted this record.</td>
</tr>
<tr>
<td></td>
<td>· Skipped: The system did not change this record in order to preserve customizations.</td>
</tr>
<tr>
<td></td>
<td>· Reverted: This record was reverted to the base version.</td>
</tr>
<tr>
<td></td>
<td>· Table not found: The system could not find the table that contains this record.</td>
</tr>
<tr>
<td></td>
<td>· Unchanged: The system did not change this record because the baseline component has not changed since the last release.</td>
</tr>
<tr>
<td></td>
<td>· Skipped Manual Merge: The system did not change this record because updating it requires manual intervention.</td>
</tr>
<tr>
<td></td>
<td>· Skipped Apply Once: The system skipped this record because it had already applied an update from an xml file in the apply once folder.</td>
</tr>
<tr>
<td></td>
<td>· Not Latest: The system applied a change, but this change was overwritten later during the same upgrade.</td>
</tr>
<tr>
<td>Priority</td>
<td>Relative importance of the conflict that caused the skip based on the following criteria:</td>
</tr>
<tr>
<td></td>
<td>· 1 (highest priority): xml content</td>
</tr>
<tr>
<td></td>
<td>· 2: script or script_plain</td>
</tr>
<tr>
<td></td>
<td>· 3: html content</td>
</tr>
<tr>
<td></td>
<td>· 4: sys_ui_form_section, sys_ui_related_list, or sys_choice_set</td>
</tr>
<tr>
<td></td>
<td>· 5 (lowest priority): other</td>
</tr>
<tr>
<td>Resolution</td>
<td>· Reviewed</td>
</tr>
<tr>
<td></td>
<td>· Retained</td>
</tr>
<tr>
<td></td>
<td>· Reverted</td>
</tr>
<tr>
<td>Comment</td>
<td>During the process of resolving a skipped update, you have the option to add a Comment to any record. For example, the comment might explain the action that you took to future reviewers.</td>
</tr>
<tr>
<td>Target name</td>
<td>Name of the record corresponding to the current file.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Plugin that contains the record.</td>
</tr>
<tr>
<td>Type</td>
<td>Current file type (such as Business Rule or UI Policy).</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the record.</td>
</tr>
<tr>
<td>File name</td>
<td>Current upgrade file name.</td>
</tr>
</tbody>
</table>
### Field | Input Value
---|---
File differences | Comparison of the file in the upgrade with the customized version.
Changed by vendor | Indicates whether the file has been changed by the vendor since the last upgrade.

---

**Upgrade Details related list**

Upgrade Details lists all Upgrade Details records for this upgrade.

Navigate to **System Diagnostics > Upgrade History** to view the Upgrade Details related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
</table>
| Disposition | Action performed on this file during the selected upgrade:  
· Inserted: The system inserted a new record.  
· Updated: The system updated this record.  
· Deleted: The system deleted this record.  
· Skipped: The system did not change this record in order to preserve customizations.  
· Reverted: This record was reverted to the base version.  
· Table not found: The system could not find the table that contains this record.  
· Unchanged: The system did not change this record because the baseline component has not changed since the last release.  
· Skipped Manual Merge: The system did not change this record because updating it requires manual intervention.  
· Skipped Apply Once: The system skipped this record because it had already applied an update from an xml file in the apply once folder.  
· Not Latest: The system applied a change, but this change was overwritten later during the same upgrade. |
| Priority | Relative importance of the conflict that caused the skip based on the following criteria:  
· 1 (highest priority): xml content  
· 2: script or script_plain  
· 3: html content  
· 4: sys_ui_form_section, sys_ui_related_list, or sys_choice_set  
· 5 (lowest priority): other |
| Resolution |  
· Reviewed  
· Retained  
· Reverted |
### Upgrade Monitor module: Upgrade an individual instance

The Upgrade Monitor helps you upgrade an individual instance. You can monitor the progress of an upgrade and resolve conflicts between the upgrade and customizations.

#### Set up
- **Upgrade Monitor overview**

#### Use
- **Monitor an upgrade to an instance**
- **Process the skipped records list**
- **Resolve conflicts for an individual record**

#### Troubleshoot and get help
- **Ask or answer questions in the [Developer Community](#)**
- **Search the HI knowledge base for known error articles**
- **Contact ServiceNow Technical Support**

---

### Upgrade Monitor overview

The Upgrade Monitor helps you upgrade an individual instance. You can monitor the progress of an upgrade and resolve conflicts between the upgrade and customizations.

### Set up for the Upgrade Monitor

In Jakarta, the Upgrade Monitor is installed by default.

If you log in with the admin role while an upgrade is underway, the system automatically displays the Upgrade Progress screen. If no upgrade is in progress, you can navigate to **System Diagnostics > Upgrade Monitor**.

### How the Upgrade Monitor fits into the upgrade process

**Note:** For detailed information about the upgrade process, see [Upgrade your instance](#).

The Upgrade Monitor concerns only part of the larger upgrade process:

1. Clone the production instance to a test instance and a non-production instance.
2. Apply the upgrade to the non-production instance.
3. On the upgraded non-production instance, process the skipped list.
4. Test the non-production instance to confirm that the instance still works and performs adequately. Compare to benchmark data from pre-upgrade production instance.
5. Apply the upgrade to the test instance. Import the update sets created on the non-production instance when you processed the skipped list. Repeat the testing to make sure that the process is working.
6. Apply the upgrade to the production instance. Import the update sets created on the non-production instance when you processed the skipped list. Test to confirm that the instance works and performs adequately.

Within this larger process, the Upgrade Monitor helps you upgrade individual instances:

- during the upgrade, it shows where in the process the system is
- after the upgrade, it reports what the upgrade did and for how long
- as you upgrade the first non-production instance, it helps you resolve conflicts between customizations and changes that are part of the upgrade
- on non-production instances, it provides information that can help you estimate how long the upgrade takes on the production instance.

**Monitoring an individual instance as it upgrades**

While the upgrade is in progress the Upgrade Progress shows what the upgrade process has done, what it is doing, and what remains to be done.

When the upgrade completes, the system displays the Upgrade Summary Report. The Upgrade Summary Report provides information about conflicts between customizations versus the upgrade and provides a link to reconcile these conflicts. For information about understanding and resolving these conflicts, see Process the skipped records list.

When you upgrade a non-production instance, the Upgrade Summary Report can help you estimate how long the same upgrade takes on a production instance. For details about the elements on this report and how to use this information, see Upgrade Details form.

**Resolving conflicts**

To prevent losing customizations, the system skips upgrading records you have customized and provides you with a list of these skipped records.

As you upgrade your first non-production instance, go through the Skipped Changes to Review related list and resolve these conflicts. The system records the changes you make during this process in update sets.

You do not need to reconcile the skipped list on any instances you later upgrade. Instead, you can apply the upgrade then import the update sets containing your changes.

For details on reconciling conflicts, see Process the skipped records list.

**Factors affecting upgrade duration**

Various factors affect how long the system takes to perform an upgrade. The Upgrade Monitor can help you understand those factors and estimate how long the upgrade to your production instance takes.
Many factors can affect the duration of the upgrade process:

- The number of records in the database
- The number of customizations in the database
- The number of nodes in the instance
- The size of tables in the instance that require a schema-change in the instance.
- The number of fix scripts required and the size of the tables those fix scripts manipulate.

Upgrading a non-production instance can help you estimate how long the upgrade takes on production, but differences between the instances can significantly affect the duration:

- When you cloned the production instance to the non-production instance, you may have clone-excluded some tables. This reduces the size of the database and makes the non-production instance upgrade faster than the production instance.
- The production instance may have more memory and processing power.
- The production instance may have more nodes than the non-production instance.

After upgrading the first non-production instance, examine the Upgrade Summary Report for data to help estimate the impact of these factors.

**Upgrade Monitor**

When an upgrade is not running, the Upgrade Monitor displays information about the next check for an available upgrade.

The Upgrade Monitor displays the next date and time when the system will check for an available upgrade.

To check immediately for an available upgrade, click **Check Now**.
If one or both of the triggers for upgrading the system (‘Upgrade’ and ‘Check Upgrade Script’) have been customized or are missing, the Upgrade Monitor displays a warning and provides a button for resolving the issues.

To resolve the issues with the upgrade jobs, click Fix Upgrade Jobs. This action reverts both upgrade triggers to their base versions.

Monitor an upgrade to an instance

While the system is upgrading an instance, you can monitor its progress with the Upgrade Monitor. When the upgrade is done, you can view a summary of the results on the Upgrade Summary Report.

1. If necessary, navigate to System Diagnostics > Upgrade Monitor.
   When an upgrade is in progress, the Upgrade Progress page shows its status.
2. Monitor the progress of the upgrade.
   When the system finishes the upgrade, it displays the Upgrade Summary Report.

From the Upgrade Summary Report, resolve any conflicts that prevented the system from upgrading records.
Upgrade Progress

When an upgrade is underway, Upgrade Progress displays progress bars and other information to help monitor the process.

<table>
<thead>
<tr>
<th>Screen element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade Progress</td>
<td>A progress bar depicting where the upgrade is in the overall process. The length of a section in the bar does not indicate the relative duration of that process.</td>
</tr>
<tr>
<td>Upgrade Progress: Upgrading Platform</td>
<td>The system is applying upgrades to elements that form the foundation of the platform.</td>
</tr>
</tbody>
</table>
**Screen element** | **Description**  
---|---  
**Upgrade Progress: Updating Schema** | The system is scanning the plugins to create a list of tables that require upgrading. This prevents the system from upgrading the same table multiple times.  
**Upgrade Progress: Loading Plugins** | The system is loading both core and optional plugins. Some features require more than one plugin, so the number of plugins listed may not match the number of optional features installed.  
**Upgrade Progress: Completing** | The system is upgrading components that need to be completed after the previous three stages are done.  

**Note:** After the system finishes the Completing phase, it displays a separate screen showing Finalizing. The system tracks in update sets the changes made during the Upgrading Platform, Updating Schema, Loading Plugins, and Completing phases. It does not track changes made during Finalizing.  
**Details** | Shows the current activity, a progress bar for the current activity, and the file currently being updated.  
**Node Upgrades** | The color of the icons represents the status of each node during this upgrade: Pending, Running, Successful, Failed, or Down.  
**Node** | The selected node indicated by the arrow. To change the selection, position the mouse cursor over the icon for the node to select.  
**Running time** | How long the selected node (indicated by the arrow) has been running. If the selected node is offline, this value stops updating and shows how long a node was online before going offline.  
**Version** | The current build for the selected node (indicated by the arrow).  
**Successful upgrade** | When the selected node is online, shows how long the node has been online. If the selected node is offline, shows how long the node has been offline.  

**Upgrade Summary Report**  
This report summarizes the actions taken, provides tools to resolve conflicts between customizations and the upgrade, and provides information to help estimate time for upgrades to other instances.
Upgrade Summary Report: Database Upgrade Highlights

Screen elements

<table>
<thead>
<tr>
<th>Screen element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From version</td>
<td>Previous version of the instance</td>
</tr>
<tr>
<td>To version</td>
<td>Upgraded version of the instance</td>
</tr>
<tr>
<td>Started</td>
<td>When the upgrade process started</td>
</tr>
<tr>
<td>Finished</td>
<td>When the upgrade process finished</td>
</tr>
<tr>
<td>Duration</td>
<td>How long the upgrade process took</td>
</tr>
</tbody>
</table>
### Screen element | Description
---|---
Skipped | In the example, **24 Skipped of 7016 changes** reads as:
- **24 Skipped** - Total number of customizations that were skipped, skipped manual merge, or skipped in error, and the file changed in the distribution since the last upgrade of the instance. These are the number of records the system did not upgrade because of conflicts between customizations and the upgrade.
- **7016 Changes** - Total number of file changes in the distribution since the last upgrade of the instance, plus all inserts and deletes.

**Note:** The manner in which upgrade records are counted was changed in the Jakarta release, which may render different record counts than in previous releases.

Review Skipped Updates | Click to reconcile conflicts that caused the system to skip some updates

---

### Node Upgrades

The Node Upgrades section shows the status of the upgrade for each node in the instance. The color of the icon denotes the status, as illustrated by the legend (key) and to the right of the node icons. To see details about a node, position the cursor above the icon for that node. An arrow points to the node selected, and the information below the icons pertains to that node.

### Upgrade Summary Report: Node Upgrades

The Node Upgrades section shows the status of the upgrade for each node in the instance. The color of the icon denotes the status, as illustrated by the legend (key) and to the right of the node icons. To see details about a node, position the cursor above the icon for that node. An arrow points to the node selected, and the information below the icons pertains to that node.
Schema Changes to Clone-excluded Tables

Upgrade Summary Report: Schema Changes to Clone-excluded tables

The Schema Changes to Clone-excluded Tables section shows a list of tables affected by the upgrade that were clone-excluded when you cloned the production instance to this instance. Because clone-excluded tables are empty, upgrading them takes less time than upgrading those same tables on the production instance. To estimate how much longer the production upgrade takes, note the size of the clone-excluded tables on the production instance.
### Top 10 Fix Scripts by Duration

<table>
<thead>
<tr>
<th>Duration</th>
<th>Name / Description</th>
<th>Duration</th>
<th>Name / Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Minute</td>
<td>fix_promote_credential_attributes_to_cmdb.xml reprompt_cmdb_ci_to_cmdb</td>
<td>21 Seconds</td>
<td>activate_amb_plugin.xml</td>
</tr>
<tr>
<td>1 Minute</td>
<td>fix_index_for_identification.xml</td>
<td>20 Seconds</td>
<td>j_syslog_transaction_schema_change2.xml</td>
</tr>
<tr>
<td>3.1 Seconds</td>
<td>r_metadata_conversion_6.xml Metadata conversion re-parenting</td>
<td>12 Seconds</td>
<td>activate_live_upgrade_plugin.xml</td>
</tr>
<tr>
<td>27 Seconds</td>
<td>fix_extended_web_server.xml Move existing records in the web_server table to the new extended web-server based on the type of the web server</td>
<td>8 Seconds</td>
<td>activate_amb_msg_relation.xml Use mailbox retrieval on sys_amb_message</td>
</tr>
<tr>
<td>25 Seconds</td>
<td>fix_promote_database_application_fields.xml Promote Listener name to Database Instance, Edition and is clustered to Application</td>
<td>7 Seconds</td>
<td>fix_related_list_calculated_name.xml Fix sys ui_related_list_calculated_name</td>
</tr>
</tbody>
</table>

### Upgrade Summary Report: Top 10 Fix Scripts by Duration

The Top 10 Fix Scripts by Duration helps you understand which fix scripts required the most time.
Top 10 Schema Changes by Duration

<table>
<thead>
<tr>
<th>Duration</th>
<th>Table Name</th>
<th>Alter Type(s)</th>
<th>Element Names</th>
<th>Flow Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Seconds</td>
<td>sys_upgrade_history_log</td>
<td>create_index</td>
<td>[index:1:upgrade_history, resolution_status, disposition, type_priority, index2:upgrade_history, order], indexed:1:ordered</td>
<td>53211</td>
</tr>
<tr>
<td>3 Seconds</td>
<td>sys_upgrade_history_log</td>
<td>add_columns</td>
<td>[resolution_status, plugin, type_priority, sys_source_table, comments]</td>
<td>53211</td>
</tr>
<tr>
<td>2 Seconds</td>
<td>sys_upgrade_history_log</td>
<td>modify_column</td>
<td>'file_path' MEDIUMTEXT</td>
<td>53211</td>
</tr>
<tr>
<td>1 Second</td>
<td>pmdb_ci</td>
<td>modify_column</td>
<td>'correlation_id' MEDIUMTEXT</td>
<td>2752</td>
</tr>
</tbody>
</table>

Upgrade Summary Report: Top 10 Schema Changes by Duration

The Top 10 Schema Changes by Duration helps you understand which schema changes required the most time.

Process the skipped records list

If you customized a record affected by this upgrade, you must resolve the differences between the upgraded and customized versions of the record. This process is called processing the skipped record list or just processing the skipped list.

Role required: admin

1. If necessary, navigate to System Diagnostics > Upgrade Monitor.
   If the upgrade is still in progress, the system displays the Upgrade Progress screen. When the upgrade finishes, the system displays the Upgrade Summary Report.
2. After the system displays the Upgrade Summary Report, click the Click here link in the Skipped box.
   The system displays the System Upgrades form.
3. Navigate to Review Skipped Records section and – if necessary – scroll to the Upgrade Details related list (skipped list).
4. Click the row for the first record you want to reconcile.
   The system displays the Upgrade Details form for that record.
5. Evaluate how you want to resolve the conflict for this record and take the appropriate action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain the customized record as is and do not update it.</td>
<td>After reviewing the changes, set Resolution Status to Reviewed and Retained. The record moves from the Skipped Changes to Review to Skipped Changes Reviewed related list.</td>
</tr>
<tr>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>Retain the customization by merging changes from the updated object.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>1. Click <strong>Resolve Conflicts</strong> to navigate to the <strong>Resolve Conflicts form</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Review the differences.</td>
<td></td>
</tr>
<tr>
<td>3. To merge a field:</td>
<td></td>
</tr>
<tr>
<td>· Click the right-arrow button for the field.</td>
<td></td>
</tr>
<tr>
<td>· Click a text box to view and edit the detailed differences.</td>
<td></td>
</tr>
<tr>
<td>· When you have merged all appropriate fields, click <strong>Merge</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

After merging the customization changes:
- The **Disposition** changes from **Skipped** to **Merged**.
- The **Resolution Status** changes to **Reviewed and Merged**.
- The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard the customization and update the record to match the base system for this upgrade.</td>
</tr>
</tbody>
</table>

After reviewing the changes, click **Revert to Base System**.
- The **Disposition** changes from **Skipped** to **Reverted**.
- The **Resolution Status** changes to **Reviewed and Reverted**.
- The system creates a Customer Update record.
- The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.

**Note:** At any time after you revert a customization, you can click **Reapply Changes** to reapply the customization (undo the revert).

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review the skip and perform no action on the object.</td>
</tr>
</tbody>
</table>

After reviewing the changes, set **Resolution Status to Reviewed**. The record moves from the Skipped Changes to Review to the Skipped Changes Reviewed related list.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave on the skipped list for a later decision, and note that you have not reviewed the record.</td>
</tr>
</tbody>
</table>

From the **Resolution list**, choose **Not Reviewed** to defer the decision on how to handle this conflict. The record stays on the Skipped Changes to Review related list.

**Note:** The system tracks changes to records in an update set so you can apply these changes to another instance later. However, the system does not migrate the upgrade details records from one instance to the next. These records apply to a specific upgrade of a specific instance. If you want to preserve the Comments, Resolutions, or other information from the skipped list, export it from this instance.
6. In the **Comment** field, write the reasons for making your decision and other information you want to document.

7. Click **Update**.

**System Upgrades form**

When an upgrade is complete, the System Upgrades form displays key statistics about the upgrade and a related list of skipped records (the *skipped list*).

**System Upgrades form**

**Fields**

<table>
<thead>
<tr>
<th>Screen element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>The version of the instance before upgrading.</td>
</tr>
<tr>
<td>To</td>
<td>The version of the instance after upgrading.</td>
</tr>
<tr>
<td>Upgrade started</td>
<td>The time upgrade started.</td>
</tr>
<tr>
<td>Upgrade finished</td>
<td>The time the upgrade finished.</td>
</tr>
<tr>
<td>Screen element</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Skipped</td>
<td>The number of records the system did not upgrade because of conflicts between customizations and the upgrade.</td>
</tr>
<tr>
<td>Unchanged</td>
<td>The number of records in the instance unchanged by the upgrade.</td>
</tr>
<tr>
<td>Unchanged and customized</td>
<td>The number of customized records in the instance unchanged by the upgrade.</td>
</tr>
<tr>
<td>Skipped error</td>
<td>The number of records the system did not upgrade because of one or more errors.</td>
</tr>
<tr>
<td>Inserted</td>
<td>The number of records the system inserted.</td>
</tr>
<tr>
<td>Updated</td>
<td>The number of records the system successfully updated.</td>
</tr>
<tr>
<td>Deleted</td>
<td>The number of records the system deleted.</td>
</tr>
<tr>
<td>Total</td>
<td>The total number of records the system inspected and/or processed for this upgrade.</td>
</tr>
</tbody>
</table>

**Resolve conflicts for an individual record**

Reconcile differences between your customized record and the changes associated with the upgrade.

Role required: admin

1. From the Upgrade Details form for the record you are reconciling, click Resolve Conflicts.
   The system displays the Resolve Conflicts form, which highlights differences between the two versions of the record. The form displays information about the base system record on the left and the customized record on the right.

2. Compare the base system with the customized record for each field on this form. For non-script fields, edit the customized record on the right-hand side to include what you want from the base system and the customization.

3. If this record contains a script, check it for conflicts and resolve.
   a) Click inside the Script field.
      The system displays the Resolve Conflicts - Script form highlighting areas where the two versions of the script differ.
   b) Edit the right-hand side so that the script contains whichever content you want. To move a block of code from the left to right side, click the small arrows corresponding to that block in the middle column.
   c) Click OK.
      The system returns to the Resolve Conflicts form.

4. To save your changes to the record, click Save Merge.
   The system sets the Resolution for this record to Reviewed and Merged.

**Upgrade Details form**

From the Upgrade Details form, you can review an individual record affected by the upgrade and reconcile conflicts between the upgrade and customizations.
Upgrade Details form

Fields

<table>
<thead>
<tr>
<th>Screen element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>The record the system has flagged as needing to be reconciled.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority the system has assigned to resolving this conflict. Values range from one to five, with one representing the highest priority.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments to document your decisions about reconciling this record.</td>
</tr>
<tr>
<td>Screen element</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Resolution     | How you elected to resolve this conflict:  
|                | - Not Reviewed  
|                | - Reviewed - reviewed but no action yet taken  
|                | - Reviewed and Merged - made changes to the record to reconcile the customized and upgraded versions  
|                | - Reviewed and Retained - left customizations in place without update from upgrade  
|                | - Reviewed and Reverted - customizations discarded, record updated according to upgrade  
|                | For more information, see Process the skipped records list. |
| Disposition    | Action performed on this file during the selected upgrade:  
|                | - Inserted: The system inserted a new record.  
|                | - Updated: The system updated this record.  
|                | - Deleted: The system deleted this record.  
|                | - Skipped: The system did not change this record in order to preserve customizations.  
|                | - Reverted: This record was reverted to the base version.  
|                | - Table not found: The system could not find the table that contains this record.  
|                | - Unchanged: The system did not change this record because the baseline component has not changed since the last release.  
|                | - Skipped Manual Merge: The system did not change this record because updating it requires manual intervention.  
|                | - Skipped Apply Once: The system skipped this record because it had already applied an update from an xml file in the apply once folder.  
|                | - Not Latest: The system applied a change, but this change was overwritten later during the same upgrade. |

<table>
<thead>
<tr>
<th>Type</th>
<th>The record type, for example Script include.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target name</td>
<td>Name of the skipped record, if applicable.</td>
</tr>
<tr>
<td>Update set</td>
<td>Unused.</td>
</tr>
<tr>
<td>Plugin</td>
<td>The plugin containing this record.</td>
</tr>
<tr>
<td>Table</td>
<td>The table containing this record.</td>
</tr>
</tbody>
</table>

**Resolve Conflicts form**

The Resolve Conflicts form you compare to the base system version with the customized version of a record and reconcile the differences.
Resolve Conflicts form

Fields

The fields this form displays depend on the type of record you are reconciling.

The left column shows the records fields in the base system, including the proposed changes that are part of the upgrade. The right column shows the fields for your customized record.

Express conversion to ServiceNow Enterprise

When a ServiceNow Express instance is converted to the ServiceNow Service Management enterprise platform, the instance is changed significantly.
The following topics help you understand what to expect during and after you convert from the ServiceNow Express platform to the ServiceNow Service Management enterprise platform. The topics provide advice and recommendations for advanced features and applications for you to consider.

It is recommended that you read the topics in the following order.

**Express conversion to Enterprise overview**

As you plan your upgrade from the ServiceNow Express platform to the ServiceNow Enterprise platform, become aware of the many features and resources that are available to you, both inside and outside of your instance.

Your upgraded instance will have significant new functionality that is part of the standard service management suite, including the following.

- **Graphical workflow**: Simplify complex service catalog requests with the highly configurable drag-and-drop workflow editor.
- **Scripting**: Extend your instance beyond standard configurations.
- **Content management**: create a custom interface for the ServiceNow platform and ServiceNow applications.

In addition to the standard service management suite, there are additional applications and suites that your organization can purchase, for example, financial and human resources applications, and the operation management suite. The ServiceNow Express platform did not offer these solutions, and it is recommended that you explore the resources available to learn about extending your ServiceNow Enterprise instance.

Where you may have been using the Express support site forums for help, a larger Enterprise community site is now available.

There are many resources available on the community site and on YouTube, but the ServiceNow Demo Center is the best resource to quickly learn about Enterprise platform functionality. The Demo Center offers on-demand videos and live presentations where you can ask questions via chat. Click here to access the Demo Center. Enter email address you registered with ServiceNow as your username, and reset your password if you are attempting to access the Demo Center for the first time.

Recommended Demo Center videos for an organization that upgrades from the Express platform to the Enterprise platform include the following:

- **Skinning the self service portals via Content Management**
- **Asset management life cycle**
- **Creating automation via Workflows**

**Working with support**

After you become an Enterprise customer, you may receive XML files from support that are needed to fix issues. To import these XML files into your instance, navigate to any list view, right-click a column header, and select **Import XML**. Select the XML file you were provided and submit it. The import takes place, although you see no confirmation or loading screen. You can import any XML file from any table list view. For example, if support provides XML files with report data, you can import the files from the Incidents list view, **Import XML** option.
Express conversion to Enterprise process

The conversion process includes an opportunity for you to review and test the ServiceNow Enterprise platform with a copy of your data before your production instance is converted.

Conversion process

The conversion process follows this timeline

1. A non-production instance is created from a cloned copy of your ServiceNow Express production instance. This non-production instance is for the full Enterprise Service Management platform.

2. You receive a letter indicating that you are entering a 15-day testing phase. The purpose is to verify that your ITIL and self-service portal users continue to experience the behavior they are familiar with.

3. After you verify with the non-production instance that the conversion completed and is acceptable, your designated Hi Administrator updates the change record advising ServiceNow support of your acceptance.

4. ServiceNow support schedules a full conversion of your Express production instance to ServiceNow Service Management. Your non-production instance is paired to it, and is available for you to configure new features, validate them, and roll them out to production.

ESS and ITIL experience

After an Express instance is converted to the Service Management platform, users with ESS and ITIL roles experience the look, feel, and behavior they are familiar with. They can access the same sets of applications and modules, lists and forms, and they experience the same underlying behavior. All functions that were accessible to ESS and ITIL users in the Express instance look and behave the same way for all users after the conversion.

For example:

- The incident form looks and works exactly the same way as it did in the Express instance. The same is true for the Problem, Change Request, and Configuration Item forms.
- Approvals are requested the same way as in the Express instance, and the approval process is the same.
- Survey responses are generated as in the Express instance.

Administrator experience

The Service Management platform is significantly different for administrators, who have access to all of its features. It is recommended that administrators attend the ServiceNow System Administrator training.

Express conversion to Enterprise considerations

Consider four core areas of functionality when planning your upgrade from the ServiceNow Express platform to the ServiceNow Enterprise platform. In these areas, Enterprise platform capabilities are more configurable, powerful, and flexible than in the Express platform.
Approval rule to workflow

As part of your migration from the Express platform to the Enterprise platform, reconsider your approval rules.

- In the Express platform, approval rules are applied to a record based on conditions when the record is saved. Approval rules run only when requested, and always occur first for catalog requests.
- In the Enterprise platform, approvals are an activity that is generally defined within the graphical workflow. This provides enhanced flexibility as you can define approval loops, re-approvals, and approvals that are nested at the beginning or end of a workflow. Reminder tasks can be defined to remind approvers that they need to take action.

Service level agreement (SLA) engine

The Express SLA engine is also record-based. In the Enterprise platform, the SLA engine has additional features, such as the ability to schedule jobs to auto-calculate time passed or time remaining metrics. In addition, workflow can be used to configure additional SLA complexity. You can activate the Service Level Management and SLA timeline plugins if they are not already active.

Security

The Express platform uses simple security for create, read, update, delete (CRUD) access through the dictionary. The Enterprise platform uses contextual security for more robust access control, referred to as access control lists (ACLs) or access control rules. During the conversion, your CRUD settings are converted to ACLs. The conversion does not change any of your security access.

The Enterprise platform offers additional benefits in the area of security. Security-based plugins are available and provide column level encryption, edge encryption, or encryption for data at rest.

There are also a greater number of roles available in the Enterprise platform that provide more granular options for granting access to the appropriate users to take action. Going forward, you will manage security settings using ACLs. For more information, see System security.

Development Instance

On the Enterprise platform, you can utilize a development instance in addition to your production instance. The development instance gives you a place to test and validate new Enterprise configurations. As you make changes to the development instance, you can use update sets to track and push the configurations to your production instance.

Scripting and other configuration options

As an administrator of a ServiceNow Enterprise instance, you have more configuration options available than in an Express instance. For example, there are additional field types on forms and an extensive list of dictionary options for fields or tables.

Administrators have access to core ServiceNow platform features such as scripted business rules, client scripts, UI actions, UI pages, UI Macros, UI scripts, Script includes, script actions, and so on. Administrators have access to all tables and dictionary entries, and can use...
scripting to accomplish any change in the instance. Examples of custom configurations include the following.

- You can use **UI actions** to define custom buttons.
- You can use **Client scripts** to define client-side scripts to run calculations or change fields dynamically before the form is saved.

Revisit your Express process as regards workflow and configuration in the context of how the Enterprise platform works. Determine ways to optimize your process based on Enterprise platform flexibility.

**Enterprise plugins**

The ServiceNow Enterprise platform offers enhanced functionality via plugins, and new plugins become available with each new release. When you upgrade, most plugins are not enabled on your converted Enterprise instance. This is slightly different from the plugins activated by default on a new Enterprise instance.

After the conversion, the administrator can navigate to **System Definition > Plugins** and review the list of plugins that are available and active. The administrator can also choose which capabilities to **activate after the conversion**. The **List of Jakarta plugins** lists the available plugins.

**List of plugins to consider activating after a conversion**

After the conversion is completed, review the plugins that are available and choose the capabilities to activate. The plugins listed below are not activated on an Express to Enterprise platform conversion. Learn about the functionality these plugins provide and determine which ones to activate.

For a description of plugins not linked below, review the description in the list of Jakarta plugins.

1. Assessments (com.snc.assessment_core)
2. Assessment Designer Common (com.glide.assessment_designer.common)
3. Asset Management (com.snc.asset_management)
4. Best Practice - Change Risk Calculator (com.snc.bestpractice.change_risk)
5. Best Practice - ITIL KPI Reports (com.snc.bestpractice.itil_kpi)
6. Best Practice - Task Survey Management (com.snc.bestpractice.task_survey)
7. Catalog Designer Common (com.glide.ui.ng.cc)
8. Change Management - CAB Workbench (com.snc.change_management.cab)
9. Change Management - Core (com.snc.change_management)
11. Change Management - State Model (com.snc.change_management.state_model)
12. Change Management Workflows (com.glideapp.workflow_change_management)
15. Contextual Security: Role Management V2 REST API (com.glide.role_management.inh_count.rest_api)
16. Contract Management (com.snc.contract_management)
17. Data lookup and record matching support for Service Catalog
   (com.glide.data_lookup.catalog)

18. Depreciation (com.snc.depreciation) installed with Asset Management

19. DHTMLX Scheduler Library (com.snc.dhtmlx.scheduler)

20. Expense Line (com.snc.expense_line)

21. Fixed Asset (com.snc.fixed_asset)

22. Guided Setup for Performance Analytics (com.snc.pa.guided_setup)

23. ITSM Guided Setup (com.snc.guided_setup_metadata.itsm)

24. My Assets (com.snc.asset_myassets)

25. Organization Management (com.snc.organization_management)

26. Problem Tasks (com.snc.problem_task)

27. Role Delegation (com.snc.role_delegation)

28. SCSS Bootstrap Theme (com.glide.ui.scss.bootstrap)

29. SCSS Content Provider (com.glide.ui.scss)

30. Service Creator (com.glide.service-creator)

31. Service Level Management (com.snc.sla)

32. Service Portal - Core (com.glide.service-portal)


34. Service Portal - Service Catalog (com.glide.service-portal.service-catalog)

35. Service Portal - Service Status (com.glide.service-portal.service-status)

36. Service Portal Configuration Pages (com.glide.service-portal.config)

37. Service Portal Designer (com.glide.service-portal.designer)

38. Service Portal for Enterprise Service Management (com.glide.service-portal.esm)


40. Service Portal Surveys (com.glide.service-portal.survey)

41. Software Asset Management Extensions (com.snc.sam)

42. Survey designer (com.glide.survey_designer)

43. User guide (com.glide.user_guide)

**Additional ServiceNow features and applications**

There are a large number of additional ServiceNow applications available for purchase after your conversion from the Express platform is complete.

The following list include some examples of these applications. Contact your sales representative for more information.

- Service Mapping
- Password Reset
- Automated Software or Configuration Deployment
- Automated External Script Execution
- Event Management
- Security and Vulnerability Management

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Cloud management
• Advanced reporting through Performance Analytics
• HR Service Management
• Project and Portfolio Management

Important features in the base system

Review the features listed below for an understanding of more ways to extend platform functionality.

• Update sets
• Service level agreements
• Workflow
• Project Management
• Agile development
• Import sets
• Transform maps
• LDAP
• Content Management System

Additional resources

A number of additional resources are available to learn more about the Enterprise platform. As mentioned, the Enterprise community is similar to Express forums, and it provides help and support to answer all of your questions. The community includes regional user conferences that are referred to as SNUGS (Service Now User Groups). Joining a SNUG is a great way to network and learn from other businesses that use the ServiceNow Enterprise platform.

Since the Enterprise platform comes with functionality to download and install update sets of external configurations, it is popular for users to share applications and configurations they have built via the Share portal.

Since the Enterprise platform has a large number of additional integration points, more pre-built content is available in the ServiceNow App Store. Certified partners are members of our large technology partner community, and through the App Store they offer popular applications and integrations to help you integrate with your 3rd party systems. The App Store is an excellent resource for acquiring additional functionality outside of ServiceNow applications and suites.
Index

Numerics

508 compliance
  keyboard accessibility 169
508 compliance screen reader 172

A

access account
  LDAPS 1125
access control 1310
access controls 1310
accessibility
  color and style 170
  screen reader 172
accessibility features
  search method tips 172
ACL 1310
ACLs
  configuration watcher
    execution plan 1336
    using 1337
  controlling whether script conditions apply to reference fields 1330
  creating ACL rules 1321
  debugging 1331
  evaluate the admin override at the access level 1331
activate plugins 7, 81
activated by maint 82
active directory application mode (ADAM)
  access account 1125
  backup 1123
  configuring 1119
  console 1120
  container 1121
  create objects 1121
  delegation 1121
  dependencies 1118
  group objects 1121
  instance 1119
  LDAPS 1123
  LDAPS certificate 1124
  LDAPS connection 1125
  objects 1121
  organizational unit 1121
  permission 1121
  public key & certificate 1124
  recovery 1123
  redundancy 1123
  security 1118
  testing 1122
  troubleshooting 1122
  user objects 1121
  userproxy objects 1121
Active Directory Federation Services
  creating a SAML logout 1177
  identity provider 1170, 1170, 1172, 1172, 1172, 1177, 1177, 1178
Active Directory, configure SSL access 1130
active transactions
  killing 1251
  viewing 1251
activities list
  customize 369
activity formatter
  add to a form 367
  create 367
  email property 370
  live feed 368
  security 366
activity stream
  max entries 378
ADAM
  ADAMSync 1125, 1126, 1126, 1127, 1128
  configuration file 1127, 1128
  configuring 1119
  dependencies 1118
  example 1128
  instance 1119
  security 1118
  set up 1126
  user accounts 1126
add
  field
    table 510
add role
  existing role 1006
adding
  new department 988
  suggestion fields 505
ADFS 1170, 1170, 1172, 1172, 1172, 1177, 1177, 1178
  See also Active Directory Federation Services
administer
  table administration
    unique record identifier 788
    unique record identifier 788
Administrator
  servicenow 7
administration 7
altiris integration 967
annotate
  forms 357
  annotate forms 357
application development 942
application quotas
  property 1293
  rules 1293
Application Usage Overview 1024
applications
  create a custom table 178, 183
apply ACLs
  AJAXGlideRecord 1330
approval summarizer
  formatter example 375
attachment configuring icon 362
disabling table 361
file size limiting 360
file types 729
icon configuring 362
table disabling 361
viewing 358
Attachment Indexing enabling 731
attachments administering 358
restrict file extensions 360
hide attachment (view) link 361
audit roles 1328
audit roles table sys_audit_role 1021
authentication multifactor activating 1204, 1207, 1209
configuring 1206
disabling for a user 1207
disabling on user table 1211
disabling on your user profile 1211
logging on 1209
requiring for a user 1207
two-factor 1202, 1206

B
backup active directory application mode (ADAM) 1123
ADAM 1123
Base System Roles special administravive roles 1013
breadcrumbs restricting 317
suppressing 317
Breadcrumbs restricting 314
browser support
list v3 288

C
calculated price fields 590
Calendars creating 629, 631, 631
certificate certificate authority (CA) 1366
generate with keytool 1366
trusted server 1367
upload 1366
certificates LDAP client 1365
mutual authentication 1365
child record 381
choice list
time zone 687
choice list state field 417
CI changes 1392
class base 163
child 163
parent 163
Client Transaction Timings 649, 650, 651, 1475
cmdb ci changes 1392
company name normalization 1219
complexity limits joins 162
computer telephony integration 972
condition count widget add 424
configuration 7
configure group types assignment groups 1001
Configure properties 1298
configure transaction quota rule 1288
configuring attachment icon 362
icon attachment 362
suggested text journal fields 506
string fields 506
configuring lists list calculations 297, 298
connection
LDAPS 1125
testing 1125
connection test module creating 1282
container ADAM 1121
create 1121
content management 7
context menus action script 333
create 329
dynamic actions script 333
onsho script 334
context ranking
definition, creating 323
list, ranking 325
plugin, activate 322
scrum ranking 327
sort order, apply 326
update sets 323
contextual search add functions 739
associate with wizard 753
define search context 740
defining 739, 739, 751, 753
installed components 767, 769, 770, 771, 773
record producer 751
Contextual Search
administering 766
Administering 764
configure properties 764
Defining 742, 745, 748, 749, 753, 754, 755
installed components 767, 770, 774
query feedback 767
Roles 758
This Helped 767
contextual security
configuring 308
Contextual Security: Role Management V2 1327
Contextual Security: Role Management V2 REST API 1327
Contextual Security: Role Management V2 1328
conversions 1482
Core Configuration 7
Core Configuration List Administration 287
overview 599
Platform Performance 1219 time 623
corrupt index
regenerating 726
create a custom table
create a table 178
global default fields 183
create a UI policy
convert a UI policy to a data policy 579
view-specific UI policy 399
creating
new field 510
currency
auditing 597
conversion rate job 593
conversions 593
decimal places 597
export 594
forms 592
import 594
lists 590
optimizer 598
properties 598
reference currency 588
reports 592
scripts 594
session currency 588
custom tables
delete 187
customized objects
during upgrades 1486

D
data 7
data archiving
affected records, verifying 798
archive rule, setting 793
archive schedule, changing 802
archived strings, language of 798
creating rules 794
plugin 792
related records 795
restored records, archiving 804
restoring 802
viewing 800
data destruction
creating rules 799
Data Dictionary Tables
system dictionary 254, 256
data import
schedule 893
scripting options 895
Data Lookup and Record Matching Support
create a custom data lookup table 581
create a data lookup module 586
create custom data lookups 581
data lookup definition record 583
data lookup table 582
data lookup value 582
troubleshooting 587
data management 786
data policy
installed with 574
Data policy
converting to a UI policy 579
creating 575
debugging 580
fields 578
data preserver
SAML properties 940
data source
choice list 842, 843
create 845, 1080, 1098
Data Sources
Custom CSV files 833
File 829
FTP extended properties 837
JDBC 837
LDAP 846
Database Rotation 949, 951
date and time fields
configuring for the list editor 625
personalizing the date format 624
personalizing the time format 625
Date and Time Fields 623, 626, 626, 627, 627, 628, 628
daylight saving time
time zone 685
user preferences 685
default currency fields 587
default sort sequence
list 304
define client scripts 407
delegation
active directory application mode (ADAM) 1121
ADAM 1121
delete
custom tables 187
deleting all records
table 187
dictionary attributes 264
dictionary override
define 255
dictionary overrides 255
Did You Mean?
suggestions, configuring 705
digest token authentication
  enabling exit script 1198
  disabling
  attachment table 361
drag-and-drop 360
  feature 360
table
  attachment 361
Discovery
  SCCM integration
  switching versions 965
disposition
  upgrade history 1482
Document ID Field 428
document scoring 717
domain separation
  activating and deactivating domains 1432
  activating plugins 1420
  adding to a domain field 1432, 1437
  adding to a visibility domains list 1436
  applications 1415
  changing domain visibility 1444
  configuration module 1421
  creating contains relationships between domains 1436
  creating domain-specific choice lists 1440
  default domain scope 1407
  delegated administration
    example with domain specific applications and modules 1445
    example with domain specific policies 1451
domain assignment 1398
domain query methods 1409
domain scope 1404
domain selection menus 1427
domain visibility 1400
  enabling domain logging and debug messages 1459
  enabling the domain reference picker on UI11 and UI15 1427
  enabling the domain reference picker on UI16 1427
  granting visibility domains to a group 1432
  granting visibility domains to a user 1437
  limitations 1415
  making a domain the default 1425
  managing MSP domains for records 1431
  properties 1407
  re-enable domain separation 1443
  re-enabling delegated administration 1458
  resetting all records to the global domain 1443
  restricting access by role 1430
  selecting a primary domain 1423, 1438
  setup 1420
  user preferences 1407
  validating domain hierarchy 1440
  viewing historical messages 1460
  viewing MSP domain relationships 1443
  viewing real-time messages 1459
  viewing tables that use domain separation 1443
Domain separation 1431
  domain separation for MSPs
    activating and deactivating domains 1432
    changing domain visibility 1444
    creating a domain 1423
    installed components 1410
    making a domain the default 1425
    managing MSP domains for records 1431
    selecting a primary domain 1438
    viewing MSP domain relationships 1443
domain separation setup 1425, 1433, 1443, 1458
drag-and-drop
  disabling 360
  feature 360
dynamic creation 475
E
e-signature approval
  SAML 2.0 authentication, setting up 1048
Easy Import
  add a record in the template 917
  data type validation 923
  import a record from the template 919
  import template 916
  paste data into the template 921
  template type validation 923
  unit validation 921
  update a record in the template 918
email
  notifications
    events
      business rules 778
      creating an event 783
      global 782
      passing parameters 785
      reprocessing 785
      states 775
  using a business rule 776
embedded lists
  securing records 1325
  within a form 351
embedding
  HTML fields
    images 446
    HTML fields 446
  images
  employee self-service
  login scenarios 1345
enable auditing
  table 1383, 1384, 1384
Encryption
  support 1463, 1466, 1466, 1467, 1467, 1468, 1471
  Encryption Context 1465
  encryption scripting 1469
  enter submits form
    change preference 405
    entity generation 666
  escalation intervals 661
  event log 774
  event queue 774
© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
event registry 669, 775
events
  schedule 669
Export Data
  break up a large export 816
  enable export debug logging 817
  export directly from the URL 813
  export form data 809
  export limits 806
  export list data 810
  export list fields 811
  filter list result 812
  url export 814
  url query 812
Export public key certificate 1133
Export set
  Schedule an export 821
Export sets
  Cancel an export 825
  create an export definition 820
  Create an export target 821
  create new 819
  easy export 820
  History 824
  scheduled export
    scripting 823
Export Sets
  properties 825
Exporting data
  Exporting currency fields to Excel 812
Exporting Data
  export data 805, 806, 809, 810, 811, 812, 813, 814, 816, 817
Express conversion to Service Management 1510, 1511, 1512, 1514, 1515
extend 175
External Authentication (Single Sign-On - SSO) 1158, 1160, 1164, 1178, 1182, 1213

F
feature
  disabling 360
  drag-and-drop 360
field
  add spell checking 458
  creating new 510
field administration
  choice field search 423
  choice fields 423
Field administration
  normalize 535, 539, 542, 544, 546, 548, 549, 552
Field Administration
  choice list width 423
  choice lists
    change none display value 420
    customize 414
    define option 418
    delete 421
    field type 422
    remove none option 420
reuse 419
security 414
create a wikitext field 508
data lookup and record matching support 581, 581, 582, 583, 586, 587
default choice lists
  integer values 416
extend functionality of a wikitext field 509
field normalization 527, 529
reference fields 476, 476, 478, 479, 480, 480, 483, 483, 486, 487, 487
supported wiki tags 507
use phone number fields 462, 462, 462, 462, 462, 462, 463, 463, 464, 465, 466, 467, 469, 471, 473, 473
values associated with choices
  scripting 415
wiki fields 507
Field map
  Script variables 889
Field Normalization
installed with 529
Field Normalization Rules
  expressions 571, 573
  patterns 571, 573
field status indicators
  change colors 513
Field Styles
  defining 517, 518
field transformations
  create transformation records 554
  run data jobs 537, 538
  select transform types 556
  test 558
field type
  create 532
fields
  HTML fields
    HTML sanitizer 1376, 1379, 1379, 1380, 1380
Fields
  creating new 511, 519, 521, 522
  introduction 519
file
  attachment 360
  role 360
file size
  attachment limiting 360
filter out
  hidden groups 1001
filter potential assignees
  based on skills 1003
filters
  related list query blacklist 293
  restricting 317
  suppressing 317
Filters
  restricting 314
Financial Management
  fiscal calendar 632
fiscal calendar
  generate 634
  view fiscal periods 635

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
fixed price fields 590
form administration
  create a UI policy 399, 399, 579
  create a UI policy example 402
form design 335, 340, 340, 340, 342, 342
form annotations
  add 344
  language support 357
toggle 346
types 357
form design
  add a formatter 342
  add annotation 340
display field 340
new field 342
new section 340
form personalization
  activate 356
  administer 355, 356
  disabling 357
  manage 356
  role requirements 356
  user preferences 356
form section
  create 347
form splits
  add property to enable 405
form submission
  double-check 1329
form templates
  automatically applied 379
  create from form 379
  save form as template 385
  scheduling 387
  template bar 387
formatter
  approval summarizer 375
  create 364
  create UI macro 363
  override with macros 377
forms
  activity formatter
    live feed 368
  add activity formatter 367
  adding charts 353
  adding related lists 344
  annotate 357
  configure 342
  configure condition builder 425
  configure customer updates indicator 353
  configure insert for task records 404
  control the label type 409
  customize activities 369
define required fields 408
  personalize 355, 356, 356, 356
  personalizing 357
  use HTML fields 439
frequency 731

G

general security settings
  properties 1301
Generate a certificate 1131
Glide
  durations format
    modifying 282
glide.history.role 1392
Global Catalog 1133
global text search
  search field 692
  search groups 697
  search preferences 703
  search result groups 692
  search suggestions 705
Google
  activating plugin 956
grant role access
  applications 1005
  modules 1005
group skill
  assign 1003
group type
  add 1001
  assign 1002
groups
  add a user 1000
  create 999
  hide 1001
  remove a user 1000

H

hidden field
  group form 1001
hidden groups
  filter out 1001
hierarchical list
  enable 319
high security settings
  activating 1308
  default deny property 1329
  elevated privilege 1338
  elevating to a privileged role 1342
  forcing administrators to manually elevate 1343
history access
  control 1391
history sets
  comparing CI snapshots 1395
  export historical CI snapshot 1395
HTML editor
  paste options 450
HTML fields
  embedding
    images 446
    video 448
  htmlArea HTML toolbar 433
  image uploads 450
  images
    embedding 446
Importing
XML records 927
Importing
ServiceNow instance 927, 928, 929, 929, 930, 930
XML records
matching existing records 928
inactivity monitors
setting 661
index
field, removing 726
HTML 722
removing 726
index suggestions for slow queries
export to non-production instance 1241
generate 1237
review 1238
schedule index creation 1242
schedule index drop 1247
test index performance 1246
indexing 723, 729
installation exits 1348
Instance
translate 617, 617, 618, 618, 619, 619, 619, 620, 621, 621, 622, 622, 622
instance locale
set 600
Instance Security Dashboard 1298
Instance Usage 1024
integrate 952
integration 952
Integrations
available 953
Internal CA, generate certificate 1131
internationalization
support 600
Introduction to Fields
change 512
count character counter 457
database field types 426
delete 512
delete multiple 512
field label 512
hint 512
IP address field type 451
status indicator 513
text field 457
types 410
IP Range Based Authentication
access control 1355
block a particular range 1356
block everyone except a particular range 1356
J
Java digest algorithm
encryption 1200
JDBC
SQL Server Integration 840
JDBC driver
choice list, edit 842, 843
data source, create new 845
DB2 843
LDAPS
  ADAM 1123
certificate, assigning 1124
collection 1125
public key certificate 1124
self-signed certificate 1123
left-pad numbers
  in custom tables 525
limiting
  attachment
    file size 360
    file size
      attachment 360
Linux stats 1276
list administration
  list v3
    disable for a table 295
disabling globally 294
  enabling for related lists 294
list calculations 297, 298
list control 303
list control settings
  for list editor 307
list controls 299, 303
list editor
  administering 305
contextual security, configuring 308
control settings, configuring 307
user preferences, managing 312
list editor properties
  configure editable field types 306
disable list editing 306
list mechanic
  access, controlling 313
activating 313
list v3
  activating 287
  browser support 288
  compatibility 289
designed compatibility 289
installed components
  properties 290
lists
  detail rows
  enabling 314
locales
  define 599
localization
  form annotations 357
  system 615
Localisation
  instance 617, 617, 618, 618, 619, 619, 619, 620, 621, 621, 622, 622, 622
localization properties 615
location setup 617
Login
  finding denied IP addresses 1357
  IP range based authentication 1355, 1355, 1356, 1356, 1356
login landing page
  specifying 1346
Login Scenarios 1345
login security
  activating ServiceNow access control 1362
  configuring ServiceNow access control 1363
  ServiceNow access control 1360
logout button
  remove 1348
logout confirmation prompt
  enable 1347

M
Managing Data
  system clone 932, 935, 935, 937, 944, 947, 947
Many to Many Task Relations
  define a relationship type 247
  define a task relationship allowed 248
  mark as solution button 249
  modify the displayed field 249
  plugin manifest 246
  request the plugin 246
task relationship type record 248
ui actions 249
many-to-many relationship
  creating 286
  referencing 287
match relevance by
  field, controlling 719
metric definitions 684
Microsoft
  SMS/SCCM integration 2.0 956
Microsoft Active Directory, configure SSL access 1130
MID Server 1088
modify form focus 405
multi-tenancy 1395, 1396, 1415
multiple fields
  sort 305
multiple price fields 590
Multiple Provider
  single sign-on
    using with ESS 1047
MySQL global status 1268

N
navigation and UI
  context menu 329, 333, 333, 334
new customizations
  translate 609
new department
  adding 988
Non-Interactive Sessions 1022, 1022, 1023, 1023, 1023
Nonce
  implementing 1357, 1357
normalization
  company name 1219
  properties 1218
Normalization Data Services 1219
number of history entries
  change 1392
OAuth activating 1186
APIs
  scoped 1196
authorization code flow 1190
authorization code grant flow 1190
authorize access 1193
external client scenario 1187
manage OAuth tokens 1195
profile
  parameters 1188
property 1186
revoke a token 1196
setting up 1185
OAuth 2.0 authorization code flow instance as authorization server 1194
OKTA SSO
activating the plugin 1212
instructing users to log in 1212
setting up 1212
on load check box 403
OpenLDAP
modify 1134
organizational unit
  ADAM 1121
  create 1121
Platforms encryption 1465
Platform Performance
  Stats Tools plugin 1229
table extension 1295
troubleshoot performance 1220, 1221, 1222, 1224
Platform security overview 1296
Plugin
  Google custom search integration 956
plugins
  activate 7
general 81
  options for activating 81
  purchase 83
Plugins
  List of Plugins 8
pop-up information
  customize 484
Portal
  worker 236
preserve applications 942
price fields 590
process flow formatter
  activating 372
  create 372
Production System 966
properties
  base system 83
properties module
  creating 160
public key certificate
  exporting 1124
  LDAPS 1124
Public key certificate, export 1133
punctuation 720
purchase plugins 81, 83
query method
  configuring 701
query mode
  single table 726
quotas
  application 1292
  application properties 1293
  transaction 1285
range calculator scripts 658
ranking
  stories 328
read only role 1013
read-only fields
  pop-ups 485
record
  deleted 1138
Record Numbering
  managing 523, 524, 526, 526
record producer 760
restrict a field
  example 309
  with a condition, example 311
  with a script, example 310
restrict a table
  example 308
role
  attachment
    file 360
    file
  attachment 360
role delegation
  prevention 1008
roles
  acl rules 1015
  create 1004
  group
    assign role 1006
    creating 1005
    security jump start 1015
Roles
  base system roles 1008, 1013

S

SAF
  2.0
    Java keystore 1152
    profile 1042, 1139, 1140, 1141, 1142, 1142, 1142, 1142, 1142,
    1143, 1143, 1144, 1145, 1145, 1145, 1145, 1146, 1146,
    1146, 1147, 1147, 1147, 1147, 1148, 1152, 1153, 1154,
    1154, 1155, 1161, 1162, 1166, 1168, 1169, 1169,
    1179, 1180, 1183
    SSO 1042, 1139, 1140, 1141, 1142, 1142, 1142, 1142,
    1143, 1143, 1144, 1145, 1145, 1145, 1145, 1146, 1146,
    1146, 1147, 1147, 1147, 1148, 1152, 1153, 1154,
    1154, 1155, 1161, 1162, 1166, 1168, 1169, 1169,
    1179, 1180, 1183
    user provisioning 1180, 1181
    web browser 1042, 1139, 1140, 1141, 1142,
    1142, 1142, 1143, 1143, 1144, 1144, 1145, 1145, 1145,
    1145, 1146, 1146, 1146, 1147, 1147, 1147, 1148, 1152,
    1153, 1154, 1154, 1155, 1151, 1162, 1166, 1168,
    1169, 1169, 1179, 1180, 1183
    concepts 1160
    data preservers 940
    identity provider
      certificate 1149
      logout endpoint 1177
      install 1149
      system clone 940
SAF 1.1
  migrating 1179
SAF 2.0
  integration with other features 1169
  troubleshooting 1181
Sample C 1201
SCCM
  switching versions 965
  schedule script execution 665
  scheduled data import 8
  time zone 688

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
scheduled job 668
Scheduled jobs 662
scheduled report 663
scheduled reports
    time zone 688
Schedules
    using 635, 636, 637, 639, 640, 640, 642, 643, 646, 647
script actions 779
script includes
    suppress breadcrumbs and filters 317
script sandboxing 1309
search
    attachments 729
    phrase searches 710
    wildcards 710
search groups 695
search phase 711
search phases 711
search process 711
search provider
    build 983
search results 695
searching
    boolean operators 708
Searching
    Google 956
security
    active directory application mode (ADAM) 1118
    activity formatter 365
    security admin 1341
    security_admin 1341
    self-service password reset 1352
    self-signed certificate
        ADAM 1123
        LDAPS 1123
Server Scripting
    transform map scripts 850, 850, 852, 854
Service Catalog
    localizing price 594, 613
    service level agreements 684
ServiceNow
    intranet 974, 974, 974, 974
    ServiceNow servlet 1260
    ServiceNow Store Usage Overview 1024
    session currency 588
    set up VPN
        ServiceNow and business network 1460
single logout
    Active Directory Federation Services 1177
single sign-on
    multi-provider
        activating 1029
        choosing the ldap 1046
        configuring users 1032, 1039
        ldaps 1040
        installed with 1028
        logging in 1046
        modifying the primary 1032, 1039
        setting up 1029
        testing connections 1040
        troubleshooting scripts 1045
        troubleshooting test connections 1042
    Single sign-on
        digest token authentication
            creating links 1200
            entering multi-provider single sign-on
                properties 1199
            entering single sign-on properties 1198
            generating a digest token 1197
            sample implementation 1200
            testing the integration 1197, 1197, 1199
    single-currency mode 588
size limits
    joins 162
    skill
        create 1002
    skills management
        activate 1004
    skipped updates 1486
    slow query logs
        use 1232
    sort order
        remember 305
    spell checking
        add to a field 458
SSL
    LDAP 1070
    SSL access, configure Microsoft Active Directory 1130
    stand-alone CA, set up 1131
    Standard Import Set Tables 864
    statistics
        text indexing 728
    Stats Tools
        performance evaluation 1229
    status
        text indexing 728
    stop words
        automatic, configuring 733
        global, configuring 732
        table-specific, configuring 732
    stories
        ranking 328
    string fields
        configuring
            suggested text 506
        suggestion fields
            adding 505
Support
    encryption 1463, 1466, 1466, 1467, 1467, 1468, 1471
    supported interfaces 972
synchronize
    LDAP records 1114
    synonym dictionaries 736
    synonym dictionary 736
    synonym search
        debug 737
    sys audit table
        understanding 1382
    syslog probe 984
    system clone
        SAML integration 940, 1140
    System clone
        exclude a table from cloning 935
start a clone 944
System Clone
  create a clone target 935
  preserve data 937
  run post clone cleanup scripts 947
  view active clones 947
  view clone history 947
system diagnostics
  running 1225
system dictionary
  modifying 256
System Dictionary
  dictionary entries 256
system log messages 1291
system logs
  restore deleted records 189, 189, 191
system properties
  adding 158
System Scheduler 661

T

tabbed forms
  display 349
table
  attachment
    disabling 361
    viewing 358
  deleting 186
  disabling
    attachment 361
    extending 163
  table administration
    restoring deleted records and references 190
    unique record identifier 789, 789, 789
Table Extension
  example 1295
table field
  prevent auditing 1384
table hierarchy
  extension model 1281
table index 191
table rotation
  apply 1278
tables
  delete 187
Tables
  schema map 283, 283, 284
tables module 184
task parent breadcrumbs formatter
  customize 374
task table
  flattening 1280
Task table
  activate time cards 213
  copy time cards 224
  creating a task 192
  important Task table fields 199
  journal fields 202
  modifications 212
  modify the task interceptor 204
  Planned Task plugin 191
  time cards 212, 222, 222, 227, 228
  time sheet policies 213
  time sheets 219
  tools for driving tasks 244
Task Table
  assignment lookup rules example 192
  assignment module rule 195
  assignment rules 194
  assignment rules module 193
  baseline assignment rules example 194
  business rules 194
  condition editor example 193
  data lookup rules 193, 198
  defining assignment rules 192
  many to many task relations 246, 246, 246, 247, 248, 249, 249, 249
  workflow assignments 194

tasks
  tasks workflow 212
technical 7
template
  apply from a module 387
  scripting 388
Test LDAPS connectivity 1132
text index 723
text indexing
  statistics 728
  status 728
TF-IDF scoring 718
third-party 952
this ServiceNow instance 1283
threads
  performance monitoring 1252
time
  display 654
  scheduled jobs 668
Time
  time zones 688
  view system logs 776, 1380, 1473, 1474, 1476, 1477, 1479, 1480, 1481, 1481
Time card
  submit time card 226
time card management
  time cards 212
  time sheet policies 213
Time card management
  approve time sheet 221
  assign time sheet policy to a user 218
  create project time category 219
  create time sheet 219
  create time sheet policy 214
  project manager dashboard 228
  reject time sheet 221
  set time sheet policy as default policy 218
  submit time sheet 221
time cards 222
time sheets 219
use the project manager dashboard 232
use the user manager dashboard 236
user manager dashboard 233
transform definitions create 564
transform map create 877
scripts 1083
Transform Map Scripts event scripts 854
transformation script variables 850
Transform Maps creating 848, 880, 885
translatable strings locate 609
translate and learn property use 611
Translated Text 613, 614, 614, 614
translation prefix display 609
Troubleshoot Performance compression 1224
network response times 1222
response time on forms 1221
transaction log response times 1220
type ahead suggestions, updating 705

U

ui actions 304
UI actions 389, 393, 395, 397, 398
UI policies client scripts 403
UI policy creating from a data policy 579
unique record identifier 788
untranslated string export 610
Upgrade History 1482, 1493
upgrade monitor upgrade platform 1494
upgrade system 1494
Upgrade Monitor /> upgrade instance 1494
upgrades 1482
Use HTML Fields editing functions 438
extended functions 436
formatting 433
highlight text in the TinyMCE editor 444
insert a line break 444
style a table 444
TinyMCE version 3 and htmlArea editor 443
Use Phone Number Fields configure e.164 phone number fields 462
dependent fields 462
display of local format 463
e.164 phone number field dictionary attributes 469
e.164 phone number field system properties 467
entry of international format 463
international direct dialing prefix 466
phone formats 473
phone territory selector choice list 464
phone validations 473
territories assigned 462
territory format validation 462
territory labels 465
territory phone display rule 471

Use Time Zones
set a system time zone 688

User
7
User administration
company 986
user preferences
list editor, managing 312
user registration
approve an account 994
enable auto processing 987
user sessions
locking out a user 998
making a user inactive 998
managing 997
terminating a user session 998
User sessions
modify session timeout 997
user skill
assign 1003
users
allow to view a profile 987
assign roles 1006
create 988
Users and Groups
impersonate a user 994, 995, 995, 996, 996
Using Forms
use HTML fields 429, 433, 436, 438, 443, 444, 444, 444

V
validation script
deactivate 990
Verizon
ebonding
migrating 966
integration 966
video
defining file types
HTML fields 449
embedding
HTML fields 448
HTML fields
embedding 448
view cmdb ci 1392
View System Logs
audited tables 1380
customer updates table 1480
e-mail logs 1477
event logs 776, 1476
import logs 1479
log history 1481
log utilities 1481
system logs 1473
transaction logs 1474
viewing
attachment

W
watch lists
configure email notifications 515
configure order buttons 516
hide email addresses 516
use 514
Web Proxy
ntlm authentication 173
proxy servers 174, 174
soap clients 174
Web service import sets 904, 908, 911
Web Service Import Sets
Security requirements 912
web service security 1368, 1370, 1373
website
HTML fields
linking 447
linking
HTML fields 447
words 720
Worker Portal
submit time sheet 244

X
XML files
export 817
import 817
XML Files
exporting 804
importing 804
XML import sets 928

Z
Zing
junk filter, disabling 702
text search, debugging 702
Zing text search 690